
IBM



⽬錄

歡迎

Getting Started with IBM Cast Iron
What's New for This Release
Introduction

Development Environment
Development process example

Integration Appliance
Web Management Console
Studio

The Project tab
The Activities tab
The Variables tab
The Functions tab
The Verify tab
Understanding nodes and mappings
Understanding parameters

Installation and configuration
Deployment concepts

About configurations
Before developing your projects

Planning an Integration Project
Translating project requirements into Studio components
Integration appliance configuration tips
Studio best practices

Glossary
Legal information

Notices
Terms and conditions for information centers

Cast Iron Studio
IBM Cast Iron Studio
Working with projects

Studio basics
Creating a new project
Protecting a project with a password

Changing a password associated with a project
Removing a password associated with a project

Opening a Project
Saving a Project
Renaming a Project
Publishing a Project
Exporting a Project

1

1

1

2

3

4

5

5

6

7

9

10

10

11

13

14

14

15

16

17

18

19

19

20

22

24

25

28

28

28

29

31

36

37

38

38

39

40

41

41

42



Configuring Project Settings
Setting Preferences

Project Preferences
Orchestration Preferences
Other Preferences

Creating Configuration Properties
Editing Configuration Properties
Creating Global Configuration Properties
Searching for Template Integration Projects (TIPs)
Installing Module Provider Libraries
Uploading Files into a Project

Uploading Files into a Project using the Mouse
Uploading Files into a Project using the Add Document Button

Uploading Included XML Schemas
Specifying the Location of a File to Upload
Valid External File Types for a Project
About Valid Names
Undo and Redo Operations
Updating a Changed XML Schema
Using the Project Explorer
Using the HTTP Post Utility

Orchestrations
Configuring an orchestration to orchestration connection
Creating an orchestration
Renaming an orchestration
Building an orchestration
Verifying orchestrations
Using SSL in Studio
Importing an end-entity certificate
Importing a Certification Authority (CA) Certificate
SSL server authentication
Testing an SSL server connection
SSL client authentication
Using the Log Viewer
Viewing an orchestration
Validating an orchestration
Working with activities in an orchestration
Printing an orchestration
Processing orchestration jobs sequentially
Enabling persistence
Adding a global exception handler to an orchestration
Saving an image of an orchestration

Connection Activities
Creating an endpoint
Downloading plug-in connectors
Using an existing endpoint
Polling interval behavior
Using the Shift-JIS encoding

43

44

45

46

47

50

52

53

54

55

55

56

57

58

62

63

64

66

66

68

68

69

71

72

72

73

73

75

77

78

79

80

81

81

82

83

85

87

87

88

90

91

92

92

93

94

95

96



Template Integration Process (TIPs)
About the Template Integration Project (TIP) Configuration Editor
Creating a Template Integration Project (TIP)
Modifying a Template Integration Project (TIP)
Verifying a Template Integration Project (TIP)
Searching for Template Integration Projects (TIPs)
Rating and Reviewing Template Integration Projects (TIPs)

Rating and Reviewing Template Integration Projects (TIPs) using the Publish Review Dialog box
Uploading Template Integration Projects (TIPs) to the Cast Iron solutions repository

Transform Activities
Map Variables Activity
Read MIME activity

Adding a Read MIME activity to an orchestration
Mapping the input of the activity
Mapping the output to an activity

Write MIME activity
Adding a Write MIME activity to an orchestration
Mapping the input of the activity
Mapping the output to an activity

Read XML activity
Read XML activity configuration
Read XML map inputs
Read XML map output

Write XML activity
Write XML activity configuration
Write XML map inputs
Write XML map output

Validate XML activity
Adding a Validate XML activity to an orchestration
Configuring a Validate XML activity
Mapping the input to an activity
Mapping the output to an activity - Validate XML

Read JSON activity
Read JSON activity configuration
Read JSON map inputs
Read JSON map output

Write JSON activity
Write JSON activity configuration
Write JSON map inputs
Write JSON map output

Validate JSON activity
Adding a Validate JSON activity to an orchestration
Configuring a Validate JSON activity
Mapping the input to an activity - Validate JSON
Mapping the output to an activity - Validate JSON

Read Flat File activity
Read Flat File activity configuration
Read Flat File map inputs

97

97

98

100

100

54

102

102

103

105

106

107

108

108

110

111

112

112

115

115

116

117

118

118

119

120

120

121

122

123

124

124

126

127

127

128

129

130

131

132

132

133

134

135

135

137

138

138



Read Flat File map outputs
Write Flat File activity

Write Flat File activity configuration
Write Flat File map inputs and outputs

Apply XSLT activity
Logic Activities

Logic activities overview
Terminate activity
Pick activity
If..Then activity
Try activity
Group activity
While Loop activity
For Each activity
Break Loop activity
Continue activity
Adding branches to the If..Then activity
Moving branches
Defining conditions
Basic condition syntax
bpws:getVariableData function
Basic XPath expressions
Testing XPath expressions

Utilities Activities
Create Job Keys Activity
Creating Job Keys
Log Message activity
Schedule Job activity

Archives Activities
Archive activity

Adding an Archive activity
Configuring an Archive activity
Archive activity map input
Archive activity map output

Unarchive Activity
Adding an Unarchive activity
Unarchive activity map input
Unarchive activity map output

Cryptoservice Activities
Overview of the PGP activities
Using the PGP Encrypt activity
Using the PGP Decrypt activity
Importing PGP keys
Troubleshooting and support

Data Quality Activities
About Data Quality Activities
Filter and Profile Activity

Configuring the Filter and Profile activity

139

140

141

142

143

144

145

146

146

148

149

151

152

152

153

155

155

156

157

158

159

159

162

164

165

166

167

168

169

169

170

170

172

174

174

176

176

177

178

179

180

181

183

184

184

185

186

186



Mapping Filter and Profile activity outputs
Creating Profile Summaries
Filtering Expressions

Creating a filter expression
Adding a filter expression condition
Deleting a filter expression condition
Editing a filter expression condition
Changing the processing order of filter expression conditions

Lookup Activity
Using the Lookup activity
Mapping Lookup activity outputs

Sort Activity
Merge Activity

Merging two sorted inputs
Database Activities

Creating or Editing a Database Activity Endpoint
Browsing Database Tables
Character Encodings
Database Entities and Activities
Defining Columns for Old Values in Updates
MaxPooledStatements Parameter
Oracle, Sybase, DB2, and Informix Parameters
Retry Options For Inbound Database Activities
Retry Options For Outbound Database Activities
SequeLink Parameters
Single-Table Inbound Database Activities
Single-Table Outbound Database Activities
Specifying Delivery Rules for Database Activities
Viewing Column Details
Working with Database Parameters
Call Procedure Activity
Execute Query Activity
Poll Table Activity
Testing an SSL Database Connection

Domino Activities
Overview of the Domino connector
Creating or editing an endpoint for a Domino activity
Creating a Domino document
Updating a Domino document
Retrieving a Domino document
Querying Domino documents
Querying views for Domino documents
Deleting a Domino document
Specifying Retry and Delivery Options for Domino activities
Prerequisites to use Domino inbound activities
Get Created Documents activity
Get Updated Documents activity
Get Deleted Documents activity

187

187

189

189

190

190

191

191

192

193

195

195

196

198

199

201

206

206

207

209

211

212

213

215

216

217

221

226

228

229

229

232

235

240

240

242

243

245

248

251

254

259

261

264

265

267

268

270



Handling Date/Time and Time zone data types
Rich text support for Domino connector
Troubleshooting and support

Email Activities
Creating or editing an email endpoint
Get Email activity
Send Email activity
Testing an SSL email connection

Force.com Bulk API Activities
Preparing Data for the Force.com Bulk API connector
Creating a Force.com Bulk API endpoint
Specifying the Retry options for Force.com Bulk API activities
Using the Force.com Bulk API Batch Insert activity
Using the Force.com Bulk API Batch Update activity
Using the Force.com Bulk API Batch Upsert activity
Using the Force.com Bulk API Batch Delete activity
Using the Force.com Bulk API Get Batch Status activity
Using the Force.com Bulk API Get Batch Results activity

FTP Activities
Creating or Editing an FTP endpoint
Configuring the FTP endpoint for the Parse Directory Listing Example
FTP Poll Directory activity
FTP Put File activity
FTP Get File activity
Parse directory listing example
Testing an FTPS server connection

HTTP Activities
Creating or editing an HTTP endpoint
HTTP Receive Request activity
Decompression with the HTTP Receive Request activity
HTTP Send Response activity
Compression/Decompression with the HTTP Send Response activity
HTTP Post Request activity
HTTP Get Request activity
HTTP Head Request activity
HTTP Invoke Request activity
HTTP Put Request activity
HTTP Delete Request activity
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request activity
Troubleshooting and support

JDE Activities
Overview of the JD Edwards (JDE) connector
Creating or editing an endpoint for a JDE activity
Importing JDE Libraries
Installing JAR files to connect to the JDE server
Using the JDE Invoke Business Function activity
Using the JDE Poll Real-Time Events activity
Specifying Retry and Delivery Options for JDE Activities

271

272

273

274

274

277

281

285

286

287

288

289

290

291

292

294

295

296

297

298

300

303

310

315

321

323

324

325

330

335

337

341

343

350

356

363

370

376

383

387

389

390

390

391

393

394

395

396



JMS Activities
Creating or editing a JMS endpoint
Specifying delivery rules and retry parameters for JMS activities

Specifying delivery rules parameters for JMS activities
Specifying retry parameters for JMS activities

Get Message activity
Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Get Message activity
Mapping the Inputs
Mapping the Outputs

Poll Message activity
Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Poll Message activity
Mapping the Outputs

Publish Message activity
Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Publish Message activity
Mapping the Inputs

Send Message activity
Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Send Message activity
Mapping the Inputs

Subscribe Message activity
Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Subscribe Message activity
Mapping the Outputs

Creating a JMS endpoint to a WebLogic server
MQ Activities

Creating or editing a MQ Activity endpoint
Installing JAR files to connect to the MQ system
Defining and loading an XML schema for a MQRFH2 header
MQ Get Message activity
MQ Put Message activity
MQ Poll Queue activity
MQRFH2 XML data and schema examples

NetSuite Activities
Creating or editing a NetSuite endpoint
Add Records activity

398

399

400

401

402

402

403

404

404

404

405

406

407

408

408

408

409

410

410

411

411

412

412

413

414

414

415

415

416

416

417

418

418

419

419

420

421

422

423

424

425

426

431

434

436

440

441

442



Using the Add Records activity
Mapping the inputs for the Add Records activity
Mapping the outputs for the Add Records activity

Attach Records activity
Using the Attach Records activity
Mapping the inputs for the Attach Records activity
Mapping the outputs for the Attach Records activity

Delete Records activity
Using the Delete Records activity
Mapping the inputs for the Delete Records activity
Mapping the outputs for the Delete Records activity

Detach Records activity
Using the Detach Records activity
Mapping the inputs for the Detach Records activity
Mapping the outputs for the Detach Records activity

Get Records activity
Using the Get Records activity
Mapping the inputs for the Get Records activity
Mapping the outputs for the Get Records activity

Initialize Record activity
Using the Initialize Record activity
Mapping the inputs for the Initialize Records activity
Mapping the outputs for the Initialize Records activity

Search Records activity
Using the Search Records activity
Mapping the inputs for the Search Records activity
Mapping the outputs for the Search Records activity

Update Records activity
Using the Update Records activity
Mapping the inputs for the Update Records activity
Mapping the outputs for the Update Records activity

Upsert Records Activity
Using the Upsert Records activity
Mapping the inputs for the Upsert Records activity
Mapping the outputs for the Upsert Records activity

Oracle CRM On Demand Activities
Creating or editing an Oracle CRM On Demand endpoint
Specifying the Retry options for Oracle CRM On Demand activities
Using the Oracle CRM On Demand Insert Object activity
Using the Oracle CRM On Demand Update Object activity
Using the Oracle CRM On Demand Query Object activity
Using the Oracle CRM On Demand Delete Object activity

Oracle E-Business Suite Activities
Overview of the Oracle E-Business Suite connector
Installing JAR files to connect to Oracle E-Business Suite
Creating or editing an endpoint for an Oracle E-Business Suite activity
Using the Oracle E-Business Suite Create Objects activity
Using the Oracle E-Business Suite Update Objects activity

443

444

444

445

446

447

447

448

448

449

450

450

451

452

453

453

454

455

455

456

457

458

459

459

460

461

462

462

463

464

465

465

465

467

467

468

468

469

471

472

473

474

476

477

477

478

479

481



Using the Oracle E-Business Suite Delete Objects activity
Using the Oracle E-Business Suite Retrieve Objects activity
Specifying Retry and Delivery options for Oracle E-Business Suite activities

PeopleSoft activities
Overview of the PeopleSoft connector
Creating or editing an endpoint for a PeopleSoft activity
Installing JAR files to connect to the PeopleSoft server
Using the PeopleSoft Create Component Interface activity
Using the PeopleSoft Update Component Interface activity
Using the PeopleSoft Delete Component Interface activity
Using the PeopleSoft Get Component Interface activity
Using the PeopleSoft Find Component Interface activity
Creating events table and compiling PeopleSoft JAR files
Using the PeopleSoft Get Created Component Interface activity
Using the PeopleSoft Get Updated Component Interface activity
Using the PeopleSoft Get Deleted Component Interface activity
Specifying retry and Delivery Options for PeopleSoft Activities

RightNow SOAP API Activities
Overview of the RightNow SOAP API connector
Creating and editing a RightNow SOAP API endpoint
Using the RightNow SOAP API Create Objects activity
Using the RightNow SOAP API Get Objects activity
Using the RightNow SOAP API Update Objects activity
Using the RightNow SOAP API Destroy Objects activity
Using the RightNow SOAP API Query Objects activity
Specifying retry parameters for RightNow SOAP API activities

Salesforce.com activities
Creating or editing a Salesforce.com endpoint
Configuring Salesforce.com activities
Migrating Salesforce.com projects
Setting Salesforce.com configuration properties
Specifying the Retry and Time Out parameters for Salesforce.com activities
Understanding and setting polling preferences for the Salesforce.com connector
Convert Lead activity

Map the input of the Convert Lead activity
Map the output of the Convert Lead activity

Set password activity
Reset password activity
Send email activity
Create Objects activity

Map the input of the Create Objects activity
Map the output of the Create Object activity

Delete Objects activity
Map the input of the Delete Objects activity
Map the output of the Delete Object activity

Get Deleted Objects
Map the input of the Get Deleted Objects activity
Map the output of the Get Deleted Object activity

482

483

485

486

487

488

490

490

492

493

495

496

497

500

501

502

504

505

506

507

508

509

510

512

513

514

515

517

519

520

521

521

522

523

524

525

525

526

528

529

529

530

531

532

532

533

533

534



Get Updated Objects
Map the input of the Get Updated Objects activity
Map the output of the Get Updated Object activity

Get User Information activity
Map the output of the Get User Information activity

Get Server Timestamp activity
Map the output of the Get Server Timestamp activity

Merge Objects Activity
Map the input of the Merge Objects activity
Map the output of the Merge Object activity

Poll Deleted Objects activity
Map the output of the Poll Deleted Object activity

Poll Updated Objects activity
Map the output of the Poll Updated Object activity

Query Objects activity
Configuring the Query Objects activity
Retrieve Objects activity
Search Objects activity
Undelete Objects activity
Configuring the Search Objects activity
Update Objects activity
Upsert Objects activity

SAP activities
Overview of the SAP connector
Creating or editing a SAP endpoint
Downloading and installing the SAP Jar Files and DLLs
Configuring Single Sign-on (SSO) and Secure Network Communications (SNC) for SAP connector
SAP Invoke BAPI activity
SAP Invoke RFC activity
SAP Receive IDOC activity
SAP Send IDOC activity
SAP Receive RFC activity
SAP Send RFC Response activity
Troubleshooting and support

ServiceMax activities
Creating or editing a ServiceMax endpoint
Configuring ServiceMax activities
Setting ServiceMax configuration properties
Specifying the Retry and Time Out parameters for ServiceMax activities
Understanding and setting polling preferences for the ServiceMax connector
Poll Updated Objects activity
Get Updated Objects
Poll Deleted Objects activity
Get Deleted Objects
Create Objects activity
Update Objects activity
Upsert Objects activity
Delete Objects activity

535

535

536

537

537

538

538

539

540

541

541

542

543

543

544

546

548

549

551

552

554

555

556

557

558

560

562

563

566

571

572

575

577

578

588

589

592

592

593

594

595

596

598

599

600

602

603

605



Undelete Objects activity
Retrieve Objects activity
Query Objects activity
Configuring the Query Objects activity
Search Objects activity
Configuring the Search Objects activity
Convert Lead activity
Merge Objects Activity
Get User Information activity
Get Server Timestamp activity
Send email activity
Set password activity
Reset password activity

Siebel activities
Overview of the Siebel connector
Installing JAR files to connect to the Siebel server
Creating or editing a Siebel endpoint
Using the Siebel Create Objects activity
Using the Siebel Update Objects activity
Using the Siebel Delete Objects activity
Using the Siebel Query Objects activity
Using the Siebel Execute Business Service activity
Prerequisites for starter activities in Siebel
Using the Siebel Get Created Objects activity
Using the Siebel Get Updated Objects activity
Using the Siebel Get Deleted Objects activity
Specifying Retry and Delivery Options for Siebel Activities
Siebel properties file

Security Token Service (STS) activities
Creating or editing an STS endpoint
Using the STS Get SAML 2.0 Token activity

SugarCRM activities
Creating and editing a SugarCRM endpoint
Using the SugarCRM Upsert Object activity
Using the SugarCRM Get Reports activity
Using the SugarCRM Delete Object activity
Using the SugarCRM Get Object activity
Using the SugarCRM Query Object activity
Using the SugarCRM Get ServerInfo activity
Using the SugarCRM Get UserInfo activity
Using the SugarCRM Search activity
Using the SugarCRM Set Relationship activity
Using the SugarCRM Delete Relationship activity
Using the SugarCRM Get Relationship activity
Specifying the Retry options for SugarCRM activities

Taleo activities
Creating and editing a Taleo endpoint
Using the Taleo Create Attachments activity

606

607

544

611

613

614

616

618

619

620

621

622

624

625

626

627

628

630

632

634

636

638

639

641

643

644

646

648

650

650

653

656

657

658

659

660

661

663

664

665

666

667

668

669

670

672

673

674



Using the Taleo Create Objects activity
Using the Taleo Get Objects activity
Using the Taleo Search Objects activity
Using the Taleo Delete Objects activity
Using the Taleo Set Associated Users activity
Using the Taleo Set Binary Resume activity
Using the Taleo Submit Candidates activity
Using the Taleo Update Attachments activity
Using the Taleo Update Objects activity
Using the Taleo Upsert Objects activity
Specifying retry parameters for Taleo activities

Web Services Activities
Creating or Editing a Web Services Endpoint

Creating or editing an endpoint for an Invoke Service activity
Creating or editing an endpoint for a Provide Service activity

Updating a Changed WSDL
Updating a changed WSDL

Web Services Invoke Service Activity
Adding an activity
Creating an endpoint
Configuring the activity
Specifying the retry options
Mapping the inputs of the activity
Mapping the outputs of the activity
Invoking an Orchestration with Web Services Provide Service Starter Activity

Compression/Decompression with the Web Services Invoke Service Activity
Web Services Provide Service Activity

Adding an activity
Creating an endpoint
Configuring the activity
Mapping the outputs of the activity

Decompression with the Web Services Provide Service Activity
Web Services Send Reply Activity

Adding an activity
Configuring the activity
Mapping the inputs of the activity

Web Services Send Reply with Fault Activity
Creating the Required Fault Names
Configuring the Activity
Map the Inputs of the Activity

Compression with the Web Services Send Reply Activity
Troubleshooting and support

Workday Activities
Overview of the Workday connector
Creating and editing a Workday endpoint
Using the Invoke Workday activity
Specifying the retry options for Workday activity

Zuora Activities

675

676

677

678

679

680

681

683

684

685

686

687

688

688

692

693

697

698

699

699

700

700

702

703

704

705

708

710

710

711

712

713

716

717

717

718

719

719

720

721

721

723

724

724

725

726

728

729



Overview of the Zuora connector
Creating and editing a Zuora endpoint
Using the Zuora Create Objects activity
Using the Zuora Update Objects activity
Using the Zuora Delete Objects activity
Using the Zuora Query Objects activity
Using the Zuora Amend Subscription activity
Using the Zuora Create Subscription activity
Using the Zuora Generate Invoice activity
Specifying the Retry options for Zuora activities

Using Secure Connectors
Variables

About variables
Creating variables

Create a new variable using the Create New Variable option
Create a new variable using the Select Inputs or Select Outputs buttons
Create a new variable using the toolbar menu
Create a new variable using the Copy menu option
Create a new variable using the Copy button
Primitive Data Types

Configuring variable properties
Removing Variables
Specifying a default value
Browse for Schema Element
Selecting a Substitution Type for Variables

Flat File Schemas
Flat File Schema Editor Overview
About delimited data
About fixed length or 'positional' data
Mixed positional and delimited example
Creating a flat file schema
Testing flat file schemas

Load input test data
Test a Flat File Schema
Save test output data to a file

Root node properties
Adding Fields or Field Types
Field properties
Adding Records or a Record Type
Record properties
Adding Groups or Group Types
Group Properties
Group Example
Working with Nodes in the Schema Tabs

Copy nodes
Delete nodes
Rename nodes
Move nodes

730

730

732

733

734

735

737

738

739

740

741

743

743

746

746

747

748

749

749

750

750

751

752

753

753

756

757

758

760

762

768

770

770

771

772

773

781

783

791

792

797

799

800

807

807

808

809

810



Adding Several Children
Valid Node Names
The Type Library Tab
Specifying Optional Fields and Records
Generating a flat file schema from an IDOC
Using the Flat File Wizard

Mapping
About Maps
Creating a map

Mapping Inputs
Mapping Outputs

Creating a Standalone Map
Select source schemas for a standalone map
Select destination schemas for a standalone map

Creating a Standalone Map from a Map Variables Activity
Creating a Map Variables Activity from a Standalone Map
Adding Variables to Mapping Panes
Copying Parameters
Replacing a Variable used in a Map
Finding Nodes
Assigning a Default Value for a Destination Node
Mapping Techniques

Mapping One Source to One Destination
Mapping Multiple Sources to One Destination
Mapping One Source to Multiple Destinations
Conditional Mapping for a Recurring Node

Automapping Matching Nodes
Bulk Mapping Nodes
Mapping Recurring Nodes
Mapping All Occurrences
Mapping Specific Occurrences

Select Source Occurrences
Expand Destination Occurrences
Collapse Destination Occurrences
Add destination occurrence
Remove Destination Occurrence
Select a substitution type in a mapping pane

Mapping Destination Nodes
Selecting a substitution type

Select a substitution type in a mapping pane
Remove the Derived Type Associated with a Node

Mapping Rules That Are Automatically Deleted
Assigning a Count of Occurrences
Removing Mapping Rules

Removing mapping rules with links
Removing mapping rules with no visible links
Remove All Mapping Rules

Finding Sample or Result Content

810

811

812

813

813

815

817

818

818

820

821

822

823

824

824

825

826

827

827

829

830

832

832

833

833

833

834

834

835

836

836

837

838

838

839

840

840

842

842

840

847

848

848

849

849

850

850

851



Loading a Sample Message
Testing maps
Saving or Clearing the Transformation Result
The Emit CData Option
Unsupported XML Schema Features
About Unmapped Destination Nodes
Filter Recurring Nodes

Using Custom Functions and Lookup Tables
About Lookup Tables
Defining Lookup Tables
Editing Lookup Tables
About Custom Functions
Defining a custom function
Editing a custom function
Custom Function Parameter and Return Datatypes
Assigning a Function Without a Source Node Link
Assigning a Function While Creating Maps
Adding a Function to an Existing Mapping Rule
Example: Chaining Multiple Functions
Assigning Function(s) to a Mapping Rule
Deleting a Function from a Mapping Rule
Math Functions with Node Set Constraints
Adding a Parameter
Editing a Parameter
Deleting a Parameter
Reordering Parameters
Specifying Default Values for Functions that Accept Recurring Nodes as Input

Mapping Function Reference
Mapping functions overview
Mapping Function Syntax and Datatypes
Absolute Value function
Add function
AES Decrypt function
AES Encrypt function
Align Center function
Align Left function
Align Right function
Average function
Base64 Encode and Decode functions
Boolean function
Ceiling function
Concatenate function
Cast From Base64Binary function
Casts From HexBinary function
Cast To Base64Binary function
Cast To HexBinary function
CopyOf function
Count Function

852

852

853

854

854

856

856

858

859

859

860

861

862

863

864

864

865

866

867

868

868

869

870

870

871

871

872

873

876

878

881

881

881

882

882

883

884

884

885

886

887

887

888

888

889

889

890

891



Decode Configuration Property of Type Password
Digest/Hash function
Divide function
Extract HTTP Header Field function
Extract Query Parameter function
Extract URI Path function
Floor function
Format Date String function
Format Number function
Generate RFC2104 HMAC Compliant Signature
Get Current Date and Time function
Get Current Date function
Get Current Time function
Length function
Lowercase function
Maximum function
Minimum function
Modulo function
Multiply function
Not function
Number function
Padding String function
Position function
Read Date String function
Replace function
Round function
Starts With function
String function
Substring function
Substring After function
Substring Before function
Subtract function
Sum function
Trim function
Uppercase function

Glossary
Glossary

Cast Iron Express
Cast Iron Express ⼊⾨
登錄帳⼾

協助⼊⾨

管理您的帳⼾設定檔

管理使⽤者

Cast Iron Express 說明中⼼
新增函數⾄ Express 帳⼾
隨時掌握 Cast Iron Express 的最新功能

892

892

893

894

894

894

895

895

897

898

899

900

900

901

901

902

902

903

904

904

905

906

907

907

909

912

913

913

914

915

915

916

917

917

918

919

919

923

923

924

925

925

926

926

927

928



與 Cast Iron Express 整合
⽀援的來源和⽬標系統

FTP 來源⽀援的檔案類型
管理安全連接器

建⽴安全連接器

安裝安全連接器

啟動和停⽌安全連接器

移除安全連接器

建⽴整合

使⽤「整合」編輯器

配置連線

連接⾄ MySQL 資料庫
選取作業

資料庫觸發程式表格

選取物件

選取欄位

連接⾄ salesforce.com 時使⽤外部 ID
搭配使⽤外部 ID 與更新插⼊作業
搭配使⽤外部 ID 與相關物件
過濾來源物件

設定整合

定義對映

定義函數

配置函數

複合函數

使⽤複合函數

函數清單

管理整合

修改整合

刪除整合

監視整合活動

使⽤率圖表

指導教學

指導教學：建⽴本端檔案與 salesforce.com 的整合
名詞解釋

組合 (Bundles)
連線 (Connection)
端點 (Endpoint)
欄位 (Fields)
函數 (Functions)
整合 (Integration)
作業 (Operations)
來源 (Source)
⽬標 (Target)
轉換 (Transformation)
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Cast Iron Live
About the Cloud

About Environment Dashboards
About the Cloud
Contacting Technical Support
Navigating the Management Console
Support Information

Managing Cloud Instances
Downloading and Installing SAP JAR Files and DLLs
Installing Vendor Supplied Libraries
Scheduling Downtime

Managing Orchestrations
About Orchestration Settings
Editing Orchestration Settings

Managing Projects
About Naming Projects and Configurations
About Project Configurations
About Projects
Cloning Project Configurations
Copying Projects
Creating Projects From Scratch
Creating Projects From a Template
Deleting Project Configurations
Deleting Projects
Deploying Project Configurations
Editing Project Configuration Properties
Editing Projects
Publishing Projects
Reviewing TIPs
Stopping Project Configurations
Uploading Project Configurations
Working with Project Configurations

Monitoring
About Environment Dashboards
Choosing a Notification Level
Creating Notification Policies
Deleting Notification Policies
Editing Notification Policies
Enabling Email Notification Policies
Searching for Orchestration Jobs
Viewing Orchestration Job Logs

Permissions
About Built-In Groups
About Libraries Environments
About User Profiles
Assigning Users to Groups
Changing Your Password
Changing User Passwords
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Creating New Groups
Creating New Users
Deleting Groups
Deleting Users
Granting Project Configuration Permissions

Using Secure Connectors
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Secure Connector Minimum Requirements
Creating Secure Connectors
Downloading Secure Connector Configuration Files
Installing Secure Connectors
Installing Vendor Supplied Party Libraries for Secure Connectors
Downloading and installing the SAP Jar Files and DLLs
Uninstalling Secure Connectors (Windows)
Uninstalling Secure Connectors (Linux)
Starting and Stopping Secure Connectors

Starting and Stopping Secure Connectors on Windows (Installed as a Windows Service)
Enabling Interactive Mode for Windows Services
Starting and Stopping Secure Connectors on Windows (Installed as a Windows application)
Starting and Stopping Secure Connectors on Linux

Upgrading Secure Connectors
Troubleshooting Secure Connectors

Security
About Certificates
Editing Security Settings
Exporting Certificates
Generating Certificate Signing Requests
Generating Self-Signed Certificates
Importing Certificates
Renaming Certificate Alias
Uploading Certificates

Working with Logs
Specify System Log Settings
Viewing System Logs

Cast Iron Web Management Console
About the Web Management Console

About Management Console Settings
Contacting Technical Support
Navigating the Management Console

Local Staging Database
About the Local Staging Database
Starting the Local Staging Database
Stopping the Local Staging Database

Best Practices for Memory Management
Managing Integration Appliances

About Connectors
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Downloading and installing SAP library files
Configuring Secure Network Communications (SNC) for SAP connector
Executing Commands
Exporting A Repository
Importing A Repository
Installing Libraries from Other Vendors
Scheduling Downtime
Specifying Network Settings
Executing a System Command
Upgrading a Dell Integration Appliance
Upgrading a DataPower Integration Appliance
Working with Network Routes

Managing Orchestrations
About Orchestration Settings
Editing Orchestration Settings
Exporting Orchestration Monitoring Data

Managing Projects
About Assets
About Naming Projects and Configurations
About Project Configurations
About Projects
Cloning Project Configurations
Copying Projects
Creating Projects From Scratch
Creating Projects From a Template
Deleting Project Configurations
Deleting Projects
Deploying Project Configurations
Editing Project Configuration Properties
Editing Projects
About Database Assets
Publishing Projects
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Required Quotes for Asset Table Names
Reviewing TIPs
Stopping Project Configurations
Uploading Project Configurations
Viewing and Saving Web Services Assets
Working with Project Configurations

Monitoring
About the Web Management Console
Choosing a Notification Level
Creating Notification Policies
Deleting Notification Policies
Editing Notification Policies
Enabling Email Notification Policies
Searching for Orchestration Jobs
Viewing Hardware Status
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Viewing Orchestration Job Logs
SNMP basics
Setting up an SNMP receiver
Adding a notifications policy
About the Resource Utilization Graph
Hardware health
Testing the system

Permissions
About Built-In Groups
About Libraries Environments
About User Profiles
Assigning Users to Groups
Changing Your Password
Changing User Passwords
Creating New Groups
Creating New Users
Deleting Groups
Deleting Users
Granting Project Configuration Permissions
Local Staging Database Permissions

Using Secure Connectors
About Secure Connectors
Secure Connector Minimum Requirements
Creating Secure Connectors
Downloading Secure Connector Configuration Files
Installing Secure Connectors
Adding or importing certificates to the Secure Connector TrustStore/KeyStore
Installing Vendor Supplied Libraries for Secure Connectors
Downloading and installing the SAP libraries
Uninstalling Secure Connectors (Windows)
Uninstalling Secure Connectors (Linux)
Starting and Stopping Secure Connectors

Starting and Stopping Secure Connectors on Windows (Installed as a Windows Service)
Enabling Interactive Mode for Windows Services
Starting and Stopping Secure Connectors on Windows (Installed as a Windows application)
Starting and Stopping Secure Connectors on Linux

Upgrading Secure Connectors
Troubleshooting Secure Connectors

Security
About Certificates
Configuring Kerberos
Configuring LDAP Mechanism Properties
Editing Security Settings
Enabling an LDAP Directory Server
Exporting Certificates
Generating Certificate Signing Requests
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Importing Certificates
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Renaming Certificate Alias
Uploading Certificates

Working with Logs
About Archived Logs
About Archived Logs
Purging Orchestration Monitoring Logs
Specify System Log Settings
Viewing System Logs
Customizing columns in System log and Job log

Managing Appliances
Registering, editing, and unregistering appliances
Upgrading Cast Iron appliance

Cast Iron Command Line Interface Reference
About the Command Line Interface

Logging into the CLI with an secure shell session connection
Logging into the CLI with a Serial Connection
Logging into the CLI with a telnet connection
Command Line Interface modes
Command Line Interface commands

Authorization commands
The auth set user command
The auth set recovery command
The auth show recovery command

Configuration commands
The config load command
The config save command

Debugging commands
The debug postmortem export command
The debug postmortem generate all command
The debug postmortem generate full logs command
The debug postmortem generate new logs command
The debug postmortem generate store command
The debug show stacks command
The debug system command
The debug tail file command
The debug top command
The debug job command

High availability commands
The ha active command
The ha conncheck command
The ha disconnect command
The ha power off standby command
The ha power on standby command
The ha reboot command
The ha show lastaccess command
The ha show pairstatus command
The ha switch command
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Management commands
Network commands

The net set command
The net show command

Network introspection commands
Status commands
System commands
Time commands

Cast Iron High Availability Pairs
About High Availability Pairs
About Integration Appliance States
Requirements for Configuring High Availability Pairs
Setting Up a High Availability Pair
Working with High Availability Pairs

Running High Availability Commands
High Availability Commands

Troubleshooting a High Availability Pair

WebSphere Cast Iron Hypervisor Edition
About the virtual appliance
Getting started with the IBM WebSphere Cast Iron Hypervisor Edition

Requirements
Resource mapping
Upload an appliance patch
Deploying an OVF template
Configuring to use DHCP addressing
Configuring to use static addressing
Backing up and recovering virtual appliances

Exporting a virtual appliance repository
Importing a virtual appliance repository

Cast Iron Notifications Reference
Integration Appliance Monitoring Options
About the Cast Iron SNMP MIB

Downloading the Cast Iron SNMP MIB
Reading the Cast Iron SNMP MIB

SNMP Items Available Using SNMP Get
Using Traps to Monitor Appliance Health
Archive Module

Archive Operation Notifications
ArchiveDone
ArchiveEntryBlank
ArchiverCreated
ErrorIdentifyArchive
ErrorUnZipOperation
ErrorZipOperation
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IncorrectParameters
InvalidArchiveEntry
InvalidArchiveFormat
InvalidBzipEntry
InvalidDateTime
InvalidGzipEntry
InvalidNumInArchEntry
InvalidUnArchFormat
InvalidUnarchiveInput
UnArchiverCreated
UnarchiveDone
ValidationError
ValidationFine

Crypto Service Module
Crypto Service Operation Notifications

DecryptDone
DecryptStarted
EncryptDone
EncryptStarted
FoundPrivateKey
FoundPublicKey
IOException
InputEntryCount
IntegrityCheckFailed
IntegrityCheckPassed
InvalidAlgorithm
InvalidContent
InvalidDateFormat
InvalidFormat
InvalidKeyOrPwd
InvalidKeyStore
InvalidKeyhandle
InvalidPassword
NoIntegrityCheck
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Data Module
Data Operation Notifications

BadEncoding
MissingEncParse
MissingEncSerialize
ParsingError
SerializeError
SerializeIOError

Data Quality Module
Data Quality Operation Notifications

BadPreloadQuery
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LeftMergeInputEntry
LookUpEntryCount
LookUpError
MergeError
NoAssetsError
NoPreloadedCache
OutputEntryCount
PreloadedCache
RightMergeInputEntry
SortError
SortInputEntryCount

Data Quality Internal Notifications
DQLookupFuzzyOnCloud

Database Module
Database Connection Notifications

ConnectionError
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JDBCConnectionClose
SetQueryTimeout

Database Operation Notifications
ActivateError
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DateTimeParseError
DeleteRowsError
DeleteRowsFailure
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ErrorDeletePost
ErrorSingleTableJob
InboundOperationError
InsertTableStatement
MaxRowExceeded
MethodNotFound
OperationNameAbsent
OutboundActivateError
ParamQueryActivate
ParamQueryError
ParameterizedQuery
PollTblActivateError
QueryString
RedeliverSkip
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StoredProcException
StoredProcQuery
UpdateQuery
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StoredProcActivate
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UnexpectedEmptyRows
Domino Module

Domino Operation Notifications
ActivateFailureBlank
ActivateSuccess
ActivityCreateSuccess
ActivityFailure
ActivitySuccessful
RetryCount
RunningInfo
RunningMessages
SchemaInvoke
StopSuccess

Domino Internal Notifications
ConnectError
InitializationError
UnmarshalError

Email Module
Email Connection Notifications

ConPoolReleaseError
ConnectError
ConnectErrorRetry
ConnectHeaderAbsent
ConnectHeaderPresent
ConnectionPoolReturn
DisconnectException
EndpointData
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IncorrectSmtpTimeout
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MakeConPoolError
NewConnectEverytime
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SetTimeout
SmtpConnectFailed
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SmtpConnected
SmtpDisconnectError
SmtpEndpointData
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CouldNotGetHostIP
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MailHeaderPresent
MailsDeleted
MailsToBeDeleted
NoEmailMatched
NoMailOnServer
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Pop3ConfigParams
Pop3DataError
Pop3MailSent
Pop3NumMails
Pop3ServerError
SaveStateError
SetBCCFieldValue
SetCCFieldValue
SetFromFieldValue
SetSubjectFieldValue
SetToFieldValue
SmtpConfigParams
SmtpDataError
SmtpSendEmail
SubjectPatternError

Email Internal Notifications
BodyNull
Pop3InternalError
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DeleteAfter
DeleteBefore
DeleteDupLIstEntry
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FileNotMoved
FileProcessed
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ListAfter
ListBefore
ListFileSummary
NListAfter
NListBefore
OperationError
PutAfter
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PutDuplicateFileName
PutEmptyFileName
PutInfoSummary
RenameAfter
RenameBefore
RenameDupError
RenameInfoSummary
SshFingerprintInfo
SshModeInfo
TimeStampError
TimestampCommand
UnableToDelete
UnableToMove

FTP Internal Notifications
EncodingError
InternalException
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HTTP Connection Notifications
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ConnectionRetry
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ReceiveActivate
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ReceiveIOError
ReceiveSendReplyError
ReplyConnectionError
SendRequestConnection
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CommonHandlerError
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IncomingContentEnc
ReadInputHeaders
ReceiveOperationError
ReceiveResponseBody
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RegisterKeyStore
ReplyCompressFormat
ReplyUnMarshalHeader
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ResponseBodyNotBinary
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UnSupportedMedia
UnsolicitedEncoding
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GeneralRequestFailed
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DataStructureError
NumberFormatError
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SetUpInfo
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What's New for This Release
IBM® WebSphere® Cast Iron® version 7.5.1 delivers new and enhanced features.

IBM WebSphere Cast Iron Version 7.5.1 contains new features and updates for the following components:

Studio
Connectors
Management Console

Studio
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This section describes new features and updates for Studio. For more information about connector new
features and updates, see the Connectors section.

Support for migrating WSDL of a WorkDay Connector Project
Enhancements to supported activities of JIRA Connector, Insightly Connector, and MS SharePoint.
SAP dependency JCo Jar files - Version Specific information
Transformation activities for Open Data Protocol (OData)
New connectors are available for download. For more information about the new connectors, see the
Connectors section.

Connectors

Along with updates to the existing connectors, Studio now supports the following:

The new connectors added to the list are:
Apache Cassandra connector - Allows you to Insert Rows, Update Rows, Delete Rows, and
Execute Query on Cassandra.
MailChimp connector - Supports Objects on CRUD operations, Batch operations, and Atomic
operations.
Marketo connector - interacts using Restful Web Service API’s, which allow users to access bi-
directional data-level integration.
Sage CRM connector - Enables fetching data from the CRM and saving / updating data into the
CRM for integration.

Enhancements to supported activities of JIRA Connector, Insightly Connector, and MS SharePoint.

Management Console

The following section describes new features and updates for the Web Management Console (WMC):

Agent Monitoring tool for Secure Connectors
Push WSDL from Cast Iron Project to API Management
Push REST API (Swagger) from Cast Iron Project to API Management
Support for Cast Iron Docker Container

Feedback | Notices
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Introduction
This section gives an introduction to the Integration Appliance, Studio, and the Web Management Console.
There is also information about accessing Template Integration Projects, and information about installation and
configuration.

Development Environment
The Integration Appliance combines data integration, transformation, routing, monitoring, and
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management capabilities in a single product. During run time, the Integration Appliance shares data and
processing among databases, enterprise applications, legacy systems, and business applications.
Integration Appliance
The Integration Appliance is a rack-mountable appliance comprised of redundant and hot-swappable
components
Web Management Console
The Web Management Console (WMC) is a browser-based application hosted by the Integration
Appliance
Studio
Studio is a development tool for designing and building integration projects.
Installation and configuration
This topic discusses the installation and configuration steps you must complete before you build and run
an integration project.
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Development Environment
The Integration Appliance combines data integration, transformation, routing, monitoring, and management
capabilities in a single product. During run time, the Integration Appliance shares data and processing among
databases, enterprise applications, legacy systems, and business applications.

Capabilities

Broad support for the following industry-standard formats:
XML (W3C XML Schemas, DTDs, and XML documents)
Flat File, raw text, and raw binary data types
Supports many character encodings including UTF-8, US-ASCII, ISO- 8859-1, SHIFT_JIS, EBDIC-
XML-US, and EUC-JP
Commercial database systems, including Informix®, Sybase, DB2®, MySQL, Oracle and others
through Sequelink.
System-specific protocols, such as SAP IDOC and IBM® MQ Series
Web Services

Ability to transform data easily from one format to another format, for example: Flat File data to XML
data.
Guaranteed message delivery by means of a built-in message repository that holds all messages
processed by the Integration Appliance.
Support for a variety of application programming styles: synchronous and asynchronous (request/reply,
store-andforward, publish/subscribe).
Support for data transfer through configurable ports for HTTP, secure HTTP (HTTPS), FTP, secure FTP
(SFTP).
Support for client-side PKI authentication—the ability to connect to a secure server from the Integration
Appliance.
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Ability to be managed remotely, from anywhere on the network, using a Web Management Console
(WMC) and Command Line Interface (CLI).
Support for email-based notifications using your network's SMTP-based email system and simple
network management protocol (SNMP) traps.

Components

The development environment contains the following hardware and software components:

Studio
A graphical tool used to create integration projects on your Windows development environment. You
publish integration projects from Studio to the Integration Appliance.

Integration Appliance
An appliance that connects directly into a network and runs the integration projects that you create
using Studio.

Web Management Console (WMC)
A browser-based console that you use to manage the projects on the Integration Appliance.

Command Line Interface (CLI)
A set of commands that you can use to manage the projects on the Integration Appliance.

Development process example
The steps in this topic provide an example of the development process for an integration project:

Parent topic: Introduction
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Development process example
The steps in this topic provide an example of the development process for an integration project:

Procedure

1. Develop your integration project using Studio on a standard Windows 7 machine.
2. In Studio, verify that the orchestration is valid.
3. Publish the integration project to the Integration Appliance.
4. Open a browser on a Windows 7 machine. In the browser, start the Web Management Console (WMC).

From the WMC, issue a request to the Integration Appliance to deploy the orchestration job (instance) of
the integration project.

5. An event triggers an orchestration job to be created and to start processing the activities that make up
the orchestration. For example, a file being placed in a particular directory on a FTP server can trigger an
orchestration job to be created and start processing.

6. From the WMC, verify that the orchestration job has completed and that no errors have occurred.
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7. Modify the integration project in Studio. For example, your original integration project checks if a file
appears in a particular directory on the FTP server and now you want to modify your integration project
to move the file from the FTP source directory to an FTP output directory.

8. In Studio, verify that the project updates are valid by using the Verify tab to run each affected
orchestration.

9. From the WMC, undeploy the original integration project.
10. Publish the modified integration project to the Integration Appliance.
11. From the WMC, deploy the modified integration project.
12. An event triggers an orchestration job to be created and to start processing the activities in the

orchestration.
13. From the WMC, verify that the integration project has run.

Parent topic: Development Environment
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Integration Appliance
The Integration Appliance is a rack-mountable appliance comprised of redundant and hot-swappable
components

Components that can be used in the Integration Appliance include network ports, hard-disk drives, RAM,
cooling fans, and other critical components, that ensures fault-tolerant operations.

Use the Web Management Console (WMC) and the Command Line Interface (CLI) to manage the Integration
Appliance.

Parent topic: Introduction
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Web Management Console
The Web Management Console (WMC) is a browser-based application hosted by the Integration Appliance
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The WMC can configure and monitor hardware, orchestration, and network status of an Integration Appliance,
using a Web browser.

System Administrators can use the WMC for the following monitoring tasks:

Obtaining Integration Appliance status information, such as memory-usage statics, disk-space statistics,
CPU status, fan status, and power-supply status.
Obtaining overall processing information at a glance, and then drill-down on specific orchestrations and
obtain comprehensive information about specific messages, activities, errors, and other details.
Viewing logs and error notifications.

In addition to the WMC, you can also use the Command Line Interface (CLI) to perform many administrative
and monitoring tasks. For more information on the CLI, see the Command Line Interface reference.

Parent topic: Introduction
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Studio
Studio is a development tool for designing and building integration projects.

In Studio, you build orchestrations that model business-process and data integration solutions. Studio provides
a palette of activities that you drag onto the Studio Workspace and then configure. During run time, these
activities perform actions, such as polling for a insert event in a database table. An orchestration is made up of
one or more activities. An integration project can contain one or more orchestrations.

You can design simple point-to-point orchestrations, as well as more complex orchestrations that involve
multiple endpoints, without writing any code.

After building an integration project, you publish it to an Integration Appliance.

Studio Layout

The main pane of Studio contains the following two sections:

Workspace
Visible on the left side of the main Studio pane. As you create components, such as Endpoints and flat
File Schemas, property panes for the component display in the Workspace. When you create a new
orchestration, a blank orchestration are displayed in the Workspace. You drag activities from the
Activities tab into the orchestration displayed in the Workspace. When you configure an activity of an
orchestration, the configuration panes of activity are also displayed in this Workspace.

Tabs
On the right side of the main Studio pane, the following tabs are available:

Project
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Activities
Variables
Functions
Verify

The Project tab
The Project tab contains folders for each component
The Activities tab
An activity performs a particular operation in an orchestration, and are organized into categories on the
activities tab
The Variables tab
The variables used in the current orchestration are listed in the Variables tab.
The Functions tab
The functions that you can add to a map between input and output parameters of an activity are listed in
the Functions tab.
The Verify tab
By simulating the DataPower® Cast Iron® Operating System, the Verify tab allows you to test
orchestrations within a project and resolve any issues before deploying the project to the Integration
Appliance.
Understanding nodes and mappings
The integration projects that you build using Studio are based on industry standards, including BPEL4WS
(business process execution language for Web Services), WSDL (web services description language), and
other XML based standards.
Understanding parameters
Parameters are values that are passed to activities from an orchestration, or to the orchestration from an
activity. The values from parameters are used to initialize the variables that comprise the orchestration.

Parent topic: Introduction
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The Project tab
The Project tab contains folders for each component

The following component folders can be accessed from the Project tab:

Orchestrations
Endpoints
Flat File Schemas
Stylesheets
Transformations
WSDLs
XML Schemas
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When you create new instances of a Project tab component, these instances display within the appropriate
component folder.

To create new instances of any of the components in the Project tab, right-click on the folder (e.g., Endpoint) to
display a menu and select the create option. The component is then created and displays under the
appropriate folder, and given a generic name: Orchestration, Orchestration1, and so on. You should rename all
components to something meaningful in the context of your integration project.

You can create these components in any order. To ensure that all components are available, create Flat File
Schemas, and upload XML Schemas, WSDLs, and Stylesheets before you start defining the orchestration.

Orchestrations
Orchestrations are the central component of any integration project. An orchestration contains a
sequence of activities that perform a specific business process. For example, an orchestration could get
a Flat File from a FTP Server, take the data from the Flat File, transform it, and then save the result into a
database. An integration project must contain at least one orchestration.

Endpoints
Endpoint components display in the Endpoint folder of the Project tab and specify the connection
information required to connect to the various external systems or endpoints. The Integration Appliance
supports connecting to Endpoints of many types including Email (SMTP, POP), FTP, SFTP, HTTP, HTTPS,
JDE, JMS, MQ, NetSuite, PeopleSoft, Salesforce.com, SAP, Siebel, Web Services, and many commercial
database systems.
Each type of endpoint has an associated configuration pane where you specify endpoint connection
information. For example for a database endpoint, you must provide a database name, server name,
user account, and password. You may, however, want to specify a different set of configuration
information when you move from a testing environment to the production environment. You can simplify
the process of moving from one set of connection information to another (for example: from one
database to another) by defining configuration properties (or name/ value pairs) in studio, to define the
configuration information.

Flat File Schemas
A Flat File Schema defines the parsing rules, content, and structure of a Flat File. Flat Files are any non-
XML text data, such as comma- and tab-delimited files and EDI or industry-specific textual formats,
such as the Health Level 7 (HL7) format for the health care industry.
In addition to supporting variable-length Flat File formats that use delimiters to distinguish one record
or field from another, studio also supports fixed-length records and fields such as the COBOL copy book
format. In studio using the Flat File Schema Editor, you can create definitions for either type of text file
and groups.

Stylesheets
An XSLT Stylesheet defines how to transform XML data from one format to another format. You can
upload a XSLT Stylesheet into studio and add an Apply XSLT activity to your orchestration that uses the
XSLT Stylesheet during run time.

Transformations
The Transformation folder contains standalone maps. A standalone map represents a set of one or more
mappings between source and destination nodes.
For example, you can create a standalone map called myMap that contains a set of mappings between a
source XML Schema called IncomingOrder and a destination XML Schema called ShippingOrder. A
standalone map can be used to create any number of Map Variables activities in the same orchestration
or in other orchestrations in the same project. You can create a Map Variables activity from a standalone
map by dragging the standalone map from the Transformations folder to an empty node on the
orchestration. A Map Variables activity based on the standalone map is created.
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WSDLs
A WSDL (Web Services Description Language) is an XML document that describes a Web Service. It
defines how to access a Web Service and the operations available for the Web Service.

XML Schemas
An XML Schema defines the content and structure of XML data. XML Schemas are typically stored in files
that end with the .xsd extension. Once you upload an XML Schema into a project, you can use that XML
Schema to create variables used in the activities of an orchestration.
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The Activities tab
An activity performs a particular operation in an orchestration, and are organized into categories on the
activities tab

Activities are organized into the following general categories:

Transform activities
Transform activities transform data from one format to another. For example, the Read Flat File activity
converts Flat File data to XML data. The transform activities are listed under the Transform folder of the
Activities tab.

Logic activities
Logic activities affect the processing flow of an orchestration, such as control-flow logic, branching, or
looping (for example: the For Each and the While Loop activities). The logic activities are listed under the
Logic folder of the Activities tab.

Utilities activities
Utilities activities are utilities that start or act on the current orchestration job (or instance of the
orchestration). The utilities activities are listed under the Utilities folder of the Activities tab.

Connector activities
Connector activities perform operations on the various external systems associated with the
orchestration. Connection-oriented activities are grouped into various folders named for the type of
system, such as Database, Email, FTP, HTTP, JMS, Salesforce.com, Siebel, MQ, SAP, and Web Services.

To use any activities, drag the activity icon from the Activities tab to the orchestration in the workspace. To
configure the specifics of an activity, click the icon in the orchestration. The configuration pane displays
underneath the orchestration.

The configuration pane includes an activity-specific Checklist to guide you through the configuration of each
activity. A key part of configuring most activities involves the mapping of input and output parameters.
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The Variables tab
The variables used in the current orchestration are listed in the Variables tab.

Variables are used in the context of a specific orchestration to bind data sources to an orchestration, and to
pass (or operate on) data values created as the result of orchestration processing. An orchestration's variables
are typically initialized by the parameters from the specific activities that make up the orchestration.

Variables can store primitive data, such as a string or integer value, or can represent an entire XML Schema or a
fragment of an XML Schema. In Studio, you can automatically create variables for the orchestration using the
Mapping Editor's Copy button. In the Variables tab of Studio, you can create a variable based on a fragment of
an XML Schema, by dragging a fragment (or sub-node) of an XML Schema from the Schema of pane, into the
Variables pane.

Parent topic: Studio

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.gettingstarted.doc/getstart_thevariablestab
.html

The Functions tab
The functions that you can add to a map between input and output parameters of an activity are listed in the
Functions tab.

You can add functions to the mappings between the input and output parameters of an activity to alter the data
flowing through the orchestrations. Using the functions available on the Function tab, you can complete the
following actions:

calculations
converting datatypes
re-formatting data
combining multiple data fields into a single field

10   



For the list of functions available with Studio and for reference information about each function including the
input and output parameters, see the Mapping Function Reference section of the Studio online help.

From the Functions tab, you drag the desired function onto the link between an input and output node of the
Mapping editor. If the functionality you need is not available in one of the standard Studio functions, you can
create your own custom functions. For more information, see the Mapping Custom Functions section of the
Studio online help.
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The Verify tab
By simulating the DataPower® Cast Iron® Operating System, the Verify tab allows you to test orchestrations
within a project and resolve any issues before deploying the project to the Integration Appliance.

When initiating a test run, you can start a single orchestration or all the orchestrations in a project. Studio runs
one orchestration job for each orchestration. You can start and stop orchestrations, and view orchestration
monitoring logs from the Studio toolbar or from the Verify tab.

If the orchestration is invalid, a message dialog displays possible resolutions. In the workspace, Studio
highlights each activity in the orchestration as the activity is processing the data. As Studio runs the
orchestration, the Verify tab provides orchestration job details such as activity name, processing status,
variable/parameter names, and variable/ parameter data in a tree view. If an error occurs, Studio highlights the
node where the error occurred. Clicking the node takes you to the location of the error, where you can resolve
any issues before running another instance of the orchestration.

When you click a node in the tree view, Studio displays in the Properties Pane the Checklist task that
corresponds to the node. For example, when you click an activity node, Studio displays the Configure panel for
the activity in the Properties Pane. When you click the Map Outputs node, Studio displays the Map Outputs
panel in the Properties Pane. If you click a mapping variable or parameter, the data displays in the
Variable/Parameter Message Data section of the Verify tab.

While Studio only runs one orchestration job for each orchestration, you can start the same orchestration
multiple times. The Verify tab displays the results for each run of the same orchestration under a separate
instance. For example, Instance #1 and Instance #2. You must allow an orchestration job to complete before
you can run another instance of the same orchestration.

Note: Studio does not persist the results of the runtime test. When you close the orchestration tab, you lose
runtime results for the orchestration.

Additional Requirements

Depending on the activities in the orchestration, Studio might require more input to run the orchestration job.
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For example, an orchestration with a database activity requires that you generate database assets before
running the orchestration in Studio, just as you must do in the WMC before running the orchestration on the
Integration Appliance. If the orchestration contains an HTTP Receive Request activity, you must post a
message to the specified URL. Studio provides an HTTP Post Utility to help you post a message. If the
orchestration contains an FTP Poll activity, you must place a file in the specified location before Studio can run
the orchestration. Studio prompts you for this information before it runs an orchestration.

Since the Verify tab allows you to simulate the runtime on the Integration Appliance, you can also specify
Kerberos Protocol settings in Studio to test the settings before actually deploying to the Integration Appliance.
Specifying these setting in Studio does not impact the runtime on the Integration Appliance. You must specify
the Kerberos Protocol settings in the WMC to allow the Integration Appliance to authenticate the server that
the Integration Appliance is communicating with. For more information about specifying Kerberos Protocol
settings for the Integration Appliance, see the WMC Online Help.

Navigating the Verify Tab Toolbar

The following table describes the Verify tab toolbar:
Table 1.

I
c
o
n Description

Starts the open orchestration. The orchestration must be valid before Studio can run an orchestration job.

Stops the running orchestration job immediately. Studio does not allow the orchestration job to complete
before stopping.

Starts all the valid orchestrations in the project that are not already running. If an orchestration is already
running when you click this icon, Studio does not rerun the orchestration.

Stops all running orchestration jobs immediately. Studio does not allow the orchestration jobs to complete
before stopping.

Displays orchestration monitoring data in a table or text format.

In the Workspace, highlights the activities in the execution path of the orchestration job, which allows you
can follow the logic Studio used to complete the orchestration job. Different instances can have a different
path depending on the inputs and orchestration logic. Click this icon to toggle between providing and not
providing a highlighted path.

Assigns the results from the selected instance to the Map Inputs and Map Outputs, so that when you run a
test from the Properties Pane, Studio populates the inputs and outputs with the results of the orchestration
job.

Deletes one or more selected instances from the orchestration details tree. To delete multiple instances
hold the Shift key or Ctrl key, select the instances you want to delete, and click the icon.

Expands all the nodes under the selected node in the orchestration details tree.

Collapses all the nodes under the selected node in the orchestration details tree.

Expands a single node under the selected node in the orchestration details tree.

Collapses a single node under the selected node in the orchestration details tree.

Parent topic: Studio
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Understanding nodes and mappings
The integration projects that you build using Studio are based on industry standards, including BPEL4WS
(business process execution language for Web Services), WSDL (web services description language), and other
XML based standards.

You do are not required to know the technical details of these standards to use the product. Nonetheless, as
you work with Studio, you are exposed to the XML content of your inputs and outputs. Since orchestrations
running on the Integration Appliance use, process, and deliver messages in an optimized XML format, all data
and its definition is presented as a hierarchy of nodes, as in an XML document.

For example, columns in a database table are represented as nodes. As another example, Flat File Schemas
are defined in Studio as a series of record, field, or group nodes in a tree structure that comprises a root node
containing descendents (children, grandchildren, etc).

There are two basic distinctions between node types in Studio:

Structure nodes are nodes that convey information about structure only. An example of a structure node
is a record definition (defined for a Flat File Schema). Structure nodes can contain other structure nodes,
and nodes that contain data.
Data nodes are nodes that can contain data.

In a typical complete node representation, the top node is often referred to as the root node—root in the sense
that it contains all other nodes. Subsequent nodes are descendent nodes comprised of both structure nodes
and data nodes.

A key part of designing an orchestration is specifying the mapping between nodes, that is, defining how nodes
and the data they contain should be used and transformed in the course of orchestration processing.

Several XML-specific characteristics can be associated with nodes; these characteristics are represented as an
additional icon adjacent to a node in a tree. These properties include:

Recurring - denotes that a node can repeat (either a specified number of times or an unbounded number
of times). Each time a recurring node repeats is an occurrence of the node.
Nillable - a boolean property that denotes whether the data node to which this property is associated
can have an attribute set to “nil” by the application. The nillable mechanism is defined by the XML
Schema recommendation as a way to identify non-required data elements that are empty vs. those that
convey a null data value.
Optional - denotes whether an optional node exists or not.

Studio activities contain embedded maps that you must configure at design time, in the context of an
orchestration, to define how actual parameters should map to variables, and how the variables should be
processed in the orchestration.

The characteristics and node structure of the node tree in the right pane of the mapping editor determines
whether a node from the left pane can be mapped to the right pane.

 13



Parent topic: Studio

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.gettingstarted.doc/getstart_understandingn
odesandmappings.html

Understanding parameters
Parameters are values that are passed to activities from an orchestration, or to the orchestration from an
activity. The values from parameters are used to initialize the variables that comprise the orchestration.

Parameters can be either input parameters or output parameters. Activities can either contain just input
parameters, just output parameters, or both.

You map variables of an orchestration to the input parameters of an activity in the Map Inputs task. During run
time, the values of the variables are passed into the input parameters of the activity and are used by the
activity. For example during run time, the FTP Put File activity creates a file using the name provided in the
input parameter called filename and with the data provided in the input parameter called data. The values for
the filename and data input parameters are populated by the data in variables in the orchestration.

Output parameters are return values from an activity. For example, the FTP Poll Directory activity passes three
output parameters to an orchestration, as shown in the following table, each of which can be used to initialize a
variable in the orchestration. Output parameters can be mapped from an activity to the orchestration.

Table 1.
Activity Parameter Description

FTP Poll Directory filename Name of the file obtained from the FTP server.

FTP Poll Directory data String containing the contents of the file.

FTP Poll Directory timestamp Timestamp on the file.
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Installation and configuration
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This topic discusses the installation and configuration steps you must complete before you build and run an
integration project.

Integration Appliance

The Integration Appliance is shipped with DataPower® Cast Iron® Operating System preinstalled. You must
however, set up and configure your Integration Appliance before publishing and deploying your integration
project to the Integration Appliance. Setup might include installing additional connector licenses. For more
information, see the Installation Guide. Once the Integration Appliance is set up, configured, and available to
the network, you can bring up the Web Management Console by entering the following URL into the address
field of a browser: https://hostname

Where hostname is the name of the Integration Appliance. This name was assigned to the Integration
Appliance during the installation process.

The Web Management Console opens to the Login screen in the browser window. The default login account and
password is admin/!n0r1t5@C
Note: The Web Management Console uses the default port 443.

You can also access the Integration Appliance through the Command Line Interface.

Studio

To start creating integration projects to run on the Integration Appliance, you must install Studio on a Windows
development workstation. Your Windows development workstation must meet some minimum hardware and
software requirements. For more information, see the Installation Guide.

Once you have Studio installed, you can log into the Solutions Repository and access a repository of template
integration projects (TIPs). Each TIP addresses a specific integration project scenario. For example, you can
find a TIP for integrating data from a Salesforce.com endpoint to a database endpoint. When you select a TIP
from the Solutions Repository and download the TIP to your workstation, a wizard opens and guides you
through the configuration steps.
Note: The Solutions Repository contains TIPs that have been certified, as well as uncertified TIPs. Anyone who
has access to the Solutions Repository can upload a TIP. For more information about creating, modifying, and
searching for TIPs, see the Studio online help.
Parent topic: Introduction
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Deployment concepts
Use Studio to create integration projects, which you deploy to the Cloud using the Management Console or
deploy to the Integration Appliance using the Web Management Console. A deployment of a project contains
all runtime components necessary to run the processing defined in the orchestrations of the project.
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With respect to deployment, there are two important concepts to keep in mind as you develop a project:

Publishing and Deploying are two distinct steps. Publishing is the act of promoting a project from Studio
to an integration environment (cloud or Integration Appliance) or to another intermediate location. A
project does not run in the integration environment until you deploy it.
Projects can have multiple configurations that support completely different environments (development,
test, production). Using Studio to create configuration properties for projects offers greater flexibility at
deployment time, because you can bind the properties to different environments.

The Integration Appliance provides the following two options for getting your projects from Studio to the
Integration Appliance:

Projects can be published directly to an Integration Appliance.
Projects can be exported from Studio to a staging location and then uploaded to an Integration
Appliance.

Whether you export from Studio and later upload to the Integration Appliance or publish directly to the
Integration Appliance from Studio, the project does not run on the Integration Appliance until you deploy.

About configurations
You publish a project to the Integration Appliance. The WMC then runs a configuration of the project.
Once you publish a project to an Integration Appliance, the WMC creates a default project configuration.
The default project configuration settings enable all orchestration in the project and allow you to quickly
deploy a project.
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About configurations
You publish a project to the Integration Appliance. The WMC then runs a configuration of the project. Once you
publish a project to an Integration Appliance, the WMC creates a default project configuration. The default
project configuration settings enable all orchestration in the project and allow you to quickly deploy a project.

You can create numerous configurations of the same project on your Integration Appliance. Each configuration
can connect to a different endpoint, if you have used configuration properties to specify the connection
information for the endpoint. For example, one configuration could connect to a test database while another
configuration connects a production database. Project configurations are created using the WMC, and by
default, are not deployed when they are created.

Publishing

Publishing is the process of bundling up a specific integration project (the named project in Studio) and
preparing the project for deployment on an Integration Appliance. When you publish a project, Studio creates a
runnable version of the project and sends it to the Integration Appliance that you specify.
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Exporting
Exporting is a process very similar to publishing in that it compresses your project, but instead of
pushing the result to the Integration Appliance, you give the file a name and save it for subsequent
uploading to the Integration Appliance. For example, this allows for additional testing by a quality
control team.

Uploading
Uploading is the process of moving a project that has been exported from Studio to the Integration
Appliance. A menu selection is available for this task in the WMC.

Deploying

Deploying is the process of instantiating all the runtime components necessary so that the Integration
Appliance can perform the actual integration. Deploying presumes that a project has been published or
uploaded to the Integration Appliance. Use the Web Management Console to deploy a project configuration.

Understanding configuration properties

Configuration Properties simplify the deployment process in moving from a development environment to a
production environment. Rather than hard-code configuration details into the endpoint properties, you can
create Configuration Properties, and then use these property names in the configuration pages of your
endpoints.

This is because endpoints created in Studio are configured with specific address information (hostname, IP
address) and other details (user account, password). These details may need to be changed at deployment for
the specifics of the actual environment in which the project will run (assuming that the development, test, and
production environments use different servers and systems).

At deployment , the values associated with the properties can be changed to the appropriate hostnames, IP
addresses etc.

For more information about creating configuration properties, see the Studio online help.

Parent topic: Deployment concepts
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Before developing your projects
This section provides information you should know before developing your own integration project.

Planning an Integration Project
When beginning the development process for an integration project you must define the integration
scenario before using Studio to translate the project requirements into an orchestration.
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Translating project requirements into Studio components
After identifying high-level goals for your integration project, you can start analyzing more specific
aspects of the integration project and identifying the Studio components that you can use to accomplish
your goals.
Integration appliance configuration tips
You might want to make the changes to your Integration Appliance configuration. This topic covers some
changing passwords, creating users and groups and optimal performance configuration.
Studio best practices
Some guidance for using Studio to its full potential.
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Planning an Integration Project
When beginning the development process for an integration project you must define the integration scenario
before using Studio to translate the project requirements into an orchestration.

Defining an integration scenario

When defining an integration scenario, specify a clear goal. With this goal in mind, identify the high level project
requirements:

Endpoints - From what source system and to what target system are you moving the data?
Formats - What is the format of the data from the source system? What data format does the target
system accept?
Transformation - If the source data and target data have different formats or structure, then what type of
data transformation is needed? Are there any special processing rules?

For example, if your goal is to consolidate multiple purchase orders and place the consolidated purchase order
into a supplier's database. High level project requirements might include the following details:

Endpoints - The source system is an FTP server. The target system is an Oracle database.
Formats - The source data is pulled from CVS flat files stored on the FTP server. The target database
requires data in table format.
Transformation - A flat file to table transformation is required. Also orders from locations that have sales
tax should be processed differently than orders from locations without sales tax.
Overall goal of the integration project. For example, combining a flat file purchase order with an XML
purchase order, into a singe large purchase order that is stored in the supplier's database.

For example, you want to consolidate multiple purchase orders, verify that they conform to a specific format,
and then:

A few Flat File sources need to be consolidated into a target XML file.
Files from one FTP site need to be moved to another.
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Translating project requirements into Studio components
After identifying high-level goals for your integration project, you can start analyzing more specific aspects of
the integration project and identifying the Studio components that you can use to accomplish your goals.

You can start by analyzing the following characteristics of your integration project:

From what source, or sources, do you want to obtain the data, and to what target do you want to
transmit the data? These sources and targets (databases, FTP servers, HTTP servers, Email, etc)
comprise the endpoints that are created as part of a project in Studio.
In what format is the source data, and in what format is the required target data? Text-based files,
including EDI formats, CSV, and other formats can be defined in Studio as a Flat File Schema that
converts the data into the appropriate format for the Integration Appliance. In addition, a Flat File
Schema can be used to produce data in a flat file format to be used outside of the Integration Appliance.
XML-based data can be included in an integration project by uploading the appropriate XML Schemas
(.xsd) or document type definitions (.dtd) to Studio.
Does the data format or structure need to change from source to target, and if so, how does it need to
change? Should some of the processing be based on the content itself?

Identifying these requirements provides the information needed to define (in Studio) one or more
orchestrations that comprises a set of activities, including transformations on data. Transformations convert
data from one format to another. For example converting Flat File data in a CSV (Comma Separated Values)
format to XML data. Transformations can also suppress data, add data, alter datatypes, and perform
calculations.
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Integration appliance configuration tips
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You might want to make the changes to your Integration Appliance configuration. This topic covers some
changing passwords, creating users and groups and optimal performance configuration.

Change the default password

Using the Web Management Console:

1. In the upper right corner of the WMC, click your username.
2. Select Change Password.
3. Enter the old and new passwords, and confirm the new password.
4. Click Save.

Using the Command Line Interface:

1. Use an SSH connection to log in to the CLI, by starting an application like PuTTY.
2. Enter the appliance-host-name.
3. If needed, select SSH as the connection protocol or set other connection parameters offered by the

application.
4. Initiate® the connection. The login prompt displays at first access.
5. Log in to the Integration Appliance using the default username and password [Username=admin,

Password = ! n0r1t5@C].
6. Run the following command: auth set user admin <old_password> <new_password>

Create users and groups, and define appropriate privileges.

As you would with any multi-user device, be sure to create users and groups and provide access to the
Integration Appliance using the rule of ‘least privilege,' that is, users should have no more privileges than
necessary to do their jobs. For more information about setting privileges, see the Web Management Console
online help.

Configure the Integration Appliance for optimal performance

For better performance, once an integration project has been deployed to production and runs as expected,
tune the following parameters:

For each orchestration, change the logging level from the All option to the Error Values option.
For each notification, set the Level exceeds field to the Critical option.
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Studio best practices
Some guidance for using Studio to its full potential.
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Establish naming conventions for your organization
Provide unique, meaningful names (meaningful in the context of the business problem being solved) for
all your Studio projects and related components—files, folders, projects, orchestrations, endpoints, and
so on. Names should be:

Unique - Studio is case sensitive: filename1, FILENAME1, and FileName1 are three different files.
However, do not rely on capitalization to distinguish among Studio projects, it can lead to
confusion.
Descriptive - For example, a project that integrates suppliers and an inventory system might be
called “SupplyChainIntegration.”

Back up projects frequently
In multi-user environments especially, be sure to back up projects frequently. You can quickly back up
all Studio project components by simply creating a compressed file of the contents in a specific project's
directory. Store the compressed file elsewhere, in a secure location. Ideally, in a version control system
that will let you also track project changes.

Store projects in a central location
Place all project files in a central location, preferably using version control software, so that projects are
easy to find and previous iterations are easy to recover (this is especially important if you have numerous
developers working on the same project).

Design orchestrations for optimal performance
When possible, preprocess as much input data using the native facilities of the source systems before
integrating. Transforming data outside the source system adds to the processing overhead. If
performance becomes an issue, investigate how you can minimize the use of the Map Activity in an
integration project's orchestration.
For example, if you are integrating data from several different database systems, consider creating
extract tables that preprocess the data, rather than trying to resolve all differences among disparate
data types in the orchestration.

Use Configuration Properties for endpoint definitions
Rather than hard-coding details in your project endpoints, you can use properties for some of the
details. You define these configuration properties in Studio and then use the Management Console to
specify various runtime values. Before deploying the project, you must configure the properties for the
actual endpoints in the production environment. For more details, see the online help.

Test activities and all definitions in Studio, as you design
As you use Studio to design all the elements of an orchestration, be sure to use test data wherever
appropriate to ensure that mappings work as expected. Before publishing a project, test all mappings
and flat-file schemas using Studio.

Set up development and test environments
Ideally, you should set up development and testing environments that mirror your production
environment, including replicating data sources and targets in the test environment.

Extract (or replicate) production data to your development and test environments.

Before deploying the project, you must configure the properties for the actual endpoints in the production
environment by changing the Configuration Properties. See the Management Console online help for details.

Parent topic: Before developing your projects
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Glossary
A glossary of terms

Activity
A complete, functional unit of processing within an orchestration. Activities include flow-control (logic)
activities; data activities to facilitate consumption and transmission of data; and activities that enable
integration with database systems, enterprise systems, Web servers, e-mail servers, and other systems.
An orchestration contains a series of activities.

Assets
Supplemental configuration files, scripts, or other materials associated with a specific activity. For
example, the buffer table scripts created for a database insert activity are assets. Assets are controlled
by the Web Management Console. Access privileges to assets can be given to users beyond the users of
the WMC. For example, DBAs can be given privileges to the assets associated with a database activity so
that they can create the required tables or triggers.

Buffer table
An auxiliary table used in conjunction with various Database Module Activities, such as the single-table
insert, update, or delete database activities. When you configure one of the database DML (data
manipulation language) activities, Studio generates a SQL script that can be used to create the
appropriate trigger on the database table; the buffer table gets populated when the triggering event
(INSERT, UPDATE, DELETE) occurs. The buffer table provides the means to capture database changes
and initiate processing by the orchestration.

Command-line interface
A text-based alternative to the Web Management Console for configuring, managing, and querying an
Integration Appliance.

Control table
A database table that facilitates using database endpoints in integrations. As it does with buffer tables,
Studio generates scripts to create control tables that can be used to ensure that inserts, updates, and
deletes to specific tables occur once and only once.

Deploy
Create an instance of a project configuration on an Integration Appliance.

Document
Any of the XML Schema files, DTDs, and other configuration files that comprise integration projects.

Dynamic delimiters
A delimiter that is obtained from within the fields of the message itself, such as an HL7 PID (patient ID)
message header that denotes the beginning of a new record in a file containing a batch of electronic
health records.

Empty placeholder
Appears in activities that have multiple branches as an initial placeholder for the activities in that
branch. Dropping other activities on this icon removes it.

Endpoint
Is an external system, such as a database server, FTP server, e-mail system, or enterprise application
that the Integration Appliance connects to either get data or return data during run time.

Flat file
A file containing non-XML data. Flat files are typically of two types: delimited, in which a comma, tab,
white space, or other delimiter is used to separate variable-length fields and records; or positional, in
which fields and records have a fixed width.

For each
A activity that iterates over a message structure where the data repeats.
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Flat File Schema
Defines how to interpret a specific set of Flat Files. Studio creates flat-file schema (XML Schema) based
on the configuration you define in the Message Definition pane. A flat-file schema is used in conjunction
with Read Flat File activity to convert a source flat-file into XML.

Function
String, mathematical, and miscellaneous functions provided by Studio that you can use in defining
processing in your orchestrations. In addition to the pre-built functions, Studio lets you build your own
custom functions and add lookup tables.

Integration project
The various inputs, outputs (endpoints), mapping and schema definitions (transformations, message
formats), orchestrations, and configuration information that comprise an integration solution as
designed in Studio and deployed to the Integration Appliance.

Job
A specific runtime instance of an orchestration.

Map
A component that lets you bind input parameters to variables, and variables to the orchestration. Many
Studio activities contain embedded maps that you must configure at design time, in the context of an
orchestration, to define how actual parameters should map to variables, and how the variables should
be processed in the orchestration. In addition to the embedded activity maps, Studio has a stand-alone
Map activity that can be used to bind any type of input and output to the orchestration.

Node
All data input to or output from the Integration Appliance is materialized in Studio as a series of nodes,
as in a tree-like, hierarchical structure. In many cases, the nodes represent the structure and content of
an XML document, but in many cases they don't (e.g., rows in a database table display as nodes). Nodes
in Studio convey information about structure; the type of content that can be supported; or additional
characteristics of the data.

Orchestration
The specific sequence of processing activities (such as data mapping, transformation, and control logic
activities), endpoints, and data types defined and configured using Studio and deployed to run on the
Integration Appliance.

Parameter
A value passed to an activity or to an orchestration. For example, filename and data are two of the
parameters that can be passed from an FTP endpoint to an orchestration.

Pick
An activity that determines what starter activity to launch based on the action that has occurred. For
example, a Pick activity could contain three branches, one that contains a Get Inserted Rows activity,
one that contains a Get Deleted Rows activity, and the other contains a Get Updated Rows activity. If an
UPDATE event occurs on the database, an instance of the orchestration is created and branch that
contains the Get Updated Rows activity is invoked.

Project
A project defined and created using Cast Iron® Studio. Each project has a properties file (filename.sp3)
and several additional metadata files and folders that comprise all integration elements - orchestrations,
endpoints, XML schemas, Flat Files - and their specific configuration (variables, parameters).

Publish
Copy all project files from Studio to an Integration Appliance or to an intermediate staging area, such as
a shared directory on a file server, for subsequent runtime configuration and deployment to a specific
environment. The Publish process encompasses validating the project; creating a .par file of project
configuration documents; and sending the package to the Integration Appliance specified.

Record identifier
A special field that delimits records in certain types of Flat Files, such as EDI (electronic data
interchange) or HL7 (Health Level 7) files. For example, an HL7 PID (patient ID) number is a record
identifier.

Repetition delimiters
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A delimiter in a Flat File that is used when the data lacks a unique value, such as record ID, to distinguish
one record from another.

Replace
Appears in Pick and other activity branches as an initial placeholder for the endpoint activity to receive a
message for that branch. Dropping a Receive endpoint Activity on this icon removes it.

Stored procedure
A functional code unit that resides in a database and is ran explicitly by invoking its name. Stored
procedures can be used to populate buffer tables when specific insert, update, or delete activities occur
on a particular database table.

Studio
An integrated development environment (IDE) for creating, configuring, and publishing integration
projects and the orchestrations they comprise. Studio projects run on the Cast Iron Integration
Appliance.

Terminate
Stops orchestration processing.

Transformation
Converting data from one format to another. For example converting Flat File data in a CSV (Comma
Separated Values) format to XML data. Transformations can also suppress data, add data, alter
datatypes, and perform calculations.

Trigger
A type of database stored procedure that is called implicitly when a triggering event occurs. In the
Database Module, a “triggering event” as an INSERT, UPDATE, or DELETE on a table.

Variable
Used to pass data values processed by an orchestration. Variables are used by maps to identify the
source and target. Some Activities create variables automatically.

While loop
Initiates and continually processes any children activities for as long as a specified condition is true.
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Notices
This information was developed for products and services offered in the U.S.A.

IBM® may not offer the products, services, or features discussed in this document in other countries. Consult
your local IBM representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM product,
program, or service may be used. Any functionally equivalent product, program, or service that does not
infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to
evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The
furnishing of this document does not grant you any license to these patents. You can send license inquiries, in
writing, to:

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY  10504-1785 
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law 
IBM Japan Ltd.
1623-14, 
Shimotsuruma, 
Yamato-shi
Kanagawa 
242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions
are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to
the information herein; these changes will be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time
without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the
materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring
any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of
information between independently created programs and other programs (including this one) and (ii) the
mutual use of the information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,
Hursley Park,
Winchester,
Hampshire,
England
SO21 2JN

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this information and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or any
equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results
obtained in other operating environments may vary significantly. Some measurements may have been made on
development-level systems and there is no guarantee that these measurements will be the same on generally
available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual
results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those products and cannot confirm the
accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examples include the names of individuals, companies, brands, and products. All of
these names are fictitious and any similarity to the names and addresses used by an actual business enterprise
is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any
form without payment to IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore,
cannot guarantee or imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as
follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright
IBM Corp. _enter the year or years_. All rights reserved.

Parent topic: Legal information
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IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines
Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of
IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark
information" at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States, and/or other countries.

Intel, Intel Inside (logos), MMX, and Pentium are trademarks of Intel Corporation in the United States, other
countries, or both.

Java™ and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names might be trademarks of IBM or other companies.

Privacy Policy Considerations

IBM Software products, including software as a service solutions, ("Software Offerings"�) may use cookies or
other technologies to collect product usage information, to help improve the end user experience, to tailor
interactions with the end user or for other purposes. In many cases no personally identifiable information is
collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally
identifiable information. If this Software Offering uses cookies to collect personally identifiable information,
specific information about this offering's use of cookies is set forth in the following paragraphs.

Depending upon the configurations deployed, this Software Offering may use session and persistent cookies
that collect each user’s session ID for purposes of session management, or functional purposes. These cookies
can be disabled, but disabling them will also eliminate the functionality they enable.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek your
own legal advice about any laws applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for these purposes, See IBM's
Privacy Policy at http://www.ibm.com/privacy and IBM's Online Privacy Statement at
http://www.ibm.com/privacy/details the section entitled "Cookies, Web Beacons and Other Technologies"� and
the "IBM Software Products and Software-as-a-Service Privacy Statement"� at
http://www.ibm.com/software/info/product-privacy.

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.gettingstarted.doc/notices.html

 27

http://www.ibm.com/legal/copytrade.shtml
http://www.ibm.com/privacy
http://www.ibm.com/privacy/details
http://www.ibm.com/software/info/product-privacy


Terms and conditions for information centers
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM® website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary
notices are preserved. You may not distribute, display or make derivative work of these publications, or any
portion thereof, without the express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all
proprietary notices are preserved. You may not make derivative works of these publications, or reproduce,
distribute or display these publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of the
publications is detrimental to its interest or, as determined by IBM, the above instructions are not being
properly followed.

You may not download, export or re-export this information except in full compliance with all applicable laws
and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS ARE
PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS
FOR A PARTICULAR PURPOSE.
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IBM® Cast Iron® Studio is a development tool that is used to design, test, and publish integration projects to an
IBM Cast Iron Integration Appliance. Studio provides numerous entities that you can drag into a workspace and
configure as part of one, or more, business-process orchestrations that comprise an integration project.

Before you start, read Studio basics to familiarize yourself with the Studio environment and the terminology
used, then refer to the topics in the help to find out how to complete specific tasks.

For detailed information about deploying your projects and working with them on the Integration Appliance,
see the Web Management console help.

For a conceptual overview of Studio, including a step-by-step sample of how to create, test, and publish a
project, see the Introduction to getting started section.

IBM Cast Iron Studio introduction pane

When you first launch Studio, the IBM Cast Iron Studio introduction pane is displayed. If Studio was closed
while editing an existing project, Studio automatically loads the last edited project. To edit the loaded project,
click an entity in the Project tab.

The following options are available from the IBM Cast Iron Studio introduction pane:

Create Project - Launches the New Studio Project dialog box. Use the New Studio Project dialog box to
create a new empty project with a default empty orchestration.
Open Project - Launches the Open dialog box. Use the Open dialog box to browse for and open an
existing project file. A Studio project file ends in the .sp3 extension.
Recent Project - To view a project that was recently opened, click directly on project name under the
Recent Projects folder.  
View Help - Launches the Studio help.
Find Solutions - Launches the Template Integration Projects (TIPs) Searching for Template Integration
Projects (TIPs) dialog box, which allows you to search for TIPs from the Cast Iron solutions repository.  
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Working with projects
This page is the starting point for finding information about working with projects using IBM® Cast Iron® Studio.

Studio basics
Studio provides an environment called a Workspace in which you can design and configure your
integration projects. The Toolbox is the area next to the Workspace where multiple tabs contain
components that you use to build an integration project; components such as endpoints, schemas,
orchestrations, style sheets, transformation, WSDLs, activities, variables, and functions.
Creating a new project
Each time you create a project, a project properties file is also created with the project name. These
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property files are used when you export or publish projects.
Protecting a project with a password
In Studio, you can protect a project by assigning a password to it.
Opening a Project
When you first launch Studio, the Project last worked on is opened by default. There are several ways to
open a different project.
Saving a Project
You can save a project using the Studio toolbar.
Renaming a Project
You can rename a project using the Studio toolbar.
Publishing a Project
When you publish a project, Studio connects to an Integration Appliance and directly updates the
Integration Appliance with the documents that make up the project. Publish a project when the project
is complete, has been validated, and has been tested in Studio. You cannot publish a project that has not
been successfully validated.
Exporting a Project
Export saves all the orchestrations, endpoints, schemas, and other items associated with the project,
into a single file that ends in the .par extension.
Configuring Project Settings
You can assign a unique version number to a project using the Project Settings dialog box.
Setting Preferences
You can specify Project, Orchestration, Flat File, SSL/Kerberos, Session Login, and XML Schema
preferences from the Preferences dialog box. You can change preferences at any time.
Creating Configuration Properties
Create configuration properties or name/value pairs in a project. Use configuration properties to supply
the default values for destination nodes of a map in the Mapping Editor.  
Editing Configuration Properties
You can edit configuration properties in Studio and in the Web Management Console (WMC).
Creating Global Configuration Properties
When a global configuration property is created, you can import the global configuration property into a
project as a project configuration property.
Searching for Template Integration Projects (TIPs)
Template Integration Projects (TIPs) are stored in the Cast Iron solutions repository. Through the
Configuration Wizard, TIPs guide you through the configuration steps for an integration scenario. TIPs
can be downloaded to your local machine. The login window is pre-populated with the User Name and
Password to make it easier for you to download the TIPs, without registration.
Installing Module Provider Libraries
Both IBM Cast Iron Studio and the Integration Appliance require library files (.jar and .dll) associated
with instances of certain connector types to be imported. For example, the following connectors require
additional libraries: Database Connector, JDE, JMS, MQ, PeopleSoft, and SAP. These files must be
present in Studio to enable configuration of the endpoints and orchestrations that use any of those
connectors.
Uploading Files into a Project
You can upload only specific types of files into a project. For example, if you plan on mapping a string to
XML data (valid to a particular XML Schema), you must first upload the XML Schema file (ends in the .xsd
extension) into the project before mapping the nodes in the XML Schema.
Uploading Included XML Schemas
An XML Schema or WSDL document can include other XML Schemas in the main document, using
Schema Inclusion, Schema Inclusion with Redefinition, or Importing a Namespace.
Specifying the Location of a File to Upload
Files can be uploaded into a project from a web location (HTTP or FTP Server) or from the local file
system.
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Valid External File Types for a Project
When building orchestrations, you can upload XML Schemas or other files into your project to complete
configuration tasks. External files are used in connection activities and orchestrations that use a
message that Studio cannot generate an XML schema for automatically. You must supply an XML
schema or DTD if the message must be transformed or if you need to define a job key for the message.
About Valid Names
To be valid, the names for projects, Endpoints, orchestrations, stylesheets, Flat File Schemas, XML
Schemas, WSDLs, and transformations must not exceed 42 characters and must not contain any of the
reserved characters or words.
Undo and Redo Operations
Studio stores up to the last 100 actions you make and you can undo and redo those actions. You can
undo and redo an action that you take on the fields in the UI, orchestration views, Mapping Editor,
project tree, configuration properties, and variable panel activities.
Updating a Changed XML Schema
If you created a project that uses an XML Schema and the XML Schema changes, you can attempt to
update the existing XML Schema with the new XML Schema.
Using the Project Explorer
The Project Explorer dialog box list the set of entities of the current type, that have been already defined
for the project.
Using the HTTP Post Utility
This utility provides a simple HTTP client interface that enables you to post messages/requests to HTTP
servers, which is useful for orchestrations that have an HTTP Receive Request activity as the starter
activity.
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Studio basics
Studio provides an environment called a Workspace in which you can design and configure your integration
projects. The Toolbox is the area next to the Workspace where multiple tabs contain components that you use
to build an integration project; components such as endpoints, schemas, orchestrations, style sheets,
transformation, WSDLs, activities, variables, and functions.

Toolbar icons

Directly under the Studio toolbar menu options are the following Studio toolbar icons:

New Project:  Create Project

Open Project:  Opening a Project

Save Project:  Saving a Project

Close Project:  seeSaving a Project

 31



Undo:  Allows you to undo previous actions.

Redo:  Allows you to redo previously undone actions.

Cut:  Removes an entity and saves a copy of the entity in the clipboard that can be used later by a
paste action. For example, from an orchestration you can remove and store an activity to the clipboard.
For more information, see Working with activities in an orchestration

Copy:  Saves a copy of the selected entity into the clipboard that can be used later by a paste action.

Paste:  Copy the stored entity from the clipboard.

Delete:  Removes the entity. The activity is not saved in the clipboard.

Validate Project:  Validates all the orchestrations in the project. If an orchestration is invalid the
invalid orchestration icon  is displayed next to the orchestration in the Project tab. If the orchestration
is invalid, click the orchestration to view the errors in the Validation Results window.

Publish Project:  Opens the Publishing a Project dialog box. From the Publish Project dialog box, you
can publish a project to an Integration Appliance

Export Project:  Opens the Save dialog box. From the Save dialog box, you can save all the
orchestrations, endpoints, schemas, and other objects associated with the project, into a single file that
ends in the .par extension.
Project Documentation Generation: Generates and saves project documentation as an HTML file.

Preferences:  Opens the Preferences dialog box. You can specify Project, Orchestration, Flat File
Properties, SSL/Kerberos, Session Login, and XML Schema preferences from the Preferences dialog box.

Help:  Opens the Studio help. You can also connect to the WebSphere Cast Iron Community by
selecting the option from the main Help menu.

Orchestrations and the Workspace

When you select an orchestration a tab view of the selected entities is displayed in the upper half of the
Workspace. For example, if you double-click an orchestration in the Project tab, a graphic view of the
orchestration is displayed as a tab. An orchestration or workflow contains the logical flow of your integration.
Drag-and-drop activities from the Activity tab onto the orchestration to visually define the logical flow of your
integration. For a list of other entities configurable from the top half of the Workspace, see the Project tab.

The lower half of the Workspace is where you define or configure the activities you added to the orchestration.
It is referred to by different names, depending on what you are doing at the time. If you are creating a map, this
area is called the Mapping Editor. If you are configuring endpoints or configuring an activity, it is referred to as
the Properties pane.

Toolbox tabs

The Toolbox comprises five sideways-oriented tabs: Project, Activities, Variables, Functions, and Verify.
Note: You can make the Toolbox larger or smaller by moving the invisible slider between the Workspace and
the Toolbox.

Project tab

The Project tab contains folders that store the basic entities that make up any integration project. These folders
are initially empty. The Project tab contains the following folders:

Endpoints
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Specifies the connection information required to connect to the various external systems. The
Integration Appliance supports connecting to endpoints of many types including FTP, SFTP, HTTP,
HTTPS, Email (SMTP, POP), SAP, MQ, Web Services, and many commercial database systems.

Flat File Schemas
Defines the content and structure of a Flat File. Flat Files are any non-XML text data, such as comma and
tab-delimited files and EDI or industry-specific textual formats, such as the Health Level 7 (HL7) format
for the healthcare industry.

Orchestrations
Contains a sequence of activities that performs a specific business process. Orchestrations are the
central entity of any integration project.

Stylesheets
Defines how to transform XML data from one format to another. You can upload an XSLT Stylesheet into
Studio and add an Apply XSLT activity to your orchestration that starts the XSLT Stylesheet during run
time.

Transformations
Contains stand-alone maps that represents a set of one or more mappings between source and
destination nodes.

WSDLs
A WSDL is an XML document that describes a Web Service. It defines how to access a Web Service and
the operations available for the Web Service.

XML Schemas
Defines the content and structure of XML data. XML Schemas are typically stored in files that end with
the .xsd extension. When you upload an XML Schema into a project, you can use that XML Schema to
create variables used by the activities of an orchestration.

In addition, the following icons are provided:

New Orchestration:  Click to create an Orchestration.
New Endpoint:  Click to create an Endpoint.
New Flat File Schema:  Click to create a new Flat File Schema.
New Standalone Map:  Click to create a Standalone map.

Add Document:  Click to upload a file into the current project.

Revalidate Project:  Click to validate the orchestrations in the current project.

To view the entities that make up the Project tab as a list view:

1. Select Edit > Preferences from the Studio toolbar menu. The Preferences dialog box displays.
2. Select the Show the entities of the Project tab as a list check box.

To view and configure an existing entity in the Project tab, open an entity choose from one of the following
options:

Double-click the entity in the Project tab
Select the entity in the Project tab and press Return.

The properties of the entity show in the Properties pane. Clicking an orchestration in the Project tab, validates
the orchestration. If the orchestration is invalid, the orchestration warning icon is displayed , and the
Validation Results window opens next to the Project tab. Click the error message in the window to open the
appropriate panel to fix the error.

To rename or delete an entity in the Project tab, right-click the entity and from the list select Rename or Delete.

To copy and paste an entity in the Project tab:
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1. Select an entity in one of the folders in the Project tab.
2. To copy the entity, enter the key sequence:  CTRL+C.
3. To paste the entity, enter the key sequence: CTRL+V. A copy of the entity displays in the Project tab.

To view the entities of the Project tab as a list, select the Show entities of the Project tab as a list check box in
the Preferences pane of Studio. For more information, see Setting Preferences.

When the Project tab opens, a Dependencies pane shows by default in the Project tab. Selecting an entity in the
Project tab shows the entities that are directly dependent on this entity in the project, which entities in the
project would be incomplete if this entity was removed.

For example, if you had FTP endpoint that was used by the FTP Poll Directory and FTP Put File activities of the
BatchOrder orchestration, clicking the FTP endpoint in the Project tab, displays the BatchOrder orchestration in
the Dependencies pane because the endpoint is used by the orchestration. If you deleted the FTP endpoint,
the BatchOrder orchestration would be incomplete. If you select the BatchOrder orchestration, you would not
see the FTP endpoint listed in the Dependencies pane because you can delete the BatchOrder orchestration
without affecting the FTP endpoint.

By default, the Dependencies pane appears underneath the Project tab. You can hide the Dependencies pane,
by clearing the Show dependant project nodes check box for the Project in the Preferences pane. To view the
preferences for a project, select Edit > Preferences from the toolbar menu and then select Project in the left
pane. The preferences for the project display.

Activities tab

An activity performs a specific operation in an orchestration. Activities are organized into the following general
categories on the Activities tab:

Transform
Logic
Utilities
Archives
Cryptoservice
Database
Data Quality
Domino
Email
Force.com Bulk API
FTP
HTTP
JDE
JMS
MQ
NetSuite
PeopleSoft
SAP
Salesforce.com
ServiceMax
Siebel
STS
Web Services
Workday

Variables tab
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Variables are tools for orchestrations. They are used to bind data sources to orchestrations and pass or operate
on data values as they pass through the orchestration. The Variables tab provides an area where you can create
and edit variables.

Functions tab

Functions are tools used in the Mapping Editor. Use the tools to specify how to transform data as it passes
through an orchestration. If the functions provided in the Functions tab do not meet your needs, you can create
your own custom functions.

Memory usage and garbage collection

If the Show memory usage in status bar option is selected in the Preference dialog box, a memory bar and
trash can icon is displayed as shown in the following figure. This memory bar displays how much memory is
currently used by Studio, compared to the total memory that is currently allocated to Studio (520 MBytes) from
the Operating System, as shown in Figure 1:

Figure 1. Memory usage

To request that Studio attempt garbage collection, reclaiming any unused memory inside of Studio, click the
trash can icon located to the right of the memory bar. Clicking the garbage collection trash can icon might
reduce the amount of memory Studio is currently using internally, potentially increasing the performance of
Studio when working with a large project. Clicking the garbage collection trash can does not reduce the
memory used by Studio from the operating system, the size of this memory remains constant to the 520
MBytes size initially allocated to Studio.

Entity tabs

To manage the Entities tabs: in the upper half of the Workspace, the entities selected from Project tab are
displayed as tabs (for example: Orchestrations and Endpoints). You can manage these tabs by right-clicking a
tab and selecting the appropriate action from the menu:

Close: Close the tab that you right-clicked on to open the menu.
Close Other Tabs: Close all the open entity tabs except the entity tab that you right-clicked to open the
menu.
Close All Tabs: Closes all the entity tabs currently open.
Close All But Current Tab: Close all the open entity tabs except the entity tab that is currently selected.

To navigate to hidden entity tabs, when many entitles have been opened from the Project tab, the hidden tabs
icon  is displayed as shown in Figure 2.
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Figure 2. Hidden Tab

To access the hidden entity tabs, click the hidden tabs icon . A list of all the currently opened tabs is
displayed. Select one of the tabs from the menu.
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Creating a new project
Each time you create a project, a project properties file is also created with the project name. These property
files are used when you export or publish projects.

Procedure

1. Select File > New Project
2. Enter CTRL+N, or click the New Project toolbar icon The New Studio Project dialog box is displayed.
3. Enter a name in the Project Name field. The name of the project cannot be longer than 42 characters and

cannot contain any reserved characters or words.  For the list of reserved characters and words see
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About Valid Names.
4. In the Project Directory field, click [...], to browse for the folder in which to save the project. The Open

dialog box is displayed
5. Select a folder and click Open.
6. Click OK.
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Protecting a project with a password
In Studio, you can protect a project by assigning a password to it.

Before you begin

This password does not protect a project that has been exported from Studio or published to an Integration
Appliance. This password is not used by the Integration Appliance.

Procedure

1. Select Project > Permissions > Protect from the Studio toolbar menu. The Enter Project Password dialog
box is displayed.

2. In the Enter Password field, enter a valid password. Passwords must be 4-15 characters in length and
contain at least one letter and one number. Once a valid password is entered, the message displayed at
the end of the dialog box changes from Enter password to Confirm password.

3. In the Confirm Password field, enter the same password. The message displayed at the end of the dialog
box changes from Passwords do not match to Passwords match when the correct password is
entered in the Confirm password field.

4. Click OK.

Results

The project is now protected with a password.

What to do next

Note: Studio does not store passwords. If you forget the password for the project and Studio does not currently
have that project open, you must rebuild the project. If the project is still open, you can change the current
password as described in the following topics.

Changing a password associated with a project
If a project is protected with a password, it can be changed from the Studio toolbar menu
Removing a password associated with a project
If a project is protected with a password, it can be removed from the Studio toolbar menu
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Changing a password associated with a project
If a project is protected with a password, it can be changed from the Studio toolbar menu

About this task

The option to change the password is only available if the project has already been protected with a password.

Procedure

1. Select Project > Permissions > Change Password from the Studio toolbar menu. The Enter Project
Password dialog box displays.

2. In the Old Password field, enter the existing password assigned to the project.
3. In the New Password field, enter a new valid password. Passwords must be 4-15 characters in length

and contain at least one letter and one number. Once a valid password is entered, the error changes
from Invalid password selected to Passwords do not match.

4. In the Confirm Password field, enter the same new password. Once the same password has been
entered in the Confirm Password field, the message displayed in the dialog box changes from
Passwords do not match to Passwords match.

5. Click OK.

Results

The project password has been changed.
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Removing a password associated with a project
If a project is protected with a password, it can be removed from the Studio toolbar menu
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About this task

The option to remove the password is only available if the project has already been protected with a password.

Procedure

1. Select Project > Permissions > Unprotect from the Studio toolbar menu. The Enter Project Password
dialog box displays.

2. In the Password field, enter the existing password assigned to the project.
3. Click OK.

Results

The project is no longer protected by password.
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Opening a Project
When you first launch Studio, the Project last worked on is opened by default. There are several ways to open a
different project.

About this task

The following steps explain how to open a project using the menu toolbar. You can have only one project open
at a time.

Procedure

1. Select File > Open Project , or select the Open Project  toolbar icon.
2. Navigate to the location of the project you want to open.
3. Select the project to open. Either:

Select a project file that ends in the .sp3 extension and click Open.
To view a project that was recently opened, select File > Reopen Projects > OldProjectName,
where OldProjectName is the name of the recently opened project.

If the project is secure, you must enter a valid password to open it.

What to do next

You can also open a project using the Studio Introduction pane or by using the keyboard.

Using the Studio Introduction pane, click Open Project to display the Open dialog box
Using the keyboard, use CTRL+o to select a project file that ends in the .sp3 extension
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Saving a Project
You can save a project using the Studio toolbar.

About this task

To save a project to the file system using the default project name, choose one of the following options:

SelectFile > Save Project from the Studio toolbar
Press CTRL+S
Click the Save Project toolbar icon 

Procedure

1. Choose one from one of the following options:
Select File > Save As from the Studio toolbar
Press CTRL+A

The Save As dialog box displays.
2. In the Project Name field, enter the new name of the project.
3. Optional: By default, the project is saved into the directory location specified by the Default Create Path

field of the Preferences dialog box. To specify a different directory location, click Browse.
4. Click OK.

Results

The Saving Project progress dialog box displays as the current project is saved using the new name. The new
project is saved into a directory on the local file system and the new project is opened and displays in the
Project tab. The original project remains unchanged since the last time it was saved to the local file system

What to do next

To close the current project, choose from one of the following options:

SelectFile > Close Project from the Studio toolbar.
Click the Close Project toolbar icon .
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Renaming a Project
You can rename a project using the Studio toolbar.

Procedure

1. Choose one from one of the following options:
Select File > Rename Project from the Studio toolbar
Press CTRL+R

The Rename Project dialog box displays.
2. In the Project Name field, enter the new name of the project.
3. Optional: By default, the renamed project is saved into the directory location specified by the Default

Create Path field of the Preferences dialog box. To specify a different directory location, click Browse.
4. Click OK.

Results

If the project was changed since the last save, the current project is saved before the project is renamed.

The Saving Project progress dialog box displays as the current project is renamed and saved into a directory on
the local file system using the new name. The current project with the new name is opened and displays in the
Project tab. The original project with the old name no longer exists on the local file system.

What to do next

To close the current project, choose from one of the following options:

SelectFile > Close Project from the Studio toolbar.
Click the Close Project toolbar icon .
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Publishing a Project

 41



When you publish a project, Studio connects to an Integration Appliance and directly updates the Integration
Appliance with the documents that make up the project. Publish a project when the project is complete, has
been validated, and has been tested in Studio. You cannot publish a project that has not been successfully
validated.

About this task

You can publish multiple projects to the Integration Appliance.

Note: If you attempt to publish a project from Studio to the Integration Appliance and a project of the same
name already exists on the Integration Appliance, whether the project gets published depends on the status of
the project on the Integration Appliance:

If any of the orchestrations in the project have been deployed on the Integration Appliance, the new
project does not get updated on the Integration Appliance.
If all the orchestrations in the project have been removed from the Integration Appliance, the new
project from Studio overrides the existing project of the same name on the Integration Appliance.

As an alternative to publishing a project, you can choose to export a project. Exporting is typically used for
publishing projects to production environments where administrators need to control the timing and impact of
the deployment. For more information about exporting, see Exporting a Project.
Note: To publish a project, Studio relies on the supported SSL and TLS protocols enabled in the SSL/Kerberos -
Preferences window. You can select the TLSv2 or TLSv1.2 protocol. The default is TLSv2.

Procedure

1. Select File > Publish Project or the Publish Project toolbar button.  The Publish Project dialog box
displays.

2. In the Host name field, enter the host name or the IP address of the Integration Appliance you want to
publish the project to. This is the host name for the management interface (mgmt).

3. Enter the User Name and Password for the Web Management Console (WMC) account for this
Integration Appliance. The default account name is admin and the default password is !n0r1t5@C.

4. Optional: To specify that the project documents are to be sent over HTTPS to the Integration Appliance,
select the Security check box.

5. Click OK. Studio connects to the Integration Appliance and updates the Integration Appliance with the
documents that make up the project.

6. When the publish is confirmed, click OK.

Parent topic: Working with projects

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/basics_Publishing_a_Project.html

Exporting a Project
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Export saves all the orchestrations, endpoints, schemas, and other items associated with the project, into a
single file that ends in the .par extension.

About this task

Exporting is typically used for publishing projects to production environments where administrators need to
control the timing and impact of the deployment. When a project is exported to a PAR file (in Studio), an
administrator can use the Web Management Console (WMC) to upload the project to the Integration Appliance.
This two-step process (exporting to a PAR file and uploading a project using the WMC) is equivalent to
publishing a project directly from Studio to an Integration Appliance.

Procedure

1. Select File > Export Project from the toolbar menu or select the Export Project toolbar button . The
Save dialog box displays.

2. Navigate to the directory where you want to save the exported project.
3. Optional: Change the name of the exported file. Keep the .par extension.
4. Click Save.

If successfully exported, a project file shows in the specified directory. The file name is the same
as the current name of the project with a .par extension. For example, if you export a project
named MySimpleProject, the project is saved in the MySimpleProject.par file. A dialog box displays
indicating that the export process was successful.
If there are problems with the project it is not exported; the Exporting Results dialog box displays
with a list of problems that must be corrected before the project can be successfully exported.

5. Click OK.

What to do next

For more information about exporting a project into the Integration Appliance using the WMC, see the WMC
online help.
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Configuring Project Settings
You can assign a unique version number to a project using the Project Settings dialog box.

About this task

When you publish a project to the Integration Appliance, the version number associated with the project is
visible in the Web Management Console (WMC). By changing the version number in the Version field, you can
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publish different versions of a project, even if the project itself hasn't changed. The different versions of the
project are listed separately in the WMC and can be deployed individually.

Procedure

1. Select Project > Project Settings from the menu toolbar. The Project Settings dialog box displays.
2. Enter a version number in the Version field.
3. Enter a description of the project in the Description field.
4. Enter any comments for the project in the Comments field
5. Click OK.
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Setting Preferences
You can specify Project, Orchestration, Flat File, SSL/Kerberos, Session Login, and XML Schema preferences
from the Preferences dialog box. You can change preferences at any time.

Procedure

1. Select Edit > Preferences option from the toolbar. The Preferences dialog box opens.
2. In the left pane, select the type of preferences to change:

Appearance
Project
Orchestration
Flat File
SSL/Kerberos
Session Login
XML Schema
Current Project

3. Specify, select, or clear preferences in the dialog box.
4. Click OK.

Results

The tables in the following topics describe the Appearance, Project, Orchestration, Flat File, SSL/Kerberos,
Session Login, and XML Schema preferences available from the Preferences dialog box.

Using the Appearance preferences you can change the application display and font.

Project Preferences
Project preferences can be set using the Preferences dialog box.
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Orchestration Preferences
Orchestration preferences can be set using the Preferences dialog box.
Other Preferences
Appearance, Flat File, SSL/Kerberos, Session Login, XML Schema, and Current® Project preferences can
all be set using the Preferences dialog box.
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Project Preferences
Project preferences can be set using the Preferences dialog box.

Table 1.
Button or Option
Label Description

Open editor
automatically for
new
orchestrations

If this check box is selected, when you create an orchestration the orchestration is
automatically displayed in the main Studio pane.
If this check box is cleared, when you create an orchestration the orchestration is
not automatically displayed in the main Studio pane.

Reopen the last
project when
studio starts

If this check box is selected, the last project opened in Studio is opened again
when Studio is restarted.
If this check box is cleared, no project is opened when Studio is restarted.

Always overwrite
existing projects

If this check box is selected, when creating a project with the same name as an
existing project already saved in the default directory, the new project is created,
overriding the existing project and no warning dialog box is displayed.
If this check box is cleared, when creating a project with the same name as an
existing project already saved in the default directory, a warning dialog box is
displayed asking if you want to override an existing project.

Always ask to
save project
before closing

If this check box is selected, when a project is closed, a dialog box asking if you
want to save the project is displayed even if no changes have been made to the
project.
If this check box is cleared, when a project is closed and no changes have been
made to the project, a dialog box is not displayed asking if you want to save the
project.
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Button or Option
Label Description

Show dependant
project nodes

If this check box is selected, the Dependencies pane is displayed underneath the
Project tab. For more information see Dependencies Pane in the Project tab.
If this check box is cleared, the Dependencies pane is not displayed underneath
the Project tab.

Show memory
usage in status
bar

If this check box is selected, a memory bar displays underneath the 4 sideways-
oriented tabs: Project, Activities, Variables, and Functions. For more information
see Memory usage and garbage collection.
If this check box is cleared, a memory bar does not display underneath the four
sideways-oriented tabs: Project, Activities, Variables, and Functions. For more
information see Memory usage and garbage collection.

Show the entities
of the Project tab
as a list

If this check box is selected, the entities in Project tab display as a list.
If this check box is cleared, the entities in Project tab are grouped in folders.

Clear Recent
Projects

Click Clear Recent Projects to clear the cache of projects you have recently opened and
listed when the File > Reopen Project toolbar menu option is selected.

Default Create
Path

Click Browse... to select the default directory path where new projects are saved.
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Orchestration Preferences
Orchestration preferences can be set using the Preferences dialog box.

Table 1.
Button or
Option Label Description
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Button or
Option Label Description

By Default
Animate
Orchestration
Views

This is a global option that determines the behavior for all orchestrations. By default, this
option is selected and all actions that occur in the Studio Workspace are animated.

Clear this option, to turn off workspace animation. When this option is clear and you
perform action in the Workspace, such as adding an activity, the Workspace snaps into
place.

You can override this option at the individual orchestration level, using the Animate Graph
orchestration view icon. However, if the global option is modified after you set the option
for an individual orchestration, the global change overrides any individual orchestration
setting you previously set.

Use Old
Orchestration
View  

Select this option to view an orchestration as it would display in Studio 3.X. When you
select this option, Studio 4.X orchestration view improvements are no longer available. For
a complete list of 4.X orchestration view improvements, see the Studio Release Notes®.

Maximum Job
Instances to be
displayed

Determines the maximum number of jobs that can display in the Verify tab. For example, if
you specify 2, the status of two jobs display: instance #1 and instance #2. If you run the
orchestration again, the Verify tab displays: instance #2 and instance #3.

Show Activity ID When you select this option, ID numbers display in the activities of an orchestration.

Enforce Strict
Validation for
Reply activities

By default, this option is selected. If you clear this option, Studio allows more than two
Reply activities on the execution path. Reply activities include: Web Services Send Reply,
Web Services Send Reply with Fault, and HTTP Send Response.

WS Provide-
Generate WSDL
compatible with
3.6.x version

Typically, when you upgrade projects that contain Web Services Provide Service activities,
the Studio generates a WSDL with a new namespace. Select this option so that Studio
keeps the 3.6X WSDLs instead.

If you select this option, Studio does not generate WSDLs with the most current
namespaces.

CDK Log
Enable/Disable

Select this option to view CDK Connector activity log (or flow) in the Verify pane.
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Other Preferences
Appearance, Flat File, SSL/Kerberos, Session Login, XML Schema, and Current® Project preferences can all be
set using the Preferences dialog box.

Table 1. Appearance Preferences
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Button or
Option Label Description
Button or
Option Label Description

Application

Use native
application
frame

Indicates that if you select this check box, the look and feel of the operating system will be
applied to the application window.

Use Color
Scheme

Indicates the color schemes available to customize your application display. This option is
available only if the Use native application frame options is not selected.

Font

User Interface Lists the font types available to change the font of the user interface. The Reset button
allows you to set the default font.

Data Fields Lists the font types available to change the font of the data fields. The Reset button allows
you to set the default font.

Table 2. Flat File Preferences
Button or
Option Label Description

Maximum
Preview Size
of Sample File
(in KBytes)

When testing a Flat File Schema, this field specifies how many KBytes of data is displayed in
the source pane - the left side of the Test tab. This field is useful when you have a large
source data file and you need to only view the top portion of the file to design the Flat File
Schema.

This field does not affect the size of the file that is transformed when you click the Test icon in
the Test tab. The entire source data file is transformed if the Maximum Size of Sample File (in
KBytes) field is set to a large enough size to load the entire file.

Maximum Size
of Sample File
(in KBytes)

When testing a Flat File Schema, this field limits the size in KBytes of the test data that is
loaded into Studio for testing a Flat File Schema. The maximum supported sample data size
is 2000 KBytes. If you specify a value greater than 2000 KBytes in this field, Studio resets the
value to 2000 KBytes.

Table 3. SSL/Kerberos Preferences
Button
or
Option
Label

Description

Kerberos
Realm

Specifies the Kerberos realm.

Kerberos
Server
Name

Specifies the Kerberos server name.

KeyStore
Passwor
d

Provides the password to access the keystore.

KeyStore
Path

Specifies the path to the local Java™ keystore.
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Button
or
Option
Label

Description

TrustStor
e
Passwor
d

Provides the password to access the truststore.

TrustStor
e Path

Specifies the path to the local Java truststore.

SSL
Protocol

Use the drop-down menu to specify the SSL Protocol. TLSv2 is the default and enables all SSL and
TLS protocols (including TLSv1.2) for SSL negotiation. TLSv1.2 enables the SSL communication
using the TLSv1.2 protocol only.

Table 4. Session Login Preferences
Button or Check Box Label Description

Username Studio uses this user name to log in to the Cast Iron® TIPs repository.

Password Studio uses this password to log in to the Cast Iron TIPs repository.

URL Specifies the URL to the Cast Iron Service Login.
Note: Do not modify the default value.

Host Name Specifies a proxy host if you choose to use one.

Port The proxy server port. By default, 8080.

Table 5. XML Schema Preferences. The following preferences determine the number of child
levels, which Studio allocates and displays, for each XML Schema (including WSDLs) in the

currently opened project.
Button or
Check Box
Label

Description

Number of
child node
levels
allocated in
memory for
the schema  

Specifies the number of child node levels that are allocated in memory for the XML Schema.
The number of child nodes allocated in the internal tree that stores the metadata of the XML
Schema in Studio.
Note: Specifying a large number of child node levels can adversely affect the performance of
Studio. The recommended value for this preference is 6.

Number of
recursive node
levels

Specifies the number of recursive node levels allowed and graphically displayed.  
Note: Specifying a large number of recursive node levels can adversely affect the
performance of Studio. The recommended value for this preference is 3.

Number of
child node
levels that are
initially
expanded
when a
schema is
displayed
graphically

Specifies the number of child node levels that are initially expanded when an XML Schema is
displayed graphically.  For example if this limit was set to 6 in the preferences and a variable
was selected for the From Orchestration pane of the Map Inputs task contained 8 node levels
(input/po/purchase/widgetId/price/discount/special/december), only the first 6 levels
(input/po/purchase/widgetId/price/discount) would be displayed in the Map Inputs task. You
can expand a child node manually, by clicking the + sign next to the unexpanded child node.

Note: Specifying a large number of child node levels can adversely affect the performance of
Studio. The recommended value for this preference is 4.
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Button or
Check Box
Label

Description

Number of
child node
levels
allocated in
memory for
the
substituted
types of
schema

Specifies the number of child node levels that are allocated in memory for the substituted
types of XML Schema. The number of child nodes allocated in the internal tree that stores
the metadata of the substituted types of XML Schema in Studio. The default value is 10. The
minimum value is 4.
Note: Lowering this value decreases the memory requirement for child node levels in Studio.

Note: A word about memory consumption: Studio allocates memory for each variable or parameter displayed
in the Variables or Mapper panes and generates metadata in a tree structure with each node containing
information about a specific element/complexType. Because elements or complex types have references to
themselves, the tree depth of those elements can exceed ten levels, resulting in OutOfMemory errors. To avoid
this, use the XML Schema preference parameters to improve memory consumption. For example, you can use
the Number of recursive node levels function to limit how many times a self-referring node is added to the tree
structure. Additionally, you can use the Number of child node levels allocated in memory for the schema
function to control tree depth and prevent Studio from exceeding a certain limit.

Table 6. Current Project Preferences. The following preference determines whether the
password is encrypted or not for the current opened project.

Check Box
Label

Description

Backwards
compatibility
with pre-4.5
projects is not
required

When checked, encrypts the password upon publishing. This is the default starting with the
Cast Iron 4.5 release. Before the 4.5 release, passwords were symmetrically encoded. If you
plan to have the current project send the password to pre-4.5 projects, clear the check box.
This avoids errors when the password is consumed by pre-4.5 projects.
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Creating Configuration Properties
Create configuration properties or name/value pairs in a project. Use configuration properties to supply the
default values for destination nodes of a map in the Mapping Editor.  

About this task

When you add configuration properties to the project, using the Project > Configuration Properties option of the
Studio toolbar menu, you can choose from these properties to supply the values for some of the fields in
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endpoints and default values for destination nodes in maps.

For example, if you created a configuration property named myDatabaseName of String type in Studio. While

configuring your database endpoint, click the Database Name field and the   icon displays on the right side

of field because at least one configuration property of String type was previously created. Click the  icon
and select the myDatabaseName configuration property from the menu. The Database Name for the endpoint
is supplied by the myDatabaseName configuration property during both design time (in Studio) and run time
(on the Integration Appliance). A configuration property can be of type String or Password.

A destination node of a map is located in the right pane of the Mapping Editor. For more information, see
Assigning a Default Value for a Destination Node.

You can create configuration properties in the Configuration Properties dialog box or use the quick create
method.

To create configuration properties using the Configuration Properties dialog box:

Procedure

1. Open a Project.
2. Select Project > Configuration Properties from the toolbar menu. The Configuration Properties dialog box

displays.
3. In the Add Name field, enter the name of the property you want to create.
4. From the Type list, select either String or Password.
5. Click Create. The new property name and type display in the properties list.
6. Click in the Value column for the newly created property.
7. Enter a value for the property; if it is of type password, the value is masked.
8. Press Enter or click out of the Value table cell to stop editing.
9. Continue adding additional properties as required. When finished, click OK.

Example

Instead of creating configuration properties in the Configuration Properties dialog box, you can use the quick
create option to define configuration properties directly from a text field in Studio. Fields that are enabled for
the quick create option display a small green globe in the lower-right corner.

You can change the values of the configuration properties using the Web Management Console (WMC), like the
configuration properties created in the Configuration Properties dialog box, after publishing a project.

Updating the value of the configuration property in the WMC does not affect the original value of the
configuration property, that you defined in Studio.

To create configuration properties using the quick create option:

1. In an Enabled field, click the green globe. The Create Configuration Property window is displayed.
2. In the text field, enter a name for this property.
3. Click Create to save the entry as a reusable property.

The property displays in the current text field, the  icon is replaced by the green globe, and the property is
saved in the Configuration Properties dialog box.
Parent topic: Working with projects
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Editing Configuration Properties
You can edit configuration properties in Studio and in the Web Management Console (WMC).

About this task

Editing Configuration Properties in Studio
You can edit specific information for an existing property by opening the Configuration Properties dialog
box and double-clicking the entry. This does not include changing the type. If you make a change and
click OK, all of the applications of that property are updated automatically. You cannot delete properties
that are in use in an orchestration. You can delete only unused properties or properties that you have
removed from active orchestrations.

Editing Configuration Properties in the WMC
When the project is published to the Integration Appliance, you can change the values of the
configuration properties using the WMC. For example, you can create configuration properties in Studio
that stores the following database connection information for a database endpoint: hostname, IP
address, username, and password. You can then publish the project to the Integration Appliance, deploy
the project, and test against a development database. When testing is complete, you might want to
connect to a different database; for example, your production database. Using the WMC, you can update
the values of the configuration properties in the project on the Integration Appliance to point to the
production database.

Results

Changes you make to configuration properties in a project configuration using the WMC are independent of
values you specified for the configuration property in Studio. When you create project configuration properties
in Studio and publish the project to the WMC, the WMC displays a Default project configuration. In this project
configuration, and any project configuration you generate from the published project, you can use the WMC to
modify the configuration property values you specified in Studio before publishing the project.

If you undeploy the project, update the configuration property values using Studio, and publish the project to
the WMC again. The existing project configurations do not reflect the changes. To see the changes you just
made to the configuration properties (using Studio), you must use the WMC to create a project configuration.
This new project configuration displays the configuration property values you specified for the project in Studio.

What to do next

For more information, see "Enhancing the Simple Project" in the Getting Started Guide.

Parent topic: Working with projects
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Creating Global Configuration Properties
When a global configuration property is created, you can import the global configuration property into a project
as a project configuration property.

About this task

You can use global properties to supply the values for fields in endpoints or for default values for destination
nodes in maps. Create global configuration properties in Studio using the Edit > Manage Global Configuration
Properties option of the Studio toolbar menu. For example, create a global configuration property named
dbPassWord of the type Password in Studio, then create a configuration property in your project by importing
dbPassWord.

A global configuration property can be of type String or Password.

Procedure

1. In Studio, click Edit > Manage Global Configuration Properties.
2. Under the Global Property Lists pane, click New. The New Global Properties dialog displays.
3. Enter a name for the new global configuration property list and click OK. You can create one or more

global configuration properties for each list.
4. Enter a name for the global configuration property that you want to create.
5. Select either String or Password from the Type list. If you select Password, the value is masked.
6. Click Create.
7. In the Value field, enter the value you want for the property.
8. Click OK. If you want to add more properties to the list, repeat steps 4 through 8.

What to do next

Import project properties into a global properties list by clicking Import, select the project property you want
to make global, and click Add.

To delete a global property from a global property list, select the property and click Delete.
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Searching for Template Integration Projects (TIPs)
Template Integration Projects (TIPs) are stored in the Cast Iron® solutions repository. Through the
Configuration Wizard, TIPs guide you through the configuration steps for an integration scenario. TIPs can be
downloaded to your local machine. The login window is pre-populated with the User Name and Password to
make it easier for you to download the TIPs, without registration.

Procedure

1. From the Solutions menu, select Search For TIPs. The Login window is displayed with the pre-populated
User Name and Password. These credentials have the access privilege only to download TIPs.
Note: You can also log on by clicking the Login link present on the right-hand side, near the memory bar.

2. If you already have the credentials to log on, specify the user name and password. You can specify
default login settings for the central repository in the Preferences dialog.

3. Click OK. The Search window is displayed and a confirmation message displays at the end of the main
Studio window.

4. In the Search window, choose Keywords, Filter, or My TIPs as the method by which you want to search
for TIPs.

If you select the Keywords search option, the Keywords field is displayed.
a. Enter a search keyword.
b. Click Go. The results are displayed in the Results table and a "Searching ... completed"

message is displayed at the end of the Search window. For example, if you enter the
keyword USECASES, all TIPs under the USECASES category in the Cast Iron solutions
repository are returned.

If you select Filter search option, the filter options: Source Endpoint, Target Endpoint, Integration
Patterns, and Searchable Keywords are displayed.

a. You must specify a value for at least one filter option. The options lists provide valid values.
b. Click Query. The results are displayed in the Results table and a "Searching ... completed"

message is displayed at the end of the Search window.
If you select My TIPs, all TIPs that you have created are displayed in the Results table.

5. In the Results table, select a TIP. The details for the project are displayed in the details section.
6. Optional: You can rate the TIP that you have selected.

a. Click the Edit Review link. The Publish Review window is displayed.
b. Move the slider until the appropriate number of stars are highlighted. Rate the TIP on a scale

between 1-5, 5 being the highest rating.
c. In the My Title field, add a brief description for your review.
d. In the My Summary field, add more details about your review of the project.
e. Click OK. Studio submits the review to the Cast Iron solutions repository.

7. In the Search window, click Download. The Select directory where to save the TIP window is displayed.
8. Specify the download directory and click Open. The project is saved to the directory you specified and

Studio opens the Configuration Wizard for the project.

Parent topic: Working with projects
Parent topic: Template Integration Process (TIPs)
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Installing Module Provider Libraries
Both IBM® Cast Iron® Studio and the Integration Appliance require library files (.jar and .dll) associated with
instances of certain connector types to be imported. For example, the following connectors require additional
libraries: Database Connector, JDE, JMS, MQ, PeopleSoft, and SAP. These files must be present in Studio to
enable configuration of the endpoints and orchestrations that use any of those connectors.

About this task

For information about installing the required library files on the Integration Appliance using Web Management
Console, see the WMC Online Help.

You need access to the connector-specific library files, either on your Studio workstation or through the
network.

Procedure

1. With Studio open, select Tools > Install Module Providers. The Add Provider(s) dialog box displays.
2. Click the plus button under the relevant provider name. A text entry field and a browse button display to

the right.
3. Click Browse, and use the browse dialog box to locate and select the files. Press the CTRL or SHIFT key

to select more than one file.
4. Click Open to import the file contents. The library files display in the Add Provider(s) dialog box.
5. Click OK. When a library is installed or removed you are prompted to shut down Cast Iron Studio to apply

the changes.
6. To apply the changes, click Yes then manually restart Cast Iron Studio. The library files are installed and

you can proceed with your endpoint configurations. To return to the Add Provider(s) dialog box without
applying the changes, click No.
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Uploading Files into a Project
You can upload only specific types of files into a project. For example, if you plan on mapping a string to XML
data (valid to a particular XML Schema), you must first upload the XML Schema file (ends in the .xsd extension)
into the project before mapping the nodes in the XML Schema.
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About this task

See Valid External File Types for a Project for a complete list of valid external file types.

There are three ways to upload a file from the file system into a project:

Upload files into a project by dragging a file into the Project tab
Upload files into a project by right-clicking the appropriate folder in the Project tab
Upload files into a project by clicking Add Document in the Project tab

The following procedure describes how to upload files into a project by dragging a file into the Project tab.

Procedure

1. Select a file from a Windows folder in the local file system and drag into the Project tab.
If file is a supported file type and ends in the correct extension, a node displays under the
appropriate folder in the Project tab with a default name. For example, if you dragged an XML
Schema file called PurchaseOrder.xsd from the file system to the Project tab, a new node called
PurchaseOrder shows in the XML Schemas folder of the Project tab. For a list of supported file
types see Valid External File Types for a Project.
If the uploaded file is an XML Schema or WSDL that includes other XML Schemas, the Uploading
Included XML Schemas dialog box automatically displays. For more information, see Uploading
Included XML Schemas.

2. Optional: Change the default name.
3. Press Return.

Uploading Files into a Project using the Mouse
There are three ways to upload a file from the file system into a project, this procedure describes how to
upload files into a project by right-clicking the appropriate folder in the Project tab.
Uploading Files into a Project using the Add Document Button
There are three ways to upload a file from the file system into a project, this procedure describes how to
upload files into a project by clicking the Add Document button in the Project tab.
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Uploading Files into a Project using the Mouse
There are three ways to upload a file from the file system into a project, this procedure describes how to upload
files into a project by right-clicking the appropriate folder in the Project tab.

Procedure
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1. In the Project tab, right-click the appropriate folder for the type of file you are uploading, and select Add
Document from the list.  For example, if you are uploading an XML Schema file, select the XML Schemas
folder in the Project tab. The Add Document dialog box displays.

2. In the Location field, specify the location of the file from an external web location or from the file
system.

3. Optional: In the Name field, enter the name for the entity that you want to display in Studio. The name
you enter must not exceed 42 characters, and must not contain any reserved characters. For a list of
reserved characters see About Valid Names.

4. Click OK.

Results

If the uploaded file is an XML Schema or WSDL that includes other XML Schemas, the Uploading Included XML
Schemas dialog box automatically displays. For more information, see Uploading Included XML Schemas.

The file is uploaded into the project.
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Uploading Files into a Project using the Add Document Button
There are three ways to upload a file from the file system into a project, this procedure describes how to upload
files into a project by clicking the Add Document button in the Project tab.

Procedure

1. In the Project tab, click Add Document . The Add Document dialog box displays.
2. In the Location field, specify the location of the file from an external web location or from the file

system.
3. Optional: In the Name field, enter the name for the entity that you want to display in Studio. The name

you enter must not exceed 42 characters, and must not contain any reserved characters. For a list of
reserved characters see About Valid Names.

4. Click OK.

Results

If the uploaded file is an XML Schema or WSDL that includes other XML Schemas, the Uploading Included XML
Schemas dialog box automatically displays. For more information, see Uploading Included XML Schemas.

The file is uploaded into the project.

Parent topic: Uploading Files into a Project
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Uploading Included XML Schemas
An XML Schema or WSDL document can include other XML Schemas in the main document, using Schema
Inclusion, Schema Inclusion with Redefinition, or Importing a Namespace.

About this task

Schema Inclusion
You can include other XML Schema fragments into the main XML Schema or WSDL using the include
element as shown by the following example: <xsd:include schemaLocation="myTypes.xsd"/>

Schema Inclusion with Redefinition
The XML Schema specification supports redefining definitions included by other XML Schema fragments
in the current XML Schema or WSDL. For example, the myTypes.xsd XML Schema fragment defines a
complex type called PurchaseOrderType. Another XML Schema called PurchaseOrder.xsd includes the
myTypes.xsd XML Schema fragment using the redefine element and redefines the complex type called
PurchaseOrderType.
You can include other XML Schema fragments into the main XML Schema or WSDL using the redefine
element as shown in the following example: <xsd:redefine schemaLocation="myTypes.xsd"/>

Importing a Namespace
You can include a namespace into the current document using the import element as shown in the
following example: <xs:import namespace="http://acme.com/ns/example
schemaLocation="mySchema.xsd" /> .

When you add or upload the main XML Schema or WSDL to the project using the Add Document dialog box, you
are prompted to locate any included XML Schema or XML Schemas into the project, as shown in the following
procedure. All the included XML Schemas must be located before the main XML Schema or WSDL document
shows in the Project tab and can be used in the project.

Procedure

1. Upload an XML Schema or WSDL document into the current project. If the XML Schema or WSDL
document includes other XML Schemas, the Uploading Included XML Schemas dialog box displays
listing all the included XML Schemas as shown in Figure 1.
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Figure 1. Uploading Included XML Schemas

If the included XML Schema is automatically located, the checkmark icon  displays next to the XML
Schema in the Uploading Included XML Schemas dialog box as shown for the commonTypes.xsd XML
Schema in the preceding figure. If the main XML Schema or WSDL was located on the local file system,
Studio looks for the included XML Schemas in the same directory and automatically locates them; for
example, if you uploaded mySchema.xsd from the C:\temp directory and mySchema.xsd includes the
commonTypes.xsd XML Schema, Studio automatically locates the commonTypes.xsd XML Schema in
the C:\temp directory. If the included XML Schema is not automatically located, the warning icon 
displays next to the XML Schema in the Uploading Included XML Schemas dialog box as shown for the
poTypes.xsd XML Schema in Figure 1.

2. Repeat the following steps to locate all the unlocated XML Schemas:
a. Select the XML Schema in the Uploading Included XML Schemas dialog box. The XML Schema is

highlighted in the table as shown in Figure 2.
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Figure 2. Upload an XML Schema

b. Click Locate.   The Locate the Selected XML Schema dialog box is displayed.
c. In the Location field, specify the location of the included XML Schema from an external web

location or from the file system.
d. Click OK.   If the XML Schema is located, the checkmark icon  displays next to the XML Schema

in the Uploading Included XML Schemas dialog box.
3. By default, the Store all the includes in the same project node as the main document check box is

selected. When this check box is selected, the included XML Schemas and the main XML Schema or
WSDL are uploaded as a single project node. When this check box is cleared, all the included XML
Schemas and the main XML Schema or WSDL are all displayed separately in the Project tab. A
checkmark icon shows next to every listed XML Schema indicating that all the included XML Schemas
have been located.

4. Click OK.

Example

If the Store all the includes in the same project node as the main document check box is selected, only the
main XML Schema or WSDL displays in the Project tab as shown in Figure 3.
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Figure 3. Example

With the check box selected, the included XML Schemas are still uploaded into the project but are not
displayed in the Project tab, so you cannot individually update these XML Schemas in the project as described
in Uploading Included XML Schemas.

If the Store all the includes in the same project node as the main document check box is cleared, the main XML
Schema or WSDL displays and all the included XML Schemas are uploaded in the project and show in the
Project tab as shown in Figure 4.

Figure 4. Example
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With the check box cleared, all the included XML Schemas can be individually updated as described in
Uploading Included XML Schemas.

Note: If possible, always load the main XML Schema or WSDL with this check box selected (as one project
node) to reduce potential dependency conflicts between XML Schemas. For example, if you upload the main
myTypes.xsd file into the project with the Store all the includes in the same project node as the main document
check box cleared, the following XSD files are also uploaded and show in the Project tab:

commonTypes.xsd
poTypes.xsd

If you created and uploaded a third XSD file called myTypesTwo.xsd that also included and used the types
defined in the commonTypes.xsd file, and you then changed the names of the types defined in the
commonTypes.xsd and used in myTypes.xsd outside of Studio and uploaded new versions these files, the
myTypesTwo.xsd file in the project still refers to the original names of the types and is now invalid.
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Specifying the Location of a File to Upload
Files can be uploaded into a project from a web location (HTTP or FTP Server) or from the local file system.

Procedure

1. To specify a location for the file from the local file system, choose from one of the following options:
Click Browse to browse for the file, and click Open.
In the Location field, enter the URI of the file on the local file system, for example:
file:/C:/temp/mySchema.xsd

2. To specify a location for the file from an external web location (FTP or HTTP Server), in the Location field
enter the URI of the file using any of the following format descriptions:

http://[username:password@]hostname[:portNumber]/location
https://[username:password@]hostname[:portNumber]/location
ftp://[username:password@]hostname[:portNumber]/location

The preceding format descriptions contain the following representations:
brackets [] - represent optional parameters and should not be included in the URI
username - specifies the user name to connect to the HTTP or FTP server
password - specifies the password of the specified user name to connect to the HTTP or FTP
server
portNumber - specifies the port number to use to connect to the HTTP or FTP server
location - specifies the URL path to find the file. The URL must include the name of the file as
shown in the following example.
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Example

To upload the mySchema.xsd file from the acme.com FTP server in the /input directory using the username bob
with a password of snippy1, specify the following sting in the Location field:

ftp://bob:snippy1@acme.com/input/mySchema.xsd
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Valid External File Types for a Project
When building orchestrations, you can upload XML Schemas or other files into your project to complete
configuration tasks. External files are used in connection activities and orchestrations that use a message that
Studio cannot generate an XML schema for automatically. You must supply an XML schema or DTD if the
message must be transformed or if you need to define a job key for the message.

The types of files that you can upload into a project and the file extensions they are required to include:

Table 1.

Type

File
Exte
nsio
n Description

XML DTD *.dtd XML Document Type Definitions (DTDs) define XML message formats using a non-XML
syntax. Studio automatically converts DTDs to XML Schemas when you load them into a
project.

Web
Services
Definition
Language

*.ws
dl

An XML document that defines the W3C Web Services Definition Language. Studio uses
WSDLs to describe all messages in integration transactions.

XML
Schema

*.xs
d

A definition of an XML message format using the W3C XML Schema language. Studio uses
XML Schemas to describe all messages in integration transactions.

Note: Only global elements are shown as schema types in Studio. A global element is an
immediate child of the schema element. If the schema file contains no global elements,
then the schema will appear to be empty in Studio.

Parent topic: Working with projects
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About Valid Names
To be valid, the names for projects, Endpoints, orchestrations, stylesheets, Flat File Schemas, XML Schemas,
WSDLs, and transformations must not exceed 42 characters and must not contain any of the reserved
characters or words.

Reserved characters or words are listed in the following tables.

The names of activities must not exceed 30 characters and must not contain any of the reserved characters
listed in the table provided in Table 3.

Table 1. Reserved Characters
Reserved Characters Description

& ampersand

{ } [ ] < >  any brackets

* asterisk

\ backslash

^ caret

: colon

$ dollar sign

/ forward slash

# number sign

() parenthesis

| pipe

. period

? question mark

; semicolon

  space

~ tilde

Table 2. Reserved Words
for Windows

Reserved Words for Windows

AUX

COM1
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Reserved Words for Windows

COM2

COM3

COM4

CON

LPT1

LPT2

LPT3

PRN

NUL

Table 3. Reserved Characters
For Activity Names.

The names of activities must not
exceed 30 characters and must
not contain any of the reserved

characters listed in the following
table:

Reserved Characters Description

& ampersand

{} [ ] < >   any brackets

* asterisk

\ backslash

: colon

$ dollar sign

/ forward slash

| pipe

. period

? question mark

; semicolon

~ tilde
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Undo and Redo Operations
Studio stores up to the last 100 actions you make and you can undo and redo those actions. You can undo and
redo an action that you take on the fields in the UI, orchestration views, Mapping Editor, project tree,
configuration properties, and variable panel activities.

Before you begin

Note: When you close Studio, the history of actions you have taken is cleared and you cannot undo or redo
actions that occurred prior to you closing Studio.

Procedure

1. Select the Edit menu.
2. Select Undo, to undo the last action.
3. Select Redo, to redo the last action.

Results

You can also undo and redo actions using the following keyboard shortcuts:

Ctrl + Z: Undo last action
Ctrl + Y: Redo last action
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Updating a Changed XML Schema
If you created a project that uses an XML Schema and the XML Schema changes, you can attempt to update the
existing XML Schema with the new XML Schema.

About this task

Updating to a new XML Schema means that any of the project entities that interface with the XML Schema
might be affected by the change. The following project entities can be affect by XML Schema change:

Maps that refer to the XML Schema, both stand-alone maps and the inline maps in activities.
Variables that refer to the XML Schema.
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XPath expressions in orchestrations.
XPath expressions used in job keys.
Some Endpoint configurations.
Conditions defined in orchestrations.

During the update process, Studio reports which project entities are affected by the change before the change
is committed.

For example, an XML Schema defines an input parameter to the Map Variables activity. In the From
Orchestration pane of the Map Variables activity there are links between the nodes of the input parameter to
the nodes of the output parameters. When the XML Schema that defines the input parameter is updated to the
new XML Schema, those links might no longer be valid if the input nodes have been renamed or removed in the
new XML Schema. You must recreate the links in order for the orchestration to be valid again.

In some cases, Studio completely prevents the uploading a new XML Schema for the following reasons:

The new XML Schema is invalid.
Uploading the new XML Schema to replace the existing one, would result in an invalid project.

Note: Updating an existing XML Schema (as described in the following procedure) is different from loading
multiple XML Schemas into a project by either dragging a file into the Project tab or right-clicking on the XML
Schemas folder in the Project tab and selecting Add Document. Updating an existing XML Schema replaces the
existing XML Schema in the project while uploading the same file into the Project tab creates two instances of
the XML Schema in the project.

Procedure

1. Open the XML Schema that is already used in the project that is to be replaced by the new XML Schema.
Open the graphical representation:

a. Open the Project tab and double-click the XML Schema in the XML Schemas directory. The nodes
of the XML Schema display in the XML Schema tab.

b. In the XML Schema tab, click any node of the XML Schema.
2. Select a new XML Schema to replace the existing XML Schema, using one of the following options:

In the graphic representation, you can drag an XML Schema file from the local file system onto
the XML Schema open in the XML Schema tab.
Select the File > Update option on the Studio toolbar menu. The Update the Current Schema
Document dialog box displays. In the Location field, specify the location of the new XML Schema
from an external web location or from the file system.

3. Click OK. The Updating the XML Schema Affects the Listed Dependant Project Entities dialog box
displays and any project entities that are possibly affected by the replacement of the original XML
Schema with the new XML Schema are listed.

4. Optional: In the dialog box, click any of the listed dependent entities to view the affected entity in
Studio.

5. Click Update. Studio attempts to update the project with the new XML Schema and the result of the
attempted update depends on the following conditions:

If any of the changes in the XML Schema would result in a corrupted project after the update or
the new XML Schema is invalid, an Error dialog box displays describing the problem with the XML
Schema. Click OK. The update is canceled, the XML Schema reverts to the original XML Schema,
and the project is not changed.
If the changes to the XML Schema would not result in a corrupted project and the XML Schema is
valid, the update occurs and the original XML Schema is replaced by the new XML Schema. Some
of the project entities might be invalid after the update and might require clean up. For example,
links in the Map Inputs and Map Outputs panes might need to be recreated after the update. To
find the validation errors, open an orchestration and select Orchestration > Validate from the
Studio toolbar menu.
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6. Click Close.
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Using the Project Explorer
The Project Explorer dialog box list the set of entities of the current type, that have been already defined for the
project.

Procedure

1. Select an item.
2. Click OK.
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Using the HTTP Post Utility
This utility provides a simple HTTP client interface that enables you to post messages/requests to HTTP
servers, which is useful for orchestrations that have an HTTP Receive Request activity as the starter activity.

About this task

To use this utility. either Studio or the Integration Appliance must be a web server capable of receiving
messages from any http client interface.

Procedure

1. From the Windows Start menu, choose Programs > IBM > Cast Iron Studio > HTTP Post Utility. A web
browser opens and displays the Post a Document page.
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Note: If you are using the HTTP Post Utility with Internet Explorer 8, you must click the Information Bar
and select Allow Blocked Content to avoid duplicate forms being displayed.

2. In the URL of Inbound Connector field, specify the hostname of the HTTP server, followed by the HTTP
path.

3. In the Document to Post field, you have two options:
Click Browse and open an existing file.
Enter the message into the text field.

4. Click Submit to post the message.
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Orchestrations
Configuring an orchestration to orchestration connection
You can configure a Web Service endpoint to call another Web Service orchestration stored in the
Integration Appliance, in the same project.
Creating an orchestration
There are three steps to creating a completed orchestration: Create the new orchestration, rename the
orchestration, and build the orchestration.
Renaming an orchestration
Orchestrations are given default names when they are created. You can rename it from the Project tab.
Building an orchestration
Studio provides visual cues in the workspace so that it is easier to see and control the placement of
activities in an orchestration. When you drag-and-drop activities from the Studio Toolbox to the
workspace, a green circle icon displays the target location in the orchestration where the activity is to be
placed. When adding activities to the branches of logic activities, Studio highlights the target branch.
Verifying orchestrations
Studio can simulate the Cast Iron® operating system (CIOS) runtime so that you can to test
orchestrations within a project and resolve any issues before deploying the project to the Integration
Appliance.
Using SSL in Studio
The Secure Sockets Layer (SSL) is the standard security technology for establishing an encrypted link
between a server and a client. The encrypted link ensures that all data passed between the server and
clients remain private and unchanged. To create an SSL connection a server requires an SSL certificate.
This section provides an overview of using SSL in Studio, discusses Transport Layer Security (TLS) and
SSL security, discusses certificates and supplies the procedures you need to properly import Certificate
Authority (CA) and end-entity certificates and private keys for use when verifying SSL client
authentication.
Importing an end-entity certificate
An end-entity certificate is a digitally-signed statement issued by a Certificate Authority to a person or
system. It binds a public key to some identifying information and is used for encryption, authentication,
digital signatures and other purposes. The term “end-entity” is used to distinguish it from a Certificate
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Authority certificate. The signer of the statement is the issuer and the entity discussed in the certificate
is the subject.
Importing a Certification Authority (CA) Certificate
Abbreviated as CA, a Certification Authority is a trusted third-party organization or company that issues
certificates used to create digital signatures and public-private key pairs. Because they guarantee that
the two parties exchanging information are really who they claim to be, CA's are a critical component in
data security and electronic commerce. Although the relationship between CA's is most commonly
hierarchical, CA certificates can also be used to establish trust relationships between CA's in two
different public key infrastructure (PKI) hierarchies. A PKI is the set of people, policies, procedures,
hardware, and software used in creating, distributing, managing and using digital IDs. In all of these
cases, the CA certificate is critical to defining the certificate path and usage restrictions for all end-entity
certificates issued for use in the PKI.
SSL server authentication
SSL server authentication verifies that sites you communicate with are who they claim to be.
Authentication confirms a server's identity through standard techniques of public-key cryptography to
ensure that a server's certificate and public ID are valid and have been issued by a certificate authority
listed in the client's list of trusted CA's.
Testing an SSL server connection
After creating an endpoint for the server using SSL, you are ready to test the SSL server connection.
SSL client authentication
Client authentication is similar to server authentication except that the server requests a certificate from
the client to verify that the client is who it claims to be. The certificate must be an X.509 certificate and
signed by a certificate authority trusted by the server. You can only use client authentication when a
server requests a certificate from a client. Not all servers support client authentication.
Using the Log Viewer
Orchestration monitoring data is displayed in the Log Viewer in a table or text format.
Viewing an orchestration
You can use orchestration view icons on the workspace, and View options from the Studio toolbar menu
to manipulate your orchestration view in the workspace.
Validating an orchestration
An orchestration must be valid (complete and correct) before you can publish it to the Integration
Appliance. Use the validation feature in Studio to validate your orchestration.
Working with activities in an orchestration
You can cut, copy, and paste activities, drag activities in an orchestration and add and delete new
activities.
Printing an orchestration
You can print an orchestration directly or view a print preview of an orchestration.
Processing orchestration jobs sequentially
You can use the Process Orchestration Jobs Sequentially option when an orchestration contains
activities that can conflict with each other when multiple instances of the orchestration are running. An
instance of an orchestration is also known as an orchestration job.
Enabling persistence
The Orchestration pane contains an Enable Persistence check box that by default is selected. The
setting of the Enable Persistence check box affects the way orchestration jobs are restarted after a
failure.
Adding a global exception handler to an orchestration
During run time if any of the activities of the orchestration throws an exception, and a global exception
handler has been enabled, the global CatchAll branch is run.
Saving an image of an orchestration
You can save a graphical image of the current orchestration as a ,jpg file.
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Configuring an orchestration to orchestration connection
You can configure a Web Service endpoint to call another Web Service orchestration stored in the Integration
Appliance, in the same project.

About this task

You can configure an Orchestration to Orchestration connection by specifying the transport protocol to the
endpoint location as local:// instead of the conventional http://.

You apply this option to either call (invoke) or provide endpoint type.

Note:

When an orchestration that has Web Services Provide service starter activity with Transport type set to Local,
referred to as sub-orchestration, then persistence setting for the main orchestration and the sub-orchestration
should be same within the same project.

For example, if the persistence is enabled for the main orchestration, then it should be enabled for the sub-
orchestration also. If the persistence is disabled in the main orchestration, then it should be disabled for the
sub-orchestration and vice-versa.

Procedure

1.  Open a new or existing Web Service endpoint.
2. In the Type section, select either the Invoke option or Provide option. Invoke is selected by default.

If you select the Invoke option, complete the following steps:
a. From the Location drop-down list, select Local
b. From the Orchestration drop-down list, select the orchestration you want to call.
c. From the WS Provide Activity drop-down list, select an activity.

Note: This activity is displayed only if the selected orchestration has a Web Services
Provide Service starter activity and Local as the relevant endpoint. If you select an
orchestration that does not have a Web Services Provide Service starter activity, then the
WS Provide Activity menu is empty.

If you select the Provide option, complete the following steps:
a. From the Transport drop-down list, select Local.
b. In the Path field, enter the path which is used to call the Provide activity.
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Creating an orchestration
There are three steps to creating a completed orchestration: Create the new orchestration, rename the
orchestration, and build the orchestration.

Procedure

1. Complete one of these three steps to create a new Orchestration:
To create an orchestration from the toolbar menu, select Project > New Orchestration. A new
orchestration is opened in the workspace. The new orchestration name is added to the
Orchestrations folder in the Project tab.

Click the New Orchestration button  in the Project tab.
Right-click the Orchestration folder and select New Orchestration. A new orchestration opens in
the main Studio pane. The new orchestration with a default name is added to the Orchestrations
folder in the Project tab.

2. Optional: Change the default name.
3. Press Return.
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Renaming an orchestration
Orchestrations are given default names when they are created. You can rename it from the Project tab.

Procedure

1. Click the Project tab.
2. Open the Orchestrations folder.
3. Either

Right-click the orchestration you want to rename and select Rename.
Click three times on the orchestration name in the Project tab.

4. Enter a new name for the orchestration. The orchestration name must not exceed 42 characters and
must not contain any reserved characters. For a list of reserved characters see About Valid Names.

5. The orchestration name is changed.

Parent topic: Orchestrations
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Building an orchestration
Studio provides visual cues in the workspace so that it is easier to see and control the placement of activities in
an orchestration. When you drag-and-drop activities from the Studio Toolbox to the workspace, a green circle
icon displays the target location in the orchestration where the activity is to be placed. When adding activities
to the branches of logic activities, Studio highlights the target branch.

Procedure

1. Drag the appropriate activities from the Activities tab onto the orchestration
2. Configure the activities. You must add at least one inbound activity (or one schedule), and one outbound

activity in order to complete an orchestration. See the Basic Validation Requirements section of
Validating the Orchestration for more information.

3. After the orchestration is built, set the orchestration options in the Properties pane. For more
information see Processing Orchestration Jobs Sequentially and Enabling Persistence.

4. Save the orchestration, then validate it.
5. Fix any validation issues displayed in the Validation Results dialog box.
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Verifying orchestrations
Studio can simulate the Cast Iron® operating system (CIOS) runtime so that you can to test orchestrations
within a project and resolve any issues before deploying the project to the Integration Appliance.

Before you begin

When initiating a test run, you can start a single orchestration, or all the orchestrations in a project. Studio runs
one orchestration job for each orchestration. You can start and stop orchestrations, and view orchestration
monitoring logs from the Studio toolbar or from the Verify tab.
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If the orchestration is invalid, a message dialog is displayed showing possible resolutions. In the workspace,
Studio highlights each activity in the orchestration as the activity is processing the data. As Studio runs the
orchestration, the Verify tab shows a tree-view of the orchestration job details including; activity name,
processing status, variable/parameter names, and variable/parameter data. If an error occurs, Studio
highlights the node where the error occurred. Clicking the node links you to the location of the error, where you
can resolve any issues before running another instance of the orchestration.  

When you click a node in the tree-view, Studio displays in the Properties Pane the Checklist task that
corresponds to the node. For example, when you click an activity node, the Configure panel for the activity is
displayed in the Properties Pane. When you click the Map Outputs node, the Map Outputs panel is displayed in
the Properties Pane. If you click a mapping variable or parameter, the data is displayed in the
Variable/Parameter Message Data section of the Verify tab.

Although Studio only runs one orchestration job for each orchestration, you can start the same orchestration
multiple times. The Verify tab shows the results for each run of the same orchestration under a separate
instance. For example, Instance #1 and Instance #2. An orchestration job must be complete before you can run
another instance of the same orchestration.

Note: Studio does not persist the results of the runtime test. When you close the orchestration tab, you lose the
runtime results for the orchestration.

About this task

Depending on the activities in the orchestration, Studio may require more input to run the orchestration job. For
example, an orchestration with a database activity requires that you generate database assets before running
the orchestration in Studio, just as you must do in the WMC before running the orchestration on the Integration
Appliance. If the activities in the orchestration use the Secure Sockets Layer (SSL), you may need to
understand SSL concepts and you may need to import certificates before verifying the orchestration. See Using
SSL in Studio for more information.

If the orchestration contains an HTTP Receive Request activity, you must post a message to the specified URL.
Use theHTTP Post Utility to post a message. If the orchestration contains an FTP Poll activity, you must place a
file in the specified location, as prompted by Studio, before the orchestration can run.

Since you can use the Verify tab to simulate the runtime on the Integration Appliance, you can also specify
Kerberos Protocol settings in Studio to test the settings before deploying to the Integration Appliance.
Specifying these setting in Studio does not impact the runtime on the Integration Appliance. You must specify
the Kerberos Protocol settings in the WMC to allow the Integration Appliance to authenticate the server that
the Integration Appliance is communicating with. For more information about specifying Kerberos Protocol
settings for the Integration Appliance, see the WMC Online Help.

Procedure

To specify Kerberos Protocol settings in Studio:

1. In Studio, select Edit > Preferences... . The Preferences dialog is displayed.
2. In the navigation pane, select SSL > Kerberos.
3. Specify the Kerberos Server Name.
4. Specify the Kerberos Realm.
5. Click OK.

Example

You can now test the orchestration, using the Kerberos Protocol, within Studio.
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Table 1. Navigating the Verify Tab toolbar
I
c
o
n Description

Starts the open orchestration. The orchestration must be valid before Studio can run an orchestration job.  

Starts all the valid orchestrations in the project that are not already running. If an orchestration is already
running when you click this icon, Studio does not rerun the orchestration.  

Stops the running orchestration job immediately. Studio does not allow the orchestration job to complete
before stopping.

Stops all running orchestration jobs immediately. Studio does not allow the orchestration jobs to complete
before stopping.

Shows orchestration monitoring data in a table or text format. For more information about the Log Viewer,
see Using the Log Viewer.

In the Workspace, highlights the activities in the execution path of the orchestration job, so you can follow
the logic Studio used to complete the orchestration job. Different instances can have a different path
depending on the inputs and orchestration logic. Click this icon to toggle between providing and not
providing a highlighted path.

Assigns the results from the selected instance to the Map Inputs and Map Outputs, so that when you run a
test from the Properties Pane, Studio populates the inputs and outputs with the results of the completed
orchestration job.

Deletes one or more selected instances from the orchestration details tree. To delete multiple instances
hold the Shift key or Ctrl key, select the instances you want to delete, and click the icon.

Expands all the nodes under the selected node in the orchestration details tree.

Collapses all the nodes under the selected node in the orchestration details tree.

Expands a single node under the selected node in the orchestration details tree.

Collapses a single node under the selected node in the orchestration details tree.
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Using SSL in Studio
The Secure Sockets Layer (SSL) is the standard security technology for establishing an encrypted link between
a server and a client. The encrypted link ensures that all data passed between the server and clients remain
private and unchanged. To create an SSL connection a server requires an SSL certificate. This section provides
an overview of using SSL in Studio, discusses Transport Layer Security (TLS) and SSL security, discusses
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certificates and supplies the procedures you need to properly import Certificate Authority (CA) and end-entity
certificates and private keys for use when verifying SSL client authentication.

SSL and Transport Layer Security

TLS 1.0 represents an upgrade of SSL 3.0. As an example, the TLS handshake protocol for establishing
client/server authentication and encryption differs from the SSL handshake protocol. Additionally, TLS is now
more extensible. Although they cannot interoperate, TLS provides a mechanism by which a TLS 1.0
implementation can revert to an SSL 3.0 implementation.

The TLS protocol uses public-key and symmetric-key cryptographic technology. Public-key cryptography uses a
public key and a private key. Information encrypted with one key can be decrypted only with the other key. For
example, information encrypted with the public key can be decrypted only with the private key.

Each server's public key is published, while the private key is kept secret. To send a secure message to the
server, the client encrypts the message by using the server's public key. When the server receives the message,
it decrypts the message with its private key.

Symmetric-key cryptography uses the same key to encrypt and decrypt messages. The client randomly
generates a symmetric key to be used for encrypting all session data. The key is then encrypted with the
server's public key and sent to the server.

TLS provides three basic security services:

Message privacy – Achieved through a combination of public-key and symmetric-key encryption. All
traffic between a client and a server is encrypted using a key and an encryption algorithm negotiated
during session setup.
Message integrity – Ensures that session traffic does not change en route to its final destination. TLS and
SSL use a combination of public/private keys and hash functions to ensure message integrity.
Mutual authentication – Exchange of identification through public-key certificates. Client and server
identities are encoded in public-key certificates, which contain the following components:

Subject's distinguished name
Issuer's distinguished name
Subject's public key
Issuer's signature
Validity period
Serial number

You can also use secure HTTP (HTTPS) to ensure that a client's security information is not compromised when
downloaded from a server.

Certificates

SSL uses digital certificates to authenticate the identity of the server and optionally the client. Digital
certificates are issued by a Certificate Authority (CA), a trusted agency that is authorized to issue, renew and
revoke digital certificates after verifying the identity and legitimacy of the requesting party. A CA certificate,
which may be a root CA certificate or a subordinate CA certificate, includes the CA's signature and the period of
validity. A CA guarantees the connection between a key and another CA or end-entity. A end-entity is a person,
a role, an organization, a pseudonym or a piece of hardware or software.

Encryption and authentication are performed by means of a public and a private key. The public key is
embedded into a certificate, known as a site or server certificate. The certificate contains several items of
information, including the name of the CA that issued the certificate, the name and public key of the server or
client, the CA's signature and the certificate's date and serial number. The private key is created when you
create a self-signed certificate or a CA certificate request and is used to decrypt messages from clients.

76   



A SSL or TLS session is established in the following sequence:

1. The client and the server exchange hello messages to negotiate the encryption algorithm and hashing
function (for message integrity) to be used for the session.

2. The client requests an ITU-T standard X.509 certificate from the server to prove its identity. Optionally,
the server can request a certificate from the client. Certificates are verified by checking the certificate
format, the validity dates and by verifying that the certificate includes the signature of a trusted
certificate authority (or is self-signed).

3. The client randomly generates a set of keys that is used for encryption. The keys are encrypted with the
server's public key and securely communicated to the server.
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Importing an end-entity certificate
An end-entity certificate is a digitally-signed statement issued by a Certificate Authority to a person or system.
It binds a public key to some identifying information and is used for encryption, authentication, digital
signatures and other purposes. The term “end-entity” is used to distinguish it from a Certificate Authority
certificate. The signer of the statement is the issuer and the entity discussed in the certificate is the subject.

About this task

To import an end-entity certificate and private key, you must import a file in PKCS#12 format using the Java
keytool -importkeystore command. PKCS #12, the successor to PFX from Microsoft, defines a file format
commonly used to store X.509 private keys with accompanying public key certificates, protected with a
password-based symmetric key. PKCS #12 format files typically have a file extension of .pfx or .p12.

The following steps provide an example of how to import an end-entity certificate:

Procedure

1. Navigate to the Studio security directory. For example. C:\Program Files\IBM\WebSphere Cast Iron
Studio 6.0\security.

2. Copy the PKCS #12 format file into Studio security directory, for example C:\Program
Files\IBM\WebSphere Cast Iron Studio 6.0\security\certificate.p12.

3. Import the certificate and private key into the Studio keystore using the keytool -importkeystore
command. For example: keytool -importkeystore -deststorepass "keystore admin" -destkeystore certs -
srckeystore certificate.p12 -srcstoretype PKCS12 -srcstorepass <certificatePswd> -srcalias
<certificateAlias>.

Results
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At the conclusion of these steps, the certificate is imported into your Studio security directory. For more
information about the keytool -importkeystore command, see:
http://www.ibm.com/developerworks/java/jdk/security/60/secguides/keytoolDocs/keytool.html#importKeySt
ore.
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Importing a Certification Authority (CA) Certificate
Abbreviated as CA, a Certification Authority is a trusted third-party organization or company that issues
certificates used to create digital signatures and public-private key pairs. Because they guarantee that the two
parties exchanging information are really who they claim to be, CA's are a critical component in data security
and electronic commerce. Although the relationship between CA's is most commonly hierarchical, CA
certificates can also be used to establish trust relationships between CA's in two different public key
infrastructure (PKI) hierarchies. A PKI is the set of people, policies, procedures, hardware, and software used
in creating, distributing, managing and using digital IDs. In all of these cases, the CA certificate is critical to
defining the certificate path and usage restrictions for all end-entity certificates issued for use in the PKI.

About this task

Perform the following steps to import a CA certificate.

Procedure

1. Open a command window.
2. Navigate to the server, and locate the certificate file ca-cert stored in the server.
3. Copy the ca-cert file and then navigate to the workstation where Studio is installed.
4. Using the command window, paste the CA certificate copy in the home directory of Studio: C:\Program
Files\IBM\WebSphere Cast Iron Studio x.x.x.

5. Navigate to the security directory of Studio: C:\Program Files\IBM\WebSphere Cast Iron
Studio x.x.x\security.

6. Run the following command to import the CA certificate file into Studio: ..\jre\bin\keytool.exe -
import -v -keystore cacerts -storepass changeit -file ..\castiron_ca_cert.pem -
alias alias_name Where alias_name is the alias of the server CA certificate.

7. When you are prompted for a yes or no, type yes (Y) and press Enter.
8. Exit the command window.

Results

At the conclusion of these steps, the certificate is imported into your Studio security directory. For more
information about the keytool -import command, see keytool - Key and Certificate Management Tool.
Parent topic: Orchestrations
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SSL server authentication
SSL server authentication verifies that sites you communicate with are who they claim to be. Authentication
confirms a server's identity through standard techniques of public-key cryptography to ensure that a server's
certificate and public ID are valid and have been issued by a certificate authority listed in the client's list of
trusted CA's.

Communication with "trusted" servers that possess authentication certificates issued by a certificate authority
is critical to establishing a secure environment. Authentication certificates are digitally signed documents
which bind the public key to the identity of the private key owner. Authentication happens at connection time
and is independent of the application or application protocol. With SSL, authentication is performed by an
exchange of certificates, which are blocks of data in a format described in the X.509 ITU-T standard. X.509
certificates are issued and digitally signed by a certificate authority.

However using SSL does not guarantee that the client is communicating with the correct server. Consider the
following scenario, in which "Server1" and "Server2" both have valid certificates from a CA that the client
("Client") trusts. Client wants a secure session with Server1, but Server2 wants to eavesdrop on their
communication and is physically located in a place that makes it possible to do so:

1. Client sends a request for an SSL session to Server1. Instead, the request (and all subsequent traffic)
goes through Server2. Instead of forwarding Client's request to Server1, Server2 responds directly to
the request by sending its own certificate to Client.

2. Client receives Server2's certificate and checks its list of trusted CAs. Since Server2's certificate is
signed by the same CA as Server1's certificate, Client accepts the certificate and creates a secure
session with Server2.

3. Having completed the secure session with Client, Server2 requests and creates its own SSL session with
Server1. From this point, Client sends encrypted information to Server2. Server2 decrypts the
information, re-encrypts it, then sends it to Server1. It does the same for information flowing in the
opposite direction. The result is that Server2 is able to read it and even change it, even though all data is
encrypted as it flows over the Internet.

SSL server authentication is designed to prevent this outcome. When server authentication is enabled, the
client, after ensuring that the server's certificate can be trusted, checks that the Internet name in the
certificate matches the Internet name of the server. If they match, the SSL negotiation continues. If not, the
connection ends.

With server authentication enabled, the security scenario outlined above would proceed as follows:

1. Client sends a request for an SSL session to Server1. The request (and all subsequent traffic) actually
goes through Server2. Instead of forwarding Client's request to Server1, Server2 responds directly to
Client's request by sending its own certificate to Client.
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2. Client receives Server2's certificate and checks its list of trusted CAs. Since Server2's certificate is
signed by the same CA as Server1's certificate, Client accepts the certificate and creates a secure
session with Server2.

3. After the secure session has been completed, but before any real data has been sent or received, Client
compares the Internet name in the certificate it received with the name of the server it wants to talk to.
Since they do not match, Client knows that the connection should not continue and disconnects it.
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Testing an SSL server connection
After creating an endpoint for the server using SSL, you are ready to test the SSL server connection.

About this task

Perform the following procedure to test the SSL connection to the server:

Procedure

1. Import the server CA certificate using the instructions in Importing a Certification Authority (CA)
Certificate.

2. Open the endpoint for the server.
3. For FTPS, SSL email and SSL database connections, verify the following login credentials for the server

connection: server, Port, User, and Password.
4. For HTTP and Web Services connections using SSL, if the HTTP or Web Services server requires client

authentication, configure a Client Certificate Alias Name as described in Creating or editing an HTTP
endpoint.

5. Click Test Connection.
6. If the connection is successful, use this endpoint in Studio orchestrations, then use the Verify tab

features to evaluate the orchestration.
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SSL client authentication
Client authentication is similar to server authentication except that the server requests a certificate from the
client to verify that the client is who it claims to be. The certificate must be an X.509 certificate and signed by a
certificate authority trusted by the server. You can only use client authentication when a server requests a
certificate from a client. Not all servers support client authentication.

When a server requests a certificate, the client has the option to send a certificate or attempt to connect
without it. The server allows the connection if the client's certificate can be trusted. When a client attempts to
connect without a certificate, the server might grant the client access but at a lower security level, as illustrated
by the following sequence of events:

1. The client sends a request for an SSL session to the server.
2. The client receives the server's certificate and checks its list of trusted CA's. Since the server's

certificate is signed by a trusted certificate authority, the client accepts the certificate. The server then
asks the client for a certificate that identifies the client.

3. The client responds by sending a certificate or by trying to establish a session without one.
4. If the client sends a certificate, the server checks its list of trusted certificates. If the client can be

trusted, the secure session is established. If the client does not send a certificate, normally the server
terminates the session.
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Using the Log Viewer
Orchestration monitoring data is displayed in the Log Viewer in a table or text format.

By default, the following orchestration monitoring data is displayed by the Log Viewer, in a table:

Time
Provides a timestamp of when the specified event occurred.

Level
Specifies the logging level for a specific event. Logging levels include: Off, Severe, Warning, Info, and All.

Type
Identifies the type of the activity that generated the event. For example, Scheduler, Mime, JMS, or HTTP.

Message
Provides details about a specific event.

You can filter the log events displayed in the table by specifying the logging level or an activity type from the
Level and Type list. When filtering the log events by type, you can press the Shift key to select or clear multiple
types.

To toggle between the text or table format, select or clear the View as Text option.
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Click Clear to delete all orchestration monitoring data.

You cannot restore orchestration monitoring data to the log once the log has been cleared
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Viewing an orchestration
You can use orchestration view icons on the workspace, and View options from the Studio toolbar menu to
manipulate your orchestration view in the workspace.

About this task

The workspace denotes source and target endpoints by using blue and green separating lines, respectively.
With the endpoints displayed, the workspace uses data flow lines to associate an endpoint with a specific
activity so that you can associate an activity with its endpoint.

You can manipulate the orchestration view in the workspace using the following icons:

Orientation of Orchestration
You can choose to view the orchestration in a horizontal  or vertical  view.

Expand or Collapse Orchestration Activities
Expands  or collapses the activities in an orchestration.

Orientation of Endpoints
You can choose to view the endpoints in a horizontal  or vertical  view, relative to the orchestration.

Show/Hide Endpoints
You can choose whether to display endpoints for the orchestration in the workspace. Show/Hide
endpoints that are oriented horizontally . Show/Hide endpoints that are oriented vertically .

Expand or collapse Orchestration
Expands , or collapses  the entire orchestration, not just the activities.

Animate Graph

 Animates the actions that occur in the workspace. By default, orchestration graphics in the
workspace are animated and Studio smoothly transitions any modifications you make to an
orchestration. Click the icon to disable the animations and have the actions occur more crisply. For
example, when you add an activity to the orchestration, the new activity snaps into place.   

Navigate Satellite View
 You can view your entire orchestration and select a specific area to view.

Zoom Out
 Minimizes the view of an orchestration.  

Zoom In
 Enlarges the view of an orchestration.

Restore view to 100%
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 Resets the zoom out and zoom in changes you made to the orchestration view.
Fit to view

 Resizes the orchestration to fit in the workspace.

Table 1. Studio toolbar menu options. You can control the magnification level to view an
orchestration by selecting one of the following options from the View option of the toolbar

menu.  
Option Description

Zoom In Increase the magnification level to view the orchestration.

Zoom Out Decrease the magnification level to view the orchestration.

Zoom 100% Returns the view of the orchestration to the normal magnification level.

View as Tree
Flow or View
as Flow

The View as Tree Flow option lists the activities of the orchestration in a top-to-bottom view.
During run time, the flow starts at the top activity and continues downward. This view is useful
for displaying large orchestrations.

The View as Flow option lists the activities of the orchestration in a left-to-right view. During
run time, the flow starts at the activity on the left side of the view and continues to the right.
This is the default view.

Status View Check box that defines if a status bar is displayed at the end of the main Studio pane. The
status bar shows descriptions of the menu options.

You can also right-click anywhere in the orchestration (when the orchestration is displayed as a flow) and
select one of the following options from the shortcut menu:

Zoom In
Zoom Out
Zoom 100%

Procedure

1. To view a top-level scaled-down overview of the orchestration for navigating large orchestrations,
Double-click the overview  icon. The top-level scaled-down overview of the orchestration is displayed
in a small pane in the Orchestration tab.

2. Move the cursor into the small pane to change the section of the orchestration displayed in the larger
detailed pane of the Orchestration tab.

3. Double-click in the small pane to remove the small top-level overview of the orchestration.
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Validating an orchestration
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An orchestration must be valid (complete and correct) before you can publish it to the Integration Appliance.
Use the validation feature in Studio to validate your orchestration.

Before you begin

To be valid an orchestration must met the following requirements:

Have a starter activity or a Pick activity as the first activity. Starter activities are denoted in the Activities
tab with the blue orchestration icon and a downward arrow . The first activity in each branch of the
Pick activity must be a starter activity.
Note: All starter activities are represented in Studio by the inbound icon , except for the Schedule Job
activity.
Variables must be initialized before they are used. This includes variables that are initialized in the
branches of an If.. Then activity. The variable must be initialized in all branches.

Procedure

1. Select the Project tab, and expand the Orchestration folder.
2. Select and open an orchestration from the Orchestration folder. A graphical representation of the

orchestration is displayed in the Orchestration tab.  
3. Validate your orchestration using one of the following options:

Select Orchestration > Validate from the menu toolbar. The Validation Results dialog box is
displayed.
Press ALT-F8. The Validation Results dialog box is displayed.
Click an orchestration in the Project tab. If the orchestration is invalid, the Validation Results
popup is displayed next to the Project tab and the invalid orchestration icon  is displayed next
to the orchestration in the Project tab

The Validation Results dialog box lists the problem areas in the orchestration. Problems prefaced by a
blue icon are informational; you will have to navigate to that area to fix the problem. Problems prefaced
by a red icon are errors. Click the error message in the dialog box to open the appropriate panel to fix the
error.

Validation ensures that all the basic requirements for an orchestration have been met. You must resolve
all validation issues before publishing the orchestration to the Integration Appliance.

Example

To validate all the orchestrations in the project complete the following steps:

1. In the Project tab, click Revalidate Project . All the orchestrations in the project are validated. If an
orchestration is invalid the invalid orchestration icon  is displayed next to the orchestration in the
Project tab. If the orchestration is invalid, click on the orchestration to view the errors in the Validation
Results list.

2. Select the Validate Project  toolbar button. All the orchestrations in the project are validated. If an
orchestration is invalid the invalid orchestration icon  is displayed next to the orchestration in the
Project tab. If the orchestration is invalid, click on the orchestration to view the errors in the Validation
Results list.

What to do next

Validation icons are displayed throughout the orchestration providing visual clues to potential problem areas or
to provide further information.
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In Studio, the following validation icons are displayed:

 Warning icon
Click warning icons to learn what information is required to complete the configuration of the entity in
the pane. For example, in an activity's checklist, the warning icon appears next the endpoint if an
endpoint has not yet been specified.

 Information icon
Click information icons to learn details about a entity in the pane, for example why a button has been
disabled.

 Checkmark icon
Checkmark icon is displayed when all the information for a entity in the pane has been specified.  For
example, in an activity's checklist, the checkmark icon appears next to the endpoint if a valid endpoint
has been specified.

A warning icon  displays in the upper-right corner of many panes (for example, the Endpoint configuration
pane). You can click this icon to toggle the warning icons ON or OFF displayed in the pane. If turned OFF, the
warning icons are not displayed in the pane.

Parent topic: Orchestrations

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/orch_validating_the_orchestration.html

Working with activities in an orchestration
You can cut, copy, and paste activities, drag activities in an orchestration and add and delete new activities.

About this task

You can cut, copy, paste, delete, and rename activities using any of the following methods:

Keyboard shortcuts
Right-click an activity and select an option from the drop-down list
Select an activity and then select an option from the Edit toolbar menu
Select an activity and then select a toolbar button.

Keyboard shortcuts and their menu option equivalents are listed in the following table.
Table 1. Keyboard shortcuts and their menu option equivalents

Keyboard
Shortcuts

Right-Click Menu
Options

Toolbar Menu
Options Toolbar Buttons Action
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Keyboard
Shortcuts

Right-Click Menu
Options

Toolbar Menu
Options Toolbar Buttons Action

CTRL + X Cut Edit > Cut Removes the
activity and saves a
copy of the activity
in the clipboard that
can be used later by
a paste action.

CTRL + C Copy Edit > Copy Saves a copy of an
activity into the
clipboard that can
be used later by a
paste action.

CTRL + V Paste Edit > Paste Copies the stored
activity from the
clipboard into the
orchestration.

Delete Delete Edit > Delete Removes the
activity. The activity
is not saved in the
clipboard.

F2 Rename Edit > Rename   Opens a field so you
can rename an
activity in an
orchestration.

Note: The keyboard shortcuts and menu options listed in the preceding table are only available when the
orchestration is viewed as a flow and not when the orchestration is viewed as a tree. For more information, see
Viewing an Orchestration.

You can cut, copy, or paste activities within the same orchestration and between orchestrations in the same
project.

You can drag an activity from one location in an orchestration to another location in orchestration by selecting
the activity and dragging it to the new location.

You can make a copy of an activity, by selecting the activity you want to copy, hold down the CTRL key, and then
drag the activity to new location. A copy of the activity is created in the new location.
Note: Drag functionality is only available when the orchestration is viewed as a flow and not when the
orchestration is viewed as a tree. For more information, see Viewing an Orchestration.

Procedure

1. Drag an activity from the Activities tab onto any green target in the orchestration.
2. Complete the properties of the activity in the Properties pane.
3. Optional: To rename the activity, select the Edit > Rename option in the toolbar menu. The activity name

field becomes active. You can also use one of the alternate methods mentioned in Table 1.

What to do next

To delete an activity, select the Edit > Delete option in the toolbar menu. You can also use one of the alternate
methods mentioned in Table 1.
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Printing an orchestration
You can print an orchestration directly or view a print preview of an orchestration.

Procedure

1. Select the Project tab and expand the Orchestrations folder.
2. To open an orchestration, double-click an orchestration in the Orchestrations folder. The Orchestration

is displayed.
3. Optional: To view a print preview press CTRL+SHIFT+P.
4. To print the orchestration, press CTRL+P.
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Processing orchestration jobs sequentially
You can use the Process Orchestration Jobs Sequentially option when an orchestration contains activities that
can conflict with each other when multiple instances of the orchestration are running. An instance of an
orchestration is also known as an orchestration job.

About this task

For example, an orchestration could contain a Pick activity that contains branches for the Get Inserted Rows,
Get Updated Rows, and Get Deleted Rows activities. The following steps show an example run time scenario
for this orchestration with the Process Orchestration Jobs Sequentially check box not selected:

1. An insertion into the database occurs, triggering the first instance of the orchestration to be created.
2. The first instance of the orchestration starts processing the insert branch of the Pick activity.
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3. Before Get Inserted Rows activity completes in the first orchestration instance, a deletion in the
database occurs triggering a second instance of the orchestration to be created.

4. The second instance of the orchestration starts processing the delete branch of the Pick activity.

This is undesirable behavior because first instance of the orchestration (that is processing the Get Inserted
Rows activity) should complete before the second instance of the orchestration starts to process the Get
Inserted Rows activity to avoid a potential primary key exception in the database. These database actions
should occur sequentially. To force the instances of the orchestration to run sequentially, select the Process
Orchestration Jobs Sequentially check box for the orchestration. With this option set, the instances of the
orchestration are run one at a time and conflicts, like primary key exceptions, are avoided.

Complete the following steps to set all jobs to run in a single instance check box.

Note: Selecting this option decreases the performance of the project.

Procedure

1. Select the Project tab and expand the Orchestrations folder.
2. To open an orchestration, double-click an orchestration in the Orchestrations folder. The orchestration is

displayed.
3. If the orchestration options are not displayed the bottom part of the orchestration tab, select

Orchestration > Properties from the toolbar menu.
4. Select the Process Orchestration Jobs Sequentially check box. This option is automatically selected if

the orchestration contains shared variables.
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Enabling persistence
The Orchestration pane contains an Enable Persistence check box that by default is selected. The setting of the
Enable Persistence check box affects the way orchestration jobs are restarted after a failure.

About this task

The effect of setting of the Enable Persistence check box is described by the following two options:

Enable Persistence check box is selected
During run time if an orchestration job is running and a failure occurs that causes the job to stop, when
the orchestration is restarted, the original job continues processing where it stopped and no in-flight
messages are lost.

Enable Persistence check box is cleared
During run time if an orchestration job is running and a failure occurs that causes the job to stop,  when
the orchestration is restarted, the current job does not complete and the in-flight messages are lost.
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When the Enable Persistence check box is cleared the run time performance is improved.

Note:

When an orchestration that has Web Services Provide service starter activity with Transport type set to Local,
referred to as sub-orchestration, then persistence setting for the main orchestration and the sub-orchestration
should be same within the same project.

For example, if the persistence is enabled for the main orchestration, then it should be enabled for the sub-
orchestration also. If the persistence is disabled in the main orchestration, then it should be disabled for the
sub-orchestration and vice-versa.

Note:

You should enable persistence for the FTP Poll Directory activity:

If you have an orchestration job with a FTP Poll Directory activity that is processing large input files.
Otherwise, you can experience problems like "Variable 'Lotdata' is too large, please turn on persistence
for this orchestration".
If you disable persistence and have an orchestration job with a FTP Poll Directory activity with the Keep
in place option selected, and during run time if a failure occurs that causes the job to stop, when the
orchestration is restarted it processes the file again. The state of the job is lost and Integration
Appliance does not know that it has already processed the file.

The following activities require that persistence be enabled when the Exactly Once option is selected in the
Delivery Rules for the activity:

Database
Poll Table
Get Inserted Row
Get Updated Rows
Get Deleted Rows
Insert Rows
Update Rows
Delete Rows
Call Procedure

Email
Get Email

FTP
Poll Directory

JMS
Subscribe Message
Poll Message

MQ
Poll Message

SAP
Receive IDOC
Send IDOC

SFDC
Poll Deleted Objects
Poll Updated Objects

Domino®
Get Created Documents
Get Deleted Documents
Get Updated Documents
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Procedure

1. To change the setting of the Enable Persistence check box, select Orchestration > Properties from the
toolbar menu. The Orchestration pane is displayed.

2. Select Enable Persistence check box.
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Adding a global exception handler to an orchestration
During run time if any of the activities of the orchestration throws an exception, and a global exception handler
has been enabled, the global CatchAll branch is run.

About this task

The following figure shows an example orchestration:

In this example, if either the Database Get Inserted or the Database Insert Rows activities fail and throw an
exception, the If..Then activity in the CatchAll branch is run.

Procedure

1. Right-click the start icon  of the orchestration and from the menu, and select the Add CatchAll
Branch option. The CatchAll branch is added to the orchestration and the following variables are
automatically created:

faultName - During run time, the faultName variable contains the name of the exception thrown
by an activity in the orchestration.
faultData - During run time, the faultData variable contains the error message associated with the
exception. This additional information is only currently returned for the Web Services activities.
For Web Services activities, the faultData variable contains the fault.
faultInfo - During run time, the faultInfo variable returns the following nodes:
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name - During run time, the faultInfo/name node contains the name of the exception
thrown by an activity in the orchestration. The faultInfo/name node is an xsd:QName type.
message - During run time, the faultInfo/message node contains the error message
associated with the exception. The faultInfo/message node is an xsd:string type.
activityId - During run time, the faultInfo/activityId node contains the activity ID that
uniquely identifies the activity where the exception occurred. The faultInfo/activityId node
is an xsd:int type.
activityName - During run time, the faultInfo/activityName node contains the activity name
where the exception occurred. The faultInfo/activityName node is an xsd:string type.
faultTime - During run time, the faultInfo/faultTime node contains the time the error
occurred. The faultInfo/faultTime node is an xsd:dateTime type.

Note: The exception name returned by an activity in the faultName variable and the
faultInfo/name node may change in a future release.

2. Configure the CatchAll branch by dragging activities from the Activities tab to the CatchAll branch, as
shown in the preceding figure.

Results

Note: The scope of the faultName, faultData, and faultInfo variables is limited to the CatchAll branch. This
scope limitation means that the value of the these variables is only guaranteed to be valid within the CatchAll
branch. For example, if you add a If...Then activity that tests the value of the faultName variable, the If...Then
activity must be placed inside the CatchAll branch as shown in the preceding figure.
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Saving an image of an orchestration
You can save a graphical image of the current orchestration as a ,jpg file.

Procedure

1. To create, or open, an existing orchestration double-click an orchestration in the Orchestrations folder of
the Project tab. A graphical representation of the orchestration is displayed.

2. Click an activity in the orchestration and select the Orchestration > Save as an Image option from the
Studio toolbar menu. The Save Orchestration Flow to an Image dialog box is displayed.

3. Browse for a directory location.
4. In the File Name field, enter the complete name of the file including the jpg extension. For example:

ProcessPO.jpg.
5. Click Save. The image file is saved to the file system.
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Connection Activities
Creating an endpoint
You can create an endpoint from either the Activities tab or the Project tab. Use the Activities tab when
you are in the process of building an orchestration and want to use the endpoint straight away. Use the
Project tab to configure a set of endpoints for later use.
Downloading plug-in connectors
Plug-in connectors are additional connectors that you can download into Studio and access like a built-
in connector. When you download a plug-in connector, the connector is displayed in the Activities tab
with all the other built-in connectors. You can now drag the plug-in connector activities into the Studio
workspace to create an orchestration.
Uninstalling Plug-in Connectors
Plug-in connectors are additional connectors that you can download into Studio and access like a built-
in connector. They can be uninstalled from the same location as they are downloaded.
Using an existing endpoint
You can define an endpoint and reuse it for connection activities within the same project.
Polling interval behavior
Some starter activities poll for a change in state at the specified polling interval. Once the poll occurs
and the change of state is detected, an orchestration job is started to start processing.
Using the Shift-JIS encoding
During run time, if the Shift-JIS encoding is specified, the Integration Appliance will not convert some of
the double-byte characters.
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Creating an endpoint
You can create an endpoint from either the Activities tab or the Project tab. Use the Activities tab when you are
in the process of building an orchestration and want to use the endpoint straight away. Use the Project tab to
configure a set of endpoints for later use.

Creating an endpoint from the Activities tab
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1. Drag a connection activity from the Activities tab to the orchestration. The Checklist is displayed in the
lower left side of the pane. The summary information is displayed, on the right.

2. By default, the Activity Name displayed is the name of the connection activity; for example, FTP Poll
Directory. To change the name, enter the new name in the field.

3. Select Pick Endpoint from the Checklist. The endpoint pane is displayed to the right.
4. Click New. The Create Endpoint dialog is displayed.

Note: The dialog contents vary depending on what type of connection activity you create.

Creating an endpoint by right-clicking in the Project tab

1. Right-click on the endpoints folder in the Project tab.
2. Select Create Endpoint > EndpointType, where EndpointType is type of endpoint. A new endpoint is

created and displayed under the endpoints folder in the Project tab with a default name. An Endpoint tab
is displayed in the main Studio pane.

3. Change the default name.
4. Press Return.
5. Configure the endpoint by specifying values in the Endpoint tab.

Note: The fields in the tab are identical to the fields displayed for the same type of endpoint created
from the Activities tab.

Creating an endpoint by clicking the New Endpoint icon in the Project tab

1. Click the Project tab.
2. In the Project tab, click the New Endpoint icon. A list with all types of endpoints is displayed.
3. Select an Endpoint type.
4. Change the default name.
5. Press Return.

Creating an endpoint by right-clicking in the Project tab

1. Right-click on the endpoints folder in the Project tab.
2. Select Create Endpoint EndpointType, where EndpointType is type of endpoint. A new endpoint is

created and displayed under the endpoints folder in the Project tab with a default name. An Endpoint tab
is displayed in the main Studio pane.

3. Change the default name.
4. Press Return.
5. Configure the endpoint by specifying values in the Endpoint tab.

Note: The fields in the tab are identical to the fields displayed for the same type of endpoint created
from the Activities tab.
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Downloading plug-in connectors
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Plug-in connectors are additional connectors that you can download into Studio and access like a built-in
connector. When you download a plug-in connector, the connector is displayed in the Activities tab with all the
other built-in connectors. You can now drag the plug-in connector activities into the Studio workspace to create
an orchestration.

About this task

When you download plug-in connectors you can view available and installed plug-in connectors. Click the
Available tab to view the names and versions of all the plug-in connectors that are available for download. Click
the Installed tab to view the names and versions of all the plug-in connectors that you have already
downloaded and installed on Studio. You can check for updates to these lists on startup or at one of the
following intervals: daily, weekly, on alternative weeks, monthly, or never. Select the update interval and click
Check Now to refresh the lists.

To download a plug-in connector complete the following steps:

Procedure

1. Select Solutions > Plugin Connectors. The Login window is displayed.
Note: If you are already logged into the IBM® Cast Iron® services, the Plugin Connector window is
displayed and you can omit steps 2 and 3.

2. Specify the user name and password that IBM Support has provided you with. If you do not have login
information, request a login from IBM Support.  

3. Click OK. The Plugin Connectors window is displayed.
4. In the Available tab, select a connector.
5. Click Install. The plug-in connector is displayed in the Installed tab.
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Using an existing endpoint
You can define an endpoint and reuse it for connection activities within the same project.

Procedure

1. Select the connection activity from within the orchestration.
2. Click Pick Endpoint from the Checklist.
3. Click Browse. The Project Explorer dialog box displays.
4. Select an endpoint from the list and click OK.  The endpoint information is displayed.

Parent topic: Connection Activities
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Polling interval behavior
Some starter activities poll for a change in state at the specified polling interval. Once the poll occurs and the
change of state is detected, an orchestration job is started to start processing.

For example, during run time, the FTP Poll Directory activity polls for the existence of the specified file or files
on the FTP server at the specified location and polling interval.

You specify the polling interval for the starter activity in the Delivery Rules task of the Checklist for the
activity. The polling interval determines how often a poll occurs to check for a change in state. Once an
orchestration that starts with a polling starter activity is published and deployed, the first poll occurs when the
orchestration is deployed and the second poll occurs at the next time interval in the polling schedule. For
example, if the polling interval is 10 minutes and the orchestration is deployed at 10:14 PM, the first poll
occurs at 10:14 PM and the second poll occurs at 10:20 PM, which is the next interval of 10 minutes, as shown
in the following figure:

The intervals start at the beginning of the hour, 10:00 PM in this example.

Note: When specifying the polling interview in days, the Integration Appliance uses UTC time zone and not the
local time zone to determine when to poll. When the Polling Interval is set to days in the Delivery Rules task,
the Integration Appliance polls at the start of the day (00:00) using the UTC time zone and not the local time
zone specified for the Integration Appliance. For example, if your Integration Appliance is set to Pacific
Standard Time (PST) which is 8 hours behind Coordinated Universal Time (UTC) and the Polling Interval was
set to 1 day, the poll occurs at  00:00 in the UTC time zone which is equivalent to 4:00 PM (16:00 in 24 hour
time) in the PST time zone.

The following starter activities poll for a change in state:
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Database Get Inserted Rows
Database Get Updated Rows
Database Get Deleted Rows
Database Poll Table
Get Email
FTP Poll Directory
MQ Poll Queue
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Using the Shift-JIS encoding
During run time, if the Shift-JIS encoding is specified, the Integration Appliance will not convert some of the
double-byte characters.

About this task

The Integration Appliance does not convert the double-byte characters listed in the following table:  

Hexadecimal Shift-JIS Character Code Hexadecimal Unicode Character Code Description

0x815C U+2014 Em Dash

0x8160 U+301C Wave Dash

0x8161 U+2016 Double Vertical Line

0x817C U+2212 Minus Sign

0x8191 U+00A2 Cent Sign

0x8192 U+00A3 Pound Sign

0x81CA U+00AC Not Sign

Use the CP943 encoding instead of the Shift-JIS encoding.
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Template Integration Process (TIPs)
About the Template Integration Project (TIP) Configuration Editor
Use the TIP Configuration Editor to drag objects from Studio into the TIP Configuration Editor workspace
to create and modify Template Integration Projects (TIPs), which you can upload to the Cast Iron®
solutions repository for other users to access.
Creating a Template Integration Project (TIP)
You can create, and modify, Template Integration Projects (TIPs) using the TIP Configuration Editor to
drag objects from Studio into the TIP Configuration Editor.
Modifying a Template Integration Project (TIP)
You can modify a Template Integration Project (TIP) from the Studio menu.
Verifying a Template Integration Project (TIP)
You can verify a Template Integration Project (TIP) from the Studio menu using the same process as for
verifying an orchestration.
Searching for Template Integration Projects (TIPs)
Template Integration Projects (TIPs) are stored in the Cast Iron solutions repository. Through the
Configuration Wizard, TIPs guide you through the configuration steps for an integration scenario. TIPs
can be downloaded to your local machine. The login window is pre-populated with the User Name and
Password to make it easier for you to download the TIPs, without registration.
Rating and Reviewing Template Integration Projects (TIPs)
You can rate and provide a review for all Template Integration Projects (TIP) that you download.
Uploading Template Integration Projects (TIPs) to the Cast Iron solutions repository
You can upload Template Integration Projects (TIPs) that you have created to the Cast Iron solutions
repository.
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About the Template Integration Project (TIP) Configuration
Editor

Use the TIP Configuration Editor to drag objects from Studio into the TIP Configuration Editor workspace to
create and modify Template Integration Projects (TIPs), which you can upload to the Cast Iron® solutions
repository for other users to access.

When you have created a TIP, you can use the Configuration Wizard to configure the project for your integration
scenario.

When you close the TIP Configuration Editor all changes are saved. However, if you close the project in Studio
before you save your changes in the TIP Configuration Editor, the changes you made in the TIP Configuration
Editor are not saved.
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You can launch the TIP Configuration Editor from the Studio menu. Select Tools > TIP Configuration Editor.

TIP Configuration Editor Workspace

The TIP Configuration Editor workspace contains the Edit and Preview tabs.

In the Edit tab, you can use the interface to build the pages for each step in the TIP. You can use this interface
to drag images directly into the Description and Summary Content fields. By selecting the Show Markup option
at the bottom of the tab, you can edit the underlying HTML source for the page.

You can view the page for the TIP step in the Configuration Wizard use the Preview option.

TIP Configuration Editor Modes

The TIP Configuration Editor has a compact mode, which shows only a panel with the Steps list. Click the
compact mode icon, in the upper right corner of the Steps list, to collapse or expand the TIP Configuration
Editor. When you select the Sync Selection option at the end of the Steps list, the Studio application is opened
and automatically navigates to the entity corresponding to the step in the TIP Configuration Editor that you are
editing.
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Creating a Template Integration Project (TIP)
You can create, and modify, Template Integration Projects (TIPs) using the TIP Configuration Editor to drag
objects from Studio into the TIP Configuration Editor.

About this task

You can upload to the Cast Iron® solutions repository for other users to access. After using the TIP
Configuration Editor to create a TIP, you can use the Configuration Wizard to configure the project for your
integration scenario.
Important: Only the creator of a TIP can modify the TIP. However, after you upload your TIP to the Cast Iron
solutions repository and it is certified by IBM®, you no longer have the ability to delete your TIP from the Cast
Iron solutions repository.

Procedure

1. From the Studio menu, select Tools > TIP Configuration Editor. The TIP Configuration Editor window
shows.

2. Define the steps for the TIP using one of the following methods:

Adding one of the TIP Configuration Editor's predefined step types:
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a. Click Add. The Select Type window opens.
b. Select the appropriate option and click OK. The new step is displayed beneath the

highlighted step in the Steps list. You can shuffle the order of the steps by selecting the
step and moving it to the appropriate locations on the list.

Dragging a Studio object into the TIP Configuration Editor:
a. Select a Studio object.
b. Drag the object to the appropriate position on the Steps list. You can shuffle the order of

the list by selecting a step and moving it to the required position on the list.
c. Optional: You can drag images directly into the Description and Summary Content fields of

the various steps.
Deleting a step:

a. Select a step in the Steps list. Your selection is indicated by bold type
b. Click Delete.

Renaming a step:
a. Double-click a step in the Steps list. The step name becomes an editable field.
b. Enter the required name of the step.

Or

a. Select a step in the Steps list. Your selection is indicated by bold type.
b. In the Edit tab, edit the value in the Name field.

3. In the Edit tab, define properties for each step:
a. Select a step in the Steps list. Your selection is indicated by bold type. The Edit tab opens a form

showing the properties for the selected step.
b. Optional: Optional: Select the Show Markup option to view the HTML markup for the Description

and Summary Content sections of the form. Right-click these sections to see a list of available
HTML styles.

In the HTML source view, you can add images to the Description and Summary Content fields by
dropping an image into either field. The image is converted to a file with a “.b64” extension, which
can be referenced as a relative path. For example: <img
src="/.images/SendEmail.png.b64">.

Referencing images outside of the project structure is supported by using fully-qualified HTTP
paths. For example: <img
src="http://www.yourcompany.com/images/sig/logo_med.gif">
Note: Selecting the Show Markup option only shows the HTML markup for the selected step.

c. Complete the form.
d. Preview the results in the Preview tab.

4. Click Close. The TIP Configuration Editor saves all changes and closes.
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Modifying a Template Integration Project (TIP)
You can modify a Template Integration Project (TIP) from the Studio menu.

About this task

Procedure

1. From the Studio menu, select Tools > TIP Configuration Editor. The TIP Configuration Editor window is
opened.

2. Update the appropriate step or configuration.
3. Click Close. The TIP Configuration Editor saves all changes and closes.
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Verifying a Template Integration Project (TIP)
You can verify a Template Integration Project (TIP) from the Studio menu using the same process as for
verifying an orchestration.

About this task

Procedure

1. From the Studio menu, select Solutions > TIP Configuration Editor. The Configuration Wizard is
displayed.

2. If the TIP does not have a Verify Orchestration step, add one before the Finish step. To add a Verify
Orchestration step, select Tools > Edit Configuration Wizard and add a Verify Orchestration step.

3. Click Next to step through the orchestration.
4. When you reach the Verify Orchestration step, click Start Orchestration.
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Searching for Template Integration Projects (TIPs)
Template Integration Projects (TIPs) are stored in the Cast Iron® solutions repository. Through the
Configuration Wizard, TIPs guide you through the configuration steps for an integration scenario. TIPs can be
downloaded to your local machine. The login window is pre-populated with the User Name and Password to
make it easier for you to download the TIPs, without registration.

Procedure

1. From the Solutions menu, select Search For TIPs. The Login window is displayed with the pre-populated
User Name and Password. These credentials have the access privilege only to download TIPs.
Note: You can also log on by clicking the Login link present on the right-hand side, near the memory bar.

2. If you already have the credentials to log on, specify the user name and password. You can specify
default login settings for the central repository in the Preferences dialog.

3. Click OK. The Search window is displayed and a confirmation message displays at the end of the main
Studio window.

4. In the Search window, choose Keywords, Filter, or My TIPs as the method by which you want to search
for TIPs.

If you select the Keywords search option, the Keywords field is displayed.
a. Enter a search keyword.
b. Click Go. The results are displayed in the Results table and a "Searching ... completed"

message is displayed at the end of the Search window. For example, if you enter the
keyword USECASES, all TIPs under the USECASES category in the Cast Iron solutions
repository are returned.

If you select Filter search option, the filter options: Source Endpoint, Target Endpoint, Integration
Patterns, and Searchable Keywords are displayed.

a. You must specify a value for at least one filter option. The options lists provide valid values.
b. Click Query. The results are displayed in the Results table and a "Searching ... completed"

message is displayed at the end of the Search window.
If you select My TIPs, all TIPs that you have created are displayed in the Results table.

5. In the Results table, select a TIP. The details for the project are displayed in the details section.
6. Optional: You can rate the TIP that you have selected.

a. Click the Edit Review link. The Publish Review window is displayed.
b. Move the slider until the appropriate number of stars are highlighted. Rate the TIP on a scale

between 1-5, 5 being the highest rating.
c. In the My Title field, add a brief description for your review.
d. In the My Summary field, add more details about your review of the project.
e. Click OK. Studio submits the review to the Cast Iron solutions repository.

7. In the Search window, click Download. The Select directory where to save the TIP window is displayed.
8. Specify the download directory and click Open. The project is saved to the directory you specified and

Studio opens the Configuration Wizard for the project.
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Rating and Reviewing Template Integration Projects (TIPs)
You can rate and provide a review for all Template Integration Projects (TIP) that you download.

About this task

Ratings are given on a scale of 1-5, where 5 is the highest rating. When you submit your rating and review for a
TIP, Studio uploads the information to the Cast Iron® solutions repository. Your rating is combined with any
other ratings that have been submitted by other reviewers and the average is displayed in the Details pane of
the specific TIP.

You can rate and review TIPs using the Configuration Wizard to complete TIP configurations or by accessing the
Publish Review dialog box.

Procedure

When you open a TIP in the Configuration Wizard, the last step provides an opportunity to rate and review the
TIP.

1. Select Solutions > Start Configuration Wizard. The Configuration Wizard opens.
2. Complete each step of the wizard or just click Finish to go directly to the rating and review page.
3. In the rating and review page, move the My Rating slider until the appropriate number of stars are

highlighted. Ratings are on a scale between 1 and 5; 1 is the lowest, and 5 is the highest rating.
4. In the My Title field, add a brief description for your review.
5. In the My Summary field, add more details about your review of the project.
6. Click Submit Review. Studio submits the review to the Cast Iron solutions repository.
7. Click Close.

Rating and Reviewing Template Integration Projects (TIPs) using the Publish Review Dialog box
You can rate and provide a review for all Template Integration Projects (TIPs) that you download.
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Rating and Reviewing Template Integration Projects (TIPs)
using the Publish Review Dialog box

You can rate and provide a review for all Template Integration Projects (TIPs) that you download.
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About this task

You can rate and review a TIP without having to complete the configuration steps listed in the Configuration
Wizard, by using the Publish Review dialog box.

Procedure

1. In Studio, select Solutions > Create Review. The Publish Review window opens.
2. Move the My Rating slider until the appropriate number of stars is highlighted. Ratings are on a scale

between 1 and 5; 1 is the lowest, and 5 is the highest rating.
3. In the My Title field, add a brief description for your review.
4. In the My Summary field, add more details about your review of the project.
5. Click OK. Studio submits the review to the Cast Iron® solutions repository.

What to do next

You can edit a review by click the Edit Review link. The Publish Review window opens. Complete steps 3-5 as
described in the preceding procedure.
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Uploading Template Integration Projects (TIPs) to the Cast
Iron solutions repository

You can upload Template Integration Projects (TIPs) that you have created to the Cast Iron® solutions
repository.

Procedure

1. From the Studio menu, select Solutions > Upload Project to Repository. The Upload Project Wizard
opens.

2. Enter the following summary information:

Option Description

Parameter Description

Name Name of TIP.

Path Specify the location in the Cast Iron solutions repository to which Studio uploads the TIP.
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Option Description

Category Specify the type of TIP created:
Usecases
Best Practices
Utilities
General

Description Enter a brief description of the TIP.

3. Click Next.
4. Enter source and target endpoint information for the project:

Option Description

Source Endpoint Parameter Description

Name Name of source endpoint.

Description Enter a brief description of the source endpoint.

Version Specify a version number for the source endpoint configuration.

Option Description

Target Endpoint Parameter Description

Name Name of target endpoint.

Description Enter a brief description of the target endpoint.

Version Specify the version number of the target endpoint configuration.

5. Click Next.
6. Enter details about project patterns:

Option Description

Parameters Description

Name/Descriptio
n

Name/Value pair for project patterns

Click the appropriate field to specify the name and description for the project
pattern.

Click Add to specify additional patterns.

Click Delete to remove specified patterns.

Searchable Tags You can use this string value later to search for the project.

Creator Identify the person or entity that created the project. For example: John Smith or
IBM®.

Version Specify the version of the TIP you are uploading to the Cast Iron solutions
repository.

7. Click Finished. Studio uploads the TIP to the Cast Iron solutions repository.
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Transform Activities
Map Variables Activity
You can create a new Map Variables activity in an orchestration.
Read MIME activity
During run time, the Read MIME activity reads the MIME header and the body of the message. The Read
MIME activity breaks up the attachments contained in the body of the message and places the result
into the parts XML output parameter, as shown in the figure below.
Write MIME activity
During run time the Write MIME activity constructs a MIME header and the body of the message from
multiple attachments contained in the parts XML input parameter and optionally the mimeheader input
parameter, as shown in the figure below.
Read XML activity
The Read XML activity takes an XML document and parses it to a defined schema. XML data is returned
from this activity as the output parameter and the data can be used in subsequent activities.
Write XML activity
The Write XML activity takes a complex (XML) variable and outputs a string in the XML format containing
the data held in the complex variable. This string can then be written to a file or a database.
Validate XML activity
During run time, the Validate XML activity determines if the input XML data is valid to the specified XML
Schema or WSDL.
Read JSON activity
The Read JSON activity takes a JSON or XML message and parses it to a defined schema to generate an
output structure that can be used by the orchestration. At runtime this activity parses the JSON
message and generates equivalent XML that can be mapped to other Studio activities.
Write JSON activity
The Write JSON activity takes a structure equivalent to JSON as input and outputs a string in the JSON
format containing the data held in the complex variable. This string can then be written to a file or
posted using HTTP.
Validate JSON activity
During run time, the Validate JSON activity determines if the input JSON or XML data is valid to the
specified XML schema.
Read Flat File activity
The Read Flat File activity converts flat file data (non-XML data) to XML data by applying the specified
Flat File Schema. XML data is returned from this activity as the output parameter.
Write Flat File activity
The Write Flat File activity converts data from an orchestration into flat file data (non-XML data) that is
valid to the specified Flat File Schema.
Overview of OData Activities
Apply XSLT activity
You can use the Apply XSLT activity to transform XML data, stored in one XML variable, to XML data,
stored in another XML variable, using the specified XSLT stylesheet.
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Map Variables Activity
You can create a new Map Variables activity in an orchestration.

About this task

Using the Map Variables activity you can transform and initialize variables. You can transform the data from one
or more source variables to the data stored in one or more destination variables. For more information see
About Maps.

You can create a new Map Variables activity by completing one of the following procedures:

Procedure

1. Open or create an orchestration
2. If the activity is mapping variables that conform to a particular XML Schema or DTD, upload the XML

Schema or DTD file into you project using Uploading Files into a Project.
3. Open the Activities tab.
4. Drag the Map Variables activity from the Activities tab onto the orchestration.
5. If not already selected, click Design The Mapping Editor is displayed in the lower part of the pane.
6. Add variables to the From Orchestration pane.
7. Add variables to the To Orchestration pane.
8. Drag a source node from the From Orchestration pane to a destination node in the To Orchestration

pane. If the mapping is valid, a link (line) displays from the source node to the destination node,
indicating that a mapping rule has been established. Repeat this step until all the required nodes have
been mapped.

9. If possible, test your mappings to ensure that the output is what you expect. For more information, see
Testing maps.
Note: The Extensible Markup Language (XML) specification prohibits the use of non-printing unicode
control characters. The accepted character range is:

Char       :=       #x9 | #xA | #xD | [#x20-#xD7FF] | [#xE000-#xFFFD] | 
[#x10000-#x10FFFF]

Note: You can replace a variable used in the map without changing the links of the map. For more
information, see Replacing a Variable used in a Map
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Read MIME activity
During run time, the Read MIME activity reads the MIME header and the body of the message. The Read MIME
activity breaks up the attachments contained in the body of the message and places the result into the parts
XML output parameter, as shown in the figure below.

For example, an orchestration could contain a Get Email activity, that during run time gets an email message
from a POP3 endpoint and places the resulting email message in two variables, one XML variable that contains
the mail header and another string variable that contains the body of the email message. The next activity in
the orchestration could be a Read MIME activity that maps the contents of the mail header and the body
variables to its input parameters. If the mail message contains attachments, the Read MIME activity then
breaks up the attachments contained in the body of the message and places the result into the parts XML
output parameter.

Adding a Read MIME activity to an orchestration
Perform the steps in this section to add a Read MIME activity to an orchestration.
Mapping the input of the activity
In this task, you map the XML variable containing the MIME header part of the mail header and the string
variable containing the body of the message to the mimeheader and body input parameters of the Read
MIME activity, respectively. Variables must be mapped to the mime header and body input parameters—
both input parameters are required. The mime header input parameter is of type XML and the body input
parameter is of type string.
Mapping the output to an activity
In this task, you map the elements of the parts XML output parameter to variable(s).
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Adding a Read MIME activity to an orchestration
Perform the steps in this section to add a Read MIME activity to an orchestration.

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration displays.
2. Select the Activities tab and expand the Transform folder.
3. Drag the Read MIME activity onto the orchestration. Place the Read MIME activity after the activity that

gets the message, for example a Get Email activity.
4. Select the Read MIME activity and configure it as described in the next section.
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Mapping the input of the activity
In this task, you map the XML variable containing the MIME header part of the mail header and the string
variable containing the body of the message to the mimeheader and body input parameters of the Read MIME
activity, respectively. Variables must be mapped to the mime header and body input parameters—both input
parameters are required. The mime header input parameter is of type XML and the body input parameter is of
type string.

About this task

The following table defines the elements in the mimeheader input parameter:
Table 1.

Element
Name Default

mimeVersio
n

Currently not used.

contentTyp
e/mainType

Currently not used. The Read MIME activity determines if the message is multipart or not by
parsing the message using the specified boundary delimiter
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Element
Name Default

contentTyp
e/subType

Currently not used.

contentTyp
e/charset

Currently not used.

contentTyp
e/attribute/
name –
contentTyp
e/attribute/
value

The attribute element contains a set of attributes as name/value pairs. You can specify the
boundary attribute that specifies the boundary delimiter between the multipart entities of the
message. If you specify the boundary attribute, it overrides the default boundary set in the
message itself. If no boundary attribute is specified in the message itself or using the attribute
element, an exception is thrown during run time.

contentTran
sferEncodin
g

Currently not used.

otherMime
Headers

Currently not used.

The message body can contain one or more MIME parts separated by the boundary value specified in the
contentType/attribute element of the mimeheader input parameter. Each part contains a MIME header that
describes various attributes of the associated part body. How the individual part is parsed depends on the
values assigned to the following parameters in the entityMimeHeader of the entity body:

Content-Type header
Charset attribute within the Content-Type header
Content-Transfer-Encoding

How the part body is parsed depends on the settings of Content-Transfer-Encoding and Content-Type:

Content-Type is equal to “text:”

If the Content-Type is “text” and the Content-Transfer-Encoding is “7-bit”/”8-bit” or “binary,” the part
body is converted to an UTF8 encoded string and copied into the entityBody element of the parts
output parameter.
If the Content-Type is “text” and the Content-Transfer-Encoding is “quoted-printable,”the part body is
quoted-printable decoded, converted to an UTF8 encoded string based on the charset attribute and
copied into the entityBody element of the parts output parameter.
If the Content-Type is “text” and the Content-Transfer-Encoding is “base64,” the part body is base64
decoded, converted to an UTF8 encoded string based on the charset attribute and copied into the
entityBody element of the parts output parameter.

If not explicitly specified in the part MIME header, charset defaults to UTF8. The only exception to this default
behavior is when the Content-Disposition is equal to “attachment” and the Content-Type is equal to “text." In
this case, the part is not be treated as text since the charset of the data cannot be known. In addition, the
Content-Transfer-Encoding is set to "binary."

Content-Type is not equal to “text:”

If the Content-Type is not equal to “text” and the Content-Transfer-Encoding is “7bit”/”8bit” or “binary,”
the part body is converted to an UTF8 encoded string and copied into the entityBody element of the
parts output parameter.
If the Content-Type is not equal to “text” and the Content-Transfer-Encoding is “quoted-printable,” the
part body is quoted-printable decoded, base64 encoded, and copied into the entityBody element of the
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parts output parameter.
If the Content-Type is not equal to “text” and the Content-Transfer-Encoding is “base64,” the part body
is copied as is (base64 data) into the entityBody element of the parts output parameter.
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Mapping the output to an activity
In this task, you map the elements of the parts XML output parameter to variable(s).

The entity/entityBody element of the parts output parameter contains the body and the attachments of the
mail message. To access the body and the attachments of the mail message, you must iterate though the
instances of the entity element using the For Each or While Loop activities

The order of the attachments and the body in the entity element depend on the email client that sent the
message and the type of message (either plain text or HTML). For example, for a plain text email message sent
from a Microsoft Outlook client, the parts output parameter consists of the following entity elements:

The first entityBody element contains the body of the message.
If an attachment was included in the message, the second entityBody element contains the first
attachment.
If a second attachment was included in the message, the third entityBody element contains the second
attachment.

...and so on with the rest of the attachments.

You may need to decode the attachments before parsing the contents of the attachment. For example, an
attachment that is encoded with the base64 encoding must be decoded before the contents of the attachment
can parsed by the Read Flat File activity. Another attachment might be text and therefore can be parsed
without decoding.

Note: The Email and MIME activities can only process 8-bit or binary data using the UTF8 charset. Only MIME
1.0 compliant email messages are supported. The Read MIME activity can only parse email messages that
have come from a MIME 1.0 compliant Email Server. If the message you are parsing in the Read MIME activity
does not come from the Get Email activity but from another activity such as the HTTP Receive Request activity,
you must create a Flat File Schema to parse the MIME header from the payload.
Parent topic: Read MIME activity
Related concepts:
Read MIME activity

Feedback | Notices
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Write MIME activity
During run time the Write MIME activity constructs a MIME header and the body of the message from multiple
attachments contained in the parts XML input parameter and optionally the mimeheader input parameter, as
shown in the figure below.

For example, an orchestration could contain a Write MIME activity, that during run time constructs a MIME
header and a body of a message and places the result in two orchestration variables. The orchestration then
invokes a Send Email activity that takes these two orchestration variables as input and builds a mail message
and then sends that mail message to the specified SMTP endpoint.

The steps for adding and configuring a Write MIME activity in an orchestration are described in: Adding a Write
MIME activity to an orchestration.

Adding a Write MIME activity to an orchestration
Perform the steps in this section to add a Write MIME activity to an orchestration.
Mapping the input of the activity
In this task, you map the XML variables containing the MIME header and the parts (contains the
attachments) to the mimeheader and parts input parameters of the Write MIME activity, respectively.
Variable(s) must be mapped to the parts input parameter—this input parameter is required. The
mimeheader input parameter is optional. If you do not map to or define default values for the elements
of the mimeheader input parameter, default values are provided in the following table.
Mapping the output to an activity
In this task, you map the mimeheader (of type XML) and body (of type string) output parameters to
variable(s).

Parent topic: Transform Activities
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Adding a Write MIME activity to an orchestration
Perform the steps in this section to add a Write MIME activity to an orchestration.

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Transform folder.
3. Drag the Write MIME activity onto the orchestration. Place the Write MIME activity before the activity

that pushes the message to an endpoint during run time. For example, place the Write MIME activity
before the Send Email activity in the orchestration. During run time, Send Email activity sends the email
message to the POP3 server.

4. Select the Write MIME activity and configure it as described in the next section.

Parent topic: Write MIME activity
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Mapping the input of the activity
In this task, you map the XML variables containing the MIME header and the parts (contains the attachments)
to the mimeheader and parts input parameters of the Write MIME activity, respectively. Variable(s) must be
mapped to the parts input parameter—this input parameter is required. The mimeheader input parameter is
optional. If you do not map to or define default values for the elements of the mimeheader input parameter,
default values are provided in the following table.

About this task

If the mimeheader input parameter is not listed in the To Activity pane of the Map Inputs pane, select Map >
Show Optional Parameters from the toolbar menu or right-click in the To Activity pane and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the toolbar
menu, click on a element in the Map Inputs pane to make this option active.
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The following table defines the elements in the mimeheader input parameter:
Table 1.

Child
Elemen
t of the
mimehe
ader
Input
Parame
ter Default Value

mimeVe
rsion

The standard MIME Version of 1.0 is assigned. The resulting MIME header is equal to the following
setting: MIME-Version: 1.0.

content
Type

The value of the Content-Type setting in the resulting MIME header is equal to the following setting:
Content-Type: multipart/mixed.

content
Type/att
ribute/n
ame
content
Type/att
ribute/v
alue

The attribute element contains a set of attributes as name/value pairs. The boundary between
attachments can be specified using a boundary attribute element. If a boundary attribute is not
specified a default value is generated.

content
Transfer
Encodin
g

The value of the Content-Transfer-Encoding in the resulting MIME header is equal to the following
setting: Content-Transfer-Encoding: 7-bit. NOTE: The Content-Transfer-Encoding you
specify in this element for the main MIME header cannot be more restrictive than Content-Transfer-
Encoding of the entity MIME headers. For example if you specify that the Content-Transfer-
Encoding for the main MIME header is 7-bit but the Content-Transfer-Encoding specified in the
entity MIME headers is 8-bit, the Content-Transfer-Encoding of the main MIME header is changed
to 8-bit.

If you do not specify values for some of the child elements of the parts input parameter, defaults are described
in the following table.

Table 2.
Chil
d
Ele
men
t of
the
part
s
Inpu
t
Para
met
er Default Value

mim
eVer
sion

The standard MIME Version of 1.0 is assigned. The resulting MIME header contains the following
setting: MIME-Version: 1.0.
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cont
entT
ype

The value of the Content-Type in the resulting MIME header contains the following setting: Content-
Type: text/plain; charset=US-ASCII.

cont
entT
ransf
erEn
codi
ng

The value of the Content-Transfer-Encoding in the resulting MIME header depends on the Content-
Type setting. If the Content-Type is equal to multipart, the resulting MIME header contains the
following setting: Content-Transfer-Encoding: 7-bit. If the Content-Type is equal to text and
charset is equal to not-us-ascii (where not-us-ascii is any type except US-ASCII) the resulting MIME
header contains the following setting: Content-Transfer-Encoding: quoted-printable. If the
Content-Type is equal to non-text, the resulting MIME header contains the following setting:
Content-Transfer-Encoding: base64. NOTE: If the Content-Disposition is equal to attachment,
the entity part is not treated as text.

The parts input parameter can contain one or more parts. Each part contains a MIME header that describes
various attributes of the associated part body. How the individual MIME part is serialized depends on the
values assigned to the following parameters in the mine header:

Content-Type header
Charset attribute within the Content-Type header
Content-Transfer-Encoding

How the part body is serialized depends on the settings of Content-Transfer-Encoding and Content-Type:

Content-Type is equal to “text:”

If the Content-Type is “text” and the Content-Transfer-Encoding is “7-bit”/”8-bit” or “binary,” the part
body is converted from UTF8 charset to the charset specified and copied into the body output
parameter.
If the Content-Type is “text” and the Content-Transfer-Encoding is “quoted-printable,” the part body is
converted from UTF8 charset to the charset specified, quoted-printable encoded and copied into the
body output parameter.
If the Content-Type is “text” and the Content-Transfer-Encoding is “base64," the part body is converted
from UTF8 charset to the charset specified, base64 encoded, and copied into the body output
parameter.

If not explicitly specified in the part MIME header, charset defaults to "UTF8." The only exception to this default
behavior is when the Content-Disposition is equal to “attachment” and the Content-Type is equal to “text.” In
this case, the part is not treated as text since the charset of the data cannot be known. In addition for this case,
the Content-Transfer-Encoding is set to "binary."

Content-Type is not equal to “text:”

If the Content-Type is not equal to “text” and the Content-Transfer-Encoding is “7bit”/”8bit” or “binary,”
the part body is copied to the body output parameter as is.
If the Content-Type is not equal to “text” and the Content-Transfer-Encoding is “quoted-printable,” the
part body is base64 decoded, quoted-printable encoded and copied into the body output parameter.
If the Content-Type is not equal to “text” and the Content-Transfer-Encoding is “base64,” the part body
is copied as is (base64 data) into the body output parameter.

See Creating a Standalone Map for general instructions on mapping.

Parent topic: Write MIME activity

Feedback | Notices

114   



 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Map_Activity_Input_Write_MIME.html

Mapping the output to an activity
In this task, you map the mimeheader (of type XML) and body (of type string) output parameters to variable(s).

For an email message with no message body and a single attachment of a text file, the text attachment
becomes the body of the message.

The Email and MIME activities can only process 8-bit or binary data using the UTF8 charset.

Parent topic: Write MIME activity
Related concepts:
Read MIME activity
Related information:
Get Email activity
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Read XML activity
The Read XML activity takes an XML document and parses it to a defined schema. XML data is returned from
this activity as the output parameter and the data can be used in subsequent activities.

About this task

The input parameter of the Read XML activity expects XML text. This data can be obtained from various
endpoint activities such as the FTP Poll Directory activity reading a file containing XML data or HTTP Receive
Request activity. The input data must be a well formed XML document or the activity will error. You must create
an XML variable (see the Variables tab) before you can use an XML Schema in the Configure task. The XML
variable can be defined by adding an XML schema to the project or by using an existing variable.
Note: If no function is defined in the Map Outputs for the Read XML activity and there is a straight mapping, in
the From Activity to the To Orchestration, the XML data is passed to the output activity without validating
against the schema that is specified in the XML variable.
Note: If there are any functions or other changes to the mappings in the Map Outputs for the Read XML activity,
and the content does not match the schema, then an empty XML document is provided as the output of the
Read XML activity.

To add a Read XML activity to an orchestration:

Procedure
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1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Transform folder.
3. Drag the Read XML activity onto the orchestration. Place it to the right of an activity from which the

orchestration will obtain the XML data (for example, an FTP Poll Directory).
4. Select the Read XML activity and configure it as described in Read XML activity configuration.

Read XML activity configuration
You can specify the XML Schema to apply to the Read XML input parameter.
Read XML map inputs
You can map a string variable that contains the XML data to the input parameter of the Read XML
activity called XMLText.
Read XML map output
You can map the OutputXml output parameter that contains the XML data (stored as a string) to a
variable valid to the specified XML Schema.

Parent topic: Transform Activities
Related tasks:
Read XML activity configuration
Read XML map inputs
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Read XML activity configuration
You can specify the XML Schema to apply to the Read XML input parameter.

About this task

You must create an XML variable that defines the schema before starting this task.

Procedure

1. In the XML Variable that defines the XML schema to parse, click Browse. The Select a Variable to Parse
dialog box is displayed.

2. Select the appropriate XML Variable and click OK.
3. Specify how to read the data passed into the XMLText input parameter during run time by selecting one

of the appropriate options:
a. Select the Data is text-Needs no decoding option if the incoming data is text and does not need

decoding.
b. Select the Decode data using encoding type option if incoming data is binary data that needs to

be decoded using the specified encoding type. Set the encoding type by selecting a default
encoding type from the Decode data using encoding type list or enter your encoding type by
clicking in the Decode data using encoding type field and typing in your encoding type.

4. Click OK.
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Read XML map inputs
You can map a string variable that contains the XML data to the input parameter of the Read XML activity called
XMLText.

About this task

XMLText is an input parameter of type string or base64Binary. During run time the string variable must contain
well formed XML data before the Read XML activity is run. The Encoding input parameter is optional. (You are
not required to map this input parameter). If the Encoding input parameter is not listed in the To Activity pane
of the Map Inputs pane, select Map > Show Optional Parameters from the toolbar menu or right-click the To
Activity pane and select the Show Optional Parameters option. If the Map > Show Optional Parameters
option is not selectable in the toolbar menu, click a node in the Map Inputs pane to make the option active.
The Encoding input parameter specifies how the incoming data is decoded when read.

Procedure

1. If no decoding is required, specify the string: text.
2. If decoding is required, specify the encoding type to be used to decode the incoming data. For example:

UTF-8, US-ASCII, ISO-8859-1, EBCDIC-XML-US, or SHIFT_JIS.

Example

Optionally, you can override the Encoding setting you specified in the Configure task of the Checklist
dynamically during run time, using the Encoding input parameter. For example, if you set the Encoding to UTF-8
in the Configure task but during run time you passed in the Encoding setting of Shift_JIS, the Encoding setting
specified dynamically during run time overrides the original setting specified in the Configure pane. In this
example, the Encoding is set to Shift_JIS. There is one exception to the dynamic overriding behavior: if the
XMLText is text-Needs no decoding or encoding option is selected in the Configure task, the Encoding
dynamically set during run time is ignored and no decoding occurs.
Parent topic: Read XML activity
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Read XML map output
You can map the OutputXml output parameter that contains the XML data (stored as a string) to a variable valid
to the specified XML Schema.

See Creating a Standalone Map for general instructions on mapping.

During run time, an orchestration could invoke the following sequence of activities:

1. A FTP Poll Directory activity assigns the contents of a flat file to a String variable called
XMLRawContent.

2. A Read XML activity assigns the contents of the XMLRawContent variable to the string input parameter
called XMLText.

3. The Read XML activity converts XMLTesta to XML data and passes the XML data back to the
orchestration via the output parameter. The contents of the output parameter are assigned to the
variable valid to the XML Schema. The data XML input document can now be used and mapped within
the orchestration.

Parent topic: Read XML activity
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Write XML activity
The Write XML activity takes a complex (XML) variable and outputs a string in the XML format containing the
data held in the complex variable. This string can then be written to a file or a database.

About this task

The string is returned as an output parameter. The data from the orchestration must come from a complex
variable which, on the variables tab, is indicated by the XML icon. You must create the input XML variable that
defines the schema.

To add a Write XML activity to an orchestration:

Procedure

1. Create or open an orchestration. For more information, see Building an orchestration. A graphical
representation of the orchestration is displayed.

2. Select the Activities tab and expand the Transform folder.
3. Drag the Write XML activity onto the orchestration.
4. Select the Write XML activity and configure it as described in Write XML activity configuration.

Write XML activity configuration
For this task, you specify the XML Schema for the inbound data. The inbound data must be defined by an
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XML variable that defines the schema. You specify the XML Schema that applies to the input parameter.
Write XML map inputs
You can map the data from variables of the orchestration to the InputXML parameter defined by the XML
Schema specified in the Configure task.
Write XML map output
You can map the XMLText output parameter that contains the XML data to a string variable.

Parent topic: Transform Activities
Related concepts:
Write XML map output
Related tasks:
Write XML activity configuration
Write XML map inputs
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Write XML activity configuration
For this task, you specify the XML Schema for the inbound data. The inbound data must be defined by an XML
variable that defines the schema. You specify the XML Schema that applies to the input parameter.

Procedure

1. In the XML variable that defines the XML schema to serialize, click Browse. The Select a Variable to
Serialize dialog box is displayed.

2. Select the appropriate XML variable and click OK.
3. Specify how the data defined by the OutputXML output parameter is to be encoded:

a. Select the Data is text-Needs no decoding or encoding option if the data is text and does not
require encoding.

b. Select the Decode or encode data using encoding type option if outgoing data is binary data that
requires encoding using the specified encoding type.

4. Set the encoding type using one of the following options:
a. From the Decode or encode data using encoding type list, select one of the default encoding

types.
b. Click directly in the Decode or encode data using encoding type field and enter your encoding

type.
5. Click OK.

Parent topic: Write XML activity

Feedback | Notices
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Write XML map inputs
You can map the data from variables of the orchestration to the InputXML parameter defined by the XML
Schema specified in the Configure task.

About this task

The Encoding input parameter is optional. You are not required to map this input parameter. If the Encoding
input parameter is not listed in the To Activity pane of the Map Inputs pane, select Map > Show Optional
Parameters from the toolbar menu or right-click in the To Activity pane and select the Show Optional
Parameters option. If the Map > Show Optional Parameters option is not selectable in the toolbar menu, click
on a node in the Map Inputs pane to make this option active. The Encoding input parameter specifies how
outgoing data should be encoded for this procedure.

Procedure

1. If no decoding is required, specify the string: text.
2. If encoding is required, specify the encoding type that should be used to encode the outgoing data, for

example: UTF-8, US-ASCII, ISO-8859-1, EBCDIC-XML-US, or SHIFT_JIS.

Example

Optionally, you can override the Encoding setting you specified in the Configure task of the Checklist
dynamically during run time, using the Encoding input parameter. For example, if you set the Encoding to UTF-8
in the Configure task but during run time you passed in the Encoding setting of Shift_JIS. The Encoding setting
specified dynamically during run time overrides the original setting specified in the Configure pane. In this
example, the Encoding is set to Shift_JIS. There is one exception to the dynamic overriding behavior: if the
Data is text-Needs no decoding or encoding option is selected in the Configure task, the Encoding that is
dynamically set during run time is ignored. See Creating an orchestrationfor more information.
Parent topic: Write XML activity
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Write XML map output
You can map the XMLText output parameter that contains the XML data to a string variable.

See Creating a map for general instructions on mapping.
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Validate XML activity
During run time, the Validate XML activity determines if the input XML data is valid to the specified XML
Schema or WSDL.

The Validate XML activity has the following limitations:

The Validate XML activity only supports the validation of the selected root element of an XML Schema.
The validation of XML Schema fragments is not supported. If the XML Schema contains more than one
root (or global element), you must select one of the root elements.
The Validate XML activity does not support the validation of XML data against a DTD.

Note: You must upload an XSD file (ends in the .xsd extension) that contains the XML Schema into the project
before configuring the Validate XML activity. Upload the XML Schema into the project that is used to validate
the XML data during run time.
The following table describes the result when an error or warning occurs when the Validate XML activity is
parsing XML data against an XML Schema.

Table 1.
Error/Warning
Type Description Example Result

Fatal Error Parsing of the
XML data fails
because of a
severe problem
and the parsing
cannot continue.
For example, the
XML data is not
valid to the XML
Schema.

The XML data is not valid to the
XML Schema. For example, the
XML Schema defines that there
should be a root element called
<d> but the XML data contains the
root element called <a>.

When a fatal error occurs, the
current orchestration job stops
processing— even the processing
of the Validate XML activity does
not complete. In addition, the
activities in the orchestration after
the Validate XML activity are not
processed. The value returned
from the Validate XML activity for
the success output parameter is
false but since the activity never
completes, nothing is returned.
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Error/Warning
Type Description Example Result

Error
(recoverable)

An error occurs
during the
parsing of XML
data but it does
not prevent the
parsing of rest of
the XML data.

An XML element in an integer but a
string is provided as a value: <a>
<count>two</count></a>

If only recoverable errors or
warnings occur during parsing, the
processing of the Validate XML
activity completes and the
activities in the orchestration after
the Validate XML activity are
processed. The value of false is
returned from the success output
parameter.

Warning A warning occurs
during the
parsing of XML
data but it does
not prevent the
parsing of rest of
the XML data

  If only warnings occur during
parsing, the processing of the
Validate XML activity completes
and the activities in the
orchestration after the Validate
XML activity are processed. The
value of true is returned from the
success output parameter.

Adding a Validate XML activity to an orchestration
Perform the steps in this section to add a Validate XML activity to an orchestration.
Configuring a Validate XML activity
Perform the steps in this section to configure a Validate XML activity.
Mapping the input to an activity
Do the steps in this section to map the input to an activity for Validate XML.
Mapping the output to an activity - Validate XML
Do the steps in this section to map the output to an activity for Validate XML.

Parent topic: Transform Activities
Related concepts:
Mapping the input to an activity
Mapping the output to an activity - Validate XML

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Validate_XML_activity.html

Adding a Validate XML activity to an orchestration
Perform the steps in this section to add a Validate XML activity to an orchestration.

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Transform folder.
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3. Drag the Validate XML activity onto the orchestration.
4. Select the Validate XML activity.

Parent topic: Validate XML activity

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Add_Validate_XML_Activity_to_Orchest
ration.html

Configuring a Validate XML activity
Perform the steps in this section to configure a Validate XML activity.

Procedure

1. Click Configure from the Checklist.
2. In the XML Schema field, click Browse. The Browse For Schema Type Element dialog box displays.

Select the XML schema to parse against during run time. You must select a root or global element and
not a schema fragment. The selected XML schema defines the nodes that make up the InputXml input
parameter in the Map Inputs task.

3. Select or clear the Continue Parsing XML Data after First Recoverable Error check box. (This check
box defines the run-time behavior when a recoverable error occurs).

Results

If the Continue Parsing XML Data after First Recoverable Error check box is selected and only recoverable
errors and warnings occur but no fatal errors, the processing of the Validate XML activity completes after the
first recoverable error and the value false is returned from the success output parameter. Only the first error is
returned in the errors output parameter. The activities in the orchestration after the Validate XML activity are
processed.

If the Continue Parsing XML Data after First Recoverable Error check box is cleared and only recoverable
errors and warnings occur but no fatal errors, the processing of the Validate XML activity processes all the
recoverable errors and the value false is returned from the success output parameter. Messages about all the
recoverable errors are returned in the repeating Message node of the errors output parameter. The activities in
the orchestration after the Validate XML activity are processed.

Parent topic: Validate XML activity

Feedback | Notices
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Mapping the input to an activity
Do the steps in this section to map the input to an activity for Validate XML.

1. Select the Map Inputs task in the Checklist. The XML Schema you selected in the Configuring a Validate
XML activity procedure becomes the input parameter for the activity. The input parameter for the activity
is displayed in the From Orchestration pane.

2. Map the nodes of the XML Schema of the input parameter. See Creating a Standalone Map for general
instructions on mapping.

Parent topic: Validate XML activity
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Mapping the output to an activity - Validate XML
Do the steps in this section to map the output to an activity for Validate XML.

To map the output of the activity:

1. Select the Map Outputs task in the Checklist. The output parameters for the activity are displayed in the
From Activity pane as described in the following table:

Table 1.
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During run time, if the parsing was successful, the value of true is returned. If parsing was
unsuccessful, the value of false is returned. If fatal errors occur during parsing, the value of false is
returned. If recoverable errors occur during parsing, the value of false is returned. If only warnings
occur during parsing, the value of true is returned. In addition, if no warnings or errors occur during
parsing, the value of true is returned. Map from the success output parameter to a variable of type
string. In XPATH expressions, compare the value of the string variable against the string values of
true and false.
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The type of error/warning for the last error or warning that occurred during run time.

e
r
r
o
r
s
/
M
e
s
s
a
g
e

A repeating structure that contains a string that describes each error and warning that occurred
during run time. All parsing warnings, fatal errors, and recoverable errors are returned.

2. Map the desired output parameters to variable(s). See Creating a Standalone Map for general
instructions on mapping. You are not required to map output parameters for this activity.

Parent topic: Validate XML activity
Related tasks:
Read XML activity

Feedback | Notices
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Read JSON activity
The Read JSON activity takes a JSON or XML message and parses it to a defined schema to generate an output
structure that can be used by the orchestration. At runtime this activity parses the JSON message and
generates equivalent XML that can be mapped to other Studio activities.

About this task

The input parameter of the Read JSON activity expects sample JSON or equivalent sample XML text.
(Equivalent JSON or XML text is available from the JSON/REST API documentation). The input data must be a
well formed JSON or XML message or the activity fails. If you do not use a schema, you must create a JSON
variable (see the Variables tab) before you can use an XML schema in the Configure task. The variable can be
defined by adding an XML schema to the project or by utilizing an existing variable. Once the JSON/REST
sample is provided, the activity generates an equivalent structure for JSON/XML. The XML is mapped to the
activity output which can be used by the orchestration. At runtime this activity consumes the JSON message
and generates equivalent XML that can be mapped to other studio activities.

To add a Read JSON activity to an orchestration:

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Transform folder.
3. Drag the Read JSON activity onto the orchestration. Place it to the right of an activity from which the

orchestration will obtain the JSON data (for example, an FTP Poll Directory).
4. Select the Read JSON activity and configure it as described in Read JSON activity.

Read JSON activity configuration
You can apply a sample JSON or XML message to the Read JSON input parameter. Use of a schema is
optional for this step.
Read JSON map inputs
You can map a string variable that contains JSON data to the input parameter of the Read JSON activity
called JSONText.
Read JSON map output
You can map the OutputJSON output parameter that contains the JSON data (stored as a string) to a
variable valid to the specified XML schema.

Parent topic: Transform Activities
Related tasks:
Read JSON activity configuration
Read JSON map inputs
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Read JSON activity configuration
You can apply a sample JSON or XML message to the Read JSON input parameter. Use of a schema is optional
for this step.

About this task

If you're applying a JSON or XML message to the Read JSON input parameter, do the following steps:

Note: Because not all JSON messages contain a root node, Studio, by default, adds a virtual root element to all
JSON messages during a write JSON activity. (Virtual nodes facilitate handling of rootless messages in Studio).
To determine if a root node is present, view the message in the Configure panel. If the message does not
contain a root element, Studio will automatically generate one during the write JSON activity and display it in
the root element file. To remove the root element, delete it from the Configure panel so the output message
matches the required structure.

Procedure

1. Click Configure from the Checklist. The Configure window is displayed.
2. In the Configure window, copy the JSON or XML message into the text area and click Generate Output

Map. If you're specifying an XML schema to apply to the Read JSON input parameter, do the following
additional steps: (a) In the Select XML Schema pane click the Select XML Schema button to browse for
the XML schema, then (b) select the XML schema to parse against during run time and click OK. (You
must select a root or global element and not a schema fragment).

3. Specify how to read the data passed into the JSONText input parameter during run time by selecting one
of the appropriate options:

a. Select the Data is text-Needs no decoding option if the incoming data is text and does not need
decoding.

b. Select the Decode data using encoding type option if incoming data is binary data that needs to
be decoded using the specified encoding type. Set the encoding type by selecting a default
encoding type from the Decode data using encoding type list or enter your encoding type by
clicking in the Decode data using encoding type field and typing in your encoding type.

4. Click OK.

Parent topic: Read JSON activity
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Read JSON map inputs
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You can map a string variable that contains JSON data to the input parameter of the Read JSON activity called
JSONText.

About this task

JSONText is an input parameter of type string or base64Binary. During run time the string variable must contain
well formed JSON data before the Read JSON activity is run. The Encoding input parameter is optional. (You
are not required to map this parameter). If the Encoding input parameter is not listed in the To Activity pane of
the Map Inputs pane, select Map > Show Optional Parameters from the toolbar menu or right-click the To
Activity pane and select the Show Optional Parameters option. If the Map > Show Optional Parameters
option is not selectable in the toolbar menu, click a node in the Map Inputs pane to make the option active.
The Encoding input parameter specifies how the incoming data is decoded when read.

Procedure

1. If no decoding is required, specify the string: text.
2. If decoding is required, specify the encoding type to be used to decode the incoming data. For example:

UTF-8, US-ASCII, ISO-8859-1, EBCDIC-XML-US, or SHIFT_JIS.

Example

Optionally, you can override the Encoding setting you specified in the Configure task of the Checklist
dynamically during run time, using the Encoding input parameter. For example, if you set the Encoding to UTF-8
in the Configure task but during run time you passed in the Encoding setting of Shift_JIS, the Encoding setting
specified dynamically during run time overrides the original setting specified in the Configure pane. In this
example, the Encoding is set to Shift_JIS. There is one exception to the dynamic overriding behavior: if the
JSONText is text-Needs no decoding or encoding option is selected in the Configure task, the Encoding
dynamically set during run time is ignored and no decoding occurs.
Parent topic: Read JSON activity
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Read JSON map output
You can map the OutputJSON output parameter that contains the JSON data (stored as a string) to a variable
valid to the specified XML schema.

See Creating a Standalone Map for general instructions on mapping.

During run time, an orchestration could invoke the following sequence of activities:

1. An HTTP Receive activity assigns the received body to a String variable called JSONRawContent.
2. A Read JSON activity assigns the contents of the JSONRawContent variable to the string input

parameter called JSONText.
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3. The Read JSON activity converts JSON data to XML data and passes the XML back to the orchestration
via the output parameter. The contents of the output parameter are assigned to the variable valid to the
XML schema. The data JSON input document can now be used and mapped within the orchestration.

Parent topic: Read JSON activity
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Write JSON activity
The Write JSON activity takes a structure equivalent to JSON as input and outputs a string in the JSON format
containing the data held in the complex variable. This string can then be written to a file or posted using HTTP.

About this task

The JSON string is returned as an output parameter. (This is only applicable if you use a schema). The
orchestration data must come from a complex variable which is indicated by the XML icon on the Variables tab.
You configure the activity by pasting a JSON or XML sample message (available in the JSON/REST API
documentation) in the Configure panel. This generates a compatible input structure for mapping the input data,
which is then converted to a JSON message.

To add a Write JSON activity to an orchestration:

Procedure

1. Create or open an orchestration. For more information, see Building an orchestration. A graphical
representation of the orchestration is displayed.

2. Select the Activities tab and expand the Transform folder.
3. Drag the Write JSON activity onto the orchestration.
4. Select the Write JSON activity and configure it as described in Write JSON activity configuration.

Write JSON activity configuration
During this procedure, you apply a sample JSON or XML message to the Write JSON input parameter. If
you prefer, you can also use a schema for this task.
Write JSON map inputs
You can map data from variables in the orchestration to the InputJSON parameter defined by the XML
schema specified in the Configure task or use sample JSON/REST XML and the Configure panel to
generate the input structure.
Write JSON map output
You can map the JSONText output parameter that contains the JSON data to a string variable.

Parent topic: Transform Activities
Related concepts:
Write JSON map output
Related tasks:
Write JSON activity configuration
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Write JSON activity configuration
During this procedure, you apply a sample JSON or XML message to the Write JSON input parameter. If you
prefer, you can also use a schema for this task.

About this task

Note: Because not all JSON messages contain a root node, Studio, by default, adds a virtual root element to all
JSON messages during a write JSON activity. (Virtual nodes facilitate handling of rootless messages in Studio).
To determine if a root node is present, view the message in the Configure panel. If the message does not
contain a root element, Studio will automatically generate one during the write JSON activity and display it in
the root element file. To remove the root element, delete it from the Configure panel so the output message
matches the required structure.

Procedure

1. Click Configure from the Checklist. The Configure window is displayed.
2. In the Configure window, you can either use an XML Schema or JSON or XML message to generate map.

a. If you are specifying an XML schema to apply to the Write JSON input parameter, do the following:
In the Select XML Schema field, click the Select XML Schema button to browse and select XML
schema. Select the XML schema to parse during run time and click OK.

b. If you want to use the JSON or XML message, copy the JSON or XML message into the Use JSON
or XML message to generate the output schema text area.

3. Choose a Virtual Root Configuration.
a. When you use JSON or XML message to generate map, if more than one element present in JSON,

then by default, Remove root Element is checked automatically.
b. When you use XML Schema to generate map, Remove root Element is not checked by default.

Note: If the Remove Root Element is checked, the first root element is skipped and the JSON text is
created properly with the remaining elements. You can specify a Root Element Name. However if the
Remove Root Element is not checked, then for all the complex types will not get the root element names
and hence will be displayed as null.

4. Specify how the data defined by the OutputJSON output parameter is to be encoded:
a. Select the Data is text-Needs no decoding or encoding option if the data is text and does not

require encoding.
b. Select the Encode data using encoding type option if outgoing data is binary data that requires

encoding using the specified encoding type.
5. Set the encoding type using one of the following options:

a. From the Encode data using encoding type list, select one of the default encoding types.
b. Click directly in the Encode data using encoding type field and enter your encoding type.
c. Click OK.

6. Click Generate Map.
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Write JSON map inputs
You can map data from variables in the orchestration to the InputJSON parameter defined by the XML schema
specified in the Configure task or use sample JSON/REST XML and the Configure panel to generate the input
structure.

About this task

The Encoding input parameter is optional and you are not required to map it. If the Encoding input parameter is
not listed in the To Activity pane of the Map Inputs pane, select Map > Show Optional Parameters from the
toolbar menu or right-click in the To Activity pane and select the Show Optional Parameters option. If the
Map > Show Optional Parameters option is not selectable in the toolbar menu, click on a node in the Map
Inputs pane to make this option active. The Encoding input parameter specifies how outgoing data should be
encoded for this procedure.

Procedure

1. If no decoding is required, specify the string: text.
2. If encoding is required, specify the encoding type to be used to encode the outgoing data, for example:

UTF-8, US-ASCII, ISO-8859-1, EBCDIC-XML-US, or SHIFT_JIS.

Example

Optionally, you can override the Encoding setting you specified in the Configure task of the Checklist
dynamically during run time using the Encoding input parameter. For example, if you set the Encoding to UTF-8
in the Configure task but during run time you passed in the Encoding setting of Shift_JIS. The Encoding setting
specified dynamically during run time overrides the original setting specified in the Configure pane. In this
example, the Encoding is set to Shift_JIS. There is one exception to the dynamic overriding behavior: if the
Data is text-Needs no decoding or encoding option is selected in the Configure task, the Encoding that is
dynamically set during run time is ignored. See Creating an orchestration for more information.
Parent topic: Write JSON activity
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Write JSON map output
You can map the JSONText output parameter that contains the JSON data to a string variable.

See Creating a Standalone Mapfor general instructions on mapping.

Parent topic: Write JSON activity
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Validate JSON activity
During run time, the Validate JSON activity determines if the input JSON or XML data is valid to the specified
XML schema.

The Validate JSON activity has the following limitations:

The Validate JSON activity only supports the validation of the selected root element of an XML schema.
The validation of XML schema fragments is not supported. If the XML schema contains more than one
root (or global element), you must select one of the root elements.
The Validate JSON activity does not support the validation of JSON or XML data against a DTD.

Note: You must upload an XSD file (ends in the .xsd extension) that contains the XML schema into the project
before configuring the Validate JSON activity. Upload the XML schema into the project that is used to validate
the JSON data during run time.
The following table describes the result when an error or warning occurs when the Validate JSON activity is
parsing JSON or XML data against an XML schema.

Table 1.
Error/Warning
Type Description Example Result

Fatal Error Parsing of the
JSON data fails
because of a
severe problem
and the parsing
cannot continue.
For example, the
JSON or XML
data is not valid
to the XML
schema.

The JSON or XML data is not valid
to the XML schema. For example,
the XML schema defines that there
should be a root element called
<d> but the JSON or XML data
contains the root element called
<a>.

When a fatal error occurs, the
current orchestration job stops
processing— even the processing
of the Validate JSON activity does
not complete. In addition, the
activities in the orchestration after
the Validate JSON activity are not
processed. The value returned
from the Validate JSON activity for
the success output parameter is
false but since the activity never
completes, nothing is returned.
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Error/Warning
Type Description Example Result

Error
(recoverable)

An error occurs
during the
parsing of JSON
data but does not
prevent parsing
of the remaining
data.

A JSON element in an integer but a
string is provided as a value: <a>
<count>two</count></a>

If only recoverable errors or
warnings occur during parsing, the
processing of the Validate JSON
activity completes and the
activities in the orchestration after
the Validate JSON activity are
processed. The value of false is
returned from the success output
parameter.

Warning A warning occurs
during the
parsing of JSON
data but does not
prevent parsing
of the remaining
data

  If only warnings occur during
parsing, the processing of the
Validate JSON activity completes
and the activities in the
orchestration after the Validate
JSON activity are processed. The
value of true is returned from the
success output parameter.

Adding a Validate JSON activity to an orchestration
Perform the steps in this section to add a Validate JSON activity to an orchestration.
Configuring a Validate JSON activity
Perform the steps in this section to configure a Validate JSON activity.
Mapping the input to an activity - Validate JSON
Do the steps in this section to map the input to an activity for Validate JSON.
Mapping the output to an activity - Validate JSON
Do the steps in this section to map the output to an activity for Validate JSON.

Parent topic: Transform Activities
Related concepts:
Mapping the input to an activity
Mapping the output to an activity - Validate XML
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Adding a Validate JSON activity to an orchestration
Perform the steps in this section to add a Validate JSON activity to an orchestration.

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Transform folder.
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3. Drag the Validate JSON activity onto the orchestration.
4. Select the Validate JSON activity.

Parent topic: Validate JSON activity
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Configuring a Validate JSON activity
Perform the steps in this section to configure a Validate JSON activity.

Procedure

1. Click Configure from the Checklist. The Configure window is displayed.
2. In the XML Schema field, click Browse. The Browse For Schema Type Element dialog box displays.

Select the XML schema to parse against during run time. You must select a root or global element and
not a schema fragment. The selected XML schema defines the nodes that make up the InputJSON input
parameter in the Map Inputs task.

3. Select or clear the Continue Parsing JSON Data after First Recoverable Error check box. (This check
box defines the run-time behavior when a recoverable error occurs).

Results

If the Continue Parsing JSON Data after First Recoverable Error check box is selected and only recoverable
errors and warnings occur but no fatal errors, processing of the Validate JSON activity completes after the first
recoverable error and the value false is returned from the success output parameter. Only the first error is
returned in the errors output parameter. The activities in the orchestration after the Validate JSON activity are
processed.

If the Continue Parsing JSON Data after First Recoverable Error check box is cleared and only recoverable
errors and warnings occur but no fatal errors, the processing of the Validate JSON activity processes all the
recoverable errors and the value false is returned from the success output parameter. Messages about all the
recoverable errors are returned in the repeating Message node of the errors output parameter. The activities in
the orchestration after the Validate JSON activity are processed.

Parent topic: Validate JSON activity
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Mapping the input to an activity - Validate JSON
Do the steps in this section to map the input to an activity for Validate JSON.

Procedure

1. Select the Map Inputs task in the Checklist. The XML schema you selected in the Configuring a Validate
JSON activity procedure above becomes the input parameter for the activity. The input parameters for
the activity are displayed in the From Orchestration pane.

2. Map the nodes of the XML schema of the input parameter. See Creating a Standalone Map for general
instructions on mapping.

Parent topic: Validate JSON activity
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Mapping the output to an activity - Validate JSON
Do the steps in this section to map the output to an activity for Validate JSON.

To map the output of the activity:

1. Select the Map Outputs task in the Checklist. The output parameters for the activity are displayed in the
From Activity pane as described in the following table:

Table 1.
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During run time, if the parsing was successful, the value of true is returned. If parsing was
unsuccessful, the value of false is returned. If fatal errors occur during parsing, the value of false is
returned. If recoverable errors occur during parsing, the value of false is returned. If only warnings
occur during parsing, the value of true is returned. In addition, if no warnings or errors occur during
parsing, the value of true is returned. Map from the success output parameter to a variable of type
string. In XPATH expressions, compare the value of the string variable against the string values of
true and false.
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The type of error/warning for the last error or warning that occurred during run time.
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A repeating structure that contains a string that describes each error and warning that occurred
during run time. All parsing warnings, fatal errors, and recoverable errors are returned.

2. Map the desired output parameters to variable(s). See Creating a Standalone Mapfor general
instructions on mapping. You are not required to map output parameters for this activity.

Parent topic: Validate JSON activity
Related concepts:
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Read Flat File activity
The Read Flat File activity converts flat file data (non-XML data) to XML data by applying the specified Flat File
Schema. XML data is returned from this activity as the output parameter.

About this task

The input parameter of the Read Flat File activity expects flat file data. Flat file (non-XML) data includes
comma-separated values (.csv) and other types of delimited files, as well as fixed-length text files that
comprise many EDI systems. Flat File data can be obtained from various endpoint activities, such as the FTP
Poll Directory activity, HTTP Receive Request activity, or Get Email activity.

For an example of using a Read Flat File activity in an orchestration, see "Developing a Simple Project" in the
Getting Started Guide.

You must create the Flat File Schema before you can select a Flat File Schema in the Select a Flat File Schema
field of the Configure task.

To add a Read Flat File activity to an orchestration:

Procedure

1. Create or open an orchestration. For more information, see Creating an orchestration. A graphical
representation of the orchestration is displayed.

2. Select the Activities tab and expand the Transform folder.
3. Drag the Read Flat File activity onto the orchestration. Place it to the right of an endpoint activity from

which the orchestration will obtain the flat file data (for example, an FTP Poll Directory activity).
4. Select the Read Flat File activity and configure it as described in Configuring a Flat File activity.

Read Flat File activity configuration
You can specify the Flat File Schema to apply to the Read Flat File input parameter.
Read Flat File map inputs
You can map a string variable that contains the flat file data to the input parameter of the Read Flat File
activity called Data.
Read Flat File map outputs
You can map the Xml output parameter that contains the XML data (stored as a string) to a variable valid
to the specified Flat File Schema.

Parent topic: Transform Activities
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Read Flat File activity configuration
You can specify the Flat File Schema to apply to the Read Flat File input parameter.

Before you begin

You must create the Flat File Schema before starting this task.

About this task

To complete the Configure task:

Procedure

1. In the Select a Flat File Schema field, click Browse... . The Project Explorer dialog box is displayed.
2. Select the appropriate Flat File Schema from the Flat File Schema folder and click OK.
3. Specify how to read the data passed into the Data input parameter during run time, by selecting one of

the appropriate options:
a. Select the Data is text-Needs no decoding option, if the incoming data is text and does not need

decoding.
b. Select the Decode data using encoding type option, if incoming data is binary data that needs to

be decoded using the specified encoding type. Set the encoding type using one of the following
options:

From the Decode data using encoding type list, select one of the default encoding types.
Enter your encoding type by clicking in the Decode data using encoding type field and
typing in your encoding type.

4. Click OK.

Parent topic: Read Flat File activity
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Read Flat File map inputs
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You can map a string variable that contains the flat file data to the input parameter of the Read Flat File activity
called Data.

About this task

Data is an input parameter of type string or base64Binary. During run time the string variable must contain flat
file data before the Read Flat File activity is run. For more information see the following Runtime Example.

The Encoding input parameter is optional. You are not required to map this input parameter. If the Encoding
input parameter is not listed in the To Activity pane of the Map Inputs pane, select Map > Show Optional
Parameters from the toolbar menu or right-click the To Activity pane and select the Show Optional Parameters
option. If the Map > Show Optional Parameters option is not selectable in the toolbar menu, click a node in the
Map Inputs pane to make this option active.

The Encoding input parameter specifies how the incoming data is decoded when read:

Procedure

If no decoding is required, specify the string: text.
If decoding is required, specify the encoding type that should be used to decode the incoming data. For
example: UTF-8, US-ASCII, ISO-8859-1, EBCDIC-XML-US, or SHIFT_JIS.

Example

Optionally, you can override the Encoding setting you specified in the Configure task of the Checklist
dynamically during run time, using the Encoding input parameter. For example, if you set the Encoding to UTF-
8 in the Configure task but during run time you passed in the Encoding setting of Shift_JIS. The Encoding
setting specified dynamically during run time overrides the original setting specified in the Configure pane. In
this example, the Encoding would be set to Shift_JIS. There is one exception to the dynamic overriding
behavior if the Data is text-Needs no decoding or encoding option is selected in the Configure task, the
Encoding dynamically set during run time is ignored and no decoding occurs.

See Creating a map for general instructions on mapping.

Parent topic: Read Flat File activity
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Read Flat File map outputs
You can map the Xml output parameter that contains the XML data (stored as a string) to a variable valid to the
specified Flat File Schema.

About this task
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See Creating a Map for general instructions on mapping.

Runtime Example

During run time, an orchestration could invoke the following sequence of activities:

Procedure

1. A FTP Poll Directory activity assigns the contents of a flat file to a String variable called
flatFileRawContent.

2. A Read Flat File activity assigns the contents of the flatFileRawContent variable to the string input
parameter called Data.

3. The Read Flat File activity converts flat file data to XML data and passes the XML data back to the
orchestration via the output parameter. The contents of the output parameter are assigned to the
variable valid to the Flat File Schema.

What to do next

For an example of using a Read Flat File activity in an orchestration, see "Developing a Simple Project" in the
Getting Started Guide.
Parent topic: Read Flat File activity
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Write Flat File activity
The Write Flat File activity converts data from an orchestration into flat file data (non-XML data) that is valid to
the specified Flat File Schema.

About this task

The flat file data is returned as a string output parameter. The data from the orchestration can come from
multiple variables of different types. For example, the data from the orchestration could contain two sets of
XML data valid to two different XML Schemas and a string.

Flat file (non-XML) data includes comma-separated values (.csv) and other types of delimited files, as well as
fixed-length text files that comprise many EDI systems.

You must create the Flat File Schema before you can select a Flat File Schema in the Select a Flat File Schema
field of the Configure task. See Creating a flat file schema for more information.

To add a Write Flat File activity to an orchestration:

Procedure
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1. Create or open an orchestration. For more information, see Creating an orchestration. A graphical
representation of the orchestration is displayed.

2. Select the Activities tab and expand the Transform folder.
3. Drag the Write Flat File activity onto the orchestration
4. Select the Write Flat File activity and configure it as described in Write Flat File activity configuration.

Write Flat File activity configuration
You can specify the Flat File Schema that must be applied to the outbound data.
Write Flat File map inputs and outputs
You can map the data from variables of the orchestration to the Xml input parameter defined by the Flat
File Schema specified in Configure task.

Parent topic: Transform Activities
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Write Flat File activity configuration
You can specify the Flat File Schema that must be applied to the outbound data.

Before you begin

You must first create the Flat File Schema before starting this task.

About this task

You can specify the Flat File Schema to apply to the input parameter. To complete the Configure task:

Procedure

1. In the Select a Flat File Schema field, click Browse.... The Project Explorer dialog box is displayed.
2. Select the appropriate Flat File Schema from the Flat File Schema folder and click OK.
3. Specify how to write the data returned by the Data output parameter during run time, by selecting one of

the appropriate options:
a. Select the Data is text-Needs no decoding or encoding option, if the outgoing data is text and

therefore does not require encoding.
b. Select the Decode or encode data using encoding type option, if outgoing data is binary data that

requires encoding using the specified encoding type. Set the encoding type using one of the
following options:

From the Decode or encode data using encoding type list, select one of the default
encoding types.
Click directly in the Decode or encode data using encoding type field and enter your
encoding type.

4. Click OK.
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Write Flat File map inputs and outputs
You can map the data from variables of the orchestration to the Xml input parameter defined by the Flat File
Schema specified in Configure task.

About this task

The Encoding input parameter is optional. You are not required to map this input parameter. If the Encoding
input parameter is not listed in the To Activity pane of the Map Inputs pane, select Map > Show Optional
Parameters from the toolbar menu or right-click in the To Activity pane and select the Show Optional
Parameters option. If the Map > Show Optional Parameters option is not selectable in the toolbar menu, click
on a node in the Map Inputs pane to make this option active.

The Encoding input parameter specifies how outgoing data should be encoded:

Procedure

If no encoding is required, specify the string: text.
If encoding is required, specify the encoding type that should be used to encode the outgoing data, for
example: UTF-8, US-ASCII, ISO-8859-1, EBCDIC-XML-US, or SHIFT_JIS.

Example

Optionally, you can override the Encoding setting you specified in the Configure task of the Checklist
dynamically during run time, using the Encoding input parameter. For example, if you set the Encoding to UTF-
8 in the Configure task but during run time you passed in the Encoding setting of Shift_JIS. The Encoding
setting specified dynamically during run time overrides the original setting specified in the Configure pane. In
this example, the Encoding would be set to Shift_JIS. There is one exception to the dynamic overriding
behavior, if the Data is text-Needs no decoding or encoding option is selected in the Configure task, the
Encoding dynamically set during run time is ignored.

See Creating a map for general instructions on mapping.

Parent topic: Write Flat File activity

Write Flat File map outputs

You can map the Data output parameter that contains the flat file data to a string variable.

About this task
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See Creating a Map for general instructions on mapping.
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Apply XSLT activity
You can use the Apply XSLT activity to transform XML data, stored in one XML variable, to XML data, stored in
another XML variable, using the specified XSLT stylesheet.

About this task

The Apply XSLT activity transforms XML data, stored in one XML variable, to XML data, stored in another XML
variable, using the specified XSLT stylesheet. The XSLT stylesheet is created outside of Studio.

For example, if you have a XSLT stylesheet that converts XML data, valid to one XML Schema, to XML data, valid
to a second XML Schema, you can create an Apply XSLT activity that calls this XSLT stylesheet to do this
conversion in your orchestration during run time.

To create an Apply XSLT activity:

Procedure

1. Upload the XSLT stylesheet into the project.
2. Upload the XML Schemas or DTD files that define the input and output XML variables.
3. Create the following two XML variables:

a variable to hold the input XML data based on a XML Schema or DTD.
a variable to hold the output XML data based on a different XML Schema or DTD.

4. Add the Apply XSLT activity to your orchestration:
a. Create or open an orchestration. A graphical representation of the orchestration is displayed.
b. Select the Activities tab and expand the Transform folder.
c. Drag the Apply XSLT activity onto the orchestration

5. Configure the Apply XSLT activity:
a. In the Pick Stylesheet task, for the Stylesheet field click Browse. The Project Explorer is

displayed.
b. Select the appropriate stylesheet and click OK. The stylesheet is displayed.
c. In the Checklist, select Set Input & Output.
d. In the Input pane, select Browse. The Select Variable pane is displayed.
e. Select a variable and click OK.
f. In the Output pane, select Browse. The Select Variable pane is displayed.
g. Select a variable and click OK.

Parent topic: Transform Activities
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Logic Activities
Logic activities overview
Logic activities control the flow of a orchestration.
Terminate activity
The Terminate activity stops all further orchestration job processing in the current branch.
Pick activity
The Pick activity determines what starter activity to launch based on the action that has occurred during
run time.
If..Then activity
The If..Then activity tests the Where expression in the If branches to determine what branch of the
If..Then activity to run.
Try activity
The Try... activity attempts to run the activity or activities in the main Try branch.
Group activity
Use this activity to group a set of activities in an orchestration. As a group, you can name, add
comments, and collapse the block of activities as one entity.
While Loop activity
The While Loop activity initiates and continually processes any associated activities for as long as the
specified condition evaluates to true.
For Each activity
The For Each activity iterates through recurring elements of a variable, performing other activities during
each iteration cycle.
Split activity
The Split activity is a variation of the For Each activity that can be used to break up very large messages
to improve performance
Break Loop activity
During run time, when a Break Loop activity is processed, the processing flow breaks out of the current
looping activity and continues to the next activity in the orchestration
Continue activity
The Continue activity jumps to the next item to process in the loop and is typically placed after an If or
an If..Then activity.
Adding branches to the If..Then activity
The If..Then activity supports multiple branches to handle different conditions.
Moving branches
You can change the position of a branch within an If..Then activity or a Pick activity.
Defining conditions
You can specify conditions in If..Then and While Loop activities to define a criteria that must be met
before the orchestration continues with that branch.
Basic condition syntax
There are various types of conditions that you can use to evaluate an XPath expression.
bpws:getVariableData function
Use the bpws:getVariableData function to create conditions to access variable data.
Basic XPath expressions
XPath expressions are used in orchestrations and flat file schema definitions when you need to identify
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one or more nodes in a message or variable in order to access data or determine whether a condition
has been met.
Testing XPath expressions
Use the XPath Evaluator to test XPath expressions against test XML documents.
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Logic activities overview
Logic activities control the flow of a orchestration.

Logic activities provide the functionality described in the following table:

Acti
vity Description

Brea
k
Loo
p

Breaks out of a For Each, Split, or While Loop activity.

Cont
inue

Jumps to the next item to process in a For Each, Split, or While Loop activity.

For
Eac
h  

Iterates through repeating nodes of a variable, performing one or more activities during each iteration
cycle.

If..T
hen

Routes messages based on conditions to different branches.

Pick
 

Receives messages from one or more activities and selects one of them to start an orchestration.

Split
acti
vity

Iterates through repeating sections of a variable, performing one or more activities during each
iteration cycle. The Split activity is a variation of the For Each activity that can be used to break up very
large messages to improve performance.

Ter
min
ate

Stops all further processing of the current orchestration job.

Try
acti
vity.
..

Attempts to run the activity or activities in the main Try branch. If any exception occurs when running
the activity or activities in the main Try branch, the CatchAll branch is run.
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Acti
vity Description

Whil
e
Loo
p

Initiates and continually processes any children activities for as long as a specified condition is true.

Parent topic: Logic Activities
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Terminate activity
The Terminate activity stops all further orchestration job processing in the current branch.

About this task

This activity is commonly used in the If and Else branches of an If..Then activity to stop orchestration
processing after an error occurs.

Parent topic: Logic Activities
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Pick activity
The Pick activity determines what starter activity to launch based on the action that has occurred during run
time.

About this task

For example, a Pick activity could contain three branches, one that contains a Get Inserted Rows activity, one
that contains a Get Deleted Rows activity, and the other that contains a Get Updated Rows activity. If an update
event occurs on the database, an instance of the orchestration is created and branch that contains the Get
Updated Rows activity is called.
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When you add a Pick activity to an orchestration, two Receive branches are automatically added. You can add
additional receiveEvent nodes to the Pick activity. A Pick activity is always a starter activity and in each branch
of a Pick activity the first activity must be a starter activity.

The Receive branch contains a receiveEvent node and an empty placeholder. Each message is defined in a
Receive branch that can contain other activities to handle that specific message.

Delete Receive branches if you do not want a receive operation to be a part of the Pick activity. Deleting the
Receive node removes the entire Receive branch.

Attention: If a variable is not initialized in every branch of a Pick activity, the variable cannot be used outside
the scope of a Pick activity. Attempting to use a variable outside the Pick activity that is not initialized in every
branch results in an invalid orchestration. For example, a Pick activity has two branches, one that contains a
Get Updated Rows activity and one that contains a Get Inserted Rows activity. The Get Updated Rows activity
returns the data to a variable named updateResult while the Get Updated Rows activity returns the data to a
variable named insertResult. These variables can only be used within the Pick activity and cannot be used in
the activities that follow after the Pick activity in the orchestration. If the output of each activity is based on the
same schema, you can however define one variable that both activities initialize. If all branches in a Pick
activity initialize the variable, the scope of the variable includes all activities after the Pick activity and is not
limited to the scope of the Pick activity.

To use a Pick activity complete the following steps:

Procedure

1. Drag the Pick activity from the Logic folder in the Activities tab onto the orchestration.
2. Select an inbound activity or the Schedule Job activity and drag it onto the receiveEvent placeholder.
3. To add an activity to the branch, drag the activity onto the empty placeholder.

Adding, editing, or deleting condition branches

The Pick activity can have several branches to process complex conditions

To add a branch to the Pick activity:

1. Click the Pick node.
2. Select Add Receive Branch from the list.

To edit a branch or activity name complete the following steps:

1. Select an activity or branch.
2. Select Edit from the list. The name is displayed in a box.
3. Select the current name, then enter the new one.
4. Press Enter.

To delete an activity or branch complete the following steps:

1. Select an activity or branch.
2. Select Delete from the list.

Note: If you delete a condition branch, all activities within the condition branch are also deleted.

Parent topic: Logic Activities
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If..Then activity
The If..Then activity tests the Where expression in the If branches to determine what branch of the If..Then
activity to run.

About this task

By default, each If..Then activity includes an If branch and an Else branch. You can add if additional branches to
an If..Then activity.

When the Where expression in the If branch is equal to true, processing proceeds down that If branch of the
orchestration. If an If..Then activity contains multiple If branches, the Where expressions in the If branches are
tested in sequential order. When none of the Where expressions in the If branches are satisfied, processing
proceeds down the Else branch.

You also have the option of copying a branch or Else branch from another If..Then activity.

To use an If..Then activity complete the following steps:

Procedure

1. Open the Activities tab and the Logic folder.
2. Drag the If..Then activity onto the orchestration.
3. Add more If branches as required.
4. Configure the If and Else branches.

Configure an IF branch

1. Select the If branch. The Expression Builder opens.
2. Define conditions for the branch.
3. Drag an activity from the Activities tab onto the empty placeholder.

Configuring an Else branch

1. Drag an activity from the Activities tab onto the empty placeholder.

Copying and pasting If nodes

1. Click the If branch and select Copy from the list.
2. Click on the If..Then activity in the orchestration and select Paste from the list.

Note: If and Else branches cannot be pasted outside of an If..Then activity. You cannot replace an If
branch with an Else branch.

Copying and pasting Else nodes
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Else branches can be pasted into a If..Then activity only if the If..Then activity does not already contain an Else
branch.

1. Click the Else branch and select Copy from the list.
2. Click the If..Then activity and select Paste from the list.

Adding branches

1. Click the If..Then activity and select Add If.
2. Define the conditions and the activities for the branch.

Editing an activity or branch

1. Select the activity or branch to edit existing properties.
2. Select Edit from the list.

Deleting an activity or branch

1. Select the activity or branch to edit existing properties.
2. Select Delete from the list.

Note: If you delete a condition branch, all activities within the condition branch are also deleted.

Parent topic: Logic Activities
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Try activity
The Try... activity attempts to run the activity or activities in the main Try branch.

About this task

If any exception occurs while running the activity or activities in the main Try branch, the CatchAll branch is
run.

Right-clicking the mouse on the background creates a new CatchAll branch.

For example, the main Try branch can call the Database Insert Rows activity as shown in the following figure:

 149



If the Database Insert Rows activity fails and throws an exception, the activity or activities in the CatchAll
branch are run. In this example orchestration, when an exception is thrown by the Database Insert
Rows activity, the Terminate activity runs thus terminating the current orchestration job.

To add and configure a Try... activity, complete the following steps:

Procedure

1. Open the Activities tab and the Logic folder.
2. Drag the Try... activity onto the orchestration. The Try... activity is displayed with the following branches:

Try... branch
CatchAll branch

When the first CatchAll branch is created, the following variables are automatically created:
faultName - During run time, the faultName variable contains the name of the exception thrown
by an activity in the Try branch.
faultData - During run time, the faultData variable contains the error message associated with the
exception. This additional information is only currently returned for the Web Services activities.
For Web Services activities, the faultData variable contains the fault.
faultInfo - During run time, the faultInfo variable returns the following nodes:

name - During run time, the faultInfo/name node contains the name of the exception
thrown by the activity in the Try branch. The faultInfo/name node is a xsd:QName type.
message - During run time, the faultInfo/message node contains the error message
associated with the exception. The faultInfo/message node is a xsd:string type.
activityId - During run time, the faultInfo/activityId node contains the activity ID that
uniquely identifies the activity where the exception occurred. The faultInfo/activityId node
is a xsd:int type.
activityName - During run time, the faultInfo/activityName node contains the activity name
where the exception occurred. The faultInfo/activityName node is a xsd:string type.
faultTime - During run time, the faultInfo/faultTime node contains the time the error
occurred. The faultInfo/faultTime node is a xsd:dateTime type.

Note: The exception name returned by an activity in the faultName variable and the
faultInfo/name node might change in a future release.

3. Configure the Try... and CatchAll branches by dropping activities from the Activities tab to the branches
of the Try... activity as shown in the preceding and following figures.
Attention: The scope of the faultName, faultData, and faultInfo variables is limited to the CatchAll
branch of the Try... activity. This scope limitation means that the value of these variables is only
guaranteed to be valid within the CatchAll branch. For example, if you add an If...Then activity that tests
the value of the faultName variable, the If..Then activity must be placed inside the CatchAll branch of the
Try... activity as shown in the following figure:
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Group activity
Use this activity to group a set of activities in an orchestration. As a group, you can name, add comments, and
collapse the block of activities as one entity.

About this task

When you add a CatchAll branch to the group, the CatchAll branch runs as an exception occurs in the group of
activities.

To use the Group activity complete the following steps:

Procedure

1. In the Studio toolbox, click the Activities tab.
2. Expand the Logic directory.
3. Drag the Group activity onto the orchestration.
4. Optional: Add a CatchAll branch.

a. Right-click the Group activity. An option menu opens.
b. Select Add CatchAll Branch. The CatchAll branch is displayed in the Group activity.

Parent topic: Logic Activities
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While Loop activity
The While Loop activity initiates and continually processes any associated activities for as long as the specified
condition evaluates to true.

About this task

To define a While Loop activity complete the following steps:

Procedure

1. Drag a While Loop activity from the Logic folder of the Activities tab onto the orchestration. The
Expression Builder is displayed.

2. Use the Expression Builder to define conditions in the While Loop activity. You must define a condition
that evaluates to false to ensure that the loop ends. The variables needed to iterate through the
conditions you specify are automatically created.

3. Drag an activity from the Activities tab onto the empty placeholder inside of the While Loop activity,
typically, For Each, While Loop, or Split.  Use the Break Loop or Continue activities to control iterations in
these activities
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For Each activity
The For Each activity iterates through recurring elements of a variable, performing other activities during each
iteration cycle.

About this task

When you drop a For Each activity onto an orchestration, Studio creates the following two variables:

loopvalue_X - During run time, as the For Each activity loops through a set of recurring elements, the
loopvalue_X variable contains the value of the current element.
loopcounter_X - During run time, as the For Each activity loops through a set of recurring elements, the
loopcounter_X variable contains the current count of the number of iteration cycles that have been
processed by the For Each activity.
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Where X is equal to the number of For Each activities that have been dropped on the orchestration. For
example, when the first For Each activity is dropped on an orchestration, the variables called loopvalue_1 and
loopcounter_1 are created.

Attention: Do not use the loopvalue_X and loopcounter_X variables outside of the For Each activity. The scope
of these variables are limited to the For Each activity.
 

To use a For Each activity complete the following steps:

Procedure

1. Open the Activities tab and the Logic folder.
2. Drag the For Each activity onto the orchestration.
3. In the Variable Name field, select a variable containing the recurring element that you want to loop

through in the For Each activity.
4. In the Element Name field click [...] to browse for the recurring element that you want to loop through in

the For Each activity. The Select Recurring Element window is displayed.
5. Select a recurring element and click OK.

Results

An XPath expression that refers to the recurring element is displayed in the Element Name field. The Variable
Name field is automatically populated with the loopvalue_X variable created for this For Each activity. You can
edit the generated XPath expression in the Element Name field.

You can add other activities within the For Each loop. Use the Break Loop and Continue activities to control
iterations of the For Each loop.

Parent topic: Logic Activities
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Break Loop activity
During run time, when a Break Loop activity is processed, the processing flow breaks out of the current looping
activity and continues to the next activity in the orchestration

About this task

The Break Loop activity can only be used in any of the following looping activities: For Each, Split, and While
Loop, as shown in the following examples.

To use a Break activity:

Procedure
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1. Open the Activities tab and the Logic folder.
2. Drag a For Each, Split, or While Loop activity onto the orchestration.
3. Drop the Break Loop activity into the looping activity, as shown in the following example:

To break out of a loop when a condition is true, see Example 1.
To break out of a loop after a single iteration, see Example 2.

Example 1 - Break out of a loop when a condition is true

1. Drag an If..Then activity into the looping activity you set up, as shown in the preceding figure.
2. Drag an action activity (for example: the Insert Rows activity) onto the empty placeholder to the right of

the Else node.
3. Configure the action activity.
4. Click the If node and enter a condition in the Expression Builder.
5. Drag a Break Loop activity onto the empty placeholder to the right of the If node.

At run time:

If the condition in the If activity evaluates to true, the Break Loop exits out of the looping activity.
If the condition in the If activity evaluates to false, the Else branch is started and the action activity (for
example: the Insert Rows activity) is run.

Example 2 - Break out of a loop after a single iteration runs

1. Drag an action activity (for example, the Insert Rows activity) onto the empty placeholder inside of the
looping activity you selected.

2. Configure the action activity.
3. Drag a Break Loop activity onto the empty placeholder inside of the looping activity.

At run time:

The action activity (for example: the Insert Rows activity) runs only once before the Break Loop exits out
of the looping activity.

Parent topic: Logic Activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016

154   



file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/orch_Break_Loop_Activity.html

Continue activity
The Continue activity jumps to the next item to process in the loop and is typically placed after an If or an
If..Then activity.

About this task

The Continue activity can only be used inside one of the following looping activities: For Each, Split, and While
Loop activities.

To use a Continue activity complete the following steps:

Procedure

1. Open the Activities tab and the Logic folder.
2. Drag a For Each, Split, or While Loop activity onto the orchestration.
3. Set up the looping activity to continue processing as shown in the following example.

Example - Continue processing when a condition is true

a. Drag an If..Then activity into the looping activity you set up in step 1.
b. Drag an action activity (for example: an Insert Rows activity) onto the empty placeholder to the

right of the If node.
c. Configure the action activity.
d. Click the If node and enter a condition in the Expression Builder.
e. Drag a Continue activity onto the empty placeholder to the right of the Else node.

At Run Time:
If the condition in the If evaluates to true, the action activity runs.
If the condition in the If evaluates to false, the Continue activity in the Else branch runs and
jumps to the next item in the looping activity.
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Adding branches to the If..Then activity
The If..Then activity supports multiple branches to handle different conditions.

About this task
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To add additional If and Else branches complete the following steps:

Procedure

1. Select the If..Then activity in the orchestration
2. Right-click and select one of these options:

Add If – to add another branch with a condition.
Add Else – to add a final, catch-all branch to use when a message does not match any of the
conditions in the If statements. (This option is only available if there is no Else branch displayed.)
Double-click the If icon and enter a name for the branch.
Use the Expression Builder to define the conditions for the branch.
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Moving branches
You can change the position of a branch within an If..Then activity or a Pick activity.

About this task

To move a branch within an If..Then activity or a Pick activity complete the following steps:

Procedure

1. Select the branch you want to move. For an If..Then activity, select one of the If nodes; for a Pick activity,
select one of the receiveEvent nodes.

2. To move the branch use one of the following actions:
Select Orchestration > Go Up or Orchestration > Go  Down from the toolbar menu.
Right-click the branch and select Go Up or Go Down from the list.
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Defining conditions
You can specify conditions in If..Then and While Loop activities to define a criteria that must be met before the
orchestration continues with that branch.

In most cases, conditions test the value of data in a message or in other variables defined within the
orchestration. Use the Expression Builder to define conditions.

Expression Builder

The Expression Builder is used to define conditions for If..Then and While Loop activities. It is displayed
beneath the orchestration, in the Property pane, when you select an If..Then or While Loop activity in the
orchestration.

These conditions are boolean expressions that describe the criteria against which the Integration Appliance
compares a message. During runtime, the result of this comparison determines the execution path through the
orchestration. For a complete list of operators that you can use in the Expression Builder, see Valid Operators
for Conditions. For more information about the order precedence of the conditions in the Expression Builder,
see http://www.w3.org/TR/xpath#booleans.

The Expression Builder allows you to add, delete, and edit conditions as well as change their processing order.

To add a condition:

1. Click Add.  A new condition displays beneath the existing list of conditions.
2. To or the new condition with the previous condition in the link, right-click and select or from the list.

To delete a condition:

Select the condition, then click Delete.

To edit a condition:

Select any field in the Expression Builder and make your edits. If the Expression Builder is not displayed,
click Use Builder. You can edit left-hand expressions, select operators, and right-hand expressions.

-OR-

Click Advanced to directly edit XPath expression that defines the condition. For more information, see
Basic Condition Syntax, Basic XPath Expressions, and bpws:getVariableData Function

Note: Use the XPath Evaluator to test XPath expressions.
To change the processing order of the conditions:

Select a condition in the Expression Builder and click the up or down arrows.
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Basic condition syntax
There are various types of conditions that you can use to evaluate an XPath expression.

The most common operator used to evaluate an expression is = (equals), but you can use any valid XPath
operator. See Basic XPath Expressions for a list of valid XPath operators.

The following examples demonstrate how to use various conditions to evaluate an XPath expression.

Example 1: Using string literals

String literals must be enclosed in quotation marks as shown in this example:

bpws:getVariableData('PatientInfo')/PV1/Department = 'ICU'

Example 2: Accessing variable data

Use the bpws:getVariableData function to access variable data

Using string literals in the getVariableData function:

The following example evaluates string nodes from two variables. The variable names in the
bpws:getVariableData function are string literals.

bpws:getVariableData('PatientInfo')/PV1/Department =
bpws:getVariableData('Orders')/PID/PtDept

Using numeric literals in the getVariableData function:

To evaluate numeric literals you must cast either one or both sides of the expression. For example:

number(bpws:getVariableData('PatientInfo')/PV1/Department) =
bpws:getVariableData('Orders')/PID/PtDept

 - OR -

number(bpws:getVariableData('PatientInfo')/PV1/Department) =
number(bpws:getVariableData('Orders')/PID/PtDept)

Example 3: Numeric literals

Numeric literals do not require quotation marks. Placing quotes around a numeric literal transforms it into a
string literal.

Valid numeric expression example:

number(bpws:getVariableData('PurchaseOrder')/PurchaseOrder/POTotal) >= 5000.00

Invalid numeric expression example:

number(bpws:getVariableData('PurchaseOrder')/PurchaseOrder/POTotal) >= '5000.00'

Parent topic: Logic Activities
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bpws:getVariableData function
Use the bpws:getVariableData function to create conditions to access variable data.

It can be combined with an XPath expression identifying specific nodes within the variable.

For example:

To access the data in the POTotal node in a variable named PurchaseOrder, you would enter:
bpws:getVariableData('PurchaseOrder')/PurchaseOrder/POTotal

To access the data in a primitive variable named ItemCount, enter:
bpws:getVariableData('ItemCount')
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Basic XPath expressions
XPath expressions are used in orchestrations and flat file schema definitions when you need to identify one or
more nodes in a message or variable in order to access data or determine whether a condition has been met.

XPath is an XML standard that defines a grammar to identify nodes or sets of nodes (called node sets) in XML
documents.

You can edit the default XPath expressions, generated in the following panes:

In the Configure panes of the For Each and Split activity activities, an XPath expression is generated to
define the recurring element. You can edit the default XPath expression displayed in the Element Name
field.
In the Configure panes of the While Loop and If..Then activities, an XPath expression is generated in the
Expression Builder to define the conditions. You can edit the default XPath expression displayed by
clicking Advanced.

XPath 2.0 is supported.
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Selecting nodes by path

XPath describes the location of XML elements and attributes as a path similar to URLs or directories on your
local file system. Each element or attribute is a node in a tree that begins with the root node. The root node
contains the entire tree, so any node within the tree can be found by following a path down the branches.

The basic syntax is:

/root-node/child-node/.../final-element-node

/root-node/child-node/.../final-element-node/@attribute-node

You determine this path from the XML Schema that describes the messages.

XPath uses the @ symbol as a shorthand to identify attributes. Paths without @, or the attribute:: prefix,
identify elements by default. For example:

 /PackingSlip/PONumber/Item

identifies the Item element found inside PONumber in the PackingSlip root node.

Node names and XML namespaces

Node names can also appear with namespaces, such as tns:OrderNumber or *:Item. The portion of the name
up to the colon is a prefix identifying a namespace and the colon is the delimiter between the namespace and
the node's local name.

Namespaces are an XML standard used to uniquely identify elements or attributes when documents share
content from several schemas. Cast Iron® Studio automatically assigns and manages namespaces for the XML
Schemas used in configuration documents.  

Note: Each schema within a WSDL definition can be defined by a namespace.

Select nodes conditionally with predicates

You might occasionally want to select a node only if some condition is met. These selection conditions are
known as predicates.

You define predicates inside brackets, such as:

/PV1/PatientDepartment[text()='Nursery']

This expression selects the PatientDepartment node only if the data in the node is Nursery.

/Order/OrderDetail/Item[5]

This expression selects the fifth Item node within OrderDetail.

Valid operators for conditions

XPath expressions can also be boolean conditions that evaluate to true or false. These expressions can be used
to select specific nodes or simply to identify a condition that must be met. You can use the Expression Builder
to help you define conditions. XPath operators that can appear in expressions include:

= equals
!= not equals
< less than
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> greater than
<= less than or equals
>= greater than or equals

Functions in XPath expressions

XPath also contains functions that allow you to manipulate data from nodes. This can be useful in building
subject lines that contain some constant text plus dynamic data from messages. XPath functions can also be
used to handle requirements such as trimming space or ensuring that a job key is a string datatype. Some of
the common XPath functions include:

concat()
you can combine any number of strings and the data from nodes in the order you specify the
parameters. You can specify XPath paths as parameters. Specify constant text strings within quote
marks. For example:

concat('New Order # ',/Orders/Order/OrdNumber)

count()
you can count the number of nodes in the parameter you specify. Typically the parameter is an XPath
path expression that identifies several nodes, such as all the Item nodes that are children of PODetail.
For example:

count(/Orders/Order)

normalize-space()
trims all leading and trailing space characters from the input parameter and also normalizes all space
within the input to single space characters and single line feeds. For example:

normalize-space(/Job/Address/Line1)

number()
converts the parameter to a number datatype. This function can be used to ensure that strings are
treated as numbers. For example:

number(/PurchaseOrder/POTotal)

string()
converts the parameter to a string datatype. This function can be used to ensure that numeric or date
nodes are treated as strings. For example:

string(/PurchaseOrder/VendorID)

translate()
replaces individual characters with other characters in the first parameter you specify. The second
parameter is the character or characters to replace and the third parameter is the replacement
characters. This function can be useful for ensuring that job keys are all uppercase, for example.

translate(/Issue/ShortDescr,

'abcdefghijklmnopqrstuvwxyz',

'ABCDEFGHIJKLMNOPQRSTUVWXYZ')

For a complete list of XPath functions, see the XPath Specification ( http://www.w3.org/TR/xpath).

Testing XPath expressions
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You can test your XPath Expressions against XML test data using the XPath Evaluator.
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Testing XPath expressions
Use the XPath Evaluator to test XPath expressions against test XML documents.

To bring up the XPath Evaluator window, select Tools > XPath Evaluator option from the Studio toolbar menu.
You can use the XPath Evaluator to test XPath expressions against XML files. You can edit the default XPath
expressions, generated in the following panes:

In the Configure panes of the For Each and Split activities, an XPath expression is generated to define
the recurring element. You can edit the default XPath expression displayed in the Element Name field.
In the Configure panes of the While Loop and If..Then activities, an XPath expression is generated in the
Expression Builder to define the conditions. You can edit the default XPath expression displayed clicking
Advanced.

Note: XPath 2.0 is supported.
The following table describes the functionality of the XPath Evaluator dialog box.

Field Name Description

File Specifies the directory location of the selected test XML file. Select the down arrow to select from
the set of previously loaded XML files.

Browse.. Click Browse... to load the contents of the XML file from the file system.

Load
Source  

A graphical representation of the source XML elements to test against. Selecting a node in this
text box generates an XPath expression that finds all occurrences of this element when this XPath
expression is evaluated against the specified XML data.

Generate
d XPath
Expressio
n

XPath expression that is generated when an XML element is selected in the Load Source text box.

Copy Copy the XPath Expression from the Generated XPath Expression field to the XPath Expression
field.

XPath
Expressio
n

Specifies the XPath Expression used to evaluate or test against the XML data.

Run Select Run to evaluate the XPath expression against the source XML test data. The results of the
evaluation are displayed in the text box on the right side of the pane.

To evaluate an XPath expression complete the following steps:
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1. Select the Tools > XPath Evaluator option from the Studio toolbar menu. The XPath Evaluator window
opens.

2. Click Browse... to load a test XML file from the file system. A graphical representation of the text XML
elements shows in the Load Source text box.

3. To specify an XPath expression, choose from one of the following options:
Enter an XPath expression directly into the XPath Expression field.
Select an XML element in the Load Source text box and click Copy to copy the XPath expression
from the Generated XPath Expression field to the XPath Expression field.

4. Click Run. The result of running the XML data against the XPath expression is displayed in the right
bottom pane. The following types can be returned:

number —the value of the number is returned in the Value field as shown  in the following figure:

boolean —the value of the boolean is returned in the Value field as shown in the following figure:

Node Set —the XML elements that match those displayed in the XPath expression, the Value field
is blank, and the number of matching XML elements is reported as shown in the following figure:
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string —the value of the boolean is returned in the Value field as shown in the following figure:
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Utilities Activities
Create Job Keys Activity
The Create Job Keys activity sets the values of job keys dynamically during run time.
Creating Job Keys
You can associate job keys (or identify keys) with a specific orchestration job.
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Log Message activity
You can use the Log Message activity to specify the alert levels and message text, which is displayed in
the Integration Appliance orchestration monitoring logs and system logs.
Schedule Job activity
The Schedule Job activity is a starter activity that creates an instance of an orchestration at the specified
date and time.
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Create Job Keys Activity
The Create Job Keys activity sets the values of job keys dynamically during run time.

About this task

After the orchestration job has run on the Integration Appliance, you can view the values of the job keys in the
Jobs detail pane of the Web Management Console (WMC). In addition, you can search for orchestration jobs
using the primary key in the WMC.  For more information see the WMC online help.

To create and configure a Create Job Keys activity complete the following steps:

Procedure

1. Create a Job Key by using the Creating Job Keys topic before configuring the Create Job Keys activity.
2. Add the Create Job Keys activity to your orchestration:

a. Create an orchestration using the Creating an orchestration topic, or open an existing
orchestration. A graphical representation of the orchestration is displayed.

b. Select the Activities tab and expand the Utilities folder.
c. Drag the Create Job Keys activity onto the orchestration.

3. Configure the Create Job Keys activity:
a. In the Checklist, select Map Inputs.
b. You can either set the default value of your job keys or map variables to the job keys, as described

in steps 4 and 5.
4. Set a default value for the job keys:

a. In the To Activity pane of the Map Outputs task, right-click the job key and select Define Default
Value from the list. The Define Default Value dialog box is displayed.

b. Enter the required value in the Default Value field.
c. Click OK.

During run time, the values of the job keys are set to the values specified in the Default Value field.
5. Map variables to the job keys:

a. In the From Orchestration pane, click Add. The Add Variable dialog box is displayed. If any job
keys have been created, they are displayed in the To Activity pane.

b. Select variables. These variables supply the values of the job keys during run time.
c. Click OK.

 165



d. Create mappings for each job key. From the From Orchestration pane, drag each variable to the
corresponding job key in the To Activity pane.

During run time, the value of the job keys are set to the values of the corresponding variables.
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Creating Job Keys
You can associate job keys (or identify keys) with a specific orchestration job.

About this task

You create job keys from the Job Identification pane in Studio. To launch the Job Identification pane, select
Orchestration > Properties option from the Studio toolbar menu. In the Job Identification pane, define the
name and type of the job key. You can also specify one job key as the Primary key.

During run time, a Create Job Keys activity dynamically sets the values of the job keys when an orchestration
job runs on the Integration Appliance.  After the orchestration job has completed, you can view the values of
the job keys from the Web Management Console (WMC). In the WMC, you can also search for the value of a key.
All orchestration jobs that contain keys with that value are displayed.

Note: When designing your orchestration, typically it is best to add only one Create Job Keys activity to an
orchestration. If the first Create Job Keys activity in an orchestration has a map to the job key, during run time,
the second Create Job Keys activity in an orchestration does not reset the value of the job key that was set by
first Create Job Keys activity. The action of the second Create Job Keys activity is ignored.

Procedure

1. Create or open an orchestration. See Creating an orchestration for more information. A graphical
representation of the orchestration is displayed.

2. Select Orchestration > Properties to open the Orchestration pane.
3. Click Add. A new key with default values is added to the Keys list.
4. Enter the configuration information for new job keys as described in the following table.

Field / Column Description

Name
(Required)

Specifies the name of the job key

Type (Required) Specifies the type of the job key

Primary Specifies that the key is the Primary key. You can only select one key as the Primary
key

What to do next
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To remove a key, select the key you want to remove and click Remove.
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Log Message activity
You can use the Log Message activity to specify the alert levels and message text, which is displayed in the
Integration Appliance orchestration monitoring logs and system logs.

About this task

Use this task to configure the Log Message activity. You can view the Integration Appliance orchestration
monitoring logs and system logs from the Web Management Console.

Procedure

1. In the Studio toolbox, click the Activities tab.
2. Expand the Utilities folder contents, and drag the Log Message activity onto the orchestration. The

Utilities Log Message Checklist is displayed.
3. In the Checklist, click Summary.
4. Optional Change the description in the Activity Name field.
5. Click Map Inputs. The Map Inputs workspace is displayed. The default parameters: level and message

are displayed in theTo Activity column.
6. Click Select Inputs. The variables associated with the orchestration are displayed

Tip: If required, you can create a custom mapping variable in Source or Destination column by
completing the steps in Creating Variables.

7. Choose a variable, and click OK. The variable and parameters are displayed in the From Orchestration
column.

8. To link the activities, drag a variable from the From Orchestration list onto a parameter listed in the To
Activity list. If a link can be established, a line connects the two.

9. Repeat this procedure to link other orchestration variables to this activity.
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Schedule Job activity
The Schedule Job activity is a starter activity that creates an instance of an orchestration at the specified date
and time.

About this task

Use this task to add a Schedule Job activity to an orchestration.

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activity tab and expand the Utilities folder.
3. Drag a Schedule Job activity onto the orchestration.
4. Specify the Schedule setting in the Configure pane as described in the following table:

Optio
n Description

5
secon
ds

Specifies the orchestration to run once every five seconds.

10
secon
ds

Specifies the orchestration to run once every ten seconds.

20
secon
ds

Specifies the orchestration to run once every twenty seconds.

30
secon
ds

Specifies the orchestration to run once every thirty seconds.

60
secon
ds

Specifies the orchestration to run once every sixty seconds.

5
Minut
es

Specifies the orchestration to run once every five minutes.

Hour Specifies the orchestration to run once an hour at the specified time.

Day Specifies the orchestration to run once a day at the specified time. The time is based on a 24-
hour clock in the GMT timezone.

Week Specifies the orchestration to run once a week on the specified day (Sunday - Saturday) and at
the specified time (24-hour clock) based on the GMT timezone.

Mont
h

Specifies the orchestration to run once a month on the specified date (1 - 31) and time (24-
hour clock) based on the GMT timezone.

Year Specifies the orchestration to run once a year on the specified date (month and day) and time
(24-hour clock) based on the GMT timezone.

Note: The Schedule Job activity starts the orchestration on the specified time and date based on the
GMT timezone. You must adjust the specified time and date for your timezone.
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5. To map the output of the activity:
a. Select the Map Outputs task in the Checklist. The time output parameter is displayed in the From

Activity pane. This is an optional parameter that during run time returns the date and time (in the
XML Schema xsd:dateTime data type) that the orchestration started processing.

b. If desired, map the time output parameter parameters to variable(s). See Creating a Map for
general instructions on mapping.
Note: To create an orchestration that starts on two different dates, for example: February 13,
2011 and April 21, 2011. Drop a Pick activity on the orchestration as the starter activity and drop
into the Pick branches, two Schedule Job activities, one that starts on February 13, 2011 and the
other on April 21, 2011.
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Archives Activities
Archive activity
During run time, the Archive activity takes input files and directories and adds them to a single archive.
The Archive activity may also compress the input files and directories.  Complete the steps in the
following topics to add and configure an Archive activity in an orchestration, and to map inputs and
outputs to the Archive activity
Unarchive Activity
The Unarchive activity extracts the input files and directories from the passed in archive during run time.
At run time, the Unarchive activity determines the archive/compression types and
unarchives/decompresses the archive appropriately
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Archive activity
During run time, the Archive activity takes input files and directories and adds them to a single archive.
The Archive activity may also compress the input files and directories.  Complete the steps in the following
topics to add and configure an Archive activity in an orchestration, and to map inputs and outputs to the
Archive activity
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Adding an Archive activity
Configuring an Archive activity
Archive activity map input
Archive activity map output
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Adding an Archive activity

About this task

To add an Archive activity in the orchestration complete the following steps:

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Archives folder.
3. Drag the Archive activity onto the orchestration. The Summary task is displayed.

What to do next

Configure the Archive activity.
Parent topic: Archive activity

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/archive_activity_adding.html

Configuring an Archive activity

About this task

To configure an Archive activity, complete the following steps:

Procedure
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1. Select the Configure task from the Checklist. The Configure task is displayed.
2. Select a format type as described in the following table:

Format Archived? Compressed? Description

TAR Yes No Specifies that input files
and directories are
archived using the tar
format before being
returned in the archive
output parameter as a
single value. The
returned value is
compatible with the
archive format
produced by the UNIX
tar -cf command. This
option returns a value
that is compatible with
a file that ends in the
.tar extension.

TAR+GZIP Yes Yes Specifies that input files
and directories are
archived using the tar
format and then
compressed using the
gzip format, before
being returned in the
archive output
parameter as a single
value. The returned
value is compatible with
the archive format
produced by the UNIX
tar -cf command and
the compression format
produced by the GNU
gzip command. This
option returns a value
that is compatible with
a file that ends in the
.tar.gz extension.
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Format Archived? Compressed? Description

ZIP Yes Yes Specifies that input files
and directories are
compressed and
archived using the .zip
format before being
returned in the archive
output parameter as a
single value. The
returned value is
compatible with the
compression and
archive format
produced by proprietary
compression products.
This option returns a
value that is compatible
with a file that ends in
the .zip extension.

GZIP No Yes Specifies that a single
input file is compressed
using the gzip format,
before being returned in
the archive output
parameter. The
returned value is
compatible with the
compression format
produced by the GNU
gzip command. This
option returns a value
that is compatible with
a file that ends in the .gz
extension.

What to do next

Map the input of the activity.
Parent topic: Archive activity
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Archive activity map input
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About this task

To map the input of the Archive activity complete the following steps:

Procedure

1. Select the Map Inputs task in the Checklist. The Map Inputs task is displayed. The archiveEntries input
parameter is displayed in the To Activity pane.

2. Map variables to the nodes of the archiveEntries input parameter. See Creating a Map for general
instructions on mapping. The archiveEntries/entry node is a recurring node and each entry represents a
either a single file or directory in the archive. The nodes of the archiveEntries/entry node are described
in the following table:

Node Name Required xsd Type Description

name Yes string Specifies the name of
the directory or file to
be added to the archive.
If the file or directory is
located in a sub-
directory, the value of
the name node must
contain the directory
path of the file in
addition to the file
name. For example, to
specify the file called
file1.txt located in the
directory called cat,
specify the value:
cat/file1.txt.

datetime No dateTime Specifies the creation
date and time of the file
or directory to be added
to the archive.

isdirectory No boolean Specifies if the current
entity is a directory or a
file:

true specifies the
entity is a
directory
false specifies
the entity is a file

content No base64Binary Specifies the contents
of the file or directory.

size No decimal Specifies the size of the
file or directory.

userid No string Specifies the user ID of
the file or directory.

groupid No string Specifies the group IDof
the file or directory.
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Node Name Required xsd Type Description

permissions No string Specifies the
permissions of the file
or directory.

What to do next

Map the output of the activity.
Parent topic: Archive activity
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Archive activity map output

About this task

To map the output of the activity complete the following steps:

Procedure

1. Select the Map Outputs task in the Checklist. The Map Outputs task is displayed. The archive output
parameter is displayed in the From Activity pane. The archive output parameter contains the archived
files and directories.

2. Map a variable to the archive output parameter. See Creating a Map for general instructions on mapping.
For example, you could map the archive output parameter to a variable you created called outdata. You
could then map the outdata variable to the data input parameter of the FTP Put File activity. During run
time, the FTP Put File activity creates an archive file on an FTP server.

Parent topic: Archive activity
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Unarchive Activity
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The Unarchive activity extracts the input files and directories from the passed in archive during run time. At run
time, the Unarchive activity determines the archive/compression types and unarchives/decompresses the
archive appropriately

About this task

The supported unarchive and decompression formats are listed in the following table:

Dec
om
pre
ssio
n/
Una
rchi
ve
For
mat
s Description

tar During run time, if the Unarchive activity determines that the archive type is tar, the passed in archive is
extracted into its component parts (files and directories) and passed back from the activity using the
archiveEntries output parameter. The extraction done during run time by the Unarchive activity is
equivalent to extraction done on the command line using the UNIX tar -xf command.

unt
ar
and
gun
zip

During run time, if the Unarchive activity determines that the archive type is tar and the compression
type is gzip, the passed in archive is first decompressed from the gzip format and then extracted into its
component parts (files and directories) and passed back from the activity using the archiveEntries
output parameter. The extraction done during run time by the Unarchive activity is equivalent to
extraction done on the command line using the UNIX tar -xf command to files that end in the .tar
extension. The decompression done during run time by the Unarchive activity is equivalent to the
decompression done on the command line using the GNU gunzip command to files that end in the .gz
extension.

zip During run time, if the Unarchive activity determines that the archive/compression type is zip, the
passed in archive is decompressed and extracted into its component files and directories, and passed
back from the activity using the archiveEntries output parameter.  The decompression and extraction
done during run time by the Unarchive activity is equivalent to the decompression and extraction done
using proprietary compression products to files that end in the .zip extension.

gun
zip

During run time, if the Unarchive activity determines that the compression type is gzip, the passed in
archive is decompressed from the gzip format and passed back from the activity using the
archiveEntries output parameter.  The decompression done during run time by the Unarchive activity is
equivalent to the decompression done on the command line using the GNU gunzip command to files
that end in the .gz extension.

During run time, if the passed in archive format is unsupported, the Unarchive activity produces an
ActivityFailedException error and issues the following message:

Invalid or unsupported archive format

During run time, if the passed in archive is incorrectly formed, the Unarchive activity produces an
ActivityFailedException error and issues the following message:

Error while reading archive

To add and configure an Unarchive activity in an orchestration complete the steps in the following procedures: 
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Adding an Unarchive activity
Unarchive activity map input
Unarchive activity map output

Parent topic: Archives Activities
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Adding an Unarchive activity

About this task

To add an Unarchive activity to an orchestration complete the following steps:

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Archives folder.
3. Drag the Archive activity onto the orchestration. The Summary task is displayed.

What to do next

Mapping input to the Unarchive activity.
Parent topic: Unarchive Activity
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Unarchive activity map input

About this task

To map the input of the Unarchive activity complete the following steps:

Procedure
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1. Select the Map Inputs task in the Checklist. The Map Inputs task is displayed. The archive input
parameter is displayed in the To Activity pane.

2. Map variables to the nodes of the archive input parameter. The variable should contain the archive to
extract the input files and directories from. See Creating a Map for general instructions on mapping.

Parent topic: Unarchive Activity
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Unarchive activity map output

About this task

To map the output of the Unarchive activity complete the following steps:

Procedure

1. Select the Map Outputs task in the Checklist. The Map Inputs task is displayed.
The archiveEntries output parameter is displayed in the From Activity pane.  The archiveEntries/entry
node is a recurring node and each entry represents a either a single file or directory in the archive. The
nodes of the archiveEntries/entry node are described in the following table:

Node Name Required xsd Type Description

name Yes string Specifies the name of
the directory or file that
was extracted from the
archive. If the file or
directory is located in a
sub-directory the value
returned by the name
node during run time
includes the relative
directory path of the file
or directory. For
example, if the archive
contains the file called
file1.txt located in the
directory called cat, the
value: cat\file1.txt is
returned.

datetime No dateString Specifies the creation
date and time of the file
or the directory in the
archive.
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Node Name Required xsd Type Description

isdirectory No boolean Specifies if the current
entity is a directory or a
file:

true specifies the
entity is a
directory
false specifies
the entity is a file

content No base64Binary Specifies the contents
of the file or directory.

size No long Specifies the size of the
file or directory.

userid No string Specifies the user ID of
the file or directory.

groupid No string Specifies the group IDof
the file or directory.

permissions No string Specifies the
permissions of the file
or directory.

2. Map variables to the archiveEntries output parameter. See Creating a Map for general instructions on
mapping. For example, you could map the archiveEntries output parameter to an archiveEntries variable
and then add an For Each activity after the Unarchive activity to iterate through the instances of the
archiveEntries variable. Each instance of the archiveEntries variable represents a file or a directory. You
could add a If..Then activity to the For Each loop that tests the value of the isdirectory node and if the
entity is not a directory, place the extracted file on an FTP Server using the FTP Put File activity. This
example orchestration is shown in the following figure:

Parent topic: Unarchive Activity
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Overview of the PGP activities
WebSphere® Cast Iron® Studio supports PGP encryption and decryption. You can import, store, and
retrieve keys and certificates that are used for PGP activities.
Using the PGP Encrypt activity
During run time, the PGP Encrypt activity encrypts content. Complete the following steps to add and
map inputs and output of the PGP Encrypt activity in an orchestration:
Using the PGP Decrypt activity
During run time, the PGP Decrypt activity decrypts content received from another activity or variable in
the orchestration. Complete the following steps to add and map inputs and output of the PGP Decrypt
activity in an orchestration
Importing PGP keys
The commandLine utility that is discussed in this topic, extracts the private and public keys from the
secure and public ring files, from the PGP/GPG keystore.
Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly. This
topic provides potential solutions for issues you would have with the Cryptographic activities.
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Overview of the PGP activities
WebSphere® Cast Iron® Studio supports PGP encryption and decryption. You can import, store, and retrieve
keys and certificates that are used for PGP activities.

PGP has its own keystore for managing keys. The keystore location depends on the tool used. The public and
the secret key ring of PGP is for cryptography. Cryptoservice uses the PGP keys to encrypt and decrypt content.

Cryptoservice comes with a utility to extract the PGP keys and store the same in the PKCS12 keystore.

For Cast Iron Studio, you must use the command line utility to import the extracted PKCS12 to the Studio
keystore.

For the On-Premise Appliance, you must import the extracted PKCS12 to the Appliance keystore from the Web
Management Console.

After completing the procedures mentioned above, you can encrypt and decrypt content.

To encrypt content, you must encode the human readable content to base64, and then pass the base64
content to PGP Encrypt activity. Then, configure the inputs and provide the public key to the activity,
which in turn would return the encrypted data.
To decrypt the content you must pass the encrypted data to the PGP Decrypt activity, and configure the
input with the private keys and password. The output is base64. You must decode the base64 data to
get the original content.

Parent topic: Cryptoservice Activities
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Using the PGP Encrypt activity
During run time, the PGP Encrypt activity encrypts content. Complete the following steps to add and map
inputs and output of the PGP Encrypt activity in an orchestration:

Parent topic: Cryptoservice Activities

Adding the PGP Encrypt activity

About this task

To add the PGP Encrypt activity in the orchestration, complete the following steps:

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Cryptoservice folder.
3. Drag the PGP Encrypt activity onto the orchestration. The Summary of the activity configuration checklist

is displayed.

What to do next

Map the inputs of the PGP Encrypt activity.

Mapping the inputs of the activity

About this task

To map the inputs of the PGP Encrypt activity, complete the following steps:

Procedure

1. Select the Map Inputs task in the Checklist. The Map Inputs task is displayed. The
cryptoserviceEntry input parameter is displayed in the To Activity pane.

2. Map the variables to the nodes of the cryptoserviceEntry input parameter. The nodes of the
cryptoserviceEntry/entry node are described in the following table:

Table 1. Nodes of cryptoserviceEntry
Node
name

Requir
ed xsd Type Description
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Node
name

Requir
ed xsd Type Description

conten
t

Yes base64Bin
ary

Indicates the actual base64Binary content that must be encrypted.

keyhan
dle

Yes String Indicates the name of the GPG key that is used to encrypt the content.

passwo
rd

Option
al

String Indicates the password that must be used to decrypt keyhandle.

armore
d

Option
al

Boolean Indicates the value that must be set for ASCII Armored output. The
default value is False.

Note: 128-bit encryption level requires an 8-byte key, which must be a 32-character hexadecimal string.

Mapping the output of the activity

About this task

To map the output of the activity, complete the following steps:

Procedure

1. Select the Map Outputs task in the Checklist. The Map Outputs task is displayed. The PGP Encrypt
output parameter is displayed in the From Activity pane. The PGP output parameter contains a variable
that stores the encrypted content, which can be used in the orchestration.

2. Map a variable from the PGP Encrypt output parameter to another variable or activity in the
orchestration.
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Using the PGP Decrypt activity
During run time, the PGP Decrypt activity decrypts content received from another activity or variable in the
orchestration. Complete the following steps to add and map inputs and output of the PGP Decrypt activity in an
orchestration

Parent topic: Cryptoservice Activities

Adding the PGP Encrypt activity

About this task

To add the PGP Decrypt activity in the orchestration, complete the following steps:
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Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Cryptoservice folder.
3. Drag the PGP Decrypt activity onto the orchestration. The Summary of the activity configuration

checklist is displayed.

What to do next

Map the inputs of the PGP Decrypt activity.

Mapping the inputs of the activity

About this task

To map the inputs of the PGP Decrypt activity, complete the following steps:

Procedure

1. Select the Map Inputs task in the Checklist. The Map Inputs task is displayed. The
cryptoserviceEntry input parameter is displayed in the To Activity pane.

2. Map the variables to the nodes of the cryptoserviceEntry input parameter. The nodes of the
cryptoserviceEntry/entry node are described in the following table:

Table 1. Nodes of cryptoserviceEntry
Node
name

Requir
ed xsd Type Description

conten
t

Yes base64Bin
ary

Indicates the actual base64Binary content that must be encrypted.

keyhan
dle

Yes String Indicates the name of the GPG key that is used to encrypt the content.

passwo
rd

Yes String Indicates the password that must be used to decrypt keyhandle.

armore
d

Option
al

Boolean Indicates the value that must be set for ASCII Armored output. The
default value is False.

Note: 128-bit encryption level requires an 8-byte key, which must be a 32-character hexadecimal string.

What to do next

Map the output of the PGP Decrypt activity.

Mapping the output of the activity

About this task

To map the output of the activity, complete the following steps:

Procedure

1. Select the Map Outputs task in the Checklist. The Map Outputs task is displayed. The PGP Decrypt
output parameter is displayed in the From Activity pane. The PGP Decrypt output parameter contains a
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variable that stores the decrypted content, which can be used in the orchestration.
2. Map a variable from the PGP Decrypt output parameter to another variable or activity in the

orchestration.
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Importing PGP keys
The commandLine utility that is discussed in this topic, extracts the private and public keys from the secure
and public ring files, from the PGP/GPG keystore.

Procedure

To extract the keys from the PGP/GPG keystore, the commandLine utility uses the following parameters:

1. commandLine utility accepts the following parameters to extract the private and public keys:

extractPKCS12AndPublicKey.bat  -privateKeyRingFile <file name of the secret 
key ring file> -publicKeyRingFileName <file name of the pub key ring file>  -
passphrase <password for the gpg keys> -keyStoreLocation <keyStore Location> -
keyStorePassword <keystore password> -privateCertificateName <private 
certificate name> -issuerName <name of the certificate issuer> -
certificateStartDate <start date> -certificateExpiryDate <end date> -
algorithmName SHA256withRSA

For example:

extractPKCS12AndPublicKey.bat -privateKeyRingFile 
C:\Users\IBM_ADMIN\Documents\gpg\secring.gpg -publicKeyRingFile 
C:\Users\IBM_ADMIN\Documents\gpg\pubring.gpg -passphrase castiron -
keyStoreLocation C:\mykeystore.p12 -keyStorePassword changeit -
privateCertificateName myKey -issuerName "C=US, ST=CA, L=Mountain View, O=Cast 
Iron Systems, CN=Cast Iron Appliance VMWSULXJE23SK6HO" -certificateStartDate 
01-01-2013 -certificateExpiryDate 01-01-2015 -algorithm SHA256withRSA

2. commandLine utility accepts the following parameters to import the private and public keys to a Studio
keystore file:

importPKCS12IntoJKS.bat  -privateCertificateName <private certificate name> -
pkcsKeyStoreLocation < PKCS12 keystore store that we created in step1 >  -
pkcsKeyStorePassword < password for the keystore>

For example:

importPKCS12IntoJKS.bat -privateCertificateName myKey -pkcsKeyStoreLocation 
C:mykeystore.p12 -pkcsKeyStorePassword changeit

Note: Step 2 is not required for the appliance. You can import the generated PKCS12 keystore to the
appliance through the Security menu on the Web Management Console dashboard. For more
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information about importing certificates, see Cast Iron® Web Management Console documentation.

Parent topic: Cryptoservice Activities
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Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly. This topic
provides potential solutions for issues you would have with the Cryptographic activities.

OutOfMemoryError exception thrown

Problem: The following exception is thrown when you use the PGP Encrypt activity, for FTP transfer of .zip file
or a .tar.gz file:

Internal error: java.lang.OutOfMemoryError: Java heap space (data size is over 10MB)

Cause: Insufficient default heap allocation when starting Cast Iron Studio.

Solution: Increase the heap allocation when starting Cast Iron Studio, by giving the following command:
CastIronStudio.exe -J-Xmx1024m.

Parent topic: Cryptoservice Activities
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Data Quality Activities
About Data Quality Activities
Use the Data Quality activities in Studio to migrate or load data into a new system and/or synchronize
data between existing systems.
Filter and Profile Activity
This activity filters data based on the Boolean expression you create and generates a profile summary of
the cleansed data.
Creating Profile Summaries
Use the Profile Summaries pane to specify parameters that determine the data that the Integration
Appliance profiles.
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Filtering Expressions
A filter expression is an XPath query that specifies conditions (boolean expressions) that the Integration
Appliance uses to route data to different outputs. You can create a filter expression using the Filter and
Profile activity.
Lookup Activity
Use the Lookup Activity to retrieve rows of data from a selected database endpoint and use values from
those rows to replace or add values to the current recurring element, based on an exact or approximate
match of values from the current recurring element that is used as a key to perform the lookup.
Sort Activity
This activity allows you to sort inputs.
Merge Activity
Use the Merge activity allows to join two sorted inputs. Both the left and right inputs must be sorted on a
specified sort key before you can merge or join inputs. You must specify at least one sort key for both the
left and right inputs. The Merge activity resolves any duplicates.
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About Data Quality Activities
Use the Data Quality activities in Studio to migrate or load data into a new system and/or synchronize data
between existing systems.

From the Activities tab in the Studio toolbox, select the Data Quality directory. The Data Quality activities
include:

Filter and Profile – Filters data based on the Boolean expression you create and generates a profile
summary of the cleansed data.
Lookup – Retrieves rows of data from the database endpoint, which you select.
Sort – Sorts the inputs based on sort keys you specify.
Merge – Joins two sorted inputs.

The Integration Appliance has a Local Staging Database where you can stage the data. The Local Staging
Database can be used to share data between jobs to facilitate an iterative data cleansing process.  You can
view and edit data in the  Local Staging Database through the Web Management Console (WMC).
From the WMC, you can compelete the following operations against the Local Staging Database:

Start and Stop the database server
Connect to the Local Staging Database
Create tables
Drop tables
View tables and sort by columns
Add rows
Delete rows

For more information about performing these operations, see the WMC Online Help.
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Parent topic: Data Quality Activities
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Filter and Profile Activity
This activity filters data based on the Boolean expression you create and generates a profile summary of the
cleansed data.

Configuring the Filter and Profile activity
Mapping Filter and Profile activity outputs

Parent topic: Data Quality Activities
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Configuring the Filter and Profile activity

About this task

To configure the Filter and Profile activity complete the following steps:

Procedure

1. In the Activities tab, open the Data Quality directory to find the Filter and  Profile activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity are displayed beneath

the orchestration.
3. From the Checklist, select Configure and specify the following information:

a. The variable name of the variable that contains the recurring element, which the activity loops
through.

b. The element name of the recurring element in the variable, which the activity loops through.

Click the browse button to open the Select Recurring Element window, where you can view all the
elements in the variable you selected.  

4. From the Checklist, select Filter Expression and create an expression that the Integration Appliance
uses to filter data.
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Note: The Integration Appliance can only create a profile for data that passes the filter expression. To
profile all data, complete one of the following tasks:

Click Advanced and enter the following expression: true()

OR

Enter the expression: 1 = 1
5. From the Checklist, select Profile Summary to define parameters for the data you want to summarize.
6. Map the output of the activity.

Parent topic: Filter and Profile Activity
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Mapping Filter and Profile activity outputs

About this task

To map the outputs of the Filter and Profile activity complete the following steps:

Procedure

1. In the Checklist, select Map Outputs. The following elements are displayed in the From Activity pane:
goodXML, badXML, summary, and summaryCharts.pdf.

2. Click Select Outputs... and select the output variables for the map. For instructions about creating
variables, see Creating variables.

3. As appropriate, map the output parameters to the variables. For general mapping instructions, see
Creating a map.

Parent topic: Filter and Profile Activity
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Creating Profile Summaries
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Use the Profile Summaries pane to specify parameters that determine the data that the Integration Appliance
profiles.

About this task

To create a profile summary complete the following steps:

Procedure

1. In the Activities tab, open the Data Quality directory to find the Filter and Profile activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity are displayed beneath

the orchestration.
3. From the Checklist, select Profile Summary. The Profiles Summaries pane is displayed.
4. Click Add.
5. Specify values for the following parameters:

Profile
Summary
Paramete
r Description

XPath The XPath expression, relative to the recurring element you selected, that specifies the
data to profile

Name The name of the profile. The default is the XPath expression you selected.

Datatype Specifies the data type as either text or number.

By default, the data type is text.

For a numeric data type, the following general statistics are generated: min, max, mean,
count, sum, standardDeviation, variance.

For a text data type, the following general statistics are generated: min, max.

For both data types, histograms can be generated to show frequency counts for specific
values or value ranges.

Histogram
?

Specifies whether or not to generate a histogram. The default is false and a histogram is
not generated. To generate a histogram, select the Histogram? field and select Generate
Histogram. The value true is displayed in the field.

Max. Bins Specifies the maximum number of bins for the histogram.
Important: Only specify a value for this parameter if the datatype is specified as number.
The default value is 0, indicating that no maximum exists.

Max.
Values

Specifies the maximum number of values to use for the histogram. The default value is 0,
indicating that no maximum exists.

Min. Freq. Specifies the minimum frequency for values to be included in the histogram. This is a
number between 0-1, indicating the ratio of the number of occurrences of a given value to
all values. The default is 0.0

Chart Generates a PDF of the chart type you specify:
bar
pie
none

By default, the Integration Appliance does not generate a chart.
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Filtering Expressions
A filter expression is an XPath query that specifies conditions (boolean expressions) that the Integration
Appliance uses to route data to different outputs. You can create a filter expression using the Filter and Profile
activity.

About this task

Use the Studio Builder tool to:

Create a filter expression
Add conditions
Delete conditions
Edit conditions
Specify the processing order of conditions

Creating a filter expression
Adding a filter expression condition
Deleting a filter expression condition
Editing a filter expression condition
Changing the processing order of filter expression conditions
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Creating a filter expression

About this task

To use the Builder to create a filter expression complete the following steps:
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Procedure

1. In the orchestration, select the Filter and Profile activity to open the Checklist.
2. In the Checklist, select Filter Expression. The Builder is displayed in the Filter Expression pane.
3. Click the Left Hand Expression field to enter a parameter or click (...) for the elements of a selected

variable to be displayed. Click ( B ) to select a new variable.
4. Click the Op list to select an operator for the condition.

For a complete list of operators that you can use in the Builder, see Valid Operators for Conditions

5. Click the Right Hand Expression field to enter a parameter or click (...) for the elements of a selected
variable to be displayed. Click ( B ) to select a new variable.
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Adding a filter expression condition

About this task

To add a condition complete the following steps:

Procedure

1. Click Add. Fields for a new condition are displayed. By default, the new condition is inclusive, using AND
logic.

2. Optional: In the first column, select OR from the list to use OR logic.
3. Specify the Left Hand Expression.
4. Specify the operator for the condition
5. Specify the Right Hand Expression.
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Deleting a filter expression condition
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About this task

To delete a condition complete the following steps:

Procedure

1. In the Filter Expression pane, select the condition.
2. Click Delete.
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Editing a filter expression condition

About this task

To edit a filter expression condition complete the following steps.

Procedure

Select any field in the Filter Builder and make your edits. If the Filter Builder is not displayed, click Use
Builder. You can edit left-hand expressions, select operators, and right-hand expressions.

-OR-

Click Advanced to directly edit XPath expressions that define the condition.
Note: Use the XPath Evaluator to test XPath expressions.
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Changing the processing order of filter expression conditions
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About this task

To change the processing order of the conditions complete the following step:

Select a condition in the Filter Builderand click the up or down arrows.
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Lookup Activity
Use the Lookup Activity to retrieve rows of data from a selected database endpoint and use values from those
rows to replace or add values to the current recurring element, based on an exact or approximate match of
values from the current recurring element that is used as a key to perform the lookup.

To use the fuzzy lookup capability, you must use the Local Staging Database on the Integration Appliance. For
non-fuzzy lookups, you can use any database endpoint that Studio supports.

Note: When the Lookup activity is run from Studio, lookup results are not cached.

Lookup activity requires a parameterized SQL query, an XPath query that indicates the recurring element, and
an XPath query that indicates which value to use as the key for the lookup. A set of lookup values specifies how
column values from the database result set should be mapped to elements or attributes of the current context
node.

To complete a fuzzy lookup and approximately match the key, the Lookup activity uses the edit distance
algorithm.

For example:

In the following table Names you want to perform a query on the last name Stark. The database contains the
following records:

FirstName LastName

Tony Stark

Bruno Star

Georgia States

Howard Stark

Issue the following query: select * from Names where Col_LastName='Stark'

In this example, the key_length = length (“Stark”) = 5

For comparing against the threshold, use the value (1 – ( edit_distance / key_length) )
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The edit distance is edit_distance (“Stark”, “Stark”) = 0 and edit_distance (“Stark", “Star”) = 1

To pick up only Stark use threshold (1 – (0/5)) = 1
To pick up both Stark and Star, but not States use threshold (1 - (1/5) ) = 0.8

Using the Lookup activity
Mapping Lookup activity outputs
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Using the Lookup activity

About this task

To use the Lookup activity complete the following steps:

Procedure

1. In the Activities tab, open the Data Quality directory to find the Lookup activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity are displayed beneath

the orchestration.
3. In the Checklist, select Pick Endpoint and select a database endpoint. For instructions on creating or

editing a database endpoint, see Creating or Editing a Database Activity Endpoint
Note: To complete a fuzzy lookup you must select the Local Staging Database. To access the Local
Staging Database:

a. From the Database Type list, select Local. Staging opens in the Database Name field.
b. In the Network Location Server field, specify the data IP address of the Integration Appliance,

where the Local Staging Database is started. The Port is fixed at 1526.
c. Enter a User Name and Password.

Important: This login information must be for a user with Administrator or Publisher privileges on
the Integration Appliance.

d. Specify any additional parameters. For more details about the database parameters. see Creating
or Editing a Database Activity Endpoint.

e. Click OK. The Database endpoint is displayed in the Endpoints directory of the Studio toolbox.
4. From the Checklist, select Configure and specify the following information:

a. The variable name of the variable that contains the recurring element, which the activity loops
through.

b. The element name of the recurring element in the variable, which the activity loops through.

Click the browse button ( ... ) to open the Select Recurring Element window, where you can view
all the elements in the variable you selected.

5. In the Checklist, select Enter Query
a. Specify the query for the lookup table.
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For fuzzy lookups, you must specify exactly one parameter.
For non-fuzzy lookups, you can specify one or more parameters.

b. From the Encoding list, select the encoding type.
c. Click Validate Query

Note: If using a Local database endpoint, you must start the Local Staging Database on the
Integration Appliance before you can view columns or validate queries. To start the Local Staging
Database, in the Web Management Console (WMC), select Staging > Staging Database Start/Stop.

d. Click View Columns and select a table to view detailed column information for the table you
select. The Hide Buffer and Control Table option is the default selection.

6. In the Checklist, select Setup Input Parameters. The query you entered in the previous step is displayed.

Specify the input XPath for each input parameter in the XPath column. The input XPath is an XPath
expression that is relative to the recurring element which specifies the lookup key value that the query
uses.

7. In the Checklist, select Setup Result Set.
a. Specify the output XPath for each row in the result set. The output XPath specifies the element or

attribute relative to the recurring element that will hold the output value.  
b. Use the at-sign ( @ ) at the beginning of the XPath expression to specify an attribute.

If the name of the element or attribute already exists, Studio replaces the existing value.
Otherwise, Studio creates a new named element or attribute.
If the lookup fails to find a match, the row is sent to the badXML element.

8. In the Checklist, select Delivery Rules and specify the following delivery rules:

Delivery Rule Description

Activity Timeout Specifies in seconds the length of time that the
Integration Appliance waits for the endpoint to
respond. The default setting is 300 seconds.

Fuzzy lookup Determines if the lookup is fuzzy. Select this
option to perform a fuzzy lookup.
Important: You can only perform a fuzzy lookup
against a Local Database Endpoint.
Note: Before you run the orchestration, use the
Database Asset generation tool, in the WMC, to
create an index table.

Output at most __ match(es) per fuzzy  lookup Specifies the maximum number of matches to
output per fuzzy lookup.

The similarity threshold __ for a fuzzy lookup Specifies the similarity threshold  for determining
a match during a fuzzy lookup (between 0 - 1).  1 =
an exact match.

Ignore case (for fuzzy lookup only) Select for your lookup to be case-insensitive.

Ignore leading and trailing white spaces When selected, the Lookup activity ignores any
white space that occurs before and after the data.
For non-fuzzy lookups, you can only apply this
option to the input value. For fuzzy lookups, you
can apply this option to both the input value and
the lookup table key.

Preload cache Select this option to preload the lookup cache.

Cache at most __ lookup results Specifies the maximum number of lookup results
to cache.
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What to do next

Map the output of the activity.
Parent topic: Lookup Activity
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Mapping Lookup activity outputs

About this task

To map the outputs of the Lookup activity complete the following steps:

Procedure

1. In the Checklist, select Map Outputs. The following elements are displayed in the From Activity pane:
goodXML and badXML.

2. Click Select Outputs... and select the output variables for the map. For instructions about creating
variables, see Creating variables.

3. As appropriate, map the output parameters to the variables. For mapping instructions, see Creating a
map.
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Sort Activity
This activity allows you to sort inputs.

About this task

Important: Use the Sort activity to sort data before attempting to merge data with the Merge activity.

To sort inputs complete the following steps:
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Procedure

1. In the Activities tab, open the Data Quality directory to find the Sort activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity show beneath the

orchestration.
3. From the Checklist, select Configure and specify the following information:

a. The variable name of the variable that contains the recurring element, which the activity loops
through.

b. The element name of the recurring element in the variable, which the activity loops through. Click
the browse button ( ... ) to open the Select Recurring Element window, where you can view all the
elements in the variable you selected.

4. From the Checklist, select Sort Properties and specify the following information:
a. Optional: Select Remove Duplicates, so that the activity sends duplicates to the remainderXml

element.
b. Click Add. A new row is displayed in the Sort Keys table.
c. In the XPath column, specify the recurring element.
d. Select the Sort Type field and from the list. Choose either ascending or descending sort order for

the list. The default sort type is ascending.
e. Select the Datatype field and from the list, choose either the text or number data type. The

default data type is text.
f. Optional: Select the Ignore Case option. If you select this option, the case of the data is ignored

during the sort process.
g. Optional: Select the Ignore Leading and Trailing Whitespace option. By default, the sort process

reads any white space around data. If you select this option, the activity ignores white spaces that
can affect the sort results.

5. In the Checklist, select Map Outputs. The following elements are displayed in the From Activity pane:
sortedXml and remainderXml.

a. Click Select Outputs... and select the output variables for the map. For instructions about creating
variables, see Creating variables.

b. As appropriate, map the output parameters to the variables. For mapping instructions, see
Creating a map.
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Merge Activity
Use the Merge activity allows to join two sorted inputs. Both the left and right inputs must be sorted on a
specified sort key before you can merge or join inputs. You must specify at least one sort key for both the left
and right inputs. The Merge activity resolves any duplicates.

Use an XPath query to specify the recurring element for each input. There are six types of merges:

Merge
Type Description
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Merge
Type Description

Merge and
remove
duplicates

Removes the duplicates that occur in both the left and right inputs. Studio sends any duplicates
to the RemainderXML element.

Merge and
keep left
duplicates

Sends duplicates from the left input to the RemainderXML element.

Merge and
keep all
duplicates

Keeps duplicates from both inputs.

Inner join Joins inputs on the specified keys. Any row that does not participate in the join is sent to the
RemainderXML element.

Left outer
join

Joins the inputs on the specified keys. Rows from the left input are kept in the merged output
even if they do not participate in the join. Studio sends any rows from the right input that do not
participate in the join to the RemainderXML element.

Full outer
join

Joins the inputs on the specified keys. Rows that are not involved with the join are kept in the
merged output.

Merge Examples:

Table 1 are the Left and Right inputs for this example. Table 2 are the expected results for each type of merge
operation that the Merge activity supports.

In the following example, x is the key variable. Studio sends entries that are merged or joined to the mergeXML
element and sends any entries that do not participate in a merge or join to the RemainderXml element.

Table 1. Left and Right Inputs
Left Inputs Right Inputs

<entries> 
<entry x=”1” y=”10”/> 
<entry x=”2” y=”20”/> 
<entry x=”2” y=”21”/> 
<entry x=”3” y=”30”/> 
</entries>

<entries> 
<entry x=”0” z=”00”/> 
<entry x=”2” z=”22”/> 
<entry x=”2” z=”23”/> 
<entry x=”4” z=”40”/> 
</entries>

Table 2. Merge Results for Each Merge Type
Merge Type Merge Results

Merge  and remove duplicates <entries> 
<entry x=”0” z=”00”/> 
<entry x=”1” y=”10”/> 
<entry x=”3” y=”30”/> 
<entry x=”4” z=”40”/> 
</entries>

Merge and keep left duplicates <entries> 
<entry x=”0” z=”00”/> 
<entry x=”1” y=”10”/> 
<entry x=”2” y=”20”/> 
<entry x=”2” y=”21”/> 
<entry x=”3” y=”30”/> 
<entry x=”4” z=”40”/> 
</entries>
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Merge Type Merge Results

Merge and keep all duplicates <entries> 
<entry x=”0” z=”00”/> 
<entry x=”1” y=”10”/> 
<entry x=”2” y=”20”/> 
<entry x=”2” y=”21”/> 
<entry x=”2” z=”22”/> 
<entry x=”2” z=”23”/> 
<entry x=”3” y=”30”/> 
<entry x=”4” z=”40”/> 
</entries>

Inner join <entries> 
<entry x=”2” y=”20” z=”22”/> 
<entry x=”2” y=”20” z=”23”/> 
<entry x=”2” y=”21” z=”22”/> 
<entry x=”2” y=”21” z=”23”/> 
</entries>

Left outer join <entries> 
<entry x=”1” y=”10”/> 
<entry x=”2” y=”20” z=”22”/> 
<entry x=”2” y=”20” z=”23”/> 
<entry x=”2” y=”21” z=”22”/> 
<entry x=”2” y=”21” z=”23”/> 
<entry x=”3” y=”30”/> 
</entries>

Full outer join <entries> 
<entry x=”0” z=”00”/> 
<entry x=”1” y=”10”/> 
<entry x=”2” y=”20” z=”22”/> 
<entry x=”2” y=”20” z=”23”/> 
<entry x=”2” y=”21” z=”22”/> 
<entry x=”2” y=”21” z=”23”/> 
<entry x=”3” y=”30”/> 
<entry x=”4” z=”40”/> 
</entries>

Merging two sorted inputs
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Merging two sorted inputs

About this task

To merge two sorted inputs complete the following steps:
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Procedure

1. In the Activities tab, open the Data Quality directory to find the Merge activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity are displayed beneath

the orchestration.
3. From the Checklist, select Configure and specify the following information:

a. The variable name of the left variable that contains the recurring element, which the activity loops
through.

b. The element name of the recurring element in the left variable, which the activity loops through.
Click the browse button ( ... ) to open the Select Recurring Element window, where you can view
all the elements in the variable you selected.  

c. The variable name of the right variable that contains the recurring element, which the activity
loops through.

d. The element name of the recurring element in the right variable, which the activity loops through.
Click the browse button ( ... ) to open the Select Recurring Element window, where you can view
all the elements in the variable you selected.  

4. From the Checklist, select Merge Properties and specify the following information:
a. Select a merge type for the list.
b. In the Left Sort Key section, click Add. A new row is displayed in the Sort Keys table.
c. In the XPath column, specify the recurring element.
d. Select the Sort Type field and from the list. Choose either the ascending or descending to sort the

list. The default sort type is ascending.
e. Select the Datatype field and from the list, choose either the text or number data type. The

default data type is text.
f. Repeat steps (b - e) for the Right Sort Keys.
g. Optional: Select the Ignore Case option. If you select this option, the case of the data is ignored

during the merge process.
h. Optional: Select the Ignore Leading and Trailing Whitespace option. By default, the merge process

reads any white space around data. If you select this option, the activity ignores white spaces that
can affect the merge results.

5. In the Checklist, select Map Outputs. The following elements are displayed in the From Activity pane:
mergedXml and remainderXml.

a. Click Select Outputs... and select the output variables for the map. For instructions about creating
variables, see Creating variables.

b. As appropriate, map the output parameters to the variables. For mapping instructions, see
Creating a map.
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Database Activities
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Creating or Editing a Database Activity Endpoint
Endpoints provide the database connection information that Studio and the Integration Appliance use to
connect to a database.  
Browsing Database Tables
Use the Browse Database Tables dialog box to dynamically select a table from the current list of tables
in the database specified by the Endpoint.
Character Encodings
Set the character encoding at the database level, the table level, or the column or parameter level.
Database Entities and Activities
Defining Columns for Old Values in Updates
MaxPooledStatements Parameter
The MaxPooledStatements parameter is automatically defined and set with a default value for all types
of Database Endpoints.
Oracle, Sybase, DB2, and Informix Parameters
In the Additional Parameters table of the Database Endpoint, define the connection parameters for
Oracle, Sybase, DB2®, or Informix® databases.
Retry Options For Inbound Database Activities
 This section contains the procedure for configuring the retry options for the following inbound database
activities: Get Inserted Rows activity, Get Updated Rows activity, Get Deleted Rows activity, and Poll
Table activity.
Retry Options For Outbound Database Activities
This section contains the procedure for configuring the retry options for the following outbound
database activities: Execute Query activity, Insert Rows activity, Update Rows activity, Delete Rows
activity, and Call Procedure activity
SequeLink Parameters
Single-Table Inbound Database Activities
During run time, single-table inbound database activities poll if a database operation has occurred on
any rows in the specified columns of a database table at the specified time interval.
Single-Table Outbound Database Activities
This section contains the procedures for configuring the following single-table outbound database
activities.
Specifying Delivery Rules for Database Activities
Specify how messages will be delivered at the Delivery Rules pane.
Viewing Column Details
The View Column dialog box allows you to see detailed column information for tables as you enter a SQL
statement in the Enter Query task of the Checklist for the Execute Query activity. This task describes
how to access the View Column Details dialog box.
Working with Database Parameters
Parameters supply database-specific connection information for an endpoint.
Call Procedure Activity
During run time, the Call Procedure activity runs a stored procedure in a database. The stored procedure
must be written and installed in the database before you can complete the configuration of the Call
Procedure activity in Studio.
Execute Query Activity
During run time, the Execute Query activity runs a select SQL statement.
Poll Table Activity
The Poll Table activity checks if a database operation (insert or update) has occurred on any rows of a
database table by checking the status of a special flag column at the specified time interval.
Testing an SSL Database Connection
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Creating or Editing a Database Activity Endpoint
Endpoints provide the database connection information that Studio and the Integration Appliance use to
connect to a database.  

Select or edit a database endpoint

1. In the Create Endpoint or Edit Endpoint pane, configure the fields as described in the following tables.
Note: Changing the configuration properties of an endpoint affects all orchestrations that use that
endpoint in the project. The edits are global, not local.

2. Click Test Connection to confirm that you can connect to the database. Click OK.

Database options

Table 1. Database options
Field Description

Databa
se Type

Specifies the database type. If you select the Generic JDBC driver or MySQL, you must install the
module providers into Studio. To add JDBC drivers into Studio, you add them to the Web
Management console and then complete the following steps in the WMC.

1. Go to Settings.
2. Select Design.
3. Select Libraries Environment and set it to the environment that you loaded the compressed

files into.
4. Restart Studio.

Note: For JDBC drivers to access database endpoints for Cast Iron® Generic JDBC support, the JDBC
driver must be:

Type 4.
Must implement the JDBC 2.0 or greater specification.
Must provide support for the DataSource feature API.

Additional Parameters may be required for a Generic JDBC Driver. You should check the
documentation for the driver you intend to use to see if any additional parameters are required.
For more information about installing the JDBC libraries into the WMC, see the WMC Online help.

Databa
se
Name

Specifies the name of the Database to which you want to connect. If connecting to Oracle RAC, see
For Oracle RAC:.
Note: For AS/400 DB2® databases, this is the collection name defined during installation.

 201



Field Description

Networ
k
Locatio
n:
Server

Specifies the name or IP address of the machine where the database server resides. For Informix®,
log into the Informix Server Administrator and select the Configuration > SQLHOST menu option to
find the hostname. For Sequelink, enter the name or the IP address of the Sequelink server.

Networ
k
Locatio
n: Port

Specifies the port number of the database server listener. For Sequelink, enter the port number of
the Sequelink server listener.

User
Name

Specifies the username that the Integration Appliance uses to connect to the database.
Note: For DB2, the user must have the permissions to create a package.

Passwo
rd

Specifies the password associated with the specified username.

Additio
nal
Parame
ters

Specifies the database-specific information for an endpoint. See Working with Database Parameters
for details. By default, the MaxPooledStatements parameter is automatically defined and set with a
default value for all types of Database Endpoints.

Note: For some of the fields in the endpoint, you can define configuration properties to supply the values for
these fields.  The

icon displays when you click in a field that supports a configuration property and a configuration property of the
same type has already been configured for the project.

For Informix Databases

To find the port number for an Informix database:

1. In an editor, open the following file: $INFORMIXSERVER/etc/sqlhosts
2. Note the servicename found in the SERVER column.
3. In an editor, open the appropriate file for your system:

UNIX - /etc/services  
Windows - \Winnt\system32\drivers\etc\services

4. In the file, search for the servicename to find the associated port number.

For DB2 AS/400 Databases

For some EBCDIC-US columns on DB2 AS/400, Studio cannot determine the correct size and type.
To pass an EBCDIC-US encoded parameter:

1. In Studio, open the orchestration containing a Database Connector activity.
2. Change CHAR type columns to VARBINARY type. The EBCDIC-encoded columns display as CHAR type

columns in the data type of the outbound connector.
3. Use a map before the Database Connector to pad an EBCDIC-encoded parameter with spaces, so that

the value of the parameter equals the length of the column.

For example, if the column length is 10 and the value is "abc", pad the column with 7 spaces.

If the EBCDIC-encoded value is not padded with spaces, the Database Connector pads the value with
NULL. This can create inconsistent data and errors can occur.
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To read an EBCDIC-US encoded column from a result set:

1. In Studio, open the orchestration containing the Database Connector Parameterized Query operation.

When you use a parameterized query to select an EBCDIC-encoded column from a database, the
Database Connector returns values padded with spaces if the value is shorter than the column length.

For example, if the column length is 10 and the value is "abc", the Database Connector pads the column
with 7 spaces.

2. Create a map after the Parameterized Query operation to trim the padded spaces from the XML result
set.

For Oracle RAC:

IBM Cast Iron supports additional properties in the connection string that enable Oracle RAC connectivity. Use
the following additional  properties to connect with Oracle RAC:

1. AlternateServers=(servername1[:port1] 
[;property=value[;...]], 
servername2[:port2] 
[;property=value[;...]],...) 

Where:

servername is the IP address of the server

port is the port number of the server

property=value enter the ServiceName which is used as the Database Name. Entering a SID is optional.

2. LoadBalancing=true|false

Determines whether the driver will use client load balancing in its attempts to connect to a list of
database servers, primary and alternate. The list of alternate servers is specified by the AlternateServers
property. If set to true, client load balancing is used and the driver attempts to connect to the list of
database servers, primary and alternate servers, in a random order. If set to false (the default), client
load balancing is not used and the driver connects to each server based on their sequential order
(primary server first, then, alternate servers in the order they are specified).

3. Use the service name in the Database Name of the end-point.

Connection Pool, Encoding, TimeOut, and Security Options

Default values are provided for the connection pool options. Change them as needed.
Table 2.

Field Description

Connect
ion Pool
Options

 

Initial
Pool
Size

Specifies the initial number of database connections that the Integration Appliance opens and
places in the connection pool.
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Field Description

Minimu
m
Connect
ions

Specifies the number of database connections that the Integration Appliance always keeps open in
the connection pool. Specifying 0 is supported.

Maximu
m
Connect
ions

Specifies the maximum number of database connections that the Integration Appliance can have
open in the connection pool. Specifying 0 means the number of connections is unbounded.

Maximu
m Idle
Time

Specifies the amount of time (in minutes) that a database connection can be open and idle before
being closed by the Integration Appliance. Specifying 0 means that the connections are closed
when they are returned to the pool - no idle time.

Reclaim
Connect
ions

Specifies how often the Integration Appliance checks the connection pool to determine if any
connections should be closed. For example, if the Reclaim Connections is set to 6 minutes, the
Integration Appliance checks the connection pool every six minutes to determine if the total
number of open connections in the pool are greater than the minimum number of connections. If
the number of open connections are greater than the specified minimum number, the Integration
Appliance closes any excess connections (over the number of Minimum Connections) for any
connections that have exceeded the Maximum Idle Time.

For example, the Minimum Connections is set to 2, Maximum Connections is set to 6, the Reclaim
Connections is 6 minutes, and the Maximum Idle Time set to 2 minutes. A total of five connections
are currently open in the connection pool. When the Reclaim Connections of 6 minutes is reached,
the Integration Appliance checks the connection pool and determines that one connection has
been idle for 3 minutes, one connection has been idle for 4 minutes, and three connections are still
active. The Integration Appliance closes the two idle connections. After another 6 minutes, the
Integration Appliance checks the connection pool again.

Default
Encodin
g

 

Encodin
g  

Specifies the default character Encoding to use when connection to this database. To set the
encoding type, choose from one of the following options:

From the Encoding drop-down list, select a default encoding type.  
Enter your encoding type directly by clicking in the Encoding field and typing in your
encoding type.

Note: Some double-byte characters are not converted using the SHIFT-JIS encoding. For more
information, see Using the Shift-JIS encoding.

Quoted
Identifi
ers
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Field Description

Delimit
the
identifie
rs for
tables,
column
s, and
objects
with
quotes

Specifies if quotes are used around the identifiers for database tables, columns, and objects in the
generated SQL statements that the Integration Appliance and Studio uses to communicate with the
database. Quoting an identifier makes the identifier case-sensitive. For example, the identifier
string: myTable could refer to table named mytable or MYTABLE but the identifier string with
quotes: "myTable" only refers to a table named myTable. Quoting an identifier also allows
characters not normally found in database names such as spaces.

Security  

Enable
Encrypti
on

Specifies that the connection should use SSL.

Validate
Server
Certifica
te

Specifies that the client should validate the database server certificate. See Testing an SSL
Database Connection.

Require
Client
Authent
ication

Specifies that the client present a certificate to the database server.

Connect
ion
Timeout

 

Time
out
after
___
second(
s) when
establis
hing a
connect
ion to
the
Endpoin
t.

Specifies the amount of time in seconds before a timeout occurs between the Integration Appliance
attempting to establish a connection to the Endpoint and the time it takes for the Endpoint to
respond to the connection request. For a database activity, the amount of time the Integration
Appliance attempts to establish a connection to the database before timing out. A connection
timeout is different from an activity timeout because an activity timeout occurs after the connection
to the Endpoint has already been established. An activity timeout specifies the amount of time in
seconds before a timeout occurs between the activity invoking a request on an Endpoint and the
time it takes the Endpoint to respond. You set the activity timeout in Retry task of any of the
following database activities:

Execute Query Activity, see Execute Query Activity.
Single-Table Inbound Database Activities, see Single-Table Inbound Database Activities.
Single-Table Outbound Database Activities, see Single-Table Outbound Database Activities.
Poll Table Activity Call, see Poll Table Activity.
Procedure Activity, see Call Procedure Activity.
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Browsing Database Tables
Use the Browse Database Tables dialog box to dynamically select a table from the current list of tables in the
database specified by the Endpoint.

Studio connects to the database to get the current list of tables from the database.

To select a table choose one of the following options:

Click on a table in the list and click OK.
Double-click on a table in the list.

 To change the list of selectable tables, use the following options:

To see tables associated with a different schema, select a schema from the Filter by User Schema list.
To see tables for all schemas, click Clear.
To filter out any buffer or control tables created using the Web Management Console (WMC) that are
used internally by the Integration Appliance during run time check Hide Buffer and Control Tables. The
column names in these tables are prefaced by convention with the string: IH:
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Character Encodings
Set the character encoding at the database level, the table level, or the column or parameter level.

For example, the default encoding for your database might be set to UTF-8 but one table in that database
might explicit set the encoding to SHIFT-JIS. One column in this table might have the encoding explicitly set to
ISO-8859-1 while all the other columns do not specify the encoding, so they inherit the default encoding of
SHIFT-JIS from the table.

The Integration Appliance can convert from type of encoding to another during run time. For example, the
orchestration might read in input data from a table with the encoding set to ISO-8859-1 and then write out that
data to a column set to UTF-8.

To set character encodings:

At the Database level - Select the encoding type from the Encoding list of the Edit Endpoint or Create
Endpoint dialog box.
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At the Table level - Select the encoding type from the Encoding list in the Pick Table pane.
At the Column level - Click on the Encoding field for the desired column in the Pick Table pane and
select from the list.

See the following below for descriptions of the default character encoding types.
Note: You must leave the encoding field blank for the following binary Datatypes:

Blob
Binary
Varbinary

To set the encoding type, choose from one of the following options:

From the Encoding list, select a default encoding type.  
Enter your encoding type directly by clicking in the Encoding field and typing in your encoding type.

Some of the default encoding types are listed in the following table:
Table 1.

Encodi
ng Description

UTF-8 UTF-8 is a standard character encoding for Unicode or ISO-10646. Both of these standards assign a
single unique number to each character used in modern languages. This is the default encoding.

US-
ASCII

Also known as ASCII, this is the basic character encoding used on Windows and UNIX computers.

ISO-
8859-1

Also known as Latin1, this encoding includes ASCII plus characters for many Western European
languages.

EBCDI
C-XML-
US

This is the basic character encoding used on IBM® computers. EBCDIC-US, like ASCII, is a US-based
character encoding.

SHIFT-
JIS

Also known as Katakana, specifies the Japanese language.
Note: Some double-byte characters are not converted using the SHIFT-JIS encoding. For more
information, see Using the Shift-JIS encoding.
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Database Entities and Activities
The following table shows the relationship between the database entities and the different types of database
activities. In addition, this table describes how the database entity is created in the database.

Note: For DB2® UDB, the asset generation script limits the names of buffer and control tables to nine
characters.

 207



Note: For Generic JDBC Driver connections: The scripts used to generate assets are only a template based on
the information available from the database. The scripts should be analyzed to confirm that the SQL syntax and
datatypes are supported for the target database. If they are not, the scripts must be modified and run via
another mechanism to create the required assets for the database.

 

Da
ta
ba
se
En
tit
y

Associated Activity Description How created?

Bu
ffe
r
Ta
bl
es

Used with the inbound single-table
activities: Get Inserted Rows, Get
Updated Rows, and Get Deleted
Rows. The buffer tables contain the
result of a database operation.

For example, a Get Inserted Rows
activity is polling for an insert on the
database. When the insert occurs in the
database, the buffer tables are
populated with data that was inserted.

The buffer tables used with inbound single-table activities are
created using the following procedure:

1. In the Web Management Console (WMC), go to the
Assets screen and execute the scripts.

2. From the WMC, deploy the project.

Co
nt
rol
Ta
bl
es

Used with the following activities when
messages are specified to be delivered
exactly once:

Insert Rows
Update Rows
Delete Rows
Call Procedure

Control tables are not needed if
another delivery option is specified.
Specify a delivery option in the Deliver
Rules task of the Checklist for an
activity.

The control tables used with activities are created using the
following procedure:

1. In the Web Management Console (WMC), go to the
Assets screen and execute the scripts.

2. From the WMC, deploy the project.

Tri
gg
er
s

Used with inbound single-table
activities, Get Inserted Rows, Get
Updated Rows, and Get Deleted
Rows, to populate the buffer table.

The triggers used with inbound single-table activities are
created using the following procedure:

1. In the Web Management Console (WMC), go to the
Assets screen and execute the scripts.

2. From the WMC, deploy the project.
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Da
ta
ba
se
En
tit
y

Associated Activity Description How created?

St
or
ed
Pr
oc
ed
ur
es

Stored procedures are required with
the Call Procedure activity.

The stored procedure must be written and installed in the
database before you can complete the configuration of the Call
Procedure activity in Studio. The stored procedure is not
created using the WMC. The database administrator must
create the stored procedure directly in the database.

Se
qu
en
ce

Used with inbound single-table
activities, Get Inserted Rows, Get
Updated Rows, and Get Deleted
Rows, for the Oracle database only.

Oracle only - The sequences used with inbound single-table
activities are created using the following procedure:

1. Publish a project with an orchestration that contains the
inbound single-table activity to the Integration Appliance
from Studio.

2. Use the Web Management Console (WMC) to create the
sequences in the Oracle database used by the
orchestration.

3. From the WMC, deploy the project.

Parent topic: Database Activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/conn_ref_Connector_Prerequisites_for_
Database_Operations.html

Defining Columns for Old Values in Updates

About this task

The Get Updated Rows (inbound) and Update Rows (outbound) activities can store both the new value and
the original values of the specified columns during run time. For example anGet Updated Rows activity could
be configured to stored both the original value of Name column and the new value of the Name column. Figure 1
shows the transfer of example data when the Get Updated Rows activity is processed by the Integration
Appliance after an update trigger event occurs:

Figure 1. Update old columns
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In the Old Value Columns for Updates dialog box, select the columns that you want to store the original values.
The Old Value Columns for Updates dialog box is available by clicking Old Values in the Pick Table task of the
Checklist for the Get Updated Rows and Update Rows activities. By default the name of the column used to
store the original values is the original column name prefixed with the string: old_. For example if the original
column name is called FirstName, by default the column used to store the original value of the update
operation is called old_FirstName. This default name can be changed.

For some projects, you might want to also store the original values of the Primary Keys. For example, if your
application actually changes primary key values during update operations as shown in Figure 2.

Figure 2. Example 1

The purpose of the example orchestration is to keep the myInput database table in sync with the myOutput
database table. The example orchestration contains a Get Updated Rows activity that polls for update events
in the myInput table and an Update Rows activity that updates the myOutput table.

During run time, an update operation on the myInput database table occurs, changing both the value of the
Name column and the primary key value for that row. This update operation is done outside of the integration
project. In order for the orchestration to keep the myInput database table in sync with the myOutput database
table, it needs access to the original primary key so it knows which row in the myOutput database table to
update with the new primary key and the new value for the Name.

The old primary key can be saved to a variable by the Get Updated Rows activity to be used later by the
Update Rows activity when updating the myOutput database table as shown in Figure 3.

Figure 3. Example 2
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MaxPooledStatements Parameter
The MaxPooledStatements parameter is automatically defined and set with a default value for all types of
Database Endpoints.

Attention: Changing the default setting of the MaxPooledStatements parameter can cause reduced
performance.

The MaxPooledStatements parameter specifies the maximum number of prepared statements that are cached
by the Database Endpoint. When the value of MaxPooledStatements parameter is greater than zero, the
Database Endpoint creates a prepared statement pool  to store PreparedStatement objects for later reuse. The
performance cost of creating new PreparedStatement objects can be expensive, so storing and reusing existing
PreparedStatement objects from a pool can result in a performance gain.

Parent topic: Database Activities
Related tasks:
Working with Database Parameters
Related reference:
Oracle, Sybase, DB2, and Informix Parameters
SequeLink Parameters

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/MaxPooledStatements_Parameter.html

 211



Oracle, Sybase, DB2, and Informix Parameters
In the Additional Parameters table of the Database Endpoint, define the connection parameters for Oracle,
Sybase, DB2®, or Informix® databases.

:

Oracle

If the Call Procedure activity calls an Oracle stored procedure that returns a result set, you must define an
Endpoint solely for that connector and add the parameter procedureretresult. The value for this parameter
must be 1.

If an Oracle database table name starts with a number, Studio throws an Invalid Trigger Specification error.

If the project uses database links with the Oracle 8.1.6 database, you must define the supportLinks parameter
and assign it a value of true in the Database Endpoint. By default, the MaxPooledStatements parameter is
automatically defined and set with a default value for an Oracle Database Endpoint.   

DB2

For the DB2 database, you must define the following two parameters:

LocationName - Enter the location name defined during installation for the AS/400 DB2 database. Not
required for UDB.
PackageCollection - The value of this field depends on the system type of the DB2 database:

AS/400  - Enter the collection name.
UDB  - Enter the name of the DB2 Database.

Note: The DB2 user must have the permissions to create a package.

By default, the MaxPooledStatements parameter is automatically defined and set with a default value for a DB2
Database Endpoint.

Informix

You must define the InformixServer parameter.

To find the Informix Server name search the onconfig file for DBSERVERNAME and specify its value for the
InformixServer parameter.

By default, the MaxPooledStatements parameter is automatically defined and set with a default value for an
Informix Database Endpoint.

Sybase

For a Sybase Endpoint, the OverwriteCharLimits parameter is automatically defined and set to the value of
32768. This parameter defines the size of character columns, for example: vchars and chars.

By default, the MaxPooledStatements parameter is automatically defined and set with a default value for a
Sybase Database Endpoint.  
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Retry Options For Inbound Database Activities
 This section contains the procedure for configuring the retry options for the following inbound database
activities: Get Inserted Rows activity, Get Updated Rows activity, Get Deleted Rows activity, and Poll Table
activity.

Specify the retry options for inbound database activities

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to a database. The following table describes the retry options

for connecting to a database:
Table 1.

Field Description

Retry  

1)
Wait
___
secon
d(s)
betwe
en
each
retry.

Specifies the amount of time (in seconds) that the Integration Appliance waits before trying to
establish a connection to the database.
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Field Description

2) Try
to
conne
ct ___
times
before
failing
.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the database before issuing an error.

If this parameter is set to "0", Studio does not try to reconnect.
If this parameter is set to a value less than "0", Studio retries the connection
indefinitely.

If an orchestration that starts with an inbound database activity is deployed and the
Integration Appliance cannot connect to the specified database, the Integration Appliance
logs the connections errors as Warnings in the system log until the retry count value is
reached. When the retry count is reached, the Integration Appliance logs an Error in the
system log, resets the connection error count to zero, and continues to attempt to establish a
connection to the database.

For example: the retry count is set to 3. The first, second, and third connection errors are
shown in the system log as Warnings. The Integration Appliance logs the fourth connection
error as an Error and resets the connection error count to zero. Therefore, the fifth connection
error generates a Warning in the system log. The Integration Appliance continues to attempt to
establish a connection to the database.

 

Activit
y
Timeo
ut

 

3)
Time
out
after
___
secon
ds
when
the
Endpo
int
does
not
respo
nd to
a
reque
st.

Specifies the amount of time in seconds before a timeout occurs between the activity making
a request on an Endpoint and the time it takes the Endpoint to respond. For example, the
amount of time the Integration Appliance waits for a response from the database after
requesting that database polls for an INSERT trigger event, before the Integration Appliance
issues a timeout error. An activity timeout is different from a connection timeout because an
activity timeout occurs after the connection to the Endpoint has been established. A
connection timeout specifies the amount of time in seconds before a timeout occurs between
the Integration Appliance attempting to establish a connection to the Endpoint and the time it
takes for the Endpoint to respond to the connection request. Set the connection timeout in
Database Endpoint tab. For more information about connection timeouts, see Creating or
Editing a Database Activity Endpoint.
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Retry Options For Outbound Database Activities
This section contains the procedure for configuring the retry options for the following outbound database
activities: Execute Query activity, Insert Rows activity, Update Rows activity, Delete Rows activity, and Call
Procedure activity

Specify the retry options for outbound database activities

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to a database. The following table describes the retry options

for connecting to a database:
Table 1.

Field Description

Retry  

1)
Wait
___
secon
d(s)
betwe
en
each
retry.

Specifies the amount of time (in seconds) that the Integration Appliance waits before trying to
establish a connection to the database.

2) Try
to
conne
ct ___
times
before
failing.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the database before issuing an error and stopping the processing
of the current orchestration job.

If you deploy an orchestration that contains the outbound database activity and the
Integration Appliance cannot connect to the specified database, the Integration Appliance
logs the connections errors as Warnings in the system and orchestration logs until the retry
count value is reached. When the retry count is reached, the Integration Appliance logs an
Error in the system and orchestration logs and the stops processing the current orchestration
job.

For example, the retry count is set to 3. The first, second, and third connection errors are
shown in the system log as Warnings. The Integration Appliance logs the fourth connection
error as an Error and stops processing the current orchestration job.
Note: For the Database Execute Query activity, if you set this parameter to zero, the
Integration Appliance retries the connection indefinitely.

Activit
y
Timeo
ut  
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Field Description

3)
Time
out
after
___
secon
ds
when
the
Endpoi
nt
does
not
respon
d to a
reques
t.

Specifies the amount of time in seconds before a timeout occurs between the activity making
a request on an Endpoint and the time it takes the Endpoint to respond. For example, the
amount of time that the Integration Appliance waits for a response from the database after
requesting an Insert, before the Integration Appliance issues a timeout error. An activity
timeout is different from a connection timeout because an activity timeout occurs after the
connection to the Endpoint has been established. A connection timeout specifies the amount
of time in seconds before a timeout occurs between the Integration Appliance attempting to
establish a connection to the Endpoint and the time it takes for the Endpoint to respond to the
connection request. Set the connection timeout in the Database Endpoint tab. For more
information about connection timeouts, see Creating or Editing a Database Activity Endpoint.
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SequeLink Parameters
The various parameters for a Sequelink Endpoint are listed in this section. Some parameters require that a
Parameter Value is specified. You can also add additional parameters.

Note: When you specify SequeLink Server as the Database Type for an endpoint, the parameters listed in this
section in bold display in the Additional Parameters table of the Endpoint pane.

MaxPooledStatements

By default, the MaxPooledStatements parameter is automatically defined and set with a default value for a
SequeLink Database Endpoint.  

ServerDataSource

This parameter is required. You must enter the Data Source Name in the Parameter Value field. The Data
Source Name is specified in the Data Source Settings in the Sequelink Manager.

BaseDatabaseType
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Enter the string: OTHERS.

DBLogonId

Enter the name of the user account to use to access this database. This is an optional parameter that
duplicates the User Name property of the endpoint. Use this parameter if your SequeLink Server requires it.
You must also complete the DBPassword parameter.

DBPassword

Enter the password for the account specified in DBLogonId. This is an optional parameter that duplicates the
Password property of the endpoint. Use this parameter if your SequeLink Server requires it.

HLogonID

Enter the login or user name to use to access the host where the SequeLink Server is installed. This is an
optional parameter that is only required if the SequeLink Server requires host authentication. You must also
specify the HPassword parameter.

HPassword

Enter the password to use to access the host where the SequeLink Server is installed. This is an optional
parameter that is only required if the SequeLink Server requires host authentication.
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Single-Table Inbound Database Activities
During run time, single-table inbound database activities poll if a database operation has occurred on any rows
in the specified columns of a database table at the specified time interval.

This section contains the procedures for configuring the following single-table inbound database activities:

Get Inserted Rows - During run time, the Get Inserted Rows activity polls for rows being added to the
buffer table from an INSERT trigger event. The Get Inserted Rows activity then maps the buffer data to
variable or variables.   
Get Updated Rows - During run time, the Get Updated Rows activity polls for rows being added to the
buffer table from a UPDATE trigger event. The Get Updated Rows activity then maps the buffer data to
variable or variables.   
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Get Deleted Rows - During run time, the Get Deleted Rows activity polls for rows being added to the
buffer table from a DELETE trigger event. The Get Deleted Rows activity then maps the buffer data to
variable or variables.

Figure 1 shows the transfer of example data in the UPDATE trigger event and the Get Updated Rows activity:
Figure 1. UPDATE trigger example

After publishing your orchestration with an inbound database activity to the Integration Appliance, you must
create the buffer table and triggers using the Web Management Console (WMC) before the orchestration is
deployed. For the Oracle database, you must also create a sequence using the WMC.

No Activity for that Operation Run-time Error

If an orchestration accesses a buffer table containing a row for an activity that is currently not present in the
orchestration, the orchestration fails and following error is reported during run time:

The buffer table contains the OperType operation  
but there is no activity in the orchestration for that operation.

Where OperType is type of operation; for example, INSERT. The values of the IH_OPERATION_NAME column
in the buffer table for the orchestration must be consistent with the database activities in the orchestration. For
example, if a row in the buffer table contains the value: INSERT in the  IH_OPERATION_NAME column but the
orchestration does not contain a Get Inserted Rows activity, this error is reported. Each orchestration must
have a separate buffer table. In addition, the triggers in the source table must be consistent with database
operations specified in the buffer table. For example if the orchestration only contains a single inbound Get
Updated Rows activity, the source database table must only contain a UPDATE trigger.

Add a single-table inbound database activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Database folder.
3. Drag the desired single-table inbound database activity (Get Inserted Rows, Get Deleted Rows, or Get

Updated Rows) onto the orchestration.
4. Select the activity.

Create, select, or edit a database endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
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b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.
Select an existing endpoint and edit the endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit a HTTP endpoint, see Creating or editing an HTTP endpoint.

Select the columns in the source database table that during run time the
Integration Appliance polls for changes

1. Click Pick Table from the Checklist. The Pick Table pane is displayed.
2. Click Browse... to select the database table that is to be the source for inbound messages. The Browse

Database Tables dialog box is displayed.
3. Select a table from the list and click OK. Column information for the selected table is displayed in the

Pick Table pane.
4. If the character encoding for this table is different from the encoding for the database, enter another

encoding using one of the following options:
From the Encoding list, select one of the default encoding types.  
Enter your encoding type directly by clicking in the Encoding field and typing in your encoding
type.

This sets the encoding for all the columns of the resulting buffer table.
Note: Some double-byte characters are not converted using the SHIFT-JIS encoding. For more
information, see Using the Shift-JIS encoding.

5. By default all columns in the source table are selected. Clear the Use check box to remove a column
from resulting buffer table. Click Use All to reselect all the columns.

6. Click in the heading of the column to sort the rows by the column value. For example, to sort the rows by
their column name, click the Column Name heading of the column. An arrow is displayed to the right of
the column header name. An up arrow indicates the column is sorted by alphabetic order starting with a
and continuing to z. A down arrow indicates the column is sorted by reverse alphabetic order starting
with z and continuing to a. Click the arrow to reverse the alphabetic order.

7. For the Get Updated Rows activity only - if you want the resulting buffer table to contain both the new
values and the original values of the updated columns follow these steps:

a. Click Old Values. The Old Value Columns for Updates dialog box displays.
b. Select the Store check box for the database columns that you want to save the original values.
c. You can change the default names assigned to columns to store the original values. Double-click

the appropriate Column Name to Store Old Value cell.
d. Click OK.  The selected columns are displayed in the From Activity of the Map Outputs pane

prefixed with the string: old_. You can map both the new and original values from the Map
Outputs pane.  

Note: For more information see Defining Columns for Old Values in Updates.
8. If necessary, change the settings of the Data Type, Encoding, or Nullable values. Click the field to make a

new selection.
Data Type - Defaults to the data type for the column in the source database table. If the required
data type for the column in the buffer table is different from the data type of the source table,
select a different data type by clicking in the Data Type cell and selecting another Data Type from
the list. You must select an appropriate data type for those data types that are marked
UNSUPPORTED.
Note: For the XMLTYPE data type in an Oracle database and the MONEY data types in a SQL
Server database, Studio does not automatically associate the correct data type so you must
manually select the appropriate data type.
Attention: You must select a compatible data type with the source data type to avoid invalid data
during run time. For example, do not select the SMALLINT data type for the buffer table if the
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source data type is INTEGER because during run time a large number stored in an INTEGER
column will not convert correctly to the SMALLINT data type.
Size - Size of the column defined in the table. This size is retrieved from the database table and is
not configurable.
Encoding - Defaults to current default encoding that was set either at the database level or the
table level. If the required encoding for the column is different from the current default encoding,
select another encoding by clicking in the Encoding cell and selecting another Encoding from the
list.  
Nullable - Defaults to the nullable setting for the column in the source database table. The Use
check box must be selected for those columns where nullable=false. A column marked
nullable=false cannot not contain a null during run time.

9. Click Reset to reset all column properties to their defaults. This also resets the Use check box for all
columns.

10. Click Refresh to update the list of columns in reference to the latest state of the source database. Recent
changes to the source is updated in this pane.

11. Configure the Specifying Delivery Rules for Database Activities.
Note: If you select the Exactly once option in the Delivery Rules task, you must create control tables
that are used by the Integration Appliance during run time. You create the control tables after publishing
the orchestration from Studio to the Integration Appliance. You create the control tables using the Web
Management Console (WMC) before you deploy the project.
Note: If you select the Exactly Once option, you must enable persistence. For more information, see
Enabling persistence.

12. Configure the retry options. For more information, see Retry Options For Inbound Database Activities.

Map the output of the activity

1. Select the Map Outputs task in the Checklist.

The output parameters for the activity are displayed under the rows element in the From Activity pane.
The output parameters displayed in the From Activity pane correspond to the columns you selected in
the Pick Table task. If the Batch option was selected in Delivery Rules, the multiple occurrences
symbol displays next to the row element.

Note: For the Get Updated Rows activity only, if some columns were selected in the Old Values Columns
for Updates dialog box (in the Pick Table task), these additional output parameters (by default prefixed
with the string: old_) also display under the rows element.  You must map all the old value columns
visible in the Map Outputs pane.

2. Map the required output parameters to variable or variables. See Creating a map for general instructions
on mapping. You are not required to map the output parameters for these activities.
Note: After publishing your orchestration with an inbound database activity to the Integration Appliance,
you must create the buffer table using the Web Management Console (WMC) before the orchestration is
deployed.
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Single-Table Outbound Database Activities
This section contains the procedures for configuring the following single-table outbound database activities.

These activities include:

Insert Rows - This activity takes data from variable or variables that are mapped to the input
parameters of the activity and inserts this data as rows into the specified database table.
Update Rows - This activity takes data from variable or variables that are mapped to the input
parameters of the activity and updates the rows of the specified database table with this new data.
Delete Rows - This activity takes data from variable or variables that are mapped to the input
parameters of the activity and deletes rows of the specified database table based on this data.

For the Update Rows and the Delete Rows activities, the Integration Appliance integrates the database table
to determine which columns in the table are primary key columns. When the Update Rows or the Delete Rows
activities are started during run time, the Integration Appliance uses the value of the incoming variable that
contains the primary key number to determine which rows to update or delete.
For example, the PK column is defined in the database as being a primary key column for the database table.
The Use check box is selected for the PK column in the Pick Table task of the Checklist for the Delete Rows
activity. In the Map Inputs pane of the Delete Rows activity, the variable called myIncomingPK is mapped to
the PK element of the row as shown in Figure 1:
Figure 1. myIncomingPK is mapped to the PK element of the row

During run time, if the value of the myIncomingPK variable is equal to 3 the row with the PK equal to 3 is
deleted from the table as shown in Figure 2:
Figure 2. The row with the primary key equal to 3 is deleted
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If no primary key columns are specified in the Pick Table task of the Checklist, specify at least one column to
act like the primary key. Specify acting primary key column or columns using the Configure Primary Keys dialog
box, available by clicking Keys in the Pick Table task of the Checklist for the Delete Rows and Update Rows
activities. If no primary keys are specified in the database table or selected as acting primary keys in the
Configure Primary Keys dialog box, all the rows of the database table are affected by the delete or the update
operation.

You can also use the Configure Primary Keys dialog box to specify additional columns to act as primary key
columns. For example for the table in the preceding figure, you could define that the Name column should act
like primary key column in addition to the PK primary column that was defined in the database as being a
primary key column.

Add a single-table outbound database activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Database folder.
3. Drag the wanted single-table outbound database activity (Insert Rows, Delete Rows, or Update Rows)

onto the orchestration.
4. Select the activity.

Create, select, or edit a database endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create an endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit an HTTP endpoint, see Creating or editing an HTTP endpoint.

Select the columns in the source database table that during run time the
Integration Appliance polls for changes
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1. Click Pick Table from the Checklist. The Pick Table pane is displayed.
2. Click Browse... to select the database table that is to be the source for inbound messages. The Browse

Database Tables dialog box is displayed.
3. Select a table from the list and click OK. Column information for the selected table is displayed in the

Pick Table pane.
4. If the character encoding for this table is different from the encoding for the database, enter another

encoding using one of the following options:
From the Encoding list, select one of the default encoding types.  
Enter your encoding type directly by clicking in the Encoding field and typing in your encoding
type.

This sets the encoding for all the columns of the resulting buffer table.
Note: Some double-byte characters are not converted using the SHIFT-JIS encoding. For more
information, see Using the Shift-JIS encoding.

5. By default all columns in the source table are selected. Clear the Use check box to remove a column
from resulting buffer table. Click Use All to reselect all the columns.

6. Click in the heading of the column to sort the rows by the column value. For example, to sort the rows by
their column name, click the Column Name heading of the column. An arrow is displayed to the right of
the column header name. An up arrow indicates the column is sorted by alphabetic order starting with a
and continuing to z. A down arrow indicates the column is sorted by reverse alphabetic order starting
with z and continuing to a. Click the arrow to reverse the alphabetic order.

7. For the Get Updated Rows activity only - if you want the resulting buffer table to contain both the new
values and the original values of the updated columns follow these steps:

a. Click Old Values. The Old Value Columns for Updates dialog box displays.
b. Select the Store check box for the database columns that you want to save the original values.
c. You can change the default names assigned to columns to store the original values. Double-click

the appropriate Column Name to Store Old Value cell.
d. Click OK.  The selected columns are displayed in the From Activity of the Map Outputs pane

prefixed with the string: old_. You can map both the new and original values from the Map
Outputs pane.  

Note: For more information see Defining Columns for Old Values in Updates.
8. If necessary, change the settings of the Data Type, Encoding, or Nullable values. Click the field to make a

new selection.
Data Type - Defaults to the data type for the column in the source database table. If the required
data type for the column in the buffer table is different from the data type of the source table,
select a different data type by clicking in the Data Type cell and selecting another Data Type from
the list. You must select an appropriate data type for those data types that are marked
UNSUPPORTED.
Note: For the XMLTYPE data type in an Oracle database and the MONEY data types in a SQL
Server database, Studio does not automatically associate the correct data type so you must
manually select the appropriate data type.
Attention: You must select a compatible data type with the source data type to avoid invalid data
during run time. For example, do not select the SMALLINT data type for the buffer table if the
source data type is INTEGER because during run time a large number stored in an INTEGER
column will not convert correctly to the SMALLINT data type.
Size - Size of the column defined in the table. This size is retrieved from the database table and is
not configurable.
Encoding - Defaults to current default encoding that was set either at the database level or the
table level. If the required encoding for the column is different from the current default encoding,
select another encoding by clicking in the Encoding cell and selecting another Encoding from the
list.  
Nullable - Defaults to the nullable setting for the column in the source database table. The Use
check box must be selected for those columns where nullable=false. A column marked
nullable=false cannot not contain a null during run time.
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9. Click Reset to reset all column properties to their defaults. This also resets the Use check box for all
columns.

10. Click Refresh to update the list of columns in reference to the latest state of the source database. Recent
changes to the source are updated in this pane.

11. Configure the Specifying Delivery Rules for Database Activities.
Note: If you select the Exactly once option in the Delivery Rules task, you must create control tables
that are used by the Integration Appliance during run time. You create the control tables after publishing
the orchestration from Studio to the Integration Appliance. You create the control tables using the Web
Management Console (WMC) before you deploy the project.
Note: If you select the Exactly Once option, you must enable persistence. For more information, see
Enabling persistence.

12. Configure the retry options. For more information, see Retry Options For Inbound Database Activities.

Specify the target database table for the activity

1. Click Pick Table from the Checklist. The Pick Table pane is displayed.
2. Click Browse... to select the target database table. The Browse Database Tables dialog box is displayed.
3. Select a table from the list and click OK. Column information for the selected table is displayed in the

Pick Table pane.
4. If the character encoding for this table is different from the encoding for the database, enter another

encoding using one of the following options:
From the Encoding list, select one of the default encoding types.  
Enter your encoding type directly by clicking in the Encoding field and typing in your encoding
type.

This sets the encoding for all the columns of the resulting buffer table.
Note: Some double-byte characters are not converted using the SHIFT-JIS encoding. For more
information, see Using the Shift-JIS encoding.

5. By default all columns in the source table are selected. Clear the Use check box to remove a column
from resulting buffer table. If a column is not selected, it is not displayed in the Map Inputs pane and is
not updated at run time. Click Use All to reselect all the columns.

6. Click in the heading of the column to sort the rows by the column value. For example, to sort the rows by
their column name, click the Column Name heading of the column. An arrow is displayed to the right of
the column header name. An up arrow indicates the column is sorted by alphabetic order starting with a
and continuing to z. A down arrow indicates the column is sorted by reverse alphabetic order starting
with z and continuing to a. Click the arrow to reverse the alphabetic order.

7. If necessary, change the settings of the Data Type, Encoding, or Nullable values. Click the field to make a
new selection.

Data Type - Defaults to the data type for the column in the source database table. If the wanted
data type for the column in the buffer table is different from the data type of the source table,
select a different data type by clicking in the Data Type cell and selecting another Data Type from
the list. You must select an appropriate data type for those data types that are marked
UNSUPPORTED.
Note: For the XMLTYPE data type in an Oracle database and the MONEY data types in a SQL
Server database, Studio does not automatically associate the correct data type so you must
manually select the appropriate data type.
Attention: You must select a compatible data type with the source data type to avoid invalid data
during run time. For example, do not select the SMALLINT data type for the buffer table if the
source data type is INTEGER because during run time a large number stored in an INTEGER
column is not converted correctly to the SMALLINT data type.
Size - Size of the column defined in the table. This size is retrieved from the database table and is
not configurable.
Encoding - Defaults to current default encoding that was set either at the database level or the
table level. If the wanted encoding for the column is different from the current default encoding,
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select another encoding by clicking in the Encoding cell and selecting another Encoding from the
list.  
Nullable - Defaults to the nullable setting for the column in the source database table. The Use
check box must be selected for those columns where nullable=false. A column marked
nullable=false cannot not contain a null during run time.

8. Click Reset to reset all column properties to their defaults. This also resets the Use check box for all
columns.

9. Click Refresh to update the list of columns in reference to the latest state of the source database. Recent
changes to the source are updated in this pane.

10. For the Update Rows activity only - Select the Insert row if row does not already exist check box, if
during run time you want the Update Rows activity to first try and update the specified row but if the
row does not exist,insert the row into the database table.  

11. For the Update Rows activity only - if you want to save both the new values and the original values in the
database, follow these steps:

a. Click Old Values. The Old Value Columns for Updates dialog box is displayed.
b. Select the Store check box for the database columns that you want to save the original values.
c. You can change the default names assigned to columns that store the original values during run

time. Double-click in the appropriate Column Name to Store Old Value cell.
d. Click OK.  The selected columns are displayed in the To Activity of the Map Outputs pane prefixed

with the string: old_. You can map to both the new and original values from the Map Outputs
pane.  

Note: For more information see Defining Columns for Old Values in Updates.
12. For the Update Rows or Delete Rows activities only - To specify acting primary key columns in addition

to any primary key columns already defined by the database, follow these steps:  
a. Click Keys. The Configure Primary Keys dialog box is displayed.
b. To specify a column as an acting primary key column, click the column then click >>.
c. Click OK.

Note: If no primary keys columns (as defined by the database) were specified in the Pick Table task of
the Checklist, you must specify at least one column as an acting primary key column.
Repeat this step to specify more acting primary key columns.

13. Configure the Specifying Delivery Rules for Database Activities.
Note: If you select the Exactly once option in the Delivery Rules task, you must create control tables
that are used by the Integration Appliance during run time. You create the control tables after publishing
the orchestration from Studio to the Integration Appliance. You create the control tables using the Web
Management Console (WMC) before you deploy the project.
Note: If you select the Exactly Once option, you must enable persistence. For more information, see
Enabling persistence.

14. Configure the retry options. For more information, see Retry Options For Outbound Database Activities.

Map the input of the activity

1. Select the Map Inputs task in the Checklist.
The input parameters for the activity are displayed under the row element in the To Activity pane. The
input parameters displayed in the From Activity pane correspond to the columns you selected in the
Pick Table task. If the Batch Multiple Rows Per Message check box was selected in Delivery Rules, the
multiple occurrences symbol displays next to the row element.
Note: For the Get Updated Rows activity only, if columns were selected in the Old Values Columns for
Updates dialog box (in the Pick Table task), these additional output parameters (by default prefixed with
the string: old_) also display under the rows element.  

2. Map all the input parameters. See Creating a map for general instructions on mapping. You must map all
the input parameters of the activity.

Map the output of the activity
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1. Select the Map Outputs task in the Checklist.
The GetRowsCount check box determines what is displayed in the Map Outputs pane:

If the Get Row Counts check box is cleared in the Delivery Rules, the Map Outputs pane is blank.
If the Get Row Counts check box is selected in the Delivery Rules, the Map Outputs pane
displays the rowCount element.  If the Batch Multiple Rows Per Message check box is selected in
the Delivery Rules, the multiple occurrences symbol is displayed next to the rowCount element.

2. If the RowCount output parameter is displayed, map the RowCount output parameter if wanted. See
Creating a map for general instructions on mapping. You are not required to map the output parameters
of the activity.  
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Specifying Delivery Rules for Database Activities
Specify how messages will be delivered at the Delivery Rules pane.

The delivery rules for inbound and outbound activities differ, as described in the following sections.

Specify the delivery rules for inbound database activities

1. Select the Delivery Rules task from the Checklist.
2. Configure the Delivery rules as described in the following table which describes the delivery rules for the

inbound database activities (Get Inserted Rows, Get Updated Rows, Get Deleted Rows, and Poll
Table):

Table 1.
Name Description

Polling
Interval
 

Specifies the time interval to poll for changes in database. For example, the Get Inserted
Rows activity polls for INSERT trigger events at the specified time internal. For more
information, see Polling interval behavior.

Fetch
size

Specifies how many rows the activity should retrieve from the buffer table at one time. The
default is 500 rows per poll. The range is 1 - 10,000.
Note: To improve performance, set the Fetch Size to the maximum number of rows you
expect to retrieve from the buffer table.

Batch Specifies the number of rows to batch into a single message. By default, batching is turned
off (the Batch check box is not selected). To turn on batching, select the Batch check box
then specify the number of rows to batch. The range is 1 - 10,000. If the Batch check box is
selected in Delivery Rules, then the multiple occurrences symbol displays next to the row
element in the From Activity pane of the Map Outputs task of the inbound activity.
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Name Description

Deliver
Messag
es

Select from one of the following options in the Deliver messages pull-down menu:
At least once - Specifies the message will be delivered at least once, but can be
delivered more than once. This delivery option is typically used when the receiving
system can detect or tolerate duplicate messages.
Exactly once - Specifies the message will be delivered once and only once.  If the
Exactly once option is selected and the database is Sybase, the OverwriteCharLimits
parameter must be set in the endpoint. For more information, see Oracle, Sybase,
DB2, and Informix Parameters.
Note: If you select the Exactly once option, you must create some control tables that
are used by the Integration Appliance during run time. You create the control tables
after publishing the orchestration from Studio to the Integration Appliance. You create
the control tables using the Web Management Console (WMC) before you deploy the
project.
Note: If you select the Exactly Once option, you must enable persistence. For more
information, see Enabling persistence.

Delete
rows
after
they
have
been
process
ed

This check box is displayed only for the Custom Poll activity. The Delete rows after they have
been processed check box is used by the Integration Appliance to determine the action for a
delete request while running a Poll Table activity:

If the check box is enabled, during run time the Integration Appliance sets the flag
column to M and then deletes the row.
If the check box is cleared, during run time the Integration Appliance sets the flag
column to M and then P but the row is not deleted.

Specify the delivery rules for outbound database activities

1. Select the Delivery Rules task from the Checklist.
2. Configure the Delivery rules as described in the following table, which describes the deliver rules for the

outbound database activities (Insert Rows, Update Rows, Delete Rows, Call Procedure):
Table 2.

Nam
e Description

Deliv
er
Mes
sage
s

Select from one of the following options in the Deliver messages menu:
At least once - Specifies the message will be delivered at least once, but can be
delivered more than once. This delivery option is typically used when the receiving
system can detect or tolerate duplicate messages.
Exactly once - Specifies the message will be delivered only once.

Note: If you select the Exactly once option, you must create some control tables that are used
by the Integration Appliance during run time. You create the control tables after publishing the
orchestration from Studio to the Integration Appliance. You create the control tables using the
Web Management Console (WMC) before you deploy the project.

Batc
h __
rows
at a
time

Specifies if the database operations on rows should be batched and how many rows to process
by the database operation at one time. For example, if the size of the batch is set to 20 but 100
rows are processed by a database insert, 5 messages of size 20 are sent from the Integration
Appliance to the database and then the final database commit message is sent.

If the Batch __ rows at a time check box is selected in Delivery Rules, the multiple occurrences
symbol displays next to the row element in the To Activity pane of the Map Inputs task of the
outbound activity.
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Nam
e Description

Get
Row
Coun
ts

Not available for the Call Procedure activity - This check box specifies that during run time the
activity returns how many rows were processed per transaction. If the Get Rows Counts check
box is selected, the rowCount is available in the From Activity pane of the Map Outputs pane of
the outbound activity.
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Viewing Column Details
The View Column dialog box allows you to see detailed column information for tables as you enter a SQL
statement in the Enter Query task of the Checklist for the Execute Query activity. This task describes how to
access the View Column Details dialog box.

Procedure

1. Create or open an Execute Query activity.
2. Select the Enter Query task from the Checklist. The Enter Query pane is displayed.
3. Click View Columns. The View Columns dialog box is displayed.
4. To change the data viewed in the View Columns dialog box, select from the following options:

To see detailed column information, select a table in the list. Column names, datatypes, sizes,
and nullable properties display in the right pane.
To see tables in a different schema, select a schema from the Filter by User Schema list.
To see tables for all schemas, click Clear.
To filter out any buffer or control tables created by the Web Management Console (WMC) that are
used internally by the Integration Appliance, select the Hide Buffer and Control Tables option.
Note: This filter only hides buffer and control tables that use the standard names generated in
scripts from Studio.
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Working with Database Parameters
Parameters supply database-specific connection information for an endpoint.

About this task

You can add and delete database parameters and edit parameter values as described in the following
procedures.

To add a parameter to the endpoint:

Procedure

1. In the Project tab, click an Endpoint.
2. Click Add. The Database Endpoint Parameters dialog box is displayed.
3. Type the name of a new parameter in the Parameter Name field.
4. Type a value for the parameter in the Parameter Value field.
5. Click OK.

Results

To delete a parameter from the endpoint:

1. In the Project tab, click an Endpoint.
2. Click the Parameter Name of the parameter to be deleted.
3. Click Delete.

To edit a parameter value:

1. In the Project tab, click an Endpoint.
2. Click the Parameter Value to be changed, and enter a new value in the field.
3. Press Enter.
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Call Procedure Activity
During run time, the Call Procedure activity runs a stored procedure in a database. The stored procedure must
be written and installed in the database before you can complete the configuration of the Call Procedure
activity in Studio.
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Note: Function name overloading for stored procedures in the Informix® database is not supported. Stored
procedures cannot have the same name in Informix even if their signatures are unique.
The steps for adding and configuring a Call Procedure activity to an orchestration are described in the following
procedures:

Add a Call Procedure activity to the orchestration
Create, select, or edit a database endpoint
Configure a Call Procedure activity
Map the input of the activity
Map the output of the activity

Add a Call Procedure activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration opens.
2. Select the Activities tab and expand the Database folder.
3. Drag the Call Procedure activity onto the orchestration.
4. Select the Call Procedure activity.

Create, select, or edit a database endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer opens.
b. Select an existing endpoint and click OK. Skip to the Configure a Call Procedure activity

activity procedure.
Select an existing endpoint and edit the endpoint:

a. Select Browse. The Project Explorer opens.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane shows.

Create a new endpoint:
a. Select New. The Create Endpoint pane opens.

2. Create or edit a database endpoint

Configure a Call Procedure activity

1. Click Stored Procedure from the Checklist. The Stored Procedure pane opens.
2. Click Browse... The Browse Stored Procedures dialog box shows.
3. To see all the stored procedures in the database and not just those visible with the selected user

schema, click Clear.
4. Select a Stored Procedure from the list.
5. Click OK. Parameter information for the selected stored procedure displays in the Stored Procedure

pane.
Note: Deleting stored procedure call parameters from the middle of the parameter list is not supported.
If you want to specify parameters in a different order than they are displayed in the list, you can create a
wrapper stored procedure (for example, WrapperStoredProcedure1) that doesn't have gaps in
parameters (that is, contains the exact subset of the parameters needed), then have the new stored
procedure call the underlying stored procedure (for example: BackendStoredProcedure1) using the
@parameter = value form supported by the Microsoft SQL Server. You can then have your
orchestration use the wrapper stored procedure with only the parameters needed. Alternatively, you can
provide the full set of parameters without omissions and default values in Studio for the original
underlying stored procedure (for example, BackendStoredProcedure1). Note that while deleting stored
procedure call parameters from the middle of a parameter list is not supported, parameters displayed at
the end of a parameter list can be deleted.
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6. To change the current character encoding (originally obtained from the database endpoint), select a
different encoding option from the Encoding list. This changes the default character encoding for all the
input parameters of the stored procedure.

7. By default, all the input and output (IN, INOUT, RETURN, OUT) parameters of the stored procedure
are selected. You do not need to include all the input and output parameters defined for a stored
procedure. Clearing the Use check box for an output parameter (INOUT, RETURN, OUT) means that the
output parameter is not available in the Map Inputs task. Clearing the Use check box for an input
parameter (IN, INOUT) means that the input parameter is not available in the Map Inputs task. Clear
the Use check box only for input parameters that you do not need to specify input values at run time.
Some input parameters of the stored procedure may have default values.

Most databases only return a single return parameter. For these databases, if the Use check box is
selected for the return parameter, the return value is returned in the single
results/result/RETURN_VALUE node in the From Activity pane of the Map Outputs task. The Informix
database, however, supports multiple return parameters and for the Informix database, the return
parameters are returned in the repeating results/result/result/resultsSets/any node. Even if one
parameter is returned from the stored procedure, the return parameter is returned in the
results/result/result/resultsSets/any node. Use the CopyOf function in the map to copy the contents of
the result node (including the child node called resultSet) to a variable. In order for the CopyOf function
to correctly copy the values of the source nodes to the destination nodes, the XML Schema of the
destination variable must match the XML Schema of the source node. For more information, see CopyOf
function.

8. Click the heading of the column to sort the rows by the column value. For example, to sort the rows by
their column name, click in the Column Name heading of the column. An arrow shows to the right of the
column header name. An up arrow indicates the column is sorted by alphabetic order starting with a and
continuing to z. A down arrow indicates the column is sorted by reverse alphabetic order starting with z
and continuing to a. Click the arrow to reverse the alphabetic order.

9. If necessary, change the settings of the Data type, Encoding, or Nullable values for each query input
parameter. Click the field to make a new selection:

Data Type - Defaults to the Data Type of the parameter. Select an alternate data type for the
parameter by clicking in the Data Type cell and selecting another Data Type from the list. from the
corresponding cell. You must change any data types that are UNSUPPORTED.
Note: (for MONEY and XMLTYPE data types)  For the XMLTYPE data type in an Oracle database
and the MONEY data types in an SQL Server database, Studio does not automatically associate
the correct data type so you must manually select the appropriate data type.
Encoding - Defaults to current default encoding that was set either at the database level or the
table level. If the required encoding for the parameter is different from the current default
encoding, select another encoding by clicking in the Encoding cell and selecting another Encoding
from the list.
Size — Size of the column defined in the table. This size is retrieved from the database table and is
not configurable.

10. Click Reset to reset all parameter properties to their defaults. This also selects the Use option for all
parameters.

11. Configure Delivery Rules.
Note: If you select the Exactly once option in the Delivery Rules task, you must create control tables that
are used by the Integration Appliance during run time. You create the control tables after publishing the
orchestration from Studio to the Integration Appliance. You create the control tables using the Web
Management Console (WMC) before you deploy the project.
Note: If you select the Exactly once option, you must enable persistence. For more information, see
Enabling Persisence.

12. Configure the Retry Options.
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Map the input of the activity

1. Select the Map Inputs task in the Checklist. The input parameters for the activity are displayed under
the calls element in the To Activity pane. The input parameters displayed in the To Activity pane
correspond to the IN and INOUT parameters you selected in the Stored Procedure task. If the Batch
Multiple Rows Per Message check box is selected in the Delivery Rules, the multiple occurrences icon
displays next to the call element.

2. Map all the displayed input parameters. See Creating a map for general instructions on mapping.

Map the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters for the activity are displayed under
the results element in the From Activity pane. The output parameters displayed in the From Activity
pane correspond to the OUT, RETURN, and INOUT parameters you selected in the Stored Procedure
task.

If the Batch Multiple Rows Per Message check box is selected in the Delivery Rules, the multiple
occurrences icon displays next to the result element.

A repeating node called resultSet displays in the From Activity pane of the Call Procedure activity even if
the stored procedure has no return parameters. During run time, if the stored procedure started from the
activity returns a result set, this result set is returned from the activity in the resultSet node. For
example, if the stored procedure starts a select statement, the result set from the select statement is
returned in the resultSet node. Use the CopyOf function in the map to copy the contents of the result
node (including the child node called resultSet) to a variable.   
Attention: In order for the CopyOf function to correctly copy the values of the source nodes to the
destination nodes, the XML Schema of the destination variable must match the XML Schema of the
source node. For more information, see CopyOf function.

2. Map the required output parameters to variables. See Creating a map for general instructions on
mapping. You are not required to map output parameters for this activity.

 
Parent topic: Database Activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/db_call_procedure_activity.html

Execute Query Activity
During run time, the Execute Query activity runs a select SQL statement.

The Execute Query activity supports parameterized queries - a query that contains input, or input and output
parameters. When input parameters are specified in a query, the value of the parameter is supplied at run time.
The ? character in the following example select statement specifies that there is one input parameter:

select * from myUserSchema.mySourceTable where
myUserSchema.mySourceTable.myColumn=?
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In the preceding select statement, the * character, specifies that the query returns the column or columns
found in the mySourceTable table as the output parameter or parameters. For example, if the mySource table
contains two columns, one of type CHAR and one of type VARCHAR, the Execute Query activity returns two
output parameters, one of type CHAR and the other of type VARCHAR.
Note: Only the select SQL statement is supported in the Execute Query activity. The insert SQL statement is not
supported in the Execute Query activity.
The steps for adding and configuring an Execute Query activity to an orchestration are described in the
following procedures:

Add an Execute Query in the orchestration
Create, select, or edit a database endpoint
Specify the query SQL statement
Configure the input parameters for the query
Configure output parameters
Specify retry options for the query
Map the input of the activity
Map the output of the activity

Add an Execute Query in the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration displays.
2. Select the Activities tab and expand the Database folder.
3. Drag the Execute Query activity onto the orchestration.
4. Select the Execute Query activity

Create, select, or edit a database endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer opens.
b. Select an existing endpoint and click OK. Skip to the Specify the query SQL statement

procedure.
Select an existing endpoint and edit the endpoint:

a. Select Browse. The Project Explorer opens.
b. Select an existing endpoint and click OK
c. Click Edit. The Edit Endpoint pane opens.

Create an endpoint: Select New. The Create Endpoint pane opens.
2. Create or edit a database endpoint

Specify the query SQL statement

1. Select the Enter Query task from the Checklist. The Enter Query pane opens.
2. Enter the query in the white space displayed in the pane. Do not place semicolons at the end of your

query.
3. Click View Columns to review column details for a selected table to assist you in building your SQL

statement by entering valid table names and columns.
4. Select an alternate character encoding setting for the input and output parameters if the wanted

encoding differs from the default encoding for the database using one of the following options:
From the Encoding list, select one of the default encoding types.
Enter your encoding type directly by clicking in the Encoding field and typing in your encoding
type.

Note: Some double-byte characters are not converted using the SHIFT-JIS encoding. For more
information, see Using the Shift-JIS encoding.
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5. Click Validate Query.  This action checks if your query is valid and populates input and output
parameters in the Map Inputs and Map Outputs tasks.

6. Enter a value into the MaxRows field. The MaxRows field specifies the maximum number of rows to
return from the query during run time.

Note: If the same query is started multiple times on the same data, the same set of rows are returned. For
example if MaxRows is equal to 1, the same row (the first row) is always returned each time the query is started
- there is no iteration though the set of rows.

Configure the input parameters for the query

1. Select the Setup Input Parameters task from the Checklist. The Setup Input Parameters pane shows the
input parameter or parameters of the query.

2. Click View Columns to review column details for a selected table to assist you in building your SQL
statement by entering valid table names and columns.

3. Click in the heading of the column to sort the rows by the column value. For example, to sort the rows by
their column name, click the Column Name heading of the column. An arrow is displayed to the right of
the column header name. An up arrow indicates the column is sorted by alphabetic order starting with a
and continuing to z. A down arrow indicates the column is sorted by reverse alphabetic order starting
with z and continuing to a. Click the arrow to reverse the alphabetic order.

4. If necessary, change the settings of the Data type, Encoding, or Nullable values for each query input
parameter. Click the field to make a new selection:

Parameter Name - You can change the default name to a more meaningful name. Parameters are
listed in the order they are specified in the query.
Data Type - Select a data type for this parameter.
Note: (for MONEY and XMLTYPE data types) For the XMLTYPE data type in an Oracle database
and the MONEY data types in a SQL Server database, Studio does not automatically associate the
correct data type so you must manually select the appropriate data type.
Encoding - Select an alternate character encoding setting for the parameter if the required
encoding differs from the default encoding for the database.
Size - Size of the column defined in the table. This size is retrieved from the database table and is
not configurable.

5. Click Reset Values to interrogate the database and get the data types and size from the database. This
overrides the data type and size set manually in the pane.

Configure output parameters

1. Select the Setup Result Set task from the Checklist. The Setup Result Set pane opens and the defaults
for the ouput parameter or parameters of the query are listed.

2. Click View Columns to review column details for a selected table to assist you in building your SQL
statement by entering valid table names and columns.

3. If necessary, change the settings of the Data type, Encoding, or Nullable values for each query output
parameter:

Parameter Name - You can change the default name to a more meaningful name. Parameters are
listed in the order they are specified in the query.
Data Type - Select a data type for this parameter.
Encoding - Select an alternate character encoding setting for the parameter if the required
encoding differs from the default encoding for the database.
Size - Size of the column defined in the table. This size is retrieved from the database table and is
not configurable.

4. Click Reset Values to interrogate the database and get the data types and size from the database. This
overrides the data type and size set manually in the pane.
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Specify retry options for the query

To specify the retry options for the query:

1. Configure the Retry Options.
Note: For the Database Execute Query activity, if you set the retry option to zero, the Integration
Appliance retries the connection indefinitely.

Map the input of the activity

1. Select the Map Inputs task in the Checklist. The input parameters specified for the query are the input
parameters for the activity. The input parameters of the activity are displayed under the parameters
element in the To Activity pane.

2. You must map all the input parameters of the activity. See Creating a map for general instructions on
mapping.

Map the output of the activity

1. Select the Map Outputs task in the Checklist. The columns returned by select statement are the
elements displayed under the rows/row element in the From Activity pane.

2. You are not required to map the output parameters of the activity. See Creating a map for general
instructions on mapping.
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Poll Table Activity
The Poll Table activity checks if a database operation (insert or update) has occurred on any rows of a database
table by checking the status of a special flag column at the specified time interval.

During run time, for the insert and update operations, the Poll Table activity returns the data that has changed
in your database table and directly maps that data to variables in the orchestration while the Get Inserted
Rows and Get Updated Rows activities returns the changed data into a buffer table and that buffer table is
mapped to a variable in the orchestration.
Note: Use the Poll Table activity instead of the Get Inserted Rows, Get Deleted Rows, and Get Updated Rows
activities only when you must avoid adding triggers to your database.
Before configuring the Poll Table activity in Studio, you must first either create two additional database
columns in your source database table or use two appropriate existing database columns from your database
table. The following database columns are required in your source database table:

A sequence column of  INTEGER type - This column contains the primary keys (a sequence of unique
numbers: 1, 2, 3 ...)
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A flag column of  CHAR(1) type - This column contains a flag that the Integration Appliance uses during
run time to determine if the Integration Appliance should process the row.

Before an orchestration with a Poll Table activity is run on the Integration Appliance, you must also populate
these columns in your database table. Set the flag column to P if you do not want the Integration Appliance to
process the row during run time. Set the flag column to null if you want the Integration Appliance to process
the row during run time.

In the following example database table, all the values in the Flag column are set initially to P, as shown in the
following figure:
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Attention: You must manage the state of the flag column. After processing a row, the Integration Appliance
changes the flag column to P for processed as described in the following example scenario:

1. A row is inserted into the database. The flag column is set to null for the row.
2. The Poll Table activity runs for the first time and sets the flag value to P for this row.
3. The same row is updated, and the Poll Table activity runs again. The row is not returned in the return

data of the activity because the Integration Appliance checked the flag column and the flag indicated
that this row had already been processed.

In order for a row to be processed again by the Integration Appliance, you must reset the flag column back to
null before an orchestration job with a Poll Table activity accessing the same source database table is run.

The steps for adding and configuring a Poll Table activity to an orchestration are described in the following
procedures:

Add a Poll Table activity in the orchestration
Create, select, or edit a database endpoint
Specify the columns of the source table to poll for database operations
Select the Sequence and Flag columns
Map the output of the activity

Add a Poll Table activity in the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration opens.
2. Select the Activities tab and expand the Database folder.
3. Drag the Poll Table activity onto the orchestration.
4. Select the Poll Table activity.

Create, select, or edit a database endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
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Select an existing endpoint:
a. Select Browse. The Project Explorer opens.
b. Select an existing endpoint and click OK. Skip to the Specify the columns of the source

table to poll for database operations procedure.
Select an existing endpoint and edit the endpoint:

a. Select Browse. The Project Explorer opens.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane shows.

Create a new endpoint:
a. Select New. The Create Endpoint pane opens.

2. Create or edit a database endpoint.

Specify the columns of the source table to poll for database operations

1. Click Pick Endpoint from the Checklist. The Pick Endpoint pane opens.
2. Click Browse. The Select a Single Source Table dialog box opens.
3. Select a table that during run time, the Poll Table activity polls for database operations.
4. Select a user schema from the Filter by User Schema list.
5. Select Hide Buffer and Control Tables to filter out any buffer or control tables used by the Integration

Appliance.
Note: This filter only hides buffer and control tables that use the standard names generated in scripts
from Studio.

6. Select a single table from the list:
Click >> to add a table.
Click << to remove a table.

7. If you only want to poll for database operations on primary key columns of the source table, select the
Select Only the Primary Keys from Table check box.

8. Click OK. The columns of the table show in the Pick Table pane. (If you selected the Select Only the
Primary Keys from Tables check box only the primary key columns display.)

9. If the character encoding for this table is different from the encoding for the database, enter another
encoding using one of the following options:

From the Encoding list, select one of the default encoding types.
Enter your encoding type directly by clicking in the Encoding field and typing in your encoding
type.

10. Select the columns in the table that during run time you want the PPoll Table activity to poll for database
operations (insert, delete, or update).  By default all columns are selected. Clear the Use check box for
unwanted columns. Click Use All to reselect all the columns.

11. Click the heading of the column to sort the rows by the column value. For example, to sort the rows by
their column name, click in the Column Name heading of the column. An arrow shows to the right of the
column header name. An up arrow indicates the column is sorted by alphabetic order starting with a and
continuing to z. A down arrow indicates the column is sorted by reverse alphabetic order starting with z
and continuing to a. Click the arrow to reverse the alphabetic order.

12. If necessary, change the settings of the Data type, Encoding, or Nullable values for each query input
parameter. Click the field to make a new selection:

Data Type - Defaults to the data type for the column in the source database table. If the required
data type for the column in the buffer table is different from the data type of the source table,
select a different data type by clicking in the Data Type cell and selecting another Data Type from
the list. You must select an appropriate data type for those data types that are marked
UNSUPPORTED.
Note: (for MONEY and XMLTYPE data types) For the XMLTYPE data type in an Oracle database and
the MONEY data types in a SQL Server database, Studio does not automatically associate the
correct data type so you must manually select the appropriate data type.
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Size - Size of the column defined in the table. This size is retrieved from the database table and is
not configurable
Encoding - Defaults to current default encoding that was set either at the database level or the
table level. If the required encoding for the column is different from the current default encoding,
select another encoding by clicking in the Encoding cell and selecting another Encoding from the
list.
Nullable - Defaults to the nullable setting for the column in the source database table. If nullable
= false, then the column must be included in the message. The Use check box must be selected
for those columns where nullable=false. A column marked nullable=false cannot not contain a
null during run time.

Select the Sequence and Flag columns

1. Select Choose Columns from the Checklist.
2. Select a Sequence Column from the list. This is the sequence column of  INTEGER type containing the

primary keys (a sequence of unique numbers: 1, 2, 3 ...) that you either added to your source database
table or determined that you could use an existing column in your source database table.

3. Select a Flag Column from the list. A flag column of CHAR type containing a flag that the Integration
Appliance sets to P when the Integration Appliance has processed the row. The Integration Appliance
uses sequence and flag columns to check for duplicate messages.  In addition, both columns and the
setting of the Delete rows after they have been processed check box in the Delivery Rules pane are used
by the Integration Appliance to determine the action for a delete request:

 If the Delete rows after they have been processed check box is selected, the Integration
Appliance sets the flag to M and then deletes the row.
If the Delete rows after they have been processed check box is cleared, the Integration Appliance
sets the flag to M and then P but the row is not deleted. In order for a row to be processed again
by the Integration Appliance, you must reset the flag column back to null before an orchestration
job with a Poll Table activity accessing the same source database table is run.

4. Configure the Delivery Rules.
Note: If you select the Exactly once option in the Delivery Rules task, you must create control tables that
are used by the Integration Appliance during run time. You create the control tables after publishing the
orchestration from Studio to the Integration Appliance. You create the control tables using the Web
Management Console (WMC) before you deploy the project.
Note: If you select the Exactly Once option, you must enable persistence. For more information, see
Enabling Persisence.

5. Configure the Retry Options.

Map the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters for the activity are displayed under
the row element in the From Activity pane. The output parameters displayed in the From Activity pane
correspond to the columns you selected in the Pick Table task. If the Batch option was selected in
Delivery Rules, the multiple occurrences symbol displays next to the row element.
Note: During run time, the rows output parameter of the Poll Table activity is not populated with the
sequence and flag column values. Only the columns selected in the Pick Table task are returned.

2. Map the required output parameters to variables. See Creating a map for general instructions on
mapping. You are not required to map the output parameters for these activities.
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Testing an SSL Database Connection

About this task

After creating an endpoint for a database, you must import the CA certificate for the database into Studio and
then test the SSL connection to the database. Perform the following procedure to import the database's CA
certificate and then test the SSL connection to the database:

Procedure

1. Open a command window.
2. Navigate to the database server, and locate the certificate file ca-cert stored in the server.
3. Copy this file and then navigate to the workstation where Studio is installed.
4. Using the command window, paste the ca-cert copy in the home directory of Studio: C:\Program

Files\IBM\WebSphere Cast Iron Studio x.x.x
5. Navigate to the security directory of Studio: C:\Program Files\IBM\WebSphere Cast Iron Studio

x.x.x\security
6. Run the following command to import the ca-cert file into Studio: ..\jre\bin\keytool.exe -import -v -

keystore cacerts -storepass changeit -file ..\castiron_ca_cert.pem -alias alias_name Where alias is the
alias of the database CA certificate.

7. When you are prompted for a yes or no, type yes (Y) and press Enter.
8. Exit the command window.
9. Open the endpoint for the database server.

10. Verify the following login credentials for the database connection: database server, Port, User, and
Password.

11. Click Test Connection
12. If the connection is successful, use this endpoint in Studio orchestrations, then use the Verify tab

features to evaluate the orchestration.
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Domino Activities
Overview of the Domino connector
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Creating or editing an endpoint for a Domino activity
Endpoints provide the configuration information that Studio and the Integration Appliance use to
connect to a IBM® Lotus® Domino® server. Lotus Domino server provides services like email server,
application server, web server, database server, and directory server. Business data on the server is
stored as documents in the Domino databases (.nsf files). Domino connector provides bidirectional
connectivity to work with these documents. 
Creating a Domino document
Use the Create Document activity to create a document in the Domino server.
Updating a Domino document
Use the Update Document activity to update a document in the Domino database. Each updated
document must be uniquely identifiable by its UniversalID or NotesID.
Retrieving a Domino document
Using the Retrieve Activity, you can retrieve a document from a Domino database. Each retrieved
document is uniquely identified by its UniversalID or NotesID. The retrieval is done based on the input,
that is, either the UniversalID or the NotesID.
Querying Domino documents
The Query Document activity is used to query documents from the database in the Lotus® Domino®
server that matches the values that are specified in the document fields.
Querying views for Domino documents
The Query Views activity is used to query views from the database in the Lotus® Domino® server that
matches the values that are specified in the document fields that are present in the view.
Deleting a Domino document
Use the Delete Activity to delete a document from the Domino database. Each deleted document must
be uniquely identifiable by its UniversalID or NotesID.
Getting events from Domino server
The Get Events activity is used to get events from the database in the IBM Domino® server that matches
the values that are specified in the input fields of Map Inputs.
Getting invitations from Domino server
The Get Invitations activity is used to get invitations from the database in the IBM Domino® server that
matches the values that are specified in the input fields of Map Inputs.
Getting notices from Domino server
The Get Notices activity is used to get notices from the database in the IBM Domino® server that
matches the values that are specified in the input fields of Map Inputs.
Processing calendar events in Domino server
The Process Calendar Events activity is used to process an action on an existing calendar event in a
database in the IBM Domino® server that matches the values that are specified in the input fields that
are present in the Map Inputs.
Processing calendar notices in Domino server
The Process Calendar Notices activity is used to process an action on an existing calendar Notice in a
database of the IBM Domino® server that matches the values that are specified in the input fields
present in Map Inputs.
Creating calendar events in Domino server
The Create Calendar Events activity is used to create the calendar events from the database in the IBM
Domino® server that matches the values that are specified in the input fields of Map Inputs.
Updating calendar events in Domino server
The Update Calendar Events activity is used to update the calendar events from the database in the IBM
Domino® server that matches the values that are specified in the input fields of Map Inputs.
Deleting calendar events from Domino server
The Delete Calendar Events activity is used to delete calendar events from the database in the IBM
Domino® server that matches the values that are specified in the input fields of Map Inputs.
Specifying Retry and Delivery Options for Domino activities
Specifying the Retry and Delivery parameters is one of the tasks to configure a Domino activity
configuration.
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Prerequisites to use Domino inbound activities
Get Created Documents activity
Use the Get Created Documents activity to get the documents (which are of interest) that were created
on the Domino server. The activity polls the event table in the Domino server for new events periodically
and process them.
Get Updated Documents activity
Use the Get Updated Documents activity to get the documents (which are of interest) that got updated
on the Domino server. The activity polls the event table in the Domino server for new events periodically
and process them.
Get Deleted Documents activity
Use the Get Deleted Documents activity to get the documents (which are of interest) that were deleted
on the Domino server. The activity polls the event table in the Domino server for new events periodically
and process them.
Handling Date/Time and Time zone data types
In the Lotus Domino form, a field of Date/Time type can be configured to represent only a date value,
time value, or both date and time values. This configuration is done while creating/editing the form in
Domino Designer. So, when a document is created for such a form, the value can be a date, time, or a
datetime.
Rich text support for Domino connector
The Domino connector supports RichText type in forms. Fields of RichText type can store both text and
attachments as part of the document. The connector supports attachments only for the Retrieve and
Query Document activities. Text content can be used for the Create, Update, Retrieve, and Query
Document activities.
Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly. This
topic provides potential solutions for issues you would have with the Domino connector.
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Overview of the Domino connector
The Domino® connector enables a two-way communication between Cast Iron® and IBM Domino server. The
business data can be Domino documents such as a calendar entry, a to-do item, or a note.

You can perform the following activities using the Domino connector:

Outbound Activities
Create Documents
Update Documents
Delete Documents
Query Documents
Query Views
Retrieve Documents
Get Events
Get Invitations
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Get Notices
Process Calendar Events
Process Calendar Notices
Create Calendar Events
Update Calendar Events
Delete Calendar Events

Inbound/Starter Activities
Get Created Documents
Get Updated Documents
Get Deleted Documents

The Calendar Service is an addition to the family of REST services in the IBM Domino Server, from V9.0.1. Using
Calendar Service you can perform create/retrieve/update/delete operations on the Calendar Events,
Invitations, and Notices. An event in Domino stands for a Meeting, Recursive Meeting, All Day Event,
Appointment, Recursive Appointment, and a Reminder. A Notice can be an Invitation for a Calendar Event or an
update information of a Calendar Event.

The Domino connector supports the REST Based APIs of Calendar Service of IBM Domino Server from
V7.0.0.1. The activities listed below are added to support this service :

Create Calendar Events
Update Calendar Events
Delete Calendar Events
Get Events
Get Invitations
Get Notices
Process Calendar Events
Process Calendar Notices

The versions of IBM Domino supported by the connector depend on the support lifecycle of IBM Domino. You
can configure the connector with all the versions of IBM Domino that are currently supported. The IBM Domino
versions that are currently supported are 8.0.x, 8.5.x, 9.0, and 9.0.1. The Domino connector cannot be used to
connect to a Lotus Notes® client directly. It always connects to the IBM Domino server.
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Creating or editing an endpoint for a Domino activity
Endpoints provide the configuration information that Studio and the Integration Appliance use to connect to a
IBM® Lotus® Domino® server. Lotus Domino server provides services like email server, application server, web
server, database server, and directory server. Business data on the server is stored as documents in the
Domino databases (.nsf files). Domino connector provides bidirectional connectivity to work with these
documents. 
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Selecting or editing a Domino endpoint

1. In the Create Endpoint or Edit Endpoint pane, configure the Domino server as described in the following
table. In addition to these fields, the endpoint pane contains Connection pool options and Remote
Endpoint Configuration.
Note: Changing the configuration properties of an endpoint affects all orchestrations that use that
endpoint in the project. The edits are global, not local.

2. Click Test Connection to confirm that the connection details are valid and you are able to connect to the
Domino server successfully.

3. Click OK.

Table 1. Connection properties
Field Name Description

Domino Server
Configuration

Host Name Specifies the host name or IP address of the machine on which Domino server is
running.

DIIOP Port Specifies the Domino Internet Inter ORB Protocol (DIIOP) port that allows Java™
applets or applications to access Domino data remotely using CORBA. The default
value is 63148.

User Name Specifies the user name to connect to the Domino server.

Password Specifies the password associated with the user name to connect to the Domino
server.

Note: For outbound activities such as Create, Update, Retrieve, Query, and Delete, you can dynamically
specify a different Domino server during Map Inputs. The server details in the Map Inputs section holds
preference to the regular endpoint declaration.

Connection Pool
options

Minimum
Connections

Specifies the lowest number of Domino server connections that the Integration
Appliance keeps open in the connection pool. Entering 0 (zero) is supported. The
default value is 5.

Maximum
Connections

Specifies the maximum number of Domino server connections that the Integration
Appliance can keep open in the connection pool. Entering 0 (zero) means the
maximum number of connections is unbounded. The default value is 25.

Maximum Idle Time Specifies the amount of time in minutes that a Domino server connection can be open
in an idle state before being closed by the Integration Appliance. Entering 0 (zero)
means that the connections are closed when they are returned to the pool —no idle
time. The default value is 120 minutes.

Maximum Wait Specifies the amount of time in seconds that the Integration Appliance waits for a
connection when all the connections in the pool are exhausted. If no connection is
obtained after the wait time, an exception is thrown. The default value is 300 seconds.

Reclaim
Connections

Specifies the interval at which the connector checks for idle connections. Idle
connections are reclaimed until the minimum number of connections is reached, as
specified in the Minimum Connections parameter. The default value is 5 minute.

  Note: The Connection pool properties need to be configured as per the load (number of
concurrent requests) on the endpoint.
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Field Name Description

Remote Endpoint
Configuration

Endpoint Runs
Behind Firewall

Enables the secure connector name property so that secure connector can be used if
the Lotus Domino server is running behind a firewall.

Secure Connector
Name

Specifies the name of the secure connector that is used to connect to the Lotus
Domino server running behind a firewall. For example, if an orchestration containing
Domino activity is deployed on to Cast Iron Live (cloud), then the secure connector
needs to be configured.
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Creating a Domino document
Use the Create Document activity to create a document in the Domino® server.

Using the create activity

1. Right-click Orchestration in the Project pane and click New Orchestration to create or open an
orchestration. The orchestration pane is displayed.

2. Select the Activities tab and expand the Domino folder.
3. Drag Create Document activity from the Domino folder onto the orchestration. The graphical

representation of the orchestration, including the checklist is displayed.
4. The Checklist pane lists the tasks (Summary, Pick Endpoint, Configure, Map inputs, Map outputs)

that you must complete to configure the outbound activity.
5. Click Pick Endpoint, and then select a Domino endpoint.

For instructions on creating or editing a Domino endpoint, see Creating or editing an endpoint for a
Domino activity

6. Click Configure from the Checklist. The Configure pane is displayed.
Click Browse to select an existing database from the Browse Domino databases pane. The
Browse Domino databases display all the databases for the selected endpoint.
Click Next to select an existing form from the Browse Domino Forms pane. The Browse Domino
Forms displays all the forms present in the selected database of the Domino server.

Note: The Next button is enabled only after selecting the database name.

Specifying the map inputs for create activity

1. Click Map Input from the Checklist pane.
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The input parameters for the specific Domino activity are displayed under the To Activity pane.
Note: You must map all the required input parameters of the activity, whose data comes from previous
activity.
Note: To populate dynamically added fields of the Domino document, which are not part of the map
inputs structure, use the AdditionalFields property and provide the field names and field values in
FieldDetails section.

For Form Types that are same across multiple databases, you can now specify the database name as
part of the optional parameters in map inputs, wherein the same orchestration can be used to perform
outbound operations on different databases. To do this you must specify the database name in the
databaseName optional parameter (described in the table given below). If the databaseName
parameter is populated with a value, the outbound operation will be performed on the database
specified in the databaseName parameter. If there is no value specified, the database name specified
during configuration will be used to perform the outbound operation.

The optional input parameter is described in the following table:

Table 1. Database name optional parameter
Param
eter
Name Description

databa
seName

Specifies the database name that can be dynamically added in map inputs to enable a single
orchestration to perform outbound operations across multiple databases having the same
Form Type.

The Domino connector also supports dynamic endpoint connection to a different Domino server. During
run time, if you want to dynamically connect to a Domino server other than the one that is configured in
the endpoint page, add the new optional parameters in dominoConnectionProperties of map inputs.
The parameters of dominoConnectionProperties are described in the following table:

Table 2. Optional connection parameters
Parameters Description

dominoConnectionProperties parameters

hostName Specifies the host name or IP address of the machine on which
Domino server is running.

diiopPort Specifies the Domino Internet Inter ORB Protocol (DIIOP) port that
allows Java™ applets or applications to access Domino data remotely
using CORBA. The default value is 63148.

username Specifies the user name to connect to the Domino server.

password Specifies the password associated with the user name to connect to
the Domino server.

connectionPool parameters

minimumConnections Specifies the lowest number of Domino server connections that the
Integration Appliance keeps open in the connection pool. Entering 0
(zero) is supported. The default value is 5.

maximumConnections Specifies the maximum number of Domino server connections that
the Integration Appliance can keep open in the connection pool.
Entering 0 (zero) means the maximum number of connections is
unbounded. The default value is 25.
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Parameters Description

maxIdleTime Specifies the amount of time in minutes that a Domino server
connection can be open in an idle state before being closed by the
Integration Appliance. Entering 0 (zero) means that the connections
are closed when they are returned to the pool —no idle time. The
default value is 120 minutes.

maxWait Specifies the amount of time in seconds that the Integration
Appliance waits for a connection when all the connections in the
pool are exhausted. If no connection is obtained after the wait time,
an exception is thrown. The default value is 300 seconds.

reclaimConnections Specifies the interval at which the connector checks for idle
connections. Idle connections are reclaimed until the minimum
number of connections is reached, as specified in the Minimum
Connections parameter. The default value is 5 minute.

Specifying the map outputs create activity

1. Click Map output from the Checklist pane.

The output parameters for the Domino activity are displayed under the From Activity pane.

The response of the AdditionalFields property is also displayed in the From Activity pane.

Some of the common output parameters are defined in the following table.

Par
ame
ter
Na
me Description

Univ
ersa
lID

A UniversalID of a document is a read/write property that uniquely identifies a document across
all replicas of a database. In character format, the UniversalID is a 32-character combination of
hexadecimal digits (0-9, A-F). The UniversalID is also known as the uniqueID or UNID. The
datatype is string.

Not
esI
D

A NotesID of a document is a read only property and has a hexadecimal value of up to 8
characters, which uniquely identifies a document within a particular database. A note ID
represents the location of a document within a specific database file. So the documents that are
replicas of one another generally have different note IDs. A note ID does not change, unless the
document is deleted.

For
m

A form provides the structure for creating and displaying documents, which are the design
elements that store data in the database. When you enter the information in a form and save it,
the information is saved as a document. When you open the document, the document uses the
form as a template to provide the structure for displaying the data.
Note: Changing a form (for example, by adding a field) does not change documents previously
created with that form until they are modified and saved, either manually or automatically by an
agent. Removing a field from a form does not remove the value of that field from previously
created documents.

Par
ent
Doc
ume

A parentdocumentUNID of a document is a read-only property. It is defined as the universal ID
of a document's parent, if the document is a response document. If a document does not have a
parent, it returns an empty string (""). The datatype is string.
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Note: You can map the output parameters of the activity based on requirement.

Summary flag (field flag) behavior

When a document is created for a form containing fields of type Authors, Readers, or Names; and data is set for
these fields in the Map Input, the summary flag is set with proper permissions based on the Domino field type.
This feature is supported from Domino server version 8.5.3 onwards.

For example:

1. If a Domino field of type Authors is set with a value CN=SYSTEM/O=IBM, the summary flag will be
SUMMARY READ/WRITE-ACCESS NAMES "CN=SYSTEM/O=IBM".

2. If a Domino field of type Readers is set with a value CN=SYSTEM/O=IBM, the summary flag will be
SUMMARY READ-ACCESS NAMES "CN=SYSTEM/O=IBM".

3. If a Domino field of type Names is set with a value CN=SYSTEM/O=IBM, the summary flag will be
SUMMARY NAMES "CN=SYSTEM/O=IBM".
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Updating a Domino document
Use the Update Document activity to update a document in the Domino® database. Each updated document
must be uniquely identifiable by its UniversalID or NotesID.

Using the update activity

1. Right-click Orchestration in the Project pane and click New Orchestration to create or open an
orchestration. The orchestration pane is displayed.

2. Select the Activities tab and expand the Domino folder.
3. Drag Update Activity from the Domino folder onto the orchestration. The graphical representation of

the orchestration, along with the Checklist pane is displayed.
4. The Checklist pane lists the tasks (Summary, Pick Endpoint, Configure, Map Inputs, Map Outputs)

that you must complete to configure an outbound activity.
5. Click Pick Endpoint, and then select a Domino endpoint.

For instructions on creating or editing a Domino endpoint, see Creating or editing an endpoint for a
Domino activity

6. Click Configure from the Checklist. The Configure pane is displayed.
Click Browse to select an existing database from the Browse Domino databases pane. The
Browse Domino databases display all the databases for the selected endpoint.
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Click Next to select an existing form from the Browse Domino Forms pane. The Browse Domino
Forms displays all the forms present in the selected database of the Domino server.

Note: The Next button is enabled only after you select the database name.

Specifying the map inputs for update activity

The input parameters for update activity are either UniversalID or NotesID and all the business data fields
(specific to the selected form) must be updated.

1. Click Map Input from the Checklist pane.
The input parameters for the specific Domino activity are displayed under the To Activity pane. The
input parameters are defined in the following table.

Pa
ra
me
ter
Na
me Description

Un
iv
er
sa
lI
D

A UniversalID of a document is a read/write property that uniquely identifies a document
across all replicas of a database. In character format, a UniversalID is a 32-character
combination of hexadecimal digits (0-9, A-F). A UniversalID is also known as the unique ID or
UNID. The data type is string.

No
te
sI
D

A NotesID of a document is a read only property and has a hexadecimal value of up to 8
characters, which uniquely identifies a document within a particular database. A NotesID
represents the location of a document within a specific database file. So the documents that are
replicas of one another generally have different note IDs. A NotesID does not change, unless the
document is deleted.

Note: You must map the input parameters of the activity.
Note: To populate dynamically added fields of the Domino document, which are not part of the map
inputs structure, use the AdditionalFields property and provide the field names and field values in
FieldDetails section.

For Form Types that are same across multiple databases, you can now specify the database name as part of
the optional parameters in map inputs, wherein the same orchestration can be used to perform outbound
operations on different databases. To do this, you must specify the database name in the databaseName
optional parameter (described in Table 1). If the databaseName parameter is populated with a value, the
outbound operation is performed on the database specified in the databaseName parameter. If there is no
value specified, the database name that is specified during configuration is used to perform the outbound
operation.

Optional parameters for a Domino activity

The following are the optional parameters that are defined for update activity.
Table 1. Optional parameters

Par
ame
ter
Na
me Description
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Par
ame
ter
Na
me Description

Mar
kAs
Rea
d

Specifies if the document is to be marked as read during an update operation. It is of type Boolean.

Mak
eRe
spo
nse

Specifies if the document is to be made available as the response of the saved document even if
another user modifies and saves the document. It is of type Boolean.

For
ceS
ave

Specifies if the document is to be force saved during a conflict of an update operation. It is of type
Boolean.

dat
aba
seN
ame

databaseName is the name of the database in which the document is updated. If a value is set for this
parameter, then the value of the database in the configure panel is overwritten. This parameter is
useful when documents with the same structure (Form) must be updated in multiple databases, using
the same orchestration.

The Domino connector also supports dynamic endpoint connection to a different Domino server. During run
time, if you want to dynamically connect to a Domino server other than the one that is configured in the
endpoint page, add the new optional parameters in dominoConnectionProperties of map inputs. The
parameters for dominoConnectionProperties are described in the following table:

Table 2. Optional connection parameters
Parameters Description

dominoConnectionProperties parameters

hostName Specifies the host name or IP address of the machine on which Domino
server is running.

diiopPort Specifies the Domino Internet Inter-ORB Protocol (DIIOP) port that
allows Java™ applets or applications to access Domino data remotely
using CORBA. The default value is 63148.

username Specifies the user name to connect to the Domino server.

password Specifies the password that is associated with the user name to connect
to the Domino server.

connectionPool parameters

minimumConnections Specifies the lowest number of Domino server connections that the
Integration Appliance keeps open in the connection pool. Entering 0
(zero) is supported. The default value is 5.

maximumConnections Specifies the maximum number of Domino server connections that the
Integration Appliance can keep open in the connection pool. Entering 0
(zero) means the maximum number of connections is unbounded. The
default value is 25.
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Parameters Description

maxIdleTime Specifies the amount of time in minutes that a Domino server connection
can be open in an idle state before being closed by the Integration
Appliance. Entering 0 (zero) means that the connections are closed when
they are returned to the pool —no idle time. The default value is 120
minutes.

maxWait Specifies the amount of time in seconds that the Integration Appliance
waits for a connection when all the connections in the pool are
exhausted. If no connection is obtained after the wait time, an exception
is thrown. The default value is 300 seconds.

reclaimConnections Specifies the interval at which the connector checks for idle connections.
Idle connections are reclaimed until the minimum number of connections
is reached, as specified in the Minimum Connections parameter. The
default value is 5 minute.

Specifying the map outputs for a Domino activity

1. Click Map output from the Checklist pane.

The output parameters for the Domino activity are displayed under the From Activity pane.

Note: You can map the output parameters of the activity that is based on your requirement.

Summary flag (field flag) behavior

When a document is updated for a form containing fields of type Authors, Readers, or Names; and data is set
for these fields in the Map Input, the summary flag is set with proper permissions based on the Domino field
type. This feature is supported from Domino server version 8.5.3 onwards.

For example:

1. If a Domino field of type Authors is set with a value CN=SYSTEM/O=IBM, the summary flag will be
SUMMARY READ/WRITE-ACCESS NAMES "CN=SYSTEM/O=IBM".

2. If a Domino field of type Readers is set with a value CN=SYSTEM/O=IBM, the summary flag will be
SUMMARY READ-ACCESS NAMES "CN=SYSTEM/O=IBM".

3. If a Domino field of type Names is set with a value CN=SYSTEM/O=IBM, the summary flag will be
SUMMARY NAMES "CN=SYSTEM/O=IBM".
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Retrieving a Domino document
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Using the Retrieve Activity, you can retrieve a document from a Domino® database. Each retrieved document is
uniquely identified by its UniversalID or NotesID. The retrieval is done based on the input, that is, either the
UniversalID or the NotesID.

Using the retrieve activity

1. Right-click Orchestration in the Project pane and click New Orchestration to create or open an
orchestration. The orchestration pane is displayed.

2. Select the Activities tab and expand the Domino folder.
3. Drag Retrieve Activity from the Domino folder onto the orchestration. A graphical representation of the

orchestration along with the Checklist is displayed.
4. The Checklist pane lists the tasks(Summary, Pick Endpoint, Configure, Map inputs, Map outputs) that

you must perform to complete the configuration of the outbound activity.
5. Click Pick Endpoint, and then select a Domino endpoint.

For instructions on creating or editing a Domino endpoint, see Creating or editing an endpoint for a
Domino activity.

6. Click Configure from the Checklist. The Configure pane is displayed.
Click Browse to select an existing database from the Browse Domino databases pane. The
Browse Domino databases display all the databases for the selected endpoint.
Click Next to select an existing form from the Browse Domino Forms pane. The Browse Domino
Forms displays all the forms present in the selected database of the Domino server.
Note: The Next button is enabled only after you select the database name.
Fields with canonical names accept fields that may have canonical names such as John
Smith/IBM/COUNTRY as values, which are separated by commas. Specify the canonical names in
this field if you want to convert the values in these fields to internet mail addresses, such as
johnsmith@country.ibm.com. Some of the field name examples are To, From, CC, Chair,
Required Attendees, and so on.

Specifying the map inputs for the retrieve activity

The input parameter for Retrieve activity is either UniversalID or NotesID. When both are given, UniversalID is
used to retrieve the Domino document.

1. Click Map Input from the Checklist pane.
The input parameters for the specific Domino activity are displayed under the To Activity pane. Some of
the common input parameters are defined in the following table.

Pa
ra
m
et
er
Na
m
e Description

Un
iv
er
sa
lI
D

The UniversalID parameter is a read/write property that uniquely identifies a document across
all replicas of a database. In character format, the unique ID parameter is a 32-character
combination of hexadecimal digits (0-9, A-F). The UniversalID is also known as the unique ID or
UNID. The data type is string.

No
te

The Notes® ID of a document is a read only property and has a hexadecimal value of up to 8
characters, which uniquely identifies a document within a particular database. The Notes ID
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represents the location of a document within a specific database file. So the documents that are
replicas of one another generally have different Notes IDs. A Notes ID does not change, unless the
document is deleted.

Note: You must map the input parameters of the activity.

For Form Types that are same across multiple databases, you can now specify the database name as part of
the optional parameters in map inputs, wherein the same orchestration can be used to perform outbound
operations on different databases. To do this, you must specify the database name in the databaseName
optional parameter (described in Table 1). If the databaseName parameter is populated with a value, the
outbound operation is performed on the database specified in the databaseName parameter. If there is no
value specified, the database name that is specified during configuration is used to perform the outbound
operation.

Optional parameters
The optional input parameter is described in the following table:

Table 1. Optional parameters
Par
am
eter
na
me Description

dat
aba
seN
ame

databaseName is the name of the database from which the document is retrieved. If a value is set for
this parameter, then the value of the database in the configure panel is overwritten. This parameter is
useful when documents with the same structure (Form) must be retrieved from multiple databases,
using the same orchestration.

The Domino connector also supports dynamic endpoint connection to a different Domino server. During run
time, if you want to dynamically connect to a Domino server other than the one that is configured in the
endpoint page, add the new optional parameters in dominoConnectionProperties of map inputs. The
parameters of dominoConnectionProperties are described in the following table:

Table 2. Optional connection parameters
Parameters Description

dominoConnectionProperties parameters

hostName Specifies the host name or IP address of the machine on which Domino
server is running.

diiopPort Specifies the Domino Internet Inter-ORB Protocol (DIIOP) port that
allows Java™ applets or applications to access Domino data remotely
using CORBA. The default value is 63148.

username Specifies the user name to connect to the Domino server.

password Specifies the password that is associated with the user name to connect
to the Domino server.

connectionPool parameters

minimumConnections Specifies the lowest number of Domino server connections that the
Integration Appliance keeps open in the connection pool. Entering 0
(zero) is supported. The default value is 5.

maximumConnections Specifies the maximum number of Domino server connections that the
Integration Appliance can keep open in the connection pool. Entering 0
(zero) means the maximum number of connections is unbounded. The
default value is 25.
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Parameters Description

maxIdleTime Specifies the amount of time in minutes that a Domino server connection
can be open in an idle state before being closed by the Integration
Appliance. Entering 0 (zero) means that the connections are closed when
they are returned to the pool —no idle time. The default value is 120
minutes.

maxWait Specifies the amount of time in seconds that the Integration Appliance
waits for a connection when all the connections in the pool are
exhausted. If no connection is obtained after the wait time, an exception
is thrown. The default value is 300 seconds.

reclaimConnections Specifies the interval at which the connector checks for idle connections.
Idle connections are reclaimed until the minimum number of connections
is reached, as specified in the Minimum Connections parameter. The
default value is 5 minute.

Specifying the map outputs for the retrieve activity

1. Click Map output from the Checklist pane.

The output parameters for the Domino activity are displayed under the From Activity pane.

Note: You can map the output parameters of the activity that is based on your requirement.
Note: Dynamically added fields present in the Domino document and not generated in the map
input/output structures are handled by the Domino connector. While retrieving documents using this
activity, the data for these fields are available in the map outputs section under AdditionalFields.
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Querying Domino documents
The Query Document activity is used to query documents from the database in the Lotus® Domino® server that
matches the values that are specified in the document fields.

You can specify one or more of the following criteria in the input data that is sent with the outbound request.

Document business data: When you specify the document business data in the Map Input section, the
connector reads all the valid data from the map input. The connector searches the database for
documents that match these valid data. All the matching documents that can be represented using the
map output schema are returned as a response.
ParentDocumentUNID: When you specify a valid ParentDocumentUNID in the Map Input section, the
connector queries all the child documents to this parent document. All the matching documents, which
can be represented using the map output schema are returned as a response.
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No data set: When you do not provide a data in the map input, the connector queries the documents that
can be represented using the map output schema.

You can search for documents based on two types of search methods:

1. Database Search method: Given selection criteria for a document, returns all documents in a database
that meet the criteria. By default, the activity uses the Database Search method to search for
documents. To explicitly set the search to this type, set the value of searchType optional parameter to
NORMAL_SEARCH in the map input section. This method supports the search of documents that are
based on the following types of search criteria:

a. Single values: You can specify a single value in the search criteria. For example, the connector
can query documents that are based on the single word, number, or date that is specified in the
search field. You can find more information about the search values that can be specified in the
Number and Date type fields in the following points.

Numbers: You can specify a double digit number or an integer value as the search criteria
in the Numbers type field. You can use this search function to query documents where a
Number type field equals to a certain value. For example, to query documents where
employee salary equals to 1234.56, enter the value 1234.56 in the EmployeeSalary
field.
Date: You can specify a date as the search criteria in any Date type field. For example, to
query documents where birthday equals to 1982/11/22, specify the value 1982/11/22 in
the Birthday field.

b. Multiple values: You can specify multiple values as the search criteria for any Lotus® Domino®
field types. This feature can be used to find the documents with the specified values at run time.
For example, you can configure the connector to retrieve documents that match the words that
are specified in the search criteria.

c. Text search for rich text contents: You can specify the texts to search documents that have rich
text contents at run time. The connector conducts a search by using the texts that are specified in
the RichText field and all matching documents are retrieved by the connector. The connector
supports both single and multiple text content searches for the RichText field. You can also
provide wildcard suffixes, such as * for searching documents in the RichText field.

d. Search using multiple fields: You can specify search values in more than one field. In this
configuration, the activity uses the logical AND operator to group the search strings. For instance,
you can specify a single value, multiple values, RichText, or ParentDocumentUNID in different
fields. The activity returns only the search content that matches all the specified criteria.

2. Database FTSearch/Indexed Search method: Conducts a full text search of all the documents in a
database. When the database is fully indexed, the indexed search method is faster compared to the
Database Search method. The method sorts the output data by relevance score. When the collection is
sorted by relevance, the highest relevance appears first. To explicitly set the search to this type, set the
value of searchType optional parameter to FULL_TEXT_SEARCH in the map input section.

a. Search using multiple fields: The indexed search method also supports search using multiple
fields. You can specify the search values in more than one field. In this configuration, the
connector uses the logical AND operator to group the search strings. For instance, you can specify
a single value, multiple values, or ParentDocumentUNID in different fields. The connector
returns a logical AND operation of all the specified search criteria, returning exact and close
matches for string type fields and exact matches for numeric type fields.

Note: The indexed search method does not work for RichText, Attachments, and Date fields.

Using the Query Document activity

1. Right-click Orchestration in the Project pane and click New Orchestration to create or open an
orchestration. The orchestration pane is displayed.

2. Select the Activities tab and expand the Domino folder.
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3. Drag Query Activity from the Domino folder onto the orchestration. A graphical representation of the
orchestration along with the Checklist is displayed.

4. Click Pick Endpoint, and then select a Domino endpoint.

For instructions on creating or editing a Domino endpoint, see Creating or editing an endpoint for a
Domino activity.

5. Click Configure from the Checklist. The Configure pane is displayed.
Click Browse to select an existing database from the Browse Domino database pane. The
Browse Domino databases display all the databases for the selected endpoint.
Click Next to select an existing form from the Browse Domino Forms pane. The Browse Domino
Forms displays all the forms present in the selected database of the Domino server.
Note: The Next button is enabled only after you have selected the database name.
Fields with canonical names accept fields that may have canonical names such as John
Smith/IBM/COUNTRY as values, which are separated by commas. Specify the canonical names in
this field if you want to convert the values in these fields to internet mail addresses, such as
johnsmith@country.ibm.com. Some of the field name examples are To, From, CC, Chair,
Required Attendees, and so on.

6. Select the Map Inputs in the Checklist. The XML schemas generated from the selected object of the
Query Documents activity are displayed as nodes under the request input parameter in the To Activity
panel.

For Form Types that are same across multiple databases, you can specify the database name as part of
the optional parameters in map inputs, wherein the same orchestration can be used to perform
outbound operations on different databases. To do this, you must specify the database name in the
databaseName optional parameter (described in Table 1). If the databaseName parameter is populated
with a value, the outbound operation is performed on the database specified in the databaseName
parameter. If there is no value specified, the database name that is specified during configuration is
used to perform the outbound operation.

The optional input parameter is described in the following table:

Table 1. Optional input parameter
Par
am
ete
r
na
me Description

da
ta
ba
se
Na
me

databaseName is the name of the database from which the document is queried. If a value is set
for this parameter, then the value of the database given in the configure panel will be overwritten.
This parameter is useful when documents with the same structure (Form) need to be queried
from multiple databases, using the same orchestration.

The Domino connector also supports dynamic endpoint connection to a different Domino server. During
run time, if you want to dynamically connect to a Domino server other than the one that is configured in
the endpoint page, add the new optional parameters in dominoConnectionProperties of map inputs.
The parameters of dominoConnectionProperties are described in the following table:

Table 2. Optional connection parameters
Parameters Description

dominoConnectionProperties parameters
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Parameters Description

hostName Specifies the host name or IP address of the machine on which
Domino server is running.

diiopPort Specifies the Domino Internet Inter-ORB Protocol (DIIOP) port that
allows Java™ applets or applications to access Domino data remotely
using CORBA. The default value is 63148.

username Specifies the user name to connect to the Domino server.

connectionPool parameters

minimumConnections Specifies the lowest number of Domino server connections that the
Integration Appliance keeps open in the connection pool. Entering 0
(zero) is supported. The default value is 5.

maximumConnections Specifies the maximum number of Domino server connections that
the Integration Appliance can keep open in the connection pool.
Entering 0 (zero) means the maximum number of connections is
unbounded. The default value is 25.

maxIdleTime Specifies the amount of time in minutes that a Domino server
connection can be open in an idle state before being closed by the
Integration Appliance. Entering 0 (zero) means that the connections
are closed when they are returned to the pool —no idle time. The
default value is 120 minutes.

maxWait Specifies the amount of time in seconds that the Integration
Appliance waits for a connection when all the connections in the
pool are exhausted. If no connection is obtained after the wait time,
an exception is thrown. The default value is 300 seconds.

reclaimConnections Specifies the interval at which the connector checks for idle
connections. Idle connections are reclaimed until the minimum
number of connections is reached, as specified in the Minimum
Connections parameter. The default value is 5 minute.

password Specifies the password that is associated with the user name to
connect to the Domino server.

7. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

8. Select the search type to be used for the activity:
Table 3. Search type

Parameter Name Description

searchType Specifies the search type to be used for this activity. The values are:
NORMAL_SEARCH: Uses Domino Database Search method.
FULL_TEXT_SEARCH: Uses Domino Database FTSearch method.

When no value is specified NORMAL_SEARCH is used.

9. Select the Map Outputs in the checklist. The XML schemas generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.
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Note: Dynamically added fields present in the Domino document and not generated in the map
input/output structures are handled by the Domino connector. While retrieving documents using this
activity, the data for these fields are available in the map outputs section under AdditionalFields.

queryUsingTimestamp is the parameter that is used to query documents that are based on time
stamps. The timestamp property is a recursive property. You can define groupFields, name,
operator, and value under the timestamp property.

The optional output parameters are described in the following table:

Parame
ter
Name Description

queryU
singTi
mestam
p

The following are the timestamp properties:
Table 4. timestamp properties

Proper
ty Values

group
Field
s

You can specify multiple values such as: AND, OR, (,), AND(, OR(, )AND, )OR,
)AND(, and )OR(.
Note: You can have multiple conditions. groupFields must be used when you
have multiple conditions.

name Specify one of these values: createdTimestamp or lastModifiedTimestamp

opera
tor

Specify one of these values: GREATER_THAN, GREATER_THAN_OR_EQUAL_TO,
EQUAL_TO, LESS_THAN, LESS_THAN_OR_EQUAL_TO, and NOT_EQUAL_TO

value Specify the date and time values. For example, 26-09-2013 12:05:00 PM EST.
Note: If you do not mention the timezone, by default, the timezone of the server is
considered.

Note:
Querying documents that are based on the NOT_EQUAL_TO operator (!=) is not
supported in Full Text Search.
Querying documents using time is not supported in Full Text Search. For example,
[_RevisionDate] = 05/06/2013 09:30:00.
Querying documents using the EQUAL_TO operator with timestamp does not work
with the Normal Search type. For example, @Modified = [05/06/2013
09:14:22].
Querying documents using Full Text Search as the Search Type, you can query
documents that are only based on Date; and not DateTime. For example,
lastModfiedDateTime >= 05/20/2013 20:00:00 is not supported in Full Text
Search.

10. Create a map between the output parameters and orchestration variables.

You have configured the Domino Query Documents activity.
Parent topic: Domino Activities
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Querying views for Domino documents
The Query Views activity is used to query views from the database in the Lotus® Domino® server that matches
the values that are specified in the document fields that are present in the view.

Using the Query Document activity

1. Right-click Orchestration in the Project pane and click New Orchestration to create or open an
orchestration. The orchestration pane is displayed.

2. Select the Activities tab and expand the Domino folder.
3. Drag Query Views from the Domino® folder onto the orchestration. A graphical representation of the

orchestration along with the Checklist is displayed.
4. Click Pick Endpoint, and then select a Domino endpoint.

For instructions on creating or editing a Domino endpoint, see Creating or editing an endpoint for a
Domino activity.

5. Click Configure from the Checklist. The Configure pane is displayed.
Note: The Next button is enabled only after you have selected the database name.

Click Browse to select an existing database from the Browse Domino Database pane. The
Browse Domino databases display all the databases for the selected endpoint.
Click Browse to select an existing view from the Browse Domino Views pane. The Browse
Domino Views display all the views for the selected endpoint and in the selected database.
Click Next to select an existing form from the Browse Domino Forms pane. The Browse Domino
Forms displays all the forms related to the documents in that view.

6. Select the Map Inputs in the Checklist. The XML schemas generated from the selected object of the
Query Views activity are displayed as nodes under the request input parameter in the To Activity panel.

For Form Types that are same across multiple databases, you can specify the database name as part of
the optional parameters in map inputs, wherein the same orchestration can be used to perform
outbound operations on different databases. To do this, you must specify the database name in the
databaseName optional parameter (described in Table 1). If the databaseName parameter is populated
with a value, the outbound operation is performed on the database that is specified in the
databaseName parameter. If there is no value specified, the database name that is specified during
configuration is used to perform the outbound operation.

The optional input parameter is described in the following table:

Table 1. Database name optional parameter
Param
eter
Name Description

datab
aseNa
me

Specifies the database name that can be dynamically added in map inputs to enable a single
orchestration to perform outbound operations across multiple databases that have the same
Form Type.

The Domino connector also supports dynamic endpoint connection to a different Domino server. During
run time, if you want to dynamically connect to a Domino server other than the one that is configured in
the endpoint panel, add the new optional parameters in dominoConnectionProperties of map
inputs. The parameters for dominoConnectionProperties are described in the following table:
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Table 2. Optional connection parameters
Parameters Description

dominoConnectionProperties parameters

hostName Specifies the host name or IP address of the machine on which the
Domino server is running.

diiopPort Specifies the Domino Internet Inter-ORB Protocol (DIIOP) port that
allows Java™ applets or applications to access Domino data remotely
using CORBA. The default value is 63148.

username Specifies the user name to connect to the Domino server.

password Specifies the password that is associated with the user name to
connect to the Domino server.

connectionPool parameters

minimumConnections Specifies the lowest number of Domino server connections that the
Integration Appliance keeps open in the connection pool. Entering 0
(zero) is supported. The default value is 5.

maximumConnections Specifies the maximum number of Domino server connections that
the Integration Appliance can keep open in the connection pool.
Entering 0 (zero) means the maximum number of connections is
unbounded. The default value is 25.

maxIdleTime Specifies the amount of time in minutes that a Domino server
connection can be open in an idle state before being closed by the
Integration Appliance. Entering 0 (zero) means that the connections
are closed when they are returned to the pool —no idle time. The
default value is 120 minutes.

maxWait Specifies the amount of time in seconds that the Integration
Appliance waits for a connection when all the connections in the
pool are exhausted. If no connection is obtained after the wait time,
an exception is thrown. The default value is 300 seconds.

reclaimConnections Specifies the interval at which the connector checks for idle
connections. Idle connections are reclaimed until the minimum
number of connections is reached, as specified in the Minimum
Connections parameter. The default value is 5 minute.

7. Map the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

8. Specify the values as described in Table 3:
Table 3. Search type

Paramete
r Name Description

KeyValue
s

Specify the value for which you want to run a search.

ExactMat
ch

Specify the value as False to return all possible values related to the search term. For an
exact match to be returned, specify the value as True.
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Paramete
r Name Description

SearchFo
rmula

Specify a formula for a detailed search as per your requirement.

9. Select the Map Outputs in the checklist. The XML schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.
Note: Dynamically added fields present in the Domino document and not generated in the map
input/output structures are handled by the Domino connector. While retrieving documents using this
activity, the data for these fields are available in the map outputs section under AdditionalFields.

10. Create a mapping between the output parameters and orchestration variables.

You have configured the Domino Query Views activity.
Parent topic: Domino Activities
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Deleting a Domino document
Use the Delete Activity to delete a document from the Domino® database. Each deleted document must be
uniquely identifiable by its UniversalID or NotesID.

Using the delete activity

1. Right-click Orchestration in the Project pane and click New Orchestration to create or open an
orchestration. The orchestration pane is displayed.

2. Select the Activities tab and expand the Domino folder.
3. Drag Delete Activity from the Domino folder onto the orchestration. A graphical representation of the

orchestration along with the Checklist is displayed.
4. The Checklist pane lists the tasks(Summary, Pick Endpoint, Configure, Map inputs, Map outputs) that

you must perform to complete the configuration of the outbound activity.
5. Click Pick Endpoint, and then select a Domino endpoint.

For instructions on creating or editing a Domino endpoint, see Creating or editing an endpoint for a
Domino activity.

6. Click Configure from the Checklist. The Configure pane is displayed.
Click Browse to select an existing database from the Browse Domino databases pane. The
Browse Domino databases display all the databases for the selected endpoint.
Click Next to select an existing form from the Browse Domino Forms pane. The Browse Domino
Forms displays all the forms present in the selected database of the Domino server.
Note: The Next button is enabled only after you have selected the database name.

Specifying the map inputs for the delete activity

1. Click Map Input from the Checklist.

 261



The input parameters for the specific Domino activity are displayed under the To Activity pane. Some of
the common input parameters are defined in the following table.

Pa
ra
m
et
er
Na
m
e Description

Un
iv
er
sa
lI
D

The UniversalID parameter is a read/write property that uniquely identifies a document across
all replicas of a database. In character format, the unique ID parameter is a 32-character
combination of hexadecimal digits (0-9, A-F). The UniversalID is also known as the unique ID or
UNID. The data type is string.

No
te
sI
D

The Notes® ID of a document is a read only property and has a hexadecimal value of up to 8
characters, which uniquely identifies a document within a particular database. The NotesID
represents the location of a document within a specific database file. So the documents that are
replicas of one another generally have different Notes IDs. A Notes ID does not change, unless the
document is deleted.

Note: You must map the input parameters of the activity.

For Form Types that are same across multiple databases, you can now specify the database name as part of
the optional parameters in map inputs, wherein the same orchestration can be used to perform outbound
operations on different databases. To do this, you must specify the database name in the databaseName
optional parameter (described in Table 1). If the databaseName parameter is populated with a value, the
outbound operation is performed on the database specified in the databaseName parameter. If there is no
value specified, the database name that is specified during configuration is used to perform the outbound
operation.

Optional parameters
The optional input parameters are described in the following table:

Table 1.
Inp
ut
Par
ame
ters Description

for
ceD
ele
te

This property specifies if the document is to be deleted during a conflict of delete operation. It is of
type boolean.

dat
aba
seN
ame

databaseName is the name of the database from which the document is deleted. If a value is set for
this parameter, then the value of the database given in the configure panel will be overwritten. This
parameter is useful when documents with the same structure (Form) need to be deleted from multiple
databases, using the same orchestration.

The Domino connector also supports dynamic endpoint connection to a different Domino server. During run
time, if you want to dynamically connect to a Domino server other than the one that is configured in the
endpoint page, add the new optional parameters in dominoConnectionProperties of map inputs. The
parameters of dominoConnectionProperties are described in the following table:

Table 2. Optional connection parameters
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Parameters DescriptionParameters Description

dominoConnectionProperties parameters

hostName Specifies the host name or IP address of the machine on which Domino
server is running.

diiopPort Specifies the Domino Internet Inter-ORB Protocol (DIIOP) port that
allows Java™ applets or applications to access Domino data remotely
using CORBA. The default value is 63148.

username Specifies the user name to connect to the Domino server.

password Specifies the password that is associated with the user name to connect
to the Domino server.

connectionPool parameters

minimumConnections Specifies the lowest number of Domino server connections that the
Integration Appliance keeps open in the connection pool. Entering 0
(zero) is supported. The default value is 5.

maximumConnections Specifies the maximum number of Domino server connections that the
Integration Appliance can keep open in the connection pool. Entering 0
(zero) means the maximum number of connections is unbounded. The
default value is 25.

maxIdleTime Specifies the amount of time in minutes that a Domino server connection
can be open in an idle state before being closed by the Integration
Appliance. Entering 0 (zero) means that the connections are closed when
they are returned to the pool —no idle time. The default value is 120
minutes.

maxWait Specifies the amount of time in seconds that the Integration Appliance
waits for a connection when all the connections in the pool are
exhausted. If no connection is obtained after the wait time, an exception
is thrown. The default value is 300 seconds.

reclaimConnections Specifies the interval at which the connector checks for idle connections.
Idle connections are reclaimed until the minimum number of connections
is reached, as specified in the Minimum Connections parameter. The
default value is 5 minute.

Specifying the map outputs for the delete activity

1. Click Map output from the Checklist.

The output parameters for the Domino activity are displayed under the From Activity pane.

Note: You can map the output parameters of the activity that is based on your requirement.

Parent topic: Domino Activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
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Specifying Retry and Delivery Options for Domino activities
Specifying the Retry and Delivery parameters is one of the tasks to configure a Domino® activity configuration.

About this task

This section contains the procedures for configuring the Domino outbound and inbound activities.

Procedure

To specify the retry options for inbound and outbound Domino activities:

1. Select the Retry task from the Checklist. The retry pane is displayed.
2. Configure the retry options for connecting to a Domino server as described in the following table:

Table 1. Retry options
Retry
Fields Description

Wait
__
secon
d(s)
betwe
en
each
retry.

Specifies the number of seconds that the Integration Appliance waits before trying to establish
a connection to the Domino server.

Try to
conne
ct __
times
befor
e
failing
.

Specifies the retry count — the maximum number of times the Integration Appliance attempts
to establish a connection to the Domino server before issuing the following errors:

When you set this parameter to "0", Studio does not try to reconnect.
When you set this parameter to a value less than "0", Studio retries the connection
indefinitely.

If an orchestration that starts with an inbound Domino activity is deployed and the Integration
Appliance cannot connect to the specified Domino server, the Integration Appliance logs the
connection errors as warnings in the system log until the retry count value is reached. When
the retry count is reached, the Integration Appliance logs an error in the system log, resets the
connection error count to zero, and continues to attempt to establish a connection to the
Domino server.

For example, you set the retry count to 3. The first, second, and third connection errors appear
in the system log as warnings. The Integration Appliance logs the fourth connection error as an
error and stops processing the current orchestration job.

Parent topic: Domino Activities

Domino inbound activities

Procedure
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To specify the delivery rules options for Domino inbound activities:

1. Select the Delivery Rules task from the Checklist. The delivery rules pane is displayed.
2. Configure the delivery rules options to select the activity's behavior as described in the following table:

Table 2. Delivery Rules options
Deliv
ery
Rule
s
Field
s Description

Pollin
g
Inter
val

Specifies the time interval to poll event view in Adapter for Lotus® Domino(WALD) inbound
event table of the Domino server. (For example, the Get created documents activity polls for
create trigger events at the specified time internal.) Time can be selected in the format days,
hours, minutes, and seconds.

Fetch
size

Specifies how many events the activity must retrieve from the WALD inbound event table of the
Domino server in each poll cycle.

Deliv
ery
Mess
ages

ATM
OST_
ONCE

A non-persistent mode in which a document is either processed once or not processed at all.

ATLE
AST_
ONCE

A persistent mode, in which a Domino document is not lost. As a result, there are chances that
the orchestration can process the document once or more than once.
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Prerequisites to use Domino inbound activities
This section contains the prerequisites for configuring the Domino® inbound activities:

Configuring the Domino server

1. Copy the native library mentioned in the following table from <STUDIO
ROOT>/etc/domino/<platform> directory to the Domino servers root directory. The native library is
selected based on the platform on which Domino server is running.
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Library file Supported operating systemsLibrary file Supported operating systems

waldinbound.dll Windows 32 bit

waldinbound.dll Windows 64 bit

libwaldinbound_r.a AIX® 32 bit

libwaldinbound.so Redhat 32 bit

libwaldinbound.so Suse 32 bit

libwaldinbound.so Solaris 32 bit

2. Search for notes.ini file in the Domino server. Open the file and add an entry at the end of the file.

EXTMGR_ADDINS=waldinbound

3. Copy the inbound event database (filename : waldinbound.nsf) from the (<STUDIO ROOT>/etc/domino/)
to the Domino server's data directory (<DominoRoot>/data).

4. Open the inbound event database (waldinbound.nsf) by using Lotus Notes® and configure the event
activity.

5. The following are the steps for configuring WALD inbound event table.
Select the EventTriggerConfigurationView. If there is an entry, edit it. If there is no entry, create a
new configuration.
Enter a value for connector ID. This is optional.
Enter the database name and form (both are case sensitive) for which events need to be
generated for the field ‘Monitored documents'. The same database and form will be selected
during discovery of the inbound activity. The syntax is shown below.

DatabaseName:formName
SampleDatabase.nsf:Employee
TestDatabase.nsf:Form1:TestDatabase.nsf:Form2. (For this, events will be generated for
both Form1 and Form2.)

6. Select the event type interested.
Note: The selected event type corresponds to the starter activities (Get Created Documents or Get
Updated Documents or Get Deleted Documents).

7. Save the configuration (Ctrl + S). Events from the selected databases and forms get triggered and are
available in the EventView of the inbound event database.

8. Restart Domino server. Test from Lotus Notes by using sample data and make sure that the events are
getting generated for the configuration.

9. Configure the starter activity in Studio. Then create or update or delete a document (based on the
configuration chosen in EventTriggerConfigurationView) for the configured Domino databases, which
triggers an event. The event is picked by the Domino starter activity and processed.

Parent topic: Domino Activities
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Get Created Documents activity
Use the Get Created Documents activity to get the documents (which are of interest) that were created on the
Domino® server. The activity polls the event table in the Domino server for new events periodically and process
them.

Note: Before you configure and use the get created documents activity, refer to Prerequisites to use Domino
inbound activities on the Domino server.

Adding an inbound Domino activity to the orchestration

1. Right-click Orchestration in the Project pane and click New Orchestration to create or open an
orchestration. The orchestration pane is displayed.

2. Select the Activities tab and expand the Domino folder.
3. Drag Get Created Documents activity from the Domino folder onto the orchestration. The graphical

representation of the orchestration, including the checklist is displayed.
4. The Checklist pane lists the tasks (Summary, Pick Endpoint, Configure, Map outputs) that you must

perform to complete the configuration of the inbound activity.

Naming or renaming a Domino activity

1. Click Summary from the Checklist pane. The Summary pane is displayed.
Specify the name of the activity in the Activity Name text box.

Specifying the endpoint for a Domino activity

1. Click Pick Endpoint from the Checklist pane. The Pick Endpoint pane is displayed.
2. Click one of the following options:

Browse... - To select an existing endpoint from the Project Explorer. The Project Explorer shows
all the Domino endpoints in the project available for the activity. When you select an endpoint, the
endpoint properties are displayed in the Pick Endpoint pane. To edit the endpoint properties, click
Edit.
New... - To create a new endpoint. The Create Endpoint window is displayed.
Edit... - To edit an existing endpoint. The Edit Endpoint window is displayed.

Note: Any changes that you make to the endpoint, including configuration properties, affects all orchestrations
that use that endpoint. The edits are global, not local.

Specifying the database and form for a Domino activity

1. Click Configure from the Checklist pane. The Configure pane is displayed.
Click Browse to select an existing database from theBrowse Domino databases pane. The Browse
Domino databases display all the databases for the selected endpoint.
Click Next to select an existing Form from the Browse Domino Forms pane. The Browse Domino
Forms displays all the forms in the project available for the activity.
Note: The Next button is enabled only after you have selected the database name.
Optional: Specify the names of the Additional Databases from which you would like to poll the
documents of the form that is selected in the Form field. The databases must be separated by
commas. For example, Admin.nsf, names.nsf,. The databases will be polled one after the
other. All the databases that are specified in the Additional Database field must have a Form
similar to the one configured in the Browse Domino Forms.
Optional: Fields with canonical names accept fields that may have canonical names such as John
Smith/IBM/COUNTRY as values, which are separated by commas. Specify the canonical names in
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this field if you want to convert the values in these fields to internet mail addresses, such as
johnsmith@country.ibm.com. Some of the field name examples are: To, From, CC, Chair,
Required Attendees, and so on.

Specifying the map outputs for a Domino activity

1. Click Map output from the Checklist pane.

The output parameters for the Domino activity are displayed under the From Activity pane.

Note: You can map the output parameters of the activity that is based on your requirement.

Note: Dynamically added fields present in the Domino document and not generated in the map input/output
structures are handled by the Domino connector. While retrieving documents using this activity, the data for
these fields are available in the map outputs section under AdditionalFields.
Parent topic: Domino Activities
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Get Updated Documents activity
Use the Get Updated Documents activity to get the documents (which are of interest) that got updated on the
Domino® server. The activity polls the event table in the Domino server for new events periodically and process
them.

Note: Before you configure and use the get updated documents activity, refer to Prerequisites to use Domino
inbound activities on the Domino server.

Adding an inbound Domino activity to the orchestration

1. Right-click Orchestration in the Project pane and click New Orchestration to create or open an
orchestration. The orchestration pane is displayed.

2. Select the Activities tab and expand the Domino folder.
3. Drag Get Updated Documents activity from the Domino folder onto the orchestration. The graphical

representation of the orchestration along with the Checklist pane is displayed.
4. The Checklist pane lists the tasks (Summary, Pick Endpoint, Configure, Map outputs) that you must

perform to complete the configuration of the inbound activity.

Naming or renaming a Domino activity

1. Click Summary from the Checklist pane. The Summary pane is displayed.
Specify the name of the activity in the Activity Name text box.

Specifying the endpoint for a Domino activity
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1. Click Pick Endpoint from the Checklist pane. The Pick Endpoint pane is displayed.
2. Click one of the following options:

Browse... - To select an existing endpoint from the Project Explorer. The Project Explorer displays
all the Domino endpoints in the project available for the activity. When you select an endpoint, the
endpoint properties are displayed in the Pick Endpoint pane. To edit the endpoint properties, click
Edit.
New... - To create a new endpoint. The Create Endpoint window is displayed.
Edit... - To edit an existing endpoint. The Edit Endpoint window is displayed.

Note: Any changes that you make to the endpoint, including configuration properties, affects all orchestrations
that use that endpoint. The edits are global, not local.

Specifying the database and form for a Domino activity

1. Click Configure from the Checklist pane. The Configure pane is displayed.
Click Browse to select an existing database from theBrowse Domino databases pane. The Browse
Domino databases display all the databases for the selected endpoint.
Click Next to select an existing Form from the Browse Domino Forms pane. The Browse Domino
Forms displays all the forms in the project available for the activity.
Note: The Next button is enabled only after you select the database name.
Optional: Specify the names of the Additional Databases from which you would like to poll the
documents of the form that is selected in the Form field. The databases must be separated by
commas. For example, Admin.nsf, names.nsf,. The databases will be polled one after the
other. All the databases that are specified in the Additional Database field must have a Form
similar to the one configured in the Browse Domino Forms.
Optional: Fields with canonical names accept fields that may have canonical names such as John
Smith/IBM/COUNTRY as values, which are separated by commas. Specify the canonical names in
this field if you want to convert the values in these fields to internet mail addresses, such as
johnsmith@country.ibm.com. Some of the field name examples are To, From, CC, Chair,
Required Attendees, and so on.

Specifying the map outputs for a Domino activity

1. Click Map output from the Checklist pane.

The output parameters for the Domino activity are displayed under the From Activity pane.

Note: You can map the output parameters of the activity that is based on your requirement.

Note: Dynamically added fields present in the Domino document and not generated in the map
input/output structures are handled by the Domino connector. While retrieving documents using this
activity, the data for these fields are available in the map outputs section under AdditionalFields.
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Get Deleted Documents activity
Use the Get Deleted Documents activity to get the documents (which are of interest) that were deleted on the
Domino® server. The activity polls the event table in the Domino server for new events periodically and process
them.

Note: Before you configure and use the get deleted documents activity, refer to Prerequisites to use Domino
inbound activities on the Domino server.

Adding an inbound Domino activity to the orchestration

1. Right-click Orchestration in the Project pane and click New Orchestration to create or open an
orchestration. The orchestration pane is displayed.

2. Select the Activities tab and expand the Domino folder.
3. Drag Get Deleted Documents activity from the Domino folder onto the orchestration. The graphical

representation of the orchestration along with the Checklist pane is displayed.
4. The Checklist pane lists the tasks (Summary, Pick Endpoint, Configure, Map outputs) that you must

perform to complete the configuration of the inbound activity.

Naming or renaming a Domino activity

1. Click Summary from the Checklist pane. The Summary pane is displayed.
Specify the name of the activity in the Activity Name text box.

Specifying the endpoint for a Domino activity

1. Click Pick Endpoint from the Checklist pane. The Pick Endpoint pane is displayed.
2. Click one of the following options:

Browse... - To select an existing endpoint from the Project Explorer. The Project Explorer shows
all the Domino endpoints in the project available for the activity. When you select an endpoint, the
endpoint properties display in the Pick Endpoint pane. To edit the endpoint properties, click Edit.
New... - To create a new endpoint. The Create Endpoint window is displayed.
Edit... - To edit an existing endpoint. The Edit Endpoint window is displayed.

Note: Any changes that you make to the endpoint, including configuration properties, affects all orchestrations
that use that endpoint. The edits are global, not local.

Specifying the database and form for a Domino activity

1. Click Configure from the Checklist pane. The Configure pane is displayed.
Click Browse to select an existing database from the Browse Domino databases pane. The
Browse Domino databases display all the databases for the selected endpoint.
Click Next to select an existing Form from the Browse Domino Forms pane. The Browse Domino
Forms displays all the forms in the project available for the activity.
Note: The Next button is enabled only after you have selected the database name.
Optional: Specify the names of the Additional Databases from which you would like to poll the
documents of the form that is selected in the Form field. The databases must be separated by
commas. For example, Admin.nsf, names.nsf,. The databases will be polled one after the
other. All the databases that are specified in the Additional Database field must have a Form
similar to the one configured in the Browse Domino Forms.
Optional: Fields with canonical names accept fields that may have canonical names such as John
Smith/IBM/COUNTRY as values, which are separated by commas. Specify the canonical names in
this field if you want to convert the values in these fields to internet mail addresses, such as
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johnsmith@country.ibm.com. Some of the field name examples are To, From, CC, Chair,
Required Attendees, and so on.

Specifying the map outputs for a Domino activity

1. Click Map output from the Checklist pane.

The output parameters for the Domino activity are displayed under the From Activity pane.

Note: You can map the output parameters of the activity that is based on your requirement.
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Handling Date/Time and Time zone data types
In the Lotus Domino form, a field of Date/Time type can be configured to represent only a date value, time
value, or both date and time values. This configuration is done while creating/editing the form in Domino
Designer. So, when a document is created for such a form, the value can be a date, time, or a datetime.

For example, if a form representing a Calendar has the following fields:
Table 1. Example

Fields Domino Data type

startDate Date/Time (represents only date)

startTime Date/Time (represents only time)

endDate Date/Time (represents only date)

endTime Date/Time (represents only time)

bothDateAndTime Date/Time (represents both date and time)

timeZone Time zone

Subject Text

Body Text

If a valid document is created for this form, then:

startDate and endDate will only accept a date value
startTime and endTime will only accept a time value
bothDateAndTime will only accept date and time
timeZone will only accept a time zone value

From Cast Iron version 6.1.0.9 onwards, Date/Time data type is handled as described in the following points:
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1. A Domino field of type Date/Time is represented as xsd:string in the map input and map output of the
activity.

2. The only supported syntax of the input values for the Date/Time fields in map input are:
a. If the field represents only date: MM/dd/yyyy. Example : 05/27/2012.
b. If the field represents only time (24 hour format): HH:mm:ss. Example: 22:15:30.
c. If the field represents both date and time (24 hour format): MM/dd/yyyy HH:mm:ss. Example:

05/31/2012 23:59:59.
3. The output from the activity also follows the same syntax as the Date/Time fields, in most cases.
4. The preceding syntax is used by the map input and output irrespective of:

a. The date and time format of the operating system on which the Domino server is running.
b. The date and time format settings configured when creating the form in Domino designer.

5. The Time zone value is also represented as xsd:string in the map input and output. The following
technote from Lotus Domino gives more information about the syntax: http://www-
01.ibm.com/support/docview.wss?uid=swg21163045. For more information about Time zone in Lotus
Domino, see Lotus Domino documentation.

Note:

1. In the Cast Iron 6.1.0.6 version and the earlier versions, the Domino Date/Time field was generated as
xsd:date, which was not able to handle all combinations of the input values.

2. Old projects developed using the 6.1.0.6 version or earlier versions that are already running, will work
fine with same old behavior, that is, Date/Time represented as xsd:date).

3. For all the orchestrations created newly using the 6.1.0.9 version and later versions, Date/Time field will
be generated as xsd:string.

4. If the old projects require the new behavior, that is, to generate Date/Time as xsd:string, then the
objects need to be refreshed from the Configure panel of the activity in the Studio 6.1.0.9 version or
later versions. Mapping must be validated after this change.
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Rich text support for Domino connector
The Domino connector supports RichText type in forms. Fields of RichText type can store both text and
attachments as part of the document. The connector supports attachments only for the Retrieve and Query
Document activities. Text content can be used for the Create, Update, Retrieve, and Query Document activities.

The following figure describes the structure of the RichText field when a form is discovered and the map input
and ouput are generated.
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Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly. This topic
provides potential solutions for issues you would have with the Domino® connector.

New fields added to the calendar object

From Cast Iron® version 6.3.0.2 onwards, you can get the invitee details, date/time, and the room details, in
response to retrieving and querying a calendar entry using the Domino connector.

Static subform behavior

In the earlier versions of Domino connector (before v7.0.0.0), the fields present in a subform (statically
embedded in the main form) were generated as strings in Map Inputs/Map Outputs, irrespective of the
datatypes that are defined for the fields. This issue is fixed in v7.0.0.0 and the data type of the fields are
generated correctly.

Parent topic: Domino Activities

Feedback | Notices

 273



 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Domino_troubleshooting.html

Email Activities
Creating or editing an email endpoint
Studio and the Integration Appliance use the connection information that email endpoints provide to
connect to POP3 or SMTP servers.
Get Email activity
The Get Email activity is a starter activity. When an orchestration that starts with an Get Email activity is
deployed to the Integration Appliance, the Integration Appliance polls the POP3 server for email
message or messages for the specified account at the specified interval.
Send Email activity
An orchestration that contains the Send Email activity is acting as an email client during run time.
Testing an SSL email connection
After creating an endpoint for an email server, you must import the CA certificate for the email server
into Studio and then test the SSL connection to the email server.
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Creating or editing an email endpoint
Studio and the Integration Appliance use the connection information that email endpoints provide to connect
to POP3 or SMTP servers.

Note: For some email systems, the POP3 server and the SMTP server can have the same name, for example:
mail.acmecompany.com.
Note: Email connector base library is changed from V7.5 and because of this user might see a difference in the
way attachments were retrieved separately using ReadMime and other activities. User has to re verify the values
obtained from the headers and use / map them appropriately if they see and difference in the output

Creating or editing an email endpoint

1. In the Create Endpointor Edit Endpoint pane, configure the fields as described in the following table.
Note: Changing the configuration properties of an endpoint affects all orchestrations that use that
endpoint in the project. The edits are global, not local.

2. When complete, click Test Connection to confirm that you can connect to the POP3 or SMTP server. The
Get Email activity connects to a POP3 server while the Send Email activity connects to a SMTP server.

3. Click OK.

Table 1.
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Field Name DescriptionField Name Description

Location  

Get Email From Server Get Email activity - The Get Email From Server option is
automatically selected for an email endpoint used with
the Get Email activity. During run time, the Get Email
activity gets email from the specified POP3 server.

Send Email To Server Send Email activity - The Send Email To Server option is
automatically selected for an endpoint used with the
Send Email activity. During run time, the Send Email
activity sends email to the specified SMTP server.

Host Name Get Email activity - The Host Name or IP address for the
POP3 server.

Send Email activity- The Host Name or IP address for the
SMTP server.

Port Specify the port number to access the POP3 or SMTP
Server. By default, the port for a POP3 server is 110.  

Login  

User Name and Password not required Get Email activity - This is option not available for an
endpoint of a Get Email activity. You must specify a User
Name and Password for an email endpoint used with the
Get Email activity.

Send Email activity - Select this option if you want
connect to the SMTP server using an anonymous login
instead of a username and password.  Select this option
only if SMTP server the supports anonymous logins
(where a user account is not required).

Log In to the Server Using a User Name and
Password

Get Email activity - This option is automatically selected
for an email endpoint used with the Get Email activity. To
connect to the POP3 server using a user account, you
must enter values into the User Name and Password
fields to specify the account used to connect to the POP3
Server.

Send Email activity - Select this option to connect to the
SMTP server using a user account. If this option is
selected, you must enter values into the User Name and
Password fields for the account used to connect to the
SMTP Server.

User Name   Get Email activity - Enter the User Name for the account
used to connect to the POP3 Server.

Send Email activity - Enter the User Name for the account
used to connect to the SMTP Server.
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Field Name Description

Password   Get Email activity - Enter the Password for the account
used to connect to the POP3 Server.

Send Email activity - Enter the Password for the account
used to connect to the SMTP Server.

Security  

Normal Email Specifies that email runs without SSL.

Email over SSL Specifies that email runs with SSL. For more information,
see Testing an SSL email connection.

Implicit or Explicit Implicit means that SSL is turned as soon as a connection
is made. Explicit requires that the client issue a command
to the server requesting that SSL be used.

Client Certificate Alias Name   Specifies the client alias used to access the trusted
certificate in the keystore.  Must be enabled for client
authorization by the server. By default, when you select
the Client Certificate Alias Name option, Studio provides
the following name: Factory Supplied Identity. The alias
name you specify in this field should match the value you
created when creating the certificate in the keystore.

Additional Parameters Specifies additional parameters for SMPT processing. The
following table lists the parameters:

smtpNewConnEveryTime
Default: false
Description: Specifies creation of a  new
connection everytime. If set to true, does not use a
connection pool

smtpPoolMinConnections
Default: 1
Description: Connection pool option - Minimum
Connections

smtpPoolMaxConnections
Default: 25
Description: Connection pool option - Maximum
Connections

smtpPoolMaxIdleTime
Default: 7200
Description: Connection pool option - Maximum
 Idle Time  in seconds

smtpPoolMaxWaitTime
Default: 300
Description: Connection pool option - Max Wait
Time in seconds

smtpPoolReclaimConnections
Default: 60
Description: Connection pool option - Reclaim
Connections Time in seconds

276   



Field Name Description

  When using Get Email, choose a polling frequency so that
the email server does not close the connection between
polls (GetMail activity > Delivery Rules). Some email
servers will lock the account or not permit log in if there
are frequent openings and closings of connections. Read
your email providers documentation to ensure that you
set the properties correctly for your email server. To
enable a connection pool, you must first set
smtpNewConnEveryTime to false, and then set the
required connection pool properties.

Connection Timeout  

Time out after ___ second(s)

when establishing a connection to the endpoint.

Specifies the number of seconds before a timeout occurs
between the Integration Appliance attempting to
establish a connection to the endpoint and the time it
takes for the endpoint to respond to the connection
request. For email activities, the amount of time the
Integration Appliance attempts to establish a connection
to the SMTP or the POP3 server before timing out.

A connection timeout is different from an activity timeout
because an activity timeout occurs after the connection to
the endpoint has already been established. An activity
timeout specifies the amount of time in seconds before a
timeout occurs between the activity invoking a request on
an endpoint and the time it takes the endpoint to
respond.

You set the activity timeout in Retry task of the Get Email
activity or Send Email activity.
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Get Email activity
The Get Email activity is a starter activity. When an orchestration that starts with an Get Email activity is
deployed to the Integration Appliance, the Integration Appliance polls the POP3 server for email message or
messages for the specified account at the specified interval.

Note: The Get Email activity requires the POP3 server to support the TOP and UIDL commands. While these are
optional in the POP3 protocol, most servers will support these.
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The polled POP3 server and email account is defined in the email endpoint associated with the Get Email
activity.

During run time, the Get Email activity polls a POP3 server for incoming email messages of a particular email
account, as shown in the following diagram.

Figure 1. 

If any email messages are found the following action occurs for each email message: The regular expression
defined for the Subject field is checked against the subject of the incoming mail message and the regular
expression defined for the From field is checked against the sender email account of the incoming mail
message. If both regular expressions match, an orchestration job is created to process the email, and the mail
is marked for deletion on POP3 Server. When the process is completed, the email is deleted from the POP3
server. For more information about regular expression matching, see the Configuring the activity procedure.
Note: Two Get Email activities should not poll from the same POP3 server at the same time using the same
email account even if the regular expressions specified in the Configure task of the activity are different. If two
Get Email activities are attempting to get email using the same email account, when the first Get Email activity
process the email from the POP3 server and removes the email from the server, the second Get Email activity
keeps retrying to retrieve the email from the POP3 server and the following exception may be thrown:

Protocol exception: com.jscape.inet.pop.PopException:  
Error in TOP 671 0: -ERR The requested message is no  
longer available; it may have been deleted.

Accessing an email message attachment

To access the attachment of a incoming email message, you must add a Read MIME activity in the
orchestration after the Get Email activity as shown in the preceding figure. In addition, you must map the two
output parameters of the Get Email activity to variables in the orchestration and then map those variables to
the input parameters of the Read MIME activity. During run time, the Read MIME activity reads the MIME
Header and the body of the message and then breaks up the attachments contained in the body of the
message and places the result into the parts XML output parameter. For more information, see Read MIME
Activity.

Adding a Get Email activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Email folder.
3. Drag the Get Email activity onto the orchestration.
4. Select the activity. The Checklist is displayed.
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Creating, selecting, or editing an email endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Complete theConfiguring the activity steps.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit an email endpoint. For more information, see Creating or editing an email endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields in this pane as described in the following table. In this task, you specify the

regular expressions used to match against the Subject and From fields of polled email messages. A
regular expression must be specified for both of these fields, even if the regular expression is equal to *,
which means that all strings match. In order for a incoming mail to be processed, both the Subject and
the From strings of the mail must match their respective regular expressions. In each of the regular
expression fields, the following wildcards are supported:

* (asterisk) - for zero or more characters
? (question mark) - for zero or one character

Table 1.
Field Description

Subje
ct
matc
hes

Enter a regular expression that matches the subjects of email messages that start an
orchestration job to process the email message. In the regular expression,  you can specify a
combination of characters and wildcards.

From
matc
hes  

Enter a regular expression defines the sender email address of the email messages that start
an orchestration job to process the email message. In the regular expression,  you can specify a
combination of characters and wildcards.

The following table shows some example regular expressions and the result of matching the regular
expressions to sample text.

Table 2.
Regular
Expression

Sample
Text Result

*test* test matches

*test* ttttesttt matches

test test matches

test ttttesttt does not match, has to exactly match the regular expression string:
test

test est does not match, has to exactly match the regular expression string:
test

?est test matches

?est best matches
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Regular
Expression

Sample
Text Result

?est est matches

Specifying the delivery rules

1. Select the Delivery Rules task from the Checklist. The Delivery Rules pane is displayed.
2. Specify the time interval to poll the POP3 server for new email messages:

a. Select a time unit from the menu: seconds, minutes, hours, or days.
b. Specify the amount of time using one of the following input options:

By clicking in the Poll for changes every field and entering a new value.
Using the up and down arrows.

For more information, see Polling interval behavior.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to a POP3 server. The following table defines the retry options

for a connection to an POP3 server:
Table 3.

Field Description

Retry  

1)
Wait
__
secon
d(s)
betwe
en
each
retry.

Specifies the number of seconds that the Integration Appliance waits before trying to
establish a connection to the POP3 server.

2) Try
to
conne
ct __
times
before
failing.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the POP3 server before issuing an error.

If an orchestration that starts with a Get Email activity is deployed and the Integration
Appliance cannot connect to the specified POP3 server, the Integration Appliance logs the
connections errors as warnings in the system log until the retry count value is reached. When
the retry count is reached, the Integration Appliance logs an error in the system log, resets the
connection error count to zero, and continues to attempt to establish a connection to the
POP3 server.

For example, you set the retry count to 3. The first, second, and third connection errors appear
in the system log as Warnings. The Integration Appliance logs the fourth connection error as
an error and resets the connection error count to zero. Therefore, the fifth connection error
generates a warning in the system log. The Integration Appliance continues to attempt to
establish a connection to the POP3 server.

Mapping the output of the activity
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1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane.

2. In this task, you map the mailheader (of type XML) and body (of type string) output parameters to
variables. You must map the output parameters of the activity in order for the orchestration to be valid.
See Creating a map for general instructions on mapping. The mailheader output parameter contains
meta information about the email message, for example the email addresses that the message is being
sent to and the MIME header of the message itself. The body output parameter contains the body of the
email message and associated attachments.
CAUTION:
The order of the attachments and the body in the body output depend on the email client that sent the
message and the type of message (plain text or HTML.).

Note: When using a non-English payload, the mailheader, mimeHeader and otherheaders need to be mapped
into the orchestration in the getEmail activity, and mapped from the orchestration back into the sendMail
activity.
Parent topic: Email Activities
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Send Email activity
An orchestration that contains the Send Email activity is acting as an email client during run time.

The Send Email activity connects to the SMTP server, and sends a message to the server as shown in the
following figure.

Figure 1. 
The steps for adding and configuring a Send Email activity are described in the following procedures.

Adding a Send Email activity to the orchestration
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1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Email folder.
3. Drag the Send Email activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing an email endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Complete the Configuring the activity steps.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit an email endpoint. For more information, see Creating or editing an email endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields in this pane as described in the following table:

Table 1.
Fie
ld Description

Fro
m
Ad
dre
ss

Specifies the sender address for the email message. You must specify the email address using the
standard email format: email@domain.extension. This field is required.

To Specifies the recipient's addresses for the email message. You must specify the email addresses
using the standard email format: email@domain.extension. One or more addresses can be
specified. Separate the addresses with commas or semicolons. You must specify at least one
address. This field is required.

CC Specifies the carbon copy's addresses for the email message. You must specify the email
addresses using the standard email format: email@domain.extension. One or more addresses
can be specified. Separate the addresses with commas or semicolons. This field is optional.

Su
bje
ct

Specifies the subject of the email message.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to an SMTP Server. The following table describes the retry

options for connecting to an SMTP Server:
Table 2.

Field Description

Retry  
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Field Description

1) Wait
___
second
(s)
betwee
n each
retry.

Specifies the number of seconds that the Integration Appliance waits before trying to
establish a connection to the SMTP Server.

2) Try
to
connec
t ___
times
before
failing.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the SMTP Server before issuing an error and stopping the
processing of the current orchestration job.

If you deploy an orchestration that contains an Send Email activity and the Integration
Appliance cannot connect to the specified SMTP Server, the Integration Appliance logs the
connections errors as warnings in the system and orchestration logs until the retry count
value is reached. When the retry count is reached, the Integration Appliance logs an error in
the system and orchestration logs and the stops processing the current orchestration job.

For example, you set the retry count to 3. The first, second, and third connection errors
appear in the system log as warnings. The Integration Appliance logs the fourth connection
error as an error and stops processing the current orchestration job.

 

Mapping the input of the activity

1. Select the Map Inputs task in the Checklist. The input parameters of the activity are displayed in the To
Activity pane.

2. In this task, you map variables to the following input parameters of the activity:
The body input parameter contains the body of the email message and associated attachments.
The body input parameter is of type string. You must map a variable or assign a default value to
the body input parameter.
The optional mailheader input parameter contains meta information about the email message,
for example the email addresses that the message is being sent to and the mimeHeader of the
message itself. The mailheader input parameter is optional, you do not have to map a variable or
assign default values to the mailheader input parameter.

If the optional mailheader input parameter is not listed in the To Activity pane of the Map Inputs
pane, select Map > Show Optional Parameters from the toolbar menu or right-click in the To
Activity pane and select the Show Optional Parameters option. If the Map > Show Optional
Parameters option is not selectable in the toolbar menu, click on a node in the Map Inputs pane
to make this option active.

You can optionally override the settings you specified in the Configure task of the Checklist
dynamically during run time by passing in values from variables into the nodes specified in the
following table. For example during run time, you can override the setting for the From Address
field by mapping a variable to the from node of the mailheader input parameter. During run time,
the value of the variable is the from address in the sent email message.

Table 3.
Nodes of the mailheader
Input Parameter Description

Overrides what settings in
the Configuring task?  
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Nodes of the mailheader
Input Parameter Description

Overrides what settings in
the Configuring task?  

from Specifies the sender address
for the email message. You
must specify the email
address using the standard
email format:
email@domain.extension.

The from node of the
mailheader input parameter
overrides the From Address
field specified in the Configure
task.

to Specifies the recipient
addresses for the email
message. You must specify the
email addresses using the
standard email format:
email@domain.extension.
One or more addresses can be
specified. Separate the
addresses with commas or
semicolons.

The to node of the mailheader
input parameter overrides the
To field specified in the
Configure task.

cc Specifies the carbon copy
addresses for the email
message. You must specify the
email addresses using the
standard email format:
email@domain.extension.
One or more addresses can be
specified. Separate the
addresses with commas or
semicolons.

The cc node of the mailheader
input parameter overrides the
CC field specified in the
Configure task.

subject Specifies the subject of the
email message.

The subject node of the
mailheader input parameter
overrides the Subject field
specified in the Configure
task.

mimeHeader Specifies the MIME header of
the email message.

None.
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Nodes of the mailheader
Input Parameter Description

Overrides what settings in
the Configuring task?  

otherHeaders Specifies an element that
contains a set of MIME
headers as name/value pairs
not already specified in the
mimeHeader node. For
example the MIME header:
Content-Location is not
specified in the MIME header,
so the following headerItem
node could be equal to the
following values:
otherheaders/headerItem/n
ame is equal to Content-
Location
otherHeaders/headerItem/v
alue is equal to the value of
the Content-Location MIME
header, for example the string:
RN-Preamble Multiple MIME
headers can be specified, so
this is a recurring node.

None.

Note: You can use the Write MIME activity to build the contents of the mimeHeader node of the
optional mailheader input parameter. For example, you could add a Write MIME activity to the
orchestration before the Send Email activity and have the Write MIME activity populate the
contents of the mimeHeader XML variable and then passes the mimeHeader variable to the
Send Email activity.

See Creating a map for more information

Note: When using a non-English payload, the mailheader, mimeHeader and otherheaders need
to be mapped into the orchestration in the getEmail activity, and mapped from the orchestration
back into the sendMail activity.
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Testing an SSL email connection
After creating an endpoint for an email server, you must import the CA certificate for the email server into
Studio and then test the SSL connection to the email server.
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About this task

Complete the following procedure to import the email servers CA certificate and then test the SSL connection
to the email server:

Procedure

1. Open a command window.
2. Navigate to the email server, and locate the certificate file ca-cert stored in the server.
3. Copy this file and then navigate to the workstation where Studio is installed.
4. Using the command window, paste the ca-cert copy in the home directory of Studio: C:\Program

Files\IBM\WebSphere Cast Iron Studio x.x.x
5. Browse to the security directory of Studio: C:\Program Files\IBM\WebSphere Cast Iron Studio

x.x.x\security
6. Run the following command to import the ca-cert file into Studio: ..\jre\bin\keytool.exe -
import -v -keystore cacerts -storepass changeit -file ..\castiron_ca_cert.pem -
alias alias_name  Where alias_name is the alias of the email servers CA certificate.

7. When you are prompted for a yes or no, enter 'Y'.
8. Exit the command window.
9. Open the endpoint for the email server.

10. Verify the following login credentials for the email connection: Email server, Port, User, and Password.
11. Click Test Connection.
12. If the connection is successful, use this endpoint in Studio orchestrations, then use the Verify tab

features to evaluate the orchestration.
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Force.com Bulk API Activities
Preparing Data for the Force.com Bulk API connector
The Force.com Bulk API connector supports both XML and CSV input data. Following are the details to
prepare data for these formats.
Creating a Force.com Bulk API endpoint
Force.com Bulk API endpoints contain the connection information that studio and the Integration
Appliance use to connect to the Salesforce.com server. You can create multiple endpoints that refer to
separate instances.
Specifying the Retry options for Force.com Bulk API activities
Specifying the Retry parameters is one of the tasks to configure an Force.com Bulk API activity.
Using the Force.com Bulk API Batch Insert activity
Use the Force.com Bulk API Batch Insert activity to insert or create a large number of objects in
Salesforce.com.
Using the Force.com Bulk API Batch Update activity
Use the Force.com Bulk API Batch Update activity to update a large number of objects in
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Salesforce.com.
Using the Force.com Bulk API Batch Upsert activity
Use the Force.com Bulk API Batch Upsert activity to update and insert a large number of objects in
Salesforce.com.
Using the Force.com Bulk API Batch Delete activity
Use the Force.com Bulk API Batch Delete activity to delete a large number of objects in Salesforce.com.
Using the Force.com Bulk API Get Batch Status activity
Use the Force.com Bulk API Get Batch Status activity to get the status of an individual batch or the
status of all the batches that are part of the job in Salesforce.com.
Using the Force.com Bulk API Get Batch Results activity
Use the Force.com Bulk API Get Batch Results activity to retrieve the batch result to check the status of
individual records, when a batch is completed in Salesforce.com.
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Preparing Data for the Force.com Bulk API connector
The Force.com Bulk API connector supports both XML and CSV input data. Following are the details to prepare
data for these formats.

Preparing data for XML input

If you are using the XML data as input to the Force.com Bulk API connector, you can either create an XML
schema, which can be mapped to the Force.com Bulk API activity or directly map from the previous activity's
result to Force.com Bulk API activities.

Preparing data for CSV input

Force.com Bulk API connector supports CSV input data from connector version 2.2. If you have the CSV data,
you can directly map the CSV content to Force.com Bulk API activities. To do so, Force.com Bulk API connector
activities expose two new fields, object and data, in the Map Inputs section. You must map the CSV content
to data field and provide the selected object name in the object field.

Following is the sample for the CSV data, for Account object.

Name,BillingStreet,BillingCity,BillingState,BillingCountry 
XYZ,vvnagara,Bangalore,KA,India

Note:

1. In the CSV data, the first line must contain comma separated field names of the selected object, and
from the second line, the actual data must be populated.

2. The order of the data fields must match that of the header field names.

Parent topic: Force.com Bulk API Activities
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Creating a Force.com Bulk API endpoint
Force.com Bulk API endpoints contain the connection information that studio and the Integration Appliance
use to connect to the Salesforce.com server. You can create multiple endpoints that refer to separate
instances.

About this task

Use this task to create or edit an Force.com Bulk API endpoint.
Note:
Any changes you make to the Force.com Bulk API endpoint, including configuration properties, affects all the
orchestrations that use that endpoint, as the edits are global, not local.

Procedure

1. Drag an activity from the Force.com Bulk API folder in the Activities tab to the Orchestration window.
The Summary panel is displayed.

2. Click Pick Endpoint from the Checklist. The Pick Endpoint panel is displayed.
3. Click one of the following buttons:

a. Browse - To select an existing endpoint from Project Explorer. The Project Explorer shows all the
endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel.

b. New - To create a new endpoint. The Create Endpoint window opens.
c. Edit - To edit the existing endpoint. The Edit Endpoint window opens.

4. Complete the fields defined in the following table:
Table 1. Connection Details

Field Name Description

Connection Details

User Name Specifies the user name to connect to the Salesforce.com server.

Password Specifies the password associated with the user name to connect to the
Salesforce.com server.

URI Specifies the host URI of the Salesforce.com instance

5. When finished, click Test Connection to confirm that you can connect to the Force.com Bulk API system.
6. Click OK.

Parent topic: Force.com Bulk API Activities
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Specifying the Retry options for Force.com Bulk API activities
Specifying the Retry parameters is one of the tasks to configure an Force.com Bulk API activity.

About this task

Use this task to configure the retry options for configuring Force.com Bulk API activities. The Force.com Bulk
API connector uses a single login session for all connections to a Force.com Bulk API endpoint. If a session
expires, the connector automatically establishes a new session. The connector does not count the initial
attempt to reacquiring the session as a retry attempt. The connector assumes the typical connector retry
behavior after the initial attempt to reacquire a session fails.

Procedure

1. Select the Retry task from the Checklist. The retry pane is displayed.
2. Configure the retry and timeout options for connecting to an Force.com Bulk API instance, as described

in the following table:
Table 1. Retry options

Retry
Fields Description

Wait __
second(
s)
between
each
retry.

Specifies the number of seconds that the Integration Appliance waits before trying to
establish a connection to the Force.com Bulk API instance.

Try to
connect
__ times
before
failing.

Specifies the retry count — the maximum number of times the Integration Appliance
attempts to establish a connection to the Force.com Bulk API instance before issuing an
error and stopping the processing of the current orchestration job.
Note: If you deploy an orchestration that contains the Force.com Bulk API activity and the
Integration Appliance cannot connect to the specified Force.com Bulk API instance, the
Integration Appliance logs the connections errors as Warnings in the system and
orchestration logs until the retry count value is reached. When the retry count is reached,
the Integration Appliance logs an Error in the system and orchestration logs and stops
processing the current orchestration job. For example, you set the retry count to 3, the first,
second, and third connection errors appear in the system log as warnings. The Integration
Appliance logs the fourth connection error as an error and stops processing the current
orchestration job.

Activity
Timeout
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Retry
Fields Description

Timeout
after
____
second(
s) when
the
endpoint
does not
respond
to a
request.

Specifies the number of seconds the Integration Appliance waits before timing out, when
the endpoint does not respond to a request. The default is 300 seconds.
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Using the Force.com Bulk API Batch Insert activity
Use the Force.com Bulk API Batch Insert activity to insert or create a large number of objects in
Salesforce.com.

About this task

Use this task to insert or create a large number of objects in Salesforce.com. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Force.com Bulk API folder contents.
2. Drag the Batch Insert activity icon onto the orchestration. The Force.com Bulk API Batch Insert

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Force.com Bulk API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating a Force.com Bulk API endpoint.
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8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Force.com Bulk API window is displayed.
11. In Browse Force.com Bulk API, you can either filter the object type by specifying the object type in the

Search for an object type field, or select the object type from the object type list. Click OK. The object
field preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying the Retry options for Force.com Bulk API activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Batch Insert activity are displayed as nodes under the request input parameter in the To Activity panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Force.com Bulk API Batch Insert activity.
Parent topic: Force.com Bulk API Activities
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Using the Force.com Bulk API Batch Update activity
Use the Force.com Bulk API Batch Update activity to update a large number of objects in Salesforce.com.

About this task

Use this task to update a large number of objects in Salesforce.com. The call to this activity is a synchronous
call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure
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1. In an active orchestration, open the Activities tab and expand the Force.com Bulk API folder contents.
2. Drag the Batch Update activity icon onto the orchestration. The Force.com Bulk API Batch Update

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Force.com Bulk API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating a Force.com Bulk API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Force.com Bulk API window is displayed.
11. In Browse Force.com Bulk API, you can either filter the object type by specifying the object type in the

Search for an object type field, or select the object type from the object type list. Click OK. The object
field preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying the Retry options for Force.com Bulk API activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Batch Update activity are displayed as nodes under the request input parameter in the To Activity panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Force.com Bulk API Batch Update activity.
Parent topic: Force.com Bulk API Activities
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Using the Force.com Bulk API Batch Upsert activity
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Use the Force.com Bulk API Batch Upsert activity to update and insert a large number of objects in
Salesforce.com.

About this task

Use this task to update and insert a large number of objects in Salesforce.com. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Force.com Bulk API folder contents.
2. Drag the Batch Upsert activity icon onto the orchestration. The Force.com Bulk API Batch Upsert

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Force.com Bulk API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating a Force.com Bulk API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Force.com Bulk API window is displayed.
11. In Browse Force.com Bulk API, you can either filter the object type by specifying the object type in the

Search for an object type field, or select the object type from the object type list. Click OK. The object
field preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying the Retry options for Force.com Bulk API activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Batch Upsert activity are displayed as nodes under the request input parameter in the To Activity panel.
Note: The externalIDFieldName identifies whether a record must be updated or inserted. If you specify a
value for the externalIDFieldName, then the record is updated in Salesforce.com. If there is no value set
for externalIDFieldName, a record is inserted in Salesforce.com.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Force.com Bulk API Batch Upsert activity.
Parent topic: Force.com Bulk API Activities
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Using the Force.com Bulk API Batch Delete activity
Use the Force.com Bulk API Batch Delete activity to delete a large number of objects in Salesforce.com.

About this task

Use this task to delete a large number of objects in Salesforce.com. The call to this activity is a synchronous call
where the input data is sent to the activity for processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Force.com Bulk API folder contents.
2. Drag the Batch Delete activity icon onto the orchestration. The Force.com Bulk API Batch Delete

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Force.com Bulk API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating a Force.com Bulk API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Batch
Delete activity are displayed as nodes under the request input parameter in the To Activity panel.
Note: The input data for the delete activity is a list of IDs and the object name. All the objects that match
the object name and ID are deleted from Salesforce.com.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity is
displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results
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You have configured the Force.com Bulk API Batch Delete activity.
Parent topic: Force.com Bulk API Activities
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Using the Force.com Bulk API Get Batch Status activity
Use the Force.com Bulk API Get Batch Status activity to get the status of an individual batch or the status of all
the batches that are part of the job in Salesforce.com.

About this task

Use this task to get the status of an individual batch or the status of all the batches that are part of the job in
Salesforce.com. The call to this activity is a synchronous call where the input data is sent to the activity for
processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Force.com Bulk API folder contents.
2. Drag the Get Batch Status activity icon onto the orchestration. The Force.com Bulk API Get Batch Status

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Force.com Bulk API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating a Force.com Bulk API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get
Batch Status activity are displayed as nodes under the request input parameter in the To Activity panel.
Note: The Bulk API activities return JobInfo, which contains JobId. The job ID can be used to invoke the
getBatchStatus or getBatchResult activities.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.
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12. Create a map between the output parameters and orchestration variables.

Results

You have configured the Force.com Bulk API Get Batch Status activity.
Parent topic: Force.com Bulk API Activities
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Using the Force.com Bulk API Get Batch Results activity
Use the Force.com Bulk API Get Batch Results activity to retrieve the batch result to check the status of
individual records, when a batch is completed in Salesforce.com.

About this task

Use this task to retrieve the batch result to check the status of individual records, when a batch is completed in
Salesforce.com. The call to this activity is a synchronous call where the input data is sent to the activity for
processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Force.com Bulk API folder contents.
2. Drag the Get Batch Results activity icon onto the orchestration. The Force.com Bulk API Get Batch

Results Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Force.com Bulk API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating a Force.com Bulk API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get
Batch Results activity are displayed as nodes under the request input parameter in the To Activity panel.
Note: The Bulk API activities return JobInfo, which contains JobId. The job ID can be used to invoke the
getBatchStatus or getBatchResult activities.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
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During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the Force.com Bulk API Get Batch Results activity.
Parent topic: Force.com Bulk API Activities
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FTP Activities
Creating or Editing an FTP endpoint
FTP endpoints provide the connection information that Studio and the Integration Appliance use to
connect to FTP Servers.
Configuring the FTP endpoint for the Parse Directory Listing Example
To run the Parse Directory Listing Example in your environment, configure the values of the configuration
properties used by the FTP Endpoint to point to your FTP Server. In addition, your FTP Server must
produce the directory listing in the same format as expected by the Flat File Schema.
FTP Poll Directory activity
During run time, the FTP Poll Directory activity connects to FTP Server and polls for the existence of the
specified file or files at the specified location. After reading the contents of the file or files and mapping
the contents into variable or variables of the orchestration, the FTP Poll Directory activity may delete
the file or files, move the file or files, or leave the file or files in the directory of the FTP Server.
FTP Put File activity
During run time, the FTP Put File activity takes data from variables of the orchestration, places the data
into a file, and connects to an FTP Server and places the file in the specified directory location.
FTP Get File activity
During run time, the FTP Get File activity connects to an FTP Server and attempts to get a single file at
the specified location. You can configure the FTP Get File activity to return the contents of the file into a
variable of the orchestration.  In addition, you can configure the FTP Get File activity to return the
timestamp of the file returned by the FTP Server into a variable of the orchestration.
FTP Delete File activity
Use the the FTP Delete File activity to delete specific files from the specific directories, during run time.
FTP List Files activity
During run time, the FTP List Files activity connects to an FTP Server and generates a list of files from
the specified directory location using the specified regular expression. The FTP List Files activity returns
the list of files to the orchestration using either the directoryListing or fileListing output parameter.
FTP Rename File activity
Use the FTP Rename File activity to rename and/or move a file to a different directory, during run time.

 297



Parse directory listing example
This example gets a directory listing from and FTP directory using the FTP List Files activity, parses the
long directory listing using Flat File Scheme, iterates through the list of files, based on the properties of
each file.
Testing an FTPS server connection
After successfully running a "test connection", you can use Studio verify tools on FTPS orchestrations
before publishing a project.
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Creating or Editing an FTP endpoint
FTP endpoints provide the connection information that Studio and the Integration Appliance use to connect to
FTP Servers.

1. In the Create Endpoint or Edit Endpoint pane, configure the fields as described in the following table.
Note: Changing the configuration properties of an endpoint affects all orchestrations that use that
endpoint in the project as the edits are global, not local.

2. When you had entered the field values, click Test Connection to confirm that you can connect to the FTP
Server.

3. Click OK.

Table 1.
Field
Name Description

Locatio
n

 

Host
Name

Specifies the Host Name or IP address for the FTP Server.

Port Specifies the port number for the specified host name. The default is 21, the standard port for FTP
traffic. The default port for SFTP traffic is 22.

Login Description

Log into
the
Server
as an
Anonym
ous
User

This option is only available with the Normal FTP option. Select this option only if the FTP Server
allows anonymous logins (where a user account is not required).
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Field
Name Description

Log into
the
Server
with
User
Name
and
Passwor
d

Select this option to specify a user account to log in into the FTP Server. Enter the user name and
password for the account used to connect to the FTP Server.

Securit
y

Description

Normal
FTP

Select the Normal FTP option for an unsecured connection.

Secure
FTP

Select the Secure FTP option to secure the communication between the Integration Appliance and
the FTP Server by sending and receiving the data over SSH. The SSH File Transfer Protocol (SFTP) is
a network protocol that provides file transfer over a reliable data stream.
Note: Certificate authentication for SFTP is not supported.

FTPS Select the FTPS option to secure the communication between the Integration Appliance and the
FTP Server using the SSL protocol. The SSL protocol supports mutual authentication between the
Integration Appliance and FTP Server using an authenticated and encrypted connection. Choose
one of the following authentication modes:

Implicit
Explicit (SSL) - Starts an FTP session and uses SSL security to authenticate an endpoint and
encrypts data before transfer.
Explicit (TLS) - Starts an FTP session and uses TLS security to authenticate the endpoint and
encrypts data before transfer.

Important: Before you can deploy a project using FTPS, you must upload and register a certificate
on the Integration Appliance. For more information about uploading and registering a certificate,
see the CLI Command Reference.

Client
Certifica
te Alias
Name

When the FTPS server is configured to authenticate a client, select this option and specify a client
certificate alias name. By default, when you select the Client Certificate Alias Name option, Studio
provides the following name: Factory Supplied Identity

The client certificate alias name that you specify in this field should match the value you specified
for the client certificate name using the Cast Iron® command line interface (CLI), when you
uploaded or imported the certificate. In the CLI, if you mapped the client certificate name to the
default alias name, accept the default name that Studio provides and configure the Connection
Timeout for the endpoint.

FTP
Mode

Description
If your FTP Server supports Active mode transfers, you can configure an FTP endpoint in Studio to
use the Active mode to transfer data to and from an FTP Server and the Integration Appliance. By
default, FTP endpoints support passive mode transfers.
Note: Active mode is not supported for SFTP.

Active
FTP

Select this option to enable the Active mode. When you enable the Active mode option, you can
specify the external IP and port range for incoming connections.  By default, this option is not
selected and the FTP endpoint supports passive mode transfers.
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Field
Name Description

External
IP

(Optional) Specifies the client IP address from which the FTP Server will respond to connection
attempts.

Port
Range/S
tart Port

(Optional) Specifies the lowest port number of the predetermined range assigned to incoming
connections. If you enter a start port number, you must also enter the end port number.
Important: This number cannot be less than 1024.

Port
Range/E
nd Port

(Optional) Specifies the highest port number of the predetermined range assigned to incoming
connections. If you enter an end port number, you must also enter the start port number.
Important: This number cannot be greater than 65535.

Connect
ion
Timeout

Description

Time
out after
___
second(
s) when
establis
hing a
connecti
on to
the
Endpoin
t.

The number of seconds before a timeout occurs between the Integration Appliance attempting to
establish a connection to the endpoint and the time it takes for the endpoint to respond to the
connection request. For an FTP activity, the amount of time the Integration Appliance attempts to
establish a connection to the FTP Server before timing out. A connection timeout is different from
an activity timeout because an activity timeout occurs after the connection to the endpoint has
already been established. An activity timeout specifies the amount of time in seconds before a
timeout occurs between the activity invoking a request on an endpoint and the time it takes the
endpoint to respond.  You set the activity timeout in Retry task of the following FTP activities:

FTP Poll Directory activity
FTP Put File activity
FTP Get File activity
FTP Delete File activity
FTP List Files activity
FTP Rename File activity

Note: For some of the fields in the endpoint, you can define configuration properties to supply the values for
these fields.  The

icon is displayed when you click in a field that supports a configuration property and a configuration property of
the same type has already been configured for the project.
Parent topic: FTP Activities
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Configuring the FTP endpoint for the Parse Directory Listing
Example
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To run the Parse Directory Listing Example in your environment, configure the values of the configuration
properties used by the FTP Endpoint to point to your FTP Server. In addition, your FTP Server must produce the
directory listing in the same format as expected by the Flat File Schema.

About this task

Complete following steps only if you plan on running the Parse Directory Listing Example:

To edit and test the FTP configuration properties of the FTPParseDirListingExample in Studio
To configure the root directory of the FTP Server
To determine if your FTP Server generates the file listing in the same format as the Flat File Schema
included in this example
To run the FTPParseDirListingExample

To only view and learn more about the example, complete the procedure in the Parse Directory Listing Example
section.

Edit and test the FTP configuration properties of the FTPParseDirListingExample in Studio: 

Procedure

1. Open FTPParseDirListingExample. For instructions see steps 1-2 in Parse Directory Listing Example.
2. From the toolbar menu, select Project > Configuration Properties. The Configuration Properties dialog

box is displayed.
3. Edit the values of the properties to reflect your FTP Server.
4. In the Project tab, double-click the FTP Endpoint. The FTP Endpoint tab is displayed.
5. To verify that you entered the correct FTP information, click Test. If Studio connects to your FTP

Endpoint, an Information dialog box is displayed with the message that you have successfully connected
to the endpoint.

6. In the Project tab, double-click on the processBids orchestration. The processBids orchestration tab is
displayed.

What to do next

Configure the root directory of the FTP Server:

1. Add the additional directories to your FTP Server. Mirror the directory structure and also provided in the
FTPServerDirStructure directory. If you accepted the defaults during the installation of Studio, this
directory is located in the following location: C:\Program Files\IBM\WebSphere Cast Iron Studio
3.X\Samples\FTPParseDirListing\FTPServerDirStructure
During run time, the Parse Directory Listing Example expects the root directory of the FTP Server to
contain the following directory structure:

\input 
\processFailed 
\processWidgetRUs 
\processAcmeInc 
\processNewCompany

2. Move a copy of the bid*.txt files to the \input directory on your FTP Server. If you accepted the defaults
during the installation of Studio, these files provided in the following directory location: C:\Program
Files\IBM\WebSphere Cast Iron Studio 3.X\Samples\FTPParseDirListing\FTPServerDirStructure\input
Before running the example, a copy of the following files must be located in the \input directory of the
FTP Server.

bidAcmeInc.txt
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bidCrankCo.txt
bidWidgetRUs.txt
bidBudgetManufacture.txt
bidSamAndSons.txt

Determine if your FTP Server generates the file listing in the same format as the Flat File Schema included in
this example:

1. Open FTPParseDirListingExample. For instructions see steps 1-2 in Parse Directory Listing Example.
2. In the Project tab, double-click the processBids orchestration. The processBids orchestration tab is

displayed.
3. Click the FTP List Files activity labeled List Files Full Dir Listing.
4. Click Test.
5. Determine if the format of the directory listing matches the following directory listing:

-rw-r--r--   1 551      551            65 May  3 11:39 bidAcmeInc.txt 
-rw-r--r--   1 551      551            43 May  3 11:39 bidBudgetManufacture.txt 
-rw-r--r--   1 551      551             0 May  3 11:39 bidCrankCo.txt 
-rw-r--r--   1 551      551            73 May  3 11:39 bidSamAndSons.txt 
-rw-r--r--   1 551      551            33 May  3 11:39 bidWidgetRUs.txt

If the directory format is different, you can alter the Flat File Schema called parseDirListing.

CAUTION:
Changing the nodes of the Flat File Schema may affect other entities in the orchestration. You may need to
update the orchestration to reflect these changes.
For more information, see Flat File Schema Editor Overview.

To open the Flat File Schema used in this example, in the Project tab, double-click on the parseDirListing in the
Flat File Schema folder. Copy and paste the output of the Test button of the FTP List Files activity to a file and
then open the file in the Test tab of the Flat File Schema Editor. Change the nodes of the Flat File Schema to
reflect the directory listing. The size node is used by the "If size less or equal 0" branch of the If..Then activity.
Make sure a value is provided for the size node during run time.

Run the FTPParseDirListingExample:

1. From Studio, publish the FTPParseDirListingExample project. From the Studio toolbar, select File >
Publish Project... .

2. From the Web Management Console (WMC), deploy the FTPParseDirListingExample project. For more
information, see the WMC Online help or Step 11: Publish and Deploy the Completed Integration Project
in the Developing the BookOrder Project section of the Getting Started Guide.

Parent topic: FTP Activities
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FTP Poll Directory activity
During run time, the FTP Poll Directory activity connects to FTP Server and polls for the existence of the
specified file or files at the specified location. After reading the contents of the file or files and mapping the
contents into variable or variables of the orchestration, the FTP Poll Directory activity may delete the file or
files, move the file or files, or leave the file or files in the directory of the FTP Server.

The FTP Poll Directory activity is a starter activity. When an orchestration that starts with an FTP Poll Directory
activity is deployed to the Integration Appliance, the Integration Appliance polls for file or files to be added to a
specific directory on the FTP Server. When a file or files is shown on the FTP Server, an orchestration job is
started to processes the file or files and the rest of the activities in the orchestration. For more information, see
Polling Interval Behavior. For an example of an orchestration using the FTP Poll Directory activity, see the
Getting Started Guide.

Depending on your application requirements, you can process a list of files in an FTP directory using one of the
following methods:

For some cases, you can use only the FTP Poll Directory activity to process a set of files found in an FTP
directory.
In other cases, you must use the FTP List Files activity in conjunction with the FTP Get File, FTP Put
File, FTP Delete File, and FTP Rename File activities.

Use the FTP Poll Directory activity to process a set of files found in an FTP directory when the following
conditions are true:

The FTP Poll Directory activity supports the format of the directory listing of your FTP Server. - The
format of directory listings are different for the FTP Servers supported on different operating systems.
The FTP Poll Directory activity supports many types of FTP Servers but if the directory listing format
your FTP Server cannot be parsed by the FTP Poll Directory activity, use the FTP List Files activity with
a Flat File Schema and the FTP Get File, FTP Put File, FTP Delete File, and FTP Rename File activities,
to provide the same functionality as the FTP Poll Directory activity as shown in the Parse Directory
Listing Example: Parse directory listing example.
After reading each file in the list, each file in the list can be post-processed with the same action. -
For example, while processing a set of files from a FTP directory, if each file in the list can be moved to
the same directory, you can use the FTP Poll Directory activity to process the set of files. If however,
you need to process a different action based on the properties of a file, you must use the FTP List Files
activity in conjunction with the FTP Get File, FTP Put File, FTP Delete File, and FTP Rename File
activities. For example, if you must move files to different directories based on the filename, use the FTP
List Files activity in conjunction with the FTP Get File, FTP Put File, FTP Delete File, and FTP Rename
File activities as shown in the Parse Directory Listing Example: Parse directory listing example.

Symbolic links

The support for symbolic links by the FTP Poll Directory activity during run time is dependent on the following
factors:  

The types of symbolic links supported by operating system that hosts the FTP Server.
The types of symbolic links supported by the FTP Server itself.
The types of symbolic links supported by the FTP Poll Directory activity, as listed in the following table:

Table 1.
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Symbo
lic
Links
to...

Hard
Symbol
ic Links

Soft
Symbo
lic
Links Notes®

Symbo
lic
Links
to...

Hard
Symbol
ic Links

Soft
Symbo
lic
Links Notes®

Files Not
Suppor
ted

Not
Suppor
ted

The FTP Poll Directory activity does not interpret symbolic links to files as
files and therefore symbolic links to files are not processed by the FTP Poll
Directory activity during run time.

Directo
ries

Suppor
ted

Suppor
ted

 

To determine the specific symbolic link support for a specific FTP Server on a specific operating system, see
your operating system and FTP Server documentation.

Persistence

You should enable persistence for the FTP Poll Directory activity:

If you have an orchestration job with a FTP Poll Directory activity that is processing large input files.
Otherwise, you can experience problems like "Variable 'Lotdata' is too large, please turn on persistence
for this orchestration".
If you disable persistence and have an orchestration job with a FTP Poll Directory activity with the Keep
in place option selected, and during run time if a failure occurs that causes the job to stop, when the
orchestration is restarted it processes the file again. The state of the job is lost and Integration
Appliance does not know that it has already processed the file.

For more information, see Enabling persistence.

Processing subdirectories with the Microsoft FTP Endpoint

For the Microsoft IIS (Internet Information Services) FTP Endpoint, the run time behavior of the FTP Poll
Directory activity when processing subdirectories and the files in subdirectories depends on the regular
expression specified in the File Named field of the Configure task of the activity, as described in the following
cases:

When the regular expression is equal to the string: *, the orchestration job processes the subdirectories
in the specified directory.
When the regular expression is equal to the string: *.*, the orchestration job does not process the
subdirectories in the specified directory.
When the regular expression is blank, the orchestration job does not process the subdirectories in the
specified directory

.

Adding an FTP Poll Directory activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the FTP folder.
3. Drag the Poll Directory activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing an FTP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
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Select an existing endpoint:
a. Select Browse. The Project Explorer is displayed.

CAUTION:
Specifying a new FTP endpoint with a different directory structure than the original FTP
endpoint can cause the orchestration job to fail during run time. You must either specify a
new FTP Server that matches the directory structure of the originally specified FTP Server
or change the configured directory of the In Directory field by clicking Browse as described
in the "Configure the activity" procedure.

b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.
Select an existing endpoint and edit the endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.

CAUTION:
Specifying a new FTP endpoint with a different directory structure than the original FTP
Endpoint can cause the orchestration job to fail during run time. You must either specify a
new FTP Server that matches the directory structure of the originally specified FTP Server
or change the configured directory of the In Directory field by clicking Browse as described
in the "Configure the activity" procedure. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit an FTP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields in this pane as described in the following table:

Table 2.
Fi
el
d Description

Fi
le
N
a
m
e
d

Specifies a pattern or regular expression that defines the filename or filenames to get from the FTP
Server. The processing of the regular expression is done by the FTP Server. For more information,
see the FTP Server documentation on regular expressions . Typically, FTP Servers support the
following wildcards in their regular expressions:

* - zero or more characters
? - zero or one character

Note: Because the processing of the regular expression is done on the FTP Server, the case
sensitivity is determined by FTP Server. If the FTP Server is case sensitive, the file matching done
by the FTP Poll Directory activity is also case sensitive.

In
Di
re
ct
or
y

Specifies the directory where the Integration Appliance looks for files on the FTP Server. You can
specify a directory using one of the following options:

Directly enter directory path by clicking in the field and typing in one of the following
directory paths:

Relative directory path, for example: input.  (Assumes that FTP home has been
configured for the user account that connects to the FTP Server. See "Note" for more
information.)
Complete directory path, for example on a UNIX machine: /home/user/input.

Click Browse... to populate the drop-down list of available directories. Select the appropriate
directory from the drop-down list.

Note: UNIX: If you specify a relative directory path when connecting to an FTP Server on a UNIX
machine, verify that the FTP home directory has been correctly specified in the /etc/password file
for the user account connecting to the FTP Server.
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Fi
el
d Description

T
e
st

After a regular expression has been specified in the File Named field and the directory to look for
files on the FTP Server has been specified in the In Directory field, click Test to test the regular
expression against the set of files in the specified directory on the FTP Server. A dialog box will
appear listing any matching files.

O
f
T
y
p
e

Specifies how to read in the contents of the file - either as binary data or encoded text. If the Text
option is selected, set the encoding type using one of the following options:

From the encoded with drop-down list, select one of the default encoding types.  
Enter your encoding type directly by clicking in the encoded with field and typing in your
encoding type.

Note: Some double-byte characters are not converted using the SHIFT-JIS encoding. For more
information, see Using the Shift-JIS encoding.

  CAUTION:
You must specify the Transfer as Text (ASCII) option for FTP activities when retrieving text files and
placing text files on an FTP Server for Endpoints that manipulate text data while transferring data
from/to the FTP endpoint in ASCII mode. For example, mainframe and DOS FTP Endpoints
manipulate ASCII data when passing data in ASCII mode. For example, if your orchestration
retrieves ASCII files using the FTP Poll Directory activity and places ASCII files using the FTP Put
File activity to a mainframe FTP Server, you must specify the options in the following tasks in
Studio:

In the Configure task of an FTP Poll Directory activity, for the Of Type field select the Text
option.
In the Delivery Rules task of an FTP Poll Directory activity, for the File Transfer Type field
select the Transfer as Text (ASCII) option.
In the Configure task of an FTP Put File activity, for the Of Type field select the Text option.
In the Delivery Rules task of an FTP Put File activity, for the File Transfer Type field select
the Transfer as Text (ASCII) option.

Af
te
r
re
a
di
n
g
th
e
fil
e

Delete it - Delete the file after the file has been read.

Move to directory - Move the file to the specified directory after the file has been read.

Specify the directory that the file is moved to during run time, using one of the following options:
Directly enter a directory path by clicking in the field and typing in one of the following
directory paths:

Relative directory path, for example: input/.  (Assumes that FTP home has been
configured for the user account that connects to the FTP Server. See "Note" for more
information.)
Complete directory path, for example on a UNIX machine: /home/user/input/.

Click Browse... to populate the drop-down list of available directories. Select the appropriate
directory from the drop-down list.
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Fi
el
d Description

  Attention: Specify the directory separator after the last listed directory name. For example, to move
a file to the processed/acme directory in a relative path, specify the following directory in the Move
to directory field: processed/acme/
Optional - Specify the format of the file name after it has been renamed. From the Pattern drop-
down list, select the desired pattern. To specify the character used to separate the sub-fields in the
file name, enter a character in the Pattern Separator field. Specify the run time behavior when a file
with the same file name exists:

Select the Overwrite check box to specify that the existing file should be overwritten if a file
with the same name already exists.
Clear the Overwrite check box to specify that the existing file should not be overwritten if a
file with the same name already exists.

Note: The first time the FTP Poll Directory activity polls during run time, if the activity is unable to
move the file because the specified move to directory does not exist, a warning is logged (not an
error) to the Web Management Console (WMC) and the file stays in place. For all subsequent polls,
the activity does not attempt to move the same file and an info level message is logged to the WMC
stating that the file has already been processed.

Keep in place - Leave the file in the input directory after the file has been read.

A
d
v
a
n
c
e
d
O
p
ti
o
n
s

Description

D
u
pl
ic
at
e
Li
st
Si
z
e

Size of the internal list used by the Integration Appliance to keep track of which files on the FTP
Server have been polled or not. The default value is 10000. You should only specify a size larger
than the default.

Specifying the delivery rules

1. Select the Delivery Rules task from the Checklist. The Delivery Rules pane is displayed.
2. Specify the time interval to poll for the files on the FTP Server:
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a. Select a time unit from the drop-down menu: seconds, minutes, hours, or days.
b. Specify the amount of time by clicking in the Polling Interval field and entering a value or using

the up and down arrows.
For more information, see Polling interval behavior.

3. If security is not enabled for the FTP endpoint, the Transfer as Text (ASCII) and Transfer as Binary
(BINARY) options are enabled in the Delivery Rules task. If security is enabled for the FTP Endpoint, the
file transfer type is always binary.
Select the type of file transfer between the Integration Appliance and the FTP Server from one of the
following options:

Transfer as Text (ASCII) - Only seven bits of each character in the file is transferred from the FTP
Server to the Integration Appliance. This option is used for transferring ASCII files such as HTML
and text files. WARNING: Using this option with binary files can result in a loss of data.
Transfer as Binary (BINARY) - All eight bits of each byte in the file is transferred from the FTP
Server to the Integration Appliance.  This option is used for transferring binary files.
Note: Setting the transfer mode in the Delivery Rules task is equivalent to setting the transfer
mode via a command line session with an FTP Server using the following commands:

ascii
binary

Note: Cast Iron FTP connector SFTP endpoint supports only client side SFTP protocol version 3. Hence,
the SFTP protocol does not support ASCII/text mode file transfer. Make sure to set the File Transfer
Type to Transfer as Binary (BINARY) in the Checklist > Delivery Rules.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to an FTP Server. The following table defines the retry options

for a connection to an FTP Server:
Table 3.

Fiel
d Description

Retr
y

 

1)
Wait
__
seco
nd(s
)
betw
een
each
retry
.

The number of seconds that the Integration Appliance waits before trying to establish a
connection to the FTP Server.
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Fiel
d Description

2)
Try
to
conn
ect
__
time
s
befo
re
failin
g.

Specifies the retry count - the maximum number of times the Integration Appliance attempts to
establish a connection to the FTP Server before issuing an error. If an orchestration that starts
with an FTP Poll Directory activity is deployed and the Integration Appliance cannot connect to
the specified FTP Server, the Integration Appliance logs the connection errors as warnings in the
system log until the retry count value is reached. When the retry count is reached, the
Integration Appliance logs an error in the system log, resets the connection error count to zero,
and continues to attempt to establish a connection to the FTP Server.

For example, you set the retry count to 3. The first, second, and third connection errors appear
in the system log as warnings. The Integration Appliance logs the fourth connection error as an
error and resets the connection error count to zero. Therefore, the fifth connection error
generates a warning in the system log. The Integration Appliance continues to attempt to
establish a connection to the FTP Server.

Mapping the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane as listed in the following table:

Table 4.
Out
put
Par
am
ete
r Description

file
na
me

Provides the name of the file found on the FTP Server.

dat
a

Provides the contents of the file.

tim
est
am
p

Provides the date and time as a string in the XML Schema dataType format (YYYY-MM-
DDhh:mm:ss, where YY is the year, MM is the month, DD is the day, hh is the timezone, mm is the
minutes, and ss is the seconds.)
Note: If the timestamp output parameter is mapped in the Map Outputs task but the MDTM
(return the modification time of a file) functionality is not available or is not enabled for the FTP
Server, during run time the orchestration will stop processing due to this error. A warning is
generated and the Epoch date (1/1/1970) is returned in the timestamp output parameter.

2. You are not required to map the output parameters of the activity. See Creating a map for general
instructions on mapping.  
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FTP Put File activity
During run time, the FTP Put File activity takes data from variables of the orchestration, places the data into a
file, and connects to an FTP Server and places the file in the specified directory location.

For an example of using the FTP Put File activity, see the Getting Started Guide.

Transfer interruption

The file transfer done by the FTP Put File activity during run time is non-transactional and therefore is not
guaranteed. For example, if an FTP Put File activity transfers a file from the Integration Appliance to an FTP
server and the transfer of the file is interrupted because the Integration Appliance is rebooted, it is not
guaranteed that the entire file is transferred.

Symbolic link

The FTP Put File activity supports symbolic links to directories if the symbolic links to directories are supported
by the operating system that hosts the FTP Server and the symbolic links to directories are supported by the
FTP Server itself. To determine the specific symbolic link support for a specific FTP Server on a specific
operating system, see your operating system and FTP Server documentation.

Adding an FTP Put File activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the FTP folder.
3. Drag the Put File activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing an FTP endpoint

1. Click Pick Endpoint task from the Checklist and choose one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
Attention: Specifying a new FTP Endpoint with a different directory structure than the
original FTP Endpoint can cause the orchestration job to fail during run time. You must
either specify a new FTP Server that matches the directory structure of the originally
specified FTP Server or change the configured directory of the In Directory field by clicking
Browse as described in the To configure the activity procedure.

b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.
Select an existing endpoint and edit the endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.

Attention: Specifying a new FTP Endpoint with a different directory structure than the
original FTP Endpoint can cause the orchestration job to fail during run time. You must
either specify a new FTP Server that matches the directory structure of the originally
specified FTP Server or change the configured directory of the In Directory field by clicking
Browse as described in the "Configure the activity" procedure.

c. Click Edit. The Edit Endpoint pane is displayed.
Create a new endpoint: Select New. The Create Endpoint pane is displayed.
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2. Create or edit an FTP endpoint: Creating or Editing an FTP endpoint

Specifying the delivery rules

1. Select the Delivery Rules task from the Checklist. The Delivery Rules pane is displayed. If security is
not enabled for the FTP endpoint, the Transfer as Text (ASCII) and Transfer as Binary (BINARY) options
are enabled. If security is enabled for the FTP endpoint, the file transfer type is always binary.

2. Select the type of file transfer between the Integration Appliance and the FTP Server from one of the
following options:

Transfer as Text (ASCII) - This option is used for transferring files such as HTML, XML, and other
text files. Line endings are converted as required and other text file conventions are followed.
CAUTION:
Using this option with binary files can result in a loss of data.
Transfer as Binary (BINARY) - This option is used for transferring binary files. Using this option
the Integration Appliance transfers data with no conversions.

Note: Cast Iron FTP connector SFTP endpoint supports only client side SFTP protocol version 3. Hence,
the SFTP protocol does not support ASCII/text mode file transfer. Make sure to set the File Transfer
Type to Transfer as Binary (BINARY) in the Checklist > Delivery Rules.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure the fields in this pane as described in the following table:

Table 1.
Field Description

Save

File Named This field is not used for this activity. You specify the name of the output
file using the filename input parameter of the Map Input task.

In Directory Specifies the directory on the FTP server where the Integration Appliance
places the file generated in this activity. You can specify a directory using
one of the following options:

Directly enter directory path by clicking in the field and typing in
one of the following directory paths:

Relative directory path, for example: /output.  (Assumes
that FTP home has been configured for the user account
that connects to the FTP Server. See "Note" for more
information.)
Complete directory path, for example on a UNIX machine:
/home/user/output.

Click Browse... to populate the drown-down list of available
directories. Select the appropriate directory from the drop-down
list.

Note: UNIX: If you specify a relative directory path when connecting to an
FTP Server on a UNIX machine, verify that the FTP home directory has
been correctly specified in the /etc/password file for the user account
connecting to the FTP Server.
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Field Description

Of Type Specifies how to read in the contents of the file - either as binary data or
encoded text. If the Text option is selected, set the encoding type using
one of the following options:

From the encoded with drop-down list, select one of the default
encoding types.  
Enter your encoding type directly by clicking in the encoded with
field and typing in your encoding type.

Note: Some double-byte characters are not converted using the SHIFT-
JIS encoding. For more information, see Using the Shift-JIS encoding.

  Attention: You must specify the Transfer as Text (ASCII) option for FTP
activities when retrieving text files and placing text files on an FTP Server
for Endpoints that manipulate text data while transferring data from/to
the FTP Endpoint in ASCII mode. For example, mainframe and DOS FTP
Endpoints manipulate ASCII data when passing data in ASCII mode.
For example, if your orchestration retrieves ASCII files using the FTP Poll
Directory activity and places ASCII files using the FTP Put File activity to
a mainframe FTP Server, you must specify the options in the following
tasks in Studio:

In the Configure task of an FTP Poll Directory activity, for the Of
Type field select the Text option.
In the Delivery Rules task of an FTP Poll Directory activity, for the
File Transfer Type field select the Transfer as Text (ASCII) option.
In the Configure task of an FTP Put File activity, for the Of Type
field select the Text option.
In the Delivery Rules task of an FTP Put File activity, for the File
Transfer Type field select the Transfer as Text (ASCII) option.

Options - Select one of the
following options to define
the behavior when a file of
the same name already
exists in the specified
output directory:

Overwrite Existing File if
Duplicate File Name is
Found

Specifies if the file already exists, destroys the contents of the original file
with new data returned from the activity.

Append to Existing File Specifies if the file already exists, keeps the original data in the file and
appends the new data (returned from the activity) to the end of the file.

Raise Error if File with
Duplicate Name is Found

Specifies if the file already exists, keeps the original data in the file,
throws an error, and does nothing with the new data returned from the
activity.
Note: When you select this option, the FTP Put File activity checks if the
file exists on the server before uploading the file. In some FTP servers you
may not have the permission to check if the file exists before uploading it.
This is also referred to as Blind FTP. In such cases, the file is overwritten,
even if you have selected the Raise Error if File with Duplicate Name is
Found option.

Specifying the retry options
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1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to an FTP Server. The following table describes the retry

options for connecting to an FTP Server:
Table 2.

Field Description

Retry

1) Wait
___
second
(s)
betwee
n each
retry.

The number of seconds that the Integration Appliance waits before trying to establish a
connection to the FTP Server.

2) Try
to
connec
t ___
times
before
failing.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the FTP Server before issuing an error and stopping the
processing of the current orchestration job.

If you deploy an orchestration that contains an FTP Put File activity and the Integration
Appliance cannot connect to the specified FTP Server, the Integration Appliance logs the
connections errors as warnings in the system and orchestration logs until the retry count
value is reached. When the retry count is reached, the Integration Appliance logs an error in
the system and orchestration logs and the stops processing the current orchestration job.

For example, you set the retry count to 3. The first, second, and third connection errors are
shown in the system log as warnings. The Integration Appliance logs the fourth connection
error as an error and stops processing the current orchestration job.

Mapping the input of the activity

1. Select the Map Inputs task in the Checklist. The Retry pane is displayed. The input parameters of the
activity are displayed in the To Activity pane.

2. You are not required to map all the input parameters of the activity. The following parameters are the
required:  

filename
data

All other parameters are optional. See Creating a map for general instructions on mapping.  

If the input parameter listed in the following table are not displayed in the To Activity pane of the Map Inputs
pane, select Map > Show Optional Parameters from the toolbar menu or right-click in the To Activity pane and
select the Show Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in
the toolbar menu, click on a node in the Map Inputs pane to make this option active.

You can optionally override the settings you specified in the Configure and Pick Endpoint task of the Checklist
dynamically during run time, using the input parameters defined in the following table.

For example, the directory on the FTP Server where the Integration Appliance places the file generated in this
activity, could be set in the Configure task to the directory called output. During run time, the directory name:
outputXML could be passed into the activity using the directory input parameter. The directory name specified
dynamically during run time overrides the original setting specified in the Configure pane. In this example, the
file would be placed in the outputXML directory.

Table 3.
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Inp
ut
Par
am
ete
r
Na
me
/N
od
e Description Overrides the Setting in Task?

Inp
ut
Par
am
ete
r
Na
me
/N
od
e Description Overrides the Setting in Task?

dir
ect
ory

Specifies the directory on the FTP server where the Integration
Appliance places the file generated in this activity.

The directory input parameter
overrides the In Directory field of the
Configure task.

enc
odi
ng

Specifies how the outgoing data is written out to the file:

If no encoding is required, specify the string: binary .
If encoding is required, specify the encoding type that
should be used to encode the outgoing data, for
example: UTF-8, US-ASCII, ISO_8859-1, EBCDIC-US,
or SHIFT-JIS.

The encoding input parameter
overrides the encoding specified in
 the Of Type field of the Configure task
but if the Binary option is selected in
the Of Type field of the Configure task,
the encoding specified by the encoding
input parameter is ignored.

ove
rwr
ite

Specifies the behavior when a existing file of the same name
already exists in the specified output directory. Specify one of
the following values:

y - Specifies if the file already exists, destroy the
contents of the original file with new data returned from
the activity.
a - Specifies if the file already exists, keep the original
data in the file and append the new data (returned from
the activity) to the end of the file.
n - Specifies if the file already exists, keep the original
data in the file and do nothing with the new data
returned from the activity.

The overwrite input parameter
overrides the Options field of the
Configure task.

con
nec
tio
n/ti
me
out

Specifies the connection timeout - the amount of time in
seconds before a timeout occurs between the Integration
Appliance attempting to establish a connection to the endpoint
and the time it takes for the endpoint to respond to the
connection request. For the FTP Put File activity, the amount of
time the Integration Appliance attempts to establish a
connection to the FTP Server before timing out.  

The timeout node of the connection
input parameter overrides the
Connection Timeout -Time out after
___ second(s) when establishing a
connection to the Endpoint field of the
FTP endpoint.  

con
nec
tio
n/h
ost

Specifies the Host Name or IP address for the FTP server. The host node of the connection input
parameter overrides the Host Name
field of the FTP endpoint.
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Inp
ut
Par
am
ete
r
Na
me
/N
od
e Description Overrides the Setting in Task?

con
nec
tio
n/p
ort

Specifies the port number for the specified host name. The
standard port for FTP traffic is 21. The default port for SFTP
traffic is 22.

The port node of the connection input
parameter overrides the Port field of
the FTP endpoint.

con
nec
tio
n/u
ser
na
me

Specify a user name for the account used to connect to the FTP
Server.

The username node of the connection
input parameter overrides the User
Name field of the FTP endpoint.

con
nec
tio
n/p
ass
wo
rd

Specify a password for the account used to connect to the FTP
Server.

The password node of the connection
input parameter overrides the
Password field of the FTP endpoint.
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FTP Get File activity
During run time, the FTP Get File activity connects to an FTP Server and attempts to get a single file at the
specified location. You can configure the FTP Get File activity to return the contents of the file into a variable of
the orchestration.  In addition, you can configure the FTP Get File activity to return the timestamp of the file
returned by the FTP Server into a variable of the orchestration.

The FTP Get File activity differs from the FTP Poll Directory activity in the following ways:
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The FTP Get File activity does not poll for a file or files in the specified directory. Instead the FTP Get
File activity checks for the file a single time and if the file is not found, it throws an error and the
orchestration job continues to processing.
The FTP Get File activity is not a starter activity, so it cannot be the first activity in an orchestration.
The FTP Get File activity does not move or delete files on the FTP server.

Symbolic link

The support for symbolic links by the FTP Get File activity during run time is dependant on the following
factors:  

The types of symbolic links supported by operating system that hosts the FTP Server.
The types of symbolic links supported by the FTP Server itself.
The types of symbolic links supported by the FTP Get File activity, as listed in the following table:

Table 1.
Symbol
ic Links
to...

Hard
Symbol
ic Links

Soft
Symbol
ic Links Notes®

Files Not
Support
ed

Not
Support
ed

The FTP Get File activity does not interpret symbolic links to files as files
and therefore symbolic links to files are not processed by the FTP Get
File activity during run time.

Directo
ries

Support
ed

Support
ed

 

To determine the specific symbolic link support for a specific FTP Server on a specific operating system, see
your operating system and FTP Server documentation.

Adding an FTP Get File activity in the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the FTP folder.
3. Drag the Get File activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing an FTP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
Attention: Specifying a new FTP Endpoint with a different directory structure than the
original FTP Endpoint can cause the orchestration job to fail during run time. You must
either specify a new FTP Server that matches the directory structure of the originally
specified FTP Server or change the configured directory of the In Directory field by clicking
Browse as described in the Configuring the activity procedure.

b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.
Select an existing endpoint and edit the endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.

Attention: Specifying a new FTP Endpoint with a different directory structure than the
original FTP Endpoint can cause the orchestration job to fail during run time. You must
either specify a new FTP Server that matches the directory structure of the originally
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specified FTP Server or change the configured directory of the In Directory field by clicking
Browse as described in the "Configure the activity" procedure.

c. Click Edit. The Edit Endpoint pane is displayed.
Create a new endpoint: Select New. The Create Endpoint pane is displayed.

2. Create or edit an FTP endpoint: Creating or Editing an FTP endpoint

Specifying the delivery rules

1. Select the Delivery Rules task from the Checklist. The Delivery Rules pane is displayed. If security is
not enabled for the FTP endpoint, the Transfer as Text (ASCII) and Transfer as Binary (BINARY) options
are enabled. If security is enabled for the FTP endpoint, the file transfer type is always binary.

2. Select the type of file transfer between the Integration Appliance and the FTP Server from one of the
following options:

Transfer as Text (ASCII) - Only seven bits of each character in the file is transferred by the
Integration Appliance to the FTP Server. This option is used for transferring ASCII files such as
HTML and text files.
CAUTION:
Using this option with binary files can result in a loss of data.
Transfer as Binary (BINARY) - All eight bits of each byte in the file is transferred by the
Integration Appliance to the FTP Server. This option is used for transferring binary files.

Note: Setting the transfer mode in the Delivery Rules task is equivalent to setting the transfer mode via a
command line session with an FTP Server using the following commands:

ascii
binary

Note: Cast Iron FTP connector SFTP endpoint supports only client side SFTP protocol version 3. Hence, the
SFTP protocol does not support ASCII/text mode file transfer. Make sure to set the File Transfer Type to
Transfer as Binary (BINARY) in the Checklist > Delivery Rules.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields in this pane as described in the following table:

Table 2.
Fi
el
d Description

Fil
e
Na
m
ed

This field is not used for this activity. You specify the name of the output file using the filename
input parameter of the Map Input task.
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Fi
el
d Description

Fr
o
m
Dir
ec
tor
y

Specifies the directory on the FTP server where the Integration Appliance places the file
generated in this activity. You can specify a directory using one of the following options:

Directly enter directory path by clicking in the field and typing in one of the following
directory paths:

Relative directory path, for example: /output.  (Assumes that FTP home has been
configured for the user account that connects to the FTP Server. See "Note" for more
information.)
Complete directory path, for example on a UNIX machine: /home/user/output.

Click Browse... to populate the drown-down list of available directories. Select the
appropriate directory from the drop-down list.

Note: UNIX: If you specify a relative directory path when connecting to an FTP Server on a UNIX
machine, verify that the FTP home directory has been correctly specified in the /etc/password file
for the user account connecting to the FTP Server.

Of
Ty
pe

Specifies how to read in the contents of the file - either as binary data or encoded text. If the Text
option is selected, set the encoding type using one of the following options:

From the encoded with drop-down list, select one of the default encoding types.  
Enter your encoding type directly by clicking in the encoded with field and typing in your
encoding type.

  Attention: You must specify the Transfer as Text (ASCII) option for FTP activities when retrieving
text files and placing text files on an FTP Server for Endpoints that manipulate text data while
transferring data from/to the FTP Endpoint in ASCII mode. For example, mainframe and DOS FTP
Endpoints manipulate ASCII data when passing data in ASCII mode.
For example, if your orchestration retrieves ASCII files using the FTP Poll Directory activity and
places ASCII files using the FTP Put File activity to a mainframe FTP Server, you must specify the
options in the following tasks in Studio:

In the Configure task of an FTP Poll Directory activity, for the Of Type field select the Text
option.
In the Delivery Rules task of an FTP Poll Directory activity, for the File Transfer Type field
select the Transfer as Text (ASCII) option.
In the Configure task of an FTP Put File activity, for the Of Type field select the Text option.
In the Delivery Rules task of an FTP Put File activity, for the File Transfer Type field select
the Transfer as Text (ASCII) option.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to an FTP Server. The following table defines the retry options

for a connection to an FTP Server:
Table 3.

Field Description

Retry  
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Field Description

1) Wait
___
second
(s)
betwee
n each
retry.

The number of seconds that the Integration Appliance waits before trying to establish a
connection to the FTP Server.

2) Try
to
connec
t ___
times
before
failing.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the FTP Server before issuing an error and stopping the
processing of the current orchestration job.

If you deploy an orchestration that contains an FTP Get File activity and the Integration
Appliance cannot connect to the specified FTP Server, the Integration Appliance logs the
connections errors as warnings in the system and orchestration logs until the retry count
value is reached. When the retry count is reached, the Integration Appliance logs an error in
the system and orchestration logs and the stops processing the current orchestration job.

For example, you set the retry count to 3. The first, second, and third connection errors
appear in the system log as warnings. The Integration Appliance logs the fourth connection
error as an error and stops processing the current orchestration job.

Mapping the input into the activity

1. Select the Map Inputs task in the Checklist. The input parameters of the activity are displayed in the To
Activity pane.

2. The filename parameter is the only parameter you are required to provide an value in the activity. All
other parameters are optional. The filename parameter specifies the name of the file to get from the FTP
Server. You provide a value for the filename parameter by either by creating a link from the filename
input parameter to a variable or by defining a default value for the filename input parameter.

If the optional input parameter listed in the following table are not displayed in the To Activity pane of
the Map Inputs pane, select Map > Show Optional Parameters from the toolbar menu or right-click in the
To Activity pane and select the Show Optional Parameters option. If the Map > Show Optional
Parameters option is not selectable in the toolbar menu, click on a node in the Map Inputs pane to make
this option active.

You can optionally override the settings you specified in the Configure and Pick Endpoint task of the
Checklist dynamically during run time, using the input parameters defined in the following table.

For example, the directory on the FTP Server where the Integration Appliance gets the file, could be set
in the Configure task to the directory called input. During run time, the directory name: inputXML could
be passed into the activity using the directory input parameter. The directory name specified
dynamically during run time overrides the original setting specified in the Configure pane. In this
example, the Integration Appliance attempts to get the file from the inputXML directory.

Table 4.
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Inp
ut
Par
am
ete
r
Na
me
/N
od
e Description Overrides the Setting in Task?

dir
ect
ory

Specifies the directory on the FTP server where the Integration
Appliance places the file generated in this activity.

The directory input parameter
overrides the From Directory field of
the Configure task.

enc
odi
ng

Specifies how the outgoing data is written out to the file:

If no encoding is required, specify the string: binary .
If encoding is required, specify the encoding type that
should be used to encode the outgoing data, for
example: UTF-8, US-ASCII, ISO_8859-1, EBCDIC-US,
or SHIFT-JIS.

The encoding input parameter
overrides the encoding specified in  the
Of Type field of the Configure task but
if the Binary option is selected in the Of
Type field of the Configure task, the
encoding specified by the encoding
input parameter is ignored.

con
nec
tio
n/ti
me
out

Specifies the connection timeout — the number of seconds
before a timeout occurs between the Integration Appliance
attempting to establish a connection to the endpoint and the
time it takes for the endpoint to respond to the connection
request. For the FTP Get File activity, the amount of time the
Integration Appliance attempts to establish a connection to
the FTP Server before timing out.  

The timeout node of the connection
input parameter overrides the
Connection Timeout -Time out after
___ second(s) when establishing a
connection to the Endpoint field of the
FTP endpoint.  

con
nec
tio
n/h
ost

Specifies the Host Name or IP address for the FTP server. The host node of the connection input
parameter overrides the Host Name
field of the FTP endpoint.

con
nec
tio
n/p
ort

Specifies the port number for the specified host name. The
standard port for FTP traffic is 21. The default port for SFTP
traffic is 22.

The port node of the connection input
parameter overrides the Port field of
the FTP endpoint.

con
nec
tio
n/u
ser
na
me

Specify a user name for the account used to connect to the FTP
Server.

The username node of the connection
input parameter overrides the User
Name field of the FTP endpoint.
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con
nec
tio
n/p
ass
wo
rd

Specify a password for the account used to connect to the FTP
Server.

The password node of the connection
input parameter overrides the
Password field of the FTP endpoint.

Mapping the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane as described in the following table:

Table 5.
Output
Parameter
Name Description

data Contains the contents of the file.

timestamp Contains the timestamp for the file returned from the FTP Server, typically the
creation date or last modified date of the file.  

2. Map the desired output parameters to variables.
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Parse directory listing example
This example gets a directory listing from and FTP directory using the FTP List Files activity, parses the long
directory listing using Flat File Scheme, iterates through the list of files, based on the properties of each file.

About this task
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Based on the properties of each file, one of the following actions occurs:

Move the file to a new directory using the FTP Rename File activity.
Rename the file using the FTP Rename File activity.
Delete the file using the FTP Delete File activity.

To open, view, and learn more about the FTPParseDirListingExample:

Procedure

1. Extract the FTPParseDirListingExample project:
a. Find the Default Create Path defined in Studio, the directory that new projects are created in. To

view the current Default Create Path, select File > Preferences... from the Studio toolbar menu.
The Preferences window is displayed. The current Default Create Path displays at the end of the
pane. By default, the Default Create Path is located in the following directory: C:\Documents and
Settings\ myLogin\My Documents Where myLogin represents your Windows login name.

b. Find the FTPParseDirListingExample.zip file that contains the files that make up the
FTPParseDirListingExample project. If you accepted the defaults during the installation of Studio,
this file is located in the following directory: C:\Program Files\IBM\WebSphere Cast Iron Studio
3.X\Samples\FTPParseDirListing

c. Copy the FTPParseDirListingExample.zip file from the FTPParseDirListing directory to the Default
Create Path directory.

d. Extract the contents of FTPParseDirListingExample.zip file into the Default Create Path directory.
2. Open the FTPParseDirListingExample project:

a. Select File > Open Project... from the Studio toolbar menu. The Open dialog box is displayed.
b. Browse for and open the FTPParseDirListingExample directory.
c. Click on the FTPParseDirListingExample.sp3 file and click Open. The project is displayed.

3. In the Project tab, double-click the processBids orchestration. The processBids orchestration tab
displays the activities of the orchestration, as shown in the following figure:

4. Click the Schedule Job activity. Click the Configure task in the Checklist. During run time, this activity
starts an orchestration job every 5 minutes.

5. Click the FTP List Files activity labeled List Files Full Dir Listing. Click the Configure task in
the Checklist.. This activity gets a long directory listing of the files in the /input directory on the FTP
Server and returns the listing as one string in the dirListing output parameter. In this example, the string
returned in the directoryListing output parameter is stored in the fullDirectoryListing string variable.

If the FTP Endpoint has been configured for the Parse Directory Listing Example, click Test in the
Configure task to get the directory listing. The List Only Files (NLST) check box determines if the
directory listing contains just the list of files or a full directory listing. For this example, clear the List Only
Files (NLST) check box.

6. Expand the If...Then activity. During run time, this activity checks the value of the fullDirectoryListing
string variable and if the value is empty, the If path is run and the orchestration ends. If the
fullDirectoryListing string is not empty, the Else path is run and the orchestration parses the directory.
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7. Click the Read Flat File activity. Click the Map Inputs task in the Checklist. During run time, the long
directory listing created in the FTP List Files activity, is passed to the Read Flat File activity via the Data
input parameter.

8. Click the Map Outputs task in the Checklist. During run time, the Read Flat File activity parses the
directory string into the repeating node structure displayed in the Map Outputs task.

9. Click the For Each activity. During run time, the For Each activity iterates through the repeating node
structure that stores the directory listing. Each iteration is equivalent to a singe file and the properties of
that file.

10. Click the Map Variables activity. During run time, the Map Variables activity converts the size of the
current file into a decimal number.

11. Click on the If..Then activity. During run time, the If..Then activity starts the following If..Then branches.

Results

If the size of the file is equal to 0, the FTP Rename File activity moves the file to the /processFailed
directory and renames the file by adding the ERROR prefix to the file name.
If the file name contains a string representing one of the approved supplies (AcmeInc or  WidgetRUs),
the FTP Rename File activity based on the file name, moves the file to the appropriate directory either
/processAcmeInc or /processWidgetRUs.
If the file name contains the string representing the Budget Manufacture supplier, the FTP Delete File
activity removes the file because Budget Manufacture is on the unapproved supplier list.
If the file is not processed by any of the three previous conditions, the Else clause is called and the FTP
Rename File activity moves the file to the /processNewCompany directory.

To run the Parse Directory Listing Example, see the procedures provided in the Configuring the FTP Endpoint
for the Parse Directory Listing Example section.
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Testing an FTPS server connection
After successfully running a "test connection", you can use Studio verify tools on FTPS orchestrations before
publishing a project.

About this task

If you configure an endpoint that represents an FTPS server, you can use it in a Studio project to create
orchestrations. You will not, however, be able to verify the orchestration behavior in Studio until you import a
copy of the FTPS certificate into Studio, as detailed in this help topic.

Note: The following procedure refers to a FTPS server named: “<ftps>” in a domain named "<domain.com>".
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To test an FTPS Server connection:

Procedure

1. Open a command window.
2. Navigate to the FTPS host, and locate the certificate file ca-cert stored in the FTP server <ftps>, in this

directory: /var/www/covalent/servers/<ftps.domain.com>/ssl/caerts/castiron_ca_cert.pem
3. Substitute the actual server and domain name of your FTPS installation.
4. Copy this file and navigate to the Studio workstation.
5. Using the command window, paste the ca-cert copy in the home directory of Studio: C:\Program

Files\IBM\WebSphere Cast Iron Studio x.x.x
6. Navigate to the security directory of Studio: C:\Program Files\IBM\WebSphere Cast Iron Studio

x.x.x\security
7. Run the following command to import the ca-cert file into Studio: ..\jre\bin\keytool.exe -
import -v -keystore cacerts -storepass changeit -file ..\castiron_ca_cert.pem -
alias alias_name

8. When you are prompted for a yes or no, type yes (Y) and press Enter.
9. Exit the command window.

10. Restart Studio.
11. Open the endpoint for this FTPS server.
12. Verify the following login credentials for the FTPS connection: FTP server, Port, User, and Password.
13. Click Test Connection. If the connection is successful, use this endpoint in Studio orchestrations, then

use the Verify tab features to evaluate the orchestration.
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HTTP Activities
Creating or editing an HTTP endpoint
HTTP endpoints provide the connection information that Studio and the Integration Appliance use to
connect to an HTTP server. An HTTP endpoint also specifies the connection information so the
Integration Appliance can act as HTTP listener.  
HTTP Receive Request activity
Use the HTTP Receive Request activity to configure the Integration Appliance to act as an HTTP listener
Decompression with the HTTP Receive Request activity
The HTTP Receive Request activity supports decompression with the gzip format only. The HTTP
Receive Request activity does not support the deflate format or the common UNIX file compression
format called compress.
HTTP Send Response activity
The HTTP Send Response activity sends a reply back to the sender of an HTTP request.
Compression/Decompression with the HTTP Send Response activity
During runtime, the HTTP Send Response activity sends an HTTP response complaint with the
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HTTP/HTTPS 1.0 protocol to the HTTP client.
HTTP Post Request activity
The HTTP Post Request activity sends a Post Request to the specified location (the HTTP endpoint) and
receives an HTTP response back from that location.
HTTP Get Request activity
The HTTP Get Request activity sends a Get Request to the specified location (the HTTP endpoint) and
receives a HTTP response back from that location.
HTTP Head Request activity
The HTTP Head Request activity sends a Head Request to the specified location (the HTTP endpoint)
and receives a HTTP response back from that location.
HTTP Invoke Request activity
The HTTP Invoke Request activity sends a HTTP request to the specified location, the HTTP endpoint,
and receives a HTTP response back from that location.
HTTP Put Request activity
The HTTP Put Request activity sends a Put Request to the specified location (the HTTP endpoint) and
receives a HTTP response back from that location.
HTTP Delete Request activity
The HTTP Delete Request activity sends a Delete Request to the specified location (the HTTP endpoint)
and receives a HTTP response back from that location.
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request activity
During runtime, the HTTP Invoke/Get/Post/Head/Put/Delete Request activity sends a HTTP request
compliant with the HTTP/HTTPS 1.1 protocol to the HTTP Server.
Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly.
Here, you can find potential solutions for issues you would have with the HTTP connector.
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Creating or editing an HTTP endpoint
HTTP endpoints provide the connection information that Studio and the Integration Appliance use to connect
to an HTTP server. An HTTP endpoint also specifies the connection information so the Integration Appliance
can act as HTTP listener.  

1. In the Create Endpoint or Edit Endpoint pane, configure the fields as described in the following table.
Note: Changing the configuration properties of an endpoint affects all orchestrations that use that
endpoint in the project as the edits are global, not local.

2. When finished, if available click Test Connection to confirm that you can connect to the HTTP server.
Note: The Test Connection button is only available when configuring an endpoint for the HTTP Post
Request activity - when Location is set to the Remote Server option.

3. Click OK.

Table 1.
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Field
Name Description
Field
Name Description

Location  

Integration
Appliance
Receives
Request

This option specifies that the Integration Appliance is acting as an HTTP listener.

For an HTTP endpoint used with the HTTP Receive Request activity, Location is automatically
set to the Integration Appliance Receives Request option.  

Remote
Server

This option specifies that the Integration Appliance is sending and receiving requests from a
remote HTTP server.

For an HTTP endpoint used with the HTTP Post Request activity, Location is automatically set to
the Remote Server option.

Host Name Required for the Remote Server option only - Specify the host name or IP address for the HTTP
server that this endpoint connects to.

Port For the HTTP Receive Request activity - Specify the port number of the Integration Appliance
acting as an HTTP listener.

For the HTTP Post Request activity - Specify the port number of the remote HTTP server.  

Login Description

Log into
the Server
as an
Anonymou
s User

Available for the Remote Server option only. Select this option to connect to the HTTP server
anonymously (where a user account is not required).

Log into
the Server
with User
Name and
Password

Available for the Remote Server option only. Select this option to connect to the HTTP server
using a user account. Enter the User Name and Password.

Authentica
tion

Allows you to select the type of authentication that the Integration Appliance uses when
connecting to a remote server. From the list, select one of the following authentication options:

Basic - Sends the user name and password you specify unencrypted to the server. This
authentication schema is the least secure.
Note: Basic authentication is now made available for HTTP Receive Request activity.
Digest - Encrypts the user name and password you specify before sending the user name
and password to the server. This authentication option is more secure than Basic
authentication.
NTLM - Requires an instance of NTCredentials to be available for the domain name of the
server. This authentication is the most secure authentication option. When you choose
the NTLM authentication option, the Integration Appliance authenticates a connection
and not a request; therefore, the Integration Appliance authenticates every time a new
connection is made. The connection must remain open during the authentication process.
You cannot use NTLM to authenticate with both a proxy and server.
Note: Do not prefix the user name with the domain.
Kerberos - The Kerberos protocol requires a trusted third party which is referred to as the
Kerberos server. The Kerberos server name and realm are configured on the WMC
Security:Kerberos panel instead of on the HTTP or Web Services end point.
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Field
Name Description

Realm /
Domain

If you select the Basic or Digest authentication option, specify a realm.

If you select the NTLM authentication option, specify a domain.

User Name
 

Available for the Remote Server option only - Specify the User Name for the account used to
connect to the HTTP Server.

Password Available for the Remote Server option only - Specify the Password for the account used to
connect to the HTTP Server.

Log into
the Server
using
OAuth 2.0

Description

Grant Type Cast Iron OAuth2.0 client supports two grants to request an access token. The authorization
request can be made directly to the resource owner or through the authorization server.
Select one of the following grant types:

password - Requires either a combination of Authorization Server URL, Username and
password or just the Access Token. If the Access Token is temporary, the authorization
server URL, username and password must be provided so as to regenerate the expired
access token
authorization_code - Requires an Access Token and/or the combination of Refresh
Token and Authorization Server URL in order to refresh temporary access tokens post
expiry.

Scope Specify the scope of the access request using the scope request parameter. The authorization
server uses this to inform the client about the scope of the access token issued.

Username Specify the user name used to log on to the resource server. For resource owner password
credential grant, the user name will be used as a part of the access token request.

Password Specify the password used to logon to the resource server. For resource owner password
credential grant, the password will be used as a part of the access token request.

Client ID Specify the client ID issued by the authorization server during registration. Client ID is a unique
string containing the registration information provided to the client by the authorization server.
The client ID is not a secret; it is exposed to the resource owner and must not be used only for
client authentication.

Client
Secret

Specify the client secret. The client secret is confidential.

Access
Token

Specify the Access Token. Access tokens are credentials representing the authorization issued
to the client. Tokens represent specific scopes and the duration of access.

Auth
Server URL

Specify the Authorization Server URL. Authorization Server URL is the URL for the authorization
server or token endpoint responsible for issuing and refreshing access tokens.

Refresh
Token

Specify the refresh token. Refresh tokens are used to obtain access tokens when the current
access token has expired.

For more information about OAuth 2.0, see http://tools.ietf.org/html/rfc6749.

Security Description

None Select the None option if no security is required.
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Field
Name Description

HTTPS Select the HTTPS option to enable secure HTTP over SSL.  

Available for the Integration Appliance Receives Request option only - When server
authentication is required, select the Server Certificate Alias Name check box to specify
that the Integration Appliance acting as a server should provide a certificate to the client.
If selected, the name of the certificate must be provided. A certificate specified at the
endpoint level with this check box takes precedence over certificates specified on the
Security > Certificates > Settings > Server SSL over data NIC entry in the WMC.
Available for the Remote Server option only - When client authentication is required,
select the Client Certificate Alias Name check box to specify that the Integration
Appliance acting as a client should provide a certificate to the HTTP Server. If selected,
the name of the certificate must be provided. (For information about how to import a
client certificate and private key for use with client authentication, see Importing an end-
entity certificate). A certificate specified at the endpoint level with this check box takes
precedence over certificates specified on the Security> Certificates > Settings > Client
SSL entry in the WMC

Protocol
Version

Select the protocol used for secure HTTP over SSL. By default, the protocol version used is
SSL_TLSv2.

Connection Pool Options

Maximum
Connection
s

Specifies the maximum number of HTTP server connections that the Integration Appliance can
keep open in the connection pool. The default value is 25.

Connectio
n Timeout
- The
following
Connectio
n field is
available
for the
Remote
Server
option
only.

Time out
after ___
seconds
when
establishin
g a
connection
to the
Endpoint.

The number of seconds before a timeout occurs between the Integration Appliance attempting
to establish a connection to the Endpoint and the time it takes for the endpoint to respond to the
connection request. For an HTTP activity, the amount of time the Integration Appliance attempts
to establish a connection to the HTTP Server before timing out. A connection timeout is different
from an activity timeout because an activity timeout occurs after the connection to the endpoint
has already been established. An activity timeout specifies the amount of time in seconds before
a timeout occurs between the activity invoking a request on an endpoint and the time it takes
the endpoint to respond. You set the activity timeout in the Retry task of the HTTP Post Request
Activity.
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Field
Name Description

Proxy -
The
following
Proxy
fields are
available
for the
Remote
Server
option
only.

Login Description

Log into
the Server
as an
Anonymou
s User

Available for the Remote Server option only. Select this option to connect to the HTTP server
anonymously (where a user account is not required).

Log into
the Server
with User
Name and
Password

Available for the Remote Server option only. Select this option to connect to the HTTP server
using a user account. Enter the User Name and Password.

Authentica
tion

Allows you to select the type of authentication that the Integration Appliance uses when
connecting to a remote server. From the drop-down list, select one of the following
authentication options:

Basic - Sends the user name and password you specify unencrypted to the server. This
authentication schema is the least secure.
Digest - Encrypts the user name and password you specify before sending the user name
and password to the server. This authentication option is more secure than Basic
authentication.
NTLM - Requires an instance of NTCredentials to be available for the domain name of the
server. This authentication is the most secure authentication option as the Integration
Appliance authenticates a connection and not a request; therefore, the Integration
Appliance authenticates every time a new connection is made. The connection must
remain open during the authentication process. You cannot use NTLM to authenticate
with both a proxy and server.
Note: Do not prefix the user name with the domain.

Realm /
Domain

If you select the Basic or Digest authentication option, specify a realm. If you select the NTLM
authentication option, specify a domain.

User Name
 

Available for the Remote Server option only - Specify the User Name for the account used to
connect to the HTTP Server.

Password Available for the Remote Server option only - Specify the Password for the account used to
connect to the HTTP Server.

Security Description
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Field
Name Description

None Select the None option if no security is required.

Connectio
n Timeout
- The
following
Connectio
n field is
available
for the
Remote
Server
option
only.

Time out
after ___
second(s)
when
establishin
g a
connection
to the
Endpoint.

Specifies the amount of time in seconds before a timeout occurs between the Integration
Appliance attempting to establish a connection to the endpoint and the time it takes for the
endpoint to respond to the connection request. For an HTTP activity, the amount of time the
Integration Appliance attempts to establish a connection to the HTTP Server before timing out.
A connection timeout is different from an activity timeout because an activity timeout occurs
after the connection to the endpoint has already been established. An activity timeout specifies
the amount of time in seconds before a timeout occurs between the activity invoking a request
on an endpoint and the time it takes the endpoint to respond.  You set the activity timeout in
Retry task of the HTTP Post Request Activity.

Host Specifies the host name of the proxy server. This field is required.

Port Specifies the port number to use to connect to the proxy server. This field is required

Username Specifies the username to use for proxy server authentication. This field is optional if your proxy
server does not require authentication

Password Specifies the password to use for proxy server authentication. This field is optional if your proxy
server does not require authentication.

Note: For some of the fields in the endpoint, you can define configuration properties to supply the values for
these fields.  The

icon is displayed when you click in a field that supports a configuration property and a configuration property of
the same type has already been configured for the project.
Parent topic: HTTP Activities
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HTTP Receive Request activity
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Use the HTTP Receive Request activity to configure the Integration Appliance to act as an HTTP listener

The following figure shows the Integration Appliance acting as an HTTP listener.
Figure 1.

The HTTP Receive Request activity is a starter activity. When an orchestration that starts with an HTTP
Receive Request activity is deployed to the Integration Appliance, the Integration Appliance acts as an HTTP
listener waiting for HTTP requests. When a HTTP request is received, the following actions occur:

1. An orchestration job is started.
2. The HTTP Receive Request activity processes the incoming HTTP request and maps the HTTP request

to the output parameters of the activity.
3. The output parameters are mapped to the specified orchestration variables. During design time in the

Map Outputs task of the Checklist, the mapping between the output parameters and the orchestration
variables is defined.

4. The remaining activities in the orchestration are processed. (In the graphical representation of the
orchestration,  the remaining activities are the activities located on the right side of the HTTP Receive
Request activity).

By default, decompression is enabled for the HTTP Receive Request activity. For more information, see
Decompression with the HTTP Receive Request activity.

You cannot deploy two HTTP Receive Request activities to the appliance with the same endpoint details, URL
and method.

For single HTTP Receive Request activity

If you deploy only one HTTP Receive Request activity for a URL, the orchestration accepts all requests of those
URLs starting with that base URL. For example, if you deploy /customer then it accepts requests for
/customer, /customer/21, /customer/21/dept, and so on.

If you deploy an HTTP Receive Request activity for a URL with path parameters, then the orchestration accepts
only those requests whose URLs match with the configured URL with values for path parameters. For example,
if you deploy /customer/{custid} then it accepts requests such as /customer/10, /customer/21,
/customer/dept . The following URLs are not accepted: /customer, /customer/21/dept, and so on.

For multiple HTTP Receive Request activities

If you deploy two HTTP Receive Request activities that are configured with the same base URL, and one with
path parameter, then the activities accept requests whose URLs strictly match with the configured URL. For
example, if you deploy /customer and /customer/{path parameter}, and if /customer is invoked the
request goes to the activity configured with /customer. If /customer/007 is invoked, the request goes to the
activity configured with /customer/{path parameter}. Also, if you invoke the following URLs:
/customer/dept/1 or /customer/12/21, none of the activities accept the requests.

Note: If you deploy two activities, the first one as /customer/department and the second one
as/customer/{path parameter}, and if /customer/department is invoked, then the request goes to the
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activity which was deployed first (/customer/department). If /customer/{path parameter} is deployed
first, then the request goes to /customer/{path parameter}.
Note: It is also recommended that you do not deploy the same URL for Web Services and HTTP.
Base URL - Part of the URL before path parameters. For example - If the configured URL
is/employee/manager/{id}, then Base URL will be /employee/manager.

Adding an HTTP Receive Request activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the HTTP folder.
3. Drag the Receive Request activity onto the orchestration.
4. Select the activity. The Checklist is displayed with the Summary task active in the properties pane. The

Properties pane is located under the graphical representation of the orchestration in the Workspace.

Creating, selecting, or editing an HTTP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit a HTTP endpoint, see Creating or editing an HTTP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
Fi
el
d Description
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Fi
el
d Description

U
RL
(P
at
h
Af
te
r
H
os
tn
a
m
e)

Specifies the resource path where the Integration Appliance listens for inbound HTTP requests, for
example: /mypath. The string you specify in this field must exclude the string: http://, the
hostname, and the port number of the Integration Appliance. The full URL that the Integration
Appliance uses to listen for inbound HTTP requests is automatically constructed from the
hostname of the Integration Appliance, the port number specified in the HTTP endpoint, and the
path specified in this field. For example, if the full URL that the Integration Appliance listens for
HTTP requests is http://myAR:myPort/myPath, in this field you only need to specify the string:
/myPath. The specified path must be unique for the HTTP Receive Request activities that are
deployed at the same time on the same Integration Appliance using the same port.

To make use of path parameters and query parameters, enter a URL in this format, url/ {path}?
name1=value1&name2=value2. This allows you to map a string value to the "{path}" parameter
and to specify query parameter names: name1 and name2 in this example. If you choose to
declare multiple "{path}" parameters, it is recommended that each parameter has a unique name.
Parameters with the same name are represented by only one node in the map. The path
parameters are displayed under /httpheaders/pathParameters in Map Output. Query parameters
are displayed under /httpheaders/queryParameters in Map output.

Note: In the URL, any value assigned to a query parameter is not passed to the mapper. The value
comes from the server based on the actual incoming request.
Note: The path that the Integration Appliance listens for inbound HTTP requests is a resource path
string that you specify and does not correspond to actual directory path on the Integration
Appliance.

M
et
ho
d

Specifies which HTTP method is accepted by the listening server.

Of
Ty
pe

Specifies the expected message type of the HTTP request - either Text or Binary.

Re
qu
ire
s
a
Re
pl
y

Specifies if a reply should be sent to the sender of the request.
Note: If this check box is selected, you must add and configure a HTTP Send Response activity in
your orchestration.
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Fi
el
d Description

Us
e
Co
m
pr
es
si
on
/D
ec
o
m
pr
es
si
on

Specifies if compression/decompression is turned on or off at the activity level. By default, the Use
Compression/Decompression check box is clear and compression/decompression is disabled for
this activity. Select the Use Compression/Decompression check box to enable
compression/decompression for this activity. For more information, see
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request activity

Specifying the request headers

1. Select the Request Headers task from the Checklist. The Request Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you may be
prompted to remove any duplicate headers in the Custom Headers table. The selected HTTP headers
are displayed under /httpheaders in Map Output.

Specifying Swagger information

1. Select the Swagger task from the Checklist to set sample message.
2. Specify the Request sample (JSON) and Response sample (JSON) information. If you do not specify any

request sample, the Swagger Output will display with empty sample objects.
3. Click on Generate Swagger button which will display the code in the Swagger Output textbox. You can

also click Download Swagger to download and share the file, if required.

Mapping the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane of the Map Outputs task as described in the following table:

Table 2.
Output Parameter Description

httpheaders Specifies the header of the HTTP request.

body Specifies the body of the HTTP request message.

334   



The following table defines the nodes of the optional httpheaders output parameter.  
Table 3.

Nodes of the
httpheaders Output
Parameter Description

httpheaders/uri Specifies the resource path of the incoming request, for example: /myPath.

httpheaders/meth
od

Specifies the type of HTTP request.

httpheaders/host Specifies the IP address or the host name of the client.

httpheaders/othe
rHeaders/headerI
tem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs. Multiple HTTP header parameters can be specified in the
HTTP request, so this is a recurring node.

httpheaders/<con
figured_header_n
ame>

If you configured at least one request header in Request Headers step, each is
displayed here. <configured_header_name> is replaced with the actual header
names you selected or entered.

httpheaders/path
Parameters

If you configured path parameters in the URL in the Configure step, each is
displayed here. If no path parameter is specified, this node does not display.

httpheaders/quer
yParameters

If you configured query parameters in the URL in Configure step, each is
displayed here. If no query parameter is specified, this node does not display.

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP header parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP header parameter.

2. Create a map between the output parameter or parameters of the activity and orchestration variable or
variables. See Creating a map for general instructions on mapping.
Note: To test your orchestration that starts with the HTTP Receive Request activity, you can use the
HTTP Post Utility included with the Studio installation, to send HTTP requests to the listening
Integration Appliance during run time. You can access the HTTP Post Utility from the start menu, select
Programs > IBM > Cast Iron Studio > HTTP Post Utility option. The URL you specify in the URL of the
inbound connector field must contain the full URL, for example: http://myAR:myPort/myPath.
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Decompression with the HTTP Receive Request activity
The HTTP Receive Request activity supports decompression with the gzip format only. The HTTP Receive
Request activity does not support the deflate format or the common UNIX file compression format called
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compress.

The HTTP Receive Request activity only supports receiving HTTP requests using HTTP/HTTPS 1.0 protocol.

The decompression runtime behavior of the HTTP Receive Request activity when receiving a HTTP request is
dependant on the following conditions:

The value of the Content-Encoding at the message level

The setting of the Use Compression/Decompression check box at the activity level

The affect of these conditions on the decompression runtime behavior of the HTTP Receive Request activity
are described in the following sections and in the table provided in the runtime Decompression Behavior
section.

Content-Encoding value at the message level

The value of the Content-Encoding HTTP Header Parameter of the HTTP request can determine if the
Integration Appliance decompresses the body of the HTTP request that is received from the HTTP Client as
shown in the following figure.

The value of the Content-Encoding  header is represented by the third column labeled Content-Encoding
Value in the table provided in the Run-time Decompression Behavior section.

Setting decompression at the activity level

By default, decompression is turned on at the activity level for the HTTP Receive Request activity. You can turn
off decompression at the activity level by selecting the Use Compression/Decompression check box. The Use
Compression/Decompression check box is available in the Configure task of the activity. The second column
labeled Use Compression/Decompression Check Box in the table provided in the runtime Decompression
Behavior section, represents the setting of the Use Compression/Decompression check box.

 

runtime decompression behavior

The following table describes the decompression runtime behavior when the Integration Appliance receives a
HTTP request from the HTTP Client:
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Use
Compress
ion/
Decompre
ssion
Check
Box
(Activity
Level)  

Conte
nt-
Encod
ing
Value
(Mess
age
Level)

Integration Appliance Decompression runtime BehaviorUse
Compress
ion/
Decompre
ssion
Check
Box
(Activity
Level)  

Conte
nt-
Encod
ing
Value
(Mess
age
Level)

Integration Appliance Decompression runtime Behavior

selected gzip The Integration Appliance decompresses the body of the request using the gzip format.
The value of Content-Encoding is set to gzip in the httpheaders output parameter
returned from the activity.

selected not
set

The Integration Appliance sends the body of the  request as is (unchanged). The value of
Content-Encoding is not set in the httpheaders output parameter returned from the
activity.   

selected identit
y

The Integration Appliance does not decompress the body of the request. The value of the
Content-Encoding is set to identity in the httpheaders output parameter returned from
the activity.

selected any
other
string
beside
s gzip
or
identit
y

The Integration Appliance sends the 415 (Unsupported Media Type) Response Code.

cleared value
is not
signifi
cant

The Integration Appliance does not decompress the body of the request and the current
value of Content-Encoding in the request is passed as is to the httpheaders output
parameter of the activity. For example, if the value of the Content-Encoding is set to gzip
but the Use Compression/Decompression check box is cleared, the Integration
Appliance does not decompress the body of the request but Content-Encoding is set to
gzip in the httpheaders output parameter of the activity.

Note: The Use Compression/Decompression check box will be deprecated in a future release. Use the Content-
Encoding HTTP Parameter in the HTTP request to specify how to decompresses the body of the HTTP request.
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HTTP Send Response activity
The HTTP Send Response activity sends a reply back to the sender of an HTTP request.
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The following figure shows the HTTP Send Response activity sending a reply back to the sender of an HTTP
request.
Figure 1.

The HTTP Send Response activity must be used in conjunction with an HTTP Receive Request activity in an
orchestration as shown in the preceding figure. If you add a HTTP Send Response activity to orchestration, you
must select the Requires a Reply check box in the Configure task of the HTTP Receive Request activity.

By default, compression is not enabled for the HTTP Send Response activity. For more information, see
Compression/Decompression with the HTTP Send Response activity.

Adding an HTTP Send Response activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the HTTP folder.
3. Drag the Send Response activity onto the orchestration.
4. Select the activity. The Checklist is displayed with the Configure task active in the properties pane. The

properties pane is located beneath the graphical representation of the orchestration.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
Field Description

To Specifies the HTTP Receive Request activity associated with this HTTP Send Response
activity. During run time, the associated HTTP Receive Request activity receives the request
from the client and the HTTP Send Response activity sends the response back to the client.
Note: This field is populated only if you select the Requires a Reply check box in the Configure
task of the HTTP Receive Request activity.

Of
Type

Specifies the message type of the HTTP response - either Text or Binary.

Use
Comp
ressio
n/Dec
ompr
essio
n

Specifies if compression/decompression is turned on or off at the activity level. By default, the
Use Compression/Decompression check box is clear and compression/decompression is
disabled for this activity. Select the Use Compression/Decompression check box to enable
compression/decompression for this activity. For more information, see
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request
activity.

Specifying the response headers
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1. Select the Response Headers task from the Checklist. The Response Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you are prompted
to remove any duplicate headers in the Custom Headers table. The selected HTTP headers are
displayed under /httpheaders in Map Input.

Mapping the input into the activity

1. Select the Map Inputs task in the Checklist. The body input parameter is displayed in the To Activity
pane of the Map Inputs task. The body input parameter is mandatory and at least one variable must be
mapped to it. The body input parameter contains the body of the HTTP response message sent back to
the client.

2. To view the optional input parameter in the To Activity pane of the Map Inputs pane, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity pane and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the
toolbar menu, click on a node in the Map Inputs pane to make this option active. The httpheaders input
parameter is displayed.
The following table defines the nodes of the optional httpheaders input parameter:

Table 2.
Nodes
of the
httph
eader
s
Input
Param
eter Description

httphe
aders/
uri

Specifies the resource path, for example: /myPath.

httphe
aders/
metho
d

Specifies the type of HTTP response, for example: POST.

httphe
aders/
Via

Contains the time taken by each of the activities present between HTTP Receive and HTTP
Send Response. For example, FTP Put(uploadfile):50ms;Send
Email(postinfo):30ms;. There are two activities, FTP Put and Send Email, that are present
between HTTP Receive and HTTP Send Response activities. So, when a job is processed, the
Via header response will contain this value. It means that FTP Put activity takes 50
milliseconds and the Send Email activity takes 30 milliseconds, respectively, to complete the
activity.
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Nodes
of the
httph
eader
s
Input
Param
eter Description

httphe
aders/
<confi
gured
_head
er_na
me>

If you configured at least one response header in Response Headers step, each is displayed
here. <configured_header_name> is replaced with the actual header name you selected or
entered.

httphe
aders/
other
Heade
rs/hea
derIte
m

Specifies an element that contains a set of HTTP header parameters as name/value pairs for
the HTTP response. Multiple HTTP parameters can be specified in the HTTP response, so this
is a  recurring node.

httphe
aders/
other
Heade
rs/hea
derIte
m/na
me

Specifies the name of the HTTP parameter.

httphe
aders/
other
Heade
rs/hea
derIte
m/val
ue

Specifies the value of the HTTP parameter.

3. Create a map between the orchestration variable or variables and the input parameter or parameters.
See Creating a map for general instructions on mapping

Using certificates with Microsoft Internet Explorer

If you have selected the HTTPS security option in the HTTP endpoint, note that Microsoft Internet Explorer
does not recognize a modified certificate and caches the SSL state. If you modify certificates, you must clear
the SSL state. To clear the SSL state in Microsoft Internet Explorer:

1. From the Microsoft Internet Explorer toolbar menu, select Tools > Internet Options.... The Internet
Options pane is displayed.

2. Click the Content tab.
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3. In the Certificates section, click Clear SSL State. The SSL Cache Cleared Successfully dialog box is
displayed.

4. Click OK and click OK.
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Compression/Decompression with the HTTP Send Response
activity

During runtime, the HTTP Send Response activity sends an HTTP response complaint with the HTTP/HTTPS
1.0 protocol to the HTTP client.

Note: The HTTP Send Response activity supports compression with the gzip format only. It T does not support
the deflate format or the common UNIX file compression format called compress.

The compression runtime behavior of the HTTP Send Response activity is dependant on the following
conditions:

At the message level, the value of the Accept-Encoding header in the original HTTP request received by
the HTTP Receive Request activity is passed to the HTTP Send Response activity to determine if the
body of the HTTP response is compressed or not compressed as shown in the following figure.
The setting of the Use Compression/Decompression check box at the activity level

The affect of these conditions on the compression runtime behavior of the HTTP Send Response activity are
described in the following sections and in the table provided in the runtime Compression Behavior section.

Accept-Encoding value at the message level

During runtime, a HTTP Receive Request activity receives a HTTP request from a HTTP client. In the same
orchestration, a HTTP Send Response activity sends a HTTP response back to the original client. The value of
the Accept-Encoding header in the original request received by the HTTP Receive Request activity is stored
internally on the Integration Appliance. The stored value is passed to the HTTP Send Response activity and is
used to determine if the body of the response is compressed or not and the encoding type, as shown in the
following figure.
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If values for the Content-Encoding or Accept-Encoding headers are explicitly set using the optional
httpheaders input parameter of the HTTP Send Response activity, these new values override the default
settings of these headers passed-in via the request. For example, if Accept-Encoding is set to gzip,deflate in
the request but is explicitly set to identity in the httpheaders input parameter of the HTTP Send Response
activity, the Integration Appliance does not compress the body of the response.

To explicitly set the Accept-Encoding header, provide the following values in a headerItem node in the Map
Inputs task of the HTTP Post Request activity:

httpheaders/httpheaders/otherHeaders/headerItem/name is set to the string: Accept-Encoding
httpheaders/httpheaders/otherHeaders/headerItem/value is set to the encoding type, for example the
string: identity.  

Setting Compression/Decompression at the activity level

By default, compression is turned on at the activity level for the HTTP Send Response activity.  You can turn off
compression at the activity level by clearing the Use Compression/Decompression check box. The Use
Compression/Decompression check box is available in the Configure task of the activity. The second column
labeled HTTP Compression CLI Command in the following table represents the setting of the Use
Compression/Decompression check box.

Runtime compression behavior

The following table describes the compression runtime behavior when the Integration Appliance sends a HTTP
response to the HTTP Client:

Use
Compression/
Decompression
Check Box
(Activity Level)  

Accept-Encoding
Value of the
HTTP Request
(Message Level)

Integration Appliance Compression Runtime Behavior
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Use
Compression/
Decompression
Check Box
(Activity Level)  

Accept-Encoding
Value of the
HTTP Request
(Message Level)

Integration Appliance Compression Runtime Behavior

selected gzip or
gzip,deflate

The Integration Appliance sends the body of the response
compressed in the gzip format and the Content-Encoding header is
set to gzip in the response.

selected identity The Integration Appliance sends the body of the response
uncompressed and the Content-Encoding header is set to identity in
the response.

selected not set, or any
other string
except gzip or
identity

The Integration Appliance sends the body of the response
uncompressed and the Content-Encoding header is set to identity in
the response.

cleared value is not
significant

The Integration Appliance sends the body of the response as is
(unchanged) and the Content-Encoding header is as is in the
response. (The value of the Content-Encoding header in the request
is passed unchanged to the response.)

Note: The Use Compression/Decompression check box will be deprecated in a future release. Use the Content-
Encoding and Accept-Encoding HTTP Parameters in the HTTP request to specify how to decompresses the
body of the HTTP request and compress the body of the HTTP response.
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HTTP Post Request activity
The HTTP Post Request activity sends a Post Request to the specified location (the HTTP endpoint) and
receives an HTTP response back from that location.

Adding an HTTP Post Request activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the HTTP folder.
3. Drag the Post Request activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting or editing an HTTP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
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Select an existing endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit a HTTP endpoint, see Creating or editing an HTTP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
Field
or
Chec
k
Box Description

URL
(Path
after
Host
nam
e)

Specifies the resource path that the Post Request activity sends the request to, for example:
/mypath. The string you specify in this field must exclude the string: http://, the host name, and
the port number of the Integration Appliance. The full URL is automatically constructed from
the host name of the Integration Appliance, the port number specified in the HTTP endpoint,
and the path specified in this field. For example, if the full URL that the Post Request activity
sends the request to is http://myAR:myPort/myPath, in this field you only need to specify the
string: /myPath. The specified path must be unique for the Post Request activities that are
deployed at the same time on the same Integration Appliance using the same port.

To make use of path parameters and query parameters, enter a URL in this format:url/{path}?
name1=value1&name2=value2. This allows you to map a string value to the "{path}" parameter
and to specify query parameter names: name1 and name2 in this example. If you choose to
declare multiple "{path}" parameters, each parameter should have a unique name. Parameters
with the same name are represented by only one node in the map. The path parameters are
displayed under /httpheaders/pathParameters in Map Input. Query parameters are displayed
under /httpheaders/queryParameters in Map Input.

Note: In the URL, any value you assign to a query parameter is not passed to the mapper. To
assign a value to the query parameter, either explicitly map a value to the query parameter in
the mapper or define a default value.

Wher
e
Requ
est
Mess
age
is Of
Type

Specifies the expected message type of the HTTP request - either Text or Binary.  
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Field
or
Chec
k
Box Description

Wher
e
Repl
y
Mess
age
is Of
Type

Specifies the message type of the HTTP reply - either Text or Binary.  

Stop
Proc
essin
g the
Orch
estra
tion
Job

or

Conti
nue
Proc
essin
g and
Retur
n the
HTT
P
Error
code

Specifies the run time behavior of the activity if an error response is returned from the HTTP
Server:

Stop Processing the Orchestration Job - Select this option if the orchestration job
should stop processing when an error response is received from the HTTP Server during
run time. The orchestration stops processing in the Post Request activity and the
activities after the Post Request activity in the orchestration are not processed and a
failed exception is thrown.
Continue Processing and Return the HTTP Error code - Select this option if the
orchestration job should continue processing when an error response is received from
the HTTP Server during run time. The orchestration job should continue processing
activities after the Post Request activity in the orchestration and the error response code
and the error response message is returned in the responsecode and responsemessage
output parameters, respectively.

Use
Com
press
ion/D
eco
mpre
ssion

Specifies if compression/decompression is turned on or off at the activity level. By default, the
Use Compression/Decompression check box is clear and compression/decompression is
disabled for this activity. Select the Use Compression/Decompression check box to enable
compression/decompression for this activity. For more information, see
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request
activity.

Specifying the request headers

1. Select the Request Headers task from the Checklist. The Request Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise, enter your own
description for your headers.
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3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you are prompted
to remove any duplicate headers in the Custom Headers table. The selected HTTP headers are
displayed under /httpheaders in Map Input.

Specifying the response headers

1. Select the Response Headers task from the Checklist. The Response Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle, and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise, enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you are prompted
to remove any duplicate headers in the Custom Headers table. The selected HTTP headers are
displayed under /httpheaders in Map Output.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to an HTTP Server. The following table defines the retry

options for a connection to an HTTP Server:
Table 2.

Fields Description

Retry  

1)
Wait
__
secon
ds
betwe
en
each
retry.

The number of seconds that the Integration Appliance waits before trying to establish a
connection to the HTTP Server.

2) Try
to
conne
ct __
times
before
failing
.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the HTTP Server before issuing an error and stopping the
processing of the current orchestration job.

If you deploy an orchestration that contains an HTTP Post Request activity and the
Integration Appliance cannot connect to the specified HTTP Server, the Integration Appliance
logs the connections errors as Warnings in the system and orchestration logs until the retry
count value is reached. When the retry count is reached, the Integration Appliance logs an
error in the system and orchestration logs and the stops processing the current orchestration
job.

For example, you set the retry count to 3. The first, second, and third connection errors appear
in the system log as warnings. The Integration Appliance logs the fourth connection error as an
error and stops processing the current orchestration job.
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Fields Description

Activi
ty
Timeo
ut

 

3)
Time
out
after
___
secon
ds
when
the
Endpo
int
does
not
respo
nd to
a
reque
st.

Specifies the amount of time in seconds before a timeout occurs between the activity making
a request on an Endpoint and the time it takes the Endpoint to respond. For the Post Request
activity, the activity timeout is the amount of time that the Integration Appliance waits for a
response from the HTTP Server after sending a HTTP request, before the Integration
Appliance issues a timeout error. An activity timeout is different from a connection timeout
because an activity timeout occurs after the connection to the endpoint has been established.
A connection timeout specifies the amount of time in seconds before a timeout occurs
between the Integration Appliance attempting to establish a connection to the endpoint and
the time it takes for the endpoint to respond to the connection request. You set the connection
timeout in HTTP Endpoint tab. For more information about connection timeouts, see Creating
or editing an HTTP endpoint.

Mapping the input into the activity

1. Select the Map Inputs task in the Checklist. The body input parameter is displayed in the To Activity
pane of the Map Inputs task. The body input parameter is mandatory and at least one variable must be
mapped to it. The body input parameter contains the body of the HTTP request message sent to the
HTTP server.

2. To view the optional input parameters in the To Activity pane of the Map Inputs pane, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity pane and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the
toolbar menu, click on a node in the Map Inputs pane to make this option active. The httpheaders and
httpConnParameter input parameters display.
The following table defines the nodes of the optional httpheaders input parameter:

Table 3.
Nodes of the
httpheaders Input
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/<con
figured_header_n
ame>

If you configured at least one request header in Request Headers step, each is
displayed here. <configured_header_name> is replaced with the actual header
names you selected or entered.

httpheaders/path
Parameters

If you configured path parameters in the URL in Configure step, each is
displayed here. If no path parameter is specified, this node does not display.

httpheaders/quer
y Parameters

If you configured query parameters in the URL in Configure step, each is
displayed here. If no query parameter is specified, this node does not display.
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Nodes of the
httpheaders Input
Parameter Description

httpheaders/othe
rHeaders/headerI
tem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs. Multiple HTTP header parameters can be specified in the
HTTP request, so this is a recurring node.

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP header parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP header parameter.

Note: If the Content-Length header is explicitly set using the
httpheaders/otherHeaders/headerItem/name and httpheaders/otherHeaders/headerItem/value, during
run time this value is ignored. This activity automatically sets the Content-Length header to the size of
the body.
The following table defines the nodes of the optional httpConnParameter input parameter. You can
optionally override the settings you specified in the Pick Endpoint task of the Checklist dynamically
during run time by passing in values from variables into the nodes specified in the following table. For
example during run time, you can override the Host Name specified in the endpoint, by mapping a
variable to the host node of the httpConnParameter input parameter. During run time, the value of the
variable is the host name used to connect the HTTP server.

Table 4.
Nodes of the
httpConnParam
eter Input
Parameter Description

Overrides what settings in the HTTP
endpoint?

timeout Specifies the amount of time in seconds
before a timeout occurs.

 

host Specifies the host name or IP address of
the remote HTTP server.  

The host node of the
httpConnParameter input parameter
overrides the Host Name field of the
HTTP endpoint.

port Specifies the port number of the remote
HTTP server.  

The port node of the
httpConnParameter input parameter
overrides the Port field of the HTTP
endpoint.

isSecure Set this boolean equal to true to enable
HTTPS - secure HTTP over SSL. Set this
boolean equal to false to disable security.

The isSecure node of the
httpConnParameter input parameter
overrides the Security option in the
HTTP endpoint.

username Specifies the user name for the account
used to connect to the HTTP server.

The username node of the
httpConnParameter input parameter
overrides the User Name field in the
HTTP endpoint.

password Specifies the password for the account
used to connect to the HTTP Server.

The password node of the
httpConnParameter input parameter
overrides the Password field in the
HTTP endpoint.
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3. Create a map between the orchestration variable or variables and input parameter or parameters. See
Creating a map for general instructions on mapping.

Mapping the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane of the Map Outputs task as described in the following table:

Table 5.
Output
Parameter Description

httpheaders Specifies the header of the HTTP response.

body Specifies the body of the HTTP response message.

responsecode Specifies the HTTP Response Code that is returned from the HTTP Server during
run time.  

responsemessag
e

Specifies the message associated with the HTTP Response Code.

The following table defines the nodes of the httpheaders output parameter:
Table 6.

Nodes of the
httpheaders Output
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/<con
figured_header_n
ame>

If you configured at least one response header in Response Headers step, each
is displayed here. <configured_header_name> is replaced with the actual
header names you selected or entered.

httpheaders/othe
rHeaders/headerI
tem

Specifies a set of name/value pairs that contain the HTTP parameters of the
HTTP response. Multiple HTTP parameters can be specified in the HTTP
response, so headerItem is a recurring node.

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP parameter.

2. Create a map between the output parameter or parameters of the activity and orchestration variable or
variables. See Creating a map for general instructions on mapping.

Using certificates with Microsoft Internet Explorer

If you have selected the HTTPS security option in the HTTP endpoint, note that Microsoft Internet Explorer
does not recognize a modified certificate and caches the SSL state. If you modify certificates, you must clear
the SSL state. To clear the SSL state in Microsoft Internet Explorer:

1. From the Microsoft Internet Explorer toolbar menu, select Tools > Internet Options.... The Internet
Options pane is displayed.

2. Click the Content tab.
3. In the Certificates section, click Clear SSL State. The SSL Cache Cleared Successfully dialog box is

displayed.
4. Click OK and click OK.
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HTTP Get Request activity
The HTTP Get Request activity sends a Get Request to the specified location (the HTTP endpoint) and
receives a HTTP response back from that location.

Adding an HTTP Get Request activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the HTTP folder.
3. Drag the Get Request activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing an HTTP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit a HTTP endpoint. See Creating or editing an HTTP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
Field
or
Chec
k
Box Description
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Field
or
Chec
k
Box Description

URL
(Path
after
Host
name
)

Specifies the resource path that the Get Request activity sends the request to, for example:
/mypath. The string you specify in this field must exclude the string: http://, the hostname, and
the port number of the Integration Appliance. The full URL is automatically constructed from
the host name of the Integration Appliance, the port number specified in the HTTP endpoint
and the path specified in this field. For example, if the full URL that the Get Request activity
sends the request to is http://myAR:myPort/myPath, in this field, you only need to specify the
string: /myPath. The specified path must be unique for the Get Request activities that are
deployed at the same time on the same Integration Appliance using the same port.

To make use of path parameters and query parameters, enter a URL in this format: url/{path}?
name1=value1&name2=value2. This allows you to map a string value to the "{path}" parameter
and to specify query parameter names: name1 and name2 in this example. If you choose to
declare multiple "{path}" parameters, it is recommended that each parameter has a unique
name. Parameters with the same name are represented by only one node in the map. The path
parameters will be displayed under /httpheaders/pathParameters in Map Input. And query
parameters will be displayed under /httpheaders/queryParameters in Map Input.

Note: In the URL, any value you assign to a query parameter is not passed to the mapper. To
assign a value to the query parameter, either explicitly map a value to the query parameter in
the mapper, or define a default value.

Wher
e
Requ
est
Mess
age
is Of
Type

Specifies the message type of the HTTP response - either Text or Binary.

Wher
e
Reply
Mess
age
is Of
Type

Specifies the message type of the HTTP reply - either Text or Binary..
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Field
or
Chec
k
Box Description

Stop
Proc
essin
g the
Orch
estra
tion
Job

or

Conti
nue
Proc
essin
g and
Retur
n the
HTTP
Error
code

Specifies the run time behavior of the activity if an error response is returned from the HTTP
Server:

Stop Processing the Orchestration Job - Select this option if the orchestration job
should stop processing when an error response is received from the HTTP Server during
run time. The orchestration stops processing in the HTTP Get Request activity and the
activities after the HTTP Get Request activity in the orchestration are not processed and
a failed exception is thrown.
Continue Processing and Return the HTTP Error code - Select this option if the
orchestration job should continue processing when an error response is received from
the HTTP Server during run time. The orchestration job should continue processing
activities after the HTTP Get Request activity in the orchestration and the error response
code and the error response message is returned in the responsecode and
responsemessage output parameters, respectively.

Use
Com
press
ion/D
ecom
press
ion

Specifies if compression/decompression is turned on or off at the activity level. By default, the
Use Compression/Decompression check box is clear and compression/decompression is
disabled for this activity. Select the Use Compression/Decompression check box to enable
compression/decompression for this activity. For more information, see
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request
activity.

Specifying the request headers

1. Select the Request Headers task from the Checklist. The Request Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise, enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Duplicate header names are not allowed (ignoring the case difference) and if duplicated headers appear
in the Custom Headers table, you are prompted to remove them. The selected HTTP headers are
displayed under /httpheaders in Map Input.

Specifying the response headers

1. Select the Response Headers task from the Checklist. The Response Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
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displayed in the middle, and a Standard Headers table is displayed at the bottom.
2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a

header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise, enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Duplicate header names are not allowed (ignoring the case difference) and if duplicated headers appear
in the Custom Headers table, you are prompted to remove them. The selected HTTP headers are
displayed under /httpheaders in Map Output.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options to connect to an HTTP Server. The following table defines the retry options

for connecting to an HTTP Server:

Field Description

Retry  

1)
Wait
___
secon
ds
betwe
en
each
retry.

Specifies the amount of time (in seconds) that the Integration Appliance waits before trying to
establish a connection to the HTTP server.

2) Try
to
conne
ct ___
times
before
failing
.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the HTTP Server before issuing an error and stopping the
processing of the current orchestration job. If you deploy an orchestration that contains an
HTTP Get Request activity and the Integration Appliance cannot connect to the specified
HTTP Server, the Integration Appliance logs the connections errors as Warnings in the system
and orchestration logs until the retry count value is reached. When the retry count is reached,
the Integration Appliance logs an error in the system and orchestration logs and the stops
processing the current orchestration job. For example, you set the retry count to 3. The first,
second, and third connection errors appear in the system log as warnings. The Integration
Appliance logs the fourth connection error as an error and stops processing the current
orchestration job.

3)
Time
out
after
___
secon
ds
when
the
Endpo
int
does
not
respo

Specifies the amount of time in seconds before a timeout occurs between the activity making
a request on an Endpoint and the time it takes the Endpoint to respond. For the HTTP Get
Request activity, the activity timeout is the amount of time that the Integration Appliance
waits for a response from the HTTP Server after sending a HTTP request, before the
Integration Appliance issues a timeout error. An activity timeout is different from a connection
timeout because an activity timeout occurs after the connection to the endpoint has been
established. A connection timeout specifies the amount of time in seconds before a timeout
occurs between the Integration Appliance attempting to establish a connection to the
endpoint and the time it takes for the endpoint to respond to the connection request. You set
the connection timeout in HTTP Endpoint tab. For more information about connection
timeouts, see, Creating or Editing a Web Services Endpoint.
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nd to
a
reque
st.

Mapping the input into the activity

1. Select the Map Inputs task in the Checklist. The body input parameter is displayed in the To Activity
pane of the Map Inputs task. The body input parameter is optional. The body input parameter contains
the body of the HTTP response message sent back to the HTTP server.

2. To view the optional input parameter in the To Activity pane of the Map Inputs pane, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity pane and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the
toolbar menu, click on a node in the Map Inputs pane to make this option active. The httpheaders and
httpConnParameter input parameters are displayed.
The following table defines the nodes of the optional httpheaders input parameter:

Table 2.
Nodes of the
httpheaders Input
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/<con
figured_header_n
ame>

If you configured at least one request header in the Request Headers step, each
is displayed here. <configured_header_name> is replaced with the actual
header names you selected or entered.

httpheaders/path
Parameters

If you configured path parameters in the URL in the Configure step, each is
displayed here. If no path parameter is specified, this node does not display.

httpheaders/quer
y Parameters

If you configured query parameters in the URL in the Configure step, each is
displayed here. If no query parameter is specified, this node does not display.

httpheaders/othe
rHeaders/headerI
tem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs. Multiple HTTP parameters can be specified in the HTTP
response, so this is a  recurring node.

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP header parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP parameter.

Note: If the Content-Length header is explicitly set using the
httpheaders/otherHeaders/headerItem/name and
httpheaders/otherHeaders/headerItem/value, this value is ignored during run time . This activity
automatically sets the Content-Length header to the size of the body.
The following table defines the nodes of the optional httpConnParameter input parameter. You can
optionally override the settings you specified in the Pick Endpoint task of the Checklist dynamically
during run time by passing in values from variables into the nodes specified in the following table. For
example during run time, you can override the Host Name specified in the endpoint, by mapping a
variable to the host node of the httpConnParameter input parameter. During run time, the value of the
variable is the host name used to connect the HTTP server.

Table 3.
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Nodes of the
httpConnParam
eter Input
Parameter Description

Overrides what settings in the HTTP
endpoint?

Nodes of the
httpConnParam
eter Input
Parameter Description

Overrides what settings in the HTTP
endpoint?

timeout Specifies the amount of time in seconds
before a timeout occurs.

 

host Specifies the host name or IP address of
the remote HTTP server.

The host node of the
httpConnParameter input parameter
overrides the Host Name field of the
HTTP endpoint.

port Specifies the port number of the remote
HTTP server.

The port node of the
httpConnParameter input parameter
overrides the Port field of the HTTP
endpoint.

isSecure Set this boolean equal to true to enable
HTTPS - secure HTTP over SSL. Set this
boolean equal to false to disable security.

The isSecure node of the
httpConnParameter input parameter
overrides the Security option in the
HTTP endpoint.

username Specifies the user name for the account
used to connect to the HTTP server.

The username node of the
httpConnParameter input parameter
overrides the User Name field in the
HTTP endpoint.

password Specifies the password for the account
used to connect to the HTTP Server.

The password node of the
httpConnParameter input parameter
overrides the Password field in the HTTP
endpoint.

3. Create a map between the orchestration variable or variables and the input parameter or parameters.
See Creating a map for general instructions on mapping

Mapping the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane of the Map Outputs task as described in the following table:

Table 4.
Output
Parameter Description

httpheaders Specifies the header of the HTTP request.

body Specifies the body of the HTTP request message.

responsecode Specifies the HTTP Response Code that is returned from the HTTP Server during
run time.

responsemessag
e

Specifies the message associated with the HTTP Response Code.

The following table defines the nodes of the optional httpheaders output parameter.  
Table 5.
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Nodes of the
httpheaders Output
Parameter Description

Nodes of the
httpheaders Output
Parameter Description

httpheaders/uri Specifies the resource path of the incoming request, for example: /myPath.

httpheaders/<con
figured_header_n
ame>

If you configured at least one response header in Response Headers step, each
is displayed here. <configured_header_name> is replaced with the actual
header names you selected or entered.

httpheaders/othe
rHeaders/headerI
tem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs. Multiple HTTP header parameters can be specified in the
HTTP request, so this is a recurring node.

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP header parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP header parameter.

2. Create a map between the output parameter or parameters of the activity and orchestration variable or
variables. See Creating a map for general instructions on mapping.

Using certificates with Microsoft Internet Explorer

If you have selected the HTTPS security option in the HTTP endpoint, note that Microsoft Internet Explorer
does not recognize a modified certificate and caches the SSL state. If you modify certificates, you must clear
the SSL state. To clear the SSL state in Microsoft Internet Explorer:

1. From the Microsoft Internet Explorer toolbar menu, select Tools > Internet Options.... The Internet
Options pane is displayed.

2. Click the Content tab.
3. In the Certificates section, click Clear SSL State. The SSL Cache Cleared Successfully dialog box is

displayed.
4. Click OK and click OK.

Parent topic: HTTP Activities
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HTTP Head Request activity
The HTTP Head Request activity sends a Head Request to the specified location (the HTTP endpoint) and
receives a HTTP response back from that location.

Adding an HTTP Head Request activity to the orchestration
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1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the HTTP folder.
3. Drag the Head Request activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing an HTTP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit a HTTP endpoint. See Creating or editing an HTTP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
Field
or
Chec
k
Box Description

URL
(Path
after
Host
nam
e)

Specifies the resource path that the Head Request activity sends the request to, for example:
/mypath. The string you specify in this field must exclude the string: http://, the hostname and
the port number of the Integration Appliance. The full URL is automatically constructed from
the host name of the Integration Appliance, the port number specified in the HTTP endpoint
and the path specified in this field. For example, if the full URL that the Head Request activity
sends the request to is http://myAR:myPort/myPath, in this field you only need to specify the
string: /myPath. The specified path must be unique for the Head Request activities that are
deployed at the same time on the same Integration Appliance using the same port.

To make use of path parameters and query parameters, enter a URL in this format: url/{path}?
name1=value1&name2=value2. This allows you to map a string value to the "{path}" parameter
and to specify query parameter names: name1 and name2 in this example. If you choose to
declare multiple "{path}" parameters, each parameter should have a unique name. Parameters
with the same name are represented by only one node in the map. The path parameters are
displayed under /httpheaders/pathParameters in Map Input. And query parameters will be
displayed under /httpheaders/queryParameters in Map Input.

Note: In the URL, any value you assign to a query parameter is not passed to the mapper. To
assign a value to the query parameter, either explicitly map a value to the query parameter in
the mapper, or define a default value.
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Field
or
Chec
k
Box Description

Wher
e
Requ
est
Mess
age
is Of
Type

Specifies the expected message type of the HTTP response - either Text or Binary.

Stop
Proc
essin
g the
Orch
estra
tion
Job

or

Conti
nue
Proc
essin
g and
Retur
n the
HTT
P
Error
code

Specifies the run time behavior of the activity if an error response is returned from the HTTP
Server:

Stop Processing the Orchestration Job - Select this option if the orchestration job
should stop processing when an error response is received from the HTTP Server during
run time. The orchestration stops processing in the Head Request activity and the
activities after the Head Request activity in the orchestration are not processed and a
failed exception is thrown.
Continue Processing and Return the HTTP Error code - Select this option if the
orchestration job should continue processing when an error response is received from
the HTTP Server during run time. The orchestration job should continue processing
activities after the Head Request activity in the orchestration and the error response
code and the error response message is returned in the responsecode and
responsemessage output parameters, respectively.

Use
Com
press
ion/D
eco
mpre
ssion

Specifies if compression/decompression is turned on or off at the activity level. By default, the
Use Compression/Decompression check box is clear and compression/decompression is
disabled for this activity. Select the Use Compression/Decompression check box to enable
compression/decompression for this activity. For more information, see
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request
activity.

Specifying the request headers

1. Select the Request Headers task from the Checklist. The Request Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise enter your own
description for your headers.
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3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you may be
prompted to remove any duplicate headers in the Custom Headers table. The selected HTTP headers
are displayed under /httpheaders in Map Input.

Specifying the response headers

1. Select the Response Headers task from the Checklist. The Response Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle, and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you are prompted
to remove any duplicate headers in the Custom Headers table. The selected HTTP headers are
displayed under /httpheaders in Map Output.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options to connect to an HTTP Server. The following table defines the retry options

for connecting to an HTTP Server:

Field Description

Retry  

1)
Wait
___
secon
ds
betwe
en
each
retry.

Specifies the amount of time (in seconds) that the Integration Appliance waits before trying to
establish a connection to the HTTP server.

2) Try
to
conne
ct ___
times
before
failing
.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the HTTP Server before issuing an error and stopping the
processing of the current orchestration job. If you deploy an orchestration that contains an
HTTP Head Request activity and the Integration Appliance cannot connect to the specified
HTTP Server, the Integration Appliance logs the connections errors as Warnings in the system
and orchestration logs until the retry count value is reached. When the retry count is reached,
the Integration Appliance logs an error in the system and orchestration logs and the stops
processing the current orchestration job. For example, you set the retry count to 3. The first,
second, and third connection errors appear in the system log as warnings. The Integration
Appliance logs the fourth connection error as an error and stops processing the current
orchestration job.

3)
Time
out
after
___

Specifies the amount of time in seconds before a timeout occurs between the activity making a
request on an Endpoint and the time it takes the Endpoint to respond. For the HTTP Head
Request activity, the activity timeout is the amount of time that the Integration Appliance
waits for a response from the HTTP Server after sending a HTTP request, before the
Integration Appliance issues a timeout error. An activity timeout is different from a connection
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secon
ds
when
the
Endpo
int
does
not
respo
nd to
a
reque
st.

timeout because an activity timeout occurs after the connection to the endpoint has been
established. A connection timeout specifies the amount of time in seconds before a timeout
occurs between the Integration Appliance attempting to establish a connection to the
endpoint and the time it takes for the endpoint to respond to the connection request. You set
the connection timeout in HTTP Endpoint tab. For more information about connection
timeouts, see, Creating or Editing a Web Services Endpoint.

Mapping the input into the activity

1. Select the Map Inputs task in the Checklist. The body input parameter is displayed in the To Activity
pane of the Map Inputs task. The body input parameter is optional. The body input parameter contains
the body of the HTTP response message sent back to the HTTP server.

2. To view the optional input parameter in the To Activity pane of the Map Inputs pane, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity pane and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the
toolbar menu, click on a node in the Map Inputs pane to make this option active. The httpheaders and
httpConnParameter input parameters are displayed.
The following table defines the nodes of the optional httpheaders input parameter:

Table 2.
Nodes of the
httpheaders Input
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/<co
nfigured_header
_name>

If you configured at least one request header in Request Headers step, each one
of them will be displayed here. <configured_header_name> will be replaced with
the actual header names you selected or entered.

httpheaders/pat
hParameters

If you configured path parameters in the URL in the Configure step, each is
displayed here. If no path parameter is specified, this node does not display.

httpheaders/que
ry Parameters

If you configured query parameters in the URL in Configure step, each is
displayed here. If no query parameter is specified, this node does not display.

httpheaders/oth
erHeaders/heade
rItem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs for the HTTP response. Multiple HTTP parameters can be
specified in the HTTP response, so this is a  recurring node.

httpheaders/oth
erHeaders/heade
rItem/name

Specifies the name of the HTTP parameter.

httpheaders/oth
erHeaders/heade
rItem/value

Specifies the value of the HTTP parameter.

Note: If the Content-Length header is explicitly set using the
httpheaders/otherHeaders/headerItem/name and
httpheaders/otherHeaders/headerItem/value, during run time this value is ignored. This activity
automatically sets the Content-Length header to the size of the body.
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The following table defines the nodes of the optional httpConnParameter input parameter. You can
optionally override the settings you specified in the Pick Endpoint task of the Checklist dynamically
during run time by passing in values from variables into the nodes specified in the following table. For
example during run time, you can override the Host Name specified in the endpoint, by mapping a
variable to the host node of the httpConnParameter input parameter. During run time, the value of the
variable is the host name used to connect the HTTP server.

Table 3.
Nodes of the
httpConnParameter Input
Parameter Description

Overrides what settings in the
HTTP endpoint?

timeout Specifies the amount of time in
seconds before a timeout
occurs.

 

host Specifies the host name or IP
address of the remote HTTP
server.

The host node of the
httpConnParameter input
parameter overrides the Host
Name field of the HTTP
endpoint.

port Specifies the port number of the
remote HTTP server.

The port node of the
httpConnParameter input
parameter overrides the Port
field of the HTTP endpoint.

isSecure Set this boolean equal to true to
enable HTTPS - secure HTTP
over SSL. Set this boolean equal
to false to disable security.

The isSecure node of the
httpConnParameter input
parameter overrides the Security
option in the HTTP endpoint.

username Specifies the user name for the
account used to connect to the
HTTP server.

The username node of the
httpConnParameter input
parameter overrides the User
Name field in the HTTP endpoint.

password Specifies the password for the
account used to connect to the
HTTP Server.

The password node of the
httpConnParameter input
parameter overrides the
Password field in the HTTP
endpoint.

3. Create a map between the orchestration variable or variables and the input parameter or parameters.
See Creating a map for general instructions on mapping

Mapping the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane of the Map Outputs task as described in the following table:

Table 4.
Output
Parameter Description

httpheaders Specifies the header of the HTTP request.

body Specifies the body of the HTTP request message.
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Output
Parameter Description

responsecode Specifies the HTTP Response Code that is returned from the HTTP Server during
run time.

responsemessag
e

Specifies the message associated with the HTTP Response Code.

The following table defines the nodes of the optional httpheaders output parameter.  
Table 5.

Nodes of the
httpheaders Output
Parameter Description

httpheaders/uri Specifies the resource path of the incoming request, for example: /myPath.

httpheaders/<con
figured_header_n
ame>

If you configured at least one response header in Response Headers step, each
is displayed here. <configured_header_name>will be replaced with the actual
header names you selected or entered.

httpheaders/othe
rHeaders/headerI
tem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs. Multiple HTTP header parameters can be specified in the
HTTP request, so this is a recurring node.

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP header parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP header parameter.

2. Create a map between the output parameter or parameters of the activity and orchestration variable or
variables. See Creating a map for general instructions on mapping.

Using certificates with Microsoft Internet Explorer

If you have selected the HTTPS security option in the HTTP endpoint, note that Microsoft Internet Explorer
does not recognize a modified certificate and caches the SSL state. If you modify certificates, you must clear
the SSL state. To clear the SSL state in Microsoft Internet Explorer:

1. From the Microsoft Internet Explorer toolbar menu, select Tools > Internet Options.... The Internet
Options pane is displayed.

2. Click the Content tab.
3. In the Certificates section, click Clear SSL State. The SSL Cache Cleared Successfully dialog box is

displayed.
4. Click OK and click OK.

Parent topic: HTTP Activities
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HTTP Invoke Request activity
The HTTP Invoke Request activity sends a HTTP request to the specified location, the HTTP endpoint, and
receives a HTTP response back from that location.

Adding an HTTP Invoke Request activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the HTTP folder.
3. Drag the Invoke Request activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing an HTTP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit a HTTP endpoint, see Creating or editing an HTTP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
Field
or
Chec
k
Box Description
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Field
or
Chec
k
Box Description

URL
(Path
after
Host
nam
e)

Specifies the resource path that the Invoke Request activity sends the request to, for example:
/mypath. The string you specify in this field must exclude the string: http://, the host name, and
the port number of the Integration Appliance. The full URL is automatically constructed from
the host name of the Integration Appliance, the port number specified in the HTTP endpoint,
and the path specified in this field. For example, if the full URL that the Invoke Request activity
sends the request to is http://myAR:myPort/myPath, in this field you only need to specify the
string: /myPath. The specified path must be unique for the Invoke Request activities that are
deployed at the same time on the same Integration Appliance using the same port.

To make use of path parameters and query parameters, enter a URL in this format:url/{path}?
name1=value1&name2=value2. This allows you to map a string value to the "{path}" parameter
and to specify query parameter names: name1 and name2 in this example. If you choose to
declare multiple "{path}" parameters, it is recommended that each parameter has a unique
name. Parameters with the same name are represented by only one node in the map. The path
parameters are displayed under /httpheaders/pathParameters in Map Input. Query parameters
are displayed under /httpheaders/queryParameters in Map Input.

Note: In the URL, any value you assign to a query parameter is not passed to the mapper. To
assign a value to the query parameter, either explicitly map a value to the query parameter in
the mapper, or define a default value.

Wher
e
Requ
est
Mess
age
is Of
Type

Specifies the expected message type of the HTTP request - either Text or Binary.  

Wher
e
Repl
y
Mess
age
is Of
Type

Specifies the message type of the HTTP reply - either Text or Binary.
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Field
or
Chec
k
Box Description

Stop
Proc
essin
g the
Orch
estra
tion
Job

or

Conti
nue
Proc
essin
g and
Retur
n the
HTT
P
Error
code

Specifies the run time behavior of the activity if an error response is returned from the HTTP
Server:

Stop Processing the Orchestration Job - Select this option if the orchestration job
should stop processing when an error response is received from the HTTP Server during
run time. The orchestration stops processing in the Invoke Requestactivity and the
activities after the Invoke Request activity in the orchestration are not processed and a
failed exception is thrown.
Continue Processing and Return the HTTP Error code - Select this option if the
orchestration job should continue processing when an error response is received from
the HTTP Server during run time. The orchestration job should continue processing
activities after the Invoke Request activity in the orchestration and the error response
code and the error response message is returned in the responsecode and
responsemessage output parameters, respectively.

Use
Com
press
ion/D
eco
mpre
ssion

Specifies if compression/decompression is turned on or off at the activity level. By default, the
Use Compression/Decompression check box is clear and compression/decompression is
disabled for this activity. Select the Use Compression/Decompression check box to enable
compression/decompression for this activity. For more information, see
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request
activity.

Specifying the request headers

1. Select the Request Headers task from the Checklist. The Request Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you are prompted
to remove any duplicate headers in the Custom Headers table. The selected HTTP headers are
displayed under /httpheaders in Map Input.

Specifying the response headers
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1. Select the Response Headers task from the Checklist. The Response Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you are prompted
to remove any duplicate headers in the Custom Headers table. The selected HTTP headers are
displayed under /httpheaders in Map Output.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to an HTTP Server. The following table defines the retry

options for a connection to an HTTP Server:
Table 2.

Fields Description

Retry  

1)
Wait
__
secon
ds
betwe
en
each
retry.

The number of seconds that the Integration Appliance waits before trying to establish a
connection to the HTTP Server.

2) Try
to
conne
ct __
times
before
failing
.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the HTTP Server before issuing an error and stopping the
processing of the current orchestration job.

If you deploy an orchestration that contains an HTTP Post Request activity and the Integration
Appliance cannot connect to the specified HTTP Server, the Integration Appliance logs the
connections errors as Warnings in the system and orchestration logs until the retry count value
is reached. When the retry count is reached, the Integration Appliance logs an error in the
system and orchestration logs and the stops processing the current orchestration job.

For example, you set the retry count to 3. The first, second, and third connection errors appear
in the system log as warnings. The Integration Appliance logs the fourth connection error as an
error and stops processing the current orchestration job.

Activi
ty
Timeo
ut
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Fields Description

3)
Time
out
after
___
secon
ds
when
the
Endpo
int
does
not
respo
nd to
a
reque
st.

Specifies the amount of time in seconds before a timeout occurs between the activity making
a request on an Endpoint and the time it takes the Endpoint to respond. For the Invoke
Request activity, the activity timeout is the amount of time that the Integration Appliance
waits for a response from the HTTP Server after sending a HTTP request, before the
Integration Appliance issues a timeout error. An activity timeout is different from a connection
timeout because an activity timeout occurs after the connection to the endpoint has been
established. A connection timeout specifies the amount of time in seconds before a timeout
occurs between the Integration Appliance attempting to establish a connection to the
endpoint and the time it takes for the endpoint to respond to the connection request. You set
the connection timeout in HTTP Endpoint tab. For more information about connection
timeouts, see Creating or editing an HTTP endpoint.

Mapping the input into the activity

1. Select the Map Inputs task in the Checklist. The body input parameter is displayed in the To Activity
pane of the Map Inputs task. The body input parameter is mandatory and at least one variable must be
mapped to it. The body input parameter contains the body of the HTTP request message sent to the
HTTP server.

2. To view the optional input parameters in the To Activity pane of the Map Inputs pane, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity pane and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the
toolbar menu, click on a node in the Map Inputs pane to make this option active. The httpheaders and
httpConnParameter input parameters display.
The following table defines the nodes of the optional httpheaders input parameter:

Table 3.
Nodes of the
httpheaders Input
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/meth
od

Specifies the type of HTTP request. If no value is mapped, the default method
is POST.

httpheaders/<con
figured_header_n
ame>

If you configured at least one request header in Request Headers step, each is
displayed here. <configured_header_name> is replaced with the actual header
names you selected or entered

httpheaders/path
Parameters

If you configured path parameters in the URL in Configure step, each is
displayed here. If no path parameter is specified, this node does not display.

httpheaders/quer
yParameters

If you configured query parameters in the URL in Configure step, each is
displayed here. If no query parameter is specified, this node does not display.

httpheaders/othe
rHeaders/headerI
tem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs. Multiple HTTP header parameters can be specified in the
HTTP request, so this is a recurring node.

 367



Nodes of the
httpheaders Input
Parameter Description

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP header parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP header parameter.

Note: If the Content-Length header is explicitly set using the
httpheaders/otherHeaders/headerItem/name and httpheaders/otherHeaders/headerItem/value, during
run time this value is ignored. This activity automatically sets the Content-Length header to the size of
the body.
The following table defines the nodes of the optional httpConnParameter input parameter. You can
optionally override the settings you specified in the Pick Endpoint task of the Checklist dynamically
during run time by passing in values from variables into the nodes specified in the following table. For
example during run time, you can override the Host Name specified in the endpoint, by mapping a
variable to the host node of the httpConnParameter input parameter. During run time, the value of the
variable is the host name used to connect the HTTP server.

Table 4.
Nodes of the
httpConnParam
eter Input
Parameter Description

Overrides what settings in the HTTP
endpoint?

timeout Specifies the amount of time in seconds
before a timeout occurs.

 

host Specifies the host name or IP address of
the remote HTTP server.  

The host node of the
httpConnParameter input parameter
overrides the Host Name field of the
HTTP endpoint.

port Specifies the port number of the remote
HTTP server.  

The port node of the
httpConnParameter input parameter
overrides the Port field of the HTTP
endpoint.

isSecure Set this boolean equal to true to enable
HTTPS - secure HTTP over SSL. Set this
boolean equal to false to disable security.

The isSecure node of the
httpConnParameter input parameter
overrides the Security option in the
HTTP endpoint.

username Specifies the user name for the account
used to connect to the HTTP server.

The username node of the
httpConnParameter input parameter
overrides the User Name field in the
HTTP endpoint.

password Specifies the password for the account
used to connect to the HTTP Server.

The password node of the
httpConnParameter input parameter
overrides the Password field in the
HTTP endpoint.

3. Create a map between the orchestration variable or variables and input parameter or parameters. See
Creating a map for general instructions on mapping.
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Mapping the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane of the Map Outputs task as described in the following table:

Table 5.
Output
Parameter Description

httpheaders Specifies the header of the HTTP response.

body Specifies the body of the HTTP response message.

responsecode Specifies the HTTP Response Code that is returned from the HTTP Server during
run time.  

responsemessag
e

Specifies the message associated with the HTTP Response Code.

The following table defines the nodes of the httpheaders output parameter:
Table 6.

Nodes of the
httpheaders Output
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/meth
od

Specifies the type of HTTP response.

httpheaders/<con
figured_header_n
ame>

If you configured at least one response header in Response Headers step, each
is displayed here. <configured_header_name> is replaced with the actual
header names you selected or entered.

httpheaders/othe
rHeaders/headerI
tem

Specifies a set of name/value pairs that contain the HTTP parameters of the
HTTP response. Multiple HTTP parameters can be specified in the HTTP
response, so headerItem is a recurring node.

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP parameter.

2. Create a map between the output parameter or parameters of the activity and orchestration variable or
variables. See Creating a map for general instructions on mapping.

Using certificates with Microsoft Internet Explorer

If you have selected the HTTPS security option in the HTTP endpoint, note that Microsoft Internet Explorer
does not recognize a modified certificate and caches the SSL state. If you modify certificates, you must clear
the SSL state. To clear the SSL state in Microsoft Internet Explorer:

1. From the Microsoft Internet Explorer toolbar menu, select Tools > Internet Options.... The Internet
Options pane is displayed.

2. Click the Content tab.
3. In the Certificates section, click Clear SSL State. The SSL Cache Cleared Successfully dialog box is

displayed.
4. Click OK and click OK.
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HTTP Put Request activity
The HTTP Put Request activity sends a Put Request to the specified location (the HTTP endpoint) and receives
a HTTP response back from that location.

Adding an HTTP Put Request activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the HTTP folder.
3. Drag the Put Request activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing an HTTP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit a HTTP endpoint. See Creating or editing an HTTP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
Field
or
Chec
k
Box Description

370   



Field
or
Chec
k
Box Description

URL
(Path
after
Host
name
)

Specifies the resource path that the Put Request activity sends the request to, for example:
/mypath. The string you specify in this field must exclude the string: http://, the hostname and
the port number of the Integration Appliance. The full URL is automatically constructed from
the host name of the Integration Appliance, the port number specified in the HTTP endpoint
and the path specified in this field. For example, if the full URL that the Put Request activity
sends the request to is http://myAR:myPort/myPath, in this field you only need to specify the
string: /myPath. The specified path must be unique for the Put Request activities that are
deployed at the same time on the same Integration Appliance using the same port.

To make use of path parameters and query parameters, enter a URL in this format, "url/{path}?
name1=value1&name2=value2". This allows you to map a string value to the "{path}"
parameter and to specify query parameter names: "name1" and "name2" in this example. If
you choose to declare multiple "{path}" parameters, it is recommended that each parameter
has a unique name. Parameters with the same name are represented by only one node in the
map. The path parameters will be displayed under /httpheaders/pathParameters in Map Input.
And query parameters will be displayed under /httpheaders/queryParameters in Map Input.

Note: In the URL, any value you assign to a query parameter is not passed to the mapper. To
assign a value to the query parameter, either explicitly map a value to the query parameter in
the mapper, or define a default value.

Wher
e
Requ
est
Mess
age
is Of
Type

Specifies the message type of the HTTP response - either Text or Binary.

Wher
e
Reply
Mess
age
is Of
Type

Specifies the message type of the HTTP reply - either Text or Binary..
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Field
or
Chec
k
Box Description

Stop
Proc
essin
g the
Orch
estra
tion
Job

or

Conti
nue
Proc
essin
g and
Retur
n the
HTTP
Error
code

Specifies the run time behavior of the activity if an error response is returned from the HTTP
Server:

Stop Processing the Orchestration Job - Select this option if the orchestration job
should stop processing when an error response is received from the HTTP Server during
run time. The orchestration stops processing in the Put Request activity and the
activities after the Put Request activity in the orchestration are not processed and a
failed exception is thrown.
Continue Processing and Return the HTTP Error code - Select this option if the
orchestration job should continue processing when an error response is received from
the HTTP Server during run time. The orchestration job should continue processing
activities after the Put Request activity in the orchestration and the error response code
and the error response message is returned in the responsecode and responsemessage
output parameters, respectively.

Use
Com
press
ion/D
ecom
press
ion

Specifies if compression/decompression is turned on or off at the activity level. By default, the
Use Compression/Decompression check box is clear and compression/decompression is
disabled for this activity. Select the Use Compression/Decompression check box to enable
compression/decompression for this activity. For more information, see
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request
activity.

Specifying the request headers

1. Select the Request Headers task from the Checklist. The Request Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise, enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you are prompted
to remove any duplicate headers in the Custom Headers table. The selected HTTP headers are
displayed under /httpheaders in Map Input.

Specifying the response headers

1. Select the Response Headers task from the Checklist. The Response Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
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displayed in the middle, and a Standard Headers table is displayed at the bottom.
2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a

header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise, enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you may be
prompted to remove any duplicate headers in the Custom Headers table. The selected HTTP headers
are displayed under /httpheaders in Map Output.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options to connect to an HTTP Server. The following table defines the retry options

for connecting to an HTTP Server:

Field Description

Retry  

1)
Wait
___
secon
ds
betwe
en
each
retry.

Specifies the amount of time (in seconds) that the Integration Appliance waits before trying to
establish a connection to the HTTP server.

2) Try
to
conne
ct ___
times
before
failing
.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the HTTP Server before issuing an error and stopping the
processing of the current orchestration job. If you deploy an orchestration that contains an
HTTP Put Request activity and the Integration Appliance cannot connect to the specified
HTTP Server, the Integration Appliance logs the connections errors as Warnings in the system
and orchestration logs until the retry count value is reached. When the retry count is reached,
the Integration Appliance logs an error in the system and orchestration logs and the stops
processing the current orchestration job. For example, you set the retry count to 3. The first,
second, and third connection errors appear in the system log as warnings. The Integration
Appliance logs the fourth connection error as an error and stops processing the current
orchestration job.

3)
Time
out
after
___
secon
ds
when
the
Endpo
int
does
not
respo

Specifies the amount of time in seconds before a timeout occurs between the activity making
a request on an Endpoint and the time it takes the Endpoint to respond. For the HTTP Put
Request activity, the activity timeout is the amount of time that the Integration Appliance
waits for a response from the HTTP Server after sending a HTTP request, before the
Integration Appliance issues a timeout error. An activity timeout is different from a connection
timeout because an activity timeout occurs after the connection to the endpoint has been
established. A connection timeout specifies the amount of time in seconds before a timeout
occurs between the Integration Appliance attempting to establish a connection to the
endpoint and the time it takes for the endpoint to respond to the connection request. You set
the connection timeout in HTTP Endpoint tab. For more information about connection timeout,
see Creating or Editing a Web Services Endpoint.
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nd to
a
reque
st.

Mapping the input into the activity

1. Select the Map Inputs task in the Checklist. The body input parameter is displayed in the To Activity
pane of the Map Inputs task. The body input parameter is mandatory and at least one variable must be
mapped to it. The body input parameter contains the body of the HTTP response message sent back to
the HTTP server.

2. To view the optional input parameter in the To Activity pane of the Map Inputs pane, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity pane and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the
toolbar menu, click on a node in the Map Inputs pane to make this option active. The httpheaders and
httpConnParameter input parameters are displayed.
The following table defines the nodes of the optional httpheaders input parameter:

Table 2.
Nodes of the
httpheaders Input
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/<co
nfigured_header
_name>

If you configured at least one request header in Request Headers step, each is
displayed here. <configured_header_name> is replaced with the actual header
names you selected or entered.

httpheaders/pat
hParameters

If you configured path parameters in the URL in Configure step, each is displayed
here. If no path parameter is specified, this node does not display.

httpheaders/que
ry Parameters

If you configured query parameters in the URL in Configure step, each one of
them will be displayed here. If no query parameter is specified, this node does
not display.

httpheaders/oth
erHeaders/heade
rItem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs for the HTTP response. Multiple HTTP parameters can be
specified in the HTTP response, so this is a  recurring node.

httpheaders/oth
erHeaders/heade
rItem/name

Specifies the name of the HTTP parameter.

httpheaders/oth
erHeaders/heade
rItem/value

Specifies the value of the HTTP parameter.

Note: If the Content-Length header is explicitly set using the
httpheaders/otherHeaders/headerItem/name and
httpheaders/otherHeaders/headerItem/value, during run time this value is ignored. This activity
automatically sets the Content-Length header to the size of the body.
The following table defines the nodes of the optional httpConnParameter input parameter. You can
optionally override the settings you specified in the Pick Endpoint task of the Checklist dynamically
during run time by passing in values from variables into the nodes specified in the following table. For
example during run time, you can override the Host Name specified in the endpoint, by mapping a
variable to the host node of the httpConnParameter input parameter. During run time, the value of the
variable is the host name used to connect the HTTP server.

Table 3.
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Nodes of the
httpConnParam
eter Input
Parameter Description

Overrides what settings in the HTTP
endpoint?

Nodes of the
httpConnParam
eter Input
Parameter Description

Overrides what settings in the HTTP
endpoint?

timeout Specifies the amount of time in seconds
before a timeout occurs.

 

host Specifies the host name or IP address of
the remote HTTP server.

The host node of the
httpConnParameter input parameter
overrides the Host Name field of the
HTTP endpoint.

port Specifies the port number of the remote
HTTP server.

The port node of the
httpConnParameter input parameter
overrides the Port field of the HTTP
endpoint.

isSecure Set this boolean equal to true to enable
HTTPS - secure HTTP over SSL. Set this
boolean equal to false to disable security.

The isSecure node of the
httpConnParameter input parameter
overrides the Security option in the
HTTP endpoint.

username Specifies the user name for the account
used to connect to the HTTP server.

The username node of the
httpConnParameter input parameter
overrides the User Name field in the
HTTP endpoint.

password Specifies the password for the account
used to connect to the HTTP Server.

The password node of the
httpConnParameter input parameter
overrides the Password field in the
HTTP endpoint.

3. Create a map between the orchestration variable or variables and the input parameter or parameters.
See Creating a map for general instructions on mapping

Mapping the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane of the Map Outputs task as described in the following table:

Table 4.
Output
Parameter Description

httpheaders Specifies the header of the HTTP request.

body Specifies the body of the HTTP request message.

responsecode Specifies the HTTP Response Code that is returned from the HTTP Server during
run time.

responsemessag
e

Specifies the message associated with the HTTP Response Code.

The following table defines the nodes of the optional httpheaders output parameter.  
Table 5.
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Nodes of the
httpheaders Output
Parameter Description

Nodes of the
httpheaders Output
Parameter Description

httpheaders/uri Specifies the resource path of the incoming request, for example: /myPath.

httpheaders/<con
figured_header_n
ame>

If you configured at least one response header in Response Headers step, each
is displayed here. <configured_header_name> is replaced with the actual
header names you selected or entered.

httpheaders/othe
rHeaders/headerI
tem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs. Multiple HTTP header parameters can be specified in the
HTTP request, so this is a recurring node.

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP header parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP header parameter.

2. Create a map between the output parameter or parameters of the activity and orchestration variable or
variables. See Creating a map for general instructions on mapping.

Using certificates with Microsoft Internet Explorer

If you have selected the HTTPS security option in the HTTP endpoint, note that Microsoft Internet Explorer
does not recognize a modified certificate and caches the SSL state. If you modify certificates, you must clear
the SSL state. To clear the SSL state in Microsoft Internet Explorer:

1. From the Microsoft Internet Explorer toolbar menu, select Tools > Internet Options.... The Internet
Options pane is displayed.

2. Click the Content tab.
3. In the Certificates section, click Clear SSL State. The SSL Cache Cleared Successfully dialog box is

displayed.
4. Click OK and click OK.
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HTTP Delete Request activity
The HTTP Delete Request activity sends a Delete Request to the specified location (the HTTP endpoint) and
receives a HTTP response back from that location.

Adding an HTTP Delete Request activity to the orchestration
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1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the HTTP folder.
3. Drag the Delete Request activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing an HTTP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit a HTTP endpoint. See Creating or editing an HTTP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
Field
or
Chec
k
Box Description

URL
(Path
after
Host
nam
e)

Specifies the resource path that the Delete Request activity sends the request to, for example:
/mypath. The string you specify in this field must exclude the string: http://, the hostname, and
the port number of the Integration Appliance. The full URL is automatically constructed from
the host name of the Integration Appliance, the port number specified in the HTTP endpoint
and the path specified in this field. For example, if the full URL that the Delete Request activity
sends the request to is http://myAR:myPort/myPath, in this field you only need to specify the
string: /myPath. The specified path must be unique for the Delete Request activities that are
deployed at the same time on the same Integration Appliance using the same port.

To make use of path parameters and query parameters, enter a URL in this format, "url/{path}?
name1=value1&name2=value2". This allows you to map a string value to the "{path}"
parameter and to specify query parameter names: name1 and name2 in this example. If you
choose to declare multiple "{path}" parameters, each parameter should have a unique name.
Parameters with the same name are represented by only one node in the map. The path
parameters are displayed under /httpheaders/pathParameters in Map Input. Query parameters
are displayed under /httpheaders/queryParameters in Map Input.

Note: In the URL, any value you assign to a query parameter is not passed to the mapper. To
assign a value to the query parameter, either explicitly map a value to the query parameter in
the mapper, or define a default value.
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Field
or
Chec
k
Box Description

Wher
e
Requ
est
Mess
age
is Of
Type

Specifies the message type of the HTTP response - either Text or Binary.

Wher
e
Repl
y
Mess
age
is Of
Type

Specifies the message type of the HTTP reply - either Text or Binary.

Stop
Proc
essin
g the
Orch
estra
tion
Job

or

Conti
nue
Proc
essin
g and
Retur
n the
HTT
P
Error
code

Specifies the run time behavior of the activity if an error response is returned from the HTTP
Server:

Stop Processing the Orchestration Job - Select this option if the orchestration job
should stop processing when an error response is received from the HTTP Server during
run time. The orchestration stops processing in the Delete Request activity and the
activities after the Delete Request activity in the orchestration are not processed and a
failed exception is thrown.
Continue Processing and Return the HTTP Error code - Select this option if the
orchestration job should continue processing when an error response is received from
the HTTP Server during run time. The orchestration job should continue processing
activities after the Post Request activity in the orchestration and the error response code
and the error response message is returned in the responsecode and responsemessage
output parameters, respectively.

Use
Com
press
ion/D
eco
mpre
ssion

Specifies if compression/decompression is turned on or off at the activity level. By default, the
Use Compression/Decompression check box is clear and compression/decompression is
disabled for this activity. Select the Use Compression/Decompression check box to enable
compression/decompression for this activity. For more information, see
Compression/Decompression with the HTTP Invoke/Get/Post/Head/Put/Delete Request
activity
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Specifying the request headers

1. Select the Request Headers task from the Checklist. The Request Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you are prompted
to remove any duplicate headers in the Custom Headers table. The selected HTTP headers are
displayed under /httpheaders in Map Input.

Specifying the response headers

1. Select the Response Headers task from the Checklist. The Response Headers pane is displayed. A
Custom Headers table is displayed at the top, a Include pre-defined standard headers checkbox is
displayed in the middle, and a Standard Headers table is displayed at the bottom.

2. Click the Add button to add a header to the Custom Headers table. Click on the new entry to enter a
header name or select a header name from the drop down list. If the header name is a pre-defined
header name, a description is displayed in the Description column, otherwise enter your own
description for your headers.

3. To use the pre-defined standard headers, check the Include pre-defined standard headers checkbox.
Note that duplicate header names are not allowed (ignoring the case difference) and you are prompted
to remove any duplicate headers in the Custom Headers table. The selected HTTP headers are
displayed under /httpheaders in Map Output.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options to connect to an HTTP Server. The following table defines the retry options

for connecting to an HTTP Server:

Field Description

Retry  

1)
Wait
___
secon
d s
betwe
en
each
retry.

Specifies the amount of time (in seconds) that the Integration Appliance waits before trying to
establish a connection to the HTTP server.

2) Try
to
conne
ct ___
times
before

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the HTTP Server before issuing an error and stopping the
processing of the current orchestration job. If you deploy an orchestration that contains an
HTTP Delete Request activity and the Integration Appliance cannot connect to the specified
HTTP Server, the Integration Appliance logs the connections errors as Warnings in the system
and orchestration logs until the retry count value is reached. When the retry count is reached,
the Integration Appliance logs an error in the system and orchestration logs and the stops
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failing
.

processing the current orchestration job. For example, you set the retry count to 3. The first,
second, and third connection errors appear in the system log as warnings. The Integration
Appliance logs the fourth connection error as an error and stops processing the current
orchestration job.

3)
Time
out
after
___
secon
ds
when
the
Endpo
int
does
not
respo
nd to
a
reque
st.

Specifies the amount of time in seconds before a timeout occurs between the activity making a
request on an Endpoint and the time it takes the Endpoint to respond. For the HTTP Delete
Request activity, the activity timeout is the amount of time that the Integration Appliance
waits for a response from the HTTP Server after sending a HTTP request, before the
Integration Appliance issues a timeout error. An activity timeout is different from a connection
timeout because an activity timeout occurs after the connection to the endpoint has been
established. A connection timeout specifies the amount of time in seconds before a timeout
occurs between the Integration Appliance attempting to establish a connection to the
endpoint and the time it takes for the endpoint to respond to the connection request. You set
the connection timeout in HTTP Endpoint tab. For more information about connection
timeouts, see, Creating or Editing a Web Services Endpoint.

Mapping the input into the activity

1. Select the Map Inputs task in the Checklist. The body input parameter is displayed in the To Activity
pane of the Map Inputs task. The body input parameter is optional. The body input parameter contains
the body of the HTTP response message sent back to the HTTP server.

2. To view the optional input parameter in the To Activity pane of the Map Inputs pane, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity pane and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the
toolbar menu, click on a node in the Map Inputs pane to make this option active. The httpheaders and
httpConnParameter input parameters are displayed.
The following table defines the nodes of the optional httpheaders input parameter:

Table 2.
Nodes of the
httpheaders Input
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/<co
nfigured_header
_name>

If you configured at least one request header in Request Headers step, each is
displayed here. <configured_header_name> is replaced with the actual header
names you selected or entered.

httpheaders/pat
hParameters

If you configured path parameters in the URL in Configure step, each is displayed
here. If no path parameter is specified, this node does not display.

httpheaders/que
ry Parameters

If you configured query parameters in the URL in Configure step, each one of
them will be displayed here. If no query parameter is specified, this node does
not display.
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Nodes of the
httpheaders Input
Parameter Description

httpheaders/oth
erHeaders/heade
rItem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs for the HTTP response. Multiple HTTP parameters can be
specified in the HTTP response, so this is a  recurring node.

httpheaders/oth
erHeaders/heade
rItem/name

Specifies the name of the HTTP parameter.

httpheaders/oth
erHeaders/heade
rItem/value

Specifies the value of the HTTP parameter.

Note: If the Content-Length header is explicitly set using the
httpheaders/otherHeaders/headerItem/name and
httpheaders/otherHeaders/headerItem/value, during run time this value is ignored. This activity
automatically sets the Content-Length header to the size of the body.
The following table defines the nodes of the optional httpConnParameter input parameter. You can
optionally override the settings you specified in the Pick Endpoint task of the Checklist dynamically
during run time by passing in values from variables into the nodes specified in the following table. For
example during run time, you can override the Host Name specified in the endpoint, by mapping a
variable to the host node of the httpConnParameter input parameter. During run time, the value of the
variable is the host name used to connect the HTTP server.

Table 3.
Nodes of the
httpConnParam
eter Input
Parameter Description

Overrides what settings in the HTTP
endpoint?

timeout Specifies the amount of time in seconds
before a timeout occurs.

 

host Specifies the host name or IP address of
the remote HTTP server.

The host node of the
httpConnParameter input parameter
overrides the Host Name field of the
HTTP endpoint.

port Specifies the port number of the remote
HTTP server.

The port node of the
httpConnParameter input parameter
overrides the Port field of the HTTP
endpoint.

isSecure Set this boolean equal to true to enable
HTTPS - secure HTTP over SSL. Set this
boolean equal to false to disable
security.

The isSecure node of the
httpConnParameter input parameter
overrides the Security option in the
HTTP endpoint.

username Specifies the user name for the account
used to connect to the HTTP server.

The username node of the
httpConnParameter input parameter
overrides the User Name field in the
HTTP endpoint.

password Specifies the password for the account
used to connect to the HTTP Server.

The password node of the
httpConnParameter input parameter
overrides the Password field in the
HTTP endpoint.
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3. Create a map between the orchestration variable or variables and the input parameter or parameters.
See Creating a map for general instructions on mapping

Mapping the output of the activity

1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane of the Map Outputs task as described in the following table:

Table 4.
Output
Parameter Description

httpheaders Specifies the header of the HTTP request.

body Specifies the body of the HTTP request message.

responsecode Specifies the HTTP Response Code that is returned from the HTTP Server during
run time.

responsemessag
e

Specifies the message associated with the HTTP Response Code.

The following table defines the nodes of the optional httpheaders output parameter.  
Table 5.

Nodes of the
httpheaders Output
Parameter Description

httpheaders/uri Specifies the resource path of the incoming request, for example: /myPath.

httpheaders/<con
figured_header_n
ame>

If you configured at least one response header in Response Headers step, each
is displayed here. <configured_header_name> is replaced with the actual
header names you selected or entered.

httpheaders/othe
rHeaders/headerI
tem

Specifies an element that contains a set of HTTP header parameters as
name/value pairs. Multiple HTTP header parameters can be specified in the
HTTP request, so this is a recurring node.

httpheaders/othe
rHeaders/headerI
tem/name

Specifies the name of the HTTP header parameter.

httpheaders/othe
rHeaders/headerI
tem/value

Specifies the value of the HTTP header parameter.

2. Create a map between the output parameter or parameters of the activity and orchestration variable or
variables. See Creating a map for general instructions on mapping.

Using certificates with Microsoft Internet Explorer

If you have selected the HTTPS security option in the HTTP endpoint, note that Microsoft Internet Explorer
does not recognize a modified certificate and caches the SSL state. If you modify certificates, you must clear
the SSL state. To clear the SSL state in Microsoft Internet Explorer:

1. From the Microsoft Internet Explorer toolbar menu, select Tools > Internet Options.... The Internet
Options pane is displayed.

2. Click the Content tab.
3. In the Certificates section, click Clear SSL State. The SSL Cache Cleared Successfully dialog box is

displayed.
4. Click OK and click OK.
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Compression/Decompression with the HTTP
Invoke/Get/Post/Head/Put/Delete Request activity

During runtime, the HTTP Invoke/Get/Post/Head/Put/Delete Request activity sends a HTTP request
compliant with the HTTP/HTTPS 1.1 protocol to the HTTP Server.

Note: The HTTP Invoke/Get/Post/Head/Put/Delete Request activity supports compression/decompression
with the gzip or the deflate formats. It does not support the common UNIX file compression format called
compress.

The compression/decompression runtime behavior of the HTTP Invoke/Get/Post/Head/Put/Delete Request
activity is dependant on the following conditions:

If the endpoint supports compression/decompression
The values of the Content-Encoding and Accept-Encoding headers at the message level
The setting of the Use Compression/Decompression check box at the activity level

The affect of these conditions on the compression/decompression runtime behavior of the HTTP
Invoke/Get/Post/Head/Put/Delete Request activity are described in the following sections and in the tables
provided in the Runtime Compression/Decompression Behavior section.

Endpoint support for compression/decompression

The Integration Appliance determines whether or not the HTTP Endpoint supports compression when the
Integration Appliance sends the first HTTP request in the compressed format to the HTTP Endpoint (the HTTP
Server), if the HTTP Server returns an error code indicating that HTTP Server does not support compression or
does not support the specified Content-Encoding type, the Integration Appliance re-sends the first request in
uncompressed format and all subsequent requests to this Endpoint are sent in the uncompressed format. In
addition, the HTTP response sent by the HTTP Server is not decompressed when received by Integration
Appliance.  

Endpoint support for compression/decompression is represented by the column labeled Endpoint Supports
Compression? in the tables provided in the Runtime Compression/Decompression Behavior section.  

Content-Encoding and Accept-Encoding values at the message level

The value of the Content-Encoding header in the HTTP request determines if the body of the request is
compressed and the type of encoding that is used. For example, if the Content-Encoding is equal to deflate, the
Integration Appliance sends the body of the request compressed in the deflate format as shown in the second
row of the first table labeled Compression Behavior When Sending a Request and in the following figure.
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The value of the Accept-Encoding header in the request defines the types of encoding that the HTTP client
accepts in the response. For example, if the Accept-Encoding is equal to gzip,deflate in the request, the HTTP
server can send the body of the response compressed in gzip or deflate formats to the Integration Appliance
(acting as a client) as shown in the following figure:
Figure 1. 

By default, if nothing is mapped to the optional httpheaders input parameter in the Map Inputs task of the
HTTP Invoke/Get/Post/Head/Put/Delete Request activity, a set of default headers are created.  For example,
the URL header is automatically set with the value provided in the Configure pane of the HTTP
Invoke/Get/Post/Head/Put/Delete Request activity.

The values for the Accept-Encoding and Content-Encoding headers for the request can be explicitly set using
name/value pairs in the optional httpheaders input parameter of the Map Inputs task in the HTTP
Invoke/Get/Post/Head/Put/Delete Request activity. For example, to set the Content-Encoding to deflate, set
the following name/value pair in the optional httpheaders input parameter:

httpheaders/httpheaders/otherHeaders/headerItem/name is set to the string: Content-Encoding
httpheaders/httpheaders/otherHeaders/headerItem/value is set to the encoding type, for example
the string: deflate.

If unsupported values or no values are set for the Accept-Encoding and Content-Encoding headers of the
request, default values are provided as shown in the following tables:

Compression behavior when sending a request
Accept-Encoding Header value passed to the request

The values of the Accept-Encoding and Content-Encoding headers in the request are used by the Integration
Appliance and the HTTP server to determine the compression/decompression behavior.

Setting compression/decompression at the activity level

By default, compression/decompression is not used for all HTTP activities. You can select compression or
decompression at the activity level by using the Use Compression/Decompression check box that is displayed
in the Configure task of the activity. The column labeled Use Compression/Decompression Check Box in the
table shown in Runtime Compression/Decompression Behavior represents the setting of the Use
Compression/Decompression check box.
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Note: The Use Compression/Decompression check box will be deprecated in a future release for the HTTP
activities. Use the Content-Encoding and Accept-Encoding HTTP Parameters in the HTTP request to specify
how to decompresses the body of the HTTP request and compress the body of the HTTP response.

Runtime compression/decompression behavior

The table provided in the Compression behavior when sending a request section describes the compression
runtime behavior when the Integration Appliance sends a HTTP request to the HTTP server.

The table provided in the Accept-Encoding Header value passed to the request section describes the value of
the Accept-Encoding header passed in the HTTP request.

The table provided in the Decompression behavior when receiving a response section describes the
decompression runtime behavior when the Integration Appliance receives the HTTP response from the HTTP
server.

Compression behavior when sending a request

The following table describes the compression runtime behavior when the Integration Appliance sends a HTTP
request to the HTTP server.

Use Compression/
Decompression
Check Box (Activity
Level)

Content-Encoding
Value in the HTTP
Request (Message
Level)

Endpoint
Supports
Compress
ion?

Integration Appliance Compression Runtime
Behavior When Sending a Request

selected gzip, not set, or any
other string except
deflate or identity

yes The Integration Appliance sends the body of the
request compressed in the gzip format. The
Content-Encoding header is set to gzip in the
request.

selected deflate yes The Integration Appliance sends the body of the
request compressed in the deflate format. The
Content-Encoding header is set to deflate in the
request.

selected identity yes The Integration Appliance sends the body of the
request uncompressed. The Content-Encoding
header is set to identity in the request.

selected value is not
significant

no The Integration Appliance sends the body of the
 request uncompressed. The Content-Encoding
header is set to identity in the request.

cleared value is not
significant

value is
not
significant

The Integration Appliance sends the body of the
request as is (unchanged). The current value of the
Content-Encoding header is passed as is in the
request.

 

Accept-Encoding Header value passed to the request

The following table describes the value of the Accept-Encoding header passed in the HTTP request.
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Use Compression/
Decompression Check Box
(Activity Level)

Initial Accept-Encoding
Value

Endpoint
Supports
Compression?

Accept-Encoding Value Passed in
the HTTP Request to the Server

Use Compression/
Decompression Check Box
(Activity Level)

Initial Accept-Encoding
Value

Endpoint
Supports
Compression?

Accept-Encoding Value Passed in
the HTTP Request to the Server

selected gzip yes The Accept-Encoding header is set
to gzip in the request.

selected deflate yes The Accept-Encoding header is set
to deflate in the request.

selected gzip,deflate yes The Accept-Encoding header is set
to gzip,deflate in the request.

selected deflate,gzip yes The Accept-Encoding header is set
to deflate,gzip in the request.

selected identity yes The Accept-Encoding header is set
to identity in the request.

selected not set, or any other
string except deflate,
gzip, or identity

yes The Accept-Encoding header is set
to gzip,deflate in the request.

selected value is not significant no The current value of the Accept-
Encoding header is passed as is in
the request.

cleared value is not significant value is not
significant 

The current value of the Accept-
Encoding header is passed as is in
the request.

Decompression behavior when receiving a response

The following table describes the decompression runtime behavior when the Integration Appliance receives
the HTTP response from the HTTP Server.

Use Compression/
Decompression
Check Box (Activity
Level)

Content-Encoding
Value in the HTTP
Response (Message
Level)

Endpoint
Supports
Compress
ion?

Integration Appliance Decompression Runtime
Behavior When Receiving a Response

selected gzip yes The Integration Appliance decompresses the body
of the response using the gzip format.

selected deflate yes The Integration Appliance decompresses the body
of the response using the deflate format.

selected identity yes The Integration Appliance does not decompress the
body of the response.

selected value not listed in
the Accept-Encoding
header

yes The Integration Appliance logs an error that the
response data was received in an unsolicited
content encoding type.

selected value is not
significant

no The Integration Appliance does not decompress the
body of the response. The current value of the
Content-Encoding header is passed as is in the
response.
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Use Compression/
Decompression
Check Box (Activity
Level)

Content-Encoding
Value in the HTTP
Response (Message
Level)

Endpoint
Supports
Compress
ion?

Integration Appliance Decompression Runtime
Behavior When Receiving a Response

cleared value is not
significant

value is
not
significant

The Integration Appliance does not decompress the
body of the response.  The current value of the
Content-Encoding header is passed as is in the
response.
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Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly. Here, you
can find potential solutions for issues you would have with the HTTP connector.

Inconsistent behaviour of query parameters

Problem: The behavior of the query parameters passed to the HTTP receiver varies with the input. This
inconsistency occurs for HTTP Put, Get, Invoke, Header, and Delete outbound activities. For these activities the
URL with query parameters can be set at two places:

Checklist > Configure panel > URL (Path After Hostname)
Checklist > Map Inputs panel > To Activity section > httpheaders > uri

However, the query parameters set in the steps mentioned above can be replaced or overwritten in the Map
Inputs panel > To Activity section > httpheaders > queryParameters. The behavior of the query parameters
passed to the HTTP Receiver varies with the input.

Solution: Consider the following points when setting values:

If the value of the URL is mapped and the value of the parameters are empty, then the URL is passed as
is to the HTTP Receiver.
If the value of the URL and the value of the parameter in the map are also assigned, then the HTTP
Receiver gets the values. The URL with parameter values are appended to the URL.
If value of the URL is not mapped, the url is build dynamically using the parameter values in the input
map.

Example:

Configure panel URI: /xyz/test?query2=c&query3=c&query5=c&query6=c

Map Inputs URI: /xyz/test?query4=u&query3=u
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Map Inputs Query Parameter: query2=m and query3=m

End URL: /xyz/test?query4=u&query3=m&query2=m&query5=&query6=

HTTP connector uses ISO-8859-1 as default character encoding value.

HTTP connector now uses ISO-8859-1 as default character encoding in place of UTF-8.

You can use any one of the following method to change this character encoding value:

Method 1: To resolve the issue, please follow steps below:
1. Go to the HTTP Send Response activity
2. Add response header "Content-Type"
3. In Map Inputs, To Activity body, right click on the body element and click on "Show Optional

Parameters"
4. Expand the (optional)httpheaders, and assign default value below to the "Content-Type" element:

text/plain;charset=UTF-8

Method 2: Introduced new JVM level configuration property. You can change this to the required value.
If you set any value in the HTTP activity, that will take highest priority. Next priority is given to the JVM
level property (if available). If nothing is set in either place, then default value "ISO-8859-1" is used for
content encoding.

Studio

Property name: "ContentEncoding"  
Default value: "ISO-8859-1"

Once the Studio is launched, run jConsole in bin directory of JDK. In New Connection screen,
under Local Process, select the process corresponding to the Studio and click Connect. Under
MBeans tab, navigate to HttpModule > HTTP Loopback > Attributes > ContentEncoding. Change
the default value to the required value.

Appliance

Property name: HTTP_CHARACTER_ENCODING  
Default value: ""

Setting this attribute on the appliance will require system shell access to enable/disable jmxport.
In system shell, issue the following command to check if any value is set for the property:

ihconfutil lookup /var/sysconf sysconf.db HTTP_CHARACTER_ENCODING

User will get output like:

ContentEncodingv: []

Now, try to set the value true to this property.

ihconfutil add /var/sysconf sysconf.db HTTP_CHARACTER_ENCODING <new value>

Now verify the value set using:

ihconfutil lookup /var/sysconf sysconf.db HTTP_CHARACTER_ENCODING

This results in

ContentEncodingv: [<new value>] 

The hierarchy in appliance is
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1. Jconsole property
2. Config property
3. Default value

If you want to change the value at runtime without restarting appliance you can use jconsole for
appliance, but if you want to set the value and make it permanent, then you have to set in config
properties. If nothing is set for both properties default (ISO-8859-1) is used.
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JDE Activities
Overview of the JD Edwards (JDE) connector
Creating or editing an endpoint for a JDE activity
Endpoints provide the configuration information that Studio and the Integration Appliance use to
connect to a JD Edwards EnterpriseOne transaction server (JDE server).  
Importing JDE Libraries
You must import JDE instance-specific libraries on both Studio and the Integration Appliance before you
can configure JDE endpoints, build orchestrations that use the JDE Connector, and deploy projects using
the JDE Connector.
Installing JAR files to connect to the JDE server
You must copy the JDE JAR files on the same workstation as your Cast Iron Studio installation before
you can connect to a JD Edwards EnterpriseOne transaction server (JDE server).
Using the JDE Invoke Business Function activity
Use the JDE Invoke Business Function activity to call a specific JDE business function. You can map the
resulting output from this activity to an orchestration.
Using the JDE Poll Real-Time Events activity
Use the JDE Poll Real-Time Events activity to poll real-time events from JD Edwards EnterpriseOne
transaction server. A real-time event is a business transaction that provides information from the JD
Edwards EnterpriseOne server that can be used to interoperate with a vendor system. Real-time events
can be generated wherever business functions run, such as HTML, WIN32, and enterprise servers. Real-
time events are useful for producing notifications in real-time.
Specifying Retry and Delivery Options for JDE Activities
Specifying the Retry and Delivery parameters is one of the tasks to configure a JDE activity
configuration.
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Overview of the JD Edwards (JDE) connector
The JD Edwards (JDE) connector provides the ability for the appliance to interact with the JD Edwards
EnterpriseOne server and perform certain business functions, without the need for special coding. The
connector works with the JD Edwards EnterpriseOne server by sending requests to it and by monitoring and
responding to events that occur in the JD Edwards EnterpriseOne server.

You can complete the following activities using the JDE connector:

Invoke Business Function
Poll Real-Time Events

The JDE connector supports the following versions of JDE Tools: 8.97, 8.98, and 9.1 (for Invoke Business
Function). The connector is compatible with any version of JD Edwards EnterpriseOne that works with the
supported versions of EnterpriseOne Tools.

The JDE connector requires JDE library files to connect to the JDE server. For more information, see Installing
JAR files to connect to the JDE server and Importing JDE Libraries.
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Creating or editing an endpoint for a JDE activity
Endpoints provide the configuration information that Studio and the Integration Appliance use to connect to a
JD Edwards EnterpriseOne transaction server (JDE server).  

1. In the Create Endpoint or Edit Endpoint pane, configure the JDE server as described in the following
table. The endpoint pane contains Connection Information, Connection Pool Options and Remote
Endpoint Configuration.
Note: Changing the configuration properties of an endpoint affects all orchestrations that use that
endpoint in the project. The edits are global, not local.

2. Click Test Connection to confirm that the connection details are valid and you are able to connect to the
JDE server successfully.

3. Click OK.

Table 1. Connection properties
Field Name Description

Connection Information

Environment Specifies the JD Edwards EnterpriseOne environment name.
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Field Name Description

Role Specifies the name of the role that is associated with the user name used to access the
JD Edwards EnterpriseOne environment.

User Name Specifies the user name to connect to the JDE server.

Password Specifies the password associated with the user name to connect to the JDE server.

Connection Pool options

Minimum
Connections

Specifies the lowest number of JDE server connections that the Integration Appliance
keeps open in the connection pool. Entering 0 (zero) is supported. The default value is
5.

Maximum
Connections

Specifies the maximum number of JDE server connections that the Integration
Appliance can keep open in the connection pool. Entering 0 (zero) means the
maximum number of connections is unbounded. The default value is 25.

Maximum Idle Time Specifies the amount of time in minutes that a JDE server connection can be open in an
idle state before being closed by the Integration Appliance. Entering 0 (zero) means
that the connections are closed when they are returned to the pool — no idle time. The
default value is 120 minutes.

Maximum Wait Specifies the amount of time in seconds that the Integration Appliance waits for a
connection when all the connections in the pool are exhausted. If no connection is
obtained after the wait time, an exception is thrown. The default value is 300 seconds.

Reclaim
Connections

Specifies the interval at which the connector checks for idle connections. Idle
connections are reclaimed until the minimum number of connections is reached, as
specified in the Minimum Connections parameter. The default value is 5 minute.

Note: The Connection pool properties need to be configured as per the load (number of concurrent requests)
on the endpoint.

Remote Endpoint Configuration

Endpoint Runs
Behind Firewall

Enables the secure connector name property so that secure connector can be used if
the JDE server is running behind a firewall.

Secure Connector
Name

Specifies the name of the secure connector that is used to connect to the JDE server
running behind a firewall. For example, if an orchestration containing JDE activity is
deployed on to Cast Iron Live (cloud), then the secure connector needs to be
configured.
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Importing JDE Libraries
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You must import JDE instance-specific libraries on both Studio and the Integration Appliance before you can
configure JDE endpoints, build orchestrations that use the JDE Connector, and deploy projects using the JDE
Connector.

About this task

For information about installing the required library files on the Integration Appliance using the Web
Management Console (WMC), see the WMC Online Help

Procedure

To get copies of the required JDE provider modules:

1. Log on to the instance of your JDE system.
2. Import the following JDE files to the workstation where Studio is installed:

ApplicationAPIs_JAR.jar
ApplicationLogic_JAR.jar
Base_JAR.jar
BizLogicContainer_JAR.jar
BizLogicContainerClient_JAR.jar
BusinessLogicServices_JAR.jar
castor.jar
classes12.zip
commons-httpclient-3.0.jar
Connector.jar
EventProcessor_EJB.jar
EventProcessor_JAR.jar
Generator_JAR.jar
JdbjBase_JAR.jar
JdbjInterfaces_JAR.jar
JdeNet_JAR.jar
jmxremote.jar
jmxremote_optional.jar
jmxri.jar
log4j.jar
ManagementAgent_JAR.jar
Metadata.jar
MetadataInterface.jar
ojdbc14.jar
PMApi_JAR.jar
Spec_JAR.jar
System_JAR.jar
SystemInterfaces_JAR.jar
xalan.jar
xerces.jar
xmlparserv2.jar
jdelog.properties
tnsnames.ora
jdbj.ini
jdeinterop.ini

Note: You also need to add database driver JAR files. These JAR files depend on the JD Edwards
Enterprise One server version and the database used. For more information about the required JAR list,
contact the Oracle Support team.

392   



3. After retrieving the required files, use the Add Providers dialog box to install the JDE files into Studio.
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Installing JAR files to connect to the JDE server
You must copy the JDE JAR files on the same workstation as your Cast Iron Studio installation before you can
connect to a JD Edwards EnterpriseOne transaction server (JDE server).

Before you begin

The JAR files can be obtained from the JDE system administrator.
The JAR files must be on the same computer as the studio installation.
The JAR files must be from the same version as the JDE server you connect to.

For more information about importing the JAR files, see Importing JDE Libraries.

About this task

Procedure

1. Open studio and select Tools > Install Module Providers.
2. When the Add Provider(s) dialog box is displayed, click the plus (+) button under JDE. A field and a

Browse button appears.
3. Click Browse, and use the browse dialog box to locate and select the JAR files.
4. Click Open to import the selected files.
5. When the JAR files are listed in the Add Provider(s) dialog box, click OK.

Results

A prompt is displayed to restart studio and activate the changes.

What to do next

You can now create JDE endpoints and orchestrations.

Parent topic: JDE Activities

Feedback | Notices

 393



 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/JDEnewinstalling_jarfiles.html

Using the JDE Invoke Business Function activity
Use the JDE Invoke Business Function activity to call a specific JDE business function. You can map the
resulting output from this activity to an orchestration.

Before you begin

Ensure that you have:

Imported the JDE library files required to connect to the JDE server. For more information, see Installing
JAR files to connect to the JDE server.
Valid connection details to connect to the JDE server.

About this task

Use this task to call a specific JDE business function from the JDE server. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the JDE folder.
2. Drag the Invoke Business Function activity icon onto the orchestration. The JDE Invoke Business

Function Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant JDE endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a JDE activity.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. In the JDE Business Function panel, click Browse to browse for business function names.
11. In Browse JDE Business Functions dialog, select one or more business functions from the Business

Function List, and add it to the Selected Business Functions pane.
12. The Business Function Container field gets populated based on the first business function selected and

click OK. You can also type the desired business function container name.

The selected business functions are displayed in the Configure panel.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying Retry and Delivery Options for JDE Activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Invoke Business Function activity are displayed as nodes under the request input parameter in the To
Activity panel.
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15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the JDE Invoke Business Function activity.
Parent topic: JDE Activities
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Using the JDE Poll Real-Time Events activity
Use the JDE Poll Real-Time Events activity to poll real-time events from JD Edwards EnterpriseOne transaction
server. A real-time event is a business transaction that provides information from the JD Edwards
EnterpriseOne server that can be used to interoperate with a vendor system. Real-time events can be
generated wherever business functions run, such as HTML, WIN32, and enterprise servers. Real-time events
are useful for producing notifications in real-time.

Before you begin

Ensure that you have:

Imported the JDE library files required to connect to the JDE server. For more information, see Installing
JAR files to connect to the JDE server.
Valid connection details to connect to the JDE server.

About this task

Use this task to poll real-time events from JD Edwards EnterpriseOne transaction server.

Procedure

1. In an active orchestration, open the Activities tab and expand the JDE folder.
2. Drag the Poll Real-Time Events activity icon onto the orchestration. The JDE Poll Real-Time Events

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
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5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant JDE endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a JDE activity.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. In the JDE Real-Time Events panel, click Browse to browse for real-time events. The Browse JDE Real-

Time Events dialog is displayed.
11. In Browse JDE Real-Time Events dialog, select a real-time event from the list and click OK. The selected

real-time event is displayed in the Configure panel.
12. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying Retry and Delivery Options for JDE Activities.
13. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity

is displayed as nodes under the response output parameter in the From Activity panel.
14. Create a map between the output parameters and orchestration variables.

Results

You have configured the JDE Poll Real-Time Events activity.
Parent topic: JDE Activities
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Specifying Retry and Delivery Options for JDE Activities
Specifying the Retry and Delivery parameters is one of the tasks to configure a JDE activity configuration.

About this task

This section contains the procedure for configuring the retry options for JDE outbound and inbound activities.

Procedure

1. Select the Retry task from the Checklist. The retry pane is displayed.
2. Configure the retry options for connecting to a JD Edwards EnterpriseOne transaction server as

described in the following table.
Table 1. Retry options

Ret
ry
Fie
lds Description

396   



Ret
ry
Fie
lds Description

Wai
t __
sec
ond
s
bet
we
en
eac
h
retr
y.

Specifies the number of seconds that the Integration Appliance waits before trying to establish a
connection to the JD Edwards EnterpriseOne transaction server.

Try
to
con
nec
t __
tim
es
bef
ore
faili
ng.

Specifies the retry count — the maximum number of times the Integration Appliance attempts to
establish a connection to the JDE server before issuing an error and stopping the processing of
the current orchestration job.
Note: If you deploy an orchestration that contains the inbound or outbound JDE activity and the
Integration Appliance cannot connect to the specified JDE server, the Integration Appliance logs
the connections errors as Warnings in the system and orchestration logs until the retry count
value is reached. When the retry count is reached, the Integration Appliance logs an Error in the
system and orchestration logs and stops processing the current orchestration job. For example,
you set the retry count to 3. The first, second, and third connection errors appear in the system
log as warnings. The Integration Appliance logs the fourth connection error as an error and stops
processing the current orchestration job.

Parent topic: JDE Activities

Specifying the delivery rules options for JDE inbound activities

About this task

This section contains the procedure for configuring the delivery rule options for JDE inbound activities.

Procedure

1. Select the Delivery Rules task from the Checklist. The delivery rules pane is displayed.
2. Configure the delivery rules options to select the activity's behavior as described in the following table.

Table 2. Delivery rules
Delivery Rules Fields Description

Poll for changes every
______
days/hours/minutes/sec
onds

Specifies the time interval to poll for real-time events in the JD Edwards
EnterpriseOne transaction server. Time can be selected in the format days,
hours, minutes, or seconds.

Fetch ______ rows per
poll

Specifies how many real-time events the activity should retrieve from the
JD Edwards EnterpriseOne transaction server in each poll cycle.

Delivery Messages
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Delivery Rules Fields Description

ATMOST_ONCE A non-persistent mode in which a JDE real-time event is either delivered
once or not delivered at all.

Wait time on JDE
transaction
server______seconds

Specifies the time interval that the connector waits to get an event from the
JD Edwards EnterpriseOne transaction server.
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JMS Activities
Creating or editing a JMS endpoint
JMS endpoints provide information that Studio and the Integration Appliance use to connect to a JMS
instance.
Specifying delivery rules and retry parameters for JMS activities
The JMS Connector uses a single login session for all connections to a JMS endpoint. If a session
expires, the connector automatically establishes a new session. The JMS Connector does not count the
initial attempt to reacquiring the session as a retry attempt. The JMS Connector assumes the typical
connector retry behavior after the initial attempt to reacquire a session fails.
Get Message activity
You can use the Get Message activity to get a message from the queue. If there is no message present
the activity can time out.
Poll Message activity
The Poll Message activity is a starter activity that polls the configured queue for the message. This
activity supports the ATLEAST ONCE and EXACTLY ONCE delivery semantics. The Poll Message Activity
supports batching, if the batching option is selected.
Publish Message activity
The Publish Message activity is an executable activity that allows you to publish data on the configured
topic. This activity supports the ATLEAST ONCE and ATMOST ONCE delivery semantics.
Send Message activity
The Send Message activity is an executable activity that sends message to the configured queue. The
Send Message activity supports the AT LEAST and AT MOST ONCE delivery semantics. Request-reply use
cases can use the Poll Message and Send Message activity; there is no separate activity for reply.
Subscribe Message activity
The Subscribe Message activity is a starter activity that allows you to subscribe to a JMS topic. This
activity supports the ATLEAST ONCE and EXACTLY ONCE delivery semantics.
Creating a JMS endpoint to a WebLogic server
You can define a JMS endpoint to an existing WebLogic server, by completing the following steps in IBM
Cast Iron Studio.
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Creating or editing a JMS endpoint
JMS endpoints provide information that Studio and the Integration Appliance use to connect to a JMS instance.

About this task

Any changes you make to the endpoint, including configuration properties, affects all orchestrations that use
that endpoint as the edits are global, not local.

Procedure

1. Drag an activity from the JMS folder of the Activities tab onto the orchestration.
2. The Summary panel is displayed along with a Checklist, which outlines what you must do to configure

the activity.
3. Click Pick Endpoint from the Checklist. The Pick Endpoint panel opens.
4. Click one of the following options:

Browse - To select an existing endpoint from the Project Explorer. The Project Explorer shows all
the endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel. To edit the endpoint properties, click Edit.
New - To create a new endpoint. The Create Endpoint window opens.
Edit - To edit the existing endpoint. The Edit Endpoint window opens.
Note: Editing an endpoint affects all orchestrations that use that endpoint in the project as the
edits are global, not local.

5. In the Create Endpoint window, specify connection parameters or select a configuration property by
clicking the icon to the right of the fields. Required fields are denoted by the following icon 

Connection
Parameter
Fields Description

JNDI Initial
Factory

Specifies the context factory class Studio retrieves from JNDI. Studio uses the class
to lookup JMS connection factory and JMS destinations (Queue or Topic).

Provider URL Specifies the URL of the JMS server.

Provider
Package

An optional parameter, where you can specify a provider package name.

Factory Name Use your own connection factory or use one of the default factories that comes
preconfigured with the endpoint system: JBOSS, ActiveMQ, or WebLogic.

Specify Provider login information, which includes user name and password.
Specify Connection Pool Options.

Connection
Pool Options Description

Minimum
Connections

Specifies the minimum number of connections that Studio uses to connect to a
JMS instance. By default, there is a minimum of 1 connection.
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Maximum
Connections

Specifies the maximum number of connections that Studio uses to connect to a
JMS instance. By default, there is a maximum of 25 connections.

Maximum
Idle Time

By default, maximum idle time is 120 minutes.

Maximum
Wait

By default, maximum wait time is 300 seconds.

6. Specify properties for the JNDI Provider, so you can set implementation specific JDNI initial context
properties for tasks such as authentication.

a. Click  to add a field in the JNDI Provider table. A new row is displayed in the table.
b. Enter a property name and value.

7. Specify properties for the Connection Factory, so you can set implementation specific connection
properties.

a. Click  to add a field in the Connection Factory table. A new row is displayed in the table.
b. Enter a property name and value.

8. Click Test Connection to confirm that the parameters you specified so that the project can access a JMS
instance.
Note: When you configure an endpoint using configuration properties, verify that the configuration
properties have valid values. If the configuration property value is invalid or does not exist, the
connection test fails.

Parent topic: JMS Activities
Related tasks:
Get Message activity
Poll Message activity
Publish Message activity
Send Message activity
Subscribe Message activity
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Specifying delivery rules and retry parameters for JMS
activities

The JMS Connector uses a single login session for all connections to a JMS endpoint. If a session expires, the
connector automatically establishes a new session. The JMS Connector does not count the initial attempt to
reacquiring the session as a retry attempt. The JMS Connector assumes the typical connector retry behavior
after the initial attempt to reacquire a session fails.

Specifying delivery rules parameters for JMS activities
Specifying the Delivery Rules parameters is one of the tasks you must complete to configure a JMS
activity.
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Specifying retry parameters for JMS activities
Specifying the Retry parameters is one of the tasks you must complete to configure a JMS activity.

Parent topic: JMS Activities
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Specifying delivery rules parameters for JMS activities
Specifying the Delivery Rules parameters is one of the tasks you must complete to configure a JMS activity.

About this task

For more information about the configuration tasks in the Checklist, see the help topic for the specific JMS
activity.

Procedure

1. In the Checklist, select Delivery Rules. The Delivery Rules panel opens.
2. For the Poll Message activity only, specify the polling interval. By default, the activity polls for changes

every second.
3. Select Batch objects to process the job as a batch.
4. Select one of the following delivery options.

Note: The delivery options available depend on the JMS activity. Not all delivery options are available for
every JMS activity.

Deliver
y
Option Description

ATLEAS
T_ONCE

A persistent mode, in which the JMS Provider insures that a message is not lost. As a result,
there are chances that the client can receive multiple copies of a single message. 

ALMOS
T_ONCE

In this non-persistent mode, a message may be lost, but JMS does not deliver multiple
copies of a message.  

EXACTL
Y_ONC
E

In this persistent mode, JMS delivers a message once and only once.

Parent topic: Specifying delivery rules and retry parameters for JMS activities

Feedback | Notices
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Specifying retry parameters for JMS activities
Specifying the Retry parameters is one of the tasks you must complete to configure a JMS activity.

About this task

For more information about the configuration tasks in the Checklist, see the help topic for the specific JMS
activity.

Procedure

1. In the Checklist, select Retry. The Retry panel opens.
2. Configure the retry options for connecting to a JMS instance. The following table describes the retry

options for connecting to a JMS instance:

Retry
Fields Description

Wait __
second(s)
between
each retry.

The number of seconds that the Integration Appliance waits before trying to establish a
connection to the JMS instance. By default, this parameter is set to 30 seconds

Try to
connect __
times
before
failing.

Specifies the retry count, the maximum number of times that the Integration Appliance
attempts to establish a connection to the JMS instance before issuing an error and
stopping the processing of the current orchestration job. By default this parameter is set
to 5 attempts. 

3. For the Get Message activity, specify a value for the Activity Timeout parameter.

Parent topic: Specifying delivery rules and retry parameters for JMS activities
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Get Message activity
You can use the Get Message activity to get a message from the queue. If there is no message present the
activity can time out.
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About this task

The Get Message Activity supports batching, if the batching option is selected. When the batching option is
selected, if there is more than one message in the queue, the activity processes all the messages at once,
instead of processing them one at a time.
Important: This orchestration must already have a JMS endpoint representing the data source. Otherwise,
input and output mapping is disabled.

Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Get Message activity
Mapping the Inputs
Inputs represent data that is transmitted from the orchestration (variables) to the JMS endpoint
(parameters).
Mapping the Outputs
Outputs represent data that is transmitted from the JMS activity (parameters) to the orchestration
(variables).

Parent topic: JMS Activities
Related tasks:
Creating or editing a JMS endpoint
Poll Message activity
Publish Message activity
Send Message activity
Subscribe Message activity
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Adding a JMS activity to an orchestration

Procedure

1. In an active project, open the Activities tab and expand the JMS folder contents.
2. Drag the Get Message activity icon to the orchestration.
3. When the activity is displayed, the Get Message Checklist is displayed underneath.

Parent topic: Get Message activity
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Changing the Activity Name

Procedure

1. In the Checklist, click Summary.
2. Review the contents of the Activity Name field and make any required changes.

Parent topic: Get Message activity
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Picking a JMS endpoint

Procedure

1. In the Checklist, click Pick Endpoint.
2. Click Browse and use the Project Explorer dialog box to select the relevant JMS endpoint.

Tip: You can create the needed endpoint at this time by clicking New.
3. When you click OK, the endpoint-specific configuration options are displayed in a read-only state.

Note: If changes are required to the selected endpoint configuration, click Edit to activate the options.
Any changes you make globally affects all uses of the endpoint in active orchestrations.

Parent topic: Get Message activity
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Configuring the Get Message activity

Procedure
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1. In the Checklist, click Configure.
2. In the Queue field, specify the provider-specific name of the queue to be polled.
3. Open the Message Data menu and choose the format the message takes, whether Bytes or Text.
4. In the Message Selector field, enter the text of a message header.

Using the JMS message selector a client can specify, by submitting the text of a message header, those
messages it is interested in. Only messages whose headers and properties match the selector are
delivered. Message selectors cannot reference message body values. The message selector string must
follow JMS selector syntax.

5. In the Checklist, click Delivery Rules.
6. Click the Batch Objects checkbox to activate the option, which enables the activity to batch-process

multiple messages.
7. Open the Deliver menu and choose either option: ATLEAST_ONCE or ATMOST_ONCE
8. In the Checklist, click Retry.
9. Review the default settings and make any needed changes.

For more information, see Specifying retry parameters for JMS activities

Parent topic: Get Message activity
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Mapping the Inputs
Inputs represent data that is transmitted from the orchestration (variables) to the JMS endpoint (parameters).

Before you begin

If required, you can create a custom mapping variable in Source or Destination column by following the steps in
Creating variables.

Procedure

1. In the Checklist, click Map Inputs. A set of options is displayed, and the To Activity list shows the JMS
variables.

2. Click Select Inputs.

The Select Inputs dialog box lists all the variables.

3. Choose a variable, then click OK.
4. To link the activities, click and drag a variable from the From Orchestration list onto a parameter listed in

the To Activity list.

If the link is viable, a line is displayed, linking the two.
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5. Repeat this procedure to link other orchestration variables to JMS parameters.
6. To test the input links, click the Test button.

The Input Test Files table lists all linked variables/parameters.

7. In the Location column, click the small blue button.
8. Use the Browse dialog box to select an input test file.
9. Click Run Test. Test results are displayed in the columns underneath.

Tip: You can replace a variable used in the map without changing the links of the map. For more
information, see Replacing a Variable used in a Map.

Parent topic: Get Message activity
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Mapping the Outputs
Outputs represent data that is transmitted from the JMS activity (parameters) to the orchestration (variables).

Before you begin

If required, you can create a custom mapping variable in the Source or Destination column by following the
steps in Creating variables

Procedure

1. In the Checklist, click Map Outputs.
2. Review the parameters listed in the From Activity list.
3. If you want to create new orchestration variables that match the output parameters of the current

activity, select a parameter and then click Copy.
4. In the Copy Parameters dialog box, choose one or more parameters, then click OK to add them to the To

Orchestration list. The data type, schema, or schema fragment of the selected output parameter is
applied to the new variable.

5. Click Select Inputs.

The Select Inputs dialog box lists all the variables associated with the other endpoint.

6. Choose one or more variables, then click OK to add them to this list.
7. Drag a parameter from the From Activity list onto a variable listed in the To Orchestration list.

If the link is viable, a line is displayed, linking the two.

8. Repeat this procedure to link other parameters and variables.
9. To test the output links, click the Test button. A variable is listed in an Input Test Files table.

10. In the Location column, click the small blue button.
11. Use the Browse dialog box to select an input test file.
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12. Click Run Test. Test results are displayed in the columns underneath.
Tip: You can replace a variable used in the map without changing the links of the map. For more
information, see Replacing a Variable used in a Map.

Parent topic: Get Message activity
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Poll Message activity
The Poll Message activity is a starter activity that polls the configured queue for the message. This activity
supports the ATLEAST ONCE and EXACTLY ONCE delivery semantics. The Poll Message Activity supports
batching, if the batching option is selected.

About this task

The EXACTLY ONCE delivery semantic is handled through the message acknowledgement. Since the JMS
provider must never deliver a copy of an acknowledged message, the Poll Message activity leverages the
provider for the EXACTLY_ONCE delivery semantic. When the batching option is selected, if there is more than
one message in the queue, the activity processes all the messages at once, instead of processing them one at a
time.
Important: This orchestration must have a JMS endpoint representing the data source, otherwise, output
mapping is disabled.

Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Poll Message activity
Mapping the Outputs
Outputs represent data that is transmitted from the JMS activity (parameters) to the orchestration
(variables).

Parent topic: JMS Activities
Related tasks:
Creating or editing a JMS endpoint
Get Message activity
Publish Message activity
Send Message activity
Subscribe Message activity
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Adding a JMS activity to an orchestration

Procedure

1. In an active project, open the Activities tab and expand the JMS folder contents.
2. Drag the Poll Message activity icon to the orchestration.
3. When the activity is displayed, the Poll Message Checklist is displayed underneath.

Parent topic: Poll Message activity
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Changing the Activity Name

Procedure

1. In the Checklist, click Summary.
2. Review the contents of the Activity Name field and make any required changes.

Parent topic: Poll Message activity
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Picking a JMS endpoint

Procedure

1. In the Checklist, click Pick Endpoint.
2. Click Browse and use the Project Explorer dialog box to select the relevant JMS endpoint.

Tip: You can create the needed endpoint at this time by clicking New.
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3. When you click OK, the endpoint-specific configuration options are displayed in a read-only state.
Note: If changes are required to the selected endpoint configuration, click Edit to activate the options.
Any changes you make globally affects all uses of the endpoint in active orchestrations.

Parent topic: Poll Message activity
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Configuring the Poll Message activity

Procedure

1. In the Checklist, click Configure.
2. In the Queue field, specify the provider-specific name of the queue to be polled.
3. Open the Message Data menu and choose the format the message takes, whether Byte or Text.
4. In the Message Selector field, enter the text of a message header.

Using a JMS message selector a client can specify, by submitting the text of a message header, those
messages it is interested in. Only messages whose headers and properties match the selector are
delivered. Message selectors cannot reference message body values. The message selector string must
follow JMS selector syntax.

5. In the Checklist, click Delivery Rules.
6. In the Poll for changes field, select the preferred interval number.
7. Click the Batch Objects checkbox to activate the option, which enables the activity to batch-process

multiple messages.
8. Open the Deliver menu and choose either option: ATLEAST_ONCE, ATMOST_ONCE, or EXACTLY_ONCE
9. In the Checklist, click Retry.

10. Review the default settings and make any needed changes.

For more information, see Specifying retry parameters for JMS activities

Parent topic: Poll Message activity
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Mapping the Outputs
Outputs represent data that is transmitted from the JMS activity (parameters) to the orchestration (variables).

Before you begin

If required, you can create a custom mapping variable in the Source or Destination column by following the
steps in Creating variables

Procedure

1. In the Checklist, click Map Outputs.
2. Review the parameters listed in the From Activity list.
3. If you want to create new orchestration variables that match the output parameters of the current

activity, select a parameter and then click Copy.
4. In the Copy Parameters dialog box, choose one or more parameters, then click OK to add them to the To

Orchestration list. The data type, schema, or schema fragment of the selected output parameter is
applied to the new variable.

5. Click Select Inputs.

The Select Inputs dialog box lists all the variables associated with the other endpoint.

6. Choose one or more variables, then click OK to add them to this list.
7. Drag a parameter from the From Activity list onto a variable listed in the To Orchestration list.

If the link is viable, a line is displayed, linking the two.

8. Repeat this procedure to link other parameters and variables.
9. To test the output links, click the Test button. A variable is listed in an Input Test Files table.

10. In the Location column, click the small blue button.
11. Use the Browse dialog box to select an input test file.
12. Click Run Test. Test results are displayed in the columns underneath.

Tip: You can replace a variable used in the map without changing the links of the map. For more
information, see Replacing a Variable used in a Map.

Parent topic: Poll Message activity
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Publish Message activity
The Publish Message activity is an executable activity that allows you to publish data on the configured topic.
This activity supports the ATLEAST ONCE and ATMOST ONCE delivery semantics.

About this task
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This orchestration must already have a JMS endpoint representing the data source, otherwise, input mapping is
disabled.

Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Publish Message activity
Mapping the Inputs
Inputs represent data that is transmitted from the orchestration (variables) to the JMS endpoint
(parameters).

Parent topic: JMS Activities
Related tasks:
Creating or editing a JMS endpoint
Get Message activity
Poll Message activity
Send Message activity
Subscribe Message activity

Feedback | Notices
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Adding a JMS activity to an orchestration

Procedure

1. In an active project, open the Activities tab and expand the JMS folder contents.
2. Drag the Publish Message activity icon to the orchestration.
3. When the activity is displayed, the Publish Message Checklist is displayed underneath.

Parent topic: Publish Message activity
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Changing the Activity Name
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Procedure

1. In the Checklist, click Summary.
2. Review the contents of the Activity Name field and make any required changes.

Parent topic: Publish Message activity
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Picking a JMS endpoint

Procedure

1. In the Checklist, click Pick Endpoint.
2. Click Browse and use the Project Explorer dialog box to select the relevant JMS endpoint.

Tip: You can create the needed endpoint at this time by clicking New.
3. When you click OK, the endpoint-specific configuration options are displayed in a read-only state.

Note: If changes are required to the selected endpoint configuration, click Edit to activate the options.
Any changes you make globally affects all uses of the endpoint in active orchestrations.

Parent topic: Publish Message activity
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Configuring the Publish Message activity

Procedure

1. In the Checklist, click Configure.
2. In the Topic field, specify a provider-specific name that identifies a topic to the JMS system.
3. Open the Message Data menu and choose the format the message takes, whether Byte or Text.
4. In the Reply To field, specify the name of the destination receiving the reply message.
5. In the Time to Live field, specify the time in seconds until the message expires (0 sets a no-expiry state).
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6. In the Priority field, select a number that represents the message priority (0-4: lower priorities, 5-9:
higher priorities).

7. In the Checklist, click Delivery Rules.
8. Click the Batch Objects checkbox to enable the activity to batch-process multiple messages.
9. Open the Deliver menu and choose either option: ATLEAST_ONCE or ATMOST_ONCE

10. In the Checklist, click Retry.
11. Review the default settings and make any required changes.

For more information, see Specifying retry parameters for JMS activities

Parent topic: Publish Message activity
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Mapping the Inputs
Inputs represent data that is transmitted from the orchestration (variables) to the JMS endpoint (parameters).

Before you begin

If required, you can create a custom mapping variable in Source or Destination column by following the steps in
Creating variables.

Procedure

1. In the Checklist, click Map Inputs. A set of options is displayed, and the To Activity list shows the JMS
variables.

2. Click Select Inputs.

The Select Inputs dialog box lists all the variables.

3. Choose a variable, then click OK.
4. To link the activities, click and drag a variable from the From Orchestration list onto a parameter listed in

the To Activity list.

If the link is viable, a line is displayed, linking the two.

5. Repeat this procedure to link other orchestration variables to JMS parameters.
6. To test the input links, click the Test button.

The Input Test Files table lists all linked variables/parameters.

7. In the Location column, click the small blue button.
8. Use the Browse dialog box to select an input test file.
9. Click Run Test. Test results are displayed in the columns underneath.
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Tip: You can replace a variable used in the map without changing the links of the map. For more
information, see Replacing a Variable used in a Map.

Parent topic: Publish Message activity
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Send Message activity
The Send Message activity is an executable activity that sends message to the configured queue. The Send
Message activity supports the AT LEAST and AT MOST ONCE delivery semantics. Request-reply use cases can
use the Poll Message and Send Message activity; there is no separate activity for reply.

About this task

This orchestration must already have a JMS endpoint representing the data source, otherwise, input mapping is
disabled.

Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Send Message activity
Mapping the Inputs
Inputs represent data that is transmitted from the orchestration (variables) to the JMS endpoint
(parameters).

Parent topic: JMS Activities
Related tasks:
Creating or editing a JMS endpoint
Get Message activity
Poll Message activity
Publish Message activity
Subscribe Message activity

Feedback | Notices
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Adding a JMS activity to an orchestration
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Procedure

1. In an active project, open the Activities tab and expand the JMS folder contents.
2. Drag the Send Message activity icon to the orchestration.
3. When the activity is displayed, the Send Message Checklist is displayed underneath.

Parent topic: Send Message activity
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Changing the Activity Name

Procedure

1. In the Checklist, click Summary.
2. Review the contents of the Activity Name field and make any required changes.

Parent topic: Send Message activity

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/JMS_Send_Changing_Activity_Name.ht
ml

Picking a JMS endpoint

Procedure

1. In the Checklist, click Pick Endpoint.
2. Click Browse and use the Project Explorer dialog box to select the relevant JMS endpoint.

Tip: You can create the needed endpoint at this time by clicking New.
3. When you click OK, the endpoint-specific configuration options are displayed in a read-only state.

Note: If changes are required to the selected endpoint configuration, click Edit to activate the options.
Any changes you make globally affects all uses of the endpoint in active orchestrations.

Parent topic: Send Message activity
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Configuring the Send Message activity

Procedure

1. In the Checklist, click Configure.
2. In the Queue field, specify a provider-specific name of the queue to be sent.
3. Open the Message Data menu and choose the format the message takes, whether Bytes or Text.
4. In the Reply To field, specify the name of the destination receiving the reply message.
5. In the Time to Live field, specify the time in seconds until the message expires (0 sets a no-expiry state).
6. In the Priority field, select a number that represents the message priority (0-4: lower priorities, 5-9:

higher priorities).
7. In the Checklist, click Delivery Rules.
8. Click the Batch Objects checkbox to enable the activity to batch-process multiple messages.
9. Open the Deliver menu and choose either option: ATLEAST_ONCE or ATMOST_ONCE

10. In the Checklist, click Retry.
11. Review the default settings and make any required changes.

For more information, see Specifying retry parameters for JMS activities

Parent topic: Send Message activity
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Mapping the Inputs
Inputs represent data that is transmitted from the orchestration (variables) to the JMS endpoint (parameters).

Before you begin

If required, you can create a custom mapping variable in Source or Destination column by following the steps in
Creating variables.

Procedure
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1. In the Checklist, click Map Inputs. A set of options is displayed, and the To Activity list shows the JMS
variables.

2. Click Select Inputs.

The Select Inputs dialog box lists all the variables.

3. Choose a variable, then click OK.
4. To link the activities, click and drag a variable from the From Orchestration list onto a parameter listed in

the To Activity list.

If the link is viable, a line is displayed, linking the two.

5. Repeat this procedure to link other orchestration variables to JMS parameters.
6. To test the input links, click the Test button.

The Input Test Files table lists all linked variables/parameters.

7. In the Location column, click the small blue button.
8. Use the Browse dialog box to select an input test file.
9. Click Run Test. Test results are displayed in the columns underneath.

Tip: You can replace a variable used in the map without changing the links of the map. For more
information, see Replacing a Variable used in a Map.

Parent topic: Send Message activity
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Subscribe Message activity
The Subscribe Message activity is a starter activity that allows you to subscribe to a JMS topic. This activity
supports the ATLEAST ONCE and EXACTLY ONCE delivery semantics.

About this task

This orchestration must already have a JMS endpoint representing the data source, otherwise, output mapping
is disabled.

Adding a JMS activity to an orchestration
Changing the Activity Name
Picking a JMS endpoint
Configuring the Subscribe Message activity
Mapping the Outputs
Outputs represent data that is transmitted from the JMS activity (parameters) to the orchestration
(variables).

Parent topic: JMS Activities
Related tasks:
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Creating or editing a JMS endpoint
Get Message activity
Poll Message activity
Publish Message activity
Send Message activity
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Adding a JMS activity to an orchestration

Procedure

1. In an active project, open the Activities tab and expand the JMS folder contents.
2. Drag the Subscribe Message activity icon to the orchestration.
3. When the activity is displayed, the Subscribe Message Checklist is displayed underneath.

Parent topic: Subscribe Message activity
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Changing the Activity Name

Procedure

1. In the Checklist, click Summary.
2. Review the contents of the Activity Name field and make any required changes.

Parent topic: Subscribe Message activity
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Picking a JMS endpoint

Procedure

1. In the Checklist, click Pick Endpoint.
2. Click Browse and use the Project Explorer dialog box to select the relevant JMS endpoint.

Tip: You can create the needed endpoint at this time by clicking New.
3. When you click OK, the endpoint-specific configuration options are displayed in a read-only state.

Note: If changes are required to the selected endpoint configuration, click Edit to activate the options.
Any changes you make globally affects all uses of the endpoint in active orchestrations.

Parent topic: Subscribe Message activity
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Configuring the Subscribe Message activity

Procedure

1. In the Checklist, click Configure.
2. In the Topic field, specify a provider-specific name that identifies a topic to the JMS system.
3. Open the Message Data menu and choose the format the message takes, whether Bytes or Text.
4. In the Message Selector field, enter the text of a message header.

Using a JMS message selector a client can specify, by submitting the text of a message header, those
messages it is interested in. Only messages whose headers and properties match the selector are
delivered. Message selectors cannot reference message body values. The message selector string must
follow JMS selector syntax.

5. In the Client ID field, specify the unique client identifier assigned to this JMS connection.

A client's identifier is configured in a client-specific ConnectionFactory and transparently assigned to the
connection it creates. Alternatively, a client can set a connection's client identifier using a provider-
specific value.

6. In the Checklist, click Delivery Rules.
7. Open the Deliver menu and choose either option: ATLEAST_ONCE, ATMOST_ONCE or EXACTLY_ONC
8. In the Checklist, click Retry.
9. Review the default settings and make any required changes.
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For more information, see Specifying retry parameters for JMS activities

Parent topic: Subscribe Message activity

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/JMS_Subscribe_Configuring_Subscribe
_Message_Activity.html

Mapping the Outputs
Outputs represent data that is transmitted from the JMS activity (parameters) to the orchestration (variables).

Before you begin

If required, you can create a custom mapping variable in the Source or Destination column by following the
steps in Creating variables

Procedure

1. In the Checklist, click Map Outputs.
2. Review the parameters listed in the From Activity list.
3. If you want to create new orchestration variables that match the output parameters of the current

activity, select a parameter and then click Copy.
4. In the Copy Parameters dialog box, choose one or more parameters, then click OK to add them to the To

Orchestration list. The data type, schema, or schema fragment of the selected output parameter is
applied to the new variable.

5. Click Select Inputs.

The Select Inputs dialog box lists all the variables associated with the other endpoint.

6. Choose one or more variables, then click OK to add them to this list.
7. Drag a parameter from the From Activity list onto a variable listed in the To Orchestration list.

If the link is viable, a line is displayed, linking the two.

8. Repeat this procedure to link other parameters and variables.
9. To test the output links, click the Test button. A variable is listed in an Input Test Files table.

10. In the Location column, click the small blue button.
11. Use the Browse dialog box to select an input test file.
12. Click Run Test. Test results are displayed in the columns underneath.

Tip: You can replace a variable used in the map without changing the links of the map. For more
information, see Replacing a Variable used in a Map.

Parent topic: Subscribe Message activity
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Creating a JMS endpoint to a WebLogic server
You can define a JMS endpoint to an existing WebLogic server, by completing the following steps in IBM Cast
Iron Studio.

Before you begin

Install the following JAR files in IBM Cast Iron Studio and the Integration Appliance run time:

wlclient.jar
wljmsclient.jar

Procedure

1. In Studio, drag an activity from the JMS folder of the Activities tab onto the orchestration.
2. Click Pick Endpoint from the Checklist. The Pick Endpoint panel opens.
3. To create an endpoint, click New. The Create Endpoint window opens.
4. In the Create Endpoint window, specify the following connection parameters.

Connection parameter
fields Description

JNDI Initial Factory Specify the context factory class that Studio retrieves from JNDI:

weblogic.jndi.WLInitialContextFactory

This JNDI factory class is configured during the JMS WebLogic server
installation

Provider URL Specify the URL of the JMS server in the following format:

t3://:7001

Where 7001 is the default port.

Provider Package Optionally, you can specify a provider package name.

Factory Name Use one of the supplied default factories that is configured with the WebLogic
endpoint system:

weblogic.examples.jms.QueueConnectionFactory

5. To validate the parameters you specified, click Test Connection.
Note: When you configure an endpoint by using configuration properties, verify that the configuration
properties have valid values. If the configuration property value is invalid or does not exist, the
connection test fails.

6. In the Checklist, click Configure.
7. In the Topic field, select the following topic from the Preconfigured or custom Topic/Queues list:

weblogic.examples.jms.exampleQueue
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This topic is preconfigured to use a JMS WebLogic server.

8. Open the Message Data menu and choose the format the message takes, whether Bytes or Text.
9. In the Message Selector field, you can enter the text of a message header.

By submitting the text of a message header in a JMS message selector, a client can specify the
messages it is interested in. Only messages with headers and properties that match the selector are
delivered. Message selectors cannot reference message body values. The message selector string must
comply with the JMS selector syntax.
Note: Message selector can be blank

10. In the Client ID field, specify the unique client identifier assigned to this JMS connection.
11. In the Checklist, click Delivery Rules.
12. Open the Deliver menu and choose the option: ATMOST_ONCE
13. In the Checklist, click Retry.
14. If there are any problems, review the default settings and make the required changes.

Parent topic: JMS Activities
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MQ Activities
Creating or editing a MQ Activity endpoint
MQ activities handle flat file, XML, or raw messages to or from an MQ queue. The MQ system handles
routing of messages through the network of queues.  All three of the MQ activities, MQ Get Message, MQ
Poll Queue, and MQ Put Message use the same endpoint creation dialog box.
Installing JAR files to connect to the MQ system
To connect to the MQ system from Studio, you must have the MQ connector-specific JAR files on the
same workstation as your Studio installation. These files must be present in Studio to enable
configuration of the endpoints and orchestrations.
Defining and loading an XML schema for a MQRFH2 header
To include additional metadata or parameters in an MQ message, you must define an MQRFH2 header
that defines the your parameters. Typically, these parameters are specific to an application but do not
occur in the data of the message itself.
MQ Get Message activity
Use the MQ Get Message activity retrieves messages from an MQ queue during run time.
MQ Put Message activity
Use the MQ Put Message activity sends a message to the specified queue during run time.
MQ Poll Queue activity
Use the MQ Poll Queue activity periodically checks the MQ Queue for messages based on a specified
retry interval during runtime.
MQRFH2 XML data and schema examples
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Creating or editing a MQ Activity endpoint
MQ activities handle flat file, XML, or raw messages to or from an MQ queue. The MQ system handles routing of
messages through the network of queues.  All three of the MQ activities, MQ Get Message, MQ Poll Queue, and
MQ Put Message use the same endpoint creation dialog box.

Before you begin

For MQ activities to be fully functional, ensure that the Queue Manager, Channel Name, and other queue names
are configured correctly. For more information on MQ configuration, see WebSphere MQ Help.

Procedure

1. Drag an MQ connection activity from the Activities tab onto the orchestration.

The Summary panel is displayed along with a Checklist which outlines what you must do to configure the
activity.

2. Click Endpoint from the Checklist and select one of the following options:
Browse to add an endpoint from the endpoint repository. Once added, you can click Edit to edit it.
Note: Editing an endpoint affects all orchestrations that use it. The edits are global, not local.
New to create a new endpoint.
Edit to edit the existing endpoint.

The Create Endpoint panel is displayed.

3. Fill in the fields defined in the following table.
4. Click OK when finished.

Table 1. Queue Manager Details
Field Description

Locati
on

 

Host
Name

Specifies the host name for the MQ Queue Manager.

Port Specifies the port number to connect to the Queue Manager. Defaults to 1414, the default for
Queue Managers.

Queue
Manag
er

Specifies the name of the Queue Manager to connect to. The name can have a maximum
length of 48 characters.

Chann
el
Name

Specifies the channel name to use to connect to the Queue Manager. The name can have a
maximum length of 20 characters.
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Field Description

Login

User
Name

User name for the account used to connect to the Queue Manager. The name has a maximum
length of 12 characters. This account must be defined in the mqm group in MQ

  Note: For some of the fields in the endpoint, you can define configuration properties to supply

the values for these fields.  The  icon is displayed when you click in a field that supports a
configuration property and a configuration property of the same type has already been
configured for the project.

Conne
ction
Pool
Optio
ns

(Default values are provided for the connection pool options, but can be changed.)

Minim
um
Conne
ctions

Specifies the number of connections in the connection pool that the Integration Appliance
always keeps open. Specifying 0 is supported.

Maxim
um
Conne
ctions

Specifies the maximum number of connections that the Integration Appliance has open in the
connection pool. If you change the default value, the value must be greater than or equal to
the value specified for Minimum Connections. Valid values are 1 - 50. If you enter a value
greater than 50, the value is reset to 50.

Maxim
um
Idle
Time

Specifies the amount of time that a connection can be open and idle before being closed by
the Integration Appliance. Specifying 0 means that the connections are closed when they are
returned to the pool —no idle time.

Parent topic: MQ Activities
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Installing JAR files to connect to the MQ system
To connect to the MQ system from Studio, you must have the MQ connector-specific JAR files on the same
workstation as your Studio installation. These files must be present in Studio to enable configuration of the
endpoints and orchestrations.

About this task

The two JAR files to be installed for WebSphere MQ version 5.x and 6.x are:
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connector.jar
com.ibm.mq.jar

Procedure

1. Open Studio, select Tools > Install Module Providers.
2. When the Add Provider(s) dialog box is displayed, click the plus (+) button under MQ Connector. A field

and a Browse button is displayed.
3. Click Browse, and use the browse dialog box to locate and select both the JAR files.
4. Click Open to import the contents of the JAR files.
5. When the JAR files are listed in the Add Providers dialog box, click OK.

Results

A prompt is displayed to restart Cast Iron Studio and activate the changes.
Note: You must manually restart Studio after it shuts down to apply the changes.

What to do next

You can now create MQ connector endpoints and orchestrations.
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Defining and loading an XML schema for a MQRFH2 header
To include additional metadata or parameters in an MQ message, you must define an MQRFH2 header that
defines the your parameters. Typically, these parameters are specific to an application but do not occur in the
data of the message itself.

About this task

Each parameter, which MQ calls a folder, is passed as an XML fragment along with other MQRFH2 header data.
Each parameter can have its own unique XML structure.

Because the Integration Appliance works with XML messages, each of these parameter fragments must be
extracted from the MQRFH2 header. The fragments are consolidated into one fragment and passed as the
MQRFH2 parameter to the Integration Appliance.

To make these parameters accessible, both Studio and the Integration Appliance need access to an XML
Schema that defines the structures of all the parameters. Complete the following procedure to create that XML
Schema and load it into the project.

Procedure
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1. Create an XML Schema that defines the parameters of your MQRFH2 header using an XML Schema
editor or text editor. For an example XML Schema, see MQRFH2 XML data and schema examples. Your
XML Schema must be customized for your application's parameters.
Create the XML Schema according to the following guidelines:

Define the consolidated structure as a single NameValueData element.
List all the parameters, in the order they occur in the MQRFH2 header, as elements inside
NameValueData element.
Parameter names must be unique.
Parameter, group, and property names must be valid XML names. See the XML specification or
MQ documentation for more information.
Each parameter must be wrapped in a single element. MQ documentation refers to this
parameter element as a folder.
Parameters may contain properties, groups, or both.
Groups and properties may repeat.
Groups can nest inside other groups.
Properties must be defined as type MQRFHQPropertyType.

2. Add this XML Schema to the project. See Uploading Files into a Project for more information.
3. The XML Schema is now available in the Browse for Schema Type Element dialog box. In the Configure

pane of the MQ activities, this dialog box appears when you click the Schema Fragment for MQRFH2
Header check box and then click [..]. In the Browse For Schema Type Element dialog box find the XML
Schema that defines the header, select NameValueData element in that XML Schema, and click OK.
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MQ Get Message activity
Use the MQ Get Message activity retrieves messages from an MQ queue during run time.

Note: You must have created an endpoint for the MQ activity before configuring the activity.
The Configure task has three sections:

Queue and Message details - where you specify properties for queue and message details.
Delivery  rules - where you specify how you want messages delivered.
Retry options - where you specify how long to wait between retries and the number of time to retry
before failing.

After completing the Configure tasks, Mapping inputs and Mapping outputs of the activity.

Note: The maximum message size is 100 MBytes.

Queue and Message details

426   



Specify the Queue and Message details for the fields in the following table. Required fields are marked with an
asterisk.

Field Description

Queue
Name *

Specifies the name of the MQ queue where Integration Appliance attempts to retrieve the message
from.

Timeou
t

The number of seconds before a timeout occurs between the MQ Get Message activity requesting to
retrieve a message from the queue and the time it takes for the message to be returned. If this
timeout period expires and no message is returned from the queue, the Integration Appliance waits
the specified retry time before attempting to retrieve a message again. For a detail explanation of
the timeouts and retry options, see Timeout and Retry options.

To specify the number of seconds that the Integration Appliance should wait before issuing a
timeout, select the After option and enter the number seconds in the Seconds field. By default the
Never option is selected, this option specifies the Integration Appliance waits indefinitely to retrieve
a message from the queue —there is no timeout period.

Payloa
d Data
Type

Specifies the datatype of the message payload, either binary or string.

Schem
a
Fragm
ent for
MQRF
H2
Header

Specifies if an MQRFH2 header is included in the message. If the message includes a MQRFH2
header, select this check box and click [...]. In the Browse For Schema Type Element dialog box to
find the XML Schema that defines the header, select the NameValueData element in that XML
Schema, and click OK. The schema fragment is the NameValueData element and all its child
elements.
Note: The XML Schema that defines the header must first be created and loaded into the project
before you can select it. For more information see Defining and loading an XML schema for a
MQRFH2 header.

Delivery  rules

Field Description

Deliver
Message
s

The options available here depend on whether the Unique ID's checkbox is selected. If selected,
all three options are available. If not, only At Least Once is displayed.

At least once -  Specifies that the message is delivered at least once but can be delivered
more than once. Connection or Integration Appliance failures can result in messages being
retrieved and processed more than once. This delivery option is typically used when the
receiving system can detect or tolerate duplicate messages
At most once - Specifies the message is delivered only once or not at all. Connection or
Integration Appliance failures can result in messages being missed. This delivery option is
typically used when the receiving system cannot tolerate duplicate messages but can
tolerate lost messages.
Exactly once -  Specifies the message is delivered once and only once. Connection or
Integration Appliance failures do not affect delivery with this option. The Integration
Appliance uses MQ message IDs to ensure that every message is retrieved and processed
exactly once.
Note: If you select the Exactly Once option, you must enable persistence. For more
information, see Enabling Persistence.

Where
message

Specifies if the messages on the queue have unique IDs.
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s have
Unique
ID's

Retry options

Configure the retry options for getting a message from the MQ queue as described in the following table:

Retry
Option
s Description

1) Wait
___
second
s
betwee
n each
retry.

The number of seconds that the Integration Appliance waits before attempting to retrieve a
message from the queue. To learn more about how this option relates to the Timeout field in the
Configure pane or the timeout input parameter, see Timeout and Retry options.

2) Try
to
connec
t ___
times
before
failing.

Specifies the maximum number of times the Integration Appliance attempts to retrieve a message
from the queue before issuing an error and stops the processing of the current orchestration job.

If you deploy an orchestration that contains an MQ Get Message activity and the Integration
Appliance cannot connect to the specified MQ Server or cannot get a message from the queue, the
Integration Appliance logs the errors as warnings in the system and orchestration logs until the retry
count value is reached. When the retry count is reached, the Integration Appliance logs an error in
the system and orchestration logs and the stops processing the current orchestration job.

For example, you set the retry count to 3. The first, second, and third errors appear in the system log
as warnings. The Integration Appliance logs the fourth error as an error and stops processing the
current orchestration job.

To learn more about how this option relates to the Timeout field in the Configure pane or the timeout
input parameter, see Timeout and Retry Options.

Mapping inputs

1. Select the Map Inputs task in the Checklist. The Retry panel opens.

The input parameters of the activity are displayed in the To Activity panel.

2. All the input parameters of the MQ Get Message activity are optional. If the input parameter listed in the
following table are not displayed in the To Activity pane of the Map Inputs panel, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity panel and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the
toolbar menu, click on a node in the Map Inputs panel to activate this option.
You can constrain the type of message returned by the MQ Get Message activity by mapping any
combination of the following nodes of the mqmdheader optional input parameter:

mqmdheader/MsgId
mqmdheader/CorreId
mqmdheader/GroupId
mqmdheader/MsgSeqNumber
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During run time, the activity iterates sequentially through the messages in the queue. If nothing is
mapped to these nodes, nothing is constrained so the first message in the queue is returned by the MQ
Get Message activity and next activity in the orchestration is processed.

If any of these nodes are mapped, during run time the MQ Get Message activity iterates through each
message in the queue until it finds the first message that matches the run time values of all the mapped
nodes. The first matching message is returned by the MQ Get Message activity and next activity in the
orchestration is processed.

For example in the Map Inputs task, mqmdheader/MsgId is mapped to the string called msgId and a
default value of largeOrders is specified for the mqmdheader/GroupId as shown in the following figure:

During run time, the MQ Get Message activity returns the first message in the queue that satisfies both
of the following conditions:

The run time value specified of the string variable called msgId is equal message ID of the
message in the queue.
The group IDof the message equals largeOrders.

You can optionally override the settings you specified for the Queue Name and the Timeout in the
Configure task of the Checklist dynamically during run time, using the input parameters defined in the
following table.

For example, the MQ queue name can be set in the Configure task to poqueue. During run time, the MQ
queue name: newqueue could be passed into the activity using the queuename input parameter. The
queue name specified dynamically during run time overrides the original setting specified in the
Configure panel. In this example, the Integration Appliance looks at the MQ queue named newqueue for
messages.

Optional Input Parameters that Override the Settings in the Configure Task
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Input
Param
eter
Name/
Node

Description Overrides the Setting in
Task?

timeou
t

Specifies the amount of time that the Integration Appliance
waits after requesting to retrieve a message from the queue
before retrying.

Specify a negative number to specify no timeout period — the
Integration Appliance waits indefinitely to retrieve a message
from the queue. Specifying a negative number is equal to
specifying the Never option in the Configure task.

The timeout input parameter
overrides the Timeout field of
the Configure task.

queue
name

Specifies the name of the MQ queue where the Integration
Appliance looks for messages.

The queuename input
parameter overrides the
encoding specified in the
Queue Name field of the
Configure task.

See Creating a Map for general instructions on mapping.

Mapping outputs

You are not required to map the output parameters for this activity. See Creating a Map for general instructions
on mapping.

Timeout and Retry options

The timeout specified in the Timeout field in the Configure task or the timeout input parameter specifies the
number of seconds before a timeout occurs between the MQ Get Message activity requesting to retrieve a
message from the queue and the time it takes for the message to be returned. If this timeout period expires
and no message is returned from the queue, the Integration Appliance waits the amount of time specified in
the 1) Wait ___ second(s) between each retry option before attempting to retrieve a message, again. The
Integration Appliance keeps attempting to get the message up to the specified retry count. The retry count is
specified with the 2) Try to connect ___ times before failing. The 1) Wait ___ second(s) between each retry and
2) Try to connect ___ times before failing options are specified in the Retry options task.

For example, a MQ Get Message activity is configured with the following options:

The Timeout field in the Configure task is set to 10 seconds and the optional timeout input parameter is
not mapped and no default value is defined.
The 1) Wait ___ second(s) between each retry option is set to 15 seconds.
The 2) Try to connect ___ times before failing option is set to 2.

During run time, if the MQ Get Message activity is continuously unable to retrieve a message from the queue, as
shown in the following figure:
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MQ Put Message activity
Use the MQ Put Message activity sends a message to the specified queue during run time.

Note: You must have created an endpoint for the MQ activity before configuring the activity.
The Configure task has three sections:

Queue and Message details - where you specify properties for queue and message details.
Delivery rules - where you specify how you want messages delivered.
Retry options - where you specify how long to wait between retries and the number of time to retry
before failing.

After completing the Configure tasks, and Mapping inputs for the activity.

Note: The maximum message size is 100 MBytes.

Queue and Message details

Specify the Queue and Message details using the fields in the following table. Required fields are marked with
an asterisk.
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Field Description

Queue
Name *

Specifies the name of the queue where the messages are put.

Payload
Data
Type

Specifies the datatype of the message payload, either binary or string.

Messag
e Type

Datagram - Select if the message should be sent and no reply is needed.

Request - Select if the message should have a reply. Be sure to set the Reply to Queue property for
request messages.

Response - Select if the message is a reply to a previous request.

Reply to
Queue

Specifies the queue the reply should be sent to for request messages.

Reply to
Queue
Manage
r

Specifies the name of the Queue Manager that the queue (specified in the Reply to Queue field)
belongs to.

Persiste
nt

True - Messages are restored to queues if the Queue Manager crashes.
False - Messages may be lost from the queue if the Queue Manager crashes.
Default - Messages use the persistence setting for the queue (this is the default).

Priority Specifies the priority of the message.  By default, the message priority defaults to the default
priority for the queue. If the queue uses priorities to order messages and this message should have
a specific priority set, select Specify and enter the priority. Priorities can range from 1 (lowest) up to
9 (highest).
Note: The priority should not exceed the maximum priority number set for the MQ queue. Check
with your MQ system administrator for this information.

Messag
e
Expirati
on

The number of seconds that messages are kept in the queue before expiring. Defaults to Never,
which ensures that the message is delivered and waits on the queue until it is retrieved, no matter
how long that may take.

If messages for this queue should expire and be discarded after some period of time, select Specify
and enter the maximum number of Seconds that the message should be kept in the queue.

Schema
Fragme
nt for
MQRFH
2
Header

Specifies if an MQRFH2 header is included in the message. If the message is an XML message and
includes a MQRFH2 header, select this check box and click [...]. In the Browse For Schema Type
Element dialog box find the XML Schema that defines the header, select the NameValueData
element in that XML Schema, and click OK. The schema fragment is the NameValueData element
and all its child elements.  
Note: The XML Schema that defines the header must first be created and loaded into the project
before you can select it. For more information see Defining and loading an XML schema for a
MQRFH2 header.

Delivery rules

Fiel
d Description

Deli
ver

The options available here are:
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Mes
sag
es

At least once - Specifies that the message is delivered at least once but can be delivered more
than once. Connection or Integration Appliance failures can result in messages being retrieved
and processed more than once. This delivery option is typically used when the receiving system
can detect or tolerate duplicate messages.
At most once - Specifies the message is delivered only once or not at all. Connection or
Integration Appliance failures can result in messages being missed. This delivery option is
typically used when the receiving system cannot tolerate duplicate messages but can tolerate
lost messages.

Retry options

Configure the retry options for connecting to a MQ Server. The following table describes the retry options for
connecting to a MQ Server:

Retry
Option
s Description

1) Wait
___
second(
s)
betwee
n each
retry.

The number of seconds that the Integration Appliance waits before attempting to contact the
Queue manager to send a message to MQ Server, again.

2) Try
to
connect
___
times
before
failing.

Specifies the maximum number of times the Integration Appliance attempts to contact the Queue
manager to send a message to the MQ Server before issuing an error and stopping the processing of
the current orchestration job.

If you deploy an orchestration that contains an MQ Put Message activity and the Integration
Appliance cannot connect to the Queue manager of the specified MQ Server, the Integration
Appliance logs the errors as warnings in the system and orchestration logs until the retry count
value is reached. When the retry count is reached, the Integration Appliance logs an error in the
system and orchestration logs and the stops processing the current orchestration job.

For example, you set the retry count to 3. The first, second, and third connection errors appear in
the system log as warnings. The Integration Appliance logs the fourth error as an error and stops
processing the current orchestration job.

Mapping inputs

You are required to map input parameters for this activity. The following parameter is required and must be
mapped in order for the configuration to be complete. All other parameters are optional. See Creating a Map for
more information.

Required Input Parameters:
payload

To view the optional input parameters in the To Activity panel of the Map Inputs panel, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity panel and select the Show Optional
Parameters option. If the Map > Show Optional Parameters option is not selectable in the toolbar menu, click
on a node in the Map Inputs panel to activate this option.
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MQ Poll Queue activity
Use the MQ Poll Queue activity periodically checks the MQ Queue for messages based on a specified retry
interval during runtime.

Note: You must have created an endpoint for the MQ activity before configuring the activity.
The Configure task has three sections:

Queue and Message details - where you specify properties for queue and message details.
Delivery  rules - where you specify how you want messages delivered.
Retry options - where you specify how long to wait between retries and the number of time to retry
before failing.

After completing the Configure tasks, Mapping outputs for the activity.

Note: The maximum message size is 100 MBytes.

Queue and Message details

Specify Queue and Message details for the fields in the following table. Required fields are marked with an
asterisk.

Field Description

Queue
Name *

Specifies the name of the queue which is polled for messages.

Payload
Data
Type

Specifies the datatype of the message payload, either binary or string.

Schema
Fragme
nt for
MQRFH
2
Header

Specifies if an MQRFH2 header is included in the message. If the message is an XML message and
includes a MQRFH2 header, select this check box and click [...]. In the Browse For Schema Type
Element dialog box find the XML Schema that defines the header, select the NameValueData
element in that XML Schema, and click OK. The schema fragment is the NameValueData element
and all its child elements.
Note: The XML Schema that defines the header must first be created and loaded into the project
before you can select it. For more information see Defining and loading an XML schema for a
MQRFH2 header.

Delivery  rules

Field Description
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Poll for
changes

Specifies how often the Integration Appliance should poll the queue for changes. For more
information, see Polling Interval Behavior.

Where
message
s have
Unique
ID's

Specifies if the messages on the queue have unique IDs.

Deliver
Message
s

The options available here depend on whether the Unique ID's checkbox is selected. If selected,
all three options are available. If not, only At Least Once is displayed.

At least once - Specifies that the message is delivered at least once but can be delivered
more than once. Connection or Integration Appliance failures can result in messages being
retrieved and processed more than once. This delivery option is typically used when the
receiving system can detect or tolerate duplicate messages.
At most once - Specifies the message is delivered only once or not at all. Connection or
Integration Appliance failures can result in messages being missed. This delivery option is
typically used when the receiving system cannot tolerate duplicate messages but can
tolerate lost messages.
Exactly once - Specifies the message is delivered once and only once. Connection or
Integration Appliance failures do not affect delivery with this option. The Integration
Appliance uses MQ message IDs to ensure that every message is retrieved and processed
exactly once.
Note: If you select the Exactly Once option, you must enable persistence. For more
information, see Enabling Persistence.

Retry options

Configure the retry options of the MQ Poll Queue activity, as defined in the following table:

Retry
Option
s Description

1) Wait
__
secon
d(s)
betwe
en
each
retry.

The number of seconds that the Integration Appliance waits before attempting to retrieve messages
from MQ Server, again.

2) Try
to
conne
ct __
times
before
failing.

Specifies the maximum number of times the Integration Appliance attempts to retrieve messages
from the MQ Server before failing.

If an orchestration that starts with an MQ Poll Queue activity is deployed and the Integration
Appliance cannot connect to the specified MQ server or cannot retrieve messages from queue, the
Integration Appliance logs the errors as warnings in the system log until the retry count value is
reached. When the retry count is reached, the Integration Appliance logs an error in the system log,
resets the current retry count to zero, and continues to attempt to establish a connection to the MQ
server.
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For example, you set the retry count to 3. The first, second, and third errors appear in the system log
as warnings. The Integration Appliance logs the fourth error as an error and resets the current retry
count to zero. Therefore, the fifth connection error generates a warning in the system log. The
Integration Appliance continues to attempt to retrieve messages from the queue.

Mapping outputs

You are not required to map output parameters for this activity. However, if you do map any of these
parameters, note the following points:

Parameters:

payload and mqmdheader parameters are obtained from the message that is received from the
queue.
rfh2header is obtained if the schema for the RFH2 Header is specified in the Configure task.
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MQRFH2 XML data and schema examples
This section contains the following examples:

Example XML data that contains MQRFH2 parameters
Example XML Schema that defines MQRFH2 parameters

Example XML data that contains MQRFH2 parameters

Note the following characteristics about the example XML data:

ParameterA contains only properties.
ParameterB contains groups with properties.
ParameterC contains both a group and a property.
Property4 repeats several times within groupDtl.

Example XML Data that Contains MQRFH2 Parameters:

<?xml version="1.0" encoding="UTF-8"?>

<NameValueData>

    <parameterA>

        <property1>value</property1>

        <property2 datatype="nt">345</property2>
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    </parameterA>

    <parameterB>

        <groupHeader>

            <property3>true</property3>

        </groupHeader>

        <groupDtl>

            <property4>ANR</property4>

            <property4>BYC</property4>

            <property4>ENN</property4>

        </groupDtl>

    </parameterB>

    <parameterC>

        <groupNew>

            <property5>01/15/2004</property5>

        </groupNew>

        <property1>value</property1>

    </parameterC>

</NameValueData>

Example XML Schema that defines MQRFH2 parameters

The following example XML Schema defines the three parameters displayed in Example XML data that contains
MQRFH2 parameters. The type for all of the property elements: MQRFH2PropertyType, provides the datatype
attribute shown on property2 in the preceding example. The MQRFH2PropertyType type also ensures that the
elements can contain values.

The repetition for property4 in groupDtl is handled with the minOccurs and maxOccurs attributes. You can also
set maxOccurs to unbounded to allow an unlimited number of repetitions.

An Example XML Schema that defines MQRFH2 Parameters:

<xsd:schema elementFormDefault="qualified"

  xmlns:xsd="http://www.w3.org/2001/XMLSchema"

  xmlns:rfh="http://www.approuter.com/samples/MQ"

  targetNamespace="http://www.approuter.com/samples/MQ">

  <xsd:complexType name="MQRFH2PropertyType">

    <xsd:simpleContent>
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      <xsd:extension base="xsd:string">

        <xsd:attribute name="dt" type="xsd:string" use="optional"/>

      </xsd:extension>

    </xsd:simpleContent>

  </xsd:complexType>

  <xsd:element name="NameValueData">

    <xsd:complexType>

      <xsd:sequence>

        <xsd:element name="parameterA">

          <xsd:complexType>

            <xsd:sequence>

              <xsd:element name="property1" type="rfh:MQRFH2PropertyType"/>

              <xsd:element name="property2" type="rfh:MQRFH2PropertyType"/>

            </xsd:sequence>

          </xsd:complexType>

        </xsd:element>

        <xsd:element name="parameterB">

          <xsd:complexType>

            <xsd:sequence>

              <xsd:element name="groupHeader">

                <xsd:complexType>

                  <xsd:sequence>

                    <xsd:element name="property3" type="rfh:MQRFH2PropertyType"/>

                  </xsd:sequence>

                </xsd:complexType>

              </xsd:element>

              <xsd:element name="groupDtl">

                <xsd:complexType>

                  <xsd:sequence>

                    <xsd:element name="property4" type="rfh:MQRFH2PropertyType" minOccurs="1"

                      maxOccurs="5"/>
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                  </xsd:sequence>

                </xsd:complexType>

              </xsd:element>

            </xsd:sequence>

          </xsd:complexType>

        </xsd:element>

        <xsd:element name="parameterC">

          <xsd:complexType>

            <xsd:sequence>

              <xsd:element name="groupNew">

                <xsd:complexType>

                  <xsd:sequence>

                    <xsd:element name="property5" type="rfh:MQRFH2PropertyType"/>

                  </xsd:sequence>

                </xsd:complexType>

              </xsd:element>

              <xsd:element name="property1" type="rfh:MQRFH2PropertyType"/>

            </xsd:sequence>

          </xsd:complexType>

        </xsd:element>

      </xsd:sequence>

    </xsd:complexType>

  </xsd:element>

</xsd:schema>
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NetSuite Activities
Creating or editing a NetSuite endpoint
Endpoints provide the NetSuite connection information that Studio and the Integration Appliance use to
connect with NetSuite.
Add Records activity
Use the Add Records activity to add one or more new records to NetSuite. Each added record must be
uniquely identifiable by its name, type, and hierarchy. If two or more records have the same identifiers, a
SOAP fault is posted. The records to be added must be of the same record type.
Attach Records activity
The Attach Records activity can be used to define a relationship between two records. For example, a
Contact record can be associated with a Vendor record. A Contact record can be associated with all
entity records except for other Contact records and Group records.
Delete Records activity
The Delete Records activity can delete one or more records from NetSuite. Each deleted record must be
uniquely identifiable by its name, type, and hierarchy. If two or more records have the same identifiers, a
SOAP fault is posted. The records to be deleted must be of the same record type.
Detach Records activity
The detach records activity can be used to remove a relationship between two records. For example, a
Contact record associated with a Vendor record can be removed. The Detach Records activity can also
detach files, such as Word or PDF files, from a NetSuite record.
Get Records activity
The Get Records activity retrieves one or more records based on the records unique IDs. If any of the
IDs are invalid, valid IDs are processed and a warning for invalid IDs is sent in the response.
Initialize Record activity
Use the Initialize Record activity to populate a transaction record with input from another related record.
For example, you can populate a Sales Order record with input from the related Estimate record before
submitting the Sales Order record to NetSuite.
Search Records activity
The Search Records activity searches for a specific record type based on search criteria that you specify.
Update Records activity
The Update Records activity can update one or more records. Only fields that are populated are updated
in NetSuite. For fields that are not populated, the previous value in NetSuite is maintained. If a field is
populated with an empty string, the value of the field in NetSuite is replaced with an empty string.
Upsert Records Activity
The Upsert Records activity can update a record if the record already exists in the database, or to insert
the record if it does not. Only fields that are populated are updated in NetSuite. For fields that are not
populated, the previous value in NetSuite is maintained. If a field is populated with an empty string, the
value of the field in NetSuite is replaced with an empty string.
Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly. This
topic provides potential solutions for issues you would have with the NetSuite connector.
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Creating or editing a NetSuite endpoint
Endpoints provide the NetSuite connection information that Studio and the Integration Appliance use to
connect with NetSuite.

Procedure

1. Select an activity from the NetSuite folder of the Activities tab.
2. Drag the activity onto the orchestration.

The Summary panel is displayed along with a Checklist that lists the tasks that must be performed to
configure the activity.

3. Click the Endpoint task from the Checklist and choose one of the following options:
Browse - To select an existing endpoint from the project.
New - To create a new endpoint.
Edit - To edit an existing endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the Project.

4. When the NetSuite endpoint screen is displayed, complete, or edit, the information in the following
fields:

NetSuite Customer Login - Users are limited to two sessions for each username/password. One
session is through the browser and the other session is through Web Services. Attempting a
second login through the browser with the same username and password results in the first
session terminating. The same scenario applies to attempts to establish two concurrent Web
Services sessions. For multiple concurrent Web Services connections, obtain a Web Services Plus
license.

Field Description

Email Address E-mail address used to login to NetSuite

Password Password for E-mail address

Account Number Account number associated with E-mail address

Login Options - Choose either Login normally or Login in to the specified URL and specified
version.

If you purchased the Web Services Concurrent License, click Web Services Plus License.

Connection Pool Options - Leave the default values or change the values for the Connection Pool
Options:

Field Description

Minimum
Connectio
ns

The default is 1.

Maximum
Connectio
ns

The default is 1. If Web Services Plus License (Concurrent Web Services User
preference) is selected, the default is 5.

Maximum
Idle Time

The maximum number of minutes, the session can remain idle before ending the
session. The default is 120 minutes. NetSuite enforces a 120 minute maximum.

Maximum
Wait

Maximum Wait The maximum number of seconds to wait for the session to start.
The default is 300 seconds.
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Connection Timeout - Use the up and down arrows to select the number of seconds, that you
want to wait to establish a connection to the endpoint before ending the attempt.
Proxy - To use a proxy server to connect with NetSuite, select Connect via a Proxy Server.

For Authentication, click the arrow and choose the mode, either Basic or NTLM.

For Realm, if you choose Basic authentication, you can specify a realm. If you do not specify a
realm, the endpoint authenticates to 'any realm'.

Complete the following fields:

Field Description

Host Name The name of the proxy server or the IP address of the proxy server.

Port The port number used by the proxy server to connect with NetSuite.

User Name The ID used to login to the proxy server.

Password The password for User Name.

Update - Use the Update WSDL to_2011_1 button to upgrade the NetSuite WSDL. The button is
inactive if WSDL_2011_1 is already present. After clicking the button, you will be presented with
a list of project entities that will be affected by this update. At that point, you can decline to
update to WSDL_2011_1 or proceed with the update.

Click Test Connection to verify that a connection can be established.

Parent topic: NetSuite Activities
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Add Records activity
Use the Add Records activity to add one or more new records to NetSuite. Each added record must be uniquely
identifiable by its name, type, and hierarchy. If two or more records have the same identifiers, a SOAP fault is
posted. The records to be added must be of the same record type.

Using the Add Records activity
To use the Add Records activity complete the following steps.
Mapping the inputs for the Add Records activity
Up can map the Add records task inputs
Mapping the outputs for the Add Records activity
You can map the outputs for the Add Records activity.

Parent topic: NetSuite Activities
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Using the Add Records activity
To use the Add Records activity complete the following steps.

Procedure

1. In the Activities tab, expand the NetSuite directory and locate the Add Records activity.
2. Add the Add Records activity to your orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. In the Checklist, click Pick Endpoint.
4. Select one of the following options:

Browse - to select a NetSuite endpoint from the Project Explorer.
New - to create a new NetSuite endpoint using the Create Endpoint dialog.

For instructions on creating a NetSuite endpoint, see Creating or editing a NetSuite endpoint.

Edit - to edit an existing NetSuite endpoint using the Edit Endpoint dialog.
For instructions on editing a NetSuite endpoint, see Creating or editing a NetSuite endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the project.

5. In the Checklist, click Configure.
6. Click Browse to display the Browse NetSuite dialog.
7. In the Browse NetSuite dialog, click Show Record Types and select one of the following options:

All – to view all record types.
Only Custom – to view only custom records.
Only Standard – to view only standard NetSuite record types.

Note: To use custom records, you must enter the internal ID in the recType/internalId node.
8. To view custom fields in standard records, select the Generate custom fields for standard record types

checkbox.

This option does not apply to custom record types. The state of the checkbox is saved.

9. In the Browse NetSuite dialog, select a record type by completing one of the following tasks:
Enter the first few letters of a record type in the Search for a Record Type field, select the record
type in the Record Type scroll list and then click Select.
Scroll through the Record Type scroll list until you find the required record type, click the record
type, and then click Select.

10. To refresh the maps in NetSuite, in the Configure pane, click Refresh after the record type is set.
11. In the Checklist, click Retry.
12. In the Retry section:

Set the number of seconds, between each retry to connect with NetSuite. The default is 30
seconds.
Set the number of times you want to retry before failing. The default is 5 times.
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In the Activity Timeout section:
Set the Activity Timeout, the number of seconds, to wait when the endpoint does not respond to a
request. The default is 300 seconds.

13. Mapping inputs. See Mapping the inputs for the Add Records activity for more information.
14. Mapping outputs. See Mapping the outputs for the Add Records activity for more information.

Parent topic: Add Records activity
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Mapping the inputs for the Add Records activity
Up can map the Add records task inputs

About this task

To map the inputs for the add records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Inputs task.
2. Click Select Inputs... and select the input variables for the map.

For instructions on how to create variables, see Creating Variables.

3. Map the elements in the From Orchestration pane to the NetSuite elements in the To Activity pane.

The elements in the To Activity pane are determined by the NetSuite record type you selected in the
Configure task. For mapping instructions, see Creating a Map.

Parent topic: Add Records activity
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Mapping the outputs for the Add Records activity

444   



You can map the outputs for the Add Records activity.

About this task

To map the outputs for the add records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Outputs task.
2. Click Copy.
3. Select addListResponse. Click Create to copy from the Activity panel to the Orchestration panel.

Parent topic: Add Records activity
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Attach Records activity
The Attach Records activity can be used to define a relationship between two records. For example, a Contact
record can be associated with a Vendor record. A Contact record can be associated with all entity records
except for other Contact records and Group records.

About this task

The Attach Records activity can also attach files, such as Word or PDF files, to a NetSuite record. Any file that is
in the NetSuite file cabinet can be attached to any record except for custom records.
The following list describes the nodes for the Attach Records activity in the Checklist > Map Inputs > To Activity
panel:

{RecordRef} attachTo - this node specifies the record to which the attachment is attached.
@type – In the Define Default Value, select the type of record.
@externalId – Either externalId or internalId must be specified for the RecordRef.
@internalID – Either externalId or internalId must be specified for the RecordRef.

contact – This node specifies the record to associate with or the file to attach to the attachTo record.
@internalID – Either externalId or internalId must be specified for the RecordRef.
@externalId – Either externalId or internalId must be specified for the RecordRef.
@type – In the Define Default Value, select the type of record.
name – Enter the name of the contact or the file name.

contactRole – This node specifies the role in the user defined Contact List located in the NetSuite UI at
List > Relationships > Contacts.

exists – a Boolean used to indicate whether the Contacts List exists or not.
@internalID – Either externalId or internalId must be specified for the role.
@externalId – Either externalId or internalId must be specified for the role.
name – The title of the role such as Primary Contact.
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Using the Attach Records activity
To use the Attach Records activity, complete the following steps:
Mapping the inputs for the Attach Records activity
To map the inputs for the Attach Records activity, complete the following steps.
Mapping the outputs for the Attach Records activity
To map the outputs for the Attach Records activity, complete the following steps.

Parent topic: NetSuite Activities
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Using the Attach Records activity
To use the Attach Records activity, complete the following steps:

Procedure

1. In the Activities tab, expand the NetSuite directory and locate the Attach Records activity.
2. Add the Attach Records activity to your orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. In the Checklist, click Pick Endpoint.
4. Select one of the following options:

Browse - to select a NetSuite endpoint from the Project Explorer.
New - to create a new NetSuite endpoint using the Create Endpoint dialog.

For instructions on creating a NetSuite endpoint, see Creating or editing a NetSuite endpoint.

Edit - to edit an existing NetSuite endpoint using the Edit Endpoint dialog.
For instructions on editing a NetSuite endpoint, see Creating or editing a NetSuite endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the project.

5. In the Checklist, click Configure.
6. Click Configure to open the Attach Reference Activity Wizard.
7. Click Browse.
8. Select the record you want to attach and click Attach.
9. Click Next.

10. Select the record to which you want to attach the attachment record and click Select.
11. Click Finish.
12. In the Checklist, click Retry.
13. In the Retry section:

Set number of seconds, between each retry to connect with NetSuite. The default is 30 seconds.
Set the number of times you want to retry before failing. The default is 5 times.

In the Activity Timeout section:
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Set the Activity Timeout, in seconds, you want to wait when the endpoint does not respond to a
request. The default is 300 seconds.

14. Map inputs. See Mapping the inputs for the Attach Records activity for more information.
15. Map outputs. See Mapping the outputs for the Attach Records activity for more information.

Parent topic: Attach Records activity
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Mapping the inputs for the Attach Records activity
To map the inputs for the Attach Records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Inputs task.
2. Click Select Inputs... and select the input variables for the map.

For instructions on how to create variables, see Creating Variables.

3. Map the elements in the From Orchestration panel to the NetSuite elements in the To Activity panel.

The elements in the To Activity panel are determined by the NetSuite record type you selected in the
Configure task. For mapping instructions, see Creating a Map.

Parent topic: Attach Records activity
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Mapping the outputs for the Attach Records activity
To map the outputs for the Attach Records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Outputs task.
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2. Click Copy.
3. Select either or both addListResponse or headers and click Create to copy your choices from the Activity

panel to the Orchestration panel.

Parent topic: Attach Records activity
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Delete Records activity
The Delete Records activity can delete one or more records from NetSuite. Each deleted record must be
uniquely identifiable by its name, type, and hierarchy. If two or more records have the same identifiers, a SOAP
fault is posted. The records to be deleted must be of the same record type.

Using the Delete Records activity
To use the Delete Records activity, complete the following steps:
Mapping the inputs for the Delete Records activity
To map the inputs for the delete records activity, complete the following steps.
Mapping the outputs for the Delete Records activity
To map the outputs for the delete records activity, complete the following steps.

Parent topic: NetSuite Activities
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Using the Delete Records activity
To use the Delete Records activity, complete the following steps:

Procedure

1. In the Activities tab, expand the NetSuite directory and locate the Delete Records activity.
2. Add the Delete Records activity to your orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.
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3. In the Checklist, click Pick Endpoint.
4. Select one of the following:

Browse - to select a NetSuite endpoint from the Project Explorer.
New - to create a new NetSuite endpoint using the Create Endpoint dialog.

For instructions on creating a NetSuite endpoint, see Creating or editing a NetSuite endpoint.

Edit - to edit an existing NetSuite endpoint using the Edit Endpoint dialog.
For instructions on editing a NetSuite endpoint, see Creating or editing a NetSuite endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the project.

5. In the Checklist, click Configure.
6. Click Browse to display the Browse NetSuite dialog.
7. In the Browse NetSuite dialog, click Show Record Types and select one of the following options:

All – to view all record types.
Only Custom – to view only custom records.
Only Standard – to view only standard NetSuite record types.

Note: To use custom records, you must enter the internal ID in the recType/internalId node.
8. To view custom fields in standard records, select the Generate custom fields for standard record types

checkbox.

This option does not apply to custom record types. The state of the checkbox is saved.

9. In the Browse NetSuite dialog, choose a record type by performing one of the following tasks:
Enter the first few letters of a record type in the Search for a Record Type field, select the record
type in the Record Type scroll list and then click Select.
Scroll through the Record Type scroll list until you find the record type you want, click the record
type, and then click Select.

10. To refresh the maps in NetSuite, in the Configure pane, click Refresh after the record type is set.
11. In the Checklist, click Retry.
12. In the Retry section:

Set the number of seconds, between each retry to connect with NetSuite. The default is 30
seconds.
Set the number of times you want to retry before failing. The default is 5 times.

In the Activity Timeout section:
Set the Activity Timeout, in seconds, you want to wait when the endpoint does not respond to a
request. The default is 300 seconds.

13. Map inputs. See Mapping the inputs for the Delete Records activity for more information.
14. Map outputs. See Mapping the outputs for the Delete Records activity for more information.

Parent topic: Delete Records activity
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Mapping the inputs for the Delete Records activity
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To map the inputs for the delete records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Inputs task.
2. Click Select Inputs... and select the input variables for the map.

For instructions on how to create variables, see Creating Variables.

3. Map the elements in the From Orchestration panel to the NetSuite elements in the To Activity panel.

The elements in the To Activity pane are determined by the NetSuite record type you selected in the
Configure task. For mapping instructions, see Creating a Map.

Parent topic: Delete Records activity
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Mapping the outputs for the Delete Records activity
To map the outputs for the delete records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Outputs task.
2. Click Copy.
3. Select deleteListResponse. Click Create to copy deleteListResponse from the Activity panel to the

Orchestration panel.

Parent topic: Delete Records activity

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/netsuite_Delete_Records_Map_Output.
html

Detach Records activity
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The detach records activity can be used to remove a relationship between two records. For example, a Contact
record associated with a Vendor record can be removed. The Detach Records activity can also detach files,
such as Word or PDF files, from a NetSuite record.

About this task

The following list describes the nodes for the Detach Records activity in the Checklist > Map Inputs > To
Activity panel:

{RecordRef} attachTo - this node specifies the record to which the attachment is removed.
@type – In the Define Default Value, select the type of record.
@externalId – Either externalId or internalId must be specified for the RecordRef.
@internalID – Either externalId or internalId must be specified for the RecordRef.

contact – This node specifies the record or the file to detach from the detachTo record.
@internalID – Either externalId or internalId must be specified for the RecordRef.
@externalId – Either externalId or internalId must be specified for the RecordRef.
@type – In the Define Default Value, select the type of record.
name – Enter the name of the contact or the file name.

contactRole – This node specifies the role in the user defined Contact List located in the NetSuite UI at
List > Relationships > Contacts.

exists – a Boolean used to indicate whether the Contacts List exists or not.
@internalID – Either externalId or internalId must be specified for the role.
@externalId – Either externalId or internalId must be specified for the role.
name – The title of the role such as Primary Contact.

Using the Detach Records activity
To use the detach Records activity, complete the following steps:
Mapping the inputs for the Detach Records activity
To map the inputs for the detach records activity, complete the following steps.
Mapping the outputs for the Detach Records activity
To map the outputs for the detach records activity, complete the following steps.
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Using the Detach Records activity
To use the detach Records activity, complete the following steps:

Procedure

1. In the Activities tab, expand the NetSuite directory and locate the Detach Records activity.
2. Add the Detach Records activity to your orchestration.
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The Checklist and Summary for the activity are displayed beneath the orchestration.

3. In the Checklist, click Pick Endpoint.
4. Select one of the following options:

Browse - to select a NetSuite endpoint from the Project Explorer.
New - to create a new NetSuite endpoint using the Create Endpoint dialog.

For instructions on creating a NetSuite endpoint, see Creating or editing a NetSuite endpoint.

Edit - to edit an existing NetSuite endpoint using the Edit Endpoint dialog.
For instructions on editing a NetSuite endpoint, see Creating or editing a NetSuite endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the project.

5. In the Checklist, click Configure.
6. Click Configure to display the Detach Reference Activity Wizard.
7. Click Browse.
8. Select the record you want to attach and click Select.
9. Click Next.

10. Select the record to which you want to attach the attachment record and click Select.
11. Click Finish.
12. In the Checklist, click Retry.
13. In the Retry section:

Set the number of seconds, between each retry to connect with NetSuite. The default is 30
seconds.
Set the number of times you want to retry before failing. The default is 5 times.

In the Activity Timeout section:
Set the Activity Timeout, in seconds, you want to wait when the endpoint does not respond to a
request. The default is 300 seconds.

14. MapiInputs. See Mapping the inputs for the Detach Records activity for more information.
15. Map outputs. See Mapping the outputs for the Detach Records activity for more information.

Parent topic: Detach Records activity
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Mapping the inputs for the Detach Records activity
To map the inputs for the detach records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Inputs task.
2. Click Select Inputs... and select the input variables for the map.

For instructions on creating variables, see Creating Variables.
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3. Map the elements in the From Orchestration pane to the NetSuite elements in the To Activity pane.

The elements in the To Activity pane are determined by the NetSuite record type you selected in the
Configure task. For mapping instructions, see Creating a Map.

Parent topic: Detach Records activity
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Mapping the outputs for the Detach Records activity
To map the outputs for the detach records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Outputs task.
2. Click Copy.
3. Select detachListResponse and click Create to copy the detachListResponse from the Activity panel to

the Orchestration panel.

Parent topic: Detach Records activity

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/netsuite_Detach_Records_Map_Output
.html

Get Records activity
The Get Records activity retrieves one or more records based on the records unique IDs. If any of the IDs are
invalid, valid IDs are processed and a warning for invalid IDs is sent in the response.

Using the Get Records activity
To use the Get Records activity complete the following steps.
Mapping the inputs for the Get Records activity
To map the inputs for the get records activity, complete the following steps.
Mapping the outputs for the Get Records activity
To map the outputs for the get records activity, complete the following steps.
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Parent topic: NetSuite Activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/netsuite_Get_Records_Activity_ov.html

Using the Get Records activity
To use the Get Records activity complete the following steps.

Procedure

1. In the Activities tab, expand the NetSuite directory and locate the Get Records activity.
2. Add the Get Records activity to your orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. In the Checklist, click Pick Endpoint.
4. Select one of the following options:

Browse - to select a NetSuite endpoint from the Project Explorer.
New - to create a new NetSuite endpoint using the Create Endpoint dialog.

For instructions on creating a NetSuite endpoint, see Creating or editing a NetSuite endpoint.

Edit - to edit an existing NetSuite endpoint using the Edit Endpoint dialog.
For instructions on editing a NetSuite endpoint, see Creating or editing a NetSuite endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the project.

5. In the Checklist, click Configure.
6. Click Browse to display the Browse NetSuite dialog.
7. In the Browse NetSuite dialog, click Show Record Types and select one of the following:

All – to view all record types.
Only Custom – to view only custom records.
Only Standard – to view only standard NetSuite record types.

Note: To use custom records, you must enter the internal ID in the recType/internalId node.
8. To view custom fields in standard records, select the Generate custom fields for standard record types

checkbox.

This option does not apply to custom record types. The state of the checkbox is saved.

9. In the Browse NetSuite dialog, choose a record type by performing one of the following tasks:
Enter the first few letters of a record type in the Search for a Record Type field, select the record
type in the Record Type scroll list and then click Select.
Scroll through the Record Type scroll list until you find the record type you want, click the record
type, and then click Select.

10. To refresh the maps in NetSuite, after the record type is set in the Configure panel, click Refresh.
11. In the Checklist, click Retry.
12. In the Retry section:
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Set the number of seconds, between each retry to connect with NetSuite. The default is 30
seconds.
Set the number of times you want to retry before failing. The default is 5 times.

In the Activity Timeout section:
Set the Activity Timeout, in seconds, you want to wait when the endpoint does not respond to a
request. The default is 300 seconds.

13. Map inputs. See Mapping the inputs for the Get Records activity for more information.
14. Map outputs. See Mapping the outputs for the Get Records activity for more information.
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Mapping the inputs for the Get Records activity
To map the inputs for the get records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Inputs task.
2. Click Select Inputs... and select the input variables for the map.

For instructions on creating variables, see Creating Variables.

3. Map the elements in the From Orchestration panel to the NetSuite elements in the To Activity panel.

The elements in the To Activity panel are determined by the NetSuite record type you selected in the
Configure task. For mapping instructions, see Creating a Map.
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Mapping the outputs for the Get Records activity
To map the outputs for the get records activity, complete the following steps.
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Procedure

1. In the Checklist, click the Map Outputs task.
2. Click Copy.
3. Select getListResponse and click Create to copy your choices from the Activity panel to the

Orchestration panel.
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Initialize Record activity
Use the Initialize Record activity to populate a transaction record with input from another related record. For
example, you can populate a Sales Order record with input from the related Estimate record before submitting
the Sales Order record to NetSuite.

About this task

The following table lists the transaction records with the related record types that can be used to populate the
transaction records.

Transaction Record Type Related Initialization Record

Customer Refund Cash Sale

Customer Refund Return Authorization

Cash Sale Customer

Cash Sale Estimate

Cash Sale Opportunity

Cash Sale Sales Order

Credit Memo Customer

Credit Memo Invoice

Credit Memo Return Authorization

Customer Payment Customer

Customer Payment Invoice

Estimate Opportunity

Invoice Customer

Invoice Estimate
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Transaction Record Type Related Initialization Record

Invoice Opportunity

Invoice Sales Order

Item Fulfillment Sales Order

Item Receipt Return Authorization

Item Receipt Purchase Order

Return Authorization Cash Sale

Return Authorization Invoice

Return Authorization Sales Order

Sales Order Estimate

Sales Order Opportunity

Vendor Bill Purchase Order

Using the Initialize Record activity
To use the initialize records activity complete the following steps.
Mapping the inputs for the Initialize Records activity
To map the inputs for the initialize records activity, complete the following steps.
Mapping the outputs for the Initialize Records activity
To map the outputs for the initialize records activity, complete the following steps.
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Using the Initialize Record activity
To use the initialize records activity complete the following steps.

Procedure

1. In the Activities tab, expand the NetSuite directory and locate the Initialize Records activity.
2. Add the Initialize Records activity to your orchestration.

The Checklist and Summary for the activity display beneath the orchestration.

3. In the Checklist, click Pick Endpoint.
4. Select one of the following options:

Browse - to select a NetSuite endpoint from the Project Explorer.
New - to create a new NetSuite endpoint using the Create Endpoint dialog.

 457



For instructions on creating a NetSuite endpoint, see Creating or editing a NetSuite endpoint.

Edit - to edit an existing NetSuite endpoint using the Edit Endpoint dialog.
For instructions on editing a NetSuite endpoint, see Creating or editing a NetSuite endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the project.

5. In the Checklist, click Configure.
6. Click Browse to display the Browse NetSuite dialog.
7. In the Browse NetSuite dialog, click Show Record Types and select one of the following options:

All – to view all record types.
Only Custom – to view only custom records.
Only Standard – to view only standard NetSuite record types.

Note: To use custom records, you must enter the internal ID in the recType/internalId node.
8. To view custom fields in standard records, select the Generate custom fields for standard record types

checkbox.

This option does not apply to custom record types. The state of the checkbox is saved.

9. In the Browse NetSuite dialog, choose a record type by performing one of the following tasks:
Enter the first few letters of a record type in the Search for a Record Type field, select the record
type in the Record Type scroll list and then click Select.
Scroll through the Record Type scroll list until you find the record type you want, click the record
type, and then click Select.

10. To refresh the maps in NetSuite, after the record type is set in the Configure panel, click Refresh.
11. In the Checklist, click Retry.
12. In the Retry section:

Set the number of seconds, between each retry to connect with NetSuite. The default is 30
seconds.
Set the number of times you want to retry before failing. The default is 5 times.

In the Activity Timeout section:
Set the Activity Timeout, in seconds, you want to wait when the endpoint does not respond to a
request. The default is 300 seconds.

13. Map inputs. See Mapping the inputs for the Initialize Records activity for more information.
14. Map outputs. See Mapping the outputs for the Initialize Records activity for more information.
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Mapping the inputs for the Initialize Records activity
To map the inputs for the initialize records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Inputs task.
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2. Click Select Inputs... and select the input variables for the map.

For instructions on creating variables, see Creating Variables.

3. Map the elements in the From Orchestration panel to the NetSuite elements in the To Activity panel.

The elements in the To Activity pane are determined by the NetSuite record type you selected in the
Configure task. For mapping instructions, see Creating a Map.
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Mapping the outputs for the Initialize Records activity
To map the outputs for the initialize records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Outputs task.
2. Click Copy.
3. Select initializeListResponse and click Create to copy your choices from the Activity panel to the

Orchestration panel.
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Search Records activity
The Search Records activity searches for a specific record type based on search criteria that you specify.

About this task

 459



You specify search criteria by expanding an element node and then specifying the operator and search value.
For example, for a record type having an account number node:

1. Expand the accountNumber node.
2. Click operator and then right-click operator.
3. Select Define Default Value.
4. In the Default Value field, click the arrow and select an operator from the list.
5. Click OK.
6. Click searchValue.
7. Select Define Default Value.
8. In the Default Value field, enter the account number.
9. Click OK.

The Search Records activity supports searching on fields with a null value using the operator noneOf. This
search returns all records for which the field does not have a null value.

To retrieve values from lists, use the Get Records activity as the Search Records activity does not support lists.

You define the search criteria during the Map Inputs task in the To Activity panel.

Using the Search Records activity
To use the search records activity complete the following steps.
Mapping the inputs for the Search Records activity
To map the inputs for the search records activity, complete the following steps.
Mapping the outputs for the Search Records activity
To map the outputs for the search records activity, complete the following steps.
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Using the Search Records activity
To use the search records activity complete the following steps.

Procedure

1. In the Activities tab, expand the NetSuite directory and locate the Initialize Records activity.
2. Add the Initialize Records activity to your orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. In the Checklist, click Pick Endpoint.
4. Select one of the following options:

Browse - to select a NetSuite endpoint from the Project Explorer.
New - to create a new NetSuite endpoint using the Create Endpoint dialog.
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For instructions on creating a NetSuite endpoint, see Creating or editing a NetSuite endpoint.

Edit - to edit an existing NetSuite endpoint using the Edit Endpoint dialog.
For instructions on editing a NetSuite endpoint, see Creating or editing a NetSuite endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the project.

5. In the Checklist, click Configure.
6. Click Browse to display the Browse NetSuite dialog.
7. In the Browse NetSuite dialog, click Show Record Types and select one of the following options:

All – to view all record types.
Only Custom – to view only custom records.
Only Standard – to view only standard NetSuite record types.

Note: To use custom records, you must enter the internal ID in the recType/internalId node.
8. To view custom fields in standard records, select the Generate custom fields for standard record types

checkbox.

This option does not apply to custom record types. The state of the checkbox is saved.

9. In the Browse NetSuite dialog, choose a record type by performing one of the following tasks:
Enter the first few letters of a record type in the Search for a Record Type field, select the record
type in the Record Type scroll list and then click Select.
Scroll through the Record Type scroll list until you find the record type you want, click the record
type, and then click Select.

10. To refresh the maps in NetSuite, after the record type is set in the Configure panel, click Refresh.
11. In the Checklist, click Retry.
12. In the Retry section:

Set the number of seconds, between each retry to connect with NetSuite. The default is 30
seconds.
Set the number of times you want to retry before failing. The default is 5 times.

In the Activity Timeout section:
Set the Activity Timeout, in seconds, you want to wait when the endpoint does not respond to a
request. The default is 300 seconds.

13. Map inputs. See Mapping the inputs for the Search Records activity for more information.
14. Map outputs. See Mapping the outputs for the Search Records activity for more information.
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Mapping the inputs for the Search Records activity
To map the inputs for the search records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Inputs task.
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2. Click Select Inputs... and select the input variables for the map.

For instructions on creating variables, see Creating Variables.

3. Map the elements in the From Orchestration panel to the NetSuite elements in the To Activity panel.

The elements in the To Activity panel are determined by the NetSuite record type you selected in the
Configure task. For mapping instructions, see Creating a Map.
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Mapping the outputs for the Search Records activity
To map the outputs for the search records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Outputs task.
2. Click Copy to copy the searchResponse elements from the Activity panel to the Orchestration panel.
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Update Records activity
The Update Records activity can update one or more records. Only fields that are populated are updated in
NetSuite. For fields that are not populated, the previous value in NetSuite is maintained. If a field is populated
with an empty string, the value of the field in NetSuite is replaced with an empty string.

Using the Update Records activity
To use the Update Records activity complete the following tasks.
Mapping the inputs for the Update Records activity
To map the inputs for the update records activity, complete the following steps.
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Mapping the outputs for the Update Records activity
To map the outputs for the update records activity, complete the following steps.
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Using the Update Records activity
To use the Update Records activity complete the following tasks.

Procedure

1. In the Activities tab, expand the NetSuite directory and locate the Get Records activity.
2. Add the Get Records activity to your orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. In the Checklist, click Pick Endpoint.
4. Select one of the following options:

Browse - to select a NetSuite endpoint from the Project Explorer.
New - to create a new NetSuite endpoint using the Create Endpoint dialog.

For instructions on creating a NetSuite endpoint, see Creating or editing a NetSuite endpoint.

Edit - to edit an existing NetSuite endpoint using the Edit Endpoint dialog.
For instructions on editing a NetSuite endpoint, see Creating or editing a NetSuite endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the project.

5. In the Checklist, click Configure.
6. Click Browse to display the Browse NetSuite dialog.
7. In the Browse NetSuite dialog, click Show Record Types and select one of the following options:

All – to view all record types.
Only Custom – to view only custom records.
Only Standard – to view only standard NetSuite record types.

Note: To use custom records, you must enter the internal ID in the recType/internalId node.
8. To view custom fields in standard records, select the Generate custom fields for standard record types

checkbox.

This option does not apply to custom record types. The state of the checkbox is saved.

9. In the Browse NetSuite dialog, choose a record type by performing one of the following tasks:
Enter the first few letters of a record type in the Search for a Record Type field, select the record
type in the Record Type scroll list and then click Select.
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Scroll through the Record Type scroll list until you find the record type you want, click the record
type, and then click Select.

10. To refresh the maps in NetSuite, after the record type is set in the Configure panel, click Refresh.
11. In the Checklist, click Retry.
12. In the Retry section:

Set the number of seconds, between each retry to connect with NetSuite. The default is 30
seconds.
Set the number of times you want to retry before failing. The default is 5 times.

In the Activity Timeout section:
Set the Activity Timeout, in seconds, you want to wait when the endpoint does not respond to a
request. The default is 300 seconds.

13. Map inputs. See Mapping the inputs for the Update Records activity for more information.
14. Map outputs. See Mapping the outputs for the Update Records activity for more information.
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Mapping the inputs for the Update Records activity
To map the inputs for the update records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Inputs task.
2. Click Select Inputs... and select the input variables for the map.

For instructions on how to create variables, see Creating Variables.

3. Map the elements in the From Orchestration panel to the NetSuite elements in the To Activity panel.

The elements in the To Activity panel are determined by the NetSuite record type you selected in the
Configure task. For mapping instructions, see Creating a Map.
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Mapping the outputs for the Update Records activity
To map the outputs for the update records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Outputs task.
2. Click Copy.
3. Select either or both updateListResponse or headers_x and click Create to copy your choices from the

Activity panel to the Orchestration panel.
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Upsert Records Activity
The Upsert Records activity can update a record if the record already exists in the database, or to insert the
record if it does not. Only fields that are populated are updated in NetSuite. For fields that are not populated,
the previous value in NetSuite is maintained. If a field is populated with an empty string, the value of the field in
NetSuite is replaced with an empty string.

Using the Upsert Records activity
To use the Upsert Records activity complete the following tasks.
Mapping the inputs for the Upsert Records activity
To map the inputs for the update records activity, complete the following steps.
Mapping the outputs for the Upsert Records activity
To map the outputs for the update records activity, complete the following steps.
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Using the Upsert Records activity
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To use the Upsert Records activity complete the following tasks.

Procedure

1. In the Activities tab, expand the NetSuite directory and locate the Upsert Records activity.
2. Add the Upsert Records activity to your orchestration.

The Checklist and Summary for the activity are displayed below the orchestration.

3. In the Checklist, click Pick Endpoint.
4. Select one of the following options:

Browse - to select a NetSuite endpoint from the Project Explorer.
New - to create a new NetSuite endpoint using the Create Endpoint dialog.

For instructions on creating a NetSuite endpoint, see Creating or editing a NetSuite endpoint.

Edit - to edit an existing NetSuite endpoint using the Edit Endpoint dialog.
For instructions on editing a NetSuite endpoint, see Creating or editing a NetSuite endpoint.
Note: Edits are global, not local. Editing an endpoint affects all orchestrations that use that
endpoint in the project.

5. In the Checklist, click Configure.
6. Click Browse to display the Browse NetSuite dialog.
7. In the Browse NetSuite dialog, click Show Record Types and select one of the following options:

All – to view all record types.
Only Custom – to view only custom records.
Only Standard – to view only standard NetSuite record types.

Note: To use custom records, you must enter the internal ID in the recType/internalId node.
8. To view custom fields in standard records, select the Generate custom fields for standard record types

checkbox.

This option does not apply to custom record types. The state of the checkbox is saved.

9. In the Browse NetSuite dialog, choose a record type by performing one of the following tasks:
Enter the first few letters of a record type in the Search for a Record Type field, select the record
type in the Record Type scroll list and then click Select.
Scroll through the Record Type scroll list until you find the record type you want, click the record
type, and then click Select.

10. To refresh the maps in NetSuite, after the record type is set in the Configure panel, click Refresh.
11. In the Checklist, click Retry.
12. In the Retry section:

Set the number of seconds, between each retry to connect with NetSuite. The default is 30
seconds.
Set the number of times you want to retry before failing. The default is 5 times.

In the Activity Timeout section:
Set the Activity Timeout, in seconds, you want to wait when the endpoint does not respond to a
request. The default is 300 seconds.

13. Map inputs. See Mapping the inputs for the Upsert Records activity for more information.
14. Map outputs. See Mapping the outputs for the Upsert Records activity for more information.

Parent topic: Upsert Records Activity
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Mapping the inputs for the Upsert Records activity
To map the inputs for the update records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Inputs task.
2. Click Select Inputs... and select the input variables for the map.

For instructions on how to create variables, see Creating Variables.

3. Map the elements in the From Orchestration panel to the NetSuite elements in the To Activity panel.

The elements in the To Activity panel are determined by the NetSuite record type you selected in the
Configure task. For mapping instructions, see Creating a Map.
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Mapping the outputs for the Upsert Records activity
To map the outputs for the update records activity, complete the following steps.

Procedure

1. In the Checklist, click the Map Outputs task.
2. Click Copy.
3. Select either or both upsertListResponse or headers_x and click Create to copy your choices from the

Activity panel to the Orchestration panel.

Parent topic: Upsert Records Activity

Feedback | Notices
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Oracle CRM On Demand Activities
The following activities require the C0020-IBM: Connector for Oracle CRM On Demand.

Creating or editing an Oracle CRM On Demand endpoint
Oracle CRM On Demand endpoints contain the connection information that studio and the Integration
Appliance use to connect to the Oracle CRM On Demand Server. You can create multiple endpoints that
refer to separate instances.
Specifying the Retry options for Oracle CRM On Demand activities
Specifying the Retry parameters is one of the tasks to configure an Oracle CRM On Demand activity.
Using the Oracle CRM On Demand Insert Object activity
Use the Oracle CRM On Demand Insert Object activity to insert or create objects in the Oracle CRM On
Demand instance.
Using the Oracle CRM On Demand Update Object activity
Use the Oracle CRM On Demand Update Object activity to update objects in the Oracle CRM On Demand
instance, with new values.
Using the Oracle CRM On Demand Query Object activity
Use the Oracle CRM On Demand Query Object activity to query objects in the Oracle CRM instance.
Using the Oracle CRM On Demand Delete Object activity
Use the Oracle CRM On Demand Delete Object activity to delete objects from the Oracle CRM On
Demand instance.
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Creating or editing an Oracle CRM On Demand endpoint
Oracle CRM On Demand endpoints contain the connection information that studio and the Integration
Appliance use to connect to the Oracle CRM On Demand Server. You can create multiple endpoints that refer to
separate instances.

About this task

Use this task to create or edit an Oracle CRM On Demand endpoint.
Note:
Any changes you make to the Oracle CRM On Demand endpoint, including configuration properties, affects all
the orchestrations that use that endpoint, as the edits are global, not local.
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Procedure

1. Drag an activity from the Oracle CRM On Demand folder under the Activities tab to the Orchestration
window. The Summary panel is displayed.

2. Click Pick Endpoint from the Checklist. The Pick Endpoint panel is displayed.
3. Click one of the following buttons:

a. Browse - To select an existing endpoint from Project Explorer. The Project Explorer shows all the
endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel.

b. New - To create a new endpoint. The Create Endpoint window opens.
c. Edit - To edit the existing endpoint. The Edit Endpoint window opens.

4. Complete the fields defined in the following table:
Table 1. Connection Details

Field Name Description

Connection Details

OracleCRM HostName Specifies the host name of the Oracle CRM On Demand instance.

User Name Specifies the user name to connect to the OracleCRM On Demand server.

Password Specifies the password associated with the user name to connect to the
OracleCRM On Demand server.

5. When finished, click Test Connection to confirm that you can connect to the Oracle CRM On Demand
system.

6. Click OK.

Parent topic: Oracle CRM On Demand Activities
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Specifying the Retry options for Oracle CRM On Demand
activities

Specifying the Retry parameters is one of the tasks to configure an Oracle CRM On Demand activity.

About this task

Use this task to configure the retry options for the Oracle CRM On Demand activities. The Oracle CRM On
Demand connector uses a single login session for all connections to an Oracle CRM On Demand endpoint. If a
session expires, the connector automatically establishes a new session. The connector does not count the
initial attempt to reacquiring the session as a retry attempt. The connector assumes the typical connector retry
behavior after the initial attempt to reacquire a session fails.
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Procedure

1. Select the Retry task from the Checklist. The retry pane is displayed.
2. Configure the retry and timeout options for connecting to an Oracle CRM On Demand instance, as

described in the following table:
Table 1. Retry options

Retry
Fields Description

Wait __
seconds
betwee
n each
retry.

Specifies the number of seconds that the Integration Appliance waits before trying to
establish a connection to the Oracle CRM On Demand instance.

Try to
connect
__ times
before
failing.

Specifies the retry count — the maximum number of times the Integration Appliance
attempts to establish a connection to the Oracle CRM On Demand instance before issuing an
error and stopping the processing of the current orchestration job.
Note: If you deploy an orchestration that contains the Oracle CRM On Demand activity and
the Integration Appliance cannot connect to the specified Oracle CRM On Demand instance,
the Integration Appliance logs the connections errors as Warnings in the system and
orchestration logs until the retry count value is reached. When the retry count is reached,
the Integration Appliance logs an Error in the system and orchestration logs and stops
processing the current orchestration job. For example, you set the retry count to 3, the first,
second, and third connection errors appear in the system log as warnings. The Integration
Appliance logs the fourth connection error as an error and stops processing the current
orchestration job.

Activity
Timeout

Timeout
after
____
seconds
when
the
endpoin
t does
not
respond
to a
request.

Specifies the number of seconds the Integration Appliance waits before timing out, when
the endpoint does not respond to a request. The default is 300 seconds.
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Using the Oracle CRM On Demand Insert Object activity
Use the Oracle CRM On Demand Insert Object activity to insert or create objects in the Oracle CRM On Demand
instance.

About this task

Use this task to insert or create objects in the Oracle CRM On Demand instance. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Oracle CRM On Demand folder
contents.

2. Drag the Insert Object activity icon onto the orchestration. The Oracle CRM On Demand Insert Object
Checklist is displayed.

3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Oracle CRM On Demand

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an Oracle CRM On Demand endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse OracleCRMOD window is displayed.
11. In Browse OracleCRMOD, you can either filter the object type by specifying the object type in the Search

for an object type field, or select the object type from the object type list. Click OK. The object field
preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying the Retry options for Oracle CRM On Demand activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Insert Object activity are displayed as nodes under the request input parameter in the To Activity panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.
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Results

You have configured the Oracle CRM On Demand Insert Object activity.
Parent topic: Oracle CRM On Demand Activities
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Using the Oracle CRM On Demand Update Object activity
Use the Oracle CRM On Demand Update Object activity to update objects in the Oracle CRM On Demand
instance, with new values.

About this task

Use this task to update objects in the Oracle CRM On Demand instance, with new values. The call to this
activity is a synchronous call where the input data is sent to the activity for processing and the response is sent
back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Oracle CRM On Demand folder
contents.

2. Drag the Update Object activity icon onto the orchestration. The Oracle CRM On Demand Update Object
Checklist is displayed.

3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Oracle CRM On Demand

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an Oracle CRM On Demand endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse OracleCRMOD window is displayed.
11. In Browse OracleCRMOD, you can either filter the object type by specifying the object type in the Search

for an object type field, or select the object type from the object type list. Click OK. The object field
preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying the Retry options for Oracle CRM On Demand activities.
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14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Update Object activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Oracle CRM On Demand Update Object activity.
Parent topic: Oracle CRM On Demand Activities
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Using the Oracle CRM On Demand Query Object activity
Use the Oracle CRM On Demand Query Object activity to query objects in the Oracle CRM instance.

About this task

Use this task to query objects in the Oracle CRM On Demand instance. The call to this activity is a synchronous
call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Oracle CRM On Demand folder
contents.

2. Drag the Query Object activity icon onto the orchestration. The Oracle CRM On Demand Query Object
Checklist is displayed.

3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Oracle CRM On Demand

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an Oracle CRM On Demand endpoint.
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8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse OracleCRMOD window is displayed.
11. In Browse OracleCRMOD, you can either filter the object type by specifying the object type in the Search

for an object type field, or select the object type from the object type list. Click OK. The object field
preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying the Retry options for Oracle CRM On Demand activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Query Object activity are displayed as nodes under the request input parameter in the To Activity panel.

Perform the following steps to type the query strings in the SearchSpec of the To Activity pane:

a. Right-click a SearchSpec and select the Define Default Value option.
b. Specify the Default Value in the Define Default Value window. For example, to query for contact

objects whose given name begins with Jo, then type the query string as "[ContactFirstName]
= ‘Jo*’”. To query for contact objects whose given name is John, type ”[ContactFirstName]
= ‘John’”. To query for contact objects whose name is Jane Doe, type the query string as "
([ContactFirstName] = ‘Jane’”) AND ([ContactLastName] = ‘Doe’”).

c. Click OK.
Note: To get the value of the object name field, you must specify a blank value in the Name field of the
Map Inputs section.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Oracle CRM On Demand Query Object activity.
Parent topic: Oracle CRM On Demand Activities
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Using the Oracle CRM On Demand Delete Object activity
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Use the Oracle CRM On Demand Delete Object activity to delete objects from the Oracle CRM On Demand
instance.

About this task

Use this task to delete objects from the Oracle CRM On Demand instance. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Oracle CRM On Demand folder
contents.

2. Drag the Delete Object activity icon onto the orchestration. The Oracle CRM On Demand Delete Object
Checklist is displayed.

3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Oracle CRM On Demand

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an Oracle CRM On Demand endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse OracleCRMOD window is displayed.
11. In Browse OracleCRMOD, you can either filter the object type by specifying the object type in the Search

for an object type field, or select the object type from the object type list. Click OK. The object field
preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying the Retry options for Oracle CRM On Demand activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Delete Object activity are displayed as nodes under the request input parameter in the To Activity panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Oracle CRM On Demand Delete Object activity.
Parent topic: Oracle CRM On Demand Activities
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Oracle E-Business Suite Activities
Overview of the Oracle E-Business Suite connector
Installing JAR files to connect to Oracle E-Business Suite
You must copy the Oracle JDBC driver JAR file on the same workstation as your Cast Iron Studio
installation before you can connect to the Oracle E-Business Suite application.
Creating or editing an endpoint for an Oracle E-Business Suite activity
Endpoints provide the configuration information that Studio and the Integration Appliance use to
connect to an Oracle database.  
Using the Oracle E-Business Suite Create Objects activity
Use the Create Objects activity to create rows in database tables corresponding to the business object in
the request. You can create rows to flat tables/views that have a primary key defined.
Using the Oracle E-Business Suite Update Objects activity
Use the Update Objects activity to update rows in the database tables corresponding to the business
object in the request. You can update rows of flat tables that have a primary key defined.
Using the Oracle E-Business Suite Delete Objects activity
Use the Delete Objects activity to delete rows from the Oracle table. You can delete rows from flat
tables/views that have a primary key defined.
Using the Oracle E-Business Suite Retrieve Objects activity
Use the Retrieve Objects activity to retrieve rows from the Oracle table. You can retrieve rows from flat
tables/views that have a primary key defined.
Specifying Retry and Delivery options for Oracle E-Business Suite activities
Specifying the Retry and Delivery parameters is one of the tasks to configure a Oracle E-Business Suite
activity configuration.
Prerequisites for starter activities in Oracle E-Business Suite
Using the Oracle E-Business Suite Get Created Objects activity
Use the Get Created Objects activity to get the values of rows that have been newly created in the
database tables/views corresponding to the business object in the request.
Using the Oracle E-Business Suite Get Updated Objects activity
Use the Get Updated Objects activity to get the rows that have been updated in the database tables
corresponding to the business object in the request.
Using the Oracle E-Business Suite Get Deleted Objects activity
Use the Get Deleted Objects activity to get the deleted records from the Oracle table.

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/toc_oracleebsactivities.html

476   



Overview of the Oracle E-Business Suite connector
With the Oracle E-Business Suite connector, you can interact and exchange information with Oracle E-Business
Suite. By using the connector, you can send requests to the underlying Oracle database, without special coding.

You can perform the following activities by using the Oracle E-Business Suite connector:

Outbound Activities
Create Objects
Update Objects
Delete Objects
Retrieve Objects

Inbound Activities
Get Created Objects
Get Updated Objects
Get Deleted Objects

The versions of Oracle E-Business Suite application that is supported by the connector are 11.5,12.0, and 12.1.

Parent topic: Oracle E-Business Suite Activities
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Installing JAR files to connect to Oracle E-Business Suite
You must copy the Oracle JDBC driver JAR file on the same workstation as your Cast Iron Studio installation
before you can connect to the Oracle E-Business Suite application.

Before you begin

The JAR files can be obtained from the Oracle system administrator.
The JAR files must be on the same computer as the studio installation.
The JAR files must be from the same version as the Oracle E-Business Suite application you connect to.

Note: The Oracle E-Business Suite connector uses the Oracle thin driver to connect and work with the
database.

About this task

Procedure

1. Open studio and select Tools > Install Module Providers.
2. When the Add Provider(s) dialog box is displayed, click the plus (+) button under Oracle E-Business

Suite. A field and a Browse button appears.
3. Click Browse, and use the browse dialog box to locate and select the JAR file.
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4. Click Open to import the selected file.
5. When the JAR file is listed in the Add Provider(s) dialog box, click OK.

Results

A prompt is displayed to restart studio and activate the changes.

What to do next

You can now create Oracle E-Business Suite endpoints and orchestrations.

Parent topic: Oracle E-Business Suite Activities
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Creating or editing an endpoint for an Oracle E-Business Suite
activity

Endpoints provide the configuration information that Studio and the Integration Appliance use to connect to an
Oracle database.  

Selecting or editing an Oracle E-Business Suite endpoint

1. In the Create Endpoint or Edit Endpoint pane, configure the Oracle database as described in the
following table. In addition to these fields, the endpoint pane contains Connection pool options and
Remote Endpoint Configuration.
Note: Changing the configuration properties of an endpoint affects all orchestrations that use that
endpoint in the project. The edits are global, not local.

2. Click Test Connection to confirm that the connection details are valid and you are able to connect to the
Oracle database successfully.

3. Click OK.

Table 1. Connection properties
Field Name Description

Oracle E-Business Suite connector - Connection Information

Interface Specifies the interface used to communicate with Oracle E-Business Suite. Currently,
only database is supported, which uses JDBC API to communicate with Oracle E-
Business Suite.

Host Name Specifies the host name or IP address of the machine on which the Oracle database is
running.

Port Number Specifies the Oracle Internet port that allows Java™ applets or applications to access
the database.
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Field Name Description

System ID Specifies the system ID (SID) to connect to the Oracle database.

User Name Specifies the user name to connect to the Oracle database.

Password Specifies the password associated with the user name to connect to the Oracle
database.

Additional
Properties

Specifies the additional properties to be set when connecting to the database using the
JDBC driver.

Connection Pool options

Minimum
Connections

Specifies the lowest number of Oracle database connections that the Integration
Appliance keeps open in the connection pool. Entering 0 (zero) is supported. The
default value is 5.

Maximum
Connections

Specifies the maximum number of Oracle database connections that the Integration
Appliance can keep open in the connection pool. Entering 0 (zero) means the
maximum number of connections is unbounded. The default value is 25.

Maximum Idle Time Specifies the amount of time in minutes that a Oracle database connection can be
open in an idle state before being closed by the Integration Appliance. Entering 0
(zero) means that the connections are closed when they are returned to the pool —no
idle time. The default value is 120 minutes.

Maximum Wait Specifies the amount of time in seconds that the Integration Appliance waits for a
connection when all the connections in the pool are exhausted. If no connection is
obtained after the wait time, an exception is thrown. The default value is 300 seconds.

Reclaim
Connections

Specifies the interval at which the connector checks for idle connections. Idle
connections are reclaimed until the minimum number of connections is reached, as
specified in the Minimum Connections parameter. The default value is 5 minutes.

Note: The Connection pool properties need to be configured as per the load (number of concurrent requests)
on the endpoint.

Remote Endpoint Configuration

Endpoint Runs
Behind Firewall

Enables the secure connector name property so that secure connector can be used if
the Oracle database is installed behind a firewall.

Secure Connector
Name

Specifies the name of the secure connector that is used to connect to the Oracle
database is installed behind a firewall.

Parent topic: Oracle E-Business Suite Activities
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Using the Oracle E-Business Suite Create Objects activity
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Use the Create Objects activity to create rows in database tables corresponding to the business object in the
request. You can create rows to flat tables/views that have a primary key defined.

About this task

Use this task to create objects in the Oracle E-Business Suite application. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Oracle E-Business Suite folder
contents.

2. Drag the Create Objects activity from the Oracle E-Business Suite folder onto the orchestration. The
graphical representation of the orchestration, including the checklist is displayed.

3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Oracle E-Business Suite

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for an Oracle E-Business Suite activity.

8. To make the required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Browse for the Oracle table/view name in the Oracle Table/View field.
11. In Browse Oracle Database Tables/Views dialog:

Select a user schema from the Filter by user schema drop-down list.
Select either Tables or Views from Database object type.
Use Filter tables/views by name to filter the tables/views during selection.
Select a table/view.

12. Click OK.
13. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying Retry and Delivery options for Oracle E-Business Suite activities.
14. Select Map Inputs in the Checklist. The XML schemas generated from the selected object of the Create

Objects activity are displayed as nodes under the request input parameter in the To Activity panel.
15. Create a map between the orchestration variables and the input parameter of the activity.

Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel. Create a map
between the output parameters and orchestration variables.

Results

You have configured the Oracle E-Business Suite Create Objects activity.
Parent topic: Oracle E-Business Suite Activities
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Using the Oracle E-Business Suite Update Objects activity
Use the Update Objects activity to update rows in the database tables corresponding to the business object in
the request. You can update rows of flat tables that have a primary key defined.

About this task

Use this task to update objects in the Oracle E-Business Suite application. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Oracle E-Business Suite folder
contents.

2. Drag the Update Objects activity from the Oracle E-Business Suite folder onto the orchestration. The
graphical representation of the orchestration, including the checklist is displayed.

3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Oracle E-Business Suite

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for an Oracle E-Business Suite activity.

8. To make the required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Browse for the Oracle table/view name in the Oracle Table/View field.
11. In Browse Oracle Database Tables/Views dialog:

Select a user schema from the Filter by user schema drop-down list.
Select either Tables or Views from Database object type.
Use Filter tables/views by name to filter the tables/views during selection.
Select a table/view.

12. Select a table and click OK.
13. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying Retry and Delivery options for Oracle E-Business Suite activities.
14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Update Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
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Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel. Create a map
between the output parameters and orchestration variables.

Results

You have configured the Oracle E-Business Suite Update Objects activity.
Parent topic: Oracle E-Business Suite Activities
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Using the Oracle E-Business Suite Delete Objects activity
Use the Delete Objects activity to delete rows from the Oracle table. You can delete rows from flat tables/views
that have a primary key defined.

About this task

Use this task to delete rows from the Oracle E-Business Suite application. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Oracle E-Business Suite folder
contents.

2. Drag the Delete Objects activity from the Oracle E-Business Suite folder onto the orchestration. The
graphical representation of the orchestration, including the checklist is displayed.

3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Oracle E-Business Suite

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for an Oracle E-Business Suite activity.

8. To make the required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.
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9. In the Checklist, click Configure.
10. Browse for the Oracle table/view name in the Oracle Table/View field.
11. In Browse Oracle Database Tables/Views dialog:

Select a user schema from the Filter by user schema drop-down list.
Select either Tables or Views from Database object type.
Use Filter tables/views by name to filter the tables/views during selection.
Select a table/view.

12. Click OK.
13. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying Retry and Delivery options for Oracle E-Business Suite activities.
14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Delete Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel. Create a map
between the output parameters and orchestration variables.

Results

You have configured the Oracle E-Business Suite Delete Objects activity.
Parent topic: Oracle E-Business Suite Activities
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Using the Oracle E-Business Suite Retrieve Objects activity
Use the Retrieve Objects activity to retrieve rows from the Oracle table. You can retrieve rows from flat
tables/views that have a primary key defined.

About this task

Use this task to retrieve objects in the Oracle E-Business Suite application. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure
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1. In an active orchestration, open the Activities tab and expand the Oracle E-Business Suite folder
contents.

2. Drag the Retrieve Objects activity from the Oracle E-Business Suite folder onto the orchestration. The
graphical representation of the orchestration, including the checklist is displayed.

3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Oracle E-Business Suite

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for an Oracle E-Business Suite activity.

8. To make the required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Browse for the Oracle table/view name in the Oracle Table/View field.
11. In Browse Oracle Database Tables/Views dialog:

Select a user schema from the Filter by user schema drop-down list.
Select either Tables or Views from Database object type.
Use Filter tables/views by name to filter the tables/views during selection.
Select a table/view.

12. Click OK.
13. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying Retry and Delivery options for Oracle E-Business Suite activities.
14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Retrieve Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel. Create a map
between the output parameters and orchestration variables.

Results

You have configured the Oracle E-Business Suite Retrieve Objects activity.
Parent topic: Oracle E-Business Suite Activities
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Specifying Retry and Delivery options for Oracle E-Business
Suite activities

Specifying the Retry and Delivery parameters is one of the tasks to configure a Oracle E-Business Suite activity
configuration.

About this task

This section contains the procedures for configuring the Oracle E-Business Suite activities.

Procedure

To specify the retry options for Oracle E-Business Suite activities:

1. Select the Retry task from the Checklist. The retry pane is displayed.
2. Configure the retry options for connecting to a Oracle E-Business Suite server as described in the

following table:
Table 1. Retry options

Retr
y
Field
s Description

Wait
__
seco
nd(s)
betw
een
each
retry.

Specifies the number of seconds that the Integration Appliance waits before trying to establish
a connection to the Oracle E-Business Suite application.

Try
to
conn
ect
__
time
s
befor
e
failin
g.

Specifies the retry count — the maximum number of times the Integration Appliance attempts
to establish a connection to the Oracle E-Business Suite application before issuing the following
errors:

When you set this parameter to 0, Studio does not try to reconnect.
When you set this parameter to a value less than 0, Studio retries the connection
indefinitely.

If an orchestration that starts with an outbound Oracle E-Business Suite activity is deployed
and the Integration Appliance cannot connect to the specified Oracle E-Business Suite
application, the Integration Appliance logs the connection errors as warnings in the system log
until the retry count value is reached. When the retry count is reached, the Integration
Appliance logs an error in the system log, resets the connection error count to zero, and
continues to attempt to establish a connection to the Oracle E-Business Suite application.

For example, you set the retry count to 3. The first, second, and third connection errors appear
in the system log as warnings. The Integration Appliance logs the fourth connection error as an
error and stops processing the current orchestration job.

Parent topic: Oracle E-Business Suite Activities
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Specifying the delivery rules options for Oracle E-Business Suite inbound
activities

About this task

This section contains the procedure for configuring the delivery rule options for Oracle E-Business Suite
inbound activities.

Procedure

1. Select the Delivery Rules task from the Checklist. The delivery rules pane is displayed.
2. Configure the delivery rules options to select the activity's behavior as described in the following table.

Table 2. Delivery rules
Delivery Rules
Fields Description

Poll for changes
every ______
days/hours/minute
s/seconds

Specifies the time interval to poll for objects in the Oracle database. (For
example, the Get created object activity polls for create objects at the specified
time internal.) Time can be selected in the format days, hours, minutes, or
seconds.

Fetch ______ rows
per poll

Specifies how many objects or components the activity should retrieve from the
Oracle database in each poll cycle.

Delivery Messages  

ATMOST_ONCE A non-persistent mode in which a row from the Oracle table is either delivered
once or not delivered at all.

ATLEAST_ONCE A persistent mode, in which a row from the Oracle table is not lost. As a result,
there are chances that the orchestration can receive events once or more than
once.
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PeopleSoft activities
Overview of the PeopleSoft connector
Creating or editing an endpoint for a PeopleSoft activity
Endpoints provide the configuration information that Studio and the Integration Appliance use to
connect to a PeopleSoft server.  
Installing JAR files to connect to the PeopleSoft server
You must copy two JAR files on the same workstation as your Cast Iron Studio installation before you
can connect to a PeopleSoft server.
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Using the PeopleSoft Create Component Interface activity
Use the PeopleSoft Create Component Interface activity to create new component interfaces on the
PeopleSoft server. The newly created component contains data that represent a business entity.
Using the PeopleSoft Update Component Interface activity
Use the PeopleSoft Update Component Interface activity to update component interfaces on the
PeopleSoft server. This activity updates the corresponding PeopleSoft component with the incoming
business object.
Using the PeopleSoft Delete Component Interface activity
Use the PeopleSoft Delete Component Interface activity to delete component interfaces from the
PeopleSoft server. This activity deletes the PeopleSoft components and its children. Because the
connector supports only logical deletes, the components are marked as deleted, but not removed.
Using the PeopleSoft Get Component Interface activity
Use the PeopleSoft Get Component Interface activity to retrieve component interfaces from the
PeopleSoft server. With this activity you can access the PeopleSoft component and retrieve values from
the PeopleSoft server.
Using the PeopleSoft Find Component Interface activity
Use the PeopleSoft Find Component Interface activity to retrieve all the component interfaces from the
PeopleSoft server. This activity behaves like the PeopleSoft Get Component Interface activity, except
that it retrieves multiple instances of the same PeopleSoft component that match the input criteria.
Creating events table and compiling PeopleSoft JAR files
The first of the two required JAR files, which will be named PSFTCI.jar, must be manually built and
compiled.
Using the PeopleSoft Get Created Component Interface activity
Use the Get Created Component Interface activity to poll for created objects in the PeopleSoft server.
Using the PeopleSoft Get Updated Component Interface activity
Use the Get Updated Component Interface activity to poll for updated events in the PeopleSoft server.
Using the PeopleSoft Get Deleted Component Interface activity
Use the Get Deleted Component Interface activity to poll for deleted events in the PeopleSoft server.
Specifying retry and Delivery Options for PeopleSoft Activities
Specifying the Retry and Delivery parameters is one of the tasks to configure a PeopleSoft activity
configuration.
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Overview of the PeopleSoft connector
The PeopleSoft connector enables you to create integrated processes that exchange information with
PeopleSoft Enterprise through a standard interface. This interface shields the client application from analyzing
lower-level details about implementation of the application or data structures used on the PeopleSoft
Enterprise server.

You can perform the following activities using the PeopleSoft connector:

Outbound Activities
Create Component Interface
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Update Component Interface
Delete Component Interface
Get Component Interface
Find Component Interface

Inbound/Starter Activities
Get Created Component Interface
Get Updated Component Interface
Get Deleted Component Interface

The PeopleSoft connector supports the following versions of the PeopleTools: 8.22, 8.40 - 8.49, 8.50, and
8.51.
Note: The connector is compatible with any version of PeopleSoft Applications that works with the version of
PeopleTools supported by the adapter.

The PeopleSoft connector requires PeopleSoft JAR files to connect to the PeopleSoft server. For more
information, see Installing JAR files to connect to the PeopleSoft server and Creating events table and
compiling PeopleSoft JAR files.

Parent topic: PeopleSoft activities
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Creating or editing an endpoint for a PeopleSoft activity
Endpoints provide the configuration information that Studio and the Integration Appliance use to connect to a
PeopleSoft server.  

Selecting or editing a PeopleSoft endpoint

1. In the Create Endpoint or Edit Endpoint pane, configure the PeopleSoft server as described in the
following table. In addition to these fields, the endpoint pane contains Connection pool options and
Remote Endpoint Configuration.
Note: Changing the configuration properties of an endpoint affects all orchestrations that use that
endpoint in the project. The edits are global, not local.

2. Click Test Connection to confirm that the connection details are valid and you are able to connect to the
PeopleSoft server successfully.

3. Click OK.

Table 1. Connection properties
Field Name Description

PeopleSoft Server Configuration

Host Name Specifies the host name or IP address of the machine on which PeopleSoft server is
running.
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Field Name Description

Port Specifies the PeopleSoft Internet port that allows Java™ applets or applications to
access PeopleSoft data.

User Name Specifies the user name to connect to the PeopleSoft server.

Password Specifies the password associated with the user name to connect to the PeopleSoft
server.

Language Code Specifies the language code to connect to the PeopleSoft server. There are 22
language codes listed. The default code is ENG.

Connection Pool options

Minimum
Connections

Specifies the lowest number of PeopleSoft server connections that the Integration
Appliance keeps open in the connection pool. Entering 0 (zero) is supported. The
default value is 5.

Maximum
Connections

Specifies the maximum number of PeopleSoft server connections that the Integration
Appliance can keep open in the connection pool. Entering 0 (zero) means the
maximum number of connections is unbounded. The default value is 25.

Maximum Idle Time Specifies the amount of time in minutes that a PeopleSoft server connection can be
open in an idle state before being closed by the Integration Appliance. Entering 0
(zero) means that the connections are closed when they are returned to the pool —no
idle time. The default value is 120 minutes.

Maximum Wait Specifies the amount of time in seconds that the Integration Appliance waits for a
connection when all the connections in the pool are exhausted. If no connection is
obtained after the wait time, an exception is thrown. The default value is 300 seconds.

Reclaim
Connections

Specifies the interval at which the connector checks for idle connections. Idle
connections are reclaimed until the minimum number of connections is reached, as
specified in the Minimum Connections parameter. The default value is 5 minute.

Note: The Connection pool properties need to be configured as per the load (number of concurrent requests)
on the endpoint.

Remote Endpoint Configuration

Endpoint Runs
Behind Firewall

Enables the secure connector name property so that secure connector can be used if
the PeopleSoft server is running behind a firewall.

Secure Connector
Name

Specifies the name of the secure connector that is used to connect to the PeopleSoft
server running behind a firewall. For example, if an orchestration containing PeopleSoft
activity is deployed on to Cast Iron Live (cloud), then the secure connector needs to be
configured.

Parent topic: PeopleSoft activities
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Installing JAR files to connect to the PeopleSoft server
You must copy two JAR files on the same workstation as your Cast Iron Studio installation before you can
connect to a PeopleSoft server.

Before you begin

The JAR files can be obtained from the PeopleSoft system administrator.
The JAR files must be on the same computer as the studio installation.
The JAR files must be from the same version as the PeopleSoft server you connect to.

For more information about creating event tables and compiling PeopleSoft JAR files, see Creating
events table and compiling PeopleSoft JAR files.

About this task

The files to be installed are:

PSFTCI.jar
psjoa.jar

Procedure

1. Open studio and select Tools > Install Module Providers.
2. When the Add Provider(s) dialog box is displayed, click the plus (+) button under PeopleSoft Connector.

A field and a Browse button appears.
3. Click Browse, and use the browse dialog box to locate and select the JAR files.
4. Click Open to import the selected files.
5. When the JAR files are listed in the Add Provider(s) dialog box, click OK.

Results

A prompt is displayed to restart studio and activate the changes.

What to do next

You can now create PeopleSoft endpoints and orchestrations.

Parent topic: PeopleSoft activities
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Using the PeopleSoft Create Component Interface activity
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Use the PeopleSoft Create Component Interface activity to create new component interfaces on the PeopleSoft
server. The newly created component contains data that represent a business entity.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the PeopleSoft server. For more information, see Installing
JAR files to connect to the PeopleSoft server.
Valid connection details to connect to the PeopleSoft server.

About this task

Use this task to create component interfaces on the PeopleSoft server. The call to this activity is a synchronous
call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the PeopleSoft folder contents.
2. Drag the Create Component Interface activity icon onto the orchestration. The PeopleSoft Create

Component Interface Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant PeopleSoft endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a PeopleSoft activity.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Browse for the component interface name in the Component Interface field. Component interface name

is populated with a default value, which represents the PeopleSoft interface. Browse for the component
interface name if it is not same as the default value. All the metadata needed for discovering the objects
are retrieved from this component interface.

11. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry and Delivery Options for PeopleSoft Activities.

12. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Create Component Interface activity are displayed as nodes under the request input parameter in the To
Activity panel.
Note: The PeopleSoft connector generates a single input schema for all the objects used by the
activities. There may be some fields that are redundant and not applicable for this activity.

13. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

14. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

15. Create a map between the output parameters and orchestration variables.

 491



Results

You have configured the PeopleSoft Create Component Interface activity.
Parent topic: PeopleSoft activities
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Using the PeopleSoft Update Component Interface activity
Use the PeopleSoft Update Component Interface activity to update component interfaces on the PeopleSoft
server. This activity updates the corresponding PeopleSoft component with the incoming business object.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the PeopleSoft server. For more information, see Installing
JAR files to connect to the PeopleSoft server.
Valid connection details to connect to the PeopleSoft server.

About this task

Use this task to update component interfaces on the PeopleSoft server. The call to this activity is a synchronous
call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the PeopleSoft folder contents.
2. Drag the Update Component Interface activity icon onto the orchestration. The PeopleSoft Update

Component Interface Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant PeopleSoft endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a PeopleSoft activity.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Browse for the component interface name in the Component Interface field. Component interface name

is populated with a default value, which represents the PeopleSoft interface.
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a. In the Browse component interface window, browse for the component interface name if it is not
same as the default value. All the metadata needed for discovering the objects are retrieved from
this component interface.

b. Click Next. The Preserve child relationship window is displayed.
c. Select the child business objects from the populated list, and click Finish to complete configure.

11. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry and Delivery Options for PeopleSoft Activities.

12. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Update Component Interface activity are displayed as nodes under the request input parameter in the
To Activity panel.

13. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

14. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

15. Create a map between the output parameters and orchestration variables.

Results

You have configured the PeopleSoft Update Component Interface activity.
Parent topic: PeopleSoft activities
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Using the PeopleSoft Delete Component Interface activity
Use the PeopleSoft Delete Component Interface activity to delete component interfaces from the PeopleSoft
server. This activity deletes the PeopleSoft components and its children. Because the connector supports only
logical deletes, the components are marked as deleted, but not removed.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the PeopleSoft server. For more information, see Installing
JAR files to connect to the PeopleSoft server.
Valid connection details to connect to the PeopleSoft server.

About this task

Use this task to delete component interface from the PeopleSoft server. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
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orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the PeopleSoft folder contents.
2. Drag the Delete Component Interface activity icon onto the orchestration. The PeopleSoft Delete

Component Interface Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant PeopleSoft endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a PeopleSoft activity.

8. To make required changes to the selected endpoint configuration, click Edit and access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Browse for the component interface name in the Component Interface field. Component interface name

is populated with a default value, which represents the PeopleSoft interface.
a. In the Browse component interface window, browse for the component interface name if it is not

same as the default value. All the metadata needed for discovering the objects are retrieved from
this component interface.

b. Click Next. The Logical delete window is displayed.
c. Select a field from the Field name for logical delete drop-down list.
d. Specify the value of the deleted object in the Value to indicate deleted object field, and click

Finish to complete configure.
11. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying retry and Delivery Options for PeopleSoft Activities.
12. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Delete Component Interface activity are displayed as nodes under the request input parameter in the To
Activity panel.

13. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

14. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

15. Create a map between the output parameters and orchestration variables.

Results

You have configured the PeopleSoft Delete Component Interface activity.
Parent topic: PeopleSoft activities
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Using the PeopleSoft Get Component Interface activity
Use the PeopleSoft Get Component Interface activity to retrieve component interfaces from the PeopleSoft
server. With this activity you can access the PeopleSoft component and retrieve values from the PeopleSoft
server.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the PeopleSoft server. For more information, see Installing
JAR files to connect to the PeopleSoft server.
Valid connection details to connect to the PeopleSoft server.

About this task

Use this task to retrieve component interfaces from the PeopleSoft server. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the PeopleSoft folder contents.
2. Drag the Get Component Interface activity icon onto the orchestration. The PeopleSoft Get Component

Interface Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant PeopleSoft endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a PeopleSoft activity.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Browse for the component interface name in the Component Interface text box. Component interface

name is populated with a default value, which represents the PeopleSoft interface. Browse for the
component interface name if it is not same as the default value. All the metadata needed for discovering
the objects are retrieved from this component interface.

11. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry and Delivery Options for PeopleSoft Activities.

12. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get
Component Interface activity are displayed as nodes under the request input parameter in the To
Activity panel.
Note: The PeopleSoft connector generates a single input schema for all the objects used by the
activities. There may be some fields that are redundant and not applicable for this activity. You must set
the GETKEYS field for this activity. For Wbi_Customer_Ci component interface, you must specify the
value for the customerid field.
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13. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

14. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

15. Create a map between the output parameters and orchestration variables.

Results

You have configured the PeopleSoft Get Component Interface activity.
Parent topic: PeopleSoft activities
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Using the PeopleSoft Find Component Interface activity
Use the PeopleSoft Find Component Interface activity to retrieve all the component interfaces from the
PeopleSoft server. This activity behaves like the PeopleSoft Get Component Interface activity, except that it
retrieves multiple instances of the same PeopleSoft component that match the input criteria.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the PeopleSoft server. For more information, see Installing
JAR files to connect to the PeopleSoft server.
Valid connection details to connect to the PeopleSoft server.

About this task

Use this task to find component interfaces in the PeopleSoft server. The call to this activity is a synchronous
call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the PeopleSoft folder contents.
2. Drag the Find Component Interface activity icon onto the orchestration. The PeopleSoft Find Component

Interface Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
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6. Click Browse and use the Project Explorer dialog box to select the relevant PeopleSoft endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a PeopleSoft activity.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Browse for the component interface name in the Component Interface text box. Component interface

name is populated with a default value, which represents the PeopleSoft interface. Browse for the
component interface name if it is not same as the default value. All the metadata needed for discovering
the objects are retrieved from this component interface.

11. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry and Delivery Options for PeopleSoft Activities.

12. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Find
Component Interface activity are displayed as nodes under the request input parameter in the To
Activity panel. The PeopleSoft connector generates a single input schema for all the objects used by the
activities. There may be some fields that are redundant and not applicable for this activity. You must set
the FINDKEYS field for this activity For the Wbi_Customer_Ci component interface, you must specify
either the customerid field or the customerfirstname field value, or both.

13. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

14. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

15. Create a map between the output parameters and orchestration variables.

Results

You have configured the PeopleSoft Find Component Interface activity.
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Creating events table and compiling PeopleSoft JAR files
The first of the two required JAR files, which will be named PSFTCI.jar, must be manually built and compiled.

PeopleSoft connector polls the PeopleSoft Enterprise server at specified intervals for events. When the
connector detects an event, it converts the event data into a business object and sends it to the client
application. To use this scenario, you must create a custom event project in PeopleSoft Enterprise server.
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Event store

The event store is a table that holds events that represent data changes until the polling connector can process
them. The connector uses the event store to keep track of event entities. To use inbound processing, you must
use PeopleTools Application Designer to create a custom project for event notification. The custom project
creates the event store the connector needs for inbound processing. Each time a business object is created,
updated, or deleted, the PeopleCode function used in the project and then added to the component interface
inserts a new record in the event store, with the appropriate object name, keys, and status value.

During inbound processing, the connector polls the events from the event store at configured poll intervals. In
each poll call, a configured number of events are processed by the connector. The order of event processing is
based on the ascending order of priority and the ascending order of the event time stamp. The events with the
Ready for poll (0) status are picked up for polling in each poll cycle. The connector uses the object name and
object key to retrieve the corresponding business object. As events are retrieved from the event store and
processed, the status of the event changes to reflect its state, as shown in the following table.

Table 1. Event status values

Status short name Description
Event Table
Value

Error processing
event

An error occurred during event processing. -1

Ready for poll The event is ready to be picked up. 0

Success The event has been delivered to the event manager. 1

Deleted The event has been processed successfully and is removed from the
event store.

4

I. To create the events table

Ensure that the following steps are met for configuring and compiling the PeopleSoft JAR files.

Creating Events Table
Add the trigger to WBI_CUSTOMER_COMP component
Create the Java™ API for Component Interface

1. Copy WBI_CUST_PROJ project located at <Cast Iron Installation directory>\etc\peoplesoft\scripts to a
temp directory (C:\Projects) on the machine where the PeopleTools runs.

2. Log on to the PeopleSoft application designer, and select Tools > Copy Project > From File.
3. Browse to C:\Projects directory. From the Select Project from the List Below, double-click
WBI_CUST_PROJ.

4. In the Copy From File dialog, click Copy. Wait for the operation to complete.
5. Select WBI_CUST_PROJ in the left panel, and then select Build > Project from the main menu.
6. In the Build panel, select the following check boxes:

Create Tables
Create Views
Create Trigger
Run and build script

7. Click Build, to begin to build the project.
8. Click Close, to exit the Build Progress dialog.
9. In the Build Log view of the application designer, check the log messages to confirm that three records

were processed correctly.
10. Select File > Save All to save the changes.
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11. To configure the user security for the Component Interfaces, log onto PeopleSoft Web Client with the
URL: http://localhost/psp/ps/?cmd=login.

12. Go to PeopleTools > Security > Permissions & Roles > Permission Lists.
13. Specify PTPT1200 in the edit box of begins with and click Search.
14. Go to the Component Interfaces tab, click + to add the Component Interface

WBI_CUSTOMER_COMP_INTERFACE.
15. Click Edit of WBI_CUSTOMER_COMP_INTERFACE.
16. Select Full Access for all methods and click OK.
17. Go back to the Component Interfaces tab, click + to add the Component Interface IBM_EVENT_CI.
18. Click Edit of IBM_EVENT_CI.
19. Select Full Access for all methods and click OK.
20. Go back to the Component Interfaces tab and press Save button to save the changes.

II. To add triggers

1. In PeopleSoft application designer, open WBI_CUST_PROJ project.
2. In the left panel, right-click on WBI_CUSTOMER_COMP and select View PeopleCode.
3. In the PeopleCode edit window, select SavePostChange in the right panel.
4. Type the following PeopleCode in the edit window.

Declare Function IBMPublishEvent PeopleCode IBM_FETCH_ID.IBM_NEXT_EVENT_ID 
FieldFormula; 
Component string &BONAME1; Component string &KEYLIST1; 
&BONAME1 = "WbiCustomerCompInterface"; 
&KEYLIST1 = "WBI_CUSTOMER.WBI_CUSTOMER_ID"; /* Check if Component Changed 
before calling function*/ If ComponentChanged() And %UserId &lt;> "C" Then /* 
Publish this event to the IBM WebSphere IBM_EVENT_TBL for polling */ 
IBMPublishEvent(&BONAME1; &KEYLIST1); End-If;

5. Select File > Save All to save the changes.
6. To ensure the trigger that was created in the steps above can work well, you need to do some

initialization work. Connect to the database that PeopleTools uses, and run the following SQL statement:

$ insert into PS_IBM_FETCH_ID values(1000); 
$ commit;

III. To create the Java API for Component Interface

The Component Interface API provides access to all the objects and PeopleCode methods. You can manually
generate these API using the application designer, and then compile them to a PSFTCI.jar file.

1. In PeopleSoft application designer, open IBM_EVENT_CI Component Interface.
2. Select Build > PeopleSoft API from the main menu.
3. In the Build PeopleSoft API Bindings dialog, make sure only the Build check box under Java Classes is

selected. Set the Target Directory for storing the generated Java files.
In the Select API to Build list, select the following items:

CompIntfc.CompIntfcPropertyInfo
CompIntfc.CompIntfcPropertyInfoCollection
All beginning with CompIntfc.IBM_EVENT_CI
All beginning with CompIntfc.WBI_CUSTOMER_COMP_INTERFACE

4. Click OK. Check the target directory to make sure the Java files are generated correctly.
5. Copy the generated Java files to C:\Temp directory, then copy psjoa.jar file from
<PeopleTools_HOME>\web\psjoa to C:\Temp directory.

6. Enter directory as C:\Temp and run the following commands to build the Java files.
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$ javac -classpath .\psjoa.jar PeopleSoft\Generated\CompIntfc\*.java 
$ jar -cvf PSFTCI.jar PeopleSoft\Generated\CompIntfc\*.class

These two JAR files psjoa.jar and PSFTCI.jar would be used by PeopleSoft connector to access the
PeopleSoft Enterprise application.
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Using the PeopleSoft Get Created Component Interface
activity

Use the Get Created Component Interface activity to poll for created objects in the PeopleSoft server.

Before you begin

Ensure that you have:

Installed the necessary vendor software JAR files.
The valid connection details to connect to the PeopleSoft server.
Configured the EventStore business objects and triggers to generate events. For more information, see
Creating events table and compiling PeopleSoft JAR files.

About this task

Use this task to poll for events created on the PeopleSoft server.

Procedure

1. In an active orchestration, open the Activities tab and expand the PeopleSoft folder contents.
2. Drag the Get Created Component Interface activity icon onto the orchestration. The PeopleSoft Get

Created Component Interface Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant PeopleSoft endpoint.
7. You can create the endpoint by clicking New and specifying the required connection details. Click OK to

save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a PeopleSoft activity.

8. To make any required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
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10. Specify the Event Store Name configured in the PeopleSoft server. The activity polls this event store for
new events. The Event Store Name field is populated with a default value, specify the event store name
configured in PeopleSoft server if it is not same as the default value.

11. Specify the component interface name in the Component Interface field, or browse for the required
component interface.

12. In the Checklist, click Retry. Review the default settings and make the required changes. Similarly,
configure the Delivery Rules panel. For more information, see Specifying retry and Delivery Options for
PeopleSoft Activities.

The activity polls the event store at configured interval for create events and fetches the actual object for
that event. This object is sent to the orchestration. After processing, the event is marked as archived in
the event store.

13. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

14. Create a map between the output parameters and orchestration variables.

Results

You have configured the PeopleSoft Get Created Component Interface activity.
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Using the PeopleSoft Get Updated Component Interface
activity

Use the Get Updated Component Interface activity to poll for updated events in the PeopleSoft server.

Before you begin

Ensure that you have:

Installed the necessary vendor software JAR files.
The valid connection details to connect to the PeopleSoft server.
Configured the EventStore business objects and triggers to generate events. For more information, see
Creating events table and compiling PeopleSoft JAR files>.

About this task

Use this task to poll for events updated on the PeopleSoft server.

Procedure
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1. In an active orchestration, open the Activities tab and expand the PeopleSoft folder contents.
2. Drag the Get Updated component Interface activity icon onto the orchestration. The PeopleSoft Get

Updated Component Interface Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant PeopleSoft endpoint.
7. You can create the endpoint by clicking New and specifying the required connection details. Click OK to

save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a PeopleSoft activity.

8. To make any required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Specify the Event Store Name configured in the PeopleSoft server. The activity polls this event store for

new events. The Event Store Name field is populated with a default value, specify the event store name
configured in PeopleSoft server if it is not same as default value.

11. Specify the component interface name in the ComponentInterface field, or browse for the required
component interface.

12. In the Checklist, click Retry. Review the default settings and make the required changes. Similarly,
configure the Delivery Rules panel. For more information, see Specifying retry and Delivery Options for
PeopleSoft Activities.

The activity polls the event store at configured interval for create events and fetches the actual object for
that event. This object is sent to the orchestration. After processing, the event is marked as archived in
the event store.

13. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

14. Create a map between the output parameters and orchestration variables.

Results

You have configured the PeopleSoft Get Updated Component Interface activity.
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Using the PeopleSoft Get Deleted Component Interface activity
Use the Get Deleted Component Interface activity to poll for deleted events in the PeopleSoft server.

Before you begin
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Ensure that you have:

Installed the necessary vendor software JAR files.
The valid connection details to connect to the PeopleSoft server.
Configured the EventStore business objects and triggers to generate events. For more information, see
Creating events table and compiling PeopleSoft JAR files.

About this task

Use this task to poll for events deleted on the PeopleSoft server.

Procedure

1. In an active orchestration, open the Activities tab and expand the PeopleSoft folder contents.
2. Drag the Get Deleted Component Interface activity icon onto the orchestration. The PeopleSoft Get

Deleted Component Interface Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant PeopleSoft endpoint.
7. You can create the endpoint by clicking New and specifying the required connection details. Click OK to

save and use the endpoint for this configuration.
Note: For more information, see Creating or editing an endpoint for a PeopleSoft activity.

8. To make any required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Specify the Event Store Name configured in the PeopleSoft server. The activity polls this event store for

new events. The Event Store Name field is populated with a default value, specify the event store name
configured in PeopleSoft server if it is not same as default value.

11. Specify the component interface name in the Component Interface field, or browse for the required
component interface.

12. In the Checklist, click Retry. Review the default settings and make the required changes. Similarly,
configure the Delivery Rules panel. For more information, see Specifying retry and Delivery Options for
PeopleSoft Activities.

The activity polls the event store at configured interval for create events and fetches the actual object for
that event. This object is sent to the orchestration. After processing, the event is marked as archived in
the event store.

13. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

14. Create a map between the output parameters and orchestration variables.

Results

You have configured the PeopleSoft Get Deleted Component Interface activity.
Parent topic: PeopleSoft activities
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Specifying retry and Delivery Options for PeopleSoft Activities
Specifying the Retry and Delivery parameters is one of the tasks to configure a PeopleSoft activity
configuration.

About this task

This section contains the procedure for configuring the retry options for PeopleSoft outbound and inbound
activities.

Procedure

1. Select the Retry task from the Checklist. The retry pane is displayed.
2. Configure the retry options for connecting to a PeopleSoft server as described in the following table.

Table 1. Retry options
Ret
ry
Fie
lds Description

Wai
t __
sec
ond
s
bet
we
en
eac
h
retr
y.

Specifies the number of seconds that the Integration Appliance waits before trying to establish a
connection to the PeopleSoft server.

Try
to
con
nec
t __
tim
es
bef
ore
faili
ng.

Specifies the retry count — the maximum number of times the Integration Appliance attempts to
establish a connection to the PeopleSoft server before issuing an error and stopping the
processing of the current orchestration job.
Note: If you deploy an orchestration that contains the inbound or outbound PeopleSoft activity
and the Integration Appliance cannot connect to the specified PeopleSoft server, the Integration
Appliance logs the connections errors as Warnings in the system and orchestration logs until the
retry count value is reached. When the retry count is reached, the Integration Appliance logs an
Error in the system and orchestration logs and stops processing the current orchestration job. For
example, you set the retry count to 3. The first, second, and third connection errors appear in the
system log as warnings. The Integration Appliance logs the fourth connection error as an error
and stops processing the current orchestration job.

Parent topic: PeopleSoft activities
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Specifying the delivery rules options for PeopleSoft inbound activities

About this task

This section contains the procedure for configuring the delivery rule options for PeopleSoft inbound activities.

Procedure

1. Select the Delivery Rules task from the Checklist. The delivery rules pane is displayed.
2. Configure the delivery rules options to select the activity's behavior as described in the following table.

Table 2. Delivery rules
Delivery Rules
Fields Description

Poll for changes
every ______
days/hours/minu
tes/seconds

Specifies the time interval to poll for objects in the PeopleSoft server. (For example,
the Get Component Interfaces activity polls for Create Component Interfaces
activity at the specified time internal.) Time can be selected in the format days,
hours, minutes, or seconds.

Fetch ______
rows per poll

Specifies how many objects or components the activity should retrieve from the
PeopleSoft server in each poll cycle.

Delivery Messages

ATMOST_ONCE A non-persistent mode in which a PeopleSoft component interfaces is either
delivered once or not delivered at all.
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RightNow SOAP API Activities
Overview of the RightNow SOAP API connector
Creating and editing a RightNow SOAP API endpoint
RightNow SOAP API endpoints contain the connection information that Studio and the Integration
Appliance use to connect to the RightNow CRM instance. You can create multiple endpoints that refer to
separate instances.
Using the RightNow SOAP API Create Objects activity
Use the RightNow SOAP API Create Objects activity to create objects such as Account, Answer, Contact,
Incident, Meta Answer, Opportunity, Organization, Purchased Product, Sales Product, Task and so on, in
the RightNow server.
Using the RightNow SOAP API Get Objects activity
Use the RightNow SOAP API Get Objects activity to retrieve objects such as Account, Answer, Contact,
Incident, Meta Answer, Opportunity, Organization, Purchased Product, Sales Product, Task, and so on
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from the RightNow server. In order to retrieve sub objects, we need to populate default values for the
sub objects.
Using the RightNow SOAP API Update Objects activity
Use the RightNow SOAP API Update Objects activity to update objects such as Account, Answer,
Contact, Incident, Meta Answer, Opportunity, Organization, Purchased Product, Sales Product, Task, and
so on in the RightNow server.
Using the RightNow SOAP API Destroy Objects activity
Use the RightNow SOAP API Destroy Objects activity to delete objects such as Account, Answer,
Contact, Incident, Meta Answer, Opportunity, Organization, Purchased Product, Sales Product, Task and
so on, from the RightNow server. If you delete the primary object, all the corresponding sub objects
related to the primary object will also be deleted.
Using the RightNow SOAP API Query Objects activity
Use the RightNow SOAP API Query Objects activity to query objects such as Account, Address,
AnalyticsReport, Answer, Contact, Country, Email, Organization and so on, from the RightNow server.
The query string that you specify for this operation must adhere to the RightNow Object Query Language
(ROQL) standard. In order to retrieve sub objects, we need to populate default values for the sub
objects.
Specifying retry parameters for RightNow SOAP API activities
Specifying the retry parameters is one of the tasks you must complete to configure a RightNow activity.
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Overview of the RightNow SOAP API connector
The RightNow SOAP API connector enables a two-way communication between Cast Iron and the RightNow
server. This connector uses the RightNow SOAP APIs.

You can perform the following activities using the RightNow SOAP API connector:

Create Objects
Get Objects
Query Objects
Update Objects
Destroy Objects

The versions of RightNow supported by the connector depend on the support life cycle of RightNow. The SOAP
API version of RightNow currently supported is v1_2.

Parent topic: RightNow SOAP API Activities
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Creating and editing a RightNow SOAP API endpoint
RightNow SOAP API endpoints contain the connection information that Studio and the Integration Appliance
use to connect to the RightNow CRM instance. You can create multiple endpoints that refer to separate
instances.

About this task

Use this task to create or edit a RightNow SOAP API endpoint. The call to this activity is a synchronous call
where the input data is sent to the activity for processing and the response is sent back to the orchestration.
Note:
Any changes you make to the RightNow SOAP API endpoint, including configuration properties, affects all the
orchestrations that use that endpoint, as the edits are global, not local.

To create and edit a RightNow SOAP API endpoint, complete the following steps:

Procedure

1. Drag an activity from the RightNow SOAP API folder under the Activities tab, to the Orchestration
window. The Summary panel is displayed.

2. Click Pick Endpoint from the Checklist. The Pick Endpoint panel is displayed.
3. Click one of the following buttons:

a. Browse - To select an existing endpoint from Project Explorer. The Project Explorer shows all the
endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel.

b. New - To create a new endpoint. The Create Endpoint window opens.
c. Edit - To edit the existing endpoint. The Edit Endpoint window opens.

4. In the Create Endpoint window, complete the fields defined in the following table:
Table 1. Connection details

Field Name Description

Connection Details

URL Specifies the URL of the RightNow instance.

User Name Specifies the user name to connect to the RightNow instance.

Password Specifies the password associated with the user name to connect to the
RightNow instance.

Proxy Connection Details

Proxy Host Specifies the host name of the proxy server.

Proxy Port Specifies the port number needed to connect to the proxy server.

Proxy User Name Specifies the user name needed to connect to the proxy server.

Proxy Password Specifies the password needed to connect to the proxy server.

5. When finished, click Test Connection to confirm that you can connect to the RightNow system.
6. Click OK.
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Results

You have created or edited a RightNow SOAP API endpoint.
Parent topic: RightNow SOAP API Activities
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Using the RightNow SOAP API Create Objects activity
Use the RightNow SOAP API Create Objects activity to create objects such as Account, Answer, Contact,
Incident, Meta Answer, Opportunity, Organization, Purchased Product, Sales Product, Task and so on, in the
RightNow server.

About this task

Use this task to create objects in the RightNow server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the RightNow SOAP API Create Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the RightNow SOAP API folder contents.
2. Drag the Create Objects activity icon onto the orchestration. The RightNow SOAP API Create Objects

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant RightNow SOAP API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a RightNow SOAP API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse RightNow SOAP API window is displayed.
11. In Browse RightNow SOAP API, you can either filter the object type by specifying the object type in the

Search for an object type field, or select the object type from the object type list. Click OK. The object
field preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.
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13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for RightNow SOAP API activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Create Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for an element or by linking the element with an input
node. During run time if no value is provided for a mandatory element, the activity throws an exception,
which is reported by the Web Management Console. If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the RightNow SOAP API Create Objects activity.
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Using the RightNow SOAP API Get Objects activity
Use the RightNow SOAP API Get Objects activity to retrieve objects such as Account, Answer, Contact,
Incident, Meta Answer, Opportunity, Organization, Purchased Product, Sales Product, Task, and so on from the
RightNow server. In order to retrieve sub objects, we need to populate default values for the sub objects.

About this task

Use this task to retrieve objects from the RightNow server. The call to this activity is a synchronous call where
the input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the RightNow SOAP API Get Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the RightNow SOAP API folder contents.
2. Drag the Get Objects activity icon onto the orchestration. The RightNow SOAP API Get Objects Checklist

is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
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6. Click Browse and use the Project Explorer dialog box to select the relevant RightNow SOAP API
endpoint.

7. Optional: You can create the endpoint by clicking New and specifying the required connection details.
Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a RightNow SOAP API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse RightNow SOAP API window is displayed.
11. In Browse RightNow SOAP API, you can either filter the object type by specifying the object type in the

Search for an object type field, or select the object type from the object type list. Click OK. The object
field preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for RightNow SOAP API activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get
Objects activity are displayed as nodes under the request input parameter in the To Activity panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the RightNow SOAP API Get Objects activity.
Parent topic: RightNow SOAP API Activities
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Using the RightNow SOAP API Update Objects activity
Use the RightNow SOAP API Update Objects activity to update objects such as Account, Answer, Contact,
Incident, Meta Answer, Opportunity, Organization, Purchased Product, Sales Product, Task, and so on in the
RightNow server.

About this task
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Use this task to update objects in the RightNow server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the RightNow SOAP API Update Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the RightNow SOAP API folder contents.
2. Drag the Update Objects activity icon onto the orchestration. The RightNow SOAP API Update Objects

activity Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant RightNow SOAP API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a RightNow SOAP API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse RightNow SOAP API window is displayed.
11. In Browse RightNow SOAP API, you can either filter the object type by specifying the object type in the

Search for an object type field, or select the object type from the object type list. Click OK. The object
field preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for RightNow SOAP API activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Update Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the RightNow SOAP API Update Objects activity.
Parent topic: RightNow SOAP API Activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
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Using the RightNow SOAP API Destroy Objects activity
Use the RightNow SOAP API Destroy Objects activity to delete objects such as Account, Answer, Contact,
Incident, Meta Answer, Opportunity, Organization, Purchased Product, Sales Product, Task and so on, from the
RightNow server. If you delete the primary object, all the corresponding sub objects related to the primary
object will also be deleted.

About this task

Use this task to delete objects in the RightNow server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the RightNow SOAP API Destroy Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the RightNow SOAP API folder contents.
2. Drag the Destroy Objects activity icon onto the orchestration. The RightNow SOAP API Destroy Objects

activityChecklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant RightNow SOAP API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a RightNow SOAP API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse RightNow SOAP API window is displayed.
11. In Browse RightNow SOAP API, you can either filter the object type by specifying the object type in the

Search for an object type field, or select the object type from the object type list. Click OK. The object
field preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for RightNow SOAP API activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Destroy Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.
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16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the RightNow SOAP API Destroy Objects activity.
Parent topic: RightNow SOAP API Activities
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Using the RightNow SOAP API Query Objects activity
Use the RightNow SOAP API Query Objects activity to query objects such as Account, Address,
AnalyticsReport, Answer, Contact, Country, Email, Organization and so on, from the RightNow server. The query
string that you specify for this operation must adhere to the RightNow Object Query Language (ROQL) standard.
In order to retrieve sub objects, we need to populate default values for the sub objects.

About this task

Use this task to query objects from the RightNow server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the RightNow SOAP API Query Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the RightNow SOAP API folder contents.
2. Drag the Query Objects activity icon onto the orchestration. The RightNow SOAP API Query Objects

activityChecklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant RightNow SOAP API

endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a RightNow SOAP API endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse RightNow SOAP API window is displayed.
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11. In Browse RightNow SOAP API, you can either filter the object type by specifying the object type in the
Search for an object type field, or select the object type from the object type list. Click OK. The object
field preferences are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for RightNow SOAP API activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Query Objects activity are displayed as nodes under the request input parameter in the To Activity panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the RightNow SOAP API Query Objects activity.
Parent topic: RightNow SOAP API Activities
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Specifying retry parameters for RightNow SOAP API activities
Specifying the retry parameters is one of the tasks you must complete to configure a RightNow activity.

About this task

The RightNow SOAP API connects to the RightNow server to execute the activities. If a connection is lost or
timed out, the connector automatically establishes a new connection based on the parameters described in
Table 1. The connector does not count the initial attempt to reacquiring the session as a retry attempt. The
connector assumes the typical connector retry behavior after the initial attempt to reacquire a session fails.

For more information about the configuration tasks in the Checklist, see the help topic for the specific
RightNow SOAP API activity.

To specify the retry parameters, complete the following steps:

Procedure
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1. In the Checklist, select Retry. The Retry panel is displayed.
2. Configure the retry options for connecting to a RightNow application.

The following table describes the retry options for connecting to a RightNow application:
Table 1. Retry options

Retry Fields Description

Wait __ seconds
between each retry.

Specifies the number of seconds that the Integration Appliance waits before
trying to establish a connection to the RightNow application. By default, this
parameter is set to 30 seconds.

Try to connect __
times before failing.

Specifies the maximum number of times that the Integration Appliance
attempts to establish a connection to the RightNow application before issuing
an error and stopping the processing of the current orchestration job. By
default this parameter is set to 5 attempts.

Activity Timeout

Time out after __
seconds when the
endpoint does not
respond to a request.

Specifies the number of seconds the Integration Appliance waits before timing
out, when the endpoint does not respond to a request. The default is 300
seconds.

Results

You have configured the retry parameters for the RightNow SOAP API activities.
Parent topic: RightNow SOAP API Activities
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Salesforce.com activities
Creating or editing a Salesforce.com endpoint
Salesforce.com endpoints provide information that Studio and the Integration Appliance use to connect
to a Salesforce.com instance.
Configuring Salesforce.com activities
Selecting fields from the Salesforce.com object to map is one of the tasks you must complete to
configure a Salesforce.com activity. For more information about the configuration tasks in the Checklist,
see the help topic for the specific Salesforce.com activity.
Migrating Salesforce.com projects
Setting Salesforce.com configuration properties
Any changes you make to configuration properties affects all orchestrations that use that endpoint. The
edits are global, not local.
Specifying the Retry and Time Out parameters for Salesforce.com activities
Specifying the Retry and Time Out parameters is one of the tasks you must complete to configure a
Salesforce.com activity. The Salesforce.com Connector uses an HTTP 1.1 persistent connection over SSL
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to make all connections to the Salesforce.com server. The Salesforce.com connector compresses all
data for requests and responses using the gzip format.
Understanding and setting polling preferences for the Salesforce.com connector
Convert Lead activity
Use this activity to convert leads into accounts, contacts, or opportunities in Salesforce.com. While the
Salesforce.com API limits the number of objects that it can convert in a single call to 100 objects, the
Cast Iron® Salesforce.com connector does not have such a limit. You can use the Convert Lead activity
to convert an unlimited number of objects.
Set password activity
Use this activity to change the password of a user or SelfServiceUser to a value that you specify.
Reset password activity
Use this activity to reset the password of the user to a system-generated value.
Send email activity
Use this activity to send single or multiple emails. The emails include all standard email attributes such
as the email address, subject line, and carbon copies.
Create Objects activity
Use this activity to create one or more Salesforce.com objects. In the Activities tab, open the
Salesforce.com directory to find the Create Objects activity.
Delete Objects activity
Use this activity to delete one or more objects in Salesforce.com. While the Salesforce.com API limits
the number of objects that it can delete in a single call to 200 objects, the Cast Iron Salesforce.com
connector does not have such a limit. You can use the Delete Objects activity to delete an unlimited
number of objects.
Get Deleted Objects
This activity retrieves the list of individual objects that have been deleted within the specified time-span
for the specified object.
Get Updated Objects
Get User Information activity
Use this activity to get user information from the Salesforce.com server. In the Activities tab, open the
Salesforce.com directory to find the Get User Information activity.
Get Server Timestamp activity
Use this activity to get the current time from the Salesforce.com server. In the Activities tab, open the
Salesforce.com directory to find the Get Server Timestamp activity.
Merge Objects Activity
Use this activity to merge Salesforce.com objects into a single record.
Poll Deleted Objects activity
This activity polls the Salesforce.com Server for objects that have been recently deleted and returns IDs
to the Integration Appliance.
Poll Updated Objects activity
This activity polls the Salesforce.com Server for objects that have been recently created or updated and
returns all the object fields that you selected in the configuration panel to the Integration Appliance. In
Studio, configure the polling interval for the activity.
Query Objects activity
Use the Sforce Object Query Language (SOQL) to run a query on one or more Salesforce.com object
types from this activity and return a results set. The Query Objects activity automatically runs a query or
queryAll call, followed by continuous queryMore calls for all children and objects returned from
Salesforce.com.
Configuring the Query Objects activity
You must create a SForce Object Search Language (SOSL) query to configure the Search Objects
activity. The following sections discuss the steps to configure the Search Objects activity, create an
SOSL query, and provide SOSL syntax rules for IBM® Cast Iron.
Retrieve Objects activity
Use this activity to retrieve one or more Salesforce.com objects of a specified type. While the
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Salesforce.com API limits the number of objects that it can retrieve in a single call to 2,000 objects, the
Cast Iron Salesforce.com connector does not have such a limit. You can use the Retrieve Objects
activity to retrieve an unlimited number of objects.
Search Objects activity
Undelete Objects activity
Configuring the Search Objects activity
You must create an SForce Object Search Language (SOSL) query to configure the Search Objects
activity.
Update Objects activity
Use this activity to update existing objects in Saleforce.com.
Upsert Objects activity
Use this activity to update existing objects or create new objects in Saleforce.com.
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Creating or editing a Salesforce.com endpoint
Salesforce.com endpoints provide information that Studio and the Integration Appliance use to connect to a
Salesforce.com instance.

About this task

Any changes you make to the endpoint, including configuration properties, affects all orchestrations that use
that endpoint as the edits are global, not local.

Procedure

1. Drag an activity from the Salesforce.com folder of the Activities tab onto the orchestration.

The Summary panel is displayed along with a Checklist which lists the tasks that you must perform to
configure the activity.

2. Click Pick Endpoint task from the Checklist. The Pick Endpoint panel opens.
3. Click one of the following options:

Browse...: To select an existing endpoint from the Project Explorer. The Project Explorer shows all
the endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel. To edit the endpoint properties, click Edit. Go
to step 5.
New: To create a new endpoint. The Create Endpoint window opens. Go to step 5.
Edit: To edit an existing endpoint. The Edit Endpoint window opens. Go to step 5.

Note: Editing an endpoint affects all orchestrations that use that endpoint in the project as the edits are
global, not local.

4. In the endpoint window, specify a user name and a password to access a Salesforce.com instance.
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a. Type a user name or click the icon to the right of the User Name field to select the sfdc_login
configuration property.

b. Type a password or click the icon to the right of the Password field to select the sfdc_password
configuration property.

5. Choose a login option:

Login Options Description

Login normally By default, Login is selected. At run time, the Integration Appliance accesses a
production instance of Salesforce.com.

Login to
Salesforce.com
Sandbox

At run time, the Integration Appliance accesses a copy of the production
system. You can run tests in the Sandbox without affecting production data.

Login to specified
Partner WSDL Login
URL

At run time, the Integration Appliance accesses the URL you specify in the
Login URL field.

Login URL Only required when you choose the Login to specified Partner WSDL Login URL
option.

6. Specify the Connection Timeout parameter. By default, the Integration Appliance times out if it is unable
to connect to the Salesforce.com endpoint after 300 seconds.

7. To connect through a proxy server, complete the fields described in the following table:

Opt
ion Description

Fiel
d
na
me

Description

Co
nne
ct
via
a
Pro
xy
Ser
ver

Select this check box to enable the fields to connect through a proxy server.

Aut
hen
tica
tio
n

Allows you to select the type of authentication that the Integration Appliance uses when
connecting to a proxy server. From the list, select one of the following authentication options:

Basic - Sends the user name and password you specify unencrypted to the server. This
authentication schema is the least secure.
NTLM - Requires an instance of NTCredentials to be available for the domain name of the
server. This authentication is the most secure authentication option. When you choose the
NTLM authentication option, the Integration Appliance authenticates a connection and not
a request; therefore, the Integration Appliance authenticates every time a new connection
is made. The connection must remain open during the authentication process. You cannot
use NTLM to authenticate with both a proxy and server.
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Opt
ion Description

Rea
lm/
Do
mai
n

If you select the Basic authentication option, specify a realm. If you select the NTLM
authentication option, specify a domain.

Hos
t
Na
me

Specify the host name of the proxy server.

Por
t

Specify the port number needed to connect to the proxy server.

Use
r
Na
me

Specify the user name needed to connect to the proxy server.

Pas
sw
ord

Specify the password needed to connect to the proxy server.

8. Click Test Connection to confirm that the parameters you specified allow the project to access a
Salesforce.com instance.
Note: When you configure a Salesforce.com endpoint to use configuration properties, verify that the
configuration properties have valid values. If the configuration property value is invalid or does not exist,
the connection test fails.

Parent topic: Salesforce.com activities
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Configuring Salesforce.com activities
Selecting fields from the Salesforce.com object to map is one of the tasks you must complete to configure a
Salesforce.com activity. For more information about the configuration tasks in the Checklist, see the help topic
for the specific Salesforce.com activity.

About this task

For some of the fields in the endpoint, you can create configuration properties to supply the values for these
fields. An icon is displayed when you click in a field that supports a configuration property and a configuration
property of the same type has already been configured for the project.
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Procedure

1. In the Checklist, select Configure. The Configure panel opens.
2. Click Browse... to select a Salesforce.com object type. The Choose a Salesforce.com Object window

shows all the Salesforce.com objects that are associated with the Studio activity.
3. Select an object type from the list.

Note: Custom object types end with a double underscore c ( __c ). For example: CustomerPriority__c

Enter a character or string in the Search for an Object Type field and Studio filters the object types and
only shows the object types that match the filter criteria. (Optional) Click the refresh icon to retrieve the
latest Salesforce.com object types.

4. Click OK.

All the fields associated with the object type you selected are displayed.

5. In the Object Field Preferences section, select the fields to map.

By default, all fields are selected. You can choose to clear any field that you do not want to show in the
map. A global checkbox allows you to select and clear all fields at once.

Note: The Id field is required for many activities. For these activities, the Id field is disabled and you
cannot clear this field.

Parent topic: Salesforce.com activities
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Migrating Salesforce.com projects

About this task

In Studio version 3.6.2, the Salesforce.com connector version 3.0 is built-in and does not require additional
installation as the previous version required.

Salesforce.com Connector Version Studio Version Installation Type

3.0X 3.6.2 and higher built-in (no additional installation)

2.0X 3.5 and higher add-on (separate installation)

1.0X 3.5 and higher add-on (separate installation)

Studio does not automatically migrate projects containing Salesforce.com connector version 1.x or
Salesforce.com connector version 2.x. However, the latest version of Studio can support any manually migrated
projects that contain orchestrations using add-on versions of the connector. Therefore, it is possible to use
both the built-in and add-on versions of the Salesforce.com connector in the same orchestration.
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Setting Salesforce.com configuration properties
Any changes you make to configuration properties affects all orchestrations that use that endpoint. The edits
are global, not local.

Procedure

1. Select Project > Configuration Properties. The Configuration Properties window opens.
2. Click the Value field for the sfdc_password property and type a valid password.
3. Click the Value field for the sfdc_login property and type a valid Salesforce.com login.
4. Click OK.

Parent topic: Salesforce.com activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Setting_Salesforce.html

Specifying the Retry and Time Out parameters for
Salesforce.com activities

Specifying the Retry and Time Out parameters is one of the tasks you must complete to configure a
Salesforce.com activity. The Salesforce.com Connector uses an HTTP 1.1 persistent connection over SSL to
make all connections to the Salesforce.com server. The Salesforce.com connector compresses all data for
requests and responses using the gzip format.

About this task

The Salesforce.com connector uses a single login session for all connections to a Salesforce.com endpoint. If a
session expires, the connector automatically establishes a new session. The Salesforce.com connector does
not count the initial attempt to reacquire the session as a retry attempt. The Salesforce.com connector
assumes the typical connector retry behavior after the initial attempt to reacquire a session fails.
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For more information about the configuration tasks in the Checklist, see the help topic for the specific
Salesforce.com activity.

Procedure

1. In the Checklist, select Retry. The Retry panel open.
2. Configure the retry options for connecting to a Salesforce.com instance.

The following table describes the retry options for connecting to a Salesforce.com instance:

Retry Fields Description

Wait __ second(s)
between each retry.

Specifies the number of seconds that the Integration Appliance waits
before trying to establish a connection to the Salesforce.com instance.

By default, this parameter is set to 30 seconds.

Try to connect __ times
before failing.  

Specifies the maximum number of times that the Integration Appliance
attempts to establish a connection to the Salesforce.com instance before
issuing an error and stopping the processing of the current orchestration
job.

By default this parameter is set to 5 attempts.

Activity Timeout Field Description

Time out after __
seconds when the
Endpoint does not
respond to a request.

Specifies the number of seconds before a time out occurs between the
activity making a request on an endpoint and the time it takes the endpoint
to respond.

By default this parameter is set to 300 seconds.

Parent topic: Salesforce.com activities
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Understanding and setting polling preferences for the
Salesforce.com connector

About this task

The Salesforce.com connector contains two activities that poll the Salesforce.com server for changes:

Poll Deleted Objects activity
Poll Updated Objects activity
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These activities have the following startup behavior:

For an orchestration that has never been deployed, the baseline time stamp is established when the
activity is activated for the first time. The activity uses the baseline time stamp as the start time to poll
for changes after the poll interval elapses. After the poll completes, the activity stores the last poll time.
For a previously deployed orchestration, the activity uses the last poll time and the current time to poll
for changes after the poll interval elapses.
Salesforce.com requires at least 60 seconds between each poll. If less than 60 seconds have transpired,
then the activity ignores the current polling interval until the next polling interval elapses.

Procedure

1. In the Checklist, select Polling.

The Polling Preferences panel opens.

2. Set the polling preferences for the following parameters:

Polling Preference Description

Poll for changes every <i>

Where <i> is the polling
interval. The interval can
be specified in minutes,
hours, or days

Specifies the polling interval for which the Integration Appliance polls the
Salesforce.com Server for objects that have been created or updated since
the last poll.

By default, the Integration Appliance polls the Salesforce.com Server every
5 minutes.

Batch up to <n> objects
per orchestration

Where <n> is the number
of objects in a batch.

Specifies the maximum number of object records per orchestration job,
during a polling interval. By default, the Integration Appliance processes 1
record per orchestration job. Use this preference to tune the performance
of the Integration Appliance.

Parent topic: Salesforce.com activities
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Convert Lead activity
Use this activity to convert leads into accounts, contacts, or opportunities in Salesforce.com. While the
Salesforce.com API limits the number of objects that it can convert in a single call to 100 objects, the Cast
Iron® Salesforce.com connector does not have such a limit. You can use the Convert Lead activity to convert an
unlimited number of objects.

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Convert Lead activity.

 523



2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or Editing a
Salesforce.com Endpoint.

4. Specify the Retry and Time out parameters for the activity.
5. Map the input of the activity.
6. Map the output of the activity.

Map the input of the Convert Lead activity
Map the output of the Convert Lead activity

Parent topic: Salesforce.com activities
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Map the input of the Convert Lead activity

Procedure

1. In the Checklist, select Map Inputs.

The convertLead element displays in the To Activity pane. The parameters displayed correspond to the
structure of the input to the Salesforce.com convertLead operation.

2. (Optional) Right-click the default node and choose Show Optional Parameters, to show the optional
input parameters for this activity:

CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Convert Lead activity

Feedback | Notices
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Map the output of the Convert Lead activity

Procedure

1. In the Checklist, select Map Outputs.

The convertLeadResponse element is displayed in the From Activity panel. The parameters displayed
correspond to the convertLeadResponse structure, which is returned by the convertLead operation.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Convert Lead activity
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Set password activity
Use this activity to change the password of a user or SelfServiceUser to a value that you specify.

Note: You must have the administrative permission to change the password for the users.

To use the Set Password activity:

1. In the Activities tab, open the Salesforce.com directory to find the Set Password activity.
2. Drag the Set Password activity onto the orchestration.

The Summary and Checklist for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

Note: No additional configuration is required for this activity in the Configure section.
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4. Specify the Retry and Activity Timeout parameters for the activity.
5. Map the inputs of the activity.
6. Map the outputs of the activity.

To map the input of the Set Password activity:

1. In the Checklist, select Map Inputs.

The userId and password parameters are displayed in the To Activity pane.

2. (Optional) Right-click the default node and choose Show Optional Parameters, to display these optional
input parameters for this activity:

CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

To map the output of the Set Password activity:

1. In the Checklist, select Map Outputs.

The sessionInfo element is displayed in the From Activity pane.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Salesforce.com activities
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Reset password activity
Use this activity to reset the password of the user to a system-generated value.

Note: You must have the administrative permission to reset the password for the users.
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To use the Reset Password activity:

1. In the Activities tab, open the Salesforce.com directory to find the Reset Password activity.
2. Drag the Reset Password activity onto the orchestration.

The Summary and Checklist for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

Note: No additional configuration is required for this activity in the Configure section.
4. Specify the Retry and Activity Timeout parameters for the activity.
5. Map the inputs of the activity.
6. Map the outputs of the activity.

To map the input of the Reset Password activity:

1. In the Checklist, select Map Inputs.

The userId parameter is displayed in the To Activity pane.

2. (Optional) Right-click the default node and choose Show Optional Parameters, to display these optional
input parameters for this activity:

CallOptions
EmailHeader
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

To map the output of the Reset Password activity:

1. In the Checklist, select Map Outputs.

The password and sessionInfo elements are displayed in the From Activity pane.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Salesforce.com activities

Feedback | Notices
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Send email activity
Use this activity to send single or multiple emails. The emails include all standard email attributes such as the
email address, subject line, and carbon copies.

To use the email activity:

1. In the Activities tab, open the Salesforce.com directory to find the Send Email activity.
2. Drag the Send Email activity onto the orchestration.

The Summary and Checklist for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

4. In the Configure section, select the Send Mass Emails check box if you want to send multiple emails.
5. Specify the Retry and Activity Timeout parameters for the activity.
6. Map the inputs of the activity.
7. Map the outputs of the activity.

To map the input of the Send Email activity:

1. In the Checklist, select Map Inputs.

The emails parameter is displayed in the To Activity pane.

2. (Optional) Right-click the default node and choose Show Optional Parameters, to display these optional
input parameters for this activity:

connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

To map the output of the Send Email activity:

1. In the Checklist, select Map Outputs.

The results and sessionInfo elements are displayed in the From Activity pane.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.
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3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Salesforce.com activities
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Create Objects activity
Use this activity to create one or more Salesforce.com objects. In the Activities tab, open the Salesforce.com
directory to find the Create Objects activity.

Procedure

1. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

2. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

3. Configure the activity, by choosing a Salesforce.com object type and object field preferences.
4. Specify the Retry and Time out parameters for the activity.
5. Map the input of the activity.
6. Map the output of the activity.

Map the input of the Create Objects activity
Map the output of the Create Object activity

Parent topic: Salesforce.com activities
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Map the input of the Create Objects activity
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Procedure

1. In the Checklist, select Map Inputs.

The Objects element is displayed in the To Activity panel. The parameters displayed correspond to the
structure of the input to the Salesforce.com Objects operation.

2. (Optional) Right-click the default node and choose Show Optional Parameters, to show the optional
input parameters for this activity:

AssignmentRuleHeader
MruHeader
EmailHeader
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Optional and nillable field elements have the following behavior:
The Integration Appliance does not update an optional field, when the Salesforce.com server
does not provide a value for the field.
If you set the xsi:nil attribute to true on a nillable field, the Integration Appliance sets the field to
null during an update.
Note: Setting a field to an empty string does not set a field to null.

Parent topic: Create Objects activity
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Map the output of the Create Object activity

Procedure

1. In the Checklist, select Map Outputs.

The saveResults element is displayed in the From Activity panel. The parameters displayed correspond
to the saveResults structure, which is returned by the create activity.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.
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3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Create Objects activity
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Delete Objects activity
Use this activity to delete one or more objects in Salesforce.com. While the Salesforce.com API limits the
number of objects that it can delete in a single call to 200 objects, the Cast Iron® Salesforce.com connector
does not have such a limit. You can use the Delete Objects activity to delete an unlimited number of objects.

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Delete Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

4. Specify the Retry and Time out parameters for the activity.
5. Map the input of the activity.
6. Map the output of the activity.

Map the input of the Delete Objects activity
Map the output of the Delete Object activity

Parent topic: Salesforce.com activities
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Map the input of the Delete Objects activity

Procedure

1. In the Checklist, select Map Inputs.

The Ids element is displayed in the To Activity panel.

2. (Optional) Right-click the default node and choose Show Optional Parameters, to show the optional
input parameters for this activity:

UserTerritoryDeleteHeader
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Delete Objects activity
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Map the output of the Delete Object activity

Procedure

1. In the Checklist, select Map Outputs.

The deleteResults element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Delete Objects activity
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Get Deleted Objects
This activity retrieves the list of individual objects that have been deleted within the specified time-span for the
specified object.

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Get Delete Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

4. Specify the Retry and Time out parameters for the activity.
5. Map the input of the activity.
6. Map the output of the activity.

Map the input of the Get Deleted Objects activity
Map the output of the Get Deleted Object activity

Parent topic: Salesforce.com activities
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Map the input of the Get Deleted Objects activity

Procedure

1. In the Checklist, select Map Inputs.

The startDateTime element is displayed in the To Activity panel.

 533



2. (Optional) Right-click the default node and choose Show Optional Parameters, to show the optional
input parameters for this activity:

endDateTime
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Get Deleted Objects
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Map the output of the Get Deleted Object activity

Procedure

1. In the Checklist, select Map Outputs.

The deleteResults element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Get Deleted Objects
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Get Updated Objects

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Get Updated Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

4. Configure the activity, by choosing a Salesforce.com object type and object field preferences.
You can only select object types and fields that the Integration Appliance can update. The input map
contains the object type with elements that correspond to the fields you select during this configuration
step.
Note: The Integration Appliance cannot create auto-number fields.

5. Specify the Retry and Time out parameters for the activity.
6. Map the input of the activity.

The input map consists of an object's input parameter. This parameter consists of a single root element
that has a single repeating element, named after the object type you selected, containing all the fields
you selected in the Object Field Preferences table.

7. Map the output of the activity.

Map the input of the Get Updated Objects activity
Map the output of the Get Updated Object activity

Parent topic: Salesforce.com activities
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Map the input of the Get Updated Objects activity

Procedure

1. In the Checklist, select Map Inputs.

The startDateTime element is displayed in the To Activity panel.

2. (Optional) Right-click the default node and choose Show Optional Parameters, to show the optional
input parameters for this activity:

endDateTime
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CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Optional and nillable field elements have the following behavior:
The Integration Appliance does not update an optional field, when the Salesforce.com server
does not provide a value for the field.
If you set the xsi:nil attribute to true on a nillable field, the Integration Appliance sets the field to
null during an update.
Note: Setting a field to an empty string does not set a field to null.

Parent topic: Get Updated Objects
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Map the output of the Get Updated Object activity

Procedure

1. In the Checklist, select Map Outputs.

The saveResults element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Get Updated Objects
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Get User Information activity
Use this activity to get user information from the Salesforce.com server. In the Activities tab, open the
Salesforce.com directory to find the Get User Information activity.

Procedure

1. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

2. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

3. Specify the Retry and Time out parameters for the activity.
4. Map the output of the activity.

Map the output of the Get User Information activity

Parent topic: Salesforce.com activities
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Map the output of the Get User Information activity

Procedure

1. In the Checklist, select Map Outputs.

The GetUserInformationResult element contains the Salesforce.com user information and opens in the
From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Get User Information activity
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Get Server Timestamp activity
Use this activity to get the current time from the Salesforce.com server. In the Activities tab, open the
Salesforce.com directory to find the Get Server Timestamp activity.

Procedure

1. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

2. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

3. Specify the Retry and Time out parameters for the activity.
4. Map the output of the activity.

Map the output of the Get Server Timestamp activity

Parent topic: Salesforce.com activities
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Map the output of the Get Server Timestamp activity

Procedure

1. In the Checklist, select Map Outputs.

The serverTimestamp element contains the Salesforce.com user information and opens in the From
Activity panel.
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2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Get Server Timestamp activity
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Merge Objects Activity
Use this activity to merge Salesforce.com objects into a single record.

About this task

You can merge two or more of the following Salesforce.com objects into a single record:

Account
Contact
Leads

After the activity merges the objects, it deletes the pre-merge records and re-parents any duplicates.

While the Salesforce.com API limits the number of requests that it can merge in a single call to 200, the Cast
Iron® Salesforce.com connector does not have such a limit. You can use the Merge Objects activity to process
an unlimited number of merge requests.

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Merge Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

4. Configure the activity, by choosing a Salesforce.com object type and object field preferences.

You can only select Account, Contact, and Lead object types and fields that the Appliance can update.
Fields such as auto-number fields might not be available to select.
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5. Specify the Retry and Time out parameters for the activity.
6. Map the input of the activity.
7. Map the output of the activity.

Map the input of the Merge Objects activity
Map the output of the Merge Object activity
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Map the input of the Merge Objects activity

Procedure

1. In the Checklist, select Map Inputs.

The Merge element is displayed in the To Activity panel.

2. (Optional) Right-click the default node and choose Show Optional Parameters, to display these optional
input parameters for this activity:

AssignmentRuleHeader
MruHeader
EmailHeader
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Optional and nillable field elements have the following behavior:
The Integration Appliance does not update an optional field, when the Salesforce.com server
does not provide a value for the field.
If you set the xsi:nil attribute to true on a nillable field, the Integration Appliance sets the field to
null during an update.
Note: Setting a field to an empty string does not set a field to null.

Parent topic: Merge Objects Activity
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Map the output of the Merge Object activity

Procedure

1. In the Checklist, select Map Outputs.

The results element is displayed in the From Activity panel. The parameters displayed correspond to the
structure of the Salesforce.com MergeResults schema.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Merge Objects Activity
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Poll Deleted Objects activity
This activity polls the Salesforce.com Server for objects that have been recently deleted and returns IDs to the
Integration Appliance.

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Poll Deleted Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.
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4. Configure the activity by choosing a Salesforce.com object type and object field preferences.
5. Specify the Polling preferences for the activity.
6. Specify the Retry and Time out parameters for the activity.
7. Map the output of the activity.

Map the output of the Poll Deleted Object activity

Parent topic: Salesforce.com activities
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Map the output of the Poll Deleted Object activity

Procedure

1. In the Checklist, select Map Outputs.

The objects element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

The output map can have nillable field elements have the following behavior:
If the field being retrieved is null, the Integration Appliance sets the xsi:nil attribute to true in the
result.
If the input ID is not valid or does not represent the object type you specified, then for the entire
object element the Integration Appliance sets xsi:nil to true for that element's position in the
result set.

Parent topic: Poll Deleted Objects activity
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Poll Updated Objects activity
This activity polls the Salesforce.com Server for objects that have been recently created or updated and returns
all the object fields that you selected in the configuration panel to the Integration Appliance. In Studio,
configure the polling interval for the activity.

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Poll Updated Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

4. Configure the activity by choosing a Salesforce.com object type and object field preferences.
5. Specify the Polling preferences for the activity.
6. Specify the Retry and Time out parameters for the activity.
7. Map the output of the activity.

Map the output of the Poll Updated Object activity

Parent topic: Salesforce.com activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Poll_Updated_Objects_Activity.html

Map the output of the Poll Updated Object activity

Procedure

1. In the Checklist, select Map Outputs.

The objects element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variable(s) for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

The output map can have nillable field elements have the following behavior:
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If the field being retrieved is null, the Integration Appliance sets the xsi:nil attribute to true in the
result.  

Parent topic: Poll Updated Objects activity
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Query Objects activity
Use the Sforce Object Query Language (SOQL) to run a query on one or more Salesforce.com object types from
this activity and return a results set. The Query Objects activity automatically runs a query or queryAll call,
followed by continuous queryMore calls for all children and objects returned from Salesforce.com.

Note: Running the Query Objects activity can result in a cursor being opened by Salesforce.com to track the
query results. If the activity reaches the cursor limit that Salesforce.com allots to each user or if the cursor
expires, the Integration Appliance tries the activity again.

Using the Query Objects activity

1. In the Activities tab, open the Salesforce.com directory to find the Query Objects activity.
2. Add the activity to your orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

4. Configure the activity, by specifying a query and setting query options.
5. Specify the Retry and Time out parameters for the activity.
6. Map the input of the activity.
7. Map the output of the activity.

Map the input of the Query Objects activity

1. In the Checklist, select Map Inputs.

The parameters element is displayed in the To Activity panel. The parameters element has a child
element for each parameter you specified in the SOQL query. The context for the parameter in the query
determines the parameter type. If you did not specify any parameters, then no child elements are
displayed under the parameters element.

2. Right-click the default node and choose Show Optional Parameters, to show the optional input
parameters for this activity:

MruHeader
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CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variable or variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variable or variables.

For mapping instructions, see Creating a Map.

Map the output of the Query Objects activity

1. In the Checklist, select Map Outputs.

The objects element is displayed in the From Activity panel. The result parameter has a single element
named objects with a single repeating element named after the driving object of the query. The driving
object is the first object named in the FROM clause of the query. For example, in the following SOQL
statement Account is the driving object:

Select Name from Account, Account.Contacts

The driving object has child elements that correspond to the fields or relationships listed in the SELECT
clause of a query.  The schema is defined as follows:

For fields, the field type matches the SOAP type of the field. The field type is nillable if the SOAP
type is nillable.
For relationships for parent elements, the element name is the name of the parent. If there is no
parent when the activity runs the query, then the element is absent. The fields or relationships of
the parent is displayed immediately underneath the relationship element.
For relationships for child elements, the element name is the name of the child. The relationship
element has a single repeating element named after the object type of the child object. The fields
and relationship of the child is displayed underneath the object type element. If there are no
children when the activity runs the query, then the element is absent.
If you did not select any fields or relationships, but instead request the count() in the SELECT
clause, the entire object type element is replaced with an element named count of type
unsignedInt.

 
2. Click Select Outputs... and select the output variable or variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variable or variables.

For mapping instructions, see Creating a Map.

Parent topic: Salesforce.com activities
Parent topic: ServiceMax activities
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Configuring the Query Objects activity
You must create a SForce Object Search Language (SOSL) query to configure the Search Objects activity. The
following sections discuss the steps to configure the Search Objects activity, create an SOSL query, and
provide SOSL syntax rules for IBM® Cast Iron®.

Procedure

1. In the Checklist, select Configure.

The Specify Query window opens.

2. Create an SOSL query in the Specify Query window.
3. (Optional) You can specify dynamic parameters in the search clause of the SOSL statement. You can

then map these parameters dynamically as the input parameters for the activity, which allows the
activity to dynamically control the query based upon the input to the orchestration. Use a ($) dollar sign
to denote a parameter and follow it with the parameter name.

4. Click the Validate icon  , to validate the query.
If the query is invalid, the Validation Feedback icon  displays in the lower left corner of the Specify
Query window. For invalid queries:

a. Click the Validation Feedback icon in the lower left corner of the Specify Query window for a list of
validation errors.

b. Use the Refresh icon  to refresh meta data and revalidate the SOSL statement.
5. In the Checklist, select Query to configure specific query options.

The Query Options pane opens.

6. Select Include deleted items in query (execute a queryAll operation), to query for deleted records in
addition to existing records. If you do not select this option, the Integration Appliance only queries
existing records.

7. Specify a Query batch size between 200-2,000 queries to help tune the performance of the Integration
Appliance.

The option determines the batch size to use in the QueryOptions SOAP header for all query calls and
does not affect the number of results returned by the activity. By default, this option is set to 500
queries.

Parent topic: Salesforce.com activities

Creating SOSL Queries

When creating a SOQL query, you can use dynamic parameters in the WHERE clause of the SOQL statement.
Studio can then dynamically map these parameters as the input parameters for the activity. This allows for
dynamic control of the query based upon input to the orchestration.

About this task

The SForce Object Query Language does not define a syntax for parameterized queries; however, Cast Iron
does enforce some proprietary SOQL syntax rules. You can use parameters in either simple expressions or set
expressions.
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SOSL Syntax Rules for Cast Iron

Use a ($) dollar sign to denote a parameter. After the ($) dollar sign, specify a string of alphanumeric
characters. The first character must be a letter [a-zA-Z], optionally followed by one or more letters [a-
zA-Z], digits [0-9], or ( _ ) underscores.
Note: Parameter names are case-sensitive; therefore, the parameters $a and $A are considered to be
different parameters.
The following table contains examples of valid and invalid parameter declarations:

Parameter Valid or Invalid

$AnAccount valid

$a123_456 valid

$123a invalid

$_id invalid

You must declare parameters on the right-hand side of an expression in a WHERE clause.
Parameters can appear more than once in a given SOQL statement. However, even though the parameter
appears more than once in the SOQL statement, it only appears once in the input parameter map. The
activity substitutes the same value for all locations where the parameter is used at runtime.
Note: When you use the same parameter name and there is a type mismatch, an error occurs. For
example, the following SOQL generates an error because $param is used as both a string and date type:

SELECT Name from Account where Name like $param and createdDate > $param

The type of the field in which a parameter is being compared determines the type of the parameter and
whether the parameter is being used in a simple expression, a set expression, or part of a set
expression.

Ty
pe
of
Ex
pre
ssi
on Description

Si
mp
le
Ex
pre
ssi
ons

For example: Select ID from Account where Name = $NameParam

The SoapType of the field on the left-hand side of the expression determines the parameter type.
If the field type is nillable and the operator is ( = ) or ( != ), then the parameter is nillable.  Setting
xsi:nil=true on the parameter sets the parameter value to null when it is substituted. If the
parameter's type requires it to be enclosed in (‘) single quotes, then the parameter's value is
enclosed in single quotes during substitution and its contents are escaped automatically.

For SOQL, the (\) backslash and (‘) single-quote will be escaped.

Set
Ex
pre
ssi
ons

For example: Select ID From Account where ID in $idList

The parameter's type is a repeating sequence of the SoapType of the field on the left-hand side of
the expression. The parameter is not nillable and has minOccurs=1, maxOccurs=unbounded on
the element.

The sequence is expanded at runtime to be a proper set value, for example:

Select Id From Account where Id in (‘value1',‘value2')

Par Parameters inside a set list are treated like a simple expression parameter type, for example:
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SELECT Name from Account where BillingState IN (‘California', $state2)

In this example, the $state2 parameter type is the SoapType of the Account BillingState field and
is not a repeating element. The parameter is not nillable.
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Retrieve Objects activity
Use this activity to retrieve one or more Salesforce.com objects of a specified type. While the Salesforce.com
API limits the number of objects that it can retrieve in a single call to 2,000 objects, the Cast Iron®
Salesforce.com connector does not have such a limit. You can use the Retrieve Objects activity to retrieve an
unlimited number of objects.

Using the Retrieve Objects activity

1. In the Activities tab, open the Salesforce.com directory to find the Retrieve Objects activity.
2. Add the activity to your orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

4. Configure the activity, by choosing a Salesforce.com object type and object field preferences.

Only object types that the Integration Appliance is able to retrieve via the Salesforce.com API display.

5. Specify the Retry and Time out parameters for the activity.
6. Map the input of the activity.
7. Map the output of the activity.

Map the input of the Retrieve Objects activity

1. In the Checklist, select Map Inputs.

The ids element is displayed in the To Activity pane. The element contains the collection of IDs that the
Integration Appliance retrieves from Salesforce.com
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2. (Optional) Right-click the default node and choose Show Optional Parameters, to show the optional
input parameters for this activity:

MruHeaderUser
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Optional and nillable field elements have the following behavior:

If the field being retrieved is null, the Integration Appliance sets the xsi:nil attribute to true in the
result.
If the input ID is not valid or does not represent the object type you specified, then for the entire object
element the Integration Appliance sets xsi:nil to true for that element's position in the result set.

Map the output of the Retrieve Objects activity

1. In the Checklist, select Map Outputs.

The objects element is displayed in the From Activity panel. The element contains all fields that you
selected in the field preferences table, during the configuration steps.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: Salesforce.com activities
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Search Objects activity

About this task

Use the Sforce Object Search Language (SOSL) to run a search query on one or more Salesforce.com object
types from this activity and return a results set.
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Note: You can only search objects that are configured as searchable or eSearchable. You cannot search
attachment objects.

Using the Search Objects activity:

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Search Objects activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity is displayed beneath

the orchestration.

Results

1. Select a Salesforce.com endpoint. For instructions on creating or editing a Salesforce.com endpoint, see
Creating or Editing  a Salesforce.com Endpoint.

2. Configure the activity, by specifying a search query and setting search query options.
3. Specify the Retry and Time out parameters for the activity.
4. Map the input of the activity.
5. Map the output of the activity.

Map the input of the Search Objects activity:

1. In the Checklist, select Map Inputs. The parameters element is displayed in the To Activity panel. The
parameter element has a child element for each parameter you specified in the SOSL query. The context
for the parameter in the query determines the parameter type. If you did not specify any parameters,
then no child elements are displayed under the parameters element.  

2. Right-click the default node and choose Show Optional Parameters, to show the optional input
parameters for this activity:

CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variable or variables for the map. For instructions about
creating variables, see Creating variables.

4. As appropriate, map the input parameters to the variable or variables. For mapping instructions, see
Creating a map.

Map the output of the Search Objects activity:

1. In the Checklist, select Map Outputs. The objects element is displayed in the From Activity panel.   
2. Click Select Outputs... and select the output variable or variables for the map. For instructions about

creating variables, see Creating variables.
3. As appropriate, map the output parameters to the variable or variables. For mapping instructions, see

Creating a map.

Parent topic: Salesforce.com activities
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Undelete Objects activity

About this task

Use this activity to restore one or more objects that you deleted in Salesforce.com.

To use the Undelete Objects activity complete the following steps:

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Undelete Objects activity. Add the
activity to an orchestration. The Checklist and Summary for the activity are displayed beneath the
orchestration.

2. Select a Salesforce.com endpoint. For instructions on creating or editing a Salesforce.com endpoint, see
Creating or Editing a Salesforce.com Endpoint.

3. Specify the Retry and Time out parameters for the activity.
4. Map the input of the activity.
5. Map the output of the activity.

Results

Map the input of the Undelete Objects activity

1. In the Checklist, select Map Inputs. The ids element is displayed in the To Activity panel.
2. Right-click the default node and choose Show Optional Parameters, to show the optional input

parameters for this activity:
CallOptions
connection

3. Click Select Inputs... and select the input variable or variables for the map. For instructions about
creating variables, see Creating variables.

4. As appropriate, map the input parameters to the variable or variables. For mapping instructions, see
Creating a map.

Map the output of the Undelete Objects activity

1. In the Checklist, select Map Outputs. The results element is displayed in the From Activity panel.
2. Click Select Outputs... and select the output variable or variables for the map. For instructions about

creating variables, see Creating variables.
3. As appropriate, map the output parameters to the variable or variables. For mapping instructions, see

Creating a map.

Parent topic: Salesforce.com activities
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Configuring the Search Objects activity
You must create an SForce Object Search Language (SOSL) query to configure the Search Objects activity.

About this task

The following sections discuss the steps to configure the Search Objects activity, create an SOSL query, and
provide SOSL syntax rules for IBM® Cast Iron®.

To configure the Search Objects activity complete the following steps:

Procedure

1. In the Checklist, select Configure. The Specify Query window opens.
2. Create an SOSL query in the Specify Query window.
3. Optional: You can specify dynamic parameters in the search clause of the SOSL statement. You can then

map these parameters dynamically as the input parameters for the activity, which allows the activity to
dynamically control the query based upon the input to the orchestration. Use a ($) dollar sign to denote
a parameter and follow it with the parameter name.

4. Click the Validate icon , to validate the query. If the query is invalid, the Validation Feedback icon 
shows in the lower left corner of the Specify Query window. For invalid queries:

Click the Validation Feedback icon in the lower left corner of the Specify Query window for a list of
validation errors.

Use the Refresh icon  to refresh meta data and revalidate the SOSL statement.

Parent topic: Salesforce.com activities

Creating SOSL queries

About this task

When creating a SForce Object Search Language (SOSL) query, you can use dynamic parameters in the WHERE
clause of the SOSL statement. Studio can then dynamically map these parameters as the input parameters for
the activity. This allows for dynamic control of the query based upon input to the orchestration.

The SForce Object Search Language does not define a syntax for parameterized queries; however, IBM Cast
Iron does enforce a few proprietary SOSL syntax rules. You can use parameters in either simple expressions or
set expressions.

SOSL syntax rules for IBM Cast Iron

About this task

Use a ($) dollar sign to denote a parameter. After the ($) dollar sign, specify a string of alphanumeric
characters. The first character must be a letter [a-zA-Z], optionally followed by one or more letters [a-
zA-Z], digits [0-9], or ( _ ) underscores.
Note: Parameter names are case-sensitive; therefore, the parameters $a and $A are considered to be
different parameters.
The following table contains examples of valid and invalid parameter declarations:

Parameter Valid or Invalid

$AnAccount valid
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Parameter Valid or Invalid

$a123_456 valid

$123a invalid

$_id invalid

You must declare parameters in the Search Query portion of the SOSL statement. Curly braces ( { } )
demarcate the Search Query portion of the SOSL statement.
Important: Do not use double-quotes ( " " ) to enclose parameters. If you enclose parameters in double-
quotes, the activity treats the parameter as a string search literal.
The parameter type is always xsd:string. During substitution, the activity escapes any parameter that
you declare using a reserved character. Reserved characters include the following characters:

Reserved Characters Description

& ampersand

* asterisk

\ back slash

[ ] box brackets

: colon

, comma

{ } curly braces

" double quote

! exclamation mark

- minus sign

+ plus sign

' single quote

~ tilda

^ up arrow

| vertical bar

Parameters can appear more than once in a given SOQL statement. However, even though the parameter
appears more than once in the SOQL statement, it only appears once in the input parameter map. The
activity substitutes the same value for all locations where the parameter is used at runtime.
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Update Objects activity
Use this activity to update existing objects in Saleforce.com.

About this task

While the Salesforce.com API limits the number of objects that it can update in a single call to 200 objects, the
Cast Iron® Salesforce.com Connector does not have such a limit. You can use the Update Objects activity to
update an unlimited number of objects.  

Using the Update Objects activity.

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Update Objects activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity are displayed beneath

the orchestration.
3. Select a Salesforce.com endpoint. For instructions on creating or editing a Salesforce.com endpoint, see

Creating or Editing a Salesforce.com Endpoint.
4. Configure the activity by choosing a Salesforce.com object type and object field preferences. You can

only select object types and fields that the Integration Appliance can update. The input map contains
the object type with elements that correspond to the fields you select during this configuration step.
Note: The Integration Appliance cannot create auto-number fields.

5. Specify the Retry and Time out parameters for the activity.
6. Map the input of the activity. The input map consists of an object's input parameter. This parameter

consists of a single root element that has a single repeating element, named after the object type you
selected, containing all the fields you selected in the Object Field Preferences table.

7. Map the output of the activity.

Results

Map the input of the Update Objects activity

1. In the Checklist, select Map Inputs. The objects element is displayed in the To Activity pane.
2. Right-click the default node and choose Show Optional Parameters to show the optional input

parameters for this activity:
AssignmentRuleHeader
MruHeader
EmailHeader
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variable or variables for the map. For instructions about
creating variables, see Creating variables.

4. As appropriate, map the input parameters to the variable or variables. For mapping instructions, see
Creating a map.

Optional and nillable field elements have the following behavior:

The Integration Appliance does not update an optional field, when the Salesforce.com server does not
provide a value for the field.
If you set the xsi:nil attribute to true on a nillable field, the Integration Appliance sets the field to null
during an update.
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Note: Setting a field to an empty string does not set a field to null.

Map the output of the Update Objects activity

1. In the Checklist, select Map Outputs. The saveResults element is displayed in the From Activity panel.
2. Click Select Outputs... and select the output variable or variables for the map. For instructions about

creating variables, see Creating variables.
3. As appropriate, map the output parameters to the variable or variables. For mapping instructions, see

Creating a map.

Parent topic: Salesforce.com activities
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Upsert Objects activity
Use this activity to update existing objects or create new objects in Saleforce.com.

About this task

The activity uses an external ID, usually a foreign key, to determine whether to update an existing object or
create a new object in Salesforce.com.

While the Salesforce.com API limits the number of objects that it can create in a single upsert call to 200
objects, the Cast Iron® Salesforce.com connector does not have such a limit. You can use the Upsert Objects
activity to create an unlimited number of objects.

To use the Upsert Objects activity:

Procedure

1. In the Activities tab, open the Salesforce.com directory to find the Upsert Objects activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity are displayed beneath

the orchestration.
3. Select a Salesforce.com endpoint. For instructions on creating or editing a Salesforce.com endpoint, see

Creating or Editing a Salesforce.com Endpoint.
4. Configure the activity, by choosing a Salesforce.com object type and object field preferences.

Note: You can only choose object types that the Integration Appliance can update or create and contain
at least one External ID field. When you select the object type, Studio displays the external IDs defined
on the object type in the External ID field of the Configure pane. You cannot edit the IDs listed in the
External ID list. The external ID that you select becomes a required field, you cannot clear this field from
the Object Field Preferences table. If only one external ID is available, Studio automatically selects this
field in the Object Field Preferences table.

5. Specify the Retry and Time out parameters for the activity.
6. Map the input of the activity.
7. Map the output of the activity.
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Results

Map the input of the Upsert Objects activity

1. In the Checklist, select Map Inputs. The objects element is displayed in the To Activity panel.
2. Right-click the default node and choose Show Optional Parameters, to show the optional input

parameters for this activity:
AssignmentRuleHeader
MruHeader
EmailHeader
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variable or variables for the map. For instructions about
creating variables, see Creating variables.

4. As appropriate, map the input parameters to the variable or variables. For mapping instructions, see
Creating a map.

This activity supports the following optional input parameters:

AssignmentRuleHeader
EmailHeader
MruHeader

Optional and nillable field elements have the following behavior:

The Integration Appliance does not update an optional field, when the Salesforce.com server does not
provide a value for the field.
If you set the xsi:nil attribute to true on a nillable field, the Integration Appliance sets the field to null
during an update.
Note: Setting a field to an empty string does not set a field to null.

Map the output of the Upsert Objects activity

1. In the Checklist, select Map Outputs. The upsertResults element is displayed in the From Activity
panel.

2. Click Select Outputs... and select the output variable or variables for the map. For instructions about
creating variables, see Creating variables.

3. As appropriate, map the output parameters to the variable or variables. For mapping instructions, see
Creating a map.

Parent topic: Salesforce.com activities
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SAP activities
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Overview of the SAP connector
Creating or editing a SAP endpoint
Endpoints provide the SAP connection information that Studio and the Integration Appliance use to
connect to the SAP system.
Downloading and installing the SAP Jar Files and DLLs
To connect to an SAP system from studio, you must install SAP DLLs and jar files onto your Windows
development machine. You must have the SAP login credentials to enter the SAP Support Portal and
download the files.
Configuring Single Sign-on (SSO) and Secure Network Communications (SNC) for SAP connector
SAP Invoke BAPI activity
Use the SAP Invoke BAPI activity to call a Business Object Method (BAPI), that is remotely enabled at
the specified SAP Endpoint, during run time.
SAP Invoke RFC activity
Use the SAP Invoke RFC activity to call a Remote Function Call (RFC), that is remotely enabled at the
specified SAP endpoint, during run time.
SAP Receive IDOC activity
Use the SAP Receive IDOC activity to act as a server and listenson the configured SAP endpoint, during
run time. The activity receives an IDOC from the specified SAP endpoint and converts it to XML data. The
SAP Receive IDOC activity is a starter activity.
SAP Send IDOC activity
Use the SAP Send IDOC activity to send an IDOC to the specified SAP endpoint, during run time.
SAP Receive RFC activity
Use the SAP Receive RFC activity to act as a server and listen on the configured SAP endpoint, during run
time. The activity receives RFC from the specified SAP endpoint and converts it to XML data. The SAP
Receive RFC activity is a starter activity. This activity can be configured in both synchronous and
asynchronous mode.
SAP Send RFC Response activity
The SAP Send RFC Response activity sends a reply back to the sender (SAP) of the SAP Receive RFC
request.
Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly. This
topic provides potential solutions for issues you would have with the SAP connector.
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Overview of the SAP connector
The SAP connector enables a two-way communication between Cast Iron and the SAP instance. The connector
supports Business Application Programming Interface (BAPI), Remote Function Call (RFC), and Intermediate
Document (IDOC) interfaces.

You can perform the following activities using the SAP connector:

Outbound Activities
Invoke BAPI
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Invoke RFC
Send IDOC

Inbound/Starter Activities
Receive IDOC

The SAP connector supports SAP Java Connector (JCo) libraries to work with SAP via IDOC, RFC and BAPI
interfaces.

The SAP connector requires the SAP JCo libraries to connect to the SAP instance. The connector supports JCo
version 3.0.x or later versions. For more information, see Downloading and installing the SAP Jar Files and
DLLs.
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Creating or editing a SAP endpoint
Endpoints provide the SAP connection information that Studio and the Integration Appliance use to connect to
the SAP system.

Procedure

1. Drag an activity from the SAP folder of the Activities tab onto the orchestration.

The Summary pane is displayed along with a Checklist which outlines what you must do to configure the
activity.

2. Click Endpoint task from the Checklist and click on one of the following options:
Browse —To select an existing endpoint from the Project Explorer. Once a SAP endpoint has been
added, you can click Edit to edit it.
Note: Editing an endpoint affects all orchestrations that use that endpoint in the project. The edits
are global, not local.
New —To create a new endpoint. The Create Endpoint window is displayed.
Edit —To edit the existing endpoint. The Edit Endpoint window is displayed.

3. Complete the fields defined in the tables below.
4. When finished, click Test Connection to confirm that you can connect to the SAP System.
5. Click OK.

Table 1. SAP Options
Field Description

Location

Host Name Specifies the IP Address or the machine name that contains the SAP system.

System
Number

Specifies the number that identifies the specific instance of the SAP system that
Studio should connect to. Your SAP administrator must supply this information.
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Field Description

Client Information

SAP Client Specifies a number that identifies Studio and the Integration Appliance as a client for
the SAP system. Your SAP administrator must supply this information.

Language Specifies the message language option for SAP. For example, EN is the ISO code for
English.

SAP Login Details

Username/Pas
sword based
authentication

Specifies the user name and password of the user account of the SAP connector on
the SAP system.

User name Specifies the user name to use when connecting to the SAP system.

Password Specifies the password to the user name when connecting to the SAP system.

SSO Token
based
authentication

Specifies that this option needs to be selected if the SSO Token is to be specified to log
on to the SAP system.

SSO Token Specifies the single sign-on (SSO) token.

Secure
Network
Connection
(SNC)

Indicates that this check box must be selected for SNC.
Note: When the SNC check box is selected, the Username/Password based
authentication is cleared. To use this option, you must select it again.

Secure
Network
Connection
(SNC) name

Specifies the distinguished name of the SNC connection.

Secure
Network
Connection
(SNC) partner

Specifies the distinguished name of the SNC partner.

Secure
Network
Connection
(SNC) security
level

Specifies the level of security of SNC.

X509
Certificate

Specifies the X509 certificate to be used as the logon ticket. This field is optional only
if Username/Password based authentication is used with SNC.

For more information about configuring SSO and SNC, see Configuring Single Sign-on (SSO) and Secure
Network Communications (SNC) for SAP connector

Connection Pool Options

Maximum
Connections

Specifies the additional SAP connections, up to the specified amount, that the
Integration Appliance opens based on the message load.

Maximum Idle
Time

Specifies the number of minutes that a SAP connection can be open and idle before
being closed by the Integration Appliance.
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Field Description

Inbound Gateway
Note: The values specified in this section are only used by the Receive IDOC activity.

Enable
inbound
gateway

Select this check box if this endpoint is used by a Receive IDOC activity and Receive
RFC activity.

Host Specifies the hostname of the SAP gateway.

Server
Instances

Specifies the maximum number of Servers that can be registered with the same
programID within an SAP instance.

Program ID Specifies the ID of the registered Server. This ID is assigned when the RFC destination
port is configured. SAP Program Ids cannot start with the exclamation (!) character.
Note: For SAP systems, the Program ID name is case sensitive. For example, the
Program ID name: Aaa is not equivalent to the Program ID name: aaa.

Service Specifies the name of the SAP gateway service.

Retry Interval Specifies the number of seconds that the Integration Appliance should wait before
trying to re-establish a connection to the gateway of the SAP system.

Remote
Endpoint
Configuration

 

Endpoint Runs
Behind
Firewall

Enables the secure connector name property so that secure connector can be used if
the SAP application is running behind a firewall.

Secure
Connector
Name

Specifies the name of the secure connector that is used to connect to the SAP
application running behind a firewall. For example, if an orchestration containing an
SAP activity is deployed on to Cast Iron Live (cloud), then the secure connector needs
to be configured.

Note: For some of the fields in the endpoint, you can define configuration properties to supply the values

for these fields. The  icon is displayed when you click in a field that supports a configuration property
and a configuration property of the same type has already been configured for the project.

Parent topic: SAP activities
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Downloading and installing the SAP Jar Files and DLLs
To connect to an SAP system from studio, you must install SAP DLLs and jar files onto your Windows
development machine. You must have the SAP login credentials to enter the SAP Support Portal and download
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the files.

About this task

To download and install the SAP jar files and DLLs:

1. Contact SAP Technical Support to obtain the compressed files for the following SAP Components:
SAP JCo - based on the platform on which studio is running.
SAP Java IDoc Class Library

Note: Latest version of JCo jar available: 3.0.14, IDoc version 3.0.12.
2. Uncompress the SAP JCo compressed file:

Double-click the sapjidoc30P_x-1000xxxx.zip file.
Use the decompression tool to extract the contents of the compressed file to a temporary
directory. This compressed file contains another compressed file sapjco3- NTintel-
3.0.x.zip. Extract this compressed file to a temporary directory, for example:
C:\temp\sapjco3-NTintel-3.0.x. This directory contains the required libraries
sapjco3.jar and sapjco3.dll.

3. Uncompress the SAP IDoc JCo compressed file:
Double-click the sapjidoc30P_x-1000xxxx.zip file.
Use the decompression tool to extract the contents of the compressed file to a temporary
directory, for example, C:\temp\sapjidoc30P_x-1000xxxx. This directory contains the
required library sapidoc3.jar.

Note: If you are using Cast Iron Studio version 6.4 or earlier versions, you must download and install the 32 bit
SAP libraries. For Cast Iron version 7.0 onwards, you must download and install the 64 bit SAP libraries.

Procedure

1. Open studio, select Tools > Install Module Providers.
2. When the Add Providers dialog box is displayed, click the plus (+) button beneath SAP Connector.

A text entry field and a Browse button is displayed.

3. Click Browse, and use the browse dialog box to locate and select the sapjco3.jar file.
4. Click Open to import the jar file contents.
5. Click the next available plus (+) button to add the sapidoc3.jar and sapjco3.dll files.
6. When the jar file is listed in the Add Providers dialog box, click OK.

Results

A prompt is displayed to restart studio and activate the changes.

What to do next

You can now create SAP endpoints and orchestrations.

Parent topic: SAP activities
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Configuring Single Sign-on (SSO) and Secure Network
Communications (SNC) for SAP connector

Before you begin

In Cast Iron version 6.3.0.2 and later versions, you can connect to SAP through the SAP connector in the
following ways:

By providing user name and password
By providing an SSO ticket (for Invoke RFC, Invoke BAPI, and Send IDOC activities only).
Note: Enable the SAP server for SSO. The SAP SSO ticket can be obtained by logging into the SAP system
using a web browser and fetching the value of session cookie named MYSAPSSO2.
Using the SNC feature, by providing the SNC name, the SNC partner name, and one of the following:

X509 certificate
X509 certificate, username (user of the certificate), and a dummy password
User name and password

Note: Enable the SAP server for SNC.

Procedure

For SNC:

1. Add SECUDIR as a system variable and set it to the PATH: WHERE SECUDIR = <PATH OF EXTRACTED
SAP CRYPTO lib file>.

2. Add the system credentials to the .pse file: sapgenpse seclogin -p <PSE LOCATION>.pse -O
<SYSTEM USERNAME>.

3. In Cast Iron Studio, go to Tools > Install Module Providers and upload sapcrypto.dll file of the
respective version of studio (32 bit/64 bit) to the SAP connector.

4. In the endpoint page, complete the following:
a. Specify the distinguished name for client PSE (created while generating client PSE) in the SNC

name field.
b. Specify the distinguished name for client PSE (created while generating client PSE) in the SNC

partner field.
c. Specify the level of security in SNC security level. Security level support is provided by

Cryptographic Library and all security levels may not be supported by a particular library file.
Select the required option from the drop-down list.

d. Optional: Specify the X509 certificate to be used as the log on ticket, if required. Remove the
extra lines such that the certificate is in a single line.

e. Complete the rest of the fields and click Test Connection.

Parent topic: SAP activities
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SAP Invoke BAPI activity
Use the SAP Invoke BAPI activity to call a Business Object Method (BAPI), that is remotely enabled at the
specified SAP Endpoint, during run time.

Note: To connect to the SAP System from Studio, you must download and install the SAP Jar files and DLLs
onto your Window's development machine. For more information, see Downloading and installing the SAP Jar
Files and DLLs.

Adding a SAP Invoke BAPI activity in the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the SAP folder.
3. Drag the SAP Invoke BAPI activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing a SAP endpoint

1. Click Pick Endpoint task from the Checklist and select one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Go to the Configuring the activity procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint panel is displayed.
2. Create or Edit a SAP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure panel is displayed.
2. In the Object Name field click Browse.... The BAPI List dialog box is displayed.
3. Search for a Business Object. Click a Business Object in the list and enter the starting characters of the

Business Object name.
4. Expand the Business Object to view the associated BAPI methods.
5. Select a Business Object and Method and click OK.
6. Select one of the following Transaction Options:

Do Nothing (Transaction handled by BAPI directly) - During run time, the Integration Appliance
calling the BAPI does no transaction processing. If a transaction is associated with the BAPI, the
BAPI must completely handle the transaction
Commit transaction after completion -  During run time, the Integration Appliance calls the BAPI
and waits for a return message from the SAP System. The return code of the message returned
from the SAP System determines if the Integration Appliance sends another message requesting
that the SAP System to commit or rollback the transaction:

If the return code passed back from the BAPI indicates success, the Integration Appliance
sends another message requesting that the SAP System commit the transaction and
immediately starts processing the next activity in the orchestration.
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If the return code passed back from the BAPI indicates failure, the Integration Appliance
sends a rollback request to the SAP System and immediately starts processing the next
activity in the orchestration.

Commit transaction and wait upon completion -  During run time, the Integration Appliance
invokes the BAPI and waits for a return message from the SAP System. The return code of the
message returned from the SAP System determines if the Integration Appliance sends another
message requesting that the SAP System to commit or rollback the transaction:

If the return code passed back from the BAPI indicates success, the Integration Appliance
sends another message requesting that the SAP System commit the transaction. The
orchestration waits until the SAP System sends a second message indicating that the
transaction has been committed before processing the next activity in the orchestration.
If the return code passed back from the BAPI indicates failure, the Integration Appliance
sends a rollback request to the SAP System. The orchestration waits until the SAP System
sends a second message indicating that the rollback of the transaction has occurred before
processing the next activity in the orchestration.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry panel is displayed.
2. Configure the retry options for connecting to an SAP System. The following table describes the retry

options for connecting to an SAP System:  

Re
try
op
tio
ns Description

1)
Wa
it
__
_
se
co
nd
s
be
tw
ee
n
ea
ch
ret
ry.

Specifies the number of seconds that the Integration Appliance waits before trying to establish a
connection to the SAP System.

2)
Try
to
co
nn
ect
__
_
ti

Specifies the maximum number of times the Integration Appliance attempts to establish a
connection to the SAP System before issuing an error and stopping the processing of the current
orchestration job. If you deploy an orchestration that contains an SAP Invoke BAPI activity and
the Integration Appliance cannot connect to the specified SAP System, the Integration Appliance
logs the connections errors as warnings in the system and orchestration logs until the retry count
value is reached. When the retry count is reached, the Integration Appliance logs an error in the
system and orchestration logs and the stops processing the current orchestration job. For
example, you set the retry count to 3. The first, second, and third connection errors appear in the
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system log as warnings. The Integration Appliance logs the fourth connection error as an error and
stops processing the current orchestration job.

Mapping the inputs of the activity

1. Select the Map Inputs task in the Checklist. The XML Schemas generated from the input parameters of
the BAPI are displayed as nodes under the request input parameter in the To Activity panel. In addition
if the BAPI contains tables, the XML Schemas representing the tables of the BAPI , are displayed as
nodes under the request input parameter in the To Activity panel.

The SAP connector also supports dynamic endpoint connection to a different SAP system. During run
time, add optional parameters in sapConnectionProperties of map inputs, if you want to
dynamically connect to an SAP system other than the one configured in the endpoint panel, if you want
to connect to the same SAP system with a different user name and password other than the fields used
in the endpoint panel, or if you want a different SSO token other than the one added in the endpoint
panel. The parameters of sapConnectionProperties are described in the following table:

Table 1. Connection properties
Optional
parameter Description

sapConnectionProperties parameters

hostName Specifies the IP Address or the machine name that contains the SAP system.

systemNum
ber

Specifies the number that identifies the specific instance of the SAP system that Studio
should connect to. Your SAP administrator must supply this information.

client Specifies a number that identifies Studio and the Integration Appliance as a client for the
SAP system. Your SAP administrator must supply this information.

language Specifies the message language option for SAP. For example, EN is the ISO code for
English.

basicAuthentication parameters

username Specifies the user name to use when connecting to the SAP system.

password Specifies the password to the user name when connecting to the SAP system.

ssoAuthentication parameters

ssotoken Specifies the single sign-on (SSO) token.

sncAuthentication parameters

sncmode Specifies if the Secure Network Connections (SNC) mode is enabled.

sncname Specifies the distinguished name of the SNC connection.

partner Specifies the distinguished name of the SNC partner.

qop Specifies the level of security of SNC.

X509
Certificate

Specifies the X509 certificate to be used as the logon ticket. This field is optional only if
Username/Password based authentication is used with SNC.
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Optional
parameter Description

connectionPool parameters

maximumC
onnections

Specifies the additional SAP connections, up to the specified amount, which the
Integration Appliance opens based on the message load.

maxIdleTim
e

Specifies the number of minutes that a SAP connection can be open and idle before
being closed by the Integration Appliance.

2. Create a map between orchestration variables and the BAPI input parameters and tables. See Creating a
map for general instructions on mapping.

Values must be provided at run time for any mandatory elements of the BAPI input parameters or
tables. A value can be provided by specifying a default value for element or by linking the element with
input node. During run time if no value is provided for a mandatory element, the activity throws an
exception during run time which is reported by the Web Management Console (WMC). If a value is not
provided at run time for an optional element of the BAPI input parameters or tables, no exception is
thrown during run time.

Mapping the outputs of the activity

1. Select the Map Outputs task in the Checklist. The XML Schema generated from return types of the BAPI
display as nodes under the response output parameter in the From Activity panel. In addition, if the
BAPI contains tables, the XML Schemas representing the tables are displayed as nodes under the
response node in the From Activity.

2. Create a map between the BAPI output parameters and tables and orchestration variables. See Creating
a map for general instructions on mapping.

Note about deploying a SAP orchestration

Before you can deploy an orchestration with SAP activities using the WMC, the Integration Appliance must first
be able to establish a connection to the SAP System. If the Integration Appliance is unable to establish the
connection to the SAP System, the orchestration is not deployed.
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SAP Invoke RFC activity
Use the SAP Invoke RFC activity to call a Remote Function Call (RFC), that is remotely enabled at the specified
SAP endpoint, during run time.

Note: To connect to the SAP System from Studio, you must download and install the SAP Jar files and DLLs
onto your Window's development machine. For more information, see Downloading and installing the SAP Jar
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Files and DLLs.

Adding a SAP Invoke RFC activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the SAP folder.
3. Drag the SAP Invoke RFC activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing a SAP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Go to the Configuring the activity procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint panel is displayed.

Create a new endpoint: Select New. The Create Endpoint panel is displayed.
2. Create or Edit a SAP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure panel is displayed.
2. In the RFC Name field, click Browse.... The RFC List dialog box is displayed.
3. In the RFC Search Function field, enter a combination of characters and the * wildcard character to find

the desired RFC name as shown in the following examples:
AB* —Finds all the RFC whose names begin with the AB prefix.
AB*TRANSACTION —Finds all the RFC whose begin with the AB prefix and end with the string:
TRANSACTION.

The SAP system is interrogated and the RFC names that match the wildcard expression are listed
in the Matching SAP Functions table.

4. From the Matching SAP Functions table, select one of the SAP Functions and click OK.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry panel is displayed.
2. Configure the retry options for connecting to an SAP System. The following table describes the retry

options for connecting to an SAP System:  

Re
try
op
tio
ns Description

1)
Wa
it
__
_
se

Specifies the number of seconds that the Integration Appliance waits before trying to establish a
connection to the SAP System.
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Specifies the maximum number of times the Integration Appliance attempts to establish a
connection to the SAP System before issuing an error and stopping the processing of the current
orchestration job. If you deploy an orchestration that contains an SAP Invoke RFC activity and the
Integration Appliance cannot connect to the specified SAP System, the Integration Appliance logs
the connections errors as warnings in the system and orchestration logs until the retry count value
is reached. When the retry count is reached, the Integration Appliance logs an error in the system
and orchestration logs and the stops processing the current orchestration job. For example, you
set the retry count to 3. The first, second, and third connection errors appear in the system log as
warnings. The Integration Appliance logs the fourth connection error as an error and stops
processing the current orchestration job.

Mapping the inputs of the activity

1. Select the Map Inputs task in the Checklist. The XML Schemas generated from the input parameters of
the RFC are displayed as nodes under the request input parameter in the To Activity pane. In addition if
the RFC contains tables, the XML Schemas representing the tables of the RFC, are displayed as nodes
under the request input parameter in the To Activity panel.

2. Create a map between orchestration variables and the RFC input parameters and tables. See Creating a
map for general instructions on mapping.

Values must be provided at run time for any mandatory elements of the RFC input parameters or tables.
A value can be provided by specifying a default value for the element or by linking the element with
input node. During run time if no value is provided for a mandatory element, the activity throws an
exception during run time which is reported by the Web Management Console (WMC). If a value is not
provided at run time for an optional element of the RFC input parameters or tables, no exception is
thrown during run time.

Transaction Options:

1. In the Map Inputs of the activity, right click the To Activity section and select Show Optional Parameters.
A variable transactionOptions appears in the map input. This property is available from Cast Iron
Studio version 6.1.0.12 only.

2. Select one of the following values:
Note: If you do not set any value for the transactionOptions property, the
COMMIT_HANDLED_BY_RFC value will be used.
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Table 1.
Value Description

COMMIT_HA
NDLED_BY_R
FC

The commit of RFC is taken care by the RFC itself. The connector does not do any
explicit commit calls.

COMMIT_TRA
NSACTION_A
FTER_COMPL
ETION

During run time, the SAP connector calls the RFC and waits for a return message from
the SAP System. The return code of the message returned by the SAP system
determines if the SAP connector sends another call requesting the SAP system to
commit or rollback the transaction:

If the return code passed from the RFC indicates success, the SAP connector
makes another call requesting the SAP system to commit the transaction, and
immediately starts processing the next activity in the orchestration.
If the return code passed from the RFC indicates failure, the SAP connector
makes a rollback request to the SAP system, and immediately starts processing
the next activity in the orchestration.

COMMIT_TRA
NSACTION_A
ND_WAIT_UP
ON_COMPLET
ION

During run time, the SAP connector invokes the RFC and waits for a return message
from the SAP system. The return code of the message returned by the SAP system
determines if the SAP connector sends another message requesting the SAP system to
commit or rollback the transaction:

If the return code passed back from the RFC indicates success, the SAP
connector makes another call requesting the SAP system to commit the
transaction. The orchestration waits until the SAP System sends a second
message indicating that the transaction has been committed before processing
the next activity in the orchestration.
If the return code passed back from the RFC indicates failure, the SAP connector
makes a rollback request to the SAP system. The orchestration waits until the
SAP system sends a second message indicating that the rollback of the
transaction has occurred before processing the next activity in the orchestration.

3. After the transaction operations are selected, fill in the input data for RFC.

The SAP connector also supports dynamic endpoint connection to a different SAP system. During run time, add
optional parameters in sapConnectionProperties of map inputs, if you want to dynamically connect to an
SAP system other than the one configured in the endpoint panel, if you want to connect to the same SAP
system with a different user name and password other than the fields used in the endpoint panel, or if you want
a different SSO token other than the one added in the endpoint panel. The parameters of
sapConnectionProperties are described in the following table:

Table 2. Connection properties
Optional
parameter Description

sapConnectionProperties parameters

hostName Specifies the IP Address or the machine name that contains the SAP system.

systemNum
ber

Specifies the number that identifies the specific instance of the SAP system that Studio should
connect to. Your SAP administrator must supply this information.

client Specifies a number that identifies Studio and the Integration Appliance as a client for the SAP
system. Your SAP administrator must supply this information.

language Specifies the message language option for SAP. For example, EN is the ISO code for English.

basicAuthentication parameters
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Optional
parameter Description

username Specifies the user name to use when connecting to the SAP system.

password Specifies the password to the user name when connecting to the SAP system.

ssoAuthentication parameters

ssotoken Specifies the single sign-on (SSO) token.

sncAuthentication parameters

sncmode Specifies if the Secure Network Connections (SNC) mode is enabled.

sncname Specifies the distinguished name of the SNC connection.

partner Specifies the distinguished name of the SNC partner.

qop Specifies the level of security of SNC.

X509
Certificate

Specifies the X509 certificate to be used as the logon ticket. This field is optional only if
Username/Password based authentication is used with SNC.

connectionPool parameters

maximumCo
nnections

Specifies the additional SAP connections, up to the specified amount, which the Integration
Appliance opens based on the message load.

maxIdleTim
e

Specifies the number of minutes that a SAP connection can be open and idle before being
closed by the Integration Appliance.

Mapping the outputs of the activity

1. Select the Map Outputs task in the Checklist. The XML Schema generated from return types of the RFC
are displayed as nodes under the request output parameter in the From Activity panel. In addition, if the
RFC contains tables, the XML Schemas representing the tables are displayed as nodes under the request
node in the From Activity.

2. Create a map between the RFC output parameters and tables and orchestration variables. See Creating
a map for general instructions on mapping.

Note about Deploying a SAP Orchestration

Before you can deploy an orchestration with SAP activities using the WMC, the Integration Appliance must first
be able to establish a connection to the SAP System. If the Integration Appliance is unable to establish the
connection to the SAP System, the orchestration is not deployed.
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SAP Receive IDOC activity
Use the SAP Receive IDOC activity to act as a server and listenson the configured SAP endpoint, during run
time. The activity receives an IDOC from the specified SAP endpoint and converts it to XML data. The SAP
Receive IDOC activity is a starter activity.

If you receive your SAP data directly from the SAP system using an RFC port, you must use the SAP Receive
IDOC activity. If you receive your SAP data as a file through a SAP File Port to the SAP system, you must use the
Project > Import > SAP IDOC Schema toolbar menu option during design time to generate a Flat File Schema
for your IDOC metadata and use the Read Flat File activity to read the SAP data. For more information, see
Generating a Flat File Schema from an IDOC.

For the SAP Receive IDOC activity only, you must specify an inbound gateway connection parameters. For more
information, see Creating or editing a SAP endpoint.

In order to connect to the SAP System from Studio, you must download and install the SAP Jar files and DLLs
on your Window's development machine. For more information, see Downloading and installing the SAP Jar
Files and DLLs.

Note: An orchestration that contains an SAP Receive IDOC activity must have persistence enabled. For more
information, see Enabling persistence.

Adding a SAP Receive IDOC activity in the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the SAP folder.
3. Drag the Receive IDOC activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing a SAP endpoint

1. Click Pick Endpoint task from the Checklist and select one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Go to the Configuring the activity procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint panel is displayed.

Create a new endpoint: Select New. The Create Endpoint panel is displayed.
2. Create or Edit a SAP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure panel is displayed.
2. Click Browse....
3. Select an IDOC row and click OK. The Message Type, IDOC Type, and IDOC Extended Type in the

Configure task are populated.

Mapping the outputs of the activity

1. Select the Map Outputs task in the Checklist.
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The output parameter of the activity is displayed in the From Activity panel. The XML Schema generated
from the selected IDOC Type and IDOC Extended Type becomes the output parameter of the activity.

2. Create a map between the IDOC XML Schema and orchestration variables. See Creating a map for
general instructions on mapping.

Note about Deploying a SAP Orchestration

Before you can deploy an orchestration with SAP activities using the Web Management Console, the
Integration Appliance must first be able to establish a connection to the SAP System. If the Integration
Appliance is unable to establish the connection to the SAP System, the orchestration is not deployed.
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SAP Send IDOC activity
Use the SAP Send IDOC activity to send an IDOC to the specified SAP endpoint, during run time.

If you send your SAP data directly to the SAP system using an RFC port, you must use the SAP Send IDOC
activity. If you send your SAP data as a file through a SAP File Port to the SAP system, you must use the Project
> Import > SAP IDOC Schema toolbar menu option during design time to generate a Flat File Schema for your
IDOC metadata and use the Write Flat File activity to write the SAP data. For more information, see Generating
a Flat File Schema from an IDOC.

To connect to the SAP System from Studio, you must download and install the SAP Jar files and DLLs on your
Window's development machine. For more information, see Downloading and installing the SAP Jar Files and
DLLs.

During run time, if the SAP Send IDOC activity processes two instances of an IDOC, where both instances have
the same IDOC number, the SAP Send IDOC activity appends the data segment of the second instance to the
first instance.

Note: An orchestration that contains a SAP Send IDOC activity must have persistence enabled. For more
information, see Enabling persistence.
The steps for adding and configuring a SAP Send IDOC activity to an orchestration are described in the
following procedures:

Adding a SAP Send IDOC activity to the orchestration
Creating, selecting, or editing a SAP endpoint
Configuring the activity
Specifying the retry options
Mapping the inputs of the activity

Adding a SAP Send IDOC activity to the orchestration
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1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the SAP folder.
3. Drag the Send IDOC activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing a SAP endpoint

1. Click Pick Endpoint task from the Checklist and select one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Go to the Configuring the activity procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint panel is displayed.

Create a new endpoint: Select New. The Create Endpoint panel is displayed.
2. Create or Edit a SAP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure panel is displayed.
2. Click Browse....
3. Select an IDOC row and click OK. The Message Type, IDOC Type, and IDOC Extended Type in the

Configure task are populated.

Specifying the retry options

1. Select the Retry task from the Checklist. The Retry panel is displayed.
2. Configure the retry options for connecting to an SAP System. The following table describes the retry

options for connecting to an SAP System:  

Re
try
op
tio
ns Description

1)
Wa
it
__
_
se
co
nd
s
be
tw
ee
n
ea
ch
ret
ry.

Specifies the number of seconds that the Integration Appliance waits before trying to establish a
connection to the SAP System.
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2)
Try
to
co
nn
ect
__
_
ti
me
s
be
for
e
fail
ing
.

Specifies the maximum number of times the Integration Appliance attempts to establish a
connection to the SAP System before issuing an error and stopping the processing of the current
orchestration job. If you deploy an orchestration that contains an SAP Send IDOC activity and the
Integration Appliance cannot connect to the specified SAP System, the Integration Appliance logs
the connections errors as warnings in the system and orchestration logs until the retry count value
is reached. When the retry count is reached, the Integration Appliance logs an error in the system
and orchestration logs and the stops processing the current orchestration job. For example, you
set the retry count to 3. The first, second, and third connection errors appear in the system log as
warnings. The Integration Appliance logs the fourth connection error as an error and stops
processing the current orchestration job.

Mapping the inputs of the activity

1. Select the Map Inputs task in the Checklist. The input parameter of the activity are displayed in the To
Activity panel. The XML Schema generated from selected IDOC Type and IDOC Extended Type becomes
the input parameter of the activity.

2. Right-click the To Activity section and select Show Optional Parameters.

The SAP connector also supports dynamic endpoint connection to a different SAP system. During run
time, add optional parameters in sapConnectionProperties of map inputs, if you want to
dynamically connect to an SAP system other than the one configured in the endpoint panel, if you want
to connect to the same SAP system with a different user name and password other than the fields used
in the endpoint panel, or if you want a different SSO token other than the one added in the endpoint
panel. The parameters of sapConnectionProperties are described in the following table:

Table 1. Connection properties
Optional
parameter Description

sapConnectionProperties parameters

hostName Specifies the IP Address or the machine name that contains the SAP system.

systemNum
ber

Specifies the number that identifies the specific instance of the SAP system that Studio
should connect to. Your SAP administrator must supply this information.

client Specifies a number that identifies Studio and the Integration Appliance as a client for the
SAP system. Your SAP administrator must supply this information.

language Specifies the message language option for SAP. For example, EN is the ISO code for
English.

basicAuthentication parameters

username Specifies the user name to use when connecting to the SAP system.

password Specifies the password to the user name when connecting to the SAP system.

ssoAuthentication parameters

ssotoken Specifies the single sign-on (SSO) token.
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Optional
parameter Description

sncAuthentication parameters

sncmode Specifies if the Secure Network Connections (SNC) mode is enabled.

sncname Specifies the distinguished name of the SNC connection.

partner Specifies the distinguished name of the SNC partner.

qop Specifies the level of security of SNC.

X509
Certificate

Specifies the X509 certificate to be used as the logon ticket. This field is optional only if
Username/Password based authentication is used with SNC.

connectionPool parameters

maximumC
onnections

Specifies the additional SAP connections, up to the specified amount, which the
Integration Appliance opens based on the message load.

maxIdleTim
e

Specifies the number of minutes that a SAP connection can be open and idle before
being closed by the Integration Appliance.

3. Create a map between orchestration variables and the IDOC input parameters and tables. See Creating a
map for general instructions on mapping.

Note about Deploying a SAP Orchestration

Before you can deploy an orchestration with SAP activities using the Web Management Console, the
Integration Appliance must first be able to establish a connection to the SAP System. If the Integration
Appliance is unable to establish the connection to the SAP System, the orchestration is not deployed.
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SAP Receive RFC activity
Use the SAP Receive RFC activity to act as a server and listen on the configured SAP endpoint, during run time.
The activity receives RFC from the specified SAP endpoint and converts it to XML data. The SAP Receive RFC
activity is a starter activity. This activity can be configured in both synchronous and asynchronous mode.

For the SAP Receive RFC activity, you must specify the inbound gateway connection parameters. The Receive
RFC activity accepts requests only from the configured Program ID in the endpoint. For more information see
Creating or editing a SAP endpoint.

To connect to the SAP system from Studio, you must download and install the SAP Jar files and DLLs on your
Window's development machine. For more information, see Downloading and installing the SAP Jar Files and
DLLs.
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Note: An orchestration that contains an SAP Receive RFC activity must have persistence enabled to run in
asynchronous mode. For more information, see Enabling persistence.

Adding a SAP Receive RFC activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the SAP folder.
3. Drag the Receive RFC activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

Creating, selecting, or editing a SAP endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Go to the Configuring the activity procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint panel is displayed.

Create a new endpoint: Select New. The Create Endpoint panel is displayed.
2. Create or Edit a SAP endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure panel is displayed.
2. In the RFC Name field, click Browse.... The RFC List dialog box is displayed.
3. In the RFC Search Pattern field, enter a combination of characters and the * wildcard character to find

the desired RFC name as shown in the following examples:
AB* —Finds all the RFC names that begin with the AB prefix.
AB*TRANSACTION —Finds all the RFC names that begin with the AB prefix and end with the
string: TRANSACTION.

The SAP system is interrogated and the RFC names that match the wildcard expression are listed
in the Matching SAP Functions table.

4. In the Options panel, you can either select the Synchronous mode check box or clear it. The processing
can be handled either synchronously or asynchronously. By default, the Receive RFC activity is
configured to the asynchronous mode.

Synchronous mode - Both SAP and Cast Iron (the SAP Receive RFC activity) must be available
during processing. SAP sends an RFC request to Cast Iron and waits for a response from the
Receive RFC activity.
Asynchronous mode - The SAP Receive RFC activity need not be available when SAP invokes the
function call. SAP sends an RFC request to Cast Iron and does not wait for a response from the
Receive RFC activity.

5. From the Matching SAP Functions table, select one of the SAP Functions and click OK.

Mapping the outputs of the activity

1. Select the Map Outputs task in the Checklist. The output parameter of the activity is displayed in the
From Activity panel. The XML Schema generated from the selected RFC becomes the output parameter
of the activity.
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2. Create a map between the RFC output parameters and tables and orchestration variables. See Creating
a map for general instructions on mapping.

Note about Deploying a SAP Orchestration

Before you can deploy an orchestration with SAP activities using the WMC, the Integration Appliance must first
be able to establish a connection to the SAP System. If the Integration Appliance is unable to establish the
connection to the SAP System, the orchestration is not deployed.
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SAP Send RFC Response activity
The SAP Send RFC Response activity sends a reply back to the sender (SAP) of the SAP Receive RFC request.

The Send RFC Response activity must be used in conjunction with a Receive RFC activity in an orchestration.
If you add a Send RFC Response activity to orchestration, you must select the Synchronous mode check box in
the Configure task of the Receive RFC activity.

Adding a Send RFC Response activity to the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the SAP folder.
3. Drag the Send RFC Response activity onto the orchestration.
4. Select the activity. The Checklist is displayed with the Configure task active in the properties pane. The

properties pane is located below the graphical representation of the orchestration.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
F
i
e
l
d Description
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F
i
e
l
d Description

T
o

Specifies the SAP Receive RFC activity associated with this Send RFC Response activity. During run
time, the associated Receive RFC activity receives the request from SAP, processes the request, and
sends the output to Send RFC Response. The Send RFC Response activity sends the response back
to SAP.
Note: This field gets populated only if you select the Synchronous mode check box in the Configure
task of the SAP Receive RFC activity.
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Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly. This topic
provides potential solutions for issues you would have with the SAP connector.

Getting EDI_DC40 IDOC control record structure with WebSphere Cast Iron SAP
Connector

EDI_DC40 is a standard SAP structure used to store IDoc Control Record for Interface to External System
information. With the SAP connector using non-Unicode SAP server as endpoint in WebSphere Cast Iron Studio
version 7002 for the Receive IDoc and Send IDoc activities, supports Control record name as EDI_DC40.

Customer who are getting the EDI_DC as their standard structure name, are requested to use the latest version
of 7501/7510 Studio and reconfigure the object in their orchestration and map it accordingly.

Older behavior:

With the Old Behavior for non-Unicode machine the control record name was EDI_DC instead of EDI_DC40.

-ALEREQ01  
|_SAPTransactorID  
|_qRECQueueName  
|_IDOC     
 |_@Begin     
 |_EDI_DC         
      |_@Segment         
      |_TABNAM         
      |_MANDT 
……… 
………
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New behavior:

With the new behavior for both Unicode and non-Unicode SAP server, the control record name will be
EDI_DC40.

-ALEREQ01  
|_SAPTransactorID  
|_qRECQueueName  
|_IDOC     
 |_@Begin     
 |_EDI_DC40         
      |_@Segment         
      |_TABNAM         
      |_MANDT 
……… 
………

Dependency JCo Jar files - Version Specific Information

Install and use the latest patch level of the SAP Java Connector 3.0. Latest version of JCo jar available: 3.0.14,
IDoc version 3.0.12.

You need to have these 3 files: sapjco3.jar, sapjco3.dll (for Windows) or sapjco3.so (for Appliance), and
sapidoc3.jar.

For downloading SAP JCo jar (2 files), follow these steps with specific to version:

Download latest the SAP Java Connector 3.0.14 from the SAP Service Marketplace at
http://service.sap.com/connectors. You will find the download package with the latest patch level for
various platform by navigating to SAP Java Connector > Tools & Services > Download SAP JCo Release
3.0. An installation guide is included in the download archive.

For Studio 32 bit Version, download the JCo jar zip file under Microsoft Windows and Windows
Server > 32bit for 32 bit version of WebSphere Cast Iron Studio.
For Studio 64 bit Version, download the JCo jar zip file under Microsoft Windows and Windows
Server > 64bit x86 for 64 bit version of WebSphere Cast Iron Studio.
For WebSphere Cast Iron Appliance, download the JCo jar zip file under Linux (for Intel
compatible processors)> 64bit x86 for Appliance.

For downloading SAP IDoc jar (1 file), follow these steps with specific to version:

Download latest the SAP Java Connector 3.0.14 from the SAP Service Marketplace at
http://service.sap.com/connectors. You will find the download package with the latest patch level for
various platform by navigating to SAP Java Connector > Tools & Services > SAP Java IDoc Class Library.

For all platforms, SAP Java IDoc Class Library 3.0.12 zip file will contain the SAP IDoc jar file.

Exception thrown when trying to browse for IDoc/BAPI/RFC of an orchestration
(new/existing) for 6.1.0.15 studio projects in later studio versions

Problem:

Null point exception is thrown when a 6.1.0.15 studio project is opened in any other later versions of studio and
when a browse for IDoc/BAPI/RFC is done in a new or an existing orchestrations.

Error shown in studio error.log file:

WARNING: Unable to find entry: /.configuration-wizard -- err msg: Unable to locate  
entry 
      /.configuration-wizard java.util.concurrent.ExecutionException: 
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      java.lang.NullPointerException at 
      java.util.concurrent.FutureTask.report(FutureTask.java:134) at 
      java.util.concurrent.FutureTask.get(FutureTask.java:200) at 
      com.approuter.studio.gui.FutureBusyView$1.run(FutureBusyView.java:72) at 
      
java.util.concurrent.ThreadPoolExecutor.runWorker(ThreadPoolExecutor.java:1157) at 
      
java.util.concurrent.ThreadPoolExecutor$Worker.run(ThreadPoolExecutor.java:627) at 
      java.lang.Thread.run(Thread.java:798) Caused by: 
java.lang.NullPointerException at 
      com.approuter.studio.connectors.sap.WSSapConnection.<init>
(WSSapConnection.java:88) at 
      
com.approuter.studio.connectors.sap.endpoint.SapEndpointProjectNode$3.call(SapEndpoi
ntProjectNode.java:345) 
      at 
      
com.approuter.studio.connectors.sap.endpoint.SapEndpointProjectNode$3.call(SapEndpoi
ntProjectNode.java:342) 
      at java.util.concurrent.FutureTask.run(FutureTask.java:274)

Cause:

Enhanced authentication mechanisms in higher versions of Cast Iron Studio.

Solution:

After opening the project in later version of Studio, navigate to any of the respective Endpoints displayed on the
right side of the project tab and come back to the Configure tab of the orchestration.

Now you are enabled with browsing for the IDoc/BAPI/RFC for that orchestration.

Supported formats of the date and time field values

The following table describes the supported formats of the date and time field values for all activities of the
SAP connector:

Table 1. Formats for Date and Time field values
Field Input parameter (non-starter activities) Output parameter (starter and non-starter activities)

Date yyyy-mm-dd

or

yyyymmdd

yyyymmdd

Time hh:mm:ss

or

hhmmss

hhmmss

The supported formats for the input and output parameters of the date and time field values in the SAP
connector version 6.0.x and earlier versions are: yyyy-mm-dd and hh:mm:ss, respectively.

Exception thrown when you deploy orchestrations with Receive RFC and Receive
IDOC activities using the same RFC Program ID

Problem: When you deploy orchestrations with Receive RFC and Receive IDOC activities with the same SAP
RFC Program ID, the following exception is thrown:
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java.lang.RuntimeException: An attempt to start a JCoIDocServer failed. There might 
be an existing JCoServer with the same server configuration, else try restarting 
your server 
at 
com.ibm.j2ca.sap.inbound.SapJCoServerBuilder.verfiyServerConfiguration(SapJCoServerB
uilder.java:403) 
at 
com.ibm.j2ca.sap.inbound.SapJCoServerBuilder.createServer(SapJCoServerBuilder.java:9
6) 
at 
com.ibm.j2ca.sap.inbound.SAPEventListenerManager.buildEventListener(SAPEventListener
Manager.java:149) 
at 
com.ibm.j2ca.sap.inbound.SAPEventListenerManager.startEventListeners(SAPEventListene
rManager.java:132) 
at com.ibm.j2ca.sap.inbound.EndpointManager.addEndpoint(EndpointManager.java:68) 
at 
com.ibm.j2ca.sap.SAPResourceAdapter.endpointActivation(SAPResourceAdapter.java:266) 
at 
com.approuter.module.sap.activity.ReceiveIDOCActivity.activate(ReceiveIDOCActivity.j
ava:222) 
at com.approuter.maestro.activities.BaseModule.activate(BaseModule.java:296) 
at com.approuter.maestro.vm.Program.start(Program.java:796) 
at com.approuter.maestro.vm.Kernel.startOrchestration(Kernel.java:704) 
at com.approuter.maestro.management.Loader$1.run(Loader.java:461) 
at java.lang.Thread.run(Thread.java:736)

Cause: SAP JCo allows only one instance of JCoServer with a given set of server configuration to run within a
Java virtual machine (JVM); another JCoServer with same server configuration cannot run in the same JVM.
JCo throws an error indicating that the server cannot be restarted. The Receive IDOC activity and Receive RFC
activity do not support the same SAP Program ID used during orchestration.

Solution: Ensure that you deploy orchestrations having Receive RFC and Receive IDOC activities using different
SAP Program IDs, and create separate end points for IDOC/RFC.

Recommended configurations to avoid 'Maximum number of 202 conversations
exceeded' error

When working with the SAP connector, the following are the recommended configurations to be done if the
'Maximum number of 202 conversations exceeded' error is displayed:

Error:

LOCATION   CPIC (TCP/IP) on local host with Unicode 
ERROR      max no of 202 conversations exceeded 
TIME       <Day> <Date> <Time> <Year> 
RELEASE    720 
COMPONENT  CPIC (TCP/IP) with Unicode

The following recommendations depend on the load and the number of parallel requests:

1. Reduce the timeout value in the endpoint configuration so that the unused connections are terminated
automatically.

2. Configure Cast Iron runtime and SAP gateway to support more RFC connections.
a. Set the environment value CPIC_MAX_CONV to >100 on Cast Iron runtime. Update maestro.sh

to set the environment variable. The steps are described in Schedule A.
b. Increase the profile value gw/max_conn and gw/max_sys on the SAP gateway to support many

parallel connections. Also, if you run into memory bottlenecks increase the values of
gw/max_overflow_size and gw/max_shm_req.
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c. Set maximum connections value in SAP endpoint to a realistic value. Depending on the load and
parallel requests, appliance either generates or receives.

d. Set the number of Server Instance value in SAP endpoint to 10.
3. Sample Values:

SAP-Gateway 
gw/max_conn=2000, gw/max_sys=1200 
gw/max_overflow_size =40000000, gw/max_shm_req = 200 (this is to adjust the 
memory allocation) 
CPIC_MAX_CONV=5000

Schedule A:

1. Log on into the appliance shell (contact IBM support to get appliance shell key in order to log on to the
system shell).

2. Go to the /usr/ironhide/bin folder. Take a back up of maestro.sh (copy maestro.sh to
maestro.sh.old).

3. Edit maestro.sh.

move to line  
#  Version of java currently in use. 
if [ -z $JAVA_HOME ]; then 
  JAVA_HOME=/usr/java/default 
fi 
JAVA="${JAVA_HOME}/bin/java"

4. Add the following line:

## maximum SAP conversations allowed 
export CPIC_MAX_CONV=500

5. Save and exit.
6. Exit system shell and run the command system restart in order to restart the appliance runtime.

Upgrading JRE from 32 bit to 64 bit

Problem: If you have an SAP project running on an earlier version of the appliance, when you upgrade the
appliance to version 7.0 or later, the SAP projects will not start and the following errors occur:

Examples of errors thrown in WMC:

Start of Orchestration config- 
url://SAP_BAPI/1.0/Default/Orchestrations/Orchestration failed: 
java.lang.ExceptionInInitializerError: Error 
getting the version of the native layer: 
java.lang.UnsatisfiedLinkError: sapjco3 
(/usr/ironhide/lib/thirdparty/libsapjco3.so: 
wrong ELF class: ELFCLASS32).

Required SAP JCO library is not found. 
Install version 3.x SAP JCO library (.dll or .so based on platform)

Examples of exceptions recorded in the maestro.out log:

java.lang.UnsatisfiedLinkError: sapjco3 
(/usr/ironhide/lib/thirdparty/libsapjco3.so: wrong ELF class: ELFCLASS32) 
 at java.lang.ClassLoader.loadLibraryWithPath(ClassLoader.java:1030) 
 at 
java.lang.ClassLoader.loadLibraryWithClassLoader(ClassLoader.java:994) 
 at java.lang.System.loadLibrary(System.java:507) 
 at 
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com.sap.conn.jco.rt.DefaultJCoRuntime.loadLibrary(DefaultJCoRuntime.java:481) 
 at 
com.sap.conn.jco.rt.DefaultJCoRuntime.registerNativeMethods(DefaultJCoRuntime.j
ava:347) 
 at com.sap.conn.jco.rt.JCoRuntime.registerNatives(JCoRuntime.java:1108) 
 at com.sap.conn.rfc.driver.CpicDriver.<clinit>(CpicDriver.java:954) 
 at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at 
com.sap.conn.rfc.engine.DefaultRfcRuntime.getVersion(DefaultRfcRuntime.java:43) 
 at com.sap.conn.rfc.api.RfcApi.RfcGetVersion(RfcApi.java:237) 
 at com.sap.conn.jco.rt.MiddlewareJavaRfc.<clinit>
(MiddlewareJavaRfc.java:215) 
 at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at 
com.sap.conn.jco.rt.DefaultJCoRuntime.initialize(DefaultJCoRuntime.java:77) 
 at com.sap.conn.jco.rt.JCoRuntimeFactory.<clinit>
(JCoRuntimeFactory.java:23) 
 at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at java.lang.Class.forNameImpl(Native Method) 
 at java.lang.Class.forName(Class.java:182) 
 at com.sap.conn.jco.JCo.createJCo(JCo.java:52) 
 at com.sap.conn.jco.JCo.<clinit>(JCo.java:26) 
 at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at java.lang.Class.forNameImpl(Native Method) 
 at java.lang.Class.forName(Class.java:182) 
 at 
com.approuter.module.sap.SAPActivator.checkSAPInstalled(SAPActivator.java:101) 
 at 
com.approuter.module.sap.activity.SAPBaseActivity.checkSapSetup(SAPBaseActivity
.java:498) 
 at 
com.approuter.module.sap.activity.SAPBaseActivity.generateSchemas(SAPBaseActivi
ty.java:172) 
 at 
com.approuter.module.sap.activity.SapSendRfcData.activate(SapSendRfcData.java:1
12) 
 at 
com.approuter.maestro.activities.BaseModule.activate(BaseModule.java:301) 
 at com.approuter.maestro.vm.Program.start(Program.java:768) 
 at com.approuter.maestro.vm.Kernel.startOrchestration(Kernel.java:739) 
 at com.approuter.maestro.management.Loader$1.run(Loader.java:455) 
 at java.lang.Thread.run(Thread.java:738) 
java.lang.ExceptionInInitializerError: Error getting the version of the native 
layer: java.lang.UnsatisfiedLinkError: sapjco3 
(/usr/ironhide/lib/thirdparty/libsapjco3.so: wrong ELF class: ELFCLASS32) 
 at com.sap.conn.jco.rt.MiddlewareJavaRfc.<clinit>(MiddlewareJavaRfc.java:227) 
 at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at 
com.sap.conn.jco.rt.DefaultJCoRuntime.initialize(DefaultJCoRuntime.java:77) 
 at com.sap.conn.jco.rt.JCoRuntimeFactory.<clinit>(JCoRuntimeFactory.java:23) 
 at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at java.lang.Class.forNameImpl(Native Method) 
 at java.lang.Class.forName(Class.java:182) 
 at com.sap.conn.jco.JCo.createJCo(JCo.java:52) 
 at com.sap.conn.jco.JCo.<clinit>(JCo.java:26) 
at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at java.lang.Class.forNameImpl(Native Method) 
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 at java.lang.Class.forName(Class.java:182) 
 at 
com.approuter.module.sap.SAPActivator.checkSAPInstalled(SAPActivator.java:101) 
 at 
com.approuter.module.sap.activity.SAPBaseActivity.checkSapSetup(SAPBaseActivity
.java:498) 
 at 
com.approuter.module.sap.activity.SAPBaseActivity.generateSchemas(SAPBaseActivi
ty.java:172) 
 at 
com.approuter.module.sap.activity.SapSendRfcData.activate(SapSendRfcData.java:1
12) 
 at 
com.approuter.maestro.activities.BaseModule.activate(BaseModule.java:301) 
 at com.approuter.maestro.vm.Program.start(Program.java:768) 
 at com.approuter.maestro.vm.Kernel.startOrchestration(Kernel.java:739) 
 at com.approuter.maestro.management.Loader$1.run(Loader.java:455) 
 at java.lang.Thread.run(Thread.java:738) 
2013-08-22 09:18:25.013 SEVERE [T-10] 
[orc:SAP_BAPI/1.0/Default/Orchestrations/Orchestration] 
[com.approuter.module.common.util.LogHelper] Required SAP JCO native library is 
not found. Install version 3.x SAP JCO native library(.dll or .so based on 
platform). 
java.lang.RuntimeException: java.lang.ExceptionInInitializerError: Error 
getting the version of the native layer: java.lang.UnsatisfiedLinkError: 
sapjco3 (/usr/ironhide/lib/thirdparty/libsapjco3.so: wrong ELF class: 
ELFCLASS32) 
 at 
com.approuter.module.sap.activity.SAPBaseActivity.checkSapSetup(SAPBaseActivity
.java:509) 
 at 
com.approuter.module.sap.activity.SAPBaseActivity.generateSchemas(SAPBaseActivi
ty.java:172) 
 at 
com.approuter.module.sap.activity.SapSendRfcData.activate(SapSendRfcData.java:1
12) 
 at 
com.approuter.maestro.activities.BaseModule.activate(BaseModule.java:301) 
 at com.approuter.maestro.vm.Program.start(Program.java:768) 
 at com.approuter.maestro.vm.Kernel.startOrchestration(Kernel.java:739) 
 at com.approuter.maestro.management.Loader$1.run(Loader.java:455) 
 at java.lang.Thread.run(Thread.java:738) 
Caused by: java.lang.ExceptionInInitializerError: Error getting the version of 
the native layer: java.lang.UnsatisfiedLinkError: sapjco3 
(/usr/ironhide/lib/thirdparty/libsapjco3.so: wrong ELF class: ELFCLASS32) 
 at com.sap.conn.jco.rt.MiddlewareJavaRfc.<clinit>(MiddlewareJavaRfc.java:227) 
 at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at 
com.sap.conn.jco.rt.DefaultJCoRuntime.initialize(DefaultJCoRuntime.java:77) 
 at com.sap.conn.jco.rt.JCoRuntimeFactory.<clinit>(JCoRuntimeFactory.java:23) 
 at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at java.lang.Class.forNameImpl(Native Method) 
 at java.lang.Class.forName(Class.java:182) 
 at com.sap.conn.jco.JCo.createJCo(JCo.java:52) 
 at com.sap.conn.jco.JCo.<clinit>(JCo.java:26) 
 at java.lang.J9VMInternals.initializeImpl(Native Method) 
 at java.lang.J9VMInternals.initialize(J9VMInternals.java:200) 
 at java.lang.Class.forNameImpl(Native Method) 
 at java.lang.Class.forName(Class.java:182) 
 at 
com.approuter.module.sap.SAPActivator.checkSAPInstalled(SAPActivator.java:101) 
 at 

584   



com.approuter.module.sap.activity.SAPBaseActivity.checkSapSetup(SAPBaseActivity
.java:498)

Cause:

In the earlier versions of Cast Iron appliance (version 6.4 and earlier versions), 32 bit SAP JCo libraries were
used. From Cast Iron appliance version 7.0 onwards, you must use the 64 bit SAP JCo libraries.

Solution:

You need to delete the 32 bit SAP JCo libraries, sapjco3.jar and libsapjco3.so, and load the 64 bit SAP
JCo libraries.

Upgrading SAP JCo libraries:

In case of any issue after applying 64 bit JCo libraries, contact IBM Technical Support for further assistance.

Exception thrown when SAP server Host name is not correct

Problem: When SAP server Host Name is not correct, the below exception is thrown in JCo trace

Error: >Thu Jul 16 15:08:00,483< RfcException: 
 Message: Connect to SAP gateway failed 
Connection parameters: TYPE=A DEST=9.184.167.114|100|dev0028.492965 
ASHOST=9.184.167.114 SYSNR=10 CODEPAGE=1100 PCS=1 
LOCATION CPIC (TCP/IP) on local host with Unicode 
ERROR partner '9.184.167.114:3310' not reached 
TIME Thu Jul 16 15:08:00 2015 
RELEASE 721 
COMPONENT NI (network interface) 
VERSION 40 
RC -10 
MODULE nixxi.cpp 
LINE 3283 
DETAIL NiPConnect2:9.184.167.114:3310 
SYSTEM CALL connect 
ERRNO 10060 
ERRNO TEXT WSAETIMEDOUT: Connection timed out 
COUNTER 2 
 return code: RFC_FAILURE (1) 
 error group: 102 
 key: RFC_ERROR_COMMUNICATION

Exception thrown when SAP system number is not correct

Problem: When SAP system number is not correct, the below exception is thrown in JCO trace

Error: >Thu Jul 16 15:21:40,738< RfcException: 
 message: Connect to SAP gateway failed 
Connection parameters: TYPE=A DEST=9.184.167.115|100|dev0028.741310 
ASHOST=9.184.167.115 SYSNR=15 CODEPAGE=1100 PCS=1 
LOCATION CPIC (TCP/IP) on local host with Unicode 
ERROR partner '9.184.167.115:3315' not reached 
TIME Thu Jul 16 15:21:40 2015 
RELEASE 721 
COMPONENT NI (network interface) 
VERSION 40 
RC -10 
MODULE nixxi.cpp 
LINE 3283 
DETAIL NiPConnect2: 9.184.167.115:3315 
SYSTEM CALL connect 
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ERRNO 10061 
ERRNO TEXT WSAECONNREFUSED: Connection refused 
COUNTER 2 
 return code: RFC_FAILURE (1) 
 error group: 102 
 key: RFC_ERROR_COMMUNICATION 

Exception thrown when SAP client is not correct

Problem: When SAP client is not correct, the below exception is thrown

Error log shows as below:

Jul 16, 2015 3:25:21 PM com.ibm.j2ca.sap.SAPManagedConnection getJcoConnection 
SEVERE: CWYAP1019E: An exception occurred while connecting to the SAP system. Error 
message: Initialization of destination 9.184.167.115|000|dev0028.145604 failed: Name 
or password is incorrect (repeat logon) on 9.184.167.115 sysnr 10 Explanation=An 
exception occurred while making the connection to the SAP application. The adapter 
cannot connect using the logon credentials that have been provided. UserAction=Refer 
to the exception message for more details. 
Jul 16, 2015 3:25:21 PM 
com.approuter.studio.connectors.sap.endpoint.SapEndpointPanel testConnection2 
SEVERE: Unable to connect to the endpoint. Please check the endpoint's information 
and try again. Detail: com.ibm.j2ca.base.exceptions.AuthenticationFailException: 
Initialization of destination 9.184.167.115|000|dev0028.145604 failed: Name or 
password is incorrect (repeat logon) on 9.184.167.115 sysnr 10

JCO trace shows as below:

<* RfcReceive >Thu Jul 16 15:25:21,155< failed *> 
>>>> [1] <unknown> R/3 <ac: 6> >>> CLOSE (45412733) 
RfcException raised by system [SD1|eccdev1]: 
 message: Name or password is incorrect (repeat logon) 
 return code: RFC_SYS_EXCEPTION (3) 
 error group: 104 
 key: RFC_ERROR_SYSTEM_FAILURE*> RfcReceive ...  
 handle = 1 
 parameter = <null>  
 parameter = <null>  
 tables = <null>   
>>> RfcClose [1] >Thu Jul 16 15:25:21,158< ...

Exception thrown when SAP User Name is not correct

Problem: When SAP server user name is not correct, the below exception is thrown

Error log shows as below:

Jul 16, 2015 3:33:09 PM com.ibm.j2ca.sap.SAPManagedConnection getJcoConnection 
SEVERE: CWYAP1019E: An exception occurred while connecting to the SAP system. Error 
message: Initialization of destination 9.184.167.115|100|cev0028.789483 failed: Name 
or password is incorrect (repeat logon) on 9.184.167.115 sysnr 10 Explanation=An 
exception occurred while making the connection to the SAP application. The adapter 
cannot connect using the logon credentials that have been provided. UserAction=Refer 
to the exception message for more details. 
Jul 16, 2015 3:33:09 PM 
com.approuter.studio.connectors.sap.endpoint.SapEndpointPanel testConnection2 
SEVERE: Unable to connect to the endpoint. Please check the endpoint's information 
and try again. Detail: com.ibm.j2ca.base.exceptions.AuthenticationFailException: 
Initialization of destination 9.184.167.115|100|cev0028.789483 failed: Name or 
password is incorrect (repeat logon) on 9.184.167.115 sysnr 10
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JCO trace shows as below:

<* RfcReceive >Thu Jul 16 15:33:08,861< failed *> 
>>>> [1] <unknown> R/3 <ac: 6> >>> CLOSE (45885421) 
RfcException raised by system [SD1|eccdev1]: 
 message: Name or password is incorrect (repeat logon) 
 return code: RFC_SYS_EXCEPTION (3) 
 error group: 104 
 key: RFC_ERROR_SYSTEM_FAILURE*> RfcReceive ...  
 handle = 1 
 parameter = <null>  
 parameter = <null>  
 tables = <null>  
>>> RfcClose [1] >Thu Jul 16 15:33:08,863< ... 
<* RfcClose *>

Exception thrown when SAP Server Password is not correct

Problem: When SAP server password is not correct, the below exception is thrown

Error log shows as below:

Jul 16, 2015 3:40:13 PM com.ibm.j2ca.sap.SAPManagedConnection getJcoConnection 
SEVERE: CWYAP1019E: An exception occurred while connecting to the SAP system. Error 
message: Initialization of destination 9.184.167.115|100|dev0028.879503 failed: Name 
or password is incorrect (repeat logon) on 9.184.167.115 sysnr 10 Explanation=An 
exception occurred while making the connection to the SAP application. The adapter 
cannot connect using the logon credentials that have been provided. UserAction=Refer 
to the exception message for more details. 
Jul 16, 2015 3:40:13 PM 
com.approuter.studio.connectors.sap.endpoint.SapEndpointPanel testConnection2 
SEVERE: Unable to connect to the endpoint. Please check the endpoint's information 
and try again. Detail: com.ibm.j2ca.base.exceptions.AuthenticationFailException: 
Initialization of destination 9.184.167.115|100|dev0028.879503 failed: Name or 
password is incorrect (repeat logon) on 9.184.167.115 sysnr 10

JCO trace shows as below:

>>>> [1] <unknown> R/3 <ac: 6> >>> CLOSE (46318530) 
RfcException raised by system [SD1|eccdev1]: 
 message: Name or password is incorrect (repeat logon) 
 return code: RFC_SYS_EXCEPTION (3) 
 error group: 104 
 key: RFC_ERROR_SYSTEM_FAILURE*> RfcReceive ...  
 handle = 1 
 parameter = <null>  
 parameter = <null>  
 tables = <null>  
 >>> RfcClose [1] >Thu Jul 16 15:40:13,842< ... 
 <* RfcClose *>

Parent topic: SAP activities
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ServiceMax activities
Creating or editing a ServiceMax endpoint
ServiceMax endpoints provide information that Studio and the Integration Appliance use to connect to a
ServiceMax instance.
Configuring ServiceMax activities
Selecting fields from the ServiceMax object to map is one of the tasks you must complete to configure a
ServiceMax activity. For more information about the configuration tasks in the Checklist, see the help
topic for the specific ServiceMax activity.
Setting ServiceMax configuration properties
Any changes you make to configuration properties affects all orchestrations that use that endpoint. The
edits are global, not local.
Specifying the Retry and Time Out parameters for ServiceMax activities
Specifying the Retry and Time Out parameters is one of the tasks you must complete to configure a
ServiceMax activity. The ServiceMax Connector uses an HTTP 1.1 persistent connection over SSL to
make all connections to the ServiceMax server. The ServiceMax connector compresses all data for
requests and responses using the gzip format.
Understanding and setting polling preferences for the ServiceMax connector
Poll Updated Objects activity
This activity polls the ServiceMax Server for objects that have been recently created or updated and
returns all the object fields that you selected in the configuration panel to the Integration Appliance. In
Studio, configure the polling interval for the activity.
Get Updated Objects
Poll Deleted Objects activity
This activity polls the ServiceMax Server for objects that have been recently deleted and returns IDs to
the Integration Appliance.
Get Deleted Objects
This activity retrieves the list of individual objects that have been deleted within the specified time-span
for the specified object.
Create Objects activity
Use this activity to create one or more ServiceMax objects. In the Activities tab, open the ServiceMax
directory to find the Create Objects activity.
Update Objects activity
Use this activity to update existing objects in ServiceMax.
Upsert Objects activity
Use this activity to update existing objects or create new objects in ServiceMax.
Delete Objects activity
Use this activity to delete one or more objects in ServiceMax. While the Salesforce.com API limits the
number of objects that it can delete in a single call to 200 objects, the Cast Iron® ServiceMax connector
does not have such a limit. You can use the Delete Objects activity to delete an unlimited number of
objects.
Undelete Objects activity
Retrieve Objects activity
Use this activity to retrieve one or more ServiceMax objects of a specified type. While the Salesforce.com
API limits the number of objects that it can retrieve in a single call to 2,000 objects, the Cast Iron
ServiceMax connector does not have such a limit. You can use the Retrieve Objects activity to retrieve
an unlimited number of objects.
Query Objects activity
Use the Sforce Object Query Language (SOQL) to run a query on one or more Salesforce.com object
types from this activity and return a results set. The Query Objects activity automatically runs a query or
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queryAll call, followed by continuous queryMore calls for all children and objects returned from
Salesforce.com.
Configuring the Query Objects activity
You must create a Sforce Object Search Language (SOSL) query to configure the Search Objects activity.
The following sections discuss the steps to configure the Search Objects activity, create an SOSL query,
and provide SOSL syntax rules for IBM® Cast Iron.
Search Objects activity
Configuring the Search Objects activity
You must create an Sforce Object Search Language (SOSL) query to configure the Search Objects
activity.
Convert Lead activity
Use this activity to convert leads into accounts, contacts, or opportunities in ServiceMax. While the
Salesforce.com API limits the number of objects that it can convert in a single call to 100 objects, the
Cast Iron ServiceMax connector does not have such a limit. You can use the Convert Lead activity to
convert an unlimited number of objects.
Merge Objects Activity
Use this activity to merge ServiceMax objects into a single record.
Get User Information activity
Use this activity to get user information from the ServiceMax server. In the Activities tab, open the
ServiceMax directory to find the Get User Information activity.
Get Server Timestamp activity
Use this activity to get the current time from the ServiceMax server. In the Activities tab, open the
ServiceMax directory to find the Get Server Timestamp activity.
Send email activity
Use this activity to send single or multiple emails. The emails include all standard email attributes such
as the email address, subject line, and carbon copies.
Set password activity
Use this activity to change the password of a user or SelfServiceUser to a value that you specify.
Reset password activity
Use this activity to reset the password of the user to a system-generated value.
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 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/toc_servicemaxactivities.html

Creating or editing a ServiceMax endpoint
ServiceMax endpoints provide information that Studio and the Integration Appliance use to connect to a
ServiceMax instance.

About this task

Any changes that you make to the endpoint, including configuration properties, affects all orchestrations that
use that endpoint as the edits are global, not local.

Procedure
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1. Drag an activity from the ServiceMax folder of the Activities tab onto the orchestration.

The Summary panel is displayed along with a Checklist, which lists the tasks that you must perform to
configure the activity.

2. Click Pick Endpoint task from the Checklist. The Pick Endpoint panel opens.
3. Click one of the following options:

Browse...: To select an existing endpoint from the Project Explorer. The Project Explorer shows all
the endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel. To edit the endpoint properties, click Edit. Go
to step 5
New: To create a new endpoint. The Create Endpoint window opens. Go to step 5
Edit: To edit an existing endpoint. The Edit Endpoint window opens. Go to step 5

Note: Editing an endpoint affects all orchestrations that use that endpoint in the project as the edits are
global, not local.

4. In the endpoint window, specify a user name and a password to access a ServiceMax instance.
a. Type a user name or click the icon to the right of the User Name field to select the configuration

property.
b. Type a password or click the icon to the right of the Password field to select the configuration

property.
5. Choose a login option:

Login Options Description

Login normally By default, Login is selected. At run time, the Integration Appliance accesses a
production instance of ServiceMax.

Login to ServiceMax
sandbox

At run time, the Integration Appliance accesses a copy of the production
system. You can run tests in the sandbox without affecting production data.

Login to specified
Partner WSDL Login
URL

At run time, the Integration Appliance accesses the URL you specify in the
Login URL field.

Login URL Only required when you choose the Login to specified Partner WSDL Login URL
option.

6. Specify the Connection Timeout parameter. By default, the Integration Appliance times out if it is unable
to connect to the ServiceMax endpoint after 300 seconds.

7. To connect through a proxy server, complete the fields that are described in the following table:

Opt
ion Description

Co
nne
ct
via
a
Pro
xy
Ser
ver

Select this check box to enable the fields to connect through a proxy server.

590   



Opt
ion Description

Aut
hen
tica
tio
n

Indicates the type of authentication that the Integration Appliance uses when connecting to a
proxy server. From the list, select one of the following authentication options:

Basic - Sends the user name and password you specify unencrypted to the server. This
authentication schema is the least secure.
NTLM - Requires an instance of NTCredentials to be available for the domain name of the
server. This authentication is the most secure authentication option. When you choose the
NTLM authentication option, the Integration Appliance authenticates a connection and not
a request; therefore, the Integration Appliance authenticates every time that a new
connection is made. The connection must remain open during the authentication process.
You cannot use NTLM to authenticate with both a proxy and server.

Rea
lm/
Do
mai
n

If you select the Basic authentication option, specify a realm. If you select the NTLM
authentication option, specify a domain.

Hos
t
na
me

Specify the host name of the proxy server.

Por
t

Specify the port number that is required to connect to the proxy server.

Use
r
na
me

Specify the user name that is required to connect to the proxy server.

Pas
sw
ord

Specify the password that is required to connect to the proxy server.

8. Click Test Connection to confirm that the parameters you specified allow the project to access a
ServiceMax instance.
Note: When you configure a ServiceMax endpoint to use configuration properties, verify that the
configuration properties have valid values. If the configuration property value is invalid or does not exist,
the connection test fails.

Parent topic: ServiceMax activities
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Configuring ServiceMax activities
Selecting fields from the ServiceMax object to map is one of the tasks you must complete to configure a
ServiceMax activity. For more information about the configuration tasks in the Checklist, see the help topic for
the specific ServiceMax activity.

About this task

For some of the fields in the endpoint, you can create configuration properties to supply the values for these
fields. An icon is displayed when you click in a field that supports a configuration property and a configuration
property of the same type has already been configured for the project.

Procedure

1. In the Checklist, select Configure. The Configure panel opens.
2. Click Browse... to select a ServiceMax object type. The Choose a ServiceMax Object window shows all

the ServiceMax objects that are associated with the Studio activity.
3. Select an object type from the list.

Note: Custom object types end with a double underscore c ( __c ). For example: CustomerPriority__c

Enter a character or string in the Search for an Object Type field and Studio filters the object types and
only shows the object types that match the filter criteria. (Optional) Click the refresh icon to retrieve the
latest ServiceMax object types.

4. Click OK.

All the fields that are associated with the object type you selected are displayed.

5. In the Object Field Preferences section, select the fields to map.

By default, all fields are selected. You can choose to clear any field that you do not want to show in the
map. A global check box allows you to select and clear all fields at once.

Note: The Id field is required for many activities. For these activities, the Id field is disabled and you
cannot clear this field.

Parent topic: ServiceMax activities
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Setting ServiceMax configuration properties
Any changes you make to configuration properties affects all orchestrations that use that endpoint. The edits
are global, not local.

592   



Procedure

1. Select Project > Configuration Properties. The Configuration Properties window opens.
2. Click the Value field for the servicemax_password property and type a valid password.
3. Click the Value field for the servicemax_login property and type a valid ServiceMax login.
4. Click OK.

Parent topic: ServiceMax activities
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Specifying the Retry and Time Out parameters for ServiceMax
activities

Specifying the Retry and Time Out parameters is one of the tasks you must complete to configure a ServiceMax
activity. The ServiceMax Connector uses an HTTP 1.1 persistent connection over SSL to make all connections
to the ServiceMax server. The ServiceMax connector compresses all data for requests and responses using the
gzip format.

About this task

The ServiceMax connector uses a single login session for all connections to a ServiceMax endpoint. If a session
expires, the connector automatically establishes a new session. The ServiceMax connector does not count the
initial attempt to reacquire the session as a retry attempt. The ServiceMax connector assumes the typical
connector retry behavior after the initial attempt to reacquire a session fails.

For more information about the configuration tasks in the Checklist, see the help topic for the specific
ServiceMax activity.

Procedure

1. In the Checklist, select Retry. The Retry panel opens.
2. Configure the retry options for connecting to a ServiceMax instance.

The following table describes the retry options for connecting to a ServiceMax instance:

Retry fields Description

Wait __ seconds between
each retry.

Specifies the number of seconds that the Integration Appliance waits
before trying to establish a connection to the ServiceMax instance.

By default, this parameter is set to 30 seconds.
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Retry fields Description

Try to connect __ times
before failing.  

Specifies the maximum number of times that the Integration Appliance
attempts to establish a connection to the ServiceMax instance before
issuing an error and stopping the processing of the current orchestration
job.

By default this parameter is set to 5 attempts.

Activity Timeout field Description

Time out after __
seconds when the
Endpoint does not
respond to a request.

Specifies the number of seconds before a time-out occurs between the
activity making a request on an endpoint and the time it takes the endpoint
to respond.

By default this parameter is set to 300 seconds.

Parent topic: ServiceMax activities
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Understanding and setting polling preferences for the
ServiceMax connector

About this task

The ServiceMax connector contains two activities that poll the ServiceMax server for changes:

Poll Deleted Objects activity
Poll Updated Objects activity

These activities have the following startup behavior:

For an orchestration that has never been deployed, the baseline time stamp is established when the
activity is activated for the first time. The activity uses the baseline time stamp as the start time to poll
for changes after the poll interval elapses. After the poll completes, the activity stores the last poll time.
For a previously deployed orchestration, the activity uses the last poll time and the current time to poll
for changes after the poll interval elapses.
ServiceMax requires at least 60 seconds between each poll. If less than 60 seconds have transpired,
then the activity ignores the current polling interval until the next polling interval elapses.

Procedure

1. In the Checklist, select Polling.
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The Polling Preferences panel opens.

2. Set the polling preferences for the following parameters:

Polling Preference Description

Poll for changes every
<i>

Where <i> is the polling
interval. The interval can
be specified in minutes,
hours, or days

Specifies the polling interval for which the Integration Appliance polls the
ServiceMax Server for objects that have been created or updated since the
last poll.

By default, the Integration Appliance polls the ServiceMax Server every 5
minutes.

Batch up to <n> objects
per orchestration

Where <n> is the number
of objects in a batch.

Specifies the maximum number of object records per orchestration job,
during a polling interval. By default, the Integration Appliance processes
one record per orchestration job. Use this preference to tune the
performance of the Integration Appliance.

Parent topic: ServiceMax activities
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Poll Updated Objects activity
This activity polls the ServiceMax Server for objects that have been recently created or updated and returns all
the object fields that you selected in the configuration panel to the Integration Appliance. In Studio, configure
the polling interval for the activity.

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Poll Updated Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

4. Configure the activity by choosing a ServiceMax object type and object field preferences.
5. Specify the Polling preferences for the activity.
6. Specify the Retry and Time out parameters for the activity.

What to do next
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Map the output of the Poll Updated Objects activity.
Parent topic: ServiceMax activities

Mapping the output of the Poll Updated Object activity

Procedure

1. In the Checklist, select Map Outputs.

The objects element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

The output map can have nillable field elements have the following behavior:
If the field that is being retrieved is null, the Integration Appliance sets the xsi:nil attribute to
true in the result.
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Get Updated Objects

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Get Updated Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

4. Configure the activity, by choosing a ServiceMax object type and object field preferences.
You can only select object types and fields that the Integration Appliance can update. The input map
contains the object type with elements that correspond to the fields you select during this configuration
step.
Note: The Integration Appliance cannot create auto-number fields.

5. Specify the Retry and Time out parameters for the activity.
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6. Map the input of the activity.

The input map consists of an object's input parameter. This parameter consists of a single root element
that has a single repeating element, named after the object type you selected, containing all the fields
you selected in the Object Field Preferences table.

What to do next

Map the input of the Get Updated Objects.
Parent topic: ServiceMax activities

Mapping the input of the Get Updated Objects activity

Procedure

1. In the Checklist, select Map Inputs.

The startDateTime element is displayed in the To Activity panel.

2. Optional: Right-click the default node and choose Show Optional Parameters, to show the optional input
parameters for this activity:

endDateTime
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Optional and nillable field elements have the following behavior:
The Integration Appliance does not update an optional field, when the ServiceMax server does
not provide a value for the field.
If you set the xsi:nilattribute to true on a nillable field, the Integration Appliance sets the
field to null during an update.
Note: Setting a field to an empty string does not set a field to null.

What to do next

Map the output of the Get Updated Object activity.

Mapping the output of the Get Updated Object activity

Procedure

1. In the Checklist, select Map Outputs.

The saveResults element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.
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3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.
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Poll Deleted Objects activity
This activity polls the ServiceMax Server for objects that have been recently deleted and returns IDs to the
Integration Appliance.

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Poll Deleted Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

4. Configure the activity by choosing a ServiceMax object type and object field preferences.
5. Specify the Polling preferences for the activity.
6. Specify the Retry and Time out parameters for the activity.

What to do next

Map the output of the Poll Deleted Object activity.
Parent topic: ServiceMax activities

Mapping the output of the Poll Deleted Object activity

Procedure

1. In the Checklist, select Map Outputs.

The objects element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.
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For mapping instructions, see Creating a Map.

The output map can have nillable field elements have the following behavior:
If the field being retrieved is null, the Integration Appliance sets the xsi:nil attribute to true in
the result.
If the input ID is not valid or does not represent the object type that you specified, then for the
entire object element the Integration Appliance sets xsi:nil to true, for that element's position
in the result set.
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Get Deleted Objects
This activity retrieves the list of individual objects that have been deleted within the specified time-span for the
specified object.

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Get Delete Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

4. Specify the Retry and Time out parameters for the activity.

What to do next

Map the input of the Get Deleted Objects activity.
Parent topic: ServiceMax activities

Mapping the input of the Get Deleted Objects activity

Procedure

1. In the Checklist, select Map Inputs.

The startDateTime element is displayed in the To Activity panel.
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2. Optional: Right-click the default node and choose Show Optional Parameters, to show the optional input
parameters for this activity:

endDateTime
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

What to do next

Map the output of the Get Deleted Objects activity.

Mapping the output of the Get Deleted Object activity

Procedure

1. In the Checklist, select Map Outputs.

The deleteResults element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.
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Create Objects activity
Use this activity to create one or more ServiceMax objects. In the Activities tab, open the ServiceMax directory
to find the Create Objects activity.

Procedure

1. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.
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2. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

3. Configure the activity, by choosing a ServiceMax object type and object field preferences.
4. Specify the Retry and Time out parameters for the activity.

What to do next

Map the inputs of the Create Objects activity.
Parent topic: ServiceMax activities

Mapping the input of the Create Objects activity

Procedure

1. In the Checklist, select Map Inputs.

The Objects element is displayed in the To Activity panel. The parameters that are displayed correspond
to the structure of the input to the ServiceMax objects operation.

2. Optional: Right-click the default node and choose Show Optional Parameters, to show the optional input
parameters for this activity:

AssignmentRuleHeader
MruHeader
EmailHeader
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Optional and nillable field elements have the following behavior:
The Integration Appliance does not update an optional field, when the ServiceMax server does
not provide a value for the field.
If you set the xsi:nil attribute to true on a nillable field, the Integration Appliance sets the
field to null during an update.
Note: Setting a field to an empty string does not set a field to null.

What to do next

Map the output of the Create Objects activity.

Mapping the output of the Create Object activity

Procedure

1. In the Checklist, select Map Outputs.
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The saveResults element is displayed in the From Activity panel. The parameters that are displayed
correspond to the saveResults structure, which is returned by the create activity.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.
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Update Objects activity
Use this activity to update existing objects in ServiceMax.

About this task

While the Salesforce.com API limits the number of objects that it can update in a single call to 200 objects, the
Cast Iron® ServiceMax connector does not have such a limit. You can use the Update Objects activity to update
an unlimited number of objects.  

Using the Update Objects activity.

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Update Objects activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity are displayed beneath

the orchestration.
3. Select a ServiceMax endpoint. For instructions on creating or editing a ServiceMax endpoint, see

Creating or editing a ServiceMax endpoint.
4. Configure the activity by choosing a ServiceMax object type and object field preferences. You can only

select object types and fields that the Integration Appliance can update. The input map contains the
object type with elements that correspond to the fields you select during this configuration step.
Note: The Integration Appliance cannot create auto-number fields.

5. Specify the Retry and Time out parameters for the activity.
6. Map the input of the activity. The input map consists of an object's input parameter. This parameter

consists of a single root element that has a single repeating element, which is named after the object
type you selected, containing all the fields you selected in the Object Field Preferences table.

7. Map the output of the activity.

Results

Map the input of the Update Objects activity
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1. In the Checklist, select Map Inputs. The objects element is displayed in the To Activity pane.
2. Right-click the default node and choose Show Optional Parameters to show the optional input

parameters for this activity:
AssignmentRuleHeader
MruHeader
EmailHeader
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variable or variables for the map. For instructions about
creating variables, see Creating variables.

4. As appropriate, map the input parameters to the variable or variables. For mapping instructions, see
Creating a map.

Optional and nillable field elements have the following behavior:

The Integration Appliance does not update an optional field, when the ServiceMax server does not
provide a value for the field.
If you set the xsi:nilattribute to true on a nillable field, the Integration Appliance sets the field to
null during an update.
Note: Setting a field to an empty string does not set a field to null.

Map the output of the Update Objects activity

1. In the Checklist, select Map Outputs. The saveResults element is displayed in the From Activity panel.
2. Click Select Outputs... and select the output variable or variables for the map. For instructions about

creating variables, see Creating variables.
3. As appropriate, map the output parameters to the variable or variables. For mapping instructions, see

Creating a map.

Parent topic: ServiceMax activities
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Upsert Objects activity
Use this activity to update existing objects or create new objects in ServiceMax.

About this task

The activity uses an external ID, usually a foreign key, to determine whether to update an existing object or
create a new object in ServiceMax.

While the Salesforce.com API limits the number of objects that it can create in a single upsert call to 200
objects, the Cast Iron® ServiceMax connector does not have such a limit. You can use the Upsert Objects
activity to create an unlimited number of objects.
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To use the Upsert Objects activity:

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Upsert Objects activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity are displayed beneath

the orchestration.
3. Select a ServiceMax endpoint. For instructions on creating or editing a ServiceMax endpoint, see

Creating or editing a ServiceMax endpoint.
4. Configure the activity, by choosing a ServiceMax object type and object field preferences.

Note: You can only choose object types that the Integration Appliance can update or create and contain
at least one External ID field. When you select the object type, Studio displays the external IDs defined
on the object type in the External ID field of the Configure pane. You cannot edit the IDs listed in the
External ID list. The external ID that you select becomes a required field, you cannot clear this field from
the Object Field Preferences table. If only one external ID is available, Studio automatically selects this
field in the Object Field Preferences table.

5. Specify the Retry and Time out parameters for the activity.
6. Map the input of the activity.
7. Map the output of the activity.

Results

Map the input of the Upsert Objects activity

1. In the Checklist, select Map Inputs. The objects element is displayed in the To Activity panel.
2. Right-click the default node and choose Show Optional Parameters, to show the optional input

parameters for this activity:
AssignmentRuleHeader
MruHeader
EmailHeader
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variable or variables for the map. For instructions about
creating variables, see Creating variables.

4. As appropriate, map the input parameters to the variable or variables. For mapping instructions, see
Creating a map.

This activity supports the following optional input parameters:

AssignmentRuleHeader
EmailHeader
MruHeader

Optional and nillable field elements have the following behavior:

The Integration Appliance does not update an optional field, when the ServiceMax server does not
provide a value for the field.
If you set the xsi:nil attribute to true on a nillable field, the Integration Appliance sets the field to
null during an update.
Note: Setting a field to an empty string does not set a field to null.

Map the output of the Upsert Objects activity
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1. In the Checklist, select Map Outputs. The upsertResults element is displayed in the From Activity
panel.

2. Click Select Outputs... and select the output variable or variables for the map. For instructions about
creating variables, see Creating variables.

3. As appropriate, map the output parameters to the variable or variables. For mapping instructions, see
Creating a map.

Parent topic: ServiceMax activities
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Delete Objects activity
Use this activity to delete one or more objects in ServiceMax. While the Salesforce.com API limits the number
of objects that it can delete in a single call to 200 objects, the Cast Iron® ServiceMax connector does not have
such a limit. You can use the Delete Objects activity to delete an unlimited number of objects.

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Delete Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

4. Specify the Retry and Time out parameters for the activity.

What to do next

Map the input of the Delete Objects activity.
Parent topic: ServiceMax activities

Mapping the input of the Delete Objects activity

Procedure

1. In the Checklist, select Map Inputs.

The Ids element is displayed in the To Activity panel.

2. Optional: Right-click the default node and choose Show Optional Parameters, to show the optional input
parameters for this activity:
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UserTerritoryDeleteHeader
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

What to do next

Map the output of the Delete Object activity.

Mapping the output of the Delete Object activity

Procedure

1. In the Checklist, select Map Outputs.

The deleteResults element is displayed in the From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.
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Undelete Objects activity

About this task

Use this activity to restore one or more objects that you deleted in ServiceMax.

To use the Undelete Objects activity complete the following steps:

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Undelete Objects activity. Add the
activity to an orchestration. The Checklist and Summary for the activity are displayed beneath the
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orchestration.
2. Select a ServiceMax endpoint. For instructions on creating or editing a ServiceMax, see Creating or

editing a ServiceMax endpoint.
3. Specifythe Retry and Time out parameters for the activity.
4. Map the input of the activity.
5. Map the output of the activity.

Results

Map the input of the Undelete Objects activity

1. In the Checklist, select Map Inputs. The ids element is displayed in the To Activity panel.
2. Right-click the default node and choose Show Optional Parameters, to show the optional input

parameters for this activity:
CallOptions
connection

3. Click Select Inputs... and select the input variable or variables for the map. For instructions about
creating variables, see Creating variables.

4. As appropriate, map the input parameters to the variable or variables. For mapping instructions, see
Creating a map.

Map the output of the Undelete Objects activity

1. In the Checklist, select Map Outputs. The results element is displayed in the From Activity panel.
2. Click Select Outputs... and select the output variable or variables for the map. For instructions about

creating variables, see Creating variables.
3. As appropriate, map the output parameters to the variable or variables. For mapping instructions, see

Creating a map.

Parent topic: ServiceMax activities
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Retrieve Objects activity
Use this activity to retrieve one or more ServiceMax objects of a specified type. While the Salesforce.com API
limits the number of objects that it can retrieve in a single call to 2,000 objects, the Cast Iron® ServiceMax
connector does not have such a limit. You can use the Retrieve Objects activity to retrieve an unlimited
number of objects.

Using the Retrieve Objects activity

1. In the Activities tab, open the ServiceMax directory to find the Retrieve Objects activity.
2. Add the activity to your orchestration.
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The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

4. Configure the activity, by choosing a ServiceMax object type and object field preferences.

Only object types that the Integration Appliance is able to retrieve through the Salesforce.com API
display.

5. Specify the Retry and Time out parameters for the activity.

Mapping the input of the Retrieve Objects activity

1. In the Checklist, select Map Inputs.

The ids element is displayed in the To Activity pane. The element contains the collection of IDs that the
Integration Appliance retrieves from ServiceMax.

2. (Optional) Right-click the default node and choose Show Optional Parameters, to show the optional
input parameters for this activity:

MruHeaderUser
CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Optional and nillable field elements have the following behavior:

If the field being retrieved is null, the Integration Appliance sets the xsi:nil attribute to true in the
result.
If the input ID is not valid or does not represent the object type that you specified, then for the entire
object element the Integration Appliance sets xsi:nil to true for that element's position in the result
set.

Mapping the output of the Retrieve Objects activity

1. In the Checklist, select Map Outputs.

The objects element is displayed in the From Activity panel. The element contains all fields that you
selected in the field preferences table, during the configuration steps.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.
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Parent topic: ServiceMax activities
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Query Objects activity
Use the Sforce Object Query Language (SOQL) to run a query on one or more Salesforce.com object types from
this activity and return a results set. The Query Objects activity automatically runs a query or queryAll call,
followed by continuous queryMore calls for all children and objects returned from Salesforce.com.

Note: Running the Query Objects activity can result in a cursor being opened by Salesforce.com to track the
query results. If the activity reaches the cursor limit that Salesforce.com allots to each user or if the cursor
expires, the Integration Appliance tries the activity again.

Using the Query Objects activity

1. In the Activities tab, open the Salesforce.com directory to find the Query Objects activity.
2. Add the activity to your orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a Salesforce.com endpoint.

For instructions on creating or editing a Salesforce.com endpoint, see Creating or editing a
Salesforce.com endpoint.

4. Configure the activity, by specifying a query and setting query options.
5. Specify the Retry and Time out parameters for the activity.
6. Map the input of the activity.
7. Map the output of the activity.

Map the input of the Query Objects activity

1. In the Checklist, select Map Inputs.

The parameters element is displayed in the To Activity panel. The parameters element has a child
element for each parameter you specified in the SOQL query. The context for the parameter in the query
determines the parameter type. If you did not specify any parameters, then no child elements are
displayed under the parameters element.

2. Right-click the default node and choose Show Optional Parameters, to show the optional input
parameters for this activity:

MruHeader
CallOptions
connection
sessionInfo
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3. Click Select Inputs... and select the input variable or variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variable or variables.

For mapping instructions, see Creating a Map.

Map the output of the Query Objects activity

1. In the Checklist, select Map Outputs.

The objects element is displayed in the From Activity panel. The result parameter has a single element
named objects with a single repeating element named after the driving object of the query. The driving
object is the first object named in the FROM clause of the query. For example, in the following SOQL
statement Account is the driving object:

Select Name from Account, Account.Contacts

The driving object has child elements that correspond to the fields or relationships listed in the SELECT
clause of a query.  The schema is defined as follows:

For fields, the field type matches the SOAP type of the field. The field type is nillable if the SOAP
type is nillable.
For relationships for parent elements, the element name is the name of the parent. If there is no
parent when the activity runs the query, then the element is absent. The fields or relationships of
the parent is displayed immediately underneath the relationship element.
For relationships for child elements, the element name is the name of the child. The relationship
element has a single repeating element named after the object type of the child object. The fields
and relationship of the child is displayed underneath the object type element. If there are no
children when the activity runs the query, then the element is absent.
If you did not select any fields or relationships, but instead request the count() in the SELECT
clause, the entire object type element is replaced with an element named count of type
unsignedInt.

 
2. Click Select Outputs... and select the output variable or variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variable or variables.

For mapping instructions, see Creating a Map.

Parent topic: Salesforce.com activities
Parent topic: ServiceMax activities
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Configuring the Query Objects activity
You must create a Sforce Object Search Language (SOSL) query to configure the Search Objects activity. The
following sections discuss the steps to configure the Search Objects activity, create an SOSL query, and
provide SOSL syntax rules for IBM® Cast Iron®.

Procedure

1. In the Checklist, select Configure.

The Specify Query window opens.

2. Create an SOSL query in the Specify Query window.
3. Optional: You can specify dynamic parameters in the search clause of the SOSL statement. You can then

map these parameters dynamically as the input parameters for the activity, which allows the activity to
dynamically control the query that is based on the input to the orchestration. Use a ($) dollar sign to
denote a parameter and follow it with the parameter name.

4. Click the Validate icon  , to validate the query.
If the query is invalid, the Validation Feedback icon  displays in the lower left corner of the Specify
Query window. For invalid queries:

a. Click the Validation Feedback icon in the lower left corner of the Specify Query window for a list of
validation errors.

b. Use the Refresh icon  To refresh metadata and revalidate the SOSL statement.
5. In the Checklist, select Query to configure specific query options.

The Query Options pane opens.

6. Select Include deleted items in query (execute a queryAll operation), to query for deleted records in
addition to existing records. If you do not select this option, the Integration Appliance only queries
existing records.

7. Specify a Query batch size between 200-2000 queries to help tune the performance of the Integration
Appliance.

The option determines the batch size to use in the QueryOptions SOAP header for all query calls and
does not affect the number of results that are returned by the activity. By default, this option is set to
500 queries.

Parent topic: ServiceMax activities

Creating SOSL Queries

When creating a SOQL query, you can use dynamic parameters in the WHERE clause of the SOQL statement.
Studio can then dynamically map these parameters as the input parameters for the activity. This allows for
dynamic control of the query that is based on input to the orchestration.

About this task

The SForce Object Query Language does not define a syntax for parameterized queries; however, Cast Iron
does enforce some proprietary SOQL syntax rules. You can use parameters in either simple expressions or set
expressions.

SOSL Syntax Rules for Cast Iron
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Use a ($) dollar sign to denote a parameter. After the ($) dollar sign, specify a string of alphanumeric
characters. The first character must be a letter [a-zA-Z], optionally followed by one or more letters [a-
zA-Z], digits [0-9], or ( _ ) underscores.
Note: Parameter names are case-sensitive; therefore, the parameters $a and $A are considered to be
different parameters.
The following table contains examples of valid and invalid parameter declarations:

Parameter Valid or Invalid

$AnAccount valid

$a123_456 valid

$123a invalid

$_id invalid

You must declare parameters on the right side of an expression in a WHERE clause.
Parameters can appear more than once in a given SOQL statement. However, even though the parameter
appears more than once in the SOQL statement, it only appears once in the input parameter map. The
activity substitutes the same value for all locations where the parameter is used at run time.
Note: When you use the same parameter name and there is a type mismatch, an error occurs. For
example, the following SOQL generates an error because $param is used as both a string and date type:

SELECT Name from Account where Name like $param and createdDate > $param

The type of the field in which a parameter is being compared determines the type of the parameter and
whether the parameter is being used in a simple expression, a set expression, or part of a set
expression.

Ty
pe
of
Ex
pre
ssi
on Description

Si
mp
le
Ex
pre
ssi
ons

For example: Select ID from Account where Name = $NameParam

The SoapType of the field on the left side of the expression determines the parameter type. If the
field type is nillable and the operator is ( = ) or (!=), then the parameter is nillable.  Setting
xsi:nil=true on the parameter sets the parameter value to null when it is substituted. If the
parameter's type requires it to be enclosed in (‘) single quotation marks, then the parameter's
value is enclosed in single quotation marks during substitution and its contents are escaped
automatically.

For SOQL, the (\) backslash and (‘) single quotation mark is escaped.

Set
Ex
pre
ssi
ons

For example: Select ID From Account where ID in $idList

The parameter's type is a repeating sequence of the SoapType of the field on the left side of the
expression. The parameter is not nillable and has minOccurs=1, maxOccurs=unbounded on the
element.

The sequence is expanded at run time to be a proper set value, for example:

Select Id From Account where Id in (‘value1',‘value2')

Par
t of

Parameters inside a set list are treated like a simple expression parameter type, for example:
SELECT Name from Account where BillingState IN (‘California', $state2)
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In this example, the $state2 parameter type is the SoapType of the Account BillingState field and
is not a repeating element. The parameter is not nillable.
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Search Objects activity

About this task

Use the Sforce Object Search Language (SOSL) to run a search query on one or more ServiceMax object types
from this activity and return a results set.

Note: You can only search objects that are configured as searchable or eSearchable. You cannot search
attachment objects.

Using the Search Objects activity:

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Search Objects activity.
2. Add the activity to an orchestration. The Checklist and Summary for the activity is displayed beneath

the orchestration.

Results

1. Select a ServiceMax endpoint. For instructions on creating or editing a ServiceMax endpoint, see
Creating or editing a ServiceMax endpoint.

2. Configure the activity, by specifying a search query and setting search query options.
3. Specify the Retry and Time out parameters for the activity.
4. Map the input of the activity.
5. Map the output of the activity.

Mapping the input of the Search Objects activity:

1. In the Checklist, select Map Inputs. The parameters element is displayed in the To Activity panel. The
parameter element has a child element for each parameter you specified in the SOSL query. The context
for the parameter in the query determines the parameter type. If you did not specify any parameters,
then no child elements are displayed under the parameters element.  
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2. Right-click the default node and choose Show Optional Parameters, to show the optional input
parameters for this activity:

CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variable or variables for the map. For instructions about
creating variables, see Creating variables.

4. As appropriate, map the input parameters to the variable or variables. For mapping instructions, see
Creating a map.

Mapping the output of the Search Objects activity:

1. In the Checklist, select Map Outputs. The objects element is displayed in the From Activity panel.   
2. Click Select Outputs... and select the output variable or variables for the map. For instructions about

creating variables, see Creating variables.
3. As appropriate, map the output parameters to the variable or variables. For mapping instructions, see

Creating a map.

Parent topic: ServiceMax activities
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Configuring the Search Objects activity
You must create an Sforce Object Search Language (SOSL) query to configure the Search Objects activity.

About this task

The following sections discuss the steps to configure the Search Objects activity, create an SOSL query, and
provide SOSL syntax rules for IBM® Cast Iron®.

To configure the Search Objects activity complete the following steps:

Procedure

1. In the Checklist, select Configure. The Specify Query window opens.
2. Create an SOSL query in the Specify Query window.
3. Optional: You can specify dynamic parameters in the search clause of the SOSL statement. You can then

map these parameters dynamically as the input parameters for the activity, which allows the activity to
dynamically control the query that is based on the input to the orchestration. Use a ($) dollar sign to
denote a parameter and follow it with the parameter name.

4. Click the Validate icon , to validate the query. If the query is invalid, the Validation Feedback icon 
shows in the lower left corner of the Specify Query window. For invalid queries:

Click the Validation Feedback icon in the lower left corner of the Specify Query window for a list of
validation errors.
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Use the Refresh icon  to refresh metadata and revalidate the SOSL statement.

Parent topic: ServiceMax activities

Creating SOSL queries

About this task

When creating a Sforce Object Search Language (SOSL) query, you can use dynamic parameters in the WHERE
clause of the SOSL statement. Studio can then dynamically map these parameters as the input parameters for
the activity. This allows for dynamic control of the query that is based on input to the orchestration.

The Sforce Object Search Language does not define a syntax for parameterized queries; however, IBM Cast
Iron does enforce a few proprietary SOSL syntax rules. You can use parameters in either simple expressions or
set expressions.

SOSL syntax rules for IBM Cast Iron

About this task

Use a ($) dollar sign to denote a parameter. After the ($) dollar sign, specify a string of alphanumeric
characters. The first character must be a letter [a-zA-Z], optionally followed by one or more letters [a-
zA-Z], digits [0-9], or ( _ ) underscores.
Note: Parameter names are case-sensitive; therefore, the parameters $a and $A are considered to be
different parameters.
The following table contains examples of valid and invalid parameter declarations:

Parameter Valid or Invalid

$AnAccount valid

$a123_456 valid

$123a invalid

$_id invalid

You must declare parameters in the Search Query portion of the SOSL statement. Curly braces ({ })
demarcate the Search Query portion of the SOSL statement.
Important: Do not use double quotation marks (" ") to enclose parameters. If you enclose parameters in
double quotation marks, the activity treats the parameter as a string search literal.
The parameter type is always xsd:string. During substitution, the activity escapes any parameter that
you declare using a reserved character. Reserved characters include the following characters:

Reserved Characters Description

& ampersand

* asterisk

\ back slash

[ ] box brackets

: colon

, comma

{ } curly braces
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Reserved Characters Description

" Double quotation mark

! exclamation mark

- minus sign

+ plus sign

' Single quotation mark

~ tilde

^ up arrow

| vertical bar

Parameters can appear more than once in a given SOQL statement. However, even though the parameter
appears more than once in the SOQL statement, it only appears once in the input parameter map. The
activity substitutes the same value for all locations where the parameter is used at run time.
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Convert Lead activity
Use this activity to convert leads into accounts, contacts, or opportunities in ServiceMax. While the
Salesforce.com API limits the number of objects that it can convert in a single call to 100 objects, the Cast
Iron® ServiceMax connector does not have such a limit. You can use the Convert Lead activity to convert an
unlimited number of objects.

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Convert Lead activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

4. Specify the Retry and Time out parameters for the activity.

What to do next

Map the inputs of the Convert Lead activity.
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Parent topic: ServiceMax activities

Mapping the input of the Convert Lead activity

Procedure

1. In the Checklist, select Map Inputs.

The convertLead element displays in the To Activity pane. The parameters that are displayed
correspond to the structure of the input to the ServiceMax convertLead operation.

2. Optional: Right-click the default node and choose Show Optional Parameters, to show the optional input
parameters for this activity:

CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

What to do next

Map the output of the Convert Lead activity.

Mapping the output of the Convert Lead activity

Procedure

1. In the Checklist, select Map Outputs.

The convertLeadResponse element is displayed in the From Activity panel. The parameters that are
displayed correspond to the convertLeadResponse structure, which is returned by the convertLead
operation.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.
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Merge Objects Activity
Use this activity to merge ServiceMax objects into a single record.

About this task

You can merge two or more of the following ServiceMax objects into a single record:

Account
Contact
Leads

After the activity merges the objects, it deletes the pre-merge records and reparents any duplicates.

While the Salesforce.com API limits the number of requests that it can merge in a single call to 200, the Cast
Iron® ServiceMax connector does not have such a limit. You can use the Merge Objects activity to process an
unlimited number of merge requests.

Procedure

1. In the Activities tab, open the ServiceMax directory to find the Merge Objects activity.
2. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

4. Configure the activity, by choosing a ServiceMax object type and object field preferences.

You can only select Account, Contact, and Lead object types and fields that the Appliance can update.
Fields such as auto-number fields might not be available to select.

5. Specify the Retry and Time out parameters for the activity.

What to do next

Map the input of the Merge Objects activity.
Parent topic: ServiceMax activities

Mapping the input of the Merge Objects activity

Procedure

1. In the Checklist, select Map Inputs.

The Merge element is displayed in the To Activity panel.

2. Optional: Right-click the default node and choose Show Optional Parameters, to display these optional
input parameters for this activity:

AssignmentRuleHeader
MruHeader
EmailHeader
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CallOptions
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sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Optional and nillable field elements have the following behavior:
The Integration Appliance does not update an optional field, when the ServiceMax server does
not provide a value for the field.
If you set the xsi:nil attribute to true on a nillable field, the Integration Appliance sets the
field to null during an update.
Note: Setting a field to an empty string does not set a field to null.

Mapping the output of the Merge Object activity

Procedure

1. In the Checklist, select Map Outputs.

The results element is displayed in the From Activity panel. The parameters that are displayed
correspond to the structure of the ServiceMax MergeResults schema.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.
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Get User Information activity
Use this activity to get user information from the ServiceMax server. In the Activities tab, open the ServiceMax
directory to find the Get User Information activity.

Procedure

1. Add the activity to an orchestration.
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The Checklist and Summary for the activity are displayed beneath the orchestration.

2. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

3. Specify the Retry and Time out parameters for the activity.

What to do next

Map the output of the Get User Information activity.
Parent topic: ServiceMax activities

Mapping the output of the Get User Information activity

Procedure

1. In the Checklist, select Map Outputs.

The GetUserInformationResult element contains the ServiceMax user information and opens in the
From Activity panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.
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Get Server Timestamp activity
Use this activity to get the current time from the ServiceMax server. In the Activities tab, open the ServiceMax
directory to find the Get Server Timestamp activity.

Procedure

1. Add the activity to an orchestration.

The Checklist and Summary for the activity are displayed beneath the orchestration.

2. Select a ServiceMax endpoint.
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For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

3. Specify the Retry and Time out parameters for the activity.

What to do next

Map the output of the Get Server Timestamp activity.
Parent topic: ServiceMax activities

Mapping the output of the Get Server Timestamp activity

Procedure

1. In the Checklist, select Map Outputs.

The serverTimestamp element contains the ServiceMax user information and opens in the From Activity
panel.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.
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Send email activity
Use this activity to send single or multiple emails. The emails include all standard email attributes such as the
email address, subject line, and carbon copies.

Using the email activity

1. In the Activities tab, open the ServiceMax directory to find the Send Email activity.
2. Drag the Send Email activity onto the orchestration.

The Summary and Checklist for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.
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4. In the Configure section, select the Send Mass Emails check box if you want to send multiple emails.
5. Specify the Retry and Activity Timeout parameters for the activity.
6. Map the inputs of the activity.
7. Map the outputs of the activity.

Mapping the input of the Send Email activity

1. In the Checklist, select Map Inputs.

The emails parameter is displayed in the To Activity pane.

2. Right-click the default node and choose Show Optional Parameters, to display these optional input
parameters for this activity:

connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Mapping the output of the Send Email activity

1. In the Checklist, select Map Outputs.

The results and sessionInfo elements are displayed in the From Activity pane.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: ServiceMax activities
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Set password activity
Use this activity to change the password of a user or SelfServiceUser to a value that you specify.

Note: You must have the administrative permission to change the password for the users.
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Using the Set Password activity

1. In the Activities tab, open the ServiceMax directory to find the Set Password activity.
2. Drag the Set Password activity onto the orchestration.

The Summary and Checklist for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

Note: No additional configuration is required for this activity in the Configure section.
4. Specify the Retry and Activity Timeout parameters for the activity.
5. Map the inputs of the activity.
6. Map the outputs of the activity.

Mapping the input of the Set Password activity

1. In the Checklist, select Map Inputs.

The userId and password parameters are displayed in the To Activity pane.

2. Right-click the default node and choose Show Optional Parameters, to display these optional input
parameters for this activity:

CallOptions
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Mapping the output of the Set Password activity

1. In the Checklist, select Map Outputs.

The sessionInfo element is displayed in the From Activity pane.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.

3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: ServiceMax activities

Feedback | Notices
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Reset password activity
Use this activity to reset the password of the user to a system-generated value.

Note: You must have administrative permission to reset the password for the users.

Using the Reset Password activity

1. In the Activities tab, open the ServiceMax directory to find the Reset Password activity.
2. Drag the Reset Password activity onto the orchestration.

The Summary and Checklist for the activity are displayed beneath the orchestration.

3. Select a ServiceMax endpoint.

For instructions on creating or editing a ServiceMax endpoint, see Creating or editing a ServiceMax
endpoint.

Note: No additional configuration is required for this activity in the Configure section.
4. Specify the Retry and Activity Timeout parameters for the activity.

Mapping the input of the Reset Password activity

1. In the Checklist, select Map Inputs.

The userId parameter is displayed in the To Activity pane.

2. Right-click the default node and choose Show Optional Parameters, to display these optional input
parameters for this activity:

CallOptions
EmailHeader
connection
sessionInfo

3. Click Select Inputs... and select the input variables for the map.

For instructions about creating variables, see Creating Variables.

4. As appropriate, map the input parameters to the variables.

For mapping instructions, see Creating a Map.

Mapping the output of the Reset Password activity

1. In the Checklist, select Map Outputs.

The password and sessionInfo elements are displayed in the From Activity pane.

2. Click Select Outputs... and select the output variables for the map.

For instructions about creating variables, see Creating Variables.
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3. As appropriate, map the output parameters to the variables.

For mapping instructions, see Creating a Map.

Parent topic: ServiceMax activities
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Siebel activities
Overview of the Siebel connector
Installing JAR files to connect to the Siebel server
You must copy two JAR files on the same workstation as your Cast Iron Studio installation before you
can connect to a Siebel server. Also, you can copy the Siebel.properties file, which is optional, to
configure the connection timeout, transaction timeout, and the Siebel properties.
Creating or editing a Siebel endpoint
Siebel endpoints contain the connection information that Studio and the Integration Appliance use to
connect to a Siebel Business Applications Server. You can create multiple endpoints that refer to
separate instances.
Using the Siebel Create Objects activity
Use the Siebel Create Objects activity to work with either Siebel Business Objects, Business
Components, or Siebel Integration Objects.
Using the Siebel Update Objects activity
Use the Siebel Update Objects activity to work with either Siebel Business Objects, Business
Components, or Siebel Integration Objects.
Using the Siebel Delete Objects activity
Use the Siebel Delete Objects activity to work with either Siebel Business Objects, Business
Components, or Siebel Integration Objects.
Using the Siebel Query Objects activity
Use the Siebel Query Objects activity to work with either Siebel Business Objects, Business
Components, or Siebel Integration Objects.
Using the Siebel Execute Business Service activity
The Siebel execute business service activity is used to run a Siebel business service on the Siebel
Business Applications server.
Prerequisites for starter activities in Siebel
Using the Siebel Get Created Objects activity
Use the Get Created Objects activity to poll for Siebel Business Objects, Business Components, or Siebel
Integration Objects from the Siebel server.
Using the Siebel Get Updated Objects activity
Use the Get Updated Objects activity to poll for events that were updated on the Siebel Sever.
Using the Siebel Get Deleted Objects activity
Use the Get Deleted Objects activity to poll for deleted Siebel Business Objects, Business Components,
or Siebel Integration Objects from the Siebel server.
Specifying Retry and Delivery Options for Siebel Activities
Specifying the Retry and Delivery parameters is one of the tasks to configure a Siebel activity
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configuration.
Siebel properties file
The Siebel connector uses Siebel API (Java™ Data Bean) to interact with the Siebel server. Siebel API
also provides a way to configure the connection settings on the client side. The siebel.properties
file located in your classpath, can be used to provide default parameters for client applications
connecting to Siebel applications using the Java Data Bean.
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Overview of the Siebel connector
The Siebel connector enables a two-way communication between Cast Iron and the Siebel business
applications server. The connector supports Business Object/Business Component (BO/BC), Integration
Objects (IO), and Business Service (BS) interfaces.

You can perform the following activities using the Siebel connector:

Outbound Activities
Create Objects (uses BO/BC or IO)
Update Objects (uses BO/BC or IO)
Delete Objects (uses BO/BC or IO)
Query Objects (uses BO/BC or IO)
Execute Business Service (uses BS)

Inbound/Starter Activities
Get Created Objects (uses BO/BC or IO)
Get Updated Objects (uses BO/BC or IO)
Get Deleted Objects (uses BO/BC or IO)

The Siebel connector supports the following versions of the Siebel server: 7.0.5, 7.5.x, 7.7.x, 7.8.x, 8.0, 8.1,
and 8.1.1.

The Siebel connector requires Siebel JAR files to connect to the Siebel server. For more information, see
Installing JAR files to connect to the Siebel server.

Parent topic: Siebel activities
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Installing JAR files to connect to the Siebel server
You must copy two JAR files on the same workstation as your Cast Iron Studio installation before you can
connect to a Siebel server. Also, you can copy the Siebel.properties file, which is optional, to configure the
connection timeout, transaction timeout, and the Siebel properties.

Before you begin

The JAR files can be obtained from the Siebel system administrator.
The JAR files must be on the same computer as the studio installation.
The JAR files must be from the same version as the Siebel server you connect to.
The Siebel.properties file must have properties for that particular version of the Siebel server.

About this task

The files to be installed are:

Siebel.jar
A language specific JAR file. For example, the English language JAR file is named SiebelJI_enu.jar
Siebel.properties - This is an optional file. For more information about the Siebel.properties file, see
Siebel properties file.

Procedure

1. Open studio and select Tools > Install Module Providers.
2. When the Add Provider(s) dialog box is displayed, click the plus (+) button under Siebel Connector. A

field and a Browse button appears.
3. Click Browse, and use the browse dialog box to locate and select the JAR files and the properties file

(optional).
4. Click Open to import the contents of the selected files.
5. When the two JAR files and the properties file (optional) are listed in the Add Provider(s) dialog box, click

OK.

Results

A prompt is displayed to restart studio and activate the changes.

What to do next

You can now create Siebel endpoints and orchestrations.

Parent topic: Siebel activities
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Creating or editing a Siebel endpoint
Siebel endpoints contain the connection information that Studio and the Integration Appliance use to connect
to a Siebel Business Applications Server. You can create multiple endpoints that refer to separate instances.

About this task

Use this task to create or edit a Siebel endpoint.
Note: Any changes you make to the Siebel endpoint, including configuration properties, affects all the
orchestrations that use that endpoint, as the edits are global, not local.

Procedure

1. Drag an activity from the Siebel folder under the Activities tab to the Orchestration window. The
Summary panel is displayed.

2. Click Pick Endpoint under Checklist. The Pick Endpoint panel is displayed.
3. Click one of the following buttons:

a. Browse - To select an existing endpoint from Project Explorer. The Project Explorer window
shows all the endpoints in the project available for the activity. When you select an endpoint, the
endpoint properties are displayed in the Pick Endpoint panel.

b. New - To create a new endpoint. The Create Endpoint window opens.
Note: In Version 6.1.0.1, select the first Siebel entry in the list. For more information, see the
technote http://www-01.ibm.com/support/docview.wss?uid=swg21516320.

c. Edit - To edit the existing endpoint. The Edit Endpoint window opens.
4. Complete the fields defined in the following table:

Table 1. Connection properties
Field Name Description

Connection information

Connection URL Specifies the connection URL to connect to the Siebel server. The connection
URLs for all versions of Siebel follow this format:

siebel[.transport][.encryption]
[.compression]://host[:port]/EnterpriseServer/AppObjMgr

The default port number is 2320. For Siebel version 7.5x and earlier
versions, the port number (2320) and the server name are specified.

For Siebel version 7.8, the port and the server name are not specified.

If you do not select the default port, you can specify another port number
(for example, 2321).

The following are the examples of connection URIs for different versions of
the Siebel server:

For Siebel 7.5:
siebel://<IP_address>:2320/siebel/SSEObjMgr_ENU/sebld
evl
For Siebel 7.8:
siebel://<IP_address>:/Sieb78/SSEObjMgr_enu
For Siebel 8:
siebel://<IP_address>:2321/SBA_80/SSEObjMgr_enu
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Field Name Description

Language Code Specifies the language code to log on to the Siebel server. If the system
locale is English, the value for this property is ENU (English).

User Name Specifies the user name to connect to the Siebel server.

Password Specifies the password associated with the user name to connect to the
Siebel server.

Code page Specifies the character encoding (code page) of the Siebel Server. The
character encoding (code page) of the Siebel Server and the character
encoding of the Siebel client (machine on which Siebel connector is used)
must be the same. This allows the Siebel client and the Siebel Server to
communicate correctly. Change the character encoding of the Siebel client if
it is different from that of the Siebel server.

The Siebel Java™ Data Bean supports a limited list of code page settings. If
the current code page setting of your run time is not supported, the
connector may not be able to connect to the Siebel server. For more details
refer to the Siebel Java Data Bean documentation.

Load Balancing

Use Resonate for load
balancing on Siebel
server

Specifies the option (select the check box) if the Siebel system uses resonate
for load balancing. The connector takes advantage of the load balancing
feature to connect to the Siebel Business Applications server efficiently.

Connection pool
options

Minimum Connections Specifies the minimum number of connections available in the connection
pool. The activity uses the connections to connect to a Siebel server. The
default value is 5.

Maximum Connections Specifies the maximum number of connections available in the connection
pool. The activity uses the connections to connect to a Siebel server. The
default value is 25.

Maximum Idle Time Specifies the amount of time in minutes an open connection can be idle
before being closed by the Integration Appliance. Entering 0 (zero) means
that the connections are closed when they are returned to the pool - no idle
time. The default value is 120 minutes.

Maximum Wait Specifies the amount of time in seconds that the Integration Appliance waits
for a connection when all the connections in the pool are exhausted. If no
connection is obtained after the wait time, an exception is thrown. The
default value is 300 seconds.

Reclaim Connections Specifies the interval at which the connector checks for idle connections.
Idle connections are reclaimed until the minimum number of connections, as
specified in the Minimum Connections parameter, is reached. By default, the
connector reclaims connections at five minutes interval.

  Note: The Connection pool properties need to be configured as per the load
(number of concurrent requests) on the endpoint.

Remote endpoint
configuration

 629



Field Name Description

Endpoint Runs Behind
Firewall

Enables the secure connector name property so that secure connector can
be used if the Siebel Business Applications server is running behind a
firewall.

Secure Connector
Name

Specifies the name of the secure connector that is used to connect to the
Siebel Business Applications server running behind a firewall. For example, if
an orchestration containing Siebel activity is deployed on to Cast Iron® Live
(cloud), then the secure connector needs to be configured.

5. When finished, click Test Connection to confirm that you can connect to the Siebel system.
6. Click OK.

Parent topic: Siebel activities
Related information:

Technote: Changes in the Siebel activities in WebSphere Cast Iron version 6.1.x.x when compared to the
earlier versions (6.0.0.x and earlier)

Feedback | Notices
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Using the Siebel Create Objects activity
Use the Siebel Create Objects activity to work with either Siebel Business Objects, Business Components, or
Siebel Integration Objects.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the Siebel server. For more information, see Installing JAR
files to connect to the Siebel server.
Valid connection details to connect to the Siebel server.

About this task

Use this task to create either a Business Component hierarchy or an Integration Object on the Siebel server.
The call to this activity is a synchronous call where the input data is sent to the activity for processing and the
response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Siebel folder contents.
2. Drag the Create Objects activity icon onto the orchestration. The Siebel create objects Checklist is

displayed.
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3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Siebel endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing a Siebel endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Enter the repository name in the Repository Name text box. Repository name is populated with a default

value, which represents the Siebel Repository. Enter the repository name if it is not same as the default
value. All the metadata needed for discovering the objects are retrieved from this repository.

11. Select one of the following objects for integration.

To work with Business Object/Business Component:

a. Select the Object Type as Business Object / Business Component.
b. Click Browse to display the list of Business Objects.
c. Use the Business Object Filter to filter the business objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select a Business Object from the business object list and click Next.
f. The list of business components for the selected business object is displayed. Select a business

component and click Finish to generate schemas for the map input and map output.
g. If the selected business component is a child of a parent business component, then both the

parent and the child business components are generated with a relation between them.
Note: Each of the child object attributes created in the map input is processed by the activity as
follows:

The key attributes are not set on the parent business component. Siebel generates the key
attributes when a record is created. If the key attributes are set, Siebel returns an
exception and sets the read-only fields populated with values.
If the child object is a business component of a Picklists, and you want to select an existing
child instance, do not create a new child object. Instead, set the value on the parent. For
example, if you select an existing Business Address under Account, set the
PrimaryAddressId instead of creating a Business Address. However, to create a new child
instance, you must populate the non-key attributes in the child business component so
that the activity tries to create the corresponding child instance in the Siebel application.
If there are static Picklists, then the corresponding simple attribute in the object is
required. If a value is not listed in the Picklist's list of values, the activity tries to populate
the value. If the list is unbounded and Insert is enabled, the activity processing is
successful. If the activity is unable to populate the value by itself, the operation fails.
The child record is created with multi-value links. If the create operation for the child
record fails, the child record is rolled back. If the create operation for the parent record
fails, all the child and the parent records are rolled back.
The connector attempts to select an existing child business component (for example,
Association) based on the values of all the attributes in the corresponding input child
object. If a matching child business component is found, it is associated with the parent. If
a matching child business component is not found, a new child business component is
created and associated with the parent business component.
If the child create operation fails, the child is rolled back. If the parent create operation
fails, only the parent is rolled back. Because association components can also be individual
components, as well as children of other components, a child, or parent cannot be rolled
back once an associated child has been created.
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To work with Integration Object:

a. For Siebel Integration Object, select the Object Type as Integration Object.
b. Click Browse to display the list of integration objects.
c. Use Integration Object Filter to filter the integration objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select an integration object and click Finish to generate schemas for the map input and map

output. During processing, the selected business service is executed and the output is sent back
to the orchestration.

12. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying Retry and Delivery Options for Siebel Activities.

13. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Create Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

14. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

15. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.

Results

You have configured the Siebel Create Objects activity.
Parent topic: Siebel activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
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Using the Siebel Update Objects activity
Use the Siebel Update Objects activity to work with either Siebel Business Objects, Business Components, or
Siebel Integration Objects.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the Siebel server. For more information, see Installing JAR
files to connect to the Siebel server.
Valid connection details to connect to the Siebel server.

About this task
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Use this task to update either a Business Component hierarchy or an Integration Object on the Siebel server.
The call to this activity is a synchronous call where the input data is sent to the activity for processing and the
response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Siebel folder contents.
2. Drag the Update Objects activity icon onto the orchestration. The Siebel Update Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Siebel endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing a Siebel endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Enter the repository name in the Repository Name text box. Repository name is populated with a default

value, which represents the Siebel Repository. Enter the repository name if it is not same as the default
value. All the metadata needed for discovering the objects are retrieved from this repository.

11. Select one of the following objects for integration.

To work with Business Object/Business Component:

a. Select the Object Type as Business Object / Business Component.
b. Click Browse to display the list of Business Objects.
c. Use the Business Object Filter to filter the business objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select a Business Object from the business object list and click Next.
f. The list of business components for the selected business object is displayed. Select a business

component and click Finish to generate schemas for the map input and map output.

During processing, the business component hierarchy is retrieved from the Siebel server and
compared to the incoming top-level business object hierarchy of the activity. The child objects are
created, updated, and deleted based on the results of this comparison. The Update activity fails if
the key attributes (for example, ID) are not set correctly.

To work with Integration Object:

a. For Siebel Integration Object, select the Object Type as Integration Object.
b. Click Browse to display the list of integration objects.
c. Use Integration Object Filter to filter the integration objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select an integration object and click Finish to generate schemas for the map input and map

output. During processing, the selected business service is executed and the output is sent back
to the orchestration.

12. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying Retry and Delivery Options for Siebel Activities.

13. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Update Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

14. Create a map between the orchestration variables and the input parameter of the activity.
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Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

15. Select the Map Outputs in the checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.

Results

You have configured the Siebel Update Objects activity.
Parent topic: Siebel activities

Feedback | Notices
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Using the Siebel Delete Objects activity
Use the Siebel Delete Objects activity to work with either Siebel Business Objects, Business Components, or
Siebel Integration Objects.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the Siebel server. For more information, see Installing JAR
files to connect to the Siebel server.
Valid connection details to connect to the Siebel server.

About this task

Use this task to delete either a Business Component hierarchy or an Integration Object on the Siebel server.
The call to this activity is a synchronous call where the input data is sent to the activity for processing and the
response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Siebel folder contents.
2. Drag the Delete Objects activity icon onto the orchestration. The Siebel Delete Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Siebel endpoint.
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7. Optional: You can create the endpoint by clicking New and specifying the required connection details.
Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing a Siebel endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Enter the repository name in the Repository Name text box. Repository name is populated with a default

value, which represents the Siebel Repository. Enter the repository name if it is not same as the default
value. All the metadata needed for discovering the objects are retrieved from this repository.

11. Select one of the following objects for integration.

To work with Business Object/Business Component:

a. Select the Object Type as Business Object / Business Component.
b. Click Browse to display the list of Business Objects.
c. Use the Business Object Filter to filter the business objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select a Business Object from the business object list and click Next.
f. The list of business components for the selected business object is displayed. Select a business

component and click Finish to generate schemas for the map input and map output.

The Delete activity deletes the top-level business objects and its children. This results in a
physical delete, and the record is removed from the Siebel application. The Delete activity fails if
the key attributes (for example, ID) are not set correctly.

To work with Integration Object:

a. For Siebel Integration Object, select the Object Type as Integration Object.
b. Click Browse to display the list of integration objects.
c. Use Integration Object Filter to filter the integration objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select an integration object and click Finish to generate schemas for the map input and map

output. During processing, the selected business service is executed and the output is sent back
to the orchestration.

12. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying Retry and Delivery Options for Siebel Activities.

13. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Delete Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

14. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

15. Select the Map Outputs in the checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.

Results

You have configured the Siebel Delete Objects activity.
Parent topic: Siebel activities
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Using the Siebel Query Objects activity
Use the Siebel Query Objects activity to work with either Siebel Business Objects, Business Components, or
Siebel Integration Objects.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the Siebel server. For more information, see Installing JAR
files to connect to the Siebel server.
Valid connection details to connect to the Siebel server.

About this task

Use this task to query either a Business Component hierarchy or an Integration Object on the Siebel server. The
call to this activity is a synchronous call where the input data is sent to the activity for processing and the
response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the Siebel folder contents.
2. Drag the Query Objects activity icon onto the orchestration. The Siebel Query Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Siebel endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating or editing a Siebel endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Enter the repository name in the Repository Name text box. Repository name is populated with a default

value, which represents the Siebel Repository. Enter the repository name if it is not same as the default
value. All the metadata needed for discovering the objects are retrieved from this repository.

11. Select one of the following objects for integration.

To work with Business Object/Business Component:
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a. Select the Object Type as Business Object / Business Component.
b. Click Browse to display the list of Business Objects.
c. Use the Business Object Filter to filter the business objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select a Business Object from the business object list and click Next.
f. The list of business components for the selected business object is displayed. Select a business

component and click Finish to generate schemas for the map input and map output.

The Query activity retrieves the Siebel business component for the specified key in the map input.
The following occurs during the Query activity:

The keys are set on the top-level business component to search for records. If the record is
not found, an error message is logged, and the job fails. If the record is found, the simple
attribute values are retrieved from the top-level business component and set to the map
output.
Note: A simple PickList attribute is retrieved differently from other simple attributes. The
simple PickList attribute is retrieved by obtaining the value of the PickListKey from the
child picklist component. To retrieve a child picklist component, the FieldName value must
be used.
Child business components are retrieved based on the type of relationship they have with
the parent business component.
Child PickList instances are retrieved.
If the child record is found with multi-value link and association, the attribute value is set
to the parent.

To work with Integration Object:

a. For Siebel Integration Object, select the Object Type as Integration Object.
b. Click Browse to display the list of integration objects.
c. Use Integration Object Filter to filter the integration objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select an integration object and click Finish to generate schemas for the map input and map

output. During processing, the selected business service is executed and the output is sent back
to the orchestration.

12. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying Retry and Delivery Options for Siebel Activities.

13. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Query Objects activity are displayed as nodes under the request input parameter in the To Activity panel.

14. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console (WMC). If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

15. Select the Map Outputs in the checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.

Results

You have configured the Siebel Query Objects activity.
Parent topic: Siebel activities
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Using the Siebel Execute Business Service activity
The Siebel execute business service activity is used to run a Siebel business service on the Siebel Business
Applications server.

Before you begin

Ensure that you have:

Installed the JAR files required to connect to the Siebel server. For more information, see Installing JAR
files to connect to the Siebel server.
The valid connection details to connect to the Siebel server.

About this task

The call to this activity is a synchronous call where the input data is sent to the activity for processing and the
response is sent back to the orchestration. The business service can be a standard business service like Siebel
Contact or a custom business service where the integration object needs to be selected.

Procedure

1. In an active orchestration, open the Activities tab and expand the Siebel folder contents.
2. Drag the Execute Business Service activity icon onto the orchestration.
3. When the activity shows in the orchestration, the Siebel Execute Business Service Checklist is displayed.
4. In the Checklist, click Summary.
5. Review the contents of the Activity Name field, and make the required changes.
6. In the Checklist, click Pick Endpoint.
7. Click Browse and use the Project Explorer dialog box to select the relevant Siebel endpoint.
8. You can create the endpoint by clicking New and enter the required connection details. Click OK to save

and use the endpoint for this configuration.
Note: For more information, see Creating or editing a Siebel endpoint.

9. To make any required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

10. In the Checklist, click Configure.
11. Type the repository name in the Repository Name text box. The repository name is populated with a

default value, which represents the Siebel Repository. Specify the repository name if it is not same as
the default value. All the metadata needed for discovering the objects are retrieved from this repository.

12. Select the business service.
a. Click Browse to display the list of Business Services.
b. Use the Business Service Filter to filter the business services during selection.
c. Optional: Click Refresh to update the current object list from the Siebel server.
d. Select a Business Service from the business service list and click Next. The list of business

operations for the selected business service is displayed.
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If the business service has a fixed integration object associated with it then after selecting the
business operation, click Finish to generate the schemas for the map input/output.
If the business service has no fixed integration object associated with it then after selecting the
business operation click Next and select the integration objects for the input/output message.

13. Select Map Inputs from the Checklist. The XML Schemas generated from the selected service of the
Execute Business Service activity are displayed as nodes under the request input parameter in the To
Activity panel.

14. Create a map between orchestration variables and the input parameter of the activity.

Values must be provided at run time for any mandatory elements of the input structure. A value can be
provided by specifying a default value for element or by linking the element with input node. During run
time if no value is provided for a mandatory element, the activity throws an exception which is reported
by the Web Management Console. If a value is not provided at run time for an optional input parameter,
no exception is thrown during run time.

15. Select the Map Outputs from the Checklist. The XML Schema generated to hold the response of the
activity is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and the orchestration variables.

Results

You have configured the Siebel Execute Business Service activity.
Parent topic: Siebel activities
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Prerequisites for starter activities in Siebel
This section contains the prerequisites to configure the Siebel inbound activities.

You must create an event store in Siebel as a prerequisite for using the starter activities.

Creating the Event Store in Siebel

This procedure uses the Siebel Sales Enterprise application as an example. For convenience, whenever we say
Siebel application, it means Siebel Sales Enterprise application in the following chapter. IBM Events are used
as the event store name in this example. This name can be changed based on the end user needs.

To create an ‘Event Store’ and ‘Object’ in Siebel Business Applications, perform the following procedure in
Siebel tools:

1. Using New Object Wizard, create a stand-alone table CX_IBM_EVENT.
2. Create these columns in your new table:

Table 1. Columns for the event table

 639



Column
Name /
User
Name

Type Length Physical
Type

Required Nullable StatusColumn
Name /
User
Name

Type Length Physical
Type

Required Nullable Status

DESCRIP
TION

Data
(public)

255 Varchar   ✓ Active

EVENT_I
D

Data
(public)

30 Varchar ✓   Active

CONNECT
OR_ID

Data
(public)

255 Varchar   ✓ Active

EVENT_T
YPE

Data
(public)

20 Varchar ✓   Active

OBJECT_
KEY

Data
(public)

255 Varchar ✓   Active

OBJECT_
NAME

Data
(public)

255 Varchar ✓   Active

PRIORITY Data
(public)

10 Number   ✓ Active

STATUS Data
(public)

20 Number ✓   Active

XID Data
(public)

255 Varchar ✓   Active

3. Create a new Business Component (BC) IBM Events based on your new table. All fields are single value
fields.

4. In addition to the fields in BC, create a new field Event Time Stamp and map it to CREATED column in
from CX_IBM_EVENT. The Type of this field should be DTYPE_UTCDATETIME.

5. Create a new Business Object (BO) IBM Events.
6. Associate IBM Events BC to IBM Events BO.
7. Create IBM Event List Applet based on IBM Events BC.
8. Create IBM Event List View based on IBM Events BO.
9. Create IBM Events Screen and associate it to the IBM Event List View in Screen View.

10. Create a page tab as follows:
a. Access the Application > Siebel Sales Enterprise > Page tab.
b. Right-click and select New Record from the menu.
c. Enter IBM Events as the screen name and IBM Events for the Text-String Override.
d. Leave the inactive field unchecked

11. Create a screen menu item as follows:
a. Access the Application > Siebel Sales Enterprise > Screen Menu Item.
b. Right-click and select new record.
c. Enter IBM Events as the screen name and IBM Events for the Text–String Override.
d. Leave the inactive field unchecked.

12. Create a new Business Object Schema Version for IBM project and associate it to Schema Version BC.
13. Apply the physical schema for the new tables in your local database. You can do this by querying on the

new table, CX_IBM_EVENT. Select the current query to create a physical schema. Make sure that you
leave the table space and index space blank.

14. Activate the new schema using Activate.
15. Add or modify the Siebel VB or e-scripts for the BC that corresponds to the business objects used at

your site. Siebel scripts triggers event notification for the configured objects (sample scripts are in the
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<studio_root>/etc/Siebel folder). In the Siebel script, ensure that the event will not get created for the
connector user name to prohibit the ping-pong effect.

16. Compile the updated and locked projects in your local database to create a new Siebel repository (.srf)
file.

17. Open Siebel Sales Enterprise in your local database. You need to have administrative privileges to
perform the following:

a. Create a new view called IBM Event List View.
b. Create a new responsibility called IBM Responsibility for IBM Event List View.
c. Add the employees or teams who are responsible for receiving events to the newly created IBM

Responsibility.
d. Create the IBMCONN (or your connector user name) user and add it to IBM Responsibility and

Administrative Responsibility.
18. Test the application in your local environment. Ensure that you have the visibility to IBM Event List View

and that an event is generated in the view after you create a record in supported object. For example,
create a new account in Siebel and check if a new account event appears in the IBM Event List View.

19. Check-in the new and updated projects into your development server.
20. Activate the new tables in the development database.
21. Compile a new Siebel.srf file and deploy it on the server.

You have successfully created the event store in the Siebel server.

Parent topic: Siebel activities
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Using the Siebel Get Created Objects activity
Use the Get Created Objects activity to poll for Siebel Business Objects, Business Components, or Siebel
Integration Objects from the Siebel server.

Before you begin

Ensure that you have:

Installed the necessary vendor software JAR files.
The valid connection details to connect to the Siebel server.
Configured the EventStore business objects and triggers to generate events. For more information, see
Prerequisites for starter activities in Siebel.

About this task

Use this task to poll for either a Business Component hierarchy or an Integration Object, created on the Siebel
server.
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Procedure

1. In an active orchestration, open the Activities tab and expand the Siebel folder contents.
2. Drag the Get Created Objects activity icon onto the orchestration. The Siebel Get Created Objects

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Siebel endpoint.
7. You can create the endpoint by clicking New and specifying the required connection details. Click OK to

save and use the endpoint for this configuration.
Note: For more information, see Creating or editing a Siebel endpoint.

8. To make any required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Specify the repository name in the Repository Name text box. Repository name is populated with a

default value, which represents the Siebel Repository. Specify the repository name if it is not the same
as the default value. All the metadata needed for discovering the objects are retrieved from this
repository.

11. Specify the Event Store name configured in the Siebel server. The activity polls this Event Store for new
events.

12. Select one of the following objects for integration.

To work with Business Object/Business Component:

a. Select the Object Type as Business Object / Business Component.
b. Click Browse to display the list of Business Objects.
c. Use the Business Object Filter to filter the business objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select a Business Object from the business object list and click Next.
f. The list of business components for the selected business object is displayed. Select a business

component and click Finish to generate schemas for the map output.
g. If the selected business component is a child of a parent business component, then both the

parent and the child business components are generated with a relation between them.

To work with Integration Object:

a. Select the Object Type as Integration Object.
b. Click Browse to display the list of integration objects.
c. Use Integration Object Filter to filter the integration objects during selection.
d. Optional: Click Refresh to update the object list from the Siebel server.
e. Select an integration object and click Finish to generate schemas for the map output.

13. In the Checklist, click Retry. Review the default settings and make the required changes. Similarly,
configure the Delivery Rules panel. For more information, see Specifying Retry and Delivery Options for
Siebel Activities.

The activity polls the event store at configured interval for create events and fetches the actual object for
that event. This object is sent to the orchestration. After processing, the event is marked as archived in
the event store.

14. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

15. Create a map between the output parameters and orchestration variables.
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Results

You have configured the Siebel Get Create Objects activity.
Parent topic: Siebel activities
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Using the Siebel Get Updated Objects activity
Use the Get Updated Objects activity to poll for events that were updated on the Siebel Sever.

Before you begin

Ensure that you have:

Installed the necessary vendor software JAR files.
The valid connection details to connect to the Siebel server.
Configured the EventStore business objects and triggers to generate events. For more information, see
Prerequisites for starter activities in Siebel

About this task

Use this task to get updated Business Component hierarchy or updated Integration Objects on the Siebel
server.

Procedure

1. In an active orchestration, open the Activities tab and expand the Siebel folder contents.
2. Drag the Get Updated Objects activity icon onto the orchestration. The Siebel Get Updated Objects

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Siebel endpoint.
7. You can create the endpoint by clicking New and specifying the required connection details. Click OK to

save and use the endpoint for this configuration.
Note: For more information, see Creating or editing a Siebel endpoint.

8. To make any required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Enter the repository name in the Repository Name text box. Repository name is populated with a default

value, which represents the Siebel Repository. Enter the repository name if it is not same as the default
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value. All the metadata needed for discovering the objects are retrieved from this repository.
11. Specify the Event Store name which is configured in the Siebel server. The activity polls this Event Store

for new events.
12. Select one of the following objects for integration.

To work with Business Object/Business Component:

a. Select the Object Type as Business Object / Business Component.
b. Click Browse to display the list of Business Objects.
c. Use the Business Object Filter to filter the business objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select a Business Object from the business object list and click Next
f. The list of business components for the selected business object is displayed. Select a business

component and click Finish to generate schemas for the map input and map output.
g. If the selected business component is a child of a parent business component, then both the

parent and the child business components are generated with a relation between them.

To work with Integration Object:

a. Select the Object Type as Integration Object.
b. Click Browse to display the list of integration objects.
c. Use Integration Object Filter to filter the integration objects during selection.
d. Optional: Click Refresh to update the object list from the Siebel server.
e. Select an integration object and click Finish to generate schemas for the map output.

13. In the Checklist, click Retry. Review the default settings and make the required changes. Similarly,
configure the Delivery Rules panel. For more information, see Specifying Retry and Delivery Options for
Siebel Activities

14. The activity polls the event store at configured intervals for update events, and fetches the actual object
for that event. This object is sent to the orchestration. After processing, the event is marked as archived
in the event store.

15. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.

Results

You have configured the Siebel Get Updated Objects activity.
Parent topic: Siebel activities
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Using the Siebel Get Deleted Objects activity
Use the Get Deleted Objects activity to poll for deleted Siebel Business Objects, Business Components, or
Siebel Integration Objects from the Siebel server.
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Before you begin

Ensure that you have:

Installed the necessary vendor software JAR files.
The valid connection details to connect to the Siebel server.
Configured the EventStore business objects and triggers to generate events. For more information, see
Prerequisites for starter activities in Siebel

About this task

Use this task to poll for events that are generated because of a delete operation performed on the Siebel
Business Application server.

Procedure

1. In an active orchestration, open the Activities tab and expand the Siebel folder contents.
2. Drag the Get Deleted Objects activity icon onto the orchestration. The Siebel Get Deleted Objects

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Siebel endpoint.
7. You can create the endpoint by clicking New and enter the required connection details. Click OK to save

and use the endpoint for this configuration.
Note: For more information, see Creating or editing a Siebel endpoint.

8. To make any required changes to the selected endpoint configuration, click Edit to access the options in
a separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Enter the repository name in the Repository Name text box. Repository name is populated with a default

value, which represents the Siebel Repository. Specify the repository name if it is not same as the
default value. All the metadata needed for discovering the objects are retrieved from this repository.

11. Specify the event store name which is configured in the Siebel server. The activity polls this event store
for new events.

12. Select one of the following objects for integration.

To work with Business Object/Business Component:

a. Select the Object Type as Business Object / Business Component.
b. Click Browse to display the list of Business Objects.
c. Use the Business Object Filter to filter the business objects during selection.
d. Optional: Click Refresh to update the current object list from the Siebel server.
e. Select a Business Object from the business object list and click Next.
f. The list of business components for the selected business object is displayed. Select a business

component and click Finish to generate schemas for the map input and map output.
g. If the selected business component is a child of a parent business component, then both the

parent and the child business components are generated with a relation between them.

To work with Integration Object:

a. Select the Object Type as Integration Object.
b. Click Browse to display the list of integration objects.
c. Use Integration Object Filter to filter the integration objects during selection.
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d. Optional: Click Refresh to update the object list from the Siebel server.
e. Select an integration object and click Finish to generate schemas for the map output.

13. In the Checklist, click Retry. Review the default settings and make the required changes. Similarly,
configure the Delivery Rules panel. For more information, see Specifying Retry and Delivery Options for
Siebel Activities

14. The activity polls the event store at configured interval for delete events and fetches the actual object for
that event. This object is sent to the orchestration. After processing, the event is marked as archived in
the event store.

15. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.

Results

You have configured the Siebel Get Deleted Objects activity.
Parent topic: Siebel activities
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Specifying Retry and Delivery Options for Siebel Activities
Specifying the Retry and Delivery parameters is one of the tasks to configure a Siebel activity configuration.

About this task

This section contains the procedure for configuring the retry options for Siebel outbound and inbound
activities.

Procedure

1. Select the Retry task from the Checklist. The retry pane is displayed.
2. Configure the retry options for connecting to a Siebel server as described in the following table.

Table 1. Retry options
Ret
ry
Fie
lds Description
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Ret
ry
Fie
lds Description

Wai
t __
sec
ond
s
bet
we
en
eac
h
retr
y.

Specifies the number of seconds that the Integration Appliance waits before trying to establish a
connection to the Siebel server.

Try
to
con
nec
t __
tim
es
bef
ore
faili
ng.

Specifies the retry count — the maximum number of times the Integration Appliance attempts to
establish a connection to the Siebel server before issuing an error and stopping the processing of
the current orchestration job.
Note: If you deploy an orchestration that contains the inbound or outbound Siebel activity and
the Integration Appliance cannot connect to the specified Siebel server, the Integration
Appliance logs the connections errors as Warnings in the system and orchestration logs until the
retry count value is reached. When the retry count is reached, the Integration Appliance logs an
Error in the system and orchestration logs and stops processing the current orchestration job. For
example, you set the retry count to 3. The first, second, and third connection errors appear in the
system log as warnings. The Integration Appliance logs the fourth connection error as an error
and stops processing the current orchestration job.

Parent topic: Siebel activities
Related tasks:
Using the Siebel Receive activity
Using the Siebel Invoke activity

Specifying the delivery rules options for Siebel inbound activities

About this task

This section contains the procedure for configuring the delivery rule options for Siebel inbound activities.

Procedure

1. Select the Delivery Rules task from the Checklist. The delivery rules pane is displayed.
2. Configure the delivery rules options to select the activity's behavior as described in the following table.

Table 2. Delivery rules
Delivery Rules
Fields Description

Poll for changes
every ______
days/hours/minute
s/seconds

Specifies the time interval to poll for objects in the Siebel server. (For example,
the Get created object activity polls for create objects at the specified time
internal.) Time can be selected in the format days, hours, minutes, or seconds.
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Delivery Rules
Fields Description

Fetch ______ rows
per poll

Specifies how many objects or components the activity should retrieve from the
Siebel server in each poll cycle.

Delivery Messages

ATMOST_ONCE A non-persistent mode in which a Siebel business object or business component
is either delivered once or not delivered at all.

ATLEAST_ONCE A persistent mode, in which the Siebel business objects or business components
are not lost. As a result, there are chances that the orchestration can receive
events once or more than once.
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Siebel properties file
The Siebel connector uses Siebel API (Java™ Data Bean) to interact with the Siebel server. Siebel API also
provides a way to configure the connection settings on the client side. The siebel.properties file located in
your classpath, can be used to provide default parameters for client applications connecting to Siebel
applications using the Java Data Bean.

The following table describes the properties of the siebel.properties file:
Table 1. Siebel.properties file description

Property Type
Propert
y Description

Siebel Connection
Manager Connection
properties

siebel.c
onmgr.t
xtimeou
t

Indicates the transaction timeout (in milliseconds). The default value is
600000 = 10 minutes.

  siebel.c
onmgr.p
oolsize

Indicates the connection pool size. Connection pool maintains a set of
connections to a specific server process. the default value is 2. Max
connection pool size is 500.

  siebel.c
onmgr.s
esstime
out

Indicates the transaction timeout (in seconds) on the client side. The
default value is 2700 = 45 minutes.

  siebel.c
onmgr.r
etry

Indicates the number of open session retries. The default value is 3.
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Property Type
Propert
y Description

  siebel.c
onmgr.j
ce

Indicates the usage of Java Cryptography Extension. 1 for jce usage and
0 for no usage.

  siebel.c
onmgr.vi
rtualhos
ts

Indicates the list of virtual servers representing a group of similar
servers that perform the same function, for example, call center
functions.

An incoming login for the call center Virtual Server tries servers from the
list in a round-robin fashion. An example of such a list is as follows:

VirtualServer1=sid1:host:port,sid2:host:port...;Virtual
Server2=... , where Virtual Servers is an assigned list of real Siebel
Servers with host names and port numbers (of the local SCB).

Siebel Generated code
for JCA/JDB properties

Siebel
connect
ion
string

siebel.u
ser.nam
e

Indicates the Siebel connection string.

Indicates the user name to be used for logging on to Object Manager.

  siebel.u
ser.pass
word

Indicates the password to be used for logging on to Object Manager.

  siebel.u
ser.lang
uage

Indicates the preferred language of the user.

  siebel.u
ser.encr
ypted

Indicates whether the user name and password are encrypted.

  siebel.jd
b.classn
ame

Indicates the default JDB classname.

Java System Properties
Note: Java System
Properties are System
Properties, not Siebel
Properties.

file.enco
ding

Indicates the code page on the client side. For example, cp1252, utf8,
unicodeBig, cp942.

The following is a sample siebel.properties file:

siebel.conmgr.txtimeout = 3600 
siebel.conmgr.poolsize = 5 
siebel.conmgr.sesstimeout = 300000

Parent topic: Siebel activities
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Security Token Service (STS) activities
Creating or editing an STS endpoint
A Security Token Service (STS) endpoint provides the connection information that Studio and the
Integration Appliance use to connect to an STS. You can request for a SAML 2.0 token/assertion from
STS, which complies to WS-Trust specification.
Using the STS Get SAML 2.0 Token activity
The Get SAML 2.0 Token activity is used to send a request that conforms to WS-Trust standard
specification, to the Secure Token Service (STS) Provider. The request message is called the Request
Security Token (RST). On receiving the request, the STS generates the requested token and sends it as
part of the response, called the Request Security Token Response (RSTR). For this activity, the only
token that is requested is SAML 2.0 token/assertion.
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Creating or editing an STS endpoint
A Security Token Service (STS) endpoint provides the connection information that Studio and the Integration
Appliance use to connect to an STS. You can request for a SAML 2.0 token/assertion from STS, which complies
to WS-Trust specification.

1. In the Create Endpoint or Edit Endpoint pane, configure the fields as described in the following table.
Note: Changing the configuration properties of an endpoint affects all orchestrations that use that
endpoint in the project as the edits are global, not local.

Table 1. Endpoint field description
Field Name Description

Location  

Host Name Specify the host name or IP address of the STS that this endpoint connects to.

Port Specify the port number of the STS.

Login Description
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Field Name Description

Log into the
Server as an
Anonymous
User

Select this option to connect to STS anonymously (where user account is not required).

Log into the
Server with
User Name
and
Password

Select this option to connect to STS using a user account. Specify the User Name and
Password.

Authenticati
on

Allows you to select the type of authentication that the Integration Appliance uses when
connecting to an STS server. From the list, select one of the following authentication options:

Basic - Sends the user name and password you specify unencrypted to the server. This
authentication scheme is the least secure.

User Name   Specify the User Name for the account used to connect to the STS.

Password Specify the Password for the account used to connect to the STS.

Security Description

None Select the None option if no security is required.

HTTPS Select the HTTPS option to enable secure HTTP over SSL.  

When client authentication is required, select the Client Certificate Alias Name check
box to specify that the Integration Appliance acting as a client should provide a
certificate to STS. If selected, the name of the certificate must be provided. (For
information about how to import a client certificate and private key for use with client
authentication, see Importing an end-entity certificate). A certificate specified at the
endpoint level with this check box takes precedence over certificates specified on the
Security> Certificates > Settings > Client SSL entry in the WMC.

Protocol
Version

Select the protocol used for secure HTTP over SSL. By default, the protocol version used is
SSL_TLSv2.

Connection
Timeout -
The
following
Connection
field is
available for
the Remote
Server
option only.
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Field Name Description

Time out
after ___
seconds
when
establishing
a connection
to the
Endpoint.

The number of seconds before a timeout occurs between the Integration Appliance attempting
to establish a connection to the Endpoint and the time it takes for the endpoint to respond to
the connection request. For an STS activity, the amount of time the Integration Appliance
attempts to establish a connection to STS before timing out. A connection timeout is different
from an activity timeout because an activity timeout occurs after the connection to the
endpoint has already been established. An activity timeout specifies the amount of time in
seconds before a timeout occurs between the activity invoking a request on an endpoint and
the time it takes the endpoint to respond.

Proxy - The
following
Proxy fields
are
available for
the Remote
Server
option only.

Login Description

Connect via
a Proxy
Server

Select this check box if the request has to be routed through a proxy server.

Authenticati
on

Allows you to select the type of authentication that the Integration Appliance uses when
connecting to a remote server. From the drop-down list, select one of the following
authentication options:

Basic - Sends the user name and password you specify unencrypted to the server. This
authentication schema is the least secure.
NTLM - Requires an instance of NTCredentials to be available for the domain name of
the server. This authentication is the most secure authentication option as the
Integration Appliance authenticates a connection and not a request; therefore, the
Integration Appliance authenticates every time a new connection is made. The
connection must remain open during the authentication process. You cannot use NTLM
to authenticate with both a proxy and server.
Note: Do not prefix the user name with the domain.

Realm /
Domain

If you select the Basic authentication option, specify a realm. If you select the NTLM
authentication option, specify a domain.

Host Name Specify the host name or IP address of the proxy server that the request is routed through.

Port Specify the port number of the proxy server that the request is routed through.

User Name   Specify the User Name for the account used to connect to the proxy server.

Password Specify the Password for the account used to connect to the proxy server.

Remote
Endpoint
Configuratio
n
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Field Name Description

Endpoint
Runs Behind
Firewall

Select the check box to enable the secure connector name property so that secure connector
can be used if STS is running behind a firewall.

Secure
Connector
Name

Specify the name of the secure connector that is used to connect to STS running behind a
firewall. For example, if an orchestration containing an STS activity is deployed on to Cast Iron
Live (cloud), then the secure connector needs to be configured.

Note: For some of the fields in the endpoint, you can define configuration properties to supply the values for
these fields.  The

icon is displayed when you click in a field that supports a configuration property and a configuration property of
the same type has already been configured for the project.
Parent topic: Security Token Service (STS) activities
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Using the STS Get SAML 2.0 Token activity
The Get SAML 2.0 Token activity is used to send a request that conforms to WS-Trust standard specification,
to the Secure Token Service (STS) Provider. The request message is called the Request Security Token (RST).
On receiving the request, the STS generates the requested token and sends it as part of the response, called
the Request Security Token Response (RSTR). For this activity, the only token that is requested is SAML 2.0
token/assertion.

Configuring the Get SAML 2.0 Token activity in the orchestration

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the STS folder.
3. Drag the Get SAML 2.0 Token activity onto the orchestration.
4. Select the activity. The Checklist is displayed.

The Get SAML 2.0 Token activity requires an endpoint to be configured, to send the request for a security token
to the external STS (Secure Token Service). The endpoint that is used in this activity is called the STS endpoint.
The configuration parameters and functions of this endpoint are similar to the HTTP endpoint. However, this
endpoint has properties that are specific to the Get SAML 2.0 activity.

Creating, selecting, or editing an STS endpoint

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to the "Configure the activity" procedure.

Select an existing endpoint and edit the endpoint:
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a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane is displayed.

Create a new endpoint: Select New. The Create Endpoint pane is displayed.
2. Create or edit an STS endpoint. See Creating or editing an STS endpoint.

Configuring the activity

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields and check boxes in this pane as described in the following table:

Table 1.
Fi
el
d
or
C
h
ec
k
B
ox Description

Request

U
R
L
(P
at
h
af
te
r
H
os
tn
a
m
e)

Specifies the URI path that the Get SAML 2.0 Token activity sends the request to, for example:
TrustServerWST13/services/RequestSecurityToken. The string that you specify in this field must
exclude the protocol, for example: http://, the host name, and the port number of the Integration
Appliance. The full URL is automatically constructed from the host name of the Integration
Appliance, the port number that is specified in the STS endpoint, and the URI path that is specified
in this field. For example, if the complete URL that the Get SAML 2.0 Token activity sends the
request to, is http://<applianceHost>:<appliancePort>/<URI>, in this field, you must only specify
the URI.

SAML Security Token Service Properties

R
e
q
ue
st
Ty
p
e

This activity supports only issuing of SAML 2.0 token/assertion. The default value is
http://docs.oasis-open.org/ws-sx/ws-trust/200512/Issue.
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Fi
el
d
or
C
h
ec
k
B
ox Description

Request

A
p
pli
es
To

The recipient endpoint reference/entity of SAML 2.0 token/assertion.

Is
su
er

The authority responsible for issuing SAML 2.0 token/assertion.

To
ke
n
Ty
p
e

This activity issues SAML 2.0 token/assertion. The default value is SAML v2.0. If you select None
as the Token Type, then, no token type is sent as a part of the request.
Note: Some STS services do not require a token type, but issues tokens that are based on the
configurations in STS.

Mapping the input into the activity

1. Select the Map Inputs task in the Checklist. The header input parameter is displayed in the To Activity
pane of the Map Inputs task. The header input parameter is mandatory. The header input parameter
contains the WSSE standard Username Token.

2. To view the optional input parameter in the To Activity pane of the Map Inputs pane, select Map > Show
Optional Parameters from the toolbar menu or right-click in the To Activity pane and select the Show
Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in the
toolbar menu, click a node in the Map Inputs pane to make this option active. The requestSecurityToken,
location, httpheaders, and proxyConnection input parameters are displayed.
The following table defines the nodes of the optional httpheaders input parameter:

Table 2.
Input
parameter Description

requestSecu
rityToken

requestSecurityToken is sent as a SOAP body, which is interpreted by STS. Based
on the input, STS issues the SAML 2.0 token/assertion.
Note: If the values are populated in requestSecurityToken, the values that are
provided in the Configure panel will not be considered.

3. Create a map between the orchestration variable or variables and the input parameter or parameters.
See Creating a map for general instructions on mapping

Mapping the output of the activity
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1. Select the Map Outputs task in the Checklist. The output parameters of the activity are displayed in the
From Activity pane of the Map Outputs task as described in the following table:

Table 3.
Output Parameter Description

httpheaders Specifies the HTTP header of the response.

assertion Contains the SAML 2.0 token/assertion.

2. Create a map between the output parameter or parameters of the activity and orchestration variable or
variables. See Creating a map for general instructions on mapping.

Parent topic: Security Token Service (STS) activities
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SugarCRM activities
Creating and editing a SugarCRM endpoint
SugarCRM endpoints contain the connection information that studio and the Integration Appliance use
to connect to the SugarCRM Server. You can create multiple endpoints that refer to separate instances.
Using the SugarCRM Upsert Object activity
Use the SugarCRM Upsert Object activity to update or insert objects in the SugarCRM instance.
Using the SugarCRM Get Reports activity
Use the SugarCRM Get Reports activity to retrieve specific reports from the SugarCRM server.
Using the SugarCRM Delete Object activity
Use the SugarCRM Delete Object activity to delete objects from the SugarCRM server.
Using the SugarCRM Get Object activity
Use the SugarCRM Get Object activity to get objects from the SugarCRM server.
Using the SugarCRM Query Object activity
Use the SugarCRM Query Object activity to query objects in the SugarCRM server.
Using the SugarCRM Get ServerInfo activity
Use the SugarCRM Get ServerInfo activity to retrieve server information such as flavor, version, and GMT
time from the SugarCRM server.
Using the SugarCRM Get UserInfo activity
Use the SugarCRM Get UserInfo activity to retrieve user information such as userId, userTeamId, and so
on from the SugarCRM server.
Using the SugarCRM Search activity
Use the SugarCRM Search activity to search for objects from specified records. This activity searches for
details based on a query.
Using the SugarCRM Set Relationship activity
Use the SugarCRM Set Relationship activity to set a single relationship between two records.
Using the SugarCRM Delete Relationship activity
Use the SugarCRM Delete Relationship activity to delete a relationship between two records.
Using the SugarCRM Get Relationship activity
Use the SugarCRM Get Relationship activity to retrieve the relationship data between two records. For
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example, you can use this activity to retrieve the contact details of a particular account and also retrieve
the e-mail address and the opportunities information for that contact.
Specifying the Retry options for SugarCRM activities
Specifying the Retry parameters is one of the tasks to configure an SugarCRM activity. The SugarCRM
connector uses a single login session for all connections to an SugarCRM endpoint. If a session expires,
the connector automatically establishes a new session. The connector does not count the initial attempt
to reacquiring the session as a retry attempt. The connector assumes the typical connector retry
behavior after the initial attempt to reacquire a session fails.
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Creating and editing a SugarCRM endpoint
SugarCRM endpoints contain the connection information that studio and the Integration Appliance use to
connect to the SugarCRM Server. You can create multiple endpoints that refer to separate instances.

About this task

Use this task to create or edit a SugarCRM endpoint.
Note:
Any changes you make to the SugarCRM endpoint, including configuration properties, affects all the
orchestrations that use that endpoint, as the edits are global, not local.

Procedure

1. Drag an activity from the SugarCRM folder under the Activities tab to the Orchestration window. The
Summary panel is displayed.

2. Click Pick Endpoint from the Checklist. The Pick Endpoint panel is displayed.
3. Click one of the following buttons:

a. Browse - To select an existing endpoint from Project Explorer. The Project Explorer shows all the
endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel.

b. New - To create a new endpoint. The Create Endpoint window opens.
c. Edit - To edit the existing endpoint. The Edit Endpoint window opens.

4. Complete the fields defined in the following table:
Table 1. Connection Details

Field Name Description

Connection Details

SugarCRM URL Specify the SOAP URL of your SugarCRM instance. For example,
http:/<sugar-server>/<sugar-path>/soap.php.

User Name Specifies the user name to connect to the SugarCRM server.
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Field Name Description

Password Specifies the password associated with the user name to connect to the
SugarCRM server.

Application Name Indicates the name of the application used. The application name is
populated automatically as sugarCRM.

Version Indicates the version of the application used. The version number is
populated automatically as 2.0.

5. When finished, click Test Connection to confirm that you can connect to the SugarCRM system.
6. Click OK.

Parent topic: SugarCRM activities
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Using the SugarCRM Upsert Object activity
Use the SugarCRM Upsert Object activity to update or insert objects in the SugarCRM instance.

About this task

Use this task to update or insert objects in the SugarCRM instance. The call to this activity is a synchronous call
where the input data is sent to the activity for processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Upsert Object activity icon onto the orchestration. The SugarCRM Upsert Object Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse SugarCRM window is displayed.
11. In Browse SugarCRM, you can either filter the object type by specifying the object type in the Search for

an object type field, or select the object type from the object type list. Click OK. The object field
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preferences are displayed.
12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding

field name check boxes.
13. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for SugarCRM activities.
14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Upsert Object activity are displayed as nodes under the request input parameter in the To Activity panel.
15. Create a map between the orchestration variables and the input parameter of the activity.

Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Upsert Object activity.

Note: You can add more than one object as input to this activity. To add more than one object as input, right
click the object in the To Activity pane of Map Inputs, and select Expand Occurrences. Only multiple objects of
the same type is supported.
Parent topic: SugarCRM activities
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Using the SugarCRM Get Reports activity
Use the SugarCRM Get Reports activity to retrieve specific reports from the SugarCRM server.

About this task

Use this task to retrieve specific reports from the SugarCRM server. The call to this activity is a synchronous call
where the input data is sent to the activity for processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Get Reports activity icon onto the orchestration. The SugarCRM Get Reports Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
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6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get
Reports activity are displayed as nodes under the request input parameter in the To Activity panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Get Reports activity.

Note: You can add more than one object as input to this activity. To add more than one object as input, right
click the object in the To Activity pane of Map Inputs, and select Expand Occurrences. Only multiple objects of
the same type is supported.
Parent topic: SugarCRM activities
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Using the SugarCRM Delete Object activity
Use the SugarCRM Delete Object activity to delete objects from the SugarCRM server.

About this task

Use this task to delete objects from the SugarCRM server. The call to this activity is a synchronous call where
the input data is sent to the activity for processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Delete Object activity icon onto the orchestration. The SugarCRM Delete Object Checklist is

displayed.
3. In the Checklist, click Summary.
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4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse SugarCRM window is displayed.
11. In Browse SugarCRM, you can either filter the object type by specifying the object type in the Search for

an object type field, or select the object type from the object type list.
12. Click OK. The object field preferences are displayed.
13. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for SugarCRM activities.
14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Delete Object activity are displayed as nodes under the request input parameter in the To Activity panel.
15. Create a map between the orchestration variables and the input parameter of the activity.

Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Delete Object activity.

Note: You can add more than one object as input to this activity. To add more than one object as input, right
click the object in the To Activity pane of Map Inputs, and select Expand Occurrences. Only multiple objects of
the same type is supported.
Parent topic: SugarCRM activities
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Using the SugarCRM Get Object activity
Use the SugarCRM Get Object activity to get objects from the SugarCRM server.

About this task
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Use this task to get objects from the SugarCRM server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Get Object activity icon onto the orchestration. The SugarCRM Get Object Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse SugarCRM window is displayed.
11. In Browse SugarCRM, you can either filter the object type by specifying the object type in the Search for

an object type field, or select the object type from the object type list.
12. Click OK. The object field preferences are displayed.
13. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding

field name check boxes.
14. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for SugarCRM activities.
15. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get

Object activity are displayed as nodes under the request input parameter in the To Activity panel.
16. Create a map between the orchestration variables and the input parameter of the activity.

Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for the element or by linking the element with an input
node. During run time, if no value is provided for a mandatory element, the activity throws an exception,
which is reported by the Web Management Console. If a value is not provided at run time for an optional
input parameter, no exception is thrown during run time.

17. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

18. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Get Object activity.

Note: You can add more than one object as input to this activity. To add more than one object as input, right
click the object in the To Activity pane of Map Inputs, and select Expand Occurrences. Only multiple objects of
the same type is supported.
Parent topic: SugarCRM activities
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Using the SugarCRM Query Object activity
Use the SugarCRM Query Object activity to query objects in the SugarCRM server.

About this task

Use this task to query objects in the SugarCRM server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Query Object activity icon onto the orchestration. The SugarCRM Query Object Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse SugarCRM window is displayed.
11. In Browse SugarCRM, you can either filter the object type by specifying the object type in the Search for

an object type field, or select the object type from the object type list.
12. Click OK. The object field preferences are displayed.
13. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding

field name check boxes.
14. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for SugarCRM activities.
15. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Query Object activity are displayed as nodes under the request input parameter in the To Activity panel.
Note: To retrieve all deleted objects, set the required string in the QueryString, under Map Inputs. For
example, to retrieve all deleted account objects, the query string should be accounts.deleted=1.

16. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

17. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

18. Create a map between the output parameters and orchestration variables.

Results
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You have configured the SugarCRM Query Object activity.
Parent topic: SugarCRM activities
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Using the SugarCRM Get ServerInfo activity
Use the SugarCRM Get ServerInfo activity to retrieve server information such as flavor, version, and GMT time
from the SugarCRM server.

About this task

Use this task to retrieve server information such as flavor, version, and GMT time from the SugarCRM server.
The call to this activity is a synchronous call where the input data is sent to the activity for processing and the
response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Get ServerInfo activity icon onto the orchestration. The SugarCRM Get ServerInfo Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get
ServerInfo activity are displayed as nodes under the request input parameter in the To Activity panel.

10. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

11. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Get ServerInfo activity.
Parent topic: SugarCRM activities
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Using the SugarCRM Get UserInfo activity
Use the SugarCRM Get UserInfo activity to retrieve user information such as userId, userTeamId, and so on
from the SugarCRM server.

About this task

Use this task to retrieve user information such as such as userId, userTeamId, and so on from the SugarCRM
server. The call to this activity is a synchronous call where the input data is sent to the activity for processing
and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Get UserInfo activity icon onto the orchestration. The SugarCRM Get UserInfo Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get
UserInfo activity are displayed as nodes under the request input parameter in the To Activity panel.

10. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

11. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Get UserInfo activity.
Parent topic: SugarCRM activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

 665



http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/SugarCRM_getuserinfo_activity.html

Using the SugarCRM Search activity
Use the SugarCRM Search activity to search for objects from specified records. This activity searches for details
based on a query.

About this task

Use this task to to search for objects from specified records. The call to this activity is a synchronous call where
the input data is sent to the activity for processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Search activity icon onto the orchestration. The SugarCRM Search Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Search activity are displayed as nodes under the request input parameter in the To Activity panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Search activity.
Parent topic: SugarCRM activities
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Using the SugarCRM Set Relationship activity
Use the SugarCRM Set Relationship activity to set a single relationship between two records.

About this task

Use this task to set a single relationship between two records. The call to this activity is a synchronous call
where the input data is sent to the activity for processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Set Relationship activity icon onto the orchestration. The SugarCRM Set Relationship Checklist

is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse SugarCRM window is displayed.
11. In Browse SugarCRM, you can either filter the object type by specifying the object type in the Search for

an object type field, or select the object type from the object type list.
12. Click OK. The object field preferences are displayed.
13. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding

field name check boxes.
14. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for SugarCRM activities.
15. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Set

Relationship activity are displayed as nodes under the request input parameter in the To Activity panel.
16. Create a map between the orchestration variables and the input parameter of the activity.

Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

17. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

18. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Set Relationship activity.
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Note: You can add more than one object as input to this activity. To add more than one object as input, right
click the object in the To Activity pane of Map Inputs, and select Expand Occurrences. Only multiple objects of
the same type is supported.
Parent topic: SugarCRM activities
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Using the SugarCRM Delete Relationship activity
Use the SugarCRM Delete Relationship activity to delete a relationship between two records.

About this task

Use this task to delete a relationship between two records. The call to this activity is a synchronous call where
the input data is sent to the activity for processing and the response is sent back to the orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Delete Relationship activity icon onto the orchestration. The SugarCRM Delete Relationship

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse SugarCRM window is displayed.
11. In Browse SugarCRM, you can either filter the object type by specifying the object type in the Search for

an object type field, or select the object type from the object type list.
12. Click OK. The object field preferences are displayed.
13. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding

field name check boxes.
14. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for SugarCRM activities.
15. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Delete Relationship activity are displayed as nodes under the request input parameter in the To Activity
panel.

16. Create a map between the orchestration variables and the input parameter of the activity.
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Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

17. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

18. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Delete Relationship activity.

Note: You can add more than one object as input to this activity. To add more than one object as input, right
click the object in the To Activity pane of Map Inputs, and select Expand Occurrences. Only multiple objects of
the same type is supported.
Parent topic: SugarCRM activities
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Using the SugarCRM Get Relationship activity
Use the SugarCRM Get Relationship activity to retrieve the relationship data between two records. For
example, you can use this activity to retrieve the contact details of a particular account and also retrieve the e-
mail address and the opportunities information for that contact.

About this task

Use this task to retrieve the relationship data between two records. The call to this activity is a synchronous
call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

Procedure

1. In an active orchestration, open the Activities tab and expand the SugarCRM folder contents.
2. Drag the Get Relationship activity icon onto the orchestration. The SugarCRM Get Relationship Checklist

is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant SugarCRM endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a SugarCRM endpoint.
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8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse SugarCRM window is displayed.
11. In Browse SugarCRM, you can either filter the object type by specifying the object type in the Search for

an object type field, or select the object type from the object type list.
12. Click OK. The object field preferences are displayed.
13. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding

field name check boxes.
14. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for SugarCRM activities.
15. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get

Relationship activity are displayed as nodes under the request input parameter in the To Activity panel.
16. Create a map between the orchestration variables and the input parameter of the activity.

Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

17. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

18. Create a map between the output parameters and orchestration variables.

Results

You have configured the SugarCRM Get Relationship activity.

Note: You can add more than one object as input to this activity. To add more than one object as input, right
click the object in the To Activity pane of Map Inputs, and select Expand Occurrences. Only multiple objects of
the same type is supported.
Parent topic: SugarCRM activities
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Specifying the Retry options for SugarCRM activities
Specifying the Retry parameters is one of the tasks to configure an SugarCRM activity. The SugarCRM
connector uses a single login session for all connections to an SugarCRM endpoint. If a session expires, the
connector automatically establishes a new session. The connector does not count the initial attempt to
reacquiring the session as a retry attempt. The connector assumes the typical connector retry behavior after
the initial attempt to reacquire a session fails.

About this task
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Use this task to configure the Retry options for SugarCRM activities.

Procedure

1. Select the Retry task from the Checklist. The retry pane is displayed.
2. Configure the retry and timeout options for connecting to an SugarCRM instance, as described in the

following table:
Table 1. Retry options

Retry
Fields Description

Wait __
seconds
between
each
retry.

Specifies the number of seconds that the Integration Appliance waits before trying to
establish a connection to the SugarCRM instance.

Try to
connect
__ times
before
failing.

Specifies the retry count — the maximum number of times the Integration Appliance
attempts to establish a connection to the SugarCRM instance before issuing an error and
stopping the processing of the current orchestration job.

Note: If you deploy an orchestration that contains the SugarCRM activity and the Integration
Appliance cannot connect to the specified SugarCRM instance, the Integration Appliance
logs the connections errors as Warnings in the system and orchestration logs until the retry
count value is reached. When the retry count is reached, the Integration Appliance logs an
Error in the system and orchestration logs and stops processing the current orchestration
job. For example, you set the retry count to 3, the first, second, and third connection errors
appear in the system log as warnings. The Integration Appliance logs the fourth connection
error as an error and stops processing the current orchestration job.

Activity
Timeout

Timeout
after
____
seconds
when
the
endpoint
does not
respond
to a
request.

Specifies the number of seconds the Integration Appliance waits before timing out, when
the endpoint does not respond to a request. The default is 300 seconds.
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Taleo activities
Creating and editing a Taleo endpoint
Taleo endpoints contain the connection information that Studio and the Integration Appliance use to
connect to the Taleo HR Community, Resources, Application, and Recruitment database. You can create
multiple endpoints that refer to separate instances.
Using the Taleo Create Attachments activity
Use the Taleo Create Attachments activity to create appended files associated with an object. For
example, creating interview letters and appointment orders for a candidate in the Taleo server.
Using the Taleo Create Objects activity
Use the Taleo Create Objects activity to create objects such as Employee, Task, Calendar Event,
Account, Candidate, Contact, Interview, Requisition, and User in the Taleo server.
Using the Taleo Get Objects activity
Use the Taleo Get Objects activity to get objects such as Employee, Task, Calendar Event, Account,
Candidate, Contact, Interview, Requisition, and User from the Taleo server.
Using the Taleo Search Objects activity
Use the Taleo Search Objects activity to search for objects based on the search value entered in the field
name, in the Taleo server.
Using the Taleo Delete Objects activity
Use the Taleo Objects activity to delete objects such as Employee, Task, Calendar Event, Account,
Candidate, Contact, Interview, Requisition, and User from the Taleo server.
Using the Taleo Set Associated Users activity
Use the Taleo Set Associated Users activity to set an association with specific users and requisitions, in
the Taleo server. Requisitions contain details of all the job openings that you want to track in Taleo.
Using the Taleo Set Binary Resume activity
Use the Taleo Set Binary Resume activity to append resumes in a binary format (Word, PDF, and so on)
to Candidate IDs in the Taleo server.
Using the Taleo Submit Candidates activity
Use the Taleo Submit Candidates activity to submit candidates (Candidate ID) who are either applicants,
employee referrals, sourced prospects, or agency submissions, for requisitions (job openings) in the
Taleo server.
Using the Taleo Update Attachments activity
Use the Taleo Update Attachments activity to update attachments associated with Candidates in the
Taleo server. The update request replaces the existing attachment file.
Using the Taleo Update Objects activity
Use the Taleo Update Objects activity to update objects such as Employee, Task, Calendar Event,
Account, Candidate, Contact, Interview, Requisition, and User in the Taleo server.
Using the Taleo Upsert Objects activity
Use the Taleo Upsert Objects activity to insert or update employee records in the Taleo server.
Specifying retry parameters for Taleo activities
Specifying the retry parameters is one of the tasks you must complete to configure a Taleo activity.
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Creating and editing a Taleo endpoint
Taleo endpoints contain the connection information that Studio and the Integration Appliance use to connect
to the Taleo HR Community, Resources, Application, and Recruitment database. You can create multiple
endpoints that refer to separate instances.

About this task

Use this task to create or edit a Taleo endpoint. The call to this activity is a synchronous call where the input
data is sent to the activity for processing and the response is sent back to the orchestration.
Note:
Any changes you make to the Taleo endpoint, including configuration properties, affects all the orchestrations
that use that endpoint, as the edits are global, not local.

To create and edit a Taleo endpoint, complete the following steps:

Procedure

1. Drag an activity from the Taleo folder under the Activities tab, to the Orchestration window. The
Summary panel is displayed.

2. Click Pick Endpoint from the Checklist. The Pick Endpoint panel is displayed.
3. Click one of the following buttons:

a. Browse - To select an existing endpoint from Project Explorer. The Project Explorer shows all the
endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel.

b. New - To create a new endpoint. The Create Endpoint window opens.
c. Edit - To edit the existing endpoint. The Edit Endpoint window opens.

4. In the Create Endpoint window, complete the fields defined in the following table:
Table 1. Connection details

Field Name Description

Connection Details

Instance Name Specifies the name of the Taleo instance.

User Name Specifies the user name to connect to the Taleo server.

Password Specifies the password associated with the user name to connect to the
Taleo server.

5. When finished, click Test Connection to confirm that you can connect to the Taleo system.
6. Click OK.

Results

You have created or edited a Taleo endpoint.
Parent topic: Taleo activities
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Using the Taleo Create Attachments activity
Use the Taleo Create Attachments activity to create appended files associated with an object. For example,
creating interview letters and appointment orders for a candidate in the Taleo server.

About this task

Use this task to create attachments in the Taleo server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Taleo Create Attachments activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Create Attachments activity icon onto the orchestration. The Taleo Create Attachments

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Create Attachments activity are displayed as nodes under the request input parameter in the To Activity
panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Create Attachments activity.
Parent topic: Taleo activities
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Using the Taleo Create Objects activity
Use the Taleo Create Objects activity to create objects such as Employee, Task, Calendar Event, Account,
Candidate, Contact, Interview, Requisition, and User in the Taleo server.

About this task

Use this task to create objects in the Taleo server. The call to this activity is a synchronous call where the input
data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Taleo Create Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Create Objects activity icon onto the orchestration. The Taleo Create Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Taleo window is displayed.
11. In Browse Taleo, you can either filter the object type by specifying the object type in the Search for an

object type field, or select the object type from the object type list. Click OK. The object field preferences
are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for Taleo activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Create Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
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is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Create Objects activity.
Parent topic: Taleo activities
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Using the Taleo Get Objects activity
Use the Taleo Get Objects activity to get objects such as Employee, Task, Calendar Event, Account, Candidate,
Contact, Interview, Requisition, and User from the Taleo server.

About this task

Use this task to get objects from the Taleo server. The call to this activity is a synchronous call where the input
data is sent to the activity for processing and the response is sent back to the orchestration.

To configure Taleo Get Objects, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Get Objects activity icon onto the orchestration. The Taleo Get Objects Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Taleo window is displayed.
11. In Browse Taleo, you can either filter the object type by specifying the object type in the Search for an

object type field, or select the object type from the object type list. Click OK. The object field preferences
are displayed.
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12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for Taleo activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Get
Objects activity are displayed as nodes under the request input parameter in the To Activity panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Get Objects activity.
Parent topic: Taleo activities
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Using the Taleo Search Objects activity
Use the Taleo Search Objects activity to search for objects based on the search value entered in the field name,
in the Taleo server.

About this task

Use this task to search for objects in the Taleo server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Taleo Search Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Search Objects activity icon onto the orchestration. The Taleo Search Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
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7. Optional: You can create the endpoint by clicking New and specifying the required connection details.
Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Search Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Search Objects activity.
Parent topic: Taleo activities
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Using the Taleo Delete Objects activity
Use the Taleo Objects activity to delete objects such as Employee, Task, Calendar Event, Account, Candidate,
Contact, Interview, Requisition, and User from the Taleo server.

About this task

Use this task to delete objects from the Taleo server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Taleo Delete Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Delete Objects activity icon onto the orchestration. The Taleo Delete Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
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5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Taleo window is displayed.
11. In Browse Taleo, you can either filter the object type by specifying the object type in the Search for an

object type field, or select the object type from the object type list. Click OK. The object field preferences
are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for Taleo activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Delete Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Delete Objects activity.
Parent topic: Taleo activities
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Using the Taleo Set Associated Users activity
Use the Taleo Set Associated Users activity to set an association with specific users and requisitions, in the
Taleo server. Requisitions contain details of all the job openings that you want to track in Taleo.

About this task
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Use this task to set an association with users and requisitions. The call to this activity is a synchronous call
where the input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Taleo Set Associated Users activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Set Associated Users activity icon onto the orchestration. The Taleo Set Associated Users

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Set
Associated Users activity are displayed as nodes under the request input parameter in the To Activity
panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Set Associated Users activity.
Parent topic: Taleo activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Taleo_set_associated_user_activity.ht
ml

Using the Taleo Set Binary Resume activity
Use the Taleo Set Binary Resume activity to append resumes in a binary format (Word, PDF, and so on) to
Candidate IDs in the Taleo server.

680   



About this task

Use this task to append binary resumes to Candidate IDs in the Taleo server. The call to this activity is a
synchronous call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

To configure the Taleo Set Binary Resume activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Set Binary Resumes activity icon onto the orchestration. The Taleo Set Binary Resumes

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the Set
Binary Resumes activity are displayed as nodes under the request input parameter in the To Activity
panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Set Binary Resumes activity.
Parent topic: Taleo activities
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Using the Taleo Submit Candidates activity
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Use the Taleo Submit Candidates activity to submit candidates (Candidate ID) who are either applicants,
employee referrals, sourced prospects, or agency submissions, for requisitions (job openings) in the Taleo
server.

About this task

Use this task to submit candidates in the Taleo server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Taleo Submit Candidates activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Submit Candidates activity icon onto the orchestration. The Taleo Submit Candidates Checklist

is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Submit Candidates activity are displayed as nodes under the request input parameter in the To Activity
panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Submit Candidates activity.
Parent topic: Taleo activities
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Using the Taleo Update Attachments activity
Use the Taleo Update Attachments activity to update attachments associated with Candidates in the Taleo
server. The update request replaces the existing attachment file.

About this task

Use this task to update attachments in the Taleo server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Taleo Update Attachments activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Update Attachments activity icon onto the orchestration. The Taleo Update

AttachmentsChecklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Update Attachments activity are displayed as nodes under the request input parameter in the To Activity
panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Update Attachments activity.
Parent topic: Taleo activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

 683



http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Taleo_update_attachments_activity.ht
ml

Using the Taleo Update Objects activity
Use the Taleo Update Objects activity to update objects such as Employee, Task, Calendar Event, Account,
Candidate, Contact, Interview, Requisition, and User in the Taleo server.

About this task

Use this task to updates objects in the Taleo server. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Taleo Update Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Update Objects activity icon onto the orchestration. The Taleo Update Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Taleo window is displayed.
11. In Browse Taleo, you can either filter the object type by specifying the object type in the Search for an

object type field, or select the object type from the object type list. Click OK. The object field preferences
are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for Taleo activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Update Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

15. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

684   



Results

You have configured the Taleo Update Objects activity.
Parent topic: Taleo activities

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Taleo_update_objects_activity.html

Using the Taleo Upsert Objects activity
Use the Taleo Upsert Objects activity to insert or update employee records in the Taleo server.

About this task

Use this task to insert or update employee records in the Taleo server. The call to this activity is a synchronous
call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

To configure the Taleo Upsert Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Taleo folder contents.
2. Drag the Upsert Objects activity icon onto the orchestration. The Taleo Upsert Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Taleo endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Taleo endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Taleo window is displayed.
11. In Browse Taleo, you can either filter the object type by specifying the object type in the Search for an

object type field, or select the object type from the object type list. Click OK. The object field preferences
are displayed.

12. In Object Field Preferences, select the fields that you would like to map by selecting the corresponding
field name check boxes.

13. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying retry parameters for Taleo activities.

14. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Upsert Objects activity are displayed as nodes under the request input parameter in the To Activity
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panel.
15. Create a map between the orchestration variables and the input parameter of the activity.

Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

16. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

17. Create a map between the output parameters and orchestration variables.

Results

You have configured the Taleo Upsert Objects activity.
Parent topic: Taleo activities
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Specifying retry parameters for Taleo activities
Specifying the retry parameters is one of the tasks you must complete to configure a Taleo activity.

About this task

The Taleo connector connects to the Taleo application to execute the activities. If a connection is lost or timed
out, the connector automatically establishes a new connection based on the parameters described in Table 1.
The connector does not count the initial attempt to reacquiring the session as a retry attempt. The connector
assumes the typical connector retry behavior after the initial attempt to reacquire a session fails.

For more information about the configuration tasks in the Checklist, see the help topic for the specific Taleo
activity.

To specify the retry parameters, complete the following steps:

Procedure

1. In the Checklist, select Retry. The Retry panel is displayed.
2. Configure the retry options for connecting to a Taleo application.

The following table describes the retry options for connecting to a Taleo application:
Table 1. Retry options

Retry Fields Description

Wait __ second(s)
between each retry.

Specifies the number of seconds that the Integration Appliance waits before
trying to establish a connection to the Taleo application. By default, this
parameter is set to 30 seconds.
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Retry Fields Description

Try to connect __
times before failing.

Specifies the maximum number of times that the Integration Appliance
attempts to establish a connection to the Taleo application before issuing an
error and stopping the processing of the current orchestration job. By default
this parameter is set to 5 attempts.

Activity Timeout

Time out after __
second(s) when the
endpoint does not
respond to a request.

Specifies the number of seconds the Integration Appliance waits before timing
out, when the endpoint does not respond to a request. The default is 300
seconds.

Results

You have configured the retry parameters for Taleo activities.
Parent topic: Taleo activities
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Web Services Activities
Creating or Editing a Web Services Endpoint
You can define two types of Web Services endpoints.
Updating a Changed WSDL
If you created a project that uses a WSDL and the WSDL changes, you can attempt to update the existing
WSDL with the new WSDL.
Web Services Invoke Service Activity
During run time, the Web Services Invoke Service activity starts an outside Web Service.
Compression/Decompression with the Web Services Invoke Service Activity
During run time, the Web Services Invoke Service activity sends a HTTP request complaint with the
HTTP/HTTPS 1.1 protocol to the Web Service. The Invoke Service activity supports compression with
the gzip format only and decompression with the gzip or the deflate formats.
Web Services Provide Service Activity
During run time the Provide Service activity provides a Web Service that can be started from an outside
client.
Decompression with the Web Services Provide Service Activity
The Web Services Provide Service activity supports decompression with the gzip format only.
Web Services Send Reply Activity
During run time, the Send Reply activity returns a response for a Provide Service activity.
Web Services Send Reply with Fault Activity
During run time, the Send Reply with Fault activity returns a fault to the calling orchestration. This
activity provides SOAP functionality as a reply configuration option.
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Compression with the Web Services Send Reply Activity
During run time, the Web Services Send Reply activity sends an HTTP response complaint with the
HTTP/HTTPS 1.0 protocol to the client. The Send Reply activity supports compression with the gzip
format only.
Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly.
Here, you can find potential solutions for issues you would have with the Web Services connector.
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Creating or Editing a Web Services Endpoint
You can define two types of Web Services endpoints.

About this task

For the Invoke Service activity - the endpoint defines the remote Web Service server and service that is
started during run time.

For the Provide Service activity - the endpoint defines the port number and the path of the service provided by
the Integration Appliance.

Creating or editing an endpoint for an Invoke Service activity
Create or edit a Web Service endpoint for a Invoke Service activity.
Creating or editing an endpoint for a Provide Service activity
Create or edit a Web Service endpoint for a Provide Service activity.

Parent topic: Web Services Activities
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Creating or editing an endpoint for an Invoke Service activity
Create or edit a Web Service endpoint for a Invoke Service activity.

Procedure
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1. In the Create Endpoint or Edit Endpoint pane, select the Remote Server option and click Browse. The
Project Explorer displays.

2. In the Project Explorer pane, you can select one of the following options to select a WSDL file:
In the Project Explorer pane, select an existing WSDL file that has already been uploaded into the
project.
Select a WSDL file from the file system: Click Add. In the Add dialog box, browse for the WSDL file
and click Add.
Download a WSDL file from a URL: Click Add URL. In the Add field, enter the URL of the WSDL to
download. Click OK.

Note:
The WSDL file you select must be compatible with the WSDL 1.1 and WS-I Basic Profile 1.1
specifications.
While editing an existing Web Service endpoint that is referenced by an Invoke Service activity, if
you select a different WSDL for the endpoint, you must select the appropriate operation in the
Configure task of the Web Services Invoke Service Activity.  

The WSDL Name, Service, Port, and Location fields display with the values specified in the WSDL file as
described in the following list:

WSDL Name
XML element in the WSDL file that defines this field:

<definitions targetNamespace="http://www.acme.com/wsdl/hello.wsdl" 
    xmlns="http://schemas.xmlsoap.org/wsdl/" 
    xmlns:tns="http://www.acme.com/wsdl/hello.wsdl" 
    xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 
    xmlns:soap="http://schemas.xmlsoap.org/wsdl/soap/ 
...</definitions>

Description: Specifies the name of the Web Service and the namespaces used in the WSDL. In
addition, the definitions element is the root element for the rest of the elements that define the
Web Service. These other elements are contained within the </definitions> elements in
WSDL.

Service
XML element in the WSDL file that defines this field:

<service name="HelloWorld"> 
  <port name="HelloWorld" binding="s0:HelloWorld"> 
<soap:address location="http://localhost:7001/WS/HelloWorld.jws"/> 
</port> 
</service>  

Description: Specifies the name of the service. In the WSDL, the service element contains the
port and location elements that define the location of the service. One or more services can be
defined in a WSDL. If more than one service is defined, you can select a service by selecting the
menu in the Service field of the endpoint pane.

Port
XML element in the WSDL file that defines this field:

<port name="HelloWorld" binding="s0:HelloWorld"> 
<soap:address location="http://localhost:7001/WS/HelloWorld.jws"/> 
</port>

Description: Specifies the binding of the service. One or more ports can be defined per service in
a WSDL. If more than one port is defined for the service, you can select a port by selecting the
menu in the Port field of the endpoint pane.

Location
XML element in the WSDL file that defines this field:
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<soap:address location="http://localhost:7001/WS/HelloWorld.jws"/>

Description: Specifies the address for starting the specified service. Typically this is the URL for
starting the Soap service.

3. Select a service from the Service list. See the previous table for details.
4. Select a port from the Port list. See the previous table for details.
5. Choose a Login option and specify settings described in the following table as needed.

Note: These options are only available when you select the Remote Server Location option.
Table 1. Login options

Option/Fi
eld Name

Description

Log into
the
Server as
an
Anonymo
us User

Select this option to connect to the server anonymously. No user account
information is required.

Log into
the
Server
with User
Name
and
Password

Select this option to connect to the server using a user account. When you select
this option, you must choose an authentication mode and specify a user name
and password.

Authentic
ation

Allows you to select the type of authentication that the Integration Appliance
uses when connecting to a remote server. From the list, select one of the
following authentication modes:

Basic - Sends the user name and password you specify unencrypted to
the server. This authentication schema is the least secure.
Note: If the Remote Server is Cast Iron Live web service provider, then
use the IBM ID credential for basic authentication.
Digest - Encrypts the user name and password you specify before
sending the user name and password to the server. This authentication
option is more secure than Basic authentication.
NTLM - Requires an instance of NTCredentials to be available for the
domain name of the server. This authentication is the most secure
authentication option.
When you choose the NTLM authentication option, the Integration
Appliance authenticates a connection and not a request; therefore, the
Integration Appliance authenticates every time a new connection is
made. The connection must remain open during the authentication
process. You cannot use NTLM to authenticate with both a proxy and
server.
Note: Do not prefix the user name with the domain.

Realm/Do
main

If you select the Basic or Digest authentication option, you can specify a
realm. When you do not specify a realm, the activity authenticates to 'any
realm'.
If you select the NTLM authentication option, you must specify a domain.
If you do not specify a domain, the endpoint configuration is not valid and
an error occurs.
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Option/Fi
eld Name

Description

User
Name

Specifies the User Name for the account used to connect to the Server.

Password Specifies the Password for the account used to connect to the HTTP Server.

6. Specify security options.

When client authentication is required, select the Client Certificate Alias Name check box to specify that
the Integration Appliance acting as a client should provide a certificate to the HTTP Server. If selected,
the name of the certificate must be provided. A certificate specified at the activity level with this check
box takes precedence over a certificate specified on the Security-> Certificates-> Settings-> Client
SSL entry in the WMC.

Select the Protocol Version used for secure HTTP over SSL. By default, the protocol version used is
SSL_TLSv2.

7. For the Connection Pool Options, specify the maximum number of connections.

This value specifies the maximum number of connections that the Integration Appliance has open in the
connection pool. By default, the Integration Appliance can have 25 connections open.

8. Specify the Connection Timeout. The connection timeout specifies the amount of time in seconds before
a timeout occurs between the Integration Appliance attempting to establish a connection to the
Endpoint and the time it takes for the Endpoint to respond to the connection request. For a Web Services
activity, the amount of time the Integration Appliance attempts to establish a connection to the Web
Service before timing out. A connection timeout is different from an activity timeout because an activity
timeout occurs after the connection to the Endpoint has already been established. An activity timeout
specifies the amount of time in seconds before a timeout occurs between the activity invoking a request
on an Endpoint and the time it takes the Endpoint to respond. You set the activity timeout in Retry task
of the Web Services Invoke Service Activity.

9. Optional - To connect the Web Service through a proxy server, select the Connect via a Proxy Server
check box and specify the fields defined in the following table:
Figure 1. Web Service options

Table 2.
Field name in Endpoint
pane

Description Required or Optional?

Host Name Specifies the hostname of
the proxy server.

Required

Port Specifies the port number to
use to connect to the proxy
server.

Required

User Name Specifies the username to
use for proxy server
authentication.

Optional - If your proxy
server does not require
authentication

Password Specifies the password to
use for proxy server
authentication.

Optional -  If your proxy
server does not require
authentication

Parent topic: Creating or Editing a Web Services Endpoint
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Creating or editing an endpoint for a Provide Service activity
Create or edit a Web Service endpoint for a Provide Service activity.

Procedure

1. In the Create Endpoint or Edit Endpoint pane, select the Provide option and configure the relevant fields.
Note: Changing the configuration properties of an endpoint affects all of the orchestrations that use that
endpoint in the project. These changes are global, not local.

2. 

Transport
Select one of the following transport options:

HTTP : Select this option if the Web Service provide project is to be deployed on an
Integration Appliance .
Cast Iron Cloud : Select this option if the Web Service provide project is to be deployed on
Cast Iron Live.
Local : Select this option if this orchestration is called locally by other orchestrations. It can
be used in Studio and on an Integration Appliance.

Port
Specifies the port number to communicate with the Integration Appliance acting as the Web
Service.
CAUTION:
This port number is different to the port name specified in the WSDL.

Path
The path string specified in this field is added to the URL of the Integration Appliance to form the
location element of the generated WSDL. For example, if your Integration Appliance is named:
myAR.myCompany.com and the string specified in the Path field is /services/myservice/1.0, the
resulting location element in the WSDL file is equal to the following string:
http://myAR.myCompany.com/services/myservice/1.0

Login
Select the Log into the Server as an Anonymous User option to connect to the endpoint
server anonymously (where a user account is not required).
Select the Log into the Server with User Name and Password option connect to the
endpoint server using a user account. Specify the User Name and Password.
Select the type of Authentication to authenticate with the remote server.

Basic - Sends the user name and password you specify, base64 encoded as part of
the HTTP Authorization header to the server.

Specify the Realm.
Specify the User Name for the account used to connect to the endpoint server.
Specify the Password for the account used to connect to the endpoint server.

Security
Select the None option if no security is required.
Select the HTTPS option to enable secure Web Service over SSL.  
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Available for the HTTP transport option only. When server authentication is required,
select the Server Certificate Alias Name check box to specify that the Integration
Appliance acting as a server provides a certificate to the client. This certificate is
used by the client for authentication and encryption. If this check box is selected,
the name of the certificate must be provided. A certificate specified at the activity
level with this check box, takes precedence over certificates specified on the
Security > Certificates > Settings > Server SSL over data NIC entry in the WMC.

Select the Protocol Version used for secure HTTP over SSL. By default, the protocol
version used is SSL_TLSv2.

Connection Pool Options
The Maximum Connections parameter specifies the maximum number of connections that the
Integration Appliance can open in the connection pool. By default, the Integration Appliance can
have 25 connections open.

Note: For some of the fields in the endpoint, you can define configuration properties to supply the values

for these fields. The icon displays when you click in a field that supports a configuration property and
a configuration property of the same type is already configured for the project.

Parent topic: Creating or Editing a Web Services Endpoint
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Updating a Changed WSDL
If you created a project that uses a WSDL and the WSDL changes, you can attempt to update the existing WSDL
with the new WSDL.

About this task

Updating a WSDL means that any entities that interface with the WSDL might be affected by the change. For
example, the WSDL defines the input and output parameters of the operation and if the schema that defines
these parameters changes in the new WSDL, the nodes that represent these parameters in the Map Inputs and
Map Outputs tasks of the Web Services activities might no longer exist and any links to these nodes are no
longer valid. You must recreate the links in order for the orchestration to be valid again. Updating a WSDL might
require other changes to the project besides recreating links, for details see Table 1. In some cases, the new
WSDL is not loaded as described in the first three rows in the following table.
Note: Updating an existing WSDL is different from loading multiple WSDLs into a project by either dragging a
file into the Project tab or right-clicking on the WSDL folder in the Project tab and selecting Add Document.
Updating a WSDL replaces the existing WSDL in the project, while uploading the same file into the Project tab
creates two instances of the WSDL in the project.

Table 1.
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Change in WSDL Ne
w
WS
DL
rep
lac
es
the
init
ial
WS
DL
?

How is the project affected?

New WSDL is not a valid WSDL.
For example the final
</definitions> tag is missing at
the end of the WSDL.

No,
the
up
dat
e
do
es
not
occ
ur

None, the new WSDL is not loaded. No updates occur to any of the
project entities.

Uploading the new WSDL to
replace the existing one, would
result in an invalid project.

No,
the
up
dat
e
do
es
not
occ
ur

None, the new WSDL is not loaded. No updates occur to any of the
project entities.

Attempt to update the current
WSDL with a different WSDL and
an orchestration or an endpoint
in the project refers to the
current WSDL.
Note: You can load multiple
WSDLs into a project.

No,
the
up
dat
e
do
es
not
occ
ur

None, the new WSDL is not loaded. No updates occur to any of the
project entities.
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The Service Binding definition of
the WSDL is defined by the
service, port, and location
elements. If the values of the
service, port and location
elements in the WSDL change,
the values for these elements
that are stored in the Web
Service endpoint must be
updated.

Yes
,
up
dat
e
occ
urs

The values in the Web Service endpoint are updated with the newest
values specified in the WSDL. For details about these elements, see
Creating or Editing a Web Services Endpoint.

The name of an operation
changes in the WSDL and the
orchestration is starting that
operation in an Invoke Service
activity.

Yes
,
up
dat
e
occ
urs

If the name of the operation changes and the operation is used by the
Invoke Service activity, the first operation in the WSDL is by default
assigned to the Invoke Service activity. This reassigning to the first
operation might not be the wanted result. The input and output
parameters of the first operation in the WSDL might be different than
the operation originally specified and therefore the links might no
longer exist in the Map Inputs and Map Outputs tasks. You must
configure the Invoke Service activity again for the orchestration to be
valid.

The name of one of the
operation changes in the WSDL
but the orchestration is not
starting that operation in any
Invoke Service activities.

Yes
,
up
dat
e
occ
urs

If the name of the operation changes and that operation is not used
any Invoke Service activities, this change to the WSDL has no affect.

Additional <part> elements are
added to the elements that
define the input or output
parameters of the operation.
This change affects any project
entity that references this part of
the WSDL. The following is a list
of possible affected entities:

Standalone Maps
Map Variables activity
Variables based on this
part of the WSDL
An orchestration that
contains an Invoke
Service activity which
starts an operation that
uses this message type.
For example, to the
following example
<message> element

For example, see Figure 1.

Yes
,
up
dat
e
occ
urs

Since new <part> elements have only been added to the <message>
element, typically this change has no affect on the existing maps and
variables based on the WSDL. For the <Helloin> message example,
adding the new city element has no affect on links to the existing
address <part> element in the Map Inputs or Map Outputs tasks of
the Invoke Service activity. If required, you can create links to the
new element.
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Change the type of a <part>
element in a <message>
element that define the input
and output parameters of the
operation. This change affects
any project entity that
references this part of the WSDL.
The following is a list of possible
affected entities:

Standalone Maps
Map Variables activity
Variables based on this
part of the WSDL
An orchestration that
contains an Invoke
Service activity which
starts an operation that
uses this message type.

Yes
,
up
dat
e
occ
urs

Any existing links in the maps are not removed even though the type
might have changed.
CAUTION:
The type change might have run time impact, resulting in potentially
bad output data. Check that any type conversions done in the links of
maps do not result in bad output data being returned at run time.

Change the <message> element
of the input or output parameter
of the operation.

This change affects any project
entity that references this part of
the WSDL. The following is a list
of possible affected entities:

Standalone Maps
Map Variables activity
Variables based on this
part of the WSDL
An orchestration that
contains an Invoke
Service activity which
starts an operation that
uses this message type.

Yes
,
up
dat
e
occ
urs

Links to the input or output parameter that has changed in the map
are removed. You must create links to the changed parameter in
maps. For example, if the <message> element changes for the input
parameter of the operation called by an Invoke Service activity, the
links to the nodes in the Map Inputs task of the Invoke Service
activity are removed. You must create links from variables to the new
set of nodes that show in the To Activity pane of the Map Inputs task.

Figure 1. Additional <part> elements example

<message name="HelloIn"> 
 <part name="address" type="xsd:string> 
</message> 
Add the following additional <part> element 
<message name="HelloIn"> 
<part name="address" type="xsd:string> 
<part name="city" type="xsd:string> 
</message>

Updating a changed WSDL
To update a WSDL, start the upgrade WSDL process using one of the following options:

Parent topic: Web Services Activities
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Updating a changed WSDL
To update a WSDL, start the upgrade WSDL process using one of the following options:

Procedure

1. Use one of the following options to start the upgrade:
Double click an existing WSDL in the WSDLs folder of the Project tab. A WSDL tab displays with a
graphical view of the WSDL. Drag a WSDL file from the local file system onto the WSDL open in the
WSDL tab.
Double click an existing WSDL in the WSDLs folder of the Project tab. A WSDL tab displays with a
graphical view of the WSDL. Click on a node of the WSDL in the WSDL tab. Select the File > Update
WSDL or XML Schema option from Studio toolbar menu. The Update the Current WSDL Document
dialog box displays. In the Location field, specify the location of the new WSDL from an external
web location or from the file system and click OK.
Double click an existing WSDL in the WSDLs folder of the Project tab. A WSDL tab displays with a
graphical view of the WSDL. Right-click a node in the WSDL tab and from the menu and select the
Update option. The Update the Current WSDL Document dialog box displays. In the Location field,
specify the location of the new WSDL from an external web location or from the file system and
click OK.
Right-click an existing WSDL in the WSDLs folder of the Project tab and from the menu select the
Update option. The Update the Current® WSDL Document dialog box displays. In the Location
field, specify the location of the new WSDL from an external web location or from the file system
and click OK.

The Updating the WSDL Affects the Listed Dependant Project Entities dialog box displays and project
entities that are affected by the replacement of the original WSDL with the new WSDL are listed.

2. Optional - In the dialog box, click any of the listed dependant entities to view the entity in Studio.
3. Click Update. Studio attempts to update the project with the new WSDL and the result of the attempted

update depends on the following conditions:
If any of the changes in the WSDL would result in a corrupt project after the update or the new
WSDL is invalid, an Error dialog box displays describing the problem with the WSDL. Click OK and
click Close. The update is canceled, the WSDL reverts to the original WSDL, and the project is not
changed.
If none of the changes to the WSDL would result in a corrupt project, the update occurs and the
original WSDL is replaced by the new WSDL. Some of the project entities might be invalid after the
update and could require clean up.
Click Close.

Parent topic: Updating a Changed WSDL
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Web Services Invoke Service Activity
During run time, the Web Services Invoke Service activity starts an outside Web Service.

About this task

The Web Services connection activity is a single-operation activity. It connects to a single service on a single
portType in a Web Service. If you specify a WSDL containing more than one operation, select which operation
the activity should start.
Note: Web Services Basic Profile 1.1 2nd Edition is supported. SOAP encoding arrays are not supported in the
Web Services Basic Profile 1.1.

By default, compression and decompression are enabled for the Invoke Service activity. For more information,
see Compression/Decompression with the Web Services Invoke Service activity.

The steps for adding and configuring an Invoke Service activity to an orchestration are described in the
following procedures:

Adding an activity
Add a Web Services Invoke Service activity in the orchestration.
Creating an endpoint
Create, select, or edit a Web Services endpoint.
Configuring the activity
Configure the Invoke Service activity.
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Specifying the retry options
Specify the retry options for the Invoke Service activity.
Mapping the inputs of the activity
Map the inputs of the Invoke Service activity.
Mapping the outputs of the activity
Map the output of the Invoke Service activity.
Invoking an Orchestration with Web Services Provide Service Starter Activity
Invoke Service tool enables in house invocation of an orchestration with Web Services Provide Activity.
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Adding an activity
Add a Web Services Invoke Service activity in the orchestration.

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration displays.
2. Select the Activities tab and expand the Web Services folder.
3. Drag the Invoke Service activity onto the orchestration.
4. Select the activity. The Checklist is displayed.
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Creating an endpoint
Create, select, or edit a Web Services endpoint.

Procedure

1. Click Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:
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a. Select Browse. The Project Explorer displays.
b. Select an existing endpoint and click OK. Skip to theConfiguring the activity procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer displays.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane displays.

Create a new endpoint: Select New. The Create Endpoint pane displays.
2. Create or edit a Web Services endpoint.
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Configuring the activity
Configure the Invoke Service activity.

Procedure

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Select a single operation to start on the Web Service.
3. The Use Compression/Decompression check box specifies if compression/decompression is turned on

or off at the activity level. By default, the Use Compression/Decompression check box is selected. Clear
the Use Compression/Decompression check box to disable compression and decompression for this
activity. For more information, see Compression/Decompression with the Web Services Invoke Service
Activity.

4. The Message Transmission Optimization Mechanism (MTOM) when checked specifies using MTOM to
efficiently send SOAP messages containing binary data.
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Specifying the retry options
Specify the retry options for the Invoke Service activity.
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Procedure

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to a Web Service. The following table describes the retry

options for connecting to a Web Service:

Field Description

Retry  

Wait
___
secon
d(s)
betw
een
each
retry.

Specifies the amount of time (in seconds) that the Integration Appliance waits before trying to
establish a connection to the Web Service.

Try to
conne
ct
___
times
befor
e
failing
.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the Web Service before issuing an error and stopping the
processing of the current orchestration job.

If you deploy an orchestration that contains a Web Services Invoke Service activity and the
Integration Appliance cannot connect to the specified Web Service, the Integration Appliance
logs the connections errors as Warnings in the system and orchestration logs until the retry
count value is reached. When the retry count is reached, the Integration Appliance logs an
Error in the system and orchestration logs and the stops processing the current orchestration
job.

For example, the retry count is set to 3. The first, second, and third connection errors are
shown in the system log as Warnings. The Integration Appliance logs the fourth connection
error as an Error and stops processing the current orchestration job.

Time
out
after
___
secon
ds
when
the
Endp
oint
does
not
respo
nd to
a
reque
st.

Specifies the amount of time in seconds before a timeout occurs between the activity making a
request on an Endpoint and the time it takes the Endpoint to respond. For the Web Services
Invoke Service, the activity timeout is the amount of time that the Integration Appliance waits
for a response from the Web Service after attempting to start the Web Service, before the
Integration Appliance issues a timeout error. An activity timeout is different from a connection
timeout because an activity timeout occurs after the connection to the Endpoint has been
established. A connection timeout specifies the amount of time in seconds before a timeout
occurs between the Integration Appliance attempting to establish a connection to the Endpoint
and the time it takes for the Endpoint to respond to the connection request. Set the connection
timeout in Web Services Endpoint tab. For more information about connection timeouts, see
Creating or Editing a Web Services Endpoint.

Parent topic: Web Services Invoke Service Activity
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Mapping the inputs of the activity
Map the inputs of the Invoke Service activity.

About this task

The XML input parameter for the operation selected in the Configure task is shown beneath the body input
parameter listed in the To Activity pane of the Map Inputs task.

To view the optional input parameters called location, header, and httpheaders in the To Activity pane of the
Map Inputs pane, select Map > Show Optional Parameters from the toolbar menu or right-click in the To
Activity pane and select the Show Optional Parameters option. If the Map > Show Optional Parameters option
is not selectable in the toolbar menu, click a node in the Map Inputs pane to make this option active.

You can override the setting of the location element specified in the WSDL using the optional location input
parameter. The location element in the WSDL, specifies the URL endpoint. A request to start a Web Services is
made to the URL Endpoint.

The schema of the header input parameter is defined by WSDL. The header input parameter is optional
because Web Service you start might not require a header.

The following table defines the nodes of the optional httpheaders input parameter.

Nodes of the
httpheaders Input
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/metho
d

Specifies the type of HTTP request.

httpheaders/otherH
eaders/headerItem

Specifies an element that contains a set of HTTP header parameters as name/value
pairs. Multiple HTTP header parameters can be specified in the HTTP request, so this is
a recurring node.

httpheaders/otherH
eaders/headerItem/
name

Specifies the name of the HTTP header parameter.

httpheaders/otherH
eaders/headerItem/
value

Specifies the value of the HTTP header parameter.

Note: If the Content-Length header is explicitly set using the httpheaders/otherHeaders/headerItem/name and
httpheaders/otherHeaders/headerItem/value, during run time this value is ignored. This activity automatically
sets the Content-Length header to the size of the body.
You can optionally override the settings you specified for the proxy server in the Configure and Pick Endpoint
task of the Checklist by providing values for the proxyConnection input parameter dynamically during run time.
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The following table defines the nodes of the optional proxyConnection input parameter:

Input
Paramete
r
Name/No
de Description Overrides the Setting in Task?

proxyCon
nection/h
ost

Specifies the hostname of the proxy server. The host node of the proxyConnection input
parameter overrides the Proxy Host Name
field of the Web Services Endpoint.

proxyCon
nection/p
ort

Specifies the port number to use to connect to
the proxy server.

The port node of the proxyConnection input
parameter overrides the Proxy Port field of the
Web Services Endpoint.

proxyCon
nection/u
sername

Specifies the username to use for proxy server
authentication. This field is optional if your proxy
server does not require authentication.

The username node of the proxyConnection
input parameter overrides the Proxy User
Name field of the Web Services Endpoint.

proxyCon
nection/p
assword

Specifies the password to use for proxy server
authentication. This field is optional if your proxy
server does not require authentication.

The password node of the proxyConnection
input parameter overrides the Proxy Password
field of the Web Services Endpoint.
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Mapping the outputs of the activity
Map the output of the Invoke Service activity.

Procedure

1. Select the Map Outputs task in the Checklist. The output parameters of the activity display in the From
Activity pane of the Map Outputs task as described in the following table.

Output
Parame
ter Description

body Contains the body of the response from the Web Service. The nodes that defines the return
parameter or parameters of the Web Service operation displays under the body output
parameter.

header Contains the header of the SOAP Envelope.

httphea
ders

Contains the header of the HTTP response.
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The following table defines the nodes of the httpheaders output parameter.

Nodes of the
httpheaders
Output
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/meth
od

Specifies the type of HTTP response.

httpheaders/other
Headers/headerIt
em

Specifies a set of name/value pairs that contain the HTTP parameters of the HTTP
response.  Multiple HTTP parameters can be specified in the HTTP response, so
headerItem is a recurring node.

httpheaders/other
Headers/headerIt
em/name

Specifies the name of the HTTP parameter.

httpheaders/other
Headers/headerIt
em/value

Specifies the value of the HTTP parameter.

2. Map the output nodes of the activity to orchestration variables. See Creating a Map for general
instructions on mapping.

Parent topic: Web Services Invoke Service Activity

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/WS_Invoke_Map_Outputs.html

Invoking an Orchestration with Web Services Provide Service
Starter Activity

Invoke Service tool enables in house invocation of an orchestration with Web Services Provide Activity.

About this task

Use this task to create/ modify SOAP request based on configured schema for starter Web Services Provide
Activity, and then invoke an orchestration that handle responses.

Procedure

To Invoke an Orchestration, complete the following steps:

1. Open an orchestration with Web Services Provide Service Starter Activity. A graphical representation of
the orchestration is displayed in the Studio Workspace.
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2. Right-click Provide Service activity and select Invoke Service. The Invoke Service pane is displayed.
3. This pane displays a generated template request message. You can either fill the required details in the

template request message or click Open to select a different text request message.
4. Click Save to save the current request message.
5. Click Execute to invoke a web service and hence an orchestration. It also enables you to retest a

particular activity with the current request message by saving the request message across the Studio
Start up.

6. Click Show Response to view the web service response.
Note: Click Reset to reset the current request message to the template request message.
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Compression/Decompression with the Web Services Invoke
Service Activity

During run time, the Web Services Invoke Service activity sends a HTTP request complaint with the
HTTP/HTTPS 1.1 protocol to the Web Service. The Invoke Service activity supports compression with the gzip
format only and decompression with the gzip or the deflate formats.

Note: The Invoke Service activity does not support the common UNIX file compression format called compress.
The compression/decompression run-time behavior of the Invoke Service activity is dependant on the
following conditions:

If the Endpoint supports compression/decompression
Content-Encoding and Accept-Encoding Values at the Message Level
The setting of the Use Compression/Decompression check box at the activity level

The affect of these conditions on the compression/decompression run-time behavior of the Invoke Service
activity are described in the following sections and in the tables provided in the Run-time
Compression/Decompression Behavior section.

Endpoint Support for Compression/Decompression

The Integration Appliance determines whether or not the HTTP Endpoint supports compression when the
Integration Appliance sends the first HTTP request in the compressed format to the HTTP Endpoint (the Web
Service), if the Web Service returns an error code indicating that Web Service does not support compression or
does not support the specified Content-Encoding type, the Integration Appliance resends the first request in
uncompressed format and all subsequent requests to this Endpoint are sent in the uncompressed format. In
addition, the HTTP response sent by the Web Service is not decompressed when received by Integration
Appliance.

Endpoint support for compression/decompression is represented by the fourth column labeled Endpoint
Supports Compression? in the tables provided in the Run-time Compression/Decompression Behavior section.
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Content-Encoding and Accept-Encoding Values at the Message Level

The value of the Content-Encoding header in the HTTP request determines if the body of the request is
compressed or not using. For the Invoke Service activity, the Integration Appliance sets the Content-Encoding
to gzip and sends the body of the request compressed in the gzip format as shown in the second row of the first
table labeled Compression Behavior When Sending a Request and in the following figure.

The value of the Accept-Encoding header in the request defines the types of encoding that the HTTP client
accepts in the response. For the Invoke Service activity, the Integration Appliance sets the Accept-Encoding
equal to gzip,deflate in the request and the Web Service sends the body of the response compressed in either
the gzip or the deflate format to the Integration Appliance (acting as a client) as shown in the following figure:

The values of the Accept-Encoding and Content-Encoding headers in the request are used by the Integration
Appliance and the Web Service to determine the compression/decompression behavior.

Setting Compression/Decompression at the Activity Level

By default, compression and decompression are turned on at the activity level for the Invoke Service activity.
 You can turn off compression/decompression at the activity level by clearing the Use
Compression/Decompression check box. The Use Compression/Decompression check box is available in the
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Configure task of the activity. The second column labeled Use Compression/Decompression check box in the
following tables provided in the Run-time Compression/Decompression Behavior section, represents the
setting of the Use Compression/Decompression check box.

Deprecation Note: The Use Compression/Decompression check box will be deprecated in a future release. Use
the Content-Encoding and Accept-Encoding HTTP Parameters in the HTTP request to specify how to
decompresses the body of the HTTP request and compress the body of the HTTP response.

Run-time Compression/Decompression Behavior

The first table provided in the Compression Behavior When Sending a Request section, describes the
compression run-time behavior when the Integration Appliance sends a HTTP request to the Web Service.

The second table provided in the Accept-Encoding Header Value Passed to the Request section, describes the
value of the Accept-Encoding header passed in the HTTP request.

The third table provided in the Decompression Behavior When Receiving a Response section, describes the
decompression run-time behavior when the Integration Appliance receives the HTTP response from the Web
Service.

Compression Behavior When Sending a Request

The following table describes the compression run-time behavior when the Integration Appliance sends a
HTTP request to the Web Service.

Use Compression/
Decompression
Check Box (Activity
Level)

Content-Encoding
Value in the HTTP
Request (Message
Level)

Endpoint
Supports
Compress
ion?

Integration Appliance Compression Run-Time
Behavior When Sending a Request

selected gzip yes The Integration Appliance sends the body of the
request compressed in the gzip format. The
Content-Encoding header is set to gzip in the
request.

selected value is not
significant

no The Integration Appliance sends the body of the
 request uncompressed. The Content-Encoding
header is set to identity in the request.

cleared value is not
significant

value is
not
significant

The Integration Appliance sends the body of the
request as is (unchanged). The current value of the
Content-Encoding header is passed as is in the
request

Accept-Encoding Header Value Passed to the Request

The following table describes the value of the Accept-Encoding header passed in the HTTP request.

Use Compression/
Decompression Check Box
(Activity Level)

Initial Accept-
Encoding
Value

Endpoint
Supports
Compression?

Accept-Encoding Value Passed in the
HTTP Request to the Web Service

selected gzip,deflate yes The Accept-Encoding header is set to
gzip,deflate in the request.

value is not significant value is not
significant

no The current value of the Accept-
Encoding header is passed as is in the
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request.

cleared value is not
significant

value is not
significant

The current value of the Accept-
Encoding header is passed as is in the
request.

Decompression Behavior When Receiving a Response

The following table describes the decompression run-time behavior when the Integration Appliance receives
the HTTP response from the Web Service.

Use Compression/
Decompression
Check Box (Activity
Level)

Content-Encoding
Value in the HTTP
Response (Message
Level)

Endpoint
Supports
Compress
ion?

Integration Appliance Decompression Run-Time
Behavior When Receiving a Response

selected gzip yes The Integration Appliance decompresses the body
of the response using the gzip format.

selected deflate yes The Integration Appliance decompresses the body
of the response using the deflate format.

selected identity yes The Integration Appliance does not decompress the
body of the response.

selected value not listed in
the Accept-Encoding
header

yes The Integration Appliance logs an error that the
response data was received in an unsolicited
content encoding type.

selected value is not
significant

no The Integration Appliance does not decompress the
body of the response. The current value of the
Content-Encoding header is passed as is in the
response.

cleared value is not
significant

value is
not
significant

The Integration Appliance does not decompress the
body of the response.  The current value of the
Content-Encoding header is passed as is in the
response.
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Web Services Provide Service Activity
During run time the Provide Service activity provides a Web Service that can be started from an outside client.

About this task
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Figure 1. Provide Service activity

The Provide Service activity is an inbound Web Service activity. It is a starter activity that listens for Web
Service requests at the specified port.

Based on the configuration information you provide in Studio about the Web Service, the WMC generates a
WSDL file that describes the Web Service Interface available during run time.

When a project with a WSDL is deployed, the Web Service interface defined by the WSDL is available. You can
export and then view the WSDL file that has been generated for the Web Service from the WMC.

During run time, when a client sends a request to the Web Service, the Integration Appliance starts processing
the Provide Service activity and the rest of the activities that make up the orchestration.

You can only specify one input and one output XML Schema for the Provide Service activity, so the generated
WSDL defines only one request header and one response header. The WMC generates a WSDL with one
operation.  In tFigure 1, the Web Service calculcatePrice operation is derived from the name of the Provide
Service activity. There is a one-to-one relationship between the Web Service operation and the Provide Service
activity.

By default, decompression is enabled for the Provide Service activity. For more information, see
Decompression with the Web Services Provide Service Activity.

The steps for adding and configuring a Provide Service activity to an orchestration are described in the
following procedures.

Adding an activity
Add a Web Services Provide Service activity in the orchestration.
Creating an endpoint
Create, select, or edit a Web Services endpoint.
Configuring the activity
Configure the Provide Service activity.
Mapping the outputs of the activity
Map the output of the Provide Service activity.

Parent topic: Web Services Activities
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Adding an activity
Add a Web Services Provide Service activity in the orchestration.

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration displays.
2. Select the Activities tab and expand the Web Services folder.
3. Drag the Provide Service activity onto the orchestration.
4. Select the activity. The Checklist is displayed.
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Creating an endpoint
Create, select, or edit a Web Services endpoint.

Procedure

1. Click the Pick Endpoint task from the Checklist and choose from one of the following actions:
Select an existing endpoint:

a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK. Skip to theConfiguring the activity procedure.

Select an existing endpoint and edit the endpoint:
a. Select Browse. The Project Explorer is displayed.
b. Select an existing endpoint and click OK.
c. Click Edit. The Edit Endpoint pane displays.

Create a new endpoint: Select New. The Create Endpoint pane displays.
2. Create or edit a Web Services endpoint.

Parent topic: Web Services Provide Service Activity
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Configuring the activity
Configure the Provide Service activity.

Procedure

1. Select the Configure task from the Checklist. The Configure pane is displayed.
2. Configure all the fields in this pane as described in the following table.

Field Description

Receive
Request
with

 

Schema Defines the XML Schema of incoming XML data to the operation of the Web Service.
Click Browse... to select a schema.
Click Clear to disassociate the selected schema from the activity.

Soap
Header

Defines the XML Schema of the incoming Soap Header.
Click Browse... to select a schema.
Click Clear to disassociate the selected schema from the activity.

This
activity

 

Requires
a Reply

This check box specifies to send a reply to the sender of the request. If this option is
selected, you must add a Web Services Send Reply activity to your orchestration to send a
reply to the client that started it.

Schema Defines the XML Schema of the returned XML data from the operation of the Web Service.
 (The XML data is returned by the associated Send Reply activity. )

Click Browse... to select a schema.
Click Clear to disassociate the selected schema from the activity.

Soap
Header

Defines the XML Schema of the returned Soap Header of the Web Service.  (The SOAP
Header is returned by the associated Send Reply activity. )

Click Browse... to select a schema.
Click Clear to disassociate the selected schema from the activity.

May
throw
the
followin
g Faults

 

Fault
Name

Specifies user-defined fault name for the activity.

Fault Click Browse to display the schema and select the element for which the fault is thrown.
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Element

Options  

Use
Compres
sion /
Decomp
ression

Specifies if decompression is turned on or off at the activity level. By default, the Use
Compression/Decompression check box is selected. Clear the Use
Compression/Decompression check box to disable decompression for this activity. For more
information, see Decompression with the Web Services Provide Service Activity.
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Mapping the outputs of the activity
Map the output of the Provide Service activity.

Procedure

1. Select the Map Outputs task in the Checklist. The output parameters of the activity display in the From
Activity pane of the Map Outputs task as described in the following table.

Output
Parame
ter Description

body Contains the body of the response from the Web Service. The nodes that defines the return
parameter or parameters of the Web Service operation displays under the body output
parameter.

header Contains the header of the SOAP Envelope.

httphea
ders

Contains the header of the HTTP response.

The following table defines the nodes of the httpheaders output parameter.

Nodes of the
httpheaders
Output
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/meth
od

Specifies the type of HTTP response.

httpheaders/host Specifies the IP address or the host name of the client.
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httpheaders/other
Headers/headerIt
em

Specifies a set of name/value pairs that contain the HTTP parameters of the HTTP
response.  Multiple HTTP parameters can be specified in the HTTP response, so
headerItem is a recurring node.

httpheaders/other
Headers/headerIt
em/name

Specifies the name of the HTTP parameter.

httpheaders/other
Headers/headerIt
em/value

Specifies the value of the HTTP parameter.

2. Map the output nodes of the activity to orchestration variables. See Creating a Map for general
instructions on mapping.
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Decompression with the Web Services Provide Service Activity
The Web Services Provide Service activity supports decompression with the gzip format only.

Note: The Provide Service activity does not support the deflate format or the common UNIX file compression
format called compress.

The Provide Service activity only supports receiving HTTP requests using HTTP/HTTPS 1.0 protocol.

The decompression run time behavior of the Provide Service activity when receiving an HTTP request is
dependent on the following conditions:

The value of the Content-Encoding at the message level.
The setting of the Use Compression/Decompression check box at the activity level.

These conditions affect the decompression run time behavior of the Provide Service activity and are described
in the following sections and in the table provided in the Run time Decompression Behavior section.

Content-Encoding Value at the Message Level

The value of the Content-Encoding header of the HTTP request can determine if the Integration Appliance
decompresses the body of the HTTP request that is received from the client as shown in Figure 1.
Figure 1. HTTP request
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The value of the Content-Encoding header is represented by the third column labeled Content-Encoding Value
in the table provided in the Run time Decompression Behavior section.

Setting Decompression at the Activity Level

By default, decompression is turned on at the activity level for the Provide Service activity. You can turn off
decompression at the activity level by clearing the Use Compression/Decompression check box. The Use
Compression/Decompression check box is available in the Configure task of the activity. The second column
labeled Use Compression/Decompression check box in the table provided in the Run time Decompression
Behavior section, represents the setting of the Use Compression/Decompression check box.

Run time Decompression Behavior

The following table describes the decompression run time behavior when the Integration Appliance receives an
HTTP request from the HTTP Client:

Use
Compress
ion/
Decompre
ssion
Check
Box
(Activity
Level)

Conte
nt-
Encod
ing
Value
(Mess
age
Level) Integration Appliance Decompression Run Time Behavior

selected gzip The Integration Appliance decompresses the body of the request using the gzip format.
The value of Content-Encoding is set to gzip in the headers output parameter returned
from the activity.

selected not
set

The Integration Appliance sends the body of the  request as is (unchanged). The value of
Content-Encoding is not set in the headers output parameter returned from the activity.   

selected identif
y

The Integration Appliance sends the body of the  request as is (unchanged). The value of
Content-Encoding is not set in the headers output parameter returned from the activity.   

selected any
other
string

The Integration Appliance sends the 415 (Unsupported Media Type) Response Code.
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beside
s gzip
or
identit
y

cleared value
is not
signifi
cant

The Integration Appliance does not decompress the body of the request and the current
value of Content-Encoding in the request is passed as is to the headers output
parameter of the activity. For example, if the value of the Content-Encoding is set to gzip
but the Use Compression/Decompression check box is cleared, the Integration
Appliance does not decompress the body of the request but Content-Encoding is set to
gzip in the headers output parameter of the activity.

Compression Behavior When Sending a Request

The following table describes the compression run time behavior when the Integration Appliance sends an
HTTP request to the Web Service.

Accept-Encoding Header Value Passed to the Request

The following table describes the value of the Accept-Encoding header passed in the HTTP request.

Use Compression/
Decompression Check Box
(Activity Level)

Initial Accept-
Encoding
Value

Endpoint
Supports
Compression?

Accept-Encoding Value Passed in the
HTTP Request to the Web Service

selected gzip,deflate yes The Accept-Encoding header is set to
gzip,deflate in the request.

value is not significant value is not
significant

no The current value of the Accept-
Encoding header is passed as is in the
request.

cleared value is not
significant

value is not
significant

The current value of the Accept-
Encoding header is passed as is in the
request.

Decompression Behavior When Receiving a Response

The following table describes the decompression run time behavior when the Integration Appliance receives
the HTTP response from the Web Service.

Use Compression/
Decompression
Check Box (Activity
Level)

Content-Encoding
Value in the HTTP
Response (Message
Level)

Endpoint
Supports
Compress
ion?

Integration Appliance Decompression Run Time
Behavior When Receiving a Response

selected gzip yes The Integration Appliance decompresses the body
of the response using the gzip format.

selected deflate yes The Integration Appliance decompresses the body
of the response using the deflate format.

selected identity yes The Integration Appliance does not decompress the
body of the response.

selected value not listed in
the Accept-Encoding

yes The Integration Appliance logs an error that the
response data was received in an unsolicited
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header content encoding type.

selected value is not
significant

no The Integration Appliance does not decompress the
body of the response. The current value of the
Content-Encoding header is passed as is in the
response.

cleared value is not
significant

value is
not
significant

The Integration Appliance does not decompress the
body of the response.  The current value of the
Content-Encoding header is passed as is in the
response.
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Web Services Send Reply Activity
During run time, the Send Reply activity returns a response for a Provide Service activity.

About this task

Figure 1. Send Reply activity

As shown in Figure 1, the client runs the calculatePrice Web Service operation (a Provide Service activity) by
sending a request. The Integration Appliance receives the request and starts processing the activities in the
orchestration. When the sendPrice activity (a Send Reply activity) is started, it returns a response to the client.
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By default, compression is enabled for the Send Reply activity. For more information, see Compression with the
Web Services Send Reply Activity.

The steps for adding and configuring a Send Reply activity to an orchestration are described in the following
procedures.

Adding an activity
Add a Web Services Send Reply activity in the orchestration.
Configuring the activity
Configure the Send Reply service activity.
Mapping the inputs of the activity
Map the inputs of the Send Reply service activity.
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Adding an activity
Add a Web Services Send Reply activity in the orchestration.

Procedure

1. Create or open an orchestration. A graphical representation of the orchestration is displayed.
2. Select the Activities tab and expand the Web Services folder.
3. Drag the Send Reply activity onto the orchestration. The Send Reply activity is used in conjunction with

Provide Service activity to send a reply back to the client that started it. Place the Send Reply activity
after the Provide Service activity.

4. Select the activity. The Checklist is displayed.
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Configuring the activity
Configure the Send Reply service activity.
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Procedure

1. Select the Configure task from the Checklist. The Configure pane opens.
2. Select a Provide Service to which this Send Reply activity is returning the reply.
3. The Use Compression/Decompression check box specifies if compression is turned on or off at the

activity level. By default, the Use Compression/Decompression check box is selected. Clear the Use
Compression/Decompression check box to disable compression/decompression for this activity. For
more information, see Compression with the Web Services Send Reply Activity.

4. The Message Transmission Optimization Mechanism (MTOM) when checked specifies using MTOM to
efficiently send SOAP messages containing binary data.
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Mapping the inputs of the activity
Map the inputs of the Send Reply service activity.

About this task

The return parameter for the operation selected in the Requires a Reply Schema field of the Configure task of
the associated Provide Service activity, is shown beneath the body input parameter listed in the To Activity
pane of the Map Inputs task.

To view the optional input parameters called header and httpheaders in the To Activity pane of the Map Inputs
pane, select Map > Show Optional Parameters from the toolbar menu or right-click in the To Activity pane and
select the Show Optional Parameters option. If the Map > Show Optional Parameters option is not selectable in
the toolbar menu, click a node in the Map Inputs pane to make this option active.

If a Soap Header XML Schema was selected in the Requires a Reply SOAP Header field of the Configure task of
the associated Provide Service activity, this schema is shown beneath the header input parameter listed in the
To Activity pane of the Map Inputs task.

The following table defines the nodes of the optional httpheaders input parameter.

Nodes of the
httpheaders Input
Parameter Description

httpheaders/uri Specifies the resource path, for example: /myPath.

httpheaders/method Specifies the type of HTTP request.

httpheaders/otherH
eaders/headerItem

Specifies an element that contains a set of HTTP header parameters as name/value
pairs. Multiple HTTP header parameters can be specified in the HTTP request, and is a
recurring node.
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httpheaders/otherH
eaders/headerItem/
name

Specifies the name of the HTTP header parameter.

httpheaders/otherH
eaders/headerItem/
value

Specifies the value of the HTTP header parameter.
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Web Services Send Reply with Fault Activity
During run time, the Send Reply with Fault activity returns a fault to the calling orchestration. This activity
provides SOAP functionality as a reply configuration option.

About this task

The WS Provide activity must have previously been added as the starter activity to the active orchestration,
since a Send Reply with Fault activity depends on a WS Provide activity.

The steps for creating and configuring a Send Reply with Fault activity to an orchestration are described in the
following procedures.

Creating the Required Fault Names
Create the required fault names using the following procedure.
Configuring the Activity
Configure the Send Reply activity with the fault names.
Map the Inputs of the Activity
Map the inputs for the Send Reply activity with the fault names.
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Creating the Required Fault Names
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Create the required fault names using the following procedure.

Procedure

1. In an active orchestration, click the WS Provide activity.
2. In the Checklist, click Configure.
3. In the Configure options, select Requires Reply.
4. Click Add Fault. The Add Fault dialog box is displayed.
5. Browse and select a valid schema. Repeat the preceding steps to create as many faults as are required.
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Configuring the Activity
Configure the Send Reply activity with the fault names.

Procedure

1. Open the Activities tab.
2. Expand the Web Services folder contents and drag Send Reply with Fault into the orchestration,

following the existing Web Services Provide Service activity.
3. In the Checklist, click Configure.

The Reply To text area is displayed and lists the name of the preceding Web Services Provide Service
activity.

4. In the With Fault section, select a fault name from the Fault Name list.
5. In the Options section, select Use Compression/Decompression to activate this feature.
6. Select Use Soap Message Transmission Optimization Mechanism (MTOM) to activate this feature.
7. In the Threshold field, enter the preferred value in a range of 1 to 9,999,999.
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Map the Inputs of the Activity
Map the inputs for the Send Reply activity with the fault names.

Procedure

1. In the Checklist, click Map Inputs.
2. The To Activity column lists the schema associated with the previously selected fault name.
3. In the From Orchestration column, select the variable that would be used to provide input values.
4. If no variables are listed, click Select Inputs, above the From Orchestration list.

The Select Inputs dialog box is displayed and lists available variables.
Tip: If needed, you can create a custom mapping variable in Source or Destination column by following
the steps in Creating Variables.

5. 
6. Choose a variable, then click OK.
7. In the To Activity field, right-click faultcode and choose Define Default value. When the Define Default

Value dialog box is displayed, select one of the predefined values.
8. To view any optional parameters, right-click either node and choose Show Optional Parameters. These

are displayed in the To Activity column.
9. Map the variables from the Orchestration column to the parameters in the Activity column. For more

information, see Mapping Techniques.
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Compression with the Web Services Send Reply Activity
During run time, the Web Services Send Reply activity sends an HTTP response complaint with the
HTTP/HTTPS 1.0 protocol to the client. The Send Reply activity supports compression with the gzip format
only.

Note: The Send Reply activity does not support the deflate format or the common UNIX file compression
format called compress.
The compression run time behavior of the Send Reply activity is dependent on the following conditions:

At the message level, the value of the Accept-Encoding header in the original HTTP request received by
the Web Services Provide Service activity is passed to the Send Reply activity to determine if the body of
the HTTP response is compressed or not compressed as shown in Figure 1.
The setting of the Use Compression/Decompression check box at the activity level.

These conditions affect the compression run time behavior of the Send Reply activity are described in the
following sections and in the table provided in the Run time Compression Behavior section.

Accept-Encoding Value at the Message Level
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During run time, a Web Services Provide Service activity receives an HTTP request from a client. In the same
orchestration, a Send Reply activity sends a response back to the original client. The value of the Accept-
Encoding header in the original request received by the Provide Service activity is stored internally on the
Integration Appliance. The stored value is passed to the Send Reply activity and is used to determine if the
body of the response is compressed or not and the encoding type, as shown in Figure 1.
Figure 1. The Accept-Encoding header

Setting Compression/Decompression at the Activity Level

By default, compression is turned on at the activity level for the Send Reply activity. You can turn off
compression at the activity level by clearing the Use Compression/Decompression check box. The Use
Compression/Decompression check box is available in the Configure task of the activity. The second column
labeled HTTP Compression CLI Command in the following table represents the setting of the Use
Compression/Decompression check box.

Run time Compression Behavior

The following table describes the compression run time behavior when the Integration Appliance sends an
HTTP response to the client:

Use
Compression/
Decompression
Check Box
(Activity Level)

Accept-Encoding
Value of the
HTTP Request
(Message Level) Integration Appliance Compression Run Time Behavior

selected gzip or
gzip,deflate

The Integration Appliance sends the body of the response
compressed in the gzip format and the Content-Encoding header is
set to gzip in the response.

selected identity The Integration Appliance sends the body of the response
uncompressed and the Content-Encoding header is set to identity in
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the response. 

selected not set, or any
other string
except gzip or
identity

The Integration Appliance sends the body of the response
uncompressed and the Content-Encoding header is set to identity in
the response. 

cleared value is not
significant

The Integration Appliance sends the body of the response as is
(unchanged) and the Content-Encoding header is as is in the
response. (The value of the Content-Encoding header in the request
is passed unchanged to the response.)

Note: The Use Compression/Decompression check box will be deprecated in a future release. Use the Content-
Encoding and Accept-Encoding HTTP Parameters in the HTTP request to specify how to decompress the body
of the HTTP request and compress the body of the HTTP response.
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Troubleshooting and support
Troubleshooting techniques and self-help information help you identify and solve problems quickly. Here, you
can find potential solutions for issues you would have with the Web Services connector.

Exception thrown when Web Services Provide Service activity is processed

Problem: An Illegal Argument Exception is thrown during the processing of the Provide Service activity, if the
Path name ends with a forward slash /.

Cause:This exception is caused because ContextHandler context = new ContextHandler();
context.setContextPath(listenerDetails.getUri()); when the contextPath is being set.
ContextHandler is a class in the jetty-6.1.6 JAR file.

Solution: Ensure that you specify the Path name such that the slash / is followed by a path string. For example,
/abc or /abc/def.
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Workday Activities
Overview of the Workday connector
Creating and editing a Workday endpoint
Workday endpoints contain the connection information that studio and the Integration Appliance use to
connect to the Workday application. You can create multiple endpoints that refer to separate instances.
Using the Invoke Workday activity
The Invoke Workday activity allows you to browse and execute operations in Workday management
services related to human resources, finance, and so on. You can also fetch custom report operations
and work with it.
Migrating WSDL of a WorkDay Connector Project
This section details the WSDL migration of WorkDay connector projects created with WSDL version that
is lower than the current version supported by Cast Iron.
Specifying the retry options for Workday activity
Specify the retry options for the Invoke Workday activity.
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Overview of the Workday connector
The Workday connector enables a connection between Cast Iron and Workday management modules related
to human resources, finance, and so on. The Workday connector also supports Custom Reports.

You can perform the following activity using the Workday connector:

Invoke Workday

The Workday connector supports Workday application v25.2.
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Creating and editing a Workday endpoint
Workday endpoints contain the connection information that studio and the Integration Appliance use to
connect to the Workday application. You can create multiple endpoints that refer to separate instances.

About this task

Use this task to create or edit Workday endpoint.
Note:
Any changes you make to Workday endpoint, including configuration properties, affects all the orchestrations
that use that endpoint, as the edits are global, not local.

Procedure

1. Drag an activity from Workday folder in the Activities tab to the Orchestration window. The Summary
panel is displayed.

2. Click Pick Endpoint from the Checklist. The Pick Endpoint panel is displayed.
3. Click one of the following buttons:

a. Browse - To select an existing endpoint from Project Explorer. The Project Explorer shows all the
endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel.

b. New - To create a new endpoint. The Create Endpoint window opens.
c. Edit - To edit the existing endpoint. The Edit Endpoint window opens.

4. Complete the fields defined in the following table:
Table 1. Connection Details

Field Name Description

Workday

Domain Name Specifies the domain name of your Workday endpoint. You can either specify
the domain name of your choice or use the sandbox domain name given as a
watermark reference.

Tenant Name Specifies the tenant name of your Workday endpoint. You can either specify
the tenant name of your choice or use the sandbox tenant name given as a
watermark reference.

Login

User Name Specifies the user name to connect to the Workday application. You can
either specify the user name of your choice or use the user name given as a
watermark reference.

Password Specifies the password associated with the user name to connect to the
Workday application. You can either specify the password of your choice or
use the password given as a watermark reference.

Connection Timeout

Timeout after ........
seconds when
establishing a
connection to the
endpoint

Specifies the amount of time in seconds before a timeout occurs between
the activity making a request on an Endpoint and the time it takes the
Endpoint to respond. The default is 300 seconds.

Proxy
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Field Name Description

Connect via a Proxy
Server

Allows you to enable the proxy connection details.

Authentication Allows you to select the type of authentication that the Integration Appliance
uses when connecting to a remote server. From the list, select one of the
following authentication modes:

Basic - Sends the user name and password you specify unencrypted
to the server. This authentication schema is the least secure.
Digest - Encrypts the user name and password you specify before
sending the user name and password to the server. This
authentication option is more secure than Basic authentication.
NTLM - Requires an instance of NTCredentials to be available for the
domain name of the server. This authentication is the most secure
authentication option.

When you choose the NTLM authentication option, the Integration
Appliance authenticates a connection and not a request; therefore,
the Integration Appliance authenticates every time a new connection
is made. The connection must remain open during the authentication
process. You cannot use NTLM to authenticate with both a proxy and
server.

Note: Do not prefix the user name with the domain.

Realm If you select the Basic or Digest authentication option, you can specify a
realm. When you do not specify a realm, the activity authenticates to 'any
realm'. If you select the NTLM authentication option, you must specify a
domain. If you do not specify a domain, the endpoint configuration is not
valid and an error occurs.

Host Name Specifies the host name of the proxy server.

Port Specifies the port number needed to connect to the proxy server.

User Name Specifies the user name needed to connect to the proxy server.

Password Specifies the password needed to connect to the proxy server.

5. When finished, click Test Connection to confirm that you can connect to Workday application.
6. Click OK.
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The Invoke Workday activity allows you to browse and execute operations in Workday management services
related to human resources, finance, and so on. You can also fetch custom report operations and work with it.

About this task

Use this task to browse and execute operations in Workday management services related to human resources,
finance and so on.

Procedure

To configure Invoke Workday activity, complete the following steps:

1. In an active orchestration, open the Activities tab and expand the Workday folder contents.
2. Drag the Invoke Workday activity icon onto the orchestration. The Invoke Workday Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make the required changes.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Workday endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click OK to save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Workday endpoint.

8. In the Checklist, click Configure.
9. In the Workday Service pane, complete one of the following:

a. Click the Service option and select the required Workday services from the list.
b. Click the Custom Report Name field and specify the name of the report.

10. Click Fetch Workday Operations to populate the Workday operations pane with operations from the
module selected in the Service option.

11. Optional: Click Workday Help to view the Workday help pages for the operation you have selected. If you
click the help button before selecting an operation, you can view the Workday help page which displays
information about all the Workday services.

12. In the Checklist, click Retry. Review the default settings and make the required changes. For more
information, see Specifying the retry options for Workday activity.

13. Select the required Workday operation and click Map Inputs from the Checklist. The XML Schemas
generated from the selected operation of the Invoke Workday activity are displayed as nodes under the
request input parameter in the To Activity panel. The Version field will be populated automatically with
the latest version of Workday supported by the connector.

The user name and password in the map inputs are populated based on the details provided in the
endpoint screen.

14. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time if no value is provided for a mandatory element, the activity throws an exception, which
is reported by the Web Management Console. If a value is not provided at run time for an optional input
parameter, no exception is thrown during run time.

15. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.

Results

You have configured the Invoke Workday activity.
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Specifying the retry options for Workday activity
Specify the retry options for the Invoke Workday activity.

Procedure

1. Select the Retry task from the Checklist. The Retry pane is displayed.
2. Configure the retry options for connecting to the Workday application. The following table describes the

retry options for connecting to the Workday application:

Field Description

Retry  

1)
Wait
___
secon
d(s)
betwe
en
each
retry.

Specifies the amount of time (in seconds) that the Integration Appliance waits before trying to
establish a connection to the Workday application.

2) Try
to
conne
ct ___
times
before
failing
.

Specifies the retry count - the maximum number of times the Integration Appliance attempts
to establish a connection to the Workday application before issuing an error and stopping the
processing of the current orchestration job.

If you deploy an orchestration that contains a Invoke Workday activity and the Integration
Appliance cannot connect to the specified the Workday service, the Integration Appliance logs
the connections errors as Warnings in the system and orchestration logs until the retry count
value is reached. When the retry count is reached, the Integration Appliance logs an Error in
the system and orchestration logs and the stops processing the current orchestration job.

For example, the retry count is set to 5. The first, second, third, fourth, and fifth, connection
errors are shown in the system log as Warnings. The Integration Appliance logs the sixth
connection error as an Error and stops processing the current orchestration job.

3)
Time
out
after
___
secon

Specifies the amount of time in seconds before a timeout occurs between the activity making a
request on an Endpoint and the time it takes the Endpoint to respond. For the Invoke Workday,
the activity timeout is the amount of time that the Integration Appliance waits for a response
from the Workday application after attempting to start the Workday service, before the
Integration Appliance issues a timeout error. An activity timeout is different from a connection
timeout because an activity timeout occurs after the connection to the Endpoint has been
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ds
when
the
Endpo
int
does
not
respo
nd to
a
reque
st.

established. A connection timeout specifies the amount of time in seconds before a timeout
occurs between the Integration Appliance attempting to establish a connection to the
Endpoint and the time it takes for the Endpoint to respond to the connection request. Set the
connection timeout in Workday Endpoint tab. For more information about connection
timeouts, see Creating and editing a Workday endpoint.
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Zuora Activities
Overview of the Zuora connector
Creating and editing a Zuora endpoint
Zuora endpoints contain the connection information that studio and the Integration Appliance use to
connect to the Zuora application. You can create multiple endpoints that refer to separate instances.
Using the Zuora Create Objects activity
Use the Zuora Create Objects activity to create objects such as Account, Amendment, Contact,
InvoiceAdjustment, InvoiceItemAdjustment, InvoicePayment, Payment, PaymentMethod, Product,
ProductRatePlan, ProductRatePlanCharge, ProductRatePlanChargeTier, RatePlan, RatePlanCharge,
RatePlanChargeTier, Refund, and Usage in the Zuora application.
Using the Zuora Update Objects activity
Use the Zuora Update Objects activity to update objects such as Account, Amendment, Contact, Invoice,
InvoiceAdjustment, InvoiceItemAdjustment, Payment, PaymentMethod, Product, ProductRatePlan,
ProductRatePlanCharge, ProductRatePlanChargeTier, RatePlanCharge, and Subscription in the Zuora
application.
Using the Zuora Delete Objects activity
Use the Zuora Delete Objects activity to delete objects such as Product, Account, or Contact from the
Zuora application.
Using the Zuora Query Objects activity
Use the Zuora Query Objects activity to query for objects such as Product, Account, or RatePlan from the
Zuora application. The query string that you specify for this operation must adhere to the Zuora Object
Query Language standard.
Using the Zuora Amend Subscription activity
Use the Zuora Amend Subscription activity to amend or change objects such as Subscription, in the
Zuora application.
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Using the Zuora Create Subscription activity
Use the Zuora Create Subscription activity to create a subscription by specifying the basic information
about the subscription such as the Account, PaymentMethod, and RatePlanData in the Zuora
application.
Using the Zuora Generate Invoice activity
Use the Zuora Generate Invoice activity to generate an invoice for a customer by specifying the
AccountId, InvoiceDate, TargetDate and so on, in the Zuora application.
Specifying the Retry options for Zuora activities
Specifying the Retry parameters is one of the tasks to configure Zuora activity.
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Overview of the Zuora connector
The Zuora connector enables a two-way communication between Cast Iron and the Zuora application. You can
create and modify objects within the Z-Billing and Z-Payment applications in Zuora, using the Zuora connector.

You can perform the following outbound activities using the Zuora connector:

Create Objects
Update Objects
Delete Objects
Query Objects
Amend Subscription
Create Subscription
Generate Invoice

The Zuora connector supports version 41.0 of the Zuora application. For more information, see
http://knowledgecenter.zuora.com/.
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Zuora endpoints contain the connection information that studio and the Integration Appliance use to connect
to the Zuora application. You can create multiple endpoints that refer to separate instances.

About this task

Use this task to create or edit Zuora endpoint.
Note:
Any changes you make to Zuora endpoint, including configuration properties, affects all the orchestrations that
use that endpoint, as the edits are global, not local.

Procedure

1. Drag an activity from Zuora folder in the Activities tab to the Orchestration window. The Summary panel
is displayed.

2. Click Pick Endpoint from the Checklist. The Pick Endpoint panel is displayed.
3. Click one of the following buttons:

a. Browse - To select an existing endpoint from Project Explorer. The Project Explorer shows all the
endpoints in the project available for the activity. When you select an endpoint, the endpoint
properties are displayed in the Pick Endpoint panel.

b. New - To create a new endpoint. The Create Endpoint window opens.
c. Edit - To edit the existing endpoint. The Edit Endpoint window opens.

4. Complete the fields defined in the following table:
Table 1. Connection Details

Field Name Description

Provide Connection Information

URL Specifies the URL of the Zuora application. By default, the value of the
production environment in Zuora
https://www.zuora.com/apps/services/a/41.0 is displayed.

User Name Specifies the user name to connect to the Zuora application.

Proxy Connection Details

Password Specifies the password associated with the user name to connect to the
Zuora application.

Proxy Host Specifies the host name of the proxy server.

Proxy Port Specifies the port number needed to connect to the proxy server.

Proxy User Name Specifies the user name needed to connect to the proxy server.

Proxy Password Specifies the password needed to connect to the proxy server.

5. When finished, click Test Connection to confirm that you can connect to Zuora application.
6. Click OK.
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Using the Zuora Create Objects activity
Use the Zuora Create Objects activity to create objects such as Account, Amendment, Contact,
InvoiceAdjustment, InvoiceItemAdjustment, InvoicePayment, Payment, PaymentMethod, Product,
ProductRatePlan, ProductRatePlanCharge, ProductRatePlanChargeTier, RatePlan, RatePlanCharge,
RatePlanChargeTier, Refund, and Usage in the Zuora application.

About this task

Use this task to create objects in the Zuora application. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Zuora Create Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Zuora folder contents.
2. Drag the Create Objects activity icon onto the orchestration. The Zuora Create Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make required changes if necessary.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Zuora endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click Test Connection to test that you have connected successfully to the Zuora application. Click OK to
save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Zuora endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Zuora window is displayed.
11. In Browse Zuora, you can either filter the object type by specifying the object type in the Search for an

object type field, or select the object type from the object type list. Click OK.
12. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for Zuora activities.
13. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Create Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

14. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time, if no value is provided for a mandatory element, the activity will be completed and the
result of createResponse will be populated with an error message. By reviewing the response of the
activity, you can know if the request had failed or was successful.

15. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.
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Results

You have configured the Zuora Create Objects activity.
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Using the Zuora Update Objects activity
Use the Zuora Update Objects activity to update objects such as Account, Amendment, Contact, Invoice,
InvoiceAdjustment, InvoiceItemAdjustment, Payment, PaymentMethod, Product, ProductRatePlan,
ProductRatePlanCharge, ProductRatePlanChargeTier, RatePlanCharge, and Subscription in the Zuora
application.

About this task

Use this task to update objects in the Zuora application. The call to this activity is a synchronous call where the
input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Zuora Update Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Zuora folder contents.
2. Drag the Update Objects activity icon onto the orchestration. The Zuora Update Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make required changes if necessary.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Zuora endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click Test Connection to test that you have connected successfully to the Zuora application. Click OK to
save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Zuora endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Zuora window is displayed.
11. In Browse Zuora, you can either filter the object type by specifying the object type in the Search for an

object type field, or select the object type from the object type list. Click OK.
12. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for Zuora activities.
13. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Update Objects activity are displayed as nodes under the request input parameter in the To Activity
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panel.
14. Create a map between the orchestration variables and the input parameter of the activity.

Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time, if no value is provided for a mandatory element, the activity will be completed and the
result of updateResponse will be populated with an error message. By reviewing the response of the
activity, you can know if the request had failed or was successful.

15. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.

Results

You have configured the Zuora Update Objects activity.
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Using the Zuora Delete Objects activity
Use the Zuora Delete Objects activity to delete objects such as Product, Account, or Contact from the Zuora
application.

About this task

Use this task to delete objects from the Zuora application. The call to this activity is a synchronous call where
the input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Zuora Delete Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Zuora folder contents.
2. Drag the Delete Objects activity icon onto the orchestration. The Zuora Delete Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make required changes if necessary.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Zuora endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click Test Connection to test that you have connected successfully to the Zuora application. Click OK to
save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Zuora endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
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orchestrations.
9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Delete Objects activity are displayed as nodes under the request input parameter in the To Activity
panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time, if no value is provided for a mandatory element, the activity will be completed and the
result of deleteResponse will be populated with an error message. By reviewing the response of the
activity, you can know if the request had failed or was successful.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results

You have configured the Zuora Delete Objects activity.
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Using the Zuora Query Objects activity
Use the Zuora Query Objects activity to query for objects such as Product, Account, or RatePlan from the Zuora
application. The query string that you specify for this operation must adhere to the Zuora Object Query
Language standard.

About this task

Use this task to query objects from the Zuora application. The call to this activity is a synchronous call where
the input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Zuora Query Objects activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Zuora folder contents.
2. Drag the Query Objects activity icon onto the orchestration. The Zuora Query Objects Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make required changes if necessary.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Zuora endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click Test Connection to test that you have connected successfully to the Zuora application. Click OK to
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save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Zuora endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes that you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML schemas generated from the selected object of the
Query Objects activity are displayed as nodes under the request input parameter in the To Activity panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time, if no value is provided for a mandatory element, the activity is completed and the result
of queryResponse is populated with an error message. By reviewing the response of the activity, you can
know if the request had failed or was successful.

11. Select the Map Outputs in the Checklist. The XML schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.
Note: The output of the Query Objects activity is queryResponse, which has a generic structure. If the
output of the Query Objects activity must be used in a later activity, direct mapping cannot be done. The
data must be extracted from the queryResponse with the help of the Apply XSLT activity.
Sample XSLT that can be used to extract specific data:

<?xml version="1.0" encoding="UTF-8"?> 
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"  
xmlns:ns1="http://api.zuora.com/" xmlns:ns2="http://object.api.zuora.com/"> 
<xsl:template match="/ns1:queryResponse/ns1:result"> 
<xsl:element name="Products"> 
<xsl:apply-templates select="ns1:records" /> 
</xsl:element> 
</xsl:template> 
<xsl:template match="ns1:records"> 
<xsl:element name="Product"> 
<xsl:element name="Id"> 
<xsl:value-of select="ns2:Id"/> 
</xsl:element > 
<xsl:element name="Name"> 
<xsl:value-of select="ns2:Name"/> 
</xsl:element > 
<xsl:element name="SKU"> 
<xsl:value-of select="ns2:SKU"/> 
</xsl:element > 
<xsl:element name="EffectiveStartDate"> 
<xsl:value-of select="ns2:EffectiveStartDate"/> 
</xsl:element > 
<xsl:element name="EffectiveEndDate"> 
<xsl:value-of select="ns2:EffectiveEndDate"/> 
</xsl:element > 
<xsl:element name="Description"> 
<xsl:value-of select="ns2:Description"/> 
</xsl:element > 
</xsl:element> 
</xsl:template> 
</xsl:stylesheet>

Results

You have configured the Zuora Query Objects activity.
Parent topic: Zuora Activities
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Using the Zuora Amend Subscription activity
Use the Zuora Amend Subscription activity to amend or change objects such as Subscription, in the Zuora
application.

About this task

Use this task to amend or change objects from the Zuora application. The call to this activity is a synchronous
call where the input data is sent to the activity for processing and the response is sent back to the
orchestration.

To configure the Zuora Amend Subscription activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Zuora folder contents.
2. Drag the Amend Subscription activity icon onto the orchestration. The Zuora Amend Subscription

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make required changes if necessary.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Zuora endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click Test Connection to test that you have connected successfully to the Zuora application. Click OK to
save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Zuora endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Amend Subscription activity are displayed as nodes under the request input parameter in the To Activity
panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time, if no value is provided for a mandatory element, the activity will be completed and the
result of amendResponse will be populated with an error message. By reviewing the response of the
activity, you can know if the request had failed or was successful.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.

Results
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You have configured the Zuora Amend Subscription activity.
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Using the Zuora Create Subscription activity
Use the Zuora Create Subscription activity to create a subscription by specifying the basic information about
the subscription such as the Account, PaymentMethod, and RatePlanData in the Zuora application.

About this task

Use this task to create a subscription in the Zuora application. The call to this activity is a synchronous call
where the input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Zuora Create Subscription activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Zuora folder contents.
2. Drag the Create Subscription activity icon onto the orchestration. The Zuora Create Subscription

Checklist is displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make required changes if necessary.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Zuora endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click Test Connection to test that you have connected successfully to the Zuora application. Click OK to
save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Zuora endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the
Create Subscription activity are displayed as nodes under the request input parameter in the To Activity
panel.

10. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time, if no value is provided for a mandatory element, the activity will be completed and the
result of subscribeResponse will be populated with an error message. By reviewing the response of the
activity, you can know if the request had failed or was successful.

11. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

12. Create a map between the output parameters and orchestration variables.
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Results

You have configured the Zuora Create Subscription activity.
Parent topic: Zuora Activities
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Using the Zuora Generate Invoice activity
Use the Zuora Generate Invoice activity to generate an invoice for a customer by specifying the AccountId,
InvoiceDate, TargetDate and so on, in the Zuora application.

About this task

Use this task to generate an invoice in the Zuora application. The call to this activity is a synchronous call where
the input data is sent to the activity for processing and the response is sent back to the orchestration.

To configure the Zuora Generate Invoice activity, complete the following steps:

Procedure

1. In an active orchestration, open the Activities tab and expand the Zuora folder contents.
2. Drag the Generate Invoice activity icon onto the orchestration. The Zuora Generate Invoice Checklist is

displayed.
3. In the Checklist, click Summary.
4. Review the contents of the Activity Name field, and make required changes if necessary.
5. In the Checklist, click Pick Endpoint.
6. Click Browse and use the Project Explorer dialog box to select the relevant Zuora endpoint.
7. Optional: You can create the endpoint by clicking New and specifying the required connection details.

Click Test Connection to test that you have connected successfully to the Zuora application. Click OK to
save and use the endpoint for this configuration.
Note: For more information, see Creating and editing a Zuora endpoint.

8. To make required changes to the selected endpoint configuration, click Edit to access the options in a
separate window. Any changes you make globally affects all uses of the endpoint in active
orchestrations.

9. In the Checklist, click Configure.
10. Click Browse to select the object type. The Browse Zuora window is displayed.
11. In Browse Zuora, you can either filter the object type by specifying the object type in the Search for an

object type field, or select the object type from the object type list. Click OK.
12. In the Checklist, click Retry. Review the default settings and make the required changes. For more

information, see Specifying the Retry options for Zuora activities.
13. Select the Map Inputs in the Checklist. The XML Schemas generated from the selected object of the

Generate Invoice activity are displayed as nodes under the request input parameter in the To Activity
panel.
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14. Create a map between the orchestration variables and the input parameter of the activity.
Note: Values must be provided at run time for any mandatory elements of the input structure. A value
can be provided by specifying a default value for element or by linking the element with an input node.
During run time, if no value is provided for a mandatory element, the activity will be completed and the
result of generateResponse will be populated with an error message. By reviewing the response of the
activity, you can know if the request had failed or was successful.

15. Select the Map Outputs in the Checklist. The XML Schema generated to hold the response of the activity
is displayed as nodes under the response output parameter in the From Activity panel.

16. Create a map between the output parameters and orchestration variables.

Results

You have configured the Zuora Generate Invoice activity.
Parent topic: Zuora Activities
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Specifying the Retry options for Zuora activities
Specifying the Retry parameters is one of the tasks to configure Zuora activity.

About this task

Use this task to configure the retry options for the Zuora activities. The Zuora connector obtains a new session
for each activity. If the connector fails to obtain a session in the first attempt due to network issues, retry
occurs. The connector does not count the initial attempt to reacquiring the session as a retry attempt. The
connector assumes the typical connector retry behavior after the initial attempt to reacquire a session fails.

Procedure

1. Select the Retry task from the Checklist. The retry pane is displayed.
2. Configure the retry and timeout options for connecting to Zuora application, as described in the

following table:
Table 1. Retry options

Retry
Fields Description

Wait __
seconds
between
each
retry.

Specifies the number of seconds that the Integration Appliance waits before trying to
establish a connection to Zuora application.
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Retry
Fields Description

Try to
connect
__ times
before
failing.

Specifies the retry count — the maximum number of times the Integration Appliance
attempts to establish a connection to Zuora application before issuing an error and stopping
the processing of the current orchestration job.
Note: If you deploy an orchestration that contains Zuora activity and the Integration
Appliance cannot connect to the specified Zuora application, the Integration Appliance logs
the connections errors as Warnings in the system and orchestration logs until the retry
count value is reached. When the retry count is reached, the Integration Appliance logs an
Error in the system and orchestration logs and stops processing the current orchestration
job. For example, you set the retry count to 3, the first, second, and third connection errors
appear in the system log as warnings. The Integration Appliance logs the fourth connection
error as an error and stops processing the current orchestration job.

Activity Timeout

Timeout
after
____
seconds
when
the
endpoint
does not
respond
to a
request.

Specifies the number of seconds the Integration Appliance waits before timing out, when
the endpoint does not respond to a request. The default is 300 seconds.

Parent topic: Zuora Activities
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Using Secure Connectors
A Secure Connector facilitates the secure transfer of data between the IBM® WebSphere® Cast Iron® appliance
and an endpoint that is located behind a firewall. You can perform the run time verification of the orchestration
against an endpoint behind a firewall from Studio, using Secure Connectors. This feature of discovering Secure
Connectors and verifying the orchestrations in Studio, is applicable only for the Integration Appliance and not
for Cast Iron Live.

Before you begin

To verify the orchestration in Studio using Secure Connector, you must complete the following tasks:
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Create a Secure Connector on the appliance.

Download the configuration file and the installer for the Secure Connector from the appliance, and install
it on a machine behind the firewall.

Start the Secure Connector that was installed in the earlier step, and ensure that the status of the Secure
Connector in the Integration Appliance, is displayed as "running".

Procedure

Configure the orchestration with a locally accessible endpoint, which is a replica of the endpoint behind the
firewall.

To use Secure Connectors for the verification of the orchestration from Studio for the compatible Cast Iron
connectors, such as, the HTTP connector, complete the following:

1. Edit the endpoint details of the activity, to use the other endpoint behind firewall.
2. Go to the Remote Endpoint Configuration section.
3. Select the Endpoint Runs Behind Firewall check box to enable the Secure Connector Name field.
4. Click Browse and specify the details of the Integration Appliance, where the Secure Connectors are

registered. The Discover Secure Connectors dialog is displayed.

The appliance users of the Publisher or Admin group can connect to the appliance through Studio, to
discover the Secure Connectors.

5. Click Discover. The Integration Appliance displays the list of all the Secure Connectors that are actively
running.

6. Select the Secure Connector that corresponds to the environment where the endpoint is running.
7. Save the project and perform the verification of the orchestration.

During the verification of the orchestration in the Studio environment, the connector will execute the
activity using the Secure Connector that you configured through the Integration appliance. You can now
test the orchestration against an environment situated on a different network other than the Studio
environment.

Note:
The Discover Secure Connectors dialog displays only those Secure Connectors that are currently
in the "running" state. So, ensure that the Secure Connector is started in the on-premise
environment.
The communication between Studio and Appliance is through HTTP transport.
For an old project, you must import the project into the Studio and perform the steps described
above.
The test connection and discovery of the artifacts through a Secure Connector is not currently
supported from the Studio environment.
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Variables
About variables
In orchestrations, variables provide temporary storage locations to hold the input and output data of
activities.
Creating variables
Use the topics in this section to decide which method to use to create new variables in an orchestration.
Configuring variable properties
Configure variable properties from the Properties of pane on the Variables tab.
Removing Variables
You can remove a specific variable, or all unused variables from the orchestration, as described in this
section.
Specifying a default value
Specify a default value for a variable which is appropriate for its data type.
Browse for Schema Element
Select a root element of a schema or fragment of a schema.
Selecting a Substitution Type for Variables
When an XML Schema defines an XML element based on derived types, you must specify the derived
type (or substitution type) expected during run time.
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About variables
In orchestrations, variables provide temporary storage locations to hold the input and output data of activities.

This is shown in the example orchestration of the following figure:

During run time, this orchestration extracts data from and stores data into variables as described in the
following steps:
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1. The FTP Poll Directory activity polls for a Flat File on an FTP Server and places the contents of the Flat
File into the data output parameter. The data output parameter is mapped to the string variable called
flatFileRawContent.

2. The Flat File data returned from the FTP Poll Directory activity is stored as a string into the
flatFileRawContent variable.

3. The flatFileRawContent variable is mapped to the Data input parameter of the Read Flat File activity. The
Flat File data is parsed by the Read Flat File activity and returned from the activity in the XML output
parameter.

4. The XML output parameter is mapped to the batchOrderXML Flat File Schema variable. The data is
available in the orchestration from the batchOrderXML Flat File Schema variable. For example, if an
activity is added to the orchestration to the right of the Read Flat File activity, it can use this data as
input.

Variables must be initialized in an orchestration in order for the orchestration to be considered valid. This
includes variables that are initialized in the branches of an If.. Then activity. The variable must be initialized in
all branches. For more information see Validating the orchestration.

Variable scope

Variables defined within the Group, Try/Catch, If Then, While Loop, or For Each activities are considered as
local variables. When such a variable is used as an input of a Map Inputs Tasks activity or a Map Variables
activity that is outside of, and following the Group, Try/Catch, If Then, While Loop, or For Each activity, the
variable is considered as uninitalized because it is outside the scope of the activities where it was declared.
Therefore, these variables must be initialized with a default value.

For more information about specifying a default value, see the Specifying a default value section.

The Variables tab

The Variables tab contains the following panes:

Variables: Displays the variables that are defined and available for use in the Mapping Editor. A
predefined variable called JobInfo is available in the Variables pane of the Variables tab by default.
Schema of <variable>: Displays the schema for the selected variable.
Activities using <variable>: Displays all activities in the orchestration which use the variable.
Properties of <variable>: Where you define or edit variable properties or specify a default value.

The JobInfo variable

By default, Studio provides the JobInfo variable. The Integration Appliance provides the values for the JobInfo
nodes during run time. The JobInfo variable contains the nodes defined in the following table:

JobInfo Node Name Data Type Description

jobId String Contains the job ID number
assigned to the instance of the
orchestration. When the
orchestration starts processing the
activities contained in the
orchestration, a job ID number is
assigned to that instance of the
orchestration. This job ID number
is also visible from the Web
Management Console (WMC).
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JobInfo Node Name Data Type Description

jobStartTime XML Schema data type
xsd:dateTime

Contains the date and time that the
instance of the orchestration
started processing.
Note: The jobStartTime is the date
and time that the orchestration
starts processing the messages or
events and is assigned a job ID
number. The jobStartTime is not
the date and time that
orchestration was deployed on the
Integration Appliance and became
active —ready to start processing
messages and events.  For
example, an orchestration contains
a FTP Poll Directory activity (a
starter activity) that is deployed on
the Integration Appliance. The
orchestration becomes active
waiting for a file to show on the
FTP Server in a particular directory.
When the orchestration
determines that a file has been
placed in a particular directory on
the FTP Server, it starts processing
the FTP Poll Directory activity.
When the orchestration starts
processing, the current date and
time is stored in thejobStartTime
node.

projectName String The name of the project that
contains the current orchestration.

configurationName String The name of the configuration
associated with the current
instance of the orchestration.
Different configurations of projects
are created using the Web
Management Console (WMC).

orchestrationName String The name of the orchestration
currently processing.

routerHostName String The host name of the Integration
Appliance that the current instance
of the orchestration is running on.

Note: The JobInfo variable or the nodes of the JobInfo variable cannot be removed.
Parent topic: Variables

Feedback | Notices

 745



 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/about_variables.html

Creating variables
Use the topics in this section to decide which method to use to create new variables in an orchestration.

Create a new variable using the Create New Variable option
Create a new variable using the Select Inputs or Select Outputs buttons
Create a new variable using the toolbar menu
Create a new variable using the Copy menu option
Create a new variable using the Copy button
Primitive Data Types

Parent topic: Variables
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Create a new variable using the Create New Variable option

About this task

To create a new variable using the Create New Variable option of the Variables pane:

Procedure

1. Open an orchestration and select the Variables tab.
2. Right-click the Variables pane and select the Create New Variable option from the list. The "Create New

Variables Step 1 of 2" dialog box is displayed.
3. Select a data type or schema to base the new variable:

For a variable based on a primitive data type:
a. Scroll to the end of the "Create New Variables Step 1 of 2" dialog box.
b. Select a primitive data type from the Primitive Types folder.
c. Click Next.

For a variable based on a schema:
a. Optional: To search for a node by name, click Find.
b. From the schema, select a node to be the root of the new variable.
c. Click Next.

4. Enter a name for the new variable and click Finish. The new variable is added to Variables toolbox, and
the schema opens in the Schema of pane on the Variables tab.
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Attention: Do not create a variable in the following format: __variableName__. Variable names that start
with two underscore characters (_) and ends with two underscore characters (_) are not supported. If an
orchestration contains variable names using this format, the orchestration fails to validate.

Parent topic: Creating variables
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Create a new variable using the Select Inputs or Select
Outputs buttons

About this task

To add a new variable using the Select Inputs or Select Outputs buttons in the mapping panes of activities:

Procedure

1. Open an orchestration.
2. Double-click an activity.
3. Select a mapping task in the Checklist.
4. Add a variable to the map:

To add an input variable to the map, click Select Inputs.
To add an output variable to the map, click Select Outputs.

5. Click New. The "Create New Variables Step 1 of 2" dialog box opens.
6. Select a data type or schema to base the new variable:

For a variable based on a primitive data type:
a. Scroll to the end of the "Create New Variables Step 1 of 2" dialog box.
b. Select a primitive data type from the Primitive Types folder.
c. Click Next.

For a variable based on a schema:
a. Optional: To search for a node by name, click Find
b. From the schema, select a node to be the root of the new variable.
c. Click Next.

7. Enter a name for the new variable and click Finish.

The new variable is added to Variables toolbox, and the schema displays in the Schema of pane on the
Variables tab. The new variable is also added to the mapping pane.

Attention: Do not create a variable in the following format: __variableName__. Variable names that start
with two underscore characters (_) and ends with two underscore characters (_) are not supported. If an
orchestration contains variable names using this format, the orchestration fails to validate.

Parent topic: Creating variables
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Create a new variable using the toolbar menu

About this task

To add a new variable using the Map > Add options available from the toolbar menu:

Procedure

1. Open a mapping pane of an activity.
2. Click a node in the mapping pane.
3. Select an active Map toolbar menu option

Map > Add Input Variables
Map > Add Output Variables

The "Add Variables" dialog box is displayed.
4. Click New. The "Create New Variables Step 1 of 2" dialog box is displayed.
5. Select a data type or schema to base the new variable:

For a variable based on a primitive data type:
a. Scroll to the end of the "Create New Variables Step 1 of 2" dialog box.
b. Select a primitive data type from the Primitive Types folder.
c. Click Next.

For a variable based on a schema:
a. Optional: To search for a node by name, click Find.
b.  From the schema, select a node to be the root of the new variable.
c. Click Next.

6. Enter a name for the new variable and click Finish. The new variable is added to Variables toolbox, and
the schema is displayed in the Schema of pane on the Variables tab. The new variable is also added to
the mapping pane.
Attention: Do not create a variable in the following format: __variableName__. Variable names that start
with two underscore characters (_) and ends with two underscore characters (_) are not supported. If an
orchestration contains variable names using this format, the orchestration fails to validate.

Parent topic: Creating variables
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Create a new variable using the Copy menu option

About this task

To create a new variable using the Copy menu option while viewing the graphical representation of an XML
Schema:

Procedure

1. Open an orchestration.
2. Select the Project tab and double-click an XML Schema in the XML Schemas folder to open it. A schema

tab opens with a graphical representation of the XML Schema.
3. Select the Variables tab.
4. Select a node in the schema to be the root of the new variable. Right-click the node in the schema tab

(displayed on the left) and from the menu select Copy.
5. Select an orchestration tab and then select the Variables tab.
6. Click the Variables pane of the Variables tab and paste fragment of the schema using one of the

following options:
Right-click and from the menu select Paste.
From the toolbar menu, select Edit > Paste.

7. Optional: Rename the variable by clicking in the Name field of the "Properties of" pane of the Variables
tab.
Attention: Do not create a variable in the following format: __variableName__. Variable names that start
with two underscore characters (_) and ends with two underscore characters (_) are not supported. If an
orchestration contains variable names using this format, the orchestration fails to validate.

Parent topic: Creating variables
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Create a new variable using the Copy button

About this task

To add a new variable using the Copy button in the mapping panes of activities:

Procedure

For more information, see Copying Parameters.
Parent topic: Creating variables
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Primitive Data Types
The following table lists primitive data types that can be used when creating a variable:

Primiti
ve Data
Type Description

base64
binary

Base64-encoded arbitrary binary data The ·value space· of base64Binary is the set of finite-length
sequences of binary octets. For base64Binary data the entire binary stream is encoded using the
Base64 Alphabet in [RFC 2045].

anyTyp
e

A concrete ur-Type, which can serve either as a complex type (non-scalar data, means elements),
or as a simple type (scalar data) depending on the context.

dateTim
e

Specific instant of time. ISO 8601 extended format CCYY-MMDDThh:mm:ss

QName
/qname

XML qualified names.

int int is derived from long by setting the value of ·maxInclusive· to be 2147483647 and ·minInclusive·
to be -2147483648

string The string datatype represents character strings in XML

boolean This data type has two possible values: true or false. It is typically used to track true or false
conditions.

decimal A subset of the real numbers, which can be represented by decimal numerals

Parent topic: Creating variables
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Configuring variable properties
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Configure variable properties from the Properties of pane on the Variables tab.

About this task

When using variables within the Group or Try/Catch activities, these variables are regarded as local variables.
When these variables are used outside of the scope of the activities where they were declared, they are
considered to be uninitialised. If a variable defined within the Group or Try/Catch activities is used as an input
of a Map Inputs Tasks activity or a Map Variables activity that is outside of, and following, the Group or
Try/Catch activity, the variable is considered as uninitalised.

Procedure

1. Click the Name field and enter a name for the variable.
2. Click the Data Type field and select a Data Type from the list. In addition to the default Data Types, the

list lists the names of the root nodes of the Flat File Schemas, XML Schemas, and DTD files that have
been defined or uploaded into the project. The following default Data Types are listed in the menu:

DateTime: a date and time stored as an XML Schema xs:dateTime data type
AnyType: any type of data can be stored in this catch-all (XML Schema xs:anyType) data type
String: text characters (primitive)
Integer: integers (primitive)
Base64Binary: base64 binary encoded data stored as an XML Schema xs:base64Binary data type
Browse for Schema....: use this option to redefine the schema or schema fragment that the
variable is based on

3. Optional: Click the Default Value field and specify a default value for the variable.
4. Click the Shared field to specify to share this variable across orchestration jobs. By default, variables are

not shared (False). To share this variable across all the orchestration jobs of this type of orchestration,
select the True option from the list. If the Shared field is set to True, the Process Orchestration Jobs
Sequentially check box becomes automatically selected.
Note: Variables based on schema fragments can be created by dragging a node from the Schema of
pane into the Variables pane of the Variables tab.
Note: Shared variables are sometimes used with scheduled orchestrations to maintain state information
for each scheduled invocation of the orchestration job.

Parent topic: Variables
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Removing Variables
You can remove a specific variable, or all unused variables from the orchestration, as described in this section.

About this task

Remove variables from the orchestration in one of the following methods:
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To remove a specific variable:

1. Select the variable from the Variables pane inside of the Variables tab.
2. Right-click and select Remove Variable from the list

Note: Removing a variable can modify any maps that refer to it.

To remove variables not used in the orchestration:

1. Right-click the Variables pane inside of the Variables tab.
2. Select Remove Unused Variable(s).

Parent topic: Variables
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Specifying a default value
Specify a default value for a variable which is appropriate for its data type.

About this task

The value you supply as a default must match the data type of the variable. You can enter a default value or you
can select a default value from a file. Typically you select a default value from a file for variables that are based
on schemas. For variables based on an XML Schema, you load an XML file that is valid to the XML Schema.

Specify a default value using one of the following methods:

To enter a default value manually:

1. Click the Default Value field of the "Properties of" pane.
2. Enter a value.

To select a default value from a file:

1. Click [..] in the Default Value field. The Default Value dialog box is displayed.
2. Click Upload. The Open Sample Document dialog box opens.
3. Select a sample file and click Open. The contents of the file show in the Default Value dialog box.
4. Click OK. The OK button is located at the end of the pane.

Parent topic: Variables
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Browse for Schema Element
Select a root element of a schema or fragment of a schema.

About this task

The Browse for Schema Type Element dialog box shows the current nodes of the different schemas available in
the project. You can select either a root element of the schema or a fragment of the schema (a child node of the
root element). To upload a new schema into the project, see Uploading Files into a Project.

To select the root of a schema or a schema fragment:

Procedure

1. In the Browse for Schema Type Element dialog box select either a root element of the schema or a
fragment of the schema (a child node of the root element).

2. Expand the schema to view the nodes that make up the schema. To find a particular node in the schema,
enter the beginning characters of the node name.

3. Click OK.

Parent topic: Variables
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Selecting a Substitution Type for Variables
When an XML Schema defines an XML element based on derived types, you must specify the derived type (or
substitution type) expected during run time.

About this task

The XML Schema specification supports the ability to derive complex types by extension. For more general
information about type substitution and about using type substitution in mapping panes, see Selecting a
Substitution Type.

When an XML Schema defines an XML element based on derived types, you must specify the derived type (or
substitution type) expected during run time. In Studio, you must specify the expected substitution type for the
XML element of the variable using the Substitute Node With ... menu option as described in the following
procedure.

To select a substitution type for a variable:
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Procedure

1. Upload an XML Schema that contains an XML element-based derived types into the project. For more
information, see Uploading Files into a Project.

2. Create a variable that contains an XML element based on derived types. The schema associated with the
node displays in the "Schema of" pane of the Variables tab.

For the example XML Schema provided in Selecting a Substitution Type, create a variable based on the
<shape> element. The schema associated with the <shape> element is displayed in the "Schema of"
pane of the Variables tab as shown in Figure 1:

Figure 1. The schema associated with the shape element as displayed by the Schema of pane.

Note that the child elements of the derived types are not listed in the "Schema of" pane.  In this
example, the child element of circle which is named diameter is not listed, nor are the child elements of
rectangle which are named width and length.

3. In the "Schema Of" pane of the Variables tab, select the derived type expected during run time, by right-
clicking the node and from the menu selecting the Substitute Node With ... option.

The Substitute Node with a Derived Type dialog box is displayed. In the menu, the available derived
types for the node as defined by the XML Schema are listed. For this example, the two derived types are
available from the menu as shown in Figure 2:
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Figure 2. The figure shows the two derived types for the Node: circle and rectangle.

4. Select one of the derived types. The selected derived type determines the expected type of XML
instance document during run time.

In this example, the circle derived type is selected, so the XML data expected for this variable during run
time is of type circle.

In addition to the child elements of the base type, the child elements of the derived type are displayed in
the "Schema of" pane. In this example, the child element named diameter is displayed with the child
element named color (inherited from the base type) in the "Schema of" pane of the Variables tab as
shown in Figure 3:

Figure 3. Variables tab

What to do next

When a derived type has been selected for a node of a variable using the Substitute Node With ... option, you
can remove the association between the node of a variable and the derived type by right-clicking the node and
selecting the Unsubstitute Node option from the menu. An Unsubstitute dialog box opens. Click Yes.
Parent topic: Variables
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Flat File Schemas
Flat File Schema Editor Overview
A Flat File Schema is metadata that describes the format and structure of Flat File data processed by the
Integration Appliance. When you create a Flat File Schema, a corresponding internal XML Schema-based
representation of the metadata is also generated.
About delimited data
About fixed length or 'positional' data
Mixed positional and delimited example
Creating a flat file schema
Testing flat file schemas
Root node properties
When a root node is selected in the Schema Layout tab, the following two sections of properties are
available in the pane: Basic Properties and Delimiters.
Adding Fields or Field Types
Field properties
Adding Records or a Record Type
Record properties
Adding Groups or Group Types
Group Properties
When a group is selected in the Schema Layout tab, the Basic Properties of a group are displayed. When
a group type is selected in the Type Library tab, the Basic Properties of the group type are displayed. The
Basic Properties of a group or group type are listed in the following table:
Group Example
Working with Nodes in the Schema Tabs
Adding Several Children
Valid Node Names
The Type Library Tab
Specifying Optional Fields and Records
Generating a flat file schema from an IDOC
At design time, using the Project > Import > SAP IDOC Schema toolbar menu option, you can interrogate
an SAP endpoint for IDOC metadata and from that metadata generate a Flat File Schema.
Using the Flat File Wizard
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Flat File Schema Editor Overview
A Flat File Schema is metadata that describes the format and structure of Flat File data processed by the
Integration Appliance. When you create a Flat File Schema, a corresponding internal XML Schema-based
representation of the metadata is also generated.

During run time, the Integration Appliance uses the Flat File Schema for the following actions:

Parse incoming Flat File data (valid to the Flat File Schema) and convert it to XML data. This parsing is
done in the Read Flat File activity of an orchestration. The converted XML data is valid to the generated
internal XML Schema generated from the Flat File Schema. For an example orchestration that reads Flat
File data, see the "Developing the BookOrder Project" section of the Getting Started Guide.
Convert XML data into outgoing Flat File data valid to a Flat File Schema. This conversion is done in the
Write Flat File activity of an orchestration.

Use the Flat File Schema Editor to create Flat File Schemas to describe the following types of data:

Delimited data - A Flat File Schema can describe data that is defined using delimiters, for example: EDI
data or by comma-separated values (CSV). A CSV file containing delimited data is shown in the following
figure:

For an example Flat File Schema that parses delimited fields and contains repeating records, see "Developing
the BookOrder Project" section of the Getting Started Guide.

Fixed length or 'positional' data: A Flat File Schema can describe fixed length or positional data. Many
mainframe applications use positional data. Fixed-length data is shown in the following figure:
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Mixed positional and delimited data - A Flat File Schema can describe a mix of both delimited and
positional data as shown in the following figure:

Parent topic: Flat File Schemas

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/ref_Flat_File_Definition_Editor_Overvie
w.html

About delimited data
Delimited data is a collection of records or fields with variable lengths. Delimiters are used to signal the
beginning or end of the record or field as shown in the following figure:

Figure 1. An example of delimited data where individual fields of the record are delimited by commas
(LastName, FirstName and CustomerId), and the records of the file are delimited by the end of line.
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Records can also have identifying codes, known as records IDs. In the data in Figure 2, each record begins with
a record ID and ends with a delimiter.

Figure 2. Records with identifying codes

As shown in Figure 2, records can repeat individually; the end of the repetition is marked by the record ID of
the next record. Records can also repeat as a set of records; the end of the repetition is marked by the record
ID of the next record that is not in the set.
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Records contain fields; each field begins with a field delimiter. Fields end with either the delimiter beginning in
the next field or with the end of the record.

Fields can be complex, containing components that are delimited with a component delimiter. Fields can also
contain multiple data values - they repeat and use a repeat delimiter between values as shown with the
phone1 and phone2 fields.

To implement a Flat File Schema for this sample data with record IDs, you would map each characteristic of the
data as shown in the following table:

Flat File Characteristic Flat File Schema Implementation

Delimited format for the highest level of
structure in the data

For the root node set the Structure property to Delimited

Record delimiter For the root node or a record node set the child delimiter

Record IDs For the root node or a record node, set the record identifier
property to the respective ID value
For the root node or a record node, set the record identifier
offset to 1

Repeating records For record nodes, set the maximum occurrence property to
unbounded or to a specific value

Repeating sets of records Create a group node for each set and make the records in the set
the content of the group

Field delimiter Record nodes, set the child delimiter property

Repeating fields Record nodes, set the repeat delimiter property

Complex fields Define each as a subrecord that is child to the record containing the
field

Components within complex fields Define as field children in the subrecord

Component delimiter Record node for the complex field, set the child delimiter property
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About fixed length or 'positional' data
Fixed length or positional data are simple collections of records where each record has a known length.  For
example, the lastName field could contain the characters found between the 1 and the 16 character positions,
as shown in Figure 1:

Figure 1. Positional or Fixed Length Data example where a limited number of cells or boxes is allocated to each
category, in this example: lastName, firstName, and customerID.
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As shown in Figure 1, delimiters are not used to separate the characters between the following fields:

lastName
firstName
customerID

For this example, the end-of-line delimiter is used to separate the data in the first and second records. You can
define a Flat File Schema for a mix of positional and delimited data.

All data in the record is required because omitting the data would change the position of subsequent fields. If
data is not available, spaces or zeros are added to pad out the field lengths as shown for the nickname and age
fields in the following figure:

Figure 2. Padding using spaces or zeros

In the second line of data in the previous figure, no name is specified in for the nickname field - instead, there
are spaces to pad out the missing nickname, so the string: Halden is correctly parsed as a last name. In
addition, an extra zero was added to the front of the ages because the age field is three characters but the ages
12 and 91 are only two characters long.

Fields and records can repeat, but the number of repletions must be predefined in Studio and each record must
have the same number of fields. For example, if you specified that the number of occurrences of the nickname
field was equal to two, each record in the field must specify two nicknames or add spaces to pad for the
missing nickname as shown in the following figure:
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Figure 3. Padding with spaces

For an example of parsing positional data, see the originNode of the Mixed positional and delimited example.
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Mixed positional and delimited example

About this task

This example shows how to build a Flat File Schema to parse a mix of positional and delimited data. To create a
Flat File Schema, you must first analyze your Flat File data to determine what fields and nodes to added to the
Flat File Schema. In this example, you create a Flat File Schema for the following two lines of data:

BuyRight Pharmacy;USACAMVI334;!389!22;34980;

Taylor Drugs;USANJWLB128;!778!23!523;5667;

Use a top-down approach for defining the records and fields of the Flat File Schema as shown in the following
steps:

Procedure

1. Create a root node:
a. In the Project tab, right-click the Flat File Schemas folder and select New Flat File Schema. The

Basic Wizard dialog box opens.
b. Enter Order in the Name field.
c. Click OK. The Flat File Schema Editor opens and the Flat File Schema is displayed beneath the

Flat File Schemas folder in the Project tab. In addition, a root node of the same name shows in
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the Schema Layout tab.
2. Determine the highest level of structure in the data. In this example the largest structure is the two lines

that each represent a record. The two records in this Flat File data are delimited by an end-of-line that is
located in between the two records, as shown in Figure 1:
Figure 1. Mixed example 1: the records of the file are delimited by the end-of-line that is located
between the characters that make up the record.

3. Configure the root node called Order to parse the child repeating records using the following criteria:
Separate the data into records using a delimiter.
Expect the document to end with an EOS (End Of Stream) because the last record does not end
with a delimiter.
Use the end-of-line delimiter to delimit any child records.
Expect the delimiter in between the data.
Expect repeating child records.
Use the end-of-line delimiter to delimit the child repeating records.

Using these criteria, specify the following values for the Basic Properties and Delimiters pane of the
Order node as shown in Figure 2:

Figure 2. Mixed example pane 1 where Structure is Delimited and Document ends with EOS box ticked.
The Line End option is selected and Child Delimiter position is set to In Between

4. Add a child node to the root node to represent the records. In the Schema Layout tab, right-click the
Order node. From the menu, select New Child > Record, enter purchaseOrder, and click OK.

5. Determine the next level of structure in data. In this example, the next level of structure are the fields
delimited by semicolons as shown in Figure 3:
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Figure 3. Mixed example 2: The individual fields of the record are delimited by semicolons.

6. Configure the purchaseOrder node to parse these fields as described by following criteria:
The purchaseOrder node can have one or more occurrences.
Parse the data of the record into child fields using a delimiter.
Use the semicolon as the delimiter between the data.
Expect the delimiter after the data.

Using these criteria, specify the following values for the Basic Properties and Delimiters pane of the
purchaseOrder node as shown in Figure 4:

Figure 4. Mixed example pane 2: Structure is set to Delimited, Maximum unbounded and Character
option selected. Child Delimiter Position is set to After.

7. Add the fields of the purchaseOrder node by right-clicking the purchaseOrder node in the Schema
Layout tab and selecting the New Children option from the list.  The Bulk Add dialog box is displayed.

8. In the Bulk Add dialog box, add all the child records and fields of the purchaseOrder node:
Click Add and change field1 to storeName. Leave the Node Type set to Field.
Click Add and change field2 to originCode. Change the Node Type to Record.
Click Add and change field3 to items. Change the Node Type to Record.
Click Add and change field4 to orderID. Leave the Node Type set to Field.
Click OK.

9. Determine the next level of structure in data. In this example, the next level of structure is a set of
positional data found in the originCode record as shown in Figure 5:
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Figure 5. Mixed example 3: originCode is a section of positional data in the delimited record.

10. Configure the originCode record to be positional:
a.  In the Schema Layout tab, select the originCode node. The Basic Properties are displayed.
b. In the Structure list, select Positional.

11. Add the positional fields of the originCode node by right-clicking the originCode node in the Schema
Layout tab and selecting the New Children option from the list. The Bulk Add dialog box opens.

12. In the Bulk Add dialog box, add all the child records and fields of the originCode node:
a. Click Add and change field1 to countryCode. Leave the Node Type set to Field.
b. Click Add and change field2 to stateCode. Leave the Node Type set to Field.
c. Click Add and change field3 to cityCode. Leave the Node Type set to Field.
d. Click Add and change field4 to storeCode. Leave the Node Type set to Field.
e. Click OK.

13. Configure the Positional Properties of each positional field. For each child node of the originCode node,
click the node in the Schema Layout tab and at the end of the properties pane set the values of the Field
Offset and Field Length as shown in the following list:

countryCode -

stateCode -

cityCode -

storeCode -
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The Field Offset is calibrated from the current character location as the originCode string is being
processed and not from the beginning of the originCode string for each field. In this example, the
countryCode is processed and the first three characters of the originString are assigned to the
countryCode. When the stateCode is processed, the current character location is already at the 3
character location, so the Field Offset of 1 of stateCode is added to the current character location to get
the starting point for processing the stateCode string as shown in Figure 6:

Figure 6. Mixed Example 4 shows current cursor location and Field Offset.

14. Determine the next level of structure in data. In this example, the next level of structure are the
repeating fields delimited by exclamation points as shown in Figure 7:
Figure 7. Mixed example 5 where delimited data is indicated by exclamation points.

15. Configure the items node to parse child repeating records using the following criteria:
Separate the data into fields using a delimiter.
Use exclamation points as delimiters to delimit any child fields.
Expect the delimiter before the data.
Expect one or more repeating child fields.
Use exclamation points as delimiters to delimit the child repeating fields.

Using these criteria, specify the following values for the Basic Properties and Delimiters pane of the
items node as shown in Figure 8:
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Figure 8. Mixed example pane 3 where Child Delimiter Position is set to Before.

16. Add the repeating child field to the items node by right-clicking the items node in the Schema Layout tab
and selecting the New Child > Field option from the list. The New Field dialog box opens.

17. In Field Name enter item and click OK.
18. Configure the item node to contain one or more occurrences as shown in Figure 9:

Figure 9. Mixed example pane 4 where Maximum Repeat is set to Unbounded.

The Flat File Schema is complete and ready to test.
19. Paste the following text into the left sub-pane of the test pane:

BuyRight Pharmacy;USACAMVI334;!389!22;34980;

Taylor Drugs;USANJWLB128;!778!23!523;5667;

This data is also provided in the mixedData.txt file. If you accepted the defaults during the installation of
Studio, this file is located in the following directory: C:\Program Files\IBM\WebSphere Cast Iron Studio
3.X\Samples\FlatFileSchema
Attention: Do not add a carriage return after the last line.

20. Click the Test icon.

The Save Confirmation dialog box opens.
21. Click Yes. The following XML representation of the data is shown within the test pane:

<?xml version="1.0" encoding="UTF-8"?> 
<Order> 
 <purchaseOrder> 
  <storeName>BuyRight Pharmacy</storeName> 
  <originCode> 
   <countryCode>USA</countryCode> 
   <stateCode>CA</stateCode 
   <cityCode>MVI</cityCode> 
   <storeCode>334</storeCode> 
  </originCode> 
  <items> 
   <item>389</item> 
   <item>22</item> 
  </items> 
  <orderId>34980</orderId> 
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 </purchaseOrder> 
 <purchaseOrder> 
  <storeName>Taylor Drugs</storeName> 
  <originCode> 
   <countryCode>USA</countryCode> 
   <stateCode>NJ</stateCode> 
   <cityCode>WLB</cityCode> 
   <storeCode>128</storeCode> 
  </originCode> 
  <items> 
   <item>778</item> 
   <item>23</item> 
   <item>523</item> 
  </items> 
  <orderId>5667</orderId> 
 </purchaseOrder> 
</Order>

22. In the Schema Layout tab, click the item node. In the right sub-pane of the test pane, the data parsed
into the item node is highlighted as shown in Figure 10:
Figure 10. The item node is highlighted

23. Click the state node to view the data assigned into the state node.
Note: A reference implementation of the Order Flat File Schema is provided in the
FlatFileSchemasExample project. To view and open the FlatFileSchemasExample project, follow steps 1
and 2 in the Group Example and double-click the Order Flat File Schema. The nodes of the Order Flat
File Schema are displayed in the Schema Layout tab and the properties of the Order root node show in
the right pane.
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Creating a flat file schema
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About this task

To create a Flat File Schema:

Procedure

1. Select the Project tab from the Toolbox located on the right side of the main Studio pane.
2. To create a new Flat File Schema, choose from one of the following options:

In the Project tab, right-click the Flat File Schemas folder and from the list select New Flat File
Schema.
In the Project tab, click New Flat File Schema (  ).

The Basic Wizard dialog box is displayed.
3. Enter a valid node name for the Flat File Schema in the Name field.
4. Optional: If you want to use an existing Flat File Schema as a starting point, select the Inherit from an

existing Flat File Schema check box. Click [...] to browse for the existing Flat File Schema from the
Project Explorer dialog box, and click OK.

5. Click OK and press Enter. The Flat File Schema Editor opens and the Flat File Schema is displayed
beneath the Flat File Schemas folder in the Project tab.  In addition, a root node of the same name as the
one shown in the Schema Layout tab.

6. Configure the root node:
a. Click the root node in the Schema Layout tab. The properties for the root node are displayed.
b. Configure the root node properties.

7. Define the records, fields, and groups of the Flat File Schema for your Flat File data. Start from the
outermost structure of data and work inwards. For an example on how to build a Flat File Schema from
data see Mixed positional and delimited example or the "Developing the BookOrder Project" section of
the Getting Started Guide.

8. Optional: You can select the Type Library tab and define the shared record types, group types, and field
types for the data:

Add a Record Type to define common record properties or content.
Add a Group Type to define common group properties or content.
Add a Field Type to define common field properties.

9. Select the Schema Layout tab, and add records, groups, and fields to the root node:
Add a Record to define the major components of the message or for fields with complex structure.
Add a Group to define a set of records or groups that repeat as a set.
Add a Field to define the data within each record.
Add Several Children, of any type, to quickly build the content of records or groups.

10. Test the Flat File Schema.

The icons representing fields, field types, records, record types, groups, and group types are displayed in
the Schema Layout and Type Library tabs as shown in the following table:

Node Type Icon Displayed in Tabs

Field or field type that is not based on a field type

Field or field type that is based on a field type

Record or record type that is not based on a record type

Record or record type that is based on a record type

Group or group type that is not based on a group type

Group or group type that is based on a group type

Parent topic: Flat File Schemas
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Testing flat file schemas

About this task

Test a flat file schema by completing the following steps:

Procedure

1. Create a flat file schema or open an existing Flat File Schema by selecting it in the Project tab.
2. Load input test data
3. Test a Flat File Schema using the test data.
4. Optional: Save test output data to a file.

Load input test data
Test a Flat File Schema
Save test output data to a file
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Load input test data

About this task

The format of the test data depends on how the Flat File Schema is used in your orchestration as described in
the following examples:

If your orchestration contains a Read Flat File activity that reads in Flat File data, test the Flat File
Schema using the incoming Flat File Data. The resulting data from the test is XML data.
If your orchestration contains a Write Flat File activity that writes in a Flat File data file, test the Flat File
Schema using the incoming XML data. The resulting data from the test is Flat File data.
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In the left input sub-pane of the test pane, you can enter the test data directly or load a test data from a file on
the file system:

Procedure

1. In the test pane, specify the path and the filename for the data file using one of the following options:
Enter the path and file name for the input data file into the Test File field.
Click Browse to navigate to the file:

a. In the Open Sample Data File dialog box, select the input data file.
b. Optional: Select an encoding for the input data, using one of the following options:

From the encoding list located in the upper left side of the dialog box, select one of
the default encoding types.
Enter your encoding type directly by clicking in the encoding field and typing in your
encoding type

c. Click Open.
Note: The size of the data displayed and transformed is determined by the settings of the Flat File
preferences. These settings are important when loading very large data files.  For more
information, see the Flat File section of the table in Setting Preferences.

2. Optional: You can change the how the input data is displayed by clicking the Display in Hexadecimal (

 ) icon to toggle between displaying the text in the following two ways:
Display just the text.
Display the hexadecimal representation next to the text.

Note: If the input data is displayed in hexadecimal form, you cannot test or edit the data.
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Test a Flat File Schema

About this task

To test a Flat File Schema:

Procedure

1. Click the Test (  ) icon. The results pane is located on the right side of the test pane and shows the
results of converting the sample data:

If the incoming data is Flat File data, the resulting data is an XML data.
If the incoming data is XML, the resulting data is Flat File data.

2. Optional: Change the font used to display the input and output data is displayed by clicking the following
icons:
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Click the Monospace font ( ) button to display data using a font that displays each character
with the same width. This option is useful for viewing positional text.

Click the Unicode font ( ) button to display the input data using a font that supports double-
byte characters.

3. Optional: Change the formatting used to display output data by clicking the following icons:

Click the Formatted (  ) button to display XML output data formatted with carriage returns with
indentation spacing of the XML elements.

Click the Unformatted (  ) button to display the XML output data unformatted. During run time,
the Integration Appliance produces the output XML data unformatted as shown when the
Unformat button is selected.
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Save test output data to a file

About this task

To save the test output data to a file:

Procedure

1. Test sample data as described in Test a Flat File Schema.
2. To save the test result data unformatted without carriage returns and indention spacing of the XML

elements, click the Unformat (  ) button. During run time, the Integration Appliance produces the

output XML data unformatted. If the Format (  ) button is select before saving the file, the carriage
returns and spaces using to indent the XML elements are saved to the file.

3. When the resulting data displays in the results pane, click the Save (  ) icon. The Save Test Result
dialog box opens.

4. Browse for a directory on your computer where you want to save the result data file.  
5. Enter the name and file extension for the result data file.
6. Click Save.
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Root node properties
When a root node is selected in the Schema Layout tab, the following two sections of properties are available in
the pane: Basic Properties and Delimiters.

Basic Properties

The Basic Properties of the root node are defined in the following table:

Property Definition

Name Specifies the name assigned to this Flat File Schema.
When you create a Flat File Schema in the Project tab
the name entered for the Flat File Schema is the
default name of the root node.
Attention: The root node name for a Flat File Schema
must be a valid node name.

Type Optional: Specifies to record type used as a basis for
the root node.
Attention: Selecting a new type might reset some of
the existing properties of the record with the new
settings.

Reset Resets properties that were set locally for this record
to the values for the selected type.  Reset is only
active if a record type has been selected from the
Type list.

Structure Select Delimited from the list if the outermost
level of structure in the data is determined by
delimiters.
Select Positional from the list if the outermost
level of the structure in the data is determined
by their position.

Write Line Ends as CRLF Specifies how the Integration Appliance should write
end of line characters when a Write Flat File activity
creates outgoing data.  If the receiving system for this
data is a Windows platform, the Integration Appliance
must write Line End characters as carriage return, line
feed (CRLF). The default is to write Line End
characters as a line feed (LF), the default for UNIX.
 The Integration Appliance accepts both line end
characters (LF and CRLF) when parsing data.
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Property Definition

Document Ends with EOS (end of stream) Specifies that the end of the data is delimited with an
end-of-stream (EOS) character for parsing incoming
Flat File data in the Read Flat File activity or when
producing Flat File data in the Write Flat File activity.
 End-of-stream might need to be specified for data
where the transport mechanism treats the data as a
stream rather than a file.

Delimiters

If the Delimited option is selected for the Structure property for the root node, the following root node delimiter
properties are active:

Child Delimiter
Include Trailing Delimiters for Empty Data
Child Delimiter Position
Repeat Delimiter

Child Delimiters

The Child property defines the character that delimits children of the root node. This character is commonly
called the record delimiter, segment delimiter, or line delimiter.

Specify the type of child delimiter by selecting one type from the three options listed in the following table:

Option Definition
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Option Definition

Character Specifies the character for the child delimiter. If the
Character option is selected for the Child Delimiter,
you must enter a single character using one of the
following actions:

Type in the character.
Type in the Unicode value of the character. For
example, enter /u0020 for the space
character.
Click [...] to browse for a character. The
Character Selection dialog box opens listing
the valid character choices for delimiters. In
the Display column, the character or a
mnemonic representing the character is
displayed. In addition, the corresponding
hexadecimal value and Unicode code point for
the character is displayed.

Select a character and click OK.  If the selected
character does not have a visual symbol, a
mnemonic or the Unicode value might show for
this character.

For more information about any of these
characters, see the Basic Latin and Latin-1
Supplement character sets at:
 http://www.unicode.org/charts/.

Line End Specifies that the child delimiter is the end of the line,
either a LF (line feed) or CRLF (carriage return, line
feed). If the children are delimited with just a CR
(carriage return), select the Character option and
specify a CR (carriage return) character as the
delimiter. The Integration Appliance accepts both line
end characters (LF and CRLF) when parsing data.
When writing data, the character used for line ends is
determined by the Write Line Ends As CRLF property.
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Option Definition

Dynamic Position Specifies that the character used as the child
delimiter is defined dynamically within the data.
Dynamic delimiters must show at a specific position
within the first record of the data, such as in EDI or
HL7 data. How the character is used by the
Integration Appliance depends if the Flat File data is
incoming or outgoing:

While parsing incoming Flat File data in the
Read Flat File activity, the Integration
Appliance reads the character is the specified
position of the first record and uses it as a child
delimiter to parse the rest of the data. The
Write Default text field is not used when
incoming Flat File data is read.
While writing outgoing Flat File data in the
Write Flat File activity, the Integration
Appliance uses the character specified in the
Write Default text field to delimit the children
of the root node. In addition, the specified
character is written at the specified position of
the first record in the outgoing data.
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Option Definition

Write Default Specifies the character that should be used as the
child delimiter when the Integration Appliance writes
outgoing data in the Write Flat File activity of the root
node. In addition, the specified character is written at
the specified position of the first record in the
outgoing data. The character specified in this field is
not used when incoming Flat File data is read in the
Read Flat File activity.
In the Write Default text field of the pane, enter a
single character using one of the following actions:

Type in the character.
Type if the Unicode value of the character. For
example, enter /u0020 for the space
character.
Click [...] to browse for a character. The
Character Selection dialog box opens listing
the valid character choices for delimiters. In
the Display column, the character or a
mnemonic representing the character is
displayed. In addition, the corresponding
hexadecimal value and Unicode code point for
the character is displayed. Select a character
and click OK.  If the selected character does
not have a visual symbol, a mnemonic or the
Unicode value might display for this character.
For more information about any of these
characters, see the Basic Latin and Latin-1
Supplement character sets at:
 http://www.unicode.org/charts/

Include Trailing Delimiters for Empty Data

Select the Include Trailing Delimiters for Empty Data check box to specify that delimiters for empty optional
children must be present at the end of the record or field when the Integration Appliance writes outgoing Flat
File data in the Write Flat File activity.

Clear this check box, if delimiters for empty optional children may be omitted.

This check box does not affect how the Integration Appliance reads incoming data because when reading data
the Integration Appliance accepts either the absence or presence of delimiters with empty data.

Child Delimiter Position
This property defines the position of record delimiters for data. Select one option from the following table:

Position Definition

 777

http://www.unicode.org/charts/


Position Definition

After Specifies that the child delimiter marks the end of a
child, including the last child in the data, as shown in
the following example where the comma delimiter is
shown after the fields: field1,field2,field3,

After is the most common position for record
delimiters.

Before Specifies that the child delimiter indicates the
beginning of a child. The end of the last child is
marked by the parent's delimiter as shown in the
following example where the exclamation point
delimiter is shown in Figure 1.

In between Specifies that delimiters are placed between children
but do not show at either the beginning of the first
child nor the end of the last child as shown in the
following example, where the comma delimiter show
in between the fields:

field1,field2,field3

Figure 1. Exclamation point delimiter in the Before position

!field1of1stRecord!field2of1stRecord!field3of1stRecord  
!field1of2ndRecord!field1of2ndRecord!field1of2ndRecord

For an example with all three types of child delimiter positions, see Mixed positional and delimited example.
Repeat Delimiter
This property determines the delimiter used between repeated occurrences of one record in the Flat File data.
Select one option from the following table:

Header Header
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Header Header

Character Specifies the character for the repeat delimiter. If the
Character option is selected for the Repeat Delimiter,
you must enter a single character using one of the
following actions:

Type in the character.
Type in the Unicode value of the character. For
example, enter /u0020 for the space
character.
Click [...] to browse for a character. The
Character Selection dialog box opens listing
the valid character choices for delimiters. In
the Display column, the character or a
mnemonic representing the character is
displayed. In addition, the corresponding
hexadecimal value and Unicode code point for
the character is displayed.

Select a character and click OK.  If the selected
character does not have a visual symbol, a
mnemonic or the Unicode value might show for
this character.

For more information about any of these
characters, see the Basic Latin and Latin-1
Supplement character sets at:
 http://www.unicode.org/charts/.

Line End Specifies that the repeat delimiter is the end of the
line, either a LF (line feed) or CRLF (carriage return,
line feed).  If the children are delimited with just a CR
(carriage return), select the Character option and
specify a CR (carriage return) character as the
delimiter. The Integration Appliance accepts both line
end characters (LF and CRLF) when parsing data.
When writing data, the character used for line ends is
determined by the Write Line Ends As CRLF property.

 779

http://www.unicode.org/charts/


Header Header

Dynamic Position Specifies that the character used as the repeat
delimiter is defined dynamically within the data.
Dynamic delimiters must show at a specific position
within the first record of the data, such as in EDI or
HL7 data. How the character is used by the
Integration Appliance depends if the Flat File data is
incoming or outgoing:

While parsing incoming Flat File data in the
Read Flat File activity, the Integration
Appliance reads the character is the specified
position of the first record and uses it as a
repeat delimiter to parse the rest of the data.
The Write Default text field is not used when
incoming Flat File data is read.
While writing outgoing Flat File data in the
Write Flat File activity, the Integration
Appliance uses the character specified in the
Write Default text field to delimit the repeating
children of the root node. In addition, the
specified character is written at the specified
position of the first record in the outgoing data.
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Header Header

Write Default Specifies the character that should be used as the
child delimiter when the Integration Appliance writes
outgoing data in the Write Flat File activity of the root
node. In addition, the specified character is written at
the specified position of the first record in the
outgoing data. The character specified in this field is
not used when incoming Flat File data is read in the
Read Flat File activity.
In the Write Default text field of the pane, enter a
single character using one of the following actions:

Type in the character.
Type if the Unicode value of the character. For
example, enter /u0020 for the space
character.
Click [...] to browse for a character. The
Character Selection dialog box opens listing
the valid character choices for delimiters. In
the Display column, the character or a
mnemonic representing the character is
displayed. In addition, the corresponding
hexadecimal value and Unicode code point for
the character is displayed. Select a character
and click OK.  If the selected character does
not have a visual symbol, a mnemonic or the
Unicode value might display for this character.
For more information on any of these
characters, see the Basic Latin and Latin-1
Supplement character sets at:
 http://www.unicode.org/charts/
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Adding Fields or Field Types

About this task

Why add fields?

You can define a field based on one of the following simple data types:

 781

http://www.unicode.org/charts/


boolean - true or false
string - text in the specified encoding
integer - whole numbers
numeric - decimal numbers

You create fields in the Schema Layout tab. Fields are displayed in the Schema Layout tab using the following
icon:

Fields that are based on a field type are displayed in the Schema Layout tab using the following icon:

Use records to model flat File data fields that have complex structures, such as components or
subcomponents.

Why add Field Types?

You can define a field type with particular properties to be reused later. For example, if you wanted to create
many fields that all use a double quotation mark as an encapsulation character, you could define a field type
with the encapsulation character set to the double-quotes character and then create multiple fields based on
this field type.

You create field types in the Type Library tab. Field types are displayed in the Type Library tab using the
following icon:

Field types that are based on a field type are displayed in the Type Library tab using the following icon:

Adding Fields or Field Types

The procedure for adding fields and field types is identical except for the tab you initially select as described in
the following procedure.

Procedure

1. Open a Flat File Schema from the Project tab.
2. Select the appropriate tab:

To add a field, select the Schema Layout tab.
To add a field type, select the Type Library tab.

3. Select one of the following options from the list:
New Child > Field: To add a field as a child of the current node.
New Sibling > Field: To add a field as a sibling of the current node.
New Children: to add child fields and records in bulk.

4. In the New Field dialog box, enter a valid node name in the Field Name field.
5. If this field should be based on a field type, select the field type from the Based on Field list.
6. Click OK. The field node ( ) shows in the appropriate tree (Schema Layout or Type Library) and the field

properties show in the properties pane to the right of the tree.
7. Specify the properties for the field or field type.

Parent topic: Flat File Schemas
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Field properties
When a field is selected in the Schema Layout tab or a field type is selected in the Type Library tab, the
following properties sections display in the pane:

Basic Properties
Padding and Trimming
Delimiters
Positional Properties

Basic Properties

The Basic Properties of a field are defined in the following table:

Prop
erty Description

Nam
e

Specifies the name of this field.
Attention: The field name must be a valid node name.

Type Optional: Specifies the field type used as a basis for the field. The Type list is only active if a field type
has been created.
Attention: Selecting a new type might reset some of the existing properties of the field with the new
settings.

Reset Resets properties that have been set locally for this field to the values for the selected type.

Type Specifies one of the following data types for the field:

string -  text in the specified encoding
boolean - true or false
integer - any whole number
numeric- any decimal number

Occu
rrenc
es
Optio
nal

For delimited data, this check box specifies that both the field and its delimiter can be omitted from
the data. For positional data there is no delimiter so just the field is just omitted. If the field can be
empty but the delimiter must be present, then the field is considered required and this check box
should not be selected.
Attention: When specifying the optional property for a field, be careful not to create an ambiguous
grammar for the Flat File Schema.  For more information, see Specifying Optional Fields and Records.

Repe
at
Mini
mum

Specifies the minimum number occurrences of the field.
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Prop
erty Description

Repe
at
Maxi
mum

Controls repetitions of this single field. Select one of the following options:

Unbounded - Specifies this field can repeat any number of times

Range - Specify the maximum number of repetitions for this field. The actual occurrences of the
field can be less than or equal to this number.

Note: Multiple occurrences are only allowed when the parent node has specified a repeat delimiter.

Padding and Trimming

Whether data is trimmed or padded depends on the following conditions:

In the Read Flat File activity, when converting Flat File data to XML data, the characters of the Flat File
field are trimmed before being placed into the corresponding XML field.
In the Write Flat File activity, when converting XML data to Flat File Data, the characters of the XML
element are padded before being placed into the corresponding Flat File field.

The Padding and Trimming properties of a field are defined in the following table:

P
r
o
p
e
rt
y Description

P
a
d
/
Tr
i
m
C
h
ar
a
ct
e
r

Specifies the single character used to pad the length of, or to trim from a field.
In the Character text field of the pane, enter a single character using one of the following actions:

Type in the character.
Type if the Unicode value. For example, enter /u0020 for the space character.
Click [...] to browse for a character. The Character Selection dialog box opens listing the valid
character choices for delimiters. In the Display column, the character or a mnemonic representing
the character is displayed. In addition, the corresponding hexadecimal value and Unicode code
point for the character is displayed. Select a character and click OK.  If the selected character does
not have a visual symbol, a mnemonic or the Unicode value might show for this character. For more
information about any of these characters, see the Basic Latin and Latin-1 Supplement character
sets at: http://www.unicode.org/charts/
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P
r
o
p
e
rt
y Description

P
a
d
t
o
L
e
n
gt
h

Specifies the final length of data for the field when converting XML data to Flat File Data in the Write Flat
File activity. The specified padding characters are added to the data for the field up to this length.
Typically the size of the padding is the same as the field.
Note: This value specified in this field is not used while trimming Flat File data to XML data in the Read
Flat File activity.

J
u
st
ifi
c
at
io
n

Specifies how what side of the field is padded or trimmed:

Left - When the Left option is specified, the action that occurs depends on if the field is read or
written:

Read Flat File activity - When the field is read, the specified trim characters are trimmed
from the end of the field. For example, if the trim character is equal to a hyphen character,
the Field Length is equal to 10,  and the Flat File input field is equal to ---1234---. The
result is the following XML element: <element>---1234</element>.
Write Flat File activity - When the field is written, the padding is added after the field
data. For example, if the pad character is equal to a hyphen character, the Pad to Length is
equal to 10,  and the input XML element is equal to <element>1234</element>,, the
result is the following Flat File field: 1234------.

  Right - When the Right option is specified, the action that occurs depends on if the field is being
read or written:

Read Flat File activity - When the field is read, padding characters are trimmed from the
beginning of the field. For example, if the trim character is equal to a hyphen character, the
Field Length is equal to 10,  and the Flat File input field is equal to ---1234---. The result
is the following XML element: <element>1234---</element>.
Write Flat File activity - When the field is written, padding is added before the field data. For
example, if the pad character is equal to a hyphen character, the Pad to Length is equal to
10,  and the input XML element is equal to <element>1234</element>, the result is the
following Flat File field: ------1234.  

Delimiters

The Escape and Encapsulation Delimiters of a field are defined in the following table. These properties are only
used if the parent record has the Delimited option selected for Structure property.

Pr
op
er
ty Description
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Pr
op
er
ty Description

Es
ca
pe
Ch
ar
ac
ter

Specifies the single character used to escape delimiters within the data of the field. During run time, the
Integration Appliance parses the character directly after this delimiter as a character, not as a delimiter.
In the Character text field of the pane, enter a single character using one of the following actions:

Type in the character.
Type in the Unicode value of the character. For example, enter /u0020 for the space character.
Click [...] to browse for a character. The Character Selection dialog box opens listing the valid
character choices for delimiters. In the Display column, the character or a mnemonic representing
the character is displayed. In addition, the corresponding hexadecimal value and Unicode code
point for the character is displayed. Select a character and click OK.  If the selected character
does not have a visual symbol, a mnemonic or the Unicode value might show for this character. For
more information about any of these characters, see the Basic Latin and Latin-1 Supplement
character sets at:  http://www.unicode.org/charts/

  For example, how is the following record parsed when no escape character is defined and the delimiter of
the record is a colon?

135:Caving: What You Really Need to Know:10

The preceding  record would be parsed into the following 4 fields:

135
Caving
What You Really Need to Know
10

If you do not want the Caving What You Really Need to Know title broken up into two fields, you can
specify an escape character of backslash and preface the colon with a backslash character as shown in
the following record:

135:Caving/: What You Really Need to Know:10

When this Flat File record is parsed with the escape character before the colon, the title is not broken up
into two sections even though the record uses the colon as a delimiter.
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Pr
op
er
ty Description

Dy
na
mi
c
Po
sit
io
n

Specifies the character position, starting from 1, where the escape character is defined in the first record.
 The escape character is determined at run time using the character found at the specified character
position. For example, how is the following record parsed when no encapsulation character is defined
and the delimiter of the record is a colon?

135:Caving: What You Really Need to Know:10

The preceding  record would be parsed into the following 4 fields:

135
Caving
What You Really Need to Know
10

If you do not want the Caving What You Really Need to Know title broken up into two fields, you can
specify a Dynamic Position of 11 and add a backslash character before the colon as shown in the
following record:

135:Caving/: What You Really Need to Know:10

The escape character is now equal to the 11th character in the record: the backslash character. When
this Flat File record is now parsed with the escape character is equal to the backslash character, the
colon after Caving does not break this field into two sections even though the record uses the colon as a
delimiter.
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Pr
op
er
ty Description

Wr
ite
De
fa
ult

Specifies the escape character to use when writing this field as Flat File data. Write Default is only used
in the Write Flat File activity when converting XML data to Flat File data. Write Default is not used when
converting Flat File data to XML data in the Read Flat File activity.  
In the Write Default text field of the pane, enter a single character using one of the following actions:

Type in the character.
Type in the Unicode value of the character. For example, enter /u0020 for the space character.
Click [...] to browse for a character. The Character Selection dialog box opens listing the valid
character choices for delimiters. In the Display column, the character or a mnemonic representing
the character is displayed. In addition, the corresponding hexadecimal value and Unicode code
point for the character is displayed. Select a character and click OK.  If the selected character
does not have a visual symbol, a mnemonic or the Unicode value might show for this character. For
more information about any of these characters, see the Basic Latin and Latin-1 Supplement
character sets at:  http://www.unicode.org/charts/

For example, you wanted to escape the colon with a backslash in the <title>Caving: What You
Really Need to Know</title>. XML element, when converting it to Flat File data, specify a
backslash in the Write Default field.  The run-time result for this field is the following string:

Caving\: What You Need to Know

The character position specified in the Dynamic Position field is not used when an XML element is
converted to Flat File data.

En
ca
ps
ul
ati
on
Ch
ar
ac
ter

Specifies a delimiter character to encapsulate data in the field because the field could contain
character(s) that are being used to delimit this field in the parent record.
In the Character text field of the pane, enter a single character using one of the following actions:

Type in the character.
Type in the Unicode value of the character. For example, enter /u0020 for the space character.
Click [...] to browse for a character. The Character Selection dialog box opens listing the valid
character choices for delimiters. In the Display column, the character or a mnemonic representing
the character is displayed. In addition, the corresponding hexadecimal value and Unicode code
point for the character is displayed. Select a character and click OK.  If the selected character
does not have a visual symbol, a mnemonic or the Unicode value might show for this character. For
more information about any of these characters, see the Basic Latin and Latin-1 Supplement
character sets at:  http://www.unicode.org/charts/
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Pr
op
er
ty Description

  For example, how is the following record parsed when no encapsulation character is defined and the
delimiter of the record is a colon?

135:Caving: What You Really Need to Know:10

The preceding  record would be parsed into the following 4 fields

135
Caving
What You Really Need to Know
10

If you do not want the Caving What You Really Need to Know title broken up into two fields, you can
specify the encapsulation character to be a double quotation mark and surround the book title with
double quotation marks as shown in the following record:

135:"Caving: What You Really Need to Know":10

When this Flat File record is now parsed with the encapsulation character set to double quotation marks,
the colon after Caving does not break this field into two sections even though the parent record uses the
colon as a delimiter. The Integration Appliance reads all the characters between two encapsulation
delimiters as characters rather than delimiters.

Dy
na
mi
c
Po
sit
io
n

Specifies the character position, starting from 1, where the delimiter is defined in the first record.  The
encapsulation delimiter is determined at run time using the character found at the specified character
position

For example, how is the following record parsed when no encapsulation character is defined and the
delimiter of the record is a colon?

135:Caving: What You Really Need to Know:10

The preceding  record would be parsed into the following 4 fields:

135
Caving
What You Really Need to Know
10

If you do not want the Caving What You Really Need to Know title broken up into two fields, you
can specify the Dynamic Position of 5 and surround the book title with double quotation marks and as
shown in the following record:

135:"Caving: What You Really Need to Know":10

The encapsulation character is equal to the 5th character in the record: the double quotation mark
character. When this Flat File record is now parsed with the encapsulation character is equal to the
double quotation mark character, the colon after Caving does not break this field into two sections even
though the record uses the colon as a delimiter. The Integration Appliance reads all the characters
between two encapsulation delimiters as characters and not delimiters.
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Pr
op
er
ty Description

Wr
ite
De
fa
ult

Specifies the encapsulation character to use when writing this field as Flat File data. Write Default is only
used in the Write Flat File activity when converting XML data to Flat File data. The Write Default is not
used when converting Flat File data to XML data in the Read Flat File activity.
In the Write Default text field of the pane, enter a single character using one of the following actions:

Type in the character.

Type in the Unicode value of the character. For example, enter /u0020 for the space character.
Click [...] to browse for a character. The Character Selection dialog box opens listing the valid
character choices for delimiters. In the Display column, the character or a mnemonic representing
the character is displayed. In addition, the corresponding hexadecimal value and Unicode code
point for the character is displayed. Select a character and click OK.  If the selected character
does not have a visual symbol, a mnemonic or the Unicode value might show for this character. For
more information about any of these characters, see the Basic Latin and Latin-1 Supplement
character sets at:  http://www.unicode.org/charts/.

  For example, you wanted to encapsulate the data found in the <title>Caving: What You Really
Need to Know</title> XML element with quotation marks when converting it to Flat File data, specify
the double quotation marks in the Write Default field. The runtime result for this field is the following
string:

"Caving: What You Need to Know"

The character position specified in the Dynamic Position field is not used when an XML element is
converted to Flat File data.

Positional Properties

The Positional Properties of a field are defined in the following table. These properties are only active if the
parent record has the Positional option selected for Structure property.

Field Description

Field
Offset

Specifies the number of characters to skip, starting from the end of the previous field, to reach the
beginning of this field.

Field
Length

Specifies the length of the data for this field.
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Adding Records or a Record Type

About this task

Why add records?

You use records to define the structure of your Flat File data. Records can contain fields, groups, or other
records.  Records that are children of another record are used to model fields with a complex structure.
Records can also be used define additional layers of hierarchy of the data.

The fields and subrecords of a record are parsed using one of the following methods:

Delimited: The fields and child records within the record use delimiters to define their beginning and end
points. Some delimited formats use record IDs as identifiers and beginning delimiters. For examples of
defining records that parse delimited data, see the following examples:

Mixed positional and delimited example
"Developing the BookOrder Project" section of the Getting Started Guide

Positional: the fields within the record use no delimiters but are defined instead by their position and
length. Positional fields are also known as fixed-length fields. For an example of defining a record that
parses positional data, see Mixed positional and delimited example.

You create records in the Schema Layout tab. Records that contain child records and fields and are not based
on a record type are displayed in the Schema Layout tab using the following icon:

Records that are based on a record type are displayed in the Schema Layout tab using the following icon:

Why Add Record Types?

Record types define a set of record properties, fields, and child records that can be reused by multiple records.
 For example, you could define an address record type that contains a street field, a city field, a state field, and
a zip code field. You could then use the address record type as the basis of all the addresses in the Flat File
Schema, for example to define the shipping address record and the billing address record.

You create record types in the Type Library tab. Record types that contain child records and fields and are not
based on a record type are displayed in the Type Library tab using the following icon:

Record types that are based on a record type are displayed in the Type Library tab using the following icon:

Note:

Record types are only reusable to the current Flat File Schema and are not global to the project.
Records based on a record type can only inherit child nodes from the record type. Child nodes cannot be
added to a record that is based on a record type.
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The child nodes inherited from the record type are only visible in the Type Library tab and are not visible
in the Schema Layout tab.
Record types can also be based on other record types, inheriting both properties and children from
parent record types.

To add a record or a record type:

Procedure

1. Open a Flat File Schema from the Project tab.
2. Select the appropriate tab:

To add a record, select the Schema Layout tab.
To add a record type, select the Type Library tab.

3. Right-click a node in the tab and select one of the options in the list:
New Child > Record: To add a record as a child of the current node. Records can only be children
of the root node, another record, or a group.
New Sibling > Record: To add a record as a sibling after the current node.
New Children: to add child fields and records in bulk.

4. Enter a valid node name for the new record in the New Record pane.
5. If this record should be based on a record type, select the record type from the Based on Record list.
6. Click OK. The record node is shown in the appropriate tab (Schema Layout or Type Library) and record

properties display in the Properties pane.
7. Specify the properties for the record or record type.
8. If you are creating a new record not based on a record type, add fields, groups, or records to define the

content of the record. If you based the record on a record type, the record is complete and because the
content of the record is defined by the record type.
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Record properties
When a record is selected in the Schema Layout tab or a record type is selected in the Type Library tab, the
following sections of properties are available in the pane:

Basic Properties
Delimiters

Basic Properties

The Basic Properties of a record are defined in the following table:
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Prop
erty Description
Prop
erty Description

Name Specifies the name of this record.
Attention: The field name must be a valid node name.

Type Optional: Specifies the record type used as a basis for the record. The Type list is only active if the
selected record node does not contain any children and a record type has been created. A record
cannot inherit fields or subrecords from a record type if the record contains children.
Attention: Selecting a new type might reset some of the existing properties of the record with the new
settings.

Reset Resets properties that have been set locally for this record to the values for the selected type. Reset
is only active if a record type has been selected from the Type list.

Struct
ure

Specify Delimited if the structure of the record is determined by delimiters.
Specify Positional if the structure of the record is determined positions in the record.

Recor
d
Identi
fier

Specifies the unique string that identifies this record. Record identifiers are called segment IDs in
X.12 message standards such as EDI or HL7, and typically begin each record.

Recor
d ID
Starti
ng
Positi
on

Specifies the character position where the record ID begins after the end of the previous record. The
default is 0, which places the record ID at the beginning of the record.

Minim
um
Occur
rence
s

Specifies the minimum number of repetitions for this record. The default is 1, which means the record
is required. Specify 0 if this record is optional. WARNING:  When specifying the optional property for a
record, be careful not to create an ambiguous grammar for the Flat File Schema. For more
information, see Specifying Optional Fields and Records.

Maxi
mum
Occur
rence
s

Controls repetitions of the single record. Select one of the following options: Unbounded -  Specifies
this record can repeat any number of times. Range  - Specify the maximum number of repetitions for
this record. The actual occurrences in a specific message can be less than or equal to this limit. NOTE:
Multiple occurrences are only allowed when the parent node has specified

Delimiters

If the Delimited option is selected for the Structure property for the record, the following record delimiter
properties are active:

Child Delimiter
Include Trailing Delimiters for Empty Data
Child Delimiter Position
Repeat Delimiter

Child delimiters

Child Delimiters
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The Child property defines the character that delimits children of the record. This character is commonly called
the record delimiter, segment delimiter, or line delimiter.

Specify the type of child delimiter by selecting one type from the three options listed in the following table:

O
p
ti
o
n Definition

C
h
a
r
a
c
t
e
r

Specifies the character for the child delimiter. If the Character option is selected for the Child Delimiter,
you must enter a single character using one of the following actions:

Type in the character.
Type in the Unicode value of the character. For example, enter /u0020 for the space character.
Click [...] to browse for a character. The Character Selection dialog box opens listing the valid
character choices for delimiters. In the Display column, the character or a mnemonic representing
the character is displayed. In addition, the corresponding hexadecimal value and Unicode code
point for the character is displayed.

Select a character and click OK.  If the selected character does not have a visual symbol, a
mnemonic or the Unicode value might show for this character.

For more information about any of these characters, see the Basic Latin and Latin-1 Supplement
character sets at: http://www.unicode.org/charts/.

Li
n
e
E
n
d

Specifies that the child delimiter is the end of the line, either a LF (line feed) or CRLF (carriage return, line
feed). If the children are delimited with just a CR (carriage return), select the Character option and specify
a CR (carriage return) character as the delimiter. The Integration Appliance accepts both line end
characters (LF and CRLF) when parsing data. When writing data, the character used for line ends is
determined by the Write Line Ends As CRLF property.

D
y
n
a
m
i
c
P
o
si
ti
o
n

Specifies that the character used as the child delimiter is defined dynamically within the data. Dynamic
delimiters must show at a specific position within the first record of the data, such as in EDI or HL7 data.
How the character is used by the Integration Appliance depends if the Flat File data is incoming or
outgoing:

While parsing incoming Flat File data in the Read Flat File activity, the Integration Appliance reads
the character is the specified position and uses it as a child delimiter to parse the rest of the data.
The Write Default text field is not used when incoming Flat File data is read.
While writing outgoing Flat File data in the Write Flat File activity, the Integration Appliance uses
the character specified in the Write Default text field to delimit the children of the record. In
addition, the specified character is written at the specified position of the first record in the
outgoing data.
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O
p
ti
o
n Definition

W
ri
t
e
D
e
f
a
u
lt

Specifies the character that should be used as the child delimiter when the Integration Appliance writes
outgoing data in the Write Flat File activity. In addition, the specified character is written at the specified
position of the first record in the outgoing data. The character specified in this field is not used when
incoming Flat File data is read in the Read Flat File activity.
In the Write Default text field of the pane, enter a single character using one of the following actions:

Type in the character.
Type if the Unicode value of the character. For example, enter /u0020 for the space character.
Click [...] to browse for a character. The Character Selection dialog box opens listing the valid
character choices for delimiters. In the Display column, the character or a mnemonic representing
the character is displayed. In addition, the corresponding hexadecimal value and Unicode code
point for the character is displayed. Select a character and click OK.  If the selected character does
not have a visual symbol, a mnemonic or the Unicode value might display for this character. For
more information about any of these characters, see the Basic Latin and Latin-1 Supplement
character sets at: http://www.unicode.org/charts/

Include Trailing Delimiters for Empty Data

Select the Include Trailing Delimiters for Empty Data check box to specify that delimiters for empty optional
children must be present at the end of the record or field when the Integration Appliance writes outgoing Flat
File data in the Write Flat File activity.

Clear this checkbox, if delimiters for empty optional children might be omitted.

This check box does not affect how the Integration Appliance reads incoming data because when reading data
the Integration Appliance accepts either the absence or presence of delimiters with empty data.

Child Delimiter Position
This property defines the position of record delimiters for data. Select one option from the following table:

Positio
n Definition

After Specifies that the child delimiter marks the end of a child, including the last child in the data.

After is the most common position for record delimiters.

Before Specifies that the child delimiter indicates the beginning of a child. The end of the last child is
marked by the delimiter of the parent.

In
betwee
n

Specifies that delimiters are placed between children but do not show at either the beginning of the
first child nor the end of the last child.

For an example with all three types of child delimiter positions, see Mixed positional and delimited example.
Repeat Delimiter
This property determines the delimiter used between repeated occurrences of one record in the Flat File data.
Select one option from the following table:
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P
o
s
it
i
o
n Definition

P
o
s
it
i
o
n Definition

C
h
a
r
a
c
t
e
r

Specifies the character for the repeat delimiter. If the Character option is selected for the Repeat
Delimiter, you must enter a single character using one of the following actions:

Type in the character.
Type in the Unicode value of the character. For example, enter /u0020 for the space character.
Click [...] to browse for a character. The Character Selection dialog box opens listing the valid
character choices for delimiters. In the Display column, the character or a mnemonic representing
the character is displayed. In addition, the corresponding hexadecimal value and Unicode code
point for the character is displayed.

Select a character and click OK.  If the selected character does not have a visual symbol, a
mnemonic or the Unicode value might show for this character.

For more information about any of these characters, see the Basic Latin and Latin-1 Supplement
character sets at: http://www.unicode.org/charts/.

Li
n
e
E
n
d

Specifies that the repeat delimiter is the end of the line, either a LF (line feed) or CRLF (carriage return,
line feed).  If the children are delimited with just a CR (carriage return), select the Character option and
specify a CR (carriage return) character as the delimiter. The Integration Appliance accepts both line end
characters (LF and CRLF) when parsing data. When writing data, the character used for line ends is
determined by the Write Line Ends As CRLFproperty.

D
y
n
a
m
i
c
P
o
si
ti
o
n

Specifies that the character used as the repeat delimiter is defined dynamically within the data. Dynamic
delimiters must show at a specific position within the first record of the data, such as in EDI or HL7 data.
How the character is used by the Integration Appliance depends if the Flat File data is incoming or
outgoing:

While parsing incoming Flat File data in the Read Flat File activity, the Integration Appliance reads
the character is the specified position and uses it as a repeat delimiter to parse the rest of the data.
The Write Default text field is not used when incoming Flat File data is read.
While writing outgoing Flat File data in the Write Flat File activity, the Integration Appliance uses
the character specified in the Write Default text field to delimit the repeating children of the root
node. In addition, the specified character is written at the specified position of the first record in the
outgoing data.
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P
o
s
it
i
o
n Definition

W
ri
t
e
D
e
f
a
u
lt

Specifies the character that should be used as the repeat delimiter when the Integration Appliance writes
outgoing data in the Write Flat File activity. In addition, the specified character is written at the specified
position of the first record in the outgoing data. The character specified in this field is not used when
incoming Flat File data is read in the Read Flat File activity.
In the Write Default text field of the pane, enter a single character using one of the following actions:

Type in the character.
Type if the Unicode value of the character. For example, enter /u0020 for the space character.
Click [...] to browse for a character. The Character Selection dialog box opens listing the valid
character choices for delimiters. In the Display column, the character or a mnemonic representing
the character is displayed. In addition, the corresponding hexadecimal value and Unicode code
point for the character is displayed. Select a character and click OK.  If the selected character does
not have a visual symbol, a mnemonic or the Unicode value might display for this character. For
more information about any of these characters, see the Basic Latin and Latin-1 Supplement
character sets at: http://www.unicode.org/charts/
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Adding Groups or Group Types

About this task

Why add groups?

Groups allow you to define repeated occurrences of sets of records, for example the groups that are used with
EDI messages to define loops. Groups are only required when the data does not provide any additional
delimiters or structure to clearly mark the beginning and end of repetitions that contain more than one record.
 The following example data shows a repeating set of records that can be defined using groups:
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Groups can contain any number of records or other groups. Groups cannot contain fields. For an example of
using a group to model the preceding input Flat File data, see Group Example.

You create groups in the Schema Layout tab. Groups that are not based on a group type are displayed in the
Schema Layout tab using the following icon:

Groups that are based on a group type are displayed in the Schema Layout tab using the following icon:

Note: Groups are not global to the project and can only be reused in the current Flat File Schema.

Why Add Group Types?

Group types allow you to define a set of repeating records or groups once and then use it many times within a
Flat File Schema. Both the occurrence properties and the content you define in a group type are inherited by
any group based on that type.

Note:

Groups based on a group type cannot contain any other content besides the nodes inherited from the
group type
The content inherited from the group type is not visible in the Schema Layout tab.
Group types can also be based on other group types.
Group types are not global to the project and can only be reused in the current Flat File Schema.

Create group types in the Type Library tab. Group types that are not based on a group type are displayed in the
Type Library tab using the following icon:

Group types that are based on a group type are displayed in the Type Library tab using the following icon:
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Adding Groups or Group Types

The procedure for adding groups and group types is identical except for the tab you initially select as described
in the following procedure. To add a group or group type:

Procedure

1. Open a Flat File Schema from the Project tab.
2. Select the appropriate tab:

To add a group, select the Schema Layout tab.
To add a group type, select the Type Library tab.

3. Select the appropriate tab:
To add a group, select the Schema Layout tab.
To add a group type, select the Type Library tab.

4. Select one of the following options from the list:
New Child > Group: To add a group as a child of the current node.
New Sibling > Group: To add a group as a sibling of the current node.
New Children: to bulk add groups as a child of the current group or record.

5. In the New Group dialog box, enter a valid node name in the Group Name field.
6. If this group should be based on a group type, select the group type from the Based on Group list.
7. Click OK. The group node is shown in the appropriate tab (Schema Layout or Type Library) and group

properties display in the Basic Properties pane.
8. Specify the properties for the group.

If this group is based on a group type that defines the content for the group, the group is complete. If
not, define the content of the group.
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Group Properties
When a group is selected in the Schema Layout tab, the Basic Properties of a group are displayed. When a
group type is selected in the Type Library tab, the Basic Properties of the group type are displayed. The Basic
Properties of a group or group type are listed in the following table:

Field Description

Name Specifies the name of this field.
Attention: The field name must be a valid node name.
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Field Description

Type Optional: Specifies the group type used as a basis for the group. The Type list is only active if the
selected group node does not contain any children and a group type has been created. A group
cannot inherit groups or records from a group type if the group contains children.
Attention: Selecting a new type may reset some of the existing properties of the field with the new
settings.

Reset Resets properties that were set locally for this group to the values for the selected type. Reset is
only active if a group type has been selected from the Type list.

Minimu
m
Occurr
ences

Specifies the minimum occurrences for the group. Defaults to 1, making the group required.  Select
0 if this group is optional.

Maxim
um
Occurr
ences

Specifies the maximum occurrences for the group:

Unbounded - Specifies this group can repeat any number of times. Unbounded, optional
groups must contain at least one required record.
Range - Specifies the maximum number of repetitions for this group. The actual occurrences
of the group can be less than or equal to this number.
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Group Example

About this task

This example shows a Flat File Schema that parses a repeating set of records using groups. Each set of the
repeating record contains records of different types as shown in the following example input Flat File data:
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Figure 1. An example input Flat File

In this example data, the first, second, and third records of the repeating set are each a different type of record.
In addition, this example shows how types stored in the Type Library tab are used in a Flat Files Schema. In
this example, you view and test an existing Flat File Schema rather than creating the Flat File Schema from
scratch.

To open, view, and test the Flat File Schema used to parse the input data displayed in Figure 1:

Procedure

1. In this example, the Flat File Schema is already built in the FlatFileSchemasExample project. To view the
Flat File Schema, you must first extract the FlatFileSchemasExample project:

a. Find the Default Create Path defined in Studio - the directory that new projects are created in. To
view the current Default Create Path, select File > Preferences... from the Studio toolbar menu.
The Preferences dialog opens. The current Default Create Path shows at the end of the pane. By
default, the Default Create Path is located in the following directory:

C:\Documents and Settings\myLogin\My Documents

Where myLogin represents your Windows login name.

b. Find the FlatFileSchemasExample.zip file that contains the files that make up the
FlatFileSchemasExample project. If you accepted the defaults during the installation of Studio,
this file is located in the following directory:

C:\Program Files\IBM\WebSphere Cast Iron Studio 3.X\Samples\FlatFileSchema

c. Copy the FlatFileSchemasExample.zip file from the FlatFileSchema directory to the Default
Create Path directory.

d. Extract the contents of FlatFileSchemasExample.zip file into the Default Create Path directory.
2. Open the FlatFileSchemasExample project:

a. Select File > Open Project... from the Studio toolbar menu. The Open dialog box shows.
b. Browse for and open the FlatFileSchemasExample directory.
c. Click the FlatFileSchemasExample.sp3 file and click Open. The project is displayed.

3. Open the prebuilt vegPO Flat File Schema. In the Flat File Schemas folder of the Project tab, double-
click the vegPO Flat File Schema. The nodes of the vegPO Flat File Schema are displayed in the Schema
Layout tab and the properties of the vegPO root node show in the right pane.
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4. Test the vegPO Flat File Schema:
a. In the test pane, click Browse. The Open Sample Test Data File dialog box opens.
b. Browse for the vegPO.txt file that contains the input data.  If you accepted the defaults during the

installation of Studio, this file is located in the following directory:

C:\Program Files\IBM\WebSphere Cast Iron Studio 3.X\Samples\FlatFileSchema

c. Click Open. The input data from the vegPO.txt file shows in the left pane of the Test tab.

d. Click the Test (  ) icon. In the results pane, the result of the conversion is displayed as XML
data.

5. In the Schema Layout tab, click the vegPO root node. The vegPO root node is displayed with the
following properties:

a. Structure property is equal to Delimited - The structure of the root node is delimited.
b. Child delimiter is equal to Line End- The child records are delimited by an end-of-line.
c. Child Delimiter Position is equal to After - Expect the delimiters after each record
d. Repeat delimiter is equal to Line End- Repeating records are also delimited by end-of-line.

6. In the Schema Layout tab, click the orderingStore node. The first line of the input data is highlighted
within the test pane as shown in the following figure:
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The first record of the vegPO Flat File Schema is a header record called orderingStore that occurs only
once. In the Schema Layout tab, the fields and record that make up the orderingStore record display as
children. This first line is parsed into the fields and records that make up the orderingStore record.

After the first header record, the sets of repeating elements start. Each set of repeating elements
contains three child records of different types as shown in the following figure:
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A repeating record that contains child records of different types can be modeled in the Flat File Schema
Editor using groups. Groups are only required when the data does not provide any additional delimiters
or structure to clearly mark the beginning and end of repetitions that contain more than one record. The
delimiters for the repetitions are inherited from the parent record or root node. In this example for the
vegPO root node, the repeat delimiter is set to end-of-line. The orders group node uses end-of-line
delimiter to parse its repeating records

7. In the Schema Layout tab, click the orders group node. Note the following graphical changes in the
panes:

In the left subpane of the test pane, all the lines after the header line are highlighted. This
highlighting indicates that after parsing, all the data after the first record are all assigned to the
orders group node.
In the Basic Properties pane, the Occurrences of the orders group is Unbounded. This setting
means that there can be one or more instances of this group.
In the Basic Properties pane, for the orders group the Type is equal to order. This setting means
that the orders group is based on the order group type. The contents and the properties of the
order group type are defined in the Type Library tab.

8. Select the Type Library tab. The record types and group types used in the vegPO Flat File Schema
display. The order group type contains three records as shown in the following figure:

The following icon represents a record that is based on a record type:

The orders group with the order group type define a set of repeating records of different records
because of the following characteristics:

There can be one to many instances of the orders group.
The order group type contains three records of different types.
The orders group is based on or inherits from the order group type.

The repeating relationship between the orders group and the order group type is shown in the following
figure:

9. In the Type Library tab, click the id record node of the order group type. Note the following graphical
changes in the panes:
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In the Basic Properties pane, the Type of the id record is equal to the record type named orderID.
This setting means that the id record is based on the orderID record type.
In the left subpane of the test pane, the first line of each repeating record is highlighted as shown
in the following figure:

This highlighting indicates that the first line of each repeating record is assigned to the id record.
10. In the Type Library tab, click the shipdate record node of the order group type. Note the following

graphical changes in the panes:
In the Basic Properties pane, the Type of the shipdate record is equal to the record type named
shippingDate. This setting means that the shipdate record is based on the shippingDate record
type.
In the Basic Properties pane, the Structure of the shipdate record is Positional. This setting
means that the child fields of the shipDate record are determined by their position and length in
the record and not by delimiters.
In the left subpane of the test pane, the second line of each repeating record is highlighted as
shown in the following figure:

This highlighting indicates that the second line of each repeating record is assigned to the
shipDate record. The shipDate record contains three positional child fields (month, day, and year)
that are inherited from the shippingDate record type.

11. In the Type Library, click the month field node of the shippingDate record type. In the left subpane of the
test pane, the values assigned to the month field are highlighted as shown in the following figure:
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12. In the Type Library, click the contents record node of the order group type. Note the following graphical
changes in the panes:

In the Basic Properties pane, the Type of the contents record is equal to the record type named
orderContent. This setting means that the contents record is based on the orderContent record
type.
In the left subpane of the test pane, the third line of each repeating record is highlighted as shown
in the following figure:

The orderContent record type contains the vegetables record. The vegetables record its contains
a set of repeating vegetable records. The vegetable record contains a name field and a pounds
field.

13. In the Type Library, click the name record node of the orderContent record type. In the left subpane of
the test pane, the values assigned to the name field are highlighted as shown in the following figure:
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Working with Nodes in the Schema Tabs

About this task

In the Schema tab or the Type Library tab, you can do the following actions:

Copy nodes
Delete nodes
Rename nodes
Move nodes

You can also bulk-add many children. For more information, see Adding Several Children.

Copy nodes
Delete nodes
Rename nodes
Move nodes
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Copy nodes

About this task

You can copy nodes in the Schema Layout tab or in the Type Library tab using the following procedures:

Copy and paste a Child node
Copy and paste a Sibling node
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You can also use keyboard shortcuts (CTRL+C, CTRL+V, CTRL+X) or the Edit toolbar menu options (Edit > Cut,
Edit > Copy, Edit > Paste) to copy nodes.

To copy and paste a Child node:

Pasting a node as a child places the node inside the record or group you have selected at the end of any
existing children.

1. Right-click the node you want to copy.
2. Select Copy.
3. Right-click the record or group that should be the parent of the node you are pasting.
4. Select Paste As Child.

If you paste a node within the same record or group that you copied it from, the Flat File Schema Editor
changes the name of the new node to copy_node-name.

To copy and paste a Sibling node:

Pasting a node as a sibling places it directly above the node you have selected. This option is not available for
the root node.

1. Right-click the node you want to copy.
2. Select Copy.
3. Right-click the node that should come directly after the node you are pasting.
4. Select Paste As Sibling.

If you paste a node within the same record or group that you copied it from, the Flat File Schema Editor
changes the name of the new node to copy_node-name.
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Delete nodes

About this task

You can delete nodes in the Schema Layout tab or the Type Library tab, using any of the following procedures:

To delete a tree node by right-clicking the node
To delete a tree node using the Delete key

You can also use keyboard shortcut cut (CTRL+X) or the Edit > Cut toolbar menu option to delete nodes.

To delete a tree node by right-clicking the node:

1. Right-click the node to be deleted.
2. Select Delete from the list.
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To delete a tree node using the Delete key:

1. Click the node to be deleted.
2. Press Delete.

Attention: If you delete a type node in the Type Library tab that is used as the basis for records, groups, or
fields within the Schema Layout tab, the nodes that are based on that type are affected in the following ways:

The Type is changed to None.
Node properties are left unchanged, but inherited content from the type node is removed.
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Rename nodes

About this task

You can rename nodes in the Schema Layout tab or the Type Library tab, using any of the following procedures:

Change a node name from the Basic Properties pane
To change a node name using a shortcut menu
To change a node name using F2

You can also use the Edit > Rename toolbar menu option to rename nodes.

To change a node name from the Basic Properties pane:

1. Double-click the node to open its properties.
2. Enter the new name into Name text field in the Basic Properties pane.

Note: Press Esc to cancel the editing of the name of a node.
To change a node name using a shortcut menu:

1. Right-click the node.
2. Select Rename from the list.
3. Enter a new valid node name.

Note: Press Esc to cancel the editing of the name of a node.
To change a node name using F2:

1. Click the node to be renamed.
2. Press F2.
3. Enter a new valid node name.

Parent topic: Working with Nodes in the Schema Tabs
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Move nodes

About this task

You can move nodes in the Schema Layout tab or the Type Library tab, using any of the following procedures:

To copy and paste a Child node (as described in Copy nodes).
To copy and paste a Sibling node (as described in Copy nodes).
To move nodes using drag and drop

To move nodes using drag and drop:

1. Select the node you want to move in the Schema Layout or Type Library tab.
2. Drag it over another node:

To make it the last child, drop it over the root, record, or group that should be the new parent.

Parent topic: Working with Nodes in the Schema Tabs
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Adding Several Children

About this task

Add several child records and fields to a root node or a record by right-clicking the node and selecting the New
Children option from the list.

To add multiple child nodes to a Flat File Schema:

Procedure

1. Create a new Flat File Schema or open an existing Flat File Schema by selecting it in the Project tab.
2. Select either the Schema Layout or Type Library tab.
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3. Right-click the root node or a record node in the tree and select New Children. The Bulk Add dialog box
opens.

4. Click Add.
5. Click the Name field and enter a valid node name for the field, record, or group to be added.
6. Click the Node Type field and select a node type (Field, Group, or Record) for the child from the list.
7. If this node is based on a record type, group type, or field type, click the Based On Type field and select

an existing type from the list.
8. Repeat steps 4-7 for each node you want to add.
9. To reorganize or delete the nodes in the list:

Click Up to move a child up the list.
Click Down to move a child down the list.
Click Delete to delete a child.

10. When finished, click OK.
11.  In the Schema Layout or Type Library tab, select the node and edit the properties:

Edit the field properties
Edit the record properties
Edit group properties

Parent topic: Flat File Schemas
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Valid Node Names
When a Flat File Schema is created, an internal XML Schema-based representation of the metadata is also
generated, so the node names you specify for the records, fields, and groups must be valid XML names. Follow
the naming restrictions listed in the following tables when creating node nodes in Flat File Schema.

Attention: You might be able to enter invalid characters into the Name field but the generated Flat File Schema
might be incorrect. You cannot create a variable from an invalid schema.

XML naming restrictions are listed in the following tables.

Valid Name Types Description

Starting Name Characters Letters: both uppercase and lower case
Punctuation: underscore (_)

Non-starting Name Characters Letters: both uppercase and lowercase
Punctuation: underscore, period, and hyphen
Numbers: 0-9

Invalid Characters Description

    space
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Invalid Characters Description

: colon

~ tilde

/ forward slash

\ backslash

; semicolon

? question mark

$ dollar sign

& ampersand

% percent sign

@ at sign

^ hat sign

= equals sign

* asterisk

+ plus sign

 ( ) any parentheses

| pipe

' " ` any quotation marks

{   } [ ] > < any brackets

Parent topic: Flat File Schemas
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The Type Library Tab
In the Type Library tab, you can define reusable types for records, groups, and fields. Defining record types,
group types, and field types allows you to define properties that can be reused in different parts of the Flat File
Schema. Record and group types also allow you to define content that is reusable where a record or group can
show in many places within the same set of Flat File Data.
Note: The type you create in the Type Library tab can only be used with the Flat File Schema visible in the
Schema Layout tab. The type cannot be used by other Flat File Schemas in the same project.
Parent topic: Flat File Schemas
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Specifying Optional Fields and Records

About this task

When creating optional fields or records in a Flat File Schema, it is important to understand how the Flat File
data is parsed so you can design your Flat File schema to avoid ambiguity. For example, if you create a Flat File
Schema with a delimited root node and three child string fields where field1 is required, field2 is optional, and
field3 is required, the grammar of the schema is ambiguous, as shown when the following data is parsed during
run time:

A,C

This Flat File data could be parsed in the following two ways:

field1 is equal to A and field2 is equal to B
field1 is equal to A and field3 is equal to C

Specifying a required field after an optional field defines an ambiguous grammar that cannot be correctly
parsed. Specifying a required record after an optional field also defines an ambiguous grammar that cannot be
correctly parsed.

Redefining this Flat File Schema to contain three child string fields where field1 is required, field2 is optional,
and field3 is optional does not fix this problem because when the Flat File data: A,C is parsed, field1 is equal to
A, and field2 is equal to C. Again the grammar of the schema is ambiguous because this is not the wanted
result, the wanted result was for the value: C to be assigned to field3. Specifying a required record followed by
two optional records also defines an ambiguous grammar.

Parent topic: Flat File Schemas
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Generating a flat file schema from an IDOC
At design time, using the Project > Import > SAP IDOC Schema toolbar menu option, you can interrogate an
SAP endpoint for IDOC metadata and from that metadata generate a Flat File Schema.
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WARNING: In order to connect to the SAP System from Studio, you must download and install the SAP Jar file
and DLLs onto your Windows development workstation.

If you receive or send your SAP data as a file through a SAP File Port to the SAP system, you must use the
Project > Import > SAP IDOC Schema toolbar menu option during design time to generate a Flat File Schema
for your IDOC metadata and use the Read Flat File and Write Flat File activities to read and write the SAP data
during run time. For more information, see the following two example orchestrations.

If you receive or send your SAP data directly from the SAP system using an RFC port, you must use the SAP
Receive IDOC and SAP Send IDOC activities.

Using the Generated Flat File Schema during Run Time

During design time, you use the Project > Import > SAP IDOC Schema toolbar menu option, to generate a Flat
File Schema that describes the SAP data you receive or send to the SAP File Port. This section describes how
that Flat File Schema is used by the following two example orchestrations during run time.

Receive SAP Flat File Data from a SAP System Using an SAP File Port.

This first example orchestration receives SAP data from a SAP System during run time, using the following
activities:

1. An SAP data file is placed into a directory that the FTP Poll Directory activity is polling in. This starts the
processing of the orchestration job.

2. The FTP Poll Directory reads the SAP Flat File data and saves the result into a string variable.
3. Using the Flat File Schema generated during design time using the Project > Import > SAP IDOC Schema

toolbar menu option, the Read Flat File activity converts the SAP data stored in the string variable to
XML data and saves the XML data into an XML variable.

4. The Database Insert Rows activity maps the XML data from the XML variable to some database rows and
inserts these rows into a database

Send SAP Flat File Data From a SAP System Using an SAP File Port

This second example orchestration sends SAP data to a SAP System during run time, using the following
activities:

1. Data is inserted into a database, triggering the Database Get Inserted Rows activity to start processing.
2. The Database Get Inserted Rows activity gets the data that was inserted into the database and coverts it

to XML data.
3. The Write Flat File activity converts the contents of the XML variable to the SAP Flat File data valid

against the Flat File Schema generated during design time using the Project > Import > SAP IDOC
Schema toolbar menu option.

4. The FTP Put File activity writes the Flat File data to a file into a directory.
5. The SAP System reads the data from the file.

To generate a Flat File Schema from an IDOC:

1. Select Project > Import > SAP IDOC Schema from the toolbar menu. The SAP IDOC Flat File Schema
Generator Step 1 of 2 dialog box shows.

2. Enter the SAP connection information as described in the following table:

Field Description

Location  
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Field Description

Host
Name

Specifies the IP address or the workstation name that contains the SAP system.

System
Number

Specifies the number that identifies the specific instance of the SAP system that Studio is to
connect to. Your SAP administrator must supply this information.

SAP
Client

Specifies a number that identifies Studio as a client for the SAP system. Your SAP
administrator must supply this information.

Login  

User
Name  

Specifies the user name to use when connecting to the SAP system.

Passwor
d

Specifies the password to the user name when connecting to the SAP system.

3. Click Next. The SAP IDOC Flat File Schema Generator Step 2 of 2 dialog box is displayed.
4. Select an IDOC Type and optionally an IDOC SubType using one of the following options:

Click [...] to browse for the IDOC Type, the IDOC SubType, or both. The IDOC List dialog box opens
with the list of IDOC Types and IDOC SubTypes available on the selected SAP endpoint. Select an
IDOC Type, the IDOC SubType, or both and click OK.
Enter the IDOC Type, and optionally the IDOC SubType directly into the respective fields.

5. Select the Bundled check box if the incoming IDOC contains more than one instance of the IDOC
message of the same IDOC Type and IDOC SubType. If Bundled is checked, the IDOC element in the
generated Flat File Schema is a repeating element.

6. Click Finish.

If the generation of the Flat File Schema was successful, the Flat File Schema is shown in the Flat File Schemas
folder of the Project tab.
Parent topic: Flat File Schemas
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Using the Flat File Wizard
The Flat File Wizard creates a schema that defines the format of a flat file based on sample data that you
provide. The Read Flat File activity uses this schema to convert flat files into an XML document.

For the best results, provide sample data that is like the actual data. For example, if the actual data contains
header and footer rows, provide sample data with a header row for field names and footer rows. If the actual
data contains quoted fields, the appropriate fields in the sample data should be quoted fields as well.

The Flat File Wizard only reads the first 1000 lines of a file. If the sample file contains more than 1000 lines
and contains footer rows, remove lines before the footer rows so that the total line count stays within the 1000
line limit.
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Important: All rows in your sample data must have the same number of fields.
To use the Flat File Wizard:

1. From the Studio menus select Project > Flat File Wizard. The Flat File Wizard opens in a tab in the Studio
workspace.

2. Enter sample data into the Sample Data text box or click Browse... to load a sample file.
3. Click Next >. The File Format page opens.
4. Choose one of the file format options:

Character-delimited format (including Comma Separated Values format) - Choose this option
when each line in the file has a record with fields separated by a single character, such as a
comma or tab.
This file is in another format - Choose this option when your file does not meet the criteria of the
previous file format option. If you select this option, you cannot use the Flat File Wizard to create
a schema for your flat file.

5. Click Next >. The Field Delimiters page opens.
6. Select a field separator from the Fields separated by list. If you select Other:, specify the field separator

in the field that displays to the right.
7. If the field is enclosed by a specific character, select the character that encloses the field from the Fields

enclosed by list. If you select Other:, specify the enclosing character in the field that displays to the
right.

8. Click Next >. The Header & Trailer page opens
9. Specify whether header and trailer rows exist:

a. Select Treat first row as header for field names, if a header row exists.
b. Select Treat last __ row(s) as trailer, if a trailer row exists and specify the row number.

10. Click Next >. The Edit Schema Name page opens.
11. Enter a schema name.

Tip: Choose a schema name that describes the data and file format.
12. Click Finish. In the Project tab of the Studio Toolbox, the flat file schema you just created displays in the

Flat File Schemas directory.

To read the flat file you created and convert it to XML:

1. Add the Read Flat File activity to an orchestration.
2. In the Checklist, select Configure. The Configure pane opens.
3. In the Select a Flat File Schema field, specify the name of the flat file schema you have created.  

 To convert XML data to a flat file:

1. Add the Write Flat File activity to an orchestration.
2. In the Checklist, select Configure. The Configure pane opens.
3. In the Select a Flat File Schema field, specify the name of the flat file schema you have created.

Parent topic: Flat File Schemas
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Mapping
About Maps
Maps define how data is transformed by the Integration Appliance during run time. Maps can reorganize
data, convert data, suppress or add data, and performing calculations or other complex conversions.
Creating a map
Create a map between the variables and the input parameter or between the output parameters and the
variables.
Creating a Standalone Map
A standalone map is visible in the Transformations folder of the Project tab and represents a set of one
or more mappings between source and destination nodes.
Creating a Standalone Map from a Map Variables Activity
Creating a Map Variables Activity from a Standalone Map
Adding Variables to Mapping Panes
You can add existing variables to a map or create new variables and add them to a map using the Select
Inputs.. or Select Outputs... buttons available from the mapping panes of an activity.
Copying Parameters
Replacing a Variable used in a Map
Finding Nodes
Assigning a Default Value for a Destination Node
Mapping Techniques
Automapping Matching Nodes
Bulk Mapping Nodes
Mapping Recurring Nodes
Mapping All Occurrences
Mapping Specific Occurrences
Mapping Destination Nodes
Selecting a substitution type
The XML Schema specification supports the ability to derive complex types by extension.
Mapping Rules That Are Automatically Deleted
Assigning a Count of Occurrences
Removing Mapping Rules
Finding Sample or Result Content
Loading a Sample Message
Testing maps
You can test the transformation defined in a map using one or more sample messages that match the
source schemas for the map.
Saving or Clearing the Transformation Result
The Emit CData Option
The Emit Only If Option
Unsupported XML Schema Features
About Unmapped Destination Nodes
During transformations, the Integration Appliance includes all destination nodes in the result message.
Destination nodes that are not mapped become empty nodes in the resulting message.
Filter Recurring Nodes
By specifying an XPath predicate to filter against during run time, you can limit the recurring nodes
returned by a mapping activity.

Feedback | Notices
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About Maps
Maps define how data is transformed by the Integration Appliance during run time. Maps can reorganize data,
convert data, suppress or add data, and performing calculations or other complex conversions.

Maps can transform data from one or more sources to one or more destinations. For example, during run time a
map can transform XML data valid against one XML Schema to XML data valid against another XML Schema.
The XML Schemas and Flat File Schemas you use to define the source and destination nodes of a map must
exist in the current project before you start creating a map. For more information about uploading an XML
Schema or DTD to a project, see Uploading Files into a Project. For more information about creating a Flat File
Schema, see Creating a flat file schema.

The following types of maps can be created in Studio:

Inline maps - Inline or embedded maps are not visible in the Project tab. These maps are created
automatically inline when you configure activities that contain Map Input and Map Output tasks, or when
you configure a Map Variables activity. The source and destination types of an inline map are determined
from the variables you select by clicking Add in the From Orchestrations and To Orchestrations panes of
the Mapping Editor. Inline maps transform data from one or more source variables to one or more
destination variables. The source and destination variables can be of any data type.
Standalone maps - A standalone map is visible in the Transformations folder of the Project tab and
represents a set of one or more mappings between source and destination nodes. You can create
standalone maps by right-clicking the Transformations folder in the Project tab or from the Project >
New > New Standalone Map toolbar menu option. For more information, see Creating a Standalone Map.
The source and destination types of an inline map are determined from the schema types you select by
clicking Add in the From Orchestrations and To Orchestrations panes of the Mapping Editor.

You can also test a map against sample data, for more information see Testing maps.
Parent topic: Mapping
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Creating a map
Create a map between the variables and the input parameter or between the output parameters and the
variables.

Many Studio activities contain inline or embedded maps that you must configure in the activity Checklist. You
configure the inline maps in an activity in either the Map Inputs or Map Outputs tasks in an activity Checklist.
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In addition, configure an inline map in the Map Variables activity. The Mapping Editor is displayed beneath the
orchestration.

For instructions about creating maps while configuring a Map Variables activity, see Map Activity

In addition to the inline maps that you create in the Map Inputs or Map Outputs tasks or when configuring a
Map Variable activity, you can also create standalone maps. You can create an inline map in a Map Variables
activity from a standalone map. For more information, see Creating a Map Variables Activity from a Standalone
Map.

In the Map Inputs task, you map variable or variables from the orchestration (From Orchestration pane) to the
input parameter or parameters of the activity (To Activity pane).

In the Map Outputs task, you map output parameters from the activity (the From Activity pane) to variable or
variables of the orchestration (the To Orchestration pane).

During run time, an activity typically takes data from orchestration variable or variables manipulates the data in
some way and returns the result in another set of variables as shown in the following figure:

The flow of data (from left to right) through the example activity (shown in the preceding figure) is described in
the following steps:

1. In this case, the contents of the variable was supplied by the previous activity in the orchestration, the
FTP Poll Directory activity. Comma separated values are stored in the flatFileRawContent variable by the
FTP Poll Directory activity.

2. The contents of the flatFileRawContent variable is assigned to the input parameter called Data of the
Read Flat File activity.

3. The Read Flat File activity converts the comma separated values to XML data and places the resulting
data into the Xml output parameter.

4. The contents of the Xml output parameter is assigned to the batchOrderXML variable. The
batchOrderXML variable is available in the orchestration. The next activity in the orchestration can use
the contents of the batchOrderXML variable.

You can also manipulate the data in the maps between parameters and variables (created in the Map Inputs
and Map Outputs task) using the functions available from the Functions tab. For more information see
Assigning Function(s) to a Mapping Rule.
The following activities require mapping:

All connection activities that are listed under the following folders in the Activities tab:
Database
Email
FTP
HTTP
MQ
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SAP
Web Services

All the Transform activities that are listed under the Transform folder in the Activities tab.
Create Job Keys Activity

 

Mapping Inputs
When you map inputs, you are mapping from the orchestration (variables) to the activity (parameters).
Mapping Outputs
When you map outputs, you are mapping from the activity (parameters) to the orchestration (variables).  
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Mapping Inputs
When you map inputs, you are mapping from the orchestration (variables) to the activity (parameters).

About this task

To create a map between variables and input parameters:

Procedure

1. Open or create an orchestration.
2. If the activity is mapping variables that conform to a particular XML Schema or DTD, upload the XML

Schema or DTD file into your project.
3. Click the activity in the orchestration that contains the Map Inputs task in the Checklist.
4. Select the Map Inputs task from the Checklist.
5. If not already selected, click Design. The Mapping Editor is displayed and the input parameters of the

activity show in the To Activity pane.
6. Add variables to the From Orchestration pane.
7. Drag a source node from the From Orchestration pane to a destination node of an input parameter listed

in the To Activity pane. If the mapping is valid, a link (line) displays from the source node to the
destination node, indicating that a mapping rule has been established. Repeat this step until all the
required nodes have been mapped. For more information, see the help topic for an activity to determine
which nodes are required.
Note: You can find a node in a source or destination schema using the Find dialog box.

8. Optional: Assign Function(s) to a Mapping Rule.
9. If possible, test your mappings to ensure that the output is what you expect.

Note: You can replace a variable used in the map without changing the links of the map. For more
information, see Replacing a Variable used in a Map.
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What to do next

You can show the optional input parameters of an activity using the Map > Show Optional Parameters toolbar
menu option or hide the optional input parameters of an activity using the Map > Hide Optional Parameters
toolbar menu option.

In addition, you can show or hide the optional input parameters of an activity by right-clicking in the To Activity
pane and selecting the Show Optional Parameters to show the optional input parameters or selecting Hide
Optional Parameters option to hide the optional input parameters. When the Show optional parameters option
is set, the optional input parameters of an activity display in the To Activity pane of the Map Inputs pane with
the prefix string: {optional}. If the Map > Show Optional Parameters option is not selectable in the toolbar
menu, click a node in the Map Inputs pane to make this option active

Parent topic: Creating a map
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Mapping Outputs
When you map outputs, you are mapping from the activity (parameters) to the orchestration (variables).  

About this task

To create a map between output parameters and variables:

Procedure

1. Open or create an orchestration.
2. If the activity is mapping variables that conform to a particular XML Schema or DTD upload the XML

Schema or DTD file into your project.
3. Click the activity in the orchestration that contains the Map Outputs task in the Checklist.
4. Select the Map Outputs task from the Checklist.
5. If not already selected, click Design. The Mapping Editor is displayed and the output parameters of the

activity show in the To Activity pane.
6. Add output variables to the To Orchestration pane:

To add existing variables to the To Orchestration pane or create new variables, click Select
Outputs....
To create new variables and to automatically map those variables in the To Orchestration pane,
click Copy.

7. Drag a source node from the From Activity pane to a destination node of an input parameter listed in the
To Orchestration pane. If the mapping is valid, a link (line) is displayed from the source node to the
destination node, indicating that a mapping rule has been established. Repeat this step until all the
required nodes have been mapped. In general, it is not a requirement that you map all the outputs from
an activity.

 821



Note: You can find a node in a source or destination schema using the Find dialog box.
8. Optional: Assign Function(s) to a Mapping Rule.
9. If possible, test your mappings to ensure that the output is what you expect.

Note: You can replace a variable used in the map without changing the links of the map. For more
information, see Replacing a Variable used in a Map.

Parent topic: Creating a map
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Creating a Standalone Map
A standalone map is visible in the Transformations folder of the Project tab and represents a set of one or more
mappings between source and destination nodes.

About this task

The set of source nodes available in the From Orchestration pane and destination nodes in the To Orchestration
panes of the Mapping Editor are determined by the schema types defined for the source and destination
variables of the map. A standalone map can be used to create any number of Map Variables activities in the
same orchestration or in other orchestrations in the same project. For example, you could create a standalone
map called myMap that contains a set of mappings between an source XML Schema called IncomingOrder and
a destination XML Schema called ShippingOrder.

You can reuse this map by selecting the myMap entity from the Transformations folder in the Project tab and
dropping it onto any orchestration in the project. This dropping action creates a new Map Variables activity in
the orchestration with the same set of mappings as defined for the map called myMap. The new inline map
created for the Map Variables activity is a copy of parent standalone map. If you change the mappings between
the source and destination nodes in myMap, the changes are not propagated to new Map Variables activity
because it is a local copy. For more information see Creating a Map Variables Activity from a Standalone Map.

To create a standalone map:

Procedure

1. Create a new instance of a standalone map using one of the following options:
Select the Project tab, right-click on the Transformations folder, and select the New Standalone
Map option from the menu.
From the toolbar menu, select the Project > New Standalone Map option.
In the Project tab, click New Standalone Map ( ).

An instance of a standalone map shows in the Maps folder in the Project tab
2. Double-click the instance of the standalone map in the Transformations folder in the Project tab. The

Mapping Editor opens in the lower part of the pane.
3. Select the source schemas.
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4. Select the destination schemas
5. Drag a source node from the From Orchestration pane to a destination node in the To Orchestration

pane. If the mapping is valid, a link (line) displays from the source node to the destination node,
indicating that a mapping rule has been established. Repeat this step until all the required nodes have
been mapped.
Note: You can find a node in a source or destination schema using the Find dialog box. For more
information about finding a node in a source or destination schema, see Assigning Function(s) to a
Mapping Rule.

6. Optional: Assign function or functions to a mapping rule. For more information, see Assigning
Function(s) to a Mapping Rule.

7. If possible, test your mappings to ensure that the output is what you expect. For more information about
testing mappings, see Testing maps.

Select source schemas for a standalone map
Select destination schemas for a standalone map

Parent topic: Mapping
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Select source schemas for a standalone map

Before you begin

Before you can select a schema or a fragment of the schema as a source schema for a map, you must first
upload the XML Schema or DTD file that contains the schema into the Project or you must create the Flat File
Schema that represents the Flat File data.

About this task

To select the source schemas for a standalone map:

Procedure

1. Click Add in the From Orchestration pane. The Browse For Schema Type Element dialog box shows.
2. Browse for the schema or schema fragment.
3. Select the schema or schema fragment and click OK. The schema or schema fragment is displayed in

the From Orchestration pane.
4. Repeat these steps to add additional source schema or schema fragments to a map.

Parent topic: Creating a Standalone Map
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Select destination schemas for a standalone map

Before you begin

Before you can select a schema or a fragment of the schema as a destination schema for a map, you must first
Uploading Files into a Project that contains the schema into the Project or you must create the Flat File Schema
that represents the Flat File data.

About this task

To select destination schemas for a standalone Map:

Procedure

1. Click Add in the To Orchestration pane. The Browse For Schema Type Element dialog box is displayed.
2. Browse for the schema or schema fragment.
3. Select the schema or schema fragment and click OK. The schema or schema fragment is displayed in

the To Orchestration pane.
4. Repeat these steps to add additional destination schema or schema fragments to a map.

Parent topic: Creating a Standalone Map
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Creating a Standalone Map from a Map Variables Activity

About this task

The following procedure provides instructions for creating a standalone map from a Map Variables activity. For
more information about standalone maps and the inline map of a Map Variables activity, see About Maps.

To create a standalone map from a Map Variables activity:

Procedure
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1. Select the Project tab.
2. Double-click an orchestration that contains the Map Variables activity, in the Orchestrations folder of the

Project tab.
3. Drag the Map Variables activity from the orchestration into the Project tab. A new Map shows under the

Transformations folder of the Project tab. New schemas might also be created when this new map is
created.
Important: The new standalone map is a copy of the map from the Map Variables activity. Changing the
map in the Map Variables activity does not change the new standalone map. The converse is also true,
changing the new standalone map does not change the map in the Map Variables activity.

Parent topic: Mapping
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Creating a Map Variables Activity from a Standalone Map

About this task

The following procedure provides instructions for creating a Map Variables activity from a standalone map. For
more information about standalone maps and the inline map of a Map Variables activity, see About Maps.

To create a Map Variables activity from a standalone map:

Procedure

1. Select the Project tab.
2. Select the orchestration that you want to add the Map Variables activity to, by double-clicking the

orchestration in the Orchestrations folder of the Project tab.
3. Drag a Map from the Transformations folder of the Project tab, onto the orchestration. The Link Schema

Type to Variables dialog box opens.
4. For all the input and output schema types of the map, enter the name of an existing variable or a new

variable in the Orchestration Variable field.
5. Click OK. The new Map Activity shows in the orchestration.

Important: The new inline map created for the Map Variables activity is a copy of the standalone map in
the Project tab. Changing the map in the Map Variables activity does not change the new standalone
map. The converse is also true, changing the new standalone map does not change the map in the Map
Variables activity.

Parent topic: Mapping
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Adding Variables to Mapping Panes
You can add existing variables to a map or create new variables and add them to a map using the Select
Inputs.. or Select Outputs... buttons available from the mapping panes of an activity.

About this task

To add a variable using the Select Inputs.. or Select Outputs... buttons:

Procedure

1. Click an activity in the orchestration.
2. Select a mapping task from the Checklist for the activity. The mapping tasks of an activity are typically

called Mapping Inputs or Mapping Outputs.
3. To add variables:

To add input variables to the map, click Select Inputs...
To add output variables to the map, click Select Outputs....

The Select Inputs or Select Outputs dialog box opens.
4. Select from one of the following options:

Add an existing variable to the mapping pane - Select an existing variable and click OK. The
existing variable is added to the mapping pane.
Add a new variable to the mapping pane - To add a new variable to the mapping pane:

a. Click New. The Create New Variables Step 1 of 2 dialog box opens.
b. Select a data type or schema to base the new variable:

For a variable based on a primitive data type:
i. Scroll to the end of the Create New Variables Step 1 of 2 dialog box.
ii. Select a primitive data type from the Primitive Types folder.

iii. Click Next.
For a variable based on a schema:

i. Optional: To search for a node by name, click Find.
ii. From the schema, select a node to be the root of the new variable.

iii. Click Next.
c. Enter a name for the new variable and click Finish. Click OK.

The new variable is added to Variables toolbox, and the schema is displayed in the "Schema of"
pane on the Variables tab. The new variable is also added to the mapping pane

Parent topic: Mapping
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Copying Parameters

About this task

Using the Copy button ( ) available from the Map Outputs pane, you can create new orchestration
variables that match the output parameters of the current activity.

To copy variables:

Procedure

1. Click an activity in the orchestration.
2. Select the Map Outputs task from the Checklist for the activity. The mapping pane displays the output

parameters of the current activity in the From Activity pane.
3. Click Copy. The Copy Parameters dialog box opens, containing a list of parameters matching those in the

From Activity pane.
4. Click the output parameter or parameters to create variables from. The data type, schema, or schema

fragment of the selected output parameter defines the data type, schema, or schema fragment of the
new variable. To select more than one output parameter, press Shift while clicking the output
parameters.

5. Click Create. The variables display in the To Orchestration pane. If required, rename the newly created
variable to a more meaningful name. To rename the variable, double-click the variable in the blue
section of the To Orchestration pane, enter the new name, and press Return.

Parent topic: Mapping
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Replacing a Variable used in a Map

About this task

You can change the variables used in the From Activity and To Orchestration panes without changing the links
between source and destination nodes of a map.

For example, you could have a Map Variables activity that maps the nodes of the varBatchOrder variable to the
nodes of the varPurchaseOrder variable as shown in the following figure.
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The varBatchOrder variable is based on the BatchOrder XML Schema and the varPurchaseOrder variable is
based on the PurchaseOrder XML Schema.

If you wanted another Map Variables activity in your orchestration maps source and destination nodes but you
wanted to use a different set of variables. You could copy the original Map Variables activity and then paste the
new Map Variables activity into the orchestration and then change the variables used in the map without
changing the links of the map.

To replace an original variable used in a map:

Procedure

1. Click the Map Variables activity or the Map Inputs or Map Outputs tasks of an activity.
2. Create a new variable or replace a source or destination variable:

Double-click the blue area where the variable is listed in the From Activity, From Orchestration, To
Activity, or To Orchestration panes and enter the name of the variable. A new variable of the same
schema type is created.
Replace a source or destination variable using one of the following actions:

Right-click the blue area where the variable is listed in the From Activity, From
Orchestration, To Activity, or To Orchestration panes and select the Choose Another
Variable option from the list.
Double-click the blue area where the variable is listed in the From Activity, From
Orchestration, To Activity, or To Orchestration panes.

An arrow shows to the right of the variable name as shown in the following figure.

Select another variable from the list.  For this example, select the varOrder variable from the list.
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Note: You can only change the variables used in Map Input and Map Output panes and not the
parameters that are used in a map. For example in the FTP Poll Directory activity, the filename,
data, and timestamp input parameters located in the From Activity pane of the Map Outputs task
cannot be changed but the variables that the parameters map to in the To Orchestration pane can
be changed.

Parent topic: Mapping
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Finding Nodes

About this task

You can search for nodes in the mapping panes of activities as described in the following procedure.

To find nodes:

Procedure

1. Open the mapping pane containing the node you want to search for.
2. Open the Find dialog box using one of the following options:

Right-click either the source pane or the destination pane and select Find. The Find dialog box
opens.
Click a node in either the source pane or the destination pane. Select Edit > Find from the Studio
toolbar menu. The Find dialog box opens.

3. Enter the name of the node that you want to search for in the Text to find field.
4. Select any options or change the direction of the search:

Case Sensitive - Exactly matches the case of the text entered in the Text to find field.
Whole Words Only - Matches the search text only as whole words. No partial matches are
allowed.
Wrap Search - Continues searching through the entire schema regardless of where the search
was started.
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Forward - Searches from the root node or current node down through the schema in node-tree
order.
Backward. Searches from the last node in the tree or the current node up through the schema in
reverse node-tree order.

5. Click Find. Click Find again to continue the search through the schema.
6. Click Cancel to close the dialog box.

Parent topic: Mapping
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Assigning a Default Value for a Destination Node

About this task

You can assign a default value for a destination node in a map. A destination node of a map is displayed in the
mapping pane. The following figure shows the To Orchestration pane.  How the default value is used during run
time depends if a link is assigned to the destination node as described in the following cases:

Define a default value for a destination node that does not have a link from a source node or function as
shown in the following figure:

For this case, the specified constant value is always assigned to the destination node during run time.
Define a default value for a destination node that has a link from a source node or function as shown in
the following figure:
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For this case, the specified value is only assigned to the destination node, if the link from the source
node or a function to the destination node does not provide a value for the destination node during run
time.  

You can also use configuration properties to supply the default values for destination nodes of a map of a
mapping pane as described in step 2 of the following procedure. You must create the configuration property
before defining the default value as described in the following procedure.

To define a default value for a destination node:

Procedure

1. Right-click a destination node within the mapping pane. The name of the pane within the mapping pane
depends on the type of map you are currently configuring as described in the following list:

While configuring a Map Inputs task of an activity, the destination nodes of a map show in the To
Activity pane.
While configuring a Map Outputs task of an activity, the destination nodes of a map show in the To
Orchestration pane.
While configuring a stand-alone map or a Map Variables activity, the destination nodes of a map
show in the To Orchestration pane.

2. Select the Define Default Value option from the list. The Define Default Value dialog box opens. If any

configuration properties have been defined for the project, the  icon shows in the right of the Default
Value field.

3. In the Default Value field, define the default value using one of the following options:
Directly enter the characters that define the default value.

Select a configuration property to supply the default value by clicking the  icon and selecting a
configuration property from the list.

4. Click OK. The default (  ) icon shows next to the destination node in the mapping pane.

What to do next

To clear the default value for a destination node:

1. Right-click a destination node with a default value assigned to the node within the mapping pane. A
destination node with a value assigned shows the default (  ) icon to the left of the node.

2. Select the Define Default Value option from the list. The Define Default Value dialog box opens with the
text or the selected configuration property highlighted.

3. Press the Delete key.
4. Click OK. The default ( ) icon is removed from the destination node in the mapping pane.

Parent topic: Mapping
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Mapping Techniques

About this task

You can map from Source nodes to Destination nodes in various ways, depending on how your mapping is set
up. You can:

Map from one Source node to one Destination node
Map from multiple Source nodes to one Destination node
Map from one Source node to multiple Destination nodes
Conditional Mapping for a Recurring Node

Mapping One Source to One Destination
Mapping Multiple Sources to One Destination
Mapping One Source to Multiple Destinations
Conditional Mapping for a Recurring Node
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Mapping One Source to One Destination

About this task

To map from one Source node to one Destination node:

Procedure

1. Open the Mapping Editor.
2. Drag a Source node onto a Destination node. The Mapping Editor draws a link between the nodes and

marks the destination node as mapped.
Note: You may receive a validation warning if this mapping rule is not guaranteed or is not allowed.
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Mapping Multiple Sources to One Destination

About this task

You cannot map several source nodes to a single destination node unless you use functions to define how the
source data should be combined. For example, you can use the Concatenate function to combine several
source nodes with string datatypes.

See Assigning Function(s) to a Mapping Rule for more information.
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Mapping One Source to Multiple Destinations

About this task

To map from one Source node to multiple Destination nodes:

Procedure

1. Open the Mapping Editor.
2. Drag a Source node onto each Destination node you want to map.
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Conditional Mapping for a Recurring Node
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About this task

To map from one Source node to multiple Destination nodes:

Procedure

1. Right-click the element or variable in the recurring node for which you want a conditional mapping. The
Select Occurrence pane opens.

2. Enter the code for the condition.
3. Click OK.

Parent topic: Mapping Techniques
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Automapping Matching Nodes
Automapping quickly maps source nodes to matching destination nodes. Matching is ‘fuzzy' and ignores
differences in case or punctuation. It does not match nodes that are at different levels within the structure or
have differences such as abbreviations in names.

To automap, select Map > Automap from the toolbar. The Mapping Editor draws mapping rules for each
matching node that it finds.

The Mapping Editor also display warnings for any mapping rules that it attempts to create that are not
guaranteed.
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Bulk Mapping Nodes

About this task
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Bulk mapping can quickly map similar structures, such as addresses, that use similar or identical names and
organization. Matching is ‘fuzzy' and ignores differences in case or punctuation. It does not match nodes that
are at different levels within the structure or have differences such as abbreviations in names.

Bulk mapping is applied to structure nodes that you identify in the Source and Destination.

To bulk map a structure node:

Procedure

1. Right-click a structure node in the Source tree displayed in the Mapping Editor.
2. Select Map > Create Bulk Mapping Rules from the menu toolbar.
3. Drag a Source structure node onto a Destination structure node. The Mapping Editor draws mapping

rules for each matching node that it finds within the structures you have selected.
Note: Bulk mapping removes any existing mapping rules for the Destination structure you select.
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Mapping Recurring Nodes

About this task

Mapping rules for recurring nodes can:

Determine the output for all occurrences
Determine the output for specific occurrences
Reconcile cardinality issues, such as different minimum occurrences or source and destination schemas
that model recurring structures with different levels or no recurrence.

How you map recurring nodes is determined by the recurring relationships in your source and destination
schemas, as outlined in the following table.

Source
Destinati
on Action to take

Not
recurring

Recurring Expand the destination node to map the source nodes to specific destination node
occurrences.

Recurring Not
recurring

Select specific occurrences of the source and map them to the destination.

Matching
Recurring
Levels

Matching
Recurring
Levels

Map all occurrences or select/expand specific occurrences if you need to.
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Source
Destinati
on Action to take

More
Recurring
Levels

Fewer
Recurring
Levels

Select specific occurrences of the source nodes and map them to specific occurrences
of the destination. See the discussion on mapping limitations for recurring nodes in the
Getting Started Guide for more information.

Fewer
Recurring
Levels

More
Recurring
Levels

Expand specific occurrences of the additional recurring levels of the destination nodes
and map the source levels within the expanded destination nodes.

For more information on recurring nodes and how to limit the recurring nodes returned by a mapping activity,
see Filter Recurring Nodes.
Parent topic: Mapping
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Mapping All Occurrences

About this task

You can map all occurrences of a recurring source node to a recurring destination node as long as the nested
levels of recurrence match or you have specified how any uneven levels should be handled.

To map all occurrences of a recurring source node:

Drag a node in the Source tree to the appropriate node in the Destination tree. The Mapping Editor
automatically creates mapping rules linking the Source occurrence nodes to the matching Destination
occurrence nodes

Note: If the levels of recurrence in the source and destination schema trees do not match, you must map
specific occurrences instead.
Parent topic: Mapping
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Mapping Specific Occurrences
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About this task

When the recurring levels in the Source tree do not match those in the Destination tree, you must expand the
recurring nodes and define mapping rules for specific occurrences to resolve cardinality differences:

When source tree recurring levels are greater than destination tree levels, Select Source Occurrences
When source tree recurring levels are less than destination tree levels, Expand Destination Occurrences

In addition, the following functionality is available for a recurring destination node that has already been
expanded:

Collapse Destination Occurrences - Removes all the occurrences of a recurring destination node, leaving
just the recurring destination node.
Add Destination Occurrence - Adds a single occurrence of a recurring destination node.
Remove Destination Occurrence - Removes the selected occurrence.

Select Source Occurrences
Expand Destination Occurrences
Collapse Destination Occurrences
Add destination occurrence
Remove Destination Occurrence
Select a substitution type in a mapping pane

Parent topic: Mapping
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Select Source Occurrences

About this task

To select source occurrences: 

Procedure

1. Open a mapping pane and right-click the source node that you want to map.
2. Select Select One Occurrence from the list. The Select One Occurrence dialog box opens.
3. This dialog box displays the path to the source node you have chosen with an occurrence property for

each recurring level. Select the number of occurrences to use at each recurring level.
4. Click OK. The source node is highlighted in red in the Mapping Editor.
5. Select the source node and drag it onto the destination node to complete the mapping.

Parent topic: Mapping Specific Occurrences
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Expand Destination Occurrences

About this task

To expand destination occurrences:

Procedure

1. Right-click the recurring (  ) destination node in the mapping panes of activities. Destination nodes are
located on the right side of mapping panes.

2. Select Expand Occurrences from the list
3. In the Expand Occurrences dialog box, specify the number of occurrences that you want to expand and

map to explicitly. You can map to both the recurring node and the explicit occurrences.
4. Select a setting for the Before check box:

Select the Before check box if you want the set of single occurrences to show in the map before
the set of recurring nodes.
Clear the Before check box if you want the set of single occurrences to show in the map after the
set of recurring nodes.

5. Click OK. The specified number of occurrences shows for the selected recurring destination node.
6. Map to the expanded destination nodes as needed, treating each set as one occurrence of that

structure.

You can specify the substitution type for an expanded occurrence of a recurring destination node. This
type substitution of an expanded occurrence is only supported for the recurring destination nodes.
Destination nodes are located on the right side of mapping panes.
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Collapse Destination Occurrences

About this task
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To collapse destination occurrences:

Attention: Collapsing destination occurrences removes all the current mappings for all of the expanded
occurrences.

Procedure

1. Open a mapping pane and right-click the recurring destination node or any occurrence of a recurring
destination node. Destination nodes are located on the right side of mapping panes.

2. Select Collapse Occurrences from the list.
3. Click OK.
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Add destination occurrence

About this task

To add an occurrence to a destination node with existing expanded occurrences:

Procedure

1. Open a mapping pane and right-click the recurring destination node or any occurrence of a recurring
destination node. Destination nodes are located on the right of the mapping panes.

2. From the list, select one of the following options (if available) from the Add New Occurrence menu
option:

Add New Occurrence > After - Select this option if you want add the new occurrence after the
currently selected destination occurrence.
Add New Occurrence > Before -  Select this option if you want add the new occurrence before the
currently selected destination occurrence.

3. Click OK.

You can specify the substitution type for an expanded occurrence of a recurring destination node. This
type substitution of an expanded occurrence is only supported for the recurring destination nodes.
Destination nodes are located on the right of the mapping panes.

Parent topic: Mapping Specific Occurrences

Feedback | Notices

 839



 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/map_Mapping_Specific_Occurrences_A
dd_Destination.html

Remove Destination Occurrence

About this task

To remove a destination occurrence:

Procedure

1. Open a mapping pane and right-click the recurring destination node or any occurrence of a recurring
destination node. Destination nodes are located on the right of the mapping panes.

2. From the list, select the Remove Selected Occurrence menu option. A Confirmation dialog box opens.
3. Click Yes.
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Select a substitution type in a mapping pane

About this task

To select a substitution type in a mapping pane:

Procedure

1. Upload an XML Schema that contains an XML element based on derived types into the project.
2. In an activity that uses an XML Schema, select the node representing the XML element that is based on

a derived type for the input or output parameter of the activity.

For example, the Read XML activity uses an XML Schema to define the output parameter of the activity.
In the Configure task of the Checklist for the Read XML activity, select an XML variable that defines the
node of the XML Schema to use the output parameter. Using example XML Schema shown in the
preceding figure, a variable based on the <shape> element can be used to define the node of the XML
Schema to use as the output parameter of the Read XML activity. Since the derived type for the <shape>
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element is not selected, only the child element (named color) of the base type are displayed in the From

Activity pane as shown in the following figure: 

Note that the child elements of the derived types are not listed in the mapping pane. In this example, the
child element of circle which is named diameter is not listed, nor are the child elements of rectangle
which are named width and length.

3. In the From Activity and To Orchestration panes of an activity, select the derived type expected during
run time, by right-clicking on the node and from the menu selecting the Substitute Node With ... option.
The Substitute Node with a Derived Type dialog box open the menu, the available derived types for the
node as defined by the XML Schema are listed. For this example, the two derived types are available
from the menu as shown in the following figure: 

4. Select one of the derived types. The selected derived type determines the expected type of XML
instance document during run time.

In this example, the circle derived type is selected, so the XML data expected for this node during run
time is of type circle as shown in the XML instance document displayed at the top of this page.

In addition to the child elements of the base type, the child elements of the derived type show in the
mapping panes. In this example, the child element named diameter is displayed with the child element
named color (inherited from the base type) in the From Activity pane of the Read XML activity as shown

in the following figure:
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Parent topic: Selecting a substitution type

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

 841



http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/map_Selecting_a_Substitution_Type_in
_a_Mapping_Pane.html

Mapping Destination Nodes
When you map a destination node, you indicate the data source used to complete the node and create a
mapping rule. Mapping rules provide data to a destination node in various ways, as described in the following
topics.

From source nodes

Mapping from a source node to a destination node creates a link between them. This is the most common way
to define a mapping rule. There are several ways to link source and destination nodes as described in these
topics:

Mapping Techniques

Mapping Recurring Nodes

Automapping Matching Nodes

Bulk Mapping Nodes

By assignment

Mapping by assignment means that you provide a default value or use functions to determine the value of the
destination node. See Assigning a Default Value for a Destination Node and Assigning a Function Without a
Source Node Link for more information.

Using a combination of source nodes and functions

Mapping using a combination of source nodes and functions refers to manipulating the link between source
and destination nodes with functions to convert data, calculate or assign data. See the Assigning Function(s) to
a Mapping Rule for details
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Selecting a substitution type
The XML Schema specification supports the ability to derive complex types by extension.

In the XML instance document, you declare the type of an XML element from a set of types that are all derived
from the same base type, rather than explicitly declaring the type for the XML element in the XML Schema. The
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type for the element is defined using the type attribute as shown by the following example XML instance
document:

<?xml version="1.0" encoding="UTF-8"?> 
<shape xmlns="http://shapesrus.com/example"  
  xmlns:xsd="http://www.w3.org/2001/XMLSchema-instance" 
xsd:type="circle"> 
 <color xmlns="">blue</color> 
 <diameter xmlns="">10</diameter>   
</shape>

In the preceding XML instance document, the <shape> element is declared as a circle type. The <shape>
element in the XML instance document can also be defined as a rectangle type as defined in the following
example XML instance document:

<?xml version="1.0" encoding="UTF-8"?> 
<shape xmlns="http://shapesrus.com/example"  
  xmlns:xsd="http://www.w3.org/2001/XMLSchema-instance" 
xsd:type="rectangle"> 
 <color xmlns="">blue</color> 
 <length xmlns="">5</length> 
 <width xmlns="">8</width>   
</shape>

In this example, the <shape> element is based on one of the derived types of shapeType base type. The
derived types of shapeType are named circle and rectangle, as shown in the following example XML
Schema:
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When an XML Schema defines an XML element based on derived types, you must specify the derived type (or
substitution type) expected for the XML element during run time. For the preceding example XML Schema, you
must specify the type of the <shape> element – either circle or rectangle. In Studio, you specify the
expected substitution type of an XML element using the Substitute Node With ... menu option:

For a variable based on a substitution type - Select the expected type of the XML element by right-
clicking the node in the Schema of pane in the Variables tab and by selecting the Substitute Node With ...
option from the menu. For more information see Selecting a Substitution Type for Variables.
For a node based on substitution type in a mapping pane - Select the expected type of the XML element
by right-clicking the node in the Schema of pane in the Variables tab and by selecting the Substitute
Node With ... option from the menu, as described in the following procedure.  

In the preceding example XML Schema, the base type called <shapeType> is defined as abstract. An abstract
base type cannot be used in the XML instance document to define the type for the element - one of the derived
types must be specified instead. In this example, the <shape> element in the XML instance document cannot
be declared as shapeType, it must be declared as one of the derived types; either circle or rectangle.

In the preceding example, the base type is defined as abstract but type substitution of derived types based on
a base type that is not abstract is also supported. To make the complexType called shapeType not abstract in
the example XML Schema, remove the abstract=true attribute as shown in the following XML Schema
segment:

844   



<xsd:complexType name="shapeType"> 
  <xsd:sequence> 
    <xsd:element name="color" type="xsd:string"/> 
  </xsd:sequence> 
 </xsd:complexType>

A WSDL is a specific XML Schema that defines a Web Service. Using type substitution with a WSDL is also
supported.

You can specify the substitution type for an expanded occurrence of a recurring destination node. This type
substitution of an expanded occurrence is only supported for the recurring destination nodes. Destination
nodes are located on the right side of mapping panes.

Attention: Type substitution of complex types is supported in the mapping panes of activities and for variables.
However, deriving elements by extension using substitution groups is not supported in the mapping panes of
activities or for variables. For more information, see Unsupported XML Schema Features.

Example XML Schema

The example XML Schema used in this topic is provided for reference:

<xsd:schema xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
           targetNamespace="http://shapesrus.com/example" 
           xmlns:sru="http://shapesrus.com/example"> 
  <xsd:element name="shape" type="sru:shapeType"/> 
    <xsd:complexType name="shapeType" abstract="true"> 
      <xsd:sequence> 
         <xsd:element name="color" type="xsd:string"/> 
      </xsd:sequence> 
    </xsd:complexType> 
    <xsd:complexType name="circle"> 
       <xsd:complexContent> 
         <xsd:extension base="sru:shapeType"> 
         <xsd:sequence> 
           <xsd:element name="diameter" type="xsd:integer"/> 
         </xsd:sequence> 
        </xsd:extension> 
  </xsd:complexContent> 
  </xsd:complexType> 
  <xsd:complexType name="rectangle"> 
    <xsd:complexContent> 
      <xsd:extension base="sru:shapeType"> 
      <xsd:sequence> 
        <xsd:element name="length" type="xsd:integer"/> 
        <xsd:element name="width" type="xsd:integer"/> 
      </xsd:sequence> 
      </xsd:extension> 
    </xsd:complexContent> 
  </xsd:complexType> 
</xsd:schema>

Select a substitution type in a mapping pane
Remove the Derived Type Associated with a Node

Parent topic: Mapping
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Select a substitution type in a mapping pane

About this task

To select a substitution type in a mapping pane:

Procedure

1. Upload an XML Schema that contains an XML element based on derived types into the project.
2. In an activity that uses an XML Schema, select the node representing the XML element that is based on

a derived type for the input or output parameter of the activity.

For example, the Read XML activity uses an XML Schema to define the output parameter of the activity.
In the Configure task of the Checklist for the Read XML activity, select an XML variable that defines the
node of the XML Schema to use the output parameter. Using example XML Schema shown in the
preceding figure, a variable based on the <shape> element can be used to define the node of the XML
Schema to use as the output parameter of the Read XML activity. Since the derived type for the <shape>
element is not selected, only the child element (named color) of the base type are displayed in the From

Activity pane as shown in the following figure: 

Note that the child elements of the derived types are not listed in the mapping pane. In this example, the
child element of circle which is named diameter is not listed, nor are the child elements of rectangle
which are named width and length.

3. In the From Activity and To Orchestration panes of an activity, select the derived type expected during
run time, by right-clicking on the node and from the menu selecting the Substitute Node With ... option.
The Substitute Node with a Derived Type dialog box open the menu, the available derived types for the
node as defined by the XML Schema are listed. For this example, the two derived types are available
from the menu as shown in the following figure: 

4. Select one of the derived types. The selected derived type determines the expected type of XML
instance document during run time.
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In this example, the circle derived type is selected, so the XML data expected for this node during run
time is of type circle as shown in the XML instance document displayed at the top of this page.

In addition to the child elements of the base type, the child elements of the derived type show in the
mapping panes. In this example, the child element named diameter is displayed with the child element
named color (inherited from the base type) in the From Activity pane of the Read XML activity as shown

in the following figure:
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Remove the Derived Type Associated with a Node

About this task

To remove the derived type associated with a node:

Procedure

1. Once a derived type has been selected for a node using the Substitute Node With ... option, you can
remove the association between the node and the derived type by right-clicking the node and selecting
the Unsubstitute Node option from the menu. A Unsubstitute dialog box opens.

2. Click Yes.
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Mapping Rules That Are Automatically Deleted
When you open a map, the Mapping Editor automatically deletes mapping rules from the map in two cases:

Case 1: One or both of the XML Schemas that the map refers to have been
changed.

Schemas can change due to changes in the connection activities or message definitions they are generated
from. Schemas that you add to the project can also be edited directly.

Note: The warning message from the Mapping Editor lists the mapping rules that were deleted. This list might
also include rules for property nodes, such as ihmap:exists for the optional property node.

Review the map and recreate or alter mapping rules to handle the schema changes properly.

Case 2: One of the XML Schemas that the map refers to has been deleted from
the project.

In this case, the Mapping Editor deletes all mapping rules, and the map cannot be recreated. Close the map
and delete it from the project.
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Assigning a Count of Occurrences

About this task

You can assign a value to a destination node that counts the actual occurrences in a message of a specific
recurring node.

To assign a count of occurrences:

Procedure

1. Drag the Count function from the Functions tab to the Function Graph pane in the Mapping Editor.
2. Link the recurring node that should be counted to the Count function.

Note: Count works with any recurring node, including recurring structure nodes.
3. Link the Count function to the destination node.

Parent topic: Mapping

848   



Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/map_Assigning_a_Count_of_Occurrenc
es.html

Removing Mapping Rules

About this task

You can remove one mapping rule or all mapping rules as outlined in the following sections.

Removing mapping rules with links
Removing mapping rules with no visible links
Remove All Mapping Rules
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Removing mapping rules with links

About this task

To remove a mapping rule that has a link from source to destination node:

Procedure

Delete the mapping rule in one of the following ways:

Select the link for the mapping rule and press Delete.
Right-click the link and select Delete Mapping.

Results

The Mapping Editor prompts you to confirm the removal if the mapping rule you select links occurrence
property nodes. Removing occurrence mapping rules also removes all the mapping rules for descendant nodes
within that recurring structure.
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Removing mapping rules with no visible links

About this task

Mapping rules can have no visible link if they use only functions or a default value.

To remove mapping rules with no links:

Procedure

1. Select the destination node and right-click.
2. Select one of these options:

a. Define Default Value. If the node has a default assigned. Remove the default value in the Default
Value window and click OK.

b. Edit Function Graph. If the node has a function graph assigned. Once the function graph is
expanded, right-click the function and select Delete Mapping.
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Remove All Mapping Rules

About this task

Procedure

1. Select Map > Clear Map from the menu toolbar.
2. Confirm the deletion when prompted.
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Finding Sample or Result Content

About this task

You can search the sample messages or the test result to find specific nodes or content:

Procedure

1. Open the Mapping pane containing the node you want to search for and click Test.
2. Right-click either the Selected Test Files pane or the Test Result pane and select Find from the shortcut

menu.
3. Enter the text that you want to search for in the Text to find field.
4. Select any options or change the direction of the search:

Case Sensitive - Exactly matches the case of the text entered in the Text to find field.
Whole Words Only - Matches the search text only as whole words. No partial matches are
allowed.

Wrap Search - Continues searching through the entire schema regardless of where the search
was started.

Forward - Searches from the root node or current node down through the schema in node-tree
order.

Backward. Searches from the last node in the tree or the current node up through the schema in
reverse node-tree order.

5. Click Find. Click Find again to continue the search through the schema.
6. Click Cancel to close the dialog box.
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Loading a Sample Message

About this task

It is recommended that you test the mapping rules you set up in the Mapping Editor before mapping the next
activity in your orchestration. You do this by loading a sample message into the project and testing against it to
verify that the mapping rules are applied correctly.

To load a sample message into the project:

Procedure

1. Click Test. The Test Files pane opens.
2. In the Find Test Files pane, click Browse and search for the message you want to load.
3. Select the XML file to use as a sample message in the window and click OK.

If the sample is valid, it displays in the Selected Test Files pane. If there are several source schemas for
this map, test files are displayed in source schema order.

4. If the map uses several source schemas, you can load sample messages for other source schemas
before you test the transformation. Repeat steps 2 and 3 for each sample you want to test
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Testing maps
You can test the transformation defined in a map using one or more sample messages that match the source
schemas for the map.

About this task

To test a map:

Procedure

1. Click Test from either the Map Inputs or Map Outputs pane. The Test pane is displayed. The variables or
parameters that show in the Select Input Test Files table depend on the type of task:

In the Test pane of a Map Inputs task, the variables that are mapped to the input parameters of
the activity are displayed in the Select Input Test Files table.
In the Test pane of a Map Outputs task, input parameters of the activity are displayed in the
Select Input Test Files table.

2. Get sample data to use as input to the map, using one of the following options:
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Generate sample data - To generate sample XML data valid against the source schema, select the
Map > Generate Test Data from the toolbar menu.
Import sample data from files - For each parameter in the Find Test Files list, click [...] to browse
for a sample message from your computer or a network drive. The selected message is displayed
in the Selected Test Files table.
Note: The sample message must be valid XML that meets the requirements defined in the source
XML Schema for the map. If the map uses several source schemas, you can load a sample
message for any or all of the schemas.

3. Click Run Test. The transformation defined in your map is run against the sample message you specified
in the Location column. The result of the transformation is displayed in the Test Result pane.

What to do next

Either save the transformation result, or clear it from the Mapping Editor panes.
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Saving or Clearing the Transformation Result

About this task

You can save the result of the map test to a file on your computer or a network drive. This can be useful if you
would like to review the result using XML tools outside of Studio. It can also be useful if the result of the
transformation is input to another activity, such as a message definition or another map.

To save the result of a map test:

Procedure

1. Test your mapping. For more information, see Testing maps.
2. Select Map > Save Results. The Save Results Message dialog box opens.
3. Navigate to the directory where you want to save the file and enter a file name.
4. Click Save.

Parent topic: Mapping

Clearing the transformation result

Procedure

Select Map > Clear Results. The results are cleared.

 853



Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/map_Saving_or_Clearing_the_Transfor
mation_Result.html

The Emit CData Option

About this task

Select the Emit CData option for a destination node for the text in the destination XML element to be treated as
an XML CDATA section and assigned to the destination node as a block and is not parsed during run time. It is
equivalent to specifying data for an XML element using the following XML syntax:

<![CDATA[

text

]]>

The Emit CData option can be selected for any destination nodes (located on the right pane of the Mapping
Editor). You can also select the Emit CData option for default values.

Note: The Emit CData option is not available for input nodes (located on the left pane of the Mapping Editor.)

To select the Emit CData option:

Procedure

1. In the Mapping Editor, right-click a destination node that is linked (or mapped) or has a default value
associated with it. Destination nodes are located in the right pane of the Mapping Editor either in the To
Activity or To Orchestration pane

2. Select the Emit CData option from the list. During run time, the Integration Appliance treats that
destination node as a CDATA section.
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Unsupported XML Schema Features
Using the following XML Schema features can cause maps to display or transform incorrectly, and can cause
validation warnings:
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Choice

Limitations to mapping rules might not allow you to correctly define transformation requirements for nodes
within a choice. The guaranteed status of mapping rules involving choice structures might be incorrect.
Transformations to destination schemas that have choice structures might incorrectly include all choices.

Mixed Content

Elements that allow mixed content can contain both data and other nodes. These nodes display correctly and
can be mapped. However, transformation of messages with mixed content nodes might not be complete.

Recursive Content

You cannot create a map with unlimited levels of recursive elements. You can specify mapping rules for no
more than five recursive levels.

Substitution Groups

Substitution groups support deriving elements by extension. Using substitution groups in an XML Schema to
extend an xs:anyType element to different types of elements is not supported. For example, extending an
xs:anyType element to either an element based on a simple type or an element based on a complexType is not
supported.

The ability to derive complex types by extension using type substitution is supported. For more information,
see Selecting a substitution type and Selecting a Substitution Type for Variables.

Unique, Key, or Keyref

The Mapping Editor does not provide information about elements that have unique, key, or keyref constraints
and mapping rules do not evaluate.

Various facets for restrictions or extensions

Information about the following facets is not available within the Mapping Editor and these facets are not
considered when you create mapping rules:

minInclusive, maxInclusive, minExclusive, and maxExclusive
length, minLength, and maxLength
totalDigits and fractionDigits
whitespace
patterns
enumeration
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About Unmapped Destination Nodes
During transformations, the Integration Appliance includes all destination nodes in the result message.
Destination nodes that are not mapped become empty nodes in the resulting message.

In most cases, this is desired behavior. With updates to databases, however, the Integration Appliance treats
an empty node in the outbound message as a NULL value for the database.

To prevent NULL values from being saved to the database, you must remove the unmapped nodes from the
XML Schema by clearing the columns from the database activity in the Configure pane. See the following topics
for more details:

Single-Table Inbound Database Activities

Single-Table Outbound Database Activities

Poll Table Activity

Parent topic: Mapping
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Filter Recurring Nodes
By specifying an XPath predicate to filter against during run time, you can limit the recurring nodes returned by
a mapping activity.

About this task

Filtering using a predicate directly in the mapping panes of activities eliminates the need for the following
activities:

A While Loop or For Each activity that loops through the recurring structures
An If...Then activity to test for values.

Eliminating the looping and If..Then activities improves orchestration performance.
For example, you can limit the books processed by the BatchOrderProcessingSample orchestration to only
return book titles that start with the letter B using either of the following methods:

After the Read Flat File activity which converts flat file data to XML, you can add a While Loop activity
that contains an If..Then activity that tests for all book titles that start with the letter B. When the While
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Loop activity completes at run time, it returns the set of recurring BookOrder nodes that have titles
beginning with the letter B.
Filter by specifying a predicate directly in the To Orchestration pane of the Map Outputs task of the Read
Flat File activity that converts flat file data to XML. This is the preferred method because it reduces the
processing during run time - improving orchestration performance.  For example, you can specify the
following predicate on the recurring BookOrder node to limit the Bookorder nodes returned during run
time to only those titles that begin with the letter B:*:title/starts-with(.,'B')

This example predicate is explained in the following table:

Predicate
Characters Description

*: Specifies this predicate applies to any namespace of the source node.

title/ Specifies to apply this predicate against the title node of the current source node.

starts-
with(.,'B')

Specifies this predicate returns only nodes that have title nodes that start with the letter B.
The starts-with function is a built-in XPath function.

For more information about the BookOrder sample, see the Getting Started Guide. If you accepted the defaults
during the installation of Studio, you can find the reference implementation of the sample in the following
directory:C:\Program Files\IBM\WebSphere Cast Iron Studio 3.X\Samples\BookOrder

To specify a predicate on a recurring node:

Procedure

1. You can only apply a filter on a recurring destination node which is mapped to a recurring source node in
the mapping panes of activities, as shown in the following Map Outputs pane of the Read Flat File
activity in the BatchOrderProcessingSample orchestration:

2. Right-click on the destination occurrence node (in this example BookOrder/occurrence) and select Filter
Recurring Nodes from the menu. The Filter Recurring Nodes dialog box opens.

3. Enter the XPath predicate. For this example, enter the predicate shown in the following figure:
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4. Click OK. The predicate is evaluated to determine if it is valid:
If the predicate is invalid, an error message is reported.
If the predicate is valid, the filter icon ( ) shows next to the destination occurrence node.
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Using Custom Functions and Lookup Tables
About Lookup Tables
Lookup tables define a set of key-value (name-value) pairs. During run time, these key-value pairs are
used to translate the passed in key to the associated value.
Defining Lookup Tables
Editing Lookup Tables
About Custom Functions
Defining a custom function
Editing a custom function
Custom Function Parameter and Return Datatypes
Assigning a Function Without a Source Node Link
Assigning a Function While Creating Maps
Adding a Function to an Existing Mapping Rule
Example: Chaining Multiple Functions
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Assigning Function(s) to a Mapping Rule
Assign built-in or custom function(s) to a map to convert or manipulate the data from source node(s)
before it populates the destination node. In addition, the source data for input parameters can be
provided by other functions associated with the mapping rule.
Deleting a Function from a Mapping Rule
Math Functions with Node Set Constraints
Adding a Parameter
Editing a Parameter
Deleting a Parameter
Reordering Parameters
Specifying Default Values for Functions that Accept Recurring Nodes as Input
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About Lookup Tables
Lookup tables define a set of key-value (name-value) pairs. During run time, these key-value pairs are used to
translate the passed in key to the associated value.

A lookup table is similar to a function that has one input string parameter (the source value to translate) and a
string return value (the result of the translation). In the Mapping Editor, a lookup table can be dragged onto a
mapping rule in the same way that a function can be.

Lookup tables are available to use in any map in the project where they were defined.
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Defining Lookup Tables

About this task

To define or create a lookup table:

Procedure
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1. Select the Functions tab. In the Function tab, the list of standard functions shows. In addition, the
Actions pane is displayed.

2. To display the Lookup Table dialog box, choose from one of the following options:
Right-click the Lookup Tables node in the Functions tab and from the menu select Add New
Lookup Table... .
In the Actions pane, select Add New Lookup Table.

The Lookup Table dialog box opens.
3. In the Table Name field of the Lookup Table dialog box, enter a name for your lookup table.

Note: This name must be unique for all tables in the current project. The name of the table is not case
sensitive - the case of a character is not considered. For example, the table name: Aaa is equivalent to
the table name: AAA.

4. Optional: In the Description field enter descriptive information about the table.
5. Define the Key Value pairs for the table.

Repeat the following steps for each Key Value pair in the table:
a. Click Add.
b. In the Key field, enter the value of the key. During run time, this key will be matched by the

specified value.
c. In the Value field, enter the value that the key will be translated to during run time. Press the

Return key.
6. Optional: Enter a value in the Default Value field. Enter a value in this field, if you want the lookup table

to supply a value even when no keys are matched during run time. Leave this field blank, if the lookup
table should not return a value when no keys are matched during run time.

7. Optional: Enter a value in the Value if "nil" field. This property only affects nillable nodes. Enter a value in
this field, if during run time you want the lookup table to supply a value even when the source node is
empty and the source node is nillable. Leave this field blank, if during run time the lookup table should
not return any value when the source node is empty and the source node is nillable.

8. Click OK.
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Editing Lookup Tables

About this task

To edit an existing lookup table:

Procedure

1. Select the Functions tab. In the Function tab, the list of standard functions shows. In addition, the
Actions pane is displayed.

2. In the Function tab, expand Lookup Tables.
3. Select the table to edit.
4. To display the Lookup Table dialog box, choose from one of the following options:
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Right-click the table node in the Functions tab and from the menu select Edit....
In the Actions pane, select Add New Lookup Table.

The Lookup Table dialog box opens.
5. Edit your table using one of the following actions:

Add a Key Value pair - To add another key value pair to your table, follow these steps:
a. Click Add.
b. In the Key field, enter the name of the key. During run time, this key will be replaced by the

specified value.
c. In the Value field, enter the value that the key will be translated to during run time. Press

the Return key.
Delete a Key Value pair - To delete a key value pair from your table, follow these steps:

a. Select a key value pair.
b. Click Delete.

Change the Default Value field -  Edit the current setting of the Default Value field. Enter a value
in this field, if you want the lookup table to supply a value even when no keys are matched during
run time. Leave this field blank, if the lookup table should not return a value when no keys are
matched during run time.
Change the Value if "nil" value field - Edit the current setting of the Value if "nil" value field. This
property only affects nillable nodes. Enter a value in this field, if during run time you want the
Lookup table to supply a value even when the source node is empty and the nillable. Leave this
field blank, if during run time the lookup table should not return any value when the source node
is empty and the source node is nillable.

6. Click OK.

What to do next

Lookup tables are added to mapping rules like functions. For more information about adding functions to
mapping rules, see Assigning Function(s) to a Mapping Rule.
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About Custom Functions
Custom functions are JavaScript functions that you develop to use in the Mapping Editor. The following script
standards are supported:

JavaScript 1.5
ECMAScript 3.0
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Defining a custom function

About this task

To define or create a custom function:

Procedure

1. Select the Functions tab. In the Function tab, the list of standard functions is displayed. In addition, the
Actions pane opens.

2. To display the Custom Function dialog box, choose from one of the following options:
Right-click the Custom Functions node in the Functions tab and from the menu select Add New
Custom Function... .
In the Actions pane, select Add New Custom Function.

The Custom Function dialog box opens.

3. In the Function Name field of the Custom Function dialog box, enter a valid JavaScript name for your
custom function.
Note: This name must be unique for all custom functions in the current project. The name of the function
is not case sensitive - the case of a character is not considered. For example the function name: Aaa is
equivalent to the function name: AAA.

4. Select a Return Type for your custom function from one of the following options:
string
number
boolean

For more information about these datatypes, see Custom Function Parameter and Return Datatypes.
5. Define the parameters for your custom function. Repeat the following steps for each parameter in your

custom function:
a. Click Add.
b. In the Name field of the Parameters table, enter the name of the parameter and press the Return

key.
c. Select a Type for the parameter, from one of the following options:

string
number
boolean

d. For more information about these datatypes, see Custom Function Parameter and Return
Datatypes.

6. Enter the source code for your custom function by following these steps:
a. Click Next.
b. In the white area displayed between the braces enter the JavaScript code of your custom

function.  
c. Click Compile. The syntax of the function will be checked and any errors reported. The location of

the errors are highlighted in red in the source code.
d. Fix any syntax errors and once the function compiles successfully, click OK and then Finish.
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Results

The custom function is now available from the Custom Functions folder of the Functions tab.
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Editing a custom function

About this task

To edit an existing custom function:

Procedure

1. Select the Functions tab. In the Function tab, the list of standard functions is displayed. In addition, the
Actions pane opens.

2. In the Function tab, expand Custom Functions.
3. Select the custom function to edit.
4. To display the Custom Function dialog box, choose from one of the following options:

Right-click the function node in the Functions tab and from the menu select Edit....  
In the Actions pane, select Add New Lookup Table.

The Custom Function dialog box opens.

5. In the Custom Function dialog box, edit your custom function using one of the following actions:
Add a Parameter - To add a parameter to your custom function follow these steps:

a. Click Add.  
b. In the Name field of the Parameters table, enter the name of the parameter.
c. Select a Type for the parameter, from one of the following options:

string
number
boolean

For more information about these datatypes, see Custom Function Parameter and Return
Datatypes.
Delete a Parameter - To delete a parameter from your custom function follow these steps:

a. In the Name field of the Parameters table, select the parameter and press the Return key.
b. Click Delete.

Change the Return Type - To select one of the following options from the Return Type field:
string
number
boolean

For more information about these datatypes, see Custom Function Parameter and Return
Datatypes.
Edit the source code - To edit the source code of your custom function, follow these steps:
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a. Click Next.
b. In the white area displayed between the braces enter the JavaScript code of your custom

function.
c. Click Compile.

The syntax of the function will be checked and any errors reported. The location of the
errors is highlighted in red in the source code.

d. Fix any syntax errors and once the function compiles successfully, click OK and then Finish.

The custom function is now available from the Custom Functions folder of the Functions
tab.
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Custom Function Parameter and Return Datatypes
The datatypes supported in the parameters and the return types of custom functions and their equivalent
JavaScript types are listed in the following table.

Custom Datatype JavaScript Datatype Description

string string Text characters

number double Integer or decimal numbers

boolean bool Boolean value equal to either true or false
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Assigning a Function Without a Source Node Link

About this task
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To define a mapping rule in which the input for the destination node is provided by the return value of a
function and not from a source node:

Procedure

1. Select the Functions tab. In the Functions tab, the list of available functions is displayed.  

2. In the Functions tab, expand folder that contains the function to assign to the destination node. This
function must have no input parameters. For example, the Get Current® Date and Time function has no
parameters and returns the current date and time.

3. Select the function icon and drag it into the Mapping Editors middle pane, near the destination node you
want to map.

4. In the Mapping Editor, drag from the function icon to the destination node. A link from the function to the
destination node is displayed.

5. Optional: Test if the mapping rule is valid by right-clicking on the function in the mapping rule and
selecting Apply Function Graph. If the mapping rule is valid, the square function icon in the graphical
representation of the mapping link is not displayed and a function icon is shown to the left of the
destination node icon, as shown in Figure 1.

Results

Figure 1. No source node function icon
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Assigning a Function While Creating Maps

About this task

To assign a function while creating maps:

Procedure

1. Select the Function tab. In the Function tab, the list of available functions is displayed.
2. From the Function tab, drag a function between the two nodes you want to map in the Mapping Editor.
3. Drag the source node onto the function icon to create a link. The source node is assigned to the first

parameter of the function. During run time, the value of this source node is provided as the first
parameter of the function.

4. Drag the destination node onto the function to create the link. During run time, the return value of the
function populates the destination node.
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5. If the function has more than one input parameter, you must assign the remaining input parameters
using one of the following options:

Create links from other source nodes (as described in step 3) or from functions used in the
current mapping rule.
Edit the assignment of input parameters using the Functions Properties dialog box. To open the
Functions Properties dialog box, double-click the function in the Mapping Editor.

6. Optional: Add additional functions to the mapping rule using the procedure described in the topic
Adding a Function to an Existing Mapping Rule. For an example, see Example: Chaining Multiple
Functions.

7. Optional: If any functions are still associated with the mapping rule, test if the mapping rule is valid by
right-clicking on the function in the mapping rule and selecting Apply Function Graph. If the mapping
rule is valid, the square function icon or icons in the graphical representation of the mapping link are not
displayed and a blue bar with small squares at each end is displayed ( ). If the mapping rule is
not valid, the graphical representation of the mapping rule does not change, the function icons are still

visible, (for example  ) and an error dialog opens.
Note: A mapping rule with function or functions is considered valid if all the input parameters of the
function or functions are assigned with values of the correct datatype and if the return value of the last
function matches the datatype of the destination node. The input parameters of a function can be
provided by source nodes or by the return type of other functions associated with that mapping rule.
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Adding a Function to an Existing Mapping Rule

About this task

To add a function to an existing mapping rule:

Procedure

1. Select the Function tab. In the Function tab, the list of available functions is displayed.
2. From the Function tab, drag a function onto an existing mapping rule in the Mapping Editor.

The source node of the mapping rule is assigned to the first parameter of the function. During run time,
the value of the source node is provided to the first parameter of the function.

The destination node of the mapping rule is assigned to the return type of the function. During run time,
the return value of the function populates the destination node.

3. If the function has more than one input parameter, you must assign the remaining input parameters
using one of the following options:
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Create links from other source nodes (as described in step 3 of Assigning a Function While
Creating Maps) or from functions used in the current mapping rule.
Edit the assignment of input parameters using the Functions Properties dialog box. To open the
Functions Properties dialog box double-click the function in the Mapping Editor.

4. Optional: Add additional functions to the mapping rule using this same procedure. For more information,
see Example: Chaining Multiple Functions.

5. Optional: Test if the mapping rule is valid by right-clicking on the function in the mapping rule and
selecting Apply Function Graph. If the mapping rule is valid, the square function icon or icons in the
graphical representation of the mapping link are not displayed and a blue bar with small squares at each
end is displayed ( ). If the mapping rule is not valid, the graphical representation of the

mapping rule does not change, the function icons are still visible, (for example: ) and an error
dialog opens.
Note: A mapping rule with function or functions is considered valid if all the input parameters of the
function or functions are assigned with values of the correct datatype and if the return value of the last
function matches the datatype of the destination node. The input parameters of a function can be
provided by source nodes or by the return type of other functions associated with that mapping rule.
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Example: Chaining Multiple Functions

About this task

Multiple functions can be chained together in a single mapping rule. The flow of execution of the functions in
the mapping rule is from left to right.

For example, you could build a mapping rule that uses multiple functions as described in the following
sequence:

Procedure

1. A source node of type: string is the input parameter to the trim function.
2. The trim function removes trailing and leading white space from the input parameter and the resulting

string is returned.
3. The return string of the trim function is the input parameter to the lowercase function.
4. The lowercase function converts each of the uppercase characters of the input string into their

lowercase form and the resulting string is returned.
5. The return string of the lowercase function populates the destination node of type: string.

Results
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In the Mapping Editor, this mapping rule is displayed as shown in the following figure.
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Assigning Function(s) to a Mapping Rule
Assign built-in or custom function(s) to a map to convert or manipulate the data from source node(s) before it
populates the destination node. In addition, the source data for input parameters can be provided by other
functions associated with the mapping rule.
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Deleting a Function from a Mapping Rule

About this task

To delete a function used in a mapping rule in the Mapping Editor:

Procedure

1. Display the mapping link with the functions visible. If the mapping link with function or functions has
functions associated with it but the functions are not displayed (as shown here: ), right-click
the mapping rule and from the list and select Edit Function Graph. The functions associated with the
mapping rule are displayed.

2. Choose one of the following options:
Select the function to delete and press the Delete key.
Right-click the function and select Delete Function in the list.
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Depending on your mapping rule, links between source nodes, other functions, or the destination node
might be deleted.

3. Repair any missing links in the mapping rule.
4. Optional: If any functions are still associated with the mapping rule, test if the mapping rule is valid by

right-clicking on the function in the mapping rule and selecting Apply Function Graph. If the mapping
rule is valid, the square function icon or icons in the graphical representation of the mapping link are not
displayed and a blue bar with small squares at each end displays ( ). If the mapping rule is not
valid, the graphical representation of the mapping rule does not change, the function icons are still

visible, ( ) and an error dialog opens
Note: A mapping rule with function or functions is considered valid if all the input parameters of the
function or functions are assigned with values of the correct datatype and if the return value of the last
function matches the datatype of the destination node. The input parameters of a function can be
provided by source nodes or by the return type of other functions associated with that mapping rule.
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Math Functions with Node Set Constraints
The following math functions calculate values from sets of nodes:

Average
Count
Maximum
Minimum
Sum

For example, the Sum function calculates the total value of all ItemPrice nodes when ItemPrice is a recurring
source node.

You can use several node sets as parameters with these functions, including single nodes. You can also use
literal numbers or the results of other math functions as parameters for functions that accept node sets.

Limitations in Combining Other Math Functions or Literals

When using numbers or other functions to supply node set parameters, some math functions use the first
occurrence of a node set in calculations. In a mapping rule, if you link functions that work with only one node of
the set as a parameter to another function that works with the full node set, the final result will not include
values from the full node set.

For example, the Multiply function is linked with the Sum function in a mapping rule and so during run time, the
result of the Multiply function becomes the input to the Sum function.  If the input to the Multiply function is a
recurring item structure, the Multiply function multiples the UnitPrice with the Quantity and then passes the
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result to the Sum function. The result from Sum function would be the product of the first UnitPrice and
Quantity – not the total extended price for all items.

Note: The Count function accepts any source node as a parameter, including structure or choice nodes which
you usually cannot map.
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Adding a Parameter

About this task

You can only add parameters if required parameters are missing or if the maximum number of optional
parameters has not been filled.

To add a parameter:

Procedure

1. Click Add from the Function Parameters dialog box.
2. Enter a value for that parameter in the Value cell.
3. Click OK.

Note: Some functions can only accept source nodes as parameters. For more information, see Math
Functions with Node Set Constraints.
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Editing a Parameter

About this task
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To edit a parameter:

Procedure

1. Open the Function Parameters dialog box for the function to be edited.
2. Click the cell containing the value you want to change. Alternatively, click one of the buttons in the dialog

box to add, delete, or reorder the selected parameter.
3. When finished editing, click OK to save changes and close the dialog box.
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Deleting a Parameter

About this task

To delete a parameter:

Procedure

1. Open the Function Parameters dialog box for the function to be edited.
2. Select the optional parameter you want to delete from the parameter list.
3. Click Delete.

Parent topic: Using Custom Functions and Lookup Tables

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/map_adding_function_properties_delet
e.html

Reordering Parameters

About this task

To change the order of a parameter in the Parameters list:
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Procedure

1. Select the parameter from within the Function Parameters dialog box.
2. Click Up to move the parameter up the list; click Down to move the parameter down the list.
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Specifying Default Values for Functions that Accept Recurring
Nodes as Input

About this task

The following math functions calculate values from sets of nodes:

Average
Count
Maximum
Minimum
Sum

You cannot specify a default value (or constant) for the input parameters of these functions in their Functions
Properties dialog box. To specify default values for the input parameters of these functions, complete these
steps:

Procedure

1. Create a variable with the same data type as the input parameter for the function.
2. In the "Properties of" pane of the Variables tab, enter the constant value in the Default Value field for the

variable
3. In the From Orchestration pane of the activity, add the variable that has the default value.
4. Map the variable to the input parameter of the function.
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Mapping Function Reference
Mapping functions overview
There are seven mapping function types: String, Mathematical, HTTP Header, Miscellaneous, Binary
Data, Date, and Security functions.
Mapping Function Syntax and Datatypes
Use the Mapping Function to describe the purpose of the function, set valid input parameters and
syntax, and set what the function returns.
Absolute Value function
The Absolute Value function determines the absolute value of the parameter.
Add function
The Add function adds all the parameters.
AES Decrypt function
The AES Decrypt function decrypts fields and content using the Advanced Encryption Standard (AES)
algorithm with 128 bit strength. 128-bit encryption level requires an 8-byte key, which must be a 32-
character hexadecimal string.
AES Encrypt function
The AES Encrypt function encrypts fields and content using the Advanced Encryption Standard (AES)
algorithm with 128 bit strength. 128-bit encryption level requires an 8-byte key, which must be a 32-
character hexadecimal string.
Align Center function
The Align Center function centers a string within a padding string. If the padding for both sides is
uneven, the lesser amount of padding is placed on the left.
Align Left function
The Align Left function places a string within a padding string starting from the left-most character.
Align Right function
The Align Right function places a string within a padding string ending at the right-most character.
Average function
The Average function determines the average value for the sets of numeric nodes in all parameters.
Base64 Encode and Decode functions
Base64 refers to a specific MIME content transfer encoding. Base64 encoding represents arbitrary
sequences of octets in a form that requires case sensitivity but need not be humanly readable.
Boolean function
The Boolean function evaluates the parameter and returns either ‘true' or ‘false' depending on the
datatype of the input:
Ceiling function
The Ceiling function rounds the parameter up to the next closest integer.
Concatenate function
The Concatenate function joins all parameter strings into a single result in the order you specify the
parameters.
Cast From Base64Binary function
The Cast From Base64Binary function casts from one specific XML Schema data type to another XML
Schema data type.
Casts From HexBinary function
The Casts From HexBinary function casts from one specific XML Schema data type to another XML
Schema data type.
Cast To Base64Binary function
The Cast To Base64Binary function casts from one specific XML Schema data type to another XML
Schema data type.
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Cast To HexBinary function
The Cast To HexBinary function casts from one specific XML Schema data type to another XML Schema
data type.
CopyOf function
The CopyOf function copies the entire contents of the source node to the destination node.
Count Function
The Count function determines the number of nodes in all of the sets of nodes in parameters.
Decode Configuration Property of Type Password
The Decode Configuration Property of type Password decodes base64-encoded passwords between
two orchestrations.
Digest/Hash function
The Digest/Hash function produces a digital summary of information called a message digest. Message
digests provide a digital identifier for a digital document. The message digest produced by the
Digest/Hash function is Base64 encoded.
Divide function
The Divide function returns the decimal quotient of the first parameter divided by all subsequent
parameters.
Extract HTTP Header Field function
The Extract HTTP Header Field function extracts a string with a specified delimiter. It can be used to
further extract strings from HTTP headers.
Extract Query Parameter function
The Extract Query Parameter function extracts a query string from the HTTP header's URI string.
Extract URI Path function
The Extract URI Path function extracts a URI from the HTTP header's URI string.
Floor function
The Floor function rounds the parameter down to the next closest integer.
Format Date String function
The Format Date String function converts the XML Schema data type: xs:dateTime to a string in the
format defined by the second parameter.
Format Number function
The Format Number function returns a string that is a number formatted to fit the specified pattern.
Generate RFC2104 HMAC Compliant Signature
HMAC is a mechanism for message authentication using cryptographic hash functions.
Get Current Date and Time function
The Get Current® Date and Time function returns the current date and time as a specific XML Schema
data type.
Get Current Date function
The Get Current Date function returns the current date (with the local timezone) as a XML Schema data
type: xs:date.
Get Current Time function
The Get Current Time function returns the current time (with the local timezone) as a XML Schema data
type: xs:time
Length function
The Length function determines the number of character in the parameter.
Lowercase function
The Lowercase function converts all uppercase characters to lowercase characters.
Maximum function
The Maximum function determines the highest value in the nodes, sets of numeric nodes, or numbers in
parameters.
Minimum function
The Minimum function determines the lowest value in the nodes, sets of numeric nodes, or numbers in
parameters.
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Modulo function
The Modulo function determines the remainder from dividing the first parameter by all subsequent
parameters.
Multiply function
The Multiply function returns the product of all parameters.
Not function
The Not function is typically used in conditions to specify negative or complimentary conditions.
Number function
The Number function changes the datatype of the parameter to number.
Padding String function
The Padding String function returns a padding string of the specified length and characters. Padding
strings are used in alignment functions.
Position function
The Position function is used with conditions to represent the index to the current node within the set of
its siblings. The function works only within the context of a recurring node and has no parameters.
Read Date String function
The Read Date String function converts a string (that contains a date and time) to the XML Schema data
type: xs:dateTime.
Replace function
The Replace function replaces individual characters with other individual characters.
Replace String function
The Replace String function replaces individual characters or a string with other individual characters or
string.
Round function
The Round function rounds a number to the closest integer.
Starts With function
The Starts With function determines whether or not the first parameter begins with the characters in
the second parameter.
String function
The String function changes the datatype of the parameter to string.
Substring function
The Substring function extracts a portion of the parameter based on the specified character placement.
Substring After function
The Substring After function extracts all the characters in a string starting after the first occurrence of a
specified substring (one or more characters) through the end of the string.
Substring Before function
The Substring Before function extracts all the characters in a string starting at the beginning up to the
first occurrence of a specified substring (one or more characters).
Subtract function
The Subtract function returns the difference of the first parameter less all subsequent parameters.
Sum function
The Sum function determines the sum of values in the numeric node, sets of numeric nodes, or numbers
in parameters.
Trim function
The Trim function trims all leading and trailing spaces and replaces continuous sets of white space
characters by a single space.
Uppercase function
The Uppercase function converts all lowercase characters to the corresponding uppercase character.

Feedback | Notices
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Mapping functions overview
There are seven mapping function types: String, Mathematical, HTTP Header, Miscellaneous, Binary Data, Date,
and Security functions.

The mapping functions can be displayed by clicking the Functions tab. Mapping functions are divided into the
following categories:

String
Mathematical
HTTP Header
Miscellaneous
Binary Data
Date
Security

String
functions Definition

Align
Center

Centers a string within the specified padding string.

Align Left Places a string inside a padding string starting from the leftmost character.

Align
Right

Places a string inside a padding string ending with the rightmost character.

Concaten
ate

Joins all the parameter strings into a single string.

Format
Number

Returns a string that is a number formatted to fit the specified pattern.

Length Determines the number of characters in the parameter.

Lowercas
e

Converts all uppercase English characters to lowercase characters.

Padding
String

Returns a padding string of the specified length and characters.

Replace Replaces individual characters with other individual characters.

Starts
With

Determines whether the first parameter begins with the characters in the second parameter.

Substring Extracts a portion of the parameter that is based on the specified character placement.

Substring
After

Extracts all the characters in a string starting after the first occurrence of a specified substring
(one or more characters) through the end of the string.

Substring
Before

Extracts all the characters in a string from the beginning to the first occurrence of a specified
substring (one or more characters).
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String
functions Definition

Trim Trims all leading and trailing space from the parameter and normalizes all space within the
parameter.

Uppercas
e

Converts all lowercase English characters to the corresponding uppercase character.

Mathematical
functions Description

Absolute Value Determines the absolute value of a parameter.

Add Adds all parameters.

Average Determines the average value of the numeric nodes or sets of nodes in parameters.

Ceiling Rounds the parameter up to the next closest integer.

Count Counts the number of nodes in all the nodes or sets of nodes in parameters.

Divide Returns the quotient of the first parameter that is divided by all the subsequent
parameters.

Floor   Rounds the parameter down to the next closest integer.

Maximum   Determines the highest value in the numeric nodes or sets of nodes in parameters.

Minimum Determines the lowest value in the numeric nodes or sets of nodes in parameters.

Modulo Determines the remainder from dividing the first parameter by all subsequent
parameters.

Multiply Returns the product of all parameters.

Round Rounds a number to the closest integer.

Subtract   Returns the difference of the first parameter less all subsequent parameters.

Sum Adds all the numeric nodes or sets of node in parameters.

HTTP Header functions Description

Extract HTTP Header
Field function

Extracts a string with a specified delimiter. It can also be used to further extract
strings from HTTP headers.

Extract URI Path function Extracts a URI from the HTTP header's URI string.

Extract Query Parameter
function

Extracts a query string from the HTTP header's URI string.

Miscellan
eous
functions Description

Boolean Evaluates the parameter and returns either true or false depending on the data type of the input.

CopyOf When the name of the source node matches the passed in value, this function copies the entire
contents of the source node (the entire subtree of the source node including all children) to the
destination node.

Not Returns true if the parameter evaluates as false. Returns false if the parameter evaluates as true.

Number Changes the data type of the parameter to number.
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Miscellan
eous
functions Description

Position
oh

Determines the index to the current node within the set of its siblings.

String Changes the data type of the parameter to string.

Functions for Binary Data Description

Cast From Base64Binary
function

Casts from the XML schema data type: xs:base64Binary to the XML schema data
type: xs:string.  

Cast From HexBinary
function

Casts from the XML schema data type: xs:hexBinary to the XML schema data
type: xs:string.

Cast To Base64Binary
function

Casts from the XML schema data type: xs:string to the XML schema data type:
xs:base64Binary.

Cast To HexBinary
function

Casts from the XML schema data type: xs:string to the XML schema data type:
xs:hexBinary.

Date functions Description

Get Current® Date and
Time function

Returns the current date and time (with the local timezone) as an XML schema
data type: xs:dateTime.

Get Current Date function Returns the current date (with the local timezone) as an XML schema data type:
xs:date.

Get Current Time
function

Returns the current time (with the local timezone) as an XML schema data type:
xs:time.

Read Date String function Converts a string (that contains a date and time) to the XML schema data type:
xs:dateTime

Format Date String
function

Converts an XML schema data type: xs:dateTime to a string in the format that is
defined by the second parameter.

Security functions Description

AES Encrypt
function

Encrypts the fields and content using the Advanced Encryption Standard (AES)
algorithm.

AES Decrypt
function

Decrypts the fields and content using the Advanced Encryption Standard (AES)
algorithm.
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Mapping Function Syntax and Datatypes
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Use the Mapping Function to describe the purpose of the function, set valid input parameters and syntax, and
set what the function returns.

Mapping function topic descriptions include the following:

A brief description of the purpose of the function.
Valid input parameters. Parameters are listed in order as the order is significant for most functions. The
following syntax is used with parameters:

datatypen – where n indicates an order if several parameters of the same type are allowed

[datatype] – where [ ] indicates that the parameter is optional.

What the function returns.

Mapping functions can process the following datatypes:

anysimpletype
Any type of data is allowed including numbers, strings, dates, or boolean.

boolean
Either true or false.

date
A string representing a date in the format YYYY-MM-DD (see datetime for the component descriptions).

datetime
A string representing a date and time in the format:YYYY-MM-DDThh:mm:ss.ssss
Where:

YYYY = year
MM = month
DD = day
T = date/time separator character
hh = hour
mm = minute
ss = second
ssss = optional millisecond

day
A string representing the day portion of a date in the format: DD

dt
Several different date or time datatypes can be supplied. See the description of the parameter for a list
of the datatypes that are valid.

duration
A string representing a time interval in the form [-]PnYnMnDTnHnMnS:

[-] = an optional minus sign
P = period indicator
nY = the number of years
nM = the number of months
nD = the number of days
T = date/time separator
nH = the number of hours
nM = the number of minutes
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nS = the number of seconds

empty string
A string with no contents (for example, ''). This is typically returned for error conditions when the result
is normally a string.

month
A string representing the month portion of a date in the format: MM

monthday
A string representing the month and day portion of a date in the format: MM-DD

nodeset
A set of nodes within the schema. Node sets are identified by a specific path to a node or structure in the
schema. Node sets are used in certain math functions. The datatype of the nodes within the set should
be number.

number
Any integer or decimal number including:

positive and negative zero
positive and negative infinity
NaN (This is a value indicating that the result is not a number.)

string
Text characters within the character encoding of the message

time
A string representing a time of day in the format:

hh:mm:ss.sss[-time-zone-indicator]

See datetime for the component descriptions.

tm
Several different time datatypes can be supplied. See the description of the parameter for a list of the
datatypes that are valid.

year
A string representing the year portion of a date in the format: YYYY

yearmonth
A string representing the year and month portion of a date in the format: YYYY-MM
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Absolute Value function
The Absolute Value function determines the absolute value of the parameter.

Parameter: number

The number for which an absolute value is determined. This can be a source node, the result of another
function, or a value you specify.

Returns: number

The absolute value of the parameter.

 Example:

10 is the result for both 10 and -10.
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Add function
The Add function adds all the parameters.

Parameter: number1, [number2 - 1000]

Each parameter can be a source node, the result of another function, or a value you specify. At least one
parameter is required.

Returns: number

The sum of all parameters.
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The AES Decrypt function decrypts fields and content using the Advanced Encryption Standard (AES)
algorithm with 128 bit strength. 128-bit encryption level requires an 8-byte key, which must be a 32-character
hexadecimal string.

Parameter: data, key

Data that is passed as the encrypted content is decrypted to the original content using the AES key.

Returns: string

The decrypted content is returned and stored as a string.
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AES Encrypt function
The AES Encrypt function encrypts fields and content using the Advanced Encryption Standard (AES) algorithm
with 128 bit strength. 128-bit encryption level requires an 8-byte key, which must be a 32-character
hexadecimal string.

Parameter: data, key

Data that is passed as the input is encrypted using the AES key.

Returns: string

The encrypted content is returned and stored as a string.
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Align Center function
The Align Center function centers a string within a padding string. If the padding for both sides is uneven, the
lesser amount of padding is placed on the left.
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Parameter: string1

The string to be aligned. This can come from a source node, the result of another function, or a value you
specify.

Parameter: string2

A padding string. This string must be long enough to create a result and must contain the character or
characters to use for padding. This can come from a source node, the result of another function, or a value that
you specify. You can use the Padding String function to produce a padding string.

Returns: string

The padded and centered string.

Example:

align-center(‘widgets','----------') = '-widgets--'
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Align Left function
The Align Left function places a string within a padding string starting from the left-most character.

Parameter: string1

The string to be aligned. This can come from a source node, the result of another function, or a value you
specify.

Parameter: string2

A padding string. This string must be long enough to create a result and must contain the character or
characters to use for padding. This can come from a source node, the result of another function, or a value that
you specify. You can use the Padding String function to produce a padding string.

Returns: string

The padded and left-aligned string.

Example: align-left(‘widgets','----------') = 'widgets---'

Example:

align-center(‘widgets','----------') = '-widgets--'

Parent topic: Mapping Function Reference
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Align Right function
The Align Right function places a string within a padding string ending at the right-most character.

Parameter: string1

The string to be aligned. This can come from a source node, the result of another function, or a value you
specify.

Parameter: string2

A padding string. This string must be long enough to create the result and must contain the character or
characters to use for padding. This can come from a source node, the result of another function, or a value that
you specify. You can use the Padding String function to produce a padding string.

Example:

align-center(‘widgets','----------') = '-widgets--'
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Average function
The Average function determines the average value for the sets of numeric nodes in all parameters.

If you use literal numbers or the results of other functions as parameters to this function, the numbers are
added to the total. They are also counted as nodes to determine the average.

Parameter: input, input...

The numeric nodes to calculate an average from. These can come from recurring or nonrecurring source nodes,
the results of other functions, or values that you specify.
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You cannot specify a default value (or constant) for the input parameters of this function but you can specify a
variable with a default value and then pass that variable as an input parameter to this function.  For more
information, see Specifying Default Values for Functions that Allow Recurring Nodes as Input.   
Attention: In the Mapping Editor, if you chain together a recurring source node, a function that does not support
recurring nodes, and then map that result to this function, during run time you may get an unexpected result.
 For more information, see Limitations in Combining Other Math Functions or Literals.

Returns: number

The average value of all parameters. This returns NaN (not a number) in the following cases:

If any parameters are not numeric nodes.
If both the sum of all values and the count of node sets are zero (the average of 0 / 0).
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Base64 Encode and Decode functions
Base64 refers to a specific MIME content transfer encoding. Base64 encoding represents arbitrary sequences
of octets in a form that requires case sensitivity but need not be humanly readable.

A 65-character subset of US-ASCII is used, enabling 6 bits to be represented per printable character. The 65th
character, "=", is used to signify a special processing function.

The encoding process represents 24-bit groups of input bits as output strings of 4 encoded characters.
Proceeding from left to right, a 24-bit input group is formed by concatenating 3 8-bit input groups. These 24
bits are then treated as 4 concatenated 6-bit groups, each of which is translated into a single digit in the base
64 alphabet.

Each 6-bit group is used as an index into an array of 64 printable characters. The character referenced by the
index is placed in the output string.

Base64 Alphabet

Value Encoding  Value Encoding  Value Encoding  Value Encoding 
          0 A            17 R            34 i            51 z 
          1 B            18 S            35 j            52 0 
          2 C            19 T            36 k            53 1 
          3 D            20 U            37 l            54 2 
          4 E            21 V            38 m            55 3 
          5 F            22 W            39 n            56 4 
          6 G            23 X            40 o            57 5 
          7 H            24 Y            41 p            58 6 
          8 I            25 Z            42 q            59 7 
          9 J            26 a            43 r            60 8 
         10 K            27 b            44 s            61 9 
         11 L            28 c            45 t            62 + 
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         12 M            29 d            46 u            63 / 
         13 N            30 e            47 v 
         14 O            31 f            48 w         (pad) = 
         15 P            32 g            49 x 
         16 Q            33 h            50 y

Special processing is performed if fewer than 24 bits are available at the end of the data being encoded. A full
encoding quantum is always completed at the end of a quantity. When fewer than 24 input bits are available in
an input group, zero bits are added (on the right) to form an integral number of 6-bit groups. Padding at the end
of the data is performed using the '=' character. Since all base 64 input is an integral number of octets, only the
following cases can arise:

The final quantum of encoding input is an integral multiple of 24 bits; here, the final unit of encoded
output will be an integral multiple of 4 characters with no "=" padding,
The final quantum of encoding input is exactly 8 bits; here, the final unit of encoded output will be two
characters followed by two "=" padding characters.
The final quantum of encoding input is exactly 16 bits; here, the final unit of encoded output will be
three characters followed by one "=" padding character.
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Boolean function
The Boolean function evaluates the parameter and returns either ‘true' or ‘false' depending on the datatype of
the input:

string – true unless the string is empty
number – true if the number is not zero, false if the number is zero

Parameter: anysimpletype

The value to be evaluated. This can come from a source node, the result of another function, or a value that you
specify.

Returns: boolean

Either true or false.
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Ceiling function
The Ceiling function rounds the parameter up to the next closest integer.

Parameter: number

The number to round up to an integer. This can come from a source node, the result of another function, or a
value that you specify.

Returns: number

The closest integer that is greater than the parameter.

Example:

ceiling(4.2) = 5
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Concatenate function
The Concatenate function joins all parameter strings into a single result in the order you specify the
parameters.

Parameters: string1, string2, [string3-string1000]

Each parameter can be a source node, the result of another function, or a value that you specify. The order of
the parameters determines the order in which the parameters are joined (that is, the first parameter displays
as left-most in the resulting string).

Note: You must specify at least two parameters in order for the function to be valid. While configuring the
properties of the Concatenate function in the Function Properties dialog box, you cannot click Delete for the
top two parameters in the list. (The Delete button is not active for the top two parameters.) You can only click
Delete, if there are more than two parameters in the list and only for the parameters at the bottom of the list.
To delete a parameter from the top two positions of the list, first move the parameter down the list clicking
Down and then click Delete.

Returns: string

The joined strings.
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Cast From Base64Binary function
The Cast From Base64Binary function casts from one specific XML Schema data type to another XML Schema
data type.

About this task

Casts from the XML Schema data type: xs:base64Binary to the XML Schema data type: xs:string. The data is
not converted, only the type associated with the data is changed.

Parameter: base64Binary

The data to cast from the XML Schema data type: xs:base64Binary.

Returns: string

The data that has been cast to the XML Schema data type xs:string.
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Casts From HexBinary function
The Casts From HexBinary function casts from one specific XML Schema data type to another XML Schema
data type.

About this task

Casts from the XML Schema data type: xs:hexBinary to the XML Schema data type: xs:string. The data is not
converted, only the type associated with the data is changed.

Parameter: HexBinary
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The data to cast from the XML Schema data type: xs:hexBinary

Returns: string

The data that has been cast to the XML Schema data type: xs:string.
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Cast To Base64Binary function
The Cast To Base64Binary function casts from one specific XML Schema data type to another XML Schema
data type.

About this task

Casts from the XML Schema data type xs:string to the XML Schema data type: xs:base64Binary. The data is not
converted, only the type associated with the data is changed.

Parameter: string

The data to cast from the XML Schema data type: xs:string.

Returns: base64Binary

The data that has been cast to the XML Schema data type: xs:base64Binary.
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Cast To HexBinary function
The Cast To HexBinary function casts from one specific XML Schema data type to another XML Schema data
type.
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About this task

Casts from the XML Schema data type: xs:string to the XML Schema data type: xs:hexBinary. The data is not
converted, only the type associated with the data is changed.

Parameter: string

The data to cast from the XML Schema data type: xs:string.

Returns: hexBinary

The data that has been cast to the XML Schema data type: xs:hexBinary.
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CopyOf function
The CopyOf function copies the entire contents of the source node to the destination node.

The CopyOf function (  ) copies the entire contents of the source node (the entire subtree of the source node
including all children) to the destination node.

Attention: The XML Schema of the destination node must match the XML Schema of the source node for the
CopyOf function to correctly copy the values of the source nodes to the destination nodes.
For example, if the Call Procedure activity returns the following result set nodes (through the any node) during
run time:

results/result/resultSet/column1, where column1 is an integer.
results/result/resultSet/column2, where column2 is an integer.

The XML Schema of the destination nodes in the To Orchestration pane, must match the expected XML Schema
of the result set that is returned from the Call Procedure activity, as shown in the following figure:
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In the preceding figure, the CopyOf function (  ) is linking the source result node and the destination result
node.

Parameter: input

The name of the source nodes to copy.   

Returns: anySimpleType

The resulting subtree of XML data.
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Count Function
The Count function determines the number of nodes in all of the sets of nodes in parameters.

For recurring nodes, this function determines the actual number of occurrences.

This function accepts any source node as a parameter. This includes structure or choice nodes which you
normally cannot map.

If you use literal numbers as parameters in this function, the numbers are considered one node and
incremented by a count of one.

Parameter: input, input...

The sets of nodes to count. These can come from recurring or nonrecurring source nodes, the results of other
functions, or values that you specify.

You cannot specify a default value (or constant) for the input parameters of this function but you can specify a
variable with a default value and then pass that variable as an input parameter to this function.  For more
information see Specifying Default Values for Functions that Allow Recurring Nodes as Input.   

Attention: In the Mapping Editor, if you chain together a recurring source node, a function that does not support
recurring nodes, and then map that result to this function, during run time you might get an unexpected result.
 For more information see Limitations in Combining Other Math Functions or Literals.

Returns: number

The total number of nodes in the parameters.

Parent topic: Mapping Function Reference
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Decode Configuration Property of Type Password
The Decode Configuration Property of type Password decodes base64-encoded passwords between two
orchestrations.

The calling orchestration sends a user ID and a password. The decode password configuration property
ensures that the receiving orchestration receives a base64-encoded password which it can decode.
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Digest/Hash function
The Digest/Hash function produces a digital summary of information called a message digest. Message digests
provide a digital identifier for a digital document. The message digest produced by the Digest/Hash function is
Base64 encoded.

Message digest functions are mathematical functions that process information to produce a message digest for
each unique document. Identical documents have the same message digest, which can be used to ensure that
the message received is the same as the message sent.

There are three Digest/Hash functions in Studio:

Digest/Hash the Input Data with MD5
Digest/Hash the Input Data with SHA-1
Digest/Hash the Input Data with SHA-256

The input is the document or string for which you want a digest. For example, MD5 ("Austin was happy that the
band played on") =NjJhODJhNTViZmI3Y2YwZDc2NDkxYjc0ZTkzZDlmMTQ=

MD5 is defined in RFC 1321. IBM® Cast Iron® uses the MD5 algorithm included in the JDK security package.
The algorithm takes a message of undefined length and outputs a message digest of 128 bits.

SHA-1 is defined by the Federal Information Processing Standards Publication 180-1 (FIPS PUB 180-1). IBM
Cast Iron uses the SHA-1 algorithm included in the JDK security package. SHA-1 takes an input message of any
length less than 264 bits and produces a message digest of 160-bits.
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SHA-256 is a 256-bit hash function and is compliant with the National Institute of Standards SP 800-131a
specification. IBM Cast Iron uses the SHA-256 algorithm included in the JDK security package. The input is the
document or string for which you want a digest. For example, SHA-56 ("Sample Input")
=bEzV+7Tz6afzJhY0E5u0Zt1+9uBURb/2pgi2PT9Ms/s=. The hash value is 32 bytes or 256 bits length.

Use Digest/Hash the Input Data with MD5 function to create a Base64 encoded digest of the input data using
MD5.

Use the Digest/Hash the Input Data with SHA-1 function to create a Base64 encoded digest of the input data
using SHA-1.

Use the Digest/Hash the Input Data with SHA-256 function to create a Base64 encoded digest of the input
data using SHA-256.
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Divide function
The Divide function returns the decimal quotient of the first parameter divided by all subsequent parameters.

Parameter: number1

The number to be divided (dividend). This can be a source node, the result of another function, or a value that
you specify.

Parameter: number2, [number3-999]

The numbers to divide by (divisor). These can be source nodes, the results of other functions, or values that
you specify. At least one parameter is required.

Returns: number

The result of the division operation. If the divisor is zero (positive or negative), the result is infinity (positive or
negative), or NaN (not a number) if the dividend is also zero.
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Extract HTTP Header Field function
The Extract HTTP Header Field function extracts a string with a specified delimiter. It can be used to further
extract strings from HTTP headers.

Input1 – Header string, for example: text/html; char-set=UTF-8 or text/*;q=0.3, text/html;q=0.7,
text/html;level=1

Input2 – A string that specifies the name value, for example: char-set

Input3 – Specified delimiter, for example: ";" or ","

Output – The value string. For example: UTF-8 when char-set is extracted from Content-Type header.
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Extract Query Parameter function
The Extract Query Parameter function extracts a query string from the HTTP header's URI string.

Input1 – HTTP header's URI string, for example: URI?name1=value1&name2=value2....#anchor. The
characters after ? or # may not be present.

Input2 – A string that specifies the query string's name, for example: name1 in the input1 string.

Output – The query string's string value, for example: value1 in the input1 string.
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Extract URI Path function
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The Extract URI Path function extracts a URI from the HTTP header's URI string.

Input – HTTP header URI string, for example: URI?name1=value1&name2=value2....#fragment. The characters
after ? or # may not be present. fragment is not part of the HTTP request and is only used by the Web browser
client.
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Floor function
The Floor function rounds the parameter down to the next closest integer.

Parameter: number

The number to round down to an integer. This can come from a source node, the result of another function or a
value that you specify.

Returns: number

The closest integer that is less than the parameter.

Example:

floor(4.7) = 4
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Format Date String function
The Format Date String function converts the XML Schema data type: xs:dateTime to a string in the format
defined by the second parameter.

Parameter: dateTime

The date and time as a XML Schema data type: xs:dateTime.
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Parameter: string

This string defines the format of the date and time string returned from this function. For example, the format
string could be equal to MM/dd/yyyy. For more information about the supported date and time pattern strings
see the SimpleDataFormat class in the Sun J2SE 1.4.2 JavaDoc:
http://www.science.uva.nl/ict/ossdocs/java/jdk1.3/docs/api/java/text/SimpleDateFormat.html.

Pattern Letter Description Example1 Example2

G Era  designation AD BC

y Year 2004 2001

M Month in a year April 04

w Week in a year 12 24

W Week in a month 3 1

D Day in a year 234 333

d Day in a month 13 20

F Day of week in a month 1 3

E Day in a week Monday Friday

a AM or PM designation AM PM

H Hour in a day - a number between 0 and 23 12 13

k Hour in a day - a number between 1 and 24 14 23

K Hour in AM or PM - a number between 0 and 11 0 10

h Hour in AM or PM - a number between 1 and 12 11 12

m Minute in an hour 20 50

s Second in a minute 10 30

S Milliseconds 224 338

z Time zone in General time zone designation PDT EDT

Z Time zone in ISO-8601 time zone designation -03:00 +02:00

Parameter: string  (Optional)

This string defines the locale. For example, the English United States locale is defined with the following string:
en_US.

The locale string can be defined by any of the following formats:

LANGUAGE
LANGUAGE_COUNTRY
LANGUAGE_COUNTRY_VARIANT

Where LANGUAGE represents a two letter code as defined by the ISO-639 standard, COUNTRY represents a
two letter code defined by the ISO-3166, and VARIANT represents a vendor or browser-specific code, for
example WIN for Windows.

This parameter is optional.

To add this parameter:
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1. Drop the Format Date String function into the middle pane of the Mapping Editor.
2. Double-click the function. The Function Properties pane opens.
3. Click Add. The Locale input parameter shows in the list of parameters.

Returns: string

The passed in date and time as a string in the format defined by the second parameter.

For example, if the Format Date String function was called with the following input parameters:

dateTime: 2005-02-22T16:18:00.852-08:00

format string: MM/dd/yyyy

locale string: en_US

The following string would be returned: 02/22/2005.
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Format Number function
The Format Number function returns a string that is a number formatted to fit the specified pattern.

Parameter: number

The number to format. This can come from a source node, the result of another function, or a value that you
specify.

Parameter: string

A pattern that specifies how the first parameter should be formatted. This pattern uses these symbols to define
the pattern:

Required digits = 0
Optional digits = #
Minus symbol = -
Decimal symbol = .
Grouping separator = ,.Typically used to separate groups of three digits.
Percent symbol = %. When the percent symbol is present, the input number is multiplied by 100 and the
result is shown as a percentage.
Per mille symbol =  (Unicode x2030). This symbol multiplies the number by 1000 and shows the result
as a per mille.
Positive/negative separator = ;
Infinity = infinity
Not a number = NaN
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$ = $

Patterns can have constant text as a prefix, suffix, or both. Common uses are to specify the currency symbol or
some unit of measurement.

$#,##0.00 – formats a number in the standard format for United States dollars with the dollar sign,
commas for separators and at least one dollar digit and two digits for cents.
#0.000% – formats a decimal number as a percentage with at least three decimal places.
#,##0.00;(#,##0.00) – formats negative number with parentheses, a format commonly used in
accounting.

Returns: string

The first parameter reformatted to reflect the pattern specified by the second parameter.

Examples

Patterns can have constant text as a prefix, suffix, or both. Common uses are to specify the currency symbol or
some unit of measurement.  

Example 1

$#,##0.00 – formats a number in the standard format for United States dollars with the dollar sign, commas
for separators and at least one dollar digit and two digits for cents.

format-number(12345.6789,'$#,##0.00') = '$12,345.67'
Example 2

#0.000% – formats a decimal number as a percentage with at least three decimal places.

format-number(.67890123,'#0.000%') = '67.890%'

When the percent symbol is present, the input number is multiplied by 100.

Example 3

#,##0.00;(#,##0.00) – formats negative number with parentheses, a format commonly used in accounting.

format-number(-12345.6789,'#,##0.00;(#,##0.00)') = '(12,345.67)'
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Generate RFC2104 HMAC Compliant Signature
HMAC is a mechanism for message authentication using cryptographic hash functions.

This HMAC function uses the iterative cryptographic hash function SHA-1 with a secret shared key.
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Use this function to generate a digital signature that is compliant with HMAC.

Parameter: data (type=string)

The information or message to be validated.

Parameter: key (type=string)

The key used to validate the data.

Parameter: encoding (type=string)

The encoding to apply to the data and key. This can be one of:

US-ASCII - Seven-bit ASCII. Also called ISO646-US. The Basic Latin block of the Unicode character set.
ISO-8859-1 - ISO Latin Alphabet No. 1. Also called ISO-LATIN-1.
UTF-8 - Eight-bit UCS Transformation Format.
UTF-16BE - Sixteen-bit UCS Transformation Format, big-endian byte order.
UTF-16LE - Sixteen-bit UCS Transformation Format, little-endian byte order.
UTF-16 - Sixteen-bit UCS Transformation Format, byte order identified by an optional byte-order mark.

Returns: HMAC signature (type string)

The generated HMAC signature in UTF-8 encoding.
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Get Current Date and Time function
The Get Current® Date and Time function returns the current date and time as a specific XML Schema data
type.

About this task

The Get Current Date and Time function returns the current date and time (with the local timezone) as an XML
Schema data type: xs:dateTime.

Parameter: none

Returns: dateTime

The current date and time as the XML Schema data type: xs:dateTime. For example, if this function is run on
February 22, 2005, at 12:43 PM in the PST timezone (- 08:00) this function returns the following dateTime:

2005-02-22T12:43:51-08:00
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Note: If this function is called twice in a map, it is not guaranteed that the same dateTime is returned. This
function is not stable as defined by the W3C.
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Get Current Date function
The Get Current® Date function returns the current date (with the local timezone) as a XML Schema data type:
xs:date.

About this task

Parameter:  none

Returns: date

The current date as the XML Schema data type: xs:date. For example, if this function is run on February 22,
2005 in the PST timezone (- 08:00) this function returns the following date:

2005-02-22-08:00
Note: If this function is called twice in a map, it is not guaranteed that the same date is returned. This function
is not stable as defined by the W3C.
Parent topic: Mapping Function Reference

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/Get_Current_Date_function.html

Get Current Time function
The Get Current® Time function returns the current time (with the local timezone) as a XML Schema data type:
xs:time

About this task

Parameter:  none
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Returns: time

The current time as the XML Schema data type: xs:time. For example, if this function is run at 12:43 PM in the
PST timezone (-08:00) this function returns the following time:

12:43:51-08:00
Note: If this function is called twice in a map, it is not guaranteed that the same time is returned. This function
is not stable as defined by the W3C.
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Length function
The Length function determines the number of character in the parameter.

Returns: number

The number of characters in the parameter.

Parameter: string

The string to count. This can come from a source node, the result of another function, or a value you specify.

Example
length('The string to count') = 19
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Lowercase function
The Lowercase function converts all uppercase characters to lowercase characters.

Parameter: string

The string to convert. This can come from a source node, the result of another function, or a value you specify.
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Returns: string

The converted string.
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Maximum function
The Maximum function determines the highest value in the nodes, sets of numeric nodes, or numbers in
parameters.

Parameter: input, input ...

The numeric nodes to compare. These can come from recurring or nonrecurring source nodes, the results of
other functions, or values that you specify.

You cannot specify a default value (or constant) for the input parameters of this function but you can specify a
variable with a default value and then pass that variable as an input parameter to this function.  For more
information see Specifying Default Values for Functions that Allow Recurring Nodes as Input.

Attention: In the Mapping Editor, if you chain together a recurring source node, a function that does not support
recurring nodes, and then map that result to this function, during run time you might get an unexpected result.
 For more information see Limitations in Combining Other Math Functions or Literals.

Returns: number

The maximum value of all nodes in the parameters. For recurring nodes, values for every occurrence in the
recurring set is used to find the maximum. If any parameter is not a set of numeric nodes or is an empty node
set, the function returns NaN (not a number).
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Minimum function
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The Minimum function determines the lowest value in the nodes, sets of numeric nodes, or numbers in
parameters.

Parameter: input, input ...

The numeric nodes to compare. These can come from recurring or nonrecurring source nodes, the results of
other functions, or values that you specify.

You cannot specify a default value (or constant) for the input parameters of this function but you can specify a
variable with a default value and then pass that variable as an input parameter to this function.  For more
information see Specifying Default Values for Functions that Allow Recurring Nodes as Input.

Attention: In the Mapping Editor, if you chain together a recurring source node, a function that does not support
recurring nodes, and then map that result to this function, during run time you might get an unexpected result.
 For more information see Limitations in Combining Other Math Functions or Literals.

Returns: number

The minimum value of all nodes in the parameters. For recurring nodes, values for every occurrence in the
recurring set is used to find the minimum. If any parameter is not a number, not a set of numeric nodes, or is an
empty node set, the function returns NaN (not a number).
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Modulo function
The Modulo function determines the remainder from dividing the first parameter by all subsequent
parameters.

Returns: number

The remainder from dividing the first parameter by the remaining parameters. If the divisor is zero, returns NaN
(not a number).

Parameter: number1

The number to be divided (dividend). This can come from a source node, the result of a function, or a value you
specify.

Parameter: number2, [number3-999]

The numbers to divide with (divisor). These can come from source nodes, the results of other functions, or
values you specify. At least one divisor parameter is required.

If multiple parameters are specified as divisors, the order of operations is as follows: the remainder returned
from the first division operation becomes the dividend for the second operation, and so forth. See Example 2.
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Example 1: Using one divisor parameter
modulo(42, 5) = 2

42 / 5 = 8 R2

Example 2: Using multiple divisor parameters

modulo(61,7,2) = 1

61 / 7 = 8 R5

5 / 2 = 2 R1
Parent topic: Mapping Function Reference

Feedback | Notices

 Last updated: Wednesday, 15 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.doc/ref_Modulo.html

Multiply function
The Multiply function returns the product of all parameters.

Parameter(s): number1, number2, [number3-1,000]

The numbers to multiply. At least two parameters are required. Each parameter can come from a source node,
the result of a function, or a value you specify.

Returns: number

The product of the parameters.
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Not function
The Not function is typically used in conditions to specify negative or complimentary conditions.

Returns true if the parameter evaluates as false. Returns false if the parameter evaluates as true.
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Parameter: datatype

Any number, string, date, time, or boolean value. This can come from a source node, the result of a function, or
a value you specify.

Returns: boolean

The boolean inverse of the parameter. The evaluation rules depend on the datatype of the parameter.

For number datatypes:

Positive and negative zero evaluate as false
Any other number evaluates as true

For string, any date or any time datatypes:

An empty string evaluates as false
Any other string, date or time evaluates as true

For the boolean datatype:

The evaluation returns the inverse value
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Number function
The Number function changes the datatype of the parameter to number.

Parameter: datatype

Any number, string, date, time, or boolean value. This can come from a source node, the result of a function, or
a value you specify.

Returns: number

The numeric value of the parameter or NaN (not a number). The conversion rules depend on the datatype of
the parameter:

For number datatypes:

NaN for NaN, positive infinity or negative infinity
The same number for any other value

For string, any date, or any time datatypes:

The corresponding number if the string is in any of these formats, where n represents any set of digits:
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n or -n

n. or -n.

n.n or -n.n

.n or -.n

NaN for any other value

For the boolean datatype:

‘true' evaluates to 1
‘false' evaluates to 0
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Padding String function
The Padding String function returns a padding string of the specified length and characters. Padding strings
are used in alignment functions.

Parameter: number

The total length to make the padding string. This can come from a source node, the result of another function,
or a value you specify.

Parameter: [string]

One or more characters to use to build the padding string. If you use multiple characters and the length of the
padding string is not an even multiple, these characters are truncated at the end of the string to fit the overall
length. This can come from a source node, the result of another function, or a value you specify. If you omit this
parameter, it defaults to the space character.

Returns: string

The string to use for padding.
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Position function
The Position function is used with conditions to represent the index to the current node within the set of its
siblings. The function works only within the context of a recurring node and has no parameters.

Returns: number

The index or number identifying the position of the current node within the set of its siblings.
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Read Date String function
The Read Date String function converts a string (that contains a date and time) to the XML Schema data type:
xs:dateTime.

Purpose

Parameter: string

The date and time as a string.

Parameter: string
This string defines the format of the date and time string of the first parameter. For example, the format string
could be equal to MM/dd/yyyy. For more information about the supported date and time pattern strings see
SimpleDateFormat class in the Sun J2SE 1.4.2 Javadoc:
http://www.science.uva.nl/ict/ossdocs/java/jdk1.3/docs/api/java/text/SimpleDateFormat.html.

Pattern Letter Description Example1 Example2

G Era  designation AD BC

y Year 2004 2001

M Month in a year April 04

w Week in a year 12 24

W Week in a month 3 1

D Day in a year 234 333

d Day in a month 13 20

F Day of week in a month 1 3
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Pattern Letter Description Example1 Example2

E Day in a week Monday Friday

a AM or PM designation AM PM

H Hour in a day - a number between 0 and 23 12 13

k Hour in a day - a number between 1 and 24 14 23

K Hour in AM or PM - a number between 0 and 11 0 10

h Hour in AM or PM - a number between 1 and 12 11 12

m Minute in an hour 20 50

s Second in a minute 10 30

S Milliseconds 224 338

z Time zone in General time zone designation PDT EDT

Z Time zone in RFC 822 time zone designation -0300 +0200

Parameter: string  (Optional)

This string defines the locale. For example, the English United States locale is defined with the following string:
en_US.

The locale string can be defined by any of the following formats:

LANGUAGE
LANGUAGE_COUNTRY
LANGUAGE_COUNTRY_VARIANT

Where LANGUAGE represents a two letter code as defined by the ISO-639 standard, COUNTRY represents a
two letter code defined by the ISO-3166, and VARIANT represents a vendor or browser-specific code, for
example WIN for Windows.

This parameter is optional.

To add this parameter:

1. Drop the Format Date String function into the middle pane of the Mapping Editor.
2. Double-click the function. The Function Properties pane opens.
3. Click Add. The Locale input parameter shows in the list of parameters.

Returns: dateTime

The date and time as an XML Schema data type: xs:dateTime is returned. For example, if the Read Date String
function was run with the following input parameters:

date and time string: 02/22/2005/12/20/44

format string: MM/dd/yyyy/HH/mm/ss

A dateTime representing February 22, 2005 at 12:20 and 44 seconds is returned from Read Date String
Function.
Parent topic: Mapping Function Reference
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Replace function
The Replace function replaces individual characters with other individual characters.

The replacement is done at the individual character level and not the string level. Every occurrence of a
character is replaced with specified replacement character as shown in the following example:

list of characters to be replaced is equal to 'abc'
list or replacement characters is equal to 'ABC'
input string is equal to 'aWWWbYYYYcPPPPabc'

The result string is equal to ''AWWWBYYYYCPPPPABC' because the replacement is done at the character level -
every character is replaced. (If the replacement was done at the string level the resulting string would be equal
to 'aWWWbYYYYcPPPPABC'.)

Parameter: input

The string to search for characters to replace. The value for this parameter can be provided by a source node,
the result of another function, or a value you specify.

Parameter: fromChars

A list of the character or characters to be replaced. If you need to replace several characters, they should be
listed without any separation. The value for this parameter can be provided by a source node, the result of
another function, or a value you specify.

Parameter: toChars

A list of character or characters to use as replacements. List the replacement characters in this parameter in
the same order as characters to be replaced in the fromChars parameter because the first character from the
fromChars parameter is replaced by the first character in toChars parameter and so on. For more information,
see Example 2. The value for this parameter can be provided by a source node, the result of another function,
or a value you specify.
Note: You can not directly replace a single character with an empty string because the toChars parameter
cannot equal a empty string - a string with no characters. For a workaround, see Example 3.

Returns: string

The result of replacing all occurrences of characters in the second parameter (fromChars) that are found in the
first parameter (input) with the matching characters in the third parameter (toChars).

Example 1

This example shows a simple one-to-one character replacement as shown in the following figure:
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The run-time result of running this function is the following string:

A list of chArActers

All lowercase a characters are replace with uppercase A characters.
Note: In this example, the input parameter is hardcoded to a specific value. Typically this value is supplied by a
source node in a map.

Example 2

In this example, the first character from the fromChars parameter is replaced by the first character of the
toChars parameter, the second character from the fromChars parameter is replaced by the second character of
the toChars parameter, and so on. The replacement of multiple characters is shown in the following figure:
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In this example, the non-numeric characters (specified at the end of the fromChars parameter) are removed
from the phone number string. All the numeric characters are replaced with the same numeric character; for
example, the 1 character is replaced by the 1 character. The other non-numeric characters at the end of the
fromChars do not have a replacement character specified in the toChars, so they are removed from the
returned string.

The run-time result of running this function is the following string:

000238882349940
Note: In this example, the input parameter is hardcoded to a specific value. Typically this value is supplied by a
source node in a map.

Example 3

This example shows a workaround to the limitation that you cannot replace a single character with an empty
string. This limitation exists because the toChars parameter cannot be set to an empty string - a string with no
characters. You can workaround this limitation by supplying a dummy character like a hyphen (-) that is not
found in the input parameter. For example, you could specify the following values for the parameters of the
Replace function as shown in the following figure:
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In this example, the input parameter is equal to '1 2 3' (1, space, 2, space, 3), the fromChars parameter is
equal to '- ' (hyphen, space), and the toChars parameter is equal to '-' (hyphen). During run time, the Replace
function with these values strips the spaces from input parameter and the run-time result is the following
string:

123

Attention: When you specify the strings in the Value field of the Function Properties dialog box, do not enter the
quotes. Enter just the hyphen and the space and not the quote characters.
Note: In this example, the input parameter is hardcoded to a specific value. Typically this value is supplied by a
source node in a map.
Parent topic: Mapping Function Reference
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Round function
The Round function rounds a number to the closest integer.

Parameter: number

The number to be rounded. This can come from a source node, the result of another function, or a value you
specify.

Returns: number
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The closest integer to the parameter, rounding up if two integers are equally close. This can come from a
source node, the result of another function, or a value you specify.

Example:

round(4.2) = 4
round(4.5) = 5
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Starts With function
The Starts With function determines whether or not the first parameter begins with the characters in the
second parameter.

Parameter: string1

The string to test. This can come from a source node, the result of another function, or a value that you specify.

Parameter: string2

The beginning string to test for. This can come from a source node, the result of another function, or a value
that you specify.

Returns: boolean

True or false indicating whether the first parameter begins with the second parameter.
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String function
The String function changes the datatype of the parameter to string.

Parameter: datatype
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Any string, boolean, date, or numeric datatype. This can come from a source node, the result of another
function, or a value that you specify.

Returns: string

The result of changing the parameter to string. The conversion rules depend on the datatype of the parameter:

For boolean datatypes, returns the string true or false
For date or time datatypes, returns the date or time as a string in the specific format for that datatype,
such as ‘2003-01-20T05:00:00' for a datetime datatype.
For number datatypes, this returns:

‘NaN' if the value is NaN (not a number)
‘0' if the value is positive or negative zero.
‘Infinity' or ‘-Infinity' if the value is positive or negative infinity (respectively).
The corresponding numeral, with a minus sign if negative and no leading zeroes. Decimal values
have at least one numeral before the decimal point and as many decimal places as needed.
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Substring function
The Substring function extracts a portion of the parameter based on the specified character placement.

Parameter: string

The string to extract from. This can come from a source node, the result of another function, or a value you
specify.

Parameter: number1

The position of the first character to extract. Characters are numbered in the string beginning from 1.

Parameter: [number2]

The total number of characters to extract. If you omit this parameter, it defaults to the length from the starting
position to the end of the first parameter.

Returns: string

The substring for the specified character places.

Example
substring('abcde',3,2) = 'cd'
Parent topic: Mapping Function Reference
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Substring After function
The Substring After function extracts all the characters in a string starting after the first occurrence of a
specified substring (one or more characters) through the end of the string.

Parameter: string

The string to extract a substring from. This can come from a source node, the result of another function, or a
value you specify.

Parameter: string

The character to use as a starting point for the extraction. The first occurrence of the character is used as the
starting point. This parameter can come from a source node, the result of another function, or a value you
specify.

Returns: string

A substring of  the first parameter which starts after the first occurrence of the specified start string through the
end of the string. If the start string is not present, returns an empty string.

Example
substring-after('12/31/1999','/') = '31/1999',
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Substring Before function
The Substring Before function extracts all the characters in a string starting at the beginning up to the first
occurrence of a specified substring (one or more characters).

Parameter: string
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The string to extract a substring from. This can come from a source node, the result of another function, or a
value you specify.

Parameter: string

The characters to use as the ending point for the extraction. The first occurrence of these characters is used as
the ending point. This can come from a source node, the result of another function, or a value you specify.

Returns: string

The substring in the first parameter starting at the beginning up to the first occurrence of the specified end
string. If the end string is not present, this returns an empty string.

Example
substring-before('12/31/1999','/') = '12'
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Subtract function
The Subtract function returns the difference of the first parameter less all subsequent parameters.

Parameter: number1

The number to subtract from. This can come from a source node, the result of another function, or a value that
you specify.

Parameter: number2,, [number3-999]

The numbers to subtract. These can come from source nodes, the results of other functions, or values that you
specify. You can specify multiple parameters here, but at  least one parameter is required.

Returns: number

The difference of the two parameters. If either parameter is not a number, returns NaN (not a number).

Example

number 1 = 42

number 2 = 7

number 3 = 8

returns: 27
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Sum function
The Sum function determines the sum of values in the numeric node, sets of numeric nodes, or numbers in
parameters.

Parameter: input, input ...

The numeric nodes to add. These can come from recurring or nonrecurring source nodes, the results of other
functions, or values that you specify.

You cannot specify a default value (or constant) for the input parameters of this function but you can specify a
variable with a default value and then pass that variable as an input parameter to this function.  For more
information see Specifying Default Values for Functions that Allow Recurring Nodes as Input.

Attention: In the Mapping Editor, if you chain together a recurring source node, a function that does not support
recurring nodes, and then map that result to this function, during run time you might get an unexpected result.
 For more information see Limitations in Combining Other Math Functions or Literals
.

Returns: number

The total sum of all parameters. If any parameter is a nodeset, the total includes values for every node in the
set. If any parameter is not a number or a numeric node set, returns NaN (not a number).
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Trim function
The Trim function trims all leading and trailing spaces and replaces continuous sets of white space characters
by a single space.

The string value of the parameter is normalized, as described in the following steps:
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1. All tabs, carriage returns, and line feeds are replaced with spaces.  
2. Contiguous sequences of spaces are reduced to a single space.
3. Trailing and leading spaces are removed.

Parameter: string

The string to trim and normalize. This can come from a source node, the result of another function, or a value
you specify

Returns: string

The trimmed and normalized parameter.

Examples:

Input String Equals... The Trim Function Returns...

'  The string to trim and  normalize.  ' 'The string to trim and normalize.'

'           first line

                         second line

third line            '

'first line second line third line'
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Uppercase function
The Uppercase function converts all lowercase characters to the corresponding uppercase character.

Parameter: string

The string to convert. This can come from a source node, the result of another function, or a value you specify.

Returns: string

The converted string.
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Glossary
A    B    C    D    E    F   G   H    I    J   K   L    M    N    O    P   Q    R    S    T   U    V    W   X   Y   Z

A
Activity

A complete, functional unit of processing within an orchestration. Activities include flow-control (logic)
activities; data activities to facilitate consumption and transmission of data; and activities that enable
integration with database systems, enterprise systems, Web servers, email servers, and other systems.
An orchestration comprises a series of activities.

Assets
Supplemental configuration files, scripts, or other materials associated with a specific activity. For
example, the buffer table scripts created for a database insert activity are assets. Assets are controlled
by the Web Management Console (WMC). Access privileges to assets can be given to users beyond the
users of the WMC. For example, DBAs can be given privileges to the assets associated with a database
activity so that they can create the required tables or triggers.

B
Buffer table

An auxiliary table used in conjunction with various database activities, such as the single-table insert,
update, or delete database activities. When you configure one of the database DML (data manipulation
language) activities, Studio generates a SQL script that can be used to create the appropriate trigger on
the database table; the buffer table gets populated when the triggering event (INSERT, UPDATE,
DELETE) occurs. The buffer table provides the means to capture database changes and initiate
processing by the orchestration.

C
Cast Iron® Studio

An integrated development environment (IDE) for creating, configuring, and publishing integration
projects and the orchestrations they comprise. Studio projects run on the WebSphere® Cast Iron
Appliance.

Command-line interface
A text-based alternative to the Web Management Console (WMC) for configuring, managing, and
querying an Integration Appliance.
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Control table
A database table that facilitates using database endpoints in integrations. As it does with buffer tables,
Studio generates scripts to create control tables that can be used to ensure that inserts, updates, and
deletes to specific tables occur once and only once.

Copy parameters
Copy creates new default orchestration variables that match the output from the parameters.

D
Deploy

Create an instance of an integration project (instantiate) on an Integration Appliance.

Document
Any of the XML Schema files, DTDs, and other configuration files that comprise integration projects.

Dynamic delimiter
A delimiter that is obtained from within the fields of the message itself, such as an HL7 PID (patient ID)
message header that denotes the beginning of a new record in a file containing a batch of electronic
health records.

E
Empty Placeholder

Appears in activities that have multiple branches as an initial placeholder for the activities in that
branch. Dropping other activities on this icon removes it.

Endpoint
Represents the properties of an external system, such as a database server, FTP server, email system, or
enterprise application that is either the source of data to the Integration Appliance or the target of
processing by the Integration Appliance.

F
For Each

A function that iterates over a message structure.

Flat File
A file containing non-XML data. Flat Files are typically of two types: delimited, in which a comma, tab,
white space, or other delimiter is used to separate variable-length fields and records; or positional, in
which fields and records have a fixed width.

Flat File Schema

Defines how to interpret a specific set of Flat Files. Cast Iron Studio creates Flat File Schema (XML
Schema) based on the configuration you define in the Flat File Schema Editor. A Flat File Schema is used
by the Read Flat File activity to convert a source Flat File into XML.

Function
String, mathematical, and miscellaneous functions provided by Studio that you can use in defining
processing in your orchestrations. In addition to the pre-built functions, Studio lets you build your own
custom functions and add lookup tables.

I
Integration project

The various inputs, outputs (endpoints), mapping and schema definitions (transformations, message
formats), orchestrations, and configuration information that comprise an integration solution as
designed in Studio and deployed to the Integration Appliance.

J
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Job
A specific run-time instance of an orchestration.

M
Map

A component that lets you bind input parameters to variables, and variables to the orchestration. Many
Studio activities contain embedded maps that you must configure at design time, in the context of an
orchestration, to define how actual parameters should map to variables, and how the variables should
be processed in the orchestration. In addition to the embedded activity maps, Studio has a stand-alone
Map Variables activity that can be used to bind any type of input and output to the orchestration

N
Node

All data input to or output from the Integration Appliance is materialized in Studio as a series of nodes,
as in a tree-like, hierarchical structure. In many cases, the nodes represent the structure and content of
an XML document, but in many cases they don't (e.g., rows in a database table are displayed as nodes).
Nodes in Studio convey information about structure; the type of content that can be supported; or
additional characteristics of the data.

Notification policy
Applies across an entire orchestration. Rules are based on event levels from 0 (no logging) to 9 for
complete logging information.

O
Orchestration

The specific sequence of processing activities (such as data mapping, transformation, and control logic
activities), endpoints, and data types defined and configured using Studio and deployed to run on the
Integration Appliance.

P
Parameter

A value passed to an activity or to an orchestration. For example, Filename and data are two of the
parameters that can be passed from an FTP endpoint to an orchestration.

Parameterized query
A database SQL statement that contains input or output database parameters. The Execute Query
activity supports parameterized queries.

Parse
The converse of serialize. To convert to constituent pieces according to some established rules.

Pick
An activity that chooses from two or more alternatives. Typically used to start an orchestration, the Pick
activity can support either synchronous or asynchronous messaging.

Project
An integration project defined and created using Cast Iron Studio. Each project has a properties file
(filename.sp3) and several additional metadata files and folders that comprise all integration elements -
orchestrations, endpoints, XML schemas, flat files - and their specific configuration (variables,
parameters)

Publish
Copy all project files from Studio to an Integration Appliance or to an intermediate staging area, such as
a shared directory on a file server, for subsequent runtime configuration and deployment to a specific
environment. The Publish process encompasses validating the project; creating a .par file of project
configuration documents; and sending the package to the Integration Appliance specified.
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R
Raw message

The configuration that defines the character encoding for raw messages

Record identifier
A special field that delimits records in certain types of flat files, such as EDI (electronic data
interchange) or HL7 (Health Level 7) files. For example, an HL7 PID (patient ID) number is a record
identifier.

Repetition delimiters
A delimiter in a flat file that is used when the data lacks a unique value, such as record ID, to distinguish
one record from another.

Replace
Appears in activity branches as an initial placeholder for the endpoint activity to receive a message for
that branch. Dropping a Receive endpoint activity on this icon removes it.

Reply
Sends an acknowledgement when it receives a message.

Repository
Persistent storage for various types of data. Cast Iron Appliance has a configuration repository and a
message repository.

S
Serialize

The converse of parse. Serialization assumes that the data is in XML format

Stored procedure
A functional code unit that resides in a database and is started explicitly by name. Stored procedures
can be used to populate buffer tables when specific insert, update, or delete activities occur on a
particular database table.

System store
A repository containing Appliance configuration information. Same as configuration repository.

T
Terminate

Stops orchestration processing.

Toolbox
The five-tab-set of Project, Activities, Variables, Functions, and Verify available in the right corner of
Studio. These tabs provide access to all the entities you need to create new projects, create new
orchestrations within projects, and develop the processing logic.

Trigger
A type of database stored procedure that is called implicitly when a triggering event occurs such as an
INSERT, UPDATE, or DELETE on a table.

V
Variable

Used to pass data values processed by an orchestration. Variables are used by maps to identify the
source and target. Some Activities create variables automatically.

W
While Loop

Initiates and continually processes any children activities for as long as a specified condition is true.
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Cast Iron Express ⼊⾨

您可以使⽤ IBM® WebSphere® Cast Iron® Express®，來快速註冊以取得免費試⽤帳⼾、建⽴整合，以及安全地管
理 Cast Iron Express 環境。您也可以使⽤所提供的分析，來分析您的整合使⽤情形。

為何使⽤ Cast Iron Express？

WebSphere Cast Iron Express 是針對⽤途建置的解決⽅案，可讓您快速建⽴、定義、執⾏及管理整合專案。只需
數分鐘，您就可以在 salesforce.com 帳⼾與其他資料來源之間建⽴整合。

重點在於速度及簡化，因此使⽤配置⽅法來定義整合。您不⽤編碼來進⾏整合。

當完成時，您可以執⾏整合，從遠端資料庫、本端檔案及 Dropbox 將資料移⼊及移出 salesforce.com。

您隨時可以擴充 Cast Iron Express 帳⼾的功能，⽅法為選取⼀個以上可⽤的附加程式函數套件。

您可以邀請其他使⽤者加⼊您的 Cast Iron Express 帳⼾。您也可以監視及管理帳⼾。

若要註冊，請跳⾄ WebSphere Cast Iron Express ⾸⾴ https://express.castiron.com/express/。

需要瞭解甚麼？

根據您的⾓⾊，有不同的作業概述於下列⽂件中。每⼀項作業會依序說明，從如何登錄 Cast Iron Express 帳⼾開
始。

基於安全原因，如果您的使⽤者名稱處於登⼊狀態，但沒有活動，則您的階段作業將逾時。

部分 Cast Iron Express 函數會使⽤蹦現視窗。因此，您可能要防⽌ Web 瀏覽器封鎖蹦現視窗。

在開始之前，請檢查是否⽀援您正要使⽤的瀏覽器，以及該瀏覽器是否符合必要的最低層次：

Google Chrome 18
Mozilla Firefox 10
Windows Internet Explorer 8

您可以選取下列作業，來瞭解 Cast Iron Express。然後，您可以開始建⽴並管理您的整合、 邀請其他使⽤者加⼊
您的帳⼾，以及監視您帳⼾內的活動。

若要瞭解如何建⽴從本端檔案到 salesforce.com 帳⼾的整合，請參閱指導教學：建⽴本端檔案與 salesforce.com
的整合。
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登錄帳⼾

您可以登錄 IBM Cast Iron Express 帳⼾，⽅法為在 Cast Iron Express ⾸⾴上按⼀下註冊。
協助⼊⾨

當您利⽤收到的使⽤者名稱和密碼登⼊時，「Cast Iron Express ⼊⾨」視圖即會開啟。
管理您的帳⼾設定檔

您可以使⽤管理設定檔視圖，來新增詳細資料，或變更現⾏詳細資料。您也可以變更帳⼾密碼。

管理使⽤者

管理者可以管理 Cast Iron Express 帳⼾的使⽤者。只有管理者才能新增使⽤者⾄帳⼾，以及移除不再需要
存取的現有使⽤者。

Cast Iron Express 說明中⼼
當您登⼊ Cast Iron Express 時，包含⼀系列有⽤資源的「說明中⼼」，可協助您瞭解並使⽤產品中的可⽤
函數。

新增函數⾄ Express 帳⼾
您可以要求其他函數，來⾃訂 Cast Iron Express 帳⼾。您可以選取⼀個以上可⽤的函數套件，來增加帳⼾
的功能。

隨時掌握 Cast Iron Express 的最新功能
您可以查看「Cast Iron Express 說明中⼼」，瞭解 Cast Iron Express 的「最新功能」。

登錄帳⼾

您可以登錄 IBM® Cast Iron® Express® 帳⼾，⽅法為在 Cast Iron Express ⾸⾴上按⼀下註冊。

關於這項作業

您可以登錄 IBM Cast Iron Express 帳⼾，⽅法為跳⾄ https://express.castiron.com/express/。

無需承諾購買本產品。來⾃ Cast Iron Express ⾸⾴的登錄鏈結會設定免費的試⽤帳⼾。您可以要求可⽤的附加程
式套件，在您的帳⼾內擴充函數。如需相關資訊，請參閱新增函數⾄ Express 帳⼾。

登錄帳⼾時，您必須識別單⼀使⽤者以進⾏登⼊。每⼀個 Cast Iron Express 帳⼾都有⼀個具備管理者專⽤權的使
⽤者。此使⽤者是在您⾸次完成登錄時建⽴，稱為 admin。admin 使⽤者可以邀請其他使⽤者加⼊相同的 Cast
Iron Express 帳⼾。

程序

1. 當 Cast Iron Express ⾸⾴開啟時，請按⼀下註冊。 「註冊」⾴⾯即會開啟。
2. 輸⼊所要求的詳細資料來填寫所有欄位。如果您省略某欄位，則會提⽰您輸⼊資訊。
3. 閱讀使⽤條款。當您提交登錄要求時，表⽰您同意 Cast IronExpress 條款。
4. 完成時，請按⼀下註冊。 這時會顯⽰確認訊息，顯⽰電⼦郵件正在傳送⾄所登錄的位址。
5. 跳⾄電⼦郵件帳⼾，並開啟歡迎使⽤ IBM WebSphere Cast Iron Express 郵件。若要確認登錄並啟動您的
帳⼾，您必須按⼀下所提供的鏈結。 這時會顯⽰帳⼾驗證訊息。

6. 在您確認後，會傳送兩封進⼀步的電⼦郵件。其中⼀封郵件包含您的 admin@YourCompanyName Cast
Iron Express 使⽤者名稱。另⼀封郵件則包含您的密碼。 admin 使⽤者 ID 有權建⽴及定義整合、邀請其
他使⽤者存取帳⼾，以及管理公司 Cast Iron Express 帳⼾。

7. 以提供的認證登⼊，開始使⽤您的免費試⽤帳⼾。

結果

限制： Cast Iron Express 限制每⼀家公司的使⽤者只能使⽤單⼀試⽤帳⼾。如果出現錯誤訊息，指出您提供的公
司名稱已登錄，請聯絡您公司的管理者。管理者可以在現有帳⼾內邀請其他使⽤者。
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上層主題： Cast Iron Express ⼊⾨

協助⼊⾨

當您利⽤收到的使⽤者名稱和密碼登⼊時，「Cast Iron Express ⼊⾨」視圖即會開啟。

關於這項作業

為了協助您瞭解 Cast Iron® Express® 帳⼾內可⽤的函數，您可以按⼀下「⼊⾨」視圖中顯⽰的每⼀個選項。

您可以隨時存取「⼊⾨」⾴⾯，⽅法為按⼀下⼯具列中的「說明」圖⽰。下列畫⾯擷取顯⽰「說明」圖⽰和各種

說明選項：

程序

1. 利⽤您從 IBM® Cast Iron Express 收到的使⽤者名稱和密碼登⼊。 「Express ⼊⾨」視圖即會開啟。
2. 在「Express ⼊⾨」視圖中，您可以按⼀下三個顯⽰選項的其中⼀個：

建⽴，⽤來快速定義並執⾏您的整合。

監視，⽤來開啟儀表板⾴⾯並即時分析您的整合。您也可以檢查是否有任何報告的問題。

擴充，⽤來新增更多函數⾄您的帳⼾，以擴充您的整合功能。

結果

您現在可以開始定義 Cast Iron Express 環境。
上層主題： Cast Iron Express ⼊⾨

管理您的帳⼾設定檔

您可以使⽤管理設定檔視圖，來新增詳細資料，或變更現⾏詳細資料。您也可以變更帳⼾密碼。

開始之前

登⼊您的 Cast Iron® Express® 帳⼾。

程序

1. 按⼀下⾴⾯右上⽅的登⼊名稱，以顯⽰功能表選項。按⼀下管理設定檔。 下列畫⾯擷取顯⽰功能表。
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2. 您可在下列欄位中新增或更新詳細資料：
名字

姓⽒

電⼦郵件

國家/地區
電話

⼯作職稱

3. 若要變更密碼，請按⼀下變更密碼。輸⼊新密碼之前，您必須提供現有密碼。

適⽤⼀般密碼規則。密碼最少須有⼋個字元，⽽且可以包含特殊字元。

4. 選擇性的： 如果想要接收 Cast Iron Express 新聞信件，您可以選取註冊「Cast Iron Express 新聞信件」，
並讓 IBM 通知我優惠活動。

5. 若要修改您的設定檔，請按⼀下儲存。 若要取消新增或修改，請按⼀下關閉圖⽰ 。

上層主題： Cast Iron Express ⼊⾨

管理使⽤者

管理者可以管理 Cast Iron® Express® 帳⼾的使⽤者。只有管理者才能新增使⽤者⾄帳⼾，以及移除不再需要存取
的現有使⽤者。

關於這項作業

依預設，當登錄 Cast Iron Express 帳⼾時，會停⽤管理使⽤者函數。若要使⽤這個額外函數，請按⼀下附加程
式，並選取協同作業 套件。如需相關資訊，請參閱新增函數⾄ Express 帳⼾。

請完成下列步驟，以邀請⼀個以上使⽤者存取您的 Cast Iron Express 帳⼾。

程序

1. 若要開啟「管理使⽤者」⾴⾯，請按⼀下管理使⽤者。
2. 在「新增使⽤者」區段中，輸⼊您要新增⾄ Cast Iron Express 帳⼾之使⽤者的電⼦郵件位址。 如果您想要
邀請數個⼈員，請以逗點區隔每⼀個電⼦郵件位址。

3. 選擇性的： 若要⾃訂傳送給使⽤者的電⼦郵件，請選取⾃訂電⼦郵件，並在提供的⽂字區中編輯內容。
4. 完成時，請按⼀下傳送。 這時會顯⽰訊息，以確認正在傳送電⼦郵件。
5. 您邀請的⼈員會收到⼀封郵件，其中包括的鏈結會引導他們完成登⼊程序。他們第⼀次登⼊時，畫⾯會顯
⽰授權合約。受邀的作者必須按⼀下接受，才能完成登⼊程序。

6. 在新使⽤者登⼊之後，您可在「作⽤中使⽤者」區段中看到他們前次登⼊ Cast Iron Express 的詳細資料。
7. 必要時，您可以按⼀下「前次登⼊」欄位旁邊的刪除圖⽰，來刪除使⽤者。

上層主題： Cast Iron Express ⼊⾨

Cast Iron Express 說明中⼼

當您登⼊ Cast Iron® Express® 時，包含⼀系列有⽤資源的「說明中⼼」，可協助您瞭解並使⽤產品中的可⽤函
數。

「Cast Iron Express 說明中⼼」包含下列資訊：
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「新增功能」詳細資料

⼀系列短⽚指導教學

記載的指導教學

常⾒問題 (FAQ) 區段

您可以隨時按⼀下「說明」圖⽰，來開啟「說明中⼼」。下列畫⾯擷取顯⽰「說明」圖⽰和功能表選項：

您可以按⼀下⾴⾯右上⽅的關閉圖⽰，來關閉「說明中⼼」區段。

您也可以從說明功能表選項中存取「Cast Iron Express 資訊中⼼」。

上層主題： Cast Iron Express ⼊⾨

新增函數⾄ Express 帳⼾

您可以要求其他函數，來⾃訂 Cast Iron® Express® 帳⼾。您可以選取⼀個以上可⽤的函數套件，來增加帳⼾的功
能。

開始之前

登⼊您的 Cast Iron Express 帳⼾。

關於這項作業

根據您選取的額外函數，您可能需要付費，才能取得部分函數套件。您會重新導向⾄「IBM® 軟體」及服務線上網
站，您可以在這裡新增 Cast Iron Express 產品項⽬⾄您的購物籃。出現提⽰時，請以 IBM 使⽤者 ID（必須在
Cast Iron Express 登⼊名稱之外另外配置）登⼊。

訂購程序結束時，請記錄確認號碼以供⽇後參考。

重要： 付款系統會在新的視窗中開啟。因此，您必須確保 Web 瀏覽器沒有封鎖蹦現視窗。

程序

1. 若要查看可⽤套件的清單，請按⼀下附加程式。
可⽤的函數套件包括：

對映函數。定義轉換，以操作在移⼊⽬標端點之前先從來源端點對映的資料。

內部部署⽀援。在本端系統與遠端系統之間提供連續的同步化。

協同作業。邀請其他使⽤者在您的 Cast Iron Express 帳⼾中協助建⽴及管理整合。
每⼀個套件詳述內含的函數，以及是否有免費的試⽤。您可以使⽤⼀次的免費試⽤，來體驗函數如何加強

您的商業應⽤程式。

2. 若要選取所有額外函數，請按⼀下嘗試全部 90 天。 若要在免費 90 天試⽤完成時繼續使⽤函數，您必須購
買套件。
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3. 若要選取個別套件，請按⼀下免費試⽤ 90 天，以取得您要使⽤的特定函數。 當僅選擇部分套件時，您無
法選取嘗試全部 90 天。

4. 如果適⽤，請在「IBM 軟體」及服務線上網站上完成購買。
5. 提交您的新函數要求。

結果

「附加程式」視圖會顯⽰您的要求狀態、您的現⾏套件使⽤情形，以及指出免費試⽤的剩餘時間。

上層主題： Cast Iron Express ⼊⾨

隨時掌握 Cast Iron Express 的最新功能

您可以查看「Cast Iron® Express® 說明中⼼」，瞭解 Cast Iron Express 的「最新功能」。

您可以在新增最新功能時查看其詳細資料。若要開啟「說明中⼼」，請在「說明」圖⽰下按⼀下功能表中顯⽰的

選項。下列畫⾯擷取顯⽰「說明」圖⽰和功能表：

上層主題： Cast Iron Express ⼊⾨

與 Cast Iron Express 整合

⽀援的來源和⽬標系統

Cast Iron® Express® 提供在資料庫、FTP 伺服器、本端檔案、Dropbox 及 salesforce.com 帳⼾之間整合的
功能。

管理安全連接器

為了與資料庫和 FTP 伺服器等站上系統通訊，Cast Iron Express 可讓您使⽤安全連接器。從「整合」⾴⾯
可管理安全連接器。

建⽴整合

在 Cast Iron Express 中可以從整合⾴⾯建⽴整合。
使⽤「整合」編輯器

您可以使⽤「整合」編輯器來⾃訂整合的所有相關資訊。

複合函數

複合函數是兩個不同函數的組合，其中⼀個函數的輸出是鏈結為後續函數的輸⼊。下列各主題提供建⽴、

編輯或刪除複合函數的相關資訊。

函數清單

Cast Iron Express 可選取在對映內使⽤的函數。這些函數可以⽤來操作所對映的欄位值，例如，變更字串
內容、對數字執⾏數值作業，以及操作⽇期和時間值。

管理整合

Cast Iron Express 會將帳⼾中定義所有整合的清單顯⽰在「整合」⾴⾯上。
監視整合活動

您可以使⽤ Cast Iron Express 活動⾴⾯，來查看您帳⼾內所有活動的詳細資料。
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使⽤率圖表

使⽤率圖表可讓您快速識別特定租⼾的最活躍整合和端點。⼯作成功和失敗的摘要以及整合活動細分，會

以⽉和年圖表呈現。

⽀援的來源和⽬標系統

Cast Iron® Express® 提供在資料庫、FTP 伺服器、本端檔案、Dropbox 及 salesforce.com 帳⼾之間整合的功能。

⽀援的整合來源和⽬標配對的完整清單

下表概述您可在 Cast Iron Express 選取的各種「來源」端點。當選取「來源」端點時，只會顯⽰該特定「來源」
端點⽀援的「⽬標」端點。

表 1. 選取的「來源」端點及對應的受
⽀援「⽬標」端點

選取的「來源」端點 ⽀援的「⽬標」端點

DB2® salesforce.com

MySQL salesforce.com

SQL Server salesforce.com

Oracle salesforce.com

salesforce.com DB2
MySQL
SQL Server
Oracle
salesforce.com

FTP salesforce.com

Local File salesforce.com

Dropbox salesforce.com

FTP 來源⽀援的檔案類型
Cast Iron Express ⽀援使⽤ FTP 作為某些檔案類型的來源。

上層主題： 與 Cast Iron Express 整合

FTP 來源⽀援的檔案類型

Cast Iron® Express® ⽀援使⽤ FTP 作為某些檔案類型的來源。

當選取 FTP 作為來源端點時，⽀援下列檔案類型：

CSV 檔案，檔案的第⼀⾏定義其餘各⾏的欄位名稱。
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其他⽂字檔中的⽂字內容會作為單⼀⽂字欄位使⽤。

⼆進位檔中的內容會作為單⼀的⼆進位欄位使⽤。

上層主題： ⽀援的來源和⽬標系統

管理安全連接器

為了與資料庫和 FTP 伺服器等站上系統通訊，Cast Iron® Express® 可讓您使⽤安全連接器。從「整合」⾴⾯可管
理安全連接器。

依預設，當登錄 Cast Iron Express 帳⼾時，會停⽤「安全連接器」函數。若要使⽤這個額外函數，請按⼀下附加
程式，並選取內部部署⽀援 套件。如需相關資訊，請參閱新增函數⾄ Express 帳⼾。

當您開啟「整合」⾴⾯時，已定義的安全連接器會列⽰在⾴⾯左下⽅。對於每⼀個列出的連接器，您會看到連接

器的名稱及狀態。

您可以按⼀下刪除圖⽰來刪除任⼀個安全連接器。

建⽴安全連接器

您可以從 Cast Iron Express 的「整合」⾴⾯建⽴安全連接器。
安裝安全連接器

您可以在主機系統上安裝安全連接器。

啟動和停⽌安全連接器

當您安裝安全連接器時，啟動和停⽌安全連接器的功能表項⽬會新增⾄稱為 Cast Iron Secure Connector
1.6.2.0.0 群組中的作業系統。
移除安全連接器

先執⾏停⽌安全連接器項⽬，再執⾏解除安裝安全連接器項⽬，即可從主機系統中移除安全連接器。

上層主題： 與 Cast Iron Express 整合

建⽴安全連接器

您可以從 Cast Iron® Express® 的「整合」⾴⾯建⽴安全連接器。

開始之前

依預設，當登錄 Cast Iron Express 帳⼾時，會停⽤「安全連接器」函數。若要使⽤這個額外函數，請按⼀下附加
程式，並選取內部部署⽀援 套件。如需相關資訊，請參閱新增函數⾄ Express 帳⼾。

程序

1. 當整合⾴⾯開啟時，請按⼀下「新增」圖⽰： 。

2. 輸⼊安全連接器的唯⼀敘述性名稱。
3. 按⼀下建⽴。

結果

安全連接器會在背景中建⽴，完成時會顯⽰在「安全連接器」清單中。

下⼀步
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下載安裝檔及配置檔，並在主機系統上安裝安全連接器。如需相關資訊，請參閱安裝安全連接器。

上層主題： 管理安全連接器

安裝安全連接器

您可以在主機系統上安裝安全連接器。

開始之前

限制： 主機系統與⽬標系統必須在相同的本端網路上。

程序

1. 登⼊主機系統，並在 Web 瀏覽器中跳⾄ http://express.castiron.com。

2. 按⼀下您所要安裝安全連接器旁邊的下載圖⽰：  畫⾯上顯⽰對話框，內含 Windows 和 Linux 平台的安
裝與配置檔的下載鏈結，以及只下載配置檔本⾝的選項。

3. 將相關檔案下載⾄主機系統，並執⾏安裝程式。 安裝期間會提⽰您提供配置檔。

上層主題： 管理安全連接器

啟動和停⽌安全連接器

當您安裝安全連接器時，啟動和停⽌安全連接器的功能表項⽬會新增⾄稱為 Cast Iron® Secure Connector
1.6.2.0.0 群組中的作業系統。

關於這項作業

您可以在「開始」功能表 (Windows)，或在「應⽤程式」功能表 (Linux) 中，尋找啟動和停⽌安全連接器的功能表
項⽬。

重要： 如果您是在 Windows 7 系統上執⾏安全連接器，請以管理者⾝分執⾏安全連接器。⽤滑⿏右鍵按⼀下啟動
安全連接器選項，然後選擇以管理者⾝分執⾏。

啟動時，安全連接器會與您的 Cast Iron Express® 帳⼾通訊，並指出它已在執⾏中。

提⽰： 在 Windows 系統上安裝期間，安全連接器可以安裝為 Windows 服務。將安全連接器安裝為 Windows 服
務，表⽰您不需要使⽤「開始」功能表，即可啟動安全連接器。

程序

當安全連接器啟動時，請在 Cast Iron Express 整合⾴⾯上，按⼀下「安全連接器」區段中的「重新整理」圖⽰ 

。 狀態會變更為「執⾏中」。

結果

重新整理可以將安全連接器清單更新為最新狀態。

上層主題： 管理安全連接器

 931

http://express.castiron.com/


移除安全連接器

先執⾏停⽌安全連接器項⽬，再執⾏解除安裝安全連接器項⽬，即可從主機系統中移除安全連接器。

程序

1. 在主機系統上：
a. 使⽤「開始」功能表選項停⽌安全連接器，停⽌安全連接器。
b. 使⽤「開始」功能表選項解除安裝安全連接器，解除安裝安全連接器。

2. 在「Cast Iron® Express® 的「整合」⾴⾯上：

a. 按⼀下相關安全連接器旁邊的「刪除」圖⽰ 。

b. 按⼀下確定。

結果

會從 Cast Iron Express 的「整合」⾴⾯中移除安全連接器。

上層主題： 管理安全連接器

建⽴整合

在 Cast Iron® Express® 中可以從整合⾴⾯建⽴整合。

關於這項作業

登⼊ Cast Iron Express 帳⼾，然後按⼀下整合。

程序

1. 從清單選擇來源。 根據您的來源端點，會過濾⽬標清單只列出⽀援的系統。
2. 選擇⽬標。
3. 按⼀下新建空⽩整合以建⽴整合，並進⼊「整合」編輯器。

上層主題： 與 Cast Iron Express 整合

使⽤「整合」編輯器

您可以使⽤「整合」編輯器來⾃訂整合的所有相關資訊。

關於這項作業

您可以提供整合的⾃訂名稱，⽅法為在編輯器上半部的⽂字欄位中輸⼊名稱。您可以按⼀下儲存，以儲存整合變

更。若要關閉整合編輯器⽽不儲存，請按⼀下關閉。隨時都可以儲存整合，但必須完成之後才能執⾏整合。

「整合」編輯器包含三個⼤型畫⾯：

來源

轉換
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⽬標

如需配置「來源」和「⽬標」區段的相關資訊，請參閱下列主題：

配置連線

選取作業

選取物件

選取欄位

設定整合

程序

1. 選取來源區段。 來源編輯器開啟。
配置連線

選取作業

選取物件

選取欄位

配置來源時，會顯⽰記號以指出步驟完成。

2. 選取⽬標區段 ⽬標編輯器開啟。
配置連線

選取作業

選取物件

選取欄位

配置⽬標時，會顯⽰記號以指出步驟完成。

3. 建⽴轉換
定義對映

定義函數

結果

同時配置來源和⽬標端點時，「整合」編輯器會在左側顯⽰「來源」欄位清單，在右側顯⽰「⽬標」欄位清單。

程序的步驟 3 將與轉換區段互動，以建⽴「來源」與「⽬標」之間的資料轉換。如需相關資訊，請參閱下列主
題：

定義對映

定義函數

設定整合

當完成轉換時，即可儲存整合，然後關閉以回到「整合」⾴⾯。如需啟動和停⽌新整合的相關資訊，請參閱管理

整合。

配置連線

您必須提供整合將連接的系統連線詳細資料。必須對連線詳細資料集指定名稱，稍後可使⽤該名稱來識別

這些連線詳細資料，以在其他整合中重複使⽤。

連接⾄ MySQL 資料庫
若要順利連接⾄ MySQL 實例，安全連接器中必須安裝相關的 MySQL JDBC 驅動程式。
選取作業

作業的選擇決定 Cast Iron Express 如何監控「來源」和「⽬標」端點並與之互動。對個別作業的⽀援可能
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因實作不同⽽不同。例如，FTP 會利⽤取得和放置作業，⽽ salesforce.com ⽀援更新插⼊和取得更新項⽬
作業。

資料庫觸發程式表格

使⽤資料庫系統做為來源時，Cast Iron Express 需要資料庫系統內建⽴觸發程式表格。
選取物件

順利連接來源或⽬標之後，Cast Iron Express 會在系統中查詢可處理的物件。
選取欄位

選取物件時，Cast Iron Express 會⾃動查詢「來源」或「⽬標」系統，以識別該物件內的欄位。
連接⾄ salesforce.com 時使⽤外部 ID
連接⾄ salesforce.com 時，您可以配置 Cast Iron Express，在更新插⼊物件作業上使⽤外部 ID。您也可以
使⽤外部 ID 欄位將⽬標 salesforce.com 物件連結⾄其他 salesforce.com 物件。
過濾來源物件

Cast Iron Express 過濾功能可讓您根據「整合」⾴⾯中顯⽰的欄位值，來控制從來源應⽤程式傳遞⾄整合
的記錄。

設定整合

配置「來源」和「⽬標」端點之後，您已準備好定義對映。瞭解資料類型之間隱含轉換的 Cast Iron 準則，
對於設定整合⽽⾔⼗分重要。繼續之前，讓⾃⼰熟悉本節中的資訊。

定義對映

當配置「來源」與「⽬標」時，您會看到左側的來源欄位清單、右側的⽬標欄位清單及兩欄錨點。請連接

這些錨點來定義對映。

定義函數

簡式對映可以從來源欄位複製資料，並放⼊⽬標欄位中。不過，有時需要更複雜的轉換。所有對映都有可

⽤來定義函數的新增函數圖⽰。

配置函數

您可以配置函數，以符合特定需求。作法是編輯來源欄位和參數以新增或移除來源，或是變更其顯⽰順

序。

上層主題： 與 Cast Iron Express 整合

配置連線

您必須提供整合將連接的系統連線詳細資料。必須對連線詳細資料集指定名稱，稍後可使⽤該名稱來識別這些連

線詳細資料，以在其他整合中重複使⽤。

關於這項作業

就資料庫和 FTP 伺服器等內部部署系統⽽⾔，連線詳細資料需要指定安全連接器。如需相關資訊，請參閱管理安
全連接器。

當填完連線詳細資料時，請按⼀下連接，以連接⾄系統來驗證連線詳細資料。「連線詳細資料」畫⾯頂端會顯⽰

訊息，指出連線是否成功。

上層主題： 使⽤「整合」編輯器

連接⾄ MySQL 資料庫

若要順利連接⾄ MySQL 實例，安全連接器中必須安裝相關的 MySQL JDBC 驅動程式。

關於這項作業
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⼩⼼： 如果 Cast Iron® Express® 偵測到安全連接器沒有可⽤的驅動程式，則會顯⽰錯誤訊息，內含如何安裝驅動
程式的資訊。

程序

1. 從here下載驅動程式。
2. 跳⾄執⾏「安全連接器」的機器，停⽌「安全連接器」。
3. 將檔案複製到 Secure Connector install root\lib\plugins，其中 Secure Connector install root 是安裝「安全
連接器」的⽬錄。例如，C:\Program Files\IBM\Secure Connector。

4. 啟動「安全連接器」。

上層主題： 使⽤「整合」編輯器

選取作業

作業的選擇決定 Cast Iron® Express® 如何監控「來源」和「⽬標」端點並與之互動。對個別作業的⽀援可能因實
作不同⽽不同。例如，FTP 會利⽤取得和放置作業，⽽ salesforce.com ⽀援更新插⼊和取得更新項⽬作業。

關於這項作業

選取作業之前，請檢閱下列資訊，以確保您正在使⽤的特定端點⽀援您要使⽤的活動。

表 1. FTP 作為「來源」端點
作業 產⽣的活動

輪詢⽬錄 每隔 30 秒監視⼀次選擇的檔案是否有更新項⽬。

表 2. 資料庫（MySQL、SQL Server、DB2®、Oracle）作
為「來源」端點

作業 產⽣的活動

取得插⼊的列 從資料庫表格中擷取最近插⼊的項⽬，並觸發整合。

取得更新的列 從資料庫表格中擷取最近修改的項⽬，並觸發整合。

取得刪除的列 從資料庫表格中傳遞最近刪除的項⽬，並觸發整合。

表 3. 資料庫（MySQL、SQL Server、
DB2、Oracle）作為「⽬標」端點
作業 產⽣的活動

插⼊列 根據流經整合的資料建⽴資料庫項⽬。

更新列 根據流經整合的資料修改資料庫項⽬。

刪除列 根據流經整合的資料刪除資料庫項⽬。

表 4. salesforce.com 作為「來源」端點
作業 產⽣的活動

取得刪除的物件 從 salesforce.com 傳遞最近刪除之選定類型的物件，並觸發整合。

取得更新的物件 從 salesforce.com 傳遞最近修改之選定類型的物件，並觸發整合。

表 5. salesforce.com 作為「⽬標」端點
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作業 產⽣的活動作業 產⽣的活動

建⽴物件 根據流經整合的資料建⽴物件項⽬。

更新物件 根據流經整合的資料修改物件項⽬。

更新插⼊物件 根據流經整合的資料更新及/或插⼊物件項⽬。

刪除物件 根據流經整合的資料刪除物件項⽬。

上層主題： 使⽤「整合」編輯器

資料庫觸發程式表格

使⽤資料庫系統做為來源時，Cast Iron® Express® 需要資料庫系統內建⽴觸發程式表格。

當啟動的整合第⼀次使⽤資料庫中的表格時，Cast Iron Express 會通知使⽤者需要建⽴此觸發程式表格。畫⾯上
會顯⽰資訊對話框，說明需要什麼並提供兩個鏈結。其中⼀個鏈結會嘗試連接⾄資料庫，並代表使⽤者⾃動建⽴

觸發程式表格。使⽤此⽅法表⽰配置在整合中的連線詳細資料，包括資料庫系統中⽤以建⽴表格的必要權限。如

果配置的使⽤者沒有必要的權限，則會顯⽰第⼆個鏈結來提供建⽴所需表格的 DDL ⽂件。

此⽂件鏈結可傳送給資料庫管理者，以代表使⽤者建⽴必要的表格。

限制： Cast Iron Express 緩衝區表格使⽤下列欄位名稱：

IH_PK
IH_OPERATION_NAME
IH_FLAG

因此，當您建⽴專屬的表格時，不會⽀援這些欄位名稱，因為它們與觸發程式機制相互衝突。

上層主題： 使⽤「整合」編輯器

選取物件

順利連接來源或⽬標之後，Cast Iron® Express® 會在系統中查詢可處理的物件。

關於這項作業

物件可以是 FTP 伺服器上的檔案、資料庫綱⽬和表格，或是 salesforce.com 物件。所有可⽤的物件以樹狀結構呈
現，可供導覽⾄想要進⾏整合的物件。

「來源」或「⽬標」系統可能隨時變更。例如，新的⾃訂物件可能新增⾄連接的 salesforce.com 帳⼾、新的表格
可能新增⾄資料庫綱⽬，或新的檔案已上傳⾄ FTP 伺服器。

程序

1. 若要選擇要使⽤的物件，請從可⽤清單選取物件。

2. 若要重新整理物件清單，請在「可⽤的物件」區段中按⼀下重新整理圖⽰ 。

上層主題： 使⽤「整合」編輯器

選取欄位
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選取物件時，Cast Iron® Express® 會⾃動查詢「來源」或「⽬標」系統，以識別該物件內的欄位。

關於這項作業

物件內的欄位可能為：

CSV 檔中的記錄。
表格中的直欄。

salesforce.com 物件中的欄位。

欄位會顯⽰在清單中，且每⼀個欄位名稱旁邊都有勾選框。

註： 來源端點是 FTP 伺服器時，在「可⽤的欄位」畫⾯上會有額外的選項，⽽您可以在此畫⾯中指定 Cast Iron
Express 如何解譯選取的檔案。這些選項如下：

分隔字元。這個字元是識別⽤來區隔檔案內的個別欄位。

引號字元。這個字元是識別⽤來括住可能跨多⾏的欄位值。

檔案具有標頭列勾選框。這決定 Cast Iron Express 是否將檔案的第⼀列處理為標頭列。
標底列數⽬。這會決定檔案底端要忽略的列數。⽐⽅說，如果檔案包含總計或摘要。

部分欄位由「⽬標」系統標⽰為選⽤，部分欄位會標⽰為必要。例如，您必須提供名稱，才能使⽤

salesforce.com 建⽴帳⼾物件。Cast Iron Express 會預先選取這些必要欄位，並停⽤該欄位的勾選框，以防⽌取
消選取。這些欄位的名稱後⾯會標⽰星號 (*)。

其他欄位可能為選⽤但常⽤：Cast Iron Express 會預先選取這些欄位以節省時間，但您可以變更這些選擇。

註： 欄位清單上⽅提供全選和全部清除鏈結。

「來源」或「⽬標」系統可能隨時變動；新的⾃訂欄位可能新增⾄連接的 salesforce.com 帳⼾、新的直欄可能新

增⾄資料庫表格，或新的檔案格式上傳⾄ FTP 伺服器。在可⽤的欄位區段中按⼀下重新整理圖⽰ ，可以重新

整理給定的物件的欄位清單。

下⼀步

完成欄位選擇之後，請按⼀下完成按鈕。

現在已定義完成「來源」或「⽬標」，您會回到主要整合概觀。「來源」或「⽬標」以綠⾊勾號標⽰為完成 

上層主題： 使⽤「整合」編輯器

連接⾄ salesforce.com 時使⽤外部 ID

連接⾄ salesforce.com 時，您可以配置 Cast Iron® Express®，在更新插⼊物件作業上使⽤外部 ID。您也可以使⽤
外部 ID 欄位將⽬標 salesforce.com 物件連結⾄其他 salesforce.com 物件。

您可以根據其他系統產⽣的 ID 或索引鍵值，使⽤外部 ID 來識別 salesforce.com 中的物件。salesforce.com 管理
者可以將外部 ID 欄位新增⾄ salesforce.com 物件。如需相關資訊，請參閱您的 salesforce.com ⽂件。

選取 salesforce.com 物件時，Cast Iron Express 會⾃動查詢⽬標系統，以識別該物件內的欄位。

搭配使⽤外部 ID 與更新插⼊作業
在 salesforce.com 中，當選取更新插⼊ 作業時，您可以在「可⽤的欄位」區段中選擇要使⽤的外部 ID。
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搭配使⽤外部 ID 與相關物件
在 salesforce.com 中，當選取建⽴ 或更新插⼊ 作業時，您可以使⽤外部 ID 欄位將⽬標物件連結⾄其他物
件。例如，根據 Account 物件中定義的外部 ID 欄位值，Contact 物件可以連結⾄ Account 物件。

上層主題： 使⽤「整合」編輯器

搭配使⽤外部 ID 與更新插⼊作業

在 salesforce.com 中，當選取更新插⼊ 作業時，您可以在「可⽤的欄位」區段中選擇要使⽤的外部 ID。

程序

1. 在 salesforce.com ⽬標編輯器中，從「作業」功能表中選取更新插⼊物件選項。
2. 在「可⽤的欄位」區段中，從做為外部 ID 功能表選擇必要的外部 ID。
3. 按⼀下完成。

上層主題： 連接⾄ salesforce.com 時使⽤外部 ID

搭配使⽤外部 ID 與相關物件

在 salesforce.com 中，當選取建⽴ 或更新插⼊ 作業時，您可以使⽤外部 ID 欄位將⽬標物件連結⾄其他物件。例
如，根據 Account 物件中定義的外部 ID 欄位值，Contact 物件可以連結⾄ Account 物件。

程序

1. 在 salesforce.com ⽬標編輯器中，從「作業」功能表選取建⽴物件或更新插⼊物件選項。
2. 在「可⽤的欄位」區段中，選取連接⾄預期物件的欄位。那些包含已定義外部 ID 的欄位，會在「類型」直
欄中顯⽰選項清單。從清單選取所需的外部 ID 欄位。

3. 按⼀下完成。

上層主題： 連接⾄ salesforce.com 時使⽤外部 ID

過濾來源物件

Cast Iron® Express® 過濾功能可讓您根據「整合」⾴⾯中顯⽰的欄位值，來控制從來源應⽤程式傳遞⾄整合的記
錄。

關於這項作業

對於此作業，您可以使⽤「整合」⾴⾯，將搜尋準則指定給擷取⾃來源應⽤程式的內容。「整合」⾴⾯的「來

源」區域中，每⼀個欄位旁邊都會緊接著顯⽰過濾器圖⽰：

當您按⼀下過濾器圖⽰時會顯⽰蹦現視窗，讓您設定參數以控制整合所處理的資料。您可以在來源欄位上指定單

⼀或多個過濾器。例如，您可能只想要擷取值超出特定⾦額且產⽣⾃另⼀個國家/地區的銷售訂單，⽽不是擷取所
有現⾏銷售訂單。

程序
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1. 若要過濾來源物件，請按⼀下「整合」⾴⾯的「來源」區域中的物件。 這時會顯⽰與來源物件相關的欄位
清單。

2. 在來源欄位的清單中，尋找想要過濾的欄位，然後按⼀下它旁邊的過濾器圖⽰。 這時會顯⽰「過濾器」蹦
現視窗。您在「整合」視窗中選取的欄位會顯⽰在「過濾器」視窗中。

3. 在「過濾器」視窗的新增過濾器區段中，按下拉功能表，然後選取過濾選項。
可⽤的選項為：

等於

不等於

⼩於

⼤於

在範圍內

4. 在⽂字欄位中，輸⼊過濾器參數。
5. 按⼀下新增。 新的過濾器會顯⽰在「過濾器」視窗的陰影化區域中。
6. 若要將其他過濾器新增⾄來源欄位，請重複之前的步驟。
7. 若要控制如何將多個過濾器套⽤⾄來源欄位，請使⽤「⽐對的過濾器」按鈕。如果您想要將任何 過濾器參
數⽤於來源，請按⼀下任何。如果您想要全部 過濾器都套⽤⾄來源欄位，請按⼀下任何按鈕，將它切換為
全部。

8. 當完成時，請按⼀下關閉。

結果

「整合」⾴⾯上來源欄位旁邊的過濾器圖⽰會加上綠⾊陰影，指出已定義過濾器。

上層主題： 使⽤「整合」編輯器

修改過濾器

您也可以使⽤「整合」⾴⾯來修改現有的過濾器設定，或刪除過濾器。

程序

1. 按⼀下「整合」⾴⾯中來源欄位旁邊的綠⾊過濾器圖⽰。這時會顯⽰「過濾器」視窗。
a. 若要修改特定的過濾器，請跳⾄過濾器定義，然後按⼀下編輯。這時會顯⽰過濾器參數。請使⽤下
拉功能表和⽂字欄位，以修改過濾器設定。完成時，請按⼀下儲存。

b. 若要刪除過濾器，請跳⾄您要刪除的過濾器，然後按⼀下它旁邊的刪除圖⽰。
2. 按⼀下關閉，即可回到「整合」⾴⾯。

結果

已修改的過濾器會顯⽰在「過濾器」視窗的陰影化區域中。如果您已刪除過濾器，則它會從「過濾器」視窗中移

除，⽽且來源欄位旁邊的過濾器圖⽰顏⾊不再是綠⾊。

設定整合

配置「來源」和「⽬標」端點之後，您已準備好定義對映。瞭解資料類型之間隱含轉換的 Cast Iron® 準則，對於
設定整合⽽⾔⼗分重要。繼續之前，讓⾃⼰熟悉本節中的資訊。

當您使⽤「整合」編輯器來定義對映時，會看到來源和⽬標欄位清單以及兩欄錨點。請連接這些錨點來定義對

映。如需對映的相關資訊、有效資料類型的詳細資料，以及如何轉換資料類型，請參閱定義對映。
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下表顯⽰資料類型間之隱含強制轉型的特定準則。「來源」直欄可指定對映轉換中所使⽤的來源資料。「⽬標」

直欄可顯⽰衍⽣的⽬標。「註解」直欄提供所選取作業的任何必要相關資訊。

表 1. 資料類型之間強制轉型的 Cast Iron Express® 準則。
來

源

⽬

標 註解

任

何

字

串

所有資料類型都轉換為字串。

任

何

布

林

"T"、"t"、"true"、"TRUE"、"tRuE"、"1" 和類似項⽬都會強制轉型為 "TRUE"。其他則會強制轉型為
"FALSE"。

字

串

數

字

將含有數值表⽰法的字串（例如 "10" 或 "3.14"）轉換為⼗進位數類型。
註：

未包含數字的字串會在處理來源資料時導致失敗。

字

串

整

數

將含有整數數值表⽰法的字串（例如 "10"）轉換為整數類型。未包含整數的字串會在處理來源資料時導
致失敗。使⽤者可以使⽤「捨⼊」、「上限」或「下限」函數從⼗進位數字串轉換為整數類型，來避免

此狀況。

數

字

整

數

將⼗進位數（例如 10 或 3.14）轉換為整數。針對⾮整數，會以相同⽅式⾃動轉換值，就像使⽤者已套
⽤「捨⼊」函數⼀樣。使⽤者可以使⽤「捨⼊」、「上限」或「下限」函數，對轉換施⾏更特定的控

制。

上層主題： 使⽤「整合」編輯器

定義對映

當配置「來源」與「⽬標」時，您會看到左側的來源欄位清單、右側的⽬標欄位清單及兩欄錨點。請連接這些錨

點來定義對映。

關於這項作業

每⼀個欄位旁邊會緊接著顯⽰錨點：

請在錨點之間繪製連線，將來源欄位對映⾄⽬標欄位。

對映會以下列三種顏⾊的其中⼀種來顯⽰：

綠⾊

指出來源與⽬標資料類型相符，且對映有效。

琥珀⾊

指出資料類型不符，但可能會從某種資料類型⾃動轉換為另⼀種資料類型。例如，數值資料類型可以⾃動

轉換為字串。在此情況下，右側的「結果」直欄中會顯⽰警告圖⽰ 。按⼀下此圖⽰，即可查看警告的詳

細資訊。

紅⾊

指出由於資料類型不相容，來源欄位無法對映⾄⽬標欄位。您無法儲存具有紅⾊對映的任何整合。在此情

況下，右側的「結果」直欄中會顯⽰錯誤圖⽰ 。按⼀下此圖⽰，即可查看錯誤的詳細資訊。
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程序

若要繪製連線，請按⼀下選擇的來源錨點，再按⼀下想要的⽬標錨點，或將來源錨點拖放到⽬標錨點上。

結果

繪出兩個欄位之間的連線。這表⽰當整合執⾏且接收來源系統的資料時，來源欄位的值會維持原樣地複製到⽬標

欄位。Cast Iron® Express® 會從左側的「來源」系統提供範例資料，並將此範例資料移⼊右側「⽬標結果」直欄
中的對映結果。

上層主題： 使⽤「整合」編輯器

定義函數

簡式對映可以從來源欄位複製資料，並放⼊⽬標欄位中。不過，有時需要更複雜的轉換。所有對映都有可⽤來定

義函數的新增函數圖⽰。

關於這項作業

依預設，當登錄 Cast Iron® Express® 帳⼾時，會停⽤此函數。若要使⽤這個額外函數，請按⼀下附加程式，並選
取對映函數 套件。如需相關資訊，請參閱新增函數⾄ Express 帳⼾。

按⼀下「新增函數」圖⽰  可開啟可⽤的函數清單。函數是根據下列種類來分組：

字串

數學

布林

⽇期

公⽤程式

如需這些函數的相關資訊，請參閱名詞解釋。

程序

按⼀下必要函數。 對映中會插⼊函數⽅框。

範例

此範例顯⽰簡單的「字串⻑度」函數。

右側的「結果」直欄也會更新來反映函數結果，⽽⾮簡單複製。

部分函數的可配置性更強，可以接受多個輸⼊欄位。例如，下列畫⾯擷取顯⽰「連結」函數。
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其他來源欄位可以連接⾄函數左側的錨點，如下列畫⾯擷取所⽰。

「連結」函數也有配置選項，按⼀下「編輯」圖⽰  即可顯⽰。您可以變更輸⼊順序，並指定「連結」函數的
配置選項，例如 prefix、defaultDelimiter 及 postfix。

下⼀步

按⼀下套⽤來儲存您的變更。右側的「⽬標結果」直欄會更新。

限制： 如果結果太⻑⽽無法顯⽰在畫⾯上，則會截斷。按⼀下截斷的結果，可在⼯具提⽰中看到完整結果。
上層主題： 使⽤「整合」編輯器

配置函數

您可以配置函數，以符合特定需求。作法是編輯來源欄位和參數以新增或移除來源，或是變更其顯⽰順序。

關於這項作業

依預設，當登錄 Cast Iron® Express® 帳⼾時，會停⽤此函數。若要使⽤這個額外函數，請按⼀下附加程式，並選
取對映函數 套件。如需相關資訊，請參閱新增函數⾄ Express 帳⼾。

請完成下列步驟，以指定連結和其他函數的配置選項。

程序

1. 在「整合」⾴⾯上，按⼀下想要編輯的整合。 該整合會顯⽰在整合編輯器中，⽽先前選取的欄位會顯⽰在
轉換視圖中。

2. 在轉換視圖中，按⼀下來源物件欄位上的錨點，然後按⼀下⽬標物件上的欄位，來對映欄位。 這時會顯⽰

「新增函數」圖⽰ 。

3. 按⼀下「新增函數」圖⽰ ，以檢視可⽤函數的清單。 這時會出現顯⽰可⽤函數清單的「配置函數」蹦
現視窗。

4. 在「配置函數」視窗中，按⼀下想要套⽤⾄對映的函數。 如果函數允許或需要配置其他資訊，則會顯⽰

「編輯」圖⽰ 。

5. 按⼀下「編輯」圖⽰。 這時會出現顯⽰來源欄位和參數的「編輯來源欄位」視窗。
6. 若要編輯來源欄位，請按⼀下「編輯來源欄位」視窗中的列，⽽此列包含您想要編輯的來源欄位。即會強
調顯⽰此欄位。

a. 若要刪除來源欄位，請按⼀下「刪除」圖⽰。 。

b. 若要上下移動來源欄位，請按⼀下「上移」或「下移」箭頭。
7. 完成時，請按⼀下套⽤。
8. 在「整合」⾴⾯上，按⼀下儲存以儲存對整合所做的變更。

結果
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即會儲存您的編輯。

下⼀步

如果您是使⽤函數複合，請參閱複合函數。

上層主題： 使⽤「整合」編輯器

複合函數

複合函數是兩個不同函數的組合，其中⼀個函數的輸出是鏈結為後續函數的輸⼊。下列各主題提供建⽴、編輯或

刪除複合函數的相關資訊。

依預設，當登錄 Cast Iron® Express® 帳⼾時，會停⽤此函數。若要使⽤這個額外函數，請按⼀下附加程式，並選
取對映函數 套件。如需相關資訊，請參閱新增函數⾄ Express 帳⼾。

使⽤複合函數

您可以將函數新增⾄現有複合、變更複合順序，以及刪除函數。

上層主題： 與 Cast Iron Express 整合

使⽤複合函數

您可以將函數新增⾄現有複合、變更複合順序，以及刪除函數。

關於這項作業

依預設，當登錄 Cast Iron® Express® 帳⼾時，會停⽤此函數。若要使⽤這個額外函數，請按⼀下附加程式，並選
取對映函數 套件。如需相關資訊，請參閱新增函數⾄ Express 帳⼾。

請完成下列步驟，以將函數新增⾄現有的複合函數。

程序

1. 在整合⾴⾯上，按⼀下想要編輯的整合。 該整合會顯⽰在「整合」編輯器中，⽽先前選取的欄位會顯⽰在
「轉換」視圖中。

2. 在「轉換」視圖中，從來源物件按⼀下欄位的錨點，然後按⼀下⽬標物件上欄位的錨點。 這時會顯⽰「新

增函數」  圖⽰。
3. 按⼀下「新增函數」圖⽰，以檢視可⽤函數的清單。 這時會出現顯⽰可⽤函數清單的「配置函數」蹦現視
窗。

4. 在「配置函數」視窗中，按⼀下想要套⽤⾄對映的函數。 如果函數允許編輯，或需要配置其他資訊，則會

在其旁邊顯⽰「編輯」圖⽰ 。

5. 按⼀下「編輯」圖⽰。 這時會顯⽰含有「編輯組合」、「編輯來源欄位」和「編輯參數」視窗區段的蹦現
視窗。

註：

「編輯組合」視窗區段顯⽰可⽤的複合函數。

「編輯來源欄位」視窗區段定義第⼀個複合函數的來源（輸⼊）。

「編輯參數」視窗區段顯⽰您在「編輯組合」區段中所選取複合的已配置參數。

6. 在「編輯組合」視窗區段中，按⼀下連結。 這時會出現顯⽰可⽤連結函數參數清單的下拉功能表。
7. 從下拉功能表中選取參數。 這時會使⽤您選取的項⽬來更新視窗。
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8. 按⼀下套⽤。 這時會更新複合函數。
9. 在「整合」⾴⾯上，按⼀下儲存以儲存整合。

結果

這時會使⽤新的函數來更新複合函數。

註： 因為 subsequent 函數接收到單⼀輸⼊，所以無法選擇需要兩個以上輸⼊的函數作為 subsequent 複合函
數。此外，不容許嘗試在複合內建⽴複合函數，⽽且複合函數不會顯⽰為選項。

上層主題： 複合函數

編輯組合函數

您也可以編輯組合來移動、刪除或變更函數的順序。

關於這項作業

請完成下列步驟，以刪除或移動複合函數。

程序

1. 在整合⾴⾯上，按⼀下想要編輯的整合。 該整合會顯⽰在「整合」編輯器中，⽽先前選取的欄位會顯⽰在
「轉換」視圖中。

2. 在「轉換」視圖中，從來源物件按⼀下欄位的錨點，然後按⼀下⽬標物件上欄位的錨點。 這時會顯⽰「新

增函數」  圖⽰。
3. 按⼀下「新增函數」圖⽰。 這時會出現顯⽰可⽤函數清單的「配置函數」視窗。
4. 在「配置函數」視窗中，按⼀下想要套⽤⾄對映的函數。 如果函數允許編輯，或需要配置其他資訊，則會

在其旁邊顯⽰「編輯」圖⽰ 。

5. 按⼀下「編輯」圖⽰。 這時會顯⽰含有「編輯組合」、「編輯來源欄位」和「編輯參數」視窗區段的蹦現
視窗。

6. 在「編輯來源欄位」，選取要刪除或移動的函數。請使⽤  圖⽰，或「上移」和「下移」箭頭來刪除函
數，或將它上下移動。 函數的來源（輸⼊）會修改或移⾄其新位置。

7. 完成時，請按⼀下套⽤。
8. 在「整合」⾴⾯上，按⼀下儲存以儲存整合。

函數清單

Cast Iron® Express® 可選取在對映內使⽤的函數。這些函數可以⽤來操作所對映的欄位值，例如，變更字串內
容、對數字執⾏數值作業，以及操作⽇期和時間值。

依預設，當登錄 Cast Iron Express 帳⼾時，會停⽤此函數。若要使⽤這個額外函數，請按⼀下附加程式，並選取
對映函數 套件。如需相關資訊，請參閱新增函數⾄ Express 帳⼾。

表 1. 字串函數. 此表格列出和說明字串函數
對

映

函

數 說明

944   



對

映

函

數 說明

連

結

接受兩個以上的引數，並將它們強制轉型為字串。傳回轉換之後為其引數值連結的字串。使⽤者也可以配置

字⾸和（或）字尾字串，以及將在每⼀個引數之間插⼊的定界字元。

⻑

度

傳回等於引數值⻑度（以字元為單位）的整數。如果引數值是空序列，則會傳回整數 0。

⼩

寫

將每個字元轉換為其⼩寫對應項⽬（定義於 Unicode 標準的適當⼤⼩寫對映⼩節中）之後，傳回引數值。

⼤

寫

將每個字元轉換為其⼤寫對應項⽬（定義於 Unicode 標準的適當⼤⼩寫對映⼩節中）之後，傳回引數值。

取

代

傳回透過下列作業所取得的字串：將輸⼊中符合所提供型樣的每⼀個⾮重疊⼦字串，取代為出現的取代字

串。

開

始

於

傳回布林結果，指出第⼀個引數值的開頭是否為第⼆個引數的值。

字

串

傳回以字串形式代表的引數的值。此值可以⽤來將數值資料類型強制轉型為字串，以防⽌對映顯⽰警告。

⼦

字

串

傳回在第⼆個引數值所指出位置開始的第⼀個引數值的部分，並持續第三個引數的值所指出的字元數。若為

⼦字串，只有⼀個欄位作為函數的「輸⼊」。不過，若為函數，起始索引和⻑度值是配置於函數對話視窗

中。在現有⽂字（和所有其他說明）中，引數 ⽤於這兩種狀況中。

修

整

傳回含有空格的引數值，該值是透過下列⽅式正規化：刪除前置和尾端空格，並將⼀系列⼀個以上空格字元

取代為單⼀空格。

表 2. 數學函數. 此表格列出和說明數學函數
對

映

函

數 說明

絕

對

值

傳回數字的數值（或模數），⽽不考慮其正負號。

平

均

值

傳回輸⼊順序中值的平均值（即值的總和除以值的數⽬）。

上

限

傳回不⼩於 X 的最⼩整數。

除 傳回第⼀個引數除以第⼆個引數的結果值。

下

限

傳回不⼤於 X 的最⼤整數。
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對

映

函

數 說明

格

式

format-number 函數會將它的第⼀個引數轉換為字串，⽅法為使⽤第⼆個引數所指定的格式型樣字串，以
及第三個引數所指定的⼗進位格式，或是預設⼗進位格式（如果沒有第三個引數）。

第⼆個參數的格式選項如下：

0 - 數字

# - 數字（零顯⽰為不存在）
. - ⼩數點的位置。例如：###.##
, - 千位群組分隔字元。例如：###,###.##
% - 以百分⽐顯⽰數字。例如：##%
; - 型樣分隔字元。第⼀個型樣會⽤於正數，第⼆個則是⽤於負數

第三個參數的⼗進位格式可協助本地化數字，⽽且可以使⽤下列選項：

0 - 數字
# - 數字（零顯⽰為不存在）
. - ⼩數點或貨幣⼩數點
- - 減號
, - 分組分隔字元
E - 以科學記號表⽰法區隔假數與指數。字⾸或字尾中不需要加上引號
; - 區隔正數與負數⼦型樣
% - 乘上 100，並以百分⽐顯⽰
\u2030 - 乘上 1000，並以千分⽐值顯⽰
¤ (\u00A4) - 貨幣符號，取代為貨幣符號。如果加倍，則取代為國際貨幣符號。如果出現在型樣
中，則會使⽤貨幣⼩數點，⽽不是⼩數點

' - ⽤來括住字⾸或字尾中的特殊字元。例如，'#'# 將 123 格式化為 #123。若要建⽴單引號本
⾝，請連續使⽤兩個：# o''clock

上

限

傳回傳遞為引數的節點的最⼤值。

下

限

傳回傳遞為引數的節點的最⼩值。

模

數

傳回模數，或第⼀個引數除以第⼆個引數之後的餘數值。

乘 傳回所有引數相乘的值。

數

字

將引數轉換為⼗進位。

捨

⼊

傳回最接近引數且沒有⼩數部分的數字。如果有兩個這類數字，則會傳回最接近正無限⼤的數字。
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對

映

函

數 說明

減 傳回第⼀個引數減去第⼆個引數的值

總

和

傳回將引數中的值相加⽽取得的值。

表 3. 布林函數. 此表格列出和說明布林函數
對映函數 說明

布林 計算引數的有效布林值。

⾮ 如果有效布林值為 false，則傳回 true，如果有效布林值為 true，則傳回 false。

表 4. ⽇期函數. 此表格列出和說明⽇期函數
對映函數 說明

⽇期時間（⽇

期）

第⼀個引數必須為⽇期格式，⽽第⼆個引數是時間格式。結果是引數中同時具有⽇期和時間

的 DateTime 格式。

⽇期到字串（⽇

期）

第⼆個引數是顯⽰如何格式化⽇期/時間的字串。下列重要字元會取代為⽇期/時間的各部分：

yy - 年份的後兩位數。例如，1986 中的 86
MM - 兩位數的⽉份
dd - 兩位數的⽇期
HH - 兩位數的⼩時
mm - 兩位數的分鐘
ss - 兩位數的秒鐘

例如，如果已使⽤下列輸⼊參數呼叫「格式⽇期字串」函數：

dateTime：2012-02-22T16:18:00.852-08:00

格式字串：MM/dd/yyyy

語⾔環境字串：en_US

將傳回下列字串：02/22/2012。

如需「⽇期到字串」函數的相關資訊，請參閱 Studio 說明⼩節中的「格式化⽇期字串」主
題。

調整到時區（⽇

期）

轉換 TimeDate 以保留特定時區，或轉換為無。例如，套⽤的時區是第⼆個引數：

-10H - 減去 10 ⼩時的時區
+5H30M - 加上 5 ⼩時 30 分鐘的時區
0H - 0 ⼩時的時區

表 5. 公⽤程式函數. 此表
格列出和說明公⽤程式函

數

對映函數 說明

 947



對映函數 說明

複合 鏈結⼀系列函數。

上層主題： 與 Cast Iron Express 整合

管理整合

Cast Iron® Express® 會將帳⼾中定義所有整合的清單顯⽰在「整合」⾴⾯上。

此清單包含每⼀個整合的名稱、前次更新整合的⽇期和時間，以及執⾏前次變更的登⼊名稱。

也會顯⽰整合的現⾏狀態：

執⾏中。整合會繼續執⾏，直到停⽌。

已停⽌。依預設，當定義整合時，狀態為已停⽌。您必須按⼀下已停⽌，才能執⾏整合。當整合狀態顯⽰

為已停⽌時，不會對⽬標系統進⾏更新。

您可以按⼀下刪除圖⽰來移除整合。您必須先確認刪除，然後才能採取任何動作。

修改整合

您可以隨時在「整合」⾴⾯按⼀下清單中的名稱來修改整合。

刪除整合

您可以隨時從整合⾴⾯刪除整合。

上層主題： 與 Cast Iron Express 整合

修改整合

您可以隨時在「整合」⾴⾯按⼀下清單中的名稱來修改整合。

「整合編輯器」會顯⽰前次儲存的整合。您可以變更整合的配置，但「來源」和「⽬標」系統類型除外。

使⽤者可以變更

「來源」或「⽬標」系統的整合「連線」詳細資料名稱。

⽤於與「來源」和「⽬標」系統連接的作業。

與整合互動的物件。

整合所使⽤的欄位清單。

「來源」和「⽬標」系統之間的轉換。

完成時，請按⼀下儲存。如果整合處於「執⾏中」狀態，則會先停⽌，然後更新並重新啟動

上層主題： 管理整合

刪除整合

您可以隨時從整合⾴⾯刪除整合。

程序

1. 按⼀下刪除圖⽰ 
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2. 按⼀下確定。 如果整合在「執⾏中」狀態，則會先停⽌，然後刪除。

上層主題： 管理整合

監視整合活動

您可以使⽤ Cast Iron® Express® 活動⾴⾯，來查看您帳⼾內所有活動的詳細資料。

活動⾴⾯會顯⽰許多不同類型的事件：

整合建⽴、修改及刪除。

整合所執⾏的⼯作。⼯作是從「來源」系統傳過來資料的單⼀實例，經過轉換，然後推送⾄「⽬標」系

統。

詳述帳⼾潛在問題的警⽰。⽐⽅說，如果執⾏中的整合沒有可⽤的安全連接器，則會顯⽰警⽰，指出必須

先啟動安全連接器，才能執⾏任何⼯作。

您可以按⼀下⾴⾯頂端的三個按鈕，來過濾「活動」資訊來源。選項包括：

所有活動，在⼀份清單中顯⽰所有不同類型的活動訊息。

整合活動，只顯⽰與系統中執⾏的⼯作有關的活動訊息。

警⽰，只顯⽰可能需要使⽤者介⼊的警告和錯誤。

「活動」⾴⾯會先顯⽰最近的訊息。

此清單在每次「活動」⾴⾯開啟時會⾃動更新，且每隔 60 秒會在背景中⾃動更新，以確保提供最新的資訊。

上層主題： 與 Cast Iron Express 整合

使⽤率圖表

使⽤率圖表可讓您快速識別特定租⼾的最活躍整合和端點。⼯作成功和失敗的摘要以及整合活動細分，會以⽉和

年圖表呈現。

從整合⾴⾯中，按⼀下圖表圖⽰來開啟圖表顯⽰畫⾯：

若要關閉使⽤率圖表顯⽰畫⾯，請再次按⼀下圖表圖⽰。

您可以使⽤左移及右移箭頭，來捲動各種使⽤率圖表：

過去三⼗天前幾個最為活躍的整合

過去三⼗天前幾個最為活躍的端點

過去⼗⼆個⽉活動總計

每 60 秒會重新整理使⽤率圖表中所顯⽰的資訊。

過去⼗⼆個⽉活動總計 圖表的範例會顯⽰在下列畫⾯擷取中：
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過去三⼗天前幾個最為活躍的整合

此圖表提供在過去 30 天期間已處理⼤部分⼯作之整合的相關資料。前⼗個整合會以活動順序顯⽰在圖表中：最活
躍整合是在圖表的頂端，並往下遞減，⽽最不活躍整合則在圖表的底端。針對前⼗個整合的每⼀個整合，圖表會

進⼀步細分成功⼯作（以綠⾊條欄代表）和失敗⼯作（以紅⾊條欄代表）的總數。按⼀下綠⾊或紅⾊條欄，即可

查看其他詳細⼯作資訊。

過去三⼗天前幾個最為活躍的端點

此圖表提供在過去 30 天期間已處理⼤部分⼯作之端點的相關資料。圖表會將最活躍的端點顯⽰在頂端。針對每⼀
個端點，圖表會進⼀步細分成功⼯作（以綠⾊條欄代表）和失敗⼯作（以紅⾊條欄代表）的總數。按⼀下綠⾊或

紅⾊條欄，即可查看其他詳細⼯作資訊。

過去⼗⼆個⽉活動總計

此圖表提供特定租⼾在最後 12 個⽉期間發⽣之所有整合活動的視圖。所有在最後 12 個⽉發⽣的整合活動都會以
⽉間隔顯⽰。按⼀下特定條欄，以取得該⽉之成功和失敗呼叫細分的其他詳細資料。

上層主題： 與 Cast Iron Express 整合

指導教學

下列指導教學提供如何建⽴整合的範例。您可以使⽤這些資訊，在 Cast Iron® Express® 帳⼾內快速建⽴整合。

指導教學：建⽴本端檔案與 salesforce.com 的整合
您可以建⽴並執⾏與 IBM® Cast Iron Express 的整合。此指導教學說明如何建⽴從本端檔案到
salesforce.com 帳⼾的整合。您可以在單次作業中快速定義整合，並上傳您的資料。

指導教學：建⽴本端檔案與 salesforce.com 的整合

您可以建⽴並執⾏與 IBM® Cast Iron® Express® 的整合。此指導教學說明如何建⽴從本端檔案到 salesforce.com
帳⼾的整合。您可以在單次作業中快速定義整合，並上傳您的資料。

步驟 1：建⽴整合
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在登⼊ Cast Iron Express 之後，請按⼀下整合。當「整合」視圖開啟時，選取您的來源與⽬標端點來建⽴整合。

提⽰： 當建⽴及定義整合時，您可能想要定期按⼀下儲存。因此，如果您遭遇 Web 瀏覽器問題，或由於閒置⽽登
出 Cast Iron Express，則您的⼯作將不會失去。

對於此指導教學，請選取本端檔案作為「來源」，以及 salesforce.com 作為「⽬標」。

按⼀下「⽬標」選項下顯⽰的新建空⽩整合。

這時會顯⽰⼤綱整合，必須在其中定義「來源」、「轉換」及「⽬標」。數字指出整合定義順序：

1. 定義來源端點
2. 定義⽬標端點
3. 將來源端點中的資料路徑對映⾄⽬標端點來定義轉換

步驟 2：配置端點

在來源標頭中，按⼀下編輯。

來源端點配置視圖即會開啟。

按⼀下選取檔案，並選擇您要從中上傳資料的本端檔案。檔案必須是以定界字元區隔的檔案。

對於此指導教學，我們正在使⽤名稱為 accounts.csv 的檔案。
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此檔案包含部分帳⼾資訊，並包括⼀個稱為 "id" 的欄位，可唯⼀識別檔案中的每⼀筆帳⼾記錄。這裡包括所使⽤
accounts.csv 檔案的內容：

id,name,streetAddress,city,postcode,phoneNumber 
0,AcmeCo,10 Downing Street,London,SW1A 2AA,02012345678 
1,MyOtherCompany,221b Baker Street,London,SW2B 3FG,020654321

如果想要選取不同的檔案，請按⼀下變更。

按⼀下載⼊欄位，並驗證⾃動產⽣關於所選取檔案的詳細資料。例如，檔案中使⽤的定界字元。

對於此指導教學，accounts.csv 檔案會使⽤逗點作為定界字元。另外，剩餘的欄位可以保留其預設值。

按⼀下繼續，以顯⽰所選取檔案內的所有可⽤欄位。
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選取您要從中上傳資料的欄位。依預設，會選取所有欄位。

對於此指導教學，我們正在使⽤所有選取的欄位。

完成時，請按⼀下完成。

會針對此整合定義來源端點。

您會回到整合概觀，⽽且這時會顯⽰選取的「來源」欄位。

現在您可以定義⽬標端點。

在⽬標標頭中，按⼀下編輯。輸⼊登⼊ salesforce.com 所需的認證。

這些認證即會進⾏驗證，如果正確，您會登⼊ salesforce.com 帳⼾。會列出您可在整合中使⽤的可⽤商業物件。

對於此指導教學，從物件清單中選取 Account。Account 物件的說明會呈現在「可⽤的欄位」區段中，其會顯⽰
Account 物件中的所有欄位。
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註： 您可以從本端檔案選取感興趣，⽽且想要與資料⼀起載⼊的欄位。您不必整合整個物件，只需整合定義的必
要欄位。

使⽤「作業」選項，為您的整合指定所想要資料作業的環境定義。

對於此指導教學，請選取更新物件作為作業。當整合執⾏中時，它會⾃動更新 salesforce.com 中選取的「帳⼾」
欄位。

選取下列畫⾯擷取中顯⽰的必要「帳⼾」欄位：

完成時，請按⼀下完成。

會針對此整合定義⽬標端點。

您會回到整合概觀。這時會以 salesforce.com 中選取的「⽬標」欄位更新整合。
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在整合概觀中，現在您可以同時看到準備對映的來源及⽬標欄位。

步驟 3：定義轉換

若要完成整合，您必須將欄位從來源對映⾄⽬標。

根據需要，連接來源及⽬標欄位。對於每⼀個來源欄位，請按⼀下錨點，然後按⼀下對應的⽬標欄位錨點。

在此指導教學中，您會將來源欄位中的資料對映⾄⽬標欄位，如下列畫⾯擷取所⽰。您不需要對資料定義函數。

在關於轉換的指導教學中，涵蓋如何定義函數及更複雜的轉換。

輸⼊代表整合的有意義名稱。例如，Local File Accounts to salesforce.com Account。

按⼀下儲存來儲存已完成的整合。然後，按⼀下關閉以回到「整合」視圖。

「整合」視圖列出所有已定義的整合及其現⾏狀態。
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步驟 4：執⾏整合

既然已定義整合，您必須執⾏整合，將來源端點中的資料複製到⽬標端點。

按⼀下您所建⽴整合右側顯⽰的執⾏。

即會執⾏整合，⽽且可透過單次作業，將資料從您定義的來源本端檔案上傳⾄定義的⽬標 salesforce.com 物件。

整合狀態會變更為執⾏中：

您可以按⼀下活動 > 整合活動，以檢視最近的 Cast Iron Express 整合活動。這時會顯⽰活動，⽽且最新的活動會
位於清單頂端。

對於此指導教學，下列畫⾯擷取顯⽰已完成的整合詳細資料。

若要驗證是否順利完成整合，請跳⾄⽬標系統並檢查是否已傳來資料。

當整合完成時，順利完成整合的確認通知也會⽴即顯⽰在視圖的下半部。

上層主題： 指導教學

名詞解釋

本名詞解釋包含 Cast Iron® Express® 的術語及定義。

組合 (Bundles)
組合是指端點的集合。
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連線 (Connection)
可共同⽤來建⽴與來源或⽬標之間連線的內容集（DB 使⽤者名稱、密碼、伺服器、埠等）。
端點 (Endpoint)
代表外部系統的內容，例如資料庫伺服器、FTP 伺服器、電⼦郵件系統，或是企業應⽤程式。這可以作為
「整合設備」的資料來源，或者「整合設備」的處理⽬標。

欄位 (Fields)
物件/表格/檔案的內容（視環境定義⽽定）。
函數 (Functions)
⽤於操作資料的簡式 XSLT 樣式函數。例如 move、concat、not 或 max。
整合 (Integration)
處理活動（如資料對映、轉換及控制邏輯活動）、端點，以及使⽤ Cast Iron Express 所定義及配置資料類
型的特定順序。

作業 (Operations)
在轉換期間已使⽤的動作。在來源端，這些動作為過去式，例如已建⽴、已更新、已刪除或已更新並插

⼊。在⽬標端，這些動作為主動語態，例如建⽴、更新、刪除或更新並插⼊。

來源 (Source)
位於整合左側的原始端點。

⽬標 (Target)
位於整合右側的⽬標端點。

轉換 (Transformation)
將進⾏中的資料從來源格式轉換成⽬標格式的程序定義。這可能（也可能不）包括查閱、過濾及函數。

組合 (Bundles)

組合是指端點的集合。

上層主題： 名詞解釋

連線 (Connection)

可共同⽤來建⽴與來源或⽬標之間連線的內容集（DB 使⽤者名稱、密碼、伺服器、埠等）。

上層主題： 名詞解釋

端點 (Endpoint)

代表外部系統的內容，例如資料庫伺服器、FTP 伺服器、電⼦郵件系統，或是企業應⽤程式。這可以作為「整合
設備」的資料來源，或者「整合設備」的處理⽬標。

上層主題： 名詞解釋

欄位 (Fields)

物件/表格/檔案的內容（視環境定義⽽定）。

表格的欄位是直欄名稱

物件的欄位是其內容名稱

上層主題： 名詞解釋
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函數 (Functions)

⽤於操作資料的簡式 XSLT 樣式函數。例如 move、concat、not 或 max。

上層主題： 名詞解釋

整合 (Integration)

處理活動（如資料對映、轉換及控制邏輯活動）、端點，以及使⽤ Cast Iron® Express® 所定義及配置資料類型的
特定順序。

上層主題： 名詞解釋

作業 (Operations)

在轉換期間已使⽤的動作。在來源端，這些動作為過去式，例如已建⽴、已更新、已刪除或已更新並插⼊。在⽬

標端，這些動作為主動語態，例如建⽴、更新、刪除或更新並插⼊。

上層主題： 名詞解釋

來源 (Source)

位於整合左側的原始端點。

上層主題： 名詞解釋

⽬標 (Target)

位於整合右側的⽬標端點。

上層主題： 名詞解釋

轉換 (Transformation)

將進⾏中的資料從來源格式轉換成⽬標格式的程序定義。這可能（也可能不）包括查閱、過濾及函數。

上層主題： 名詞解釋

About the Cloud
About the Cloud topics provide general information about the IBM® WebSphere® Cast Iron® Cloud.

About Environment Dashboards
About the Cloud
Contacting Technical Support
Navigating the Management Console
The Management Console is a web-based tool that allows you to manage and monitor the various
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systems and resources of your integration environment. This environment can be a physical Integration
Appliance or an environment in the WebSphere Cast Iron Cloud.
Support Information

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/About_the_Cloud/toc_a
bout_the_cloud.html

About Environment Dashboards
An environment dashboard provides multiple snapshot views of project configurations and jobs, a list of
unresolved critical system errors, and an overall project configurations summary, and status of Secure
Connectors. The Dashboard also allows you to search for orchestration jobs by job key. The Search box is
located in the Results section of the dashboard.

To expand the views of the Critical Alerts and Secure Connector Summary, click the icon in the upper right
corner. An expanded view of Project Configuration is available by selecting Repository > Configurations from
the navigation pane. An expanded view of Results is available by selecting Repository > Job Log from the
navigation pane.

A dashboard is available for each environment in a multi-environment cloud. The information the dashboard
displays is specific to its environment.

Parent topic: About the Cloud

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/About_the_Cloud/about
Dashboard.html

About the Cloud
The IBM® WebSphere® Cast Iron® Cloud (Cloud) administrator provisions a tenant for your organization and can
create multiple environments for you to deploy your projects in. The Cloud administrator also provides a
username and password for the tenant administrator.

After the tenant, and any environments are created, it is the tenant administrator that creates users and
groups, and manages environments in the tenant.
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Cloud Tenants

The IBM WebSphere Cast Iron Cloud (Cloud) supports multiple organizations (tenants). Each cloud tenant is
managed by a tenant administrator. The tenant administrator creates and manages users and groups, for a
specific cloud tenant.

You can get a trial version or buy Cast Iron Live licenses using the IBM Marketplace:
https://www.ibm.com/marketplace/cloud/cloud-integration/us/en-us.

Cloud Environments

The Cloud supports multiple environments for each tenant. The environments allow you to stage project
development or isolate project development.

For example, you can have a Development, Staging, and Production environment. These environments display
as tabs in the Cloud Web Application. While the Cloud administrator, not the tenant administrator, creates
these environments for each tenant, it is the tenant administrator that grants permissions to individual
users/groups for each environment.

Note: Some connectors require you to install 3rd party libraries before you can deploy a project to an
environment. In a multi-environment tenant, verify that the environment to which you deploy a project has all
required libraries installed.
Note: To use Studio Verify in a multi-environment tenant, you must specify the environment from which Studio
will retrieve connector libraries.

For example, SAP libraries are installed in the Development environment and Production environment. You
specify the Development environment in your user profile. When you execute Studio Verify for your SAP project,
Studio uses the libraries in the Development environment. You can then chose to deploy your project to the
Development environment or Production environment.

To specify the environment from which Studio Verify retrieves connector libraries:

1. Click your username, located in the upper right corner of the console. The User Profile dialog is
displayed.

2. Click Change Libraries Environment.
3. Select a libraries environment from the list.
4. Click Save.

Studio Cloud

In addition to the desktop version of Studio, you can launch and work with the Studio directly in the Cloud. This
cloud version of Studio (Studio Cloud) allows you to create and deploy projects from the cloud.

Functionally, Studio Cloud is similar to Studio Desktop with a few differences listed here:

The Recently Opened Project option is not available in Studio Cloud.
The Save Remotely toolbar is not available in Studio Cloud, but is available in Studio Desktop when you
are logged in to the Cloud.
For Studio Cloud, when you select Save As Project [Cloud] or Rename Project [Cloud], the wizard does
not display the location on the local file system where the wizard saves a project.
Instead of a New Project option, Studio Cloud has a New Project Local option. The new option creates a
new project on the local file system.
Instead of a Open Project option, Studio Cloud has an Open Project Local option. The new option opens
a project from the local file system.
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Instead of the Save Project option, Studio Cloud has two new options, which depend on whether you are
logged in. If you are logged in, the Save Project [Cloud] options saves projects to the cloud. If you are not
logged in, Save Project [Local] saves the project locally.
Instead of the Save As option, Studio Cloud has a Save As to Local option.
In Studio Cloud, you can select the Save As To Cloud option, which saves a copy of a project to the cloud.
Instead of Rename Project, Studio Cloud has two new options, which depend on whether you are logged
in. If you are logged in, the Rename Project [Cloud] option renames the project locally and remotely. If
you are not logged in, the Rename Project [Local] option only renames the project locally.

Cloud TIPs Wizard

You can now access the TIP Wizard in the Cloud. The TIP Wizard steps you through an integration project
template to help you quickly build your own integration project.

The Cloud Management Console allows you to search all the templates available in the Solutions Repository.
When search results are returned, a check mark in the Certified column of the Solutions page identifies
templates that Cast Iron has tested and certified. User rating information is also available in the Template
Details pane. The final step in the TIP Wizard allows you to rate the template.

To launch the TIP Wizard:

1. In the cloud, select the Create tab. The Solutions page is displayed.
2. In the Search Templates by keyword(s) field, enter a keyword. For example: SAP.
3. Click Search. All templates that match the keyword display.

Note: You can select the Advanced Search option to filtertemplates by first endpoint or second endpoint.

4. Click the appropriate template. The Templates Details pane is displayed.

5. Click the Create a Project Based on this Template link.

Secure Connector

The Secure Connector allows you to access the cloud using endpoints that sit behind your internal firewalls and
transfers data using a secure protocol.

Parent topic: About the Cloud

Feedback | Notices
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http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/About_the_Cloud/about
TheCastIronCloud.html

Contacting Technical Support
Submit technical support issues through the IBM® Support Page.
Parent topic: About the Cloud
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Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/About_the_Cloud/conta
ctingTechnicalSupport.html

Navigating the Management Console
The Management Console is a web-based tool that allows you to manage and monitor the various systems and
resources of your integration environment. This environment can be a physical Integration Appliance or an
environment in the WebSphere® Cast Iron® Cloud.

The navigation pane on the left of the Management Console displays a menu of pages that allow you to view,
configure, and take actions on various systems and resources.

The back and forward buttons on browsers do not allow you to move through the Management Console pages
in the order which you opened them. Use the back and forward arrows in the top right corner of the
Management Console to move through the Management Console pages in the order you opened them.

The user that is currently logged in is also displayed in the top right corner. Click the username to open the User
Profile window.

Parent topic: About the Cloud

Feedback | Notices
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Support Information
The Support Information page provides information about your cloud space. Specifically, the page displays the
version and ID of the cloud your tenant or tenants and environments are running on.

This page also provides the environment ID information you must specify while you are installing a Secure
Connector.

Parent topic: About the Cloud
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Managing Cloud Instances
Managing Cloud Instances topics provide information about installing 3rd party libraries and scheduling
downtimes.

Downloading and Installing SAP JAR Files and DLLs
Installing Vendor Supplied Libraries
Scheduling Downtime

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/Managing_Integration_
Appliances/toc_managing_cloud_instances.html

Downloading and Installing SAP JAR Files and DLLs

Before you begin

You must have an SAP User ID and password to enter the SAP Support Portal to download the files.

About this task

In order to connect to an SAP system, you must install SAP DLLs and JAR files onto your development
environment.

To download and install the SAP jar files and DLLs:

1. Contact SAP Technical Support to obtain the zip files for the following SAP Components:
If the secure connector is running on Windows:

SAP 32 bit JCo version 3.0.10 or later versions - Windows
SAP Java IDoc Class Library 3.0.10 or later versions

If the secure connector is running on Linux:
32 bit SAP JCo 3.0.10 or later versions - Linux (for Intel compatible processors)
SAP Java IDoc Class Library 3.0.10 or later versions

2. Unzip the SAP JCo zip file:
Double-click the sapjidoc30P_x-1000xxxx.zip file.
Use the decompression tool to extract the contents of the compressed file to a temporary
directory. This zip file contains another zip file sapjco3-NTintel-3.0.x.zip. Extract this zip
also to a temporary directory, for example, in Windows: C:\temp\sapjco3-NTintel-3.0.x.
This directory contains the required libraries sapjco3.jar and sapjco3.dll. For example in
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Linux: /tmp/sapjco-linuxintel-3.0.x. This directory contains the required libraries
sapjco3.jar and libsapjco3.so.

3. Unzip the SAP IDoc JCo zip file:
Double-click the sapjidoc30P_x-1000xxxx.zip file.
Use the decompression tool to extract the contents of the compressed file to a temporary
directory, for example, C:\temp\sapjidoc30P_x-1000xxxx. This directory contains the
required library sapidoc3.jar.

Procedure

1. Log on to the Management Console and select System > Connectors. The Connectors page is displayed.
2. Click Update Libraries. The Update Connector Libraries window is displayed.
3. Select SAP in the Connector column.
4. Click the plus (+) button and repeat the following substeps until you have imported all the jar files you

just downloaded.
a. Locate one of the jar files you just downloaded.
b. Click Open to import the jar file. The file displays in the Files to Add column.

5. Click Update.

The files that display in the Files to Add column are not committed until you click Update. If you click
Reset before you click Update, the Management Console does not add the files you uploaded. If the
Management Console times out before you click Update and commit the added files, repeat the last two
steps.

Results

You can now run SAP projects.

Parent topic: Managing Cloud Instances
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Installing Vendor Supplied Libraries

About this task

If your integration project uses a connector that requires additional libraries, you must install the additional
libraries before you deploy the project configuration. Deploying the project configuration before installing the
additional libraries generates runtime errors. For a complete list of connectors that require vendor supplied
libraries, open the Update Connector Libraries page. See the following procedure.

If you have a multi-environment tenant, you must install the 3rd party libraries in each environment where you
deploy a project configuration with a connector that requires the additional libraries.
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For example, you have a tenant with three environments: Development, Staging, and Production. You publish a
project configuration for an SAP endpoint in the Development and Production environments. Before you can
deploy the project configuration, you must install additional SAP libraries on both the Development and
Production environments.

Procedure

1. Click an environment tab.
2. Select System > Connector Libraries to open the Update Connector Libraries page.
3. In the Connector column, select the connector for which you want to install additional files.

Any files that have already been installed display in the Installed Files column.

4. Click the ( + ) icon and select the library file or files to upload. In the cloud, . jar and .dll are valid library
files types. The files you select display in the Files to Add column.

5. Click Update.

The files that display in the Files to Add column are not committed until you click Update. If you click
Reset before you click Update, the Cloud Management Console does not add the files you uploaded. If
the Cloud Management Console times out before you click Update and commit the added files, repeat
the last two steps.

Parent topic: Managing Cloud Instances
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Scheduling Downtime

About this task

Scheduling downtime allows you to perform maintenance on an environment or related system. You can create
downtime rules for project configurations that stop or suspend all enabled orchestration jobs in that project
configuration for a specified duration of time. The project configuration does not have to be undeployed to
create or edit a downtime rule. Downtime rules can occur once or repeat at specific intervals. You must have
administrator or publisher permissions to create, edit, or delete a downtime rule.

By default, downtime rules are stored in GMT time zone. If an administrator modifies the system clock from
GMT to another time zone, downtime rules are executed at the same absolute time. For example: You create a
downtime rule to stop all orchestration between 4:00pm - 4:15pm GMT. The administrator then modifies the
system clock to display PDT. Your downtime rule is modified to now stop all orchestration between 8:00am -
8:15am PDT. To execute the downtime rule at 4:00pm - 4:15pm PDT, you must edit the downtime rule. Times
differences caused by daylight savings are automatically adjusted.

If the environment is offline when a downtime rule is scheduled to occur, all unexecuted rules are identified
and executed in the appropriate order when the environment returns online. After all the backlogged downtime
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rules are executed, you regain control to modify the deployment state of a project configuration.

Procedure

1. From the Navigation pane, select Repository > Configurations. The Project Configurations page is
displayed.

2. Click the project configuration, which contains the downtime rule you want to work with. The
Configuration Details page is displayed.

3. In the Scheduled Downtimes section, click New Rule. The New Downtime Rule dialog box is displayed.
4. Select one of the following actions from the list:

Stop (allows jobs to finish) - At the specified time, prevents any new orchestration jobs from
starting while allowing current jobs to finish processing. This action allows all jobs to end.
Stop (cancel running jobs) - At the specified time, prevents any new orchestration jobs from
starting and stops all currently running jobs. This action immediately stops all jobs.
Suspend - At the specified time, prevents any new orchestrations from starting and pauses any
jobs that are currently running. At the end of the scheduled downtime, the runtime processes the
suspended job from the point it paused.

5. Specify the duration of the downtime by specifying a date and time for Start Downtime and End
Downtime.

6. Optional: Select the Repeat option to create a repeat downtime rule.
a. Specify a repeat interval (numeric value).
b. Specify frequency from the list: Days, Weeks, Months, or Years.

7. Click Save.

Results

The new downtime rule displays in the Scheduled Downtimes section and the Scheduled Downtime counter
increases by one.
Parent topic: Managing Cloud Instances

Edit Downtime Rules

Procedure

1. From the Navigation pane, select Repository > Configurations. The Project Configurations page is
displayed.

2. Click the project configuration, which contains the downtime rule you want to work with. The
Configuration Details page is displayed.

3. In the Scheduled Downtime section, click the downtime rule you want to edit. The Edit Downtime Rule is
displayed.

4. Select one of the following actions from the list:
Stop (allows jobs to finish) - At the specified time, prevents any new orchestration jobs from
starting while allowing current jobs to finish processing. This action allows all jobs to end.
Stop (cancel running jobs) - At the specified time, prevents any new orchestration jobs from
starting and stops all currently running jobs. This action immediately stops all jobs.
Suspend - At the specified time, prevents any new orchestrations from starting and pauses any
jobs that are currently running. At the end of the scheduled downtime, the runtime processes the
suspended job from the point it paused.

5. Specify the duration of the downtime by specifying a date and time for Start Downtime and End
Downtime.

6. Optional: Select the Repeat option to create a repeat downtime rule.
a. Specify a repeat interval (numeric value).
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b. Specify frequency from the list: Days, Weeks, Months, or Years.
7. Click Save.

Deleting Downtime Rules

Procedure

1. From the Navigation pane, select Repository > Configurations. The Project Configurations page is
displayed.

2. Click the project configuration, which contains the downtime rule you want to work with. The
Configuration Details page is displayed.

3. In the Scheduled Downtime section, select the downtime rule you want to delete. The Delete Rules
confirmation window is displayed.

4. Click Yes.

Results

The downtime rule no longer displays.
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 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/Managing_Integration_
Appliances/schedulingDowntime.html

Managing Orchestrations
Managing Orchestrations topics provide information about editing orchestration settings and exporting job
reports.

About Orchestration Settings
Orchestration settings allow you to configure properties for individual orchestrations in a project
configuration. For each orchestration you can specify whether the orchestration is enabled, the logging
levels, logging behavior, and the maximum number of jobs that the orchestration can simultaneously
run.
Editing Orchestration Settings

Feedback | Notices
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About Orchestration Settings
Orchestration settings allow you to configure properties for individual orchestrations in a project configuration.
For each orchestration you can specify whether the orchestration is enabled, the logging levels, logging
behavior, and the maximum number of jobs that the orchestration can simultaneously run.

When a project configuration is undeployed you can edit the following orchestration settings:

Orchestration Settings Description

Enabled Indicates whether an orchestration is enabled and can be deployed. At
least one orchestration in a project configuration must be enabled to
deploy a project configuration. By default, all orchestrations in a project
configuration are enabled.

Logging Level Allows you to specify the level of orchestration details that are logged
in the System Logs.

None - Orchestration status and activity are not logged.
Initial Values - Only the initial values of orchestration variables
are logged.
Initial and Error Values- Both the initial values of orchestration
variables and orchestration errors are logged.
Error Values- Only orchestration errors are logged.
Inline - Orchestration job details are logged for
suborchestrations inline with the job details of the calling
orchestration.
All- The highest level of logging. All orchestration activity is
logged.

Log Synchronously Allows the runtime to synchronize the writing of orchestration events to
the orchestration monitoring logs as the orchestration is running.

By default, this orchestration setting is disabled and orchestration jobs
are not synchronously logged.

Note: When you enable this orchestration setting, the time it takes to
process an orchestration job increases.

Max Simultaneous Job Allows you to specify the number of orchestration jobs that can run
simultaneously.

Parent topic: Managing Orchestrations
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Editing Orchestration Settings

Before you begin

To edit orchestration settings, the project configuration must be undeployed.

Tenant administrators, environment administrators (for the environment where the project is published), and
publisher of a project can edit its orchestration properties.

About this task

Note: If you grant project configuration permissions to a group, the users in that group will have full access to
the project configuration- the user will be able to create new versions of the project configuration, as well as
edit and delete the project configuration.

Procedure

1. Select the environment tab, where the project configuration is published.
2. From the navigation pane, select Repository > Configurations. The Project Configuration page is

displayed.
3. If the project configuration you want to edit is running, stop the project configuration by clicking the 

Stop icon in the Actions column. When the Stop Configuration dialog box displays, click one of the
following options:

Finish Jobs - At the specified time, prevents any new orchestration jobs from starting while
allowing current jobs to finish processing. Allow the jobs to end.
Cancel Jobs - At the specified time, prevents any new orchestration jobs from starting and stops
all currently running jobs. This action immediately stops all jobs.

4. Undeploy the project Configuration, by clicking the Undeploy icon in the Action Column.
5. Click the project configuration you want to edit. The Configuration Details page displays.
6. In the Orchestration section, click Edit to edit the orchestration settings. The Edit Orchestration Settings

window is displayed.
7. Click Save.
8. Deploy the project configuration to begin processing orchestration jobs.

Results

The updates you made display in the Orchestration section of the Configuration Details page and the runtime
processes the orchestration as specified.

Parent topic: Managing Orchestrations
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Managing Projects
Managing Projects topics provide information about creating, managing, and deploying integration projects.

About Naming Projects and Configurations
About Project Configurations
About Projects
Cloning Project Configurations
Copying Projects
Creating Projects From Scratch
Creating Projects From a Template
Deleting Project Configurations
Deleting Projects
Deploying Project Configurations
Editing Project Configuration Properties
Editing Projects
Publishing Projects
Push WSDL from Cast Iron Project to API Management
Push REST API (Swagger) from Cast Iron Project to API Management
Reviewing TIPs
Stopping Project Configurations
Uploading Project Configurations
Working with Project Configurations
Troubleshooting Projects
This topic provides potential solutions for issues you have with the projects in Cast Iron Live.
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About Naming Projects and Configurations
Project and project configuration names cannot be longer than 42 characters. When you create a project or
project configurations avoid using the following list of reserved characters.

Reserved Characters Description

‘ & ’ ampersand

‘ { ‘ ‘ } ’‘ [ ‘‘ ] ’ ' < '' > ' any brackets

‘ * ’ asterisk
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Reserved Characters Description

‘ \ ’ backslash

' ^ ' caret

‘ : ’ colon

‘ $ ’ dollar sign

‘ / ’ forward slash

' # ' number sign

' ( ) ' parenthesis

' | ' pipe

‘ . ’ period

‘ ? ’ question mark

‘ ; ’ semicolon

' ' space

‘ ~ ’ tilde
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About Project Configurations
Project configurations allow you to create multiple variations of the same integration project, so you can create
and publish one project and deploy it to many different scenarios. Within a project configuration you can
specify which orchestrations are enabled, modify configuration properties for endpoints, generate or modify
assets, manage scheduled downtime rules, and control permissions for the project configuration.

Each project you publish has a Default project configuration. In the Management Console, you can create
additional project configurations. The project name, project version, configuration name, and project state
uniquely identify each project configuration.

You must have Administrator privileges or be the publisher of the specific project to create, edit, and delete
project configurations. Administrators and publishers can grant users and groups permissions that allow them
to a create, edit, and delete project configurations.

Enabling and Disabling Orchestrations

The runtime only runs orchestration jobs for enabled orchestration. Before you can deploy a project
configuration, the project configuration must contain at least one enabled orchestration. By default, all
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orchestrations are enabled.

Specifying the orchestration logging level allows you to control the type of orchestration errors that are written
to the system logs. The Management Console also allows you to limit the number of jobs that run
simultaneously. The number of jobs that run simultaneously can affect performance.

You must have administrator or publisher permissions to specify orchestration properties.

Understanding Configuration Properties

You create these configuration properties for a project in Studio. For more information about creating project
properties and specifying a project version, see the Studio online help.

When you publish the project, you can specify values for the configuration properties. The values you specify
for the configuration properties determine how the project is deployed. For example, in a project that contains
database endpoints, you can create properties for database connection parameters. This allows you to create a
project configuration for a test environment connecting to a test database and then use the same project to
create another project configuration for a production environment that connects to another database.

You must have administrator or publisher permissions to edit configuration properties in the Management
Console.

Modifying Assets

If your project configuration contains a database or WebServices endpoint, you must generate assets before
you can deploy the project configuration. If your project does not contain a database or WebServices endpoint,
assets are irrelevant to your project configuration.

You must have administrator or publisher permissions to generate or modify assets.

Scheduling Downtimes

Scheduling downtime allows you to perform maintenance. You can create downtime rules for project
configurations that stop or suspend all enabled orchestration jobs in that project configuration for a specified
duration of time. The project configuration does not have to be undeployed to create or edit a downtime rule.
Downtime rules can occur once or repeat at specific intervals.

You must have administrator or publisher permissions to create, edit, or delete a downtime rule.

Editing Project Configuration Permissions

As an administrator or project publisher, you can grant permissions for project configurations to other users
and groups. When you grant users or groups permissions to a project configuration they are able to create, edit,
and delete the project configuration. By default, permissions to project configurations are granted to only the
Administrator Group. If you want to grant permissions to another group you must explicitly do so.

For example, you are a user with publisher rights and belong to the built-in Publisher group. You publish a
project. Only the Administrator Group and you have permissions to the project configuration. Members of the
Publisher group, of which you are a member, do not have permissions to the project configuration. You must
edit the permission on the project configuration to include another group like Publisher. For more information,
see Granting Project Configuration Permissions.

Parent topic: Managing Projects
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About Projects
Projects contain components that the runtime needs to execute an integration scenario: orchestrations,
endpoints, maps, and other documents. Use Studio to create and test projects without being connected to an
integration environment.

Multiple people can publish multiple projects to the same integration environment. Use Studio to publish
projects to an integration environment or export projects to a staging location. You can later use the
Management Console to upload the exported project. You must have Administrator or Publisher privileges to
publish or upload a project to the integration environment.

When you publish a project from Studio, the Management Console displays the project with default project
settings; creating a default project configuration. You can clone this default project configuration to create new
project configurations, which you can configure for separate development and production environments.

Use the Studio to create projects and specify endpoint configurations properties and then use the Management
Console to specify project configurations and deploy project configurations.
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Cloning Project Configurations

Before you begin

You must have Administrator privileges or be the publisher of a project to clone project configurations.

About this task

Project configurations contain properties and assets that you can configure in the Management Console to
create multiple variations of the same integration project. When you create a new configuration you can choose
to clone an existing project configuration. A cloned project configuration inherits all the configurations from the
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original project configurations. However, if you edit the original configuration project, the changes are not
propagated to the cloned project.

Note: The project configuration you clone does not display on the Favorites view, unless you explicitly add the
project configuration to the view.

Procedure

1. From the Navigation pane, select Repository > Configurations. The Project Configurations page is
displayed.

2. From the Configuration Filter list, select All. All project configurations display.
3. Locate the project configuration you want to clone.
4. Click the Clone icon . The Create Project Configuration dialog box is displayed.
5. Provide a unique name for the new project configuration.
6. Click OK.

Results

The cloned project configuration is displayed on the Project Configurations page. The cloned project has all the
same project configuration details as the original project configuration.

Parent topic: Managing Projects

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/Managing_Projects/clon
ingProjectConfigurations.html

Copying Projects

About this task

The Management Console allows you to copy a project by assigning a new version number to an existing
project.

Procedure

1. Click the Modify tab. The Projects page is displayed.
2. Click the project you want to copy. The Copy Project dialog is displayed.
3. Enter a new project version. The version number can contain a decimal.
4. Click Save.

Results

The copy of the project is displayed in alphabetical order in the Projects page.

Parent topic: Managing Projects
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Creating Projects From Scratch

About this task

You can create a project from scratch in the cloud.

Procedure

1. Click the Create tab. The Solutions page is displayed.
2. Click Create One From Scratch. The Create Project dialog box is displayed.
3. Specify a unique project name.
4. Click Save. The project displays in the Projects page of the Modify tab.

Results

You can now take edit, publish, delete or copy your project. Select the project to view the project details and
assign permissions to your project. If you do assign permissions, click Save to save your updates.

Project details include the environment to which the project configuration was published, a timestamp of the
last time you published the project, and the current state of the project configuration. For example: deployed.
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Creating Projects From a Template

About this task

You can create a project from a template. Templates are stored in the Solutions Repository. All users can create
a template solution and upload it to the Solutions Repository.
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Note: Not all templates in the Solutions Repository are certified. The templates that are certified are denoted
with a Cast Iron® logo.

Procedure

1. Click the Create tab. The Solutions page is displayed.
2. Search for a template.

a. Select a source endpoint.
b. Select a target endpoint.
c. Click Search

You can also select the Keyword Search option to search for a template using a keyword.

3. Choose a template from the solutions that are returned. The template details are displayed.
4. Click Create a project based on this template. Studio Cloud opens and the wizard guides you through the

process of creating your project.
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Deleting Project Configurations

Before you begin

The publisher of a project configuration, the environment administrator, or tenant administrator can delete
project configurations. The publisher of a project configuration can grant permissions that allow other users to
delete his project configuration. The environment administrator can grant permissions that allow other users to
delete any project configuration in the environment. The tenant administrator can grant permissions that allow
other users to delete any project configuration in the tenant.

Project configurations must be undeployed before you can delete them.

About this task

When you delete a project configuration, all monitoring history associated with the project configuration is also
deleted.

Procedure

1. Select the environment tab, where the project configuration is published. A list of project configurations
is displayed in the Project Configuration section of the Dashboard.

2. Verify that the project configuration you want to delete is undeployed. The state displays in parentheses
( ) at the end of the project configuration name. For example, (undeployed)
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3. If the project configuration is in any other state but undeployed, undeploy the project configuration by
clicking the Undeploy icon in the Actions column.

4. In the Actions column, click the Delete icon. The Delete Project Configuration dialog box is displayed.
5. Click Yes.

Results

The project configuration is deleted and no longer available.
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Deleting Projects

Before you begin

The publisher of a project, the environment administrator, or tenant administrator can delete projects. The
publisher of a project can grant permissions that allow other users to delete his project. The environment
administrator can grant permissions that allow other users to delete any project in the environment. The tenant
administrator can grant permissions that allow other users to delete any project in the tenant.

Procedure

1. Select the Modify tab. The Projects page displays a list of projects that can be published.
2. In the Actions column, click the Delete icon. The Delete Project? dialog box is displayed.
3. Click Yes.

Results

The project is deleted; however, any project configurations created from this project are still available.
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Deploying Project Configurations

Before you begin

To deploy or undeploy project configurations, you must have tenant administrator or environment
administrator privileges, or be the publisher of the project configuration.

About this task

The type of endpoint in an orchestration determines the steps you must complete to deploy a project
configuration. A project configuration must contain at least one enabled orchestration before you can deploy
the project configuration. If the orchestration contains a database or Web Services endpoint, you must also
generate assets for the endpoints before you can deploy the project configuration.

By default, all the orchestrations in a project configuration are enabled. Therefore, if the orchestrations in a
project configuration do not require additional configuration and do not access database or Web Services
endpoints, you can deploy your project configuration by clicking the deploy icon next to the project
configuration in any of the Project tabs. If your project configuration requires assets or additional configuration,
see the following deployment procedure.

Note: A project configuration must be in the stopped state for you to undeploy the project configuration.

Procedure

1. Select the environment tab to which you published your project.
2. In the Project Configuration section, select the project configuration you want to deploy. The

Configuration Details page is displayed.
3. In the Orchestrations section, verify that at least one orchestration in the project configuration is

enabled. Edit orchestration settings, as needed.

You cannot edit orchestration settings while a project configuration is running. Stop and undeploy the
project configuration to edit configuration settings.

4. In the Properties section, edit configuration properties, as needed.

You cannot edit configuration properties while a project configuration is running. Stop and undeploy the
project configuration to edit configuration settings.

5. If the project configuration contains a Database or Web Services endpoint, you must generate assets for
these endpoints.

6. Optional: Add a schedule downtime rule.
7. Optional: Assign permissions for the project configuration, which specify which group of users can edit

and deploy a project configuration. By default, tenant administrators, environment administrators, and
the publisher of a project configuration can edit and deploy a project configuration.

8. If you assign permissions, click Save.
9. In the Summary section, click the Deploy icon  to deploy the project configuration.

Results

The project configuration deploys, the runtime starts to process orchestration jobs, and the status is
appropriately updated in the Summary section.

Parent topic: Managing Projects
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Editing Project Configuration Properties

Before you begin

You must have administrator or publisher permissions to edit configuration properties.

About this task

You create configuration properties for an integration project in Studio, before you publish the project to an
environment in the cloud. When you publish the project, you can specify values for the configuration
properties. Configuration properties allow you to move a project configuration from a staging environment to a
production environment.

For example, in a project that contains database endpoints, you can create properties for database connection
parameters. This allows you to create a project configuration for a test environment connecting to a test
database and then use the same project to create another project configuration for a production environment
that connects to another database.

Procedure

1. Select the environment tab, where the project configuration is published.
2. From the navigation pane, select Repository > Configurations. The Project Configuration page is

displayed.
3. If the project configuration you want to edit is running, stop the project configuration by clicking the 

Stop icon in the Actions column. When the Stop Configuration dialog box displays, click one of the
following options:

Finish Jobs - At the specified time, prevents any new orchestration jobs from starting while
allowing current jobs to finish processing. Allow the jobs to end.
Cancel Jobs - At the specified time, prevents any new orchestration jobs from starting and stops
all currently running jobs. This action immediately stops all jobs.

4. Click the project configuration you want to edit. The Configuration Details page displays.
5. In the Properties section, click Edit to edit configuration property values.
6. Modify the configuration properties.
7. Click Save.

Results

The Configuration Details page displays the updated configuration property values.

Parent topic: Managing Projects
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Editing Projects

About this task

You can edit projects in the cloud using Studio Cloud.

Procedure

1. Select the Modify tab and click the project name. Studio Cloud opens.
2. Edit the project as needed.
3. Click Save.
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Publishing Projects

Before you begin

You must be a tenant administrator, environment administrator, or environment publisher to publish projects.

About this task

Publishing a project uploads a project from Studio to a runtime environment.

Procedure

1. In the Management console, select the Modify tab. The Projects page is displayed.
2. In the Actions column, click the Publish Project icon. A lists displays all the environments in the tenant.
3. Select the environment to which you want to publish the project.
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Results

A confirmation displays. The project is available in the environment you selected.
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Reviewing TIPs
You can rate and provide a review for all TIPs that you download. Ratings are given on a scale of 1-5, where 5 is
the highest rating. When you submit your rating and review for a TIP, Studio uploads the information to the
WebSphere® Cast Iron® Solutions Repository. Your rating is combined with any other ratings that have been
submitted by other reviewers and the average is displayed in the Details pane of the specific TIP.
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Stopping Project Configurations

About this task

There are two ways to stop a running project configuration:

Stop (allows jobs to finish) - When you click Finish Jobs, prevents any new orchestration jobs from
starting while allowing current jobs to finish processing. This action allows the Integration Appliance to
end.
Stop (cancel running jobs)- When you click Cancel Jobs, this option prevents any new orchestration
jobs from starting and stops all currently running jobs. This action immediately stops all jobs.

Procedure

1. From the Project Configurations page, select a project configuration.
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2. In the Actions column, click the Stop icon . The Stop Configuration window is displayed.
3. Click either Finish Jobs or Cancel Jobs to stop the project configuration.
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Uploading Project Configurations

Before you begin

To upload a project configuration, you must have tenant administrator, environment administrator, or
environment publisher permissions.

About this task

When you upload a project configuration, you are publishing a project using a two-stage process. First, you
export a project from Studio to an intermediate location. Then from the Management Console, you upload the
project to a cloud environment.

Procedure

1. Select the environment tab, to which you want to upload the project configuration.
2. From the Navigation pane, select Repository > Upload Project. The Upload Project Configuration dialog

box is displayed.
3. In the Local Project File field, specify the path from which to upload the project. You can click Browse to

select a file from your local machine.
4. Specify a project name. The name should not exceed 42 characters and should not contain any

restricted characters.
5. Specify a product version number. This field is not populated with the project version you specified in

Studio. However as a best practice, you should specify a project version that matches the version you
specified in Studio.

6. Click Upload.

Results

The project configuration is displayed in the cloud environment Project Configuration page.

Parent topic: Managing Projects
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Working with Project Configurations
Various views are available for project configurations:

All - Displays the deployment state and status of all project configurations, regardless of the state of the
project configuration. You can clone or delete project configurations from this view.
Recent - Displays the deployment state and status of the most recently published or modified project
configurations. You can clone or delete project configurations from this view.
Favorites - Displays the deployment state and status of project configurations for which you have
permissions. By default, this view is not populated. You must explicitly add project configurations from
either the Recent view or All view.

You can access these views from the Dashboard or by selecting the following path in the Navigation pane:
Repository > Configurations. The Configuration Filter allows you to choose your view from a drop-down list.

The following table describes information available in the various project configuration views:

Columns in Project
Configuration Views

Descriptions

Configuration Displays published project configurations.

Running Displays the number of currently running jobs for the project configuration.

Completed Displays the number of orchestration jobs, for the project configuration, that
were completely processed.

When orchestration monitoring data is purged, the number of orchestration
jobs is reset to 0. For more information about modifying log purging
parameters, see the purging help topics.

Errored Displays the number of orchestration jobs where a runtime error occurred for
the project configuration.

When orchestration monitoring data is purged, the number of orchestration
jobs is reset to 0. For more information about modifying log purging
parameters, see the purging help topics.

Total Displays the total number of orchestration jobs, for the project configuration,
that have run.

When orchestration monitoring data is purged, the number of orchestration
jobs is reset to 0. For more information about modifying log purging
parameters, see the purging help topics.
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Columns in Project
Configuration Views

Descriptions

Actions Displays the state of project configurations, as well as options for you to
delete  or clone  project configurations.

Clicking this icon deploys and runs a project configuration.

Clicking this icon causes the runtime to suspend the orchestration job
processing of the project configuration.

Clicking this icon undeploys a project configurations. You must stop the
project configuration before you can undeploy the project configuration.

Clicking this icon stops the runtime from processing orchestration jobs for
the project configuration.

When you stop a project configuration, you can choose to have the runtime
completely process all currently running jobs or have the runtime cancel all
currently running jobs.

Only available in All and Recent views. Clicking this icon adds the project
configuration to Favorites.

When the Management Console displays the project configuration in
Favorites, this icon is no longer active next to the project configuration in the
All and Recent views.

Clicking this icon removes the project configuration from Favorites, but
does not delete the project configuration from the environment. You can view
the project configuration from the All and Recent views.
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Monitoring
Monitoring topics provide information about creating and managing notifications, viewing hardware status,
searching orchestration jobs, and viewing orchestration job logs.

About Environment Dashboards
Choosing a Notification Level
Creating Notification Policies
Deleting Notification Policies
You can delete one or more notification policies.
Editing Notification Policies
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Enabling Email Notification Policies
Searching for Orchestration Jobs
Viewing Orchestration Job Logs
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About Environment Dashboards
An environment dashboard provides multiple snapshot views of project configurations and jobs, a list of
unresolved critical system errors, and an overall project configurations summary, and status of Secure
Connectors. The Dashboard also allows you to search for orchestration jobs by job key. The Search box is
located in the Results section of the dashboard.

To expand the views of the Critical Alerts and Secure Connector Summary, click the icon in the upper right
corner. An expanded view of Project Configuration is available by selecting Repository > Configurations from
the navigation pane. An expanded view of Results is available by selecting Repository > Job Log from the
navigation pane.

A dashboard is available for each environment in a multi-environment cloud. The information the dashboard
displays is specific to its environment.
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Choosing a Notification Level
Notification levels define the severity of events that can trigger an alert. When you specify a notification level,
an alert is only sent for errors that meet or exceed the level you choose. �

Note: If you do not receive notifications for events, it might be that you do not have the system log level set to
produce entries that would trigger a notification. For example, if you chose the Error level for Deployment, all
events that were Error or Critical level in the Deployment system are logged.

You can specify the following notification levels:

 985



Notification Level Description

Critical Sends an alert when an error condition causes the a shutdown.

Error Sends an alert when non-critical issues that must be handled
immediately occur.

Warning Sends an alert when potential error conditions occur.

Info Sends an alert for informational usage.
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Creating Notification Policies

About this task

Notification policies allow you to monitor potential errors in a specific system. When you create a notification
policy, the notification policy monitors the system log for the system you specify. When a system log event
occurs that meets or exceeds the notification level of a notification policy, an alert is sent to the specified users.

Note: If you do not receive notifications for events, it might be that you do not have the system log level set to
produce entries that would trigger a notification or you did not enable the notification policy. For more
information about specifying system log settings, see Specify System Log Settings. For more information about
enabling email notification policies, see Enabling Email Notification Policies.

Procedure

1. Click the environment for which you will create a notification policy. The Navigation pane is displayed.
2. Select Logs > Notifications. The Notifications page is displayed.
3. Click New Policy. The New Policy dialog box is displayed.
4. Specify a policy name.
5. From the Level Exceeds list, select a level. Alerts are only sent for errors that exceed the level you

choose.
6. From the With System list, select the system you want the notification policy to monitor.
7. Specify the email address or addrdsses of the person or people that will receive the email notification.

When you have multiple email addresses, add one email address per line.
8. Click Save.

Results

The new policy displays on the Notifications page. You must enable email notifications before any alerts can be
sent. If the Email status displays as (inactive), email notifications are not enabled.
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Deleting Notification Policies
You can delete one or more notification policies.

Procedure

1. Click the environment for which you will delete a notification policy. The Navigation pane is displayed.
2. Select Logs > Notifications. The Notifications page is displayed.
3. Select the check box next to the policy you want to delete.

To delete multiple policies, select the top check box. All the policies are selected.

4. Click Delete. The Delete Policies? confirmation window is displayed.
5. Click Yes.

Results

The policy is deleted and is no longer displayed in the Notifications page.
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Editing Notification Policies

Procedure

1. In the Navigation pane, select Logs > Notifications. The Notifications page is displayed.
2. Click a notification policy. The Edit Policy dialog box is displayed.
3. Update the appropriate notification settings.
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4. Click Save.

Results

The updated policy is displayed on the Notifications page. You must enable email notifications before any alerts
can be sent. If the Email status is displayed as (inactive), email notifications are not enabled.

Parent topic: Monitoring
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Enabling Email Notification Policies

About this task

When you create an email notification policy, you must enable the email notification policy for alerts to be sent.
By default, email notifications are not enabled.

If you enable email notification policies, the settings you specified when you created the email notification
determine when an email alert is sent.

Note: If you disable the email notification policy by clearing the Enable Email option, alerts are not delivered for
any email notification policy.

Procedure

1. Click the environment for which you will enable an email notification policy. The Navigation pane is
displayed.

2. Select Logs > Notifications. The Notifications page is displayed.
3. At the top of the page, click the Email link. The Enable Email option is displayed.
4. Select the Enable Email option.
5. Optional: Provide a email subject line that will qualify the alert sent.
6. Click Save.

Results

The Notifications page is displayed with the new policy and the Email status changes from (Inactive) to
(Active). Email notifications will now be sent when an event that triggers the notification policy occurs.

Parent topic: Monitoring
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Searching for Orchestration Jobs

About this task

Job IDs and keys allow you to search for orchestration jobs. You define primary message keys in Studio, when
you configure connectors. The primary message key must be a unique value. For example, the purchase order
number for a purchase order message. If you do not define a primary key, the runtime uses the job ID, a unique
number that the runtime generates, to identify an orchestration job.

From the Management Console, you can search orchestration jobs by job ID. By default, the Management
Console searches only for completed orchestration jobs that match the job ID you specify. Use the Advanced
Search option to search for all other orchestration jobs.

Procedure

1. From the navigation pane, select Dashboard.
2. In the Results section, enter a job ID in the Key Search field.
3. From your keyboard, press Enter. The completed job with the matching job ID displays.

Parent topic: Monitoring

Using Advanced Search

About this task

Use the Advanced Search option to further refine your job search. If you enter values for multiple fields in the
Advanced Search box, the Management Console uses AND logic to refine the search.

For example, you specify a time range in addition to selecting the errored status. The Management Console
searches for all orchestration jobs that had an error within the time range specified.

Note: If you choose to search by date and time, you must specify a start and end date and time.

Procedure

1. From the navigation pane, select Dashboard.
2. In the Results section, select an orchestration. The Orchestration Details page displays all the jobs

associated with the orchestration.
3. In the Advanced Search box, specify values for Job ID, Key, Status, Start Date and Time, or End Date and

Time as appropriate for your search.
Note: If you choose to search by date and time, you must specify a start and end date and time.

4. Click Search.
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Results

The search results are displayed in the table.

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/Monitoring/searchingOr
chestrationJobs.html

Viewing Orchestration Job Logs
The Dashboard displays information about orchestration jobs, including status, timestamp of job events, and
key/job ID in multiple tabs:

All - displays orchestration job information for all project configurations.
Recent - displays orchestration job information for the most recently published or modified project
configurations.
Favorites - displays orchestration job information for the project configurations displayed in the
Favorites filter. Orchestration job information displayed through this filter also displays in the Recent and
All filters.

In some cases, the Management Console displays an orchestration job status of Unknown, even though the
orchestration job completed successfully. Rebooting the environment, while orchestration jobs are processing,
can result in the Unknown status because monitoring data is lost during the reboot. Stop all orchestration jobs
before rebooting the environment to avoid an Unknown status.

Click an orchestration job to view the orchestration details for that orchestration. The Orchestration Details
page displays all the jobs associated with the orchestration you selected and the status of each individual job.
Use the Left and Right arrows (<< , <, >, >>) to view all orchestration jobs.

Parent topic: Monitoring

Sorting Orchestration Jobs

About this task

You can search orchestration jobs by job ID. To sort orchestration jobs by project configuration name,
orchestration name, status, time, or job ID click the appropriate column header.

Feedback | Notices
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Permissions
Permissions topics provide information about creating user profiles, setting and changing passwords, creating
and managing users, and creating and managing groups.

About Built-In Groups
About Libraries Environments
About User Profiles
Assigning Users to Groups
Changing Your Password
Changing User Passwords
Creating New Groups
Creating New Users
Deleting Groups
Deleting Users
Granting Project Configuration Permissions
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About Built-In Groups
Built-in groups are predefined groups. In the cloud, in addition to a tenant administrator group, each
environment has a built-in administrator, publisher, and user group.

For example: A tenant, named Cumulus, is created for your organization. Within this tenant there are two
environments: Development and Production. The following built-in groups would be available:

admin [cumulus.com]
admin [Development]
publisher [Development]
user [Development]
admin [Production]
publisher [Production]
user [Production]

The same user can be a part of multiple groups. You can assign users to a built-in group or create a new group.

Note: If you grant project configuration permissions to a group, the users in that group will have full access to
the project configuration- the user will be able to create new versions of the project configuration, as well as
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edit and delete the project configuration.

The following list defines the permissions granted to each of the built-in groups:

Tenant Administrator Group. Provides privileges to all environments, users, groups, and projects in a
specific tenant. Permits users to create, edit, and delete users and custom groups in the tenant. Users in
this group can add and delete users to and from any built-in or custom group in the tenant. Users in this
group can view, edit, and delete permissions for all source projects in the tenant.

Users in this group can view all the environments in the tenant and have all the permissions of an
environment administrator in each of the tenant environments.

Environment Administrator Group. Provides privileges to all users, groups, and projects in a specific
environment. Permits users to create, edit, and delete users and custom groups in a specific
environment. Users in this group can add and delete users to and from any built-in or custom group in
the environment.

Environment Administrators can also create and deploy project configurations for project that any
environment publisher publishes, and view orchestration job details for any project configuration in the
environment. With environment administrator group privileges you can edit permissions that publishers
for the same environment set for their individual project configurations.

Even though members of the Environment Administrator group have Environment Publisher group and
Environment User group privileges, the members of the Environment Administrator Group do not appear
in other groups in the same environment until you explicitly add the user.

Environment Publisher Group. Provides project privileges in a specific environment. Permits users to
create, deploy, or delete project configurations for any project that they publish in the environment.
Users in this group can also start and stop orchestrations and view orchestration job details for project
configurations they deployed in the environment. As an environment publisher, you can grant
permissions for individual project configurations you create to another user with environment publisher
privileges for the same environment.

The members of the Environment Publisher Group are not displayed in the Environment User Group,
until you explicitly add the user.

Environment User Group. Permits users to monitor alerts and orchestrations in a specific environment.
Users in this group can create and edit projects; however, they cannot publish the project to an
environment. You must have Publisher privileges for the specific environment to which you want to
publish a project. All users are automatically members of the Environment User group.

In a multi-environment tenant, users in this group only see the environment tab for environments of
which they are a member. For example, a tenant has a Development, a Staging, and a Production
environment. The tenant administrator or administrator of the Development environment adds a user to
the User [Development] group. When the user logs in to the tenant, the user can only see the
Development environment, even though the tenant has two other environments.

Parent topic: Permissions
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About Libraries Environments
Libraries Environment is a user profile parameter that specifies the environment from which Studio retrieves
connector libraries.

In a multi-environment tenant, each environment can potentially have different versions of connector libraries
installed. Setting this parameter points Studio to the libraries you want to use while verifying your projects. This
parameter is not as critical if your project does not use an endpoint that requires additional libraries to be
installed. See the Connector Release Notes for a complete list of endpoints that require you to install additional
libraries.

Note: The environment you select should match the environment of the primary group the user is a member of.
For example: If you select the Development environment as the Libraries Environment, you should be a
member of groups in the Development environment.
Parent topic: Permissions
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About User Profiles
A user profile provides a summary of user details, such as: name, display name, email, and group
memberships. The user profile displayed is for the user currently logged in to the Management Console.

From the User Profile window, you can change the user password and specify libraries environments.

Parent topic: Permissions

Accessing User Profile Information

Procedure

1. Click your username in the upper right corner of the Management Console. The User Profile window is
displayed.

2. Optional: Click Change Password, to change the user password.
3. Optional: Click Change Libraries Environment, to specify the environment from which Studio retrieves

connector libraries.
4. Click Save to save any updates to the user profile.
5. Click Close to close the User Profile window.
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Assigning Users to Groups
You must have tenant administrator or environment administrator privileges to assign users to groups.
Environment administrators can only add users to groups in their specific environment.

You can assign users to groups, when you create or edit a user. You can also assign users to groups, when you
create or edit groups.

For more information about assigning users and groups, see Creating New Users and Creating New Groups.

Parent topic: Permissions
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Changing Your Password

About this task

You can change your own password at anytime. However, to modify another user’s password, you must have
tenant administrator permissions. Environment administrators cannot change passwords for users in their
environment.

For example, you are the administrator for the Development environment. You can change your password, but
you cannot change the password for any specific user with permissions to the Development environment.

Procedure

1. Click your username in the upper right-hand corner of the Management Console. The User Profile
window is displayed.

2. Click Change Password.
3. Enter values for the Old Password, New Password, and Confirm Password fields.
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If you clear the Hide Password Text option, your password displays and is no longer encrypted.

4. Click Save to change your password.

Results

A confirmation message is displayed when the Management Console has successfully saved the new password.

Parent topic: Permissions

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/Permissions/changingP
assword.html

Changing User Passwords

About this task

You can change your own password at anytime. However, to modify another user’s password, you must have
tenant administrator permissions. Environment administrators cannot change passwords for users in their
environment.

For example, you are the administrator for the Development environment. You can change your password, but
you cannot change the password for any specific user with permissions to the Development environment.

To change another user’s password:

Procedure

1. Log in to the Management Console as the tenant administrator.
2. Select Setup > Users and Groups.
3. Click the name of the user whose password you want to change.
4. In the Edit User window, enter a password and confirm the password.

If you clear the Hide Password Text option, your password displays and is no longer encrypted.

5. Click Save to change your password.

Results

A confirmation message displays when the Management Console has successfully saved the new password.

Parent topic: Permissions
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Creating New Groups

Before you begin

In the cloud, only the tenant admin user can create new groups. In a multi-environment tenant, environment
administrators can also create new groups for their specific environment.

On a physical or virtual Integration Appliance, only admin users can create new groups.

Procedure

1. In the Management Console, login as administrator.
2. Select Setup > Users and Groups.
3. In the New Group dialog box, enter a Name and Display Name for the new group.
4. From the Scope list, select the scope of permissions you want to grant the group. You can select to give

permissions to the entire tenant or to a specific environment.
5. In the User list, select the users to join the group.

Select the User checkbox to select all the users in the list.

6. Click Save.

Results

In the Groups section of the Users and Groups page, the new group is displayed in alphabetical order.
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Creating New Users

Before you begin
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In the cloud, only the tenant admin user can create new users. In a multi-environment tenant, environment
administrators can also create new users for their specific environment.

On a physical or virtual Integration Appliance, only admin users can create new users.

Procedure

1. Tenant migrated from v7.0
a. In the Management Console, login as administrator.
b. Select Setup > Users and Groups.
c. In the New User window, enter a value for the following fields: Name, Display Name, Email,

Password, and Confirm Password.

Specify the user name without the @tenantname as that will be appended by default.

If you clear the Hide Password Text option, your password displays and is no longer encrypted.

d. From the Libraries Environment list, select the environment from which the user’s projects can
retrieve additional libraries and files for endpoints. The environment you select should match the
environment of the primary group the user is a member of. For example: If you select the
Development environment as the Libraries Environment, you should be a member of groups in the
Development environment.

e. In the Groups list, select all the groups to which the new user will have access.
f. Optional: Clear the Active checkbox. If you clear this option, the user cannot log in to the

Management Console.
g. Click Save.

2. New v7.5 Tenant with 'My IBM Cloud' link
a. Users who neither have an existing Cast Iron account nor any other IBM subscription

i. In the Management Console, login as administrator.
ii. Click My IBM Cloud > Manage Users > Add User Account.

iii. In the Add User window, enter a value for the following fields: IBM ID, First Name, Last
Name.
Note: Specify a valid IBM ID in the IBM ID field.

iv. Choose the Account Administrative Role to be Administrator.
v. Click Save.

b. Users who do not have an existing Cast Iron account but have some other IBM subscription
i. In the Management Console, login as administrator.
ii. Click My IBM Cloud > Services > Invite User.

iii. In the Invite User window, enter a value for the following fields: First Name, Last Name,
Email.
Note: If the Email is not a valid IBM ID, the IBM ID will be created and the user will need to
set the password for it at the time of activation.

iv. Choose the Account Administrative Role to be Administrator.
v. Click Invite.

c. Users with an existing Cast Iron account
i. In the Management Console, login as administrator.
ii. Select Setup > Users and Groups.

iii. In the Add User window, enter a value for the following fields: Name, Display Name, Email.
Note: Specify a valid IBM ID in the Name field.

iv. From the Libraries Environment list, select the environment from which the user’s projects
can retrieve additional libraries and files for endpoints. The environment you select should
match the environment of the primary group the user is a member of. For example, if you
select the Development environment as the Libraries Environment, you should be a
member of groups in the Development environment.
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v. In the Groups list, select all the groups to which the new user will have access.
vi. Clear the Active checkbox. If you clear this option, the user cannot log in to the

Management Console.
vii. Click Save.

3. New v7.5 Tenant without the 'My IBM Cloud' link
a. In the Management Console, login as administrator.
b. Select Setup > Users and Groups.
c. In the Add User window, enter a value for the following fields: Name, Display Name, Email.

Note: Specify a valid IBM ID in the Name field.
d. From the Libraries Environment list, select the environment from which the user’s projects can

retrieve additional libraries and files for endpoints. The environment you select should match the
environment of the primary group the user is a member of. For example: If you select the
Development environment as the Libraries Environment, you should be a member of groups in the
Development environment.

e. In the Groups list, select all the groups to which the new user will have access.
f. Optional: Clear the Active checkbox. If you clear this option, the user cannot log in to the

Management Console.
g. Click Save.

Results

In the Users section of the Users and Groups page, the new user is displayed in alphabetical order.

Parent topic: Permissions

Feedback | Notices

 Last updated: Thursday, 4 August 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/Permissions/creatingNe
wUser.html

Deleting Groups

Before you begin

In the cloud, only the tenant admin users can delete groups from a cloud environment. In a multi-environment
tenant, environment administrators can also delete groups for their specific environment.

On a physical or virtual Integration Appliance, only admin users can delete groups.

Procedure

1. In the Management Console, select Setup > Users and Groups.
2. In the Groups section, select the groups that you want to delete.
3. Click Delete.
4. Click Yes, to confirm that the Management Console should delete the selected groups.

Results
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The Management Console refreshes the list of groups.
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Deleting Users

Before you begin

In the cloud, only the tenant admin user can delete users from a cloud environment. In a multi-environment
tenant, environment administrators can also delete users for their specific environment.

On a physical or virtual Integration Appliance, only admin users can delete users.

Procedure

1. In the Management Console, login as administrator.
2. Select Setup > Users and Groups.
3. In the Users section, select the users you want to delete.
4. Click Delete.
5. Click Yes, to confirm that the Management Console should delete the selected users.

Results

The Management Console refreshes the list of users.
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Granting Project Configuration Permissions

Before you begin
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You must have Administrator privileges or be the publisher of a project to grant permissions to other users or
groups to create, edit, or delete project configurations.

About this task

Once you grant permissions to a user or group, they can edit or delete the project configuration. By default,
permissions to project configurations are granted to only the Administrator Group. If you want to grant
permissions to another group you must explicitly do so.

For example, you are a user with publisher rights and belong to the built-in Publisher group. You publish a
project. Only the Administrator Group and you have permissions to the project configuration. Members of the
Publisher group, of which you are a member, do not have permissions to the project configuration. You must
edit the permission on the project configuration to include another group like Publisher.

Procedure

1. Click on a project configuration. The Configuration Details page is displayed.
2. In the Permissions section, select users and groups to grant permissions to.
3. Click Save.

Results

All the users and groups you select now have full access to the project configuration. These users and groups
can now create new project configurations, edit the project configuration and any new project configurations
they create, and delete the source project.
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Using Secure Connectors
Using Secure Connectors topics provide information about creating, installing, and managing Secure
Connectors.

About Secure Connectors
Secure Connector Minimum Requirements
This topic provides information about minimum system requirements needed to use a Secure Connector.
Creating Secure Connectors
This topic provides information about creating Secure Connectors.
Downloading Secure Connector Configuration Files
How to download Secure Connector configuration files.
Installing Secure Connectors
Provides the procedures to download the Secure Connector installer and install the Secure Connector.
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Adding or importing certificates to the Secure Connector TrustStore/KeyStore
For Cast Iron connector activities, such as HTTP, FTP, Email, or Web Services (or any other connector)
that need to establish connection with the SSL enabled server (HTTPS/FTPS), you must import the
corresponding certificates into the TrustStore or KeyStore of the Secure Connector.
Installing Vendor Supplied Libraries for Secure Connectors
Certain endpoints require additional libraries to be installed before the Secure Connector can
communicate with them. This section provides information about using the Cloud Management Console
to install these vendor supplied libraries. For a complete list of connectors that require vendor supplied
libraries, open the Update Connector Libraries page in the Cloud Management Console.
Downloading and installing the SAP Jar Files and DLLs
To connect to an SAP system from studio, you must install SAP DLLs and jar files onto your Windows
development machine. You must have the SAP login credentials to enter the SAP Support Portal and
download the files.
Uninstalling Secure Connectors (Windows)
This topic provides information about uninstalling a Secure Connector from a Windows machine.
Uninstalling Secure Connectors (Linux)
This topic provides information about uninstalling a Secure Connector from a Linux machine.
Starting and Stopping Secure Connectors
Starting and Stopping Secure Connectors topics provide information about starting and stopping Secure
Connectors on Windows and Linux machines. For Windows machines, options you chose during
installation affect how you can start and stop Secure Connectors. If you installed the Secure Connector
as an automatic Windows Service, as recommended, then you can use the Windows Services control
panel to stop and start the Secure Connector. If you installed the Secure Connector as a Windows
application, then you can start and stop the Secure Connector using Windows Start menu shortcuts or
desktop shortcuts. For Linux machines, you can start and stop Secure Connectors by using a graphical
interface or by running commands from the command line.
Upgrading Secure Connectors
This topic provides information about upgrading Secure Connectors.
Updating Secure Connector Configuration
This topic provides information about updating Secure Connector configuration.
Troubleshooting Secure Connectors
This topic provides potential solutions for issues you have with the Secure Connector.
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About Secure Connectors
A Secure Connector facilitates the secure transfer of data between the IBM® WebSphere® Cast Iron® Cloud and
an endpoint located behind a firewall. The Secure Connector installer for appliance supports both 32-bit and
64-bit Windows and Linux machines.

To enable a Secure Connector a tenant administrator must complete the following tasks:

Create a Secure Connector.
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Download the Secure Connector configuration file.

Launch the Secure Connector installer.

Install vendor supplied libraries.

Parent topic: Using Secure Connectors
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Secure Connector Minimum Requirements
This topic provides information about minimum system requirements needed to use a Secure Connector.

You can run the Secure Connector on the following operating systems:

Microsoft Windows 7
Microsoft Windows 8
Microsoft Windows 2008
Microsoft Windows 2012 R2 64 bit server
Linux (RHEL 6.5, Ubuntu 14.04)
Note: For installing Secure Connectors on Linux platform, use xWindows or KDE environment to use the
GUI option.

The Secure Connector has the following minimum system requirements:

1 GHz CPU
2 GB RAM
Java 1.7 and above.

Parent topic: Using Secure Connectors
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Creating Secure Connectors
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This topic provides information about creating Secure Connectors.

About this task

Use the Management Console to create a Secure Connector for your environment.

After you create a Secure Connector in the cloud, you must configure a machine behind the firewall to facilitate
communication between the Secure Connector and a specific endpoint behind the firewall. Use the Secure
Connector installer to configure the machine behind the firewall.

Note: If the endpoint you are creating a Secure Connector for requires additional libraries, use the Management
Console to install the libraries before you deploy any project configurations that use the Secure Connector.

Procedure

1. From the Navigation pane of an environment tab, select System > Secure Connector.
2. Click New Secure Connector. The Create Secure Connector dialog box is displayed.
3. Provide a name for the new Secure Connector.
4. Provide a brief description of the Secure Connector.
5. Click Save. The Secure Connector is displayed in the Secure Connector page.
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Downloading Secure Connector Configuration Files
How to download Secure Connector configuration files.

About this task

When you download a configuration file, the configuration file is saved to your default download directory. You
can choose to save configuration files to different locations. Regardless of the number of configuration files you
download, you can only use one configuration file during the Secure Connector installation process.

Once you select a configuration file to set up a Secure Connector, that configuration file will be used to
configure any subsequent Secure Connector. It is not recommended to configure multiple Secure Connectors
using the same configuration file. Instead, use a new configuration file or modify the existing configuration file.
The Gateway, Listen to Port, and Transmit to Port parameters should have unique values for each Secure
Connector.

The Secure Connector configuration file provides the Secure Connector installer with values for the following
parameters:

Secure Connector Name - Specify the name of the Secure Connector you created.
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Tenant ID - Specify the hexadecimal UUID for the tenant. You can retrieve this information by logging in
to the cloud and selecting Setup > Support Information. The Support Information page is displayed.
Copy the Identifier column value for the tenant. You can copy the value by selecting the cell value, right-
clicking, and selecting copy from the menu.
Environment ID - Specify the hexadecimal UUID for the environment. You can retrieve this information
by logging in to the cloud and selecting Setup > Support Information. The Support Information page is
displayed. Copy the Identifier column value for the environment where you want the Secure Connector
installed. You can copy the value by selecting the cell value, right-clicking, and selecting copy from the
menu.
Cloud Gateway - Specify the gateway name.
Listen on Port - Only modify this parameter if another service is using the port specified or you want to
run multiple Secure Connectors on the box.
Transmit on Port - Only modify this parameter if another service is using the port specified or you want
to run multiple Secure Connectors on the box.
Secure Connector Auth Key - Specify the Auth key from the Secure Connector you created in the cloud.
Secure Connector Private Key - Specify the Auth private key, which you downloaded while creating the
Secure Connector in the cloud.

Procedure

1. Log into the Cloud Management Console as the tenant administrator.
2. From the Navigation pane of an environment tab, select System > Secure Connector.
3. In the Secure Connector window, click the Secure Connector that will communicate with an endpoint

behind the firewall. The Edit Secure Connector dialog box is displayed.
4. Click Download Secure Connector Configuration and click Download now. The Opening Secure

Connector Configuration dialog box is displayed.
5. Choose Save File and click OK. The configuration file is saved to the default download directory of the

current user.
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Installing Secure Connectors
Provides the procedures to download the Secure Connector installer and install the Secure Connector.

Before you begin

For Windows installations, verify that you do not have an existing version of the Secure Connector installed. If
you have a earlier version installed, you can upgrade it to the latest version using the Upgrade option. For more
information about upgrading Secure Connectors, see Upgrading Secure Connectors.
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For Linux installations, while it is not required, it is good practice to uninstall previous Secure Connector
installations.

For Linux machines, install a desktop environment, such as GNOME or KDE, to provide a graphical interface.

About this task

After you create a Secure Connector in the cloud, you must configure a machine behind the firewall to facilitate
communication between the Secure Connector and a specific endpoint behind the firewall. Use the Secure
Connector installer to configure the machine behind the firewall.

Note: The machine on which you choose to run the installer must have access to the endpoint. You do not have
to run the installer on the same machine as the endpoint.
To download the Secure Connector installer:

1. Log on to the Cloud Management Console as the tenant administrator. The Home page is displayed.
2. Click one of the environment tabs, that is, Development, Staging, and Production.
3. From the Navigation pane of the selected environment tab, click System > Secure Connector.
4. In the Secure Connector window, if you have already created a Secure Connector, click the Secure

Connector that will communicate with the endpoint behind the firewall. The Edit Secure Connector
dialog box is displayed.
Note: If there are no Secure Connectors available in the Secure Connector window, create a new Secure
Connector. For more information about creating a Secure Connector, see <creating secure connector>.

5. Click Download Installer and choose the operating system of the machine to which the installer is
downloaded: Windows or Linux.

6. Click Save File. The file is saved to the default download directory.

To install the Secure Connector:

1. Launch the Secure Connector installer you downloaded.
windows-secure-connector-installer.exe (for 32-bit Windows machine)
windows-secure-connector-installer_64 (for 64-bit Windows machine)
linux-secure-connector-installer.sh (for 32-bit Linux machine)
linux-secure-connector-installer_64.sh (for 64-bit Linux machine)

The Secure Connector Installer Wizard is displayed.

2. Select the Install option.
3. Click Next then read and accept the licensing agreement.
4. Click Next and choose an installation directory.
5. Click Next. A message window states the location where the target directory will be created.

Note: If an install directory exists, a warning message displays and you must confirm that you want to
install and overwrite existing files.

6. Click OK.
7. Set up shortcut options to start, stop, and edit a Secure Connector.

a. Select one or both of the following options:
Create shortcuts in the Start menu.
Create additional shortcuts on the desktop.

b. Select a program group from which you will access the shortcuts.
c. Choose to create shortcuts for the current user or all users.

8. Click Next. The installation progress is displayed.
9. Select a Secure Connector configuration file. If you have not already downloaded a Secure Connector

configuration file, download one now. For more information about how to download Secure Connector
configuration files, see Downloading Secure Connector Configuration Files.

10. Click Next.
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11. For Windows installation, choose to install and run the Secure Connector as a Windows Service. If you
choose install the Secure Connector as a Windows Service, you can control the Secure Connector using
the Windows Services control panel (recommended). If you choose not to install and run the Secure
Connector as a Windows Service, then the Secure Connector is installed as a Windows application. To
run the Secure Connector as a Windows Service, you must specify the following service account
information:

Service Start Mode
Service Account Domain
Service Account User
Service Account Password

12. Click Next. The installation is complete.
13. Click Done.

Note: If your endpoint, for example, SAP, requires additional libraries, you must install the additional libraries
before you start the Secure Connector. For more information about installing additional libraries, see Installing
Vendor Supplied Libraries for Secure Connectors.
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Installing Vendor Supplied Libraries for Secure Connectors
Certain endpoints require additional libraries to be installed before the Secure Connector can communicate
with them. This section provides information about using the Cloud Management Console to install these
vendor supplied libraries. For a complete list of connectors that require vendor supplied libraries, open the
Update Connector Libraries page in the Cloud Management Console.

About this task

If your integration project uses a connector that requires additional libraries, you must install the additional
libraries before you deploy the project configuration. Deploying the project configuration before installing the
additional libraries generates runtime errors. For a complete list of connectors that require vendor supplied
libraries, open the Update Connector Libraries page. See the following procedure.

If you have a multi-environment tenant, you must install the 3rd party libraries in each environment where you
deploy a project configuration with a connector that requires the additional libraries.

For example, you have a tenant with three environments: Development, Staging, and Production. You publish a
project configuration for an SAP endpoint in the Development and Production environments. Before you can
deploy the project configuration, you must install additional SAP libraries on both the Development and
Production environments. For more information about installing SAP libraries, see Downloading and installing
the SAP Jar Files and DLLs.

Procedure
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1. Click an environment tab.
2. Select System > Connector Libraries to open the Update Connector Libraries page.
3. In the Connector column, select the connector for which you want to install additional files.

Any files that have already been installed display in the Installed Files column.

4. Click the ( + ) icon and select the library file or files to upload. In the cloud, . jar and .dll are valid library
files types. The files you select display in the Files to Add column.

5. Click Update.

The files that display in the Files to Add column are not committed until you click Update. If you click
Reset before you click Update, the Cloud Management Console does not add the files you uploaded. If
the Cloud Management Console times out before you click Update and commit the added files, repeat
the last two steps.

6. In the same environment tab, select: System > Secure Connectors.
7. Click Download Libraries and save the libraries.zip file to your workstation.
8. Unzip the libraries.zip file and find a *.tp-1.0.0.jar for each connector module.
9. Use the .jar files in the libraries.zip to replace the files in the Secure Connector install directory:

lib/plugins.
10. Copy all the remaining .zip files to following Secure Connector install directory: lib/thirdparty
11. Restart the Secure Connector by running one of the following files from a command line:

For Windows: runclient_osgi.bat
For Linux: runclient_osgi.sh
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Downloading and installing the SAP Jar Files and DLLs
To connect to an SAP system from studio, you must install SAP DLLs and jar files onto your Windows
development machine. You must have the SAP login credentials to enter the SAP Support Portal and download
the files.

About this task

To download and install the SAP jar files and DLLs:

1. Contact SAP Technical Support to obtain the zip files for the following SAP Components:
SAP JCo Release 3.0.x - based on the platform on which studio is running.

Note: Latest version of JCo jar available: 3.0.14, IDoc version 3.0.12.
2. Unzip the SAP JCo zip file:

Double-click the sapjidoc30P_x-1000xxxx.zip file.
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Use the decompression tool to extract the contents of the compressed file to a temporary
directory. This zip file contains another zip file sapjco3- NTintel-3.0.x.zip. Extract this zip
also to a temporary directory, for example: C:\temp\sapjco3-NTintel-3.0.x. This directory
contains the required libraries sapjco3.jar and sapjco3.dll.

3. Unzip the SAP IDoc JCo zip file:
Double-click the sapjidoc30P_x-1000xxxx.zip file.
Use the decompression tool to extract the contents of the compressed file to a temporary
directory, for example, C:\temp\sapjidoc30P_x-1000xxxx. This directory contains the
required library sapidoc3.jar.

Procedure

1. Open studio, select Tools > Install Module Providers.
2. When the Add Providers dialog box is displayed, click the plus (+) button present beneath SAP

Connector.

A text entry field and a Browse button is displayed.

3. Click Browse, and use the browse dialog box to locate and select the sapjco3.jar file.
4. Click Open to import the jar file contents.
5. Click the next available plus (+) button to add the sapidoc3.jar and sapjco3.dll files.
6. When the jar file is listed in the Add Providers dialog box, click OK.

Results

A prompt is displayed to restart studio and activate the changes.

What to do next

You can now create SAP endpoints and orchestrations.
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Uninstalling Secure Connectors (Windows)
This topic provides information about uninstalling a Secure Connector from a Windows machine.

About this task

The following procedure allows you to uninstall a Secure Connector and all its configuration settings.

Procedure
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1. Verify that another program, such as your browser or command shell, does not have any of the Secure
Connector directories open.

2. From the Windows Start button, select All Programs > IBM > Cast Iron Secure Connector
<connector_name> > Stop Secure Connector.

3. From the Windows Start button, select All Programs > IBM > Cast Iron Secure Connector
<connector_name> > Uninstall Secure Connector. The Uninstaller window is displayed.

4. Select Force the deletion of C:\Program Files\IBM\Secure_Connector _<connector_name>.
5. Click Uninstall.
6. When the status bar displays [Finished], you can close the Uninstaller window.
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Uninstalling Secure Connectors (Linux)
This topic provides information about uninstalling a Secure Connector from a Linux machine.

Before you begin

You must have root level permissions to uninstall the Secure Connector from a Linux machine.

About this task

You can uninstall the Secure Connector by using a graphical interface, issuing a command line command, or
running the Java uninstall .jar file. Choose one of the following options to uninstall a Secure Connector and all
its configuration settings from a Linux machine.

Uninstalling the Secure Connector using a graphical interface: You must have a desktop environment, such
as GNOME or KDE, to successfully uninstall the Secure Connector using this procedure.

1. Verifty that another program, such as your browser or command shell, does not have any of the Secure
Connector directories open.

2. From the application directory, select IBM > Cast Iron Secure Connector <connector_name> > Stop
Secure Connector.

3. From the application directory, select IBM > Cast Iron Secure Connector <connector_name> > Uninstall
Secure Connector.

Uninstalling the Secure Connector from the command prompt:

1. Verify that another program, such as your browser or command shell, does not have any of the Secure
Connector directories open.

2. From the command prompt, issue the ./Uninstaller/uninstall.sh command.
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Uninstalling the Secure Connector with .jar file. You must have Java™ version 1.6 or higher installed to
successfully uninstall the Secure Connector using this procedure.

1. Verifty that another program, such as your browser or command shell, does not have any of the Secure
Connector directories open.

2. From the command prompt, enter the runclient_osgi.sh stop command.
3. In the directory where you installed the Secure Connector, navigate to the Uninstaller sub-directory to

find the uninstaller.jar file: "${JAVA}" -jar "${INSTALL_DIR}/Uninstaller/uninstaller.jar"
where {JAVA} is the Java executable and {INSTALL_DIR} is the Secure Connector name.

A dialog box is displayed.

4. Select the Force the Deletion… option.
5. Click Uninstall.
6. Click Quit.

Results

The Secure Connector is uninstalled. Configuration settings are retained in the home directory.
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Starting and Stopping Secure Connectors
Starting and Stopping Secure Connectors topics provide information about starting and stopping Secure
Connectors on Windows and Linux machines. For Windows machines, options you chose during installation
affect how you can start and stop Secure Connectors. If you installed the Secure Connector as an automatic
Windows Service, as recommended, then you can use the Windows Services control panel to stop and start the
Secure Connector. If you installed the Secure Connector as a Windows application, then you can start and stop
the Secure Connector using Windows Start menu shortcuts or desktop shortcuts. For Linux machines, you can
start and stop Secure Connectors by using a graphical interface or by running commands from the command
line.

Starting and Stopping Secure Connectors on Windows (Installed as a Windows Service)
This topic provides information about starting and stopping Secure Connectors on Windows machines,
where you have a Secure Connector installed as a Windows Service.
Enabling Interactive Mode for Windows Services
When the Secure Connector is installed as a Windows Service, enable the interactive mode for the
service to view system tray icons and command window.
Starting and Stopping Secure Connectors on Windows (Installed as a Windows Application)
This topic provides information about starting and stopping Secure Connectors on Windows machines,
where you have a Secure Connector installed as a Windows application.
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Starting and Stopping Secure Connectors on Linux
This topic provides information about starting and stopping Secure Connectors on Linux machines.
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Starting and Stopping Secure Connectors on Windows
(Installed as a Windows Service)

This topic provides information about starting and stopping Secure Connectors on Windows machines, where
you have a Secure Connector installed as a Windows Service.

About this task

If you installed the Secure Connector as an automatic Windows Service, as recommended, use the Windows
Services control panel to stop or restart the Secure Connector.

By default, when a Secure Connector is installed as a Windows Service, the Secure Connector is not configured
to interact with the Windows Desktop. However, if the Secure Connector service was installed under a local
system account, you can enable an interactive mode that presents system tray icons and a command window
when the Secure Connector service is running.

For steps to enable the interactive mode for a Windows service, see Enabling Interactive Mode for Windows
Services.

Note: If you use the Start Secure Connector Start menu shortcut or desktop shortcut to start a Secure
Connector, the Secure Connector starts as a normal application rather than as a service. You must use the
Windows Services control panel to start Secure Connectors as a service. You can use either the Stop Secure
Connector Start menu shortcut or desktop shortcut to stop a Secure Connector.

Starting and stopping Secure Connectors, using the Windows Services control panel:

Procedure

1. Open the Windows Services window : Start > Control Panel > Administrative Tools > Services.
2. Scroll down the list of services to locate the IBM® Secure Connector service.
3. Right-click on the IBM Secure Connector service and select the appropriate command: Start, Stop,

Pause, Resume, or Restart.

Parent topic: Starting and Stopping Secure Connectors
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Enabling Interactive Mode for Windows Services
When the Secure Connector is installed as a Windows Service, enable the interactive mode for the service to
view system tray icons and command window.

About this task

By default, when a Secure Connector is installed as a Windows Service, the Secure Connector is not configured
to interact with the Windows Desktop. However, if the Secure Connector service was installed under a local
system account, you can enable an interactive mode that presents system tray icons and a command window
when the Secure Connector service is running.

Procedure

1. Open the Services control panel. For example: Start > Control Panel > Administrative Tools > Services.
2. Select the Cast Iron Secure Connector service.
3. Right-click the service name, and select Properties. The Service Properties window is displayed.
4. Select the Log On tab.
5. Select Local System account and then select Allow service to interact with desktop.
6. Click OK.
7. Click Restart.

Results

When the Cast Iron Secure Connector service is restarted, system tray icons and a command window is
displayed.
Note: You can minimize the command window. However, if you close the command window, the Cast Iron
Secure Connector service will be stopped and terminated. Closing the command window is the equivalent of
stopping the Secure Connector service from the Windows Services control panel.
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Starting and Stopping Secure Connectors on Windows
(Installed as a Windows Application)

This topic provides information about starting and stopping Secure Connectors on Windows machines, where
you have a Secure Connector installed as a Windows application.

About this task

When the Secure Connector is installed on a Windows machine as a Windows application, rather than a
Windows Service, you can start and stop the Secure Connector using Windows Start menu shortcuts or desktop
shortcuts.

Procedure

1. Start the Secure Connector from either the Windows Start menu shortcut or desktop shortcut.
From the Windows Start button, select All Programs > IBM > Cast Iron Secure Connector
<connector_name> > Start Secure Connector.
From the Windows desktop, click the Start Secure Connector shortcut to start the Secure
Connector.

2. Stop the Secure Connector from either the Windows Start menu shortcut or desktop shortcut.
From the Windows Start button, select All Programs > IBM > Cast Iron Secure Connector
<connector_name> > Stop Secure Connector.
From the Windows desktop, click the Stop Secure Connector shortcut to stop the Secure
Connector.
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Starting and Stopping Secure Connectors on Linux
This topic provides information about starting and stopping Secure Connectors on Linux machines.

About this task

If you have a desktop environment, such as GNOME or KDE, you can start and stop the Secure Connector using
menu shortcuts or desktop shortcuts. You can also start and stop the Secure Connector using the command
line.

Procedure
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1. Start the Secure Connector from either the menu shortcut , desktop shortcut or command line. Choose
one of the following options:

Select <application> > IBM® > Cast Iron® Secure Connector <connector_name> > Start Secure
Connector .
From the desktop, click the Start Secure Connector shortcut to start the Secure Connector.
From the command prompt, enter runclient_osgi.sh start .

2. Stop the Secure Connector from either the menu shortcut, desktop shortcut, or command line. Choose
one of the following options:

Select <application> > IBM > Cast Iron Secure Connector <connector_name> > Stop Secure
Connector .
From the desktop, click the Stop Secure Connector shortcut to stop the Secure Connector.
From the command prompt, enter runclient_osgi.sh stop.
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Upgrading Secure Connectors
This topic provides information about upgrading Secure Connectors.

Procedure

1. Create a new Secure Connector.
2. Download the latest version of the Secure Connector installer, based on your operating system. For

example, Windows or Linux.
3. On a Windows or Linux machine, launch the Secure Connector installer. The Cast Iron® Secure Connector

wizard guides you through the upgrade process.
Note: If you already have a Secure Connector installation that is higher than or same as the latest
version, a warning message states that you have an existing installation and alternatively you can
upgrade the existing installation.
Note: You must stop the Secure Connector (if already started) before upgrading.
Note: Before you proceed with the Secure Connector upgrade process, ensure that you have:

Stopped the Secure Connector
Taken a manual backup of the certificates (if any) located at
<secure_connector_install_path>/etc/security or jre/lib. You may want to
replace/add your certificates after upgrade.

4. Click the Upgrade option. The Select the installed path list box is displayed.
5. Select the Secure Connector installed path, if it is displayed in the list box. Else, click Browse button to

select the installed path.
6. Click Next, then read and accept the licensing agreement.
7. Click Next. The installation progress is displayed. A message is displayed stating that the installation has

been completed successfully. The path to the installer program is also displayed.
8. Click Done.
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9. Start the Secure Connector.
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Troubleshooting Secure Connectors
This topic provides potential solutions for issues you have with the Secure Connector.

Secure Connector log files are available for your review. The Log directory is created after the initial start of the
Secure Connector. The Log directory is located in the Secure Connector install directory. For example:
C:\Program Files\IBM\Secure_Connector_1.development\logs

A port contention error occurs. A port contention error can occur when two Secure Connectors are
configured to use the same port and gateway. To resolve the issue, provide unique values for the
Gateway, Listen on Port, and Transmit on Port parameters in each Secure Connector configuration file.
Unable to run .jar file to uninstall a Secure Connector. Verify that the Java™ path is specified correctly
and that you have Java version 1.6x or higher installed on the machine.
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Security
Security topics provide information about generating and managing certificates.

About Certificates
Editing Security Settings
Exporting Certificates
Generating Certificate Signing Requests
Generating Self-Signed Certificates
Importing Certificates
Renaming Certificate Alias
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About Certificates
Certificates enable secure communication between the Integration Appliance and endpoints located in your
intranet and extranet. Use the Management Console to manage certificates.

From the Certificates page, you can generate, import, and update security certificates and security settings.

The following tables provides definitions for certificate terminology.

Certificate Terminology Definition

Alias A string of alphanumeric characters you assign to a KeyStore or
TrustStore entry to provide a more user friendly name. Within a KeyStore
or TrustStore you can use an alias to refer to the keys and certificates.
Note: Aliases are not case sensitive. For example, MyCert and mycert
refer to the same entry.

Certificate A signed credential which identifies an endpoint or organization.

Key Pair A public key and associated private key.

KeyStore A Java™ data store that houses private keys and certificates used by a
Java SSL endpoint. For example, a local Java endpoint supplies a
certificate from its KeyStore as a credential to identify itself to a remote
SSL endpoint.

PKI Public Key Infrastructure is a system for managing encryption keys and
identity information. The purpose of the system is to provide standards
based system for protecting/securing communications over the internet.

Private Key A key known only to a single endpoint used to encrypt and/or sign data.

Public Key A key associated with a private key that can be distributed to anyone.

SSL Secure Sockets Layer enables secure web communications and permits
endpoints to optionally authenticate each other.

TrustStore A Java data store that houses certificate authority signed certificates.
For example, a local Java endpoint utilizes a TrustStore to authenticate
the identity (certificate) provided to it by a remote SSL endpoint.

Parent topic: Security
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Editing Security Settings

Procedure

1. In the Key Store section, click Generate. The Generate Self-Signing Certificate dialog box displays.
2. In the Settings section, click Edit. The Edit Settings dialog box is displayed.
3. Select the certificate alias for which you want to edit settings.
4. Select the cipher strength:

Standard
Strong

5. Click Save.
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Exporting Certificates

Procedure

1. In the Key Store section, click Generate. The Generate Self-Signing Certificate dialog box displays.
2. In the Key Store section, click on an alias. The Certificate Details window is displayed.
3. Click Export. The Export Certificate dialog box is displayed.
4. Select an exporting format.
5. Provide a password.
6. Click Export.

Parent topic: Security

Feedback | Notices
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Generating Certificate Signing Requests

Procedure

1. In the Key Store section, click Generate. The Generate Self-Signing Certificate dialog box displays.
2. In the Key Store section, click on an alias. The Certificate Details window is displayed.
3. Click Generate CSR. The Certificate Content window is displayed.
4. Click Copy. The entire contents of the window is copied.
5. Click Download and enter a location for the download.
6. Click Save. The certificate contents are downloaded to the specified location.

Parent topic: Security
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Generating Self-Signed Certificates

Procedure

1. In the Key Store section, click Generate. The Generate Self-Signing Certificate dialog box displays.
2. Specify values for the following parameters:

Alias - The name used to identify the key pair.
Common Name (CN)
Organization (O)
Organization Unit (OU)
Country (C) - Select a country from the list
State (ST)
Locale (L)
Email (EMAILADDRESS)
OID -
Key Algorithm - Choose an algorithm type from the list.
Key Length - Choose a value from the list.
Valid For: - Specify the length of time this certificate is valid for in years and days.

3. Click Generate.

Results
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The self-signed certificate displays in the Key Store table.

Parent topic: Security
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Importing Certificates

About this task

You can import a certificate or certificate chain into the IBM® WebSphere® Cast Iron KeyStore. You can also
import trusted Certificate Authority certificates (CA Certs) to the TrustStore.

Procedure

1. In the Key Store section, click Generate. The Generate Self-Signing Certificate dialog box displays.
2. In the Key Store or Trust Store section, click Import. The Import Certificates dialog box is displayed.
3. Specify an alias name. This name is used to identify the imported certificate or certificate chain.
4. Optional: Provide a key password.

The password protects the private key of the key pair associated with the alias. If you do not specify a
password, the password defaults to the password protecting the KeyStore.

5. If you are importing a certificate from a trusted site, select the Trusted option.

If you select the Trusted option, the certificate is imported without checking for an existing chain of
trust. If you do not select the Trusted option, the KeyStore and TrustStore is checked to ensure a chain
of trust exists for the certificate being imported.

6. Choose to import the content from a file or from content in the clipboard that contains the certificate or
certificate chain to be imported.

Supported formats include: CER/PEM (RFC 1421), DER, PKCS7, and PKCS12.

7. Click Import.

Results

The certificate is displayed in the Certificates page.

Parent topic: Security

Feedback | Notices
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Renaming Certificate Alias

Procedure

1. In the Key Store section, click Generate. The Generate Self-Signing Certificate dialog box displays.
2. In the Certificate page, select an Alias. The Certificate Details dialog box is displayed.
3. Click Rename.
4. In the Alias field, enter a new alias.
5. Click Apply.

Results

The updated alias is displayed on the Certificates page.

Parent topic: Security

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.live.doc/CloudHelp/Security/renamingCerti
ficateAlias.html

Uploading Certificates

Procedure

1. In the Key Store section, click Generate. The Generate Self-Signing Certificate dialog box displays.
2. In the Key Store section, select an alias. The Certificate Details window is displayed.
3. Click Upload. The Update Certificate dialog box is displayed.
4. If you are uploading a certificate to a trusted site, select the Trusted option.
5. Choose to upload the content from a file or from content in the clipboard.
6. Click Import.

Parent topic: Security

Feedback | Notices
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Working with Logs
Working with Logs topics provide information about specifying system settings, and viewing system logs.

Specify System Log Settings
Viewing System Logs
Viewing Job Logs
Customizing columns in System log and Job log
You can customize the columns displayed in the System log and Job log pages, respectively.
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Specify System Log Settings

About this task

You can specify the level of details that appears in the system logs. The log level you specify affects alerts for
notification policies. Alerts are only sent for events that meet or exceed the log level you specify.

Note: If you do not receive notifications for events, it might be that you do not have the system log level set to
produce entries that would trigger a notification.

Procedure

1. In the Navigation pane, select Logs > System Log. The System Log page is displayed.
2. Click Settings. The System Log Settings dialog box is displayed.
3. From the list, select a log level for each system.
4. Click Save.

Results

A confirmation message displays. The system log logs all events that occur at the level you specified or higher
for the specific system. For example, if you chose the Error level for Deployment, all events that were Error or
Critical level in the Deployment system are logged.

Parent topic: Working with Logs
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Viewing System Logs

About this task

You can view system logs from the Management Console and use the system log filters to sort through system
log entries.

When you upgrade, the Management Console does not persist system logs. To retain system log information,
export system logs before you upgrade.

Note: The Management Console displays a maximum of 99,999 system log entries. When the number of
system log entries exceeds 99,999, the oldest log entry is deleted from the system log.

Procedure

1. From the navigation pane, select Logs > System Log. The System Log page is displayed.
2. Choose the filter values from the lists at the top of the System Log page.

You can filter the log entries according to the level of severity for the event, the environment system that
generated the log event, dates, and resolution state. The filters use AND logic.

Parent topic: Working with Logs

System Log Content
The system log provides the following information:

System Log Content Description

Level Identifies the level of severity of the log event:

Critical
Error
Warning
Info

System Identifies the system where the log event occurred.

Message Text messages that provides details about the log event.

Job When available displays Job ID information for log events that occur in the
Orchestration system.
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System Log Content Description

When Records the time when the log event occurred.

Resolved On Provides a time stamp of when you resolved a log event.

Resolved By Identifies which user resolved a log event.

Resolved Select this checkbox to acknowledge that you have resolved a log event.
When a user resolves a log event, a time stamp documents the date and time
the issue was resolved. Information about the user who resolved the log
event is tracked in the Resolved By column. You can resolve all the system
log issues, by clicking Resolve All. Clear the checkbox next to any log events
that are not resolved and the Resolved On and Resolved By values are
cleared.
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About the Web Management Console
About the Web Management Console (WMC) topics provide general information about the WMC.

About Management Console Settings
From the Settings link, you can manage various user profile, session, and display preferences. The Web
Management Console supports only the English language. The Settings link is in the upper right corner of
the Management Console.
Contacting Technical Support
Submit technical support issues through the IBM® Support page.
Navigating the Management Console
The Management Console is a web-based tool that allows you to manage and monitor the various
systems and resources of your integration environment. This environment can be a physical Integration
Appliance or an environment in the WebSphere® Cast Iron® Cloud.
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About Management Console Settings
From the Settings link, you can manage various user profile, session, and display preferences. The Web
Management Console supports only the English language. The Settings link is in the upper right corner of the
Management Console.

From the Settings dialog box, you can view and edit the following settings and preferences.
Table 1. User Profile Setting

User Profile Setting Description

User Name The name of the user currently logged in.

Display Name The name that displays on the console and that displays in the logs.

Password Password for the current user:

Minimum length is 8 characters
Maximum length is 15 characters
Must contain characters from 3 of the 4 following categories:

1. upper-case
2. lower-case
3. numeric
4. punctuation (for example, !, $, #, %)

Must not contain any 3 character substring of user name
Must not contain any 3 character substring of prior password

Email Current® user email address. Email notifications are sent to this email.

User Groups User groups for which the user is a member.

Login Policy

When the 5th consecutive login failure occurs for a single user, in any span of time, the user is prohibited from
logging-in again for a delay interval of 15 seconds.

For each subsequent login failure, the delay interval doubles until the delay interval capacity is reached. The
delay interval capacity is 1 hour. A successful login by the user resets the login failure count and the delay
interval for the user.

Table 2. Session Settings
Session Settings Description

Inactivity
Timeout

The amount of inactive time the console waits before logging off the current user. You can
choose one of the following timeout intervals:

5 minutes
15 minutes
30 minutes
60 minutes
Never

1024   



Session Settings Description

Dashboard
Refresh Interval

The amount of time the console waits before refreshing the view. You can choose one of
the following refresh intervals:

15 seconds
30 seconds
60 seconds
Off

Table 3. Display Settings
Display
Settings Description

Time Zone Allows you to specify the time displayed on the console. You can specify one of the following
display modes:

Local Time (GMT-0800)
Remote Time (GMT)
GMT

Page Size
for Jobs
Log

Allows you to specify the number of rows of the Jobs log to display on the console. You can
choose to display 15, 25, 50, or 100 rows.

Page Size
for System
Log

Allows you to specify the number of rows of the System log to display on the console. You can
choose to display 15, 25, 50, or 100 rows.

Maximum
Age for
Recent
Jobs

Allows you to specify the age of the recent jobs that are displayed on the console. For example,
if you choose 1 hour, any job that is older than an hour is not displayed. You can include jobs as
old as: 1 hour, 2 hours, 4 hours, 8 hours, 1 day, 2 days, 5 days, or 1 week.

Maximum
Age for
Recent
Configurati
ons

Allows you to specify the age of the recent project configurations that are displayed on the
console. For example, if you choose 1 day, any project configuration that is older than a day is
not displayed. You can include project configurations as old as: 1 day, 2 days, 5 days, 1 week, 2
weeks, 3 weeks, or 4 weeks.

Parent topic: About the Web Management Console
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Contacting Technical Support
Submit technical support issues through the IBM® Support page.
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For more information, see http://www.ibm.com/support/us/en/.
Parent topic: About the Web Management Console
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Navigating the Management Console
The Management Console is a web-based tool that allows you to manage and monitor the various systems and
resources of your integration environment. This environment can be a physical Integration Appliance or an
environment in the WebSphere® Cast Iron® Cloud.

The navigation pane on the left of the Management Console displays a menu of pages that allow you view,
configure, and take actions on various systems and resources.

If you have logged on to the Management Console as an administrator, you can view the reports of:

Publish details: Displays the configurations published, by whom it was published, and the date and time
when it was published.
Login History: Displays the login history of the user or users that logged on to the appliance. The login
history includes the name of the user, the log in time, and the log out time.

The back and forward buttons on browsers do not allow you to move through the Management Console pages
in the order which you opened them. Use the back and forward arrows in the top right corner of the
Management Console to move through the Management Console pages in the order you opened them.

The user that is currently logged in is also displayed in the upper right corner. Click Settings > User Profile to
open the User Profile window.

Parent topic: About the Web Management Console
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Local Staging Database
Local Staging Database topics provide information about using the local staging database in the Web
Management Console.
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About the Local Staging Database
Starting the Local Staging Database
Stopping the Local Staging Database
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About the Local Staging Database
In Studio, you can build projects with Data Quality activities that sort and merge data from a source system to
help you cleanse and quickly migrate the data to a target system. As the Data Quality activities in a project
iteratively process data from a source system--sorting "good" and "bad" data, the Integration Appliance can
store the data in a Local Staging Database.

From the WMC, you can view the local database tables and lookup tables to make further changes, as needed,
to the processed data. You must have the appropriate permissions to view tables and perform operations on
the Local Staging Database.

Important: The Local Staging Database must be started before you can view the Database Viewer in the WMC.

Database Viewer Panes

The Database Viewer is made up of three panes:

Database Objects pane
Located on the left-hand side of the Database Viewer, this pane displays all tables in the Local Staging
Database, including fields and rows.

Query pane
Located in the upper-right side of the Database Viewer, this pane provides a workspace for you to
validate and submit queries to the Local Staging Database. You can manage each query in a separate
tab. You can perform the following operations on each tab:

Validate Query

Submit Query

Clear Query

Close Tab

Summary pane
Located in the lower-right side of the Database Viewer, this pane contains two tabs: Results and History.

Results tab - Provides a summary of the rows returned from the query.
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History tab - Provides a log of events that have occurred on the Local Staging Database. A time
stamp marks each event logged. The log of events persists as long as the WMC is open. Once you
close the WMC, the History tab is cleared.

Parent topic: Local Staging Database
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Starting the Local Staging Database

About this task

From the WMC, you can start and stop the Local Staging Database. You must start the staging database to view
or update data. By default, the staging database is in a stopped state. In the stopped state, you cannot view or
update the staging database. When you stop the database, all sessions for all users also stop.

Only users with Administrator privileges, granted as being part of the built-in Administrator group, can start,
stop, and perform operations on the Local Staging Database. Users with Publisher privileges can only view the
database if the Local Staging Database has already been started by a user with Administrator privileges. If the
Local Staging Database has not been started, users with Publisher privileges will not be able to view the
database. Users that are part of the built-in Users group or with WMC login credentials created in an LDAP
Server do not have access to the Local Staging Database.

Procedure

1. From the navigation pane, select System > Staging DB. The Staging DB page is displayed.
2. Click Start Database.

Parent topic: Local Staging Database
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Stopping the Local Staging Database
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About this task

From the WMC, you can start and stop the Local Staging Database. You must start the staging database to view
or update data. By default, the staging database is in a stopped state. In the topped state, you cannot view or
update the staging database. When you stop the database, all sessions for all users also stops.

Only users with Administrator privileges, granted as being part of the built-in Administrator group, can start,
stop, and perform operations on the Local Staging Database. Users with Publisher privileges can only view the
database if the Local Staging Database has already been started by a user with Administrator privileges. If the
Local Staging Database has not been started, users with Publisher privileges will not be able to view the
database. Users that are part of the built-in Users group or with WMC login credentials created in an LDAP
Server do not have access to the Local Staging Database.

Procedure

1. From the Navigation pane, select System > Staging DB. The Staging DB is displayed.
2. Click Stop Database.

Parent topic: Local Staging Database
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Best Practices for Memory Management
Outlines memory management best practices to maintain a healthy runtime environment and avoid out of
memory errors.

An Integration Appliance sets aside a pool of memory to run orchestration jobs. Managing this pool of memory
is key to maintaining a healthy runtime environment.

There is a direct relationship between the amount of memory used and garbage collection cycles. Garbage
collection is a process that returns memory, held by completed jobs and variable data, back to a pool of
memory used by all orchestration jobs. This garbage collection process ensures that the Integration Appliance
has a constant supply of free memory that new orchestration jobs can use.

Garbage collection (GC) is a continual process that runs in the background with no effect on orchestration job
performance. However, when memory reaches a critical threshold, a more in-depth process known as full
garbage collection occurs. The full garbage collection process puts all the running jobs into a sleep state and
returns unused memory back to the pool. Because all orchestration jobs stop during a full garbage collection,
frequent full garbage collections can affect orchestration performance.

When the GC Activity value on the Resource Utilization Graph spikes at regular intervals, there is most likely a
high demand on memory that the Integration Appliance is trying to manage by initiating more frequent full
garbage collection cycles. However, high memory usage does not necessarily mean an increase in full garbage
collection cycles. For example, a large volume of short running orchestrations results in a larger percentage of
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memory being used. But the garbage collection cycles, constantly running in the background, most likely return
memory back to the pool of memory quickly enough that the overall memory usage is never high enough to
trigger a full garbage collection. Full garbage collections stop all orchestrations, so frequent full garbage
collections can affect orchestration performance.

Scenarios where high memory usage likely results in frequent full garbage collection cycles include a mix of
orchestration types. For example, having multiple, non-persistent, long running orchestrations with numerous
variables processing large objects. These types of orchestrations would consume and tie up large amounts of
memory that could not quickly be returned to the memory pool.
Note: These types of orchestrations are not recommended by Cast Iron®.

The following table provides a list of best practices that will help you manage memory usage and maintain a
healthy runtime environment.

Table 1. Best Practices for Memory Management
Best Practice
Principles Description

Reduce logging levels. More detailed logging requires more memory to process and store the data and
also increases the I/O load on the Integration Appliance disk, which can slow
performance. Detailed logging levels are recommended for debugging purposes
only and not recommended for production environments, where high volumes of
data are processed.

The Integration Appliance generates system logs and orchestration job logs.

Cast Iron recommends setting the System Log level to "Warning" for all
components that are tracked in the system log:

Hardware
Resources
Network
Security
Orchestration
Deployment

If the number of warnings generated by the various system components is high,
memory usage might become an issue. Either resolve the problem that is causing
the warnings to be generated or increase the system logging level to "Error". For
more information about setting system log levels, see Specify System Log Settings.

Orchestration logging levels are specified for each orchestration in a project. Cast
Iron recommends setting Logging Levels to "Error Values" for all orchestrations
under all projects on the Integration Appliance. For more information about setting
orchestration log levels, see Editing Orchestration Settings.
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Best Practice
Principles Description

Verify persistence is
enabled for all
orchestrations.

By default, persistence is enabled for an orchestration and variable data is written
to disk instead of memory. Enabling persistence has the added benefit of point-in-
time data recovery should a fault occur during runtime.

If you disable persistence for an orchestration, data is stored in memory. While
disabling persistence can improve performance, as the number of running jobs
increases the likelihood of running out of memory also increases. Because of the
high risk of running out of memory, proceed with extreme caution when you choose
to disable persistence.

Note: Turning off persistence reduces the number of orchestration jobs that the
Integration Appliance can run simultaneously. The limit is set by the amount of
memory available on the Integration Appliance.

Use scheduling
capabilities available in
the Web Management
Console (WMC) and
Studio to stagger
orchestration jobs.

By scheduling memory intensive jobs to start at different times or to run during off-
peak hours, you relieve some of the load on memory, reduce the number of full
garbage collections, and potentially improve performance.

In Studio, you can use the Schedule Job activity or configure polling intervals for
activities in an orchestration to stagger orchestration jobs and maximize resource
utilization. You can also create a schedule in the WMC, to control when the
Integration Appliance should run an orchestration job. Measure the average
execution time of a given orchestration job, so you can optimize job schedules.

Minimize the number of
variables used in an
orchestration.

The more variables you use in an orchestration, the more memory is required to
store the data. This in turn could increase the number of garbage collection cycles
and affect performance. Review your orchestrations to see if you can reduce the
number of variables used.

Reduce the number of
simultaneously running
jobs.

In the WMC, you are able to specify the maximum number of simultaneously
running jobs for an orchestration. As the number of concurrently running
orchestrations increases, so does the percentage of memory usage increase. If you
notice memory is getting overloaded, reduce the number of jobs running
simultaneously.

The effects of reducing the number of simultaneously running jobs is especially
impactful for non-persistent, long running orchestrations jobs that contain a large
number of variables.

Note: These types of orchestrations are not recommended by Cast Iron.

Do not exceed 75% load
on memory.

In the WMC Resource Utilization Graph, you can track the percentage of memory
used. When the percentage of memory used is approximately 75% or less, the
Integration Appliance has capacity to process more orchestrations. When the
percentage of memory used exceeds approximately 75%, you will likely notice
performance issues as the number of full garbage collections increase.

Limit full garbage
collection cycles.

In the WMC Resource Utilization Graph, you can use the GC Activity value to track a
percentage of full garbage collections. When this percentage exceeds 50%, you
might notice a reduction in the throughput of your orchestrations jobs. Implement
the best practices for memory management to reduce memory usage and thus
reduce the likelihood of full garbage collection cycles occurring.
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Best Practice
Principles Description

Add additional
Integration Appliances
to your environment.

After implementing the best practices principles, if memory usage continues to be
high, it might be time to add another Integration Appliance to your environment.
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Managing Integration Appliances
Managing Integration Appliances topics provide information about downloading 3rd party libraries, importing
and exporting repositories, as well as describing and using commands on the Web Management Console.

About Connectors
System Summary
Downloading and installing SAP library files
Configuring Secure Network Communications (SNC) for SAP connector
In Cast Iron version 6.3.0.2 and later versions, you can connect to SAP through the SAP connector by
using the SNC feature.
Executing Commands
Exporting A Repository
Importing A Repository
Installing Libraries from Other Vendors
Scheduling Downtime
Specifying Network Settings
Executing a System Command
Upgrading a Dell Integration Appliance
This section provides information on using the WMC to upload minor and patch releases to a Dell
Integration Appliance. When you upgrade the appliance, you are able to access the latest features of the
Cast Iron® operating system. This upgrade process only replaces or adds necessary files, it does not
destroy any data.
Upgrading a DataPower Integration Appliance
This section provides information on using the WMC to upload minor and patch releases to a DataPower
Cast Iron XH40 Integration Appliance. When you upgrade the appliance, you are able to access the
latest features of the Cast Iron operating system. The upgrade process only replaces or adds necessary
files, it does not destroy any data.
Working with Network Routes
You can add and delete network routes for the Integration Appliance.
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About Connectors
The Connectors page displays all the connectors that are installed on the Integration Appliance. From the
Connectors page you can also see the version number of each installed connector and licensing status for each
connector. The Integration Appliance can only process configuration projects that contain endpoints with valid
connector licenses. To open the Connectors page, select System > Connectors from the navigation page.

Some connectors require you to install additional libraries, before you can deploy a configuration project. On
the Connectors page, click the Update Libraries link to manage these additional connector libraries.

Parent topic: Managing Integration Appliances
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System Summary
The System Summary page provides information about the Integration Appliance. To access the System
Summary page, select System > Summary from the navigation pane.

System Information Description

Model Displays the Integration Appliance hardware model.

Version Displays the version of WebSphere® Cast Iron® Operating System that is
currently running on the Integration Appliance.

Serial Number Displays the Integration Appliance serial number.
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Downloading and installing SAP library files

Before you begin

You must have an SAP User ID and password to enter the SAP Support Portal to download the files.

About this task

In order to connect to an SAP system, you must install SAP libraries onto your development environment.

Note:

If you have older versions of the librfccm.so and libsapjcorfc.so files in any system directories, you
must remove these files. Appliance must use the libsapjco3.so file provided with SAP JCo Release 3.0.x.
You must use 64 bit SAP JCo libraries for Cast Iron® version 7.0 and later versions; and 32 bit SAP JCo libraries
for Cast Iron version 6.4 and earlier versions.

Procedure

1. Contact SAP Technical Support to obtain the following zip files for the following SAP Components:

SAP 32/64 bit JCo version 3.0.14 - Linux 32/64 bit version.

SAP Java™ IDoc Class Library 3.0.12.

2. Extract the contents of the package received from SAP Technical Support and copy it onto a local folder.
3. Log on to the Management Console and select System > Connectors. The Connectors page is displayed.
4. Click Update Libraries. The Update Connector Libraries window is displayed.
5. Select SAP in the Connector column.
6. Click the plus (+) button and repeat the following substeps until you have imported all the jar files you

just downloaded.
a. Locate one of the jar files you just downloaded (sapjco3.jar, sapidoc3.jar, and
libsapjco3.so).

b. Click Open to import the jar file. The file is displayed in the Files to Add column.
7. Click Update.

The files that display in the Files to Add column are not committed until you click Update. If you click
Reset before you click Update, the Management Console does not add the files you uploaded. If the
Management Console times out before you click Update and commit the added files, repeat the last two
steps.

Results

You can now run SAP projects.

Parent topic: Managing Integration Appliances
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Configuring Secure Network Communications (SNC) for SAP
connector

In Cast Iron version 6.3.0.2 and later versions, you can connect to SAP through the SAP connector by using the
SNC feature.

Procedure

1. Upload libsapcrypto.so to the same place where SAP JCo JARs are uploaded (for more information,
see Downloading and installing SAP library files) in system library using WMC.

2. Run the shell commands to add the SAP crypto directory to the path variable of the system and to add
the system credentials to the .pse file.
Note: Shell commands can be run only by the IBM WebSphere Cast Iron L2 or L3 support engineers and
share the .pse file with IBM Support if required.
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Executing Commands

About this task

To run a system control command against the Integration Appliance:

Procedure

1. From the navigation pane, select System > Command. The System Commands page is displayed.
2. From the Choose Command drop-down list, select a command. You can view command details by

clicking the drop-down arrow.
3. Click Go.

Parent topic: Managing Integration Appliances
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System Control Commands
You can execute the following commands against a standalone Integration Appliance or an High Availability
(HA) Pair. For more information about HA specific commands, see Working with High Availability Pairs.

System Control Commands Descriptions

Remove Job History Removes all job history from the Integration Appliance.

Remove Projects & Configurations Removes all projects, orchestrations, and project
configurations from the Integration Appliance.

Remove All Jobs in Progress Removes all data for currently running projects.

Download Postmortem Generates and downloads a postmortem file to the location
you specify.

Restart Stops and restarts the Integration Appliance.

Reboot Shuts down all services and then reboots the Integration
Appliance.
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Exporting A Repository

About this task

Export the project repository to create a backup before upgrading an Integration Appliance. You can export all
project configuration and user settings, which includes: network configurations, users and groups, licenses, job
log parameters, log levels, notifications, downtime rules, and passwords, from the WMC to another location.

The Integration Appliance system logs are not exported when you export a repository. So if you import an
earlier version of the repository, the system logs still contain events that occurred before the new repository
was imported.

You can export a repository with the project configurations running. However, when you import this repository,
the project configurations will all be in the undeployed state.

Procedure

1. In the Navigation pane, select Repository > Import/Export. The Import/Export Repository dialog box is
displayed.

2. Click Export. The Save As window displays.
3. Specify the location where you would like to save the exported repository.
4. Click Save. The WMC exports a copy of the repository as a .tar.gz file.
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Importing A Repository

About this task

When you import a repository, the WMC deletes some information held in the existing repository. Exactly which
information is deleted depends on which option you select when you import the repository, as explained in this
topic. However, the system log is not deleted. Therefore, you could potentially see system log entries from the
previous repository. Once you have imported a repository, you cannot roll back to a previous repository.
Therefore, it is recommended that you export the existing repository before importing another repository.

You must stop and undeploy all project configurations on the WMC, before you can import a repository. When
the WMC successfully imports a repository, all the project configurations are in the undeployed state.

Procedure

1. In the Navigation pane, select Repository > Configurations. The Project Configurations page is displayed.
2. From the Configurations Filter list, select All. All project configurations are displayed.
3. Stop and undeploy all project configurations.
4. In the Navigation pane, select Repository > Import/Export. The Import/Export Repository dialog box is

displayed.
5. In the Repository File field, specify the path for the repository that you want to import.
6. Choose an import option:

Project and User Settings
Imports all the contents of the repository file you select. All projects are imported in the
undeployed state.

Project Settings Only
Imports projects, configurations, notification policies, and job logs, from the repository file
you select. All projects are imported in the undeployed state.
Note: Any projects, configurations, notification policies and job logs that exist prior to the
import will be deleted.

User Settings Only
Imports only the user setting information from the repository file you select. User setting
information includes: network configurations, users and groups, licenses, job log filter
parameters, system log levels, downtime rules and passwords.

7. Click Import. A warning is displayed.
8. Click Import to verify that you would like to proceed.
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Results

The Integration Appliance imports the repository and restarts the Integration Appliance. When the import is
complete, the WMC login window displays.

Parent topic: Managing Integration Appliances

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.appliance.doc/ApplianceHelp/Managing_Int
egration_Appliances/importingRepository.html

Installing Libraries from Other Vendors

About this task

If your integration project uses a connector that requires extra libraries, you must install the additional libraries
before you deploy the project configuration. Deploying the project configuration before installing the additional
libraries generates run time errors. For a complete list of connectors that require vendor libraries, open the
Update Connector Libraries page. See the following procedure.

If you have a multi-environment tenant, you must install the vendor libraries in each environment where you
deploy a project configuration with a connector that requires the additional libraries.

For example, you have a tenant with three environments: Development, Staging, and Production. You publish a
project configuration for an SAP endpoint in the Development and Production environments. Before you can
deploy the project configuration, you must install extra SAP libraries on both the Development and Production
environments.

Procedure

1. Click an environment tab.
2. Select System > Upgrade > Upgrade Connector Libraries to open the Update Connector Libraries page.
3. In the Connector column, select the connector for which you want to install additional files.

Any files that have already been installed display in the Installed Files column.

4. Click the plus ( + ) icon and select the library files to upload. In a Linux system, the valid files are .jar or
.so; in a Windows system, the valid files are .jar or .dll. The files that you select are displayed in the
Files to Add column.

5. Click Update.

The files that display in the Files to Add column are not committed until you click Update. If you click
Reset before you click Update, WMC does not add the files that you have uploaded. If WMC times out
before you click Update and commit the added files, repeat the last two steps.

Parent topic: Managing Integration Appliances
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Scheduling Downtime

About this task

Scheduling downtime allows you to perform maintenance on an environment or related system. You can create
downtime rules for project configurations that stop or suspend all enabled orchestration jobs in that project
configuration for a specified duration of time. The project configuration does not have to be undeployed to
create or edit a downtime rule. Downtime rules can occur once or repeat at specific intervals. You must have
administrator or publisher permissions to create, edit, or delete a downtime rule.

By default, downtime rules are stored in GMT time zone. If an administrator modifies the system clock from
GMT to another time zone, downtime rules are executed at the same absolute time. For example: You create a
downtime rule to stop all orchestration between 4:00pm - 4:15pm GMT. The administrator then modifies the
system clock to display PDT. Your downtime rule is modified to now stop all orchestration between 8:00am -
8:15am PDT. To execute the downtime rule at 4:00pm - 4:15pm PDT, you must edit the downtime rule. Times
differences caused by daylight savings are automatically adjusted.

If the environment is offline when a downtime rule is scheduled to occur, all unexecuted rules are identified
and executed in the appropriate order when the environment returns online. After all the backlogged downtime
rules are executed, you regain control to modify the deployment state of a project configuration.

Procedure

1. From the Navigation pane, select Repository > Configurations. The Project Configurations page is
displayed.

2. Click the project configuration, which contains the downtime rule you want to work with. The
Configuration Details page is displayed.

3. In the Scheduled Downtimes section, click New Rule. The New Downtime Rule dialog box is displayed.
4. Select one of the following actions from the drop-down list:

Stop (allows jobs to finish) - At the specified time, prevents any new orchestration jobs from
starting while allowing current jobs to finish processing. This action facilitates a gracefully stop.

Stop (cancel running jobs) - At the specified time, prevents any new orchestration jobs from
starting and stops all currently running jobs. This action immediately stops all jobs.

Suspend - At the specified time, prevents any new orchestrations from starting and pauses any
jobs that are currently running. At the end of the scheduled downtime, the runtime processes the
suspended job from the point it paused.

5. Specify the duration of the downtime by specifying a date and time for Start Downtime and End
Downtime.
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6. (Optional) Select the Repeat option to create a repeat downtime rule.
a. Specify a repeat interval (numeric value).
b. Specify frequency from the drop-down list: Days, Weeks, Months, or years.

7. Click Save.

Results

The new downtime rule displays in the Scheduled Downtimes section and the Scheduled Downtime counter
increases by one.

Parent topic: Managing Integration Appliances

Edit Downtime Rules

Procedure

1. From the Navigation pane, select Repository > Configurations. The Project Configurations is displayed
2. Click the project configuration, which contains the downtime rule you want to work with. The

Configuration Details page is displayed
3. In the Scheduled Downtime section, click the downtime rule you want to edit. The Edit Downtime Rule

displays.
4. Select one of the following actions from the drop-down list:

Stop (allows jobs to finish) - At the specified time, prevents any new orchestration jobs from
starting while allowing current jobs to finish processing. This action facilitates a gracefully stop.
Stop (cancel running jobs) - At the specified time, prevents any new orchestration jobs from
starting and stops all currently running jobs. This action immediately stops all jobs.
Suspend - At the specified time, prevents any new orchestrations from starting and pauses any
jobs that are currently running. At the end of the scheduled downtime, the runtime processes the
suspended job from the point it paused.

5. Specify the duration of the downtime by specifying a date and time for Start Downtime and End
Downtime.

6. Optional: Select the Repeat option to create a repeat downtime rule.
a. Specify a repeat interval (numeric value).
b. Specify frequency from the drop-down list: Days, Weeks, Months, or years.

7. Click Save.

Deleting Downtime Rules

Procedure

1. From the Navigation pane, select Repository > >Configurations. The Project Configurations page is
displayed.

2. Click the project configuration, which contains the downtime rule you want to work with. The
Configuration Details page is displayed.

3. In the Scheduled Downtime section, select the downtime rule you want to delete. The Delete Rules
confirmation window is displayed.

4. Click Yes.

Results

The downtime rule no longer displays.
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Specifying Network Settings

About this task

Network opens Network Settings page.

The iA300 only has one physical port; however, for network configuration purposes, you specify separate IP
addresses for data networking and management networking. The iA1000, iA1500, iA2000, iA2500, and
iA3000 have two physical ports.

You must have Administrator privileges to specify network configurations. By default, the Integration Appliance
uses DHCP to configure network settings. When you choose to use DHCP to configure network settings, the
WMC displays the settings in the Network Configuration page. You can edit these settings by clearing the Use
DHCP option or selecting the Manual option.

Note: Using DHCP to configure your network settings can result in longer startup times. For faster startup time,
select the Manual option and specify a static value.

Procedure

1. In the navigation pane, select Network. The Network Settings page is displayed.
2. Click Edit. The Edit Network Settings wizard is displayed.
3. In the Data Network section, select the Use DHCP option. If you clear this option, the Integration

Appliance requires that you specify the IP address, subnet, and broadcast settings.

By default, the Integration Appliance uses DHCP to configure data network settings. To manually
configure data network settings, clear the Use DHCP option and enter a valid value for the required
settings. The Integration Appliance requires the following management network settings:

IP address
Subnet
Broadcast

4. In the Management Network section, select the Use DHCP option. If you clear this option, the
Integration Appliance requires that you specify the IP address, subnet, and broadcast settings.

By default, the Integration Appliance uses DHCP to configure management network settings. To
manually configure management network settings, clear the Use DHCP option and enter a valid value for
the required settings. The Integration Appliance requires the following management network settings:

IP address
Subnet
Broadcast
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5. Select a Gateway Interface and Gateway Source.
6. Select an option to set the HostName.
7. Select an option to set the Domain.
8. Select an option to set the DNS. When specifying multiple DNS values, use a space to separate the

values.
9. Select an option to set the Time Server.

10. Click Next to validate settings.
11. Click Next to apply settings.
12. Click Finish.
13. Wait for the Integration Appliance to restart and log in.

Parent topic: Managing Integration Appliances
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Executing a System Command

Procedure

1. In the navigation pane, select System > Commands. The System Command page is displayed.
2. From the Choose Command list, select a command.
3. Click Go.

Parent topic: Managing Integration Appliances

System Commands
From the Management Console, you can run system commands. Different system commands are available
depending on the Integration Appliance configuration (stand-alone vs. high availability pairs) and Integration
Appliance state (active or standby). The following table lists all system commands available from the
Management Console and notes behavioral differences due to Integration Appliance configuration or state.

Command Description

Remove job history The remove job history command removes
orchestration monitoring data.

Remove project and configurations The remove projects and configurations command
removes currently deployed project(s) data.

Remove all jobs in progress The remove all job in progress command removes all
currently running project data.
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Command Description

Download postmortem The download postmortem command exports the
postmortem archive to an FTP Server you specify. The
Integration Appliance does not require that you
specify an export file name; however, as a best
practice, you should include the Integration
Appliance serial number, date, and timestamp. If you
do not specify an export file name, the Integration
Appliance exports a file named postmortem.tar.gz.
Note: Do not use reserved words in the user name or
password.

Restart Restarts the Integration Appliance routing
subsystem.

Reboot Shuts down all routing services and then reboots the
Integration Appliance. If the force parameter is used,
reboot begins immediately.

HA Connect Only available for HA pairs. The ha connect command
reconnects an Active and Standby Integration
Appliance to create an HA pair that can resume fail-
over operations. This command is only available if you
disconnected an HA pair by issuing the HA Disconnect
command.

HA Disconnect Only available for HA pairs. The ha disconnect
temporarily disconnects an HA pair without causing
the Standby machine to takeover the Active machine.
This action allows you to perform any necessary
hardware or software maintenance on the Standby
machine without interrupting orchestration
processing. When you choose this action, the Standby
machine transitions to an idle state. Reboot the Active
machine or execute the Connect action to reestablish
communications between an HA pair and resumes
data synchronization and fail-over operations. To
perform maintenance on an Active machine, use the
Switch action. The Active machine becomes the
Standby machine, where you can use the Disconnect
action and perform Integration Appliance
maintenance without interrupting orchestration
processing.

HA Switch Only available for HA pairs. The ha switch command
causes the Integration Appliances in an HA pair to
switch roles: the Active machine becomes the
Standby machine and the Standby machine becomes
the Active machine.
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Command Description

Reboot active machine (allow peer takeover) Only available for HA pairs. The reboot active
machine (allow peer takeover) command shuts down
all routing services and then reboots the active
Integration Appliance in an HA pair. When you reboot
the Active Integration Appliance using this command,
the Standby Integration Appliance takes over data
processing.

Reboot active machine (prevent peer takeover) Only available for HA pairs. The reboot active
machine (prevent peer takeover) command shuts
down all routing services and then reboots the Active
Integration Appliance in an HA pair. When you reboot
the Active Integration Appliance using this command,
the Active Integration Appliance stops all data
processing and the Standby Integration Appliance
does not take over data processing.

Reboot standby machine Only available for HA pairs. Thereboot standby
machine command reboots the Standby Integration
Appliance in an HA pair. While the Standby
Integration Appliance is rebooting, the Active
Integration Appliance continues to process data.
After a successful reboot, the Standby Integration
Appliance synchronizes with the Active Integration
Appliance.
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Upgrading a Dell Integration Appliance
This section provides information on using the WMC to upload minor and patch releases to a Dell Integration
Appliance. When you upgrade the appliance, you are able to access the latest features of the Cast Iron®
operating system. This upgrade process only replaces or adds necessary files, it does not destroy any data.

About this task

Use the Web Management Console (WMC) to upgrade to the latest version of Cast Iron operating system by
uploading an upgrade image onto the appliance. Please note that the WMC forces any running projects to be
undeployed and stops any active orchestration jobs currently running on the appliance during the upgrade
procedure. After the appliance is upgraded, you cannot undo or rollback to the previous version.
Note: Upgrades may also be applied through the Command Line Interface (CLI). See the system update
command in the CLI Reference Guide for more information about using this option.
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Procedure

1. Request the latest patch and download the patch to a location where you can access it. For example:
C:\Desktop

2. Using the WMC, log into the Dell Integration Appliance that you want to upgrade.
3. Select System > Upgrade. The Upgrade page displays.
4. Click the Upgrade Operating System link. The Upgrade Wizard launches.
5. Click Browse to locate the upgrade file.
6. Click Upgrade. The Integration Appliance uploads the upgrade file and starts the upgrade process. When

the upgrade is complete, the Integration Appliance automatically reboots.
7. When the reboot is complete, the WMC Login page displays. If the page does not display, click the

browser refresh button.

What to do next

Using the WMC, redeploy any projects that were undeployed by this upgrade procedure. Upgrade to a Studio
version compatible with the installed Cast Iron operating system. For more information about appliance and
Studio compatibility, see the Compatibility section of the Cast Iron Operating System Release Notes or the Cast
Iron Studio Release Notes. For the procedure on upgrading Studio, see Installing Studio.

Parent topic: Managing Integration Appliances
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Upgrading a DataPower Integration Appliance
This section provides information on using the WMC to upload minor and patch releases to a Cast Iron® Cast
Iron XH40 Integration Appliance. When you upgrade the appliance, you are able to access the latest features of
the Cast Iron operating system. The upgrade process only replaces or adds necessary files, it does not destroy
any data.

About this task

Use the Web Management Console (WMC) to upgrade to the latest version of Cast Iron operating system by
uploading an upgrade image onto the appliance. Please note that the WMC forces any running projects to be
undeployed and stops any active orchestration jobs currently running on the appliance during the upgrade
procedure. After the appliance is upgraded, you cannot undo or rollback to the previous version.
Note: Upgrades may also be applied through the Command Line Interface (CLI). See the system update
command in the CLI Reference Guide for more information about using this option.

Procedure
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1. Obtain the latest patch, then download the appliance upgrade image file to a location you can access
from your Windows workstation, for example: C:\Desktop.

2. Use the WMC to log into the Integration Appliance running the Cast Iron operating system.
3. From the Items menu in the WMC, select System > Upgrade. The System Summary window is displayed

showing the model, version and serial number.
4. Click Upgrade Operating System. The Upgrade window is displayed.
5. In the text field, specify the path to the appliance upgrade image file or click Browse to locate the

upgrade image file.
6. Click Upgrade. In the Upgrade panel, the following message is displayed: Upload in progress.
Please wait. A progress bar displays the status of the upload. When the upload is complete, the WMC
validates the upgrade. If the upgrade is successful, the appliance reboots.

7. Use the WMC to log into the appliance. You may need to click the browser refresh button.

What to do next

Using the WMC, redeploy any projects that were undeployed by this upgrade procedure. Upgrade to a Studio
version compatible with the installed Cast Iron operating system. For more information about appliance and
Studio compatibility, see the Compatibility section of the Cast Iron Operating System Release Notes or the Cast
Iron Studio Release Notes. For the procedure on upgrading Studio, see Installing Studio.

Parent topic: Managing Integration Appliances
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Working with Network Routes
You can add and delete network routes for the Integration Appliance.

Parent topic: Managing Integration Appliances

Adding Network Routes

Procedure

1. In the navigation pane, select Network. The Network Settings page is displayed.
2. Click Edit. The Edit Network Settings wizard is displayed.
3. In the Routes section, click New Rule. The New Network Route dialog displays.
4. Specify a destination.
5. Specify a netmask.
6. Choose an interface from the drop-down list.
7. Specify a gateway.
8. Click Save.
9. Click Next to validate settings.

10. Click Next to apply settings.
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11. Click Finish.
12. Wait for the Integration Appliance to restart and log in.

Deleting Network Routes

Procedure

1. In the navigation pane, select Network. The Network Settings page is displayed.
2. Click Edit. The Edit Network Settings wizard is displayed.
3. In the Routes section, click Delete. A confirmation window displays.
4. Click Yes.
5. Click Next to validate settings.
6. Click Next to apply settings.
7. Click Finish.
8. Wait for the Integration Appliance to restart and log in.
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Managing Orchestrations
Managing Orchestrations topics provide information about editing orchestration settings and exporting job
reports.

About Orchestration Settings
Orchestration settings allow you to configure properties for individual orchestrations in a project
configuration. For each orchestration you can specify whether the orchestration is enabled, the logging
levels, logging behavior, and the maximum number of jobs that the orchestration can simultaneously
run.
Editing Orchestration Settings
Exporting Orchestration Monitoring Data
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About Orchestration Settings
Orchestration settings allow you to configure properties for individual orchestrations in a project configuration.
For each orchestration you can specify whether the orchestration is enabled, the logging levels, logging
behavior, and the maximum number of jobs that the orchestration can simultaneously run.

When a project configuration is undeployed you can edit the following orchestration settings:

Orchestration Settings Description

Enabled Indicates whether an orchestration is enabled and can be deployed. At
least one orchestration in a project configuration must be enabled to
deploy a project configuration. By default, all orchestrations in a project
configuration are enabled.

Logging Level Allows you to specify the level of orchestration details that are logged
in the System Logs.

None - Orchestration status and activity are not logged.

Initial Values - Only the initial values of orchestration variables
are logged.

Initial and Error Values- Both the initial values of orchestration
variables and orchestration errors are logged.

Error Values- Only orchestration errors are logged.

Inline - Orchestration job details are logged for
suborchestrations inline with the job details of the calling
orchestration.

All- The highest level of logging. All orchestration activity is
logged.

Log Synchronously Allows the runtime to synchronize the writing of orchestration events to
the orchestration monitoring logs as the orchestration is running.

By default, this orchestration setting is disabled and orchestration jobs
are not synchronously logged.

Note:

When you enable this orchestration setting, the time it takes to process
an orchestration job increases.

Max Simultaneous Job Allows you to specify the number of orchestration jobs that can run
simultaneously.

Parent topic: Managing Orchestrations
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Editing Orchestration Settings

Before you begin

To edit orchestration settings, the project configuration must be undeployed.

Tenant administrators, environment administrators (for the environment where the project is published), and
publisher of a project can edit its orchestration properties.

About this task

Note: If you grant project configuration permissions to a group, the users in that group will have full access to
the project configuration--user will be able to create new versions of the project configuration, as well as edit
and delete the project configuration.

Procedure

1. Select the environment tab, where the project configuration is published.
2. From the navigation pane, select Repository > Configurations. The Project Configuration page is

displayed.
3. If the project configuration you want to edit is running, stop the project configuration by clicking the 

Stop icon in the Actions column. When the Stop Configuration dialog box displays, click one of the
following options:

Finish Jobs - At the specified time, prevents any new orchestration jobs from starting while
allowing current jobs to finish processing. Allows the jobs to end.
Cancel Jobs - At the specified time, prevents any new orchestration jobs from starting and stops
all currently running jobs. This action immediately stops all jobs.

4. Undeploy the project Configuration, by clicking the Undeploy icon in the Action Column.
5. Click the project configuration you want to edit. The Configuration Details page is displayed.
6. In the Orchestration section, click Edit to edit the orchestration settings. The Edit Orchestration Settings

window is displayed.
7. Click Save.
8. Deploy the project configuration to begin processing orchestration jobs.

Results

The updates you made display in the Orchestration section of the Configuration Details page and the runtime
processes the orchestration as specified.
Parent topic: Managing Orchestrations
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Exporting Orchestration Monitoring Data

About this task

You can export orchestration monitoring data. When you export orchestration monitoring data, you can choose
to delete the orchestration monitoring data that you export or choose to persist the orchestration monitoring
data on the system.

If you choose to delete the orchestration monitoring data, there is no mechanism to recover the data.

Procedure

1. In the navigation pane, select Logs > Job Logs. The Results page is displayed.
2. Click Export. The Export Jobs window is displayed.
3. Choose one of the following export options:

Export and Delete - Exports the monitoring data and deletes the data from the environment.
Export - Exports monitoring data and preserves data on the environment.

4. Click Download Now to download the exported log file.
5. Choose to open or save the file. If you choose to save the file, specify a location and click Save. The XML

file is saved to the location you specified.
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Managing Projects
Managing Projects topics provide information about creating, managing, and deploying integration projects.

About Assets
About Naming Projects and Configurations
About Project Configurations
About Projects
Cloning Project Configurations
Copying Projects
Creating Projects From Scratch
Creating Projects From a Template
Deleting Project Configurations
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Deleting Projects
Deploying Project Configurations
Editing Project Configuration Properties
Editing Projects
About Database Assets
Publishing Projects
Push WSDL from Cast Iron Project to API Management
Push REST API (Swagger) from Cast Iron Project to API Management
Recreating Database Assets
Required Quotes for Asset Table Names
Reviewing TIPs
You can rate and provide a review for all TIPs that you download.
Stopping Project Configurations
Uploading Project Configurations
Viewing and Saving Web Services Assets
Working with Project Configurations
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About Assets
The Management Console groups assets by endpoint. Assets must be generated for database and Web
Services endpoints that connect to the following orchestration activities:

Starter database activities.

Non-starter database activities with the exactly once delivery option specified.

Provide Services activity.

For each database endpoint, you must specify unique values for configuration properties associated with the
database assets before you can deploy a project configuration. Database assets are control tables, buffer
tables, sequence tables, or triggers. All starter database activities are managed in one buffer table, while it
manages events for each non-starter database activity with the exactly once delivery option specified in
individual control tables

A WSDL for the Provide Services activity is generated by the integration environment. From the Management
Console, you can save this Web Services asset.

Parent topic: Managing Projects
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About Naming Projects and Configurations
Project and project configuration names cannot be longer than 42 characters. When you create a project or
project configuration avoid using the following list of reserved characters.

Reserved Characters Description

‘ & ’ ampersand

‘ { ‘ ‘ } ’‘ [ ‘‘ ] ’ ' < '' > ' any brackets

‘ * ’ asterisk

‘ \ ’ backslash

' ^ ' caret

‘ : ’ colon

‘ $ ’ dollar sign

‘ / ’ forward slash

' # ' number sign

' ( ) ' parenthesis

' | ' pipe

‘ . ’ period

‘ ? ’ question mark

‘ ; ’ semicolon

' ' space

‘ ~ ’ tilde

Parent topic: Managing Projects
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About Project Configurations
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Project configurations allow you to create multiple variations of the same integration project, so you can create
and publish one project and deploy it to many different scenarios. Within a project configuration you can
specify which orchestrations are enabled, modify configuration properties for endpoints, generate or modify
assets, manage scheduled downtime rules, and control permissions for the project configuration.

Each project you publish has a Default project configuration. In the Management Console, you can create
additional project configurations. The project name, project version, configuration name, and project state
uniquely identify each project configuration.

You must have Administrator privileges or be the publisher of the specific project to create, edit, and delete
project configurations. Administrators and publishers can grant users and groups permissions that allow them
to a create, edit, and delete project configurations.

The Summary section displays the details of the project configuration selected from Repository >
Configurations. The summary section includes the project configuration name, status of the configuration, the
date and time when the project was last published, the name of the user who published or cloned the project
configuration. In addition, the summary page also displays the number of orchestrations, properties, assets,
and the scheduled downtimes associated with the configuration.
Note: The name of the user who published or cloned the project configuration is displayed in the following
formats:

username [groupname] - indicates that this particular user (username) belonging to (groupname) is
the one who published or cloned the project configuration.
username {user does not exist} - indicates that the user does not exist in the integration
appliance.

Enabling and Disabling Orchestrations

The runtime only runs orchestration jobs for enabled orchestration. Before you can deploy a project
configuration, the project configuration must contain at least one enabled orchestration. By default, all
orchestrations are enabled.

Specifying the orchestration logging level allows you to control the type of orchestration errors that are written
to the system logs. The Management Console also allows you to limit the number of jobs that run
simultaneously. The number of jobs that run simultaneously can affect performance.

You must have administrator or publisher permissions to specify orchestration properties.

Understanding Configuration Properties

You create these configuration properties for a project in Studio. For more information about creating project
properties and specifying a project version, see the Studio online help.

When you publish the project, you can specify values for the configuration properties. The values you specify
for the configuration properties determine how the project is deployed. For example, in a project that contains
database endpoints, you can create properties for database connection parameters. This allows you to create a
project configuration for a test environment connecting to a test database and then use the same project to
create another project configuration for a production environment that connects to another database.

You must have administrator or publisher permissions to edit configuration properties in the Management
Console.

Modifying Assets
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If your project configuration contains a database or WebServices endpoint, you must generate assets before
you can deploy the project configuration. If your project does not contain a database or WebServices endpoint,
assets are irrelevant to your project configuration.

You must have administrator or publisher permissions to generate or modify assets.

Scheduling Downtimes

Scheduling downtime allows you to perform maintenance. You can create downtime rules for project
configurations that stop or suspend all enabled orchestration jobs in that project configuration for a specified
duration of time. The project configuration does not have to be undeployed to create or edit a downtime rule.
Downtime rules can occur once or repeat at specific intervals.

You must have administrator or publisher permissions to create, edit, or delete a downtime rule.

Editing Project Configuration Permissions

As an administrator or project publisher, you can grant permissions for project configurations to other users
and groups. When you grant users or groups permissions to a project configuration they are able to create, edit,
and delete the project configuration. By default, permissions to project configurations are granted to only the
Administrator Group. If you want to grant permissions to another group you must explicitly do so.

For example, you are a user with publisher rights and belong to the built-in Publisher group. You publish a
project. Only the Administrator Group and you have permissions to the project configuration. Members of the
Publisher group, of which you are a member, do not have permissions to the project configuration. You must
edit the permission on the project configuration to include another group like Publisher. For more information,
see Granting Project Configuration Permissions.
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About Projects
Projects contain components that the runtime needs to execute an integration scenario: orchestrations,
endpoints, maps, and other documents. Use Studio to create and test projects without being connected to an
integration environment.

Multiple people can publish multiple projects to the same integration environment. Use Studio to publish
projects to an integration environment or export projects to a staging location. You can later use the
Management Console to upload the exported project. You must have Administrator or Publisher privileges to
publish or upload a project to the integration environment.

When you publish a project from Studio, the Management Console displays the project with default project
settings; creating a default project configuration. You can clone this default project configuration to create new
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project configurations, which you can configure for separate development and production environments.

Use the Studio to create projects and specify endpoint configurations properties and then use the Management
Console to specify project configurations and deploy project configurations.
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Cloning Project Configurations

Before you begin

You must have Administrator privileges or be the publisher of a project to clone project configurations.

About this task

Project configurations contain properties and assets that you can configure in the Management Console to
create multiple variations of the same integration project. When you create a new configuration you can choose
to clone an existing project configuration. A cloned project configuration inherits all the configurations from the
original project configurations. However, if you edit the original configuration project, the changes are not
propagated to the cloned project.

Note: The project configuration you clone does not display on the Favorites view, unless you explicitly add the
project configuration to the view.

Procedure

1. From the Navigation pane, select Repository > Configurations. The Project Configurations page is
displayed.

2. From the Configuration Filter list, select All. All project configurations is displayed.
3. Locate the project configuration you want to clone.
4. Click the Clone icon . The Create Project Configuration dialog box is displayed.
5. Provide a unique name for the new project configuration.
6. Click OK.

Results

The cloned project configuration displays on the Project Configurations page. The cloned project has all the
same project configuration details as the original project configuration.

Parent topic: Managing Projects
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Copying Projects

About this task

The Management Console allows you to copy a project by assigning a new version number to an existing
project.

Procedure

1. Click the Modify tab. The Projects page is displayed.
2. Click the project you want to copy. The Copy Project dialog is displayed.
3. Enter a new project version. The version number can contain a decimal.
4. Click Save.

Results

The copy of the project is displayed in alphabetical order in the Projects page.
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Creating Projects From Scratch

About this task

You can create a project from scratch in the cloud.

Procedure

1. Click the Create tab. The Solutions page is displayed.
2. Click Create One From Scratch. The Create Project dialog box is displayed.
3. Specify a unique project name.
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4. Click Save. The project is displayed in the Projects page of the Modify tab.

Results

You can now take edit, publish, delete or copy your project. Select the project to view the project details and
assign permissions to your project. If you do assign permissions, click Save to save your updates.

Project details include the environment to which the project configuration was published, a timestamp of the
last time you published the project, and the current state of the project configuration. For example: deployed.
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Creating Projects From a Template

About this task

You can create a project from a template. Templates are stored in the Solutions Repository. All users can create
a template solution and upload it to the Solutions Repository.

Note:

Not all templates in the Solutions Repository are certified. The templates that are certified are denoted with a
WebSphere® DataPower® Cast Iron® logo.

Procedure

1. Click the Create tab. The Solutions page is displayed.
2. Search for a template.

a. Select a source endpoint.
b. Select a target endpoint.
c. Click Search.

You can also select the Keyword Search option to search for a template using a keyword.

3. Choose a template from the solutions that are returned. Template details display.
4. Click Create a project based on this template. Studio Cloud launches and the wizard steps you through

the process of creating your project.

Results

Parent topic: Managing Projects
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Deleting Project Configurations

Before you begin

The publisher of a project configuration, the environment administrator, or tenant administrator can delete
project configurations. The publisher of a project configuration can grant permissions that allow other users to
delete his project configuration. The environment administrator can grant permissions that allow other users to
delete any project configuration in the environment. The tenant administrator can grant permissions that allow
other users to delete any project configuration in the tenant.

Project configurations must be undeployed before you can delete them.

About this task

When you delete a project configuration, all monitoring history associated with the project configuration is also
deleted.

Procedure

1. Select the environment tab, where the project configuration is published. A list of project configurations
is displayed in the Project Configuration section of the Dashboard.

2. Verify that the project configuration you want to delete is undeployed. The state displays in parentheses
( ) at the end of the project configuration name. For example, (undeployed)

3. If the project configuration is in any other state but undeployed , undeploy the project configuration by
clicking the Undeploy icon in the Actions column.

4. In the Actions column, click the Delete icon. The Delete Project Configuration dialog box displays.
5. Click Yes.

Results

The project configuration is deleted and no longer available.
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Deleting Projects

Before you begin

The publisher of a project, the environment administrator, or tenant administrator can delete projects. The
publisher of a project can grant permissions that allow other users to delete his project. The environment
administrator can grant permissions that allow other users to delete any project in the environment. The tenant
administrator can grant permissions that allow other users to delete any project in the tenant.

Procedure

1. Select the Modify tab. The Projects page displays a list of projects that can be published.
2. In the Actions column, click the Delete icon. The "Delete Project?" dialog box is displayed.
3. Click Yes.

Results

The project is deleted; however, any project configurations created from this project are still available.
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Deploying Project Configurations

Before you begin

To deploy or undeploy project configurations, you must have tenant administrator or environment
administrator privileges, or be the publisher of the project configuration.

About this task

The type of endpoint in an orchestration determines the steps you must complete to deploy a project
configuration. A project configuration must contain at least one enabled orchestration before you can deploy
the project configuration. If the orchestration contains a database or Web Services endpoint, you must also
generate assets for the endpoints before you can deploy the project configuration.

By default, all the orchestrations in a project configuration are enabled. Therefore, if the orchestrations in a
project configuration do not require additional configuration and do not access database or WebServices
endpoints, you can deploy your project configuration by clicking the deploy icon next to the project
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configuration in any of the Project tabs. If your project configuration requires assets or additional configuration,
see the following deployment procedure.

Note: A project configuration must be in the stopped state for you to undeploy the project configuration.

Procedure

1. Select the environment tab to which you published your project.
2. In the Project Configuration section, select the project configuration you want to deploy. The

Configuration Details page is displayed.
3. In the Orchestrations section, verify that at least one orchestration in the project configuration is

enabled. Edit orchestration settings, as needed.

You cannot edit orchestration settings while a project configuration is running. Stop and undeploy the
project configuration to edit configuration settings.

4. In the Properties section, edit configuration properties, as needed.

You cannot edit configuration properties while a project configuration is running. Stop and undeploy the
project configuration to edit configuration settings.

5. If the project configuration contains a Database or Web Services endpoint, you must generate assets for
these endpoints.

6. Optional: Add a schedule downtime rule.
7. Optional: Assign permissions for the project configuration, which specify which group of users can edit

and deploy a project configuration. By default, tenant administrators, environment administrators, and
the publisher of a project configuration can edit and deploy a project configuration.

8. If you assign permissions, click Save.
9. In the Summary section, click the Deploy icon ( ) to deploy the project configuration.

Results

The project configuration deploys, the runtime starts to process orchestration jobs, and the status is
appropriately updated in the Summary section.
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Editing Project Configuration Properties

Before you begin

You must have administrator or publisher permissions to edit configuration properties.
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About this task

You create configuration properties for an integration project in Studio, before you publish the project to an
environment in the cloud. When you publish the project, you can specify values for the configuration
properties. Configuration properties allow you to move a project configuration from a staging environment to a
production environment.

For example, in a project that contains database endpoints, you can create properties for database connection
parameters. This allows you to create a project configuration for a test environment connecting to a test
database and then use the same project to create another project configuration for a production environment
that connects to another database.

Procedure

1. Select the environment tab, where the project configuration is published.
2. From the navigation pane, select Repository > Configurations. The Project Configuration page is

displayed.
3. If the project configuration you want to edit is running, stop the project configuration by clicking the 

Stop icon in the Actions column. When the Stop Configuration dialog box displays, click one of the
following options:

Finish Jobs - At the specified time, prevents any new orchestration jobs from starting while
allowing current jobs to finish processing. Allows the jobs to end.
Cancel Jobs - At the specified time, prevents any new orchestration jobs from starting and stops
all currently running jobs. This action immediately stops all jobs.

4. Click the project configuration you want to edit. The Configuration Details page is displayed.
5. In the Properties section, click Edit to edit configuration property values.
6. Modify the configuration properties.
7. Click Save.

Results

The Configuration Details page displays the updated configuration property values.
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Editing Projects

About this task

You can edit projects in the cloud using Studio Cloud.
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Procedure

1. In the Modify tab, click the project name. Studio Cloud opens.
2. Edit the project as needed.
3. Click Save.
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About Database Assets
The type of database endpoint you use determines the assets that must be generated. The following table
shows the assets that are generated for each supported database:

Note: In Cast Iron, asset tables are created with the identifier size of 30 characters. For asset tables, the
format that Cast Iron follows is: CI_CT_<respective-table-name> (for Control Table), and
CI_BT_<respective-table-name> (for Buffer Table). So you must use tables with names having a
maximum of 24 characters.

Database Assets Generated

DB2® AS/400

Informix®

Microsoft SQL

Sybase

Buffer tables

Control tables

Triggers

Local Staging Database Buffer tables

Control tables

Index tables

Triggers

Oracle Buffer tables

Control tables

Triggers

Sequences
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Assets are only generated for starter activities and non-starter activities that specify the Exactly Once delivery
option. Assets are not generated for non-starter activities that specify At Least Once or At Most Once delivery
options.

Note: Control table names are appended with an activity ID to ensure all assets have unique names. This
number does not distinguish multiple endpoints in an orchestration using the same control table.
Parent topic: Managing Projects

Validating Database Assets

About this task

Before you generate database assets, validate the assets. When you validate an asset, the integration
environment verifies whether the buffer table or control table exists in the source database and verifies that
table structures are correct.

Note:

Triggers and sequences are not validated .

Procedure

1. In the navigation pane, select Repository > Configurations. The Project Configuration page is displayed.
2. Click the project configuration that requires database assets. The Configuration Details page is

displayed.
3. Verify the project configuration is in the undeployed state.
4. In the Assets section, click Database. The Database Assets page is displayed.
5. Select all the assets you want to validate and click Validate.
6. The results returned determine the next step. The following table tells you how to interpret the feedback

and how to proceed.
A green check mark - valid
A yellow warning sign = warning

Database Asset Validation Feedback

Exists? Valid? Action

valid valid The asset exists in the database and the asset structure matches the
project configuration you created in Studio.You can now deploy the
project configuration.

valid warning The asset exists in the database, but the asset structure is incorrect.
Check that the database script contains the appropriate columns and
that the columns are in the correct order. If there is an error, recreate
the asset.

warning warning The asset does not exist in the source database table. You must create
the asset before you can deploy the project configuration.

Warning: Constraint names ending in a unique ID are generated. However, if the size of the database table
name is greater than 18 characters, the constraint name is truncated resulting in a naming conflict. If the
database table name is greater than 18 characters, edit the database assets script generated and make the
constraint names unique.
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Generating Database Assets

About this task

The project configuration must be undeployed before you can validate or generate assets. Validate assets
before you generate them.

Procedure

1. In the navigation pane, select Repository > Configurations. The Project Configuration page is displayed.
2. Click the project configuration that requires database assets. The Configuration Details page is

displayed.
3. Verify the project configuration is in the undeployed state.
4. In the Assets section, click Database. The Database Assets page is displayed.
5. Select all the assets you want to generate. You can select all the assets by selecting the top-most check

box.
6. Click Create.
7. Review and modify the database script as needed.
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Publishing Projects

Before you begin

You must be a tenant administrator, environment administrator, or environment publisher to publish projects.

About this task

Publishing a project uploads a project from Studio to a runtime environment.

Procedure

1. In the Management console, select the Modify tab. The Projects page displays.
2. In the Actions column, click the Publish Project icon. A list displays all the environments in the tenant.
3. Select the environment to which you want to publish the project.

Results

A confirmation displays. The project is available in the environment you selected.
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Recreating Database Assets

About this task

If a database asset exists but its structure does not match the source table, you must recreate the database
asset before you can deploy the project configuration.

Procedure

1. In the navigation pane, select Repository > Configurations. The Project Configuration page is displayed.
2. Click the project configuration that requires database assets. The Configuration Details page is

displayed.
3. Verify the project configuration is in the undeployed state.
4. In the Assets section, click Database. The Database Assets page is displayed.
5. Select the assets you want to recreate.
6. Click Recreate.
7. Review and modify the scripts as needed.
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Required Quotes for Asset Table Names
The following table provides information about quotes that you must use to enclose asset properties to
generate valid assets:

Database Required Quotes

DB2® AS/400 " "
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Database Required Quotes

Informix® [ ]

Microsoft SQL [ ]

Oracle " "

Sybase [ ]
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Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.appliance.doc/ApplianceHelp/Managing_Pr
ojects/requiredQuotesForAssetTableNames.html

Reviewing TIPs
You can rate and provide a review for all TIPs that you download.

Ratings are given on a scale of 1-5, where 5 is the highest rating. When you submit your rating and review for a
TIP, Studio uploads the information to the WebSphere® Cast Iron® Solutions Repository. Your rating is
combined with any other ratings that have been submitted by other reviewers and the average is displayed in
the Details pane of the specific TIP.
Parent topic: Managing Projects
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Stopping Project Configurations

About this task

There are two ways to stop a running project configuration:

Stop (allows jobs to finish) - When you click Finish Jobs, prevents any new orchestration jobs from
starting while allowing current jobs to finish processing. This action allows the Integration Appliance to
gracefully stop.
Stop (cancel running jobs)- When you click Cancel Jobs, this option prevents any new orchestration
jobs from starting and stops all currently running jobs. This action immediately stops all jobs.
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Procedure

1. From the Project Configurations page, select a project configuration.
2. In the Actions column, click the Stop icon . The Stop Configuration window is displayed.
3. Click either Finish Jobs or Cancel Jobs to stop the project configuration.

Parent topic: Managing Projects
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Uploading Project Configurations

Before you begin

To upload a project configuration to the cloud, you must have tenant administrator, environment administrator,
or environment publisher permissions.

About this task

When you upload a project configuration, you are publishing a project using a two-stage process. First, you
export a project from Studio to an intermediate location. Then from the Management Console, you upload the
project to an Integration Appliance or cloud environment.

Procedure

1. Select the environment tab, to which you want to upload the project configuration.
2. From the Navigation pane, select Repository > Upload Project. The Upload Project Configuration dialog

box displays.
3. Enter the path from which to upload the project in the Local Project File field. You can click Browse to

select a file from your local machine.
4. Specify a project name. The name should not exceed 42 characters and should not contain any

restricted characters.
5. Specify a product version number. This field is not populated with the project version you specified in

Studio. However as a best practice, you should specify a project version that matches the version you
specified in Studio.

6. Click Upload.

Results

The project configuration displays in the Project Configuration page.

Parent topic: Managing Projects
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Viewing and Saving Web Services Assets

About this task

The Management Console generates a WSDL file for a project configuration that contains a Provide Service
Activity, which you can view or save for reference. View the WSDL to verify it is correct before you deploy the
project configuration that contains this web services endpoint.
Parent topic: Managing Projects
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Working with Project Configurations
Various views are available for project configurations:

All - Displays the deployment state and status of all project configurations, regardless of the state of the
project configuration. You can clone or delete project configurations from this view.

Recent - Displays the deployment state and status of the most recently published or modified project
configurations. You can clone or delete project configurations from this view.

Favorites - Displays the deployment state and status of project configurations for which you have
permissions. By default, this view is not populated. You must explicitly add project configurations from
either the Recent view or All view.

My Configurations - Displays the deployment state and the status of the project configurations that you
have published or cloned (configurations published by the user currently logged on).

You can access these views from the Dashboard or by selecting the following path in the Navigation pane:
Repository > Configurations. The Configuration Filter allows you to choose your view from a list.

The following table describes information available in the various project configuration views:
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Columns in Project
Configuration Views

DescriptionsColumns in Project
Configuration Views

Descriptions

Configuration Displays published project configurations.

Running Displays the number of currently running jobs for the project configuration.

Completed Displays the number of orchestration jobs, for the project configuration, that
were completely processed.

When orchestration monitoring data is purged, the number of orchestration
jobs is reset to 0. For more information about modifying log purging
parameters, see the purging help topics.

Errored Displays the number of orchestration jobs where a runtime error occurred for
the project configuration.

When orchestration monitoring data is purged, the number of orchestration
jobs is reset to 0. For more information about modifying log purging
parameters, see the purging help topics.

Total Displays the total number of orchestration jobs, for the project configuration,
that have run.

When orchestration monitoring data is purged, the number of orchestration
jobs is reset to 0. For more information about modifying log purging
parameters, see the purging help topics.

Actions Displays the state of project configurations, as well as options for you to
delete  or clone  project configurations.

Clicking this icon deploys and runs a project configuration.

Clicking this icon causes the runtime to suspend the orchestration job
processing of the project configuration.

Clicking this icon undeploys a project configurations. You must stop the
project configuration before you can undeploy the project configuration.

Clicking this icon stops the runtime from processing orchestration jobs for
the project configuration.

When you stop a project configuration, you can choose to have the runtime
completely process all currently running jobs or have the runtime cancel all
currently running jobs.

Only available in All and Recent views. Clicking this icon adds the project
configuration to Favorites.

When the Management Console displays the project configuration in
Favorites, this icon is no longer active next to the project configuration in the
All and Recent views.

Clicking this icon removes the project configuration from Favorites, but
does not delete the project configuration from the environment. You can view
the project configuration from the All and Recent views.

Parent topic: Managing Projects
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Monitoring
Monitoring topics provide information about creating and managing notifications, viewing hardware status,
searching orchestration jobs, and viewing orchestration job logs.

About the Web Management Console
Choosing a Notification Level
Notification levels define the severity of events that can trigger an alert. When you specify a notification
level, an alert is only sent for errors that exceed the level you choose.
Creating Notification Policies
Notification policies allow you to monitor potential errors in a specific system.
Deleting Notification Policies
You can delete one or more notification policies.
Editing Notification Policies
Enabling Email Notification Policies
Searching for Orchestration Jobs
Viewing Hardware Status
Viewing Orchestration Job Logs
The Dashboard displays information about orchestration jobs, including status, timestamp of job events,
and key/job ID in multiple tabs:
SNMP basics
The Simple Network Management Protocol (SNMP) is an Internet standard protocol used primarily in
network management systems to monitor network devices for conditions that warrant administrative
attention. Devices that typically support SNMP include routers, switches, servers, workstations and
printers. This section introduces SNMP basics and provides an overview of Cast Iron MIBs.
Setting up an SNMP receiver
You can use the WMC to create notifications for events that happen in runtime components such as
orchestrations, security, hardware and others. A delivery mechanism for these notifications is SNMP in
which a trap is set for events. To retrieve these events, you must to set up a receiver or manager that is
registered with the appliance. Use the procedures in this section to set up an SNMP receiver.
Adding a notifications policy
When you add a notifications policy, you inform administrators of alerts, policy violations and the status
changes of job executions. Using SNMP traps, the notification system also allows you to send traps to
SNMP-enabled third-party applications. Perform the following steps to add a notifications policy and
assign it a name.
About the Resource Utilization Graph
Describes how to use the data the Resource Utilization graph provides for capacity planning and
understanding the health of the runtime environment.
Hardware health
Use the information in this section to obtain notifications based on the hardware health of the appliance.
Testing the system
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About the Web Management Console
The Web Management Console (WMC) is a web-based management tool that allows you to:

Manage the Integration Appliance

Manage integration projects

Monitor integration projects

You can access the same Integration Appliance from multiple WMCs. However, each WMC can only monitor and
manage one Integration Appliance at a time. The tasks you can complete in the WMC depend on the user
account you log in with. The WMC has built-in groups, which you can use to further control access to the
Integration Appliance. Alternatively, you can specify an LDAP server to manage user and group authentication
and authorization.

When you log into an Integration Appliance through the WMC, the Dashboard appears. The Dashboard provides
multiple snapshot views of project configurations and jobs, a resource utilization graph, a list of unresolved
critical system errors, and an overall project configuration summary. The Dashboard also allows you to search
for orchestration jobs by job key. The Search box is located in the Results section of the dashboard.

The WMC displays the name of the current user as well as the date and timestamp set on the Integration
Appliance. This date and timestamp do not necessarily represent the local date and time. For example, the
Integration Appliance is set to GMT; however, you can log on to this Integration Appliance from a WMC in San
Francisco, CA, which is in the PST time zone. Use the Command Line Interface (CLI) to modify the time zone of
the Integration Appliance.
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Choosing a Notification Level
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Notification levels define the severity of events that can trigger an alert. When you specify a notification level,
an alert is only sent for errors that exceed the level you choose.

Note: If you do not receive notifications for events, it might be that you do not have the system log level set to
produce entries that would trigger a notification. For example, if you chose the Error level for Deployment, all
events that were Error or Critical level in the Deployment system are logged.

You can specify the following notification levels:

Notification Level Description

Critical Sends an alert when an error condition causes the a shutdown.

Error Sends an alert when non-critical issues that must be handled
immediately occur.

Warning Sends an alert when potential error conditions occur.

Info Sends an alert for informational usage.

Parent topic: Monitoring
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Creating Notification Policies
Notification policies allow you to monitor potential errors in a specific system.

About this task

When you create a notification policy, the notification policy monitors the system log for the system you
specify. When a system log event occurs that meets or exceeds the notification level of a notification policy, an
alert is sent to the specified users.

Note: If you do not receive notifications for events, it might be that you do not have the system log level set to
produce entries that would trigger a notification or you did not enable the notification policy. For more
information about specifying system log settings, see "Specify System Log Settings". For more information
about enabling email notification policies, see " Enabling Email Notification Policies".

Procedure

1. Click the environment for which you will create a notification policy. The Navigation pane is displayed.
2. Select Logs > Notifications. The Notifications page is displayed.
3. Click New Policy. The New Policy dialog box is displayed.
4. Enter a policy name.
5. From the Level Exceeds list, select a level. Alerts are only sent for errors that exceed the level you

choose.
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6. From the With System list, select the system you want the notification policy to monitor.
7. Specify the email address or addresses of the person or people that will receive the email notification.

When you have multiple email addresses, add one email address per line.
8. Click Save.

Results

The new policy is displayed on the Notifications page. You must enable e-mail notifications before any alerts
can be sent. If the email status is displayed as (inactive), email notifications are not enabled.

Parent topic: Monitoring
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Deleting Notification Policies
You can delete one or more notification policies.

Procedure

1. Click the environment for which you will delete a notification policy. The Navigation pane is displayed.
2. Select Logs > Notifications. The Notifications page is displayed.
3. Select the check box for the policy you want to delete.

To delete multiple policies, select the top check box. All the policies are selected.

4. Click Delete. The Delete Policies? confirmation window is displayed.
5. Click Yes.

Results

The policy is deleted and no longer displays in the Notifications page.
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Editing Notification Policies

Procedure

1. In the Navigation pane, select Logs > Notifications. The Notifications page is displayed.
2. Click a notification policy. The Edit Policy dialog box is displayed.
3. Update the appropriate notification settings.
4. Click Save.

Results

The updated policy is displayed on the Notifications page. You must enable email notifications before any alerts
can be sent. If the Email status displays as (inactive), email notifications are not enabled.
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Enabling Email Notification Policies

About this task

When you create an email notification policy, you must enable the email notification policy for alerts to be sent.
By default, email notifications are not enabled.

If you enable email notification policies, the settings you specified when you created the email notification
determine when an email alert is sent.

Note: If you disable the email notification policy by clearing the Enable Email option, alerts are not delivered for
any email notification policy.

Procedure

1. Click the environment for which you will enable an email notification policy. The Navigation pane is
displayed.

2. Select Logs > Notifications. The Notifications page is displayed.
3. At the top of the page, click the Email link. The Enable Email option is displayed.
4. Click the Enable Email option.
5. Optional: Provide an email subject line that will qualify the alert sent.
6. Click Save.

Results
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The Notifications page displays the new policy and Email status changes from (Inactive) to (Active). Email
notifications will now be sent when an event that triggers the notification policy occurs.

Parent topic: Monitoring
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Searching for Orchestration Jobs

About this task

Job IDs and keys allow you to search for orchestration jobs. You define primary message keys in Studio, when
you configure connectors. The primary message key must be a unique value. For example, the purchase order
number for a purchase order message. If you do not define a primary key, the runtime uses the job ID, a unique
number that the runtime generates, to identify an orchestration job.

From the Management Console, you can search orchestration jobs by job ID. By default, the Management
Console searches only for completed orchestration jobs that match the job ID you specify. Use the Advanced
Search option to search for all other orchestration jobs.

Procedure

1. From the navigation pane, select Dashboard.
2. In the Results section, enter a job ID in the Key Search field.
3. From your keyboard, press Enter. The completed job with the matching job ID is displayed.

Parent topic: Monitoring

Using Advanced Search

About this task

Use the Advanced Search option to further refine your job search. If you enter values for multiple fields in the
Advanced Search box, the Management Console uses AND logic to refine the search.

For example, you specify a time range in addition to selecting the status that has an error. The Management
Console searches for all orchestration jobs that had an error within the time range specified.

Note: If you choose to search by date and time, you must specify a start and end date and time.

Procedure

1. From the navigation pane, select Dashboard.
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2. In the Results section, select an orchestration. The Orchestration Details page displays all the jobs
associated with the orchestration.

3. In the Advanced Search box, specify values for Job ID, Key, Status, Start Date and Time, or End Date and
Time as appropriate for your search.
Note: If you choose to search by date and time, you must specify a start and end date and time.

4. Click Search.

Results

The search results are displayed in the table.

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.appliance.doc/ApplianceHelp/Monitoring/se
archingOrchestrationJobs.html

Viewing Hardware Status
The WMC allows you to monitor Integration Appliance resource utilization and hardware health.

Viewing Resource Utilization

To view Integration Appliance CPU usage, memory usage, and disk space usage select System > Hardware
Status. The Resource Utilization page is displayed.

The WMC displays a usage percentage for each resource utilization category listed. In cases where a category
contains multiple components, like multiple CPUs, the percentage shown is an average of all the components
displayed. In the Dashboard, the WMC provides a graphical summary of the Integration Appliance resource
utilization data. For more information about interpreting the Resource Utilization graph, see About the Web
Management Console.

Viewing Hardware Health

To view status about Integration Appliance hardware components, select System > Hardware Status. The
Hardware Health page displays the status of fans, temperature, disks, and network links. A green checkmark
indicates that the component is good working order
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Viewing Orchestration Job Logs
The Dashboard displays information about orchestration jobs, including status, timestamp of job events, and
key/job ID in multiple tabs:

All - displays orchestration job information for all project configurations.
Recent - displays orchestration job information for the most recently published or modified project
configurations.
Favorites - displays orchestration job information for the project configurations displayed in the
Favorites filter. Orchestration job information displayed through this filter also displays in the Recent and
All filters.

In some cases, the Management Console displays an orchestration job status of Unknown, even though the
orchestration job completed successfully. Rebooting the environment, while orchestration jobs are processing,
can result in the Unknown status because monitoring data is lost during the reboot. Stop all orchestration jobs
before rebooting the environment to avoid an Unknown status.

Click an orchestration job to view the orchestration details for that orchestration. The Orchestration Details
page displays all the jobs associated with the orchestration you selected and the status of each individual job.
Use the Left and Right arrows (<< , <, >, >>) to view all orchestration jobs.

Parent topic: Monitoring

Sorting Orchestration Jobs

About this task

You can search orchestration jobs by job ID. To sort orchestration jobs by project configuration name,
orchestration name, status, time, or job ID click the appropriate column header.
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SNMP basics
The Simple Network Management Protocol (SNMP) is an Internet standard protocol used primarily in network
management systems to monitor network devices for conditions that warrant administrative attention. Devices
that typically support SNMP include routers, switches, servers, workstations and printers. This section
introduces SNMP basics and provides an overview of Cast Iron MIBs.

 1077



In the lexicon of SNMP, a Cast Iron Integration Appliance is referred to as a "network element" or "managed
device," indicating that it is a citizen on a network and available to be managed. Network elements include an
agent that provides information about the element. Agents perform two key functions. First, they respond to
requests from the management system and secondly, send notifications about events on the network element.
Asynchronous notifications from agent to manager are referred to as traps.

SNMP traps enable an agent to notify the management station of significant events by way of an unsolicited
SNMP message. Information provided through polling or traps are defined in Management Information Bases
(MIBs). A MIB is a virtual database used for managing the entities in a communications network. MIBs define a
hierarchy of objects, with each object having its own Object Identifier (OID). An OID is specified by numbers
separated by periods, for example: ".1.3.6.1.2.1.1." A OID is sometimes referred to by a common name. For
example, the specific OID .1.3.6.1.2.1.1 can be referred to as "system." The SNMP protocol defines many
public MIBs, and also allows for organizations to define custom, application-specific MIBs.

Understanding Cast Iron MIBs

Files downloaded from the Cast Iron WMC have multiple MIB DEFINITIONS = BEGIN - END sections. Each
section comprises a MIB with its own hierarchy. To poll for Cast Iron-specific information, use CASTIRON-IA-
MIB. Each MIB has a MODULE-IDENTITY that describes the MIB function. A comment section that follows
MODULE-IDENTITY provides an overview of the MIB contents and contains an Object Summary that lists the
name and OID of every MIB object.

Note: Some tools, such as those provided by NET-SNMP, require each MIB to be split into a single file. For more
information on splitting MIBs, see Setting up an SNMP receiver.
A section of the Object Summary from a CASTIRON-IA-MIB follows:

--   ciIaProjectSummary                             ciia.1.1.1 
--    ciIaNbrProjects                               ciia.1.1.1.1 
--    ciIaNbrRunningOrchs                           ciia.1.1.1.2 
--    ciIaNbrStoppedOrchs                           ciia.1.1.1.3 
--    ciIaNbrRunningJobs                            ciia.1.1.1.4 
--    ciIaNbrCompletedJobs                          ciia.1.1.1.5 
--    ciIaNbrErroredJobs                            ciia.1.1.1.6

As shown, an organizational node (in this case, OBJECT-IDENTITY, which is similar to a directory) called
ciIaProjectSummary contains general information about projects. Inside that "directory" are specific items
(OBJECT-TYPEs) containing the number of projects, the number of running and stopped orchestrations and
more. To get more information about the meaning of these items, search the file for the name of the item. For
example, to get information about ciIaNbrRunningJobs, searching the file for that string turns up the following:

ciIaNbrRunningJobs OBJECT-TYPE                      -- ciia.1.1.1.4 
    SYNTAX Unsigned32 
    MAX-ACCESS read-only 
    STATUS current 
    DESCRIPTION 
        "Total number of currently running jobs. 
        " 
::= { ciIaProjectSummary 4 }

The key areas are:

ciIaNbrRunningJobs OBJECT-TYPE - Defines the name of the object. Note that there is a comment at the
end giving a shortened form of the OID.
SYNTAX Unsigned32 - This is an unsigned integer whose value could go up or down.
MAX-ACCESS read-only - A read-only value. The manager may ask for it but cannot change it.
DESCRIPTION - Describes the object.

The following example illustrates the data displayed when polling for ProjectSummary information:
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$ snmpwalk -v 2c -c public -M "+/home/choller/mibs" -m "+CASTIRON-IA-MIB" 
flintstone2 ciIaProjectSummary 
CASTIRON-IA-MIB::ciIaNbrProjects.0 = Gauge32: 2 
CASTIRON-IA-MIB::ciIaNbrRunningOrchs.0 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaNbrStoppedOrchs.0 = Gauge32: 14 
CASTIRON-IA-MIB::ciIaNbrRunningJobs.0 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaNbrCompletedJobs.0 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaNbrErroredJobs.0 = Gauge32: 0

The following data is displayed when polling lciIaProjectTable:

--   ciIaProjectTable                               ciia.1.1.2 
--    ciIaProjectEntry                              ciia.1.1.2.1 
--     ciIaProjEntryIndex                           ciia.1.1.2.1.1 
--     ciIaProjEntryName                            ciia.1.1.2.1.2 
--     ciIaProjEntryVersion                         ciia.1.1.2.1.3 
--     ciIaProjEntryConfig                          ciia.1.1.2.1.4 
--     ciIaProjEntryState                           ciia.1.1.2.1.5 
--     ciIaProjEntryNbrRunning                      ciia.1.1.2.1.6 
--     ciIaProjEntryNbrCompleted                    ciia.1.1.2.1.7 
--     ciIaProjEntryNbrErrored                      ciia.1.1.2.1.8 
--     ciIaProjEntryTimePublished                   ciia.1.1.2.1.9

SNMP Tables can be challenging. SNMP tables indicate the name, version, configuration, state and other
information about each project on the appliance, similar to a database schema. Each entry item (for example,
ciIaProjEntryName, ciIaProjEntryVersion ) describes a column in the table. You can search through the MIB for
the string to find more information on each item. Note: Attempting to "walk" the Project table in an iterative
fashion may present problems. Instead, always use a tool feature that understands tables when viewing table
information. The following example illustrates a "walk" technique. In this case a project was published and
then cloned to create a new configuration, resulting in two table rows. As the output indicates, it is difficult to
understand which items are associated with specific rows. In this case, you need to view the index (the last
piece of the OID) to determine the correct arrangement of items and rows.

$ snmpwalk -v 2c -c public -M "+/home/choller/mibs" -m "+CASTIRON-IA-MIB" 
flintstone2 ciIaProjectTable 
CASTIRON-IA-MIB::ciIaProjEntryName.98304 = STRING: OnlineLicensing 
CASTIRON-IA-MIB::ciIaProjEntryName.98305 = STRING: OnlineLicensing 
CASTIRON-IA-MIB::ciIaProjEntryVersion.98304 = STRING: 1.0 
CASTIRON-IA-MIB::ciIaProjEntryVersion.98305 = STRING: 1.0 
CASTIRON-IA-MIB::ciIaProjEntryConfig.98304 = STRING: Default 
CASTIRON-IA-MIB::ciIaProjEntryConfig.98305 = STRING: OnlineLicensingClone 
CASTIRON-IA-MIB::ciIaProjEntryState.98304 = INTEGER: undeployed(1) 
CASTIRON-IA-MIB::ciIaProjEntryState.98305 = INTEGER: undeployed(1) 
CASTIRON-IA-MIB::ciIaProjEntryNbrRunning.98304 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrRunning.98305 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrCompleted.98304 = Counter32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrCompleted.98305 = Counter32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrErrored.98304 = Counter32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrErrored.98305 = Counter32: 0 
CASTIRON-IA-MIB::ciIaProjEntryTimePublished.98304 = STRING: 2009-6-
12,16:36:20.0,+0:0 
CASTIRON-IA-MIB::ciIaProjEntryTimePublished.98305 = STRING: 2009-6-
12,16:36:20.0,+0:0

When information is mapped using the snmptable command, it is displayed more clearly, as shown in the
following example:

$ snmptable -v 2c -c public -M "+/home/choller/mibs" -m "+CASTIRON-IA-MIB" 
flintstone2 ciIaProjectTable 
SNMP table: CASTIRON-IA-MIB::ciIaProjectTable 
 
 PEN*                 PEV PEC                  PES          PER COM PEE  PETP 
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 OnlineLicensing      1.0 Default              undeployed   0   0   0    2009-6-
12,16:36:20.0, 
                                                                         +0:0 
 OnlineLicensing      1.0 OnlineLicensingClone undeployed   0   0   0    2009-6-
12,16:36:20.0, 
                                                                         +0:0 
 
*Table Key: PEN=ciIaProjEntryName, PEV=ciIaProjEntryVersion, 
PEC=ciIaProjEntryConfig,  
 PES=ciIaProjEntryState, PER=ciIaProjEntryNbrRunning, COM=ciIaProjEntryNbrCompleted,  
 PEE=ciIaProjEntryNbrErrored, PETP=ciIaProjEntryTimePublished

Note that these examples use textual names rather than OIDs. Because a function of the MIB is to map
between OID and textual name, you should not need to use OIDs on a regular basis.
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Setting up an SNMP receiver
You can use the WMC to create notifications for events that happen in runtime components such as
orchestrations, security, hardware and others. A delivery mechanism for these notifications is SNMP in which a
trap is set for events. To retrieve these events, you must to set up a receiver or manager that is registered with
the appliance. Use the procedures in this section to set up an SNMP receiver.

About this task

When you set up an SNMP receiver, you download and split the MIBs, create the configuration file, enable
notifications, add a notification policy and then test the system:

Procedure

1. Click on WMC: Logs-> Notifications -> SMNP.
2. In the dialog box click Download MIB.
3. Add the MIBs to the machine you've designated to be the receiver.
4. Run the following script to split the MIBs into logical units. Note: the script assumes the file is in the

local directory and that the file you downloaded is named castironsys.mib.

#!/bin/bash 
 
sed -ne 's/DEFINITIONS ::= BEGIN.*//p' castironsys.mib | 
  while read mib; do 
    echo $mib 
    sed -ne "/^$mib/,/^END/p" castironsys.mib > $mib 
  done

5. Set up your SNMP manager of choice.
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6. Select WMC: Logs-> Notifications -> SMNP to enable SNMP notifications. Be sure that the Enable
SNMP checkbox is checked.

7. Add the receiver hostname.
8. Set the trap community to be public. This is defined in /etc/snmp/snmptrapd.conf as the

authCommunity entry.
9. Click Save.
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Adding a notifications policy
When you add a notifications policy, you inform administrators of alerts, policy violations and the status
changes of job executions. Using SNMP traps, the notification system also allows you to send traps to SNMP-
enabled third-party applications. Perform the following steps to add a notifications policy and assign it a name.

Procedure

1. Click on the Policies tab.
2. Click the New Policy link at the bottom left of the screen and give the policy a name.
3. In the Notify When row, select a level and system. Be sure the SNMP checkbox under the Notify

section is checked.
4. Click Save.

Example

The following table shows the system, level and messages delivered via the Uncategorized trap.
TheUncategorized trap is named CASTIRON-IA-MIB::ciIaUncategorizedEv, Enterprise
1.3.6.1.4.1.13336.2.2.2.1.1.10, Trap 1.

Table 1.
Header Header Header

Network Warning Automatically added hostname to /etc/hosts, see "net show etchost."

Hardware Warning Fan is not functional. Fan: {0} Current Speed: {1} rpm Min Required Speed: {2}
rpm Max Allowed Speed: {3} rpm Machine ID: {4}

Hardware Info Fan is functional. Fan: {0} Current Speed: {1} rpm Min Required Speed: {2} rpm
Max Allowed Speed: {3} rpm Machine ID: {4}

Hardware Critical Temperature is out of range. Temperature sensor: {0} Current temperature: {1}
degrees C Minimum: {2} degrees C Maximum: {3} degrees C Machine ID: {4}

Hardware Info Temperature is restored. Temperature sensor: {0} Current temperature: {1}
degrees C Minimum: {2} degrees C Maximum: {3} degrees C Machine ID: {4}
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Header Header Header

Hardware Warning Power has been interrupted. Machine ID: {1}

Hardware Info Power has been restored. Machine ID: {1}

Hardware Warning The Integration Appliance {0} has been opened. Machine ID: {1}

Hardware Info The Integration Appliance {0} has been closed. Machine ID: {1}

Hardware Critical RAID Array {0} is offline. Machine ID: {1}

Hardware Severe RAID Array {0} is degraded, probably because of a disk failure. Machine ID: {1}

Hardware Info RAID Array {0} is optimal. Machine ID: {1}

Hardware Critical RAID Disk {0} on array {1} has failed. Machine ID: {2}

Hardware Info RAID disk {0} on array {1} is rebuilding. Do not remove the disk until the rebuild
is completed. Machine ID: {2}

Hardware Info RAID disk {0} on array {1} is online. Machine ID: {2}

Hardware Warning High Availability System Failover successful

Hardware Info Network Interface Link Up. Network Interface {0} is now up Machine ID: {1}

Hardware Warning Network Interface Link Down. Network Interface {0} is now down Machine ID:
{1}

Hardware Critical Incorrect number of CPUs: expected {0} but found {1}

Resources Info Swap space monitoring errors encountered.

Resources Info Suspending swap space monitoring for {0} seconds.

Resources Info Swap space usage is now below the {0}% warning threshold - current usage is
{1}.{2}%

Resources Info Swap space usage is now below the {0}% critical threshold - current usage is
{1}.{2}%

Resources Warning Swap space usage has exceeded the {0}% warning threshold - current usage is
{1}.{2}%

Resources Critical Swap space usage has exceeded the {0}% critical threshold - current usage is
{1}.{2}%

Resources Info Disk space monitoring errors encountered.

Resources Info Suspending disk space monitoring for {0} seconds.

Resources Info {0} disk space usage is now below the {1}% warning threshold - current usage is
{2}.{3}%

Resources Info {0} disk space usage is now below the {1}% critical threshold - current usage is
{2}.{3}%

Resources Warning {0} disk space usage has exceeded the {1}% warning threshold - current usage
is {2}.{3}%

Resources Critical {0} disk space usage has exceeded the {1}% critical threshold - current usage is
{2}.{3}%

Resources Critical HA peers are running different versions of CIOS!

Parent topic: Monitoring

1082   



Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.appliance.doc/ApplianceHelp/Monitoring/a
dd_notifications_policy.html

About the Resource Utilization Graph
Describes how to use the data the Resource Utilization graph provides for capacity planning and understanding
the health of the runtime environment.

The Resource Utilization graph tracks the following variables, which you can use to analyze the overall health of
the runtime and calculate the available capacity for additional projects and orchestrations:

% Disk Used
% Memory Used
GC Activity
# Running Jobs

% Disk Used

This variable tracks the percentage of disk space used by orchestration job variables and historical data.

When you run an orchestration job, the runtime uses the disk to store the variable data for that job. When you
enable persistence, the stored variable data for jobs allows the Integration Appliance to provide a point-in-time
recovery of orchestration jobs should the Integration Appliance encounter a fault that requires restarting the
runtime.

The runtime also stores historical data about orchestration jobs, which you can view on the Web Management
Console (WMC) Job Log page.

If the amount of disk space available becomes too low, the Integration Appliance generates an alert, which
sends a notification to designated users.

% Memory Used

The Integration Appliance has a fixed amount of available memory to run orchestrations. The % Memory Used
variable tracks the amount of this fixed memory used by orchestration jobs and the corresponding variable
data. When the memory allocated to orchestration jobs and variable data is no longer being used, the memory
is returned to the pool of available memory using a process called garbage collection.

There is a direct relationship between the amount of memory used and garbage collection cycles. However,
high memory usage does not necessarily mean an increase in full garbage collection cycles.

For more information about factors that affect the amount of memory used, see Best Practices for Memory
Management.

GC Activity
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Garbage collection is a process that returns memory, held by completed jobs and variable data, back to a pool
of memory used by all orchestration jobs. This garbage collection process ensures that the Integration
Appliance has a constant supply of free memory to be used by new orchestration jobs.

The GC Activity variable tracks the percentage of full garbage collections that occur in a minute. This
percentage is calculated by dividing the number of full garbage collections by 6. Ideally, the GC activity should
be at or below 50%, that is 3 full garbage collections per minute. Orchestration performance is severely
degraded when 6 or more full garbage collections happen per minute.

For more information about garbage collection and factors that impact garbage collection, see Best Practices
for Memory Management.

# Running Jobs

Displays the number of jobs currently running on the Integration Appliance.
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Hardware health
Use the information in this section to obtain notifications based on the hardware health of the appliance.

First you must prepare the SNMP Manager to receive Uncategorized traps (CASTIRON-IA-
MIB::ciIaUncategorizedEv .1.3.6.1.4.1.13336.2.2.2.1.1.10 #1). Next you configure the SNMP Manager to poll
for the following items and generate notifications when the conditions are met:

Table 1.
Parameters to
Monitor Recommended Thresholds Snmp OID

Garbage
Collections

Alert if this value changes quickly
(by more than 6 counts in a 1-
minute time period).

CASTIRON-IA-MIB::ciIaResNbrGarbageCollects
.1.3.6.1.4.1.13336.2.2.2.1.1.2.1.0

Memory Usage Alert if this value goes over 80%
(raw value of 8000).

CASTIRON-IA-MIB::ciIaResPctMemoryUsed
.1.3.6.1.4.1.13336.2.2.2.1.1.2.2.0

Disk Usage Alert if this value goes over 75%
(raw value of 7500).

CASTIRON-IA-MIB::ciIaResPctWipFull
.1.3.6.1.4.1.13336.2.2.2.1.1.2.3.0

Garbage collections

CASTIRON-IA-MIB::ciIaResNbrGarbageCollects counts the number of garbage collections that have occurred
since the system was last restarted. While occasional garbage collections are normal, collections of 6 or more
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per minute is excessive and indicates that an appliance is overworked and as a result, may experience
performance issues.

$ snmpwalk -On -v 2c -c public -M +. -m +CASTIRON-IA-MIB pebbles2.sanjose.ibm.com  
  CASTIRON-IA-MIB::ciIaResNbrGarbageCollects .1.3.6.1.4.1.13336.2.2.2.1.1.2.1.0 = 
Counter32: 149

Memory usage

CASTIRON-IA-MIB::ciIaResPctMemoryUsed shows the percentage of total memory in use, expressed in
hundredths of a percent. This number is updated after each garbage collection.

$ snmpwalk -On -v 2c -c public -M +. -m +CASTIRON-IA-MIB pebbles2.sanjose.ibm.com  
  CASTIRON-IA-MIB::ciIaResPctMemoryUsed .1.3.6.1.4.1.13336.2.2.2.1.1.2.2.0 = 
Gauge32: 1.84

Note that this value is provided as an integer (184 in this case), but the MIB causes the SNMP manager to alter
its displayed value. Values expressed in hundredths of a percent are usually modified automatically. For
example in this case. '1234' should be displayed as '12.34'. However, take care to ensure that the SNMP
management tool handles this automatically. If it does not, the value will appear as follows:

$ snmpwalk -On -v 2c -c public pebbles2.sanjose.ibm.com  
 .1.3.6.1.4.1.13336.2.2.2.1.1.2.2.1.3.6.1.4.1.13336.2.2.2.1.1.2.2.0 = Gauge32: 184

Recommendation: Alert if this value goes over 80% (raw value of 8000).

Disk usage

CASTIRON-IA-MIB::ciIaResPctWipFull indicates the percentage of total Work-in-progress (WIP) disk space in
use, expressed in hundredths of a percent. This number is key for predicting job purging activities.

$ snmpwalk -On -v 2c -c public -M +. -m +CASTIRON-IA-MIB pebbles2.sanjose.ibm.com  
  CASTIRON-IA-MIB::ciIaResPctWipFull .1.3.6.1.4.1.13336.2.2.2.1.1.2.3.0 = Gauge32: 
6.00

Recommendation: Alert if this value goes over 75% (raw value of 7500).
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Testing the system
To test the system, generate a trap by trying to log in with invalid user credentials. This trap should then get
picked up by your SNMP manager.
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Permissions
Permissions topics provide information about creating user profiles, setting and changing passwords, creating
and managing users, and creating and managing groups.

About Built-In Groups
Built-in groups are predefined groups. In the cloud, in addition to a tenant administrator group, each
environment has a built-in administrator, publisher, and user group.
About Libraries Environments
About User Profiles
A user profile provides a summary of user details, such as: name, display name, email, and group
memberships.
Assigning Users to Groups
You must have tenant administrator or environment administrator privileges to assign users to groups.
Environment administrators can only add users to groups in their specific environment.
Changing Your Password
Changing User Passwords
Creating New Groups
In the cloud, only the tenant admin user can create new groups. In a multi-environment tenant,
environment administrators can also create new groups for their specific environment.
Creating New Users
In the cloud, only the tenant admin user can create new users. In a multi-environment tenant,
environment administrators can also create new users for their specific environment.
Deleting Groups
In the cloud, only the tenant admin users can delete groups from a cloud environment. In a multi-
environment tenant, environment administrators can also delete groups for their specific environment.
Deleting Users
In the cloud, only the tenant admin user can delete users from a cloud environment. In a multi-
environment tenant, environment administrators can also delete users for their specific environment.
Granting Project Configuration Permissions
You can grant permissions to a user or a group by editing the project configuration permission. When you
grant permissions to a user or group, they can edit or delete the project configuration.
Local Staging Database Permissions
Only users with Administrator privileges, granted as being part of the built-in Administrator group, can
start, stop, and perform operations on the Local Staging Database.

Feedback | Notices
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About Built-In Groups
Built-in groups are predefined groups. In the cloud, in addition to a tenant administrator group, each
environment has a built-in administrator, publisher, and user group.

For example: A tenant, named Cumulus, is created for your organization. Within this tenant there are two
environments: Development and Production. The following built-in groups would be available:

admin [cumulus.com]

admin [Development]

publisher [Development]

user [Development]

admin [Production]

publisher [Production]

user [Production]

The same user can be a part of multiple groups. You can assign users to a built-in group or create a new group.

Note: If you grant project configuration permissions to a group, the users in that group will have full access to
the project configuration--user will be able to create new versions of the project configuration, as well as edit
and delete the project configuration.

The following list defines the permissions granted to each of the built-in groups:

Tenant Administrator Group. Provides privileges to all environments, users, groups, and projects in a
specific tenant. Permits users to create, edit, and delete users and custom groups in the tenant. Users in
this group can add and delete users to and from any built-in or custom group in the tenant. Users in this
group can view, edit, and delete permissions for all source projects in the tenant.

Users in this group can view all the environments in the tenant and have all the permissions of an
environment administrator in each of the tenant environments.

Environment Administrator Group. Provides privileges to all users, groups, and projects in a specific
environment. Permits users to create, edit, and delete users and custom groups in a specific
environment. Users in this group can add and delete users to and from any built-in or custom group in
the environment.

Environment Administrators can also create and deploy project configurations for project that any
environment publisher publishes, and view orchestration job details for any project configuration in the
environment. With environment administrator group privileges you can edit permissions that publishers
for the same environment set for their individual project configurations.

Even though members of the Environment Administrator group have Environment Publisher group and
Environment User group privileges, the members of the Environment Administrator Group are not
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displayed in other groups in the same environment until you explicitly add the user.

Environment Publisher Group. Provides project privileges in a specific environment. Permits users to
create, deploy, or delete project configurations for any project that they publish in the environment.
Users in this group can also start and stop orchestrations and view orchestration job details for project
configurations they deployed in the environment. As an environment publisher, you can grant
permissions for individual project configurations you create to another user with environment publisher
privileges for the same environment.

The members of the Environment Publisher Group do not appear in the Environment User Group, until
you explicitly add the user.

Environment User Group. Permits users to monitor alerts and orchestrations in a specific environment.
Users in this group can create and edit projects; however, they cannot publish the project to an
environment. You must have Publisher privileges for the specific environment to which you want to
publish a project. All users are automatically members of the Environment User group.

In a multi-environment tenant, users in this group only see the environment tab for environments of
which they are a member. For example, a tenant has a Development, a Staging, and a Production
environment. The tenant administrator or administrator of the Development environment adds a user to
the User [Development] group. When the user logs in to the tenant, the user can only see the
Development environment, even though the tenant has two other environments.
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About Libraries Environments
Libraries Environment is a user profile parameter that specifies the environment from which Studio retrieves
connector libraries.

In a multi-environment tenant, each environment can potentially have different versions of connector libraries
installed. Setting this parameter points Studio to the libraries you want to use while verifying your projects. This
parameter is not as critical if your project does not use an endpoint that requires additional libraries to be
installed. See the Connector Release Notes® for a complete list of endpoints that require you to install
additional libraries.

Note: The environment you select should match the environment of the primary group the user is a member of.
For example: If you select the Development environment as the Libraries Environment, you should be a
member of groups in the Development environment.
Parent topic: Permissions
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About User Profiles
A user profile provides a summary of user details, such as: name, display name, email, and group
memberships.

You can access and edit user profile settings from the Settings link in the top right-hand corner of the
Management Console. The user profile displayed is for the user currently logged in to the Management
Console.

Parent topic: Permissions

Accessing User Profile Information

Procedure

1. Click the Settings link in the upper right-hand corner of the Management Console. The Settings window
is displayed.

2. Optional: For the Display Name setting, click Edit to modify the display name. After you modify the
setting, click Save.

3. Optional: For the Password setting, click Edit to modify the user password. After you modify the setting,
click Save.

4. Optional: For the Email setting, click Edit to modify the user’s email address. After you modify the
setting, click Save.

5. Optional: Cloud: Click Change Libraries Environment, to specify the environment from which Studio
retrieves connector libraries. After you modify the setting, click Save.

6. Click Close to close the Settings window.
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Assigning Users to Groups
You must have tenant administrator or environment administrator privileges to assign users to groups.
Environment administrators can only add users to groups in their specific environment.

 1089



You can assign users to groups, when you create or edit a user. You can also assign users to groups, when you
create or edit groups.

For more information about assigning users and groups, see Creating New Users and Creating New Groups.
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Changing Your Password

About this task

You can change your own password at anytime. However, to modify another user’s password, you must have
tenant administrator permissions. Environment administrators cannot change passwords for users in their
environment.

For example, you are the administrator for the Development environment. You can change your password, but
you cannot change the password for any specific user with permissions to the Development environment.

Procedure

1. Click the Settings link in the upper right-hand corner of the Management Console. The Settings window
is displayed.

2. For the Password setting, click Edit.
3. Enter values for the Old Password, New Password, and Confirm Password fields.

If you clear the Hide Password Text option, your password displays and is no longer encrypted.

4. Click Save to change your password.

Results

A confirmation message displays when the Management Console has successfully saved the new password.
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Changing User Passwords

About this task

You can change your own password at anytime. However, to modify another user’s password, you must have
tenant administrator permissions. Environment administrators cannot change passwords for users in their
environment.

For example, you are the administrator for the Development environment. You can change your password, but
you cannot change the password for any specific user with permissions to the Development environment.

To change another user’s password:

Procedure

1. Log in to the Management Console as the tenant administrator.
2. Select Security > Users and Groups.
3. Click the name of the user whose password you want to change.
4. In the Edit User window, enter a password and confirm the password.

If you clear the Hide Password Text option, your password displays and is no longer encrypted.

5. Click Save to change your password.

Results

A confirmation message displays when the Management Console has successfully saved the new password.
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Creating New Groups
In the cloud, only the tenant admin user can create new groups. In a multi-environment tenant, environment
administrators can also create new groups for their specific environment.

Before you begin

On a physical or virtual Integration Appliance, only admin users can create new groups.
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Procedure

1. In the Management Console, login as administrator.
2. Select Security > Users and Groups.
3. In the Groups section, click New Group.
4. In the New Group dialog box, enter a Name and Display Name for your new group.
5. In the User list, select the users to join the group.

Select the User checkbox to select all the users in the list.

6. Click Save.

Results

In the Groups section of the Users and Groups page, the new group displays in alphabetical order.
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Creating New Users
In the cloud, only the tenant admin user can create new users. In a multi-environment tenant, environment
administrators can also create new users for their specific environment.

Before you begin

On a physical or virtual Integration Appliance, only admin users can create new users.

Procedure

1. In the Management Console, login as administrator.
2. Select Security > Users and Groups.
3. In the Users section, click New Users.
4. In the New User window, enter a value for the following fields: Name, Display Name, Email, Password,

and Confirm Password.

It is recommended that you add the tenant name to the user name and display name.

For example, if the tenant name is ibm.com®, then the new user name should be newuser@ibm.com.
This will help you identify common user names across multiple tenants in the cloud.

5. Optional: Clear the Hide Password Text checkbox. If you clear this option, the password you entered
displays and is no longer encrypted.

6. In the Groups list, select all the groups to which the new user will have access.
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7. Optional: Clear the Active checkbox. If you clear this option, the user cannot log in to the Management
Console.

8. Cloud only: From the Libraries Environment list, select the environment from which the user's projects
can retrieve additional libraries and files for endpoints. The environment you select should match the
environment of the primary group the user is a member of. For example: If you select the Development
environment as the Libraries Environment, you should be a member of groups in the Development
environment.

9. Click Save.

Results

In the Users section of the Users and Groups page, the new user displays in alphabetical order.
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Deleting Groups
In the cloud, only the tenant admin users can delete groups from a cloud environment. In a multi-environment
tenant, environment administrators can also delete groups for their specific environment.

Before you begin

On a physical or virtual Integration Appliance, only admin users can delete groups.

Procedure

1. In the Management Console, select Security > Users and Groups.
2. In the Groups section, select the group or groups that you want to delete.
3. Click Delete.
4. Click Yes, to confirm that the Management Console should delete the selected groups.

Results

The Management Console refreshes the list of groups.

Parent topic: Permissions
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Deleting Users
In the cloud, only the tenant admin user can delete users from a cloud environment. In a multi-environment
tenant, environment administrators can also delete users for their specific environment.

Before you begin

On a physical or virtual Integration Appliance, only admin users can delete users.

Procedure

1. In the Management Console, login as administrator.
2. Select Security > Users and Groups.
3. In the Users section, select the user or users that you want to delete.
4. Click Delete.
5. Click Yes, to confirm that the Management Console should delete the selected users.

Results

The Management Console refreshes the list of users.

Parent topic: Permissions
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Granting Project Configuration Permissions
You can grant permissions to a user or a group by editing the project configuration permission. When you grant
permissions to a user or group, they can edit or delete the project configuration.

Before you begin

You must have Administrator privileges or you must be the publisher of a project to grant permissions to other
users or groups to edit or delete project configurations.

About this task
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By default, permissions to project configurations are granted to only the Administrator Group. If you want to
grant permissions to another group you must explicitly do so.

For example, you are a user with publisher rights and belong to the built-in Publisher group. You publish a
project. Only you, the Administrator Group members, and the members of the Publisher group that you belong
to, will have permissions to the project configuration. If you would like to include another group to have
permissions to the project configuration, you must edit the permission on the project configuration to include
another group.

To edit permissions:

Procedure

1. Click a project configuration. The Configuration Details page is displayed.
2. In the Permissions section, click Edit under Group or User and select group or groups and user or users

to grant permissions to.
3. Click Save.

Note: When permission is given to a group, all the users in that group are granted permission to the
project configuration by default. You cannot remove permissions for an individual user from this group. If
any user (outside this group) requires access to the project, you can grant permissions to the user by
selecting only that user from the user table.

Results

All the users and groups you select now have full access to the project configuration. These users and groups
can now edit and delete the project configuration.
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Local Staging Database Permissions
Only users with Administrator privileges, granted as being part of the built-in Administrator group, can start,
stop, and perform operations on the Local Staging Database.

Users with Publisher privileges can view tables and perform operations on the database, only if the Local
Staging Database has already been started by a user with Administrator privileges. If the Local Staging
Database has not been started, users with Publisher privileges will not be able to view the database or perform
operations on the database.

Users that are part of the built-in Users group or with WMC login credentials created in an LDAP Server do not
have access to the Local Staging Database.

Parent topic: Permissions
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Using Secure Connectors
Using Secure Connectors topics provide information about creating, installing, and managing Secure
Connectors.

About Secure Connectors
Secure Connector Minimum Requirements
This topic provides information about minimum system requirements needed to use a Secure Connector.
Creating Secure Connectors
This topic provides information about creating Secure Connectors.
Downloading Secure Connector Configuration Files
How to download Secure Connector configuration files.
Installing Secure Connectors
Provides procedures to download the Secure Connector installer and install the Secure Connector.
Adding or importing certificates to the Secure Connector TrustStore/KeyStore
For Cast Iron connector activities, such as HTTP, FTP, Email, or Web Services (or any other connector)
that need to establish connection with the SSL enabled server (HTTPS/FTPS), you must import the
corresponding certificates into the TrustStore or KeyStore of the Secure Connector.
Installing Vendor Supplied Libraries for Secure Connectors
Certain endpoints require additional libraries to be installed before the Secure Connector can
communicate with them. This section provides information about using the Web Management Console
(WMC) to install these vendor supplied libraries. For a complete list of connectors that require vendor
supplied libraries, open the Update Connector Libraries page in WMC.
Downloading and installing the SAP libraries
To connect to an SAP system from studio, you must install SAP DLLs and JAR files onto your Windows
development machine. You must have the SAP login credentials to enter the SAP Support Portal and
download the files.
Uninstalling Secure Connectors (Windows)
This topic provides information about uninstalling a Secure Connector from a Windows machine.
Uninstalling Secure Connectors (Linux)
This topic provides information about uninstalling a Secure Connector from a Linux machine.
Starting and Stopping Secure Connectors
Starting and Stopping Secure Connectors topics provide information about starting and stopping Secure
Connectors on Windows and Linux machines. For Windows machines, options you chose during
installation affect how you can start and stop Secure Connectors. If you installed the Secure Connector
as an automatic Windows Service, as recommended, then you can use the Windows Services control
panel to stop and start the Secure Connector. If you installed the Secure Connector as a Windows
application, then you can start and stop the Secure Connector using Windows Start menu shortcuts or
desktop shortcuts. For Linux machines, you can start and stop Secure Connectors by using a graphical
interface or by running commands from the command line.
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Upgrading Secure Connectors
This topic provides information about upgrading Secure Connectors.
Updating Secure Connector Configuration
This topic provides information about updating Secure Connector configuration.
Monitoring Secure Connector
You can use the Monitoring tool to check the status of a Secure Connector (SC1) and provide an
alternate Toggle Secure Connector (SC2) in case of Secure Connector (SC1) stops working. In case of
failure of SC1, specifying SC2 will switch all the projects using SC1 to use SC2 to provide continuous
availability of Cast Iron projects.
Troubleshooting Secure Connectors
This topic provides potential solutions for issues you have with the Secure Connector.
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About Secure Connectors
A Secure Connector facilitates the secure transfer of data between the IBM® WebSphere® Cast Iron® appliance
and an endpoint that is located behind a firewall. The Secure Connector installer for appliance supports both
32-bit and 64-bit Windows and Linux machines.

To enable a Secure Connector, a tenant administrator must complete the following tasks:

Create a Secure Connector

Download the Secure Connector configuration file

Launch the Secure Connector installer

Install vendor supplied libraries

Parent topic: Using Secure Connectors
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Secure Connector Minimum Requirements
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This topic provides information about minimum system requirements needed to use a Secure Connector.

You can run the Secure Connector on the following operating systems:

Microsoft Windows 7
Microsoft Windows 8
Microsoft Windows 2008
Microsoft Windows 2012 R2 64 bit server
Linux (RHEL 6.5, Ubuntu 14.04)
Note: For installing Secure Connectors on Linux platform, use xWindows or KDE environment to use the
GUI option.

The Secure Connector has the following minimum system requirements:

1 GHz CPU
2 GB RAM
Java 1.7 and above.

Parent topic: Using Secure Connectors
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Creating Secure Connectors
This topic provides information about creating Secure Connectors.

About this task

Use the Web Management Console (WMC) to create a Secure Connector for your environment.

After you create a Secure Connector in the appliance, you must configure a machine behind the firewall to
facilitate communication between the Secure Connector and a specific endpoint behind the firewall. Use the
Secure Connector installer to configure the machine behind the firewall.

Note: If the endpoint you are creating requires extra libraries for a Secure Connector, use WMC to install the
libraries before you deploy any project configurations that use the Secure Connector.

Procedure

1. From the navigation pane of an environment tab, select System > Secure Connectors.
2. Click New Secure Connector. The Create Secure Connector dialog box is displayed.
3. Provide a name for the new Secure Connector.
4. Provide a brief description of the Secure Connector.
5. Click Save. The Secure Connector is displayed in the Secure Connector page.

Downloading the Secure Connector installer:
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You can download the Secure Connector installer from the Cast Iron installer CD, Fix Central, or IBM
Passport Advantage. You can download for Windows or Linux, 32-bit or 64-bit, based on your
requirement.

Parent topic: Using Secure Connectors
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Downloading Secure Connector Configuration Files
How to download Secure Connector configuration files.

About this task

When you download a configuration file, the configuration file is saved to your default download directory. You
can choose to save configuration files to different locations. Regardless of the number of configuration files you
download, you can only use one configuration file during the Secure Connector installation process.

When you have selected a configuration file to set up a Secure Connector, that configuration file is used to
configure any subsequent Secure Connector. It is not recommended to configure multiple Secure Connectors
using the same configuration file. Instead, use a new configuration file or modify the existing configuration file.
The Gateway, Listen to Port, and Transmit to Port parameters should have unique values for each Secure
Connector.

The Secure Connector configuration file provides the Secure Connector installer with values for the following
parameters:

Secure Connector Name - Specify the name of the Secure Connector you created.
Tenant ID - Use the default value provided in the file. It is used for internal communication.
Environment ID - Use the default value provided in the file. It is used for internal communication.
Gateway - Use the default value provided in the file. It is the data network IP on which the appliance is
running.
Listen on Port - Only modify this parameter if another service is using the port that is specified or you
want to run multiple Secure Connectors on the box.
Transmit on Port - Only modify this parameter if another service is using the port that is specified or you
want to run multiple Secure Connectors on the box.
Secure Connector Auth Key - Specify the authentication key from the Secure Connector you created in
the appliance.
Secure Connector Private Key - Specify the authentication private key, which you downloaded while
creating the Secure Connector in the appliance.

Note: If you are using secure connector on appliance then:

Ensure that the appliance IP is reachable (you are able to ping) from the machine where the secure
connector is installed.
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The ports mentioned below are used internally by the appliance for communication with the Secure
Connector. It is recommended that you do not use these ports on the appliance in any of your
orchestration activities that involves HTTP Receive Request activity and Web Service activities.

9080
9442
9443
9445

To download the Secure Connector configuration files, complete the following steps:

Procedure

1. Log into the Web Management Console as the tenant administrator.
2. From the Navigation pane of an environment tab, select System > Secure Connector.
3. In the Secure Connector window, click the Secure Connector that will communicate with an endpoint

behind the firewall. The Edit Secure Connector dialog box is displayed.
4. Click Download Secure Connector Configuration and click Download now. The Opening Secure

Connector Configuration dialog box is displayed.
5. Choose Save File and click OK. The configuration file is saved to the default download directory of the

current user.

Parent topic: Using Secure Connectors
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Installing Secure Connectors
Provides procedures to download the Secure Connector installer and install the Secure Connector.

Before you begin

For Windows installations, verify that you do not have an existing version of the Secure Connector installed. If
you have a previous version that is installed, uninstall it before you proceed.

For Linux installations, while it is not required, it is good practice to uninstall previous Secure Connector
installations.

For Linux machines, install a desktop environment, such as GNOME or KDE, to provide a graphical interface.

About this task

After you create a Secure Connector in the appliance, you must configure a machine behind the firewall to
facilitate communication between the Secure Connector and a specific endpoint behind the firewall. Use the
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Secure Connector installer to configure the machine behind the firewall.

Note: The machine on which you choose to run the installer must have access to the endpoint. You do not have
to run the installer on the same machine as the endpoint.
Note: If you are using secure connector on appliance then:

Ensure that the appliance IP is reachable (you are able to ping) from the machine where the secure
connector is installed.
The ports mentioned below are used internally by the appliance for communication with the Secure
Connector. It is recommended that you do not use these ports on the appliance in any of your
orchestration activities that involves HTTP Receive Request activity and Web Service activities.

9080
9442
9443
9445

Downloading the Secure Connector installer:

You can download the Secure Connector installer from the Cast Iron® installer CD, Fix Central, or IBM®
Passport Advantage®. You can download for Windows or Linux, 32-bit or 64-bit, based on your requirement.

To install the Secure Connector:

1. Start the Secure Connector installer that you downloaded.
windows-secure-connector-installer.exe (for Windows)
linux-secure-connector-installer.sh (for Linux)

The Secure Connector Installer wizard is displayed.

2. Click Next then read and accept the licensing agreement.
3. Click Next and choose an installation directory.
4. Click Next. A message window states the location where the target directory is created.

Note: If an installation directory exists, a warning message is displayed and you must confirm that you
want to install and overwrite existing files.

5. Click OK.
6. Set up shortcut options to start, stop, and edit a Secure Connector.

a. Select one or both of the following options:
Create shortcuts in the Start menu.
Create additional shortcuts on the desktop.

b. Select a program group from which you access the shortcuts.
c. Choose to create shortcuts for the current user or all users.

7. Click Next. The installation progress displays.
8. Select a Secure Connector configuration file. If you have not already downloaded a Secure Connector

configuration file, download one now. For more information about how to download Secure Connector
configuration files, see Downloading Secure Connector Configuration Files.

9. Click Next.
10. For Windows installation, choose to install and run the Secure Connector as a Windows Service. If you

choose install the Secure Connector as a Windows Service, you can control the Secure Connector using
the Windows Services control panel (recommended). If you choose not to install and run the Secure
Connector as a Windows Service, then the Secure Connector is installed as a Windows application. To
run the Secure Connector as a Windows Service, you must specify the following service account
information:

Service Start Mode
Service Account Domain
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Service Account User
Service Account Password

11. Click Next. The Create Vendor Supplied Libraries screen is displayed.
12. Click Add and select the library files to upload. In the appliance, the valid files are .jar,.dll, and .so

file types. The files that you select are displayed in the Files to Add column.
13. Click Update.

The files that display in the Files to Add column are not committed until you click Update.

14. Click Next. A dialog box is displayed to confirm the changes made, if you have not clicked the Update
button. Click Yes to update changes and proceed further. If you click No to go to the next screen without
any changes. Click the Cancel button to stay on the same screen.

15. When you click Yes to proceed further, the Vendor JAR created/updated successfully message
is displayed.

16. Click OK. A message saying that the installation has completed successfully is displayed.
17. Restart the Secure Connector.

Note: If your endpoint (that is SAP) requires additional libraries, you must install the additional libraries before
you start the Secure Connector. For more information about installing additional libraries, see Installing Vendor
Supplied Libraries for Secure Connectors.

To run the Secure Connector installer:

1. Start the Secure Connector installer that you downloaded in the Creating a Secure Connector section.

windows-agent-installer.exe (for Windows)

linux-agent-installer.sh (for Linux)

2. Accept the licensing agreement and choose an installation directory.

3. Log in to the Web Management Console as the administrator.

4. Select Setup > Support Information. Keep the Support Information page open while configuring the
Secure Connector installer parameters. You can cut and paste values from the Support Information page
to the appropriate parameter field.

5. Provide values for the following parameters:

Secure Connector Name - Specify the name of the Secure Connector you created.

Tenant ID - Use the default value provided in the file. It is used for internal communication.

Environment ID - Use the default value provided in the file. It is used for internal communication.

Gateway - Use the default value provided in the file. It is the data network IP on which the
appliance is running.

Listen on Port - Modify this parameter only if another service is using the port that is specified or
you want to run multiple Secure Connectors on the box.

Transmit on Port - Modify this parameter only if another service is using the port specified or you
want to run multiple Secure Connectors on the box.

Secure Connector Auth Key - Specify the authentication key from the Secure Connector you
created in the cloud.
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Secure Connector Private Key - Specify the authentication private key, which you downloaded
while creating the Secure Connector in the cloud.

6. Open a command prompt and navigate to the Secure Connector installation directory.

7. If your endpoint (that is, SAP) requires additional libraries, you must install the additional libraries
before you start the Secure Connector. For more information about installing additional libraries, see
Installing Vendor Libraries on the Secure Connector.

8. Start the Secure Connector by running one of the following files at the command prompt:

For Windows: runclient_osgi.bat

For Linux: runclient_osgi.sh

Parent topic: Using Secure Connectors
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Adding or importing certificates to the Secure Connector
TrustStore/KeyStore

For Cast Iron connector activities, such as HTTP, FTP, Email, or Web Services (or any other connector) that
need to establish connection with the SSL enabled server (HTTPS/FTPS), you must import the corresponding
certificates into the TrustStore or KeyStore of the Secure Connector.

Procedure

1. Use the Java keytool utility to import the required certificates to TrustStore(cacerts) or KeyStore(cert) in
the path mentioned: <secure_connector_install_directory>\etc\security

2. Restart Secure Connector for the changes to take effect.
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Installing Vendor Supplied Libraries for Secure Connectors
Certain endpoints require additional libraries to be installed before the Secure Connector can communicate
with them. This section provides information about using the Web Management Console (WMC) to install these
vendor supplied libraries. For a complete list of connectors that require vendor supplied libraries, open the
Update Connector Libraries page in WMC.

About this task

If your integration project uses a connector that requires additional libraries, you must install the additional
libraries before you deploy the project configuration. Deploying the project configuration before installing the
additional libraries generates runtime errors. For a complete list of connectors that require vendor supplied
libraries, open the Update Connector Libraries page. See the following procedure.

Procedure

1. Log on to WMC.
2. Select System > Upgrade Connector Libraries .
3. In the Connector column, select the connector for which you want to install additional files.

Any files that have already been installed are displayed in the Installed Files column.

4. Click the plus ( + ) icon and select the library files to upload. In the appliance, the valid files are .jar
and .dll are the valid library file types. The files that you select are displayed in the Files to Add
column.

5. Click Update.

The files that display in the Files to Add column are not committed until you click Update. If you click
Reset before you click Update, WMC does not add the files you uploaded. If WMC times out before you
click Update and commit the added files, repeat the last two steps.

6. In the same environment tab, select: System > Secure Connectors.
7. Click Download Libraries and save the SecureConnector-Default Environment-libraries.zip

file to your workstation.
8. Uncompress the SecureConnector-Default Environment-libraries.zip file and find a *.tp-
1.0.0.jar for each connector module.

9. Use the .jar files in the SecureConnector-Default Environment-libraries.zip to replace the
files in the Secure Connector installation directory: lib/plugins.

10. Copy all the remaining .zip files to the following Secure Connector installation directory: lib/thirdparty
11. Restart the Secure Connector by running one of the following files from a command line:

For Windows: runclient_osgi.bat
For Linux: runclient_osgi.sh
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Downloading and installing the SAP libraries
To connect to an SAP system from studio, you must install SAP DLLs and JAR files onto your Windows
development machine. You must have the SAP login credentials to enter the SAP Support Portal and download
the files.

About this task

To download and install the SAP JAR files and DLLs:

1. Contact SAP Technical Support to obtain the compressed files for the following SAP Components:
SAP JCo Release 3.0.x - based on the platform on which studio is running.

Note: Latest version of JCo jar available: 3.0.14, IDoc version 3.0.12.
2. Uncompress the SAP JCo compressed file:

Double-click the sapjidoc30P_x-1000xxxx.zip file.
Use the decompression tool to extract the contents of the compressed file to a temporary
directory. This compressed file contains another compressed file sapjco3- NTintel-
3.0.x.zip. Extract this compressed file also to a temporary directory, for example:
C:\temp\sapjco3-NTintel-3.0.x. This directory contains the required libraries
sapjco3.jar and sapjco3.dll.

3. Unzip the SAP IDoc JCo compressed file:
Double-click the sapjidoc30P_x-1000xxxx.zip file.
Use the decompression tool to extract the contents of the compressed file to a temporary
directory, for example, C:\temp\sapjidoc30P_x-1000xxxx. This directory contains the
required library sapidoc3.jar.

Procedure

1. Open studio, select Tools > Install Module Providers.
2. When the Add Providers dialog box is displayed, click the plus (+) button present beneath SAP

Connector.

A text field and a Browse button are displayed.

3. Click Browse, and use the browse dialog box to locate and select the sapjco3.jar file.
4. Click Open to import the JAR file contents.
5. Click the next available plus (+) button to add the sapidoc3.jar and sapjco3.dll files.
6. When the JAR file is listed in the Add Providers dialog box, click OK.

Results

A prompt is displayed to restart studio and activate the changes.

What to do next

You can now create SAP endpoints and orchestrations.

Parent topic: Using Secure Connectors
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Uninstalling Secure Connectors (Windows)
This topic provides information about uninstalling a Secure Connector from a Windows machine.

About this task

The following procedure allows you to uninstall a Secure Connector and all its configuration settings:

Procedure

1. Verify that another program, such as your browser or command shell, does not have any of the Secure
Connector directories open.

2. From the Windows Start button, select All Programs > IBM > Cast Iron Secure Connector
<connector_name> > Stop Secure Connector.

3. From the Windows Start button, select All Programs > IBM > Cast Iron Secure Connector
<connector_name> > Uninstall Secure Connector. The Uninstaller window is displayed.

4. Select Force the deletion of C:\Program Files\IBM\Secure_Connector _<connector_name>.
5. Click Uninstall.
6. When the status bar displays [Finished], you can close the Uninstaller window.
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Uninstalling Secure Connectors (Linux)
This topic provides information about uninstalling a Secure Connector from a Linux machine.

Before you begin

You must have root level permissions to uninstall the Secure Connector from a Linux machine.

About this task
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You can uninstall the Secure Connector by using a graphical interface, issuing a command line command, or
running the Java™ uninstall .jar file. Choose one of the following options to uninstall a Secure Connector and
all its configuration settings from a Linux machine.

Uninstalling the Secure Connector using a graphical interface: You must have a desktop environment, such
as GNOME or KDE, to successfully uninstall the Secure Connector using this procedure.

1. Verify that another program, such as your browser or command shell, does not have any of the Secure
Connector directories open.

2. From the application directory, select IBM > Cast Iron Secure Connector <connector_name> > Stop
Secure Connector.

3. From the application directory, select IBM > Cast Iron Secure Connector <connector_name> > Uninstall
Secure Connector.

Uninstalling the Secure Connector from the command prompt:

1. Verify that another program, such as your browser or command shell, does not have any of the Secure
Connector directories open.

2. From the command prompt, issue the ./Uninstaller/uninstall.sh command.

Uninstalling the Secure Connector with .jar file. You must have Java version 1.6 or higher installed to
successfully uninstall the Secure Connector using this procedure.

1. Verify that another program, such as your browser or command shell, does not have any of the Secure
Connector directories open.

2. From the command prompt, enter the runclient_osgi.sh stop command.
3. In the directory where you installed the Secure Connector, navigate to the Uninstaller subdirectory to

find the uninstaller.jar file: "${JAVA}" -jar
"${INSTALL_DIR}/Uninstaller/uninstaller.jar" where {JAVA} is the Java executable and
{INSTALL_DIR} is the Secure Connector name.

A dialog box is displayed.

4. Select the Force the Deletion… option.
5. Click Uninstall.
6. Click Quit.

Results

The Secure Connector is uninstalled. Configuration settings are retained in the home directory.
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Starting and Stopping Secure Connectors
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Starting and Stopping Secure Connectors topics provide information about starting and stopping Secure
Connectors on Windows and Linux machines. For Windows machines, options you chose during installation
affect how you can start and stop Secure Connectors. If you installed the Secure Connector as an automatic
Windows Service, as recommended, then you can use the Windows Services control panel to stop and start the
Secure Connector. If you installed the Secure Connector as a Windows application, then you can start and stop
the Secure Connector using Windows Start menu shortcuts or desktop shortcuts. For Linux machines, you can
start and stop Secure Connectors by using a graphical interface or by running commands from the command
line.

Starting and Stopping Secure Connectors on Windows (Installed as a Windows Service)
This topic provides information about starting and stopping Secure Connectors on Windows machines,
where you have a Secure Connector that is installed as a Windows Service.
Enabling Interactive Mode for Windows Services
When the Secure Connector is installed as a Windows Service, enable the interactive mode for the
service to view system tray icons and command window.
Starting and Stopping Secure Connectors on Windows (Installed as a Windows Application)
This topic provides information about starting and stopping Secure Connectors on Windows machines,
where you have a Secure Connector that is installed as a Windows application.
Starting and Stopping Secure Connectors on Linux
This topic provides information about starting and stopping Secure Connectors on Linux machines.

Parent topic: Using Secure Connectors
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Starting and Stopping Secure Connectors on Windows
(Installed as a Windows Service)

This topic provides information about starting and stopping Secure Connectors on Windows machines, where
you have a Secure Connector that is installed as a Windows Service.

About this task

If you installed the Secure Connector as an automatic Windows Service, as recommended, use the Windows
Services control panel to stop or restart the Secure Connector.

By default, when a Secure Connector is installed as a Windows Service, the Secure Connector is not configured
to interact with the Windows Desktop. However, if the Secure Connector service was installed under a local
system account, you can enable an interactive mode that presents system tray icons and a command window
when the Secure Connector service is running.

For steps to enable the interactive mode for a Windows service, see Enabling Interactive Mode for Windows
Services.
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Note: If you use the Start Secure Connector Start menu shortcut or desktop shortcut to start a Secure
Connector, the Secure Connector starts as a normal application rather than as a service. You must use the
Windows Services control panel to start Secure Connectors as a service. You can use either the Stop Secure
Connector Start menu shortcut or desktop shortcut to stop a Secure Connector.

Starting and stopping Secure Connectors, using the Windows Services control panel:

Procedure

1. Open the Windows Services window: Start > Control Panel > Administrative Tools > Services.
2. Scroll down the list of services to locate the IBM® Secure Connector service.
3. Right-click on the IBM Secure Connector service and select the appropriate command: Start, Stop,

Pause, Resume, or Restart.

Parent topic: Starting and Stopping Secure Connectors
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Enabling Interactive Mode for Windows Services
When the Secure Connector is installed as a Windows Service, enable the interactive mode for the service to
view system tray icons and command window.

About this task

By default, when a Secure Connector is installed as a Windows Service, the Secure Connector is not configured
to interact with the Windows Desktop. However, if the Secure Connector service was installed under a local
system account, you can enable an interactive mode that presents system tray icons and a command window
when the Secure Connector service is running.

Procedure

1. Open the Services control panel. For example: Start > Control Panel > Administrative Tools > Services.
2. Select the Cast Iron Secure Connector service.
3. Right-click the service name, and select Properties. The Service Properties window is displayed.
4. Select the Log On tab.
5. Select Local System account and then select Allow service to interact with desktop.
6. Click OK.
7. Click Restart.

Results

When the Cast Iron® Secure Connector service is restarted, system tray icons and a command window are
displayed.
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Note: You can minimize the command window. However, if you close the command window, the Cast Iron
Secure Connector service is stopped and terminated. Closing the command window is the equivalent of
stopping the Secure Connector service from the Windows Services control panel.
Parent topic: Starting and Stopping Secure Connectors
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Starting and Stopping Secure Connectors on Windows
(Installed as a Windows Application)

This topic provides information about starting and stopping Secure Connectors on Windows machines, where
you have a Secure Connector that is installed as a Windows application.

About this task

When the Secure Connector is installed on a Windows machine as a Windows application, rather than a
Windows Service, you can start and stop the Secure Connector using Windows Start menu shortcuts or desktop
shortcuts.

Procedure

1. Start the Secure Connector from either the Windows Start menu shortcut or desktop shortcut.
From the Windows Start button, select All Programs > IBM > Cast Iron Secure Connector
<connector_name> > Start Secure Connector.
From the Windows desktop, click the Start Secure Connector shortcut to start the Secure
Connector.

2. Stop the Secure Connector from either the Windows Start menu shortcut or desktop shortcut.
From the Windows Start button, select All Programs > IBM > Cast Iron Secure Connector
<connector_name> > Stop Secure Connector.
From the Windows desktop, click the Stop Secure Connector shortcut to stop the Secure
Connector.

Parent topic: Starting and Stopping Secure Connectors
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Starting and Stopping Secure Connectors on Linux
This topic provides information about starting and stopping Secure Connectors on Linux machines.

About this task

If you have a desktop environment, such as GNOME or KDE, you can start and stop the Secure Connector using
menu shortcuts or desktop shortcuts. You can also start and stop the Secure Connector using the command
line.

Procedure

1. Start the Secure Connector from either the menu shortcut, desktop shortcut, or command line. Choose
one of the following options:

Select <application> > IBM® > Cast Iron® Secure Connector <connector_name> > Start Secure
Connector.
From the desktop, click the Start Secure Connector shortcut to start the Secure Connector.
From the command prompt, enter runclient_osgi.sh start .

2. Stop the Secure Connector from either the menu shortcut, desktop shortcut, or command line. Choose
one of the following options:

Select <application> > IBM > Cast Iron Secure Connector <connector_name> > Stop Secure
Connector.
From the desktop, click the Stop Secure Connector shortcut to stop the Secure Connector.
From the command prompt, enter runclient_osgi.sh stop.

Parent topic: Starting and Stopping Secure Connectors
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Upgrading Secure Connectors
This topic provides information about upgrading Secure Connectors.

Procedure

1. Create a new Secure Connector.
2. Download the latest version of the Secure Connector installer, based on your operating system. For

example, Windows or Linux.
3. On a Windows or Linux machine, launch the Secure Connector installer. The Cast Iron® Secure Connector

wizard guides you through the upgrade process.
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Note: If you already have a Secure Connector installation that is higher than or same as the latest
version, a warning message states that you have an existing installation and alternatively you can
upgrade the existing installation.
Note: You must stop the Secure Connector (if already started) before upgrading.
Note: Before you proceed with the Secure Connector upgrade process, ensure that you have:

Stopped the Secure Connector
Taken a manual backup of the certificates (if any) located at
<secure_connector_install_path>/etc/security or jre/lib. You may want to
replace/add your certificates after upgrade.

4. Click the Upgrade option. The Select the installed path list box is displayed.
5. Select the Secure Connector installed path, if it is displayed in the list box. Else, click Browse button to

select the installed path.
6. Click Next, then read and accept the licensing agreement.
7. Click Next. The installation progress is displayed. A message is displayed stating that the installation has

been completed successfully. The path to the installer program is also displayed.
8. Click Done.
9. Start the Secure Connector.
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Troubleshooting Secure Connectors
This topic provides potential solutions for issues you have with the Secure Connector.

Secure Connector log files are available for review. The Log directory is created after the initial start of the
Secure Connector. The Log directory is in the Secure Connector installation directory. For example: C:\Program
Files\IBM\Secure_Connector_1.development\logs

A port contention error occurs. A port contention error can occur when two Secure Connectors are
configured to use the same port and gateway. To resolve the issue, provide unique values for the
Gateway, Listen on Port, and Transmit on Port parameters in each Secure Connector configuration file.
Unable to run .jar file to uninstall a Secure Connector. Verify that the Java™ path is specified
correctly and that you have Java version 1.6x or higher installed on the machine.
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Security
Security topics provide information about generating and managing certificates, configuring LDAP settings, and
configuring Kerberos settings

About Certificates
Certificates enable secure communication between the Integration Appliance and endpoints located in
your intranet and extranet. Use the Management Console to manage certificates.
Configuring Kerberos
Configuring LDAP Mechanism Properties
Editing Security Settings
Enabling an LDAP Directory Server
Exporting Certificates
Generating Certificate Signing Requests
Generating Self-Signed Certificates
Importing Certificates
Renaming Certificate Alias
Uploading Certificates
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About Certificates
Certificates enable secure communication between the Integration Appliance and endpoints located in your
intranet and extranet. Use the Management Console to manage certificates.

From the Certificates page, you can generate, import, and update security certificates and security settings.

The following tables provides definitions for certificate terminology.

Certificate Terminology Definition

Alias A string of alphanumeric characters you assign to a KeyStore or
TrustStore entry to provide a more user friendly name. Within a KeyStore
or TrustStore you can use an alias to refer to the keys and certificates.
Note: Aliases are not case sensitive. For example, MyCert and mycert
refer to the same entry.

Certificate A signed credential which identifies an endpoint or organization.
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Certificate Terminology Definition

Key Pair A public key and associated private key.

KeyStore A Java™ data store that houses private keys and certificates used by a
Java SSL endpoint. For example, a local Java endpoint supplies a
certificate from its KeyStore as a credential to identify itself to a remote
SSL endpoint.

PKI Public Key Infrastructure is a system for managing encryption keys and
identity information. The purpose of the system is to provide standards
based system for protecting/securing communications over the internet.

Private Key A key known only to a single endpoint used to encrypt and/or sign data.

Public Key A key associated with a private key that can be distributed to anyone.

SSL Secure Sockets Layer enables secure web communications and permits
endpoints to optionally authenticate each other.

TrustStore A Java data store that houses certificate authority signed certificates.
For example, a local Java endpoint utilizes a TrustStore to authenticate
the identity (certificate) provided to it by a remote SSL endpoint.

Parent topic: Security
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Configuring Kerberos

About this task

When the Integration Appliance is exchanging data over a non-secure network, the Kerberos protocol allows
the Integration Appliance to authenticate the server with which the Integration Appliance is communicating.

Procedure

1. In the navigation pane, select Security > Kerberos. The Kerberos Configuration page is displayed.
2. Specify the Kerberos Server name.
3. Specify the Kerberos Realm.
4. Click Save.

Clicking Delete clears the settings that you have specified.

Parent topic: Security
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Configuring LDAP Mechanism Properties

About this task

If you selected the Use Secure Connection (SASL) security option while enabling an LDAP Server, you must also
specify a mechanism policy and configure the mechanism properties.

LDAP mechanism properties and LDAP mechanism policies are further described in the following tables.

Procedure

1. In the navigation pane, select Security > LDAP. The LDAP Configuration page is displayed.
2. In the Security Options section, select Use Secure Connection (SASL).
3. In the Authentication section, click Advanced Settings. Options for Mechanism Policies and Mechanism

Properties display.
4. Select the appropriate options and choose the appropriate value from the drop-down list.

Parent topic: Security

LDAP Mechanism Properties

Mechanism Properties Description

QOP (Quality of Protection) Names a property that specifies the quality-of-protection that the LDAP
directory server uses. The property contains a comma-separated,
ordered list of quality-of-protection values that the client or server
supports. The following are valid QOP values:

auth
authentication only

auth-int
authentication plus integrity protection

auth-conf
authentication plus integrity and confidentiality protection

The order of the list specifies the preference order of the client or server.
If you do not specify a value, the default QOP is auth.
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Mechanism Properties Description

Cipher Strength Names the property that specifies the cipher strength that the LDAP
directory server uses. The property contains a comma-separated,
ordered list of cipher strength values that the client or server supports.
The following are valid cipher strength values:

low

medium

high

The order of the list specifies the client or server order of preference. An
implementation should allow you to configure the meaning of these
values. An application might use the Java™ Cryptography Extension
(JCE) with JCE-aware mechanisms to control the selection of cipher
suites that match the strength values.

If you do not specify a value, the default cipher strength is low.

Max Buffer Size Specifies the maximum size of the receive buffer in bytes. If you do not
specify a value, the default size is defined by the mechanism. Valid value
range is between 0 and 65536.

Mutual Authentication Names the property that specifies whether the server must authenticate
to the client. The property name contains true, if the server must
authenticate the to client and contains false otherwise. By default, this
value contains false.

LDAP Mechanism Policies

Mechanism Policies Description

Forward Secrecy Names the property that specifies whether mechanisms that implement
forward secrecy between sessions are required. Forward secrecy means
that breaking into one session does not automatically provide
information for breaking into future sessions. The property contains true
if mechanisms that implement forward secrecy between sessions are
required and contains false if such mechanisms are not required. By
default, this value contains false.

Client Credentials Names the property that specifies whether mechanisms that pass client
credentials are required. The property contains true if mechanisms that
pass client credentials are required and contains false if such
mechanisms are not required. By default, this value contains false.

Susceptible to passive attacks Names the property that specifies whether mechanisms susceptible to
simple plain passive attacks, for example: PLAIN, are not permitted. The
property contains true if such mechanisms are not permitted and
contains false if such mechanisms are permitted. By default, this value
contains false.

1116   



Mechanism Policies Description

Susceptible to active attacks Names the property that specifies whether mechanisms susceptible to
active (non-dictionary) attacks are not permitted. The property contains
true if mechanisms susceptible to active attacks are not permitted and
contains false if such mechanisms are permitted. By default, this value
contains false.

Susceptible to dictionary attacks Names the property that specifies whether mechanisms susceptible to
passive dictionary attacks are not permitted. The property contains true
if mechanisms susceptible to dictionary attacks are not permitted and
contains false if such mechanisms are permitted. By default, this value
contains false.

Susceptible to anonymous attacks Names the property that specifies whether mechanisms that accept
anonymous login are not permitted. The property contains true if
mechanisms that accept anonymous login are not permitted and
contains false if such mechanisms are permitted. By default, this value
contains false.

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.appliance.doc/ApplianceHelp/Security/confi
guringLDAP.html

Editing Security Settings

Procedure

1. In the Settings section, click Edit. The Edit Settings dialog box is displayed.
2. Select the certificate to use with the corresponding category. For example, Client SSL, Server SSL over

data NIC, or Server SSL over mgmt NIC.
3. Select the VPeer check box if appropriate.

Selecting VPeer means that the integration appliance authenticates the identity of the SSL peer
using the certificate provided by the peer.
When selected for the Client SSL category, the integration appliance authenticates the identity of
the SSL server using the certificate sent by the server.
When selected for the Server SSL over data NIC category, the integration appliance requires that
SSL clients connecting to the integration appliance must send a certificate.

4. Select the VHost check box if appropriate.
Selecting VHost means that the integration appliance verifies that the hostname of the server in
an SSL session matches the name contained in the server certificate. This check is designed to
prevent a man-in-the-middle (MITM) attack and is described in RFC 2818 HTTP Over TLS Section
3.1 Server Identity.
The VHost selection is only applicable for the Client SSL category.
The VHost selection is only applicable when VPeer is also selected.

5. Select the cipher strength.
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Standard

Strong

6. Click Save.
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Enabling an LDAP Directory Server

About this task

From the WMC, you can choose to have an LDAP server handle user authentication and authorization. When
you enable an LDAP directory server, the authentications and authorizations of the LDAP directory server
override any users, groups, or permissions you specified via the WMC, except for the built-in Admin user.
Therefore, with the exception of the Admin user, you can authenticate and authorize users and groups via an
LDAP directory server or the WMC, but not both. Regardless if you enable LDAP or not, you can updated the
Admin user password via the CLI.

Note: LDAP users will not be able to access the staging database.

Procedure

1. In the navigation pane, select Security > LDAP. The LDAP Configuration page is displayed.
2. Select the Enable LDAP option. If you do not select this option, the Integration Appliance uses the built-

in groups and users you defined in the WMC to authenticate and authorize users and their access to the
WMC.

3. Specify host information.
a. Enter the host name and port number of the LDAP directory server.
b. Choose a Base DN (Base Distinguished Name) or click Fetch DNs. The WMC fetches the Base DN

of all the Directory Information Trees (DITs) from the LDAP directory server. Select the Base DN of
the DIT that contains the users you want to authorize.

4. Choose one of the following security options:
Use Secure Connection (SASL) - Enables Simple Authentication and Security (SASL)
mechanisms supported by the LDAP directory server. This is the most secure option.
Use Simple Authentication - Enables simple authentications, but does not encrypt credentials.
Anonymous Bind - Enables anonymous binding to the LDAP directory server. This is the least
secure option.

5. If you selected the Use Secure Connection (SASL) security option, specify a mechanism and configure
the mechanism properties and mechanism policies.

6. If the LDAP directory server requires authentication for a directory search, specify values for the
Principal and Password, which are in the Credentials section. When you select the Composed DN Mode
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authentication mode, this step is not required. However, this step might be required to fetch DNs or
mechanisms when the LDAP directory server does not allow anonymous searches.

If you do not specify a password, the WMC attempts to make the initial binding into the LDAP server as
an anonymous user and the LDAP server ignores the Principal credential you specified.

7. Choose one of the following authentication modes:
Composed DN Mode
Searched DN Mode

8. Specify the User Container RDN. The authentication mode you specify determines what value you
should specify here.

If you selected the Composed DN mode, the User Container RDN is composed of one or more
attributes from the user DN. Construct the User Container RDN by walking up the tree from the
immediate ancestor of the user to the entry just before the base and adding up the RDN of each
entry in the path.

For example, if:

User DN = "uid=JohnK,ou=emp,dc=xyz,dc =com"

then

User Container RDN = "ou=emp"

If you selected the Searched DN mode, the User Container RDN is typically left blank, which
causes the LDAP directory server to search the entire DIT starting from the root (Base).
Otherwise, the LDAP directory server searches the subtree rooted at the entry having DN = User
Container RDN +BaseDN.

9. If you selected the Searched DN Mode, specify the User Search Filter that the LDAP directory server
uses to search for the user DN. (required, only if you select the Search DN Mode) This entry accepts
LDAP search filter specification and also accepts a user name in the form of $USERNAME. For example:

In MSAD, this entry could be "(samAccountName=$USERNAME)"
In SunOne, this could be "(uid=$USERNAME)"

10. Specify the User Principal DN, which specifies the DN of the user that the LDAP directory server binds
after the search. You can specify $USERNAME or $DN to represent the user name and Distinguished
Name. Where $DN represents (RDN+BaseDN) for the Compose DN Mode and searched DN for Search
DN Mode. In most the cases, $DN is the entry. However, when using SASL in MSAD, you might only need
to specify $USERNAME. For SASL in SunOne, you might only need to specify "dn:$DN".

11. Specify Group Mapping Information.
a. Specify the Admin Group Filter.
b. Specify the Publisher Group Filter.
c. Specify the Group Filter.

12. Click Save.
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Exporting Certificates

Procedure

1. In the Key Store section, click an alias. The Certificate Details window displays.
2. Click Export. The Export Certificate dialog box displays.
3. Select a exporting format.
4. Provide a password.
5. Click Export.

Parent topic: Security
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Generating Certificate Signing Requests

Procedure

1. In the Key Store section, click on an alias. The Certificate Details window displays.
2. Click Generate CSR. The Certificate Content window displays.
3. Click Copy. The entire contents of the window is copied.
4. Click Download and specify a location for the download.
5. Click Save. The certificate contents are downloaded to the specified location.
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Generating Self-Signed Certificates

Procedure

1. In the Key Store section, click Generate. The Generate Self-Signing Certificate dialog box is displayed.
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2. Specify values for the following parameters:

Alias
Common Name (CN)
Organization (O)
Organization Unit (OU)
Country (C)
State (ST)
Locale (L)
Email (EMAILADDRESS)
OID
Key Algorithm
Key Length
Valid For

3. Click Generate.

Results

The self-signed certificate displays in the Key Store table.
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Importing Certificates

About this task

You can import a certificate or certificate chain into the IBM® WebSphere® Cast Iron® KeyStore. You can also
import trusted Certificate Authority certificates (CA Certs) to the TrustStore.

Procedure

1. In the Key Store or Trust Store section, click Import. The Import Certificates dialog box is displayed.
2. Enter an alias name. This name is used to identify the imported certificate or certificate chain.
3. Optional: Enter a key password.

The password protects the private key of the key pair associated with the alias. If you do not specify a
password, the password defaults to the password protecting the KeyStore.

4. If you are importing a certificate from a trusted site, select the Trusted option.

If you select the Trusted option, the certificate is imported without checking for an existing chain of
trust. If you do not select the Trusted option, the KeyStore and TrustStore options are checked to ensure
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a chain of trust exists for the certificate being imported.

5. Choose to import the content from a file or from content in the clipboard that contains the certificate or
certificate chain to be imported.

When importing into the KeyStore, supported formats include: PKCS12. When importing into the
TrustStore, supported formats include CER/PEM (RFC 1421), DER and PKCS7.

6. Click Import.

Results

The certificate displays in the Certificates page.
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Renaming Certificate Alias

Procedure

1. In the Certificate page, click an Alias. The Certificate Details dialog box displays.
2. Click Rename.
3. In the Alias field, type in a new alias.
4. Click Apply.

Results

The updated alias displays on the Certificates page.
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Uploading Certificates

Procedure

1. In the Key Store section, click an alias. The Certificate Details window displays.
2. Click Upload. The Update Certificate dialog box displays.
3. If you are uploading a certificate to a trusted site, select the Trusted option.
4. Choose to upload the content from a file or from content in the clipboard.
5. Click Import.
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Working with Logs
Working with Logs topics provide information about managing orchestration job logs, specifying system
settings, and viewing system logs.

About Archived Logs
The Management Console lists log files that the Integration Appliance has archived. You can download
these archived log files.
About Archived Logs
Logs can be archived locally or exported to an FTP server. From the WMC, you can download locally
archived logs: Logs > Archive Logs.
Purging Orchestration Monitoring Logs
You can purge and archive orchestration monitoring logs.
Specify System Log Settings
You can specify the level of details that appears in the system logs. The log level you specify affects
alerts for notification policies. Alerts are only sent for events that meet or exceed the log level you
specify.
Viewing System Logs
You can view system logs from the Management Console and use the system log filters to sort through
system log entries.
Customizing columns in System log and Job log
You can customize the columns displayed in the System log and Job log pages, respectively.
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About Archived Logs
The Management Console lists log files that the Integration Appliance has archived. You can download these
archived log files.

Parent topic: Working with Logs

Downloading an Archived Log File

Procedure

1. In the navigation pane, select Logs > Archived Logs. Log files for the Integration Appliance display, along
with a timestamp of when the log was last modified and details about the log file size.

2. Click Refresh to get the most up-to-date log files.
3. Click a log file to download. A message is displayed.
4. Click Download Now.
5. Choose the Save File option and click OK.
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About Archived Logs
Logs can be archived locally or exported to an FTP server. From the WMC, you can download locally archived
logs: Logs > Archive Logs.

You can archive or purge orchestration monitoring logs. When you configure parameters to archive
orchestration monitoring log files, the Integration Appliance archives the log files before polling for conditions
that trigger the Integration Appliance to purge additional orchestration monitoring data. You can archive
orchestration monitoring data to a local disk on the Integration Appliance or export the archives to an FTP
server. If you do not configure archive settings, the Integration Appliance purges all orchestration monitoring
data that meets the default purging trigger conditions.

You can view archived log files by selecting Logs > Archive Logs in the Navigation page. When you export the
logs, the Integration Appliance names exported orchestration monitoring logs using the following convention:
orcmon_export_<timestamp>.xml.

Parent topic: Working with Logs
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Archiving Orchestration Monitoring Logs Locally

About this task

When you select the Archive Purged Monitor Data to a Local File option and one of the log purging trigger
conditions is met, the Integration Appliance exports orchestration monitoring logs to a local disk on the
Integration Appliance.
Note: When you archive orchestration monitoring logs locally, you decrease the availability of disk space on the
Integration Appliance. As the disk space is filled up, the purging trigger conditions generate archives much
quicker.

Procedure

1. From the Navigation pane, select Logs > Job Log. The Results page displays all orchestration monitoring
logs.

2. Click Settings. The Job Log Settings dialog is displayed.
3. Click Archive.
4. In the Archive Settings section, select Archive Purged Monitor Data to be a Local File .
5. Select Replace Exported File to replace previously exported orchestration monitoring logs. If you do not

select this option, the Integration Appliance cumulatively stores orchestration monitoring logs. This can
cause the Integration Appliance to run out of disk space very quickly and prematurely trigger a purge.

6. Click Save.

Results

The Integration Appliance archives Orchestration Monitoring logs locally. You can download locally stored
archives by selecting the archive from the Archive list and clicking Download.

Archiving Orchestration Monitoring Logs to an FTP Server

About this task

When you select the Archive Purged Monitor Data to a Local File option and the Transmit Archive to FTP Server
option and one of the log purging trigger conditions is met, the Integration Appliance exports orchestration
monitoring logs to an FTP server. You can chose to archive all the exported log files on the FTP server or chose
to have the latest archive replace the previous archive.

Procedure

1. From the Navigation pane, select Logs > Job Log. The Results page displays all orchestration monitoring
logs.

2. Click Settings. The Job Log Settings dialog is displayed.
3. Click Archive.
4. In the Archive Settings section, select Archive Purged Monitor Data to be a Local File .
5. Select Transmit Archive to FTP Server (After a Purge).
6. (Optional) Select Replace Exported File to replace previously exported logs.
7. Specify FTP settings. See the following table below:Table 1 for more information about the FTP settings.
8. Click Save.

Archiving Utilization Data to an FTP Server
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About this task

The Integration Appliance collects data about disk usage, memory usage, garbage collection, and the number
of running jobs. This resource utilization data can help you analyze the overall health of the runtime and
calculate available capacity for additional projects. The Integration Appliance stores this data in a file called
maestro.stat and provides an option to archive a snapshot of the data to an FTP server. When you select the
appropriate option, all the utilization data available on the Integration Appliance is collected and archived to
the specified FTP server.

After an archive file has been created and transmitted to an FTP server, the Integration Appliance continues to
aggregate new utilization data to the historic utilization data. Historic utilization data is not purged from the
Integration Appliance when an archive is transmitted to an FTP server.

Selecting the Transmit Archive to FTP Server option transmits a snapshot of the utilization data daily at
midnight. The following procedure describes how to select the option.

Procedure

1. From the Navigation pane, select Logs > Job Log. The Results page displays all orchestration monitoring
logs.

2. Click Settings. The Job Log Settings dialog is displayed.
3. Click Archive.
4. Select Transmit archive utilization data to FTP Server (at midnight) .
5. Specify FTP settings. See the following table below: Table 1 for more information about the FTP settings.
6. Click Save.

FTP Settings
Specifying FTP settings to archive orchestration monitoring logs and utilization data.

Table 1. Job Log FTP Settings
Parameter Description

Host Specifies the name of the FTP server, where the exported log files are archived.

Port Specifies the port number of the FTP server, where the exported log files are
archived.

Username Specifies the user ID that the Integration Appliance uses to log in to the FTP
server, where the exported log files are archived.

User Password Specifies the password that the Integration Appliance uses to log in to the FTP
server, where the exported log files are archived.

Hide Password Text If you clear this option, the password you entered displays in plain text and is
no longer encrypted.

Directory Specifies the FTP directory to which the Integration Appliance exports the log
file.
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Purging Orchestration Monitoring Logs
You can purge and archive orchestration monitoring logs.

About this task

When the Integration Appliance purges orchestration monitoring data, it can take a few minutes for the
Dashboard to display the updated job counts.

By default, an Integration Appliance purges orchestration monitoring logs older than 30 days when any of the
following conditions occurs on the Integration Appliance:

The amount of available disk space falls below 50%.
One day has passed since the last purge.
More than 5,000 orchestration jobs have completed.
More than 1,000 orchestration jobs have contained an error.

Using the WMC, you can configure the job log purging parameters on the Integration Appliance that determine:

Trigger Conditions - What conditions trigger the Integration Appliance to purge orchestration
monitoring data.
Frequency - How often to purge orchestration monitoring data.
Job Scope - What type of orchestration monitoring data to purge.

Procedure

1. From the Navigation pane, select Logs > Job Log. The Results page is displayed.
2. Click Settings. The Job Log Settings dialog box is displayed. By default the Purge page is displayed.
3. Specify the parameters as described in the following section.
4. Click Save.

Parent topic: Working with Logs

Job Log Purging Parameters

Trigger Conditions

The amount of free disk space on the Integration Appliance, the time lapse since the last orchestration
monitoring logs were purged, the number of completed jobs, and the number of jobs containing errors are all
triggers that can initiate the purging or archiving of orchestration monitoring logs. The Integration Appliance
uses "OR" logic and purges orchestration monitoring data when any one of the trigger conditions occurs.

Parameter Description Default
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Parameter Description Default

Available disk space This trigger fires when the percentage of free disk space is less
than the specified value. When this trigger fires, the Integration
Appliance purges the orchestration monitoring data as you
specify in the Job Scope parameters.

If the percentage of free disk space is still short of the
percentage you specified, the Integration Appliance purges
50% of the remaining orchestration monitoring data until the
value is reached.

For example, you specify the following values for purging
parameters:

Available disk space = 40%
Job status = completed
Jobs older than = 30 days

If only 10% of the Integration Appliance disk is free, the
Available disk space trigger fires and the Integration Appliance
purges all completed jobs that are older than 30 days. However,
purging this data only frees 10% of the disk space. Since the
minimum amount of free disk space is still not satisfied, the
Integration Appliance purges an additional 50% of the
remaining orchestration monitoring data. The Integration
Appliance continues to purge the remaining orchestration
monitoring data by 50%, until the minimum available disk
space is greater than or equal to the specified value.

You can specify a value between 1-100 percent, any value
outside a 40-75 percent range results in the Integration
Appliance using the default value of 50%.

Note: This is a required parameter.

50%

Schedule This trigger fires when the period since the last purge is greater
than the specified day, hours, minutes value.

You can more precisely schedule a purge by selecting the Fixed
option. When you select the Schedule Fixed option, the
schedule you specify overrides the day, hours, minutes value
specified since last purge.

To schedule a purge:

1. Select the Fixed option.

2. Specify the number of days, weeks, or months.

3. In the list, qualify the value by choosing Days, Weeks, or
Months.

4. Specify the start date.

1 day
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Parameter Description Default

Completed job count This trigger fires when the number of completed jobs is greater
than the specified value. This parameter must be a positive
integer value.

Note: After the Integration Appliance purges the jobs, the job
count is no longer visible from the WMC.

5,000 jobs

Errored job count This trigger fires when the number of jobs containing errors is
greater than the specified value. Errored job count includes any
orchestration job in the following states: unknown, cancelled,
terminated, or errored. This parameter must be a positive
integer value.

Note: After the Integration Appliance purges the jobs, the job
count is no longer visible from the WMC.

1,000 jobs

Frequency

The frequency determines the interval at which the Integration Appliance checks the set of defined triggers for
an actionable condition. You can specify the frequency interval in increments of hours, minutes, and seconds.

By default, this parameter is set to 10 seconds.

Job Scope

Along with specifying trigger conditions and frequency, you must also specify the type of orchestration job data
you want to purge. The Integration Appliance uses the values you specify for the Job Status AND the Jobs
Older Than parameters OR the values you specify for Job Status AND Jobs Older Than the Most Recent
parameters to determine when the Integration Appliance purges data.

Parameter Description Default

Job status This parameter specifies the type
of orchestration jobs that the
Integration Appliance purges. By
default, this parameter is set to
ANY, which purges completed and
jobs containing errors. You can
choose to purge only the
completed jobs by specifying
COMPLETED.

Any

Jobs older than This parameter specifies the
minimum age of orchestration jobs
to purge. The Integration Appliance
purges anything older than the
amount of time you specify. You
can specify the age of an
orchestration job in months, days,
hours, and minutes.

7 days
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Parameter Description Default

Jobs older than the most recent This parameter specifies the
number of most recent jobs that
the orchestration job must be older
than before the Integration
Appliance purges data.

1,000 jobs

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.appliance.doc/ApplianceHelp/Working_with
_Logs/purgingJobLogs.html

Specify System Log Settings
You can specify the level of details that appears in the system logs. The log level you specify affects alerts for
notification policies. Alerts are only sent for events that meet or exceed the log level you specify.

About this task

The system log levels are shown in the following table. The Description column provides a description of each
level and explains how it corresponds to the Cast Iron Management API log level.

Severit
y Description

INFO Informational messages. (Corresponds the Cast Iron Management API "INFO" log level).

WARNI
NG

Warning messages. (Corresponds to the Cast Iron Management API "WARNING" log level).

ERROR Serious errors that may need user attention. (Corresponds to the Cast Iron Management API
"SEVERE" log level).

CRITIC
AL

Critical errors requiring user or administrator attention. (Corresponds to the Cast Iron Management
API "FATAL" log level).

FINEST Retrieves all logs at level above FINEST. (Corresponds to the Cast Iron Management API "ALL" log
level).

Note: In certain cases, log levels set in the WMC override settings in the Cast Iron Management API. For
example, if the WMC logging level for a component is set to FINEST, logs retrieved by the Cast Iron
Management API are also set at the FINEST level. Additionally, if the WMC system logging level is set to INFO,
logs retrieved by the Cast Iron Management API are also set at INFO.
Note: If you do not receive notifications for events, it might be that you do not have the system log level set
high enough to produce entries that would trigger a notification.

Procedure

1. In the Navigation pane, select Logs > System Log. The System Log page is displayed.
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2. Click Settings. The System Log Settings dialog box is displayed.
3. From the list, select a log level for each system.
4. Click Save.

Results

A confirmation message is displayed. The system log logs all events that occur at the level you specified or
higher for the specific system. For example, if you chose the Error level for Deployment, all events that were
Error or Critical level in the Deployment system are logged.

Parent topic: Working with Logs
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Viewing System Logs
You can view system logs from the Management Console and use the system log filters to sort through system
log entries.

About this task

When you upgrade, the Management Console does not persist system logs. To retain system log information,
export system logs before you upgrade.

Note: The Management Console displays a maximum of 99,999 system log entries. When the number of
system log entries exceeds 99,999, the oldest log entry is deleted from the system log.

Procedure

1. From the navigation pane, select Logs > System Log. The System Log page is displayed.
2. Choose the filter values from the lists at the top of the System Log page. You can filter the log entries

according to the level of severity for the event, the environment system that generated the log event,
dates, and resolution state. The filters use AND logic.

Parent topic: Working with Logs

System Log Content
The system log provides the following information:

System Log Content Description
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System Log Content Description

Level Identifies the level of severity of the log event:

Critical

Error
Warning
Info

System Identifies the system where the log event occurred:

Hardware
Resources
Network
Security
Orchestration
Deployment

Message Text messages that provides details about the log event.

Job When available displays Job ID information for log events that occur in the
Orchestration system.

When Records the time when the log event occurred.

Resolved On Provides a time stamp of when you resolved a log event.

Resolved By Identifies which user resolved a log event.

Resolved Select this checkbox to acknowledge that you have resolved a log event.
When a user resolves a log event, a time stamp documents the date and time
the issue was resolved. Information about the user who resolved the log
event is tracked in the Resolved By column. You can resolve all the system
log issues, by clicking Resolve All. Clear the checkbox next to any log events
that are not resolved and the Resolved On and Resolved By values are
cleared.
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Customizing columns in System log and Job log
You can customize the columns displayed in the System log and Job log pages, respectively.

About this task
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You can customize the columns to be displayed in the System Log and Job Log pages by editing the column
display settings. To customize the log page columns, complete the following steps:

Procedure

1. From the navigation pane, select Logs > System Log or Job Log. The System Log page or the Job Log
page is displayed.

2. Click Edit Columns. The Display Columns window is displayed.
3. Select the columns that need to be displayed on the System Log or Job Log page. By default, all the

columns are selected in the Display Columns window.
4. Click Save. Only those columns selected by you will be displayed in the System Log or Job Log page.

Parent topic: Working with Logs
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Managing Appliances
You can now manage other appliances from the Web Management Console. This feature is helpful when you
have multiple appliances; and you can manage these appliances from a single console.

One appliance is designated as the master appliance, which is used to manage other appliances.

The following features are available as part of managing appliances:

Appliances can be registered and unregistered with the master appliance.
Resource utilization details of each of the appliances can be viewed from the master appliance. For more
information about the Resource Utilization Graph, see About the Resource Utilization Graph.
Projects that are published, and the status of each project/orchestration on each of the appliances can
be viewed from the master appliance.
Upgrade of each of the registered appliances can be performed from the master appliance.
Supports both physical and virtual appliances.
Supports Cast Iron® version 7.0 and earlier versions (6.0.0.x, 6.1.x.x, 6.3.x.x, 6.4.x.x) for managing and
monitoring. The earlier version of Cast Iron must be on the required patch level for using this feature.
Users of the master appliance must have administrator privileges to use this feature.
This feature is also available when the appliance is configured with high availability.

Registering, editing, and unregistering appliances
Upgrading Cast Iron appliance
This feature is used to upgrade the Cast Iron appliance by using the upgrade files vcrypt2 and
scrypt2 files. The upgrade files are obtained as a part of Cast Iron software or from Fix Central
depending on the version (FixPacks/patch/major release) of the appliance.
Running commands
Managing Project Configurations
The managing multiple appliances feature allow you to manage the life cycle of projects (start, stop,
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delete, and clone projects ) present in the registered remote appliances. You can modify the life cycle of
the projects running on different appliances through the single master appliance. The life cycle includes
stop, start, clone, resume, pause, and undeploy. The list of registered appliances are displayed in the
appliance filter through which you can select the appliance and modify the life cycle of the projects in
the selected appliance.
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Registering, editing, and unregistering appliances

About this task

To register a new appliance, complete the following steps:

Procedure

1. Log on to the Web Management Console as an administrator.
2. Select Manage > Appliances.
3. Click Register to register a new appliance. The Register New Appliance window is displayed.
4. In the Register New Appliance window, complete the following details:

a. Display Name - Specify a display name that can be used to identify the remote appliance.
b. Host Name - Specify the host name or IP address of the remote appliance that you want to

register.
c. User Name - Specify the user name, with administrator privileges, to communicate with the

remote appliance.
d. Password - Specify the password for the user name.
e. Optional: Description - Specify a brief description for this appliance.
f. LDAP - Select this option if the remote appliance is configured for LDAP. Also, provide the LDAP

credentials that are used for connecting to the appliance, in the User Name and Password fields.
g. Enabled - Select this option if you want to enable the appliance for managing and monitoring. If

disabled, the data will not be displayed for this appliance.
5. Click Save.

Note:
An appliance, which is already registered to a master cannot be made as a master appliance.
You cannot register an appliance, which is already a master to another master appliance.
You can register an appliance with multiple master appliances.
You can register the master appliance to itself for managing and monitoring.

Note:
A user with the name masteradmin4ma is created in the master appliance that indicates that the
current appliance is a master appliance.
A user with the name slaveadmin4ma is created in the appliances that are registered in the
master appliance.
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Both these users must not be deleted unless you want to unregister the appliance from the
master appliance.

Results

A confirmation message is displayed. A new appliance is registered. When the registration is successful, the
version of the appliance and the type (physical/virtual) is displayed.

Parent topic: Managing Appliances

Editing the registered appliance details

About this task

When you click the display name of any of the registered appliances, you can edit the appliance details in the
Edit Appliance Details dialog. You can edit the following fields:

Display Name
User Name
Password
Description
LDAP
Enabled

Unregistering an appliance

Procedure

1. From the list of registered appliances, select the appliances to be unregistered.
2. Click the Unregister button. The Delete Appliances confirmation message is displayed.
3. Click Yes to unregister the appliance.
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Upgrading Cast Iron appliance
This feature is used to upgrade the Cast Iron® appliance by using the upgrade files vcrypt2 and scrypt2 files.
The upgrade files are obtained as a part of Cast Iron software or from Fix Central depending on the version
(FixPacks/patch/major release) of the appliance.

About this task

To upgrade remote appliances, complete the following steps:
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Procedure

1. Copy the vcrypt2 and/or scrypt2 file to the workstation from where you can access the appliance
from Web Management Console.

2. In WMC, log on to the Integration Appliance and go to Manage > Appliances.
3. Select the appliances that you want to upgrade, from the list of registered appliances.
4. Click the Upgrade Operating System link. The Upgrade Appliances Operating System Wizard is

displayed.
5. Browse the .vcrypt2 file in the Virtual appliance Upgrade File field, to upgrade the virtual appliance.
6. Browse the .scrypt2 file in the Physical appliance Upgrade File field, to upgrade the physical

appliance.
7. Click Upgrade. All the selected appliances will be upgraded one after the other sequentially.

Results

The results of the upgrade are displayed after all the appliance upgrade is complete. The appliance version is
also updated in the registered list of appliances, after the data gets updated.

Note:

Before making changes like Upgrade/Reboot of appliance, please stop all projects in the runtime. After
appliance comes back, starts the projects one-by-one.
If the master appliance is a part of the upgrade list, it will be upgraded only after the upgrade of the
other appliances are complete.
When the files for both physical appliance and virtual appliance, scrypt2 and vcrypt2, are browsed,
upgrade is based on the type information (physical or virtual) available for the appliance in the table. If
the type information is not available (earlier version without an interim fix), then these appliances are
skipped from being upgraded.
When only one file is browsed, that file is used as an input to upgrade all selected appliances, including
appliances, which do not have type information (represented by -).

Parent topic: Managing Appliances
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About the Command Line Interface
The Cast Iron® Command Line Interface (CLI) is available to administrators to manage the Integration
Appliance and to maintain and update its configuration information.

The CLI is preinstalled on the Integration Appliance and is ready to respond to the commands described in this
documentation.

Note: The CLI is case sensitive. In general, you must enter commands and keywords using lowercase
characters.
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Only a user logged in as an administrator can use the CLI. More than one administrator can be logged in to an
Integration Appliance at the same time.

Logging into the CLI

You can log in to the CLI on the Integration Appliance through a secure shell (SSH) session, terminal emulation,
or telnet. By default. secure management is enabled on the Integration Appliance and you must use secure
connections to access the Integration Appliance. Secure connections use the default host key provided with
the Integration Appliance at installation.

When using an SSH client or a telnet client to log in to the CLI, the 5th consecutive log-in failure (regardless of
which user or any span of time) triggers a lock-out. The lock-out is characterized by a limit of one log in attempt
per minute without regard for the user. A successful log-in by any user resets the log-in failure count and ends
the lock-out.

Logging out of the CLI

At the command prompt, use the exit command to log out of the CLI. This also closes the terminal emulation or
telnet session connection.

Viewing CLI help

In the CLI, you can view a list of command categories by typing help or ?. To view syntax help for the
commands in a specific category, enter Category help. For example, net help or net ? lists syntax
information for each network command.

Tab completion also guides you through the CLI syntax. From the CLI, you can enter a partial command and
press the Tab key. Pressing the Tab key completes the command or provides a list of options to complete the
command syntax

Note: Tab completion is sensitive to spaces in the CLI syntax. For example, typing system show in the CLI and
then pressing the Tab key appears to have no results. Add a space after show and press the Tab key to view
valid command parameters.

Command conventions

The following conventions are used to illustrate command syntax rules:
Table 1.

Conven
tion Description

keywor
d
<value>

Most command parameters combine a keyword and a value. Some parameters might not require a
value.

<value> Values for parameters are enclosed in angle brackets. In many cases, the text shown indicates the
type of information you supply, such as <hostname>. Values may be explicit, such as <yes>

[x] Optional parameters are enclosed in brackets.

{x y z} Groups of mandatory parameters are enclosed in braces.

x | y | z Choices are separated by bars, select only one.

x... Parameters that may occur more than once are followed by an ellipse.
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Logging into the CLI with an secure shell session connection
By default. secure management is enabled on the Integration Appliance and you must use secure
connections to access the Integration Appliance. Secure connections use the default host key provided
with the Integration Appliance at installation. You can log in to the CLI on the Integration Appliance by
using a secure shell session (SSH).
Logging into the CLI with a Serial Connection
A serial connection allows you to monitor and issue commands against an Integration Appliance from an
ASCII terminal or PC running terminal emulation software. To establish a serial connection:
Logging into the CLI with a telnet connection
When secure management access is disabled for the Integration Appliance, you can connect to the
Integration Appliance via the network through a telnet session.
Command Line Interface modes
The mode of an Integration Appliance determines the type of Command Line Interface (CLI) commands
that you can use.
Command Line Interface commands
A list of the various command categories available from the Command Line Interface (CLI), and
describes the purpose of each command category:
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Logging into the CLI with an secure shell session connection
By default. secure management is enabled on the Integration Appliance and you must use secure connections
to access the Integration Appliance. Secure connections use the default host key provided with the Integration
Appliance at installation. You can log in to the CLI on the Integration Appliance by using a secure shell session
(SSH).

Procedure

1. In Windows, start an application, for example PuTTY, that performs SSH connections.
2. Enter the appliance-host-name.
3. If needed, select SSH as the connection protocol or set other connection parameters offered by the

application.
4. Initiate® the connection. The login prompt is displayed at first access.
5. Log in to the Integration Appliance with a username and password, which have administrative privileges.

The default username and password are:
Login: admin
Password: !n0r1t5@C

Results

When you log in, the prompt changes to the host name of the Integration Appliance.

If you have not selected a hostname, the prompt defaults to the IP address of the Integration Appliance.
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Logging into the CLI with a Serial Connection
A serial connection allows you to monitor and issue commands against an Integration Appliance from an ASCII
terminal or PC running terminal emulation software. To establish a serial connection:

Procedure

1. Connect a console or laptop computer to an Integration Appliance with a serial cable. The serial
connection must be between an ASCII terminal or a PC running terminal emulation software to the serial
port on the Integration Appliance.

2. Use the included serial cable to connect the terminal or PC to the Serial connector on the Integration
Appliance. If the terminal or PC does not have a serial port and has only a USB port, then use a USB-to-
serial converter cable (not included).

3. Configure the terminal or PC for standard 9600 8N1 and no flow control operation. 8N1 is a notation for
a serial configuration in asynchronous mode, where there are eight (8) data bits, no (N) parity bit, and
one (1) stop bit. The terminal emulation suggested for the terminal or PC is VT100.

Results

When you log in to the Integration Appliance, the prompt changes to the host name of the Integration
Appliance.

If you have not selected a hostname, the prompt defaults to the IP address of the Integration Appliance.
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Logging into the CLI with a telnet connection
When secure management access is disabled for the Integration Appliance, you can connect to the Integration
Appliance via the network through a telnet session.
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About this task

Note: By default, secure management access is enabled for the Integration Appliance; therefore, you will not
be able to connect to the Integration Appliance using a telnet connection. See the mgmt secure command for
more information about enabling and disabling secure management access.

Procedure

1. In Windows, select Start > Run.
2. Enter telnet appliance-host-name. The login prompt is displayed at first access.
3. Log in to the Integration Appliance with a username and password, which have administrative privileges.

The default username and password are:
Login: admin
Password: !n0r1t5@C

Results

When you log in, the prompt changes to the host name of the Integration Appliance.

If you have not selected a hostname, the prompt defaults to the IP address of the Integration Appliance.
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Command Line Interface modes
The mode of an Integration Appliance determines the type of Command Line Interface (CLI) commands that
you can use.

An Integration Appliance can be in one of the following modes:

Active
An Integration Appliance in an high availability (HA) pair that is actively processing data is in the Active
mode. You can run all CLI commands in this mode. The active Integration Appliance can be in one of the
following states:

Active 1 - The active Integration Appliance is not communicating with its HA peer. If the peer
Integration Appliance is rebooting or the R1 and R2 cables are disconnected, this status can
occur.
Active 2 - The active Integration Appliance is communicating with its HA peer.

Idle
An Integration Appliance enters the Idle mode when an error that requires user action occurs. This state
indicates that the non-active Integration Appliance is unable to be in either the Active or Standby mode.
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Only Integration Appliances that are part of an HA pair enter the Idle mode. You can run diagnet, ha,
netspect, and system commands in this mode.

Standalone
A single Integration Appliance that processes all messages. A standalone Integration Appliance cannot
be part of an HA pair. In this mode, you can run all commands except the commands associated with an
HA pair.

Standby
An Integration Appliance in an HA pair that monitors the processing of the Active Integration Appliance
runs in Standby mode. The Integration Appliance running in Standby mode stays in sync with the
Integration Appliance running in the Active mode, ready to take over processing if the Active Integration
Appliance goes down. You can run ha and system commands in this mode.

Unknown
In an HA pair, when an active Integration Appliance does not know the status of the standby Integration
Appliance.

Typical HA pair mode combinations

When working with an HA pair, the following mode combinations are typical:

ACTIVE_2 and STANDBY - The active machine is communicating with its peer and vice versa. The pair is
only highly available after the standby peer has synchronized all the data from the active peer.
ACTIVE_2 and IDLE - The active machine has been disconnected from the peer machine most likely as
the result of a user issuing the ha disconnect command. Issue the ha connect command to restore the
HA pair.
ACTIVE_1 and UNKNOWN - The active machine is not communicating with its peer most likely because
the peer is rebooting, powered down, or the cables are disconnected.
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Command Line Interface commands
A list of the various command categories available from the Command Line Interface (CLI), and describes the
purpose of each command category:

Table 1.
Command
Category Description

Auth
Commands

Authorization commands allow you to manage user accounts.

Config
Commands

Configuration commands allow you to manage both management and integration configuration
for the Integration Appliance.
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Command
Category Description

Debug
Commands

Debugging commands allow you to view queues and process stacks.

HA
Commands

High availability management commands. These commands are only available with an
Integration Appliance high availability (HA) pair.

Mgmt
Commands

Management commands allow you to enable and manage security settings.

Net
Commands

Network commands allow you to manage network configuration.

Netspect
Commands

Network introspection commands allow you to manage network configurations and query the
network for DHCP server, DNS server, gateway, and route information.

Stat
Commands

Status commands allow you to view Integration Appliance status.

System
Commands

System commands allow you to manage the operation of the Integration Appliance, which
includes managing licenses for the Integration Appliance and connectors.

Time
Commands

Time commands allow you to set or synchronize the date and time on the Integration Appliance.
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Authorization commands
Authorization commands allow you to manage user accounts.

The auth set user command
The auth set user command sets the password for a user. Users can change their own password using
the Web Management Console (WMC), or have the administrator change their password. The
administrator can use either the WMC, or this command. The Integration Appliance does not require the
administrator to know a user's old password to update the user's password.
The auth set recovery command
The auth set recovery command allows the admin password to be reset from the serial console for the
IBM® DataPower® Cast Iron® Appliance. The default is on.
The auth show recovery command
The auth show recovery command shows whether recovery is on or off. In the on state, the admin
password can be reset from the serial console for the IBM DataPower Cast Iron Appliance.
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The auth set user command
The auth set user command sets the password for a user. Users can change their own password using the Web
Management Console (WMC), or have the administrator change their password. The administrator can use
either the WMC, or this command. The Integration Appliance does not require the administrator to know a
user's old password to update the user's password.

When you enable an LDAP directory server to manage authorization and authentication for users and groups,
this command can only be used to change admin's password.

Syntax
auth set user <user>
Parent topic: Authorization commands
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The auth set recovery command
The auth set recovery command allows the admin password to be reset from the serial console for the IBM®
DataPower® Cast Iron® Appliance. The default is on.

If the option is enabled, you can type resetpass for the username at the serial login and any non-empty
password. Immediately after you login, you will be asked to verify physical access to the machine. To verify that
you have physical access to the appliance, you will be asked to unplug and replug the ethernet cable into the
MGMT port of the appliance. This verifies that no one is accessing the serial console over a remote port
replicator. If you do not have physical access to the appliance, you should set the recovery option to off.

Syntax
auth set recovery <on|off>
Parent topic: Authorization commands

Feedback | Notices
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The auth show recovery command
The auth show recovery command shows whether recovery is on or off. In the on state, the admin password
can be reset from the serial console for the IBM® DataPower® Cast Iron® Appliance.

If the option is enabled, you can type resetpass for the username at the serial login and any non-empty
password. Immediately after you login, you will be asked to verify physical access to the machine. To verify that
you have physical access to the appliance, you will be asked to unplug and replug the Ethernet cable into the
MGMT port of the appliance. This verifies that no one is accessing the serial console over a remote port
replicator. If you do not have physical access to the appliance, you should set the recovery option to off using
the auth set recovery command.

Syntax
auth show recovery
Parent topic: Authorization commands
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Configuration commands
Configuration commands allow you to manage both management and integration configuration for the
Integration Appliance.

The config load command
The config load command loads a management configuration file from an FTP or SFTP server. After the
configuration file is loaded on the Integration Appliance, the Integration Appliance automatically
reboots.
The config save command
The config save command saves a management configuration file to an FTP or SFTP server.
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The config load command
The config load command loads a management configuration file from an FTP or SFTP server. After the
configuration file is loaded on the Integration Appliance, the Integration Appliance automatically reboots.

Do not use reserved words in the user name, host name, or file name. Reserved words include: ftp, sftp, ibm,
port, user, and file.
Note: When using SFTP, you must specify a user name. Anonymous logins are not allowed with SFTP.

FTP Syntax
config load system ftp <host> [port <number>] [user <username>] file [<path>/]
<filename>

SFTP Syntax
config load system sftp <host> [port <number>] user <username> file [<path>/]
<filename>
Parent topic: Configuration commands
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The config save command
The config save command saves a management configuration file to an FTP or SFTP server.

Note: Do not use reserved words in the user name, host name, or file name. Reserved words include: ftp, sftp,
ibm, port, user, and file.

FTP Syntax

When saving the configuration file to an FTP server, the Integration Appliance uses anonymous if you omit the
user name.

config save system ftp <host> [port <number>] [user <username>] file [<path>/]
<filename>

Example: Saves the current system configuration as old_sys_config.cfg to the FTP server running on host tern.
The FTP user's login name is Joe.

config save system ftp tern user joe file old_sys_config.cfg

SFTP Syntax
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When saving the configuration file to an SFTP server, you must specify a user name. Anonymous logins are not
allowed with SFTP.

config save system sftp <host> [port <number>] user <username> file [<path>/]
<filename>
Parent topic: Configuration commands
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Debugging commands
Debugging commands allow you to view queues and process stacks.

The debug postmortem export command
The debug postmortem export command exports the postmortem archive to the FTP or SFTP Server you
specify.
The debug postmortem generate all command
The debug postmortem generate all command generates an archive of information gathered from
Integration Appliance logs, orchestration logs, and transaction stores, that can help debug an
Integration Appliance issue.
The debug postmortem generate full logs command
The debug postmortem generate full logs command generates a postmortem archive of all the
Integration Appliance logs, which includes new logs in addition to archived logs, and possibly several
stacks that are generated by previously running the debug show stack command.
The debug postmortem generate new logs command
The debug postmortem generate new logs command generates a postmortem archive of all the latest
Integration Appliance logs and possibly several stacks that are generated by previously running the
debug show stack command.
The debug postmortem generate store command
The debug postmortem generate store command is similar to the debug postmortem generate all
command, except that the Integration Appliance only generates a postmortem archive of all the
Integration Appliance logs and the data in the transactional store.
The debug show stacks command
The debug show stacks command displays current runtime stack traces.
The debug system command
The debug system command allows you to start and stop the Integration Appliance runtime. When you
issue the debug system stop command, all running orchestration jobs are cancelled and the Integration
Appliance does not process any new orchestration jobs..
The debug tail file command
The debug tail file command displays log file contents as they are added to the log.
The debug top command
The debug top file command dynamically displays process status.
The debug job command
The debug job command allows you to capture the instruction set and log of a running job.
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The debug postmortem export command
The debug postmortem export command exports the postmortem archive to the FTP or SFTP Server you
specify.

The Integration Appliance does not require that you specify an export file name; however, as a best practice,
you should include the Integration Appliance serial number, date, and timestamp. If you do not specify an
export file name, the Integration Appliance exports a file named postmortem.tar.gz.
Note: Do not use reserved words in the user name, host name, or file name. Reserved words include: ftp, sftp,
postmortem, debug, export, ibm, port, user, and file.

FTP Syntax

debug postmortem export ftp <hostname> [port <number>][user <user>][file <filename>
]
where:

Table 1.
Option Description

hostname Specifies the name of the FTP Server.

number Specifies the port number to use to connect to the FTP Server.

user Specifies the username used to login to the FTP Server.

filename Specifies the name of the file storing the postmortem archive.

User Input:

debug postmortem export ftp 192.168.1.2 user user1 file
logs/B2XXW56_04152005_172341.tgz
debug postmortem export ftp ftpserver.yourcompany.com user user1 file
logs/B2XXW56_04152005_172341.tgz

SFTP Syntax

To export the postmortem using SSH File Transfer Protocol, use the following SFTP syntax.
Note: When exporting a postmortem file to an SFTP server, you must specify a user name. Anonymous logins
are not allowed with SFTP.
debug postmortem export sftp <hostname> [port <number>] user <user> [file <filename>
]
where:

Table 2.
Option Description
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Option Description

hostname Specifies the name of the SFTP Server.

number Specifies the port number to use to connect to the SFTP Server.

user Specifies the username used to login to the SFTP Server.

filename Specifies the name of the file storing the postmortem archive.

User Input:

debug postmortem export sftp 192.168.1.2 user user1 file
logs/B2XXW56_04152005_172341.tgz
debug postmortem export sftp ftpserver.yourcompany.com user user1 file
logs/B2XXW56_04152005_172341.tgz

Exporting Files to IBM Support

Exports a postmortem file to IBM Support.

debug postmortem export ibm pmr <pmrnumber>
where :

pmrnumber - PMR number open with IBM Support. For example, debug postmortem export ibm
pmr 55555.555.555

Parent topic: Debugging commands
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The debug postmortem generate all command
The debug postmortem generate all command generates an archive of information gathered from Integration
Appliance logs, orchestration logs, and transaction stores, that can help debug an Integration Appliance issue.

The postmortem archive remains on the Integration Appliance until you reissue the command. When you issue
this command, the Integration Appliance generates a new archive that overwrites the previous postmortem
archive.

Issue this command before rebooting the Integration Appliance and calling technical support.

Syntax
debug postmortem generate all
Parent topic: Debugging commands
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The debug postmortem generate full logs command
The debug postmortem generate full logs command generates a postmortem archive of all the Integration
Appliance logs, which includes new logs in addition to archived logs, and possibly several stacks that are
generated by previously running the debug show stack command.

The postmortem archive remains on the Integration Appliance until you reissue the command. When you issue
this command, the Integration Appliance generates a new archive that overwrites the previous postmortem
archive.

Syntax
debug postmortem generate fulllogs
Parent topic: Debugging commands
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The debug postmortem generate new logs command
The debug postmortem generate new logs command generates a postmortem archive of all the latest
Integration Appliance logs and possibly several stacks that are generated by previously running the debug
show stack command.

The postmortem archive remains on the Integration Appliance until you reissue the command. When you
reissue this command, the Integration Appliance generates a new archive that overwrites the previous
postmortem archive.

Syntax
debug postmortem generate newlogs
Parent topic: Debugging commands
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The debug postmortem generate store command
The debug postmortem generate store command is similar to the debug postmortem generate all command,
except that the Integration Appliance only generates a postmortem archive of all the Integration Appliance logs
and the data in the transactional store.

The postmortem archive remains on the Integration Appliance until you reissue the command. When you re-
issue this command, the Integration Appliance generates a new archive that overwrites the previous
postmortem archive.

Syntax
debug postmortem generate store
Parent topic: Debugging commands
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The debug show stacks command
The debug show stacks command displays current runtime stack traces.

Syntax

debug show stacks
Parent topic: Debugging commands
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The debug system command
The debug system command allows you to start and stop the Integration Appliance runtime. When you issue
the debug system stop command, all running orchestration jobs are cancelled and the Integration Appliance
does not process any new orchestration jobs..

Syntax
debug system {start|stop }
Parent topic: Debugging commands
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The debug tail file command
The debug tail file command displays log file contents as they are added to the log.

Syntax
debug tail file<filename>
Parent topic: Debugging commands
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The debug top command
The debug top file command dynamically displays process status.

Syntax

debug top
Parent topic: Debugging commands
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The debug job command
The debug job command allows you to capture the instruction set and log of a running job.

Syntax
debug job <jobid>
Parent topic: Debugging commands
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High availability commands
High availability (HA) management commands. These commands are only available with an Integration
Appliance HA pair.

The ha active command
The ha active command orders the idle machine to become active. You can only issue this command if
there is no peer, or the peer machine is idle.
The ha conncheck command
The ha conncheck command provides information to help diagnose possible connection problems
related to a high availability pair. This command is only available in active mode.
The ha disconnect command
The ha disconnect command Temporarily disconnects an HA pair without causing the standby machine
to takeover the active machine.. This command is only available in active mode.
The ha power off standby command
The ha power off standby command powers off the Standby Integration Appliance in a high availability
pair. This command is only available in active mode.
The ha power on standby command
The ha power on standby command powers on the Standby Integration Appliance in a high availability
pair. This command is only available in active mode.
The ha reboot command
The ha reboot command completes a system reboot of the Integration Appliance you specify: active or
standby. The ha reboot command is only available for use in an HA pair. When you issue the ha reboot
standby command, the Standby Integration Appliance reboots, while the Active Integration Appliance
continues to process data. When you issue the ha reboot active command, the Active Integration
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Appliance shuts down all routing services and then reboots. The Standby Integration Appliance does not
provide failover capabilities and data is not processed until the Active Integration Appliance is back
online. To simulate failover capabilities, switch the modes of the machines in the HA pair using theha
switch command – the Active Integration Appliance (A1) becomes the Standby Integration Appliance
(S2) and Standby Integration Appliance (S1) becomes the Active Integration Appliance (A2). After the
Integration Appliances in the HA pair have switched modes, issue the ha reboot standby command. S1
continues to process data, while A1 is rebooting.
The ha show lastaccess command
The ha show lastaccess command displays the last 10 state transitions on the Integration Appliance.
Only available in idle mode.
The ha show pairstatus command
The ha show pairstatus command displays status of the high availability pair, providing information
about which Integration Appliance is Active and which is Standby. Only available in active mode.
The ha switch command
The ha switch command switches the roles of the Integration Appliance in a high availability pair. The
Active machine becomes the Standby machine and the standby machine becomes Active. Only available
in active mode.
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The ha active command
The ha active command orders the idle machine to become active. You can only issue this command if there is
no peer, or the peer machine is idle.

Syntax

Note: Using this command incorrectly can lead to data corruption.
ha active
Parent topic: High availability commands
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The ha conncheck command
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The ha conncheck command provides information to help diagnose possible connection problems related to a
high availability pair. This command is only available in active mode.

Syntax

ha conncheck
Parent topic: High availability commands
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The ha disconnect command
The ha disconnect command Temporarily disconnects an HA pair without causing the standby machine to
takeover the active machine.. This command is only available in active mode.

This action allows you to perform any necessary hardware or software maintenance on the Standby machine
without interrupting orchestration processing.

When you choose this action, the Standby machine transitions to an idle state. Reboot the active machine or
run the connect action to reestablish communications between an HA pair and resumes data synchronization
and fail-over operations.

To perform maintenance on an Active machine, run the switch action. The active machine becomes the standby
machine, where you can execute the disconnect action and perform Integration Appliance maintenance
without interrupting orchestration processing.

Syntax
ha disconnect
Parent topic: High availability commands
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The ha power off standby command
The ha power off standby command powers off the Standby Integration Appliance in a high availability pair.
This command is only available in active mode.
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Syntax
ha poweroff standby
Parent topic: High availability commands
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The ha power on standby command
The ha power on standby command powers on the Standby Integration Appliance in a high availability pair.
This command is only available in active mode.

Syntax

ha poweron standby
Parent topic: High availability commands
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The ha reboot command
The ha reboot command completes a system reboot of the Integration Appliance you specify: active or
standby. The ha reboot command is only available for use in an HA pair. When you issue the ha reboot standby
command, the Standby Integration Appliance reboots, while the Active Integration Appliance continues to
process data. When you issue the ha reboot active command, the Active Integration Appliance shuts down all
routing services and then reboots. The Standby Integration Appliance does not provide failover capabilities and
data is not processed until the Active Integration Appliance is back online. To simulate failover capabilities,
switch the modes of the machines in the HA pair using theha switch command – the Active Integration
Appliance (A1) becomes the Standby Integration Appliance (S2) and Standby Integration Appliance (S1)
becomes the Active Integration Appliance (A2). After the Integration Appliances in the HA pair have switched
modes, issue the ha reboot standby command. S1 continues to process data, while A1 is rebooting.

Syntax
ha reboot {active|standby}
Parent topic: High availability commands
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The ha show lastaccess command
The ha show lastaccess command displays the last 10 state transitions on the Integration Appliance. Only
available in idle mode.

Syntax
ha show lastaccess

An Integration Appliance state transition from idle to active displays the following information:

[GMT] Jan 10 00:55:50 State changed from ‘IDLE' to ‘ACTIVE_1'
Parent topic: High availability commands
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The ha show pairstatus command
The ha show pairstatus command displays status of the high availability pair, providing information about which
Integration Appliance is Active and which is Standby. Only available in active mode.

Syntax

ha show pairstatus
Parent topic: High availability commands
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The ha switch command
The ha switch command switches the roles of the Integration Appliance in a high availability pair. The Active
machine becomes the Standby machine and the standby machine becomes Active. Only available in active
mode.

Syntax
ha switch
Parent topic: High availability commands

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.cli.doc/CLI_ha_switch.html

Management commands
A list of the management (mgmt) commands available.

Note: If you specify community names that require quotation marks, you must use (“ ”) double quotation
marks.

Table 1.
Co
m
ma
nd
na
me Action Syntax

mg
mt
ker
ber
os
del
con
fig

Deletes the Kerberos realm and KDC server configurations. mgmt kerberos
del config
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ma
nd
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me Action Syntax

mg
mt
ker
ber
os
set
real
m

Allows you to specify the Kerberos realm and KDC server configuration settings. mgmt kerberos
set
realm<name>kd
c<name |
ipaddress>

mg
mt
ker
ber
os
sho
w
con
fig

Displays the Kerberos realm and KDC server configuration settings. mgmt kerberos
show config

mg
mt
mo
td

Allows you to set a message of the day that is displayed when a user logs in to the
CLI. You can view the message of the day that was set, by choosing the show
parameter. Choose the clear parameter and no message of the day is displayed when
a user logs in to the CLI.

mgmt
motd{set|show
| clear}

mg
mt
sec
ure

Enables or disables secure access to the Integration Appliance for the management
interface. The default option is on, which enables secure management access. When
secure management access is enabled (on), you must access the CLI by using SSH
(secure shell) and access the Web Management Console (WMC) by using HTTPS.
When you disable secure management access, by choosing the off option, you can
access the CLI by using telnet and access the WMC by using HTTP.

Verify the current security setting by using the mgmt secure setting command

mgmt secure {
on | off |
setting}

mg
mt
sn
mp
set

Allows you to set up or update current SNMP configurations, as well as enable and
disable the SNMP MIB2 service. For more information on using SNMP commands,
see SNMP basics.

1. mgmt snmp
set {
community |
description |
location |
contact }
<value>

2. mgmt snmp
set { on |
off }

mg
mt
sn
mp
sho
w

Displays current SNMP configuration settings. mgmt snmp
show {
community |
description |
location |
contact | all
| status }
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mg
mt
ssh
add

Adds a public key for the specified host to the SSH Store on the Integration
Appliance. If strict SSH key checking is enabled on the Integration Appliance, public
keys must reside in the SSH Store for all participating endpoint systems that the
Integration Appliance connects to with SFTP.

Restart the Integration Appliance after you issue this command.

Note: The keytype is a required parameter.

mgmt ssh
add<rsa|dsa
>host<name|
ipaddr|name,i
paddr>

mg
mt
ssh
del

Deletes the public key for the specified host from the SSH Store on the Integration
Appliance.

Restart the Integration Appliance after you issue this command.

Note: The keytype is a required parameter.

mgmt ssh del
host<hostname
>|host IP
address>

mg
mt
ssh
key
che
ck

Enables or disables strict SSH key checking.

In strict mode, SFTP connectors only connect to participating endpoint systems if the
public key for that system matches the public key stored in the SSH Store of the
Integration Appliance.

In easy mode, SFTP connectors connect to participating endpoint system if either:

The public key for that system matches the public key stored in the SSH Store
No public key exists in the SSH Store. If no key exists, the connector loads the
current public key from the participating endpoint system to the SSH Store

mgmt ssh
keycheck<stri
ct|easy >

mg
mt
ssh
list

Displays all or a specified host that have public keys in the SSH Store. Public keys in
the SSH Store are used with SFTP connectors to ensure secure connections.

mgmt ssh
list[host<nam
e | host IP
address>}

mg
mt
ssh
sho
w
key
che
ck

Displays the current setting of SSH key checking: strict or easy. mgmt ssh show
keycheck
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mg
mt
sysl
og
del
con
fig

Allows you to delete system log (syslog) configurations. mgmt syslog
del config

mg
mt
sysl
og
set
re
mo
te
hos
t

Allows you to specify the remote host to which logs are sent. mgmt syslog
set remote
host<name |
host IP
address>

mg
mt
sysl
og
sho
w
con
fig

Displays current system log (syslog) configuration settings. mgmt syslog
show config
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Network commands
Network commands that you can use to manage the network configuration.

Table 1.
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Co
mm
and
na
me Action Syntax

net
add
etc
hos
t

Adds an entry to the /etc/hosts configuration file in the Integration
Appliance.

The IP address is typically the management IP address of the
appliance. It is best practice to specify a fully qualified host name (for
example, myhost.mydept.mycompany.com). Also, although alias is an
optional parameter, it is best practice to specify an alias (for example,
myhost).

Here is an example of a net add etchost command.

net add etchost address 111.222.333.444 hostname 
myhost.mydept.mycompany.com alias myhost

If an entry was previously added with a host name that is not fully
qualified, that entry must first be removed by using the net del etchost
command before you add an entry with a fully qualified host name.
Verify that the entry was successfully deleted by using the net show
etchost command.

net add etchost address
<ip-address> hostname
<fully-qualified-
hostname> [alias
<short-alias-name>]

net
add
rout
e
add
res
s

Adds a static route to the routing table. net add route address
<destination> mask
<netmask> [gateway
<gateway>] interface
{emgmt | edata}

net
del
etc
hos
t

Removes one or more entries from the /etc/hosts configuration file in
the Integration Appliance.

Specify the identical parameters that were used when the entry was
added by using the net add etchost command. You can verify the
details by using the net show etchost command.

net del etchost address
<ip-address> hostname
<fully-qualified-
hostname> [alias
<short-alias-name>]

net
del
rout
e
add
res
s

Removes a static route from the routing table. net del route address
<ip-address> mask
<mask>

net
flus
h
dhc
p

Erases cached DHCP values from the Integration Appliance. net flush dhcp
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net
pin
g

Queries the specified host to determine if it is responding on the
network.

net ping {<ip-address>|
<nodename>}

net
rest
art

Saves and applies any new network settings. You must use this
command after net set, net add, or net del commands to apply the
changes.

net restart

net
rest
ore

Restores the memory to active or backup settings. net restore
{active|backup}

net
trac
ero
ute

Traces the network route to the specified node. net traceroute <ip-
address>|<nodename>

net
vali
dat
e

Tests the current in-memory settings and displays any warnings or
errors that might prevent the network from operating correctly.

When all network settings are acceptable, issuing this command
returns the following statement, "Current network settings can be
applied."

When an invalid setting is entered, issuing this command returns the
appropriate warning or error messages. For example,

warning: Route to 9.43.79.4 requires static Data IP 
address 
 
error: Gateway 9.9.9.9 is not reachable from emgmt 
 
Current network settings cannot be applied

net validate

For the net set and net show commands, see the following topics:

The net set command
Sets the configuration for the network interfaces of the Integration Appliance, DNS server, host name,
and default gateway. Choose the net set autohost command to automatically add the hostname/IP
address to the Integration Appliance. You can also set the amount of time before reporting a lost carrier.
The net show command
This command displays all network configuration for the Integration Appliance. This command can also
display specific configuration information for the network interfaces, DNS server, host name, default
gateway, routing tables, and socket connections. If you enable the net set autohost command, use the
net show autohost to view the current settings of the autohost.

Feedback | Notices
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The net set command
Sets the configuration for the network interfaces of the Integration Appliance, DNS server, host name, and
default gateway. Choose the net set autohost command to automatically add the hostname/IP address to the
Integration Appliance. You can also set the amount of time before reporting a lost carrier.

To improve startup time in networks that do not have a DHCP server, configure all items to either static values
or none so the Integration Appliance does not search for a DHCP server.

If you configure any value to be obtained through DHCP, startup time could be delayed as the Integration
Appliance tries to locate an available DHCP server.

The network interfaces of the Integration Appliance use these names:

edata - for the interface that handles all integration data
emgmt - for the interface that handles management traffic, including both the CLI and the Web
Management Console (WMC)

Table 1.
O
p
ti
o
n
s Description

a
u
t
o
h
o
s
t

Allows the Integration Appliance to find its IP address from its own hostname. When you enabled this
option and the Integration Appliance cannot find an IP address corresponding to its hostname, either
through DNS or an entry you entered manually into the /etc/hosts directory, the Integration Appliance
automatically adds an entry into the /etc/hosts directory to allow the CIOS to operate normally. Enable or
disable this option through the net set autohost command.

c
a
r
ri
e
r

Specifies the time, in seconds, until a missing ethernet link carrier is reported as an error. Setting the value
to zero disables the carrier checking and no errors are reported.

d
o
m
a
i
n

Sets the domain name for this Integration Appliance. The effect is that most queries for names within this
domain can use short names relative to the local domain.
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p
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o
n
s Description

g
a
t
e
w
a
y

Specifies the gateway and the interface to use for that gateway. The Integration Appliance supports only
one default gateway for both management and data traffic (as opposed to one gateway per interface), but
additional routes can be added separately.

h
o
s
t
n
a
m
e

Sets the name of the Integration Appliance. This should be the short hostname, without the domain name.

i
n
t
e
r
f
a
c
e

Sets the IP address, Netmask and Broadcast address for the specified interface.

li
n
k

Sets the ethernet link to autonegotiate (the default) or to specific values. In most cases autonegotiate is
preferable, but setting specific values can sometimes help improve throughput when network conditions
are not optimal.

m
t
u

Sets the Maximum Transmission Unit (MTU) size between a range of (68-9000). The default MTU is 1500.

n
a
m
e
s
e
r
v
e
r

Sets DNS server list (maximum 2).

n
t
p

Sets the time server.

1164   



O
p
ti
o
n
s Description

s
e
a
r
c
h

Specifies the search list. If you do not set this option, the search list is the same as the value of the domain
setting.

Syntax 1

net set autohost [enable|disable ]

Syntax 2

net set carrier timeout <timeout>

Syntax 3

net set {domain|search|nameserver|ntp} {dhcp[emgmt|edata]|static <value>|none}
Example 1: Set a specific domain name.

net set domain static mydomain.com

Example 2: Ask a DHCP server on the management NIC for an NTP server.

net set ntp dhcp emgmt

Example 3: Search for host names in specified domains.

net set search static a.mydomain.com b.mydomain.com

Example 4: Do not search for host names in other domains.

net set search none

Syntax 4

net set gateway {dhcp {emgmt|edata}|static <ipaddress> {emgmt|edata}|none}

Syntax 5

net set hostname {dhcp[emgmt|edata]|static <value>}

Syntax 6

net set interface {emgmt|edata} {dhcp|address <ipaddress> mask <mask> [bcast
<bcast>]}

Syntax 7
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net set link {emgmt|edata} {autonegotiate|speed <speed> duplex {half|full}}

Syntax 8

net set mtu {emgmt|edata} <MTU>
Parent topic: Network commands
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The net show command
This command displays all network configuration for the Integration Appliance. This command can also display
specific configuration information for the network interfaces, DNS server, host name, default gateway, routing
tables, and socket connections. If you enable the net set autohost command, use the net show autohost to
view the current settings of the autohost.

You can issue a collection of network settings changes in memory with the net show command. The Integration
Appliance does not persist these changes. The net show command only becomes permanent after you issue a
net restart command.

Active - Displays the network settings for the Integration Appliance that is currently running.
Memory - Displays the network settings of a staging Integration Appliance that becomes active when
you issue the net restart command.
Backup - Specifies the Integration Appliance that was active before you issued the previous net restart
command.

The network interfaces of the Integration Appliance use these names:

edata - for the interface that handles all integration data
emgmt - for the interface that handles management traffic, including both the CLI and the Web
Management Console

Table 1. . The following table provides descriptions for options available in the various
command syntaxes:

O
p
ti
o
n
s Description

a
ll

Displays all network configuration information for the Integration Appliance.

1166   



O
p
ti
o
n
s Description

a
c
ti
v
e

Displays complete network configurations.

a
u
t
o
h
o
s
t

Allows the Integration Appliance to find its IP address from its own hostname. When you enabled this
option and the Integration Appliance cannot find an IP address corresponding to its hostname, either
through DNS or an entry you entered manually into the /etc/hosts directory, the Integration Appliance
automatically adds an entry into the /etc/hosts directory to allow the runtime to operate normally. Enable
or disable this option through the net set autohost command.

b
a
c
k
u
p

Displays complete network configurations.

c
a
r
ri
e
r

Specifies the time, in seconds, until a missing ethernet link carrier is reported as an error. Setting the value
to zero disables the carrier checking and no errors are reported.

d
o
m
a
i
n

Displays the domain name for this Integration Appliance. The effect is that most queries for names within
this domain can use short names relative to the local domain.

e
t
c
h
o
s
t

Displays the entries within /etc/hosts.
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O
p
ti
o
n
s Description

g
a
t
e
w
a
y

Specifies the gateway and the interface to use for that gateway. The Integration Appliance supports only
one default gateway for both management and data traffic (as opposed to one gateway per interface), but
additional routes can be added separately.

h
o
s
t
n
a
m
e

Displays the name of the Integration Appliance. This should be the short hostname, without the domain
name.

i
n
t
e
r
f
a
c
e

Displays the IP address, Netmask and Broadcast address for the specified interface.

li
n
k

Sets the ethernet link to autonegotiate (the default) or to specific values. In most cases autonegotiate is
preferable, but setting specific values can sometimes help improve throughput when network conditions
are not optimal.

m
e
m
o
r
y

Displays complete network configurations.

m
t
u

Displays Maximum Transmission Unit (MTU) size for data in an IP packet.
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O
p
ti
o
n
s Description

n
a
m
e
s
e
r
v
e
r

Displays the DNS server list (maximum 2).

n
o
d
e

Displays the IP address for the node.

n
t
p

Displays the network protocol for clock synchronization between an appliance and network.

r
o
u
t
e

Displays active routes.

s
e
a
r
c
h

Specifies the search list. If you do not set this option, the search list is the same as the value of the domain
setting.

s
o
c
k
e
t
s

Displays a list of socket addresses.

s
t
a
t
u
s

Displays the network status of the Integration Appliance, including the last attempt to start networking,
the last time networking started, the last time networking stopped, the reason for last networking stop and
the current networking activity.

Syntax 1
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net show {active|memory|backup}

Syntax 2

net show {hostname|domain|search|nameserver|gateway|ntp}[ all|active|memory|backup]

If not specified, the last parameter defaults to active.

Syntax 3
net show autohost

Syntax 4
net show carrier [all|active|memory|backup]

Syntax 5
net show etchost

Syntax 6
net show interface {emgmt|edata} [all|active|memory|backup]

Syntax 7
net show link [all|active|memory|backup]

Syntax 8
net show node {<ip address>|<hostname> }

Syntax 9
net show route [active|memory|backup]

If not specified, the last parameter defaults to active.

Syntax 10
net show sockets

Syntax 11
net show status
Parent topic: Network commands
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Network introspection commands
Network introspection (Netspect) commands allow you to manage network configurations and query the
network for DHCP server, DNS server, gateway, and route information.

Note: Do not use reserved words in the user name, host name, or file name. Reserved words include: ftp, sftp,
export, ibm, port, user, and file.

Table 1.
Co
mm
and
na
me Action Syntax

net
spe
ct
arp

Issues an ARP request for the IP address you specify and
displays the result of the ARP reply or displays the ARP cache
content.

netspect arp <lookup ipv4-
address|show cache>

net
spe
ct
cap
ture
clea
n

Deletes all existing packet capture files. netspect capture clean

net
spe
ct
cap
ture
sho
w

Displays the captured packets. Issuing this command also
stops any running packet capture.

netspect capture show
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net
spe
ct
cap
ture
star
t

Initiates a packet trace and produces a gzip (.gz) file. Packet
traces can be useful for debugging network connection errors.

Only one packet trace capture can run at a time. The capture
continues running until you stop it using <CTRL + C> or until a
maximum number of packets is reached.

Note: When you start a capture with packet size parameter set
to full, pktsize full, fewer packets can be captured.

You can transfer packet traces to another host using the
netspect export command.

Note: Capturing a packet trace overwrites the previous
capture.

netspect capture start
[interface <emgmt|edata|all>]
[pktsize <header|full>] [find
<hostname|network>]

where

hostname - Captures to/from
specified host (nn.nn.nn.nn).
network - Captures to/from
certain network in CIDR.

Note: If you do not specify emgmt or
edata for the interface parameter, the
Integration Appliance uses the default
value of all and capture starts for
both interfaces.
Example 1: Capture packet headers
on both interfaces.

netspect capture start

Example 2: Capture full packets on
edata.

netspect capture start
interface edata pktsize full

Example 3: Capture packet headers
on edata to/from certain network.

netspect capture start
interface edata find
123.12.0.0/24

Example 4: Capture full packets on
emgmt to/from certain host.

netspect capture start
interface emgmt pktsize full
find 123.12.0.123
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net
spe
ct
con
nec
t

Using the protocol you specify, this command attempts to
open a connection to the network host port and displays the
result of the connection attempt. If a connection is
established, the connection is closed prior to this command
returning.

netspect connect host <host-
id> <protocol> port <port-
num> where

host-id - The name or IP
address of a network host.
protocol - The protocol to use
for the connection. Must be
"tcp".
port-num - Any valid tcp port
number.

net
spe
ct
dhc
p

Queries the network for DHCP servers on the network
interface you specify. Also displays DHCP server supplied
network configuration information, plus the offered IP address
and its lease terms.

netspect dhcp interface
<emgmt|edata>

net
spe
ct
dns

Queries the system configured DNS server for the specified
network host (i.e. perform either a forward lookup: return the
IP address for a given host name, or perform a reverse lookup:
return a host name for a given IP address), and display the
result of the lookup.

netspect dns lookup host
<host-id>
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net
spe
ct
exp
ort

Exports a packet capture file to an FTP Server. For more
information about capturing packet traces, see the netspect
capture start command.

netspect export <ftp|sftp>
host <host-id> [port
<number>] [user <user>] [file
<filename>]
where:

host-id - The name or IP
address of the network host.
port - A valid port on the
specified network host to which
to connect.
user - Specifies the username
used to log into the host.
Note: When using sftp, this
parameter must be specified.
Anonymous logins are not
allowed with sftp.
filename - File path on the
destination host.

Example 1: netspect export ftp.

netspect export ftp host
123.12.12.123

Example 2: netspect export sftp.

netspect export sftp host
123.12.12.123 user myname
file /home/myname/mycap.gz

net
spe
ct
gate
way
s

Queries the gateways and routes for the specified IP protocol
family, and reports whether or not the gateway responded to
the query/ping. The IP protocol family can be either ipv4,
which is the default or ipv6.

netspect gateways <ip-
protocol>

net
spe
ct
hel
p

Displays help text for the specified netspect command. If a
command is not specified, then a help summary for all
netspect commands is displayed.

netspect help <command>

net
spe
ct
ifco
nfig

Displays network interface configuration information for the
specified interface. If a network interface name is not
specified, then interface configuration information is displayed
for all network interfaces.

netspect ifconfig interface
<emgmt| edata>
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net
spe
ct
ping

Attempts to query the specified network host, and displays the
result of the query attempt.

netspect ping host <host-id>

net
spe
ct
rout
es

Displays currently configured routes for the specified IP
protocol family. The IP protocol family can be either IPv4 (the
default if none specified) or IPv6.

netspect routes [<ip-
protocol> ]

net
spe
ct
sum
mar
y

Provides a summary of network configuration information. netspect summary

net
spe
ct
trac
ero
ute

Attempts to determine the route to the specified network host,
and displays the route packets took to get to the specified
network host.

netspect traceroute host
<host-id>

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.cli.doc/CLI_netspect_commands.html

Status commands
Status commands allow you to view Integration Appliance status.

Table 1.
Command
name Action Syntax

stat show all Displays system status information, such as: disk usage, memory usage, uptime,
and active processes.

stat show
all
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System commands
System commands allow you to manage the operation of the Integration Appliance, which includes managing
licenses for the Integration Appliance and connectors.

Note: Do not use reserved words in the user name, host name, or file name. Reserved words include: ftp, sftp,
ibm, port, user, and file.

Table 1.
Com
man
d
nam
e Action Syntax

syst
em
auto
rebo
ot

Allows you to enable or disable automatic reboot for an Integration Appliance.

Note: During a Cast Iron® firmware upgrade, the Integration Appliance reboots
even if the automatic reboot is disabled.

system autoreboot
<on | off>

syst
em
auto
rebo
ot
setti
ng

Use the setting parameter to print autoreboot settings. system autoreboot
setting
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Com
man
d
nam
e Action Syntax

syst
em
clea
n

Clears the system states of the Integration Appliance. When you issue a
system clean all command, the IBM® DataPower® Cast Iron® Appliance may
reboot.

Running the all option results in the removal of all data and configurations,
including High Availability configurations, from disk. The results are equivalent
to restoring factory default settings for the appliance. After the reboot, you
will be asked to accept the license agreement before logging in to the Web
Management Console for the appliance.

system
clean{[running][
orchmon]
[deploy]}|all
where:

running -
Removes
currently
running project
data.
orchmon -
Removes
orchestration
monitoring data.
deploy -
Removes all
projects and
configurations.
all - Resets the
appliance to
factory default
settings.

syst
em
pers
ist

Enables or disables the disk cache on the Integration Appliance. The default
and recommended setting is system persist on.

When persistence is enabled, writes are synchronized to ensure that all
requested data is completely written to disk. This behavior helps protect data
integrity, particularly when accessing external transactional systems such as
databases.

When persistence is disabled, on an appliance that supports this feature,
performance might be improved. However, there is a risk of losing job
progress state.

system persist {
on | off }

syst
em
pers
ist
setti
ng

Displays the current system persist setting: on or off. Use the system persist
command to specify whether the disk cache is enabled or disabled.

system persist
setting

syst
em
pow
eroff

Shuts down all routing services and then powers off the Integration Appliance.
If the force parameter is used, power is cut off immediately.

system poweroff
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d
nam
e Action Syntax

syst
em
rebo
ot

Shuts down all routing services and then reboots the Integration Appliance.

Note:

Before making changes like Upgrade/Reboot of appliance, please stop
all projects in the runtime. After appliance comes back, starts the
projects one-by-one.

When the system reboots, any network settings that have not been
saved are lost. To commit network settings to the Integration
Appliance, use the net restart command.

system reboot

syst
em
rest
art

Restarts the runtime and Web Management Console, without affecting the
network connectivity.

system restart

syst
em
sho
w
platf
orm

Displays information about the Integration Appliance, such as: ROM version,
appliance platform, serial number, and MAC addresses.

system show
platform

syst
em
sho
w
stat
us

Available for Standalone Integration Appliances as well as the Active
Integration Appliance in an HA pair. Shows whether the following components
are up or down: System, Network, and Runtime.

system show
status

Example output:

Appliance Status 
---------------- 
     System: Up 
    Network: Up 
    Runtime: Up

syst
em
sho
w
versi
on

Displays the version of the Cast Iron operating system on the Integration
Appliance.

system show
version
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man
d
nam
e Action Syntax

syst
em
upd
ate
cios
ima
ge

Updates the Cast Iron Operating System on the Integration Appliance using an
image from an FTP Server based file or an SFTP Server based file.

system update
cios image from
<source>
where source can
specify an FTP Server
or an SFTP Server:

ftp <hostname>
[port <number>]
[user <user>]
file <filename>
sftp
<hostname>
[port <number>]
user <user> file
<filename>
http
<hostname>
[port <number>]
[user <user>]
file <filename>
https
<hostname>
[port <number>]
user <user> file
<filename>

Note: When using sftp,
you must specify the
user parameter.
Anonymous logins are
not allowed with sftp.
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Time commands
Time commands allow you to set or synchronize the date and time on the Integration Appliance.
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Note: To avoid time drift on Virtual Appliances, run NTP on the host and guest. Running NTP sets the system
time to UTC. Do not use the time set clock command to reset time on a Virtual Appliance.

Table 1.
Com
mand
name Action Syntax

time
set

Sets individual time and date components relative to the time zone
you choose. The Integration Appliance restarts after you issue this
command using the clock parameter.

If you do not know the syntax for a specific time zone, choose the last
option and do not specify a value for zone.

time set { { |
clock<string> } | {
zone<zone>} | { zone} }
Example 1:

time set clock<string>
User input: time set
clock Sat Jan 1
00:00:00 2005

Example 2:

time set zone<zone>
User input: time set
zone
America/Los_Angele
s

time
show

Display all time settings or individual time components (the current
time, date, or time zone).

time show
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About High Availability Pairs
A High Availability (HA) pair is an Integration Appliance configuration that connects two physical Integration
Appliances together, allowing them to automatically synchronize data and perform fail-over operations. The
machines that make up the HA pair share the same MAC and IP addresses, thus creating a single network
identity.

There is one Active and one Standby Integration Appliance in an HA pair. The Integration Appliance that
actively processes orchestrations is the Active machine. The Integration Appliance that automatically
synchronizes data and performs fail-over operations is the Standby machine. When the machines that make up
an HA pair initially connect to each other, they immediately synchronize with each other and determine which
machine assumes the active role and which machine assumes the standby role. During the initial
synchronization operation, the Active machine can processes orchestrations; however, fail-over cannot occur
until the HA pair is completely synchronized. Once the HA pair is synchronized, the HA pair persists data and
automatically synchronizes this data between the two machines.
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When an Active machine failure occurs, the Standby machine initiates a take over procedure, becomes the
Active machine, and resumes processing orchestrations exactly where the other machine stopped. The take
over process typically takes less than a minute to complete, but DHCP response times can slow the take over
process. During the take over procedure, the Standby machine power cycles the Active machine to ensure the
Active machine is not still processing orchestrations. Only when the Standby machine can successfully power
cycle the failed Active machine does it become the Active machine. If the Standby machine is unable to power
cycle the Active machine, the Standby machine goes into an IDLE state.

Examples of failures that can cause an HA fail-over to occur include the following failures:

Hardware failures generated by CPUs, hard drives, RAM, motherboards, network interfaces, power
supplies, and raid-controllers.
Integration Appliance runtime failures, such as fatal errors during processing.
Communication failures between the Integration Appliances caused by replication port network
interface issues or replication cable issues.

When the Active machine loses contact with the Standby machine, the Active machine stops running
orchestrations to prevent an asynchronous data commit and waits to see if the Standby machine initiates the
take over procedure. If the Standby machine does not power cycle the Active machine, the Active machine
resumes processing orchestrations. When the Standby machine is able to reconnect to the Active machine, the
Standby machine synchronizes with the Active machine.

From the WMC, you can monitor an HA pair's status and manipulate the roles of the Integration Appliances in
an HA pair.
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About Integration Appliance States
Integration Appliances in a High Availability (HA) pair can be in one of many states. States for Integration
Appliances in an HA pair include:

States for Integration Appliances in an HA pair include:

ACTIVE_1
The Active machine cannot communicate with the Standby machine; however, the Active machine
continues to process data.

ACTIVE_2
The Active machine is successfully processing data and can communicate with the peer HA machine.

IDLE
Displays when the Active machine or Standby machine encounters a hardware or software problem. An
IDLE state helps to ensure data integrity between an HA pair. IDLE is not always an error state.
For example, the Active machine enters an IDLE state when it power cycles and remains in this state
until it can verify the state of the Standby machine.

STANDBY
The Standby machine is successfully synchronizing with the Active machine.
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TRANSITIONING
Can occur immediately before or after rebooting. Typically, a machine in an HA pair remains in this state
after rebooting long enough to perform some initialization, find its peer, and then transition into the
appropriate state.

UNKNOWN
Occurs when the peer machine is unavailable. For example, when a Standby machine is powered off, the
Active machine states that the state of the peer machine (Standby machine) is UNKNOWN.
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Requirements for Configuring High Availability Pairs
A High Availability (HA) pair requires a very specific hardware configuration, and the two Integration Appliances
must meet certain requirements.

To operate as an HA pair, the two Integration Appliances must meet the following requirements:

Both Integration Appliances must use the same version of the Cast Iron® Operating System. When you
apply a patch to one Integration Appliance, the same patch is automatically applied to the other
Integration Appliance in the HA pair.
The replication interfaces on one machine must be connected by cable to the corresponding interface on
the other machine.
The management network port on each Integration Appliance must be connected to the same subnet.
The data network port on each Integration Appliance must be connected to the same subnet.

Note: A note regarding High Availability pairs and Hybrid Cloud Integration (HCI) support – If you are using HCI
functionality and attempt to convert two Integration Appliances to HA, the HCI function will no longer be
supported.
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Setting Up a High Availability Pair

About this task

Perform the following steps to set up a High Availability pair.
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Procedure

1. If you are using 9005 appliances to set up an HA pair, do the procedures in Step 1a. If you are using
9004 appliances, do the procedures in Step 1b. .
Note: High Availability can only be obtained by connecting homogeneous appliances. Do not attempt to
connect dissimilar appliances (such as a 9005 appliance and a 9004 appliance) to one another to attain
High Availability

a. For the 9005 appliance - To create an HA pair, you need a total of six Ethernet cables in addition
to the recommended serial console cable. Directly connect the replication interfaces of the two
appliances with two Ethernet cables:

1 x ethernet cable for emgmt of Appliance A 
1 x ethernet cable for emgmt of Appliance B 
1 x ethernet cable for edata of Appliance A 
1 x ethernet cable for edata of Appliance B 
1 x ethernet cable for repl1 between Appliance A and Appliance B 
1 x ethernet cable for repl2 between Appliance A and Appliance B

Connected as follows:

Appliance 1             Appliance 2 
Repl 1 <--------------> Repl 1 
MGMT                  MGMT 
Data 1                  Data 1 
Data 2                  Data 2 
Data 3                  Data 3 
Repl 2 <--------------> Repl 2

Connect MGMT and Data 1 for both appliances to the appropriate management and data
networks. Data 2 and Data 3 should remain disconnected.

b. For the 9004 appliance - Note that the network interfaces labelled externally on the Cast Iron
appliance are mapped to different interfaces internally:

External Label   Internal designation 
MGMT            emgmt 
ETH0            r1 
ETH2            edata 
ETH1            r2

Connect the appliances with two Ethernet cables:

Appliance 1                           Appliance 2 
MGMT   (internal:emgmt)               MGMT (internal:emgmt) 
ETH0   (internal:r1)    ----------->  ETH0 (internal:r1) 
ETH1   (internal:r2)    ----------->  ETH1 (internal:r2) 
ETH2   (internal:edata)               ETH2 (internal:edata)

MGMT (emgmt) and ETH2 (edata) for both appliances should be connected to the appropriate
management and data networks.

2. Select an appliance to be the initial Active peer. The second appliance will be the Standby peer.
3. Connect a serial console to the selected Cast Iron appliance. Log in to the Cast Iron command line

interface (CLI) on the Active peer appliance as user admin. The default admin password is !n0r1t5@C.
You should get a command prompt similar to: none/Standalone>.

4. Configure the management and data networks to use statically assigned IP addresses. From the CLI, you
do this by issuing a net set interface command followed by net restart:

appliance name/Standalone> net set interface emgmt address <MGMT IP  
ADDRESS> mask <MGMT NETMASK> bcast <MGMT BROADCAST> 
 
appliance name/Standalone> net set interface edata address <DATA IP  
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ADDRESS> mask <DATA NETMASK> bcast <DATA BROADCAST> 
appliance name/Standalone> net restart

5. To avoid problems, you should upgrade Cast Iron appliances with the latest software version. The
software can be located on the IBM Fix Central website at http://www.ibm.com/support/fixcentral/ and
should be downloaded onto a machine that is accessible from the Cast Iron appliance to be upgraded.
Upgrade of the Cast Iron software can be done through the Cast Iron Web Management Console (WMC)
or alternatively, through commands issued on the command line interface. To check the software level,
connect a serial console to the selected Cast Iron appliance, then log in to the Cast Iron command line
interface on the Active peer appliance as user admin. By default the admin password is !n0r1t5@C.
Issue the following command to check the software level:

none/standalone>system show version

If an update is required, issue the update command, providing the ftp location and user credentials
required. For example:

none/standalone>system update cios image from ftp 10.10.17.166 user  
billbloggs file Downloads/fixcentral/castiron/myciupdate

The appliance reboots during the upgrade process.
6. Repeat steps 3 and 5 for the Standby appliance. Because the appliance temporarily requires two IP

addresses for the duration of the upgrade, you may also need to perform step 4 on the Standby peer.
Note: After HA setup is complete, only two IP addresses (one for management and one for data) are
required for the HA pair. Any IP addresses used on the Standby peer for this step are discarded upon
completion of HA setup and may be used elsewhere in the network environment.

7. Issue the following command on both peers to ensure that they have the same level of software
installed and that it is the required software level:

none/standalone>system show version

8. Configure the Active appliance as HA:

none/standalone> system haconfig enable active

The appliance reboots and restarts as the Active appliance.
9. Log in to the Active appliance. The command prompt shows the appliance is active:

none/Active> 
or 
appliance name/Active>

10. Connect a serial console to the selected Standby appliance, then log into the Standby peer and issue the
following command to configure it as HA:

none/standalone> system haconfig enable standby 

11. Log back into the Standby appliance. The command prompt shows the appliance is standby:

none/Standby>

12. On the Active appliance check the status of the HA pair:

appliance name/Active>ha show pairstatus

The output indicates if the appliances are highly available. For example:

appliance name/Active>ha show pairstatus 
 
Pair Status 
---------------- 
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NOT Highly Available 
Local State: ACTIVE_2 
Peer  State: STANDBY 
Sync Status: 74% 
 
 
Appliance Services 
------------------- 
Network: Up 
Runtime: Starting 
 
Command complete 

In this example, the HA pair is not highly available because synchronization of the disks is only 74%
complete. Issue the command again and the status changes:

appliance name/Active>ha show pairstatus 
 
Pair Status 
---------------- 
Highly Available 
Local State: ACTIVE_2 
Peer  State: STANDBY 
Sync Status: Synced 
 
Appliance Services 
------------------- 
Network: Up 
Runtime: Up 
 
Command complete

13. After synchronization completes, it is important to ensure that the HA pair can properly switch roles
when necessary. Use ha show pairstatus to confirm that the pair is Highly Available and that the
network and runtime appliance services are reported as up. Identify the serial number of the appliance
that is currently active.

appliance name/Active> system show version

Issue the following command to switch the roles of the HA pair:

appliance name/Active> ha switch

The Standby peer takes over and becomes Active. (Typically this process requires about 2 minutes). The
peer that was previously Active becomes Standby. Use the command system show version to view
the serial number of the Active appliance and confirm that it has changed. Use the command "ha show
pairstatus" to verify that the HA pair returns to the Highly Available state.

14. After confirming that the HA pair can switch roles in one direction (for example: Peer A -> Peer B), do
Step 13 again to ensure the HA pair can switch roles in the other direction (Peer B -> Peer A).
Note: A note regarding High Availability pairs and Hybrid Cloud Integration (HCI) support – If you are
using HCI functionality and attempt to convert two Integration Appliances to HA, the HCI function will
no longer be supported.
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Working with High Availability Pairs
High Availability (HA) pairs consist of two Integration Appliances: an Active machine and a Standby machine.
This HA pair can then process orchestrations as a single entity.

The Active machine actively processes orchestrations, while the Standby machine automatically synchronizes
data with the Active machine in case the Standby machine needs to perform any fail-over operations. When the
appropriate scenario occurs, the Active machine and Standby machine can switch roles.

From the WMC, you can change the state or role of the Integration Appliances in an HA pair.

Running High Availability Commands
You can run commands against a High Availability (HA) pair from the navigation pane.
High Availability Commands
These commands can be run against a High Availability (HA) Pair.
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Running High Availability Commands
You can run commands against a High Availability (HA) pair from the navigation pane.

Procedure

1. Select System > Command. The System Commands page is displayed.
2. From the Choose Command drop-down list, select a command. You can view command details by

clicking the drop-down arrow.
3. Click Go.

Parent topic: Working with High Availability Pairs
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High Availability Commands
These commands can be run against a High Availability (HA) Pair.

Table 1.
S
ys
te
m
C
o
nt
ro
l
C
o
m
m
a
n
ds Description

H
A
C
o
n
ne
ct

Reconnects the Active and Standby Integration Appliance so that they can resume fail-over operations.

H
A
Di
sc
o
n
ne
ct

Temporarily disconnects an HA pair without causing the Standby machine to takeover the Active
machine. This action allows you to perform any necessary hardware or software maintenance on the
Standby machine without interrupting orchestration processing.When you choose this action, the
Standby machine transitions to an idle state. Reboot the Active machine or execute the Connect action to
reestablish communications between an HA pair and resumes data synchronization and fail-over
operations. To perform maintenance on an Active machine, use the Switch action. The Active machine
becomes the Standby machine, where you can use the Disconnect action and perform Integration
Appliance maintenance without interrupting orchestration processing.

H
A
S
wi
tc
h

Causes the Integration Appliances in an HA pair to switch roles: the Active machine becomes the Standby
machine and the Standby machine becomes the Active machine.

Parent topic: Working with High Availability Pairs
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Troubleshooting a High Availability Pair
If both the Active and Standby machines enter an IDLE state, use the CLI to resolve the issue.

Procedure

To resolve an IDLE/IDLE state:

1. From the CLI on both the Active machine and the Standby machine, type ha show lastaccess.
2. Determine which Integration Appliance has the most valid set of data. Usually the Integration Appliance

with the most recent activity generates the most recent timestamp.
3. Type ha active on the Integration Appliance you determine to have the most valid data.

Results

This Integration Appliance is now the Active machine in a HA pair.

If you require specific technical support for high availability pairs, contact IBM Technical Support.
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About the virtual appliance
This guide provides information about creating, configuring, backing up and recovering virtual appliances.
Virtual appliances run in a virtual environment and are packaged with a guest operating system and optional
application software, while integration appliances are physical machines.

Cast Iron® products perform equally well in both the virtual and physical worlds. You can install the Cast Iron
Operating System (CIOS) on a single virtual machine running one integration project or on multiple virtual
machines running many projects to create a data center infrastructure. For information on creating virtual
appliances with CIOS as the guest operating system, see Deploying an OVF template.

Your virtual appliance environment should consist of the following:

A host machine (desktop computer or server).
CPU (for example Intel® VT-x or AMD®-V) with virtualization technology enabled. (In some cases,
virtualization technology must be enabled through BIOS).
60 GB disk space.
Supported configuration of either 1 CPU, 4 GB RAM or 2 CPU, 8 GB RAM. Ensure that the host has
enough physical RAM to run the selected configuration or system performance might be affected.
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VMware® ESX® or ESXi version 5.0 or later. For more information on VMware products and ESX, go to
http://kb.vmware.com/selfservice/microsites/microsite.do and click VMware ESX and ESXi Comparison.
Cast Iron Hypervisor Edition installation file (in OVA format).
VMware vCenter® Server, 4.0.0, 258672 (optional).
VMware VMotion® and VMware High Availability add-ons (optional). When added to your installation,
VMware add-ons can manage and balance your workload across virtual machines, find an optimum data
center location for a virtual machine and manage OS related failures. Refer to VMware documentation to
learn more about add-ons and for tips on setting up your virtual environment.

Note: Shared storage, such as a SAN, is optional. Shared storage is required to enable VMware features such as
VMware VMotion and VMware High Availability.
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Getting started with the IBM WebSphere Cast Iron Hypervisor
Edition

This guide introduces the IBM® WebSphere® Cast Iron® Hypervisor Edition (HVE) and provides an overview of
virtualization technology. Virtualization refers to hardware virtualization where a virtual appliance runs in a
virtual environment and is packaged with a guest operating system and optional application software.

Virtualization allows you to run several instances of an operating system on the same physical piece of
hardware at the same time. Virtualization is accomplished through technology called hypervisor. A hypervisor
allows many different simultaneously running operating systems to share the same set of physical resources
(memory, CPU, disk and network) on one physical server. The physical machine on which the virtualization
software runs is the host and virtual machines running on the host are guests.

Cast Iron products perform equally well in both the virtual and physical worlds. You can install the Cast Iron
Operating System (CIOS) on a single virtual machine running one integration project or on multiple virtual
machines running many projects to create a data center infrastructure. For information on creating virtual
appliances with CIOS as the guest operating system, see Deploying an OVF template.

Requirements
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Requirements
This section outlines the requirements and resources needed to establish a virtual appliance environment. For
detailed information on mapping between resources, see Resource mapping.

Requirements:

A host machine (desktop computer or server).
CPU (for example Intel® VT-x or AMD®-V) with virtualization technology enabled. (In some cases,
virtualization technology must be enabled through BIOS).
60GB disk space.
Supported configuration of either 1 CPU, 4GB RAM or 2 CPU, 8GB RAM. Ensure the host has enough
physical RAM to run the selected configuration or system performance may be affected.
VMware® ESX® or ESXi version 5.0 or later. For more information on VMware products and ESX, go to
http://kb.vmware.com/selfservice/microsites/microsite.do and click on VMware ESX and ESXi
Comparison.
Cast Iron® Hypervisor Edition installation file (in OVA format).
VMware vCenter® Server, 4.0.0, 258672 (optional).
VMware VMotion® and VMware High Availability add-ons (optional). When added to your installation,
VMware add-ons can manage and balance your workload across virtual machines, find an optimum data
center location for a virtual machine and manage OS related failures. Refer to VMware documentation to
learn more about add-ons and for tips on setting up your virtual environment.

Note: Shared storage, such as a SAN, is optional. Shared storage is required to enable VMware features such as
VMware VMotion and VMware High Availability.
Parent topic: Getting started with the IBM WebSphere Cast Iron Hypervisor Edition
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Resource mapping
This section provides information on mapping between virtual and physical resources when provisioning virtual
machines.

When you instantiate a new virtual machine to run the Cast Iron HVE, you first must select a size for the virtual
machine. As referenced in Requirements, the supported sizes are:

1 CPU, 4GB RAM, minimum 60GB disk space. (Standard configuration).
2 CPU, 8GB RAM, minimum 60GB disk space. (Enhanced configuration).

The preceding resources sizes refer to the amount of a resource that is visible to a running virtual machine. For
the Standard configuration, 1 CPU and 60GB disk space refer to the number of virtual CPUs and the amount of
disk space the virtual machine must see. Because virtualization allows many different virtual machines running
different operating system instances to share the same physical resources, it's important to size your physical
host environment to account for the number of virtual machines you have running.
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Memory

In addition to your host environment, it's important to size your physical host to properly account for the
amount of memory needed for your running guests. Best practice dictates that your host should have more
physical memory than the sum of the memory set up for the simultaneously running guests. For example, if you
are trying to size a physical host to run both the Standard and Enhanced configurations, you should pick a host
that has 4 + 8 + 2 => at least 14GB or RAM. (The extra 2GB of RAM is recommended for the hypervisor
processes).

CPU

When mapping virtual CPUs to physical CPUs you should count one physical CPU core per virtual CPU that will
be running simultaneously, and leave at least one core as a buffer for the hypervisor processes. For example, if
you are trying to size a physical host to run both the Standard and Enhanced configurations, you should pick a
host that has 1 + 2 + 1 = 4 physical CPU cores. Because most physical CPUs are multicore, a physical host with
one quad-core CPU is sufficient to run the configurations. Because the Cast Iron HVE uses a 64-bit kernel, your
host must have a physical CPU with virtualization technology support available and enabled, (for example,
Intel's VT-x or AMD's AMD-V). In some cases, virtualization technology must be enabled through BIOS.

Disk

Disks are typically the cheapest resource in a virtualized environment. Best practices dictate that a virtual
machine should preallocate the amount of disk space required onto physical disks so that performance does
not suffer when trying to expand disks later. When sizing disks, you should significantly oversize the disks so
you can store many suspended virtual machines at the same time and only instantiate the ones needed. For
example, if you are trying to size a physical host to run both the Standard and Enhanced configurations, the
minimum requirement for disk space is 60 + 60 + 5 = 125GB. (The remaining 5GB of space is for the hypervisor
software). However, best practice is to get a physical host with significantly larger disks so that you can store
more inactive virtual machines as your needs grow.
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Upload an appliance patch
By uploading an appliance patch, you can upgrade to the newest version of the Cast Iron® operating system
and access the latest features.

Before you begin

Important: If you use SAP projects, you must ensure that you install the SAP 64-bit libraries. Remove any SAP
32-bit libraries before you upgrade to WebSphere® Cast Iron Hypervisor Edition Version 7. If there are any SAP
32-bit libraries that are installed, you cannot upgrade to WebSphere Cast Iron Hypervisor Edition Version 7.
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About this task

Use the Web Management Console (WMC) to upgrade to the latest version of Cast Iron operating system by
uploading an upgrade image onto the appliance. This upgrade process only replaces or adds necessary files, it
does not destroy any data. Note, the WMC forces any running projects to be undeployed and stops any active
orchestration jobs currently running on the appliance during the upgrade procedure. After the appliance is
upgraded, you cannot undo or roll back to the previous version.
Note: Upgrades can also be applied through the Command Line Interface (CLI). For more information, see the
system update command in the CLI Reference Guide.

Procedure

1. Download the WebSphere Cast Iron Hypervisor firmware upgrade file (type = vcrypt2) from Fix Central:
http://www.ibm.com/support/fixcentral/.

2. Download the appliance upgrade image file to a location you can access from your Windows
workstation, for example: C:\Desktop.

3. Use the WMC to log into the appliance that is running the Cast Iron operating system.
4. In the WMC, select Set Up > Install/Upgrade. The Install/Upgrade Appliance and Libraries panel is

displayed.
5. In the Upgrade Appliance section, click Install Upgrade. The upgrade wizard is displayed.
6. Click Next.
7. Click Next to check for running projects. If projects are running on the appliance, the upgrade wizard

asks for confirmation to stop the projects before proceeding. Click Continue to proceed. If there are no
projects running on the appliance, a green check mark is displayed. Click Next.

8. In the text field, either specify the path to the appliance upgrade image file or browse to locate the
appliance upgrade image file.

9. Click Next. In the Upgrade panel, the following message is displayed: Upload in progress. Please
wait. A progress bar displays the status of the upload. When the upload is complete, the WMC
validates the upgrade.

10. Verify the patch version number and click Install.
11. A series of dialog boxes are displayed asking for confirmation to stop any running orchestrations. Click

OK and OK. The Upgrade Appliance panel displays. After the upgrade completes in about 5 minutes, the
appliance reboots and the following message is displayed in the Upgrade Appliance panel:
Installation Successful! Please wait. The Appliance is rebooting. If a console
window to the appliance is open, the rebooting messages are displayed.

12. Use the WMC to log into the appliance. You might need to click the refresh button of the browser.

What to do next

Using the WMC, redeploy any projects that were undeployed by this upgrade procedure. Upgrade to a Studio
version compatible with the installed Cast Iron operating system. For more information about appliance and
Studio compatibility, see the Compatibility section of the Cast Iron Operating System Release Notes® or the Cast
Iron Studio Release Notes. For the procedure on upgrading Studio, see Installing Studio.
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Deploying an OVF template
You can deploy an OVF template which creates a virtual machine with the CIOS and VMwareTools installed.
After the OVF template is deployed, you can manage the virtual appliance from the vSphere Client Console tab,
as you would manage a physical integration appliance through the CLI.

Before you begin

Note: The steps in this section apply to VMware only. Note also that after deploying an OVF template, the
vSphere client might display the VMware Tools status as “Not Installed." However, if the OVF template is
correctly deployed, VMware Tools are installed on the virtual machine.

Procedure

1. Download a local copy of the CIOS OVA file. It is recommended that you download the OVA to a storage
device that is accessible by the host machine, where the virtual machine will reside.

2. In the VMware Infrastructure Client navigation pane, select the virtual machine on which to install the
CIOS.

3. Select File > Deploy OVF Template. The Deploy OVF Template Wizard is displayed.
4. 4. Choose an option to deploy the OVF template and specify the location of the OVF template, and click

Next.
Deploy from file - Choose this option if the source OVF template is on the local file system.
Deploy from URL - Choose this option to download the OVF template from the Internet and enter
a URL

5. Verify the template details that display and click Next.
6. Specify the name and location for the deployed template and click Next.
7. Select a configuration option and click Next.

Standard - 1CPU, 4GB RAM
Enhanced - 2CPU, 8GB RAM

The Host/Cluster page is displayed.
8. Select the host or cluster on which to run the deployed template, and click Next.
9. Select a resource pool, and click Next.

10. Select the datastore to which you want to store the virtual machine files, and click Next.
11. Map the networks used in the OVF template to networks in your inventory, by selecting the drop-down

list in the Destination Networks column. Then click Next.
12. Verify the options you have specified and click Finish. The OVF template is deployed to your virtual

machine.

What to do next

After you have successfully deployed the OVF template, do not attempt to modify the settings for hard disk 1 or
hard disk 2.
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Configuring to use DHCP addressing
You can configure a virtual machine in a network to use a DHCP server for addressing.

Procedure

1. Using the virtual machine console, log in to the virtual machine with the default user name and
password.

localhost login: admin
Password: !n0r1t5@C

The following prompt displays:

localhost>

Note: The keyboard mapping of the vSphere Client terminal uses a US layout. If your workstation
keyboard uses another layout, your login attempt might fail.

2. Assign the host name and IP address in the DNS server for the following interfaces:
Host name and IP address for the data interface
Host name and IP address for the management interface

The data interface is used by the integration appliance during run time to communicate to endpoints on
the network, for example a database server. The management interface is used to communicate with the
integration appliance from the WMC.

3. Enter the following settings:
MAC address for the data interface
Hostname assigned to the data interface in the DNS server
MAC address for the management interface
Hostname assigned to the management interface in the DNS server
Hostname assigned to the BMC interface in the DNS server

4. Apply the network settings: localhost> net restart
5. Monitor the status of the system, by repetitively issuing the following command:localhost> system
show status. As the network settings are applied, the network status transitions through the following
states:

Up
Stopping
Starting
Up

6. Monitor the state of the network: localhost> net show status. The network settings have been
applied when status of the Current activity lists Monitoring network.

7. Verify the data and management interface network settings, using the following command: localhost>
net show active

8. Reset any address that is incorrect. If you run net show all, the EData display as disabled.
9. Verify the connection to the management interface using the WMC.

Feedback | Notices
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Configuring to use static addressing
You can configure a virtual machine in a network to use static addressing.

About this task

Network settings you specify are only committed to the Integration Appliance when you run the net restart
command. If a system reboot occurs before you commit your network settings, those network settings are lost.

Procedure

1. Using the virtual machine console, log in to the virtual machine with the default user name and
password.

localhost login: admin
Password: !n0r1t5@C

The following prompt is displayed::

localhost>

2. Assign the host name and IP address in the DNS server for the following interfaces:
Host name and IP address for the data interface
Host name and IP address for the management interface

The data interface is used by the integration appliance during run time to communicate to endpoints on
the network, for example a database server. The management interface is used to communicate with the
integration appliance from the WMC.

3. Set the host name for the management interface: localhost> net set hostname static
appliancehostname. Once the host machine is restarted at the end of this procedure, the prompt
changes to the following setting:

hostname>

4. Set the DNS domain name: localhost> net set domain static domain-name
5. Set the DNS name server: localhost> net set nameserver static dns-ipaddress
6. Set the network address for the data interface: localhost> net set interface edata address
ipaddress mask netmask bcast broadcast

7. Set the network address for the management interface: localhost> net set interface emgmt
address ipaddress mask netmask bcast broadcast

8. Set the gateway address: localhost> net set gateway static ip-address emgmt
9. Disable searching the domain list: localhost> net set search none

10. Set the Network timeserver to the appropriate setting for your environment:
If you have a timeserver on your network: localhost> net set ntp static ntp-address
If you do not have a timeserver on your network: localhost> net set ntp none

11. Review the settings: localhost> net show memory
12. Apply the network settings: localhost> net restart
13. Monitor the status of the system, by repetitively issuing the following command: localhost> system

show status As the network settings are applied, the network status transitions through the following
states:

Up
Stopping
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Starting
Up

Note: As network settings are applied, you can expect the runtime to be down.
14. Monitor the state of the network: hostname> net show status The network settings have been

applied when status of the Current activity lists Monitoring network.
15. Verify the settings you entered using this command: hostname> net show active
16. Reset any address that is incorrect. If you run net show all, the EData display as disabled.
17. Log out hostname> exit The session closes.
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Backing up and recovering virtual appliances
You can purchase the VMware Consolidated Backup add-on to handle a disaster recovery scenario for your
virtual environment or you can use the Export/Import functionality of the virtual appliance.

For more information about VMware Consolidated Backup, see the VMware Consolidated Backup Guide.

The following topics describe how to export and import virtual appliance repositories and provide details about
which components of the virtual appliance are affected by these operations.

Exporting a virtual appliance repository
Export the project repository to create a backup of the virtual appliance. You can export all project
configuration and user settings from the WMC to another location. The virtual appliance system logs are
not exported when you export a repository.
Importing a virtual appliance repository
When you import a repository, the WMC deletes all existing projects, project configurations, and job
history. The virtual appliance system logs remain unaffected. Once you have imported a repository, you
cannot roll back to a previous repository.
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Exporting a virtual appliance repository
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Export the project repository to create a backup of the virtual appliance. You can export all project
configuration and user settings from the WMC to another location. The virtual appliance system logs are not
exported when you export a repository.

About this task

You can export a repository with the project configurations running. However, when you import this repository,
the project configurations will all be in the undeployed state.

Use the WMC to export a virtual appliance repository.
Note: Encryption of virtual appliance disks utilizes the VMware-assigned UUID of the virtual appliance. As a
result, attempting to clone and/or copy a virtual appliance yields a non-functioning clone/copy because such
operations yield a new UUID. To create a back-up appliance, create a new a virtual appliance with the same
configuration (for example: standard or enhanced) and use the CLI command config save/load to
export/import virtual appliance settings and WMC repository functions. (Be aware, however, that these
operations do not export/import data, including variables, stored on the disk or in memory as part of the
process of the orchestration).
Note: VMotion remains a valid operation for migrating a virtual appliance to a new host.

Procedure

1. From the Deploy tab, select Export Repository. The File Download window is displayed.
2. Click Save. The Save As window is displayed.
3. Specify the location where you would like to save the exported repository.
4. Click Save. The WMC exports a copy of the repository as a .tar.gz file.

Parent topic: Backing up and recovering virtual appliances

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.VAuserguide.doc/VA_exportingVA.html

Importing a virtual appliance repository
When you import a repository, the WMC deletes all existing projects, project configurations, and job history. The
virtual appliance system logs remain unaffected. Once you have imported a repository, you cannot roll back to
a previous repository.

Before you begin

You must stop and undeploy all project configurations on the WMC before you can import a repository. When
the WMC successfully imports a repository, all project configurations are in an undeployed state. You can
import repositories from CIOS version 3.7.1 to 6.x.
Note: Before you import a repository from one virtual appliance to another, you must power off the virtual
appliance from which you are importing a repository.

About this task
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In the steps that follow, you undeploy all projects, then use the WMC to import a virtual appliance repository:

Procedure

1. From the Deploy tab, select Projects. All project configurations are displayed.
2. Verify that all the project configurations are undeployed.
3. If any project is not in the undeployed state, click the project configuration link, then stop and undeploy

the project configuration.
4. From the Deploy tab, select Import Repository. The Import Repository page is displayed.
5. Specify the repository file you want to import or click Browse to search for a repository file.
6. Select one of the following import options:

Project & User Settings - Imports all the contents of the repository file you select. All projects are
imported in the undeployed state.
Project Only - Imports only project information from the repository file you select. All projects are
imported in the undeployed state.
User Settings Only - Imports only the user setting information from the repository file you select.
User setting information includes: network configurations, users and groups, licenses, job log
parameters, log levels, notifications, downtime rules and passwords.

7. Click Import. A warning is displayed.
8. Click Import to verify that you would like to proceed with the import. The virtual appliance restarts and

the WMC login window is displayed when the import is complete.
9. Log into the virtual appliance.

10. From the Deploy tab, select Projects to deploy all appropriate project configurations.

Parent topic: Backing up and recovering virtual appliances
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Integration Appliance Monitoring Options
Overview of monitoring options available on the Integration Appliance.

The Integration Appliance logs system events, such as a fan failing or Standby machine assuming the active
role in an HA pair. You can view these system events from the Web Management Console (WMC). When system
events occur, individual users as well as network management systems can receive notification alerts from the
Integration Appliance via email and SNMP traps respectively. Using SNMP, network management systems can
also poll an Integration Appliance to actively monitor resources such as disk usage, memory usage, and
garbage collection cycles. For more information about systems and notification severity levels you can monitor
from the WMC, see the management console online help.

While any user can view the systems events log and monitor disk and memory usage from the WMC, you must
create a notification policy to receive alerts from the Integration Appliance. Use the WMC to create a
notification policy. Notification polices contain details about which systems to monitor, notification levels to
monitor, and notification alert recipients. The Integration Appliance only sends alerts when an event meets or
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exceeds the notification level specified in a notification policy. For more information about creating notification
policies and notification levels, see the management console online help.

The Cast Iron Notifications Reference provides details about reading and using Cast Iron SNMP MIB and
individual messages from each Cast Iron MIB module. The version of SNMP is SNMPv1. (Although the MIBs are
set to SNMP version 2, Cast Iron generates SNMPv1 traps only.)
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About the Cast Iron SNMP MIB
An overview of the Cast Iron SNMP MIB and a list of available MIB modules.

As a network element, the Integration Appliance is able to respond to requests from a network management
system. The Integration Appliance is also able to send notifications to the network management system about
events that occur on the Integration Appliance. This communication between the Integration Appliance and
your network management system allows you to use traps to monitor the Integration Appliance.

Whether you choose to receive notification alerts from the Integration Appliance by enabling SNMP traps or
you choose to actively monitor Integration Appliance activities like memory usage by polling the Integration
Appliance, the Cast Iron MIB provides data structure and defines content type for the information exchange.

When you use the WMC to download the Cast Iron MIB, you are downloading one file that contains multiple
MIB definitions. Some SNMP MIB parsers are unable to read a file that contains multiple MIB modules, so you
must separate each MIB module into individual files. For more information about generating separate MIB
module files, see Downloading the Cast Iron SNMP MIB.

The Cast Iron MIB contains notification messages for the following modules:

Downloading the Cast Iron SNMP MIB
Provides information about downloading each MIB module in the Cast Iron SNMP MIB as a separate file.
Reading the Cast Iron SNMP MIB
Provides examples of how to read and organize the content of Cast Iron SNMP MIBs.
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Downloading the Cast Iron SNMP MIB
Provides information about downloading each MIB module in the Cast Iron SNMP MIB as a separate file.

Use the Web Management Console (WMC) to download the Cast Iron SNMP MIB from an Integration Appliance.
For more information about how to use the WMC to download the Cast Iron SNMP MIB, see the management
console online help.

The WMC downloads the Cast Iron SNMP MIB as a single text file. This text file is comprised of multiple
sections, where each section is a full MIB module. For example, the NetSuite Module is defined in one section
and the Salesforce Module is defined in another section.

Note: If your SNMP MIB parser is unable to read a file that contains multiple MIB modules, separate each
section (MIB module) into individual files. On Linux, you can use the following script to generate a separate file
for each MIB module in the Cast Iron SNMP MIB.

#!/bin/bash 
 
sed -ne 's/DEFINITIONS ::= BEGIN.*//p' castironsys.mib | 
while read mib; do 
echo $mib 
sed -ne "/^$mib/,/^END/p" castironsys.mib > $mib 
done

Parent topic: About the Cast Iron SNMP MIB
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Reading the Cast Iron SNMP MIB
Provides examples of how to read and organize the content of Cast Iron SNMP MIBs.

Each MIB module has a module-identity, which describes the purpose for the MIB. For example, the NetSuite
Module provides access to the NetSuite online service. Each MIB module also contains a comment section that
provides a high-level overview of its contents. Content like the Object Summary lists the name and OID of every
object in the MIB, much like a table of contents, and allows you to examine the layout and the type of data that
is being provided.

In the following example, ciIaProjectSummary is an organizational node that contains general information
about projects on the Integration Appliance. Like a directory, the ciIaProjectSummary organizational node
contains object types that provide information about the number of projects, number of running orchestrations,
number of stopped orchestrations, number of running jobs, number of completed jobs, and number of errored
jobs.

--   ciIaProjectSummary                             ciia.1.1.1 
--    ciIaNbrProjects                               ciia.1.1.1.1 
--    ciIaNbrRunningOrchs                           ciia.1.1.1.2 
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--    ciIaNbrStoppedOrchs                           ciia.1.1.1.3 
--    ciIaNbrRunningJobs                            ciia.1.1.1.4 
--    ciIaNbrCompletedJobs                          ciia.1.1.1.5 
--    ciIaNbrErroredJobs                            ciia.1.1.1.6

To get more information about the meaning of one of the objects, search the file for the name of the object. For
example, searching for ciIaNbrRunningJobs returns the following block of information:

ciIaNbrRunningJobs OBJECT-TYPE                      -- ciia.1.1.1.4 
    SYNTAX Unsigned32 
    MAX-ACCESS read-only 
    STATUS current 
    DESCRIPTION 
        "Total number of currently running jobs. 
        " 
::= { ciIaProjectSummary 4 }

where:

ciIaNbrRunningJobs OBJECT-TYPE - Defines the name of the object.
Note: Next to the object name, there is a shortened form of the OID (– ciia.1.1.1.4).
SYNTAX Unsigned32 - An unsigned integer whose value could go up or down over time.
MAX-ACCESS read-only - A read-only value that the system manager can ask for but cannot change.
STATUS -
DESCRIPTION - Describes the object.

Polling for ProjectSummary information retrieves data that is similar to the following example:

$ snmpwalk -v 2c -c public -M "+/home/choller/mibs" -m "+CASTIRON-IA-MIB" 
flintstone2 ciIaProjectSummary 
CASTIRON-IA-MIB::ciIaNbrProjects.0 = Gauge32: 2 
CASTIRON-IA-MIB::ciIaNbrRunningOrchs.0 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaNbrStoppedOrchs.0 = Gauge32: 14 
CASTIRON-IA-MIB::ciIaNbrRunningJobs.0 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaNbrCompletedJobs.0 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaNbrErroredJobs.0 = Gauge32: 0

ciIaProjectTable is another example of an organizational node that contains information about each project on
the Integration Appliance. Like a directory, the ciIaProjectTable organizational node contains object types that
provide information like the project name, project version, project configuration, project state, and so on.

--   ciIaProjectTable                               ciia.1.1.2 
--    ciIaProjectEntry                              ciia.1.1.2.1 
--     ciIaProjEntryIndex                           ciia.1.1.2.1.1 
--     ciIaProjEntryName                            ciia.1.1.2.1.2 
--     ciIaProjEntryVersion                         ciia.1.1.2.1.3 
--     ciIaProjEntryConfig                          ciia.1.1.2.1.4 
--     ciIaProjEntryState                           ciia.1.1.2.1.5 
--     ciIaProjEntryNbrRunning                      ciia.1.1.2.1.6 
--     ciIaProjEntryNbrCompleted                    ciia.1.1.2.1.7 
--     ciIaProjEntryNbrErrored                      ciia.1.1.2.1.8 
--     ciIaProjEntryTimePublished                   ciia.1.1.2.1.9

Polling for ProjectTable information retrieves data that is similar to the following example:

$ snmpwalk -v 2c -c public -M "+/home/choller/mibs" -m "+CASTIRON-IA-MIB" 
flintstone2 ciIaProjectSummary 
CASTIRON-IA-MIB::ciIaNbrProjects.0 = Gauge32: 2 
CASTIRON-IA-MIB::ciIaNbrRunningOrchs.0 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaNbrStoppedOrchs.0 = Gauge32: 14 
CASTIRON-IA-MIB::ciIaNbrRunningJobs.0 = Gauge32: 0 
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CASTIRON-IA-MIB::ciIaNbrCompletedJobs.0 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaNbrErroredJobs.0 = Gauge32: 0

The object types are much like columns in a table that store data generated by events that occur on the
Integration Appliance. For example, publishing and cloning projects are events that generate ProjectTable data.
You can poll the Integration Appliance to retrieve this data. Data for two events: publishing a project and
cloning a project are displayed in the following example:

$ snmpwalk -v 2c -c public -M "+/home/choller/mibs" -m "+CASTIRON-IA-MIB" 
flintstone2 ciIaProjectTable 
CASTIRON-IA-MIB::ciIaProjEntryName.98304 = STRING: OnlineLicensing 
CASTIRON-IA-MIB::ciIaProjEntryName.98305 = STRING: OnlineLicensing 
CASTIRON-IA-MIB::ciIaProjEntryVersion.98304 = STRING: 1.0 
CASTIRON-IA-MIB::ciIaProjEntryVersion.98305 = STRING: 1.0 
CASTIRON-IA-MIB::ciIaProjEntryConfig.98304 = STRING: Default 
CASTIRON-IA-MIB::ciIaProjEntryConfig.98305 = STRING: OnlineLicensingClone 
CASTIRON-IA-MIB::ciIaProjEntryState.98304 = INTEGER: undeployed(1) 
CASTIRON-IA-MIB::ciIaProjEntryState.98305 = INTEGER: undeployed(1) 
CASTIRON-IA-MIB::ciIaProjEntryNbrRunning.98304 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrRunning.98305 = Gauge32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrCompleted.98304 = Counter32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrCompleted.98305 = Counter32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrErrored.98304 = Counter32: 0 
CASTIRON-IA-MIB::ciIaProjEntryNbrErrored.98305 = Counter32: 0 
CASTIRON-IA-MIB::ciIaProjEntryTimePublished.98304 = STRING: 2009-6-
12,16:36:20.0,+0:0 
CASTIRON-IA-MIB::ciIaProjEntryTimePublished.98305 = STRING: 2009-6-12,16:36

As more events occur, the output can become increasingly difficult to read. To generate a more readable
output, it is recommended to use the snmptable command to display the data in a table format. Data for each
event displays as a new row.

$ snmptable -v 2c -c public -M "+/home/choller/mibs" -m "+CASTIRON-IA-MIB" 
flintstone2 ciIaProjectTable 
SNMP table: CASTIRON-IA-MIB::ciIaProjectTable 
 
 ciIaProjEntryName ciIaProjEntryVersion  ciIaProjEntryConfig ciIaProjEntryState 
ciIaProjEntryNbrRunning ciIaProjEntryNbrCompleted ciIaProjEntryNbrErrored 
ciIaProjEntryTimePublished 
   OnlineLicensing                  1.0              Default         undeployed        
0                         0                       0  2009-6-12,16:36:20.0,+0:0 
   OnlineLicensing                  1.0 OnlineLicensingClone         undeployed        
0                         0                       0  2009-6-12,16:36:20.0,+0:0

Parent topic: About the Cast Iron SNMP MIB
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Presents a table of OID trees that you can poll using SNMP Get.

Each entry in the table represents many individual items. Use snmpwalk or another SNMP polling utility to see
the complete list. You can poll the following OID trees:

OID SNMP Name Notes

.1.3.6.1.2.1.1 SNMPv2-MIB::system  

.1.3.6.1.2.1.2 IF-MIB::interfaces  

.1.3.6.1.2.1.4 IP-MIB::ip  

.1.3.6.1.2.1.5 IP-MIB::icmp  

.1.3.6.1.2.1.6 TCP-MIB::tcp  

.1.3.6.1.2.1.7 UDP-MIB::udp  

.1.3.6.1.2.1.1
1

SNMPv2-MIB::snmp  

.1.3.6.1.2.1.2
5.1

HOST-RESOURCES-
MIB::hrSystem

Excluding .1.3.6.1.2.1.25.1.3 HOST-RESOURCES-
MIB::hrSystemInitialLoadDevice

Excluding .1.3.6.1.2.1.25.1.4 HOST-RESOURCES-
MIB::hrSystemInitialLoadParameters

.1.3.6.1.2.1.2
5.2

HOST-RESOURCES-
MIB::hrStorage

 

.1.3.6.1.2.1.2
5.3

HOST-RESOURCES-
MIB::hrDevice

 

.1.3.6.1.4.1.2
021.4

UCD-SNMP-MIB::memory  

.1.3.6.1.4.1.2
021.10

UCD-SNMP-MIB::laTable CPU Load Average

.1.3.6.1.4.1.2
021.11

UCD-SNMP-MIB::systemStats  

.1.3.6.1.4.1.1
3336

CASTIRON-REGISTRATIONS-
MIB::castironsys

See the Cast Iron MIB, particularly CASTIRON-IA-MIB.
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Using Traps to Monitor Appliance Health
Recommendations for configuring alerts that monitor appliance health.
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When monitoring the health of the Integration Appliance, you can use one or both of the following methods:

Poll - Actively monitor runtime resource usage including appliance garbage collection cycles, appliance
memory usage, and appliance disk usage.
Trap - Receive notifications indicating hardware situations such as failed fans, high temperatures, or
failed disks. For more information about hardware related SNMP traps, see About the Platform Module.

For more information about creating and enabling notification alerts, see the WMC Online Help or the Cast Iron
Web Management Console Guide in the IBM WebSphere Cast Iron Information Center.

Table 1 provides recommended thresholds for notifications regarding garbage collection, memory usage, and
disk usage.

Garbage Collection - This parameter counts the number of garbage collections that have occurred since
the last system restart. Garbage collection that occurs at a rate over the recommended threshold can
indicate that the appliance is overworked and might start to experience performance issues.
Memory Usage - This parameter measures the percentage of total memory in use, expressed in
hundredths of a percent. This number is updated after each garbage collection.
Note: This value is provided as an integer, but the MIB causes the SNMP Manager to alter its displayed
value by a hundredths of a percent. For example: a value of '1234' displays as '12.34'." The SNMP
Management tool should handle this automatically, but verify that it does so.
Disk Usage - This parameter measures the percentage of total work-in-progress (WIP) disk space that is
in use, expressed in hundredths of a percent. The percentage of disk usage determines job purging
activities for the appliance.

Table 1. Recommended Notification Thresholds
Paramete
rs to
Monitor Recommended Thresholds SNMP Name and OID

Garbage
Collection

Create a notification that triggers an alert if this value
changes quickly, by more than 6 counts in a 1-minute
time period.

CASTIRON-IA-
MIB::ciIaResNbrGarbageCollects
.1.3.6.1.4.1.13336.2.2.2.1.1.2.1.0

Memory
Usage

Create a notification that triggers an alert if this value
goes over 80% (raw value of 8000).

CASTIRON-IA-
MIB::ciIaResPctMemoryUsed
.1.3.6.1.4.1.13336.2.2.2.1.1.2.2.0

Disk
Usage

Create a notifications triggers an alert if this value goes
over 75% (raw value of 7500).

CASTIRON-IA-MIB::ciIaResPctWipFull
.1.3.6.1.4.1.13336.2.2.2.1.1.2.3.0

Note: The parameters to monitor, described in the table above, are for SNMP polling only.
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The Archive Module provides activities that allow creating and reading compressed archives. This section
contains details for the messages delivered from the Archive Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Archive Module.

MIB Name : CASTIRON-COMP-ARCHIVE-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.4

The following table provides an alphabetical list of all notifications that can be issued by the Archive Module.

Table 1. Notifications issued by the Archive Module
Notification Level System Description

ArchiveDone Info Orchestration Activity has successfully completed archiving.

ArchiveEntryBlank Severe Orchestration Archive input entry does not have any content.

ArchiverCreated Info Orchestration Activity has successfully created an archiver for
archiving.

ErrorIdentifyArchive Severe Orchestration There was an error identifying the archive entry.

ErrorUnZipOperation Severe Orchestration There was an error performing unzip operation.

ErrorZipOperation Severe Orchestration There was an error performing zip operation.

IncorrectParameters Severe Orchestration Parameters provided to the activity are invalid.

InvalidArchiveEntry Severe Orchestration There was an error reading archive entry.

InvalidArchiveFormat Severe Orchestration Activity could not create an archiver for the supplied
archiving format. This format might not be supported
by the activity.

InvalidBzipEntry Severe Orchestration The bzip entry has more than one entry.

InvalidDateTime Warning Orchestration Error occurred while parsing datetime from archive
entries.

InvalidGzipEntry Severe Orchestration The gzip entry has more than one entry.

InvalidNumInArchEntry Warning Orchestration The numeric value in archive entry is not valid.

InvalidUnArchFormat Severe Orchestration Activity could not create an unarchiver for the
supplied archiving format. This format might not be
supported by the activity.

InvalidUnarchiveInput Severe Orchestration The input to unarchive is invalid.

UnArchiverCreated Info Orchestration Activity has successfully created an unarchiver for
unarchiving.

UnarchiveDone Info Orchestration Activity has successfully completed unarchiving.

ValidationError Severe Orchestration The input entries were not successfully validated
against the schema.

ValidationFine Info Orchestration The input entries were successfully validated against
the schema.

Archive Operation Notifications
Provides a comprehensive list of operation notifications sent from the Archive Module.
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Archive Operation Notifications
Provides a comprehensive list of operation notifications sent from the Archive Module.

ArchiveDone
Activity has successfully completed archiving.
ArchiveEntryBlank
Archive input entry does not have any content.
ArchiverCreated
Activity has successfully created an archiver for archiving.
ErrorIdentifyArchive
There was an error identifying the archive entry.
ErrorUnZipOperation
There was an error performing unzip operation.
ErrorZipOperation
There was an error performing zip operation.
IncorrectParameters
Parameters provided to the activity are invalid.
InvalidArchiveEntry
There was an error reading archive entry.
InvalidArchiveFormat
Activity could not create an archiver for the supplied archiving format. This format might not be
supported by the activity.
InvalidBzipEntry
The bzip entry has more than one entry.
InvalidDateTime
Error occurred while parsing datetime from archive entries.
InvalidGzipEntry
The gzip entry has more than one entry.
InvalidNumInArchEntry
The numeric value in archive entry is not valid.
InvalidUnArchFormat
Activity could not create an unarchiver for the supplied archiving format. This format might not be
supported by the activity.
InvalidUnarchiveInput
The input to unarchive is invalid.
UnArchiverCreated
Activity has successfully created an unarchiver for unarchiving.
UnarchiveDone
Activity has successfully completed unarchiving.
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ValidationError
The input entries were not successfully validated against the schema.
ValidationFine
The input entries were successfully validated against the schema.

Parent topic: Archive Module
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ArchiveDone
Activity has successfully completed archiving.

Level : Info

Log Message : Archiving done successfully.

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oArchiveDoneEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 17

Variables

The ArchiveDone message contains the following variables:

Table 1. ArchiveDone Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Archive Operation Notifications
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ArchiveEntryBlank
Archive input entry does not have any content.

Level : Severe

Log Message : Input entry has no content or it's a blank entry.

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oArchiveEntryBlankEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 19

Variables

The ArchiveEntryBlank message contains the following variables:

Table 1. ArchiveEntryBlank Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Archive Operation Notifications
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ArchiverCreated
Activity has successfully created an archiver for archiving.

Level : Info

Log Message : Archiver created successfully, now performing archiving.

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oArchiverCreatedEv15
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 15

Variables

The ArchiverCreated message contains the following variables:

Table 1. ArchiverCreated Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Archive Operation Notifications
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ErrorIdentifyArchive
There was an error identifying the archive entry.

Level : Severe

Log Message : Error identifying archive. Message is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oErrorIdentifyArchiveEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 7

Variables

The ErrorIdentifyArchive message contains the following variables:

Table 1. ErrorIdentifyArchive Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Archive Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/archive/archive
_operation_erroridentifyarchive_message.html

ErrorUnZipOperation
There was an error performing unzip operation.

Level : Severe

Log Message : Error occurred while unzip operation. Message is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oErrorUnZipOperationEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 12

Variables

The ErrorUnZipOperation message contains the following variables:

Table 1. ErrorUnZipOperation Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Archive Operation Notifications
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ErrorZipOperation
There was an error performing zip operation.

Level : Severe

Log Message : Error occurred while zip operation. Message is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oErrorZipOperationEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2
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SNMP Trap Number : 11

Variables

The ErrorZipOperation message contains the following variables:

Table 1. ErrorZipOperation Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Archive Operation Notifications

Feedback | Notices

1214   



 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/archive/archive
_operation_errorzipoperation_message.html

IncorrectParameters
Parameters provided to the activity are invalid.

Level : Severe

Log Message : Binding parameters supplied are invalid.

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oIncorrectParametersEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 1

Variables

The IncorrectParameters message contains the following variables:

Table 1. IncorrectParameters Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Archive Operation Notifications
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InvalidArchiveEntry
There was an error reading archive entry.

Level : Severe

Log Message : Error while reading archive entry. Message is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oInvalidArchiveEntryEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 6

Variables

The InvalidArchiveEntry message contains the following variables:

Table 1. InvalidArchiveEntry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Archive Operation Notifications
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InvalidArchiveFormat
Activity could not create an archiver for the supplied archiving format. This format might not be supported by
the activity.

Level : Severe

Log Message : Could not find an Archiver for supplied archive type: {FormatName}

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oInvalidArchiveFormatEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2
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SNMP Trap Number : 2

Variables

The InvalidArchiveFormat message contains the following variables:

Table 1. InvalidArchiveFormat Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FormatName

The archive format which is not supported.

Type : String
SNMP Object Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oEv2FormatName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.4.1.2.1.2.1

Parent topic: Archive Operation Notifications

Feedback | Notices
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InvalidBzipEntry
The bzip entry has more than one entry.

Level : Severe

Log Message : More than one entries found for BZIP2 operation.

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oInvalidBzipEntryEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 9

Variables

The InvalidBzipEntry message contains the following variables:

Table 1. InvalidBzipEntry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Archive Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/archive/archive
_operation_invalidbzipentry_message.html

InvalidDateTime
Error occurred while parsing datetime from archive entries.

Level : Warning

Log Message : Error while parsing datetime from archive entries. Message is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oInvalidDateTimeEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 4

Variables

The InvalidDateTime message contains the following variables:

Table 1. InvalidDateTime Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Archive Operation Notifications
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InvalidGzipEntry
The gzip entry has more than one entry.

Level : Severe

Log Message : More than one entries found for GZIP operation.

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oInvalidGzipEntryEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2
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SNMP Trap Number : 8

Variables

The InvalidGzipEntry message contains the following variables:

Table 1. InvalidGzipEntry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Archive Operation Notifications
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InvalidNumInArchEntry
The numeric value in archive entry is not valid.

Level : Warning

Log Message : Invalid numeric value found in archive entries. Message is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oInvalidNumInArchEntryEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 5

Variables

The InvalidNumInArchEntry message contains the following variables:

Table 1. InvalidNumInArchEntry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Archive Operation Notifications
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InvalidUnArchFormat
Activity could not create an unarchiver for the supplied archiving format. This format might not be supported by
the activity.

Level : Severe

Log Message : Invalid or unsupported archive format.

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oInvalidUnArchFormatEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 3

Variables

The InvalidUnArchFormat message contains the following variables:

Table 1. InvalidUnArchFormat Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Archive Operation Notifications
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InvalidUnarchiveInput
The input to unarchive is invalid.

Level : Severe

Log Message : Error while reading archive. Message is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oInvalidUnarchiveInputEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 10

Variables

The InvalidUnarchiveInput message contains the following variables:
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Table 1. InvalidUnarchiveInput Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Archive Operation Notifications
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UnArchiverCreated
Activity has successfully created an unarchiver for unarchiving.

Level : Info

Log Message : Unarchiver created successfully, now performing unarchiving.

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oUnArchiverCreatedEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 16

Variables

The UnArchiverCreated message contains the following variables:

Table 1. UnArchiverCreated Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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UnarchiveDone
Activity has successfully completed unarchiving.

Level : Info

Log Message : unarchiving done successfully.

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oUnarchiveDoneEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 18

Variables

The UnarchiveDone message contains the following variables:

Table 1. UnarchiveDone Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Archive Operation Notifications
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ValidationError
The input entries were not successfully validated against the schema.

Level : Severe

Log Message : Input entries do not conform to the schema. Error Message is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oValidationErrorEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 14

Variables

The ValidationError message contains the following variables:

Table 1. ValidationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ValidationFine
The input entries were successfully validated against the schema.

Level : Info

Log Message : Input entries successfully validated against schema.
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System : Orchestration

SNMP Name : CASTIRON-COMP-ARCHIVE-MIB::ciC4oValidationFineEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.4.1.2

SNMP Trap Number : 13

Variables

The ValidationFine message contains the following variables:

Table 1. ValidationFine Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Archive Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013

 1231



file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/archive/archive
_operation_validationfine_message.html

Crypto Service Module
The Crypto Service Module provides activities that allow encrypting and decrypting the binary content. This
section contains details for the messages delivered from the Crypto Service Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Crypto Service Module.

MIB Name : CASTIRON-COMP-CRYPTOSERVICE-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.26

The following table provides an alphabetical list of all notifications that can be issued by the Crypto Service
Module.

Table 1. Notifications issued by the Crypto Service Module
Notification Level System Description

DecryptDone Info Orchestration Activity completed decrypting the content.

DecryptStarted Info Orchestration Activity started decrypting the content.

EncryptDone Info Orchestration Activity completed encrypting the content.

EncryptStarted Info Orchestration Activity started encrypting the content.

FoundPrivateKey Info Orchestration Crypto Service was successfully able to read the
private key from the java key store.

FoundPublicKey Info Orchestration Crypto Service was successfully able to read the
public key from the java key store.

IOException Severe Orchestration Activity could not read or write to one of the Input /
Output files.

InputEntryCount Info Orchestration Activity successfully filtered specified number of
entries.

IntegrityCheckFailed Info Orchestration Message failed integrity check.

IntegrityCheckPassed Info Orchestration Message passed integrity check.

InvalidAlgorithm Severe Orchestration Activity could not find key because of invalid
algorithm.

InvalidContent Severe Orchestration The input content cannot be empty.

InvalidDateFormat Severe Orchestration The date format is not valid. Enter date in dd-MM-
yyyy format

InvalidFormat Severe Orchestration Activity could not complete due invalid crypto format.

InvalidKeyOrPwd Severe Orchestration Activity could not find a specified key handle in the
java keystore with provided name and password.

InvalidKeyStore Severe Orchestration Activity could not find a specified entry in key store.
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Notification Level System Description

InvalidKeyhandle Severe Orchestration The input keyhandle cannot be empty.

InvalidPassword Severe Orchestration The input password cannot be empty.

NoIntegrityCheck Info Orchestration No Message integrity check.

PGPException Severe Orchestration PGP Exception.

Crypto Service Operation Notifications
Provides a comprehensive list of operation notifications sent from the Crypto Service Module.
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Crypto Service Operation Notifications
Provides a comprehensive list of operation notifications sent from the Crypto Service Module.

DecryptDone
Activity completed decrypting the content.
DecryptStarted
Activity started decrypting the content.
EncryptDone
Activity completed encrypting the content.
EncryptStarted
Activity started encrypting the content.
FoundPrivateKey
Crypto Service was successfully able to read the private key from the java key store.
FoundPublicKey
Crypto Service was successfully able to read the public key from the java key store.
IOException
Activity could not read or write to one of the Input / Output files.
InputEntryCount
Activity successfully filtered specified number of entries.
IntegrityCheckFailed
Message failed integrity check.
IntegrityCheckPassed
Message passed integrity check.
InvalidAlgorithm
Activity could not find key because of invalid algorithm.
InvalidContent
The input content cannot be empty.
InvalidDateFormat
The date format is not valid. Enter date in dd-MM-yyyy format
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InvalidFormat
Activity could not complete due invalid crypto format.
InvalidKeyOrPwd
Activity could not find a specified key handle in the java keystore with provided name and password.
InvalidKeyStore
Activity could not find a specified entry in key store.
InvalidKeyhandle
The input keyhandle cannot be empty.
InvalidPassword
The input password cannot be empty.
NoIntegrityCheck
No Message integrity check.
PGPException
PGP Exception.
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DecryptDone
Activity completed decrypting the content.

Level : Info

Log Message : Decryption Done.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oDecryptDoneEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 11

Variables

The DecryptDone message contains the following variables:

Table 1. DecryptDone Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html
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DecryptStarted
Activity started decrypting the content.

Level : Info

Log Message : Decryption Started.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oDecryptStartedEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2
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SNMP Trap Number : 10

Variables

The DecryptStarted message contains the following variables:

Table 1. DecryptStarted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html
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ryptoservice_operation_decryptstarted_message.html
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EncryptDone
Activity completed encrypting the content.

Level : Info

Log Message : Encryption Done

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oEncryptDoneEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 9

Variables

The EncryptDone message contains the following variables:

Table 1. EncryptDone Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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Parent topic: Crypto Service Operation Notifications
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EncryptStarted
Activity started encrypting the content.

Level : Info

Log Message : Encryption Started.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oEncryptStartedEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 8

Variables

The EncryptStarted message contains the following variables:

Table 1. EncryptStarted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications

Feedback | Notices
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FoundPrivateKey
Crypto Service was successfully able to read the private key from the java key store.

Level : Info

Log Message : Successfully Read Private Key.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oFoundPrivateKeyEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 2

Variables

The FoundPrivateKey message contains the following variables:

Table 1. FoundPrivateKey Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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FoundPublicKey
Crypto Service was successfully able to read the public key from the java key store.

Level : Info

Log Message : Successfully Read Public Key.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oFoundPublicKeyEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 1
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Variables

The FoundPublicKey message contains the following variables:

Table 1. FoundPublicKey Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications

Feedback | Notices
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IOException
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Activity could not read or write to one of the Input / Output files.

Level : Severe

Log Message : InputOutput Exception. {0}

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oIOExceptionEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 6

Variables

The IOException message contains the following variables:

Table 1. IOException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications
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InputEntryCount
Activity successfully filtered specified number of entries.

Level : Info

Log Message : Filtered {NumberOfEntries} entries

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oInputEntryCountEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 12

Variables

The InputEntryCount message contains the following variables:

Table 1. InputEntryCount Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfEntries

Number of entries filtered by the activity.

Type : Integer
SNMP Object Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oEv12NumberOfEntries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.26.1.2.1.12.1
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IntegrityCheckFailed
Message failed integrity check.

Level : Info

Log Message : Integrity check failed.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oIntegrityCheckFailedEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 19

Variables

The IntegrityCheckFailed message contains the following variables:

Table 1. IntegrityCheckFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications
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IntegrityCheckPassed
Message passed integrity check.

Level : Info

Log Message : Integrity check passed.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oIntegrityCheckPassedEv18
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 18

Variables

The IntegrityCheckPassed message contains the following variables:

Table 1. IntegrityCheckPassed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications
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InvalidAlgorithm
Activity could not find key because of invalid algorithm.

Level : Severe

Log Message : Invalid Key Store.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oInvalidAlgorithmEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 5

Variables

The InvalidAlgorithm message contains the following variables:

Table 1. InvalidAlgorithm Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

 1247



Parent topic: Crypto Service Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/cryptoservice/c
ryptoservice_operation_invalidalgorithm_message.html

InvalidContent
The input content cannot be empty.

Level : Severe

Log Message : Invalid Content

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oInvalidContentEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 13

Variables

The InvalidContent message contains the following variables:

Table 1. InvalidContent Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications
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InvalidDateFormat
The date format is not valid. Enter date in dd-MM-yyyy format

Level : Severe

Log Message : Invalid Date Format

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oInvalidDateFormatEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 16

Variables

The InvalidDateFormat message contains the following variables:

Table 1. InvalidDateFormat Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications
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InvalidFormat
Activity could not complete due invalid crypto format.

Level : Severe

Log Message : IO Exception.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oInvalidFormatEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 7
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Variables

The InvalidFormat message contains the following variables:

Table 1. InvalidFormat Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html
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InvalidKeyOrPwd
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Activity could not find a specified key handle in the java keystore with provided name and password.

Level : Severe

Log Message : Invalid Key Handle or Password . {KeyHandleName}

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oInvalidKeyOrPwdEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 3

Variables

The InvalidKeyOrPwd message contains the following variables:

Table 1. InvalidKeyOrPwd Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. KeyHandleName

KeyHandle Name used to Encrypt / Decrypt the content.
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Type : String
SNMP Object Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oEv3KeyHandleName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.26.1.2.1.3.1

Parent topic: Crypto Service Operation Notifications

Feedback | Notices
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InvalidKeyStore
Activity could not find a specified entry in key store.

Level : Severe

Log Message : Invalid Key Store. {KeyHandleName}

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oInvalidKeyStoreEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 4

Variables

The InvalidKeyStore message contains the following variables:

Table 1. InvalidKeyStore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. KeyHandleName

KeyHandle Name used to Encrypt / Decrypt the content.

Type : String
SNMP Object Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oEv4KeyHandleName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.26.1.2.1.4.1

Parent topic: Crypto Service Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/cryptoservice/c
ryptoservice_operation_invalidkeystore_message.html

InvalidKeyhandle
The input keyhandle cannot be empty.

Level : Severe

Log Message : Invalid Keyhandle. {KeyHandleName}

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oInvalidKeyhandleEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 14

Variables
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The InvalidKeyhandle message contains the following variables:

Table 1. InvalidKeyhandle Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. KeyHandleName

KeyHandle Name used to Encrypt / Decrypt the content.

Type : String
SNMP Object Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oEv14KeyHandleName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.26.1.2.1.14.1

Parent topic: Crypto Service Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html
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http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/cryptoservice/c
ryptoservice_operation_invalidkeyhandle_message.html

InvalidPassword
The input password cannot be empty.

Level : Severe

Log Message : Invalid Password.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oInvalidPasswordEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 15

Variables

The InvalidPassword message contains the following variables:

Table 1. InvalidPassword Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications

Feedback | Notices
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NoIntegrityCheck
No Message integrity check.

Level : Info

Log Message : No Message integrity check.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oNoIntegrityCheckEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 20

Variables

The NoIntegrityCheck message contains the following variables:

Table 1. NoIntegrityCheck Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/cryptoservice/c
ryptoservice_operation_nointegritycheck_message.html

PGPException
PGP Exception.

Level : Severe

Log Message : PGP Exception.

System : Orchestration

SNMP Name : CASTIRON-COMP-CRYPTOSERVICE-MIB::ciC26oPGPExceptionEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.26.1.2

SNMP Trap Number : 17

Variables

The PGPException message contains the following variables:

Table 1. PGPException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Crypto Service Operation Notifications

Feedback | Notices
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Data Module
The Data Module provides activities for serializing and parsing textual and binary data. This section contains
details for the messages delivered from the Data Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Data Module.

MIB Name : CASTIRON-COMP-DATA-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.16

The following table provides an alphabetical list of all notifications that can be issued by the Data Module.
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Table 1. Notifications issued by the Data Module
Notification Level System Description

BadEncoding Severe Orchestration Encoding parameter specified is not supported by the
activity.

MissingEncParse Severe Orchestration Encoding parameter was not set and there was no
value specified in configuration.

MissingEncSerialize Severe Orchestration Encoding parameter was not set and there was no
value specified in configuration.

ParsingError Severe Orchestration Error occurred while parsing the error.

SerializeError Severe Orchestration Error occurred while serializing.

SerializeIOError Severe Orchestration IO Error occurred while serializing.

Data Operation Notifications
Provides a comprehensive list of operation notifications sent from the Data Module.

Feedback | Notices

 Last updated: Thursday, December 17, 2015
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/data/about_the
_data_module.html

Data Operation Notifications
Provides a comprehensive list of operation notifications sent from the Data Module.

BadEncoding
Encoding parameter specified is not supported by the activity.
MissingEncParse
Encoding parameter was not set and there was no value specified in configuration.
MissingEncSerialize
Encoding parameter was not set and there was no value specified in configuration.
ParsingError
Error occurred while parsing the error.
SerializeError
Error occurred while serializing.
SerializeIOError
IO Error occurred while serializing.

Parent topic: Data Module

Feedback | Notices
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BadEncoding
Encoding parameter specified is not supported by the activity.

Level : Severe

Log Message : Encoding parameter not supported: {Encoding}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATA-MIB::ciC16oBadEncodingEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.16.1.2

SNMP Trap Number : 3

Variables

The BadEncoding message contains the following variables:

Table 1. BadEncoding Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Encoding

The encoding parameter not supported by the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-DATA-MIB::ciC16oEv3Encoding
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.16.1.2.1.3.1

Parent topic: Data Operation Notifications

Feedback | Notices
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MissingEncParse
Encoding parameter was not set and there was no value specified in configuration.

Level : Severe

Log Message : Encoding parameter not set and no value specified in configuration

System : Orchestration

SNMP Name : CASTIRON-COMP-DATA-MIB::ciC16oMissingEncParseEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.16.1.2

SNMP Trap Number : 2

Variables

The MissingEncParse message contains the following variables:

Table 1. MissingEncParse Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Data Operation Notifications

Feedback | Notices
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MissingEncSerialize
Encoding parameter was not set and there was no value specified in configuration.

Level : Severe

Log Message : Encoding parameter not set and no value specified in configuration

System : Orchestration

SNMP Name : CASTIRON-COMP-DATA-MIB::ciC16oMissingEncSerializeEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.16.1.2
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SNMP Trap Number : 6

Variables

The MissingEncSerialize message contains the following variables:

Table 1. MissingEncSerialize Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Data Operation Notifications

Feedback | Notices
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ParsingError
Error occurred while parsing the error.

Level : Severe

Log Message : Parsing Error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATA-MIB::ciC16oParsingErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.16.1.2

SNMP Trap Number : 1

Variables

The ParsingError message contains the following variables:

Table 1. ParsingError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Data Operation Notifications

Feedback | Notices
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SerializeError
Error occurred while serializing.

Level : Severe

Log Message : Serialization Error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATA-MIB::ciC16oSerializeErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.16.1.2

SNMP Trap Number : 4

Variables

The SerializeError message contains the following variables:

Table 1. SerializeError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Data Operation Notifications

Feedback | Notices
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SerializeIOError
IO Error occurred while serializing.

Level : Severe

Log Message : Serialization Error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATA-MIB::ciC16oSerializeIOErrorEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.16.1.2
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SNMP Trap Number : 5

Variables

The SerializeIOError message contains the following variables:

Table 1. SerializeIOError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Data Operation Notifications

Feedback | Notices
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Data Quality Module
The Data Quality Module provides activities to validate and cleanse data records. This section contains details
for the messages delivered from the Data Quality Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Data Quality Module.

MIB Name : CASTIRON-COMP-DQ-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.14

The following table provides an alphabetical list of all notifications that can be issued by the Data Quality
Module.

Table 1. Notifications issued by the Data Quality Module
Notification Level System Description

BadPreloadQuery Warning Orchestration Activity could not execute query to preload lookup
cache.

DQLookupFuzzyOnCloud Severe Orchestration Data Quality Lookup activity with Fuzzy option is not
supported in cloud

FilterError Severe Orchestration Activity failed to filter data.

InputEntryCount Info Orchestration Activity successfully filtered specified number of
entries.

LeftMergeInputEntry Info Orchestration Activity successfully merged specified number of
entries.

LookUpEntryCount Info Orchestration Activity successfully looked up specified number of
entries.

LookUpError Severe Orchestration Activity failed to perform lookup for data.

MergeError Severe Orchestration Activity failed to merge data.

NoAssetsError Severe Orchestration Failed to perform lookup for data, database assets
may not have been created.

NoPreloadedCache Info Orchestration Lookup cache was not preloaded by the activity.

OutputEntryCount Info Orchestration Activity successfully outputted specified number of
entries.

PreloadedCache Info Orchestration Lookup cache was preloaded by activity with
specified number of entries.

RightMergeInputEntry Info Orchestration Activity successfully merged specified number of
entries.
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Notification Level System Description

SortError Severe Orchestration Activity failed to sort data.

SortInputEntryCount Info Orchestration Activity successfully sorted specified number of
entries.

Data Quality Operation Notifications
Provides a comprehensive list of operation notifications sent from the Data Quality Module.
Data Quality Internal Notifications
Provides a comprehensive list of internal notifications sent from the Data Quality Module.

Feedback | Notices
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Data Quality Operation Notifications
Provides a comprehensive list of operation notifications sent from the Data Quality Module.

BadPreloadQuery
Activity could not execute query to preload lookup cache.
FilterError
Activity failed to filter data.
InputEntryCount
Activity successfully filtered specified number of entries.
LeftMergeInputEntry
Activity successfully merged specified number of entries.
LookUpEntryCount
Activity successfully looked up specified number of entries.
LookUpError
Activity failed to perform lookup for data.
MergeError
Activity failed to merge data.
NoAssetsError
Failed to perform lookup for data, database assets may not have been created.
NoPreloadedCache
Lookup cache was not preloaded by the activity.
OutputEntryCount
Activity successfully outputted specified number of entries.
PreloadedCache
Lookup cache was preloaded by activity with specified number of entries.
RightMergeInputEntry
Activity successfully merged specified number of entries.
SortError
Activity failed to sort data.
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SortInputEntryCount
Activity successfully sorted specified number of entries.

Parent topic: Data Quality Module

Feedback | Notices
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BadPreloadQuery
Activity could not execute query to preload lookup cache.

Level : Warning

Log Message : Could not execute query to preload lookup cache

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oBadPreloadQueryEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 6

Variables

The BadPreloadQuery message contains the following variables:

Table 1. BadPreloadQuery Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Data Quality Operation Notifications

Feedback | Notices
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FilterError
Activity failed to filter data.

Level : Severe

Log Message : Failed to filter data, error was: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oFilterErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 1

Variables

The FilterError message contains the following variables:

Table 1. FilterError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Data Quality Operation Notifications
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InputEntryCount
Activity successfully filtered specified number of entries.
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Level : Info

Log Message : Filtered {NumberOfEntries} entries

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oInputEntryCountEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 2

Variables

The InputEntryCount message contains the following variables:

Table 1. InputEntryCount Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfEntries

Number of entries filtered by the activity.

Type : Integer
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SNMP Object Name : CASTIRON-COMP-DQ-MIB::ciC14oEv2NumberOfEntries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.14.1.2.1.2.1

Parent topic: Data Quality Operation Notifications
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LeftMergeInputEntry
Activity successfully merged specified number of entries.

Level : Info

Log Message : Merged {NumberOfEntries} left entries

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oLeftMergeInputEntryEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 11

Variables

The LeftMergeInputEntry message contains the following variables:

Table 1. LeftMergeInputEntry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfEntries

Number of entries merged by the activity.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DQ-MIB::ciC14oEv11NumberOfEntries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.14.1.2.1.11.1

Parent topic: Data Quality Operation Notifications

Feedback | Notices
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LookUpEntryCount
Activity successfully looked up specified number of entries.

Level : Info

Log Message : Looked up {NumberOfEntries} entries

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oLookUpEntryCountEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 7

Variables
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The LookUpEntryCount message contains the following variables:

Table 1. LookUpEntryCount Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfEntries

Number of entries looked up by the activity.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DQ-MIB::ciC14oEv7NumberOfEntries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.14.1.2.1.7.1

Parent topic: Data Quality Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

 1277



http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/dq/dq_operatio
n_lookupentrycount_message.html

LookUpError
Activity failed to perform lookup for data.

Level : Severe

Log Message : Failed to perform lookup for data, error was: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oLookUpErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 4

Variables

The LookUpError message contains the following variables:

Table 1. LookUpError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Data Quality Operation Notifications

Feedback | Notices
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MergeError
Activity failed to merge data.

Level : Severe

Log Message : Failed to merge data, error was: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oMergeErrorEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 10

Variables

The MergeError message contains the following variables:

Table 1. MergeError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Data Quality Operation Notifications

Feedback | Notices
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NoAssetsError
Failed to perform lookup for data, database assets may not have been created.

Level : Severe

Log Message : Failed to perform lookup for data, database assets may not have been created

System : Orchestration
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SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oNoAssetsErrorEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 5

Variables

The NoAssetsError message contains the following variables:

Table 1. NoAssetsError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Data Quality Operation Notifications

Feedback | Notices
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NoPreloadedCache
Lookup cache was not preloaded by the activity.

Level : Info

Log Message : Lookup cache not preloaded

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oNoPreloadedCacheEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 8

Variables

The NoPreloadedCache message contains the following variables:

Table 1. NoPreloadedCache Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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OutputEntryCount
Activity successfully outputted specified number of entries.

Level : Info

Log Message : Emitted {NumberOfEntries} entries to ''{Target}''

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oOutputEntryCountEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 3

Variables

The OutputEntryCount message contains the following variables:

Table 1. OutputEntryCount Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfEntries

Number of entries outputted by the activity.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DQ-MIB::ciC14oEv3NumberOfEntries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.14.1.2.1.3.1

6. Target

Output variable where entries were placed.

Type : String
SNMP Object Name : CASTIRON-COMP-DQ-MIB::ciC14oEv3Target
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.14.1.2.1.3.2

Parent topic: Data Quality Operation Notifications
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 Last updated: Thursday, November 14, 2013
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PreloadedCache
Lookup cache was preloaded by activity with specified number of entries.

Level : Info

Log Message : Lookup cache preloaded with {NumberOfEntries} entries

System : Orchestration
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SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oPreloadedCacheEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 9

Variables

The PreloadedCache message contains the following variables:

Table 1. PreloadedCache Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfEntries

Number of entries preloaded up by the activity.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DQ-MIB::ciC14oEv9NumberOfEntries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.14.1.2.1.9.1

Parent topic: Data Quality Operation Notifications
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RightMergeInputEntry
Activity successfully merged specified number of entries.

Level : Info

Log Message : Merged {NumberOfEntries} right entries

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oRightMergeInputEntryEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 12

Variables

The RightMergeInputEntry message contains the following variables:

Table 1. RightMergeInputEntry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfEntries

Number of entries merged by the activity.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DQ-MIB::ciC14oEv12NumberOfEntries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.14.1.2.1.12.1

Parent topic: Data Quality Operation Notifications
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SortError
Activity failed to sort data.

Level : Severe

Log Message : Failed to sort data, error was: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oSortErrorEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 13

Variables

The SortError message contains the following variables:

Table 1. SortError Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Data Quality Operation Notifications
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SortInputEntryCount
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Activity successfully sorted specified number of entries.

Level : Info

Log Message : Sorted {NumberOfEntries} entries

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14oSortInputEntryCountEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.2

SNMP Trap Number : 14

Variables

The SortInputEntryCount message contains the following variables:

Table 1. SortInputEntryCount Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfEntries

Number of entries sorted by the activity.

 1289



Type : Integer
SNMP Object Name : CASTIRON-COMP-DQ-MIB::ciC14oEv14NumberOfEntries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.14.1.2.1.14.1

Parent topic: Data Quality Operation Notifications
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Data Quality Internal Notifications
Provides a comprehensive list of internal notifications sent from the Data Quality Module.

DQLookupFuzzyOnCloud
Data Quality Lookup activity with Fuzzy option is not supported in cloud

Parent topic: Data Quality Module
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DQLookupFuzzyOnCloud
Data Quality Lookup activity with Fuzzy option is not supported in cloud

Level : Severe

Log Message : Data Quality Lookup activity with Fuzzy option is not supported in cloud

System : Orchestration

SNMP Name : CASTIRON-COMP-DQ-MIB::ciC14iDQLookupFuzzyOnCloudEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.14.1.3

SNMP Trap Number : 1

Variables
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The DQLookupFuzzyOnCloud message contains the following variables:

Table 1. DQLookupFuzzyOnCloud Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Data Quality Internal Notifications
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Database Module
The Database Module provides activities for accessing various SQL databases. This section contains details for
the messages delivered from the Database Module.
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This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Database Module.

MIB Name : CASTIRON-COMP-DATABASE-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.2

The following table provides an alphabetical list of all notifications that can be issued by the Database Module.

Table 1. Notifications issued by the Database Module
Notification Level System Description

ActivateError Severe Orchestration A problem occurred while activating the activity.

ConnectionError Warning Orchestration An error occurred while connecting to the database
endpoint.

ConnectionRetry Warning Orchestration An error occurred while attempting to connect to the
database.

DataSourceHashCode Info Orchestration Information regarding the hash code used to register
the datasource.

DataSourceRegistered Info Orchestration Information about the datasource name registered
with the system.

DateTimeParseError Severe Orchestration Unable to parse the date and time

DeleteRowsError Severe Orchestration An exception occurred while deleting the row from
the control table.

DeleteRowsFailure Severe Orchestration Unable to delete rows from the buffer table.

DeleteSQL Info Orchestration The delete query issued to the buffer table.

DeleteSQLWithId Info Orchestration The delete query, with id, issued to the buffer table.

ErrorDeletePost Severe Orchestration An exception occurred while deleting the row from
the control table due to a connection error.

ErrorSingleTableJob Severe Orchestration An exception occurred while processing a
SingleTableNotification job

InboundOperationError Severe Orchestration An error occurred while executing the inbound job.

InsertTableStatement Info Orchestration An insert statement was issued to the control table.

JDBCConnectionClose Warning Orchestration An error occurred while closing the connection in the
exception path.

MaxRowExceeded Info Orchestration The maximum number of rows for one poll on the
table was reached. If this happens frequently, it is
advisable to alter the threshold

MethodNotFound Info Orchestration Unable to invoke the method specified in the
connection properties.

OperationNameAbsent Severe Orchestration The buffer table contains the operation but there is no
activity in the orchestration for that operation. This is
not a valid configuration.

OutboundActivateError Severe Orchestration A problem occurred while activating the database
outbound activity.
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Notification Level System Description

ParamQueryActivate Severe Orchestration An exception occurred while activating the
parameterized query activity.

ParamQueryError Severe Orchestration An error occurred while processing the message for
the parameterized query activity.

ParameterizedQuery Info Orchestration The query for the parameterized query activity.

PollTblActivateError Severe Orchestration A problem occurred while activating the database poll
table activity.

QueryString Info Orchestration The query which was issued for buffer table.

RedeliverSkip Warning Orchestration This row is already delivered to the database and will
be skipped now.

SelectStatement Info Orchestration A select statement was issued to the control table to
check for duplicate rows.

SetQueryTimeout Warning Orchestration Unable to set the query time out for the database.

StoredProcActivate Severe Orchestration An exception occurred while activating the stored
procedure activity.

StoredProcException Severe Orchestration A data error occurred while processing an outbound
job in the stored procedure activity.

StoredProcQuery Info Orchestration The stored procedure query issued to the database.

UnexpectedEmptyRows Warning Orchestration An unexpected result returned from the buffer table.
Expecting rows to present in result, instead the result
is empty.

UpdateQuery Info Orchestration The update query issued to the buffer table for
marking rows.

Database Connection Notifications
Provides a comprehensive list of connection notifications sent from the Database Module.
Database Operation Notifications
Provides a comprehensive list of operation notifications sent from the Database Module.
Database Internal Notifications
Provides a comprehensive list of internal notifications sent from the Database Module.

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html
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_the_database_module.html

Database Connection Notifications
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Provides a comprehensive list of connection notifications sent from the Database Module.

ConnectionError
An error occurred while connecting to the database endpoint.
ConnectionRetry
An error occurred while attempting to connect to the database.
JDBCConnectionClose
An error occurred while closing the connection in the exception path.
SetQueryTimeout
Unable to set the query time out for the database.

Parent topic: Database Module

Feedback | Notices
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ConnectionError
An error occurred while connecting to the database endpoint.

Level : Warning

Log Message : An error occurred while connecting to the database. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2cConnectionErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.1

SNMP Trap Number : 1

Variables

The ConnectionError message contains the following variables:

Table 1. ConnectionError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Connection Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/database/datab
ase_connection_connectionerror_message.html

ConnectionRetry
An error occurred while attempting to connect to the database.

Level : Warning

Log Message : An error occurred while connecting to the database. The exception is {Message} The job is retrying:
{RetryAttemptNumber} out of {TotalRetryAttempts} attempts to connect to the database . Another attempt will be
made after {IntervalForRetries} secs.
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System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2cConnectionRetryEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.1

SNMP Trap Number : 2

Variables

The ConnectionRetry message contains the following variables:

Table 1. ConnectionRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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6. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2cEv2RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.1.1.2.2

7. TotalRetryAttempts

The specified number of times to attempt connecting to the database before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2cEv2TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.1.1.2.3

8. IntervalForRetries

The specified amount of time to wait between attempts to connect to the database.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2cEv2IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.1.1.2.4

Parent topic: Database Connection Notifications
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JDBCConnectionClose
An error occurred while closing the connection in the exception path.

Level : Warning

Log Message : An error occurred while closing the connection in the exception path. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2cJDBCConnectionCloseEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.1

SNMP Trap Number : 4

Variables
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The JDBCConnectionClose message contains the following variables:

Table 1. JDBCConnectionClose Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Connection Notifications
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http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/database/datab
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SetQueryTimeout
Unable to set the query time out for the database.

Level : Warning

Log Message : Unable to set the query time out for database {DBType}. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2cSetQueryTimeoutEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.1

SNMP Trap Number : 3

Variables

The SetQueryTimeout message contains the following variables:

Table 1. SetQueryTimeout Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DBType

The type of database

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2cEv3DBType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.1.1.3.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Connection Notifications
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Database Operation Notifications
Provides a comprehensive list of operation notifications sent from the Database Module.

ActivateError
A problem occurred while activating the activity.
DataSourceHashCode
Information regarding the hash code used to register the datasource.
DataSourceRegistered
Information about the datasource name registered with the system.
DateTimeParseError
Unable to parse the date and time
DeleteRowsError
An exception occurred while deleting the row from the control table.
DeleteRowsFailure
Unable to delete rows from the buffer table.
DeleteSQL
The delete query issued to the buffer table.
DeleteSQLWithId
The delete query, with id, issued to the buffer table.
ErrorDeletePost
An exception occurred while deleting the row from the control table due to a connection error.
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ErrorSingleTableJob
An exception occurred while processing a SingleTableNotification job
InboundOperationError
An error occurred while executing the inbound job.
InsertTableStatement
An insert statement was issued to the control table.
MaxRowExceeded
The maximum number of rows for one poll on the table was reached. If this happens frequently, it is
advisable to alter the threshold
MethodNotFound
Unable to invoke the method specified in the connection properties.
OperationNameAbsent
The buffer table contains the operation but there is no activity in the orchestration for that operation.
This is not a valid configuration.
OutboundActivateError
A problem occurred while activating the database outbound activity.
ParamQueryActivate
An exception occurred while activating the parameterized query activity.
ParamQueryError
An error occurred while processing the message for the parameterized query activity.
ParameterizedQuery
The query for the parameterized query activity.
PollTblActivateError
A problem occurred while activating the database poll table activity.
QueryString
The query which was issued for buffer table.
RedeliverSkip
This row is already delivered to the database and will be skipped now.
SelectStatement
A select statement was issued to the control table to check for duplicate rows.
StoredProcException
A data error occurred while processing an outbound job in the stored procedure activity.
StoredProcQuery
The stored procedure query issued to the database.
UpdateQuery
The update query issued to the buffer table for marking rows.
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ActivateError
A problem occurred while activating the activity.

 1301



Level : Severe

Log Message : Exception while activating the database inbound activity.Exception is : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oActivateErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 2

Variables

The ActivateError message contains the following variables:

Table 1. ActivateError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String

1302   



SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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DataSourceHashCode
Information regarding the hash code used to register the datasource.

Level : Info

Log Message : The datasource with the name {DataSourceName} is registered with hash code: {HashCodeName}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oDataSourceHashCodeEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 19

Variables

The DataSourceHashCode message contains the following variables:

Table 1. DataSourceHashCode Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DataSourceName

The name of the datasource

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv19DataSourceName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.19.1

6. HashCodeName

The name of the hash code used to register the datasource.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv19HashCodeName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.19.2
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DataSourceRegistered
Information about the datasource name registered with the system.

Level : Info

Log Message : The following datasource name is registered with the system.

System : Orchestration
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SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oDataSourceRegisteredEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 20

Variables

The DataSourceRegistered message contains the following variables:

Table 1. DataSourceRegistered Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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DateTimeParseError
Unable to parse the date and time

Level : Severe

Log Message : Unable to parse the date and time: {DateTimeValue} {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oDateTimeParseErrorEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 21

Variables

The DateTimeParseError message contains the following variables:

Table 1. DateTimeParseError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID

1306   



SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DateTimeValue

The value of date and time when the parsing error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv21DateTimeValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.21.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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DeleteRowsError
An exception occurred while deleting the row from the control table.

Level : Severe

Log Message : An exception occurred while deleting the row from the control table. The exception is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oDeleteRowsErrorEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 18

Variables

The DeleteRowsError message contains the following variables:

Table 1. DeleteRowsError Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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DeleteRowsFailure
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Unable to delete rows from the buffer table.

Level : Severe

Log Message : Unable to delete rows from buffer table {TableName}.

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oDeleteRowsFailureEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 9

Variables

The DeleteRowsFailure message contains the following variables:

Table 1. DeleteRowsFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TableName

Name of the buffer table.
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Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv9TableName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.9.1
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DeleteSQL
The delete query issued to the buffer table.

Level : Info

Log Message : The delete query issued to the buffer table is {Query}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oDeleteSQLEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 5

Variables

The DeleteSQL message contains the following variables:

Table 1. DeleteSQL Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Query

The query string.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv5Query
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.5.1
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DeleteSQLWithId
The delete query, with id, issued to the buffer table.

Level : Info

Log Message : The delete query, with id, issued to the buffer table is {Query}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oDeleteSQLWithIdEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 4

Variables
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The DeleteSQLWithId message contains the following variables:

Table 1. DeleteSQLWithId Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Query

The query string.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv4Query
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.4.1
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ErrorDeletePost
An exception occurred while deleting the row from the control table due to a connection error.

Level : Severe

Log Message : An exception occurred while deleting the row from the control table. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oErrorDeletePostEv24

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 24

Variables

The ErrorDeletePost message contains the following variables:

Table 1. ErrorDeletePost Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ErrorSingleTableJob
An exception occurred while processing a SingleTableNotification job

Level : Severe

Log Message : An exception occurred while processing a SingleTableNotification job. Data error at row number
{RowNumber} of table {TableName}. The Error is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oErrorSingleTableJobEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 23

Variables

The ErrorSingleTableJob message contains the following variables:

Table 1. ErrorSingleTableJob Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. RowNumber

The table row number where the error occurred.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv23RowNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.23.1

6. TableName

The table name where the error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv23TableName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.23.2

7. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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InboundOperationError
An error occurred while executing the inbound job.

Level : Severe

Log Message : An exception occurred while processing the inbound job: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oInboundOperationErrorEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 22

Variables

The InboundOperationError message contains the following variables:

Table 1. InboundOperationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Operation Notifications

Feedback | Notices
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InsertTableStatement
An insert statement was issued to the control table.

Level : Info

Log Message : An insert statement was issued to the control table. {TableName}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oInsertTableStatementEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 10

Variables

The InsertTableStatement message contains the following variables:

Table 1. InsertTableStatement Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TableName

The control table to which the insert statement was issued.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv10TableName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.10.1

Parent topic: Database Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html
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MaxRowExceeded
The maximum number of rows for one poll on the table was reached. If this happens frequently, it is advisable
to alter the threshold
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Level : Info

Log Message : The maximum number of rows for one poll on table {TableName} was reached. If this is a frequent
occurrence, then alter the threshold!

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oMaxRowExceededEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 8

Variables

The MaxRowExceeded message contains the following variables:

Table 1. MaxRowExceeded Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TableName

The name of the table for which the threshold was reached.
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Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv8TableName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.8.1

Parent topic: Database Operation Notifications
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MethodNotFound
Unable to invoke the method specified in the connection properties.

Level : Info

Log Message : Unable to invoke method {MethodName} on the data source object. This might cause unexpected
behavior. Please check the connection properties

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oMethodNotFoundEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 7

Variables

The MethodNotFound message contains the following variables:

Table 1. MethodNotFound Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MethodName

Name of the method.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv7MethodName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.7.1

Parent topic: Database Operation Notifications
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OperationNameAbsent
The buffer table contains the operation but there is no activity in the orchestration for that operation. This is
not a valid configuration.

Level : Severe

Log Message : The buffer table contains the {OperationName} operation but there is no activity in the
orchestration for that operation. This is not a valid configuration.

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oOperationNameAbsentEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2
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SNMP Trap Number : 1

Variables

The OperationNameAbsent message contains the following variables:

Table 1. OperationNameAbsent Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OperationName

The name of the operation which was not found

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv1OperationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.1.1

Parent topic: Database Operation Notifications

Feedback | Notices
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OutboundActivateError
A problem occurred while activating the database outbound activity.

Level : Severe

Log Message : Exception while activating the database outbound activity.Exception is : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oOutboundActivateErrorEv25

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 25

Variables

The OutboundActivateError message contains the following variables:

Table 1. OutboundActivateError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Operation Notifications
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ParamQueryActivate
An exception occurred while activating the parameterized query activity.

Level : Severe

Log Message : An exception occurred while activating the parameterized query activity. The exception is:
{Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oParamQueryActivateEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 13

Variables

The ParamQueryActivate message contains the following variables:

Table 1. ParamQueryActivate Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Operation Notifications
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ParamQueryError
An error occurred while processing the message for the parameterized query activity.
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Level : Severe

Log Message : An error occurred while processing the message for the parameterized query activity at row
number {RowNumber}. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oParamQueryErrorEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 15

Variables

The ParamQueryError message contains the following variables:

Table 1. ParamQueryError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. RowNumber

The row number at which the error occurred.
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Type : Integer
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv15RowNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.15.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Operation Notifications
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ParameterizedQuery
The query for the parameterized query activity.

Level : Info

Log Message : The query for the parameterized query activity is: {QueryString}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oParameterizedQueryEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 14

Variables

The ParameterizedQuery message contains the following variables:

Table 1. ParameterizedQuery Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueryString

The exact query string.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv14QueryString
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.14.1

Parent topic: Database Operation Notifications
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PollTblActivateError
A problem occurred while activating the database poll table activity.

Level : Severe

Log Message : Exception while activating the database poll table activity.Exception is : {Message}

System : Orchestration
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SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oPollTblActivateErrorEv26

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 26

Variables

The PollTblActivateError message contains the following variables:

Table 1. PollTblActivateError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Operation Notifications

 1329



Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/database/datab
ase_operation_polltblactivateerror_message.html

QueryString
The query which was issued for buffer table.

Level : Info

Log Message : The select query issued for the buffer table is {Query}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oQueryStringEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 3

Variables

The QueryString message contains the following variables:

Table 1. QueryString Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Query

The query string.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv3Query
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.3.1
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RedeliverSkip
This row is already delivered to the database and will be skipped now.

Level : Warning

Log Message : The row is already delivered to the database. Skipping it.

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oRedeliverSkipEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 12

Variables

The RedeliverSkip message contains the following variables:

Table 1. RedeliverSkip Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Database Operation Notifications
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SelectStatement
A select statement was issued to the control table to check for duplicate rows.

Level : Info

Log Message : A select statement was issued to control table {TableName} to check for duplicate rows.

System : Orchestration
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SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oSelectStatementEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 11

Variables

The SelectStatement message contains the following variables:

Table 1. SelectStatement Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TableName

The control table to which the select statement was issued.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv11TableName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.11.1

Parent topic: Database Operation Notifications
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StoredProcException
A data error occurred while processing an outbound job in the stored procedure activity.

Level : Severe

Log Message : An exception occurred while processing an outbound job in the stored procedure activity. Data
error at row number: {RowNumber}. The error is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oStoredProcExceptionEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 16

Variables

The StoredProcException message contains the following variables:

Table 1. StoredProcException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. RowNumber

The row number at which the error occurred.

Type : Integer
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv16RowNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.16.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Operation Notifications
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StoredProcQuery
The stored procedure query issued to the database.

Level : Info

Log Message : The stored procedure query issued to the database is {QueryString}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oStoredProcQueryEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2
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SNMP Trap Number : 17

Variables

The StoredProcQuery message contains the following variables:

Table 1. StoredProcQuery Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueryString

The exact query string issued to the database.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv17QueryString
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.17.1

Parent topic: Database Operation Notifications

Feedback | Notices

1336   



 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/database/datab
ase_operation_storedprocquery_message.html

UpdateQuery
The update query issued to the buffer table for marking rows.

Level : Info

Log Message : The update query issued to the buffer table for marking rows is {Query}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2oUpdateQueryEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.2

SNMP Trap Number : 6

Variables

The UpdateQuery message contains the following variables:

Table 1. UpdateQuery Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Query

The query string.

Type : String
SNMP Object Name : CASTIRON-COMP-DATABASE-MIB::ciC2oEv6Query
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.2.1.2.1.6.1

Parent topic: Database Operation Notifications
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Database Internal Notifications
Provides a comprehensive list of internal notifications sent from the Database Module.

StoredProcActivate
An exception occurred while activating the stored procedure activity.
UnexpectedEmptyRows
An unexpected result returned from the buffer table. Expecting rows to present in result, instead the
result is empty.

Parent topic: Database Module
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StoredProcActivate
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An exception occurred while activating the stored procedure activity.

Level : Severe

Log Message : An exception occurred while activating the stored procedure activity. The exception is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2iStoredProcActivateEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.3

SNMP Trap Number : 2

Variables

The StoredProcActivate message contains the following variables:

Table 1. StoredProcActivate Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Database Internal Notifications
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UnexpectedEmptyRows
An unexpected result returned from the buffer table. Expecting rows to present in result, instead the result is
empty.

Level : Warning

Log Message : An unexpected result returned from the buffer table. Expecting rows to be present in the result,
instead the result is empty.

System : Orchestration

SNMP Name : CASTIRON-COMP-DATABASE-MIB::ciC2iUnexpectedEmptyRowsEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.2.1.3

SNMP Trap Number : 1

Variables

The UnexpectedEmptyRows message contains the following variables:

Table 1. UnexpectedEmptyRows Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Database Internal Notifications
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Domino Module
The Domino Module provides activities for accessing IBM Lotus Domino servers. This section contains details
for the messages delivered from the Domino Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Domino Module.

MIB Name : CASTIRON-COMP-DOMINO-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.22

The following table provides an alphabetical list of all notifications that can be issued by the Domino Module.

Table 1. Notifications issued by the Domino Module
Notification Level System Description

ActivateFailureBlank Severe Orchestration The specified activity name is not executed
successfully because the activity name was blank.

ActivateSuccess Info Orchestration The specified activity name is activated successfully.

ActivityCreateSuccess Info Orchestration The specified activity name is created successfully
and is ready for invocation.
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Notification Level System Description

ActivityFailure Severe Orchestration The specified activity name failed to execute.

ActivitySuccessful Info Orchestration The specified activity name is executed successfully.
The response parameter is populated successfully.

ConnectError Severe Orchestration An error occurred while processing the connection
parameters sent as part of the request in the activity.

InitializationError Severe Orchestration Exception while initializing Lotus Domino connector.

RetryCount Info Orchestration The specified activity re tried the execution so many
times specified above.

RunningInfo Warning Orchestration Encountered few warnings or errors while running
Domino activity.

RunningMessages Warning Orchestration Received messages while executing the activity.

SchemaInvoke Info Orchestration The specified activity name is generating schemas.

StopSuccess Info Orchestration The specified activity name is successfully stopped.

UnmarshalError Severe Orchestration An error occurred while reading input connection
parameters in the activity.

Domino Operation Notifications
Provides a comprehensive list of operation notifications sent from the Domino Module.
Domino Internal Notifications
Provides a comprehensive list of internal notifications sent from the Domino Module.
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Domino Operation Notifications
Provides a comprehensive list of operation notifications sent from the Domino Module.

ActivateFailureBlank
The specified activity name is not executed successfully because the activity name was blank.
ActivateSuccess
The specified activity name is activated successfully.
ActivityCreateSuccess
The specified activity name is created successfully and is ready for invocation.
ActivityFailure
The specified activity name failed to execute.
ActivitySuccessful
The specified activity name is executed successfully. The response parameter is populated successfully.
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RetryCount
The specified activity re tried the execution so many times specified above.
RunningInfo
Encountered few warnings or errors while running Domino activity.
RunningMessages
Received messages while executing the activity.
SchemaInvoke
The specified activity name is generating schemas.
StopSuccess
The specified activity name is successfully stopped.

Parent topic: Domino Module
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ActivateFailureBlank
The specified activity name is not executed successfully because the activity name was blank.

Level : Severe

Log Message : {ActivityName} activity execution failed due to {Name} property is blank.

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oActivateFailureBlankEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 9

Variables

The ActivateFailureBlank message contains the following variables:

Table 1. ActivateFailureBlank Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name that failed to activate.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv9ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.9.1

6. Name

The blank activity name caused the activation to fail.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv9Name
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.9.2

Parent topic: Domino Operation Notifications
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ActivateSuccess
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The specified activity name is activated successfully.

Level : Info

Log Message : Activity {ActivityName} activated successfully.

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oActivateSuccessEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 7

Variables

The ActivateSuccess message contains the following variables:

Table 1. ActivateSuccess Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name that is activated successfully.

 1345



Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv7ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.7.1

Parent topic: Domino Operation Notifications
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ActivityCreateSuccess
The specified activity name is created successfully and is ready for invocation.

Level : Info

Log Message : {ActivityName} activity created successfully.

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oActivityCreateSuccessEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 4

Variables

The ActivityCreateSuccess message contains the following variables:

Table 1. ActivityCreateSuccess Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

1346   



The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name that is created.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv4ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.4.1

Parent topic: Domino Operation Notifications
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ActivityFailure
The specified activity name failed to execute.

Level : Severe

Log Message : An error occurred while trying to execute activity {ActivityName}. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oActivityFailureEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 6

Variables
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The ActivityFailure message contains the following variables:

Table 1. ActivityFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name that failed to execute.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv6ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.6.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Domino Operation Notifications
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ActivitySuccessful
The specified activity name is executed successfully. The response parameter is populated successfully.

Level : Info

Log Message : {ActivityName} activity executed successfully.

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oActivitySuccessfulEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 5

Variables

The ActivitySuccessful message contains the following variables:

Table 1. ActivitySuccessful Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name that is executed successfully.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv5ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.5.1
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RetryCount
The specified activity re tried the execution so many times specified above.

Level : Info

Log Message : The Domino {ActivityName} activity re trying {Count} times now.

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oRetryCountEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 11

Variables

The RetryCount message contains the following variables:

Table 1. RetryCount Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv11ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.11.1

6. Count

The retry count which activity tried so far.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv11Count
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.11.2

Parent topic: Domino Operation Notifications

Feedback | Notices
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RunningInfo
Encountered few warnings or errors while running Domino activity.

Level : Warning

Log Message : Errors/Warning messages while executing activity: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oRunningInfoEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 3

Variables

The RunningInfo message contains the following variables:

Table 1. RunningInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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RunningMessages
Received messages while executing the activity.

Level : Warning

Log Message : {MessageType} messages while executing activity: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oRunningMessagesEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 2

Variables

The RunningMessages message contains the following variables:

Table 1. RunningMessages Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MessageType

Type of the message received.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv2MessageType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.2.1

6. Message

The message received while executing the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv2Message
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.2.2

Parent topic: Domino Operation Notifications
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SchemaInvoke
The specified activity name is generating schemas.

Level : Info

Log Message : The required schema for {Name} is missing. The activity {ActivityName} generating schemas.

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oSchemaInvokeEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 10

Variables

The SchemaInvoke message contains the following variables:

Table 1. SchemaInvoke Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name that invoked the generation of schemas.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv10ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.10.1

6. Name

The name of the schema that is not in the configuration document.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv10Name
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.10.2
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StopSuccess
The specified activity name is successfully stopped.

Level : Info

Log Message : Activity {ActivityName} is stopped successfully.

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22oStopSuccessEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.2

SNMP Trap Number : 8

Variables

The StopSuccess message contains the following variables:

Table 1. StopSuccess Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name that is stopped successfully.

Type : String
SNMP Object Name : CASTIRON-COMP-DOMINO-MIB::ciC22oEv8ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.22.1.2.1.8.1
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Provides a comprehensive list of internal notifications sent from the Domino Module.

ConnectError
An error occurred while processing the connection parameters sent as part of the request in the activity.
InitializationError
Exception while initializing Lotus Domino connector.
UnmarshalError
An error occurred while reading input connection parameters in the activity.
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ConnectError
An error occurred while processing the connection parameters sent as part of the request in the activity.

Level : Severe

Log Message : Error while processing the connection parameters sent as part of the request. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22iConnectErrorEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.3

SNMP Trap Number : 13

Variables

The ConnectError message contains the following variables:

Table 1. ConnectError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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InitializationError
Exception while initializing Lotus Domino connector.

Level : Severe

Log Message : Exception while initializing Lotus Domino connector.

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22iInitializationErrorEv1
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.3

SNMP Trap Number : 1

Variables

The InitializationError message contains the following variables:

Table 1. InitializationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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UnmarshalError
An error occurred while reading input connection parameters in the activity.

Level : Severe

Log Message : Error while trying to read optional connection input parameter. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-DOMINO-MIB::ciC22iUnmarshalErrorEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.22.1.3

SNMP Trap Number : 12

Variables

The UnmarshalError message contains the following variables:

Table 1. UnmarshalError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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Email Module
The Email Module provides connectivity to POP3 and SMTP mail servers. This section contains details for the
messages delivered from the Email Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Email Module.

MIB Name : CASTIRON-COMP-EMAIL-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.7

The following table provides an alphabetical list of all notifications that can be issued by the Email Module.

Table 1. Notifications issued by the Email Module
Notification Level System Description

BodyNull Severe Orchestration The 'body' input parameter from the container is null.
This is an error condition.

ConPoolReleaseError Warning Orchestration Error while closing the connection pool.

ConnectError Severe Orchestration The email activity operation failed because a
connection to the server could not be established.

ConnectErrorRetry Warning Orchestration The email activity operation failed while trying to
connect to the server. This will cause a retry.

ConnectHeaderAbsent Info Orchestration The optional input header - emailConnection - is
mapped.

ConnectHeaderPresent Info Orchestration The optional input header - emailConnection - is
mapped.

ConnectionPoolReturn Warning Orchestration Error occurred while returning connection to pool.
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Notification Level System Description

CouldNotGetHostIP Warning Orchestration Error occurred while getting IP of the router.
Continuing activity without the host IP.

DisconnectException Warning Orchestration Error while trying to disconnect from server.
Discarding error and continuing the activity.

EmailMatched Info Orchestration Found an email matching From and subject fields
specified in configuration.

EmailSent Info Orchestration The activity successfully sent email to the server.

EndpointData Info Orchestration The information regarding the email endpoint data.

IncorrectPort Warning Orchestration The email port needs to be a positive integer.
Defaulting to 110 in case its not specified as positive
integer.

IncorrectSmtpPort Warning Orchestration The email port needs to be a positive integer.
Defaulting to 25 in case its not specified as positive
integer.

IncorrectSmtpTimeout Warning Orchestration The connection timeout needs to be a positive
integer. Defaulting to 300 seconds in case its not
specified as positive integer

IncorrectTimeout Warning Orchestration The connection timeout needs to be a positive
integer. Defaulting to 300 seconds in case its not
specified as positive integer

InvalidAddressFormat Warning Orchestration The email address in the specified field is in incorrect
format.

InvalidEmailID Warning Orchestration The email id specified is not valid.

MailHeaderAbsent Info Orchestration The optional input header - mailheader - is not
mapped.

MailHeaderPresent Info Orchestration The optional input header - mailheader - is mapped.

MailsDeleted Info Orchestration The mails processed in the current poll have been
deleted from the server.

MailsToBeDeleted Info Orchestration There are some mails to be deleted as they were
processed earlier.

MakeConPoolError Warning Orchestration Error while creating the connection.

NewConnectEverytime Info Orchestration The additional property 'smtpNewConnEveryTime'
was added to connection pool.

NoEmailMatched Info Orchestration Could not find an email matching From and subject
fields specified in configuration.

NoMailOnServer Info Orchestration No mail was found on server.

PatternIncorrect Severe Orchestration Pattern specified in the activity is incorrect.

Pop3ConfigParams Info Orchestration Configuration parameters specified in the activity.

Pop3Connected Info Orchestration The activity was successfully able to connect to the
email server.
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Notification Level System Description

Pop3DataError Severe Orchestration A pop3 data error occurred while executing the
activity.

Pop3InternalError Severe Orchestration Internal error occurred while executing pop3 activity.

Pop3MailSent Info Orchestration Activity has outputted 'mailheader' and 'body' output
parameters. Mail marked for deletion from server

Pop3NumMails Info Orchestration Number of mails found on the email server.

Pop3ServerError Severe Orchestration A pop3 command unexpectedly returned an error
while executing the activity.

SaveStateError Warning Orchestration Error occurred while trying to save duplist state after
disconnect. Will cleanup in next poll.

SetBCCFieldValue Info Orchestration Setting the value of 'BCC' field to specified value

SetCCFieldValue Info Orchestration Setting the value of 'CC' field to specified value

SetFromFieldValue Info Orchestration Setting the value of 'From' field to specified value

SetSubjectFieldValue Info Orchestration Setting the value of the 'Subject' field to the specified
value.

SetTimeout Info Orchestration Setting the timeout to specified value.

SetToFieldValue Info Orchestration Setting the value of 'To' field to specified value

SmtpConfigParams Info Orchestration Information regarding configuration parameters
specified in email activity.

SmtpConnectFailed Severe Orchestration The email activity operation failed because a
connection to the server could not be established.

SmtpConnectRetry Warning Orchestration The email activity operation failed while trying to
connect to the server. This will cause a retry.

SmtpConnected Info Orchestration The activity was successfully able to connect to the
email server.

SmtpDataError Severe Orchestration Smtp data error occurred while executing the activity.

SmtpDisconnectError Warning Orchestration Error while trying to disconnect from server.
Discarding error and continuing the activity.

SmtpEndpointData Info Orchestration The information regarding the email endpoint data.

SmtpInternalError Severe Orchestration Internal error occurred while executing smtp activity.

SmtpSendEmail Info Orchestration The activity is sending email to the server.

SmtpTimeout Info Orchestration Setting the timeout to specified value.

SubjectPatternError Severe Orchestration Subject pattern specified in the activity is incorrect.

ToAndCCEmpty Severe Orchestration There was no valid To, CC, BCC specified in the
activity.

Email Connection Notifications
Provides a comprehensive list of connection notifications sent from the Email Module.
Email Operation Notifications
Provides a comprehensive list of operation notifications sent from the Email Module.
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Email Internal Notifications
Provides a comprehensive list of internal notifications sent from the Email Module.
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Email Connection Notifications
Provides a comprehensive list of connection notifications sent from the Email Module.

ConPoolReleaseError
Error while closing the connection pool.
ConnectError
The email activity operation failed because a connection to the server could not be established.
ConnectErrorRetry
The email activity operation failed while trying to connect to the server. This will cause a retry.
ConnectHeaderAbsent
The optional input header - emailConnection - is mapped.
ConnectHeaderPresent
The optional input header - emailConnection - is mapped.
ConnectionPoolReturn
Error occurred while returning connection to pool.
DisconnectException
Error while trying to disconnect from server. Discarding error and continuing the activity.
EndpointData
The information regarding the email endpoint data.
IncorrectPort
The email port needs to be a positive integer. Defaulting to 110 in case its not specified as positive
integer.
IncorrectSmtpPort
The email port needs to be a positive integer. Defaulting to 25 in case its not specified as positive
integer.
IncorrectSmtpTimeout
The connection timeout needs to be a positive integer. Defaulting to 300 seconds in case its not
specified as positive integer
IncorrectTimeout
The connection timeout needs to be a positive integer. Defaulting to 300 seconds in case its not
specified as positive integer
MakeConPoolError
Error while creating the connection.
NewConnectEverytime
The additional property 'smtpNewConnEveryTime' was added to connection pool.
Pop3Connected
The activity was successfully able to connect to the email server.
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SetTimeout
Setting the timeout to specified value.
SmtpConnectFailed
The email activity operation failed because a connection to the server could not be established.
SmtpConnectRetry
The email activity operation failed while trying to connect to the server. This will cause a retry.
SmtpConnected
The activity was successfully able to connect to the email server.
SmtpDisconnectError
Error while trying to disconnect from server. Discarding error and continuing the activity.
SmtpEndpointData
The information regarding the email endpoint data.
SmtpTimeout
Setting the timeout to specified value.

Parent topic: Email Module
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ConPoolReleaseError
Error while closing the connection pool.

Level : Warning

Log Message : Error while closing the connection pool. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cConPoolReleaseErrorEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 21

Variables

The ConPoolReleaseError message contains the following variables:

Table 1. ConPoolReleaseError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Email Connection Notifications
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ConnectError
The email activity operation failed because a connection to the server could not be established.

Level : Severe
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Log Message : Unable to connect to server after {NumberOfRetryAttempts} attempts. Error is: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cConnectErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 4

Variables

The ConnectError message contains the following variables:

Table 1. ConnectError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv4NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.4.1
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6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Email Connection Notifications
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ConnectErrorRetry
The email activity operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to connect to server. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cConnectErrorRetryEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 5

Variables

The ConnectErrorRetry message contains the following variables:

Table 1. ConnectErrorRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv5RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.5.2

7. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv5TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.5.3

8. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv5IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.5.4

Parent topic: Email Connection Notifications

1370   



Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/email/email_co
nnection_connecterrorretry_message.html

ConnectHeaderAbsent
The optional input header - emailConnection - is mapped.

Level : Info

Log Message : Optional input 'emailConnection' parameter is not mapped.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cConnectHeaderAbsentEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 13

Variables

The ConnectHeaderAbsent message contains the following variables:

Table 1. ConnectHeaderAbsent Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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ConnectHeaderPresent
The optional input header - emailConnection - is mapped.

Level : Info

Log Message : Optional input 'emailConnection' parameter is mapped.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cConnectHeaderPresentEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 12

Variables

The ConnectHeaderPresent message contains the following variables:

Table 1. ConnectHeaderPresent Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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ConnectionPoolReturn
Error occurred while returning connection to pool.

Level : Warning

Log Message : Error while returning connection to pool. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cConnectionPoolReturnEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 20

Variables
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The ConnectionPoolReturn message contains the following variables:

Table 1. ConnectionPoolReturn Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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DisconnectException
Error while trying to disconnect from server. Discarding error and continuing the activity.

Level : Warning

Log Message : Error while trying to disconnect from server. Discarding error: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cDisconnectExceptionEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 7

Variables

The DisconnectException message contains the following variables:

Table 1. DisconnectException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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EndpointData
The information regarding the email endpoint data.

Level : Info

Log Message : Endpoint Parameters: Host: \"{HostName}\", Port: {Port}, User: \"{Username}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEndpointDataEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 6

Variables

The EndpointData message contains the following variables:

Table 1. EndpointData Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. HostName

The host name specified in email endpoint.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv6HostName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.6.1

6. Port

The port number specified in email endpoint.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv6Port
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.6.2

7. Username

The user name specified in email endpoint.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv6Username
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.6.3

Parent topic: Email Connection Notifications

Feedback | Notices
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IncorrectPort
The email port needs to be a positive integer. Defaulting to 110 in case its not specified as positive integer.

Level : Warning

Log Message : Port needs to be positive integer. Specified as: \"{PortNumber}\". Defaulted to 110.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cIncorrectPortEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 1

Variables

The IncorrectPort message contains the following variables:

Table 1. IncorrectPort Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. PortNumber

Port number specified for email which caused an error.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv1PortNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.1.1
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IncorrectSmtpPort
The email port needs to be a positive integer. Defaulting to 25 in case its not specified as positive integer.

Level : Warning

Log Message : Port needs to be positive integer. Specified as: \"{PortNumber}\". Defaulted to 25.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cIncorrectSmtpPortEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 9

Variables

The IncorrectSmtpPort message contains the following variables:

Table 1. IncorrectSmtpPort Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. PortNumber

Port number specified for email which caused an error.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv9PortNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.9.1
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IncorrectSmtpTimeout
The connection timeout needs to be a positive integer. Defaulting to 300 seconds in case its not specified as
positive integer
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Level : Warning

Log Message : Timeout needs to be positive integer. Specified as: \"{Timeout}\". Defaulted to 300 seconds.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cIncorrectSmtpTimeoutEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 10

Variables

The IncorrectSmtpTimeout message contains the following variables:

Table 1. IncorrectSmtpTimeout Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Timeout

Timeout specified for email which caused an error.

Type : Integer
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SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv10Timeout
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.10.1

Parent topic: Email Connection Notifications

Feedback | Notices
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IncorrectTimeout
The connection timeout needs to be a positive integer. Defaulting to 300 seconds in case its not specified as
positive integer

Level : Warning

Log Message : Timeout needs to be positive integer. Specified as: \"{Timeout}\". Defaulted to 300 seconds.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cIncorrectTimeoutEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 2

Variables

The IncorrectTimeout message contains the following variables:

Table 1. IncorrectTimeout Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Timeout

Timeout specified for email which caused an error.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv2Timeout
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.2.1
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MakeConPoolError
Error while creating the connection.

Level : Warning

Log Message : Error while creating the connection to destination. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cMakeConPoolErrorEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 22

Variables
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The MakeConPoolError message contains the following variables:

Table 1. MakeConPoolError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/email/email_co
nnection_makeconpoolerror_message.html

NewConnectEverytime
The additional property 'smtpNewConnEveryTime' was added to connection pool.

Level : Info

Log Message : Additional property {PropertyName} set to {PropertyValue} so setup connection pool.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cNewConnectEverytimeEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 16

Variables

The NewConnectEverytime message contains the following variables:

Table 1. NewConnectEverytime Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. PropertyName

The new property added.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv16PropertyName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.16.1

6. PropertyValue

Value of the new property added.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv16PropertyValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.16.2
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Pop3Connected
The activity was successfully able to connect to the email server.

Level : Info

Log Message : Connected to the POP3 server.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cPop3ConnectedEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 3

Variables

The Pop3Connected message contains the following variables:

Table 1. Pop3Connected Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Email Connection Notifications
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SetTimeout
Setting the timeout to specified value.

Level : Info

Log Message : Setting timeout as {Timeout} milliseconds.

System : Orchestration
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SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cSetTimeoutEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 8

Variables

The SetTimeout message contains the following variables:

Table 1. SetTimeout Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Timeout

The timeout value.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv8Timeout
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.8.1

Parent topic: Email Connection Notifications
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SmtpConnectFailed
The email activity operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Unable to connect to server after {NumberOfRetryAttempts} attempts. Error is: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cSmtpConnectFailedEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 14

Variables

The SmtpConnectFailed message contains the following variables:

Table 1. SmtpConnectFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv14NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.14.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SmtpConnectRetry
The email activity operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to connect to server. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cSmtpConnectRetryEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1
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SNMP Trap Number : 15

Variables

The SmtpConnectRetry message contains the following variables:

Table 1. SmtpConnectRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv15RetryAttemptNumber
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.15.2

7. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv15TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.15.3

8. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv15IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.15.4
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SmtpConnected
The activity was successfully able to connect to the email server.

Level : Info

Log Message : Connected to the SMTP server.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cSmtpConnectedEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 11

Variables

The SmtpConnected message contains the following variables:

Table 1. SmtpConnected Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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SmtpDisconnectError
Error while trying to disconnect from server. Discarding error and continuing the activity.

Level : Warning

Log Message : Error while trying to disconnect from server. Discarding error: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cSmtpDisconnectErrorEv18
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 18

Variables

The SmtpDisconnectError message contains the following variables:

Table 1. SmtpDisconnectError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Email Connection Notifications
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SmtpEndpointData
The information regarding the email endpoint data.

Level : Info

Log Message : Endpoint Parameters: Host: \"{HostName}\", Port: {Port}, User: \"{Username}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cSmtpEndpointDataEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 17

Variables

The SmtpEndpointData message contains the following variables:

Table 1. SmtpEndpointData Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. HostName

The host name specified in email endpoint.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv17HostName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.17.1

6. Port

The port number specified in email endpoint.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv17Port
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.17.2

7. Username

The user name specified in email endpoint.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv17Username
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.17.3
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SmtpTimeout
Setting the timeout to specified value.

Level : Info

Log Message : Setting timeout as {Timeout} milliseconds.

System : Orchestration
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SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7cSmtpTimeoutEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.1

SNMP Trap Number : 19

Variables

The SmtpTimeout message contains the following variables:

Table 1. SmtpTimeout Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Timeout

The timeout value.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7cEv19Timeout
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.1.1.19.1

Parent topic: Email Connection Notifications
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Email Operation Notifications
Provides a comprehensive list of operation notifications sent from the Email Module.

CouldNotGetHostIP
Error occurred while getting IP of the router. Continuing activity without the host IP.
EmailMatched
Found an email matching From and subject fields specified in configuration.
EmailSent
The activity successfully sent email to the server.
InvalidAddressFormat
The email address in the specified field is in incorrect format.
InvalidEmailID
The email id specified is not valid.
MailHeaderAbsent
The optional input header - mailheader - is not mapped.
MailHeaderPresent
The optional input header - mailheader - is mapped.
MailsDeleted
The mails processed in the current poll have been deleted from the server.
MailsToBeDeleted
There are some mails to be deleted as they were processed earlier.
NoEmailMatched
Could not find an email matching From and subject fields specified in configuration.
NoMailOnServer
No mail was found on server.
PatternIncorrect
Pattern specified in the activity is incorrect.
Pop3ConfigParams
Configuration parameters specified in the activity.
Pop3DataError
A pop3 data error occurred while executing the activity.
Pop3MailSent
Activity has outputted 'mailheader' and 'body' output parameters. Mail marked for deletion from server
Pop3NumMails
Number of mails found on the email server.
Pop3ServerError
A pop3 command unexpectedly returned an error while executing the activity.
SaveStateError
Error occurred while trying to save duplist state after disconnect. Will cleanup in next poll.
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SetBCCFieldValue
Setting the value of 'BCC' field to specified value
SetCCFieldValue
Setting the value of 'CC' field to specified value
SetFromFieldValue
Setting the value of 'From' field to specified value
SetSubjectFieldValue
Setting the value of the 'Subject' field to the specified value.
SetToFieldValue
Setting the value of 'To' field to specified value
SmtpConfigParams
Information regarding configuration parameters specified in email activity.
SmtpDataError
Smtp data error occurred while executing the activity.
SmtpSendEmail
The activity is sending email to the server.
SubjectPatternError
Subject pattern specified in the activity is incorrect.
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CouldNotGetHostIP
Error occurred while getting IP of the router. Continuing activity without the host IP.

Level : Warning

Log Message : Error while trying to get IP of router. Error is: {Message}. Continuing without getting IP.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oCouldNotGetHostIPEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 20

Variables

The CouldNotGetHostIP message contains the following variables:

Table 1. CouldNotGetHostIP Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Email Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/email/email_op
eration_couldnotgethostip_message.html

EmailMatched
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Found an email matching From and subject fields specified in configuration.

Level : Info

Log Message : Matched email with From: \"{FromPattern}\" and Subject: \"{SubjectPattern}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEmailMatchedEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 5

Variables

The EmailMatched message contains the following variables:

Table 1. EmailMatched Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FromPattern

The value specified for From field.
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Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv5FromPattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.5.1

6. SubjectPattern

The value specified for subject field.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv5SubjectPattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.5.2
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EmailSent
The activity successfully sent email to the server.

Level : Info

Log Message : Email sent to server.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEmailSentEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 17

Variables

The EmailSent message contains the following variables:

Table 1. EmailSent Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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InvalidAddressFormat
The email address in the specified field is in incorrect format.

Level : Warning

Log Message : The {Field} email address {EmailID} specified in optional parameters is not in correct format. Not
setting the same.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oInvalidAddressFormatEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 19

Variables
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The InvalidAddressFormat message contains the following variables:

Table 1. InvalidAddressFormat Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Field

The specified field.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv19Field
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.19.1

6. EmailID

The email ID in incorrect format.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv19EmailID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.19.2

Parent topic: Email Operation Notifications
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InvalidEmailID
The email id specified is not valid.

Level : Warning

Log Message : Email id is invalid: {EmailID}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oInvalidEmailIDEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 18

Variables

The InvalidEmailID message contains the following variables:

Table 1. InvalidEmailID Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. EmailID

The invalid email id.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv18EmailID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.18.1
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MailHeaderAbsent
The optional input header - mailheader - is not mapped.

Level : Info

Log Message : Optional input 'mailheader' parameter is not mapped.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oMailHeaderAbsentEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 14

Variables

The MailHeaderAbsent message contains the following variables:

Table 1. MailHeaderAbsent Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Email Operation Notifications
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MailHeaderPresent
The optional input header - mailheader - is mapped.

Level : Info

Log Message : Optional input 'mailheader' parameter is mapped.

System : Orchestration
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SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oMailHeaderPresentEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 15

Variables

The MailHeaderPresent message contains the following variables:

Table 1. MailHeaderPresent Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Email Operation Notifications
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MailsDeleted
The mails processed in the current poll have been deleted from the server.

Level : Info

Log Message : Mails processed in this poll deleted from server.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oMailsDeletedEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 12

Variables

The MailsDeleted message contains the following variables:

Table 1. MailsDeleted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Email Operation Notifications
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MailsToBeDeleted
There are some mails to be deleted as they were processed earlier.

Level : Info

Log Message : {NumberOfEmails} mails to be deleted now as they were processed earlier.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oMailsToBeDeletedEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 11

Variables

The MailsToBeDeleted message contains the following variables:

Table 1. MailsToBeDeleted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfEmails

Number of mails to be deleted from the server.

Type : Integer
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv11NumberOfEmails
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.11.1

Parent topic: Email Operation Notifications
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NoEmailMatched
Could not find an email matching From and subject fields specified in configuration.

Level : Info

Log Message : No emails matched on the server.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oNoEmailMatchedEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 6

Variables
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The NoEmailMatched message contains the following variables:

Table 1. NoEmailMatched Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Email Operation Notifications
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NoMailOnServer
No mail was found on server.
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Level : Info

Log Message : No mail found on the server.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oNoMailOnServerEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 7

Variables

The NoMailOnServer message contains the following variables:

Table 1. NoMailOnServer Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Email Operation Notifications
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PatternIncorrect
Pattern specified in the activity is incorrect.

Level : Severe

Log Message : From pattern \"{FromPattern}\" incorrect. Error is: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oPatternIncorrectEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 2

Variables

The PatternIncorrect message contains the following variables:

Table 1. PatternIncorrect Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FromPattern

From Pattern Specified in the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv2FromPattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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Pop3ConfigParams
Configuration parameters specified in the activity.

Level : Info

Log Message : Config parameters: From Pattern: \"{FromPattern}\", Subject Pattern: \"{SubjectPattern}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oPop3ConfigParamsEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 1

Variables
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The Pop3ConfigParams message contains the following variables:

Table 1. Pop3ConfigParams Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FromPattern

From Pattern Specified in the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv1FromPattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.1.1

6. SubjectPattern

Subject Pattern Specified in the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv1SubjectPattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.1.2

Parent topic: Email Operation Notifications
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Pop3DataError
A pop3 data error occurred while executing the activity.

Level : Severe

Log Message : Data Error: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oPop3DataErrorEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 8

Variables

The Pop3DataError message contains the following variables:

Table 1. Pop3DataError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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Pop3MailSent
Activity has outputted 'mailheader' and 'body' output parameters. Mail marked for deletion from server

Level : Info

Log Message : Outputted 'mailheader' and 'body' output parameters. Mail marked for deletion from server.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oPop3MailSentEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 10

Variables

The Pop3MailSent message contains the following variables:

Table 1. Pop3MailSent Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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Pop3NumMails
Number of mails found on the email server.

Level : Info

Log Message : Number of emails on server is {NumberOfMails}.

System : Orchestration
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SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oPop3NumMailsEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 4

Variables

The Pop3NumMails message contains the following variables:

Table 1. Pop3NumMails Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfMails

The number of mails found on email server.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv4NumberOfMails
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.4.1

Parent topic: Email Operation Notifications
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Pop3ServerError
A pop3 command unexpectedly returned an error while executing the activity.

Level : Severe

Log Message : Unexpected error from server: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oPop3ServerErrorEv27

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 27

Variables

The Pop3ServerError message contains the following variables:

Table 1. Pop3ServerError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SaveStateError
Error occurred while trying to save duplist state after disconnect. Will cleanup in next poll.

Level : Warning

Log Message : Error while trying to save duplist state after disconnect. Will cleanup in next poll.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSaveStateErrorEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 9

Variables

The SaveStateError message contains the following variables:

Table 1. SaveStateError Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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SetBCCFieldValue
Setting the value of 'BCC' field to specified value

Level : Info

Log Message : Setting BCC: \"{Value}\".

System : Orchestration
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SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSetBCCFieldValueEv24

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 24

Variables

The SetBCCFieldValue message contains the following variables:

Table 1. SetBCCFieldValue Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

The value to which BCC field is set.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv24Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.24.1

Parent topic: Email Operation Notifications
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SetCCFieldValue
Setting the value of 'CC' field to specified value

Level : Info

Log Message : Setting CC: \"{Value}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSetCCFieldValueEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 23

Variables

The SetCCFieldValue message contains the following variables:

Table 1. SetCCFieldValue Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

The value to which CC field is set.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv23Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.23.1
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SetFromFieldValue
Setting the value of 'From' field to specified value

Level : Info

Log Message : Setting From: \"{Value}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSetFromFieldValueEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 22

Variables

The SetFromFieldValue message contains the following variables:

Table 1. SetFromFieldValue Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

The value to which From field is set.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv22Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.22.1
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SetSubjectFieldValue
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Setting the value of the 'Subject' field to the specified value.

Level : Info

Log Message : Setting Subject: \"{Value}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSetSubjectFieldValueEv25

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 25

Variables

The SetSubjectFieldValue message contains the following variables:

Table 1. SetSubjectFieldValue Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

The value to which subject field is set.
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Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv25Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.25.1
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SetToFieldValue
Setting the value of 'To' field to specified value

Level : Info

Log Message : Setting To: \"{Value}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSetToFieldValueEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 21

Variables

The SetToFieldValue message contains the following variables:

Table 1. SetToFieldValue Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

The value to which To field is set.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv21Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.21.1
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SmtpConfigParams
Information regarding configuration parameters specified in email activity.

Level : Info

Log Message : Config Parameters: From: \"{From}\", To: \"{To}\", CC: \"{CC}\", BCC: \"{BCC}\", Subject: \"
{Subject}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSmtpConfigParamsEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 13

Variables
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The SmtpConfigParams message contains the following variables:

Table 1. SmtpConfigParams Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. From

The value specified for From field.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv13From
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.13.1

6. To

The value specified for To field.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv13To
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.13.2

7. CC
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The value specified for CC field.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv13CC
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.13.3

8. BCC

The value specified for BCC field.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv13BCC
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.13.4

9. Subject

The value specified for subject field.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv13Subject
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.13.5
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SmtpDataError
Smtp data error occurred while executing the activity.

Level : Severe

Log Message : Data Error: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSmtpDataErrorEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 16

Variables

The SmtpDataError message contains the following variables:
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Table 1. SmtpDataError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SmtpSendEmail
The activity is sending email to the server.

Level : Info

Log Message : Sending email to server.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSmtpSendEmailEv26

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 26

Variables

The SmtpSendEmail message contains the following variables:

Table 1. SmtpSendEmail Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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SubjectPatternError
Subject pattern specified in the activity is incorrect.

Level : Severe

Log Message : Subject pattern \"{SubjectPattern}\" incorrect. Error is: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7oSubjectPatternErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.2

SNMP Trap Number : 3

Variables

The SubjectPatternError message contains the following variables:

Table 1. SubjectPatternError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. SubjectPattern

Subject Pattern Specified in the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-EMAIL-MIB::ciC7oEv3SubjectPattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.7.1.2.1.3.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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Email Internal Notifications
Provides a comprehensive list of internal notifications sent from the Email Module.

BodyNull
The 'body' input parameter from the container is null. This is an error condition.
Pop3InternalError
Internal error occurred while executing pop3 activity.
SmtpInternalError
Internal error occurred while executing smtp activity.
ToAndCCEmpty
There was no valid To, CC, BCC specified in the activity.
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BodyNull
The 'body' input parameter from the container is null. This is an error condition.

Level : Severe

Log Message : Input parameter 'body' from container is NULL.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7iBodyNullEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.3

SNMP Trap Number : 2

Variables

The BodyNull message contains the following variables:

Table 1. BodyNull Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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Pop3InternalError
Internal error occurred while executing pop3 activity.

Level : Severe

Log Message : Error: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7iPop3InternalErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.3

SNMP Trap Number : 1

Variables

The Pop3InternalError message contains the following variables:

Table 1. Pop3InternalError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SmtpInternalError
Internal error occurred while executing smtp activity.

Level : Severe

Log Message : Error: {Message}.
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System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7iSmtpInternalErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.3

SNMP Trap Number : 3

Variables

The SmtpInternalError message contains the following variables:

Table 1. SmtpInternalError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ToAndCCEmpty
There was no valid To, CC, BCC specified in the activity.

Level : Severe

Log Message : No valid To, CC or BCC email address found.

System : Orchestration

SNMP Name : CASTIRON-COMP-EMAIL-MIB::ciC7iToAndCCEmptyEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.7.1.3

SNMP Trap Number : 4

Variables

The ToAndCCEmpty message contains the following variables:

Table 1. ToAndCCEmpty Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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FTP Module
The FTP Module provides connectivity to remote FTP servers. This section contains details for the messages
delivered from the FTP Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the FTP Module.

MIB Name : CASTIRON-COMP-FTP-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.6

The following table provides an alphabetical list of all notifications that can be issued by the FTP Module.

Table 1. Notifications issued by the FTP Module
Notification Level System Description

AppendAfter Info Orchestration Response received after issuing an append command
to the file on remote server.

AppendBefore Info Orchestration In process of issuing an append command to the file
on remote server.

ConnectionFailure Severe Orchestration The FTP operation failed because a connection to the
server could not be established.

ConnectionRetry Warning Orchestration The FTP operation failed while trying to connect to
the server. This will cause a retry.
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Notification Level System Description

DeleteAfter Info Orchestration Response received when a file was deleted from the
remote server.

DeleteBefore Info Orchestration In process of deleting a file to the remote server.

DeleteDupLIstEntry Info Orchestration Duplicate list is at maximum capacity. Removing a file
from the duplicate list.

DeleteInfoSummary Info Orchestration A complete summary of delete file activity
configuration.

DirChangeAfter Info Orchestration Changed to the specified directory on remote server.

DirChangeBefore Info Orchestration Changing directory on the remote server.

DuplicateFile Info Orchestration The file was previously processed by FTP poll activity.

EncodingError Severe Orchestration The data encoding specified is not supported by FTP
activity.

EndpointInfoSummary Info Orchestration A complete summary of endpoint information
specified.

FileNotMoved Warning Orchestration File was not moved from original location as there is
already another file in the destination location and
overwrite option is false.

FileProcessed Info Orchestration The file is processed by FTP activity and is left in
place.

FileProcessingError Warning Orchestration Error occurred while processing the file.

FtpPatternConversion Warning Orchestration In the versions greater than 3.6 FTP use different
style of pattern. If project is published from studio
version before that, FTP will automatically change the
pattern to new style.

GetAfter Info Orchestration Response received when a file was downloaded to
the remote server.

GetBefore Info Orchestration In process of downloading a file to the remote server.

GetInfoSummary Info Orchestration A complete summary of get file activity configuration.

InternalException Severe Orchestration A internal error occurred while executing FTP activity.

ListAfter Info Orchestration Response received when the directory was listed on
the remote server.

ListBefore Info Orchestration In process of listing a directory on the remote server.

ListFileSummary Info Orchestration A complete summary of list file activity configuration.

NListAfter Info Orchestration Response received when the directory was name
listed on the remote server.

NListBefore Info Orchestration In process of name listing a directory on the remote
server.

OperationError Severe Orchestration FTP activity was unable to perform operation on FTP
server.

 1443



Notification Level System Description

PutAfter Info Orchestration Response received when a file was uploaded to the
remote server.

PutBefore Info Orchestration In process of uploading a file to the remote server.

PutDuplicateFileName Severe Orchestration File with same name exists on the specified server
location. Configuration specified not to overwrite, so
erroring out.

PutEmptyFileName Severe Orchestration The file name specified in put activity is empty.

PutInfoSummary Info Orchestration A complete summary of put file activity configuration.

RenameAfter Info Orchestration Response received when a file was renamed to the
remote server.

RenameBefore Info Orchestration In process of renaming a file to the remote server.

RenameDupError Severe Orchestration Rename operation errored as file with same name
already exists.

RenameInfoSummary Info Orchestration A complete summary of get file activity configuration.

SshFingerprintInfo Info Orchestration SSH finger print information for communication with
FTP server.

SshModeInfo Info Orchestration SSH mode information for communication with FTP
server.

TimeStampError Warning Orchestration The timestamp command is not supported by the FTP
server. Continuing the FTP activity operation using
default timestamp.

TimestampCommand Warning Orchestration The timestamp command is not supported by the FTP
server. Continuing the FTP activity operation.

UnableToDelete Warning Orchestration Error occurred while deleting file from the specified
location.

UnableToMove Warning Orchestration Error occurred while moving file to destination
location.

FTP Connection Notifications
Provides a comprehensive list of connection notifications sent from the FTP Module.
FTP Operation Notifications
Provides a comprehensive list of operation notifications sent from the FTP Module.
FTP Internal Notifications
Provides a comprehensive list of internal notifications sent from the FTP Module.
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FTP Connection Notifications
Provides a comprehensive list of connection notifications sent from the FTP Module.

ConnectionFailure
The FTP operation failed because a connection to the server could not be established.
ConnectionRetry
The FTP operation failed while trying to connect to the server. This will cause a retry.
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ConnectionFailure
The FTP operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Unable to connect to the server \"{ServerName}\" after {NumberOfRetryAttempts} attempts. Error
is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6cConnectionFailureEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.1

SNMP Trap Number : 1

Variables

The ConnectionFailure message contains the following variables:

Table 1. ConnectionFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ServerName

The server name to which connection failed.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6cEv1ServerName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.1.1.1.1

6. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6cEv1NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.1.1.1.2

7. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: FTP Connection Notifications
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ConnectionRetry
The FTP operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to connect to the server \"{ServerName}\". Error is: {Message} Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6cConnectionRetryEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.1

SNMP Trap Number : 2

Variables

The ConnectionRetry message contains the following variables:

Table 1. ConnectionRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ServerName

The server name to which connection failed.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6cEv2ServerName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.1.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

7. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6cEv2RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.1.1.2.3

8. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6cEv2TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.1.1.2.4

9. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6cEv2IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.1.1.2.5

Parent topic: FTP Connection Notifications
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FTP Operation Notifications
Provides a comprehensive list of operation notifications sent from the FTP Module.

AppendAfter
Response received after issuing an append command to the file on remote server.
AppendBefore
In process of issuing an append command to the file on remote server.
DeleteAfter
Response received when a file was deleted from the remote server.
DeleteBefore
In process of deleting a file to the remote server.
DeleteDupLIstEntry
Duplicate list is at maximum capacity. Removing a file from the duplicate list.
DeleteInfoSummary
A complete summary of delete file activity configuration.
DirChangeAfter
Changed to the specified directory on remote server.
DirChangeBefore
Changing directory on the remote server.
DuplicateFile
The file was previously processed by FTP poll activity.
EndpointInfoSummary
A complete summary of endpoint information specified.
FileNotMoved
File was not moved from original location as there is already another file in the destination location and
overwrite option is false.
FileProcessed
The file is processed by FTP activity and is left in place.
FileProcessingError
Error occurred while processing the file.
FtpPatternConversion
In the versions greater than 3.6 FTP use different style of pattern. If project is published from studio
version before that, FTP will automatically change the pattern to new style.
GetAfter
Response received when a file was downloaded to the remote server.
GetBefore
In process of downloading a file to the remote server.
GetInfoSummary
A complete summary of get file activity configuration.
ListAfter
Response received when the directory was listed on the remote server.
ListBefore
In process of listing a directory on the remote server.
ListFileSummary
A complete summary of list file activity configuration.
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NListAfter
Response received when the directory was name listed on the remote server.
NListBefore
In process of name listing a directory on the remote server.
OperationError
FTP activity was unable to perform operation on FTP server.
PutAfter
Response received when a file was uploaded to the remote server.
PutBefore
In process of uploading a file to the remote server.
PutDuplicateFileName
File with same name exists on the specified server location. Configuration specified not to overwrite, so
erroring out.
PutEmptyFileName
The file name specified in put activity is empty.
PutInfoSummary
A complete summary of put file activity configuration.
RenameAfter
Response received when a file was renamed to the remote server.
RenameBefore
In process of renaming a file to the remote server.
RenameDupError
Rename operation errored as file with same name already exists.
RenameInfoSummary
A complete summary of get file activity configuration.
SshFingerprintInfo
SSH finger print information for communication with FTP server.
SshModeInfo
SSH mode information for communication with FTP server.
TimeStampError
The timestamp command is not supported by the FTP server. Continuing the FTP activity operation using
default timestamp.
TimestampCommand
The timestamp command is not supported by the FTP server. Continuing the FTP activity operation.
UnableToDelete
Error occurred while deleting file from the specified location.
UnableToMove
Error occurred while moving file to destination location.

Parent topic: FTP Module
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Response received after issuing an append command to the file on remote server.

Level : Info

Log Message : Append data to file "{FileName}" completed with return code {ResponseCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oAppendAfterEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 4

Variables

The AppendAfter message contains the following variables:

Table 1. AppendAfter Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

Name of the file to which append command was issued.

 1451



Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv4FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.4.1

6. ResponseCode

Response code returned by the remote server on the append command.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv4ResponseCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.4.2

Parent topic: FTP Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/ftp/ftp_operatio
n_appendafter_message.html

AppendBefore
In process of issuing an append command to the file on remote server.

Level : Info

Log Message : Appending data to file "{FileName}".

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oAppendBeforeEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 3

Variables

The AppendBefore message contains the following variables:

Table 1. AppendBefore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

Name of the file to which append command is being issued.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv3FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.3.1

Parent topic: FTP Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/ftp/ftp_operatio
n_appendbefore_message.html

DeleteAfter
Response received when a file was deleted from the remote server.

Level : Info

Log Message : Deleted file "{FileName}" on server with return code {ResponseCode}.

System : Orchestration
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SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oDeleteAfterEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 12

Variables

The DeleteAfter message contains the following variables:

Table 1. DeleteAfter Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

Name of the file which was deleted.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv12FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.12.1

6. ResponseCode
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Response code returned by the remote server when file was deleted.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv12ResponseCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.12.2
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DeleteBefore
In process of deleting a file to the remote server.

Level : Info

Log Message : Deleting file "{FileName}" on server.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oDeleteBeforeEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 11

Variables

The DeleteBefore message contains the following variables:

Table 1. DeleteBefore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

Name of the file which is being deleted.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv11FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.11.1
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DeleteDupLIstEntry
Duplicate list is at maximum capacity. Removing a file from the duplicate list.

Level : Info

Log Message : Duplicate list is at capacity, removing file "{FileName}" from duplicate list.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oDeleteDupLIstEntryEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 20
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Variables

The DeleteDupLIstEntry message contains the following variables:

Table 1. DeleteDupLIstEntry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

File name removed from duplicate list to purge it.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv20FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.20.1

Parent topic: FTP Operation Notifications
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DeleteInfoSummary
A complete summary of delete file activity configuration.

Level : Info

Log Message : Delete file summary - Directory: {DirName}, Filename: {FileName}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oDeleteInfoSummaryEv34

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 34

Variables

The DeleteInfoSummary message contains the following variables:

Table 1. DeleteInfoSummary Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DirName

Directory name specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv34DirName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.34.1

6. FileName

File name specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv34FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.34.2
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DirChangeAfter
Changed to the specified directory on remote server.

Level : Info

Log Message : Changed directory to "{DirectoryName}" completed with return code {ResponseCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oDirChangeAfterEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 2

Variables

The DirChangeAfter message contains the following variables:

Table 1. DirChangeAfter Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DirectoryName

Name of the directory on remote server.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv2DirectoryName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.2.1

6. ResponseCode

Response code returned by the remote server on the change directory command.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv2ResponseCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.2.2

Parent topic: FTP Operation Notifications
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DirChangeBefore
Changing directory on the remote server.

Level : Info

Log Message : Changing to directory "{DirectoryName}".

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oDirChangeBeforeEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 1

Variables

The DirChangeBefore message contains the following variables:

Table 1. DirChangeBefore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DirectoryName

Name of the directory on remote server.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv1DirectoryName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.1.1
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DuplicateFile
The file was previously processed by FTP poll activity.

Level : Info

Log Message : File named "{FileName}" has already been processed previously. The previous timestamp was
{Timestamp}.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oDuplicateFileEv24

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 24

Variables

The DuplicateFile message contains the following variables:

Table 1. DuplicateFile Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String

1462   



SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

The name of the file that was previously processed.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv24FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.24.1

6. Timestamp

The time at which file was last processed.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv24Timestamp
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.24.2
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EndpointInfoSummary
A complete summary of endpoint information specified.

Level : Info

Log Message : FTP Endpoint Summary - Host: {HostName}, Port: {PortName}, UserName: {UserName}, Protocol:
{Protocol}, Timeout: {Timeout}, FTP Mode: {FtpMode}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oEndpointInfoSummaryEv36

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 36

Variables

The EndpointInfoSummary message contains the following variables:

Table 1. EndpointInfoSummary Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. HostName

Host name specified in the endpoint configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv36HostName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.36.1

6. PortName

Port name specified in the endpoint configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv36PortName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.36.2

7. UserName

User name specified in the endpoint configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv36UserName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.36.3

8. Protocol

Protocol specified in the endpoint configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv36Protocol
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.36.4

9. Timeout

Timeout specified in the endpoint configuration.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv36Timeout
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.36.5

10. FtpMode

Active or Passive mode specified in the endpoint configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv36FtpMode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.36.6

Parent topic: FTP Operation Notifications
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FileNotMoved
File was not moved from original location as there is already another file in the destination location and
overwrite option is false.

Level : Warning

Log Message : File "{FileName}" kept in place, will not overwrite.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oFileNotMovedEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 21

Variables

The FileNotMoved message contains the following variables:

Table 1. FileNotMoved Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

The name of the file which was not moved.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv21FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.21.1
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FileProcessed
The file is processed by FTP activity and is left in place.

Level : Info

Log Message : Processed file "{FileName}". Leaving in place.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oFileProcessedEv25

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 25

Variables

The FileProcessed message contains the following variables:

Table 1. FileProcessed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

The name of the file that was processed.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv25FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.25.1
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FileProcessingError
Error occurred while processing the file.
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Level : Warning

Log Message : Error processing file "{FileName}". Error is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oFileProcessingErrorEv26

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 26

Variables

The FileProcessingError message contains the following variables:

Table 1. FileProcessingError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

The name of the file that was not processed.

Type : String
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SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv26FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.26.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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FtpPatternConversion
In the versions greater than 3.6 FTP use different style of pattern. If project is published from studio version
before that, FTP will automatically change the pattern to new style.

Level : Warning

Log Message : Automatically converting old style FTP filename pattern from "{OldStylePattern}" to "
{NewStylePattern}". Please republish project from Studio verison 3.6 or later to eliminate this warning.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oFtpPatternConversionEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 17

Variables

The FtpPatternConversion message contains the following variables:

Table 1. FtpPatternConversion Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OldStylePattern

Old style pattern sent to FTP activity.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv17OldStylePattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.17.1

6. NewStylePattern

New style pattern automatically generated by FTP activity.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv17NewStylePattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.17.2
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GetAfter
Response received when a file was downloaded to the remote server.

Level : Info

Log Message : Downloaded file "{FileName}" from server with return code {ResponseCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oGetAfterEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 8

Variables

The GetAfter message contains the following variables:

Table 1. GetAfter Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. FileName

Name of the file which was downloaded.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv8FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.8.1

6. ResponseCode

Response code returned by the remote server when file was downloaded.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv8ResponseCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.8.2
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GetBefore
In process of downloading a file to the remote server.

Level : Info

Log Message : Downloading file "{FileName}" from server.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oGetBeforeEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 7

Variables

The GetBefore message contains the following variables:

Table 1. GetBefore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

Name of the file which is being downloaded.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv7FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.7.1
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GetInfoSummary
A complete summary of get file activity configuration.
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Level : Info

Log Message : Get file summary - Directory: {DirName}, Filename: {FileName}, IsBinary? {BinaryOption}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oGetInfoSummaryEv30

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 30

Variables

The GetInfoSummary message contains the following variables:

Table 1. GetInfoSummary Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DirName

Directory name specified in the configuration.

Type : String
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SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv30DirName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.30.1

6. FileName

File name specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv30FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.30.2

7. BinaryOption

Binary or Text value specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv30BinaryOption
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.30.3
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ListAfter
Response received when the directory was listed on the remote server.

Level : Info

Log Message : Listing completed with a return code {ResponseCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oListAfterEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 14

Variables

The ListAfter message contains the following variables:

Table 1. ListAfter Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ResponseCode

Response code returned by the remote server when the directory was listed.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv14ResponseCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.14.1
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ListBefore
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In process of listing a directory on the remote server.

Level : Info

Log Message : Getting a listing for pattern "{Pattern}" for current directory.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oListBeforeEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 13

Variables

The ListBefore message contains the following variables:

Table 1. ListBefore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Pattern

The pattern match used to list the directory.
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Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv13Pattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.13.1
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ListFileSummary
A complete summary of list file activity configuration.

Level : Info

Log Message : List directory summary - Directory: {DirName}, Pattern: {Pattern}, NLIST? {ListOption}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oListFileSummaryEv35

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 35

Variables

The ListFileSummary message contains the following variables:

Table 1. ListFileSummary Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DirName

Directory name specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv35DirName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.35.1

6. Pattern

Pattern specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv35Pattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.35.2

7. ListOption

List or NList option specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv35ListOption
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.35.3
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Response received when the directory was name listed on the remote server.

Level : Info

Log Message : Name listing completed with a return code {ResponseCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oNListAfterEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 16

Variables

The NListAfter message contains the following variables:

Table 1. NListAfter Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ResponseCode

Response code returned by the remote server when the directory was name listed.
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Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv16ResponseCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.16.1
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NListBefore
In process of name listing a directory on the remote server.

Level : Info

Log Message : Getting a name listing for pattern "{Pattern}" for current directory.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oNListBeforeEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 15

Variables

The NListBefore message contains the following variables:

Table 1. NListBefore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Pattern

The pattern match used to name list the directory.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv15Pattern
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.15.1
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OperationError
FTP activity was unable to perform operation on FTP server.

Level : Severe

Log Message : Unable to perform operation \"{OperationName}\". Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oOperationErrorEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 18

Variables
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The OperationError message contains the following variables:

Table 1. OperationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OperationName

Name of the operation that could not be performed.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv18OperationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.18.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: FTP Operation Notifications
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PutAfter
Response received when a file was uploaded to the remote server.

Level : Info

Log Message : Uploaded file "{FileName}" to server with return code {ResponseCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oPutAfterEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 6

Variables

The PutAfter message contains the following variables:

Table 1. PutAfter Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

Name of the file which was uploaded.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv6FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.6.1

6. ResponseCode

Response code returned by the remote server when file was uploaded.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv6ResponseCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.6.2
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PutBefore
In process of uploading a file to the remote server.

Level : Info

Log Message : Uploading file "{FileName}" to server.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oPutBeforeEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2
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SNMP Trap Number : 5

Variables

The PutBefore message contains the following variables:

Table 1. PutBefore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

Name of the file which is being uploaded.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv5FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.5.1

Parent topic: FTP Operation Notifications

Feedback | Notices
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PutDuplicateFileName
File with same name exists on the specified server location. Configuration specified not to overwrite, so
erroring out.

Level : Severe

Log Message : {FileName}: File with the same name exists on the FTP server. It is a duplicate!

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oPutDuplicateFileNameEv28

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 28

Variables

The PutDuplicateFileName message contains the following variables:

Table 1. PutDuplicateFileName Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

The name of file which already existed on the specified location.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv28FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.28.1
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PutEmptyFileName
The file name specified in put activity is empty.

Level : Severe

Log Message : Filename is empty. Please specify valid filename.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oPutEmptyFileNameEv29

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 29

Variables

The PutEmptyFileName message contains the following variables:

Table 1. PutEmptyFileName Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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PutInfoSummary
A complete summary of put file activity configuration.

Level : Info

Log Message : Put file summary - Directory: {DirName}, Filename: {FileName}, Overwrite? {OverwriteOption},
IsBinary? {BinaryOption}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oPutInfoSummaryEv27

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2
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SNMP Trap Number : 27

Variables

The PutInfoSummary message contains the following variables:

Table 1. PutInfoSummary Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DirName

Directory name specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv27DirName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.27.1

6. FileName

File name specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv27FileName
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.27.2

7. OverwriteOption

Overwrite Option specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv27OverwriteOption
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.27.3

8. BinaryOption

Binary or Text value specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv27BinaryOption
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.27.4
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RenameAfter
Response received when a file was renamed to the remote server.

Level : Info

Log Message : Renamed file from "{SrcFileName}" to "{DestFileName}" with return code {ResponseCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oRenameAfterEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 10

Variables

The RenameAfter message contains the following variables:

Table 1. RenameAfter Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. SrcFileName

Name of the file which was renamed.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv10SrcFileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.10.1

6. DestFileName

Name of the file which the file was renamed to.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv10DestFileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.10.2

7. ResponseCode

Response code returned by the remote server when file was renamed.

Type : Integer
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv10ResponseCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.10.3

Parent topic: FTP Operation Notifications
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RenameBefore
In process of renaming a file to the remote server.

Level : Info

Log Message : Renaming file from "{SrcFileName}" to "{DestFileName}".

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oRenameBeforeEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 9

Variables

The RenameBefore message contains the following variables:

Table 1. RenameBefore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. SrcFileName

Name of the file which is being renamed.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv9SrcFileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.9.1

6. DestFileName

Name of the file which the file is being renamed to.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv9DestFileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.9.2
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RenameDupError
Rename operation errored as file with same name already exists.

Level : Severe

Log Message : {FileName}: File with the same name exists on the FTP server. It is a duplicate!

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oRenameDupErrorEv33

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2
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SNMP Trap Number : 33

Variables

The RenameDupError message contains the following variables:

Table 1. RenameDupError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

The name of file for whihc rename operation failed.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv33FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.33.1

Parent topic: FTP Operation Notifications

Feedback | Notices
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RenameInfoSummary
A complete summary of get file activity configuration.

Level : Info

Log Message : Rename file summary - fromDirectory: {DirName}, fromFilename: {FromFileName}, toPath:
{ToPath}, Overwrite: {OverwriteOption}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oRenameInfoSummaryEv32

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 32

Variables

The RenameInfoSummary message contains the following variables:

Table 1. RenameInfoSummary Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DirName

Directory name specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv32DirName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.32.1

6. FromFileName

Source file name specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv32FromFileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.32.2

7. ToPath

Destination path specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv32ToPath
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.32.3

8. OverwriteOption

Overwrite option specified in the configuration.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv32OverwriteOption
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.32.4
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Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/ftp/ftp_operatio
n_renameinfosummary_message.html

SshFingerprintInfo
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SSH finger print information for communication with FTP server.

Level : Info

Log Message : Finger print for host: {HostName} is {FingerprintInfo}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oSshFingerprintInfoEv37

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 37

Variables

The SshFingerprintInfo message contains the following variables:

Table 1. SshFingerprintInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. HostName

Host name for which finger print information is specified.
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Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv37HostName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.37.1

6. FingerprintInfo

Finger print information for the specified host.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv37FingerprintInfo
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.37.2
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SshModeInfo
SSH mode information for communication with FTP server.

Level : Info

Log Message : The SFTP key access is: {ModeInformation}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oSshModeInfoEv38

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 38

Variables

The SshModeInfo message contains the following variables:

Table 1. SshModeInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ModeInformation

SSH mode information for the communication with FTP server.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv38ModeInformation
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.38.1

Parent topic: FTP Operation Notifications
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TimeStampError
The timestamp command is not supported by the FTP server. Continuing the FTP activity operation using
default timestamp.

Level : Warning

Log Message : MDTM command is not supported by FTP server, using default timestamp of \"Jan 1, 1970\"
instead.
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System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oTimeStampErrorEv31

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 31

Variables

The TimeStampError message contains the following variables:

Table 1. TimeStampError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: FTP Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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TimestampCommand
The timestamp command is not supported by the FTP server. Continuing the FTP activity operation.

Level : Warning

Log Message : MDTM command is not supported by FTP server, using timestamp from listing instead. Please
consult manual for possible side effects.

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oTimestampCommandEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 19

Variables

The TimestampCommand message contains the following variables:

Table 1. TimestampCommand Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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UnableToDelete
Error occurred while deleting file from the specified location.

Level : Warning

Log Message : Could not delete file "{FileName}" after processing. Error is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oUnableToDeleteEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 23

Variables

The UnableToDelete message contains the following variables:

Table 1. UnableToDelete Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

The name of file which was not deleted.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv23FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.23.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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UnableToMove
Error occurred while moving file to destination location.

Level : Warning
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Log Message : Could not move file "{FileName}" after processing. Error is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6oUnableToMoveEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.2

SNMP Trap Number : 22

Variables

The UnableToMove message contains the following variables:

Table 1. UnableToMove Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FileName

The name of file which was not moved.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6oEv22FileName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.2.1.22.1
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6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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FTP Internal Notifications
Provides a comprehensive list of internal notifications sent from the FTP Module.

EncodingError
The data encoding specified is not supported by FTP activity.
InternalException
A internal error occurred while executing FTP activity.

Parent topic: FTP Module
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EncodingError
The data encoding specified is not supported by FTP activity.

Level : Severe

Log Message : The data encoding specified: \"{DataEncoding}\" is not supported.

System : Orchestration
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SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6iEncodingErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.3

SNMP Trap Number : 2

Variables

The EncodingError message contains the following variables:

Table 1. EncodingError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. DataEncoding

The data encoding that is not supported by FTP activity.

Type : String
SNMP Object Name : CASTIRON-COMP-FTP-MIB::ciC6iEv2DataEncoding
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.6.1.3.1.2.1

Parent topic: FTP Internal Notifications
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InternalException
A internal error occurred while executing FTP activity.

Level : Severe

Log Message : General FTP module exception. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-FTP-MIB::ciC6iInternalExceptionEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.6.1.3

SNMP Trap Number : 1

Variables

The InternalException message contains the following variables:

Table 1. InternalException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: FTP Internal Notifications
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HTTP Module
The HTTP Module provides HTTP/HTTPS client and server facilities. This section contains details for the
messages delivered from the HTTP Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the HTTP Module.

MIB Name : CASTIRON-COMP-HTTP-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.1

The following table provides an alphabetical list of all notifications that can be issued by the HTTP Module.

Table 1. Notifications issued by the HTTP Module
Notification Level System Description

AcceptEncodingType Info Orchestration The type of Accept-Encoding in the request-header
field.

ClientConMgrTimeout Info Orchestration Setting the client connection manager timeout value.
This is configurable on the JConsole.
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Notification Level System Description

ClientIdleTimeout Info Orchestration The amount of idle time for the connection after
which the connection can be reclaimed. This is
configurable from the JConsole.

ClientMaxTotalConn Info Orchestration Setting the client connection manager maximum
number of connections from the JConsole.

ClientReclaimPeriod Info Orchestration The number of seconds to wait before the reclaim
thread is run to reclaim an idle connection. This is set
from the JConsole.

CommonHandlerError Severe Orchestration An error occurred handling the request received by
the activity. Possible reasons are I/O or operation
exceptions.

CompressFormat Info Orchestration Indicates the type of Content-Encoding in the
response from the server.

ConnectionRetry Warning Orchestration The send request operation failed while trying to
connect to the server. This will cause a retry.

ContentEncodingType Info Orchestration The type of Content-Encoding used in the header in
the outgoing request.

DecompressedEncoding Info Orchestration Content-Encoding of the incoming request to the
receive activity.

EndpointInformation Info Orchestration Request for endpoint information.

GeneralRequestFailed Severe Orchestration The send request failed while executing the activity.

HttpListenerStop Info Orchestration Information regarding the stopping of a listener on a
specific port.

HttpLoopBackValues Info Orchestration Loopback port values set by the user, on the
JConsole, and persisted in the sysconf.

IdleConTimeoutStart Info Orchestration The idle connection timeout thread is enabled.

IdleConTimeoutStop Info Orchestration The idle connection thread is disabled.

IncomingContentEnc Info Orchestration The Content-Encoding type in the request header
received by the receive activity

LoopBackInitialize Info Orchestration Loopback values for initializing the MBean. It is set on
the JConsole.

ReadConnectionParam Info Orchestration The input connection parameter is not mapped by the
user.

ReadInputHeaders Info Orchestration The input parameter header is not mapped by the
user.

ReceiveActivate Severe Orchestration The receive activity failed to activate.

ReceiveDeActivate Severe Orchestration The receive activity failed to stop.

ReceiveIOError Severe Orchestration An I/O error occurred while the receive activity
processed the request. Possible cause might be a
broken connection.

 1511



Notification Level System Description

ReceiveInternalError Severe Orchestration An error occurred while the receive activity processed
the request.

ReceiveOperationError Severe Orchestration An error occurred while processing the request
received by the receive activity due to an
unsupported Accept-Charset encoding.

ReceiveResponseBody Info Orchestration The response sent by the receive activity to a request.

ReceiveSendReplyError Severe Orchestration A connection problem caused an error while sending
the response from the receive activity.

ReceiveURIPortInfo Info Orchestration Information regarding the URI and Port where the
server is listening.

RegisterKeyStore Severe Orchestration An error occurred while registering the key store.

ReplyCompressFormat Info Orchestration The Content-Encoding used by the send reply activity.

ReplyConnectionError Severe Orchestration An error occurred while sending the response.
Probable cause is a connection error.

ReplyGeneralError Severe Orchestration An internal error occurred while sending the reply
from the receive activity.

ReplyHandlerNull Severe Orchestration Connection handler stored in the receive activity and
retrieved by the reply activity is null. This is an
internal error and likely caused by an out of memory
error or an appliance reboot while executing an
activity.

ReplyUnMarshalHeader Severe Orchestration An error occurred while reading input headers in the
reply activity.

ReplyUnknownError Severe Orchestration An unknown exception occurred while sending the
response to the client.

RequestActivate Severe Orchestration The request activity failed to activate.

RequestIgnoredHeader Info Orchestration The header was ignored because it is not a supported
type. Supported types are gzip, deflate or compress.

RequestParamsDetails Info Orchestration Parameter details, including URL and method, used
for the post activity

ResponseBodyBinary Info Orchestration The response body is binary.

ResponseBodyNotBinary Info Orchestration The response body is not binary.

ResponseDefinition Info Orchestration Response definition received from the server for the
performed post.

SendRequestConnection Severe Orchestration The send request operation failed because a
connection to the server could not be established.

SendRequestOperation Severe Orchestration The Send Request operation failed either while
starting the activity or while executing it. Caused by
an I/O or operation exception.

ServerResponseCode Info Orchestration Post response code received from the server.
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Notification Level System Description

SockCollectorFinish Info Orchestration Information about the completion status of the
Socket Janitor. The Socket Janitor is configured on
the JConsole.

SockCollectorRunInfo Info Orchestration Information about this run of the Socket Janitor. The
Socket Janitor is configured on the JConsole.

SockCollectorSched Info Orchestration Sets the frequency for garbage collection by the
Socket Janitor. It is set on the JConsole.

StaleConnectionCheck Info Orchestration Specifies if the stale connection check should be run
on the connection manager. This is set (True or False)
from the JConsole.

UnSupportedMedia Warning Orchestration Request is an unsupported media type.

UnsolicitedEncoding Severe Orchestration The server reply contains Content-Encoding which is
not acceptable by the client.

UnsupportedEncoding Severe Orchestration The Content-Encoding in the request header is not
supported by the receive activity.

HTTP Connection Notifications
Provides a comprehensive list of connection notifications sent from the HTTP Module.
HTTP Operation Notifications
Provides a comprehensive list of operation notifications sent from the HTTP Module.
HTTP Internal Notifications
Provides a comprehensive list of internal notifications sent from the HTTP Module.

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/http/about_the
_http_module.html

HTTP Connection Notifications
Provides a comprehensive list of connection notifications sent from the HTTP Module.

ClientConMgrTimeout
Setting the client connection manager timeout value. This is configurable on the JConsole.
ClientIdleTimeout
The amount of idle time for the connection after which the connection can be reclaimed. This is
configurable from the JConsole.
ClientMaxTotalConn
Setting the client connection manager maximum number of connections from the JConsole.
ClientReclaimPeriod
The number of seconds to wait before the reclaim thread is run to reclaim an idle connection. This is set
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from the JConsole.
ConnectionRetry
The send request operation failed while trying to connect to the server. This will cause a retry.
EndpointInformation
Request for endpoint information.
HttpLoopBackValues
Loopback port values set by the user, on the JConsole, and persisted in the sysconf.
ReadConnectionParam
The input connection parameter is not mapped by the user.
ReceiveActivate
The receive activity failed to activate.
ReceiveDeActivate
The receive activity failed to stop.
ReceiveIOError
An I/O error occurred while the receive activity processed the request. Possible cause might be a broken
connection.
ReceiveSendReplyError
A connection problem caused an error while sending the response from the receive activity.
ReplyConnectionError
An error occurred while sending the response. Probable cause is a connection error.
SendRequestConnection
The send request operation failed because a connection to the server could not be established.
StaleConnectionCheck
Specifies if the stale connection check should be run on the connection manager. This is set (True or
False) from the JConsole.

Parent topic: HTTP Module
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ClientConMgrTimeout
Setting the client connection manager timeout value. This is configurable on the JConsole.

Level : Info

Log Message : Setting the client connection manager timeout at {TimeoutValue} seconds.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cClientConMgrTimeoutEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 11
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Variables

The ClientConMgrTimeout message contains the following variables:

Table 1. ClientConMgrTimeout Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TimeoutValue

The timeout value set for the client connection manager.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv11TimeoutValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.11.1

Parent topic: HTTP Connection Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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ClientIdleTimeout
The amount of idle time for the connection after which the connection can be reclaimed. This is configurable
from the JConsole.

Level : Info

Log Message : Setting the client connection idle timeout at {TimeoutValue} seconds.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cClientIdleTimeoutEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 13

Variables

The ClientIdleTimeout message contains the following variables:

Table 1. ClientIdleTimeout Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TimeoutValue

The Idle Timeout value set for a client connection.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv13TimeoutValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.13.1

Parent topic: HTTP Connection Notifications
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ClientMaxTotalConn
Setting the client connection manager maximum number of connections from the JConsole.

Level : Info

Log Message : Setting the client connection manager maximum number of connections at {MaxConnections}.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cClientMaxTotalConnEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 12

Variables

The ClientMaxTotalConn message contains the following variables:

Table 1. ClientMaxTotalConn Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MaxConnections

The maximum number of connections for the client connection manager.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv12MaxConnections
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.12.1

Parent topic: HTTP Connection Notifications
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ClientReclaimPeriod
The number of seconds to wait before the reclaim thread is run to reclaim an idle connection. This is set from
the JConsole.
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Level : Info

Log Message : Setting the client connection reclaim period at {ReclaimPeriodValue} seconds.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cClientReclaimPeriodEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 14

Variables

The ClientReclaimPeriod message contains the following variables:

Table 1. ClientReclaimPeriod Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ReclaimPeriodValue

The number of seconds to wait before the reclaim thread is run to reclaim an idle connection.

Type : Integer
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SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv14ReclaimPeriodValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.14.1

Parent topic: HTTP Connection Notifications
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ConnectionRetry
The send request operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to connect to the server. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cConnectionRetryEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 2

Variables

The ConnectionRetry message contains the following variables:

Table 1. ConnectionRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv2RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.2.2

7. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv2TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.2.3

8. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv2IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.2.4

Parent topic: HTTP Connection Notifications

Feedback | Notices
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EndpointInformation
Request for endpoint information.

Level : Info

Log Message : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cEndpointInformationEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 4

Variables

The EndpointInformation message contains the following variables:

Table 1. EndpointInformation Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: HTTP Connection Notifications
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HttpLoopBackValues
Loopback port values set by the user, on the JConsole, and persisted in the sysconf.

Level : Info

Log Message : The loopback port values persisted in the sysconf: {LoopBackString}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cHttpLoopBackValuesEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 9

Variables

The HttpLoopBackValues message contains the following variables:

Table 1. HttpLoopBackValues Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. LoopBackString

String containing the loopback port values set on the JConsole.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv9LoopBackString
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.9.1
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ReadConnectionParam
The input connection parameter is not mapped by the user.

Level : Info
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Log Message : The input connection parameter is not mapped.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cReadConnectionParamEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 3

Variables

The ReadConnectionParam message contains the following variables:

Table 1. ReadConnectionParam Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: HTTP Connection Notifications

Feedback | Notices
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ReceiveActivate
The receive activity failed to activate.

Level : Severe

Log Message : Error while activating the activity. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cReceiveActivateEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 5

Variables

The ReceiveActivate message contains the following variables:

Table 1. ReceiveActivate Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveDeActivate
The receive activity failed to stop.

Level : Severe

Log Message : Error while stopping the receive activity. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cReceiveDeActivateEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 6

Variables

The ReceiveDeActivate message contains the following variables:

Table 1. ReceiveDeActivate Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveIOError
An I/O error occurred while the receive activity processed the request. Possible cause might be a broken
connection.
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Level : Severe

Log Message : An I/O error occurred while processing the request. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cReceiveIOErrorEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 8

Variables

The ReceiveIOError message contains the following variables:

Table 1. ReceiveIOError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveSendReplyError
A connection problem caused an error while sending the response from the receive activity.

Level : Severe

Log Message : A connection error occurred while sending the receive activity response. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cReceiveSendReplyErrorEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 7

Variables

The ReceiveSendReplyError message contains the following variables:

Table 1. ReceiveSendReplyError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: HTTP Connection Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/http/http_conn
ection_receivesendreplyerror_message.html

ReplyConnectionError
An error occurred while sending the response. Probable cause is a connection error.

Level : Severe

Log Message : A connection error occurred while sending the response. Error is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cReplyConnectionErrorEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 10

Variables
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The ReplyConnectionError message contains the following variables:

Table 1. ReplyConnectionError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: HTTP Connection Notifications
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SendRequestConnection
The send request operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Unable to connect to server after {NumberOfRetryAttempts} attempts. Error is: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cSendRequestConnectionEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 1

Variables

The SendRequestConnection message contains the following variables:

Table 1. SendRequestConnection Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv1NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.1.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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StaleConnectionCheck
Specifies if the stale connection check should be run on the connection manager. This is set (True or False)
from the JConsole.

Level : Info

Log Message : Setting the stale connection check at {StaleConnection}.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1cStaleConnectionCheckEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.1

SNMP Trap Number : 15

Variables

The StaleConnectionCheck message contains the following variables:

Table 1. StaleConnectionCheck Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. StaleConnection

Value (True or False) of stale connection check.

Type : Boolean
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1cEv15StaleConnection
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.1.1.15.1
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Provides a comprehensive list of operation notifications sent from the HTTP Module.

AcceptEncodingType
The type of Accept-Encoding in the request-header field.
CommonHandlerError
An error occurred handling the request received by the activity. Possible reasons are I/O or operation
exceptions.
CompressFormat
Indicates the type of Content-Encoding in the response from the server.
ContentEncodingType
The type of Content-Encoding used in the header in the outgoing request.
DecompressedEncoding
Content-Encoding of the incoming request to the receive activity.
HttpListenerStop
Information regarding the stopping of a listener on a specific port.
IncomingContentEnc
The Content-Encoding type in the request header received by the receive activity
ReadInputHeaders
The input parameter header is not mapped by the user.
ReceiveOperationError
An error occurred while processing the request received by the receive activity due to an unsupported
Accept-Charset encoding.
ReceiveResponseBody
The response sent by the receive activity to a request.
ReceiveURIPortInfo
Information regarding the URI and Port where the server is listening.
RegisterKeyStore
An error occurred while registering the key store.
ReplyCompressFormat
The Content-Encoding used by the send reply activity.
ReplyUnMarshalHeader
An error occurred while reading input headers in the reply activity.
RequestActivate
The request activity failed to activate.
RequestIgnoredHeader
The header was ignored because it is not a supported type. Supported types are gzip, deflate or
compress.
RequestParamsDetails
Parameter details, including URL and method, used for the post activity
ResponseBodyBinary
The response body is binary.
ResponseBodyNotBinary
The response body is not binary.
ResponseDefinition
Response definition received from the server for the performed post.
SendRequestOperation
The Send Request operation failed either while starting the activity or while executing it. Caused by an
I/O or operation exception.
ServerResponseCode
Post response code received from the server.
UnSupportedMedia
Request is an unsupported media type.
UnsolicitedEncoding
The server reply contains Content-Encoding which is not acceptable by the client.
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UnsupportedEncoding
The Content-Encoding in the request header is not supported by the receive activity.
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AcceptEncodingType
The type of Accept-Encoding in the request-header field.

Level : Info

Log Message : The type of Accept-Encoding in the request-header field is {AcceptEncodingValue}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oAcceptEncodingTypeEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 12

Variables

The AcceptEncodingType message contains the following variables:

Table 1. AcceptEncodingType Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. AcceptEncodingValue

The type of Accept-Encoding header.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv12AcceptEncodingValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.12.1
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CommonHandlerError
An error occurred handling the request received by the activity. Possible reasons are I/O or operation
exceptions.

Level : Severe

Log Message : An error occurred handling a receive request. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oCommonHandlerErrorEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 22

Variables
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The CommonHandlerError message contains the following variables:

Table 1. CommonHandlerError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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CompressFormat
Indicates the type of Content-Encoding in the response from the server.

Level : Info

Log Message : The response Content-Encoding from the server is {ContentEncodingValue}. Decompressing the
body.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oCompressFormatEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 15

Variables

The CompressFormat message contains the following variables:

Table 1. CompressFormat Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ContentEncodingValue

The type of Content-Encoding in the response header.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv15ContentEncodingValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.15.1
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ContentEncodingType
The type of Content-Encoding used in the header in the outgoing request.

Level : Info

Log Message : The Content-Encoding header is {ContentEncodingValue}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oContentEncodingTypeEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 11

Variables

The ContentEncodingType message contains the following variables:

Table 1. ContentEncodingType Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

 1541



Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ContentEncodingValue

The type of Content-Encoding used in the header.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv11ContentEncodingValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.11.1
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DecompressedEncoding
Content-Encoding of the incoming request to the receive activity.

Level : Info

Log Message : The Content-Encoding of the incoming request is {ContentEncodingValue}. Decompressing the
body.

System : Orchestration
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SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oDecompressedEncodingEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 13

Variables

The DecompressedEncoding message contains the following variables:

Table 1. DecompressedEncoding Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ContentEncodingValue

Type of Content-Encoding header.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv13ContentEncodingValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.13.1

Parent topic: HTTP Operation Notifications
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HttpListenerStop
Information regarding the stopping of a listener on a specific port.

Level : Info

Log Message : There are no more activities to listen for on port {PortNumber}. Stopping the listener on port
{PortNumber}.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oHttpListenerStopEv24

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 24

Variables

The HttpListenerStop message contains the following variables:

Table 1. HttpListenerStop Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. PortNumber

Port number where the listener is stopped.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv24PortNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.24.1
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IncomingContentEnc
The Content-Encoding type in the request header received by the receive activity

Level : Info

Log Message : Content-Encoding header received: {ContentEncodingHeader}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oIncomingContentEncEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 19

Variables

The IncomingContentEnc message contains the following variables:

Table 1. IncomingContentEnc Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ContentEncodingHeader

The type of Content-Encoding in the request header.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv19ContentEncodingHeader
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.19.1
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ReadInputHeaders
The input parameter header is not mapped by the user.

Level : Info

Log Message : The input parameter header is not set.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oReadInputHeadersEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 5

Variables

The ReadInputHeaders message contains the following variables:

Table 1. ReadInputHeaders Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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ReceiveOperationError
An error occurred while processing the request received by the receive activity due to an unsupported Accept-
Charset encoding.

Level : Severe

Log Message : An error occurred while trying to process an unsupported Accept-Charset encoding. Exception:
{Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oReceiveOperationErrorEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 18

Variables

The ReceiveOperationError message contains the following variables:

Table 1. ReceiveOperationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveResponseBody
The response sent by the receive activity to a request.

Level : Info

Log Message : Response is : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oReceiveResponseBodyEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 21

Variables

 1549



The ReceiveResponseBody message contains the following variables:

Table 1. ReceiveResponseBody Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveURIPortInfo
Information regarding the URI and Port where the server is listening.

Level : Info

Log Message : Parameters: URI: "{URIValue}", Port: {PortValue}.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oReceiveURIPortInfoEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 23

Variables

The ReceiveURIPortInfo message contains the following variables:

Table 1. ReceiveURIPortInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. URIValue

The URI the server is listening on.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv23URIValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.23.1

6. PortValue

The port number the server is listening on.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv23PortValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.23.2
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RegisterKeyStore
An error occurred while registering the key store.

Level : Severe

Log Message : An error occurred while setting the key store. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oRegisterKeyStoreEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 17

Variables

The RegisterKeyStore message contains the following variables:

Table 1. RegisterKeyStore Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReplyCompressFormat
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The Content-Encoding used by the send reply activity.

Level : Info

Log Message : The response Content-Encoding is {ContentEncodingValue}.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oReplyCompressFormatEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 14

Variables

The ReplyCompressFormat message contains the following variables:

Table 1. ReplyCompressFormat Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ContentEncodingValue

The type of Content-Encoding header.
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Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv14ContentEncodingValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.14.1
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ReplyUnMarshalHeader
An error occurred while reading input headers in the reply activity.

Level : Severe

Log Message : An error occurred while reading headers. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oReplyUnMarshalHeaderEv25

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 25

Variables

The ReplyUnMarshalHeader message contains the following variables:

Table 1. ReplyUnMarshalHeader Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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RequestActivate
The request activity failed to activate.

Level : Severe

Log Message : An exception occurred while activating the activity. The exception is :{Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oRequestActivateEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 16

Variables
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The RequestActivate message contains the following variables:

Table 1. RequestActivate Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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RequestIgnoredHeader
The header was ignored because it is not a supported type. Supported types are gzip, deflate or compress.

Level : Info

Log Message : The Value:"{HeaderVal}" set for Http Header:"{HeaderName}" was ignored because the type is not
supported.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oRequestIgnoredHeaderEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 1

Variables

The RequestIgnoredHeader message contains the following variables:

Table 1. RequestIgnoredHeader Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. HeaderVal

The incorrect type.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv1HeaderVal
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.1.1

6. HeaderName

The header containing the incorrect type.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv1HeaderName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.1.2
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RequestParamsDetails
Parameter details, including URL and method, used for the post activity

Level : Info

Log Message : Parameters: URL: "{URL}", Method: "{MethodName}".

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oRequestParamsDetailsEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 6

Variables

The RequestParamsDetails message contains the following variables:

Table 1. RequestParamsDetails Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. URL

The URL used to perform Http post.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv6URL
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.6.1

6. MethodName

Method specified for the post activity

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv6MethodName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.6.2

Parent topic: HTTP Operation Notifications

Feedback | Notices
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ResponseBodyBinary
The response body is binary.

Level : Info

Log Message : The response is binary.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oResponseBodyBinaryEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 9

Variables

The ResponseBodyBinary message contains the following variables:

Table 1. ResponseBodyBinary Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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ResponseBodyNotBinary
The response body is not binary.

Level : Info

Log Message : The response is not binary.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oResponseBodyNotBinaryEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 10

Variables

The ResponseBodyNotBinary message contains the following variables:

Table 1. ResponseBodyNotBinary Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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ResponseDefinition
Response definition received from the server for the performed post.

Level : Info

Log Message : Response definition received from the server: {ResponseDef}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oResponseDefinitionEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 8

Variables

The ResponseDefinition message contains the following variables:

Table 1. ResponseDefinition Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ResponseDef

Response message received from the server. For example, OK for success.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv8ResponseDef
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.8.1
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The Send Request operation failed either while starting the activity or while executing it. Caused by an I/O or
operation exception.

Level : Severe

Log Message : The request operation failed. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oSendRequestOperationEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 3

Variables

The SendRequestOperation message contains the following variables:

Table 1. SendRequestOperation Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message
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Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ServerResponseCode
Post response code received from the server.

Level : Info

Log Message : Post response code received from the server: {ResponseCode}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oServerResponseCodeEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 7

Variables

The ServerResponseCode message contains the following variables:

Table 1. ServerResponseCode Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ResponseCode

Response code received from the server. For example, 200 is for success.

Type : Integer
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv7ResponseCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.7.1
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UnSupportedMedia
Request is an unsupported media type.

Level : Warning

Log Message : Request is an unsupported media type. Response definition: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oUnSupportedMediaEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 4
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Variables

The UnSupportedMedia message contains the following variables:

Table 1. UnSupportedMedia Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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UnsolicitedEncoding
The server reply contains Content-Encoding which is not acceptable by the client.

Level : Severe

Log Message : The server response contained an unsolicited Content-Encoding: {ContentEncoding}. Acceptable
values are: {AcceptEncoding}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oUnsolicitedEncodingEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 2

Variables

The UnsolicitedEncoding message contains the following variables:

Table 1. UnsolicitedEncoding Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ContentEncoding

The Content-Encoding in the server reply.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv2ContentEncoding
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.2.1

6. AcceptEncoding

Encodings which are acceptable by the client.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1oEv2AcceptEncoding
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.2.1.2.2
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UnsupportedEncoding
The Content-Encoding in the request header is not supported by the receive activity.

Level : Severe

Log Message : Exception : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1oUnsupportedEncodingEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.2

SNMP Trap Number : 20

Variables

The UnsupportedEncoding message contains the following variables:
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Table 1. UnsupportedEncoding Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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HTTP Internal Notifications
Provides a comprehensive list of internal notifications sent from the HTTP Module.

GeneralRequestFailed
The send request failed while executing the activity.
IdleConTimeoutStart
The idle connection timeout thread is enabled.
IdleConTimeoutStop
The idle connection thread is disabled.
LoopBackInitialize
Loopback values for initializing the MBean. It is set on the JConsole.
ReceiveInternalError
An error occurred while the receive activity processed the request.
ReplyGeneralError
An internal error occurred while sending the reply from the receive activity.
ReplyHandlerNull
Connection handler stored in the receive activity and retrieved by the reply activity is null. This is an
internal error and likely caused by an out of memory error or an appliance reboot while executing an
activity.
ReplyUnknownError
An unknown exception occurred while sending the response to the client.
SockCollectorFinish
Information about the completion status of the Socket Janitor. The Socket Janitor is configured on the
JConsole.
SockCollectorRunInfo
Information about this run of the Socket Janitor. The Socket Janitor is configured on the JConsole.
SockCollectorSched
Sets the frequency for garbage collection by the Socket Janitor. It is set on the JConsole.
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GeneralRequestFailed
The send request failed while executing the activity.

Level : Severe

Log Message : The send request failed. Exception: {Message}

System : Orchestration
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SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iGeneralRequestFailedEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 1

Variables

The GeneralRequestFailed message contains the following variables:

Table 1. GeneralRequestFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: HTTP Internal Notifications
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IdleConTimeoutStart
The idle connection timeout thread is enabled.

Level : Info

Log Message : Starting the idle connection timeout thread.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iIdleConTimeoutStartEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 10

Variables

The IdleConTimeoutStart message contains the following variables:

Table 1. IdleConTimeoutStart Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String

1574   



SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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IdleConTimeoutStop
The idle connection thread is disabled.

Level : Info

Log Message : Stopping the idle connection timeout thread.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iIdleConTimeoutStopEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 11

Variables

The IdleConTimeoutStop message contains the following variables:

Table 1. IdleConTimeoutStop Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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LoopBackInitialize
Loopback values for initializing the MBean. It is set on the JConsole.

Level : Info

Log Message : Initializing the values in the MBean: {LoopBackString}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iLoopBackInitializeEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 4

Variables

1576   



The LoopBackInitialize message contains the following variables:

Table 1. LoopBackInitialize Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. LoopBackString

String containing the port values set for loopback.

Type : String
SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1iEv4LoopBackString
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.3.1.4.1
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ReceiveInternalError
An error occurred while the receive activity processed the request.

Level : Severe

Log Message : An error occurred while processing the request. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iReceiveInternalErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 3

Variables

The ReceiveInternalError message contains the following variables:

Table 1. ReceiveInternalError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReplyGeneralError
An internal error occurred while sending the reply from the receive activity.

Level : Severe

Log Message : A general error occurred while sending the response. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iReplyGeneralErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 2

Variables

The ReplyGeneralError message contains the following variables:

Table 1. ReplyGeneralError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReplyHandlerNull
Connection handler stored in the receive activity and retrieved by the reply activity is null. This is an internal
error and likely caused by an out of memory error or an appliance reboot while executing an activity.

Level : Severe

Log Message : Connection handler retrieved from the call context is Null!

System : Orchestration
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SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iReplyHandlerNullEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 5

Variables

The ReplyHandlerNull message contains the following variables:

Table 1. ReplyHandlerNull Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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ReplyUnknownError
An unknown exception occurred while sending the response to the client.

Level : Severe

Log Message : An unknown exception occurred while sending the response to the client. Exception: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iReplyUnknownErrorEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 6

Variables

The ReplyUnknownError message contains the following variables:

Table 1. ReplyUnknownError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SockCollectorFinish
Information about the completion status of the Socket Janitor. The Socket Janitor is configured on the
JConsole.

Level : Info

Log Message : The Socket Janitor has completed this run.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iSockCollectorFinishEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 9

Variables

The SockCollectorFinish message contains the following variables:

Table 1. SockCollectorFinish Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

 1583



Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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SockCollectorRunInfo
Information about this run of the Socket Janitor. The Socket Janitor is configured on the JConsole.

Level : Info

Log Message : Information about this run of the Socket Janitor.

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iSockCollectorRunInfoEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 8

Variables
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The SockCollectorRunInfo message contains the following variables:

Table 1. SockCollectorRunInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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SockCollectorSched
Sets the frequency for garbage collection by the Socket Janitor. It is set on the JConsole.
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Level : Info

Log Message : Schedules the Socket Janitor to run every {TimeInterval}

System : Orchestration

SNMP Name : CASTIRON-COMP-HTTP-MIB::ciC1iSockCollectorSchedEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.1.1.3

SNMP Trap Number : 7

Variables

The SockCollectorSched message contains the following variables:

Table 1. SockCollectorSched Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TimeInterval

The time interval between runs of the Socket Janitor.

Type : Integer
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SNMP Object Name : CASTIRON-COMP-HTTP-MIB::ciC1iEv7TimeInterval
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.1.1.3.1.7.1
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JD Edwards Module
JD Edwards Module. This section contains details for the messages delivered from the JD Edwards Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the JD Edwards Module.

MIB Name : CASTIRON-COMP-JDE-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.15

The following table provides an alphabetical list of all notifications that can be issued by the JD Edwards
Module.

Table 1. Notifications issued by the JD Edwards Module
Notification Level System Description

ActivateSuccessful Info Orchestration JDE activity was activated successfully.

ActivateUnSuccessful Info Orchestration The activity which was not activated successfully.
Activity activated, will try to establish connectivity at
activity execute time.

ActivityError Severe Orchestration The specified activity was not successful.

ActivitySuccessful Info Orchestration The specified activity was successful.

ClassesMissing Severe Orchestration JDE is missing classes required to start the activity.
Please install the libraries from the WMC.

CloseConnectionError Severe Orchestration Error occurred while closing the connection to JDE.

ConnectException Warning Orchestration Error while connecting to JDE.

ConnectPoolRelease Warning Orchestration There was an error while closing the connection pool.

CreateSchemaError Severe Orchestration Error occurred while creating request schema for the
business function.

DataStructureError Severe Orchestration Error occurred while creating a schema for the
business function name.

DisconnectException Warning Orchestration Error while disconnecting from JDE.
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Notification Level System Description

GetConnectionError Severe Orchestration Error occurred while creating a connection to JDE.

JDEConnectError Severe Orchestration The JDE operation failed because a connection to the
server could not be established.

JDEInternalerror Severe Orchestration Error occurred while processing the request.

JDERetryError Warning Orchestration The JDE operation failed while trying to connect to
the server. This will cause a retry.

MakeConnectionError Warning Orchestration There was an error while creating a connection to
destination.

NumberFormatError Warning Orchestration There was an error due to invalid port number.

ResourceCleanError Severe Orchestration Error occurred while closing the statement or result
set in database.

ResponseSchemaError Severe Orchestration Error occurred while creating response schema for
the business function.

SetUpInfo Warning Orchestration JDE activity got warning or error messages while
setting up the specified activity.

UnSupportedEncoding Severe Orchestration Error while processing unsupported encoding.

JD Edwards Connection Notifications
Provides a comprehensive list of connection notifications sent from the JD Edwards Module.
JD Edwards Operation Notifications
Provides a comprehensive list of operation notifications sent from the JD Edwards Module.
JD Edwards Internal Notifications
Provides a comprehensive list of internal notifications sent from the JD Edwards Module.
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JD Edwards Connection Notifications
Provides a comprehensive list of connection notifications sent from the JD Edwards Module.

ActivateUnSuccessful
The activity which was not activated successfully. Activity activated, will try to establish connectivity at
activity execute time.
CloseConnectionError
Error occurred while closing the connection to JDE.
ConnectException
Error while connecting to JDE.
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ConnectPoolRelease
There was an error while closing the connection pool.
DisconnectException
Error while disconnecting from JDE.
GetConnectionError
Error occurred while creating a connection to JDE.
JDEConnectError
The JDE operation failed because a connection to the server could not be established.
JDERetryError
The JDE operation failed while trying to connect to the server. This will cause a retry.
MakeConnectionError
There was an error while creating a connection to destination.
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ActivateUnSuccessful
The activity which was not activated successfully. Activity activated, will try to establish connectivity at activity
execute time.

Level : Info

Log Message : Error connecting to JDE system while activating activity {ActivityName}, error is: {Message}.
Activity activated, will try to establish connectivity at activity execute time

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15cActivateUnSuccessfulEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.1

SNMP Trap Number : 1

Variables

The ActivateUnSuccessful message contains the following variables:

Table 1. ActivateUnSuccessful Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity which was activated successfully.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15cEv1ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.1.1.1.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JD Edwards Connection Notifications
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CloseConnectionError
Error occurred while closing the connection to JDE.

Level : Severe

Log Message : Exception while closing connection to JDE. The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15cCloseConnectionErrorEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.1

SNMP Trap Number : 8

Variables

The CloseConnectionError message contains the following variables:

Table 1. CloseConnectionError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ConnectException
Error while connecting to JDE.

Level : Warning

Log Message : Error while connecting to JDE. The error is : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15cConnectExceptionEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.1

SNMP Trap Number : 6

Variables

The ConnectException message contains the following variables:

Table 1. ConnectException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ConnectPoolRelease
There was an error while closing the connection pool.

Level : Warning

Log Message : Error while closing the connection pool. The error is: {Message}

System : Orchestration
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SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15cConnectPoolReleaseEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.1

SNMP Trap Number : 4

Variables

The ConnectPoolRelease message contains the following variables:

Table 1. ConnectPoolRelease Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JD Edwards Connection Notifications
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DisconnectException
Error while disconnecting from JDE.

Level : Warning

Log Message : Error while disconnecting from JDE. The error is : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15cDisconnectExceptionEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.1

SNMP Trap Number : 7

Variables

The DisconnectException message contains the following variables:

Table 1. DisconnectException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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GetConnectionError
Error occurred while creating a connection to JDE.

Level : Severe

Log Message : Exception while creating connection to JDE. The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15cGetConnectionErrorEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.1

SNMP Trap Number : 9

Variables

The GetConnectionError message contains the following variables:

Table 1. GetConnectionError Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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JDEConnectError
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The JDE operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Unable to connect to JDE after {NumberOfRetryAttempts} attempts. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15cJDEConnectErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.1

SNMP Trap Number : 2

Variables

The JDEConnectError message contains the following variables:

Table 1. JDEConnectError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfRetryAttempts

The total number of attempted retries.

1598   



Type : Integer
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15cEv2NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.1.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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JDERetryError
The JDE operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Connection error while executing activity {ActivityName}. The error is: {Message}. Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s)

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15cJDERetryErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.1

SNMP Trap Number : 3

Variables

The JDERetryError message contains the following variables:

Table 1. JDERetryError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity which faced errors.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15cEv3ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.1.1.3.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

7. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15cEv3RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.1.1.3.3

8. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15cEv3TotalRetryAttempts
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.1.1.3.4

9. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15cEv3IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.1.1.3.5
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MakeConnectionError
There was an error while creating a connection to destination.

Level : Warning

Log Message : Error while creating the connection to destination. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15cMakeConnectionErrorEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.1

SNMP Trap Number : 5

Variables

The MakeConnectionError message contains the following variables:

Table 1. MakeConnectionError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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JD Edwards Operation Notifications
Provides a comprehensive list of operation notifications sent from the JD Edwards Module.

ActivateSuccessful
JDE activity was activated successfully.
ActivityError
The specified activity was not successful.
ActivitySuccessful
The specified activity was successful.
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ClassesMissing
JDE is missing classes required to start the activity. Please install the libraries from the WMC.
CreateSchemaError
Error occurred while creating request schema for the business function.
DataStructureError
Error occurred while creating a schema for the business function name.
NumberFormatError
There was an error due to invalid port number.
ResourceCleanError
Error occurred while closing the statement or result set in database.
ResponseSchemaError
Error occurred while creating response schema for the business function.
SetUpInfo
JDE activity got warning or error messages while setting up the specified activity.
UnSupportedEncoding
Error while processing unsupported encoding.
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ActivateSuccessful
JDE activity was activated successfully.

Level : Info

Log Message : Activity {ActivityName} activated successfully

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oActivateSuccessfulEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 5

Variables

The ActivateSuccessful message contains the following variables:

Table 1. ActivateSuccessful Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity which was activated successfully.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv5ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.5.1
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ActivityError
The specified activity was not successful.
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Level : Severe

Log Message : Error while trying to execute activity {ActivityName}. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oActivityErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 4

Variables

The ActivityError message contains the following variables:

Table 1. ActivityError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity which was not successful.

Type : String
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SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv4ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.4.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JD Edwards Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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ActivitySuccessful
The specified activity was successful.

Level : Info

Log Message : {ActivityName} executed and outputted response output parameter

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oActivitySuccessfulEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 3

Variables

The ActivitySuccessful message contains the following variables:

Table 1. ActivitySuccessful Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity which was successful.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv3ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.3.1

Parent topic: JD Edwards Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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ClassesMissing
JDE is missing classes required to start the activity. Please install the libraries from the WMC.

Level : Severe

Log Message : Missing classes when trying to start activity {ActivityName}. JDE library may need to be installed
on the appliance. Error is: {Message}

System : Orchestration

 1607



SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oClassesMissingEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 1

Variables

The ClassesMissing message contains the following variables:

Table 1. ClassesMissing Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which failed.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv1ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.1.1

6. Message
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Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JD Edwards Operation Notifications
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CreateSchemaError
Error occurred while creating request schema for the business function.

Level : Severe

Log Message : Exception while creating request schema for the business function {FunctionName}, function code
{FunctionCode} , module code {ModuleCode}. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oCreateSchemaErrorEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 8

Variables

The CreateSchemaError message contains the following variables:

Table 1. CreateSchemaError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FunctionName

The name of function for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv8FunctionName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.8.1

6. FunctionCode

The code of function for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv8FunctionCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.8.2

7. ModuleCode

The code of module for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv8ModuleCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.8.3

8. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JD Edwards Operation Notifications
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DataStructureError
Error occurred while creating a schema for the business function name.

Level : Severe

Log Message : Exception while creating a schema for the business function name {FunctionName}, function code
{FunctionCode}, module code {ModuleCode}. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oDataStructureErrorEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 11

Variables

The DataStructureError message contains the following variables:

Table 1. DataStructureError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FunctionName

The name of function for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv11FunctionName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.11.1

6. FunctionCode

The code of function for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv11FunctionCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.11.2

7. ModuleCode

The code of module for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv11ModuleCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.11.3

8. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JD Edwards Operation Notifications
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NumberFormatError
There was an error due to invalid port number.

Level : Warning

Log Message : Invalid port number : {PortNumber}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oNumberFormatErrorEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 6

Variables

The NumberFormatError message contains the following variables:

Table 1. NumberFormatError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. PortNumber

The invalid port number which was entered.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv6PortNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.6.1

Parent topic: JD Edwards Operation Notifications
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ResourceCleanError
Error occurred while closing the statement or result set in database.

Level : Severe

Log Message : Exception while closing the statement or result set. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oResourceCleanErrorEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 10

Variables

The ResourceCleanError message contains the following variables:

Table 1. ResourceCleanError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JD Edwards Operation Notifications
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ResponseSchemaError
Error occurred while creating response schema for the business function.

Level : Severe

Log Message : Exception while creating request schema for the business function {FunctionName}, function code
{FunctionCode} , module code {ModuleCode}. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oResponseSchemaErrorEv9
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 9

Variables

The ResponseSchemaError message contains the following variables:

Table 1. ResponseSchemaError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FunctionName

The name of function for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv9FunctionName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.9.1

6. FunctionCode

The code of function for which error occurred.
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Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv9FunctionCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.9.2

7. ModuleCode

The code of module for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv9ModuleCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.9.3

8. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SetUpInfo
JDE activity got warning or error messages while setting up the specified activity.

Level : Warning

Log Message : Warning/error messages while doing setup for {ActivityName}: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oSetUpInfoEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 2

Variables

The SetUpInfo message contains the following variables:

Table 1. SetUpInfo Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which faced warnings or error.

Type : String
SNMP Object Name : CASTIRON-COMP-JDE-MIB::ciC15oEv2ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.15.1.2.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JD Edwards Operation Notifications

Feedback | Notices
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UnSupportedEncoding
Error while processing unsupported encoding.

Level : Severe

Log Message : Error while processing unsupported encoding. Exception : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15oUnSupportedEncodingEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.2

SNMP Trap Number : 7

Variables

The UnSupportedEncoding message contains the following variables:

Table 1. UnSupportedEncoding Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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JD Edwards Internal Notifications
Provides a comprehensive list of internal notifications sent from the JD Edwards Module.

JDEInternalerror
Error occurred while processing the request.

Parent topic: JD Edwards Module

Feedback | Notices
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JDEInternalerror
Error occurred while processing the request.

Level : Severe
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Log Message : Error while processing request. Exception : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JDE-MIB::ciC15iJDEInternalerrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.15.1.3

SNMP Trap Number : 1

Variables

The JDEInternalerror message contains the following variables:

Table 1. JDEInternalerror Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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JMS Module
JMS Module. This section contains details for the messages delivered from the JMS Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the JMS Module.

MIB Name : CASTIRON-COMP-JMS-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.8

The following table provides an alphabetical list of all notifications that can be issued by the JMS Module.

Table 1. Notifications issued by the JMS Module
Notification Level System Description

ConnectionPoolError Warning Orchestration Error occurred while returning connection to the pool.
Continuing the activity.

FactoryUnknownError Severe Orchestration Unknown exception while looking up the connection
factory

FirstID Warning Orchestration The appliance is in recovery mode and the first
message specified is not matching the id specified of
delivered message. Messages in the queue is
tampered and will impact the delivery of messages

GetConnectRetry Warning Orchestration The JMS operation failed while trying to connect to
the server. This will cause a retry.

GetMarshallError Severe Orchestration Error occurred while marshalling the JMS message.

JMSError Severe Orchestration Error occurred while getting message from the
provider.

LibraryNotInstalled Severe Orchestration This error may be due to JMS Provider library being
not installed on the appliance. Please install the JMS
provider library using Web management console.

MakeConnectError Severe Orchestration Error occurred while creating the connection to
destination.

NamingException Severe Orchestration Naming exception occurred while getting message
from destination.
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Notification Level System Description

NoMessage Info Orchestration There is no message to be retrieved from the
destination specified.

PollMessageError Severe Orchestration Error occurred while getting a message from queue.

PollMessageRetry Warning Orchestration The JMS operation failed while trying to connect to
the server. This will cause a retry.

PoolFactoryError Severe Orchestration Error occurred while looking up for connection
factory.

PoolReleaseError Severe Orchestration Error occurred while closing the connection pool.

PooledConnException Warning Orchestration A JMS Connection exception occurred while the
connection was in the idle pool. This can occur if the
JMS provider terminates the connection ungracefully.

RecoveryInfo Info Orchestration The activity is recovering and its skipping message
with specified id as its already delivered.

RecoveryInfo Info Orchestration The JMS connector is in recovery mode.

RestartError Severe Orchestration Error occurred while trying to restart the subscriber
on the specified topic.

SendConnectRerty Warning Orchestration The JMS operation failed while trying to connect to
the server. This will cause a retry.

SendMarshallError Severe Orchestration Error occurred while unmarshalling the JMS message.

SendMessageError Severe Orchestration Error occurred while sending message.

SendNamingException Severe Orchestration Naming exception occurred while sending message to
destination.

SubscriberConfigError Severe Orchestration Error occurred while configuring the subscriber
activity.

SubscriberConnect Severe Orchestration The JMS operation failed while trying to connect to
the server.

SubscriberError Severe Orchestration Error occurred while subscribing the message. This
message should be re-delivered manually from the
Provider.

SubscriberNameError Severe Orchestration Naming exception occurred while configuring the
subscriber activity.

SubscriberStartInfo Info Orchestration Subscriber started successfully for the specified
topic.

UnsubscribeError Warning Orchestration Error occurred while unsubscribing on the topic.

JMS Connection Notifications
Provides a comprehensive list of connection notifications sent from the JMS Module.
JMS Operation Notifications
Provides a comprehensive list of operation notifications sent from the JMS Module.
JMS Internal Notifications
Provides a comprehensive list of internal notifications sent from the JMS Module.
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JMS Connection Notifications
Provides a comprehensive list of connection notifications sent from the JMS Module.

ConnectionPoolError
Error occurred while returning connection to the pool. Continuing the activity.
FactoryUnknownError
Unknown exception while looking up the connection factory
GetConnectRetry
The JMS operation failed while trying to connect to the server. This will cause a retry.
MakeConnectError
Error occurred while creating the connection to destination.
PollMessageRetry
The JMS operation failed while trying to connect to the server. This will cause a retry.
PoolFactoryError
Error occurred while looking up for connection factory.
PoolReleaseError
Error occurred while closing the connection pool.
PooledConnException
A JMS Connection exception occurred while the connection was in the idle pool. This can occur if the
JMS provider terminates the connection ungracefully.
RecoveryInfo
The JMS connector is in recovery mode.
RestartError
Error occurred while trying to restart the subscriber on the specified topic.
SendConnectRerty
The JMS operation failed while trying to connect to the server. This will cause a retry.
SubscriberConnect
The JMS operation failed while trying to connect to the server.
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ConnectionPoolError
Error occurred while returning connection to the pool. Continuing the activity.

Level : Warning

Log Message : Exception while returning connection to pool. The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cConnectionPoolErrorEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 5

Variables

The ConnectionPoolError message contains the following variables:

Table 1. ConnectionPoolError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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FactoryUnknownError
Unknown exception while looking up the connection factory

Level : Severe

Log Message : Exception while looking up the connection factory {Message}. The exception is unknown error
message from Provider.One of the reason for the error is If the provider is ActiveMQ and the binding file name or
path is not correct.

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cFactoryUnknownErrorEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 11

Variables

The FactoryUnknownError message contains the following variables:

Table 1. FactoryUnknownError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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GetConnectRetry
The JMS operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Connection exception while getting message from the provider. The error code is {ErrorCode} and
message is {ErrorMessage}. The job is retrying {RetryAttemptNumber}, out of {TotalRetryAttempts} attempts to
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connect to JMS provider. The next attempt will be after {IntervalForRetries} seconds.

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cGetConnectRetryEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 1

Variables

The GetConnectRetry message contains the following variables:

Table 1. GetConnectRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorCode

The error code specified in the error message

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv1ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.1.1
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6. ErrorMessage

The error message specified in the error message

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv1ErrorMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.1.2

7. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv1RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.1.3

8. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv1TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.1.4

9. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv1IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.1.5
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MakeConnectError
Error occurred while creating the connection to destination.

Level : Severe

Log Message : Exception while creating the connection to destination. The Exception is {Message}

System : Orchestration
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SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cMakeConnectErrorEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 8

Variables

The MakeConnectError message contains the following variables:

Table 1. MakeConnectError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JMS Connection Notifications
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PollMessageRetry
The JMS operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Connection exception while polling message. The exception is {Message}. The job is retrying
{RetryAttemptNumber} out of {TotalRetryAttempts} attempt to connect to JMS provider. The next attempt will be
after {IntervalForRetries} secs.

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cPollMessageRetryEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 4

Variables

The PollMessageRetry message contains the following variables:

Table 1. PollMessageRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv4RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.4.2

7. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv4TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.4.3

8. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv4IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.4.4
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PoolFactoryError
Error occurred while looking up for connection factory.

Level : Severe

Log Message : Exception while looking up the connection factory {FactoryName}. The exception is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cPoolFactoryErrorEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 7

Variables

The PoolFactoryError message contains the following variables:

Table 1. PoolFactoryError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID

 1633



SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FactoryName

Name of the provider connection factory.

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv7FactoryName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.7.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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PoolReleaseError
Error occurred while closing the connection pool.

Level : Severe

Log Message : Exception while closing the connection pool. The Exception is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cPoolReleaseErrorEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 6

Variables

The PoolReleaseError message contains the following variables:

Table 1. PoolReleaseError Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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PooledConnException
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A JMS Connection exception occurred while the connection was in the idle pool. This can occur if the JMS
provider terminates the connection ungracefully.

Level : Warning

Log Message : Exception received on JMS connection while it was in the idle connections pool. The error code is:
{ErrorCode}, and the exception is: {ErrorMessage}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cPooledConnExceptionEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 12

Variables

The PooledConnException message contains the following variables:

Table 1. PooledConnException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorCode
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The error code specified in the exception

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv12ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.12.1

6. ErrorMessage

The error message specified in the exception

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv12ErrorMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.12.2

Parent topic: JMS Connection Notifications
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RecoveryInfo
The JMS connector is in recovery mode.

Level : Info

Log Message : The jms connector is in recovery mode.

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cRecoveryInfoEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 3

Variables

The RecoveryInfo message contains the following variables:

Table 1. RecoveryInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

 1637



2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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RestartError
Error occurred while trying to restart the subscriber on the specified topic.

Level : Severe

Log Message : Failed to start the subscriber for the topic {TopicName}. Will try to start the subscriber after
{IntervalForRestart} seconds

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cRestartErrorEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 10
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Variables

The RestartError message contains the following variables:

Table 1. RestartError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TopicName

The name of specified topic.

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv10TopicName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.10.1

6. IntervalForRestart

The specified time interval for restart.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv10IntervalForRestart
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.10.2
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SendConnectRerty
The JMS operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Connection exception while sending message. The error code is {ErrorCode} and exception is
{ErrorMessage}. The job is retrying {RetryAttemptNumber} out of {TotalRetryAttempts} attempt to connect to JMS
provider. The next attempt will be after {IntervalForRetries} secs.

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cSendConnectRertyEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 2

Variables

The SendConnectRerty message contains the following variables:

Table 1. SendConnectRerty Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorCode

The error code specified in the error message

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv2ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.2.1

6. ErrorMessage

The error message specified in the error message

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv2ErrorMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.2.2

7. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv2RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.2.3

8. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv2TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.2.4

9. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv2IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.2.5
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SubscriberConnect
The JMS operation failed while trying to connect to the server.

Level : Severe

Log Message : Connection exception in the subscriber. The exception is {Message}. Going to restart the subscriber
after the {IntervalForRestart} secs

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8cSubscriberConnectEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.1

SNMP Trap Number : 9

Variables

The SubscriberConnect message contains the following variables:

Table 1. SubscriberConnect Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. IntervalForRestart

The specified time interval for restart.

Type : Integer
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8cEv9IntervalForRestart
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.1.1.9.2

Parent topic: JMS Connection Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/jms/jms_conne
ction_subscriberconnect_message.html

JMS Operation Notifications
Provides a comprehensive list of operation notifications sent from the JMS Module.

FirstID
The appliance is in recovery mode and the first message specified is not matching the id specified of
delivered message. Messages in the queue is tampered and will impact the delivery of messages
NamingException
Naming exception occurred while getting message from destination.
NoMessage
There is no message to be retrieved from the destination specified.
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RecoveryInfo
The activity is recovering and its skipping message with specified id as its already delivered.
SendMessageError
Error occurred while sending message.
SendNamingException
Naming exception occurred while sending message to destination.
SubscriberConfigError
Error occurred while configuring the subscriber activity.
SubscriberError
Error occurred while subscribing the message. This message should be re-delivered manually from the
Provider.
SubscriberNameError
Naming exception occurred while configuring the subscriber activity.
SubscriberStartInfo
Subscriber started successfully for the specified topic.
UnsubscribeError
Error occurred while unsubscribing on the topic.

Parent topic: JMS Module

Feedback | Notices
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FirstID
The appliance is in recovery mode and the first message specified is not matching the id specified of delivered
message. Messages in the queue is tampered and will impact the delivery of messages

Level : Warning

Log Message : The appliance is in recovery mode and the first message id {JMSMessageID} is not matching the id
{FirstMessageID} of delivered message. Messages in the queue is tampered and will impact the delivery of
messages.

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oFirstIDEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 3

Variables

The FirstID message contains the following variables:

Table 1. FirstID Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. JMSMessageID

JMS message ID specified.

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv3JMSMessageID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.3.1

6. FirstMessageID

First message ID specified.

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv3FirstMessageID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.3.2

Parent topic: JMS Operation Notifications
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NamingException
Naming exception occurred while getting message from destination.

Level : Severe

Log Message : Naming exception while getting message to destination. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oNamingExceptionEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 1

Variables

The NamingException message contains the following variables:

Table 1. NamingException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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NoMessage
There is no message to be retrieved from the destination specified.

Level : Info

Log Message : There is no message to be retrieved from the destination {Destination}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oNoMessageEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 2

Variables

The NoMessage message contains the following variables:

Table 1. NoMessage Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Destination

The destination from which message was to be retrieved.

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv2Destination
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.2.1

Parent topic: JMS Operation Notifications
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RecoveryInfo
The activity is recovering and its skipping message with specified id as its already delivered.
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Level : Info

Log Message : The activity is recovering and the message with id: {MessageID} is already delivered. Skipping it

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oRecoveryInfoEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 6

Variables

The RecoveryInfo message contains the following variables:

Table 1. RecoveryInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MessageID

The message ID specified.

Type : String
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SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv6MessageID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.6.1
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SendMessageError
Error occurred while sending message.

Level : Severe

Log Message : Exception while sending message. The error code is {ErrorCode} and message is {ErrorMessage}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oSendMessageErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 4

Variables

The SendMessageError message contains the following variables:

Table 1. SendMessageError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorCode

The error code specified in the error message

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv4ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.4.1

6. ErrorMessage

The error message specified in the error message

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv4ErrorMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.4.2
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SendNamingException
Naming exception occurred while sending message to destination.

Level : Severe

Log Message : Naming exception while sending message to destination. The exception is {Message} not found

System : Orchestration
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SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oSendNamingExceptionEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 5

Variables

The SendNamingException message contains the following variables:

Table 1. SendNamingException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JMS Operation Notifications
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SubscriberConfigError
Error occurred while configuring the subscriber activity.

Level : Severe

Log Message : Exception while configuring the subscriber activity. The exception is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oSubscriberConfigErrorEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 8

Variables

The SubscriberConfigError message contains the following variables:

Table 1. SubscriberConfigError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JMS Operation Notifications
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SubscriberError
Error occurred while subscribing the message. This message should be re-delivered manually from the
Provider.

Level : Severe

Log Message : Exception in subscribing the message. The Exception is: {Message} for message id: {MessageID},
This message should be re-delivered manually from the Provider.

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oSubscriberErrorEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 7

Variables

The SubscriberError message contains the following variables:
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Table 1. SubscriberError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. MessageID

The message ID specified.

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv7MessageID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.7.2

Parent topic: JMS Operation Notifications
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SubscriberNameError
Naming exception occurred while configuring the subscriber activity.

Level : Severe

Log Message : Naming exception while configuring the subscriber activity. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oSubscriberNameErrorEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 9

Variables

The SubscriberNameError message contains the following variables:

Table 1. SubscriberNameError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JMS Operation Notifications
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SubscriberStartInfo
Subscriber started successfully for the specified topic.

Level : Info

Log Message : Subscriber started successfully for the topic {TopicName}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oSubscriberStartInfoEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 11

Variables

The SubscriberStartInfo message contains the following variables:

Table 1. SubscriberStartInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

 1657



Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TopicName

The name of specified topic.

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv11TopicName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.11.1

Parent topic: JMS Operation Notifications
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UnsubscribeError
Error occurred while unsubscribing on the topic.
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Level : Warning

Log Message : Exception while unsubscribing on the topic {Topic}. The error code is {ErrorCode} and message is
{Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8oUnsubscribeErrorEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.2

SNMP Trap Number : 10

Variables

The UnsubscribeError message contains the following variables:

Table 1. UnsubscribeError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Topic

Name of the topic destination being unsubscribed.
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Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv10Topic
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.10.1

6. ErrorCode

The error code specified in the error message

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8oEv10ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.2.1.10.2

7. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JMS Operation Notifications
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JMS Internal Notifications
Provides a comprehensive list of internal notifications sent from the JMS Module.

GetMarshallError
Error occurred while marshalling the JMS message.
JMSError
Error occurred while getting message from the provider.
LibraryNotInstalled
This error may be due to JMS Provider library being not installed on the appliance. Please install the JMS
provider library using Web management console.
PollMessageError
Error occurred while getting a message from queue.
SendMarshallError
Error occurred while unmarshalling the JMS message.

Parent topic: JMS Module
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GetMarshallError
Error occurred while marshalling the JMS message.

Level : Severe

Log Message : Exception while marshalling the jms message. The exception is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8iGetMarshallErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.3

SNMP Trap Number : 1

Variables

The GetMarshallError message contains the following variables:

Table 1. GetMarshallError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JMS Internal Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/jms/jms_intern
al_getmarshallerror_message.html

JMSError
Error occurred while getting message from the provider.

Level : Severe

Log Message : Exception while getting message from the provider. The error code is {ErrorCode} and message is
{ErrorMessage}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8iJMSErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.3

SNMP Trap Number : 2

Variables

The JMSError message contains the following variables:

Table 1. JMSError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorCode

The error code specified in the error message

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8iEv2ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.3.1.2.1

6. ErrorMessage

The error message specified in the error message

Type : String
SNMP Object Name : CASTIRON-COMP-JMS-MIB::ciC8iEv2ErrorMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.8.1.3.1.2.2

Parent topic: JMS Internal Notifications
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LibraryNotInstalled
This error may be due to JMS Provider library being not installed on the appliance. Please install the JMS
provider library using Web management console.

Level : Severe

Log Message : This error may be due to JMS Provider library being not installed on the appliance. Please install
the JMS provider library using Web management console. The error is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8iLibraryNotInstalledEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.3

SNMP Trap Number : 5

Variables

The LibraryNotInstalled message contains the following variables:

Table 1. LibraryNotInstalled Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JMS Internal Notifications
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PollMessageError
Error occurred while getting a message from queue.

Level : Severe

Log Message : Exception while getting the message from the queue. The Exception is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8iPollMessageErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.3

SNMP Trap Number : 4

Variables

The PollMessageError message contains the following variables:

Table 1. PollMessageError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JMS Internal Notifications
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SendMarshallError
Error occurred while unmarshalling the JMS message.

Level : Severe
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Log Message : Exception while unmarshalling the jms message. The exception is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JMS-MIB::ciC8iSendMarshallErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.8.1.3

SNMP Trap Number : 3

Variables

The SendMarshallError message contains the following variables:

Table 1. SendMarshallError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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JSON Module
The JSON Module provides activities for generating and parsing JSON content. This section contains details for
the messages delivered from the JSON Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the JSON Module.

MIB Name : CASTIRON-COMP-JSON-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.21

The following table provides an alphabetical list of all notifications that can be issued by the JSON Module.

Table 1. Notifications issued by the JSON Module
Notification Level System Description

JSONParseError Severe Orchestratio
n

There was an error while parsing the JSON.

JSONSerializeError Severe Orchestratio
n

There was an error while serializing the JSON.

TransformError Severe Orchestratio
n

There was an error while transforming the JSON.

JSON Operation Notifications
Provides a comprehensive list of operation notifications sent from the JSON Module.
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JSON Operation Notifications
Provides a comprehensive list of operation notifications sent from the JSON Module.

JSONParseError
There was an error while parsing the JSON.
JSONSerializeError
There was an error while serializing the JSON.
TransformError
There was an error while transforming the JSON.

Parent topic: JSON Module
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JSONParseError
There was an error while parsing the JSON.

Level : Severe

Log Message : Failed to parse JSON, error was: {ErrorMessage}

System : Orchestration

SNMP Name : CASTIRON-COMP-JSON-MIB::ciC21oJSONParseErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.21.1.2

SNMP Trap Number : 1

Variables

The JSONParseError message contains the following variables:

Table 1. JSONParseError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorMessage

The error message returned while parsing the JSON.

Type : String
SNMP Object Name : CASTIRON-COMP-JSON-MIB::ciC21oEv1ErrorMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.21.1.2.1.1.1

Parent topic: JSON Operation Notifications
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JSONSerializeError
There was an error while serializing the JSON.

Level : Severe

Log Message : Failed to serialize JSON, error was: {Message}

System : Orchestration
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SNMP Name : CASTIRON-COMP-JSON-MIB::ciC21oJSONSerializeErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.21.1.2

SNMP Trap Number : 3

Variables

The JSONSerializeError message contains the following variables:

Table 1. JSONSerializeError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JSON Operation Notifications
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TransformError
There was an error while transforming the JSON.

Level : Severe

Log Message : Failed to transform JSON, error was: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-JSON-MIB::ciC21oTransformErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.21.1.2

SNMP Trap Number : 4

Variables

The TransformError message contains the following variables:

Table 1. TransformError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: JSON Operation Notifications
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Log Module
The Log activity allows users to log messages in the orchestration This section contains details for the
messages delivered from the Log Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Log Module.

MIB Name : CASTIRON-COMP-LOGACTIVITY-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.25

The following table provides an alphabetical list of all notifications that can be issued by the Log Module.

Table 1. Notifications issued by the Log Module
Notification Level System Description

FailLogMessage Severe Orchestratio
n

The Log activity failed.

Log Operation Notifications
Provides a comprehensive list of operation notifications sent from the Log Module.
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Log Operation Notifications
Provides a comprehensive list of operation notifications sent from the Log Module.

FailLogMessage
The Log activity failed.
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FailLogMessage
The Log activity failed.

Level : Severe

Log Message : Failed to log message, error was {ErrorMsg}.

System : Orchestration

SNMP Name : CASTIRON-COMP-LOGACTIVITY-MIB::ciC25oFailLogMessageEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.25.1.2

SNMP Trap Number : 1

Variables

The FailLogMessage message contains the following variables:

Table 1. FailLogMessage Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorMsg

The log activity failed due to this error.

Type : String
SNMP Object Name : CASTIRON-COMP-LOGACTIVITY-MIB::ciC25oEv1ErrorMsg
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.25.1.2.1.1.1

Parent topic: Log Operation Notifications
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The MIME Module provides activities for creating and parsing Multipurpose Internet Mail Extensions. This
section contains details for the messages delivered from the MIME Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the MIME Module.

MIB Name : CASTIRON-COMP-MIME-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.10

The following table provides an alphabetical list of all notifications that can be issued by the MIME Module.

Table 1. Notifications issued by the MIME Module
Notification Level System Description

AttachmentNumber Info Orchestration Activity is processing the specified attachment
number.

AttachmentsFound Info Orchestration The activity found specified number of attachments.

AutoGeneratedBody Info Orchestration No boundary value was specified for multiple parts
attachment. Using auto-generated boundary.

BoundaryAbsent Info Orchestration Boundary attribute not set in input parameter
'mimeheader'. Input body being set as entityBody in
first entity of 'parts' output parameter.

BoundaryInfo Info Orchestration Boundary of mime attachment is as specified.

BoundaryMoreThan70 Warning Orchestration Boundary delimiters longer than 70 characters.
Ignoring the specified boundary value. Using auto-
generated boundary.

BoundarySpecified Info Orchestration Activity found boundary in mime message.

DefaultContentType Info Orchestration Activity did not find any content type specified.
Setting content type to text/plain.

EmptyParts Severe Orchestration The input parameter - parts - is empty and there is no
data to serialize.

FoundBoundary Info Orchestration Activity found boundary parameter in the mime
message.

HeaderAbsent Severe Orchestration Empty input parameter 'mimeheader'. was found.
Activity cannot parse data.

InputBodyNull Severe Orchestration Input parameter body from container is NULL. This is
due to internal exception.

MainAndSubType Severe Orchestration The main and sub type found in content type.

MainType Info Orchestration Main type specified in the serialize activity.

MimeHeaderMapped Info Orchestration Optional input parameter 'mimeheader' is mapped.

MimeHeaderNotMapped Info Orchestration Optional input parameter 'mimeheader' was not
mapped in the activity.

NoAttachments Severe Orchestration Activity did not find any attachments to serialize.

NoBoundaryFound Warning Orchestration Boundary was specified in header but no boundary
found in the body. Returning single body.
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Notification Level System Description

NoPartBody Info Orchestration This part does not have any body. Setting blank body.

NumberOfParts Info Orchestration The number of parts found in the mime message.

ParseActivityDone Info Orchestration The activity has outputted parts output parameter.

ParseException Severe Orchestration Error occurred while parsing the data.

SerialActivityDone Info Orchestration The activity is done outputting mimeheader and body
output parameters.

SerializeException Severe Orchestration Error occurred while serializing the data.

SubType Info Orchestration Sub Type found in content type of the message.

TranferEncChanged Warning Orchestration The attachment body has lines greater than 998
characters in length. Changing the Content-Transfer-
Encoding to binary.

TransferEncLimit Severe Orchestration Entities of type specified cannot have any other
Content-Transfer-Encoding apart from 7bit.

TransferEncMissing Warning Orchestration Content-Transfer-Encoding value is missing for
specified attachment number . Guessing based on
Content-Type and charset values.

TransferEncodingError Severe Orchestration Content-Transfer-Encoding specified in Composite
media type cannot be any other apart from 7bit, 8bit
or binary.

TransferEncodingValue Info Orchestration Activity found Content-Transfer-Encoding.

MIME Operation Notifications
Provides a comprehensive list of operation notifications sent from the MIME Module.
MIME Internal Notifications
Provides a comprehensive list of internal notifications sent from the MIME Module.
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MIME Operation Notifications
Provides a comprehensive list of operation notifications sent from the MIME Module.

AttachmentNumber
Activity is processing the specified attachment number.
AttachmentsFound
The activity found specified number of attachments.
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AutoGeneratedBody
No boundary value was specified for multiple parts attachment. Using auto-generated boundary.
BoundaryAbsent
Boundary attribute not set in input parameter 'mimeheader'. Input body being set as entityBody in first
entity of 'parts' output parameter.
BoundaryInfo
Boundary of mime attachment is as specified.
BoundaryMoreThan70
Boundary delimiters longer than 70 characters. Ignoring the specified boundary value. Using auto-
generated boundary.
BoundarySpecified
Activity found boundary in mime message.
DefaultContentType
Activity did not find any content type specified. Setting content type to text/plain.
EmptyParts
The input parameter - parts - is empty and there is no data to serialize.
FoundBoundary
Activity found boundary parameter in the mime message.
HeaderAbsent
Empty input parameter 'mimeheader'. was found. Activity cannot parse data.
MainAndSubType
The main and sub type found in content type.
MainType
Main type specified in the serialize activity.
MimeHeaderMapped
Optional input parameter 'mimeheader' is mapped.
MimeHeaderNotMapped
Optional input parameter 'mimeheader' was not mapped in the activity.
NoAttachments
Activity did not find any attachments to serialize.
NoBoundaryFound
Boundary was specified in header but no boundary found in the body. Returning single body.
NoPartBody
This part does not have any body. Setting blank body.
NumberOfParts
The number of parts found in the mime message.
ParseActivityDone
The activity has outputted parts output parameter.
SerialActivityDone
The activity is done outputting mimeheader and body output parameters.
SerializeException
Error occurred while serializing the data.
SubType
Sub Type found in content type of the message.
TranferEncChanged
The attachment body has lines greater than 998 characters in length. Changing the Content-Transfer-
Encoding to binary.
TransferEncLimit
Entities of type specified cannot have any other Content-Transfer-Encoding apart from 7bit.
TransferEncMissing
Content-Transfer-Encoding value is missing for specified attachment number . Guessing based on
Content-Type and charset values.
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TransferEncodingError
Content-Transfer-Encoding specified in Composite media type cannot be any other apart from 7bit, 8bit
or binary.
TransferEncodingValue
Activity found Content-Transfer-Encoding.

Parent topic: MIME Module
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AttachmentNumber
Activity is processing the specified attachment number.

Level : Info

Log Message : Processing attachment number {AttachmentNumber}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oAttachmentNumberEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 3

Variables

The AttachmentNumber message contains the following variables:

Table 1. AttachmentNumber Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. AttachmentNumber

The attachment number activity is currently processing.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv3AttachmentNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.3.1

Parent topic: MIME Operation Notifications
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AttachmentsFound
The activity found specified number of attachments.

Level : Info

Log Message : The number of attachments found is {NumberOfAttach}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oAttachmentsFoundEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 10
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Variables

The AttachmentsFound message contains the following variables:

Table 1. AttachmentsFound Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfAttach

The number of attachments found by the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv10NumberOfAttach
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.10.1

Parent topic: MIME Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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AutoGeneratedBody
No boundary value was specified for multiple parts attachment. Using auto-generated boundary.

Level : Info

Log Message : No boundary value specified for multiple parts attachment. Using auto-generated boundary:
{Boundary}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oAutoGeneratedBodyEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 19

Variables

The AutoGeneratedBody message contains the following variables:

Table 1. AutoGeneratedBody Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Boundary

The auto generated body which is used.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv19Boundary
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.19.1

Parent topic: MIME Operation Notifications
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BoundaryAbsent
Boundary attribute not set in input parameter 'mimeheader'. Input body being set as entityBody in first entity
of 'parts' output parameter.

Level : Info

Log Message : Boundary attribute not set in input parameter 'mimeheader'. Input body being set as entityBody in
first entity of 'parts' output parameter.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oBoundaryAbsentEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 8

Variables

The BoundaryAbsent message contains the following variables:

Table 1. BoundaryAbsent Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: MIME Operation Notifications
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BoundaryInfo
Boundary of mime attachment is as specified.

Level : Info

Log Message : Boundary is: \"{Boundary}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oBoundaryInfoEv1
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 1

Variables

The BoundaryInfo message contains the following variables:

Table 1. BoundaryInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Boundary

The boundary in the mime attachment.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv1Boundary
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.1.1

Parent topic: MIME Operation Notifications
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BoundaryMoreThan70
Boundary delimiters longer than 70 characters. Ignoring the specified boundary value. Using auto-generated
boundary.

Level : Warning

Log Message : Boundary delimiters longer than 70 characters. Ignoring the specified boundary value. Using
auto-generated boundary.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oBoundaryMoreThan70Ev25

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 25

Variables

The BoundaryMoreThan70 message contains the following variables:

Table 1. BoundaryMoreThan70 Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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BoundarySpecified
Activity found boundary in mime message.

Level : Info

Log Message : Got boundary: \"{Boundary}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oBoundarySpecifiedEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 23

Variables

The BoundarySpecified message contains the following variables:

Table 1. BoundarySpecified Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Boundary

Boundary found in the message.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv23Boundary
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.23.1
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DefaultContentType
Activity did not find any content type specified. Setting content type to text/plain.

Level : Info

Log Message : Content-type not found. Taking default Content-Type as text/plain.

System : Orchestration
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SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oDefaultContentTypeEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 12

Variables

The DefaultContentType message contains the following variables:

Table 1. DefaultContentType Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: MIME Operation Notifications
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file:///dcs/markdown/workspace/Transform/out.html

 1689



http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mime/mime_op
eration_defaultcontenttype_message.html

EmptyParts
The input parameter - parts - is empty and there is no data to serialize.

Level : Severe

Log Message : Empty input parameter 'parts'. No data to serialize.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oEmptyPartsEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 14

Variables

The EmptyParts message contains the following variables:

Table 1. EmptyParts Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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FoundBoundary
Activity found boundary parameter in the mime message.

Level : Info

Log Message : Found boundary parameter: \"{Boundary}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oFoundBoundaryEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 5

Variables

The FoundBoundary message contains the following variables:

Table 1. FoundBoundary Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Boundary

The boundary parameter found in the mime message.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv5Boundary
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.5.1
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HeaderAbsent
Empty input parameter 'mimeheader'. was found. Activity cannot parse data.

Level : Severe

Log Message : Empty input parameter 'mimeheader'. Cannot parse data.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oHeaderAbsentEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 9

Variables
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The HeaderAbsent message contains the following variables:

Table 1. HeaderAbsent Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: MIME Operation Notifications
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MainAndSubType
The main and sub type found in content type.
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Level : Severe

Log Message : Mime-header type: {MainType}; sub-type: {SubType}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oMainAndSubTypeEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 7

Variables

The MainAndSubType message contains the following variables:

Table 1. MainAndSubType Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MainType

The main type found in the content type of message.

Type : String
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SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv7MainType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.7.1

6. SubType

The sub type found in the content type of message.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv7SubType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.7.2

Parent topic: MIME Operation Notifications
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MainType
Main type specified in the serialize activity.

Level : Info

Log Message : Got main-type: {MainType}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oMainTypeEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 22

Variables

The MainType message contains the following variables:

Table 1. MainType Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MainType

Main type specified in the serialize activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv22MainType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.22.1

Parent topic: MIME Operation Notifications
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MimeHeaderMapped
Optional input parameter 'mimeheader' is mapped.

Level : Info

Log Message : Optional input parameter 'mimeheader' is mapped.

System : Orchestration
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SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oMimeHeaderMappedEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 21

Variables

The MimeHeaderMapped message contains the following variables:

Table 1. MimeHeaderMapped Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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MimeHeaderNotMapped
Optional input parameter 'mimeheader' was not mapped in the activity.

Level : Info

Log Message : Optional input parameter 'mimeheader' not mapped.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oMimeHeaderNotMappedEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 17

Variables

The MimeHeaderNotMapped message contains the following variables:

Table 1. MimeHeaderNotMapped Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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NoAttachments
Activity did not find any attachments to serialize.

Level : Severe

Log Message : No attachments found. Nothing to serialize.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oNoAttachmentsEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 13

Variables

The NoAttachments message contains the following variables:

Table 1. NoAttachments Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: MIME Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mime/mime_op
eration_noattachments_message.html

NoBoundaryFound
Boundary was specified in header but no boundary found in the body. Returning single body.

Level : Warning

Log Message : Boundary specified in header but no boundary found in the body. Returning single body.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oNoBoundaryFoundEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 2

Variables

The NoBoundaryFound message contains the following variables:

Table 1. NoBoundaryFound Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String

1700   



SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: MIME Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mime/mime_op
eration_noboundaryfound_message.html

NoPartBody
This part does not have any body. Setting blank body.

Level : Info

Log Message : This part does not have any body. Setting blank body.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oNoPartBodyEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2
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SNMP Trap Number : 4

Variables

The NoPartBody message contains the following variables:

Table 1. NoPartBody Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: MIME Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mime/mime_op
eration_nopartbody_message.html
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NumberOfParts
The number of parts found in the mime message.

Level : Info

Log Message : Number of parts {NumberOfParts}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oNumberOfPartsEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 18

Variables

The NumberOfParts message contains the following variables:

Table 1. NumberOfParts Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. NumberOfParts

The number of parts found.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv18NumberOfParts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.18.1

Parent topic: MIME Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mime/mime_op
eration_numberofparts_message.html

ParseActivityDone
The activity has outputted parts output parameter.

Level : Info

Log Message : Outputted 'parts' output parameter.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oParseActivityDoneEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 11

Variables

The ParseActivityDone message contains the following variables:

Table 1. ParseActivityDone Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: MIME Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mime/mime_op
eration_parseactivitydone_message.html

SerialActivityDone
The activity is done outputting mimeheader and body output parameters.

Level : Info

Log Message : Outputted 'mimeheader' and 'body' output parameters.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oSerialActivityDoneEv27

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 27

Variables

The SerialActivityDone message contains the following variables:

Table 1. SerialActivityDone Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: MIME Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mime/mime_op
eration_serialactivitydone_message.html

SerializeException
Error occurred while serializing the data.

Level : Severe

Log Message : Error while serializing data. Error is: {Message}.
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System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oSerializeExceptionEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 20

Variables

The SerializeException message contains the following variables:

Table 1. SerializeException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

 1707



Parent topic: MIME Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mime/mime_op
eration_serializeexception_message.html

SubType
Sub Type found in content type of the message.

Level : Info

Log Message : Sub-type: {SubType}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oSubTypeEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 6

Variables

The SubType message contains the following variables:

Table 1. SubType Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. SubType

The sub type found in the content type of message.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv6SubType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.6.1

Parent topic: MIME Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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eration_subtype_message.html

TranferEncChanged
The attachment body has lines greater than 998 characters in length. Changing the Content-Transfer-Encoding
to binary.

Level : Warning

Log Message : Content-Transfer-Encoding value for attachment {AttachmentNumber} is {EncodingValue} while
the attachment body has lines greater than 998 characters in length. Changing the Content-Transfer-Encoding to
binary.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oTranferEncChangedEv26

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 26

Variables
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The TranferEncChanged message contains the following variables:

Table 1. TranferEncChanged Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. AttachmentNumber

The attachment number.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv26AttachmentNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.26.1

6. EncodingValue

The content transfer encoding value.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv26EncodingValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.26.2

Parent topic: MIME Operation Notifications
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TransferEncLimit
Entities of type specified cannot have any other Content-Transfer-Encoding apart from 7bit.

Level : Severe

Log Message : Entities of type {MainType}/{SubType} cannot have any other Content-Transfer-Encoding apart
from 7bit.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oTransferEncLimitEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 16

Variables

The TransferEncLimit message contains the following variables:

Table 1. TransferEncLimit Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MainType

The main type found in the content type of message.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv16MainType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.16.1

6. SubType

The sub type found in the content type of message.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv16SubType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.16.2

Parent topic: MIME Operation Notifications
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TransferEncMissing
Content-Transfer-Encoding value is missing for specified attachment number . Guessing based on Content-
Type and charset values.

Level : Warning

Log Message : Content-Transfer-Encoding value missing for attachment number {AttachmentNumber}. Guessing
based on Content-Type and charset values.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oTransferEncMissingEv28
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 28

Variables

The TransferEncMissing message contains the following variables:

Table 1. TransferEncMissing Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. AttachmentNumber

The attachment number for which content transfer encoding is missing.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv28AttachmentNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.28.1

Parent topic: MIME Operation Notifications
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TransferEncodingError
Content-Transfer-Encoding specified in Composite media type cannot be any other apart from 7bit, 8bit or
binary.

Level : Severe

Log Message : Composite media type {MediaType} cannot have any other Content-Transfer-Encoding apart from
7bit, 8bit or binary.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oTransferEncodingErrorEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 15

Variables

The TransferEncodingError message contains the following variables:

Table 1. TransferEncodingError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MediaType

Composite Media type specified in the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv15MediaType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.15.1

Parent topic: MIME Operation Notifications
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TransferEncodingValue
Activity found Content-Transfer-Encoding.

Level : Info

Log Message : Got Content-Transfer-Encoding: {ContentTransfer}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10oTransferEncodingValueEv24

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.2

SNMP Trap Number : 24

Variables

The TransferEncodingValue message contains the following variables:

Table 1. TransferEncodingValue Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ContentTransfer

Content Transfer Encoding found in the message.

Type : String
SNMP Object Name : CASTIRON-COMP-MIME-MIB::ciC10oEv24ContentTransfer
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.10.1.2.1.24.1

Parent topic: MIME Operation Notifications
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MIME Internal Notifications
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Provides a comprehensive list of internal notifications sent from the MIME Module.

InputBodyNull
Input parameter body from container is NULL. This is due to internal exception.
ParseException
Error occurred while parsing the data.

Parent topic: MIME Module
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InputBodyNull
Input parameter body from container is NULL. This is due to internal exception.

Level : Severe

Log Message : Input parameter 'body' from container is NULL.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10iInputBodyNullEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.3

SNMP Trap Number : 1

Variables

The InputBodyNull message contains the following variables:

Table 1. InputBodyNull Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: MIME Internal Notifications

Feedback | Notices
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file:///dcs/markdown/workspace/Transform/out.html
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ParseException
Error occurred while parsing the data.

Level : Severe

Log Message : Error while parsing data. Error is: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MIME-MIB::ciC10iParseExceptionEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.10.1.3

SNMP Trap Number : 2

Variables

The ParseException message contains the following variables:

Table 1. ParseException Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: MIME Internal Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mime/mime_int
ernal_parseexception_message.html

Maestro Module
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The Maestro Module represents the internal operation of the Cast Iron runtime. This section contains details
for the messages delivered from the Maestro Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Maestro Module.

MIB Name : CASTIRON-COMP-MAESTRO-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.20

The following table provides an alphabetical list of all notifications that can be issued by the Maestro Module.

Table 1. Notifications issued by the Maestro Module
Notification Level System Description

AbandonedJobs Warning Orchestration A timeout occurred while waiting for jobs to stop and
some jobs were abandoned.

ActInvalidLicense
(Deprecated)

Severe Orchestration Deprecated.

ActivityFailedError Severe Orchestration Encountered fault of specified type, please see rest of
the log for more information.

AlreadyDeployed Severe Orchestration The specified orchestration is already deployed.

CallContext Severe Orchestration Maestro is not able to create call context.

CallContextDestroy Info Orchestration Call context created but task never started.

CatchExpression Severe Orchestration Unable to parse the catch expression.

CleanUpFailed Warning Orchestration Failed to clean up the activity.

CloseInputStream Warning Orchestration Could not close input stream.

CloseOutputStream Warning Orchestration Could not close output stream.

CloseReader Warning Orchestration Could not close reader.

CloseWriter Warning Orchestration Could not close writer.

DeactivateFailed Severe Orchestration Maestro failed to deactivate the specified activity.

DebugFailed Severe Orchestration Debugger operation failed.

DeleteObject Warning Orchestration Could not clean up object with ID.

DestroyFailed Severe Orchestration Maestro failed to destroy the specified activity.

EnqueueFailed Severe Orchestration Unable to enqueue the orchestration.

EntryPath Severe Orchestration Could not find an entry point for the specified activity
in the compiled orchestration.

ErrorMap Severe Orchestration Error in map activity.

ErrorTwoPhase Severe Orchestration Activity could not be converted to Two phase activity.

ExecuteError Severe Orchestration Unable to execute the orchestration.

FaultInfo Severe Orchestration Could not initialize FaultInfo.

ForEach Severe Orchestration Error occurred in for each activity.
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Notification Level System Description

IOError Warning Orchestration Internal error occurred because of Input/Output
error.

InitializeJobInfo Severe Orchestration Could not initialize job info.

InputMap Severe Orchestration No input maps are there for required input parameter.

InputMapXPath Severe Orchestration Could not perform input map expression.

InputMapXSLT Severe Orchestration Could not perform input map XSLT.

InvokeError Severe Orchestration Error occurred in module.

KeyLog Info Orchestration Logged key with specified name and value.

LargeInputParam Warning Orchestration Specified input parameter is over the limit and is too
large to log.

LargeNonpersistentVar Severe Orchestration Specified variable is too large for a non-persistent
orchestration.

LargeOutputParam Warning Orchestration Specified output parameter is over the limit and is too
large to log.

LargeTotalVarSize Severe Orchestration This job cannot be run during low-memory conditions.

LargeVariable Warning Orchestration Specified variable is over the limit and is too large to
log.

LicenseExpireImminent
(Deprecated)

Severe Orchestration Deprecated.

LicenseExpireSoon
(Deprecated)

Warning Orchestration Deprecated.

LicenseExpired
(Deprecated)

Severe Orchestration Deprecated.

LicenseInvalid
(Deprecated)

Severe Orchestration Deprecated.

LoaderCancel Severe Orchestration Cancel of job with specified ID of specified
orchestration.

LoaderDelete Severe Orchestration Delete of specified orchestration failed.

LoaderDeploy Severe Orchestration Deployment of specified orchestration failed.

LoaderPublish Severe Orchestration Publish of specified configuration failed.

LoaderStart Severe Orchestration Start of the specified orchestration failed.

LoaderStop Severe Orchestration Stop of the specified orchestration failed.

LoaderSuspend Severe Orchestration Suspend of the specified orchestration failed.

LoaderunDeploy Severe Orchestration Undeploy of specified orchestration failed.

MBeanRegister Severe Orchestration Could not register specified object with MBean server.

MBeanUnregister Severe Orchestration Could not unregister specified object with MBean
server.

 1721



Notification Level System Description

MaxSeqNum Warning Orchestration Exceeded maximum number of activity events for a
job.

ModuleConfig Severe Orchestration Could not read module configuration.

MonitorQuery Severe Orchestration Could not query for monitor data.

MonitorVariable Warning Orchestration Could not log monitor variable.

MonitorVariables Warning Orchestration Could not log monitor variables.

MontiorEvents Severe Orchestration Could not log monitor events.

MultipleActFactory Severe Orchestration Activity Factory with specified name and version has
multiple registrations, and hence not loading it.

NoActivityFactory Severe Orchestration Activity Factory with specified name and version not
registered.

NotDeployed Severe Orchestration Orchestration not deployed.

NotDocParameter Severe Orchestration Specified parameter is not an XML document.

NotDocVariable Severe Orchestration Specified variable is not an XML document.

NotStopped Severe Orchestration Could not undeploy as the orchestration is not
stopped.

NotSuspend Severe Orchestration Could not suspend as the orchestration is not
running.

NullParam Severe Orchestration Specified parameter is null.

NullVariable Severe Orchestration Specified variable is null.

OSGISyntaxError Severe Orchestration Invalid OSGI query syntax provided.

OrchCompileError Severe Orchestration Unable to compile the specified orchestration.

OutputMap Severe Orchestration Could not perform output map.

OutputMapXPath Severe Orchestration Could not perform output map expression.

OutputMapXSLT Severe Orchestration Could not perform output map transform.

ParamIndex Warning Orchestration Parameter at specified index is already set.

ProgramDestroy Severe Orchestration Program in non terminal state being destroyed.

ProgramStart Severe Orchestration Cannot start an orchestration that is in transient
state.

SocketNoReply Warning Orchestration Could not receive socket reply.

SplitError Severe Orchestration Error occurred in split activity.

SwitchExpEmpty Severe Orchestration The condition provided for if-then activity and case
label is empty.

SwitchExpression Severe Orchestration Unable to parse the if-then expression.

TaskCancelled Warning Orchestration Caught exception while cancelling job.

TaskEnd Info Orchestration Ended job for specified orchestration.

TaskFound Severe Orchestration Found task with specified state on undeploy.
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Notification Level System Description

TaskRemove Severe Orchestration Unable to remove the task.

TaskStart Info Orchestration Started job for specified orchestration.

TaskState Severe Orchestration Unable to set the task state.

TaskStateTransition Severe Orchestration Invalid task state transition happened, hence marking
the job as faulted.

TaskStatusChanged Info Orchestration Job status changed.

TooManyWaitingJobs Severe Orchestration A job was aborted due to a large number of waiting
jobs.

UnCaughtError Severe Orchestration Uncaught Internal error occurred.

UnExpectedError Severe Orchestration Unexpected Internal error occurred.

VariableNull Warning Orchestration Specified variable is null.

WhileExpEmpty Severe Orchestration The condition provided for while activity is empty.

WhileExpression Severe Orchestration Unable to parse while expression with specified
condition.

WrongActFactory Severe Orchestration Activity factory with specified name and version
returned wrong class.

Maestro Operation Notifications
Provides a comprehensive list of operation notifications sent from the Maestro Module.
Maestro Internal Notifications
Provides a comprehensive list of internal notifications sent from the Maestro Module.

Feedback | Notices
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_the_maestro_module.html

Maestro Operation Notifications
Provides a comprehensive list of operation notifications sent from the Maestro Module.

AbandonedJobs
A timeout occurred while waiting for jobs to stop and some jobs were abandoned.
ActInvalidLicense (Deprecated)
Activity Factory with specified name and version had a licensing failure.
ActivityFailedError
Encountered fault of specified type, please see rest of the log for more information.
AlreadyDeployed
The specified orchestration is already deployed.
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CallContext
Maestro is not able to create call context.
CallContextDestroy
Call context created but task never started.
CatchExpression
Unable to parse the catch expression.
CleanUpFailed
Failed to clean up the activity.
CloseInputStream
Could not close input stream.
CloseOutputStream
Could not close output stream.
CloseReader
Could not close reader.
CloseWriter
Could not close writer.
DeactivateFailed
Maestro failed to deactivate the specified activity.
DebugFailed
Debugger operation failed.
DeleteObject
Could not clean up object with ID.
DestroyFailed
Maestro failed to destroy the specified activity.
EnqueueFailed
Unable to enqueue the orchestration.
EntryPath
Could not find an entry point for the specified activity in the compiled orchestration.
ErrorMap
Error in map activity.
ErrorTwoPhase
Activity could not be converted to Two phase activity.
ExecuteError
Unable to execute the orchestration.
FaultInfo
Could not initialize FaultInfo.
ForEach
Error occurred in for each activity.
InitializeJobInfo
Could not initialize job info.
InputMap
No input maps are there for required input parameter.
InputMapXPath
Could not perform input map expression.
InputMapXSLT
Could not perform input map XSLT.
InvokeError
Error occurred in module.
KeyLog
Logged key with specified name and value.
LargeInputParam
Specified input parameter is over the limit and is too large to log.
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LargeNonpersistentVar
Specified variable is too large for a non-persistent orchestration.
LargeOutputParam
Specified output parameter is over the limit and is too large to log.
LargeTotalVarSize
This job cannot be run during low-memory conditions.
LargeVariable
Specified variable is over the limit and is too large to log.
LicenseExpireImminent (Deprecated)
Imminent license expiration for specified bundle - expires on specified date - Please renew the license
now to avoid service interruption.
LicenseExpireSoon (Deprecated)
License for specified bundle name expires soon. Please renew the license to avoid service interruption.
LicenseExpired (Deprecated)
License has expired. Please renew the license now to avoid service interruption.
LicenseInvalid (Deprecated)
License for specified bundle name is invalid.
LoaderCancel
Cancel of job with specified ID of specified orchestration.
LoaderDelete
Delete of specified orchestration failed.
LoaderDeploy
Deployment of specified orchestration failed.
LoaderPublish
Publish of specified configuration failed.
LoaderStart
Start of the specified orchestration failed.
LoaderStop
Stop of the specified orchestration failed.
LoaderSuspend
Suspend of the specified orchestration failed.
LoaderunDeploy
Undeploy of specified orchestration failed.
MBeanRegister
Could not register specified object with MBean server.
MBeanUnregister
Could not unregister specified object with MBean server.
MaxSeqNum
Exceeded maximum number of activity events for a job.
ModuleConfig
Could not read module configuration.
MonitorQuery
Could not query for monitor data.
MonitorVariable
Could not log monitor variable.
MonitorVariables
Could not log monitor variables.
MontiorEvents
Could not log monitor events.
MultipleActFactory
Activity Factory with specified name and version has multiple registrations, and hence not loading it.
NoActivityFactory
Activity Factory with specified name and version not registered.
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NotDeployed
Orchestration not deployed.
NotDocParameter
Specified parameter is not an XML document.
NotDocVariable
Specified variable is not an XML document.
NotStopped
Could not undeploy as the orchestration is not stopped.
NotSuspend
Could not suspend as the orchestration is not running.
NullParam
Specified parameter is null.
NullVariable
Specified variable is null.
OSGISyntaxError
Invalid OSGI query syntax provided.
OrchCompileError
Unable to compile the specified orchestration.
OutputMap
Could not perform output map.
OutputMapXPath
Could not perform output map expression.
OutputMapXSLT
Could not perform output map transform.
ParamIndex
Parameter at specified index is already set.
ProgramDestroy
Program in non terminal state being destroyed.
ProgramStart
Cannot start an orchestration that is in transient state.
SocketNoReply
Could not receive socket reply.
SplitError
Error occurred in split activity.
SwitchExpEmpty
The condition provided for if-then activity and case label is empty.
SwitchExpression
Unable to parse the if-then expression.
TaskCancelled
Caught exception while cancelling job.
TaskEnd
Ended job for specified orchestration.
TaskFound
Found task with specified state on undeploy.
TaskRemove
Unable to remove the task.
TaskStart
Started job for specified orchestration.
TaskState
Unable to set the task state.
TaskStateTransition
Invalid task state transition happened, hence marking the job as faulted.
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TaskStatusChanged
Job status changed.
TooManyWaitingJobs
A job was aborted due to a large number of waiting jobs.
VariableNull
Specified variable is null.
WhileExpEmpty
The condition provided for while activity is empty.
WhileExpression
Unable to parse while expression with specified condition.
WrongActFactory
Activity factory with specified name and version returned wrong class.

Parent topic: Maestro Module
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AbandonedJobs
A timeout occurred while waiting for jobs to stop and some jobs were abandoned.

Level : Warning

Log Message : Timeout waiting for jobs to stop, number of jobs abandoned: {NumberOfAbandonedJobs}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oAbandonedJobsEv87

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 87

Variables

The AbandonedJobs message contains the following variables:

Table 1. AbandonedJobs Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfAbandonedJobs

The number of abandoned jobs.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv87NumberOfAbandonedJobs
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.87.1

Parent topic: Maestro Operation Notifications
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ActInvalidLicense (Deprecated)

As of Cast Iron version 6.0, this message has been deprecated because connectors are no longer individually
licensed.

Activity Factory with specified name and version had a licensing failure.

Level : Severe
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Log Message : ActivityFactory (name - {ActivityName},version - {ActivityVersion}) Licensing failure: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oActInvalidLicenseEv35

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 35

Variables

The ActInvalidLicense message contains the following variables:

Table 1. ActInvalidLicense Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The name of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv35ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.35.1
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6. ActivityVersion

The version of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv35ActivityVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.35.2

7. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications
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ActivityFailedError
Encountered fault of specified type, please see rest of the log for more information.

Level : Severe

Log Message : Encountered fault of type {FaultType}, please see rest of the log for more information

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oActivityFailedErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 3

Variables

The ActivityFailedError message contains the following variables:

Table 1. ActivityFailedError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FaultType

The fault type encountered.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv3FaultType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.3.1

Parent topic: Maestro Operation Notifications
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AlreadyDeployed
The specified orchestration is already deployed.
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Level : Severe

Log Message : Orchestration already deployed: {OrchName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oAlreadyDeployedEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 4

Variables

The AlreadyDeployed message contains the following variables:

Table 1. AlreadyDeployed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The name of the orchestration which is already deployed.

Type : String
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SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv4OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.4.1
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CallContext
Maestro is not able to create call context.

Level : Severe

Log Message : Unable to create call context: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oCallContextEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 5

Variables

The CallContext message contains the following variables:

Table 1. CallContext Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices
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CallContextDestroy
Call context created but task never started.

Level : Info

Log Message : Call context created but task never started; destroying task {TaskID}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oCallContextDestroyEv80

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 80

Variables
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The CallContextDestroy message contains the following variables:

Table 1. CallContextDestroy Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TaskID

The task ID.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv80TaskID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.80.1

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html
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CatchExpression
Unable to parse the catch expression.

Level : Severe

Log Message : Unable to parse the catch expression: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oCatchExpressionEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 6

Variables

The CatchExpression message contains the following variables:

Table 1. CatchExpression Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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CleanUpFailed
Failed to clean up the activity.

Level : Warning

Log Message : Failed to cleanup activity {ActivityName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oCleanUpFailedEv63

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 63

Variables

The CleanUpFailed message contains the following variables:

Table 1. CleanUpFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The name of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv63ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.63.1

Parent topic: Maestro Operation Notifications
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CloseInputStream
Could not close input stream.

Level : Warning

Log Message : Could not close reader

System : Orchestration
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SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oCloseInputStreamEv64

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 64

Variables

The CloseInputStream message contains the following variables:

Table 1. CloseInputStream Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Maestro Operation Notifications
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 Last updated: Thursday, November 14, 2013
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CloseOutputStream
Could not close output stream.

Level : Warning

Log Message : Could not close output stream

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oCloseOutputStreamEv65

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 65

Variables

The CloseOutputStream message contains the following variables:

Table 1. CloseOutputStream Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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CloseReader
Could not close reader.

Level : Warning

Log Message : Could not close reader

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oCloseReaderEv66

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 66

Variables

The CloseReader message contains the following variables:

Table 1. CloseReader Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Maestro Operation Notifications
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CloseWriter
Could not close writer.

Level : Warning

Log Message : Could not close writer

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oCloseWriterEv67

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 67

Variables

The CloseWriter message contains the following variables:

Table 1. CloseWriter Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Maestro Operation Notifications

Feedback | Notices
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DeactivateFailed
Maestro failed to deactivate the specified activity.

Level : Severe

Log Message : Failed to deactivate activity {ActivityName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oDeactivateFailedEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

 1743



SNMP Trap Number : 1

Variables

The DeactivateFailed message contains the following variables:

Table 1. DeactivateFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Name of the activity which caused the error.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv1ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.1.1

Parent topic: Maestro Operation Notifications

Feedback | Notices
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DebugFailed
Debugger operation failed.

Level : Severe

Log Message : Debugger operation {Value} failed

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oDebugFailedEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 8

Variables

The DebugFailed message contains the following variables:

Table 1. DebugFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

The operation which failed.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv8Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.8.1
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DeleteObject
Could not clean up object with ID.

Level : Warning

Log Message : Could not clean up object with ID {ObjectID}, will try later

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oDeleteObjectEv68

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 68

Variables

The DeleteObject message contains the following variables:

Table 1. DeleteObject Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ObjectID

The ID of the object.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv68ObjectID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.68.1
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DestroyFailed
Maestro failed to destroy the specified activity.

Level : Severe
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Log Message : Failed to destroy activity {ActivityName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oDestroyFailedEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 2

Variables

The DestroyFailed message contains the following variables:

Table 1. DestroyFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Name of the activity which caused the error.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv2ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.2.1
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EnqueueFailed
Unable to enqueue the orchestration.

Level : Severe

Log Message : Unable to enqueue to orchestration: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEnqueueFailedEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 9

Variables

The EnqueueFailed message contains the following variables:

Table 1. EnqueueFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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EntryPath
Could not find an entry point for the specified activity in the compiled orchestration.

Level : Severe

Log Message : Could not find an entry point for the activity: [{ActivityName}] in the compiled orchestration

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEntryPathEv38

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 38

Variables

The EntryPath message contains the following variables:

Table 1. EntryPath Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The name of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv38ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.38.1

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html
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ro_operation_entrypath_message.html
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ErrorMap
Error in map activity.

Level : Severe

Log Message : Exception in map activity: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oErrorMapEv29

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 29

Variables

The ErrorMap message contains the following variables:

Table 1. ErrorMap Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices
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ErrorTwoPhase
Activity could not be converted to Two phase activity.

Level : Severe

Log Message : Activity could not be converted into TwoPhase activity

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oErrorTwoPhaseEv59

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 59

Variables

The ErrorTwoPhase message contains the following variables:

Table 1. ErrorTwoPhase Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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ExecuteError
Unable to execute the orchestration.

Level : Severe

Log Message : Unable to execute to orchestration: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oExecuteErrorEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 10

Variables

The ExecuteError message contains the following variables:

Table 1. ExecuteError Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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ro_operation_executeerror_message.html
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FaultInfo
Could not initialize FaultInfo.

Level : Severe

Log Message : Could not initialize FaultInfo

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oFaultInfoEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 11

Variables

The FaultInfo message contains the following variables:

Table 1. FaultInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications
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 Last updated: Thursday, November 14, 2013
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ForEach
Error occurred in for each activity.

Level : Severe

Log Message : Exception in foreach activity: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oForEachEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 12

Variables

The ForEach message contains the following variables:

Table 1. ForEach Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer

 1757



SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices
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InitializeJobInfo
Could not initialize job info.

Level : Severe

Log Message : Could not initialize JobInfo

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oInitializeJobInfoEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2
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SNMP Trap Number : 17

Variables

The InitializeJobInfo message contains the following variables:

Table 1. InitializeJobInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices
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InputMap
No input maps are there for required input parameter.

Level : Severe

Log Message : No input map for required parameter: {ParamName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oInputMapEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 13

Variables

The InputMap message contains the following variables:

Table 1. InputMap Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ParamName

The required parameter name for which input maps are missing.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv13ParamName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.13.1

Parent topic: Maestro Operation Notifications
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InputMapXPath
Could not perform input map expression.

Level : Severe

Log Message : Could not perform input map expression: {ExpressionName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oInputMapXPathEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 14

Variables

The InputMapXPath message contains the following variables:

Table 1. InputMapXPath Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ExpressionName

The name of the expression.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv14ExpressionName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.14.1

Parent topic: Maestro Operation Notifications
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InputMapXSLT
Could not perform input map XSLT.

Level : Severe
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Log Message : Could not perform input map transform: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oInputMapXSLTEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 15

Variables

The InputMapXSLT message contains the following variables:

Table 1. InputMapXSLT Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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InvokeError
Error occurred in module.

Level : Severe

Log Message : Exception detected in module, throwing exception {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oInvokeErrorEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 16

Variables

The InvokeError message contains the following variables:

Table 1. InvokeError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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KeyLog
Logged key with specified name and value.

Level : Info

Log Message : Logged key with name "{KeyName}" and value "{KeyValue}"

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oKeyLogEv81

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 81

Variables

The KeyLog message contains the following variables:

Table 1. KeyLog Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. KeyName

The key name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv81KeyName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.81.1

6. KeyValue

The key value.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv81KeyValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.81.2

Parent topic: Maestro Operation Notifications
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LargeInputParam
Specified input parameter is over the limit and is too large to log.

Level : Warning

Log Message : Input parameter "{ParamName}" is over {Length} and is too large to log

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLargeInputParamEv71

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 71

Variables

The LargeInputParam message contains the following variables:

Table 1. LargeInputParam Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ParamName

The parameter name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv71ParamName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.71.1

6. Length

The limit for the size.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv71Length
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.71.2
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LargeNonpersistentVar
Specified variable is too large for a non-persistent orchestration.

Level : Severe

Log Message : Variable "{VariableName}" is too large, please turn on persistence for this orchestration

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLargeNonpersistentVarEv86

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 86

Variables
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The LargeNonpersistentVar message contains the following variables:

Table 1. LargeNonpersistentVar Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. VariableName

The variable name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv86VariableName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.86.1
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LargeOutputParam
Specified output parameter is over the limit and is too large to log.

Level : Warning

Log Message : Output parameter "{ParamName}" is over {Length} and is too large to log

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLargeOutputParamEv72

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 72

Variables

The LargeOutputParam message contains the following variables:

Table 1. LargeOutputParam Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ParamName

The parameter name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv72ParamName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.72.1

6. Length

The limit for the size.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv72Length
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.72.2
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LargeTotalVarSize
This job cannot be run during low-memory conditions.

Level : Severe

Log Message : Cannot complete this job due to low memory, please try redeploying this orchestration

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLargeTotalVarSizeEv85

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 85

Variables

The LargeTotalVarSize message contains the following variables:

Table 1. LargeTotalVarSize Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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Specified variable is over the limit and is too large to log.

Level : Warning

Log Message : Variable "{VariableName}" is over {Length} and is too large to log

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLargeVariableEv73

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 73

Variables

The LargeVariable message contains the following variables:

Table 1. LargeVariable Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. VariableName

The variable name.
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Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv73VariableName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.73.1

6. Length

The limit for the size.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv73Length
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.73.2
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LicenseExpireImminent (Deprecated)

As of Cast Iron version 6.0, this message has been deprecated because connectors are no longer individually
licensed.

Imminent license expiration for specified bundle - expires on specified date - Please renew the license now to
avoid service interruption.

Level : Severe

Log Message : Imminent license expiration for {BundleName} - expires: {Date} - Please renew the license now to
avoid service interruption

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLicenseExpireImminentEv26

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 26

Variables

The LicenseExpireImminent message contains the following variables:

Table 1. LicenseExpireImminent Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. BundleName

The bundle for which license expires.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv26BundleName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.26.1

6. Date

The date on which license expires.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv26Date
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.26.2
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LicenseExpireSoon (Deprecated)

As of Cast Iron version 6.0, this message has been deprecated because connectors are no longer individually
licensed.

License for specified bundle name expires soon. Please renew the license to avoid service interruption.

Level : Warning

Log Message : License for {BundleName} expires soon: {Date} - Please renew the license to avoid service
interruption

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLicenseExpireSoonEv69

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 69

Variables

The LicenseExpireSoon message contains the following variables:

Table 1. LicenseExpireSoon Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. BundleName

The bundle name for which license expires soon.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv69BundleName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.69.1

6. Date

The date at which license expires.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv69Date
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.69.2
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LicenseExpired (Deprecated)

As of Cast Iron version 6.0, this message has been deprecated because connectors are no longer individually
licensed.

License has expired. Please renew the license now to avoid service interruption.

Level : Severe

Log Message : License for {BundleName} has expired - expired as of: {Date} - Please renew the license now to
avoid service interruption

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLicenseExpiredEv27

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 27
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Variables

The LicenseExpired message contains the following variables:

Table 1. LicenseExpired Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. BundleName

The bundle for which license expired.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv27BundleName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.27.1

6. Date

The date on which license expired.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv27Date
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.27.2
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LicenseInvalid (Deprecated)

As of Cast Iron version 6.0, this message has been deprecated because connectors are no longer individually
licensed.

License for specified bundle name is invalid.

Level : Severe

Log Message : License for {BundleName} is invalid: {1}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLicenseInvalidEv28

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 28

Variables

The LicenseInvalid message contains the following variables:

Table 1. LicenseInvalid Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. BundleName

The bundle for which license is invalid.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv28BundleName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.28.1
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LoaderCancel
Cancel of job with specified ID of specified orchestration.

Level : Severe

Log Message : Cancel of job {JobID} of Orchestration {OrchName} failed: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLoaderCancelEv25

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 25

Variables
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The LoaderCancel message contains the following variables:

Table 1. LoaderCancel Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. JobID

The job id which was cancelled.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv25JobID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.25.1

6. OrchName

The orchestration name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv25OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.25.2

7. Message
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Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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LoaderDelete
Delete of specified orchestration failed.

Level : Severe

Log Message : Delete of Orchestration {OrchName} failed: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLoaderDeleteEv24

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 24

Variables

The LoaderDelete message contains the following variables:

Table 1. LoaderDelete Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The orchestration name for which suspend failed.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv24OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.24.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_loaderdelete_message.html

LoaderDeploy
Deployment of specified orchestration failed.

Level : Severe

Log Message : Deploy of Orchestration {OrchName} failed: {Message}.
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System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLoaderDeployEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 19

Variables

The LoaderDeploy message contains the following variables:

Table 1. LoaderDeploy Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The orchestration name for which deployment failed.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv19OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.19.1
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6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_loaderdeploy_message.html

LoaderPublish
Publish of specified configuration failed.

Level : Severe

Log Message : Publish of Configuration {ConfigName} failed: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLoaderPublishEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 18

Variables

The LoaderPublish message contains the following variables:

Table 1. LoaderPublish Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ConfigName

The configuration name for which loading failed.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv18ConfigName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.18.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_loaderpublish_message.html

LoaderStart
Start of the specified orchestration failed.
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Level : Severe

Log Message : Start of Orchestration {OrchName} failed: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLoaderStartEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 20

Variables

The LoaderStart message contains the following variables:

Table 1. LoaderStart Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The orchestration name for which start failed.

Type : String
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SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv20OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.20.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_loaderstart_message.html

LoaderStop
Stop of the specified orchestration failed.

Level : Severe

Log Message : Stop of Orchestration {OrchName} failed: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLoaderStopEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 22

Variables

The LoaderStop message contains the following variables:

Table 1. LoaderStop Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The orchestration name for which stop failed.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv22OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.22.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_loaderstop_message.html

LoaderSuspend
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Suspend of the specified orchestration failed.

Level : Severe

Log Message : Suspend of Orchestration {OrchName} failed: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLoaderSuspendEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 23

Variables

The LoaderSuspend message contains the following variables:

Table 1. LoaderSuspend Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The orchestration name for which suspend failed.
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Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv23OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.23.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_loadersuspend_message.html

LoaderunDeploy
Undeploy of specified orchestration failed.

Level : Severe

Log Message : Undeploy of Orchestration {OrchName} failed: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oLoaderunDeployEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 21

Variables

The LoaderunDeploy message contains the following variables:

Table 1. LoaderunDeploy Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The orchestration name for which undeploy failed.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv21OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.21.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_loaderundeploy_message.html

MBeanRegister
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Could not register specified object with MBean server.

Level : Severe

Log Message : Could not register {ObjectName} with mbean server

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oMBeanRegisterEv30

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 30

Variables

The MBeanRegister message contains the following variables:

Table 1. MBeanRegister Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ObjectName

The object name which could not be registered with MBean server.
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Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv30ObjectName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.30.1

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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MBeanUnregister
Could not unregister specified object with MBean server.

Level : Severe

Log Message : Could not unregister {ObjectName} with mbean server

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oMBeanUnregisterEv31

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 31

Variables

The MBeanUnregister message contains the following variables:

Table 1. MBeanUnregister Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ObjectName

The object name which could not be unregistered with MBean server.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv31ObjectName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.31.1

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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MaxSeqNum
Exceeded maximum number of activity events for a job.

Level : Warning

Log Message : Exceeded maximum number of activity events for a job; logging disabled

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oMaxSeqNumEv74

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 74

Variables
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The MaxSeqNum message contains the following variables:

Table 1. MaxSeqNum Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Maestro Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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ModuleConfig
Could not read module configuration.
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Level : Severe

Log Message : Could not read the module configuration: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oModuleConfigEv32

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 32

Variables

The ModuleConfig message contains the following variables:

Table 1. ModuleConfig Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications
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 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_moduleconfig_message.html

MonitorQuery
Could not query for monitor data.

Level : Severe

Log Message : Could not query for monitor data

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oMonitorQueryEv34

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 34

Variables

The MonitorQuery message contains the following variables:

Table 1. MonitorQuery Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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MonitorVariable
Could not log monitor variable.

Level : Warning

Log Message : Could not log monitor variable "{VariableName}"

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oMonitorVariableEv75

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 75

Variables

The MonitorVariable message contains the following variables:

Table 1. MonitorVariable Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. VariableName

The variable name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv75VariableName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.75.1
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MonitorVariables
Could not log monitor variables.
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Level : Warning

Log Message : Could not log monitor variables

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oMonitorVariablesEv76

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 76

Variables

The MonitorVariables message contains the following variables:

Table 1. MonitorVariables Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Maestro Operation Notifications

 1801



Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_monitorvariables_message.html

MontiorEvents
Could not log monitor events.

Level : Severe

Log Message : Could not log monitor events

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oMontiorEventsEv33

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 33

Variables

The MontiorEvents message contains the following variables:

Table 1. MontiorEvents Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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MultipleActFactory
Activity Factory with specified name and version has multiple registrations, and hence not loading it.

Level : Severe

Log Message : ActivityFactory (name - {ActivityName},version - {ActivityVersion}) has multiple registrations, not
loading

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oMultipleActFactoryEv36

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 36

Variables

The MultipleActFactory message contains the following variables:

Table 1. MultipleActFactory Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The name of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv36ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.36.1

6. ActivityVersion

The version of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv36ActivityVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.36.2
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NoActivityFactory
Activity Factory with specified name and version not registered.
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Level : Severe

Log Message : ActivityFactory (name - {ActivityName}, version - {ActivityVersion}) not registered

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oNoActivityFactoryEv37

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 37

Variables

The NoActivityFactory message contains the following variables:

Table 1. NoActivityFactory Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The name of the activity.

Type : String
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SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv37ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.37.1

6. ActivityVersion

The version of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv37ActivityVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.37.2
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NotDeployed
Orchestration not deployed.

Level : Severe

Log Message : Orchestration not deployed: {OrchName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oNotDeployedEv39

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 39

Variables

The NotDeployed message contains the following variables:

Table 1. NotDeployed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The name of the orchestration not deployed.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv39OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.39.1
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NotDocParameter
Specified parameter is not an XML document.

Level : Severe

Log Message : Parameter {ParamName} is not an XML document

System : Orchestration
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SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oNotDocParameterEv40

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 40

Variables

The NotDocParameter message contains the following variables:

Table 1. NotDocParameter Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ParamName

The name of the parameter which is not an XML document.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv40ParamName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.40.1

Parent topic: Maestro Operation Notifications
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NotDocVariable
Specified variable is not an XML document.

Level : Severe

Log Message : Variable {ParamName} is not an XML document

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oNotDocVariableEv41

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 41

Variables

The NotDocVariable message contains the following variables:

Table 1. NotDocVariable Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ParamName

The name of the variable which is not an XML document.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv41ParamName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.41.1
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NotStopped
Could not undeploy as the orchestration is not stopped.

Level : Severe

Log Message : Could not undeploy, orchestration not stopped, state is {State}: {OrchName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oNotStoppedEv43

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 43

Variables

The NotStopped message contains the following variables:

Table 1. NotStopped Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. State

The current state of the orchestration.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv43State
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.43.1

6. OrchName

The orchestration name that is not running.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv43OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.43.2

Parent topic: Maestro Operation Notifications

Feedback | Notices

 1811



 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/maestro/maest
ro_operation_notstopped_message.html

NotSuspend
Could not suspend as the orchestration is not running.

Level : Severe

Log Message : Could not suspend, orchestration not running: {OrchName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oNotSuspendEv42

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 42

Variables

The NotSuspend message contains the following variables:

Table 1. NotSuspend Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The orchestration name that is not running.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv42OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.42.1
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NullParam
Specified parameter is null.

Level : Severe

Log Message : Parameter {ParamName} is null

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oNullParamEv44

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 44

Variables

The NullParam message contains the following variables:

Table 1. NullParam Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ParamName

The param name which is null.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv44ParamName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.44.1
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NullVariable
Specified variable is null.

Level : Severe
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Log Message : Variable {VariableName} is null

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oNullVariableEv45

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 45

Variables

The NullVariable message contains the following variables:

Table 1. NullVariable Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. VariableName

The variable name which is null.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv45VariableName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.45.1
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OSGISyntaxError
Invalid OSGI query syntax provided.

Level : Severe

Log Message : Invalid OSGI query syntax: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oOSGISyntaxErrorEv46

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 46

Variables

The OSGISyntaxError message contains the following variables:

Table 1. OSGISyntaxError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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OrchCompileError
Unable to compile the specified orchestration.

Level : Severe

Log Message : Unable to compile the orchestration {OrchName}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oOrchCompileErrorEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 7

Variables

The OrchCompileError message contains the following variables:

Table 1. OrchCompileError Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The name of the orchestration which was not compiled.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv7OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.7.1
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OutputMap
Could not perform output map.

Level : Severe

Log Message : Could not perform output map: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oOutputMapEv47

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 47

Variables

The OutputMap message contains the following variables:

Table 1. OutputMap Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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OutputMapXPath
Could not perform output map expression.

Level : Severe

Log Message : Could not perform output map expression: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oOutputMapXPathEv48

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 48

Variables

The OutputMapXPath message contains the following variables:

Table 1. OutputMapXPath Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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OutputMapXSLT
Could not perform output map transform.

Level : Severe

Log Message : Could not perform output map transform: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oOutputMapXSLTEv49

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2
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SNMP Trap Number : 49

Variables

The OutputMapXSLT message contains the following variables:

Table 1. OutputMapXSLT Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices
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ParamIndex
Parameter at specified index is already set.

Level : Warning

Log Message : Parameter at paramIndex {ParamIndex} and varIndex {VariableIndex} already set

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oParamIndexEv78

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 78

Variables

The ParamIndex message contains the following variables:

Table 1. ParamIndex Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ParamIndex

The parameter index.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv78ParamIndex
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.78.1

6. VariableIndex

The variable index.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv78VariableIndex
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.78.2
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ProgramDestroy
Program in non terminal state being destroyed.

Level : Severe

Log Message : Program in non-terminal state being destroyed: {ConfigURl}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oProgramDestroyEv50

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 50

Variables

The ProgramDestroy message contains the following variables:
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Table 1. ProgramDestroy Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ConfigURl

The config URl of the program being destroyed.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv50ConfigURl
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.50.1
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ProgramStart
Cannot start an orchestration that is in transient state.

Level : Severe

Log Message : Cannot start an orchestration that is in transient state: {State}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oProgramStartEv51

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 51

Variables

The ProgramStart message contains the following variables:

Table 1. ProgramStart Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. State

The current state of the orchestration.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv51State
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.51.1
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SocketNoReply
Could not receive socket reply.

Level : Warning

Log Message : Could not receive socket reply

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oSocketNoReplyEv70

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 70

Variables

The SocketNoReply message contains the following variables:

Table 1. SocketNoReply Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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SplitError
Error occurred in split activity.

Level : Severe

Log Message : Exception in split activity: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oSplitErrorEv52

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 52

Variables

The SplitError message contains the following variables:

Table 1. SplitError Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SwitchExpEmpty
The condition provided for if-then activity and case label is empty.

Level : Severe

Log Message : The condition provided for if-then activity [{ActivityName}] and case label [{CaseLabel}] is empty

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oSwitchExpEmptyEv54

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 54

Variables

The SwitchExpEmpty message contains the following variables:

Table 1. SwitchExpEmpty Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. ActivityName

The name of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv54ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.54.1

6. CaseLabel

The name of the label.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv54CaseLabel
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.54.2

Parent topic: Maestro Operation Notifications
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SwitchExpression
Unable to parse the if-then expression.

Level : Severe

Log Message : Unable to parse the if-then expression: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oSwitchExpressionEv53

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 53

Variables

The SwitchExpression message contains the following variables:

Table 1. SwitchExpression Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications

Feedback | Notices
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TaskCancelled
Caught exception while cancelling job.
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Level : Warning

Log Message : Caught exception while canceling job: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oTaskCancelledEv79

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 79

Variables

The TaskCancelled message contains the following variables:

Table 1. TaskCancelled Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String

 1833



SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications
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TaskEnd
Ended job for specified orchestration.

Level : Info

Log Message : Ended job for orchestration "{OrchName}"

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oTaskEndEv84

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 84

Variables

The TaskEnd message contains the following variables:

Table 1. TaskEnd Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The specified orchestration name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv84OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.84.1

Parent topic: Maestro Operation Notifications
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TaskFound
Found task with specified state on undeploy.

Level : Severe

Log Message : On undeploy, found task {TaskName} whose state is {State}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oTaskFoundEv55

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 55

Variables
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The TaskFound message contains the following variables:

Table 1. TaskFound Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TaskName

The task name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv55TaskName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.55.1

6. State

The state of the task.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv55State
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.55.2

Parent topic: Maestro Operation Notifications
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TaskRemove
Unable to remove the task.

Level : Severe

Log Message : Unable to remove task {TaskID}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oTaskRemoveEv56

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 56

Variables

The TaskRemove message contains the following variables:

Table 1. TaskRemove Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TaskID

The task ID for the task which was not removed.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv56TaskID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.56.1
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TaskStart
Started job for specified orchestration.

Level : Info

Log Message : Started job for orchestration "{OrchName}"

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oTaskStartEv82

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 82

Variables

The TaskStart message contains the following variables:

Table 1. TaskStart Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The specified orchestration name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv82OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.82.1

Parent topic: Maestro Operation Notifications
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TaskState
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Unable to set the task state.

Level : Severe

Log Message : Unable to set state of task {CurrentState} to {FinalState}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oTaskStateEv57

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 57

Variables

The TaskState message contains the following variables:

Table 1. TaskState Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. CurrentState

The current state of the task.
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Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv57CurrentState
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.57.1

6. FinalState

The final state of the task.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv57FinalState
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.57.2
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TaskStateTransition
Invalid task state transition happened, hence marking the job as faulted.

Level : Severe

Log Message : Invalid task state transition, marked job faulted

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oTaskStateTransitionEv58

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 58

Variables

The TaskStateTransition message contains the following variables:

Table 1. TaskStateTransition Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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TaskStatusChanged
Job status changed.

Level : Info

Log Message : Job status changed to {Status}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oTaskStatusChangedEv83

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 83

Variables
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The TaskStatusChanged message contains the following variables:

Table 1. TaskStatusChanged Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Status

The new job status.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv83Status
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.83.1
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TooManyWaitingJobs
A job was aborted due to a large number of waiting jobs.

Level : Severe

Log Message : Running of job for orchestration {OrchName} aborted due to large number of waiting jobs

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oTooManyWaitingJobsEv88

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 88

Variables

The TooManyWaitingJobs message contains the following variables:

Table 1. TooManyWaitingJobs Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OrchName

The orchestration name.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv88OrchName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.88.1
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VariableNull
Specified variable is null.

Level : Warning

Log Message : Variable {VarName} is null

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oVariableNullEv77

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 77

Variables

The VariableNull message contains the following variables:

Table 1. VariableNull Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. VarName

The variable name which is null.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv77VarName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.77.1
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WhileExpEmpty
The condition provided for while activity is empty.

Level : Severe

Log Message : The condition provided for while activity [{ActivityName}] is empty

System : Orchestration
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SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oWhileExpEmptyEv61

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 61

Variables

The WhileExpEmpty message contains the following variables:

Table 1. WhileExpEmpty Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The name of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv61ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.61.1

Parent topic: Maestro Operation Notifications
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WhileExpression
Unable to parse while expression with specified condition.

Level : Severe

Log Message : Unable to parse the while expression ''{ConditionSpecified}'': {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oWhileExpressionEv60

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

SNMP Trap Number : 60

Variables

The WhileExpression message contains the following variables:

Table 1. WhileExpression Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ConditionSpecified

The condition specified for the while expression.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv60ConditionSpecified
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.60.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Operation Notifications
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WrongActFactory
Activity factory with specified name and version returned wrong class.

Level : Severe

Log Message : ActivityFactory (name - {ActivityName},version - {ActivityVersion}) returned wrong class
{ActivityClass}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oWrongActFactoryEv62

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.2

 1849



SNMP Trap Number : 62

Variables

The WrongActFactory message contains the following variables:

Table 1. WrongActFactory Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The name of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv62ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.62.1

6. ActivityVersion

The version of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv62ActivityVersion
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.62.2

7. ActivityClass

The class of the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-MAESTRO-MIB::ciC20oEv62ActivityClass
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.20.1.2.1.62.3

Parent topic: Maestro Operation Notifications

Feedback | Notices
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Maestro Internal Notifications
Provides a comprehensive list of internal notifications sent from the Maestro Module.

IOError
Internal error occurred because of Input/Output error.
UnCaughtError
Uncaught Internal error occurred.
UnExpectedError
Unexpected Internal error occurred.

Parent topic: Maestro Module
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IOError
Internal error occurred because of Input/Output error.

Level : Warning
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Log Message : Internal error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20iIOErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.3

SNMP Trap Number : 3

Variables

The IOError message contains the following variables:

Table 1. IOError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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UnCaughtError
Uncaught Internal error occurred.

Level : Severe

Log Message : Internal error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20iUnCaughtErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.3

SNMP Trap Number : 1

Variables

The UnCaughtError message contains the following variables:

Table 1. UnCaughtError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Internal Notifications
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UnExpectedError
Unexpected Internal error occurred.

Level : Severe

Log Message : Internal error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-MAESTRO-MIB::ciC20iUnExpectedErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.20.1.3

SNMP Trap Number : 2

Variables

The UnExpectedError message contains the following variables:

Table 1. UnExpectedError Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Maestro Internal Notifications
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ro_internal_unexpectederror_message.html
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NetSuite Module
The NetSuite Module provides access to the NetSuite online service. This section contains details for the
messages delivered from the NetSuite Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the NetSuite Module.

MIB Name : CASTIRON-COMP-NETSUITE-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.11

The following table provides an alphabetical list of all notifications that can be issued by the NetSuite Module.

Table 1. Notifications issued by the NetSuite Module
Notification Level System Description

ConnectionFailed Severe Orchestration The NetSuite operation failed because a connection
to the server could not be established.

ConnectionPoolError Warning Orchestration Error occurred while returning connection to pool.
Continuing the activity.

ConnectionRetry Warning Orchestration The NetSuite operation failed while trying to connect
to the server. The operation will be retried.

CustomFieldError Severe Orchestration Error occurred and returned specified soap fault while
getting custom fields for the recordType.

IOError Severe Orchestration Unexpected IO error occurred while performing
operation with NetSuite.

SoapError Severe Orchestration Error occurred while creating SOAP message.

StreamError Severe Orchestration Unexpected IO exception occurred while streaming
the message.

TransformationError Severe Orchestration An error occurred while processing a message for
NetSuite.

UnknownError Severe Orchestration Unknown error while invoking an operation on
NetSuite.

NetSuite Connection Notifications
Provides a comprehensive list of connection notifications sent from the NetSuite Module.
NetSuite Operation Notifications
Provides a comprehensive list of operation notifications sent from the NetSuite Module.
NetSuite Internal Notifications
Provides a comprehensive list of internal notifications sent from the NetSuite Module.

Feedback | Notices
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_the_netsuite_module.html

NetSuite Connection Notifications
Provides a comprehensive list of connection notifications sent from the NetSuite Module.

ConnectionFailed
The NetSuite operation failed because a connection to the server could not be established.
ConnectionPoolError
Error occurred while returning connection to pool. Continuing the activity.
ConnectionRetry
The NetSuite operation failed while trying to connect to the server. The operation will be retried.

Parent topic: NetSuite Module
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ConnectionFailed
The NetSuite operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Unable to connect to NetSuite after {NumberOfRetryAttempts} attempts. Error is: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-NETSUITE-MIB::ciC11cConnectionFailedEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.11.1.1

SNMP Trap Number : 2

Variables

The ConnectionFailed message contains the following variables:

Table 1. ConnectionFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-NETSUITE-MIB::ciC11cEv2NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.11.1.1.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: NetSuite Connection Notifications

Feedback | Notices
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ConnectionPoolError
Error occurred while returning connection to pool. Continuing the activity.

Level : Warning

Log Message : Exception while returning connection to pool.Swallowing the exception. The Exception is
{Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-NETSUITE-MIB::ciC11cConnectionPoolErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.11.1.1

SNMP Trap Number : 3

Variables

The ConnectionPoolError message contains the following variables:

Table 1. ConnectionPoolError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: NetSuite Connection Notifications

Feedback | Notices

 Last updated: Thursday, December 17, 2015
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/netsuite/netsuit
e_connection_connectionpoolerror_message.html

ConnectionRetry
The NetSuite operation failed while trying to connect to the server. The operation will be retried.

Level : Warning

Log Message : Unable to connect to NetSuite. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-NETSUITE-MIB::ciC11cConnectionRetryEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.11.1.1

SNMP Trap Number : 1

Variables

The ConnectionRetry message contains the following variables:

Table 1. ConnectionRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-NETSUITE-MIB::ciC11cEv1RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.11.1.1.1.1.2

7. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-NETSUITE-MIB::ciC11cEv1TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.11.1.1.1.1.3

8. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-NETSUITE-MIB::ciC11cEv1IntervalForRetries
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.11.1.1.1.1.4
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NetSuite Operation Notifications
Provides a comprehensive list of operation notifications sent from the NetSuite Module.

CustomFieldError
Error occurred and returned specified soap fault while getting custom fields for the recordType.
TransformationError
An error occurred while processing a message for NetSuite.

Parent topic: NetSuite Module
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CustomFieldError
Error occurred and returned specified soap fault while getting custom fields for the recordType.

Level : Severe

Log Message : Exception while getting custom fields for the recordType. The soap fault code is {SoapFaultCode}
and fault message is {SoapFaultMessage}

System : Orchestration

SNMP Name : CASTIRON-COMP-NETSUITE-MIB::ciC11oCustomFieldErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.11.1.2

SNMP Trap Number : 2
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Variables

The CustomFieldError message contains the following variables:

Table 1. CustomFieldError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. SoapFaultCode

The soap fault returned by the error.

Type : String
SNMP Object Name : CASTIRON-COMP-NETSUITE-MIB::ciC11oEv2SoapFaultCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.11.1.2.1.2.1

6. SoapFaultMessage

The soap fault message returned by the error.

Type : String
SNMP Object Name : CASTIRON-COMP-NETSUITE-MIB::ciC11oEv2SoapFaultMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.11.1.2.1.2.2
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TransformationError
An error occurred while processing a message for NetSuite.

Level : Severe

Log Message : Exception while processing a message for NetSuite. Exception is {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-NETSUITE-MIB::ciC11oTransformationErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.11.1.2

SNMP Trap Number : 1

Variables

The TransformationError message contains the following variables:

Table 1. TransformationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

1864   



Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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NetSuite Internal Notifications
Provides a comprehensive list of internal notifications sent from the NetSuite Module.

IOError
Unexpected IO error occurred while performing operation with NetSuite.
SoapError
Error occurred while creating SOAP message.
StreamError
Unexpected IO exception occurred while streaming the message.
UnknownError
Unknown error while invoking an operation on NetSuite.

Parent topic: NetSuite Module

Feedback | Notices
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IOError
Unexpected IO error occurred while performing operation with NetSuite.

Level : Severe

Log Message : Unexpected IO error while performing operation with NetSuite. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-NETSUITE-MIB::ciC11iIOErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.11.1.3

SNMP Trap Number : 1

Variables

The IOError message contains the following variables:

Table 1. IOError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SoapError
Error occurred while creating SOAP message.

Level : Severe

Log Message : Exception while creating soap message. The exception is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-NETSUITE-MIB::ciC11iSoapErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.11.1.3

SNMP Trap Number : 2

Variables

The SoapError message contains the following variables:

Table 1. SoapError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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StreamError
Unexpected IO exception occurred while streaming the message.

Level : Severe
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Log Message : Unexpected IO exception while streaming the message. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-NETSUITE-MIB::ciC11iStreamErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.11.1.3

SNMP Trap Number : 3

Variables

The StreamError message contains the following variables:

Table 1. StreamError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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UnknownError
Unknown error while invoking an operation on NetSuite.

Level : Severe

Log Message : Unknown exception while invoking an operation on NetSuite. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-NETSUITE-MIB::ciC11iUnknownErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.11.1.3

SNMP Trap Number : 4

Variables

The UnknownError message contains the following variables:

Table 1. UnknownError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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PeopleSoft Module
The PeopleSoft Module provides access to Oracle's PeopleSoft applications. This section contains details for
the messages delivered from the PeopleSoft Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the PeopleSoft Module.

MIB Name : CASTIRON-COMP-PEOPLESOFT-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.9

The following table provides an alphabetical list of all notifications that can be issued by the PeopleSoft
Module.

Table 1. Notifications issued by the PeopleSoft Module
Notification Level System Description

ActivateFailureBlank Severe Orchestration Activity could not be started as the specified name
was blank.
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Notification Level System Description

ActivateSuccess Info Orchestration Activity name specified was successfully activated.

ActivateUnsuccessful Info Orchestration Error occurred while connecting to PeopleSoft system
while activating activity. Activity activated, will try to
establish connectivity at activity execute time.

ActivityFailure Severe Orchestration Activity name specified failed to execute.

ActivitySuccessful Info Orchestration Activity name specified executed successfully. The
response output parameter was successfully
generated.

ConfigURI Info Orchestration Information regarding the URI and Port where the
PeopleSoft Receive is listening.

ConnectionError Severe Orchestration The peoplesoft operation failed because a connection
to the server could not be established.

ConnectionPoolError Warning Orchestration Error occurred while returning connection to the pool.
Continuing the activity.

ConnectionRetry Warning Orchestration The peoplesoft operation failed while trying to
connect to the server. This will cause a retry.

CreateOnlyKeys Warning Orchestration Only Create Keys was specified and no other
properties were specified. Create might not have
created the record.

DataLengthMore Warning Orchestration The data set for specified field name has length
exceeding the field length. This may cause loss of
data.

DeleteFail Warning Orchestration The activity failed to delete specified item number.

GetNoReturn Info Orchestration Activity name specified could not find any record.

ItemNumberBlank Warning Orchestration Item number returned is empty.

MakeConnectError Warning Orchestration Error occurred while creating the connection to
destination.

MessageNameVersion Severe Orchestration Message name and version got does not match that
set in activity.

MissingLibraries Severe Orchestration Peoplesoft activity is missing required libraries.
Please install them from WMC.

NoOperationOnRecord Warning Orchestration Activity could not find any record to do specified
operation on it.

OutOfRange Warning Orchestration Activity is trying to delete an item which is out of
range.

PoolReleaseError Warning Orchestration Error occurred while closing the connection pool.

ReceiveActivate Severe Orchestration Error occurred while activating PeopleSoft Receive.

ReceiveDeActivate Severe Orchestration Error occurred while deactivating PeopleSoft Receive.

ReceiveError Severe Orchestration Peoplesoft receive activity was unsuccessful in
receiving the request.
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Notification Level System Description

ReceiveGeneralError Severe Orchestration Error occurred while sending the response from
PeopleSoft Receive.

ReceiveIOError Severe Orchestration IO Error occurred while processing request in
PeopleSoft Receive.

ReceiveInfo Info Orchestration Got document from specified host with specified
name and version.

ReceiveProcess Severe Orchestration Error occurred while processing request in PeopleSoft
Receive.

ReceiveSuccessful Info Orchestration Peoplesoft receive activity successfully received the
request.

RunningInfo Warning Orchestration Faced few warnings or errors while running
Peoplesoft activity.

RunningMessages Warning Orchestration Received messages while executing the activity.

SetupInfo Warning Orchestration Faced few warnings or errors while setting up
Peoplesoft activity.

PeopleSoft Connection Notifications
Provides a comprehensive list of connection notifications sent from the PeopleSoft Module.
PeopleSoft Operation Notifications
Provides a comprehensive list of operation notifications sent from the PeopleSoft Module.
PeopleSoft Internal Notifications
Provides a comprehensive list of internal notifications sent from the PeopleSoft Module.
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PeopleSoft Connection Notifications
Provides a comprehensive list of connection notifications sent from the PeopleSoft Module.

ActivateUnsuccessful
Error occurred while connecting to PeopleSoft system while activating activity. Activity activated, will try
to establish connectivity at activity execute time.
ConnectionError
The peoplesoft operation failed because a connection to the server could not be established.
ConnectionPoolError
Error occurred while returning connection to the pool. Continuing the activity.
ConnectionRetry
The peoplesoft operation failed while trying to connect to the server. This will cause a retry.
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MakeConnectError
Error occurred while creating the connection to destination.
PoolReleaseError
Error occurred while closing the connection pool.
ReceiveActivate
Error occurred while activating PeopleSoft Receive.
ReceiveDeActivate
Error occurred while deactivating PeopleSoft Receive.
ReceiveIOError
IO Error occurred while processing request in PeopleSoft Receive.

Parent topic: PeopleSoft Module
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ActivateUnsuccessful
Error occurred while connecting to PeopleSoft system while activating activity. Activity activated, will try to
establish connectivity at activity execute time.

Level : Info

Log Message : Error connecting to PeopleSoft system while activating activity {ActivityName}, error is: {Message}.
Activity activated, will try to establish connectivity at activity execute time

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cActivateUnsuccessfulEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.1

SNMP Trap Number : 1

Variables

The ActivateUnsuccessful message contains the following variables:

Table 1. ActivateUnsuccessful Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which failed to connect to Peoplesoft system.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cEv1ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.1.1.1.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: PeopleSoft Connection Notifications
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ConnectionError
The peoplesoft operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Unable to connect to PeopleSoft after {NumberOfRetryAttempts} attempts. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cConnectionErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.1

SNMP Trap Number : 2

Variables

The ConnectionError message contains the following variables:

Table 1. ConnectionError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cEv2NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.1.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: PeopleSoft Connection Notifications
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ConnectionPoolError
Error occurred while returning connection to the pool. Continuing the activity.

Level : Warning

Log Message : Error while returning connection to pool. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cConnectionPoolErrorEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.1

SNMP Trap Number : 7

Variables

The ConnectionPoolError message contains the following variables:

Table 1. ConnectionPoolError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: PeopleSoft Connection Notifications
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ConnectionRetry
The peoplesoft operation failed while trying to connect to the server. This will cause a retry.
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Level : Warning

Log Message : Connection error while executing activity {ActivityName}. The error is: {Message}. Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s)

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cConnectionRetryEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.1

SNMP Trap Number : 3

Variables

The ConnectionRetry message contains the following variables:

Table 1. ConnectionRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which failed to connect to Peoplesoft system.
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Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cEv3ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.1.1.3.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

7. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cEv3RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.1.1.3.3

8. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cEv3TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.1.1.3.4

9. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cEv3IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.1.1.3.5

Parent topic: PeopleSoft Connection Notifications

Feedback | Notices
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MakeConnectError
Error occurred while creating the connection to destination.

Level : Warning
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Log Message : Error while creating the connection to destination. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cMakeConnectErrorEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.1

SNMP Trap Number : 9

Variables

The MakeConnectError message contains the following variables:

Table 1. MakeConnectError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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PoolReleaseError
Error occurred while closing the connection pool.

Level : Warning

Log Message : Error while closing the connection pool. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cPoolReleaseErrorEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.1

SNMP Trap Number : 8

Variables

The PoolReleaseError message contains the following variables:

Table 1. PoolReleaseError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveActivate
Error occurred while activating PeopleSoft Receive.

Level : Severe

Log Message : Error while activating PeopleSoft Receive. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cReceiveActivateEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.1

SNMP Trap Number : 5

Variables

The ReceiveActivate message contains the following variables:

Table 1. ReceiveActivate Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveDeActivate
Error occurred while deactivating PeopleSoft Receive.

Level : Severe

Log Message : Error while deactivating PeopleSoft Receive. Discarding error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cReceiveDeActivateEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.1

SNMP Trap Number : 6

Variables

The ReceiveDeActivate message contains the following variables:

Table 1. ReceiveDeActivate Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveIOError
IO Error occurred while processing request in PeopleSoft Receive.

Level : Severe

Log Message : IO Error while processing request in PeopleSoft Receive. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9cReceiveIOErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.1

SNMP Trap Number : 4

Variables

The ReceiveIOError message contains the following variables:

Table 1. ReceiveIOError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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PeopleSoft Operation Notifications
Provides a comprehensive list of operation notifications sent from the PeopleSoft Module.

ActivateFailureBlank
Activity could not be started as the specified name was blank.
ActivateSuccess
Activity name specified was successfully activated.
ActivityFailure
Activity name specified failed to execute.
ActivitySuccessful
Activity name specified executed successfully. The response output parameter was successfully
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generated.
ConfigURI
Information regarding the URI and Port where the PeopleSoft Receive is listening.
CreateOnlyKeys
Only Create Keys was specified and no other properties were specified. Create might not have created
the record.
DataLengthMore
The data set for specified field name has length exceeding the field length. This may cause loss of data.
DeleteFail
The activity failed to delete specified item number.
GetNoReturn
Activity name specified could not find any record.
ItemNumberBlank
Item number returned is empty.
MessageNameVersion
Message name and version got does not match that set in activity.
NoOperationOnRecord
Activity could not find any record to do specified operation on it.
OutOfRange
Activity is trying to delete an item which is out of range.
ReceiveError
Peoplesoft receive activity was unsuccessful in receiving the request.
ReceiveGeneralError
Error occurred while sending the response from PeopleSoft Receive.
ReceiveInfo
Got document from specified host with specified name and version.
ReceiveProcess
Error occurred while processing request in PeopleSoft Receive.
ReceiveSuccessful
Peoplesoft receive activity successfully received the request.
RunningInfo
Faced few warnings or errors while running Peoplesoft activity.
RunningMessages
Received messages while executing the activity.

Parent topic: PeopleSoft Module
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ActivateFailureBlank
Activity could not be started as the specified name was blank.

Level : Severe
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Log Message : Activity {ActivityName} not started as {Name} is blank

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oActivateFailureBlankEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 6

Variables

The ActivateFailureBlank message contains the following variables:

Table 1. ActivateFailureBlank Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which failed to activate.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv6ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.6.1
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6. Name

The name which was left blank causing activate to fail.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv6Name
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.6.2
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ActivateSuccess
Activity name specified was successfully activated.

Level : Info

Log Message : Activity {ActivityName} activated successfully

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oActivateSuccessEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 5

Variables

The ActivateSuccess message contains the following variables:

Table 1. ActivateSuccess Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which was activated.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv5ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.5.1
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ActivityFailure
Activity name specified failed to execute.

Level : Severe

Log Message : Error while trying to execute activity {ActivityName}. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oActivityFailureEv4
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 4

Variables

The ActivityFailure message contains the following variables:

Table 1. ActivityFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which failed.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv4ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.4.1

6. Message

Textual description of the error.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ActivitySuccessful
Activity name specified executed successfully. The response output parameter was successfully generated.

Level : Info

Log Message : {ActivityName} executed and outputted response output parameter

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oActivitySuccessfulEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 3

Variables

The ActivitySuccessful message contains the following variables:

Table 1. ActivitySuccessful Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which succeeded.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv3ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.3.1
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ConfigURI
Information regarding the URI and Port where the PeopleSoft Receive is listening.

Level : Info

Log Message : PeopleSoft Receive listening for events on URI: \"{UriValue}\" and port: \"{PortValue}\"

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oConfigURIEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 19

Variables
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The ConfigURI message contains the following variables:

Table 1. ConfigURI Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. UriValue

The URI the server is listening on.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv19UriValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.19.1

6. PortValue

The port number the server is listening on.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv19PortValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.19.2
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CreateOnlyKeys
Only Create Keys was specified and no other properties were specified. Create might not have created the
record.

Level : Warning

Log Message : Only Create Keys and no other properties specified. Create might not have created record.

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oCreateOnlyKeysEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 20

Variables

The CreateOnlyKeys message contains the following variables:

Table 1. CreateOnlyKeys Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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DataLengthMore
The data set for specified field name has length exceeding the field length. This may cause loss of data.

Level : Warning

Log Message : Data being set for field named {FieldName} has length {DataLength}, where as field has length
{FieldLength}. There may be loss of data.

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oDataLengthMoreEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 12

Variables

The DataLengthMore message contains the following variables:

Table 1. DataLengthMore Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FieldName

Name of the field for which data has been set.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv12FieldName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.12.1

6. DataLength

Length of the data which has been set for this field.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv12DataLength
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.12.2

7. FieldLength

Length of the field for which data has been set.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv12FieldLength
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.12.3
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DeleteFail
The activity failed to delete specified item number.

Level : Warning

Log Message : Delete failed for item {ItemNumber}. Returning false

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oDeleteFailEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 10

Variables

The DeleteFail message contains the following variables:

Table 1. DeleteFail Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ItemNumber

Item number which is out of range.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv10ItemNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.10.1
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GetNoReturn
Activity name specified could not find any record.

Level : Info

Log Message : Activity {ActivityName} could not find any record

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oGetNoReturnEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 7

Variables

The GetNoReturn message contains the following variables:

Table 1. GetNoReturn Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

1900   



Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which could not find any record.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv7ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.7.1
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ItemNumberBlank
Item number returned is empty.
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Level : Warning

Log Message : ITEM_NO is empty. Returning false

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oItemNumberBlankEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 11

Variables

The ItemNumberBlank message contains the following variables:

Table 1. ItemNumberBlank Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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MessageNameVersion
Message name and version got does not match that set in activity.

Level : Severe

Log Message : Message name and version got does not match that set in activity. Set in activity: Message Name:
{MessageName}, Message Version: {MessageVersion}. Actually Got: Message Name: {ActualMessageName},
Message Version: {ActualMessageVersion}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oMessageNameVersionEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 14

Variables

The MessageNameVersion message contains the following variables:

Table 1. MessageNameVersion Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MessageName

The message name set in the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv14MessageName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.14.1

6. MessageVersion

The message version set in the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv14MessageVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.14.2

7. ActualMessageName

The message name received in the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv14ActualMessageName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.14.3

8. ActualMessageVersion

The message version received in the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv14ActualMessageVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.14.4
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NoOperationOnRecord
Activity could not find any record to do specified operation on it.

Level : Warning

Log Message : Not able to get any record to do {OperationName} on. Returning false

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oNoOperationOnRecordEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 8

Variables

The NoOperationOnRecord message contains the following variables:

Table 1. NoOperationOnRecord Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. OperationName

Operation name that could not be specified.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv8OperationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.8.1
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OutOfRange
Activity is trying to delete an item which is out of range.

Level : Warning

Log Message : Trying to delete item {ItemNumber} which is out of range. Returning false

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oOutOfRangeEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 9

Variables

The OutOfRange message contains the following variables:

Table 1. OutOfRange Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ItemNumber

Item number which is out of range.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv9ItemNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.9.1
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ReceiveError
Peoplesoft receive activity was unsuccessful in receiving the request.

Level : Severe

Log Message : Error while receiving in PeopleSoft Receive. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oReceiveErrorEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2
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SNMP Trap Number : 16

Variables

The ReceiveError message contains the following variables:

Table 1. ReceiveError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveGeneralError
Error occurred while sending the response from PeopleSoft Receive.

Level : Severe

Log Message : Error while sending the response from PeopleSoft Receive. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oReceiveGeneralErrorEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 17

Variables

The ReceiveGeneralError message contains the following variables:

Table 1. ReceiveGeneralError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ReceiveInfo
Got document from specified host with specified name and version.

Level : Info

Log Message : Got document from {From} with Message Name: {MessageName}, Message Version:
{MessageVersion}, Message Type: {MessageType} and Originating Time Stamp: {TimeStamp}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oReceiveInfoEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 13

Variables

The ReceiveInfo message contains the following variables:

Table 1. ReceiveInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. From

The name of the host where receive activity got the document.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv13From
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.13.1

6. MessageName

The name of the message received by the activity

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv13MessageName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.13.2

7. MessageVersion

The version of the message received by the activity

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv13MessageVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.13.3

8. MessageType
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The type of the message received by the activity

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv13MessageType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.13.4

9. TimeStamp

The originating time stamp of the message received by the activity

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv13TimeStamp
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.13.5

Parent topic: PeopleSoft Operation Notifications
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ReceiveProcess
Error occurred while processing request in PeopleSoft Receive.

Level : Severe

Log Message : Error while processing request in PeopleSoft Receive. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oReceiveProcessEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 18

Variables

The ReceiveProcess message contains the following variables:

Table 1. ReceiveProcess Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: PeopleSoft Operation Notifications
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ReceiveSuccessful
Peoplesoft receive activity successfully received the request.

Level : Info

Log Message : Successfully received request in PeopleSoft Receive and outputted output parameter response
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System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oReceiveSuccessfulEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 15

Variables

The ReceiveSuccessful message contains the following variables:

Table 1. ReceiveSuccessful Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: PeopleSoft Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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RunningInfo
Faced few warnings or errors while running Peoplesoft activity.

Level : Warning

Log Message : Errors/Warning messages while executing activity: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oRunningInfoEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 2

Variables

The RunningInfo message contains the following variables:

Table 1. RunningInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: PeopleSoft Operation Notifications
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RunningMessages
Received messages while executing the activity.

Level : Warning

Log Message : {MessageType} messages while executing activity: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oRunningMessagesEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.2

SNMP Trap Number : 1

Variables

The RunningMessages message contains the following variables:

Table 1. RunningMessages Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. MessageType

Type of the message received.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv1MessageType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.1.1

6. Message

The message received while executing the activity.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9oEv1Message
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.2.1.1.2
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Provides a comprehensive list of internal notifications sent from the PeopleSoft Module.

MissingLibraries
Peoplesoft activity is missing required libraries. Please install them from WMC.
SetupInfo
Faced few warnings or errors while setting up Peoplesoft activity.

Parent topic: PeopleSoft Module
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MissingLibraries
Peoplesoft activity is missing required libraries. Please install them from WMC.

Level : Severe

Log Message : Missing classes when trying to start activity {ActivitName}. PeopleSoft library may need to be
installed on the appliance. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9iMissingLibrariesEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.3

SNMP Trap Number : 1

Variables

The MissingLibraries message contains the following variables:

Table 1. MissingLibraries Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivitName

The activity name which faced the error.

Type : String
SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9iEv1ActivitName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.3.1.1.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: PeopleSoft Internal Notifications
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SetupInfo
Faced few warnings or errors while setting up Peoplesoft activity.
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Level : Warning

Log Message : Warning/error messages while initializing {ActivityName}: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9iSetupInfoEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.9.1.3

SNMP Trap Number : 2

Variables

The SetupInfo message contains the following variables:

Table 1. SetupInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

The activity name which faced the error.

Type : String
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SNMP Object Name : CASTIRON-COMP-PEOPLESOFT-MIB::ciC9iEv2ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.9.1.3.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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Platform Module
The Platform module provides notifications for elements generally not associated with projects or the runtime
such as hardware, network, security, and resources. This section contains details for the messages delivered
from the Platform Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Platform Module.

MIB Name : CASTIRON-COMP-PLATFORM-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.23

The following table provides an alphabetical list of all notifications that can be issued by the Platform Module.

Table 1. Notifications issued by the Platform Module
Notification Level System Description

AccessViolation Info Security An authenticated user attempted to access a section
of the Cast Iron product which would require
additional authorization.

AuthFailure Severe Security An attempt to authenticate with the appliance failed.

AuthLogOut Info Security Event showing logging out of the user.

AuthSuccess Info Security Attempt to authenticate with the appliance was
successful.

DiskUsageCritOk Info Resources Disk space usage is below the critical threshold.

DiskUsageCritical Severe Resources Disk space usage has exceeded the critical threshold.
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Notification Level System Description

DiskUsageWarnOk Info Resources Disk space usage is below the warning threshold.

DiskUsageWarning Warning Resources Disk space usage has exceeded the warning
threshold.

FanFailed Severe Hardware A cooling fan is not operating correctly.

FanRestored Info Hardware A cooling fan has resumed proper operation.

GrantRole Info Security grant new role created.

GroupCreated Info Security New group created.

GroupDeleted Info Security Group deleted.

HighAvailFailover Info Hardware The High Availability failover feature has taken effect;
failover is complete.

HighAvailNotReady Warning Hardware The HA system is not Highly Available.

HighAvailReady Info Hardware The HA system is Highly Available.

HighAvailVersionError Severe Resources The version of CIOS running on Standby does not
match that running on Active.

IntrusionInform Warning Hardware The appliance case has been opened.

IntrusionSevere Severe Hardware The appliance case has been opened, which could
result in system failure. Please contact Cast Iron
Support.

LargeFileWarning Warning Resources Large file taking up space on heavily loaded disk.

NetworkAutohost Warning Network The Autohost feature has added the appliance's
hostname and IP address to /etc/hosts.

NetworkInvalidRoute Warning Network Could not add a requested network route.

NetworkLinkDown Warning Network The network link is down (offline).

NetworkLinkUp Info Network The network link is up (online).

OrcmonArchiveError Severe Resources Job log archive error.

OrcmonDatabaseError Severe Resources Job log database error.

OrcmonDiskFull Warning Resources Normal job log purging did not clear enough disk
space. Purging half of all job logs in attempt to
recover disk space.

OrcmonDiskFullNoPurge Severe Resources Failed to purge any job logs to recover disk space.

OrcmonDiskTrigger Info Resources Job log purge was initiated due to an available disk
space trigger.

OrcmonExportCdError Severe Resources Could not upload the job log archive file to the FTP
server: Could not cd to the destination directory.

OrcmonExportError Severe Resources Failure uploading archive file to FTP server.

OrcmonExportFTP Info Resources Exporting archive file to FTP server.

OrcmonExportLocal Info Resources Exporting job log data to a local archive file.
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Notification Level System Description

OrcmonExportStoreErr Severe Resources Failure uploading archive file to FTP server: Could not
store file.

OrcmonExportedJobs Info Resources Exported jobs from the job log.

OrcmonPurgeByCompl Info Resources Job log purge has been triggered based on the
number of stored completed jobs.

OrcmonPurgeByErrored Info Resources Job log purge has been triggered based on the
number of stored errored jobs.

OrcmonPurgeByTime Info Resources Job log purge has been triggered based on the
amount of time since the last purge.

OrcmonPurgeByTimeNP Info Resources Job log purge has been triggered based on the
amount of time since collection began.

OrcmonPurgeFailed Severe Resources Job log purge/archive failed.

PowerInterrupted Warning Hardware A power module has reported that it does not have
power.

PowerRestored Info Hardware A power module has reported that power has been
restored.

RaidArrayDegraded Severe Hardware The RAID array on the appliance is degraded.

RaidArrayOffline Severe Hardware The RAID array on the appliance is offline. Please
contact Cast Iron Support.

RaidArrayOptimal Info Hardware The RAID array on the appliance is optimal.

RaidDiskFailed Severe Hardware A disk on the appliance has failed.

RaidDiskOnline Info Hardware A disk on the appliance is now online and working
properly.

RaidDiskRebuilding Info Hardware A disk on the appliance is rebuilding.

RevokeRole Info Security User role revoked.

SwapUsageCritOk Info Resources Swap space usage is below the critical threshold.

SwapUsageCritical Severe Resources Swap space usage has exceeded the critical
threshold.

SwapUsageWarnOk Info Resources Swap space usage is below the warning threshold.

SwapUsageWarning Warning Resources Swap space usage has exceeded the warning
threshold.

SystemInitComplete Info Hardware The appliance is finished initializing after reboot.

SystemInitStarted Info Hardware The appliance is initializing after being shut down or
rebooted.

SystemRecoveryReboot Warning Hardware Operational failure was detected. System is rebooting
to recover.

SystemRecoveryRestart Warning Hardware Operational failure was detected. System is restarting
to recover.
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Notification Level System Description

TemperatureOutOfRange Severe Hardware A monitored temperature within the appliance is too
high, which could lead to future failures.

TemperatureRestored Info Hardware A temperature which was previously out of range (too
hot) has come back into range

UpdateStatus Info Security Update user status as active or inactive.

UpdateUser Info Security Update display name of a user.

UpgradeComplete Info Hardware The Cast Iron firmware was successfully upgraded.

UpgradeFailed Severe Hardware The attempt to upgrade the Cast Iron firmware has
failed.

UserCreated Info Security New user created.

UserDeleted Info Security User deleted.

Platform Hardware Notifications
Provides a comprehensive list of hardware notifications sent from the Platform Module.
Platform Network Notifications
Provides a comprehensive list of network notifications sent from the Platform Module.
Platform Resources Notifications
Provides a comprehensive list of resources notifications sent from the Platform Module.
Platform Security Notifications
Provides a comprehensive list of security notifications sent from the Platform Module.
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 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/platform/about
_the_platform_module.html

Platform Hardware Notifications
Provides a comprehensive list of hardware notifications sent from the Platform Module.

FanFailed
A cooling fan is not operating correctly.
FanRestored
A cooling fan has resumed proper operation.
HighAvailFailover
The High Availability failover feature has taken effect; failover is complete.
HighAvailNotReady
The HA system is not Highly Available.
HighAvailReady
The HA system is Highly Available.
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IntrusionInform
The appliance case has been opened.
IntrusionSevere
The appliance case has been opened, which could result in system failure. Please contact Cast Iron
Support.
PowerInterrupted
A power module has reported that it does not have power.
PowerRestored
A power module has reported that power has been restored.
RaidArrayDegraded
The RAID array on the appliance is degraded.
RaidArrayOffline
The RAID array on the appliance is offline. Please contact Cast Iron Support.
RaidArrayOptimal
The RAID array on the appliance is optimal.
RaidDiskFailed
A disk on the appliance has failed.
RaidDiskOnline
A disk on the appliance is now online and working properly.
RaidDiskRebuilding
A disk on the appliance is rebuilding.
SystemInitComplete
The appliance is finished initializing after reboot.
SystemInitStarted
The appliance is initializing after being shut down or rebooted.
SystemRecoveryReboot
Operational failure was detected. System is rebooting to recover.
SystemRecoveryRestart
Operational failure was detected. System is restarting to recover.
TemperatureOutOfRange
A monitored temperature within the appliance is too high, which could lead to future failures.
TemperatureRestored
A temperature which was previously out of range (too hot) has come back into range
UpgradeComplete
The Cast Iron firmware was successfully upgraded.
UpgradeFailed
The attempt to upgrade the Cast Iron firmware has failed.

Parent topic: Platform Module
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FanFailed
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A cooling fan is not operating correctly.

The most likely cause is that the fan has become disconnected or has failed. The recommended action is to 1)
confirm the appliance with the corresponding AffectedAppliance serial number has an indicator LED (usually
orange), 2) confirm the fan is properly connected, and 3) contact Cast Iron Support for assistance replacing the
fan.

Level : Severe

Log Message : Fan {FanID} on appliance {AffectedAppliance} is not functional. Current={CurrentSpeed} RPM.
Minimum={MinimumSpeed} RPM.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hFanFailedEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 1

Variables

The FanFailed message contains the following variables:

Table 1. FanFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. FanID

Identifier associated with the failed fan.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv1FanID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.1.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

5. CurrentSpeed

Current speed of the fan in RPM.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv1CurrentSpeed
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.1.3

6. MinimumSpeed

Minimum speed of the fan in RPM.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv1MinimumSpeed
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.1.4
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FanRestored
A cooling fan has resumed proper operation.

This notification may occur if a fan previously failed, but has since been repaired or reconnected.

Level : Info

Log Message : Fan {FanID} on appliance {AffectedAppliance} is functional. Current={CurrentSpeed} RPM.
Minimum={MinimumSpeed} RPM.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hFanRestoredEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 2

Variables

The FanRestored message contains the following variables:
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Table 1. FanRestored Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. FanID

Identifier associated with the failed fan.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv2FanID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.2.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

5. CurrentSpeed

Current speed of the fan in RPM.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv2CurrentSpeed
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.2.3

6. MinimumSpeed

Minimum speed of the fan in RPM.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv2MinimumSpeed
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.2.4

Parent topic: Platform Hardware Notifications
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HighAvailFailover
The High Availability failover feature has taken effect; failover is complete.

HA systems may "fail over" to the Standby appliance based on user request or based on the needs of the
system. This notification is sent when the procedure has completed, regardless of the reason that the failover
occurred.

Level : Info

Log Message : The High Availability peer {AffectedAppliance} has successfully taken over.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hHighAvailFailoverEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 15

Variables

The HighAvailFailover message contains the following variables:

Table 1. HighAvailFailover Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

Parent topic: Platform Hardware Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/platform/platfo
rm_hardware_highavailfailover_message.html

HighAvailNotReady
The HA system is not Highly Available.

The Cast Iron HA pair is Highly Available when both Active and Standby appliances are fully operational. That
is, when Standby is ready to take over for Active in case of a failure. This notification indicates that the Standby
appliance is not currently synchronized with Active and therefore is not ready to take over if necessary.

Level : Warning

Log Message : The HA system is not Highly Available. Active appliance is {AffectedAppliance}.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hHighAvailNotReadyEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 23

Variables

The HighAvailNotReady message contains the following variables:

Table 1. HighAvailNotReady Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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HighAvailReady
The HA system is Highly Available.

The Cast Iron HA pair is Highly Available when both Active and Standby appliances are fully operational. That
is, when Standby is ready to take over for Active in case of a failure. This notification indicates that the Standby
appliance has synchronized with Active and is ready to take over if necessary.

Level : Info

Log Message : The HA system is Highly Available with appliance {AffectedAppliance} acting as Active.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hHighAvailReadyEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 22

Variables

The HighAvailReady message contains the following variables:

Table 1. HighAvailReady Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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IntrusionInform
The appliance case has been opened.

This applies to 7198-type appliances. The appliance has reported that its case was opened. This is an
informational message; the intrusion sensor on this appliance does not affect the appliance's behavior. If this
message occurs unexpectedly, you may wish to ensure the physical security of your appliance.

Level : Warning

Log Message : The appliance {AffectedAppliance} has been opened.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hIntrusionInformEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 7
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Variables

The IntrusionInform message contains the following variables:

Table 1. IntrusionInform Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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IntrusionSevere
The appliance case has been opened, which could result in system failure. Please contact Cast Iron Support.

This applies to 9235-type appliances. The appliance has reported that its case was opened. This is a serious
situation requiring immediate attention to avoid downtime.

Level : Severe
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Log Message : The appliance {AffectedAppliance} has been opened, possibly leading to system failure. Please
contact Cast Iron Support.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hIntrusionSevereEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 8

Variables

The IntrusionSevere message contains the following variables:

Table 1. IntrusionSevere Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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PowerInterrupted
A power module has reported that it does not have power.

The most likely cause is that a power cord has been unplugged. Please ensure both power cords are plugged in
and that the power modules are operating normally.

Level : Warning

Log Message : Power sensor {PowerID} on appliance {AffectedAppliance} has reported a loss of power.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hPowerInterruptedEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 5

Variables

The PowerInterrupted message contains the following variables:

Table 1. PowerInterrupted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. PowerID

Identifier associated with the monitored power module.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv5PowerID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.5.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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PowerRestored
A power module has reported that power has been restored.

Level : Info

Log Message : Power sensor {PowerID} on appliance {AffectedAppliance} has reported power is restored.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hPowerRestoredEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 6

Variables

The PowerRestored message contains the following variables:

Table 1. PowerRestored Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. PowerID
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Identifier associated with the monitored power module.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv6PowerID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.6.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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RaidArrayDegraded
The RAID array on the appliance is degraded.

The appliance will continue operating, excepting any additional hard drive failures. The most likely cause of this
notification is that one of the hard drives has failed or is rebuilding. If the disk is rebuilding, the RAID state
should return to Optimal upon completion.

Level : Severe

Log Message : The RAID array on appliance {AffectedAppliance} is degraded.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hRaidArrayDegradedEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 10

Variables

The RaidArrayDegraded message contains the following variables:

Table 1. RaidArrayDegraded Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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RaidArrayOffline
The RAID array on the appliance is offline. Please contact Cast Iron Support.

The most likely cause is that both hard drives have failed. Please examine the

Level : Severe

Log Message : The RAID array on appliance {AffectedAppliance} is offline. Please contact Cast Iron Support.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hRaidArrayOfflineEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 9
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Variables

The RaidArrayOffline message contains the following variables:

Table 1. RaidArrayOffline Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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RaidArrayOptimal
The RAID array on the appliance is optimal.

This event occurs when a disk which had previously failed or was rebuilding has been restored to proper
operation.

Level : Info

Log Message : The RAID array on appliance {AffectedAppliance} is optimal.
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System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hRaidArrayOptimalEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 11

Variables

The RaidArrayOptimal message contains the following variables:

Table 1. RaidArrayOptimal Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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RaidDiskFailed
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A disk on the appliance has failed.

Level : Severe

Log Message : The RAID disk {DiskID} on appliance {AffectedAppliance} has failed.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hRaidDiskFailedEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 12

Variables

The RaidDiskFailed message contains the following variables:

Table 1. RaidDiskFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. DiskID

Identifier associated with the associated disk.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv12DiskID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.12.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

Parent topic: Platform Hardware Notifications
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RaidDiskOnline
A disk on the appliance is now online and working properly.

This notification is typically sent when a disk has completed rebuilding and comes online, providing hardware
redundancy.

Level : Info

Log Message : The RAID disk {DiskID} on appliance {AffectedAppliance} is online.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hRaidDiskOnlineEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 14

Variables

The RaidDiskOnline message contains the following variables:

Table 1. RaidDiskOnline Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. DiskID

Identifier associated with the associated disk.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv14DiskID
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.14.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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RaidDiskRebuilding
A disk on the appliance is rebuilding.

A rebuilding disk actively copies data from the online disk. While in this state, system performance may be
affected and the RAID Array state is usually "Degraded". System performance and the RAID Array state should
return to normal when rebuilding has completed.

Level : Info

Log Message : The RAID disk {DiskID} on appliance {AffectedAppliance} is rebuilding.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hRaidDiskRebuildingEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 13

Variables

The RaidDiskRebuilding message contains the following variables:

Table 1. RaidDiskRebuilding Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. DiskID

Identifier associated with the associated disk.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv13DiskID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.13.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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SystemInitComplete
The appliance is finished initializing after reboot.

This message indicates that the appliance is fully operational after completing a reboot.

Level : Info

Log Message : The appliance {AffectedAppliance} is finished initializing after reboot.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hSystemInitCompleteEv21
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 21

Variables

The SystemInitComplete message contains the following variables:

Table 1. SystemInitComplete Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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SystemInitStarted
The appliance is initializing after being shut down or rebooted.

The appliance sends this message early in the bootup process. This message is intended as informational,
indicating that a reboot has occurred.
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Level : Info

Log Message : The appliance {AffectedAppliance} is initializing after being shut down or rebooted.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hSystemInitStartedEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 20

Variables

The SystemInitStarted message contains the following variables:

Table 1. SystemInitStarted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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SystemRecoveryReboot
Operational failure was detected. System is rebooting to recover.

The Cast Iron appliance continually monitors the health of components within the system. If a component has
a momentary failure, the system may choose to reboot to recover from the situation. In the case of a recurring
error, further reboots are not used until an hour has passed; instead the runtime is restarted. See the CLI
command "system autoreboot" for information about controlling this behavior.

Level : Warning

Log Message : Operational failure was detected on appliance {AffectedAppliance}. System is rebooting to
recover. Uptime {Days} days, {Hours}:{Minutes}.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hSystemRecoveryRebootEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 18

Variables

The SystemRecoveryReboot message contains the following variables:

Table 1. SystemRecoveryReboot Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

4. Days
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The number of days the system has been up since the last reboot.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv18Days
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.18.2

5. Hours

The number of hours the system has been up since the last reboot.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv18Hours
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.18.3

6. Minutes

The number of minutes the system has been up since the last reboot.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv18Minutes
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.18.4
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SystemRecoveryRestart
Operational failure was detected. System is restarting to recover.

Level : Warning

Log Message : Operational failure on appliance {AffectedAppliance} was detected. System is restarting to
recover.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hSystemRecoveryRestartEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 19

Variables

The SystemRecoveryRestart message contains the following variables:
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Table 1. SystemRecoveryRestart Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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TemperatureOutOfRange
A monitored temperature within the appliance is too high, which could lead to future failures.

Level : Severe

Log Message : Temperature {TempID} on appliance {AffectedAppliance} is out of range. Current=
{CurrentTemperature} deg C. Maximum={MaximumTemperature} deg C.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hTemperatureOutOfRangeEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4
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SNMP Trap Number : 3

Variables

The TemperatureOutOfRange message contains the following variables:

Table 1. TemperatureOutOfRange Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. TempID

Identifier associated with the monitored temperature.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv3TempID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.3.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

5. CurrentTemperature

Current temperature in degrees Celcius.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv3CurrentTemperature
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.3.3

6. MaximumTemperature

Maximum allowed temperature in degrees Celcius.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv3MaximumTemperature
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.3.4
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TemperatureRestored
A temperature which was previously out of range (too hot) has come back into range

Level : Info

Log Message : Temperature {TempID} on appliance {AffectedAppliance} is restored. Current=
{CurrentTemperature} deg C. Maximum={MaximumTemperature} deg C.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hTemperatureRestoredEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 4

Variables

The TemperatureRestored message contains the following variables:

Table 1. TemperatureRestored Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. TempID

 1951



Identifier associated with the monitored temperature.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv4TempID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.4.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

5. CurrentTemperature

Current temperature in degrees Celcius.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv4CurrentTemperature
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.4.3

6. MaximumTemperature

Maximum allowed temperature in degrees Celcius.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv4MaximumTemperature
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.4.4
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UpgradeComplete
The Cast Iron firmware was successfully upgraded.

Level : Info

Log Message : Successfully upgraded Cast Iron firmware on appliance {AffectedAppliance} from version
{OldVersion} to version {NewVersion}.

System : Hardware
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SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hUpgradeCompleteEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 16

Variables

The UpgradeComplete message contains the following variables:

Table 1. UpgradeComplete Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

4. OldVersion

The version of firmware which previously was operating on the Cast Iron appliance.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv16OldVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.16.2

5. NewVersion

The version of firmware which is currently operating on the Cast Iron appliance.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv16NewVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.16.3
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UpgradeFailed
The attempt to upgrade the Cast Iron firmware has failed.

Level : Severe

Log Message : Attempt to upgrade Cast Iron firmware on appliance {AffectedAppliance} from version
{OldVersion} to version {NewVersion} failed: {Message}.

System : Hardware

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hUpgradeFailedEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.4

SNMP Trap Number : 17

Variables

The UpgradeFailed message contains the following variables:

Table 1. UpgradeFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

4. OldVersion

The version of firmware which is currently operating on the Cast Iron appliance.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv17OldVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.17.2

5. NewVersion

The version of the attempted firmware upgrade.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23hEv17NewVersion
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.4.1.17.3

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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Platform Network Notifications
Provides a comprehensive list of network notifications sent from the Platform Module.

NetworkAutohost
The Autohost feature has added the appliance's hostname and IP address to /etc/hosts.
NetworkInvalidRoute
Could not add a requested network route.
NetworkLinkDown
The network link is down (offline).
NetworkLinkUp
The network link is up (online).
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NetworkAutohost
The Autohost feature has added the appliance's hostname and IP address to /etc/hosts.

The appliance requires the ability to resolve its own hostname to an IP address. The mapping is validated each
time the appliance's network subsystem is started, and may be determined by DNS lookup or from an entry
which was manually added via the CLI. If the appliance cannot determine the mapping this way, the autohost
feature automatically adds a "best-guess" entry. While this automatic entry may work in many circumstances,
it is not guaranteed to allow proper appliance operation in all environments. This notification may indicate a
misconfiguration in the network. Therefore it is recommended that the user examine the appliance's network
configuration and either enter the appliance's IP address and hostame to DNS, or manually add an entry to
/etc/hosts by using the CLI command "net add etchost".

Level : Warning

Log Message : Automatically added entry to /etc/hosts with hostname {Hostname} and IP address {IPAddress}.

System : Network

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nNetworkAutohostEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.5

SNMP Trap Number : 3

Variables

The NetworkAutohost message contains the following variables:

Table 1. NetworkAutohost Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Hostname

Hostname of the appliance as added to /etc/hosts.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nEv3Hostname
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.5.1.3.1

4. IPAddress

IP Address of the appliance as added to /etc/hosts.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nEv3IPAddress
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.5.1.3.2
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NetworkInvalidRoute
Could not add a requested network route.

One of the requested custom routes could not be added. Please check the network configuration, paying
particular attention to the gateway IP address and the ethernet link.

Level : Warning

Log Message : Could not add route to {DestinationIP} on {LinkName}.

System : Network

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nNetworkInvalidRouteEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.5

SNMP Trap Number : 4

Variables

The NetworkInvalidRoute message contains the following variables:
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Table 1. NetworkInvalidRoute Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. DestinationIP

IP address or netmask defining the requested route.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nEv4DestinationIP
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.5.1.4.1

4. LinkName

Name of the network link.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nEv4LinkName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.5.1.4.2
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NetworkLinkDown
The network link is down (offline).

The network link could be reported as down because the ethernet cable has been disconnected or the remote
host or switch has disabled the port. To adjust or disable network link detection, see the CLI reference guide for
the command "net set carrier".
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Level : Warning

Log Message : Network link {LinkName} on appliance {AffectedAppliance} is down (offline).

System : Network

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nNetworkLinkDownEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.5

SNMP Trap Number : 2

Variables

The NetworkLinkDown message contains the following variables:

Table 1. NetworkLinkDown Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. LinkName

Name of the network link.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nEv2LinkName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.5.1.2.1

4. AffectedAppliance

Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5

Parent topic: Platform Network Notifications
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NetworkLinkUp
The network link is up (online).

Level : Info

Log Message : Network link {LinkName} on appliance {AffectedAppliance} is up (online).

System : Network

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nNetworkLinkUpEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.5

SNMP Trap Number : 1

Variables

The NetworkLinkUp message contains the following variables:

Table 1. NetworkLinkUp Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. LinkName

Name of the network link.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23nEv1LinkName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.5.1.1.1

4. AffectedAppliance
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Serial number of the affected appliance. In some cases this could be different than the serial number of the
appliance sending a notification, particularly in the case of High Availability pairs where the Active peer could
send a notification on behalf of the Standby peer.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvAffectedAppliance
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.5
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Platform Resources Notifications
Provides a comprehensive list of resources notifications sent from the Platform Module.

DiskUsageCritOk
Disk space usage is below the critical threshold.
DiskUsageCritical
Disk space usage has exceeded the critical threshold.
DiskUsageWarnOk
Disk space usage is below the warning threshold.
DiskUsageWarning
Disk space usage has exceeded the warning threshold.
HighAvailVersionError
The version of CIOS running on Standby does not match that running on Active.
LargeFileWarning
Large file taking up space on heavily loaded disk.
OrcmonArchiveError
Job log archive error.
OrcmonDatabaseError
Job log database error.
OrcmonDiskFull
Normal job log purging did not clear enough disk space. Purging half of all job logs in attempt to recover
disk space.
OrcmonDiskFullNoPurge
Failed to purge any job logs to recover disk space.
OrcmonDiskTrigger
Job log purge was initiated due to an available disk space trigger.
OrcmonExportCdError
Could not upload the job log archive file to the FTP server: Could not cd to the destination directory.
OrcmonExportError
Failure uploading archive file to FTP server.
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OrcmonExportFTP
Exporting archive file to FTP server.
OrcmonExportLocal
Exporting job log data to a local archive file.
OrcmonExportStoreErr
Failure uploading archive file to FTP server: Could not store file.
OrcmonExportedJobs
Exported jobs from the job log.
OrcmonPurgeByCompl
Job log purge has been triggered based on the number of stored completed jobs.
OrcmonPurgeByErrored
Job log purge has been triggered based on the number of stored errored jobs.
OrcmonPurgeByTime
Job log purge has been triggered based on the amount of time since the last purge.
OrcmonPurgeByTimeNP
Job log purge has been triggered based on the amount of time since collection began.
OrcmonPurgeFailed
Job log purge/archive failed.
SwapUsageCritOk
Swap space usage is below the critical threshold.
SwapUsageCritical
Swap space usage has exceeded the critical threshold.
SwapUsageWarnOk
Swap space usage is below the warning threshold.
SwapUsageWarning
Swap space usage has exceeded the warning threshold.
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DiskUsageCritOk
Disk space usage is below the critical threshold.

Level : Info

Log Message : Disk space usage on {Disk} is now below the {Threshold}% critical threshold - current usage is
{Usage}%

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rDiskUsageCritOkEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6
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SNMP Trap Number : 6

Variables

The DiskUsageCritOk message contains the following variables:

Table 1. DiskUsageCritOk Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Disk

Name of the disk being monitored

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv6Disk
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.6.1

4. Threshold

Disk usage threshold

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv6Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.6.2

5. Usage

Current disk usage

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv6Usage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.6.3
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DiskUsageCritical
Disk space usage has exceeded the critical threshold.

Level : Severe

Log Message : Disk space usage on {Disk} has exceeded the {Threshold}% critical threshold - current usage is
{Usage}%

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rDiskUsageCriticalEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 8

Variables

The DiskUsageCritical message contains the following variables:

Table 1. DiskUsageCritical Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Disk

Name of the disk being monitored

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv8Disk
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.8.1

4. Threshold

Disk usage threshold
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Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv8Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.8.2

5. Usage

Current disk usage

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv8Usage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.8.3
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DiskUsageWarnOk
Disk space usage is below the warning threshold.

Level : Info

Log Message : Disk space usage on {Disk} is now below the {Threshold}% warning threshold - current usage is
{Usage}%

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rDiskUsageWarnOkEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 5

Variables

The DiskUsageWarnOk message contains the following variables:

Table 1. DiskUsageWarnOk Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Disk

Name of the disk being monitored

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv5Disk
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.5.1

4. Threshold

Disk usage threshold

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv5Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.5.2

5. Usage

Current disk usage

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv5Usage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.5.3
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DiskUsageWarning
Disk space usage has exceeded the warning threshold.

Level : Warning

Log Message : Disk space usage on {Disk} has exceeded the {Threshold}% warning threshold - current usage is
{Usage}%

System : Resources

1966   



SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rDiskUsageWarningEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 7

Variables

The DiskUsageWarning message contains the following variables:

Table 1. DiskUsageWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Disk

Name of the disk being monitored

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv7Disk
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.7.1

4. Threshold

Disk usage threshold

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv7Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.7.2

5. Usage

Current disk usage

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv7Usage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.7.3

Parent topic: Platform Resources Notifications
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HighAvailVersionError
The version of CIOS running on Standby does not match that running on Active.

Level : Severe

Log Message : HA peers are running different versions of CIOS!

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rHighAvailVersionErrorEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 23

Variables

The HighAvailVersionError message contains the following variables:

Table 1. HighAvailVersionError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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LargeFileWarning
Large file taking up space on heavily loaded disk.

Level : Warning

Log Message : There is an unusually large file, {LargeFile}, of size {FileSize} MB.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rLargeFileWarningEv24

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 24

Variables

The LargeFileWarning message contains the following variables:

Table 1. LargeFileWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. LargeFile

Large file on disk

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv24LargeFile
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.24.1

4. FileSize

Size of file in megabytes

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv24FileSize
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.24.2
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OrcmonArchiveError
Job log archive error.

Level : Severe

Log Message : An error occurred while archiving job logs. The error message is: {Message}

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonArchiveErrorEv25

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 25

Variables

The OrcmonArchiveError message contains the following variables:

Table 1. OrcmonArchiveError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Message

Textual description of the error.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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OrcmonDatabaseError
Job log database error.

Level : Severe

Log Message : An error occurred while executing a query on the job log database. The error message is:
{Message}

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonDatabaseErrorEv26

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 26

Variables

The OrcmonDatabaseError message contains the following variables:

Table 1. OrcmonDatabaseError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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OrcmonDiskFull
Normal job log purging did not clear enough disk space. Purging half of all job logs in attempt to recover disk
space.

Level : Warning

Log Message : Job log purge triggered. Available disk space is {DiskAvailPct}%. Specified trigger is
{DiskAvailTrigger}%. Purging using properties failed to clear enough disk space. Purging half of all job logs in
attempt to recover disk space.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonDiskFullEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 20

Variables

The OrcmonDiskFull message contains the following variables:

Table 1. OrcmonDiskFull Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. DiskAvailPct

Percentage of disk space which is currently available.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv20DiskAvailPct
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.20.1

4. DiskAvailTrigger

Percentage of available disk space which for triggers a purge.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv20DiskAvailTrigger
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.20.2
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OrcmonDiskFullNoPurge
Failed to purge any job logs to recover disk space.

Level : Severe

Log Message : Failed to purge any job logs to recover disk space. Available disk space is {DiskAvailPct}%.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonDiskFullNoPurgeEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 21

Variables

The OrcmonDiskFullNoPurge message contains the following variables:
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Table 1. OrcmonDiskFullNoPurge Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. DiskAvailPct

Percentage of disk space which is currently available.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv21DiskAvailPct
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.21.1
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OrcmonDiskTrigger
Job log purge was initiated due to an available disk space trigger.

Level : Info

Log Message : Job log purge triggered. Available disk space is {DiskAvailPct}%. Specified trigger is
{DiskAvailTrigger}%.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonDiskTriggerEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 9
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Variables

The OrcmonDiskTrigger message contains the following variables:

Table 1. OrcmonDiskTrigger Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. DiskAvailPct

Percentage of disk space which is currently available.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv9DiskAvailPct
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.9.1

4. DiskAvailTrigger

Percentage of available disk space which for triggers a purge.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv9DiskAvailTrigger
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.9.2
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OrcmonExportCdError
Could not upload the job log archive file to the FTP server: Could not cd to the destination directory.
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Level : Severe

Log Message : Failure uploading archive file to FTP server: Could not cd to directory "{Directory}".

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonExportCdErrorEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 17

Variables

The OrcmonExportCdError message contains the following variables:

Table 1. OrcmonExportCdError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Directory

Directory on the FTP server where the file would be stored

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv17Directory
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.17.1
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OrcmonExportError
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Failure uploading archive file to FTP server.

Level : Severe

Log Message : Failure uploading archive file to FTP server: {Message}

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonExportErrorEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 19

Variables

The OrcmonExportError message contains the following variables:

Table 1. OrcmonExportError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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OrcmonExportFTP
Exporting archive file to FTP server.

Level : Info

Log Message : Exporting archive file to FTP server {Host}:{Port}. Placing file "{Filename}" in directory "{Directory}".

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonExportFTPEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 16

Variables

The OrcmonExportFTP message contains the following variables:

Table 1. OrcmonExportFTP Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Host

Remote FTP host

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv16Host
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.16.1

4. Port

TCP Port on the remote FTP host

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv16Port
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.16.2

5. Filename
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Name of the file being exported

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv16Filename
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.16.3

6. Directory

Directory on the FTP server where the file is stored

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv16Directory
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.16.4
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OrcmonExportLocal
Exporting job log data to a local archive file.

Level : Info

Log Message : Exporting job log data to local archive file "{Filename}".

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonExportLocalEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 15

Variables

The OrcmonExportLocal message contains the following variables:

Table 1. OrcmonExportLocal Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Filename

Name of the local archive file.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv15Filename
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.15.1
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OrcmonExportStoreErr
Failure uploading archive file to FTP server: Could not store file.

Level : Severe

Log Message : Failure uploading archive file to FTP server: Could not store file.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonExportStoreErrEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 18

Variables

The OrcmonExportStoreErr message contains the following variables:

Table 1. OrcmonExportStoreErr Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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OrcmonExportedJobs
Exported jobs from the job log.

Level : Info

Log Message : Job log purged {NumExported} jobs.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonExportedJobsEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 14

Variables

The OrcmonExportedJobs message contains the following variables:

Table 1. OrcmonExportedJobs Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. NumExported

Number of jobs exported.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv14NumExported
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.14.1
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OrcmonPurgeByCompl
Job log purge has been triggered based on the number of stored completed jobs.

Level : Info

Log Message : Job log purge triggered. There are {NumCompleted} completed jobs. Completed jobs threshold is
{Threshold}.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonPurgeByComplEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 12

Variables

The OrcmonPurgeByCompl message contains the following variables:

Table 1. OrcmonPurgeByCompl Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. NumCompleted

Number of completed jobs currently stored in the job log.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv12NumCompleted
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.12.1

4. Threshold

Number of stored completed jobs which triggered a job purge.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv12Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.12.2
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OrcmonPurgeByErrored
Job log purge has been triggered based on the number of stored errored jobs.

Level : Info

Log Message : Job log purge triggered. There are {NumErrored} errored jobs. Errored jobs threshold is
{Threshold}.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonPurgeByErroredEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 13
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Variables

The OrcmonPurgeByErrored message contains the following variables:

Table 1. OrcmonPurgeByErrored Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. NumErrored

Number of errored jobs currently stored in the job log.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv13NumErrored
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.13.1

4. Threshold

Number of stored errored jobs which triggered a job purge.

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv13Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.13.2
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OrcmonPurgeByTime
Job log purge has been triggered based on the amount of time since the last purge.
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Level : Info

Log Message : Job log purge triggered. Time since last purge exceeded {PurgeTime}.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonPurgeByTimeEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 11

Variables

The OrcmonPurgeByTime message contains the following variables:

Table 1. OrcmonPurgeByTime Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. PurgeTime

Scheduled time for the purge.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv11PurgeTime
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.11.1
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OrcmonPurgeByTimeNP
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Job log purge has been triggered based on the amount of time since collection began.

Level : Info

Log Message : Job log purge triggered. Exceeded maxmimum duration since last purge.

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonPurgeByTimeNPEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 10

Variables

The OrcmonPurgeByTimeNP message contains the following variables:

Table 1. OrcmonPurgeByTimeNP Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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OrcmonPurgeFailed
Job log purge/archive failed.

Level : Severe

Log Message : Job log purge/archive failed: {Message}.
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System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rOrcmonPurgeFailedEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 22

Variables

The OrcmonPurgeFailed message contains the following variables:

Table 1. OrcmonPurgeFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SwapUsageCritOk
Swap space usage is below the critical threshold.

Level : Info
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Log Message : Swap space usage is now below the {Threshold}% critical threshold - current usage is {Usage}%

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rSwapUsageCritOkEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 2

Variables

The SwapUsageCritOk message contains the following variables:

Table 1. SwapUsageCritOk Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Threshold

Swap usage threshold

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv2Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.2.1

4. Usage

Current swap usage

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv2Usage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.2.2
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SwapUsageCritical
Swap space usage has exceeded the critical threshold.

Level : Severe

Log Message : Swap space usage has exceeded the {Threshold}% critical threshold - current usage is {Usage}%

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rSwapUsageCriticalEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 4

Variables

The SwapUsageCritical message contains the following variables:

Table 1. SwapUsageCritical Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Threshold

Swap usage threshold

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv4Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.4.1

4. Usage

Current swap usage

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv4Usage
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.4.2
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SwapUsageWarnOk
Swap space usage is below the warning threshold.

Level : Info

Log Message : Swap space usage is now below the {Threshold}% warning threshold - current usage is {Usage}%

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rSwapUsageWarnOkEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 1

Variables

The SwapUsageWarnOk message contains the following variables:

Table 1. SwapUsageWarnOk Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Threshold

Swap usage threshold
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Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv1Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.1.1

4. Usage

Current swap usage

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv1Usage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.1.2
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SwapUsageWarning
Swap space usage has exceeded the warning threshold.

Level : Warning

Log Message : Swap space usage has exceeded the {Threshold}% warning threshold - current usage is {Usage}%

System : Resources

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rSwapUsageWarningEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.6

SNMP Trap Number : 3

Variables

The SwapUsageWarning message contains the following variables:

Table 1. SwapUsageWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Threshold

Swap usage threshold

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv3Threshold
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.3.1

4. Usage

Current swap usage

Type : Integer
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23rEv3Usage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.6.1.3.2
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Platform Security Notifications
Provides a comprehensive list of security notifications sent from the Platform Module.

AccessViolation
An authenticated user attempted to access a section of the Cast Iron product which would require
additional authorization.
AuthFailure
An attempt to authenticate with the appliance failed.
AuthLogOut
Event showing logging out of the user.
AuthSuccess
Attempt to authenticate with the appliance was successful.
GrantRole
grant new role created.
GroupCreated
New group created.
GroupDeleted
Group deleted.
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RevokeRole
User role revoked.
UpdateStatus
Update user status as active or inactive.
UpdateUser
Update display name of a user.
UserCreated
New user created.
UserDeleted
User deleted.
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AccessViolation
An authenticated user attempted to access a section of the Cast Iron product which would require additional
authorization.

Level : Info

Log Message : Access Violation by user: {Username}. Target: {Target}. Action Performed: {Action}.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sAccessViolationEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 2

Variables

The AccessViolation message contains the following variables:

Table 1. AccessViolation Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Username

The name of the user who failed to log in.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv2Username
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.2.1

4. Target

Section of the product which requires additional authorization.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv2Target
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.2.2

5. Action

Action the user attempted to perform.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv2Action
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.2.3
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AuthFailure
An attempt to authenticate with the appliance failed.

Level : Severe

Log Message : Authentication failure for user {Username}, from host {Host}.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sAuthFailureEv1
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 1

Variables

The AuthFailure message contains the following variables:

Table 1. AuthFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. Username

The name of the user who failed to log in.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv1Username
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.1.1

4. Host

The name of the host the user attempted to log in from.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv1Host
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.1.2
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AuthLogOut
Event showing logging out of the user.

Level : Info

Log Message : User {UserName} with session id {SessionId} logged out successfully.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sAuthLogOutEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 12

Variables

The AuthLogOut message contains the following variables:

Table 1. AuthLogOut Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. UserName

Name of the user.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv12UserName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.12.1

4. SessionId

Session ID of the user logging out.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv12SessionId
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.12.2

Parent topic: Platform Security Notifications
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AuthSuccess
Attempt to authenticate with the appliance was successful.

Level : Info

Log Message : Authentication success for user {UserName}, from host {Host} with session id {SessionId}.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sAuthSuccessEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 3

Variables

The AuthSuccess message contains the following variables:

Table 1. AuthSuccess Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. UserName

Name of the user who logged on successfully.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv3UserName
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.3.1

4. Host

The name of the host the user attempted to log in from.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv3Host
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.3.2

5. SessionId

The Session ID of the user who logged on.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv3SessionId
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.3.3
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GrantRole
grant new role created.

Level : Info

Log Message : User {UserName} has been granted role of {GroupName}.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sGrantRoleEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 9

Variables

The GrantRole message contains the following variables:

Table 1. GrantRole Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

1998   



Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. UserName

Name of the user whose role is granted.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv9UserName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.9.1

4. GroupName

Group name granted to the user.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv9GroupName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.9.2
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GroupCreated
New group created.

Level : Info

Log Message : New Group {GroupName} has been created with id {Id}.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sGroupCreatedEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7
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SNMP Trap Number : 6

Variables

The GroupCreated message contains the following variables:

Table 1. GroupCreated Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. GroupName

Name of group newly created.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv6GroupName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.6.1

4. Id

The ID of the group created newly.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv6Id
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.6.2
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GroupDeleted
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Group deleted.

Level : Info

Log Message : Group {UserName} has been deleted.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sGroupDeletedEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 7

Variables

The GroupDeleted message contains the following variables:

Table 1. GroupDeleted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. UserName

Name of the group deleted.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv7UserName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.7.1

Parent topic: Platform Security Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/platform/platfo
rm_security_groupdeleted_message.html

 2001



RevokeRole
User role revoked.

Level : Info

Log Message : User {UserName} has been revoked of the role {GroupName}.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sRevokeRoleEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 8

Variables

The RevokeRole message contains the following variables:

Table 1. RevokeRole Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. UserName

Name of the user whose role is revoked.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv8UserName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.8.1

4. GroupName

Group name revoked for the user.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv8GroupName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.8.2
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UpdateStatus
Update user status as active or inactive.

Level : Info

Log Message : User {UserName} status has been changed from {OldValue} to {NewValue}.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sUpdateStatusEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 11

Variables

The UpdateStatus message contains the following variables:

Table 1. UpdateStatus Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. UserName

Name and Status of the user.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv11UserName
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.11.1

4. OldValue

Old value of status.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv11OldValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.11.2

5. NewValue

New value of status

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv11NewValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.11.3
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UpdateUser
Update display name of a user.

Level : Info

Log Message : User {UserName} displayName has been changed from {OldValue} to {NewValue}.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sUpdateUserEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 10

Variables

The UpdateUser message contains the following variables:

Table 1. UpdateUser Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

2004   



Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. UserName

Name of the user whose status is changed.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv10UserName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.10.1

4. OldValue

Old value of display name.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv10OldValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.10.2

5. NewValue

New value of display name.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv10NewValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.10.3
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UserCreated
New user created.

Level : Info
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Log Message : New User {UserName} has been created with id {Id}.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sUserCreatedEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 4

Variables

The UserCreated message contains the following variables:

Table 1. UserCreated Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. UserName

Name of the user newly created.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv4UserName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.4.1

4. Id

The ID of the user that was newly created.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv4Id
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.4.2

Parent topic: Platform Security Notifications
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UserDeleted
User deleted.

Level : Info

Log Message : User {UserName} has been deleted.

System : Security

SNMP Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sUserDeletedEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.23.1.7

SNMP Trap Number : 5

Variables

The UserDeleted message contains the following variables:

Table 1. UserDeleted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. UserName

Name of the user deleted.

Type : String
SNMP Object Name : CASTIRON-COMP-PLATFORM-MIB::ciC23sEv5UserName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.23.1.7.1.5.1

Parent topic: Platform Security Notifications

Feedback | Notices
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SAP Module
The SAP Module provides activities to access SAP servers. This section contains details for the messages
delivered from the SAP Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the SAP Module.

MIB Name : CASTIRON-COMP-SAP-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.19

The following table provides an alphabetical list of all notifications that can be issued by the SAP Module.

Table 1. Notifications issued by the SAP Module
Notification Level System Description

AddingServerInfo Info Orchestration Adding server gateway.

BAPIActivationError Severe Orchestration Error occurred while activating the BAPI activity.

BAPIParseError Severe Orchestration Error occurred while parsing schema for the specified
BAPI.

BAPIReturnError Severe Orchestration Error returned by specified BAPI in the type field.

CompleteFunctionExec Info Orchestration This is the name of the function which is executed by
the BAPI or RFC activity

ConnectError Severe Orchestration The SAP operation failed because a connection to the
server could not be established.

ConnectRetry Warning Orchestration The SAP operation failed while trying to connect to
the server. This will cause a retry.

ConnectionPoolError Severe Orchestration Connection Pool returned null connection.

CreateTID Info Orchestration Creating a specified TID in the TID manager.

CreateTrcDirFailed Warning Orchestration Exception while setting the log directory for SAP trace
files. The trace files generated by sap will be created
on default location.

FuncRetStructNotFound Info Orchestration This is to report that activity is not able to find the
return structure for the function

FunctionLookup Info Orchestration This is marking the start of finding the meta data of
the BAPI or RFC activity in the SAP Repository

FunctionLookupComp Info Orchestration This is marking the completion of finding the meta
data of the BAPI or RFC activity in the SAP Repository

GatewayCommWarning Warning Orchestration Error occurred, while communicating to SAP Gateway.
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Notification Level System Description

GatewayRegisterError Info Orchestration Server gateway specified already exists.

GatewayRemoveInfo Info Orchestration Removing server gateway.

IDOCExtensionError Severe Orchestration IDOC contains more than one type of IDOC extension
type.

IDOCSentInfo Info Orchestration IDOC with specified TID was sent to SAP.

IDOCTypeError Severe Orchestration Received IDOC contains more than one type of IDOC
type.

InitializationError Severe Orchestration Error occurred while initializing the send IDOC
activity.

InvalidRFCName Severe Orchestration Unable to find specified RFC name.

InvalidTIDerror Severe Orchestration TID was not set in the task context.

ListenerInstanceInfo Info Orchestration SAP listener instance was started for SAP gateway.

ListenerStartInfo Info Orchestration SAP listener started again for specified host.

ListenerStopWarning Warning Orchestration Error occurred while stopping the listener for
specified host.

NoHandlerError Warning Orchestration Received an IDOC for specified IDOC type and no
activity was registered to process it. Ignoring the
IDOC.

NoSegmentWarning Warning Orchestration The specified IDOC number contains no data
segment.

NonReturnStruct Severe Orchestration No return structure returned by the specified BAPI.

ParseError Severe Orchestration Error occurred while parsing schema for the RFC.

PoolAddInfo Info Orchestration Adding Connection pool with the specified name.

PoolExistInfo Info Orchestration Connection pool with specified name already exists.

ProcessDocError Severe Orchestration Error occurred while processing the IDOC.

RFCActivationError Severe Orchestration Error occurred while activating the RFC activity.

ReceiveTIDNotFound Severe Orchestration Specified TID was not found in TID manager.

RemoveInfo Info Orchestration Removing connection pool with specified name.

RollbackWarning Warning Orchestration Error occurred while rolling back the transaction.
Ignoring and continuing the activity.

SAPActivityError Severe Orchestration Error occurred while processing SAP activity.

SAPValidationError Severe Orchestration Input data was not valid for specified RFC. The items
specified were invalid.

SapLibNotFound Severe Orchestration Sap activity is not able to activate because the sap
provided libraries are not installed.

SendIDOCActivation Severe Orchestration Error occurred while activating the Send IDOC
activity.
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Notification Level System Description

SendIDOCCreateInfo Info Orchestration Created the specified TID for starting a transaction in
send IDOC activity.

SendIDOCValidation Severe Orchestration Input data was not valid for IDOC. The specified
item(s) were invalid.

SerializingError Severe Orchestration Error occurred while creating IDOC from input
parameter.

StartFunctionExec Info Orchestration This is the name of the function which is going to be
executed by the BAPI or RFC activity

StartWarning Info Orchestration Error occurred while starting the server.

TIDCheck Info Orchestration SAP TIP check for specified ID is requested by SAP.

TIDCommit Info Orchestration SAP TID has been committed by SAP.

TIDCommitUnknown Severe Orchestration SAP attempting to confirm an unknown or
uncommitted TID.

TIDCommitedInfo Info Orchestration Specified TID was committed to SAP.

TIDCommittingInfo Info Orchestration Committing TID to SAP.

TIDConfirmed Info Orchestration SAP TID has been confirmed and deleted from the
TID manager.

TIDRollback Info Orchestration SAP TID has been rolled back.

TIDSentInfo Info Orchestration Sending the IDOC with specified TID to SAP.

TIDUnknown Severe Orchestration SAP has requested rollback for unknown TID.

TransactionalError Severe Orchestration Unable to find the BAPI transaction RFCs.

UnicodeGateway Info Orchestration The unicode instance property is set through
JCONSOLE.

ValidationError Severe Orchestration Error occurred while validating the input data.

ValidationInfo Info Orchestration Validation is on/off for the specified field value.

SAP Connection Notifications
Provides a comprehensive list of connection notifications sent from the SAP Module.
SAP Operation Notifications
Provides a comprehensive list of operation notifications sent from the SAP Module.
SAP Internal Notifications
Provides a comprehensive list of internal notifications sent from the SAP Module.

Feedback | Notices
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SAP Connection Notifications
Provides a comprehensive list of connection notifications sent from the SAP Module.

ConnectError
The SAP operation failed because a connection to the server could not be established.
ConnectRetry
The SAP operation failed while trying to connect to the server. This will cause a retry.
PoolAddInfo
Adding Connection pool with the specified name.
PoolExistInfo
Connection pool with specified name already exists.
RemoveInfo
Removing connection pool with specified name.

Parent topic: SAP Module
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ConnectError
The SAP operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Unable to connect to the SAP server after {NumberOfRetryAttempts} attempts. Error is: Error Group
{ErrorGroup}, Error Key {ErrorKey}, Error Message {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19cConnectErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.1

SNMP Trap Number : 1

Variables

The ConnectError message contains the following variables:

Table 1. ConnectError Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv1NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.1.1

6. ErrorGroup

The group mentioned in the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv1ErrorGroup
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.1.2

7. ErrorKey

The key mentioned in the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv1ErrorKey
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.1.3
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8. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: SAP Connection Notifications
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ConnectRetry
The SAP operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to connect to the SAP server. Error is: Error Group: {ErrorGroup} Error Key {ErrorKey} Error
Message {Message}. Attempt {RetryAttemptNumber} of {TotalRetryAttempts}. Will try again in
{RetryAttemptNumber} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19cConnectRetryEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.1

SNMP Trap Number : 2

Variables

The ConnectRetry message contains the following variables:

Table 1. ConnectRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorGroup

The group mentioned in the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv2ErrorGroup
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.2.1

6. ErrorKey

The key mentioned in the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv2ErrorKey
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.2.2

7. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

8. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv2RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.2.4

9. TotalRetryAttempts
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The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv2TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.2.5

10. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv2IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.2.6

Parent topic: SAP Connection Notifications
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PoolAddInfo
Adding Connection pool with the specified name.

Level : Info

Log Message : Adding Connection Pool with name {PoolName}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19cPoolAddInfoEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.1

SNMP Trap Number : 4

Variables

The PoolAddInfo message contains the following variables:

Table 1. PoolAddInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. PoolName

Adding the connection pool .

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv4PoolName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.4.1

Parent topic: SAP Connection Notifications
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PoolExistInfo
Connection pool with specified name already exists.

Level : Info

Log Message : Connection Pool {PoolName} already exists, Using existing definition.
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System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19cPoolExistInfoEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.1

SNMP Trap Number : 3

Variables

The PoolExistInfo message contains the following variables:

Table 1. PoolExistInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. PoolName

Connection pool name which already exists.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv3PoolName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.3.1
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RemoveInfo
Removing connection pool with specified name.

Level : Info

Log Message : Removing Connection Pool with name {PoolName}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19cRemoveInfoEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.1

SNMP Trap Number : 5

Variables

The RemoveInfo message contains the following variables:

Table 1. RemoveInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. PoolName

Removing the connection pool .

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19cEv5PoolName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.1.1.5.1

Parent topic: SAP Connection Notifications
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SAP Operation Notifications
Provides a comprehensive list of operation notifications sent from the SAP Module.

AddingServerInfo
Adding server gateway.
BAPIActivationError
Error occurred while activating the BAPI activity.
BAPIParseError
Error occurred while parsing schema for the specified BAPI.
BAPIReturnError
Error returned by specified BAPI in the type field.
CompleteFunctionExec
This is the name of the function which is executed by the BAPI or RFC activity
CreateTID
Creating a specified TID in the TID manager.
CreateTrcDirFailed
Exception while setting the log directory for SAP trace files. The trace files generated by sap will be
created on default location.
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FuncRetStructNotFound
This is to report that activity is not able to find the return structure for the function
FunctionLookup
This is marking the start of finding the meta data of the BAPI or RFC activity in the SAP Repository
FunctionLookupComp
This is marking the completion of finding the meta data of the BAPI or RFC activity in the SAP Repository
GatewayCommWarning
Error occurred, while communicating to SAP Gateway.
GatewayRegisterError
Server gateway specified already exists.
GatewayRemoveInfo
Removing server gateway.
IDOCExtensionError
IDOC contains more than one type of IDOC extension type.
IDOCSentInfo
IDOC with specified TID was sent to SAP.
IDOCTypeError
Received IDOC contains more than one type of IDOC type.
InvalidRFCName
Unable to find specified RFC name.
ListenerInstanceInfo
SAP listener instance was started for SAP gateway.
ListenerStartInfo
SAP listener started again for specified host.
ListenerStopWarning
Error occurred while stopping the listener for specified host.
NoHandlerError
Received an IDOC for specified IDOC type and no activity was registered to process it. Ignoring the
IDOC.
NoSegmentWarning
The specified IDOC number contains no data segment.
NonReturnStruct
No return structure returned by the specified BAPI.
ParseError
Error occurred while parsing schema for the RFC.
ProcessDocError
Error occurred while processing the IDOC.
RFCActivationError
Error occurred while activating the RFC activity.
ReceiveTIDNotFound
Specified TID was not found in TID manager.
RollbackWarning
Error occurred while rolling back the transaction. Ignoring and continuing the activity.
SAPActivityError
Error occurred while processing SAP activity.
SAPValidationError
Input data was not valid for specified RFC. The items specified were invalid.
SapLibNotFound
Sap activity is not able to activate because the sap provided libraries are not installed.
SendIDOCActivation
Error occurred while activating the Send IDOC activity.
SendIDOCCreateInfo
Created the specified TID for starting a transaction in send IDOC activity.
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SendIDOCValidation
Input data was not valid for IDOC. The specified item(s) were invalid.
StartFunctionExec
This is the name of the function which is going to be executed by the BAPI or RFC activity
StartWarning
Error occurred while starting the server.
TIDCheck
SAP TIP check for specified ID is requested by SAP.
TIDCommit
SAP TID has been committed by SAP.
TIDCommitUnknown
SAP attempting to confirm an unknown or uncommitted TID.
TIDCommitedInfo
Specified TID was committed to SAP.
TIDCommittingInfo
Committing TID to SAP.
TIDConfirmed
SAP TID has been confirmed and deleted from the TID manager.
TIDRollback
SAP TID has been rolled back.
TIDSentInfo
Sending the IDOC with specified TID to SAP.
TIDUnknown
SAP has requested rollback for unknown TID.
TransactionalError
Unable to find the BAPI transaction RFCs.
UnicodeGateway
The unicode instance property is set through JCONSOLE.
ValidationError
Error occurred while validating the input data.
ValidationInfo
Validation is on/off for the specified field value.

Parent topic: SAP Module
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AddingServerInfo
Adding server gateway.

Level : Info

Log Message : Adding Server Gateway {GatewayName}.
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System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oAddingServerInfoEv30

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 30

Variables

The AddingServerInfo message contains the following variables:

Table 1. AddingServerInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. GatewayName

The gateway name which is being added.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv30GatewayName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.30.1
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BAPIActivationError
Error occurred while activating the BAPI activity.

Level : Severe

Log Message : Exception while activating the BAPI Activity. The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oBAPIActivationErrorEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 15

Variables

The BAPIActivationError message contains the following variables:

Table 1. BAPIActivationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

 2023



Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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BAPIParseError
Error occurred while parsing schema for the specified BAPI.

Level : Severe

Log Message : Exception while parsing schema for the BAPI {BAPIName}. The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oBAPIParseErrorEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 16

Variables

The BAPIParseError message contains the following variables:

Table 1. BAPIParseError Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. BAPIName

BAPI name for which parsing error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv16BAPIName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.16.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: SAP Operation Notifications
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BAPIReturnError
Error returned by specified BAPI in the type field.

Level : Severe

Log Message : Error returned by BAPI {BAPIName} in the type field. The values returned are TYPE: {Type} ,
MESSAGE: {Message}, LOGNO: {LogNumber}, LOGMSGNO {LogMessage}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oBAPIReturnErrorEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 18

Variables

The BAPIReturnError message contains the following variables:

Table 1. BAPIReturnError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. BAPIName

The name of the BAPI for which the error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv18BAPIName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.18.1

6. Type

The type value returned.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv18Type
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.18.2

7. Message

The message value returned.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv18Message
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.18.3

8. LogNumber

The log number value returned.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv18LogNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.18.4

9. LogMessage

The log message number value returned.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv18LogMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.18.5

Parent topic: SAP Operation Notifications
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CompleteFunctionExec
This is the name of the function which is executed by the BAPI or RFC activity

Level : Info

Log Message : Call to function {FunctionName} is complete

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oCompleteFunctionExecEv44

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 44

Variables

The CompleteFunctionExec message contains the following variables:

Table 1. CompleteFunctionExec Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FunctionName

Name of the BAPI or RFC

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv44FunctionName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.44.1

Parent topic: SAP Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/sap/sap_operat
ion_completefunctionexec_message.html

CreateTID
Creating a specified TID in the TID manager.

Level : Info

Log Message : Creating a new TID {TID} in the TID Manager.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oCreateTIDEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 5

Variables

The CreateTID message contains the following variables:

Table 1. CreateTID Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

Created this TID in specified TID manager.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv5TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.5.1
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CreateTrcDirFailed
Exception while setting the log directory for SAP trace files. The trace files generated by sap will be created on
default location.
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Level : Warning

Log Message : Exception while setting the log directory for SAP trace files.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oCreateTrcDirFailedEv49

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 49

Variables

The CreateTrcDirFailed message contains the following variables:

Table 1. CreateTrcDirFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TraceLogDir

Path for the trace directory

Type : String
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SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv49TraceLogDir
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.49.1
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FuncRetStructNotFound
This is to report that activity is not able to find the return structure for the function

Level : Info

Log Message : Not able to find field Return as structure. {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oFuncRetStructNotFoundEv47

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 47

Variables

The FuncRetStructNotFound message contains the following variables:

Table 1. FuncRetStructNotFound Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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FunctionLookup
This is marking the start of finding the meta data of the BAPI or RFC activity in the SAP Repository

Level : Info

Log Message : Looking up function {FunctionName} from SAP Repository

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oFunctionLookupEv45

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 45

Variables
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The FunctionLookup message contains the following variables:

Table 1. FunctionLookup Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FunctionName

Name of the BAPI or RFC

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv45FunctionName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.45.1
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FunctionLookupComp
This is marking the completion of finding the meta data of the BAPI or RFC activity in the SAP Repository

Level : Info

Log Message : Looking up function {FunctionName} from SAP Repository (complete)

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oFunctionLookupCompEv46

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 46

Variables

The FunctionLookupComp message contains the following variables:

Table 1. FunctionLookupComp Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FunctionName

Name of the BAPI or RFC

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv46FunctionName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.46.1
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GatewayCommWarning
Error occurred, while communicating to SAP Gateway.

Level : Warning

Log Message : Error occurred, while communicating to SAP Gateway (host {HostName}, ProgramId {ProgramID},
Service {Service}), trying again in {IntervalForRetries} seconds.\nOriginal SAP error was \n {Message} \nIf the SAP
message indicates a retry interval it may not be correct.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oGatewayCommWarningEv35

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 35

Variables

The GatewayCommWarning message contains the following variables:

Table 1. GatewayCommWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. HostName

The host name for which warning occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv35HostName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.35.1

6. ProgramID

The program ID for which warning occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv35ProgramID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.35.2

7. Service

The service name for which warning occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv35Service
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.35.3

8. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv35IntervalForRetries
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.35.4

9. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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GatewayRegisterError
Server gateway specified already exists.

Level : Info

Log Message : Server Gateway {GatewayName} already exists, Using the existing definition.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oGatewayRegisterErrorEv29

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 29

Variables

The GatewayRegisterError message contains the following variables:

Table 1. GatewayRegisterError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. GatewayName

The gateway name which already exists.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv29GatewayName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.29.1
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GatewayRemoveInfo
Removing server gateway.

Level : Info

Log Message : Removing Server Gateway {GatewayName}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oGatewayRemoveInfoEv31

 2039



SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 31

Variables

The GatewayRemoveInfo message contains the following variables:

Table 1. GatewayRemoveInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. GatewayName

The gateway name which is being removed.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv31GatewayName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.31.1

Parent topic: SAP Operation Notifications
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IDOCExtensionError
IDOC contains more than one type of IDOC extension type.

Level : Severe

Log Message : Idoc contains more than one type of IDOC extension type

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oIDOCExtensionErrorEv41

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 41

Variables

The IDOCExtensionError message contains the following variables:

Table 1. IDOCExtensionError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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IDOCSentInfo
IDOC with specified TID was sent to SAP.

Level : Info

Log Message : Idoc with the TID {TID} is sent successfully to sap.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oIDOCSentInfoEv26

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 26

Variables

The IDOCSentInfo message contains the following variables:

Table 1. IDOCSentInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

The TID which was sent.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv26TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.26.1
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IDOCTypeError
Received IDOC contains more than one type of IDOC type.

Level : Severe

Log Message : Received IDOC contains more than one type of IDOC type

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oIDOCTypeErrorEv40
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 40

Variables

The IDOCTypeError message contains the following variables:

Table 1. IDOCTypeError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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InvalidRFCName
Unable to find specified RFC name.

Level : Severe

Log Message : Unable to find RFC {RFCName}. Invalid RFC name.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oInvalidRFCNameEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 14

Variables

The InvalidRFCName message contains the following variables:

Table 1. InvalidRFCName Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. RFCName

RFC name which was not found.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv14RFCName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.14.1
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ListenerInstanceInfo
SAP listener instance was started for SAP gateway.

Level : Info

Log Message : SAP Listener instance {InstanceNumber} started for SAP Gateway(host {HostName}, ProgramId
{ProgramID}, Service {Service}).

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oListenerInstanceInfoEv34

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 34

Variables

The ListenerInstanceInfo message contains the following variables:

Table 1. ListenerInstanceInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. InstanceNumber

The instance number which was started.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv34InstanceNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.34.1

6. HostName

The host name for which instance was started.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv34HostName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.34.2

7. ProgramID

The program ID for which instance was started.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv34ProgramID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.34.3

8. Service

The service name for which instance was started.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv34Service
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.34.4

Parent topic: SAP Operation Notifications
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ListenerStartInfo
SAP listener started again for specified host.

Level : Info

Log Message : SAP listener started again for host{HostName}, programid {ProgramID} and service {Service}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oListenerStartInfoEv37

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 37

Variables

The ListenerStartInfo message contains the following variables:

Table 1. ListenerStartInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. HostName

The host name for which listener started.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv37HostName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.37.1

6. ProgramID

The program ID for which listener started.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv37ProgramID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.37.2

7. Service

The service name for which listener started.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv37Service
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.37.3
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ListenerStopWarning
Error occurred while stopping the listener for specified host.

Level : Warning
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Log Message : Exception while stopping the listener for host {HostName}, ProgramId {ProgramID} and Service
{Service}.The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oListenerStopWarningEv39

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 39

Variables

The ListenerStopWarning message contains the following variables:

Table 1. ListenerStopWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. HostName

The host name for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv39HostName

2050   



SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.39.1

6. ProgramID

The program ID for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv39ProgramID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.39.2

7. Service

The service name for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv39Service
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.39.3

8. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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NoHandlerError
Received an IDOC for specified IDOC type and no activity was registered to process it. Ignoring the IDOC.

Level : Warning

Log Message : Received an IDOC for idoctype {IDOCType} and no activity was registered to process it. Ignoring
the IDOC.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oNoHandlerErrorEv42

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 42
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Variables

The NoHandlerError message contains the following variables:

Table 1. NoHandlerError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. IDOCType

IDOC type received.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv42IDOCType
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.42.1
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NoSegmentWarning
The specified IDOC number contains no data segment.

Level : Warning

Log Message : The IDOC number {IDOCNumber} contains no data segment.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oNoSegmentWarningEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 22

Variables

The NoSegmentWarning message contains the following variables:

Table 1. NoSegmentWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. IDOCNumber

The IDOC number.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv22IDOCNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.22.1
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NonReturnStruct
No return structure returned by the specified BAPI.

Level : Severe

Log Message : No return structure returned by BAPI {BAPIName}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oNonReturnStructEv19

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 19

Variables

The NonReturnStruct message contains the following variables:

Table 1. NonReturnStruct Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

2054   



Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. BAPIName

The name of the BAPI for which the error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv19BAPIName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.19.1

Parent topic: SAP Operation Notifications

Feedback | Notices
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ParseError
Error occurred while parsing schema for the RFC.

Level : Severe

Log Message : Exception while parsing schema for the RFC {RFCName}. The Exception is {Message}

System : Orchestration
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SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oParseErrorEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 13

Variables

The ParseError message contains the following variables:

Table 1. ParseError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. RFCName

RFC name for which error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv13RFCName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.13.1

6. Message

2056   



Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ProcessDocError
Error occurred while processing the IDOC.

Level : Severe

Log Message : Exception while processing the IDOC. The exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oProcessDocErrorEv33

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 33

Variables

The ProcessDocError message contains the following variables:

Table 1. ProcessDocError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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RFCActivationError
Error occurred while activating the RFC activity.

Level : Severe

Log Message : Exception while activating the RFC Activity. The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oRFCActivationErrorEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 12
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Variables

The RFCActivationError message contains the following variables:

Table 1. RFCActivationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: SAP Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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ReceiveTIDNotFound
Specified TID was not found in TID manager.

Level : Severe

Log Message : Tid {TIDNumber} not found in TID manager.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oReceiveTIDNotFoundEv32

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 32

Variables

The ReceiveTIDNotFound message contains the following variables:

Table 1. ReceiveTIDNotFound Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TIDNumber

TID which was not found.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv32TIDNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.32.1
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RollbackWarning
Error occurred while rolling back the transaction. Ignoring and continuing the activity.

Level : Warning

Log Message : Exception while rolling back the transaction.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oRollbackWarningEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 2

Variables

The RollbackWarning message contains the following variables:

Table 1. RollbackWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: SAP Operation Notifications
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SAPActivityError
Error occurred while processing SAP activity.

Level : Severe

Log Message : Exception while processing SAP activity. Error Group: {ErrorGroup}, Error Key: {ErrorKey}, Error
Message: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oSAPActivityErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 1

Variables
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The SAPActivityError message contains the following variables:

Table 1. SAPActivityError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorGroup

The group mentioned in the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv1ErrorGroup
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.1.1

6. ErrorKey

The key mentioned in the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv1ErrorKey
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.1.2

7. Message
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Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SAPValidationError
Input data was not valid for specified RFC. The items specified were invalid.

Level : Severe

Log Message : Input data was not valid for RFC {RFCName}. The following item(s) were invalid: {InvalidItems}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oSAPValidationErrorEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 11

Variables

The SAPValidationError message contains the following variables:

Table 1. SAPValidationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. RFCName

RFC name for which data was not valid.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv11RFCName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.11.1

6. InvalidItems

The items which were not valid.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv11InvalidItems
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.11.2
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SapLibNotFound
Sap activity is not able to activate because the sap provided libraries are not installed.

Level : Severe
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Log Message : Exception while activating the sap. The exception is because the sap libraries are not installed.
Exception is

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oSapLibNotFoundEv48

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 48

Variables

The SapLibNotFound message contains the following variables:

Table 1. SapLibNotFound Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
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SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SendIDOCActivation
Error occurred while activating the Send IDOC activity.

Level : Severe

Log Message : Exception while activating the Send IDOC Activity. The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oSendIDOCActivationEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 23

Variables

The SendIDOCActivation message contains the following variables:

Table 1. SendIDOCActivation Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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SendIDOCCreateInfo
Created the specified TID for starting a transaction in send IDOC activity.

Level : Info

Log Message : Created a new TID {TID} for starting a transaction in send IDOC activity.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oSendIDOCCreateInfoEv24

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 24

Variables
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The SendIDOCCreateInfo message contains the following variables:

Table 1. SendIDOCCreateInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

The new TID which is created.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv24TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.24.1

Parent topic: SAP Operation Notifications
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SendIDOCValidation
Input data was not valid for IDOC. The specified item(s) were invalid.

Level : Severe

Log Message : Input data was not valid for IDOC. The following item(s) were invalid: {InvalidItems}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oSendIDOCValidationEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 20

Variables

The SendIDOCValidation message contains the following variables:

Table 1. SendIDOCValidation Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. InvalidItems

The invalid items in the input data.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv20InvalidItems
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.20.1
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StartFunctionExec
This is the name of the function which is going to be executed by the BAPI or RFC activity

Level : Info

Log Message : About to execute function {FunctionName}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oStartFunctionExecEv43

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 43

Variables

The StartFunctionExec message contains the following variables:

Table 1. StartFunctionExec Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. FunctionName

Name of the BAPI or RFC

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv43FunctionName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.43.1
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StartWarning
Error occurred while starting the server.

Level : Info

Log Message : Exception while starting the server. Exception is {Message}

System : Orchestration
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SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oStartWarningEv38

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 38

Variables

The StartWarning message contains the following variables:

Table 1. StartWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: SAP Operation Notifications
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TIDCheck
SAP TIP check for specified ID is requested by SAP.

Level : Info

Log Message : SAP TID {TID} check requested by SAP.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTIDCheckEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 4

Variables

The TIDCheck message contains the following variables:

Table 1. TIDCheck Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

TID for which check is requested.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv4TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.4.1
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TIDCommit
SAP TID has been committed by SAP.

Level : Info

Log Message : SAP TID {TID} has been committed by SAP.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTIDCommitEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 9

Variables

The TIDCommit message contains the following variables:

Table 1. TIDCommit Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

TID which has been committed.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv9TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.9.1
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TIDCommitUnknown
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SAP attempting to confirm an unknown or uncommitted TID.

Level : Severe

Log Message : SAP attempting to confirm an unknown or uncommitted TID

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTIDCommitUnknownEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 10

Variables

The TIDCommitUnknown message contains the following variables:

Table 1. TIDCommitUnknown Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: SAP Operation Notifications
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TIDCommitedInfo
Specified TID was committed to SAP.

Level : Info

Log Message : TID {TID} committed succesfully.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTIDCommitedInfoEv28

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 28

Variables

The TIDCommitedInfo message contains the following variables:

Table 1. TIDCommitedInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

The TID which is committed.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv28TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.28.1
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TIDCommittingInfo
Committing TID to SAP.

Level : Info

Log Message : Committing TID {TID}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTIDCommittingInfoEv27

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 27

Variables

The TIDCommittingInfo message contains the following variables:

Table 1. TIDCommittingInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

The TID which is being committed.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv27TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.27.1
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TIDConfirmed
SAP TID has been confirmed and deleted from the TID manager.
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Level : Info

Log Message : SAP TID {TID} has been confirmed and deleted from the TID Manager.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTIDConfirmedEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 6

Variables

The TIDConfirmed message contains the following variables:

Table 1. TIDConfirmed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

TID which was confirmed and deleted.

Type : String
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SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv6TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.6.1
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TIDRollback
SAP TID has been rolled back.

Level : Info

Log Message : SAP TID {TID} has been rolled-back by SAP.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTIDRollbackEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 7

Variables

The TIDRollback message contains the following variables:

Table 1. TIDRollback Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

TID which was rolled back.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv7TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.7.1
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TIDSentInfo
Sending the IDOC with specified TID to SAP.

Level : Info

Log Message : Sending IDOC with the TID {TID} to sap.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTIDSentInfoEv25

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 25

Variables
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The TIDSentInfo message contains the following variables:

Table 1. TIDSentInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

The TID which was sent.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv25TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.25.1
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TIDUnknown
SAP has requested rollback for unknown TID.

Level : Severe

Log Message : SAP has requested rollback for unknown TID {TID}. Cannot rollback.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTIDUnknownEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 8

Variables

The TIDUnknown message contains the following variables:

Table 1. TIDUnknown Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. TID

TID which could not be rolled back.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv8TID
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.8.1

Parent topic: SAP Operation Notifications

Feedback | Notices
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TransactionalError
Unable to find the BAPI transaction RFCs.

Level : Severe

Log Message : Unable to find the BAPI transaction RFC's.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oTransactionalErrorEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 17

Variables

The TransactionalError message contains the following variables:

Table 1. TransactionalError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: SAP Operation Notifications
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UnicodeGateway
The unicode instance property is set through JCONSOLE.

Level : Info

Log Message : The unicode instance property is set through JCONSOLE

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oUnicodeGatewayEv36

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 36

Variables
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The UnicodeGateway message contains the following variables:

Table 1. UnicodeGateway Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: SAP Operation Notifications
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ValidationError
Error occurred while validating the input data.

2088   



Level : Severe

Log Message : Exception while validating the input data. The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oValidationErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 3

Variables

The ValidationError message contains the following variables:

Table 1. ValidationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ValidationInfo
Validation is on/off for the specified field value.

Level : Info

Log Message : Validation is {ValidationStatus} for {Value}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19oValidationInfoEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.2

SNMP Trap Number : 21

Variables

The ValidationInfo message contains the following variables:

Table 1. ValidationInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ValidationStatus

The validation status either on or off.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv21ValidationStatus
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.21.1

6. Value

The value which is validated.

Type : String
SNMP Object Name : CASTIRON-COMP-SAP-MIB::ciC19oEv21Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.19.1.2.1.21.2

Parent topic: SAP Operation Notifications
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SAP Internal Notifications
Provides a comprehensive list of internal notifications sent from the SAP Module.

ConnectionPoolError
Connection Pool returned null connection.
InitializationError
Error occurred while initializing the send IDOC activity.

 2091



InvalidTIDerror
TID was not set in the task context.
SerializingError
Error occurred while creating IDOC from input parameter.
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ConnectionPoolError
Connection Pool returned null connection.

Level : Severe

Log Message : Null connection return by the connection pool.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19iConnectionPoolErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.3

SNMP Trap Number : 1

Variables

The ConnectionPoolError message contains the following variables:

Table 1. ConnectionPoolError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: SAP Internal Notifications
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InitializationError
Error occurred while initializing the send IDOC activity.

Level : Severe

Log Message : Exception while intializing the send IDOC activity. The error message is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19iInitializationErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.3

SNMP Trap Number : 4

Variables

The InitializationError message contains the following variables:

Table 1. InitializationError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: SAP Internal Notifications
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InvalidTIDerror
TID was not set in the task context.
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Level : Severe

Log Message : TID not set in the task state.

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19iInvalidTIDerrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.3

SNMP Trap Number : 2

Variables

The InvalidTIDerror message contains the following variables:

Table 1. InvalidTIDerror Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: SAP Internal Notifications

 2095



Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/sap/sap_intern
al_invalidtiderror_message.html

SerializingError
Error occurred while creating IDOC from input parameter.

Level : Severe

Log Message : Exception while creating IDOC form input parameter. The Exception is {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SAP-MIB::ciC19iSerializingErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.19.1.3

SNMP Trap Number : 3

Variables

The SerializingError message contains the following variables:

Table 1. SerializingError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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STS Module
The SAML STS Module This section contains details for the messages delivered from the STS Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the STS Module.

MIB Name : CASTIRON-COMP-STS-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.27

The following table provides an alphabetical list of all notifications that can be issued by the STS Module.

Table 1. Notifications issued by the STS Module
Notification Level System Description

ActivationFailed Severe Orchestration Activation of Get SAML 2.0 token failed

AssertionEmpty Severe Orchestration Received empty response from Security Token
Service. Cannot get the SAML Assertion.

InputBodyConsidered Info Orchestration RequestSecuirtyToken from Map Inputs is sent as
request body because data sent in Map Inputs holds
higher priority than in Configure Panel
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Notification Level System Description

RequestLocation Info Orchestration Location of request being sent to Security Token
Service

UriDeprecated Warning Orchestration Security Token Service Module has deprecated the
input parameter httpheaders/uri. The specified value
will be ignored.

STS Operation Notifications
Provides a comprehensive list of operation notifications sent from the STS Module.
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STS Operation Notifications
Provides a comprehensive list of operation notifications sent from the STS Module.

ActivationFailed
Activation of Get SAML 2.0 token failed
AssertionEmpty
Received empty response from Security Token Service. Cannot get the SAML Assertion.
InputBodyConsidered
RequestSecuirtyToken from Map Inputs is sent as request body because data sent in Map Inputs holds
higher priority than in Configure Panel
RequestLocation
Location of request being sent to Security Token Service
UriDeprecated
Security Token Service Module has deprecated the input parameter httpheaders/uri. The specified value
will be ignored.
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ActivationFailed
Activation of Get SAML 2.0 token failed

Level : Severe

Log Message : Activation of Get SAML 2.0 token failed

System : Orchestration

SNMP Name : CASTIRON-COMP-STS-MIB::ciC27oActivationFailedEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.27.1.2

SNMP Trap Number : 1

Variables

The ActivationFailed message contains the following variables:

Table 1. ActivationFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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AssertionEmpty
Received empty response from Security Token Service. Cannot get the SAML Assertion.

Level : Severe

Log Message : Response from Security Token Service is empty

System : Orchestration

SNMP Name : CASTIRON-COMP-STS-MIB::ciC27oAssertionEmptyEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.27.1.2

SNMP Trap Number : 3

Variables

The AssertionEmpty message contains the following variables:

Table 1. AssertionEmpty Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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InputBodyConsidered
RequestSecuirtyToken from Map Inputs is sent as request body because data sent in Map Inputs holds higher
priority than in Configure Panel

Level : Info

Log Message : RequestSecuirtyToken from Map Inputs is sent as request

System : Orchestration

SNMP Name : CASTIRON-COMP-STS-MIB::ciC27oInputBodyConsideredEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.27.1.2

SNMP Trap Number : 4

Variables

The InputBodyConsidered message contains the following variables:

Table 1. InputBodyConsidered Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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RequestLocation
Location of request being sent to Security Token Service

Level : Info

Log Message : Sending request to Security Token Service at location : {Location}

System : Orchestration

SNMP Name : CASTIRON-COMP-STS-MIB::ciC27oRequestLocationEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.27.1.2

SNMP Trap Number : 5
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Variables

The RequestLocation message contains the following variables:

Table 1. RequestLocation Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Location

Request Location

Type : String
SNMP Object Name : CASTIRON-COMP-STS-MIB::ciC27oEv5Location
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.27.1.2.1.5.1

Parent topic: STS Operation Notifications
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UriDeprecated
Security Token Service Module has deprecated the input parameter httpheaders/uri. The specified value will be
ignored.

Level : Warning

Log Message : Security Token Service Module has deprecated the input parameter "httpheaders/uri". The value:
{Value} will be ignored. Please set the URL at the input parameter "location".

System : Orchestration

SNMP Name : CASTIRON-COMP-STS-MIB::ciC27oUriDeprecatedEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.27.1.2

SNMP Trap Number : 2

Variables

The UriDeprecated message contains the following variables:

Table 1. UriDeprecated Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

The value which will be ignored due to deprecated input parameter.

Type : String
SNMP Object Name : CASTIRON-COMP-STS-MIB::ciC27oEv2Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.27.1.2.1.2.1
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Salesforce.com Module
The Salesforce.com Module provides access to the Salesforce.com online service. This section contains details
for the messages delivered from the Salesforce.com Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Salesforce.com Module.

MIB Name : CASTIRON-COMP-SFDC-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.3

The following table provides an alphabetical list of all notifications that can be issued by the Salesforce.com
Module.

Table 1. Notifications issued by the Salesforce.com Module
Notification Level System Description

ActivateError Severe Orchestration There was a problem in activating the activity.

ActivityOutput Info Orchestration The activity has completed its operation and
outputted param objects in output parameter.

BatchPollStart Info Orchestration Starting a batch poll for index range specified.
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Notification Level System Description

ConnectFailed Severe Orchestration The Salesforce.com operation failed because a
connection to the server could not be established.
This happened cause of reasons other than
connectivity issues.

ConnectionFailed Severe Orchestration The Salesforce.com operation failed because a
connection to the server could not be established.

ConnectionRetry Warning Orchestration The Salesforce.com operation failed while trying to
connect to the server. This will cause a retry.

ConnectionTryAgain Info Orchestration Not able to connect to Salesforce endpoint. Trying to
establish a new session.

EndpointNull Severe Orchestration The endpoint object provided to Salesforce.com
activity is null.

ExecuteError Severe Orchestration An error occurred while executing the activity.

ExecuteProblem Severe Orchestration An error occurred while executing the query.

InitializeProblem Warning Orchestration Error from Salesforce.com while initializing activity.
Trying to ignore error and proceed.

InputParamMapped Info Orchestration The optional input parameter in the activity is
mapped.

InputParamNotMapped Info Orchestration The optional input parameter in the activity is not
mapped.

InvalidQuery Severe Orchestration The query provided to Salesforce.com was invalid.

InvalidSFDCField Severe Orchestration The field is invalid in Salesforce.com.

InvalidSFDCObject Severe Orchestration The object is invalid in Salesforce.com

LargeData Severe Orchestration The activity was not able to get data as id limit has
exceeded.

LargeDataError Severe Orchestration An error occurred due to large data which activity
cannot handle.

LoginFailure Severe Orchestration Failure while performing a login into Salesforce.com.

MarshalError Severe Orchestration An error occurred while writing output parameters in
the activity.

MetadataError Severe Orchestration Unable to obtain meta data from Salesforce.com.

MetadataObjectError Severe Orchestration Unable to obtain meta data for the object from
Salesforce.com.

NoDatafound Info Orchestration No data was found by the activity in the interval
specified.

OptionalInputError Severe Orchestration Salesforce session timed out. The session was not
created as optional connection input parameter was
not mapped.

ParameterOutput Info Orchestration The activity has completed its operation and
outputted objects in output parameter.
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Notification Level System Description

ParameterResults Info Orchestration The activity has completed its operation and
outputted result objects in output parameter.

PollActivateError Severe Orchestration The poll activity failed to activate.

PollOutput Info Orchestration The number of objects outputted for a batch poll.

PollReturnedNothing Info Orchestration The poll activity did not return any ids for specified
interval.

PollReturnedResults Info Orchestration Poll activity returned these number of ids for interval
specified.

SessionInvalid Info Orchestration Salesforce session timed out and activity is
establishing a new session.

SfdcErrorInternal Severe Orchestration An internal error occurred in Salesforce.com
connector.

ShortPoll Info Orchestration The current time is less than 1 minute past last
polling time, so activity is skipping the poll at this
interval.

StillRun Info Orchestration There is a problem in connectivity and messages will
be picked up from this time when connectivity is
established.

TimeTooClose Info Orchestration The end time specified is less than 1 minute past
start time. Setting the interval to 1 minute and getting
the data.

UnexpectedSFDCFault Severe Orchestration Salesforce.com returned an unexpected fault that is
not declared in the method signature.

UnmarshalError Severe Orchestration An error occurred while reading input parameters in
the activity.

Salesforce.com Connection Notifications
Provides a comprehensive list of connection notifications sent from the Salesforce.com Module.
Salesforce.com Operation Notifications
Provides a comprehensive list of operation notifications sent from the Salesforce.com Module.
Salesforce.com Internal Notifications
Provides a comprehensive list of internal notifications sent from the Salesforce.com Module.
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Provides a comprehensive list of connection notifications sent from the Salesforce.com Module.

ConnectionFailed
The Salesforce.com operation failed because a connection to the server could not be established.
ConnectionRetry
The Salesforce.com operation failed while trying to connect to the server. This will cause a retry.
ConnectionTryAgain
Not able to connect to Salesforce endpoint. Trying to establish a new session.
LoginFailure
Failure while performing a login into Salesforce.com.
OptionalInputError
Salesforce session timed out. The session was not created as optional connection input parameter was
not mapped.
SessionInvalid
Salesforce session timed out and activity is establishing a new session.
StillRun
There is a problem in connectivity and messages will be picked up from this time when connectivity is
established.

Parent topic: Salesforce.com Module
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ConnectionFailed
The Salesforce.com operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Unable to connect to Salesforce.com after {NumberOfRetryAttempts} attempts. Error is: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3cConnectionFailedEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.1

SNMP Trap Number : 4

Variables

The ConnectionFailed message contains the following variables:

Table 1. ConnectionFailed Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3cEv4NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.1.1.4.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Salesforce.com Connection Notifications

Feedback | Notices

 2109



 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/sfdc/sfdc_conn
ection_connectionfailed_message.html

ConnectionRetry
The Salesforce.com operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to connect to Salesforce.com. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3cConnectionRetryEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.1

SNMP Trap Number : 3

Variables

The ConnectionRetry message contains the following variables:

Table 1. ConnectionRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3cEv3RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.1.1.3.2

7. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3cEv3TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.1.1.3.3

8. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3cEv3IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.1.1.3.4

Parent topic: Salesforce.com Connection Notifications
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Not able to connect to Salesforce endpoint. Trying to establish a new session.

Level : Info

Log Message : Not able to connect, error is: {Message}. Establishing a new session.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3cConnectionTryAgainEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.1

SNMP Trap Number : 7

Variables

The ConnectionTryAgain message contains the following variables:

Table 1. ConnectionTryAgain Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Salesforce.com Connection Notifications
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LoginFailure
Failure while performing a login into Salesforce.com.

Level : Severe

Log Message : Salesforce.com logon failure. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3cLoginFailureEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.1

SNMP Trap Number : 1

Variables

The LoginFailure message contains the following variables:

Table 1. LoginFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Salesforce.com Connection Notifications
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OptionalInputError
Salesforce session timed out. The session was not created as optional connection input parameter was not
mapped.

Level : Severe

Log Message : Salesforce session timed out. The session was not created as optional connection input parameter
was not mapped.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3cOptionalInputErrorEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.1

SNMP Trap Number : 5
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Variables

The OptionalInputError message contains the following variables:

Table 1. OptionalInputError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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Salesforce session timed out and activity is establishing a new session.

Level : Info

Log Message : Session timed out. Establishing a new session.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3cSessionInvalidEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.1

SNMP Trap Number : 6

Variables

The SessionInvalid message contains the following variables:

Table 1. SessionInvalid Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Salesforce.com Connection Notifications
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StillRun
There is a problem in connectivity and messages will be picked up from this time when connectivity is
established.

Level : Info

Log Message : Not able to establish connectivity. Polling will fail till connectivity is established. However when
connectivity is established, messages will be picked up from this time onwards.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3cStillRunEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.1

SNMP Trap Number : 2

Variables

The StillRun message contains the following variables:

Table 1. StillRun Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
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SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Salesforce.com Connection Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/sfdc/sfdc_conn
ection_stillrun_message.html

Salesforce.com Operation Notifications
Provides a comprehensive list of operation notifications sent from the Salesforce.com Module.

ActivateError
There was a problem in activating the activity.
ActivityOutput
The activity has completed its operation and outputted param objects in output parameter.
BatchPollStart
Starting a batch poll for index range specified.
ConnectFailed
The Salesforce.com operation failed because a connection to the server could not be established. This
happened cause of reasons other than connectivity issues.
ExecuteError
An error occurred while executing the activity.
ExecuteProblem
An error occurred while executing the query.
InitializeProblem
Error from Salesforce.com while initializing activity. Trying to ignore error and proceed.
InputParamMapped
The optional input parameter in the activity is mapped.
InputParamNotMapped
The optional input parameter in the activity is not mapped.
InvalidQuery
The query provided to Salesforce.com was invalid.
InvalidSFDCField
The field is invalid in Salesforce.com.
InvalidSFDCObject
The object is invalid in Salesforce.com
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LargeData
The activity was not able to get data as id limit has exceeded.
LargeDataError
An error occurred due to large data which activity cannot handle.
MetadataError
Unable to obtain meta data from Salesforce.com.
MetadataObjectError
Unable to obtain meta data for the object from Salesforce.com.
NoDatafound
No data was found by the activity in the interval specified.
ParameterOutput
The activity has completed its operation and outputted objects in output parameter.
ParameterResults
The activity has completed its operation and outputted result objects in output parameter.
PollActivateError
The poll activity failed to activate.
PollOutput
The number of objects outputted for a batch poll.
PollReturnedNothing
The poll activity did not return any ids for specified interval.
PollReturnedResults
Poll activity returned these number of ids for interval specified.
ShortPoll
The current time is less than 1 minute past last polling time, so activity is skipping the poll at this
interval.
TimeTooClose
The end time specified is less than 1 minute past start time. Setting the interval to 1 minute and getting
the data.
UnexpectedSFDCFault
Salesforce.com returned an unexpected fault that is not declared in the method signature.
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ActivateError
There was a problem in activating the activity.

Level : Severe

Log Message : Activity could not get activated. Error is: {Message}

System : Orchestration
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SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oActivateErrorEv24

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 24

Variables

The ActivateError message contains the following variables:

Table 1. ActivateError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Salesforce.com Operation Notifications
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ActivityOutput
The activity has completed its operation and outputted param objects in output parameter.

Level : Info

Log Message : Completed activity and spewed out sessionInfo and {NameOfOutputParam} output parameter.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oActivityOutputEv23

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 23

Variables

The ActivityOutput message contains the following variables:

Table 1. ActivityOutput Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NameOfOutputParam

Name of the output parameter.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv23NameOfOutputParam
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.23.1
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BatchPollStart
Starting a batch poll for index range specified.

Level : Info

Log Message : Starting batch of size {BatchSize} for index {StartIndex} through {EndIndex}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oBatchPollStartEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 13

Variables

The BatchPollStart message contains the following variables:

Table 1. BatchPollStart Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. BatchSize

The batch size for the poll.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv13BatchSize
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.13.1

6. StartIndex

The start index specified.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv13StartIndex
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.13.2

7. EndIndex

The end index specified.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv13EndIndex
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.13.3
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ConnectFailed
The Salesforce.com operation failed because a connection to the server could not be established. This
happened cause of reasons other than connectivity issues.

Level : Severe

Log Message : Unable to connect to Salesforce.com. Error is: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oConnectFailedEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 9

Variables

The ConnectFailed message contains the following variables:

Table 1. ConnectFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ExecuteError
An error occurred while executing the activity.

Level : Severe

Log Message : Error while trying to execute activity. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oExecuteErrorEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 6

Variables

The ExecuteError message contains the following variables:

Table 1. ExecuteError Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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ExecuteProblem
An error occurred while executing the query.

Level : Severe

Log Message : Error while trying to execute query. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oExecuteProblemEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 8

Variables

The ExecuteProblem message contains the following variables:

Table 1. ExecuteProblem Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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InitializeProblem
Error from Salesforce.com while initializing activity. Trying to ignore error and proceed.

Level : Warning

Log Message : Error from Salesforce.com while initializing activity. Trying to ignore error and proceed. Error is:
{Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oInitializeProblemEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 10

Variables

The InitializeProblem message contains the following variables:

Table 1. InitializeProblem Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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InputParamMapped
The optional input parameter in the activity is mapped.

Level : Info

Log Message : Optional input parameter {ParamName} mapped.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oInputParamMappedEv19
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 19

Variables

The InputParamMapped message contains the following variables:

Table 1. InputParamMapped Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ParamName

The name of the mapped input parameter.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv19ParamName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.19.1

Parent topic: Salesforce.com Operation Notifications
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InputParamNotMapped
The optional input parameter in the activity is not mapped.

Level : Info

Log Message : Optional input parameter {ParamName} not mapped.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oInputParamNotMappedEv20

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 20

Variables

The InputParamNotMapped message contains the following variables:

Table 1. InputParamNotMapped Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ParamName

The name of the input parameter not mapped.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv20ParamName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.20.1
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InvalidQuery
The query provided to Salesforce.com was invalid.

Level : Severe

Log Message : Problem with querying. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oInvalidQueryEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 4

Variables

The InvalidQuery message contains the following variables:

Table 1. InvalidQuery Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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InvalidSFDCField
The field is invalid in Salesforce.com.
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Level : Severe

Log Message : Invalid Salesforce.com field. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oInvalidSFDCFieldEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 2

Variables

The InvalidSFDCField message contains the following variables:

Table 1. InvalidSFDCField Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
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InvalidSFDCObject
The object is invalid in Salesforce.com

Level : Severe

Log Message : Invalid Salesforce.com object. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oInvalidSFDCObjectEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 3

Variables

The InvalidSFDCObject message contains the following variables:

Table 1. InvalidSFDCObject Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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LargeData
The activity was not able to get data as id limit has exceeded.

Level : Severe

Log Message : Could not get data for date range, because id limit exceeded

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oLargeDataEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 18

Variables
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The LargeData message contains the following variables:

Table 1. LargeData Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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LargeDataError
An error occurred due to large data which activity cannot handle.
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Level : Severe

Log Message : Activity failed as data to get is larger than activity can handle. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oLargeDataErrorEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 7

Variables

The LargeDataError message contains the following variables:

Table 1. LargeDataError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
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MetadataError
Unable to obtain meta data from Salesforce.com.

Level : Severe

Log Message : Unable to obtain meta data from Salesforce.com. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oMetadataErrorEv25

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 25

Variables

The MetadataError message contains the following variables:

Table 1. MetadataError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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MetadataObjectError
Unable to obtain meta data for the object from Salesforce.com.

Level : Severe

Log Message : Unable to obtain meta data from Salesforce.com for {NameOfObject}. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oMetadataObjectErrorEv26

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 26

Variables
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The MetadataObjectError message contains the following variables:

Table 1. MetadataObjectError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NameOfObject

Name of the object.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv26NameOfObject
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.26.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Salesforce.com Operation Notifications
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NoDatafound
No data was found by the activity in the interval specified.

Level : Info

Log Message : No data found in the interval.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oNoDatafoundEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 16

Variables

The NoDatafound message contains the following variables:

Table 1. NoDatafound Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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ParameterOutput
The activity has completed its operation and outputted objects in output parameter.

Level : Info

Log Message : Completed activity and spewed out sessionInfo output parameter and {NumberOfObjects} objects
in output parameter {NameOfOutputParam}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oParameterOutputEv21

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 21

Variables

The ParameterOutput message contains the following variables:

Table 1. ParameterOutput Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfObjects

Number of objects outputted by the activity.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv21NumberOfObjects
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.21.1

6. NameOfOutputParam

Name of the output parameter.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv21NameOfOutputParam
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.21.2

Parent topic: Salesforce.com Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/sfdc/sfdc_oper
ation_parameteroutput_message.html

2144   



ParameterResults
The activity has completed its operation and outputted result objects in output parameter.

Level : Info

Log Message : Completed activity and spewed out sessionInfo output parameter and {NumberOfResults} result
objects in output parameter {NameOfOutputParam}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oParameterResultsEv22

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 22

Variables

The ParameterResults message contains the following variables:

Table 1. ParameterResults Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. NumberOfResults

Number of result objects outputted by the activity.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv22NumberOfResults
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.22.1

6. NameOfOutputParam

Name of the output parameter.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv22NameOfOutputParam
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.22.2
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PollActivateError
The poll activity failed to activate.

Level : Severe

Log Message : Error while trying to activate activity. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oPollActivateErrorEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 5

Variables

The PollActivateError message contains the following variables:

Table 1. PollActivateError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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PollOutput
The number of objects outputted for a batch poll.
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Level : Info

Log Message : Outputted {OutputSize} objects in 'objects' output parameter.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oPollOutputEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 14

Variables

The PollOutput message contains the following variables:

Table 1. PollOutput Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. OutputSize

The number of objects in the output.

Type : Integer

2148   



SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv14OutputSize
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.14.1
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PollReturnedNothing
The poll activity did not return any ids for specified interval.

Level : Info

Log Message : Poll did not return any ids for interval starting from {PollStartTime} to {PollEndTime}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oPollReturnedNothingEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 15

Variables

The PollReturnedNothing message contains the following variables:

Table 1. PollReturnedNothing Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. PollStartTime

The start time for the poll.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv15PollStartTime
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.15.1

6. PollEndTime

The end time for the poll.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv15PollEndTime
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.15.2
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PollReturnedResults
Poll activity returned these number of ids for interval specified.

Level : Info

Log Message : Poll returned {NumberOfIds} ids for interval starting from {PollStartTime} to {PollEndTime}.

System : Orchestration
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SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oPollReturnedResultsEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 12

Variables

The PollReturnedResults message contains the following variables:

Table 1. PollReturnedResults Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfIds

The number of ids returned by the poll.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv12NumberOfIds
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.12.1

6. PollStartTime
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The start time for the poll.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv12PollStartTime
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.12.2

7. PollEndTime

The end time for the poll.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv12PollEndTime
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.12.3
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ShortPoll
The current time is less than 1 minute past last polling time, so activity is skipping the poll at this interval.

Level : Info

Log Message : Current time {CurrentTime} is less than 1 minute past last polling time {LastPollingTime}. Skipping
this polling interval.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oShortPollEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 11

Variables

The ShortPoll message contains the following variables:

Table 1. ShortPoll Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. CurrentTime

The current time.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv11CurrentTime
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.11.1

6. LastPollingTime

The last polling time.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv11LastPollingTime
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.11.2

Parent topic: Salesforce.com Operation Notifications
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TimeTooClose
The end time specified is less than 1 minute past start time. Setting the interval to 1 minute and getting the
data.

Level : Info

Log Message : End time {StartTime} is less than 1 minute past start time {EndTime}. Setting interval to 1 minute
and getting data.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oTimeTooCloseEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 17

Variables

The TimeTooClose message contains the following variables:

Table 1. TimeTooClose Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. EndTime

The end time.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv17EndTime
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.17.1

6. StartTime

The start time.

Type : String
SNMP Object Name : CASTIRON-COMP-SFDC-MIB::ciC3oEv17StartTime
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.3.1.2.1.17.2
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UnexpectedSFDCFault
Salesforce.com returned an unexpected fault that is not declared in the method signature.

Level : Severe

Log Message : Salesforce.com returned an unexpected error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3oUnexpectedSFDCFaultEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.2

SNMP Trap Number : 1

Variables

The UnexpectedSFDCFault message contains the following variables:

Table 1. UnexpectedSFDCFault Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Salesforce.com Operation Notifications
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Salesforce.com Internal Notifications
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Provides a comprehensive list of internal notifications sent from the Salesforce.com Module.

EndpointNull
The endpoint object provided to Salesforce.com activity is null.
MarshalError
An error occurred while writing output parameters in the activity.
SfdcErrorInternal
An internal error occurred in Salesforce.com connector.
UnmarshalError
An error occurred while reading input parameters in the activity.

Parent topic: Salesforce.com Module
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EndpointNull
The endpoint object provided to Salesforce.com activity is null.

Level : Severe

Log Message : Endpoint object is null.

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3iEndpointNullEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.3

SNMP Trap Number : 2

Variables

The EndpointNull message contains the following variables:

Table 1. EndpointNull Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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MarshalError
An error occurred while writing output parameters in the activity.

Level : Severe

Log Message : Error while trying to write output parameter sessionInfo. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3iMarshalErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.3

SNMP Trap Number : 4

Variables
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The MarshalError message contains the following variables:

Table 1. MarshalError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Salesforce.com Internal Notifications
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SfdcErrorInternal
An internal error occurred in Salesforce.com connector.

Level : Severe

Log Message : Internal error in Salesforce.com connector. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3iSfdcErrorInternalEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.3

SNMP Trap Number : 1

Variables

The SfdcErrorInternal message contains the following variables:

Table 1. SfdcErrorInternal Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Salesforce.com Internal Notifications
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UnmarshalError
An error occurred while reading input parameters in the activity.

Level : Severe

Log Message : Error while trying to read optional connection input parameter. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SFDC-MIB::ciC3iUnmarshalErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.3.1.3

SNMP Trap Number : 3

Variables

The UnmarshalError message contains the following variables:

Table 1. UnmarshalError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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Scheduler Module
The Scheduler Module allows jobs to be started on a regular basis. This section contains details for the
messages delivered from the Scheduler Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Scheduler Module.

MIB Name : CASTIRON-COMP-SCHEDULER-MIB
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MIB OID : .1.3.6.1.4.1.13336.2.2.3.5

The following table provides an alphabetical list of all notifications that can be issued by the Scheduler Module.

Table 1. Notifications issued by the Scheduler Module
Notification Level System Description

ActivityException Severe Orchestration There was an error running scheduler activity.

SchedulerUnknownType Warning Orchestration The group configured in the activity is unknown.

SchedulerWarning Warning Orchestration There was an error in scheduler activity. Continuing to
schedule further jobs.

Scheduler Operation Notifications
Provides a comprehensive list of operation notifications sent from the Scheduler Module.
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Scheduler Operation Notifications
Provides a comprehensive list of operation notifications sent from the Scheduler Module.

ActivityException
There was an error running scheduler activity.
SchedulerUnknownType
The group configured in the activity is unknown.
SchedulerWarning
There was an error in scheduler activity. Continuing to schedule further jobs.

Parent topic: Scheduler Module
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ActivityException
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There was an error running scheduler activity.

Level : Severe

Log Message : Error: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-SCHEDULER-MIB::ciC5oActivityExceptionEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.5.1.2

SNMP Trap Number : 1

Variables

The ActivityException message contains the following variables:

Table 1. ActivityException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Scheduler Operation Notifications
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SchedulerUnknownType
The group configured in the activity is unknown.

Level : Warning

Log Message : Not a known type of group.

System : Orchestration

SNMP Name : CASTIRON-COMP-SCHEDULER-MIB::ciC5oSchedulerUnknownTypeEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.5.1.2

SNMP Trap Number : 2

Variables

The SchedulerUnknownType message contains the following variables:

Table 1. SchedulerUnknownType Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Scheduler Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/scheduler/sche
duler_operation_schedulerunknowntype_message.html

SchedulerWarning
There was an error in scheduler activity. Continuing to schedule further jobs.

Level : Warning

Log Message : Got exception in "Schedule Job" activity: {Message}. Continuing to schedule jobs.

System : Orchestration

SNMP Name : CASTIRON-COMP-SCHEDULER-MIB::ciC5oSchedulerWarningEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.5.1.2

SNMP Trap Number : 3

Variables

The SchedulerWarning message contains the following variables:

Table 1. SchedulerWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Description of error occurred.

Type : String
SNMP Object Name : CASTIRON-COMP-SCHEDULER-MIB::ciC5oEv3Message
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.5.1.2.1.3.1

Parent topic: Scheduler Operation Notifications
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Siebel Module
The Siebel Module provides access to Oracle's Siebel CRM. This section contains details for the messages
delivered from the Siebel Module.
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This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Siebel Module.

MIB Name : CASTIRON-COMP-SIEBEL-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.17

The following table provides an alphabetical list of all notifications that can be issued by the Siebel Module.

Table 1. Notifications issued by the Siebel Module
Notification Level System Description

ActivateError Severe Orchestration Error occurred while activating the specified activity.

ConfigURI Severe Orchestration Specified activity name is listening on the specified
uri and port.

ConnectError Severe Orchestration The invoke operation failed because a connection to
the server could not be established.

ConnectionPoolError Warning Orchestration Error occurred while setting up connection pool for
specified activity.

ConnectionRetry Warning Orchestration The invoke operation failed while trying to connect to
the server. This will cause a retry.

DataException Severe Orchestration Data error occurred while executing the activity.

GeneralError Severe Orchestration General error occurred while sending the response.

IOError Severe Orchestration IO error occurred while processing request.

InternalError Severe Orchestration Internal error occurred while processing request.

InvokeActivate Warning Orchestration Error in setup of repository/connection-pool in
activate of specified activity. Setup will be done at
activity execution time.

InvokeDeactivateError Warning Orchestration Error occurred while deactivating the specified
activity.

InvokeException Severe Orchestration Error occurred while executing the activity.

InvokeSuccessful Info Orchestration Activity has successfully executed activity and
outputted output parameter RESPONSE.

MissingLibraries Severe Orchestration Config file jas.ini needs to be present before the JD
Edwards Invoke activity can be run. Please upload
jas.ini file and run again.

ReceiveDeactivateErr Severe Orchestration Error occurred while deactivating the specified
activity.

ReceiveError Severe Orchestration Error occurred while receiving in the specified activity
name.

ReceiveSuccessful Info Orchestration Receive activity successfully received request and
outputted output parameter RESPONSE.

RepositoryError Warning Orchestration Error occurred while setting up repository for
specified activity.
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Notification Level System Description

UnSupportedEncoding Severe Orchestration Error occurred while processing unsupported
encoding.

Siebel Connection Notifications
Provides a comprehensive list of connection notifications sent from the Siebel Module.
Siebel Operation Notifications
Provides a comprehensive list of operation notifications sent from the Siebel Module.
Siebel Internal Notifications
Provides a comprehensive list of internal notifications sent from the Siebel Module.

Feedback | Notices
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Siebel Connection Notifications
Provides a comprehensive list of connection notifications sent from the Siebel Module.

ConnectError
The invoke operation failed because a connection to the server could not be established.
ConnectionRetry
The invoke operation failed while trying to connect to the server. This will cause a retry.
IOError
IO error occurred while processing request.

Parent topic: Siebel Module
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ConnectError
The invoke operation failed because a connection to the server could not be established.

Level : Severe
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Log Message : Unable to connect to server after {NumberOfRetryAttempts} attempts. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17cConnectErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.1

SNMP Trap Number : 1

Variables

The ConnectError message contains the following variables:

Table 1. ConnectError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17cEv1NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.1.1.1.1
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6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Connection Notifications
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ConnectionRetry
The invoke operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to connect to server. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17cConnectionRetryEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.1

SNMP Trap Number : 2

Variables

The ConnectionRetry message contains the following variables:

Table 1. ConnectionRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.
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Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17cEv2RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.1.1.2.2

7. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17cEv2TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.1.1.2.3

8. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17cEv2IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.1.1.2.4

Parent topic: Siebel Connection Notifications
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IOError
IO error occurred while processing request.

Level : Severe

Log Message : IO Error while processing request. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17cIOErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.1

SNMP Trap Number : 3

Variables

The IOError message contains the following variables:

Table 1. IOError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Connection Notifications
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Siebel Operation Notifications
Provides a comprehensive list of operation notifications sent from the Siebel Module.

ActivateError
Error occurred while activating the specified activity.
ConfigURI
Specified activity name is listening on the specified uri and port.
ConnectionPoolError
Error occurred while setting up connection pool for specified activity.
DataException
Data error occurred while executing the activity.
InvokeActivate
Error in setup of repository/connection-pool in activate of specified activity. Setup will be done at activity
execution time.
InvokeDeactivateError
Error occurred while deactivating the specified activity.
InvokeException
Error occurred while executing the activity.
InvokeSuccessful
Activity has successfully executed activity and outputted output parameter RESPONSE.
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ReceiveDeactivateErr
Error occurred while deactivating the specified activity.
ReceiveError
Error occurred while receiving in the specified activity name.
ReceiveSuccessful
Receive activity successfully received request and outputted output parameter RESPONSE.
RepositoryError
Error occurred while setting up repository for specified activity.
UnSupportedEncoding
Error occurred while processing unsupported encoding.

Parent topic: Siebel Module
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ActivateError
Error occurred while activating the specified activity.

Level : Severe

Log Message : Error while activating the {ActivityName} activity. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oActivateErrorEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 11

Variables

The ActivateError message contains the following variables:

Table 1. ActivateError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Activity name which caused the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv11ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.11.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications
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Specified activity name is listening on the specified uri and port.

Level : Severe

Log Message : {ActivityName} listening for events on URI: \"{UriValue}\" and port: \"{PortValue}\".

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oConfigURIEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 13

Variables

The ConfigURI message contains the following variables:

Table 1. ConfigURI Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Activity name which is listening on the uri and port specified.
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Type : String
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv13ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.13.1

6. UriValue

The URI the server is listening on.

Type : String
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv13UriValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.13.2

7. PortValue

The port number the server is listening on.

Type : Integer
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv13PortValue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.13.3

Parent topic: Siebel Operation Notifications
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ConnectionPoolError
Error occurred while setting up connection pool for specified activity.

Level : Warning

Log Message : Error while setting up connection pool for {ActivityName} activity. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oConnectionPoolErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 2

Variables

The ConnectionPoolError message contains the following variables:

Table 1. ConnectionPoolError Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Activity name which caused the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv2ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications
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DataException
Data error occurred while executing the activity.

Level : Severe

Log Message : Data error while executing the activity. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oDataExceptionEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 5

Variables

The DataException message contains the following variables:

Table 1. DataException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications
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InvokeActivate
Error in setup of repository/connection-pool in activate of specified activity. Setup will be done at activity
execution time.

Level : Warning

Log Message : Error in setup of repository/connection-pool in activate of {ActivityName}. Setup to be done at
activity execution time. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oInvokeActivateEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 3

Variables

The InvokeActivate message contains the following variables:

Table 1. InvokeActivate Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Activity name which caused the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv3ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.3.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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InvokeDeactivateError
Error occurred while deactivating the specified activity.

Level : Warning

Log Message : Error while deactivating the {ActivityName} activity. Discarding error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oInvokeDeactivateErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 4

Variables

The InvokeDeactivateError message contains the following variables:

Table 1. InvokeDeactivateError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Activity name which caused the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv4ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.4.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications
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InvokeException
Error occurred while executing the activity.

Level : Severe

Log Message : Error while executing the activity. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oInvokeExceptionEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 6

Variables

The InvokeException message contains the following variables:

Table 1. InvokeException Message Variables
1. SerialNumber

2184   



The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications
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InvokeSuccessful
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Activity has successfully executed activity and outputted output parameter RESPONSE.

Level : Info

Log Message : Successfully executed activity and outputted output parameter RESPONSE.

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oInvokeSuccessfulEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 7

Variables

The InvokeSuccessful message contains the following variables:

Table 1. InvokeSuccessful Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Siebel Operation Notifications
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ReceiveDeactivateErr
Error occurred while deactivating the specified activity.

Level : Severe

Log Message : Error while deactivating the {ActivityName} activity. Discarding error: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oReceiveDeactivateErrEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 12

Variables

The ReceiveDeactivateErr message contains the following variables:

Table 1. ReceiveDeactivateErr Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Activity name which caused the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv12ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.12.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications
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ReceiveError
Error occurred while receiving in the specified activity name.

Level : Severe

Log Message : Error while receiving in {ActivityName} activity. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oReceiveErrorEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 9

Variables
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The ReceiveError message contains the following variables:

Table 1. ReceiveError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Activity name which caused the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv9ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.9.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications
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ReceiveSuccessful
Receive activity successfully received request and outputted output parameter RESPONSE.

Level : Info

Log Message : Successfully received request and outputted output parameter RESPONSE.

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oReceiveSuccessfulEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 8

Variables

The ReceiveSuccessful message contains the following variables:

Table 1. ReceiveSuccessful Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Siebel Operation Notifications
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RepositoryError
Error occurred while setting up repository for specified activity.

Level : Warning

Log Message : Error while setting up repository for {ActivityName} activity. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oRepositoryErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 1

Variables

The RepositoryError message contains the following variables:

Table 1. RepositoryError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ActivityName

Activity name which caused the error.

Type : String
SNMP Object Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oEv1ActivityName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.17.1.2.1.1.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications
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UnSupportedEncoding
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Error occurred while processing unsupported encoding.

Level : Severe

Log Message : Error while processing unsupported encoding. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17oUnSupportedEncodingEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.2

SNMP Trap Number : 10

Variables

The UnSupportedEncoding message contains the following variables:

Table 1. UnSupportedEncoding Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Operation Notifications
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Siebel Internal Notifications
Provides a comprehensive list of internal notifications sent from the Siebel Module.

GeneralError
General error occurred while sending the response.
InternalError
Internal error occurred while processing request.
MissingLibraries
Config file jas.ini needs to be present before the JD Edwards Invoke activity can be run. Please upload
jas.ini file and run again.

Parent topic: Siebel Module

Feedback | Notices
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GeneralError
General error occurred while sending the response.

Level : Severe

Log Message : General error while sending the response. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17iGeneralErrorEv1
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SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.3

SNMP Trap Number : 1

Variables

The GeneralError message contains the following variables:

Table 1. GeneralError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Internal Notifications
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InternalError
Internal error occurred while processing request.

Level : Severe

Log Message : Error while processing request. The error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17iInternalErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.3

SNMP Trap Number : 2

Variables

The InternalError message contains the following variables:

Table 1. InternalError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Siebel Internal Notifications
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MissingLibraries
Config file jas.ini needs to be present before the JD Edwards Invoke activity can be run. Please upload jas.ini
file and run again.

Level : Severe

Log Message : jas.ini file needs to be present before the JD Edwards Invoke activity can be run. Please upload
jas.ini file and run again.

System : Orchestration

SNMP Name : CASTIRON-COMP-SIEBEL-MIB::ciC17iMissingLibrariesEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.17.1.3

SNMP Trap Number : 3

Variables

The MissingLibraries message contains the following variables:

Table 1. MissingLibraries Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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Web Service Module
The Web Service Module provides activities to act as a Web Service client or server. This section contains
details for the messages delivered from the Web Service Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Web Service Module.

MIB Name : CASTIRON-COMP-WS-MIB
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MIB OID : .1.3.6.1.4.1.13336.2.2.3.18

The following table provides an alphabetical list of all notifications that can be issued by the Web Service
Module.

Table 1. Notifications issued by the Web Service Module
Notification Level System Description

AlreadyRegistered Severe Orchestration The URI/port is already registered by the Web Service
activity.

CleanUpMessage Severe Orchestration Unable to process the request. Additional information
about the error can be found on the Web
Management Console.

ConnectFailed Severe Orchestration The webservice operation failed because a
connection to the server could not be established.

ConnectRetry Warning Orchestration The webservice operation failed while trying to
connect to the server. This will cause a retry.

DataMessageAccepted Info Orchestration SOAP message has been accepted by the Integration
Appliance.

MissingProtocol Warning Orchestration Please put the protocol used in fromt of input
parameter location.

NotRegistered Severe Orchestration The URI/port has not been registered by the Web
Service activity.

OperationNameNull Severe Orchestration Operation name must not be null or empty.

TaskContextError Severe Orchestration Error occurred while processing Web Service activity
due to lost task context.

TransportInfo Info Orchestration The provide activity is started on local transport for
the URI.

UriDeprecated Warning Orchestration Web Service Module has deprecated the input
parameter httpheaders/uri. The specified value will
be ignored.

WSFaultString Severe Orchestration The fault string returned by the WebService activity.

WebServiceException Severe Orchestration Error occurred while processing Web Service activity.

Web Service Connection Notifications
Provides a comprehensive list of connection notifications sent from the Web Service Module.
Web Service Operation Notifications
Provides a comprehensive list of operation notifications sent from the Web Service Module.
Web Service Internal Notifications
Provides a comprehensive list of internal notifications sent from the Web Service Module.

Feedback | Notices
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Web Service Connection Notifications
Provides a comprehensive list of connection notifications sent from the Web Service Module.

ConnectFailed
The webservice operation failed because a connection to the server could not be established.
ConnectRetry
The webservice operation failed while trying to connect to the server. This will cause a retry.

Parent topic: Web Service Module
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ConnectFailed
The webservice operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Error sending SOAP request to location: {LocationName}. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18cConnectFailedEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.1

SNMP Trap Number : 2

Variables

The ConnectFailed message contains the following variables:

Table 1. ConnectFailed Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
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SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. LocationName

The specified location which was not being able to connect.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18cEv2LocationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.1.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Web Service Connection Notifications
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ConnectRetry
The webservice operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to send the SOAP request to {LocationName}. Error is: {Message}. Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will retry again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18cConnectRetryEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.1

SNMP Trap Number : 1

Variables

The ConnectRetry message contains the following variables:

Table 1. ConnectRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.
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Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. LocationName

The specified location which was not being able to connect.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18cEv1LocationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.1.1.1.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

7. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18cEv1RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.1.1.1.3

8. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18cEv1TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.1.1.1.4

9. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18cEv1IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.1.1.1.5

Parent topic: Web Service Connection Notifications
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Web Service Operation Notifications
Provides a comprehensive list of operation notifications sent from the Web Service Module.

AlreadyRegistered
The URI/port is already registered by the Web Service activity.
CleanUpMessage
Unable to process the request. Additional information about the error can be found on the Web
Management Console.
DataMessageAccepted
SOAP message has been accepted by the Integration Appliance.
MissingProtocol
Please put the protocol used in fromt of input parameter location.
NotRegistered
The URI/port has not been registered by the Web Service activity.
OperationNameNull
Operation name must not be null or empty.
TransportInfo
The provide activity is started on local transport for the URI.
UriDeprecated
Web Service Module has deprecated the input parameter httpheaders/uri. The specified value will be
ignored.
WSFaultString
The fault string returned by the WebService activity.
WebServiceException
Error occurred while processing Web Service activity.

Parent topic: Web Service Module
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AlreadyRegistered
The URI/port is already registered by the Web Service activity.

Level : Severe

Log Message : [URI: {Uri}, Port: {Port}, Operation Name: {OperationName}] Web Service has already been
registered. Key: {RegistrationKey}

System : Orchestration

2204   



SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oAlreadyRegisteredEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2

SNMP Trap Number : 7

Variables

The AlreadyRegistered message contains the following variables:

Table 1. AlreadyRegistered Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Uri

The URI which is already registered.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv7Uri
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.7.1

6. Port
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The port which is already registered.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv7Port
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.7.2

7. OperationName

The operation name which was specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv7OperationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.7.3

8. RegistrationKey

Key used to identify this URI/Port/Operation

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv7RegistrationKey
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.7.4

Parent topic: Web Service Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/ws/ws_operatio
n_alreadyregistered_message.html

CleanUpMessage
Unable to process the request. Additional information about the error can be found on the Web Management
Console.

Level : Severe

Log Message : Unable to process the request. Additional information about the error can be found on the Web
Management Console.

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oCleanUpMessageEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2

SNMP Trap Number : 9

Variables
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The CleanUpMessage message contains the following variables:

Table 1. CleanUpMessage Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Web Service Operation Notifications
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DataMessageAccepted
SOAP message has been accepted by the Integration Appliance.
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Level : Info

Log Message : SOAP message has been accepted by the Integration Appliance.

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oDataMessageAcceptedEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2

SNMP Trap Number : 1

Variables

The DataMessageAccepted message contains the following variables:

Table 1. DataMessageAccepted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Web Service Operation Notifications
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MissingProtocol
Please put the protocol used in fromt of input parameter location.

Level : Warning

Log Message : Please put the protocol used (e.g. {Protocol}) in front of the input parameter location:
{LocationName}

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oMissingProtocolEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2

SNMP Trap Number : 5

Variables

The MissingProtocol message contains the following variables:

Table 1. MissingProtocol Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Protocol

The protocol value that can be specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv5Protocol
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.5.1

6. LocationName

The location name parameter before which protocol has to be specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv5LocationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.5.2

Parent topic: Web Service Operation Notifications
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NotRegistered
The URI/port has not been registered by the Web Service activity.

Level : Severe

Log Message : [URI: {Uri}, Port: {Port}, Operation Name: {OperationName}] has not been registered. Key:
{KeyName}

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oNotRegisteredEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2

SNMP Trap Number : 8
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Variables

The NotRegistered message contains the following variables:

Table 1. NotRegistered Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Uri

The URI which is not registered.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv8Uri
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.8.1

6. Port

The port which is not registered.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv8Port
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.8.2
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7. OperationName

The operation name which was specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv8OperationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.8.3

8. KeyName

The key name which was specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv8KeyName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.8.4

Parent topic: Web Service Operation Notifications
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OperationNameNull
Operation name must not be null or empty.

Level : Severe

Log Message : Operation name must not be null or empty!

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oOperationNameNullEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2

SNMP Trap Number : 2

Variables

The OperationNameNull message contains the following variables:

Table 1. OperationNameNull Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Web Service Operation Notifications
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TransportInfo
The provide activity is started on local transport for the URI.

Level : Info

Log Message : The provide activity is started on local transport for the URI: {URI}

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oTransportInfoEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2
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SNMP Trap Number : 10

Variables

The TransportInfo message contains the following variables:

Table 1. TransportInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. URI

URI at which provie activity was started.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv10URI
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.10.1

Parent topic: Web Service Operation Notifications

Feedback | Notices

2214   



 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/ws/ws_operatio
n_transportinfo_message.html

UriDeprecated
Web Service Module has deprecated the input parameter httpheaders/uri. The specified value will be ignored.

Level : Warning

Log Message : Web Service Module has deprecated the input parameter "httpheaders/uri". The value: {Value} will
be ignored. Please set the URL (e.g. http://www.castiron.com/WebService) at the location in the endpoint panel or
at the input parameter "location".

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oUriDeprecatedEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2

SNMP Trap Number : 6

Variables

The UriDeprecated message contains the following variables:

Table 1. UriDeprecated Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

The value which will be ignored due to deprecated input parameter.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv6Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.6.1

Parent topic: Web Service Operation Notifications
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WSFaultString
The fault string returned by the WebService activity.

Level : Severe

Log Message : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oWSFaultStringEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2

SNMP Trap Number : 3

Variables

The WSFaultString message contains the following variables:

Table 1. WSFaultString Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Web Service Operation Notifications
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WebServiceException
Error occurred while processing Web Service activity.
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Level : Severe

Log Message : Exception while processing Web Service activity. Error message: {Message}. Caused by: {Cause}

System : Orchestration

SNMP Name : CASTIRON-COMP-WS-MIB::ciC18oWebServiceExceptionEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.2

SNMP Trap Number : 4

Variables

The WebServiceException message contains the following variables:

Table 1. WebServiceException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. Cause

The cause of the error message.

Type : String
SNMP Object Name : CASTIRON-COMP-WS-MIB::ciC18oEv4Cause
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.18.1.2.1.4.2

Parent topic: Web Service Operation Notifications
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Web Service Internal Notifications
Provides a comprehensive list of internal notifications sent from the Web Service Module.

TaskContextError
Error occurred while processing Web Service activity due to lost task context.

Parent topic: Web Service Module
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TaskContextError
Error occurred while processing Web Service activity due to lost task context.

Level : Severe

Log Message : Exception while processing Web Service activity. Error message: {Message}. The task context is
lost. The appliance may have been restarted, losing the task context that cannot be saved on the disk.

System : Orchestration
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SNMP Name : CASTIRON-COMP-WS-MIB::ciC18iTaskContextErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.18.1.3

SNMP Trap Number : 1

Variables

The TaskContextError message contains the following variables:

Table 1. TaskContextError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Web Service Internal Notifications
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WebSphere MQ Module
The WebSphere MQ module provides activities for communicating with IBM WebSphere MQ servers. This
section contains details for the messages delivered from the WebSphere MQ Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the WebSphere MQ Module.

MIB Name : CASTIRON-COMP-MQ-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.13

The following table provides an alphabetical list of all notifications that can be issued by the WebSphere MQ
Module.

Table 1. Notifications issued by the WebSphere MQ Module
Notification Level System Description

ConnectRetry Warning Orchestration The MQ operation failed while trying to connect to the
server. This will cause a retry.

ConnectionError Severe Orchestration The MQ operation failed because a connection to the
server could not be established.

DetailsOpen Info Orchestration Opening the queue with set all privileges as specified.

DuplicateFound Info Orchestration Discarding the duplicate message found in get
activity.

FormatError Severe Orchestration The message format field specified is invalid.
Supported formats are MQSTR, MQHRF2, and no
format.

FormatWarning Warning Orchestration Activity expected string data (MQFMT_STRING), but
the message is of another format.

GetFailure Severe Orchestration The get activity was not able to get messages from
queue.

InputParamNull Severe Orchestration The input parameter specified is of zero length.

InternalFailure Severe Orchestration There was an internal error in MQ activity.

MQConnectionInfo Info Orchestration The complete information about MQ Endpoint details.

MQMDFormatError Severe Orchestration MQMD header input parameter format is incorrect.
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Notification Level System Description

MQProtocolWarning Warning Orchestration Received warning from queue manager with specified
MQ reason code.

MQPutDetails Info Orchestration Putting in queue with set all privileges as specified.

MQPutFailure Severe Orchestration MQ was unable to put message on queue due to
specified error code.

MQRFHHeaderError Severe Orchestration MQRFH2 header input parameter format is incorrect.

MessageDelievered Info Orchestration The MQ message was successfully delivered to the
specified queue.

MessageRetrieved Info Orchestration Retrieved a message from the queue.

NoMessage Info Orchestration There is no message available on the queue.

NoMessageFailure Severe Orchestration The MQ operation failed as there was no message on
queue on server.

NoMessageRetry Warning Orchestration The MQ operation failed as there was no message on
queue on server. This will cause a retry.

PollFailure Severe Orchestration The poll activity was not able to get messages from
queue.

RFHFormatError Severe Orchestration Error encountered unmarshaling the MQRFH2 header.

ReasonCode Info Orchestration The reason code for the MQ exception caught.

WebSphere MQ Connection Notifications
Provides a comprehensive list of connection notifications sent from the WebSphere MQ Module.
WebSphere MQ Operation Notifications
Provides a comprehensive list of operation notifications sent from the WebSphere MQ Module.
WebSphere MQ Internal Notifications
Provides a comprehensive list of internal notifications sent from the WebSphere MQ Module.
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WebSphere MQ Connection Notifications
Provides a comprehensive list of connection notifications sent from the WebSphere MQ Module.

ConnectRetry
The MQ operation failed while trying to connect to the server. This will cause a retry.
ConnectionError
The MQ operation failed because a connection to the server could not be established.
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MQConnectionInfo
The complete information about MQ Endpoint details.

Parent topic: WebSphere MQ Module
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ConnectRetry
The MQ operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to connect to the Queue Manager "{QueueManager}". MQ returned error code "
{ErrorCode}". Attempt {RetryAttemptNumber} of {TotalRetryAttempts}. Will try again in {IntervalForRetries}
second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13cConnectRetryEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.1

SNMP Trap Number : 2

Variables

The ConnectRetry message contains the following variables:

Table 1. ConnectRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueueManager

The name of the queue manager which activity was not able to connect.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv2QueueManager
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.2.1

6. ErrorCode

The error code returned by the MQ server.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv2ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.2.2

7. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv2RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.2.3

8. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv2TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.2.4

9. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv2IntervalForRetries
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SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.2.5

Parent topic: WebSphere MQ Connection Notifications
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ConnectionError
The MQ operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Unable to connect to the Queue Manager "{QueueManager}" after {NumberOfRetryAttempts}
attempt(s). MQ returned error code "{ErrorCode}".

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13cConnectionErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.1

SNMP Trap Number : 3

Variables

The ConnectionError message contains the following variables:

Table 1. ConnectionError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueueManager

The name of the queue manager which activity was not able to connect.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv3QueueManager
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.3.1

6. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv3NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.3.2

7. ErrorCode

The error code returned by the MQ server.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv3ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.3.3

Parent topic: WebSphere MQ Connection Notifications
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MQConnectionInfo
2226   



The complete information about MQ Endpoint details.

Level : Info

Log Message : MQ Endpoint Details: Host: {HostName}, Port: {PortNumber}, User: {UserName}, Queue Manager:
{QueueManager}, Channel: {Channel}

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13cMQConnectionInfoEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.1

SNMP Trap Number : 1

Variables

The MQConnectionInfo message contains the following variables:

Table 1. MQConnectionInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. HostName
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The host name specified in the endpoint.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv1HostName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.1.1

6. PortNumber

The port number specified in the endpoint.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv1PortNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.1.2

7. UserName

The user name specified in the endpoint.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv1UserName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.1.3

8. QueueManager

The queue manager specified in the endpoint.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv1QueueManager
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.1.4

9. Channel

The channel specified in the endpoint.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13cEv1Channel
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.1.1.1.5

Parent topic: WebSphere MQ Connection Notifications
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WebSphere MQ Operation Notifications
Provides a comprehensive list of operation notifications sent from the WebSphere MQ Module.
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DetailsOpen
Opening the queue with set all privileges as specified.
DuplicateFound
Discarding the duplicate message found in get activity.
FormatError
The message format field specified is invalid. Supported formats are MQSTR, MQHRF2, and no format.
FormatWarning
Activity expected string data (MQFMT_STRING), but the message is of another format.
GetFailure
The get activity was not able to get messages from queue.
MQMDFormatError
MQMD header input parameter format is incorrect.
MQProtocolWarning
Received warning from queue manager with specified MQ reason code.
MQPutDetails
Putting in queue with set all privileges as specified.
MQPutFailure
MQ was unable to put message on queue due to specified error code.
MQRFHHeaderError
MQRFH2 header input parameter format is incorrect.
MessageDelievered
The MQ message was successfully delivered to the specified queue.
MessageRetrieved
Retrieved a message from the queue.
NoMessage
There is no message available on the queue.
NoMessageFailure
The MQ operation failed as there was no message on queue on server.
NoMessageRetry
The MQ operation failed as there was no message on queue on server. This will cause a retry.
PollFailure
The poll activity was not able to get messages from queue.
RFHFormatError
Error encountered unmarshaling the MQRFH2 header.
ReasonCode
The reason code for the MQ exception caught.

Parent topic: WebSphere MQ Module
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DetailsOpen
Opening the queue with set all privileges as specified.
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Level : Info

Log Message : Opening the queue with set all privileges as {Value}

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oDetailsOpenEv18

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 18

Variables

The DetailsOpen message contains the following variables:

Table 1. DetailsOpen Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

Value of set all privileges set to true or false.

Type : String
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SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv18Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.18.1

Parent topic: WebSphere MQ Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mq/mq_operati
on_detailsopen_message.html

DuplicateFound
Discarding the duplicate message found in get activity.

Level : Info

Log Message : Duplicate message found, discarding.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oDuplicateFoundEv14

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 14

Variables

The DuplicateFound message contains the following variables:

Table 1. DuplicateFound Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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FormatError
The message format field specified is invalid. Supported formats are MQSTR, MQHRF2, and no format.

Level : Severe

Log Message : The message format field "{Format}" is invalid. Supported formats are MQSTR, MQHRF2, and no
format.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oFormatErrorEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 8

Variables

The FormatError message contains the following variables:

Table 1. FormatError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Format

The invalid format specified.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv8Format
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.8.1
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FormatWarning
Activity expected string data (MQFMT_STRING), but the message is of another format.
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Level : Warning

Log Message : Activity expected string data (MQFMT_STRING), but the message is of format "{Format}".

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oFormatWarningEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 9

Variables

The FormatWarning message contains the following variables:

Table 1. FormatWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Format

The format specified.

Type : String
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SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv9Format
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.9.1
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GetFailure
The get activity was not able to get messages from queue.

Level : Severe

Log Message : Unable to get message from queue {QueueName}. MQ returned error code {ErrorCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oGetFailureEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 7

Variables

The GetFailure message contains the following variables:

Table 1. GetFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID
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The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueueName

The name of the queue.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv7QueueName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.7.1

6. ErrorCode

The error code returned by the MQ server.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv7ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.7.2

Parent topic: WebSphere MQ Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mq/mq_operati
on_getfailure_message.html

MQMDFormatError
MQMD header input parameter format is incorrect.

Level : Severe

Log Message : MQMD header input parameter format is incorrect; {Header}

System : Orchestration
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SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oMQMDFormatErrorEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 10

Variables

The MQMDFormatError message contains the following variables:

Table 1. MQMDFormatError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Header

The header specified.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv10Header
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.10.1

Parent topic: WebSphere MQ Operation Notifications
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MQProtocolWarning
Received warning from queue manager with specified MQ reason code.

Level : Warning

Log Message : Received warning from queue manager. MQ reason code is {ReasonCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oMQProtocolWarningEv16

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 16

Variables

The MQProtocolWarning message contains the following variables:

Table 1. MQProtocolWarning Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ReasonCode

The reason code for the MQ exception.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv16ReasonCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.16.1
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MQPutDetails
Putting in queue with set all privileges as specified.

Level : Info

Log Message : Putting in queue with set all privileges as {Value}

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oMQPutDetailsEv17

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 17

Variables

The MQPutDetails message contains the following variables:

Table 1. MQPutDetails Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

Value of set all privileges set to true or false.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv17Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.17.1
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MQPutFailure
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MQ was unable to put message on queue due to specified error code.

Level : Severe

Log Message : Unable to put message on queue {QueueManager}. MQ returned error code {ErrorCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oMQPutFailureEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 3

Variables

The MQPutFailure message contains the following variables:

Table 1. MQPutFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueueManager

The name of the queue manager.
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Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv3QueueManager
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.3.1

6. ErrorCode

The error code returned by the MQ server.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv3ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.3.2
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MQRFHHeaderError
MQRFH2 header input parameter format is incorrect.

Level : Severe

Log Message : MQRFH2 header input parameter format is incorrect.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oMQRFHHeaderErrorEv11

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 11

Variables

The MQRFHHeaderError message contains the following variables:

Table 1. MQRFHHeaderError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity
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Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Header

The header specified.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv11Header
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.11.1
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MessageDelievered
The MQ message was successfully delivered to the specified queue.

Level : Info

Log Message : Message successfully delivered to queue {QueueManager}.

System : Orchestration
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SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oMessageDelieveredEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 4

Variables

The MessageDelievered message contains the following variables:

Table 1. MessageDelievered Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueueManager

The name of the queue manager.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv4QueueManager
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.4.1

Parent topic: WebSphere MQ Operation Notifications
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MessageRetrieved
Retrieved a message from the queue.

Level : Info

Log Message : Message of {QueueName} bytes retrieved from queue "{NumberOfBytes}".

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oMessageRetrievedEv15

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 15

Variables

The MessageRetrieved message contains the following variables:

Table 1. MessageRetrieved Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. NumberOfBytes

The number of bytes of the message.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv15NumberOfBytes
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.15.1

6. QueueName

The name of the queue.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv15QueueName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.15.2
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NoMessage
There is no message available on the queue.

Level : Info

Log Message : No message available on queue {Queue}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oNoMessageEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2
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SNMP Trap Number : 5

Variables

The NoMessage message contains the following variables:

Table 1. NoMessage Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Queue

The name of the queue.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv5Queue
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.5.1

Parent topic: WebSphere MQ Operation Notifications
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NoMessageFailure
The MQ operation failed as there was no message on queue on server.

Level : Severe

Log Message : No message available on queue "{QueueManager}" after {NumberOfRetryAttempts} attempt(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oNoMessageFailureEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 2

Variables

The NoMessageFailure message contains the following variables:

Table 1. NoMessageFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueueManager

The name of the queue manager which activity was not able to connect.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv2QueueManager
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.2.1

6. NumberOfRetryAttempts

The total number of attempted retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv2NumberOfRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.2.2
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NoMessageRetry
The MQ operation failed as there was no message on queue on server. This will cause a retry.

Level : Warning

Log Message : No message available on queue "{QueueManager}". Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oNoMessageRetryEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 1

Variables
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The NoMessageRetry message contains the following variables:

Table 1. NoMessageRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueueManager

The name of the queue manager which activity was not able to connect.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv1QueueManager
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.1.1

6. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv1RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.1.2

7. TotalRetryAttempts

2250   



The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv1TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.1.3

8. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv1IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.1.4
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PollFailure
The poll activity was not able to get messages from queue.

Level : Severe

Log Message : Unable to get message from queue {QueueName}. MQ returned error code {ErrorCode}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oPollFailureEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 6

Variables

The PollFailure message contains the following variables:

Table 1. PollFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. QueueName

The name of the queue.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv6QueueName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.6.1

6. ErrorCode

The error code returned by the MQ server.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv6ErrorCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.6.2
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RFHFormatError
Error encountered unmarshaling the MQRFH2 header.

Level : Severe

Log Message : Error encountered unmarshaling the MQRFH2 header: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oRFHFormatErrorEv12

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 12

Variables

The RFHFormatError message contains the following variables:

Table 1. RFHFormatError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: WebSphere MQ Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/mq/mq_operati
on_rfhformaterror_message.html

ReasonCode
The reason code for the MQ exception caught.

Level : Info

Log Message : MQ Exception caught, reason code is {ReasonCode}

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13oReasonCodeEv13

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.2

SNMP Trap Number : 13

Variables

The ReasonCode message contains the following variables:

Table 1. ReasonCode Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ReasonCode

The reason code for the MQ exception.

Type : Integer
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13oEv13ReasonCode
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.2.1.13.1
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WebSphere MQ Internal Notifications
Provides a comprehensive list of internal notifications sent from the WebSphere MQ Module.

InputParamNull
The input parameter specified is of zero length.
InternalFailure
There was an internal error in MQ activity.

Parent topic: WebSphere MQ Module
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InputParamNull
The input parameter specified is of zero length.

Level : Severe

Log Message : The input parameter "{InputParam}" is zero length.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13iInputParamNullEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.3

SNMP Trap Number : 1

Variables

The InputParamNull message contains the following variables:

Table 1. InputParamNull Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. InputParam

The input parameter that was specified.

Type : String
SNMP Object Name : CASTIRON-COMP-MQ-MIB::ciC13iEv1InputParam
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.13.1.3.1.1.1
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InternalFailure
There was an internal error in MQ activity.

Level : Severe

Log Message : An internal error occurred: {Message}.

System : Orchestration

SNMP Name : CASTIRON-COMP-MQ-MIB::ciC13iInternalFailureEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.13.1.3

SNMP Trap Number : 2

Variables

The InternalFailure message contains the following variables:

Table 1. InternalFailure Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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Workday Module
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The Workday Module provides activities to act as a Workday client. This section contains details for the
messages delivered from the Workday Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the Workday Module.

MIB Name : CASTIRON-COMP-WD-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.24

The following table provides an alphabetical list of all notifications that can be issued by the Workday Module.

Table 1. Notifications issued by the Workday Module
Notification Level System Description

AlreadyRegistered Severe Orchestration The URI/port is already registered by the Workday
activity.

CleanUpMessage Severe Orchestration Unable to process the request. Additional information
about the error can be found on the Web
Management Console.

ConnectFailed Severe Orchestration The workday operation failed because a connection to
the server could not be established.

ConnectRetry Warning Orchestration The workday operation failed while trying to connect
to the server. This will cause a retry.

DataMessageAccepted Info Orchestration SOAP message has been accepted by the Integration
Appliance.

MissingProtocol Warning Orchestration Please put the protocol used in fromt of input
parameter location.

NotRegistered Severe Orchestration The URI/port has not been registered by the Workday
activity.

OperationNameNull Severe Orchestration Operation name must not be null or empty.

TaskContextError Severe Orchestration Error occurred while processing Workday activity due
to lost task context.

TransportInfo Info Orchestration The provide activity is started on local transport for
the URI.

UriDeprecated Warning Orchestration Workday Module has deprecated the input parameter
httpheaders/uri. The specified value will be ignored.

WDFaultString Severe Orchestration The fault string returned by the Workday activity.

WorkdayException Severe Orchestration Error occurred while processing Workday activity.

Workday Connection Notifications
Provides a comprehensive list of connection notifications sent from the Workday Module.
Workday Operation Notifications
Provides a comprehensive list of operation notifications sent from the Workday Module.
Workday Internal Notifications
Provides a comprehensive list of internal notifications sent from the Workday Module.
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Workday Connection Notifications
Provides a comprehensive list of connection notifications sent from the Workday Module.

ConnectFailed
The workday operation failed because a connection to the server could not be established.
ConnectRetry
The workday operation failed while trying to connect to the server. This will cause a retry.
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ConnectFailed
The workday operation failed because a connection to the server could not be established.

Level : Severe

Log Message : Error sending SOAP request to location: {LocationName}. Error is: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24cConnectFailedEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.1

SNMP Trap Number : 2

Variables

The ConnectFailed message contains the following variables:

Table 1. ConnectFailed Message Variables
1. SerialNumber
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The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. LocationName

The specified location which was not being able to connect.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24cEv2LocationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.1.1.2.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Workday Connection Notifications
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ConnectRetry
The workday operation failed while trying to connect to the server. This will cause a retry.

Level : Warning

Log Message : Unable to send the SOAP request to {LocationName}. Error is: {Message}. Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will retry again in {IntervalForRetries} second(s).

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24cConnectRetryEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.1

SNMP Trap Number : 1

Variables

The ConnectRetry message contains the following variables:

Table 1. ConnectRetry Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration
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Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. LocationName

The specified location which was not being able to connect.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24cEv1LocationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.1.1.1.1

6. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

7. RetryAttemptNumber

The current number of retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24cEv1RetryAttemptNumber
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.1.1.1.3

8. TotalRetryAttempts

The specified number of attempts to connect to the server before stopping.

Type : Integer
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24cEv1TotalRetryAttempts
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.1.1.1.4

9. IntervalForRetries

The specified time interval between retries.

Type : Integer
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24cEv1IntervalForRetries
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.1.1.1.5

Parent topic: Workday Connection Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
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Workday Operation Notifications
Provides a comprehensive list of operation notifications sent from the Workday Module.

AlreadyRegistered
The URI/port is already registered by the Workday activity.
CleanUpMessage
Unable to process the request. Additional information about the error can be found on the Web
Management Console.
DataMessageAccepted
SOAP message has been accepted by the Integration Appliance.
MissingProtocol
Please put the protocol used in fromt of input parameter location.
NotRegistered
The URI/port has not been registered by the Workday activity.
OperationNameNull
Operation name must not be null or empty.
TransportInfo
The provide activity is started on local transport for the URI.
UriDeprecated
Workday Module has deprecated the input parameter httpheaders/uri. The specified value will be
ignored.
WDFaultString
The fault string returned by the Workday activity.
WorkdayException
Error occurred while processing Workday activity.

Parent topic: Workday Module

Feedback | Notices
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AlreadyRegistered
The URI/port is already registered by the Workday activity.

Level : Severe

Log Message : [URI: {Uri}, Port: {Port}, Operation Name: {OperationName}] Workday has already been registered.
Key: {RegistrationKey}
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System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oAlreadyRegisteredEv7

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2

SNMP Trap Number : 7

Variables

The AlreadyRegistered message contains the following variables:

Table 1. AlreadyRegistered Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Uri

The URI which is already registered.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv7Uri
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.7.1
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6. Port

The port which is already registered.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv7Port
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.7.2

7. OperationName

The operation name which was specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv7OperationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.7.3

8. RegistrationKey

Key used to identify this URI/Port/Operation

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv7RegistrationKey
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.7.4

Parent topic: Workday Operation Notifications
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CleanUpMessage
Unable to process the request. Additional information about the error can be found on the Web Management
Console.

Level : Severe

Log Message : Unable to process the request. Additional information about the error can be found on the Web
Management Console.

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oCleanUpMessageEv9

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2

SNMP Trap Number : 9
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Variables

The CleanUpMessage message contains the following variables:

Table 1. CleanUpMessage Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Workday Operation Notifications
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DataMessageAccepted
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SOAP message has been accepted by the Integration Appliance.

Level : Info

Log Message : SOAP message has been accepted by the Integration Appliance.

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oDataMessageAcceptedEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2

SNMP Trap Number : 1

Variables

The DataMessageAccepted message contains the following variables:

Table 1. DataMessageAccepted Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

Parent topic: Workday Operation Notifications
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MissingProtocol
Please put the protocol used in fromt of input parameter location.

Level : Warning

Log Message : Please put the protocol used (e.g. {Protocol}) in front of the input parameter location:
{LocationName}

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oMissingProtocolEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2

SNMP Trap Number : 5

Variables

The MissingProtocol message contains the following variables:

Table 1. MissingProtocol Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Protocol

The protocol value that can be specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv5Protocol
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.5.1

6. LocationName

The location name parameter before which protocol has to be specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv5LocationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.5.2
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NotRegistered
The URI/port has not been registered by the Workday activity.

Level : Severe

Log Message : [URI: {Uri}, Port: {Port}, Operation Name: {OperationName}] has not been registered. Key:
{KeyName}

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oNotRegisteredEv8

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2

SNMP Trap Number : 8

2270   



Variables

The NotRegistered message contains the following variables:

Table 1. NotRegistered Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Uri

The URI which is not registered.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv8Uri
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.8.1

6. Port

The port which is not registered.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv8Port
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.8.2
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7. OperationName

The operation name which was specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv8OperationName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.8.3

8. KeyName

The key name which was specified.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv8KeyName
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.8.4

Parent topic: Workday Operation Notifications
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OperationNameNull
Operation name must not be null or empty.

Level : Severe

Log Message : Operation name must not be null or empty!

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oOperationNameNullEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2

SNMP Trap Number : 2

Variables

The OperationNameNull message contains the following variables:

Table 1. OperationNameNull Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
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SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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TransportInfo
The provide activity is started on local transport for the URI.

Level : Info

Log Message : The provide activity is started on local transport for the URI: {URI}

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oTransportInfoEv10

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2
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SNMP Trap Number : 10

Variables

The TransportInfo message contains the following variables:

Table 1. TransportInfo Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. URI

URI at which provie activity was started.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv10URI
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.10.1

Parent topic: Workday Operation Notifications

Feedback | Notices
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UriDeprecated
Workday Module has deprecated the input parameter httpheaders/uri. The specified value will be ignored.

Level : Warning

Log Message : Workday Module has deprecated the input parameter "httpheaders/uri". The value: {Value} will be
ignored. Please set the URL (e.g. http://www.castiron.com/Workday) at the location in the endpoint panel or at
the input parameter "location".

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oUriDeprecatedEv6

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2

SNMP Trap Number : 6

Variables

The UriDeprecated message contains the following variables:

Table 1. UriDeprecated Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4
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4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Value

The value which will be ignored due to deprecated input parameter.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv6Value
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.6.1
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WDFaultString
The fault string returned by the Workday activity.

Level : Severe

Log Message : {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oWDFaultStringEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2

SNMP Trap Number : 3

Variables

The WDFaultString message contains the following variables:

Table 1. WDFaultString Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.
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Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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WorkdayException
Error occurred while processing Workday activity.
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Level : Severe

Log Message : Exception while processing Workday activity. Error message: {Message}. Caused by: {Cause}

System : Orchestration

SNMP Name : CASTIRON-COMP-WD-MIB::ciC24oWorkdayExceptionEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.2

SNMP Trap Number : 4

Variables

The WorkdayException message contains the following variables:

Table 1. WorkdayException Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
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SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

6. Cause

The cause of the error message.

Type : String
SNMP Object Name : CASTIRON-COMP-WD-MIB::ciC24oEv4Cause
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.24.1.2.1.4.2

Parent topic: Workday Operation Notifications

Feedback | Notices
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Workday Internal Notifications
Provides a comprehensive list of internal notifications sent from the Workday Module.

TaskContextError
Error occurred while processing Workday activity due to lost task context.

Parent topic: Workday Module
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_notifications_list.html

TaskContextError
Error occurred while processing Workday activity due to lost task context.

Level : Severe

Log Message : Exception while processing Workday activity. Error message: {Message}. The task context is lost.
The appliance may have been restarted, losing the task context that cannot be saved on the disk.

System : Orchestration
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SNMP Name : CASTIRON-COMP-WD-MIB::ciC24iTaskContextErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.24.1.3

SNMP Trap Number : 1

Variables

The TaskContextError message contains the following variables:

Table 1. TaskContextError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: Workday Internal Notifications
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XML Module
The XML Module provides activities for generating and parsing XML content. This section contains details for
the messages delivered from the XML Module.

This topic provides the MIB Name and MIB OID information, in addition to high-level details about each
notification in the XML Module.

MIB Name : CASTIRON-COMP-XML-MIB

MIB OID : .1.3.6.1.4.1.13336.2.2.3.12

The following table provides an alphabetical list of all notifications that can be issued by the XML Module.

Table 1. Notifications issued by the XML Module
Notification Level System Description

TransformError Severe Orchestration There was an error while transforming the XML.

ValidateInitialize Severe Orchestration There was an error while initializing the validate
activity.

XMLParseError Severe Orchestration There was an error while parsing the XML.

XMLQueryError Severe Orchestration There was an error while querying the XML.

XMLSerializeError Severe Orchestration There was an error while serializing the XML.

XML Operation Notifications
Provides a comprehensive list of operation notifications sent from the XML Module.

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/xml/about_the_
xml_module.html

XML Operation Notifications
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Provides a comprehensive list of operation notifications sent from the XML Module.

TransformError
There was an error while transforming the XML.
ValidateInitialize
There was an error while initializing the validate activity.
XMLParseError
There was an error while parsing the XML.
XMLQueryError
There was an error while querying the XML.
XMLSerializeError
There was an error while serializing the XML.

Parent topic: XML Module

Feedback | Notices
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file:///dcs/markdown/workspace/Transform/out.html
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ion_notifications_list.html

TransformError
There was an error while transforming the XML.

Level : Severe

Log Message : Failed to transform XML, error was: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-XML-MIB::ciC12oTransformErrorEv4

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.12.1.2

SNMP Trap Number : 4

Variables

The TransformError message contains the following variables:

Table 1. TransformError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3
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2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: XML Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html
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ValidateInitialize
There was an error while initializing the validate activity.

Level : Severe

Log Message : Failed to initialize the Xml Validate Activity: {Message}
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System : Orchestration

SNMP Name : CASTIRON-COMP-XML-MIB::ciC12oValidateInitializeEv5

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.12.1.2

SNMP Trap Number : 5

Variables

The ValidateInitialize message contains the following variables:

Table 1. ValidateInitialize Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2
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XMLParseError
There was an error while parsing the XML.

Level : Severe

Log Message : Failed to parse XML, error was: {ErrorMessage}

System : Orchestration

SNMP Name : CASTIRON-COMP-XML-MIB::ciC12oXMLParseErrorEv1

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.12.1.2

SNMP Trap Number : 1

Variables

The XMLParseError message contains the following variables:

Table 1. XMLParseError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.
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Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. ErrorMessage

The error message returned while parsing the XML.

Type : String
SNMP Object Name : CASTIRON-COMP-XML-MIB::ciC12oEv1ErrorMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.3.12.1.2.1.1.1

Parent topic: XML Operation Notifications

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/xml/xml_operat
ion_xmlparseerror_message.html

XMLQueryError
There was an error while querying the XML.

Level : Severe

Log Message : Failed to query XML, error was: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-XML-MIB::ciC12oXMLQueryErrorEv2

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.12.1.2

SNMP Trap Number : 2

Variables

The XMLQueryError message contains the following variables:

Table 1. XMLQueryError Message Variables
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1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: XML Operation Notifications

Feedback | Notices
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ion_xmlqueryerror_message.html
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XMLSerializeError
There was an error while serializing the XML.

Level : Severe

Log Message : Failed to serialize XML, error was: {Message}

System : Orchestration

SNMP Name : CASTIRON-COMP-XML-MIB::ciC12oXMLSerializeErrorEv3

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.3.12.1.2

SNMP Trap Number : 3

Variables

The XMLSerializeError message contains the following variables:

Table 1. XMLSerializeError Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1

3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3
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5. Message

Textual description of the error.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : .1.3.6.1.4.1.13336.2.2.1.2.2

Parent topic: XML Operation Notifications
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Uncategorized Notifications
This topic provides details about messages that have not formally been categorized in an existing module.

These notifications are used for events which have not yet been assigned their own OID. Use the information
specified in the Message variable to identify individual notifications.

SNMP Name : CASTIRON-IA-MIB::ciIaUncategorizedEv

SNMP Enterprise : .1.3.6.1.4.1.13336.2.2.2.1.1.10

SNMP Trap Number : 1

Variables

The uncategorized message contains the following variables:

Table 1. Uncategorized Message Variables
1. SerialNumber

The serial number of the appliance sending the trap.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaPlatSerialNumber
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.3.3

2. Severity

Severity of the Notification.

Type : Integer
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvSeverity
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.1
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3. JobID

The ID of the job being run when an error occurred. If the error is unrelated to a specific job, this field is
blank.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvJobID
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.4

4. Orchestration

Reference to an entry in the Orchestration table containing information about the orchestration associated
with this event.

Type : OID
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvOrchestration
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.3

5. Message

Textual description of the error. See the table below for a list of descriptions.

Type : String
SNMP Object Name : CASTIRON-REGISTRATIONS-MIB::ciEvMessage
SNMP OID : 1.3.6.1.4.1.13336.2.2.1.2.2

6. LoggerName

Name of the logger used to send the notification. See table below.

Type : String
SNMP Object Name : CASTIRON-IA-MIB::ciIaEvLoggerName
SNMP OID : 1.3.6.1.4.1.13336.2.2.2.1.1.10.1.1

Uncategorized Messages

This table lists the most commonly encountered uncategorized notifications. When one of these notifications is
categorized, a replacement value is provided and the message remains in the uncategorized messages list for
reference purposes.

Table 2. Uncategorized Messages
Severity System LoggerName Message Replacement

Severe Orchestr
ation

com.approuter
.module.platfo
rm

Fan is not functional. Fan: {0} Current Speed: {1} rpm
Min Required Speed: {2} rpm Max Allowed Speed: {3}
rpm Machine ID: {4}

FanFailed

Info Orchestr
ation

com.approuter
.module.platfo
rm

Fan is functional. Fan: {0} Current Speed: {1} rpm Min
Required Speed: {2} rpm Max Allowed Speed: {3} rpm
Machine ID: {4}

FanRestored

Severe Orchestr
ation

com.approuter
.module.platfo
rm

Temperature is out of range. Temperature sensor: {0}
Current temperature: {1} degrees C Minimum: {2}
degrees C Maximum: {3} degrees C Machine ID: {4}

TemperatureO
utOfRange
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Severity System LoggerName Message Replacement

Info Orchestr
ation

com.approuter
.module.platfo
rm

Temperature is restored. Temperature sensor: {0}
Current temperature: {1} degrees C Minimum: {2}
degrees C Maximum: {3} degrees C Machine ID: {4}

TemperatureR
estored

Warning Orchestr
ation

com.approuter
.module.platfo
rm

Power has been interrupted. Machine ID: {1} PowerInterrup
ted

Info Orchestr
ation

com.approuter
.module.platfo
rm

Power has been restored. Machine ID: {1} PowerRestore
d

Warning Orchestr
ation

com.approuter
.module.platfo
rm

The Integration Appliance {0} has been opened.
Machine ID: {1}

IntrusionInfor
m

Severe Orchestr
ation

com.approuter
.module.platfo
rm

RAID Array {0} is offline. Machine ID: {1} RaidArrayOffli
ne

Severe Orchestr
ation

com.approuter
.module.platfo
rm

RAID Array {0} is degraded, probably because of a
disk failure. Machine ID: {1}

RaidArrayDegr
aded

Info Orchestr
ation

com.approuter
.module.platfo
rm

RAID Array {0} is optimal. Machine ID: {1} RaidArrayOpti
mal

Severe Orchestr
ation

com.approuter
.module.platfo
rm

RAID Disk {0} on array {1} has failed. Machine ID: {2} RaidDiskFailed

Info Orchestr
ation

com.approuter
.module.platfo
rm

RAID disk {0} on array {1} is rebuilding. Do not remove
the disk until the rebuild is completed. Machine ID:
{2}

RaidDiskRebui
lding

Info Orchestr
ation

com.approuter
.module.platfo
rm

RAID disk {0} on array {1} is online. Machine ID: {2} RaidDiskOnlin
e

Info Orchestr
ation

com.approuter
.module.platfo
rm

High Availability System Failover successful. HighAvailFailo
ver

Info Orchestr
ation

com.approuter
.module.platfo
rm

Network Interface Link Up. Network Interface {0} is
now up Machine ID: {1}

NetworkLinkU
p

Warning Orchestr
ation

com.approuter
.module.platfo
rm

Network Interface Link Down. Network Interface {0}
is now down Machine ID: {1}

NetworkLinkD
own

Warning Orchestr
ation

com.approuter
.module.platfo
rm

Automatically added hostname to /etc/hosts, see
"net show etchost".

NetworkAutoh
ost
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Severity System LoggerName Message Replacement

Warning Orchestr
ation

com.approuter
.module.platfo
rm

Could not add route to {0} on {1} NetworkInvali
dRoute

Info Orchestr
ation

com.approuter
.module.platfo
rm

Swap space usage is now below the {0}% warning
threshold - current usage is {1}.{2}%

SwapUsageWa
rnOk

Info Orchestr
ation

com.approuter
.module.platfo
rm

Swap space usage is now below the {0}% critical
threshold - current usage is {1}.{2}%

SwapUsageCri
tOk

Warning Orchestr
ation

com.approuter
.module.platfo
rm

Swap space usage has exceeded the {0}% warning
threshold - current usage is {1}.{2}%

SwapUsageWa
rning

Severe Orchestr
ation

com.approuter
.module.platfo
rm

Swap space usage has exceeded the {0}% critical
threshold - current usage is {1}.{2}%

SwapUsageCri
tical

Info Orchestr
ation

com.approuter
.module.platfo
rm

{0} disk space usage is now below the {1}% warning
threshold - current usage is {2}.{3}%

DiskUsageWar
nOk

Info Orchestr
ation

com.approuter
.module.platfo
rm

{0} disk space usage is now below the {1}% critical
threshold - current usage is {2}.{3}%

DiskUsageCrit
Ok

Warning Orchestr
ation

com.approuter
.module.platfo
rm

{0} disk space usage has exceeded the {1}% warning
threshold - current usage is {2}.{3}%

DiskUsageWar
ning

Severe Orchestr
ation

com.approuter
.module.platfo
rm

{0} disk space usage has exceeded the {1}% critical
threshold - current usage is {2}.{3}%

DiskUsageCriti
cal

Info Orchestr
ation

com.approuter
.module.platfo
rm

Job log purge triggered. Available disk space is {0}%.
Specified trigger is {1}%.

OrcmonDiskTri
gger

Info Orchestr
ation

com.approuter
.module.platfo
rm

Job log purge triggered. Exceeded maxmimum
duration since last purge.

OrcmonPurge
ByTimeNP

Info Orchestr
ation

com.approuter
.module.platfo
rm

Job log purge triggered. Time since last purge
exceeded {0}.

OrcmonPurge
ByTime

Info Orchestr
ation

com.approuter
.module.platfo
rm

Job log purge triggered. There are {0} completed jobs.
Completed jobs threshold is {1}.

OrcmonPurge
ByCompl

Info Orchestr
ation

com.approuter
.module.platfo
rm

Job log purge triggered. There are {0} errored jobs.
Errored jobs threshold is {1}.

OrcmonPurge
ByErrored
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Severity System LoggerName Message Replacement

Info Orchestr
ation

com.approuter
.module.platfo
rm

Job log purged {0} jobs. OrcmonExport
edJobs

Info Orchestr
ation

com.approuter
.module.platfo
rm

Exporting job log data to local archive file "{0}". OrcmonExport
Local

Info Orchestr
ation

com.approuter
.module.platfo
rm

Exporting archive file to FTP server {0}:{1}. Placing file
"{2}" in directory "{3}".

OrcmonExport
FTP

Severe Orchestr
ation

com.approuter
.module.platfo
rm

Failure uploading archive file to FTP server: Could not
cd to directory "{0}".

OrcmonExport
CdError

Severe Orchestr
ation

com.approuter
.module.platfo
rm

Failure uploading archive file to FTP server: Could not
store file.

OrcmonExport
StoreErr

Severe Orchestr
ation

com.approuter
.module.platfo
rm

Failure uploading archive file to FTP server: {0} OrcmonExport
Error

Warning Orchestr
ation

com.approuter
.module.platfo
rm

Job log purge triggered. Available disk space is {0}%.
Specified trigger is {1}%. Purging using properties
failed to clear enough disk space. Purging half of all
job logs in attempt to recover disk space.

OrcmonDiskFu
ll

Severe Orchestr
ation

com.approuter
.module.platfo
rm

Failed to purge any job logs to recover disk space.
Available disk space is {0}%.

OrcmonDiskFu
llNoPurge

Severe Orchestr
ation

com.approuter
.module.platfo
rm

Job log purge/archive failed: {0}. OrcmonPurgeF
ailed

Severe Orchestr
ation

com.approuter
.module.platfo
rm

An error occurred while archiving job logs. The error
message is: {0}

OrcmonArchiv
eError

Severe Orchestr
ation

com.approuter
.module.platfo
rm

An error occurred while executing a query on the job
log database. The error message is: {0}

OrcmonDatab
aseError

Severe Orchestr
ation

com.approuter
.module.platfo
rm

Authentication failure for user {0}, from host {1}. AuthFailure

Info Orchestr
ation

com.approuter
.module.platfo
rm

Access Violation by user: {0}. Target: {1}. Action
Performed: {2}.

AccessViolatio
n

Info Orchestr
ation

com.approuter
.module.platfo
rm

Authentication success for user {0}, from host {1} with
session id {2}.

AuthSuccess
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Severity System LoggerName Message Replacement

Info Orchestr
ation

com.approuter
.module.platfo
rm

New User {0} has been created with id {1}. UserCreated

Info Orchestr
ation

com.approuter
.module.platfo
rm

User {0} has been deleted. UserDeleted

Info Orchestr
ation

com.approuter
.module.platfo
rm

New Group {0} has been created with id {1}. GroupCreated

Info Orchestr
ation

com.approuter
.module.platfo
rm

Group {0} has been deleted. GroupDeleted

Info Orchestr
ation

com.approuter
.module.platfo
rm

User {0} has been revoked of the role {1}. RevokeRole

Info Orchestr
ation

com.approuter
.module.platfo
rm

User {0} has been granted role of {1}. GrantRole

Info Orchestr
ation

com.approuter
.module.platfo
rm

User {0} displayName has been changed from {1} to
{2}.

UpdateUser

Info Orchestr
ation

com.approuter
.module.platfo
rm

User {0} status has been changed from {1} to {2}. UpdateStatus

Info Orchestr
ation

com.approuter
.module.platfo
rm

User {0} with session id {1} logged out successfully. AuthLogOut

Feedback | Notices

 Last updated: Thursday, November 14, 2013
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.notifications_reference.doc/uncategorized_
messages.html

Log Message Reference
Alphabetized list of all log messages, with links to the details.
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Message Mo
dul
e

L
e
v
e
l

Notific
ation

A connection error occurred while sending the receive activity response. Exception:
{Message}

HT
TP

S
e
v
e
r
e

Receiv
eSend
ReplyE
rror

A connection error occurred while sending the response. Error is {Message} HT
TP

S
e
v
e
r
e

ReplyC
onnect
ionErr
or

A general error occurred while sending the response. Exception: {Message} HT
TP

S
e
v
e
r
e

ReplyG
eneral
Error

A select statement was issued to control table {TableName} to check for duplicate rows. Dat
aba
se

I
n
f
o

Select
State
ment

About to execute function {FunctionName} SA
P

I
n
f
o

StartF
unctio
nExec

Access Violation by user: {Username}. Target: {Target}. Action Performed: {Action}. Pla
tfor
m

I
n
f
o

Access
Violati
on

Activation of Get SAML 2.0 token failed STS S
e
v
e
r
e

Activat
ionFail
ed

Activity could not be converted into TwoPhase activity Ma
est
ro

S
e
v
e
r
e

ErrorT
woPha
se
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Activity could not get activated. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Activat
eError

Activity expected string data (MQFMT_STRING), but the message is of format "{Format}". We
bS
phe
re
MQ

W
a
r
n
i
n
g

Format
Warnin
g

Activity failed as data to get is larger than activity can handle. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

LargeD
ataErr
or

Activity {ActivityName} activated successfully JD
Ed
war
ds

I
n
f
o

Activat
eSucc
essful

Activity {ActivityName} activated successfully Peo
ple
Sof
t

I
n
f
o

Activat
eSucc
ess

Activity {ActivityName} activated successfully. Do
min
o

I
n
f
o

Activat
eSucc
ess

Activity {ActivityName} could not find any record Peo
ple
Sof
t

I
n
f
o

GetNo
Return

Activity {ActivityName} is stopped successfully. Do
min
o

I
n
f
o

StopSu
ccess
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Activity {ActivityName} not started as {Name} is blank Peo
ple
Sof
t

S
e
v
e
r
e

Activat
eFailur
eBlank

ActivityFactory (name - {ActivityName}, version - {ActivityVersion}) not registered Ma
est
ro

S
e
v
e
r
e

NoActi
vityFac
tory

ActivityFactory (name - {ActivityName},version - {ActivityVersion}) has multiple
registrations, not loading

Ma
est
ro

S
e
v
e
r
e

Multipl
eActFa
ctory

ActivityFactory (name - {ActivityName},version - {ActivityVersion}) returned wrong class
{ActivityClass}

Ma
est
ro

S
e
v
e
r
e

Wrong
ActFac
tory

Adding Connection Pool with name {PoolName} SA
P

I
n
f
o

PoolAd
dInfo

Adding Server Gateway {GatewayName}. SA
P

I
n
f
o

Adding
Server
Info

Additional property {PropertyName} set to {PropertyValue} so setup connection pool. Em
ail

I
n
f
o

NewCo
nnectE
veryti
me

An I/O error occurred while processing the request. Exception: {Message} HT
TP

S
e
v
e
r
e

Receiv
eIOErr
or
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

An error occurred handling a receive request. Exception: {Message} HT
TP

S
e
v
e
r
e

Comm
onHan
dlerErr
or

An error occurred while archiving job logs. The error message is: {Message} Pla
tfor
m

S
e
v
e
r
e

Orcmo
nArchi
veErro
r

An error occurred while closing the connection in the exception path. The exception is
{Message}

Dat
aba
se

W
a
r
n
i
n
g

JDBCC
onnect
ionClo
se

An error occurred while connecting to the database. The exception is {Message} Dat
aba
se

W
a
r
n
i
n
g

Conne
ctionEr
ror

An error occurred while connecting to the database. The exception is {Message} The job is
retrying: {RetryAttemptNumber} out of {TotalRetryAttempts} attempts to connect to the
database . Another attempt will be made after {IntervalForRetries} secs.

Dat
aba
se

W
a
r
n
i
n
g

Conne
ctionR
etry

An error occurred while executing a query on the job log database. The error message is:
{Message}

Pla
tfor
m

S
e
v
e
r
e

Orcmo
nData
baseEr
ror
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

An error occurred while processing the message for the parameterized query activity at row
number {RowNumber}. The error is: {Message}

Dat
aba
se

S
e
v
e
r
e

Param
Query
Error

An error occurred while processing the request. Exception: {Message} HT
TP

S
e
v
e
r
e

Receiv
eInter
nalErr
or

An error occurred while reading headers. Exception: {Message} HT
TP

S
e
v
e
r
e

ReplyU
nMars
halHea
der

An error occurred while setting the key store. Exception: {Message} HT
TP

S
e
v
e
r
e

Regist
erKeyS
tore

An error occurred while trying to execute activity {ActivityName}. Error is: {Message} Do
min
o

S
e
v
e
r
e

Activit
yFailur
e

An error occurred while trying to process an unsupported Accept-Charset encoding.
Exception: {Message}

HT
TP

S
e
v
e
r
e

Receiv
eOper
ationEr
ror

An exception occurred while activating the activity. The exception is :{Message} HT
TP

S
e
v
e
r
e

Reque
stActiv
ate
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

An exception occurred while activating the parameterized query activity. The exception is:
{Message}

Dat
aba
se

S
e
v
e
r
e

Param
Query
Activat
e

An exception occurred while activating the stored procedure activity. The exception is:
{Message}

Dat
aba
se

S
e
v
e
r
e

Stored
ProcAc
tivate

An exception occurred while deleting the row from the control table. The exception is
{Message}

Dat
aba
se

S
e
v
e
r
e

ErrorD
eleteP
ost

An exception occurred while deleting the row from the control table. The exception is:
{Message}

Dat
aba
se

S
e
v
e
r
e

Delete
RowsE
rror

An exception occurred while processing a SingleTableNotification job. Data error at row
number {RowNumber} of table {TableName}. The Error is {Message}

Dat
aba
se

S
e
v
e
r
e

ErrorSi
ngleTa
bleJob

An exception occurred while processing an outbound job in the stored procedure activity.
Data error at row number: {RowNumber}. The error is {Message}

Dat
aba
se

S
e
v
e
r
e

Stored
ProcEx
ceptio
n

An exception occurred while processing the inbound job: {Message} Dat
aba
se

S
e
v
e
r
e

Inbou
ndOpe
rationE
rror
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

An insert statement was issued to the control table. {TableName} Dat
aba
se

I
n
f
o

InsertT
ableSt
ateme
nt

An internal error occurred: {Message}. We
bS
phe
re
MQ

S
e
v
e
r
e

Intern
alFailu
re

An unexpected result returned from the buffer table. Expecting rows to be present in the
result, instead the result is empty.

Dat
aba
se

W
a
r
n
i
n
g

Unexp
ectedE
mptyR
ows

An unknown exception occurred while sending the response to the client. Exception:
{Message}

HT
TP

S
e
v
e
r
e

ReplyU
nknow
nError

Append data to file "{FileName}" completed with return code {ResponseCode}. FT
P

I
n
f
o

Appen
dAfter

Appending data to file "{FileName}". FT
P

I
n
f
o

Appen
dBefor
e

Archiver created successfully, now performing archiving. Arc
hiv
e

I
n
f
o

Archiv
erCrea
ted

Archiving done successfully. Arc
hiv
e

I
n
f
o

Archiv
eDone
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Attempt to upgrade Cast Iron firmware on appliance {AffectedAppliance} from version
{OldVersion} to version {NewVersion} failed: {Message}.

Pla
tfor
m

S
e
v
e
r
e

Upgra
deFail
ed

Authentication failure for user {Username}, from host {Host}. Pla
tfor
m

S
e
v
e
r
e

AuthFa
ilure

Authentication success for user {UserName}, from host {Host} with session id {SessionId}. Pla
tfor
m

I
n
f
o

AuthS
uccess

Automatically added entry to /etc/hosts with hostname {Hostname} and IP address
{IPAddress}.

Pla
tfor
m

W
a
r
n
i
n
g

Netwo
rkAuto
host

Automatically converting old style FTP filename pattern from "{OldStylePattern}" to "
{NewStylePattern}". Please republish project from Studio verison 3.6 or later to eliminate
this warning.

FT
P

W
a
r
n
i
n
g

FtpPat
ternCo
nversi
on

Binding parameters supplied are invalid. Arc
hiv
e

S
e
v
e
r
e

Incorr
ectPar
ameter
s

Boundary attribute not set in input parameter 'mimeheader'. Input body being set as
entityBody in first entity of 'parts' output parameter.

MI
ME

I
n
f
o

Bound
aryAbs
ent
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Boundary delimiters longer than 70 characters. Ignoring the specified boundary value.
Using auto-generated boundary.

MI
ME

W
a
r
n
i
n
g

Bound
aryMor
eThan
70

Boundary is: \"{Boundary}\". MI
ME

I
n
f
o

Bound
aryInf
o

Boundary specified in header but no boundary found in the body. Returning single body. MI
ME

W
a
r
n
i
n
g

NoBou
ndaryF
ound

Call context created but task never started; destroying task {TaskID} Ma
est
ro

I
n
f
o

CallCo
ntextD
estroy

Call to function {FunctionName} is complete SA
P

I
n
f
o

Compl
eteFun
ctionE
xec

Cancel of job {JobID} of Orchestration {OrchName} failed: {Message}. Ma
est
ro

S
e
v
e
r
e

Loader
Cancel

Cannot complete this job due to low memory, please try redeploying this orchestration Ma
est
ro

S
e
v
e
r
e

LargeT
otalVar
Size

Cannot start an orchestration that is in transient state: {State} Ma
est
ro

S
e
v
e
r
e

Progra
mStart
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Caught exception while canceling job: {Message} Ma
est
ro

W
a
r
n
i
n
g

TaskCa
ncelle
d

Changed directory to "{DirectoryName}" completed with return code {ResponseCode}. FT
P

I
n
f
o

DirCha
ngeAft
er

Changing to directory "{DirectoryName}". FT
P

I
n
f
o

DirCha
ngeBef
ore

Committing TID {TID}. SA
P

I
n
f
o

TIDCo
mmitti
ngInfo

Completed activity and spewed out sessionInfo and {NameOfOutputParam} output
parameter.

Sal
esf
orc
e.c
om

I
n
f
o

Activit
yOutp
ut

Completed activity and spewed out sessionInfo output parameter and {NumberOfObjects}
objects in output parameter {NameOfOutputParam}.

Sal
esf
orc
e.c
om

I
n
f
o

Param
eterOu
tput

Completed activity and spewed out sessionInfo output parameter and {NumberOfResults}
result objects in output parameter {NameOfOutputParam}.

Sal
esf
orc
e.c
om

I
n
f
o

Param
eterRe
sults

Composite media type {MediaType} cannot have any other Content-Transfer-Encoding apart
from 7bit, 8bit or binary.

MI
ME

S
e
v
e
r
e

Transf
erEnco
dingEr
ror
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Config Parameters: From: \"{From}\", To: \"{To}\", CC: \"{CC}\", BCC: \"{BCC}\", Subject: \"
{Subject}\".

Em
ail

I
n
f
o

SmtpC
onfigP
arams

Config parameters: From Pattern: \"{FromPattern}\", Subject Pattern: \"{SubjectPattern}\". Em
ail

I
n
f
o

Pop3C
onfigP
arams

Connected to the POP3 server. Em
ail

I
n
f
o

Pop3C
onnect
ed

Connected to the SMTP server. Em
ail

I
n
f
o

SmtpC
onnect
ed

Connection Pool {PoolName} already exists, Using existing definition. SA
P

I
n
f
o

PoolEx
istInfo

Connection error while executing activity {ActivityName}. The error is: {Message}. Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will try again in {IntervalForRetries}
second(s)

JD
Ed
war
ds

W
a
r
n
i
n
g

JDERe
tryErro
r

Connection error while executing activity {ActivityName}. The error is: {Message}. Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will try again in {IntervalForRetries}
second(s)

Peo
ple
Sof
t

W
a
r
n
i
n
g

Conne
ctionR
etry

Connection exception in the subscriber. The exception is {Message}. Going to restart the
subscriber after the {IntervalForRestart} secs

JM
S

S
e
v
e
r
e

Subscr
iberCo
nnect
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Connection exception while getting message from the provider. The error code is
{ErrorCode} and message is {ErrorMessage}. The job is retrying {RetryAttemptNumber}, out
of {TotalRetryAttempts} attempts to connect to JMS provider. The next attempt will be after
{IntervalForRetries} seconds.

JM
S

W
a
r
n
i
n
g

GetCo
nnectR
etry

Connection exception while polling message. The exception is {Message}. The job is retrying
{RetryAttemptNumber} out of {TotalRetryAttempts} attempt to connect to JMS provider. The
next attempt will be after {IntervalForRetries} secs.

JM
S

W
a
r
n
i
n
g

PollMe
ssageR
etry

Connection exception while sending message. The error code is {ErrorCode} and exception
is {ErrorMessage}. The job is retrying {RetryAttemptNumber} out of {TotalRetryAttempts}
attempt to connect to JMS provider. The next attempt will be after {IntervalForRetries} secs.

JM
S

W
a
r
n
i
n
g

SendC
onnect
Rerty

Connection handler retrieved from the call context is Null! HT
TP

S
e
v
e
r
e

ReplyH
andler
Null

Content-Encoding header received: {ContentEncodingHeader} HT
TP

I
n
f
o

Incomi
ngCont
entEnc

Content-Transfer-Encoding value for attachment {AttachmentNumber} is {EncodingValue}
while the attachment body has lines greater than 998 characters in length. Changing the
Content-Transfer-Encoding to binary.

MI
ME

W
a
r
n
i
n
g

Tranfe
rEncCh
anged
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Content-Transfer-Encoding value missing for attachment number {AttachmentNumber}.
Guessing based on Content-Type and charset values.

MI
ME

W
a
r
n
i
n
g

Transf
erEnc
Missin
g

Content-type not found. Taking default Content-Type as text/plain. MI
ME

I
n
f
o

Defaul
tConte
ntType

Could not add route to {DestinationIP} on {LinkName}. Pla
tfor
m

W
a
r
n
i
n
g

Netwo
rkInval
idRout
e

Could not clean up object with ID {ObjectID}, will try later Ma
est
ro

W
a
r
n
i
n
g

Delete
Object

Could not close output stream Ma
est
ro

W
a
r
n
i
n
g

CloseO
utputS
tream

Could not close reader Ma
est
ro

W
a
r
n
i
n
g

CloseI
nputSt
ream
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Could not close reader Ma
est
ro

W
a
r
n
i
n
g

CloseR
eader

Could not close writer Ma
est
ro

W
a
r
n
i
n
g

Close
Writer

Could not delete file "{FileName}" after processing. Error is {Message} FT
P

W
a
r
n
i
n
g

Unable
ToDele
te

Could not execute query to preload lookup cache Dat
a
Qu
alit
y

W
a
r
n
i
n
g

BadPr
eloadQ
uery

Could not find an Archiver for supplied archive type: {FormatName} Arc
hiv
e

S
e
v
e
r
e

Invalid
Archiv
eForm
at

Could not find an entry point for the activity: [{ActivityName}] in the compiled orchestration Ma
est
ro

S
e
v
e
r
e

EntryP
ath
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Could not get data for date range, because id limit exceeded Sal
esf
orc
e.c
om

S
e
v
e
r
e

LargeD
ata

Could not initialize FaultInfo Ma
est
ro

S
e
v
e
r
e

FaultIn
fo

Could not initialize JobInfo Ma
est
ro

S
e
v
e
r
e

Initiali
zeJobI
nfo

Could not log monitor events Ma
est
ro

S
e
v
e
r
e

Montio
rEvent
s

Could not log monitor variable "{VariableName}" Ma
est
ro

W
a
r
n
i
n
g

Monito
rVariab
le

Could not log monitor variables Ma
est
ro

W
a
r
n
i
n
g

Monito
rVariab
les
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Could not move file "{FileName}" after processing. Error is {Message} FT
P

W
a
r
n
i
n
g

Unable
ToMov
e

Could not perform input map expression: {ExpressionName} Ma
est
ro

S
e
v
e
r
e

Input
MapXP
ath

Could not perform input map transform: {Message} Ma
est
ro

S
e
v
e
r
e

Input
MapXS
LT

Could not perform output map expression: {Message} Ma
est
ro

S
e
v
e
r
e

Output
MapXP
ath

Could not perform output map transform: {Message} Ma
est
ro

S
e
v
e
r
e

Output
MapXS
LT

Could not perform output map: {Message} Ma
est
ro

S
e
v
e
r
e

Output
Map

Could not query for monitor data Ma
est
ro

S
e
v
e
r
e

Monito
rQuery

2310   



Message Mo
dul
e

L
e
v
e
l

Notific
ation

Could not read the module configuration: {Message} Ma
est
ro

S
e
v
e
r
e

Modul
eConfi
g

Could not receive socket reply Ma
est
ro

W
a
r
n
i
n
g

Socket
NoRep
ly

Could not register {ObjectName} with mbean server Ma
est
ro

S
e
v
e
r
e

MBean
Regist
er

Could not suspend, orchestration not running: {OrchName} Ma
est
ro

S
e
v
e
r
e

NotSu
spend

Could not undeploy, orchestration not stopped, state is {State}: {OrchName} Ma
est
ro

S
e
v
e
r
e

NotSto
pped

Could not unregister {ObjectName} with mbean server Ma
est
ro

S
e
v
e
r
e

MBean
Unregi
ster

Created a new TID {TID} for starting a transaction in send IDOC activity. SA
P

I
n
f
o

SendI
DOCCr
eateIn
fo
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Creating a new TID {TID} in the TID Manager. SA
P

I
n
f
o

Create
TID

Current time {CurrentTime} is less than 1 minute past last polling time {LastPollingTime}.
Skipping this polling interval.

Sal
esf
orc
e.c
om

I
n
f
o

ShortP
oll

Data Error: {Message}. Em
ail

S
e
v
e
r
e

Pop3D
ataErr
or

Data Error: {Message}. Em
ail

S
e
v
e
r
e

SmtpD
ataErr
or

Data Quality Lookup activity with Fuzzy option is not supported in cloud Dat
a
Qu
alit
y

S
e
v
e
r
e

DQLoo
kupFu
zzyOn
Cloud

Data being set for field named {FieldName} has length {DataLength}, where as field has
length {FieldLength}. There may be loss of data.

Peo
ple
Sof
t

W
a
r
n
i
n
g

DataLe
ngthM
ore

Data error while executing the activity. The error is: {Message} Sie
bel

S
e
v
e
r
e

DataEx
ceptio
n
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Debugger operation {Value} failed Ma
est
ro

S
e
v
e
r
e

Debug
Failed

Decryption Done. Cry
pto
Ser
vic
e

I
n
f
o

Decryp
tDone

Decryption Started. Cry
pto
Ser
vic
e

I
n
f
o

Decryp
tStarte
d

Delete failed for item {ItemNumber}. Returning false Peo
ple
Sof
t

W
a
r
n
i
n
g

Delete
Fail

Delete file summary - Directory: {DirName}, Filename: {FileName} FT
P

I
n
f
o

Delete
InfoSu
mmary

Delete of Orchestration {OrchName} failed: {Message}. Ma
est
ro

S
e
v
e
r
e

Loader
Delete

Deleted file "{FileName}" on server with return code {ResponseCode}. FT
P

I
n
f
o

Delete
After

Deleting file "{FileName}" on server. FT
P

I
n
f
o

Delete
Before
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Deploy of Orchestration {OrchName} failed: {Message}. Ma
est
ro

S
e
v
e
r
e

Loader
Deploy

Disk space usage on {Disk} has exceeded the {Threshold}% critical threshold - current usage
is {Usage}%

Pla
tfor
m

S
e
v
e
r
e

DiskUs
ageCrit
ical

Disk space usage on {Disk} has exceeded the {Threshold}% warning threshold - current
usage is {Usage}%

Pla
tfor
m

W
a
r
n
i
n
g

DiskUs
ageWa
rning

Disk space usage on {Disk} is now below the {Threshold}% critical threshold - current usage
is {Usage}%

Pla
tfor
m

I
n
f
o

DiskUs
ageCrit
Ok

Disk space usage on {Disk} is now below the {Threshold}% warning threshold - current
usage is {Usage}%

Pla
tfor
m

I
n
f
o

DiskUs
ageWa
rnOk

Downloaded file "{FileName}" from server with return code {ResponseCode}. FT
P

I
n
f
o

GetAft
er

Downloading file "{FileName}" from server. FT
P

I
n
f
o

GetBef
ore

Duplicate list is at capacity, removing file "{FileName}" from duplicate list. FT
P

I
n
f
o

Delete
DupLIs
tEntry
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Duplicate message found, discarding. We
bS
phe
re
MQ

I
n
f
o

Duplic
ateFou
nd

Email id is invalid: {EmailID}. Em
ail

W
a
r
n
i
n
g

Invalid
EmailI
D

Email sent to server. Em
ail

I
n
f
o

EmailS
ent

Emitted {NumberOfEntries} entries to ''{Target}'' Dat
a
Qu
alit
y

I
n
f
o

Output
EntryC
ount

Empty input parameter 'mimeheader'. Cannot parse data. MI
ME

S
e
v
e
r
e

Heade
rAbsen
t

Empty input parameter 'parts'. No data to serialize. MI
ME

S
e
v
e
r
e

Empty
Parts

Encoding parameter not set and no value specified in configuration Dat
a

S
e
v
e
r
e

Missin
gEncP
arse
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Encoding parameter not set and no value specified in configuration Dat
a

S
e
v
e
r
e

Missin
gEncS
erialize

Encoding parameter not supported: {Encoding} Dat
a

S
e
v
e
r
e

BadEn
coding

Encountered fault of type {FaultType}, please see rest of the log for more information Ma
est
ro

S
e
v
e
r
e

Activit
yFailed
Error

Encryption Done Cry
pto
Ser
vic
e

I
n
f
o

Encryp
tDone

Encryption Started. Cry
pto
Ser
vic
e

I
n
f
o

Encryp
tStarte
d

End time {StartTime} is less than 1 minute past start time {EndTime}. Setting interval to 1
minute and getting data.

Sal
esf
orc
e.c
om

I
n
f
o

TimeT
ooClos
e

Ended job for orchestration "{OrchName}" Ma
est
ro

I
n
f
o

TaskEn
d

Endpoint Parameters: Host: \"{HostName}\", Port: {Port}, User: \"{Username}\". Em
ail

I
n
f
o

Endpoi
ntData
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Endpoint Parameters: Host: \"{HostName}\", Port: {Port}, User: \"{Username}\". Em
ail

I
n
f
o

SmtpE
ndpoin
tData

Endpoint object is null. Sal
esf
orc
e.c
om

S
e
v
e
r
e

Endpoi
ntNull

Entities of type {MainType}/{SubType} cannot have any other Content-Transfer-Encoding
apart from 7bit.

MI
ME

S
e
v
e
r
e

Transf
erEncL
imit

Error connecting to JDE system while activating activity {ActivityName}, error is: {Message}.
Activity activated, will try to establish connectivity at activity execute time

JD
Ed
war
ds

I
n
f
o

Activat
eUnSu
ccessf
ul

Error connecting to PeopleSoft system while activating activity {ActivityName}, error is:
{Message}. Activity activated, will try to establish connectivity at activity execute time

Peo
ple
Sof
t

I
n
f
o

Activat
eUnsu
ccessf
ul

Error encountered unmarshaling the MQRFH2 header: {Message}. We
bS
phe
re
MQ

S
e
v
e
r
e

RFHFo
rmatEr
ror

Error from Salesforce.com while initializing activity. Trying to ignore error and proceed. Error
is: {Message}.

Sal
esf
orc
e.c
om

W
a
r
n
i
n
g

Initiali
zeProb
lem

Error identifying archive. Message is: {Message} Arc
hiv
e

S
e
v
e
r
e

ErrorId
entifyA
rchive
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Error in setup of repository/connection-pool in activate of {ActivityName}. Setup to be done
at activity execution time. The error is: {Message}

Sie
bel

W
a
r
n
i
n
g

Invoke
Activat
e

Error occurred while unzip operation. Message is: {Message} Arc
hiv
e

S
e
v
e
r
e

ErrorU
nZipO
peratio
n

Error occurred while zip operation. Message is: {Message} Arc
hiv
e

S
e
v
e
r
e

ErrorZi
pOper
ation

Error occurred, while communicating to SAP Gateway (host {HostName}, ProgramId
{ProgramID}, Service {Service}), trying again in {IntervalForRetries} seconds.\nOriginal SAP
error was \n {Message} \nIf the SAP message indicates a retry interval it may not be correct.

SA
P

W
a
r
n
i
n
g

Gatew
ayCom
mWarn
ing

Error processing file "{FileName}". Error is {Message} FT
P

W
a
r
n
i
n
g

FilePro
cessin
gError

Error returned by BAPI {BAPIName} in the type field. The values returned are TYPE: {Type} ,
MESSAGE: {Message}, LOGNO: {LogNumber}, LOGMSGNO {LogMessage}

SA
P

S
e
v
e
r
e

BAPIR
eturnE
rror

2318   



Message Mo
dul
e

L
e
v
e
l

Notific
ation

Error sending SOAP request to location: {LocationName}. Error is: {Message} Wo
rkd
ay

S
e
v
e
r
e

Conne
ctFaile
d

Error sending SOAP request to location: {LocationName}. Error is: {Message} We
b
Ser
vic
e

S
e
v
e
r
e

Conne
ctFaile
d

Error while activating PeopleSoft Receive. The error is: {Message} Peo
ple
Sof
t

S
e
v
e
r
e

Receiv
eActiv
ate

Error while activating the activity. Exception: {Message} HT
TP

S
e
v
e
r
e

Receiv
eActiv
ate

Error while activating the {ActivityName} activity. The error is: {Message} Sie
bel

S
e
v
e
r
e

Activat
eError

Error while closing the connection pool. The error is: {Message} Em
ail

W
a
r
n
i
n
g

ConPo
olRele
aseErr
or

Error while closing the connection pool. The error is: {Message} JD
Ed
war
ds

W
a
r
n
i
n
g

Conne
ctPool
Releas
e
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Error while closing the connection pool. The error is: {Message} Peo
ple
Sof
t

W
a
r
n
i
n
g

PoolRe
leaseE
rror

Error while connecting to JDE. The error is : {Message} JD
Ed
war
ds

W
a
r
n
i
n
g

Conne
ctExce
ption

Error while creating the connection to destination. The error is: {Message} Em
ail

W
a
r
n
i
n
g

MakeC
onPool
Error

Error while creating the connection to destination. The error is: {Message} JD
Ed
war
ds

W
a
r
n
i
n
g

MakeC
onnect
ionErr
or

Error while creating the connection to destination. The error is: {Message} Peo
ple
Sof
t

W
a
r
n
i
n
g

MakeC
onnect
Error

Error while deactivating PeopleSoft Receive. Discarding error: {Message} Peo
ple
Sof
t

S
e
v
e
r
e

Receiv
eDeAc
tivate

2320   



Message Mo
dul
e

L
e
v
e
l

Notific
ation

Error while deactivating the {ActivityName} activity. Discarding error: {Message} Sie
bel

W
a
r
n
i
n
g

Invoke
Deacti
vateErr
or

Error while deactivating the {ActivityName} activity. Discarding error: {Message} Sie
bel

S
e
v
e
r
e

Receiv
eDeact
ivateEr
r

Error while disconnecting from JDE. The error is : {Message} JD
Ed
war
ds

W
a
r
n
i
n
g

Discon
nectEx
ceptio
n

Error while executing the activity. The error is: {Message} Sie
bel

S
e
v
e
r
e

Invoke
Except
ion

Error while parsing data. Error is: {Message}. MI
ME

S
e
v
e
r
e

ParseE
xcepti
on

Error while parsing datetime from archive entries. Message is: {Message} Arc
hiv
e

W
a
r
n
i
n
g

Invalid
DateTi
me
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Error while processing request in PeopleSoft Receive. The error is: {Message} Peo
ple
Sof
t

S
e
v
e
r
e

Receiv
eProce
ss

Error while processing request. Exception : {Message} JD
Ed
war
ds

S
e
v
e
r
e

JDEInt
ernaler
ror

Error while processing request. The error is: {Message} Sie
bel

S
e
v
e
r
e

Intern
alError

Error while processing the connection parameters sent as part of the request. Error is:
{Message}

Do
min
o

S
e
v
e
r
e

Conne
ctError

Error while processing unsupported encoding. Exception : {Message} JD
Ed
war
ds

S
e
v
e
r
e

UnSup
ported
Encodi
ng

Error while processing unsupported encoding. The error is: {Message} Sie
bel

S
e
v
e
r
e

UnSup
ported
Encodi
ng

Error while reading archive entry. Message is: {Message} Arc
hiv
e

S
e
v
e
r
e

Invalid
Archiv
eEntry
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Error while reading archive. Message is: {Message} Arc
hiv
e

S
e
v
e
r
e

Invalid
Unarch
iveInp
ut

Error while receiving in PeopleSoft Receive. The error is: {Message} Peo
ple
Sof
t

S
e
v
e
r
e

Receiv
eError

Error while receiving in {ActivityName} activity. The error is: {Message} Sie
bel

S
e
v
e
r
e

Receiv
eError

Error while returning connection to pool. The error is: {Message} Em
ail

W
a
r
n
i
n
g

Conne
ctionP
oolRet
urn

Error while returning connection to pool. The error is: {Message} Peo
ple
Sof
t

W
a
r
n
i
n
g

Conne
ctionP
oolErr
or

Error while sending the response from PeopleSoft Receive. The error is: {Message} Peo
ple
Sof
t

S
e
v
e
r
e

Receiv
eGene
ralErro
r

Error while serializing data. Error is: {Message}. MI
ME

S
e
v
e
r
e

Seriali
zeExce
ption

 2323



Message Mo
dul
e

L
e
v
e
l

Notific
ation

Error while setting up connection pool for {ActivityName} activity. The error is: {Message} Sie
bel

W
a
r
n
i
n
g

Conne
ctionP
oolErr
or

Error while setting up repository for {ActivityName} activity. The error is: {Message} Sie
bel

W
a
r
n
i
n
g

Reposi
toryErr
or

Error while stopping the receive activity. Exception: {Message} HT
TP

S
e
v
e
r
e

Receiv
eDeAc
tivate

Error while trying to activate activity. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

PollAct
ivateEr
ror

Error while trying to disconnect from server. Discarding error: {Message}. Em
ail

W
a
r
n
i
n
g

Discon
nectEx
ceptio
n

Error while trying to disconnect from server. Discarding error: {Message}. Em
ail

W
a
r
n
i
n
g

SmtpD
isconn
ectErr
or
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Error while trying to execute activity {ActivityName}. Error is: {Message} JD
Ed
war
ds

S
e
v
e
r
e

Activit
yError

Error while trying to execute activity {ActivityName}. Error is: {Message} Peo
ple
Sof
t

S
e
v
e
r
e

Activit
yFailur
e

Error while trying to execute activity. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Execut
eError

Error while trying to execute query. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Execut
eProbl
em

Error while trying to get IP of router. Error is: {Message}. Continuing without getting IP. Em
ail

W
a
r
n
i
n
g

Could
NotGet
HostIP

Error while trying to read optional connection input parameter. Error is: {Message} Do
min
o

S
e
v
e
r
e

Unmar
shalErr
or

Error while trying to read optional connection input parameter. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Unmar
shalErr
or
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Error while trying to save duplist state after disconnect. Will cleanup in next poll. Em
ail

W
a
r
n
i
n
g

SaveSt
ateErr
or

Error while trying to write output parameter sessionInfo. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Marsh
alError

Error: {Message}. Em
ail

S
e
v
e
r
e

Pop3I
nternal
Error

Error: {Message}. Em
ail

S
e
v
e
r
e

SmtpI
nternal
Error

Error: {Message}. Sch
edu
ler

S
e
v
e
r
e

Activit
yExcep
tion

Errors/Warning messages while executing activity: {Message} Do
min
o

W
a
r
n
i
n
g

Runnin
gInfo
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Errors/Warning messages while executing activity: {Message} Peo
ple
Sof
t

W
a
r
n
i
n
g

Runnin
gInfo

Exceeded maximum number of activity events for a job; logging disabled Ma
est
ro

W
a
r
n
i
n
g

MaxSe
qNum

Exception : {Message} HT
TP

S
e
v
e
r
e

Unsup
ported
Encodi
ng

Exception detected in module, throwing exception {Message} Ma
est
ro

S
e
v
e
r
e

Invoke
Error

Exception in foreach activity: {Message} Ma
est
ro

S
e
v
e
r
e

ForEac
h

Exception in map activity: {Message} Ma
est
ro

S
e
v
e
r
e

ErrorM
ap

Exception in split activity: {Message} Ma
est
ro

S
e
v
e
r
e

SplitEr
ror
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Exception in subscribing the message. The Exception is: {Message} for message id:
{MessageID}, This message should be re-delivered manually from the Provider.

JM
S

S
e
v
e
r
e

Subscr
iberErr
or

Exception received on JMS connection while it was in the idle connections pool. The error
code is: {ErrorCode}, and the exception is: {ErrorMessage}

JM
S

W
a
r
n
i
n
g

Pooled
ConnE
xcepti
on

Exception while activating the BAPI Activity. The Exception is {Message} SA
P

S
e
v
e
r
e

BAPIA
ctivati
onErro
r

Exception while activating the RFC Activity. The Exception is {Message} SA
P

S
e
v
e
r
e

RFCAc
tivatio
nError

Exception while activating the Send IDOC Activity. The Exception is {Message} SA
P

S
e
v
e
r
e

SendI
DOCAc
tivatio
n

Exception while activating the database inbound activity.Exception is : {Message} Dat
aba
se

S
e
v
e
r
e

Activat
eError

Exception while activating the database outbound activity.Exception is : {Message} Dat
aba
se

S
e
v
e
r
e

Outbo
undAct
ivateEr
ror
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Exception while activating the database poll table activity.Exception is : {Message} Dat
aba
se

S
e
v
e
r
e

PollTbl
Activat
eError

Exception while activating the sap. The exception is because the sap libraries are not
installed. Exception is

SA
P

S
e
v
e
r
e

SapLib
NotFo
und

Exception while closing connection to JDE. The Exception is {Message} JD
Ed
war
ds

S
e
v
e
r
e

CloseC
onnect
ionErr
or

Exception while closing the connection pool. The Exception is: {Message} JM
S

S
e
v
e
r
e

PoolRe
leaseE
rror

Exception while closing the statement or result set. The exception is {Message} JD
Ed
war
ds

S
e
v
e
r
e

Resour
ceClea
nError

Exception while configuring the subscriber activity. The exception is: {Message} JM
S

S
e
v
e
r
e

Subscr
iberCo
nfigErr
or

Exception while creating IDOC form input parameter. The Exception is {Message} SA
P

S
e
v
e
r
e

Seriali
zingErr
or
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Exception while creating a schema for the business function name {FunctionName}, function
code {FunctionCode}, module code {ModuleCode}. The exception is {Message}

JD
Ed
war
ds

S
e
v
e
r
e

DataSt
ructur
eError

Exception while creating connection to JDE. The Exception is {Message} JD
Ed
war
ds

S
e
v
e
r
e

GetCo
nnecti
onErro
r

Exception while creating request schema for the business function {FunctionName},
function code {FunctionCode} , module code {ModuleCode}. The exception is {Message}

JD
Ed
war
ds

S
e
v
e
r
e

Create
Schem
aError

Exception while creating request schema for the business function {FunctionName},
function code {FunctionCode} , module code {ModuleCode}. The exception is {Message}

JD
Ed
war
ds

S
e
v
e
r
e

Respo
nseSc
hemaE
rror

Exception while creating soap message. The exception is: {Message} Net
Sui
te

S
e
v
e
r
e

SoapEr
ror

Exception while creating the connection to destination. The Exception is {Message} JM
S

S
e
v
e
r
e

MakeC
onnect
Error

Exception while getting custom fields for the recordType. The soap fault code is
{SoapFaultCode} and fault message is {SoapFaultMessage}

Net
Sui
te

S
e
v
e
r
e

Custo
mField
Error
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Exception while getting message from the provider. The error code is {ErrorCode} and
message is {ErrorMessage}

JM
S

S
e
v
e
r
e

JMSErr
or

Exception while getting the message from the queue. The Exception is: {Message} JM
S

S
e
v
e
r
e

PollMe
ssageE
rror

Exception while initializing Lotus Domino connector. Do
min
o

S
e
v
e
r
e

Initiali
zation
Error

Exception while intializing the send IDOC activity. The error message is {Message} SA
P

S
e
v
e
r
e

Initiali
zation
Error

Exception while looking up the connection factory {FactoryName}. The exception is:
{Message}

JM
S

S
e
v
e
r
e

PoolFa
ctoryE
rror

Exception while looking up the connection factory {Message}. The exception is unknown
error message from Provider.One of the reason for the error is If the provider is ActiveMQ
and the binding file name or path is not correct.

JM
S

S
e
v
e
r
e

Factor
yUnkn
ownErr
or

Exception while marshalling the jms message. The exception is: {Message} JM
S

S
e
v
e
r
e

GetMa
rshallE
rror
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Exception while parsing schema for the BAPI {BAPIName}. The Exception is {Message} SA
P

S
e
v
e
r
e

BAPIP
arseEr
ror

Exception while parsing schema for the RFC {RFCName}. The Exception is {Message} SA
P

S
e
v
e
r
e

ParseE
rror

Exception while processing SAP activity. Error Group: {ErrorGroup}, Error Key: {ErrorKey},
Error Message: {Message}.

SA
P

S
e
v
e
r
e

SAPAc
tivityEr
ror

Exception while processing Web Service activity. Error message: {Message}. Caused by:
{Cause}

We
b
Ser
vic
e

S
e
v
e
r
e

WebSe
rviceE
xcepti
on

Exception while processing Web Service activity. Error message: {Message}. The task
context is lost. The appliance may have been restarted, losing the task context that cannot
be saved on the disk.

We
b
Ser
vic
e

S
e
v
e
r
e

TaskCo
ntextE
rror

Exception while processing Workday activity. Error message: {Message}. Caused by: {Cause} Wo
rkd
ay

S
e
v
e
r
e

Workd
ayExce
ption

Exception while processing Workday activity. Error message: {Message}. The task context is
lost. The appliance may have been restarted, losing the task context that cannot be saved
on the disk.

Wo
rkd
ay

S
e
v
e
r
e

TaskCo
ntextE
rror

2332   



Message Mo
dul
e

L
e
v
e
l

Notific
ation

Exception while processing a message for NetSuite. Exception is {Message}. Net
Sui
te

S
e
v
e
r
e

Transf
ormati
onErro
r

Exception while processing the IDOC. The exception is {Message} SA
P

S
e
v
e
r
e

Proces
sDocEr
ror

Exception while returning connection to pool. The Exception is {Message} JM
S

W
a
r
n
i
n
g

Conne
ctionP
oolErr
or

Exception while returning connection to pool.Swallowing the exception. The Exception is
{Message}

Net
Sui
te

W
a
r
n
i
n
g

Conne
ctionP
oolErr
or

Exception while rolling back the transaction. SA
P

W
a
r
n
i
n
g

Rollba
ckWar
ning

Exception while sending message. The error code is {ErrorCode} and message is
{ErrorMessage}

JM
S

S
e
v
e
r
e

SendM
essage
Error
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Exception while setting the log directory for SAP trace files. SA
P

W
a
r
n
i
n
g

Create
TrcDirF
ailed

Exception while starting the server. Exception is {Message} SA
P

I
n
f
o

StartW
arning

Exception while stopping the listener for host {HostName}, ProgramId {ProgramID} and
Service {Service}.The Exception is {Message}

SA
P

W
a
r
n
i
n
g

Listen
erStop
Warnin
g

Exception while unmarshalling the jms message. The exception is: {Message} JM
S

S
e
v
e
r
e

SendM
arshall
Error

Exception while unsubscribing on the topic {Topic}. The error code is {ErrorCode} and
message is {Message}

JM
S

W
a
r
n
i
n
g

Unsub
scribe
Error

Exception while validating the input data. The Exception is {Message} SA
P

S
e
v
e
r
e

Validat
ionErr
or

Exporting archive file to FTP server {Host}:{Port}. Placing file "{Filename}" in directory "
{Directory}".

Pla
tfor
m

I
n
f
o

Orcmo
nExpor
tFTP
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Exporting job log data to local archive file "{Filename}". Pla
tfor
m

I
n
f
o

Orcmo
nExpor
tLocal

FTP Endpoint Summary - Host: {HostName}, Port: {PortName}, UserName: {UserName},
Protocol: {Protocol}, Timeout: {Timeout}, FTP Mode: {FtpMode}

FT
P

I
n
f
o

Endpoi
ntInfo
Summ
ary

Failed to cleanup activity {ActivityName} Ma
est
ro

W
a
r
n
i
n
g

CleanU
pFaile
d

Failed to deactivate activity {ActivityName} Ma
est
ro

S
e
v
e
r
e

Deacti
vateFai
led

Failed to destroy activity {ActivityName} Ma
est
ro

S
e
v
e
r
e

Destro
yFailed

Failed to filter data, error was: {Message} Dat
a
Qu
alit
y

S
e
v
e
r
e

FilterE
rror

Failed to initialize the Xml Validate Activity: {Message} XM
L

S
e
v
e
r
e

Validat
eInitial
ize
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Failed to log message, error was {ErrorMsg}. Log S
e
v
e
r
e

FailLog
Messa
ge

Failed to merge data, error was: {Message} Dat
a
Qu
alit
y

S
e
v
e
r
e

Merge
Error

Failed to parse JSON, error was: {ErrorMessage} JS
ON

S
e
v
e
r
e

JSONP
arseEr
ror

Failed to parse XML, error was: {ErrorMessage} XM
L

S
e
v
e
r
e

XMLPa
rseErr
or

Failed to perform lookup for data, database assets may not have been created Dat
a
Qu
alit
y

S
e
v
e
r
e

NoAss
etsErr
or

Failed to perform lookup for data, error was: {Message} Dat
a
Qu
alit
y

S
e
v
e
r
e

LookU
pError

Failed to purge any job logs to recover disk space. Available disk space is {DiskAvailPct}%. Pla
tfor
m

S
e
v
e
r
e

Orcmo
nDiskF
ullNoP
urge
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ation

Failed to query XML, error was: {Message} XM
L

S
e
v
e
r
e

XMLQu
eryErr
or

Failed to serialize JSON, error was: {Message} JS
ON

S
e
v
e
r
e

JSONS
erialize
Error

Failed to serialize XML, error was: {Message} XM
L

S
e
v
e
r
e

XMLSe
rialize
Error

Failed to sort data, error was: {Message} Dat
a
Qu
alit
y

S
e
v
e
r
e

SortErr
or

Failed to start the subscriber for the topic {TopicName}. Will try to start the subscriber after
{IntervalForRestart} seconds

JM
S

S
e
v
e
r
e

Restar
tError

Failed to transform JSON, error was: {Message} JS
ON

S
e
v
e
r
e

Transf
ormErr
or

Failed to transform XML, error was: {Message} XM
L

S
e
v
e
r
e

Transf
ormErr
or
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Failure uploading archive file to FTP server: Could not cd to directory "{Directory}". Pla
tfor
m

S
e
v
e
r
e

Orcmo
nExpor
tCdErr
or

Failure uploading archive file to FTP server: Could not store file. Pla
tfor
m

S
e
v
e
r
e

Orcmo
nExpor
tStore
Err

Failure uploading archive file to FTP server: {Message} Pla
tfor
m

S
e
v
e
r
e

Orcmo
nExpor
tError

Fan {FanID} on appliance {AffectedAppliance} is functional. Current={CurrentSpeed} RPM.
Minimum={MinimumSpeed} RPM.

Pla
tfor
m

I
n
f
o

FanRe
stored

Fan {FanID} on appliance {AffectedAppliance} is not functional. Current={CurrentSpeed}
RPM. Minimum={MinimumSpeed} RPM.

Pla
tfor
m

S
e
v
e
r
e

FanFail
ed

File "{FileName}" kept in place, will not overwrite. FT
P

W
a
r
n
i
n
g

FileNo
tMove
d

File named "{FileName}" has already been processed previously. The previous timestamp
was {Timestamp}.

FT
P

I
n
f
o

Duplic
ateFile
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ation

Filename is empty. Please specify valid filename. FT
P

S
e
v
e
r
e

PutEm
ptyFile
Name

Filtered {NumberOfEntries} entries Cry
pto
Ser
vic
e

I
n
f
o

InputE
ntryCo
unt

Filtered {NumberOfEntries} entries Dat
a
Qu
alit
y

I
n
f
o

InputE
ntryCo
unt

Finger print for host: {HostName} is {FingerprintInfo} FT
P

I
n
f
o

SshFin
gerprin
tInfo

Found boundary parameter: \"{Boundary}\". MI
ME

I
n
f
o

Found
Bound
ary

From pattern \"{FromPattern}\" incorrect. Error is: {Message}. Em
ail

S
e
v
e
r
e

Patter
nIncor
rect

General FTP module exception. Error is: {Message} FT
P

S
e
v
e
r
e

Intern
alExce
ption

General error while sending the response. The error is: {Message} Sie
bel

S
e
v
e
r
e

Gener
alError
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Get file summary - Directory: {DirName}, Filename: {FileName}, IsBinary? {BinaryOption} FT
P

I
n
f
o

GetInf
oSum
mary

Getting a listing for pattern "{Pattern}" for current directory. FT
P

I
n
f
o

ListBef
ore

Getting a name listing for pattern "{Pattern}" for current directory. FT
P

I
n
f
o

NListB
efore

Got Content-Transfer-Encoding: {ContentTransfer}. MI
ME

I
n
f
o

Transf
erEnco
dingVa
lue

Got boundary: \"{Boundary}\". MI
ME

I
n
f
o

Bound
arySpe
cified

Got document from {From} with Message Name: {MessageName}, Message Version:
{MessageVersion}, Message Type: {MessageType} and Originating Time Stamp: {TimeStamp}

Peo
ple
Sof
t

I
n
f
o

Receiv
eInfo

Got exception in "Schedule Job" activity: {Message}. Continuing to schedule jobs. Sch
edu
ler

W
a
r
n
i
n
g

Sched
ulerWa
rning

Got main-type: {MainType}. MI
ME

I
n
f
o

MainTy
pe

Group {UserName} has been deleted. Pla
tfor
m

I
n
f
o

Group
Delete
d
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ation

HA peers are running different versions of CIOS! Pla
tfor
m

S
e
v
e
r
e

HighAv
ailVers
ionErr
or

IO Error while processing request in PeopleSoft Receive. The error is: {Message} Peo
ple
Sof
t

S
e
v
e
r
e

Receiv
eIOErr
or

IO Error while processing request. The error is: {Message} Sie
bel

S
e
v
e
r
e

IOErro
r

IO Exception. Cry
pto
Ser
vic
e

S
e
v
e
r
e

Invalid
Format

ITEM_NO is empty. Returning false Peo
ple
Sof
t

W
a
r
n
i
n
g

ItemN
umber
Blank

Idoc contains more than one type of IDOC extension type SA
P

S
e
v
e
r
e

IDOCE
xtensi
onErro
r

Idoc with the TID {TID} is sent successfully to sap. SA
P

I
n
f
o

IDOCS
entInf
o
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ation

Information about this run of the Socket Janitor. HT
TP

I
n
f
o

SockC
ollecto
rRunIn
fo

Initializing the values in the MBean: {LoopBackString} HT
TP

I
n
f
o

LoopB
ackInit
ialize

Input data was not valid for IDOC. The following item(s) were invalid: {InvalidItems} SA
P

S
e
v
e
r
e

SendI
DOCVa
lidatio
n

Input data was not valid for RFC {RFCName}. The following item(s) were invalid:
{InvalidItems}

SA
P

S
e
v
e
r
e

SAPVal
idation
Error

Input entries do not conform to the schema. Error Message is: {Message} Arc
hiv
e

S
e
v
e
r
e

Validat
ionErr
or

Input entries successfully validated against schema. Arc
hiv
e

I
n
f
o

Validat
ionFin
e

Input entry has no content or it's a blank entry. Arc
hiv
e

S
e
v
e
r
e

Archiv
eEntry
Blank

Input parameter "{ParamName}" is over {Length} and is too large to log Ma
est
ro

W
a
r
n
i
n
g

LargeI
nputPa
ram
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ation

Input parameter 'body' from container is NULL. Em
ail

S
e
v
e
r
e

BodyN
ull

Input parameter 'body' from container is NULL. MI
ME

S
e
v
e
r
e

InputB
odyNul
l

InputOutput Exception. {0} Cry
pto
Ser
vic
e

S
e
v
e
r
e

IOExc
eption

Integrity check failed. Cry
pto
Ser
vic
e

I
n
f
o

Integri
tyChec
kFaile
d

Integrity check passed. Cry
pto
Ser
vic
e

I
n
f
o

Integri
tyChec
kPasse
d

Internal error in Salesforce.com connector. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

SfdcEr
rorInte
rnal

Internal error: {Message} Ma
est
ro

S
e
v
e
r
e

UnCau
ghtErr
or
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ation

Internal error: {Message} Ma
est
ro

S
e
v
e
r
e

UnExp
ectedE
rror

Internal error: {Message} Ma
est
ro

W
a
r
n
i
n
g

IOErro
r

Invalid Content Cry
pto
Ser
vic
e

S
e
v
e
r
e

Invalid
Conten
t

Invalid Date Format Cry
pto
Ser
vic
e

S
e
v
e
r
e

Invalid
DateFo
rmat

Invalid Key Handle or Password . {KeyHandleName} Cry
pto
Ser
vic
e

S
e
v
e
r
e

Invalid
KeyOr
Pwd

Invalid Key Store. Cry
pto
Ser
vic
e

S
e
v
e
r
e

Invalid
Algorit
hm

Invalid Key Store. {KeyHandleName} Cry
pto
Ser
vic
e

S
e
v
e
r
e

Invalid
KeySto
re
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ation

Invalid Keyhandle. {KeyHandleName} Cry
pto
Ser
vic
e

S
e
v
e
r
e

Invalid
Keyha
ndle

Invalid OSGI query syntax: {Message} Ma
est
ro

S
e
v
e
r
e

OSGIS
yntaxE
rror

Invalid Password. Cry
pto
Ser
vic
e

S
e
v
e
r
e

Invalid
Passw
ord

Invalid Salesforce.com field. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Invalid
SFDCF
ield

Invalid Salesforce.com object. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Invalid
SFDCO
bject

Invalid numeric value found in archive entries. Message is: {Message} Arc
hiv
e

W
a
r
n
i
n
g

Invalid
NumIn
ArchEn
try

Invalid or unsupported archive format. Arc
hiv
e

S
e
v
e
r
e

Invalid
UnArc
hForm
at
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Invalid port number : {PortNumber} JD
Ed
war
ds

W
a
r
n
i
n
g

Numb
erFor
matErr
or

Invalid task state transition, marked job faulted Ma
est
ro

S
e
v
e
r
e

TaskSt
ateTra
nsition

Job log purge triggered. Available disk space is {DiskAvailPct}%. Specified trigger is
{DiskAvailTrigger}%.

Pla
tfor
m

I
n
f
o

Orcmo
nDiskT
rigger

Job log purge triggered. Available disk space is {DiskAvailPct}%. Specified trigger is
{DiskAvailTrigger}%. Purging using properties failed to clear enough disk space. Purging half
of all job logs in attempt to recover disk space.

Pla
tfor
m

W
a
r
n
i
n
g

Orcmo
nDiskF
ull

Job log purge triggered. Exceeded maxmimum duration since last purge. Pla
tfor
m

I
n
f
o

Orcmo
nPurge
ByTim
eNP

Job log purge triggered. There are {NumCompleted} completed jobs. Completed jobs
threshold is {Threshold}.

Pla
tfor
m

I
n
f
o

Orcmo
nPurge
ByCom
pl

Job log purge triggered. There are {NumErrored} errored jobs. Errored jobs threshold is
{Threshold}.

Pla
tfor
m

I
n
f
o

Orcmo
nPurge
ByErro
red

Job log purge triggered. Time since last purge exceeded {PurgeTime}. Pla
tfor
m

I
n
f
o

Orcmo
nPurge
ByTim
e
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Job log purge/archive failed: {Message}. Pla
tfor
m

S
e
v
e
r
e

Orcmo
nPurge
Failed

Job log purged {NumExported} jobs. Pla
tfor
m

I
n
f
o

Orcmo
nExpor
tedJob
s

Job status changed to {Status} Ma
est
ro

I
n
f
o

TaskSt
atusCh
anged

List directory summary - Directory: {DirName}, Pattern: {Pattern}, NLIST? {ListOption} FT
P

I
n
f
o

ListFile
Summ
ary

Listing completed with a return code {ResponseCode}. FT
P

I
n
f
o

ListAft
er

Logged key with name "{KeyName}" and value "{KeyValue}" Ma
est
ro

I
n
f
o

KeyLo
g

Looked up {NumberOfEntries} entries Dat
a
Qu
alit
y

I
n
f
o

LookU
pEntry
Count

Looking up function {FunctionName} from SAP Repository SA
P

I
n
f
o

Functi
onLoo
kup

Looking up function {FunctionName} from SAP Repository (complete) SA
P

I
n
f
o

Functi
onLoo
kupCo
mp
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ation

Lookup cache not preloaded Dat
a
Qu
alit
y

I
n
f
o

NoPrel
oaded
Cache

Lookup cache preloaded with {NumberOfEntries} entries Dat
a
Qu
alit
y

I
n
f
o

Preloa
dedCa
che

MDTM command is not supported by FTP server, using default timestamp of \"Jan 1, 1970\"
instead.

FT
P

W
a
r
n
i
n
g

TimeSt
ampEr
ror

MDTM command is not supported by FTP server, using timestamp from listing instead.
Please consult manual for possible side effects.

FT
P

W
a
r
n
i
n
g

Timest
ampCo
mman
d

MQ Endpoint Details: Host: {HostName}, Port: {PortNumber}, User: {UserName}, Queue
Manager: {QueueManager}, Channel: {Channel}

We
bS
phe
re
MQ

I
n
f
o

MQCo
nnecti
onInfo

MQ Exception caught, reason code is {ReasonCode} We
bS
phe
re
MQ

I
n
f
o

Reaso
nCode

MQMD header input parameter format is incorrect; {Header} We
bS
phe
re
MQ

S
e
v
e
r
e

MQMD
Format
Error
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Notific
ation

MQRFH2 header input parameter format is incorrect. We
bS
phe
re
MQ

S
e
v
e
r
e

MQRF
HHead
erError

Mails processed in this poll deleted from server. Em
ail

I
n
f
o

MailsD
eleted

Matched email with From: \"{FromPattern}\" and Subject: \"{SubjectPattern}\". Em
ail

I
n
f
o

Email
Match
ed

Merged {NumberOfEntries} left entries Dat
a
Qu
alit
y

I
n
f
o

LeftMe
rgeInp
utEntr
y

Merged {NumberOfEntries} right entries Dat
a
Qu
alit
y

I
n
f
o

RightM
ergeIn
putEnt
ry

Message name and version got does not match that set in activity. Set in activity: Message
Name: {MessageName}, Message Version: {MessageVersion}. Actually Got: Message Name:
{ActualMessageName}, Message Version: {ActualMessageVersion}

Peo
ple
Sof
t

S
e
v
e
r
e

Messa
geNam
eVersi
on

Message of {QueueName} bytes retrieved from queue "{NumberOfBytes}". We
bS
phe
re
MQ

I
n
f
o

Messa
geRetri
eved

Message successfully delivered to queue {QueueManager}. We
bS
phe
re
MQ

I
n
f
o

Messa
geDeli
evered
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Mime-header type: {MainType}; sub-type: {SubType}. MI
ME

S
e
v
e
r
e

MainA
ndSub
Type

Missing classes when trying to start activity {ActivitName}. PeopleSoft library may need to
be installed on the appliance. Error is: {Message}

Peo
ple
Sof
t

S
e
v
e
r
e

Missin
gLibrar
ies

Missing classes when trying to start activity {ActivityName}. JDE library may need to be
installed on the appliance. Error is: {Message}

JD
Ed
war
ds

S
e
v
e
r
e

Classe
sMissi
ng

More than one entries found for BZIP2 operation. Arc
hiv
e

S
e
v
e
r
e

Invalid
BzipEn
try

More than one entries found for GZIP operation. Arc
hiv
e

S
e
v
e
r
e

Invalid
GzipEn
try

Name listing completed with a return code {ResponseCode}. FT
P

I
n
f
o

NListA
fter

Naming exception while configuring the subscriber activity. The exception is {Message} JM
S

S
e
v
e
r
e

Subscr
iberNa
meErr
or
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Naming exception while getting message to destination. The exception is {Message} JM
S

S
e
v
e
r
e

Namin
gExcep
tion

Naming exception while sending message to destination. The exception is {Message} not
found

JM
S

S
e
v
e
r
e

SendN
aming
Except
ion

Network link {LinkName} on appliance {AffectedAppliance} is down (offline). Pla
tfor
m

W
a
r
n
i
n
g

Netwo
rkLink
Down

Network link {LinkName} on appliance {AffectedAppliance} is up (online). Pla
tfor
m

I
n
f
o

Netwo
rkLink
Up

New Group {GroupName} has been created with id {Id}. Pla
tfor
m

I
n
f
o

Group
Create
d

New User {UserName} has been created with id {Id}. Pla
tfor
m

I
n
f
o

UserCr
eated

No Message integrity check. Cry
pto
Ser
vic
e

I
n
f
o

NoInte
grityCh
eck

No attachments found. Nothing to serialize. MI
ME

S
e
v
e
r
e

NoAtta
chmen
ts
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No boundary value specified for multiple parts attachment. Using auto-generated boundary:
{Boundary}.

MI
ME

I
n
f
o

AutoG
enerat
edBod
y

No data found in the interval. Sal
esf
orc
e.c
om

I
n
f
o

NoDat
afound

No emails matched on the server. Em
ail

I
n
f
o

NoEm
ailMat
ched

No input map for required parameter: {ParamName} Ma
est
ro

S
e
v
e
r
e

Input
Map

No mail found on the server. Em
ail

I
n
f
o

NoMail
OnSer
ver

No message available on queue "{QueueManager}" after {NumberOfRetryAttempts}
attempt(s).

We
bS
phe
re
MQ

S
e
v
e
r
e

NoMes
sageFa
ilure

No message available on queue "{QueueManager}". Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

We
bS
phe
re
MQ

W
a
r
n
i
n
g

NoMes
sageR
etry

No message available on queue {Queue}. We
bS
phe
re
MQ

I
n
f
o

NoMes
sage
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No return structure returned by BAPI {BAPIName}. SA
P

S
e
v
e
r
e

NonRe
turnStr
uct

No valid To, CC or BCC email address found. Em
ail

S
e
v
e
r
e

ToAnd
CCEm
pty

Not a known type of group. Sch
edu
ler

W
a
r
n
i
n
g

Sched
ulerUn
known
Type

Not able to connect, error is: {Message}. Establishing a new session. Sal
esf
orc
e.c
om

I
n
f
o

Conne
ctionTr
yAgain

Not able to establish connectivity. Polling will fail till connectivity is established. However
when connectivity is established, messages will be picked up from this time onwards.

Sal
esf
orc
e.c
om

I
n
f
o

StillRu
n

Not able to find field Return as structure. {Message} SA
P

I
n
f
o

FuncR
etStru
ctNotF
ound

Not able to get any record to do {OperationName} on. Returning false Peo
ple
Sof
t

W
a
r
n
i
n
g

NoOpe
ration
OnRec
ord

 2353



Message Mo
dul
e

L
e
v
e
l

Notific
ation

Null connection return by the connection pool. SA
P

S
e
v
e
r
e

Conne
ctionP
oolErr
or

Number of emails on server is {NumberOfMails}. Em
ail

I
n
f
o

Pop3N
umMai
ls

Number of parts {NumberOfParts}. MI
ME

I
n
f
o

Numb
erOfPa
rts

On undeploy, found task {TaskName} whose state is {State} Ma
est
ro

S
e
v
e
r
e

TaskFo
und

Only Create Keys and no other properties specified. Create might not have created record. Peo
ple
Sof
t

W
a
r
n
i
n
g

Create
OnlyKe
ys

Opening the queue with set all privileges as {Value} We
bS
phe
re
MQ

I
n
f
o

Details
Open

Operation name must not be null or empty! Wo
rkd
ay

S
e
v
e
r
e

Operat
ionNa
meNul
l

Operation name must not be null or empty! We
b
Ser
vic
e

S
e
v
e
r
e

Operat
ionNa
meNul
l
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Operational failure on appliance {AffectedAppliance} was detected. System is restarting to
recover.

Pla
tfor
m

W
a
r
n
i
n
g

Syste
mReco
veryRe
start

Operational failure was detected on appliance {AffectedAppliance}. System is rebooting to
recover. Uptime {Days} days, {Hours}:{Minutes}.

Pla
tfor
m

W
a
r
n
i
n
g

Syste
mReco
veryRe
boot

Optional input 'emailConnection' parameter is mapped. Em
ail

I
n
f
o

Conne
ctHead
erPres
ent

Optional input 'emailConnection' parameter is not mapped. Em
ail

I
n
f
o

Conne
ctHead
erAbse
nt

Optional input 'mailheader' parameter is mapped. Em
ail

I
n
f
o

MailHe
aderPr
esent

Optional input 'mailheader' parameter is not mapped. Em
ail

I
n
f
o

MailHe
aderAb
sent

Optional input parameter 'mimeheader' is mapped. MI
ME

I
n
f
o

MimeH
eader
Mappe
d

Optional input parameter 'mimeheader' not mapped. MI
ME

I
n
f
o

MimeH
eader
NotMa
pped

Optional input parameter {ParamName} mapped. Sal
esf
orc
e.c
om

I
n
f
o

InputP
aramM
apped
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Optional input parameter {ParamName} not mapped. Sal
esf
orc
e.c
om

I
n
f
o

InputP
aramN
otMap
ped

Orchestration already deployed: {OrchName} Ma
est
ro

S
e
v
e
r
e

Alread
yDeplo
yed

Orchestration not deployed: {OrchName} Ma
est
ro

S
e
v
e
r
e

NotDe
ployed

Output parameter "{ParamName}" is over {Length} and is too large to log Ma
est
ro

W
a
r
n
i
n
g

LargeO
utputP
aram

Outputted 'mailheader' and 'body' output parameters. Mail marked for deletion from server. Em
ail

I
n
f
o

Pop3M
ailSent

Outputted 'mimeheader' and 'body' output parameters. MI
ME

I
n
f
o

SerialA
ctivity
Done

Outputted 'parts' output parameter. MI
ME

I
n
f
o

ParseA
ctivity
Done

Outputted {OutputSize} objects in 'objects' output parameter. Sal
esf
orc
e.c
om

I
n
f
o

PollOu
tput
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PGP Exception. Cry
pto
Ser
vic
e

S
e
v
e
r
e

PGPEx
ceptio
n

Parameter at paramIndex {ParamIndex} and varIndex {VariableIndex} already set Ma
est
ro

W
a
r
n
i
n
g

Param
Index

Parameter {ParamName} is not an XML document Ma
est
ro

S
e
v
e
r
e

NotDo
cPara
meter

Parameter {ParamName} is null Ma
est
ro

S
e
v
e
r
e

NullPa
ram

Parameters: URI: "{URIValue}", Port: {PortValue}. HT
TP

I
n
f
o

Receiv
eURIP
ortInfo

Parameters: URL: "{URL}", Method: "{MethodName}". HT
TP

I
n
f
o

Reque
stPara
msDet
ails

Parsing Error: {Message} Dat
a

S
e
v
e
r
e

Parsin
gError

PeopleSoft Receive listening for events on URI: \"{UriValue}\" and port: \"{PortValue}\" Peo
ple
Sof
t

I
n
f
o

Config
URI
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Please put the protocol used (e.g. {Protocol}) in front of the input parameter location:
{LocationName}

Wo
rkd
ay

W
a
r
n
i
n
g

Missin
gProto
col

Please put the protocol used (e.g. {Protocol}) in front of the input parameter location:
{LocationName}

We
b
Ser
vic
e

W
a
r
n
i
n
g

Missin
gProto
col

Poll did not return any ids for interval starting from {PollStartTime} to {PollEndTime}. Sal
esf
orc
e.c
om

I
n
f
o

PollRet
urned
Nothin
g

Poll returned {NumberOfIds} ids for interval starting from {PollStartTime} to {PollEndTime}. Sal
esf
orc
e.c
om

I
n
f
o

PollRet
urned
Result
s

Port needs to be positive integer. Specified as: \"{PortNumber}\". Defaulted to 110. Em
ail

W
a
r
n
i
n
g

Incorr
ectPor
t

Port needs to be positive integer. Specified as: \"{PortNumber}\". Defaulted to 25. Em
ail

W
a
r
n
i
n
g

Incorr
ectSmt
pPort

Post response code received from the server: {ResponseCode} HT
TP

I
n
f
o

Server
Respo
nseCo
de
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dul
e

L
e
v
e
l

Notific
ation

Power sensor {PowerID} on appliance {AffectedAppliance} has reported a loss of power. Pla
tfor
m

W
a
r
n
i
n
g

PowerI
nterru
pted

Power sensor {PowerID} on appliance {AffectedAppliance} has reported power is restored. Pla
tfor
m

I
n
f
o

Power
Restor
ed

Problem with querying. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Invalid
Query

Processed file "{FileName}". Leaving in place. FT
P

I
n
f
o

FilePro
cessed

Processing attachment number {AttachmentNumber}. MI
ME

I
n
f
o

Attach
mentN
umber

Program in non-terminal state being destroyed: {ConfigURl} Ma
est
ro

S
e
v
e
r
e

Progra
mDest
roy

Publish of Configuration {ConfigName} failed: {Message}. Ma
est
ro

S
e
v
e
r
e

Loader
Publis
h

Put file summary - Directory: {DirName}, Filename: {FileName}, Overwrite?
{OverwriteOption}, IsBinary? {BinaryOption}

FT
P

I
n
f
o

PutInf
oSum
mary
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dul
e

L
e
v
e
l

Notific
ation

Putting in queue with set all privileges as {Value} We
bS
phe
re
MQ

I
n
f
o

MQPut
Details

Received IDOC contains more than one type of IDOC type SA
P

S
e
v
e
r
e

IDOCT
ypeErr
or

Received an IDOC for idoctype {IDOCType} and no activity was registered to process it.
Ignoring the IDOC.

SA
P

W
a
r
n
i
n
g

NoHan
dlerErr
or

Received warning from queue manager. MQ reason code is {ReasonCode}. We
bS
phe
re
MQ

W
a
r
n
i
n
g

MQPro
tocolW
arning

Removing Connection Pool with name {PoolName} SA
P

I
n
f
o

Remov
eInfo

Removing Server Gateway {GatewayName}. SA
P

I
n
f
o

Gatew
ayRem
oveInf
o

Rename file summary - fromDirectory: {DirName}, fromFilename: {FromFileName}, toPath:
{ToPath}, Overwrite: {OverwriteOption}

FT
P

I
n
f
o

Renam
eInfoS
ummar
y

Renamed file from "{SrcFileName}" to "{DestFileName}" with return code {ResponseCode}. FT
P

I
n
f
o

Renam
eAfter
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Message Mo
dul
e

L
e
v
e
l

Notific
ation

Renaming file from "{SrcFileName}" to "{DestFileName}". FT
P

I
n
f
o

Renam
eBefor
e

Request is an unsupported media type. Response definition: {Message} HT
TP

W
a
r
n
i
n
g

UnSup
ported
Media

RequestSecuirtyToken from Map Inputs is sent as request STS I
n
f
o

InputB
odyCo
nsider
ed

Response definition received from the server: {ResponseDef} HT
TP

I
n
f
o

Respo
nseDe
finition

Response from Security Token Service is empty STS S
e
v
e
r
e

Asserti
onEmp
ty

Response is : {Message} HT
TP

I
n
f
o

Receiv
eResp
onseB
ody

Running of job for orchestration {OrchName} aborted due to large number of waiting jobs Ma
est
ro

S
e
v
e
r
e

TooMa
nyWait
ingJob
s

SAP Listener instance {InstanceNumber} started for SAP Gateway(host {HostName},
ProgramId {ProgramID}, Service {Service}).

SA
P

I
n
f
o

Listen
erInst
anceIn
fo

SAP TID {TID} check requested by SAP. SA
P

I
n
f
o

TIDCh
eck
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dul
e

L
e
v
e
l

Notific
ation

SAP TID {TID} has been committed by SAP. SA
P

I
n
f
o

TIDCo
mmit

SAP TID {TID} has been confirmed and deleted from the TID Manager. SA
P

I
n
f
o

TIDCo
nfirme
d

SAP TID {TID} has been rolled-back by SAP. SA
P

I
n
f
o

TIDRol
lback

SAP attempting to confirm an unknown or uncommitted TID SA
P

S
e
v
e
r
e

TIDCo
mmitU
nknow
n

SAP has requested rollback for unknown TID {TID}. Cannot rollback. SA
P

S
e
v
e
r
e

TIDUn
known

SAP listener started again for host{HostName}, programid {ProgramID} and service
{Service}.

SA
P

I
n
f
o

Listen
erStart
Info

SOAP message has been accepted by the Integration Appliance. Wo
rkd
ay

I
n
f
o

DataM
essage
Accept
ed

SOAP message has been accepted by the Integration Appliance. We
b
Ser
vic
e

I
n
f
o

DataM
essage
Accept
ed

Salesforce session timed out. The session was not created as optional connection input
parameter was not mapped.

Sal
esf
orc
e.c
om

S
e
v
e
r
e

Option
alInpu
tError
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dul
e

L
e
v
e
l

Notific
ation

Salesforce.com logon failure. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

LoginF
ailure

Salesforce.com returned an unexpected error: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Unexp
ectedS
FDCFa
ult

Schedules the Socket Janitor to run every {TimeInterval} HT
TP

I
n
f
o

SockC
ollecto
rSched

Security Token Service Module has deprecated the input parameter "httpheaders/uri". The
value: {Value} will be ignored. Please set the URL at the input parameter "location".

STS W
a
r
n
i
n
g

UriDep
recate
d

Sending IDOC with the TID {TID} to sap. SA
P

I
n
f
o

TIDSe
ntInfo

Sending email to server. Em
ail

I
n
f
o

SmtpS
endEm
ail

Sending request to Security Token Service at location : {Location} STS I
n
f
o

Reque
stLoca
tion

Serialization Error: {Message} Dat
a

S
e
v
e
r
e

Seriali
zeErro
r
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dul
e

L
e
v
e
l

Notific
ation

Serialization Error: {Message} Dat
a

S
e
v
e
r
e

Seriali
zeIOEr
ror

Server Gateway {GatewayName} already exists, Using the existing definition. SA
P

I
n
f
o

Gatew
ayRegi
sterErr
or

Session timed out. Establishing a new session. Sal
esf
orc
e.c
om

I
n
f
o

Sessio
nInvali
d

Setting BCC: \"{Value}\". Em
ail

I
n
f
o

SetBC
CField
Value

Setting CC: \"{Value}\". Em
ail

I
n
f
o

SetCC
FieldV
alue

Setting From: \"{Value}\". Em
ail

I
n
f
o

SetFro
mField
Value

Setting Subject: \"{Value}\". Em
ail

I
n
f
o

SetSub
jectFie
ldValu
e

Setting To: \"{Value}\". Em
ail

I
n
f
o

SetToF
ieldVal
ue

Setting the client connection idle timeout at {TimeoutValue} seconds. HT
TP

I
n
f
o

ClientI
dleTim
eout

Setting the client connection manager maximum number of connections at
{MaxConnections}.

HT
TP

I
n
f
o

Client
MaxTot
alConn
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dul
e

L
e
v
e
l

Notific
ation

Setting the client connection manager timeout at {TimeoutValue} seconds. HT
TP

I
n
f
o

Client
ConMg
rTimeo
ut

Setting the client connection reclaim period at {ReclaimPeriodValue} seconds. HT
TP

I
n
f
o

Client
Reclai
mPerio
d

Setting the stale connection check at {StaleConnection}. HT
TP

I
n
f
o

StaleC
onnect
ionChe
ck

Setting timeout as {Timeout} milliseconds. Em
ail

I
n
f
o

SetTim
eout

Setting timeout as {Timeout} milliseconds. Em
ail

I
n
f
o

SmtpTi
meout

Sorted {NumberOfEntries} entries Dat
a
Qu
alit
y

I
n
f
o

SortIn
putEnt
ryCoun
t

Start of Orchestration {OrchName} failed: {Message}. Ma
est
ro

S
e
v
e
r
e

Loader
Start

Started job for orchestration "{OrchName}" Ma
est
ro

I
n
f
o

TaskSt
art

Starting batch of size {BatchSize} for index {StartIndex} through {EndIndex}. Sal
esf
orc
e.c
om

I
n
f
o

BatchP
ollStar
t
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dul
e

L
e
v
e
l

Notific
ation

Starting the idle connection timeout thread. HT
TP

I
n
f
o

IdleCo
nTime
outSta
rt

Stop of Orchestration {OrchName} failed: {Message}. Ma
est
ro

S
e
v
e
r
e

Loader
Stop

Stopping the idle connection timeout thread. HT
TP

I
n
f
o

IdleCo
nTime
outSto
p

Sub-type: {SubType}. MI
ME

I
n
f
o

SubTy
pe

Subject pattern \"{SubjectPattern}\" incorrect. Error is: {Message}. Em
ail

S
e
v
e
r
e

Subjec
tPatter
nError

Subscriber started successfully for the topic {TopicName} JM
S

I
n
f
o

Subscr
iberSta
rtInfo

Successfully Read Private Key. Cry
pto
Ser
vic
e

I
n
f
o

Found
Private
Key

Successfully Read Public Key. Cry
pto
Ser
vic
e

I
n
f
o

Found
Public
Key

Successfully executed activity and outputted output parameter RESPONSE. Sie
bel

I
n
f
o

Invoke
Succes
sful
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dul
e

L
e
v
e
l

Notific
ation

Successfully received request and outputted output parameter RESPONSE. Sie
bel

I
n
f
o

Receiv
eSucc
essful

Successfully received request in PeopleSoft Receive and outputted output parameter
response

Peo
ple
Sof
t

I
n
f
o

Receiv
eSucc
essful

Successfully upgraded Cast Iron firmware on appliance {AffectedAppliance} from version
{OldVersion} to version {NewVersion}.

Pla
tfor
m

I
n
f
o

Upgra
deCom
plete

Suspend of Orchestration {OrchName} failed: {Message}. Ma
est
ro

S
e
v
e
r
e

Loader
Suspe
nd

Swap space usage has exceeded the {Threshold}% critical threshold - current usage is
{Usage}%

Pla
tfor
m

S
e
v
e
r
e

SwapU
sageCr
itical

Swap space usage has exceeded the {Threshold}% warning threshold - current usage is
{Usage}%

Pla
tfor
m

W
a
r
n
i
n
g

SwapU
sageW
arning

Swap space usage is now below the {Threshold}% critical threshold - current usage is
{Usage}%

Pla
tfor
m

I
n
f
o

SwapU
sageCr
itOk

Swap space usage is now below the {Threshold}% warning threshold - current usage is
{Usage}%

Pla
tfor
m

I
n
f
o

SwapU
sageW
arnOk
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dul
e

L
e
v
e
l

Notific
ation

TID not set in the task state. SA
P

S
e
v
e
r
e

Invalid
TIDerr
or

TID {TID} committed succesfully. SA
P

I
n
f
o

TIDCo
mmite
dInfo

Temperature {TempID} on appliance {AffectedAppliance} is out of range. Current=
{CurrentTemperature} deg C. Maximum={MaximumTemperature} deg C.

Pla
tfor
m

S
e
v
e
r
e

Tempe
rature
OutOf
Range

Temperature {TempID} on appliance {AffectedAppliance} is restored. Current=
{CurrentTemperature} deg C. Maximum={MaximumTemperature} deg C.

Pla
tfor
m

I
n
f
o

Tempe
rature
Restor
ed

The Content-Encoding header is {ContentEncodingValue} HT
TP

I
n
f
o

Conten
tEncod
ingTyp
e

The Content-Encoding of the incoming request is {ContentEncodingValue}. Decompressing
the body.

HT
TP

I
n
f
o

Decom
presse
dEnco
ding

The Domino {ActivityName} activity re trying {Count} times now. Do
min
o

I
n
f
o

RetryC
ount

The HA system is Highly Available with appliance {AffectedAppliance} acting as Active. Pla
tfor
m

I
n
f
o

HighAv
ailRea
dy

The HA system is not Highly Available. Active appliance is {AffectedAppliance}. Pla
tfor
m

W
a
r
n
i
n
g

HighAv
ailNot
Ready
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dul
e

L
e
v
e
l

Notific
ation

The High Availability peer {AffectedAppliance} has successfully taken over. Pla
tfor
m

I
n
f
o

HighAv
ailFailo
ver

The IDOC number {IDOCNumber} contains no data segment. SA
P

W
a
r
n
i
n
g

NoSeg
mentW
arning

The RAID array on appliance {AffectedAppliance} is degraded. Pla
tfor
m

S
e
v
e
r
e

RaidAr
rayDeg
raded

The RAID array on appliance {AffectedAppliance} is offline. Please contact Cast Iron
Support.

Pla
tfor
m

S
e
v
e
r
e

RaidAr
rayOffl
ine

The RAID array on appliance {AffectedAppliance} is optimal. Pla
tfor
m

I
n
f
o

RaidAr
rayOpt
imal

The RAID disk {DiskID} on appliance {AffectedAppliance} has failed. Pla
tfor
m

S
e
v
e
r
e

RaidDi
skFaile
d

The RAID disk {DiskID} on appliance {AffectedAppliance} is online. Pla
tfor
m

I
n
f
o

RaidDi
skOnli
ne

The RAID disk {DiskID} on appliance {AffectedAppliance} is rebuilding. Pla
tfor
m

I
n
f
o

RaidDi
skReb
uilding
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dul
e

L
e
v
e
l

Notific
ation

The SFTP key access is: {ModeInformation} FT
P

I
n
f
o

SshMo
deInfo

The Socket Janitor has completed this run. HT
TP

I
n
f
o

SockC
ollecto
rFinish

The Value:"{HeaderVal}" set for Http Header:"{HeaderName}" was ignored because the type
is not supported.

HT
TP

I
n
f
o

Reque
stIgno
redHe
ader

The activity is recovering and the message with id: {MessageID} is already delivered.
Skipping it

JM
S

I
n
f
o

Recov
eryInf
o

The appliance is in recovery mode and the first message id {JMSMessageID} is not matching
the id {FirstMessageID} of delivered message. Messages in the queue is tampered and will
impact the delivery of messages.

JM
S

W
a
r
n
i
n
g

FirstID

The appliance {AffectedAppliance} has been opened, possibly leading to system failure.
Please contact Cast Iron Support.

Pla
tfor
m

S
e
v
e
r
e

Intrusi
onSev
ere

The appliance {AffectedAppliance} has been opened. Pla
tfor
m

W
a
r
n
i
n
g

Intrusi
onInfo
rm

The appliance {AffectedAppliance} is finished initializing after reboot. Pla
tfor
m

I
n
f
o

Syste
mInitC
omplet
e
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dul
e

L
e
v
e
l

Notific
ation

The appliance {AffectedAppliance} is initializing after being shut down or rebooted. Pla
tfor
m

I
n
f
o

Syste
mInitS
tarted

The buffer table contains the {OperationName} operation but there is no activity in the
orchestration for that operation. This is not a valid configuration.

Dat
aba
se

S
e
v
e
r
e

Operat
ionNa
meAbs
ent

The condition provided for if-then activity [{ActivityName}] and case label [{CaseLabel}] is
empty

Ma
est
ro

S
e
v
e
r
e

Switch
ExpEm
pty

The condition provided for while activity [{ActivityName}] is empty Ma
est
ro

S
e
v
e
r
e

WhileE
xpEmp
ty

The data encoding specified: \"{DataEncoding}\" is not supported. FT
P

S
e
v
e
r
e

Encodi
ngErro
r

The datasource with the name {DataSourceName} is registered with hash code:
{HashCodeName}

Dat
aba
se

I
n
f
o

DataS
ource
HashC
ode

The delete query issued to the buffer table is {Query} Dat
aba
se

I
n
f
o

Delete
SQL

The delete query, with id, issued to the buffer table is {Query} Dat
aba
se

I
n
f
o

Delete
SQLWi
thId
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dul
e

L
e
v
e
l

Notific
ation

The following datasource name is registered with the system. Dat
aba
se

I
n
f
o

DataS
ourceR
egister
ed

The input connection parameter is not mapped. HT
TP

I
n
f
o

ReadC
onnect
ionPar
am

The input parameter "{InputParam}" is zero length. We
bS
phe
re
MQ

S
e
v
e
r
e

InputP
aramN
ull

The input parameter header is not set. HT
TP

I
n
f
o

ReadI
nputH
eaders

The jms connector is in recovery mode. JM
S

I
n
f
o

Recov
eryInf
o

The loopback port values persisted in the sysconf: {LoopBackString} HT
TP

I
n
f
o

HttpLo
opBac
kValue
s

The maximum number of rows for one poll on table {TableName} was reached. If this is a
frequent occurrence, then alter the threshold!

Dat
aba
se

I
n
f
o

MaxRo
wExce
eded

The message format field "{Format}" is invalid. Supported formats are MQSTR, MQHRF2,
and no format.

We
bS
phe
re
MQ

S
e
v
e
r
e

Format
Error

The number of attachments found is {NumberOfAttach}. MI
ME

I
n
f
o

Attach
ments
Found
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dul
e

L
e
v
e
l

Notific
ation

The provide activity is started on local transport for the URI: {URI} Wo
rkd
ay

I
n
f
o

Transp
ortInfo

The provide activity is started on local transport for the URI: {URI} We
b
Ser
vic
e

I
n
f
o

Transp
ortInfo

The query for the parameterized query activity is: {QueryString} Dat
aba
se

I
n
f
o

Param
eterize
dQuer
y

The request operation failed. Exception: {Message} HT
TP

S
e
v
e
r
e

SendR
equest
Operat
ion

The required schema for {Name} is missing. The activity {ActivityName} generating
schemas.

Do
min
o

I
n
f
o

Schem
aInvok
e

The response Content-Encoding from the server is {ContentEncodingValue}. Decompressing
the body.

HT
TP

I
n
f
o

Compr
essFor
mat

The response Content-Encoding is {ContentEncodingValue}. HT
TP

I
n
f
o

ReplyC
ompre
ssFor
mat

The response is binary. HT
TP

I
n
f
o

Respo
nseBo
dyBina
ry

The response is not binary. HT
TP

I
n
f
o

Respo
nseBo
dyNot
Binary
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dul
e

L
e
v
e
l

Notific
ation

The row is already delivered to the database. Skipping it. Dat
aba
se

W
a
r
n
i
n
g

Redeli
verSki
p

The select query issued for the buffer table is {Query} Dat
aba
se

I
n
f
o

Query
String

The send request failed. Exception: {Message} HT
TP

S
e
v
e
r
e

Gener
alRequ
estFail
ed

The server response contained an unsolicited Content-Encoding: {ContentEncoding}.
Acceptable values are: {AcceptEncoding}

HT
TP

S
e
v
e
r
e

Unsoli
citedE
ncodin
g

The stored procedure query issued to the database is {QueryString} Dat
aba
se

I
n
f
o

Stored
ProcQ
uery

The type of Accept-Encoding in the request-header field is {AcceptEncodingValue} HT
TP

I
n
f
o

Accept
Encodi
ngTyp
e

The unicode instance property is set through JCONSOLE SA
P

I
n
f
o

Unicod
eGate
way

The update query issued to the buffer table for marking rows is {Query} Dat
aba
se

I
n
f
o

Updat
eQuer
y
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dul
e

L
e
v
e
l

Notific
ation

The {Field} email address {EmailID} specified in optional parameters is not in correct format.
Not setting the same.

Em
ail

W
a
r
n
i
n
g

Invalid
Addres
sForm
at

There are no more activities to listen for on port {PortNumber}. Stopping the listener on port
{PortNumber}.

HT
TP

I
n
f
o

HttpLis
tenerS
top

There is an unusually large file, {LargeFile}, of size {FileSize} MB. Pla
tfor
m

W
a
r
n
i
n
g

LargeF
ileWar
ning

There is no message to be retrieved from the destination {Destination} JM
S

I
n
f
o

NoMes
sage

This error may be due to JMS Provider library being not installed on the appliance. Please
install the JMS provider library using Web management console. The error is {Message}

JM
S

S
e
v
e
r
e

Library
NotIns
talled

This part does not have any body. Setting blank body. MI
ME

I
n
f
o

NoPart
Body

Tid {TIDNumber} not found in TID manager. SA
P

S
e
v
e
r
e

Receiv
eTIDN
otFoun
d
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dul
e

L
e
v
e
l

Notific
ation

Timeout needs to be positive integer. Specified as: \"{Timeout}\". Defaulted to 300 seconds. Em
ail

W
a
r
n
i
n
g

Incorr
ectTim
eout

Timeout needs to be positive integer. Specified as: \"{Timeout}\". Defaulted to 300 seconds. Em
ail

W
a
r
n
i
n
g

Incorr
ectSmt
pTime
out

Timeout waiting for jobs to stop, number of jobs abandoned: {NumberOfAbandonedJobs} Ma
est
ro

W
a
r
n
i
n
g

Aband
onedJ
obs

Trying to delete item {ItemNumber} which is out of range. Returning false Peo
ple
Sof
t

W
a
r
n
i
n
g

OutOf
Range

Unable to compile the orchestration {OrchName} Ma
est
ro

S
e
v
e
r
e

OrchC
ompile
Error

Unable to connect to JDE after {NumberOfRetryAttempts} attempts. Error is: {Message} JD
Ed
war
ds

S
e
v
e
r
e

JDECo
nnectE
rror
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L
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v
e
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Notific
ation

Unable to connect to NetSuite after {NumberOfRetryAttempts} attempts. Error is:
{Message}.

Net
Sui
te

S
e
v
e
r
e

Conne
ctionF
ailed

Unable to connect to NetSuite. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

Net
Sui
te

W
a
r
n
i
n
g

Conne
ctionR
etry

Unable to connect to PeopleSoft after {NumberOfRetryAttempts} attempts. Error is:
{Message}

Peo
ple
Sof
t

S
e
v
e
r
e

Conne
ctionEr
ror

Unable to connect to Salesforce.com after {NumberOfRetryAttempts} attempts. Error is:
{Message}.

Sal
esf
orc
e.c
om

S
e
v
e
r
e

Conne
ctionF
ailed

Unable to connect to Salesforce.com. Error is: {Message}. Sal
esf
orc
e.c
om

S
e
v
e
r
e

Conne
ctFaile
d

Unable to connect to Salesforce.com. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

Sal
esf
orc
e.c
om

W
a
r
n
i
n
g

Conne
ctionR
etry

Unable to connect to server after {NumberOfRetryAttempts} attempts. Error is: {Message}. Em
ail

S
e
v
e
r
e

Conne
ctError
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Unable to connect to server after {NumberOfRetryAttempts} attempts. Error is: {Message}. Em
ail

S
e
v
e
r
e

SmtpC
onnect
Failed

Unable to connect to server after {NumberOfRetryAttempts} attempts. Error is: {Message}. HT
TP

S
e
v
e
r
e

SendR
equest
Conne
ction

Unable to connect to server after {NumberOfRetryAttempts} attempts. The error is:
{Message}

Sie
bel

S
e
v
e
r
e

Conne
ctError

Unable to connect to server. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

Em
ail

W
a
r
n
i
n
g

Conne
ctError
Retry

Unable to connect to server. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

Em
ail

W
a
r
n
i
n
g

SmtpC
onnect
Retry

Unable to connect to server. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

Sie
bel

W
a
r
n
i
n
g

Conne
ctionR
etry
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Unable to connect to the Queue Manager "{QueueManager}" after
{NumberOfRetryAttempts} attempt(s). MQ returned error code "{ErrorCode}".

We
bS
phe
re
MQ

S
e
v
e
r
e

Conne
ctionEr
ror

Unable to connect to the Queue Manager "{QueueManager}". MQ returned error code "
{ErrorCode}". Attempt {RetryAttemptNumber} of {TotalRetryAttempts}. Will try again in
{IntervalForRetries} second(s).

We
bS
phe
re
MQ

W
a
r
n
i
n
g

Conne
ctRetr
y

Unable to connect to the SAP server after {NumberOfRetryAttempts} attempts. Error is:
Error Group {ErrorGroup}, Error Key {ErrorKey}, Error Message {Message}

SA
P

S
e
v
e
r
e

Conne
ctError

Unable to connect to the SAP server. Error is: Error Group: {ErrorGroup} Error Key {ErrorKey}
Error Message {Message}. Attempt {RetryAttemptNumber} of {TotalRetryAttempts}. Will try
again in {RetryAttemptNumber} second(s).

SA
P

W
a
r
n
i
n
g

Conne
ctRetr
y

Unable to connect to the server \"{ServerName}\" after {NumberOfRetryAttempts} attempts.
Error is: {Message}

FT
P

S
e
v
e
r
e

Conne
ctionF
ailure

Unable to connect to the server \"{ServerName}\". Error is: {Message} Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will try again in {IntervalForRetries}
second(s).

FT
P

W
a
r
n
i
n
g

Conne
ctionR
etry
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e
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Unable to connect to the server. Error is: {Message}. Attempt {RetryAttemptNumber} of
{TotalRetryAttempts}. Will try again in {IntervalForRetries} second(s).

HT
TP

W
a
r
n
i
n
g

Conne
ctionR
etry

Unable to create call context: {Message} Ma
est
ro

S
e
v
e
r
e

CallCo
ntext

Unable to delete rows from buffer table {TableName}. Dat
aba
se

S
e
v
e
r
e

Delete
RowsF
ailure

Unable to enqueue to orchestration: {Message} Ma
est
ro

S
e
v
e
r
e

Enque
ueFail
ed

Unable to execute to orchestration: {Message} Ma
est
ro

S
e
v
e
r
e

Execut
eError

Unable to find RFC {RFCName}. Invalid RFC name. SA
P

S
e
v
e
r
e

Invalid
RFCNa
me

Unable to find the BAPI transaction RFC's. SA
P

S
e
v
e
r
e

Transa
ctional
Error
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Unable to get message from queue {QueueName}. MQ returned error code {ErrorCode}. We
bS
phe
re
MQ

S
e
v
e
r
e

PollFai
lure

Unable to get message from queue {QueueName}. MQ returned error code {ErrorCode}. We
bS
phe
re
MQ

S
e
v
e
r
e

GetFail
ure

Unable to invoke method {MethodName} on the data source object. This might cause
unexpected behavior. Please check the connection properties

Dat
aba
se

I
n
f
o

Metho
dNotF
ound

Unable to obtain meta data from Salesforce.com for {NameOfObject}. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Metad
ataObj
ectErr
or

Unable to obtain meta data from Salesforce.com. Error is: {Message} Sal
esf
orc
e.c
om

S
e
v
e
r
e

Metad
ataErr
or

Unable to parse the catch expression: {Message} Ma
est
ro

S
e
v
e
r
e

CatchE
xpressi
on

Unable to parse the date and time: {DateTimeValue} {Message} Dat
aba
se

S
e
v
e
r
e

DateTi
mePar
seErro
r
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Unable to parse the if-then expression: {Message} Ma
est
ro

S
e
v
e
r
e

Switch
Expres
sion

Unable to parse the while expression ''{ConditionSpecified}'': {Message} Ma
est
ro

S
e
v
e
r
e

WhileE
xpressi
on

Unable to perform operation \"{OperationName}\". Error is: {Message} FT
P

S
e
v
e
r
e

Operat
ionErr
or

Unable to process the request. Additional information about the error can be found on the
Web Management Console.

Wo
rkd
ay

S
e
v
e
r
e

CleanU
pMess
age

Unable to process the request. Additional information about the error can be found on the
Web Management Console.

We
b
Ser
vic
e

S
e
v
e
r
e

CleanU
pMess
age

Unable to put message on queue {QueueManager}. MQ returned error code {ErrorCode}. We
bS
phe
re
MQ

S
e
v
e
r
e

MQPut
Failure

Unable to remove task {TaskID} Ma
est
ro

S
e
v
e
r
e

TaskRe
move
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Unable to send the SOAP request to {LocationName}. Error is: {Message}. Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will retry again in {IntervalForRetries}
second(s).

Wo
rkd
ay

W
a
r
n
i
n
g

Conne
ctRetr
y

Unable to send the SOAP request to {LocationName}. Error is: {Message}. Attempt
{RetryAttemptNumber} of {TotalRetryAttempts}. Will retry again in {IntervalForRetries}
second(s).

We
b
Ser
vic
e

W
a
r
n
i
n
g

Conne
ctRetr
y

Unable to set state of task {CurrentState} to {FinalState} Ma
est
ro

S
e
v
e
r
e

TaskSt
ate

Unable to set the query time out for database {DBType}. The exception is {Message} Dat
aba
se

W
a
r
n
i
n
g

SetQu
eryTim
eout

Unarchiver created successfully, now performing unarchiving. Arc
hiv
e

I
n
f
o

UnArc
hiverCr
eated

Undeploy of Orchestration {OrchName} failed: {Message}. Ma
est
ro

S
e
v
e
r
e

Loader
unDepl
oy

Unexpected IO error while performing operation with NetSuite. The exception is {Message} Net
Sui
te

S
e
v
e
r
e

IOErro
r
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Unexpected IO exception while streaming the message. The exception is {Message} Net
Sui
te

S
e
v
e
r
e

Strea
mError

Unexpected error from server: {Message}. Em
ail

S
e
v
e
r
e

Pop3S
erverE
rror

Unknown exception while invoking an operation on NetSuite. The exception is {Message} Net
Sui
te

S
e
v
e
r
e

Unkno
wnErro
r

Uploaded file "{FileName}" to server with return code {ResponseCode}. FT
P

I
n
f
o

PutAft
er

Uploading file "{FileName}" to server. FT
P

I
n
f
o

PutBef
ore

User {UserName} displayName has been changed from {OldValue} to {NewValue}. Pla
tfor
m

I
n
f
o

Updat
eUser

User {UserName} has been deleted. Pla
tfor
m

I
n
f
o

UserD
eleted

User {UserName} has been granted role of {GroupName}. Pla
tfor
m

I
n
f
o

GrantR
ole

User {UserName} has been revoked of the role {GroupName}. Pla
tfor
m

I
n
f
o

Revok
eRole
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User {UserName} status has been changed from {OldValue} to {NewValue}. Pla
tfor
m

I
n
f
o

Updat
eStatu
s

User {UserName} with session id {SessionId} logged out successfully. Pla
tfor
m

I
n
f
o

AuthLo
gOut

Validation is {ValidationStatus} for {Value} SA
P

I
n
f
o

Validat
ionInfo

Variable "{VariableName}" is over {Length} and is too large to log Ma
est
ro

W
a
r
n
i
n
g

LargeV
ariable

Variable "{VariableName}" is too large, please turn on persistence for this orchestration Ma
est
ro

S
e
v
e
r
e

LargeN
onpers
istentV
ar

Variable {ParamName} is not an XML document Ma
est
ro

S
e
v
e
r
e

NotDo
cVaria
ble

Variable {VarName} is null Ma
est
ro

W
a
r
n
i
n
g

Variabl
eNull

Variable {VariableName} is null Ma
est
ro

S
e
v
e
r
e

NullVa
riable

 2385



Message Mo
dul
e

L
e
v
e
l

Notific
ation

Warning/error messages while doing setup for {ActivityName}: {Message} JD
Ed
war
ds

W
a
r
n
i
n
g

SetUpI
nfo

Warning/error messages while initializing {ActivityName}: {Message} Peo
ple
Sof
t

W
a
r
n
i
n
g

SetupI
nfo

Web Service Module has deprecated the input parameter "httpheaders/uri". The value:
{Value} will be ignored. Please set the URL (e.g. http://www.castiron.com/WebService) at the
location in the endpoint panel or at the input parameter "location".

We
b
Ser
vic
e

W
a
r
n
i
n
g

UriDep
recate
d

Workday Module has deprecated the input parameter "httpheaders/uri". The value: {Value}
will be ignored. Please set the URL (e.g. http://www.castiron.com/Workday) at the location
in the endpoint panel or at the input parameter "location".

Wo
rkd
ay

W
a
r
n
i
n
g

UriDep
recate
d

[URI: {Uri}, Port: {Port}, Operation Name: {OperationName}] Web Service has already been
registered. Key: {RegistrationKey}

We
b
Ser
vic
e

S
e
v
e
r
e

Alread
yRegis
tered

[URI: {Uri}, Port: {Port}, Operation Name: {OperationName}] Workday has already been
registered. Key: {RegistrationKey}

Wo
rkd
ay

S
e
v
e
r
e

Alread
yRegis
tered
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[URI: {Uri}, Port: {Port}, Operation Name: {OperationName}] has not been registered. Key:
{KeyName}

Wo
rkd
ay

S
e
v
e
r
e

NotRe
gistere
d

[URI: {Uri}, Port: {Port}, Operation Name: {OperationName}] has not been registered. Key:
{KeyName}

We
b
Ser
vic
e

S
e
v
e
r
e

NotRe
gistere
d

jas.ini file needs to be present before the JD Edwards Invoke activity can be run. Please
upload jas.ini file and run again.

Sie
bel

S
e
v
e
r
e

Missin
gLibrar
ies

unarchiving done successfully. Arc
hiv
e

I
n
f
o

Unarch
iveDon
e

{ActivityName} activity created successfully. Do
min
o

I
n
f
o

Activit
yCreat
eSucc
ess

{ActivityName} activity executed successfully. Do
min
o

I
n
f
o

Activit
ySucce
ssful

{ActivityName} activity execution failed due to {Name} property is blank. Do
min
o

S
e
v
e
r
e

Activat
eFailur
eBlank

{ActivityName} executed and outputted response output parameter JD
Ed
war
ds

I
n
f
o

Activit
ySucce
ssful
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{ActivityName} executed and outputted response output parameter Peo
ple
Sof
t

I
n
f
o

Activit
ySucce
ssful

{ActivityName} listening for events on URI: \"{UriValue}\" and port: \"{PortValue}\". Sie
bel

S
e
v
e
r
e

Config
URI

{FileName}: File with the same name exists on the FTP server. It is a duplicate! FT
P

S
e
v
e
r
e

PutDu
plicate
FileNa
me

{FileName}: File with the same name exists on the FTP server. It is a duplicate! FT
P

S
e
v
e
r
e

Renam
eDupE
rror

{MessageType} messages while executing activity: {Message} Do
min
o

W
a
r
n
i
n
g

Runnin
gMess
ages

{MessageType} messages while executing activity: {Message} Peo
ple
Sof
t

W
a
r
n
i
n
g

Runnin
gMess
ages

{Message} HT
TP

I
n
f
o

Endpoi
ntInfor
mation
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{Message} Wo
rkd
ay

S
e
v
e
r
e

WDFau
ltStrin
g

{Message} We
b
Ser
vic
e

S
e
v
e
r
e

WSFau
ltStrin
g

{NumberOfEmails} mails to be deleted now as they were processed earlier. Em
ail

I
n
f
o

MailsT
oBeDe
leted
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This information center provides information for WebSphere® DataPower® Cast Iron® Management API Guide .

About WebSphere DataPower Cast Iron Management API Guide

The Management API guide is written for developers and IT personnel who want to manage Integration
Appliance and the Cloud by using applications or scripts.

This guide assumes that you have an intermediate level of expertise in integration projects and some
experience in supporting and managing an IT environment.

Integration Appliance and Cloud documentation

To view PDF documents, download Adobe Reader version 5 or higher from Adobe Systems Inc., see
http://www.adobe.com.

You can access documentation from the Documentation CD.

The documentation set includes the following books:

Command Line Interface Reference
Reference information about commands available from the Command Line Interface (CLI).

Getting Started Guide
An overview of Integration Appliance and Studio, and summary information about using Studio to create
integration projects that run on the Integration Appliance

HA Overview Guide
A high-level overview about High Availability (HA) pairs. This guide includes information about HA pair
states, configuration requirements, commands, and troubleshooting issues.

Management API Guide
Information for the Management API for the Cloud and Integration Appliances.

Documentation conventions

The following table describes the conventions that are used in this document.

Convention Description

<Hostname> command Examples of using commands are shown in this document in this format.

enter exactly as
shown

Procedures might also include instructions on what you should enter for
particular fields, prompts, or commands. Information in this font must be typed
exactly as shown.

net set interface
dataaddress <port-
address>

Placeholders are shown between angle brackets (<>) and generally indicate the
type of information you should supply in the command.

Menu > Submenu Instructions that use menu commands use the greater than symbol (>) to
indicate submenus, for example, “click Configuration > Notifications”.

Other resources

In addition to the product information, IBM® provides these other resources:

Online help
Information centers
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Knowledge Base
Product Support

Online help
Online help is accessible from Studio and the Web Management Console.

IBM website
You can access the IBM Corporation website at: http://www.ibm.com.

The site contains information about the IBM Corporation, its background, and products. The site also
provides contact information for sales and technical support.

Contacting IBM support
IBM support provides assistance with product defects. Before contacting IBM support, the following
criteria must be met:

Your company has an active maintenance contract.
You are authorized to submit problems.

Submit the problem in one of two ways:

Electronically through the Service Request (SR) problem submission tool. You must sign in with
your IBM ID and password.
Telephone. Refer to the directory of worldwide contacts in the IBM Software Support Handbook
for the appropriate software support phone number to call.

Feedback | Notices

 Last updated: Thursday, 2 June 2016
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Overview of the Management API guide
An overview of the Management API. The API provides management capabilities for Clouds and Integration
Appliances.

The Management API is implemented as a web service. This web service provides a way to manage
WebSphere® DataPower® Cast Iron® Appliances (Integration Appliances) and WebSphere Cast Iron Cloud
(Cloud) projects through your applications or scripts.

The API provides Integration Appliance and Cloud management in the following areas:

Deployment
Provides operations to create, get, and delete configurations, rules, and projects. You can start, pause,
stop, and cancel jobs. You can import or export repositories.

Security
Provides operations to create, get, list, and delete users, roles, and permissions. You can log in and log
out by using the security WSDL.
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Staging
Checks whether the staging database is started and starts or stops the staging database. (Applies to
appliances only.)

System Administration
Sets or gets the appliance name or network configuration. You can also run system commands or get
system information. (Applies to appliances only.)

Job Monitoring
Searches for job, gets job count, and gets job details. You can also set and get job monitoring properties.

Logs and Notifications
Saves, gets, and deletes notification policies. You can also get and set email and SNMP endpoints, set
and get log levels, and get log count.

The Management API complies with the following web services standards:

Web Services Interoperability Organization (WS-I) Basic Profile 1.0
SOAP 1.1
Web Services Description Language (WSDL) 1.1
XML Schema 1.1

You can create client applications that call web services operations to manage and monitor Integration
Appliances and Cloud projects. Communication between the client application and the Integration Appliance
orCloud project is accomplished by using HTTP or HTTPS.

The Management API is defined in WSDL files. Client applications call web services operations by sending
SOAP messages. SOAP messages are formatted in XML and so are programming language neutral.

Examples of SOAP messages

This section provides examples of logging in, getting a user and logging out using the Management API -
Security WSDL.

The following code is an example of a SOAP request to log in.
Note: If you are using Management API for Cast Iron Live, use the IBM ID credential for the username and
password fields.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header/> 
 <soapenv:Body> 
  <sec:login> 
   <sec:username>webuser@mycompany.com</sec:username> 
   <sec:password>D3nu9noB</sec:password> 
  </sec:login> 
 </soapenv:Body> 
</soapenv:Envelope>

The following code is an example of a SOAP reply to the request to log in.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:loginResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  security" xmlns:ns3="http://www.approuter.com/schema/router/1000/security/03"> 
   <ns2:sessionId>8F059BEEA3611033D277773A95404641</ns2:sessionId> 
  </ns2:loginResponse> 
 </S:Body> 
</S:Envelope>
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The sessionId is required to perform other SOAP operations after you log in to an Integration Appliance or the
Cloud.
The following code is an example of a SOAP request to get a user.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>8F059BEEA3611033D277773A95404641</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:getUser> 
   <sec:username>webuser</sec:username> 
  </sec:getUser> 
 </soapenv:Body> 
</soapenv:Envelope>

The following code is an example of a SOAP response to the request to get a user.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getUserResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  security" xmlns:ns3="http://www.approuter.com/schema/router/1000/security/03"> 
   <ns2:user> 
    <ns3:id>8F059BEEA3611033D277773A95404641</ns3:id> 
    <ns3:name>webuser</ns3:name> 
    <ns3:encPasswd>{SHA}clO20r2ZJMJcDrNwXQzhWB8YcdI=</ns3:encPasswd> 
    <ns3:displayName>WebServiceUser</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>true</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:email>webuser@mycompany.com</ns3:email> 
    <ns3:createdTime>2010-03-02T22:11:32.935Z</ns3:createdTime> 
    <ns3:failedLoginCount>0</ns3:failedLoginCount> 
    <ns3:scopeId>B47EAECF6AD14AA028B4EA038CB742D0</ns3:scopeId> 
    <ns3:scopeType>Tenant</ns3:scopeType> 
   </ns2:user> 
  </ns2:getUserResponse> 
 </S:Body> 
</S:Envelope>

The following code is an example of a SOAP request to logout.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>8F059BEEA3611033D277773A95404641</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:logout/> 
 </soapenv:Body> 
</soapenv:Envelope>

Cloud examples

The following examples apply to the Cloud only.

The previous examples used SOAP operations that ran in a tenant in the Cloud or an Integration Appliance. To
run operations in environments within a tenant in the Cloud, you use the setCurrentScope operation to set the
scope to the environment where you want to run SOAP operations.

The following example sets the scope to the development environment and then starts a project located in the
development environment.

 2393



<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>63Y93HD6D856EB5812EB71216C3547W7</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:setCurrentScope> 
   <sec:scopeName>Development</sec:scopeName> 
  </sec:setCurrentScope> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:setCurrentScopeResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:setCurrentScopeResponse> 
 </S:Body> 
</S:Envelope>

The following example is a SOAP request to start a configuration in the development environment.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>63Y93HD6D856EB5812EB71216C3547W7</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:start> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:start> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:startResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/deployment/ 
  types" xmlns:ns4="http://www.approuter.com/schema/router/1000/security/03" 
  xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:startResponse> 
 </S:Body> 
</S:Envelope>
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WSDL files
Client-side web services use the WSDL file to create stubs that enable client-side applications to interact with
an Integration Appliance or Cloud project.

The WSDL files specify the operations that a client application can use to install, manage, and monitor an
Integration Appliance or Cloud project.

The Management API is defined in six WSDL files:

security.wsdl
staging.wsdl
deployment.wsdl
system.wsdl
orcmon.wsdl
lognotif.wsdl

You can download the WSDL files from the following locations for an Integration Appliance:

Security: https://<appliance>/ws/security?wsdl
Staging: https://<appliance>/ws/staging?wsdl
Deployment: https://<appliance>/ws/deployment?wsdl
System: https://<appliance>/ws/system?wsdl
Orcmon: https://<appliance>/ws/orcmon?wsdl
Lognotif: https://<appliance>/ws/lognotif?wsdl

You can download the WSDL files from the following locations for the Cloud:

Security: https://cloud2.castiron.com/ws/security?wsdl
Staging: https://cloud2.castiron.com/ws/staging?wsdl
Deployment: https://cloud2.castiron.com/ws/deployment?wsdl
System: https://cloud2.castiron.com/ws/system?wsdl
Orcmon: https://cloud2.castiron.com/ws/orcmon?wsdl
Lognotif: https://cloud2.castiron.com/ws/lognotif?wsdl
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This glossary defines WebSphere® DataPower® Cast Iron® Management API Guide terms that are used in this
documentation.

This glossary contains terms specific to WebSphere DataPower Cast Iron Management API Guide .

A  B  C  D  E  F  G  H  I  J  K  L  M  N  O  P  Q  R  S  T  U  V  W  X  Y  Z 

E

environment
In the Cloud, an environment is a subdivision of a tenant. A typical tenant contains development,
staging, and production environments. An environment has its own administrators, users, roles, and role
groups. After a project is completed in the Modify tab, it is published to an environment where it can be
deployed, tested, and run. The administrator role of an environment can assign users to roles and
roleGroups. In addition, the administrator role can create, deploy, run, clone, and delete projects and
configurations in the environment.

TOP

R

role
Role is a way to provide users with a pre-defined set of permissions. When an administrator assigns a
role to a user the user is able to access all of the projects to which the role is has permissions. The user
can also perform all of the actions for which the role has permissions. In the Cloud, the user gets access
to any tenants and environments to which the role has permissions.

roleGroup
Use to combine roles into a single entity which can then be assigned to users. A user assigned to a
roleGroup inherits all of the access and permissions that the roles in the roleGroup are given.

TOP

S

scope
In the Cloud, scope refers to either a tenant or an environment within a tenant. You use setCurrentScope
to set the scope to where you want to run SOAP operations. Scope applies to the Cloud only.

TOP

T

tenant
The Cloud is a multi-tenant cloud as opposed to a single-tenant cloud. Each tenant can be divided into
environments such as development, staging, and production. The administrator role of the tenant can
assign users to environments, roles, and roleGroups. In addition, the administrator role can create,
deploy, run, clone, and delete projects and configurations in the tenant and environments within the
tenant.

TOP

Feedback | Notices
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Security
Information about the security WSDL.

The security WSDL provides operations to create, get, list and delete users, roles, and permissions. You log in
and log out by using the security WSDL.

This section contains the following topics:

addRoleToRoleGroup
changePassword
clearPrivileges
createRole
createUser
currentScope
deleteRole
deleteUser
disableUser
enableUser
filterNewUsers
filterUsers
getGrantedRoles
getImpliedRoles
getKerberosRealm
getKerberosServer
getRole
getRoleById
getRoleGroups
getRoles
getRolesInRoleGroup
getRoleUsers
getScope
getScopeById
getScopesByParentId
getUser
getUserById
getUsers
grantPrivilege
grantPrivileges
grantRole
hasPrivilege
isRealmUser
isUserEnabled
listAvailableActions
listGrantableRoles
listPrivileges
listRoles
listUsers
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login
logout
removeKerberosConfiguration
removeRoleFromRoleGroup
revokePrivilege
revokeRole
roleExists
setCurrentScope
setCurrentScopeById
setKerberosConfiguration
setLdapConfiguration
updateRole
updateUser
userExists
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addRoleToRoleGroup
Adds the specified role as a member to the specified group.

Applies to Clouds and Integration Appliances.

Parameters:

role
The name of the role.

group
The name of the group to which the role is to be added.

Returns:
True if the role is successfully added to the group.
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changePassword
Changes the password for the specified username.

Parameters:

username
The username for which the password is to be changed.

oldPassword
The old password for the username.

newPassword
The new password for the username.

Returns:
True if the password was successfully changed.

Examples:

The following example is a SOAP request to change the password for a user.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>B0097A43C5527FA552C3DDBA7EF74CE9</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:changePassword> 
   <sec:username>webman</sec:username> 
   <sec:oldPassword>Oldpw12g</sec:oldPassword> 
   <sec:newPassword>Newpw24e</sec:newPassword> 
  </sec:changePassword> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:changePasswordResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:changePasswordResponse> 
 </S:Body> 
</S:Envelope>
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clearPrivileges
Clears privileges for the specified target, such as a user.

Applies to Clouds and Integration Appliances.

Parameter:

target
The specified target.

Returns:
True if the privileges are cleared for the specified target.

Examples:

The following code is an example of a SOAP request to create a user.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>B87CDEE24C7AE5EE4B1C00158EBC483D</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:clearPrivileges> 
   <sec:target>pubuser</sec:target> 
  </sec:clearPrivileges> 
 </soapenv:Body> 
</soapenv:Envelope>

The following code is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:clearPrivilegesResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <return>true</return> 
  </ns2:clearPrivilegesResponse> 
 </S:Body> 
</S:Envelope>
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createRole
Creates a role.
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Applies to Clouds and Integration Appliances.

Parameters:

role
The specified roleName for the role that you want created.

displayName
The name to be displayed in the WMC.

email
The email address for the role.

Returns:
True if the role is created.

Examples:

The following example is a SOAP request to create a role. The input for the request is the session ID.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>85E3EB542F02449CE3FDC302A25E47F9</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:createRole> 
   <sec:role>jobmonitor</sec:role> 
   <sec:displayName>jobmonitor</sec:displayName> 
   <sec:email>monitor@mycompany.com</sec:email> 
  </sec:createRole> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:createRoleResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:createRoleResponse> 
 </S:Body> 
</S:Envelope>
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Creates a user name.

Applies to Clouds and Integration Appliances.

Parameters:

username
The user ID to create.

password
The password for username.

displayName
The name to display in the WMC.

email
The email address for username.

Returns:
True if the username was successfully created.

Examples:

The following code is an example of a SOAP request to create a user.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>8F059BEEA3611033D277773A95404641</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:createUser> 
   <sec:username>webman</sec:username> 
   <sec:password>Connect2WS</sec:password> 
   <sec:displayName>WebServiceUser</sec:displayName> 
   <sec:email>webman@mycompany.com</sec:email> 
  </sec:createUser> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:createUserResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:createUserResponse> 
 </S:Body> 
</S:Envelope>
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currentScope
Returns the current scope for this thread.

Applies to Clouds only.

Returns:
The current scope.

Examples:

The following example is a SOAP request for the current scope. The input for the request is the session ID.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>85F500F8283BBD9E4F31DCE3FD894442</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:currentScope/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:currentScopeResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:scope> 
    <active>true</active> 
    <category>enterprise</category> 
    <displayName>mycompany.com</displayName> 
    <id>B47EAECF6AD14AA028B4EA038CB742D0</id> 
    <index>0</index> 
    <name>mycompany.com</name> 
    <parentId>00000000000000000000000000000000</parentId> 
    <type>TENANT</type> 
   </ns2:scope> 
  </ns2:currentScopeResponse> 
 </S:Body> 
</S:Envelope>
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deleteRole
Deletes a specified role.

Applies to Clouds and Integration Appliances.

Parameter:

role
The specified roleName to delete.

Returns:
True if the role is deleted.

Examples:

The following example is a SOAP request to delete a role.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>B0097A43C5527FA552C3DDBA7EF74CE9</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:deleteRole> 
   <sec:role>jobmonitor</sec:role> 
  </sec:deleteRole> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:deleteRoleResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:deleteRoleResponse> 
 </S:Body> 
</S:Envelope>
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deleteUser
Deletes the user with the specified username.
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Applies to Clouds and Integration Appliances.

Parameter:

username
The user to delete from the tenant, environment, or project.

Returns:
True if the user was successfully deleted.

Examples:

The following example is a SOAP request to delete a user.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>BAB25F1A2A1ADCC0BB0D455D41354509</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:deleteUser> 
   <sec:username>webman</sec:username> 
  </sec:deleteUser> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:deleteUserResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:deleteUserResponse> 
 </S:Body> 
</S:Envelope>
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disableUser
Disables a username. A disabled username cannot authenticate.

Applies to Clouds and Integration Appliances.

Parameter:
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username
The username to disable.

Returns:
True if the user was successfully disabled.

Examples:

The following example is a SOAP request to disable a user.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>BAB25F1A2A1ADCC0BB0D455D41354509</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:disableUser> 
   <sec:username>webman</sec:username> 
  </sec:disableUser> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:disableUserResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:disableUserResponse> 
 </S:Body> 
</S:Envelope>
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enableUser
Enables a user. An enabled user can authenticate.

Applies to Clouds and Integration Appliances.

Parameter:

username
The user to enable.

Returns:
True if the user was successfully enabled.
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Examples:

The following example is a SOAP request to enable a user.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>BAB25F1A2A1ADCC0BB0D455D41354509</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:enableUser> 
   <sec:username>webman</sec:username> 
  </sec:enableUser> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:enableUserResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" 
  xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:enableUserResponse> 
 </S:Body> 
</S:Envelope>
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filterNewUsers
Filters new users.

Applies to Clouds and Integration Appliances.

Parameters:

filter
The filter to run against the list of users.

sinceDate
The date to use to determine new users.

Returns:
Returns the new users.
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filterUsers
Filters users.

Applies to Clouds and Integration Appliances.

Parameter:

filter
The filter to run against a list of users.

Returns:
The users.

Examples:

The following example is a SOAP request to filter users that begin with a w.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>A5D2F0294EACB36B70622B8EE0E94706</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:filterUsers> 
   <sec:filter>w</sec:filter> 
  </sec:filterUsers> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:filterUsersResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:users>webman</ns2:users> 
  </ns2:filterUsersResponse> 
 </S:Body> 
</S:Envelope>

Feedback | Notices
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getGrantedRoles
Returns a list of all the roles explicitly granted to the specified user.

Applies to Clouds and Integration Appliances.

Parameter:

username
The specified user.

Returns:
The list of roles granted to the specified user.
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getImpliedRoles
Returns a list of all roles to which the specified user is a member. The list might contain roles that might not
have been explicitly granted to the user, but are indirectly implied due to group memberships.

Applies to Clouds and Integration Appliances.

Parameter:

username
The specified user.

Returns:
The role names.
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getKerberosRealm
Gets the Kerberos realm.

Applies to Clouds and Integration Appliances.

Returns:
The Kerberos realm.
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getKerberosServer
Gets the name of the Kerberos server.

Applies to Clouds and Integration Appliances.

Returns:
The Kerberos server name.
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getRole
Gets the specified role.

Applies to Clouds and Integration Appliances.

Parameter:

role
The specified role to return.
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Returns:
The specified role

Examples:

The following example is a SOAP request to get a role.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>BC77BA76E338CFA6B0063218A0AE4656</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:getRole> 
   <sec:name>publisher@A347B0C49C8CFA462D4F28A4C05B47C2</sec:name> 
  </sec:getRole> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getRoleResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  security" xmlns:ns3="http://www.approuter.com/schema/router/1000/security/03"> 
   <ns2:group> 
    <ns3:id>903273B869AC8CA9D99F4C8448694680</ns3:id> 
    <ns3:name>publisher@A347B0C49C8CFA462D4F28A4C05B47C2</ns3:name> 
    <ns3:displayName>Publisher Group</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>false</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:createdTime>2010-04-10T00:08:23Z</ns3:createdTime> 
    <ns3:scopeId>A347B0C49C8CFA462D4F28A4C05B47C2</ns3:scopeId> 
    <ns3:scopeType>Environment</ns3:scopeType> 
    <ns3:groupType>Publisher</ns3:groupType> 
   </ns2:group> 
  </ns2:getRoleResponse> 
 </S:Body> 
</S:Envelope>

For each role the following information is returned:

id
The ID for the role.

name
The name of the role.

displayName
The name displayed in the WMC for the role.

isActive
True or false depending on whether the role is active.

isMutable
True or false. True means that the object can be updated.

isVisible
True or false. True means that the object is visible in the WMC.
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email
The email address for the role.

createdTime
The date and time the role was created. The time is compliant with ISO 8601.

scopeId
The ID of the scope where the role is found. (Cloud only.)

scopeType
The type of scope, either tenant or environment. (Cloud only.)

groupType
The type of group to which the role belongs. If you create your own group, it is a custom group. For
information about the built-in groups, see WMC Help > Permissions > About Built-in Groups.

Feedback | Notices
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getRoleById
Gets the specified role.

Applies to Clouds and Integration Appliances.

Parameter:

id
The specified ID for the role that you want returned.

Returns:
The role for the specified ID.

Examples:

The following example is a SOAP request to get a role by the ID of the role.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/ 
schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>A85C21BB99E816D48800C90B2C5547D4</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:getRoleById> 
   <sec:id>8F52644BBA2491693D440F2FA12A4B3D</sec:id> 
  </sec:getRoleById> 
 </soapenv:Body> 
</soapenv:Envelope>
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The following example is a SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getRoleByIdResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" 
  xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:group> 
    <ns3:id>8F52644BBA2491693D440F2FA12A4B3D</ns3:id> 
    <ns3:name>securitymonitor</ns3:name> 
    <ns3:displayName>monitor</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>true</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:email>security@mycompany.com</ns3:email> 
    <ns3:createdTime>2010-03-23T19:14:30.066Z</ns3:createdTime> 
    <ns3:scopeId>A6EFAF24DB7168A4206F605CA6E14B1D</ns3:scopeId> 
    <ns3:scopeType>Tenant</ns3:scopeType> 
    <ns3:groupType>Custom</ns3:groupType> 
   </ns2:group> 
  </ns2:getRoleByIdResponse> 
 </S:Body> 
</S:Envelope>

For each role the following information is returned:

id
The ID for the role.

name
The name of the role.

displayName
The name displayed in the WMC for the role.

isActive
True or false depending on whether the role is active.

isMutable
True or false. True means that the object can be updated.

isVisible
True or false. True means that the object is visible in the WMC.

email
The email address for the role.

createdTime
The date and time the role was created. The time is compliant with ISO 8601.

scopeId
The ID of the scope where the role is found. (Cloud only.)

scopeType
The type of scope, either tenant or environment. (Cloud only.)

groupType
The type of group to which the role belongs.
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getRoleGroups
Returns a list of all the groups to which the specified role is a member.

Applies to Clouds and Integration Appliances.

Parameter:

role
The specified role.

Returns:
The list of groups.
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getRoles
Gets a list of all roles.

Applies to Clouds and Integration Appliances.

Returns:
The roles.

Examples:

The following example is a SOAP request to get roles.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/ 
security"> 
 <soapenv:Header> 
  <sec:sessionId>84076B5B810064272043B5106EEE46C3</sec:sessionId> 
 </soapenv:Header> 
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 <soapenv:Body> 
  <sec:getRoles/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getRolesResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" 
  xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:roles> 
    <ns3:id>9A8B9ED954A3781D47C6BA88E6B048BA</ns3:id> 
    <ns3:name>user@B74A0FF293331AB2A7E4F21E15D143F3</ns3:name> 
    <ns3:displayName>User Group</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>false</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:createdTime>2010-04-02T22:44:31Z</ns3:createdTime> 
    <ns3:scopeId>B74A0FF293331AB2A7E4F21E15D143F3</ns3:scopeId> 
    <ns3:scopeType>Environment</ns3:scopeType> 
    <ns3:groupType>User</ns3:groupType> 
   </ns2:roles> 
   <ns2:roles> 
    <ns3:id>A15F37B1499136A2151868DE1E47400F</ns3:id> 
    <ns3:name>publisher@B74A0FF293331AB2A7E4F21E15D143F3</ns3:name> 
    <ns3:displayName>Publisher Group</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>false</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:createdTime>2010-04-02T22:44:31Z</ns3:createdTime> 
    <ns3:scopeId>B74A0FF293331AB2A7E4F21E15D143F3</ns3:scopeId> 
    <ns3:scopeType>Environment</ns3:scopeType> 
    <ns3:groupType>Publisher</ns3:groupType> 
   </ns2:roles> 
   <ns2:roles> 
    <ns3:id>B3BED651CA6AC0259BE3B5CBB14D4BF8</ns3:id> 
    <ns3:name>admin@B74A0FF293331AB2A7E4F21E15D143F3</ns3:name> 
    <ns3:displayName>Administrator Group</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>false</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:createdTime>2010-04-02T22:44:31Z</ns3:createdTime> 
    <ns3:scopeId>B74A0FF293331AB2A7E4F21E15D143F3</ns3:scopeId> 
    <ns3:scopeType>Environment</ns3:scopeType> 
    <ns3:groupType>Admin</ns3:groupType> 
   </ns2:roles> 
   <ns2:roles> 
    <ns3:id>B7DD994177067F9B6238B08AE6114F2A</ns3:id> 
    <ns3:name>monitor</ns3:name> 
    <ns3:displayName>Job Monitor</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>true</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:email>monitor@mycompany.com</ns3:email> 
    <ns3:createdTime>2010-04-08T16:57:20.765Z</ns3:createdTime> 
    <ns3:scopeId>B74A0FF293331AB2A7E4F21E15D143F3</ns3:scopeId> 
    <ns3:scopeType>Environment</ns3:scopeType> 
    <ns3:groupType>Custom</ns3:groupType> 
   </ns2:roles> 
  </ns2:getRolesResponse> 
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 </S:Body> 
</S:Envelope>

For each role the following is returned:

id
The ID for the role.

name
The name of the role.

displayName
tThe name displayed in the WMC for the role.

isActive
True or false depending on whether the role is active.

isMutable
True or false. True means that the object can be updated.

isVisible
True or false. True means that the object is visible in the WMC.

email
The email address for the role.

createdTime
The date and time the role was created. The time is compliant with ISO 8601.

scopeId
The ID of the scope where the role is found. (Cloud only.)

scopeType
The type of scope, either tenant or environment. (Cloud only.)

groupType
The type of group to which the role belongs.
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getRolesInRoleGroup
Returns a list of all the roles in the specified role group.

Applies to Clouds and Integration Appliances.

Parameter:
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name
The specified role group.

Returns:
The list of roles for the specified role group.
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getRoleUsers
Returns a list of all the users that are members of the specified role.

Applies to Clouds and Integration Appliances.

Parameter:

name
The specified role.

Returns:
The list of users for the specified role.

Feedback | Notices
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getScope
Gets the specified scope in the specified parent scope.

Applies to Clouds only.

Parameters:

scopeType
The type of scope, which is either tenant or environment.

name
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The name of the scope.

parentScopeId
The ID of the parent scope.

Returns:
The specified scope.

Examples:

The following example is a SOAP request to get the specified scope in the specified parent scope.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>AA91E56114D36B296D82660639B6482F</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:getScope> 
   <sec:scopeType>ENV</sec:scopeType> 
   <sec:name>Staging</sec:name> 
   <sec:parentScopeId>88673D5DF2583806B037576D94F34BBA</ 
   sec:parentScopeId> 
  </sec:getScope> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getScopeResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:scope> 
    <active>true</active> 
    <displayName>Staging</displayName> 
    <id>A51EDD44BE6C10B2D1335A9D634D407D</id> 
    <index>1</index> 
    <name>Staging</name> 
    <parentId>88673D5DF2583806B037576D94F34BBA</parentId> 
    <type>ENV</type> 
   </ns2:scope> 
  </ns2:getScopeResponse> 
 </S:Body> 
</S:Envelope>

Feedback | Notices
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getScopeById
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Gets the scope as specified by the ID.

Applies to Clouds only.

Parameter:

scopeID
The ID for the scope.

Returns:
The scope as specified by the ID.

Examples:

The following code is an example of a SOAP request to get a scope by its ID.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>B60EA6425F8FCB16BB6E96063D09408E</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:getScopeById> 
   <sec:scopeId>9378E8C3C5E5DCACA77D9F7B6BE24B98</sec:scopeId> 
  </sec:getScopeById> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getScopeByIdResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:scope> 
    <active>true</active> 
    <category>enterprise</category> 
    <displayName>mycompany.com</displayName> 
    <id>9378E8C3C5E5DCACA77D9F7B6BE24B98</id> 
    <index>0</index> 
    <name>castiron.com</name> 
    <parentId>00000000000000000000000000000000</parentId> 
    <type>TENANT</type> 
   </ns2:scope> 
  </ns2:getScopeByIdResponse> 
 </S:Body> 
</S:Envelope>
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getScopesByParentId
Using the ID of the parent scope, returns a list of all the child scopes.

Applies to Clouds only.

Parameter:

parentScopeId
The ID for the parent scope.

Returns:
A list of child scopes.

Examples:

The following example is a SOAP request to get scopes by using the ID of the parent scope.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/ 
schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>B0097A43C5527FA552C3DDBA7EF74CE9</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:getScopesByParentId> 
   <sec:parentScopeId>BB173AE61484BD7359D8910789EA4E88</ 
   sec:parentScopeId> 
  </sec:getScopesByParentId> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request. The parent scope is a tenant and the child scopes
are the environments in the tenant.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getScopesByParentIdResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" 
  xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
  <ns2:scopes> 
    <active>true</active> 
    <displayName>Staging</displayName> 
    <id>9203C78275503796DB49CB5E6CF34111</id> 
    <index>1</index> 
    <name>Staging</name> 
    <parentId>BB173AE61484BD7359D8910789EA4E88</parentId> 
    <type>ENV</type> 
   </ns2:scopes> 
   <ns2:scopes> 
    <active>true</active> 
    <displayName>Development</displayName> 
    <id>A26D2319BAE05E9513117949CF274A09</id> 
    <index>0</index> 
    <name>Development</name> 
    <parentId>BB173AE61484BD7359D8910789EA4E88</parentId> 
    <type>ENV</type> 
   </ns2:scopes> 
   <ns2:scopes> 
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    <active>true</active> 
    <displayName>Production</displayName> 
    <id>B56005332F3E41A3F1456F5F40594A06</id> 
    <index>2</index> 
    <name>Production</name> 
    <parentId>BB173AE61484BD7359D8910789EA4E88</parentId> 
    <type>ENV</type> 
   </ns2:scopes> 
  </ns2:getScopesByParentIdResponse> 
 </S:Body> 
</S:Envelope>

For each child scope, the following information is returned:

active
True or false. True means that the scope is active.

displayName
The name displayed in the WMC for the role.

id
The ID for the child scope.

index
The position in the index of the child scope.

name
The name of the child scope.

parentId
The ID of the parent scope.

type
The type of scope.
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getUser
Gets the user for specified username.

Applies to Clouds and Integration Appliances.

Parameter:

username
The specified username.
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Returns:
The user corresponding to the specified username.

Examples:

The following example is a SOAP request to get a user by using the specified username.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>BF1E7729085BB066446DF913FAE34596</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:getUser> 
   <sec:username>webman</sec:username> 
  </sec:getUser> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getUserResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  security" xmlns:ns3="http://www.approuter.com/schema/router/1000/security/03"> 
   <ns2:user> 
    <ns3:id>965AAB3FED8D3CCBBE4DC8EE0E2944EA</ns3:id> 
    <ns3:name>webman</ns3:name> 
    <ns3:encPasswd>{SHA}clO20r2ZJMJcDrNwXQzhWB8YcdI=</ns3:encPasswd> 
    <ns3:displayName>WebServiceUser</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>true</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:email>webman@mycompany.com</ns3:email> 
    <ns3:createdTime>2010-03-02T22:11:32.935Z</ns3:createdTime> 
    <ns3:failedLoginCount>0</ns3:failedLoginCount> 
    <ns3:scopeId>B47EAECF6AD14AA028B4EA038CB742D0</ns3:scopeId> 
    <ns3:scopeType>Tenant</ns3:scopeType> 
   </ns2:user> 
  </ns2:getUserResponse> 
 </S:Body> 
</S:Envelope>

For each user the following information is returned:

id
The ID for the user.

name
The name for the user.

encPasswd
The SHA encoded password for the user.

displayName
The name displayed in the WMC for the role.

isActive
True if the user is logged in, false if not.

isMutable
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True or false. True means that the object can be updated, false if not.

isVisible
True or false. True means that the object is visible in the WMC, false if not.

email
The email address for the user.

createdTime
The date and time the user was created.

failedLoginCount
The number of failed attempts to log in by using this name. After five failures, the username is blocked
for 15 seconds. For each successive failure, the blocked time is doubled (15 - 30 - 60 - 120).

scopeId
The scope ID for the scope where the user is located. Does not apply for Integration Appliances.

scopeType
The type of scope, either tenant or environment. Does not apply for Integration Appliances.
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getUserById
Gets the user by the specified ID.

Applies to Clouds and Integration Appliances.

Parameter:

id
The specified ID for the user.

Returns:
The user with the specified ID.

Examples:

The following example is a SOAP request to get a user by the specified ID.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>BAB25F1A2A1ADCC0BB0D455D41354509</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
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  <sec:getUserById> 
   <sec:id>9707B975E42F2B6135D6FB0FA36C4E53</sec:id> 
  </sec:getUserById> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getUserByIdResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:user> 
    <ns3:id>9707B975E42F2B6135D6FB0FA36C4E53</ns3:id> 
    <ns3:name>webman</ns3:name> 
    <ns3:encPasswd>{SHA}gf/yUAZHWaZFHdCMaxDHVmmd4FE=</ns3:encPasswd> 
    <ns3:displayName>Webuser</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>true</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:email>webman@castiron.com</ns3:email> 
    <ns3:createdTime>2010-03-11T19:03:46.737Z</ns3:createdTime> 
    <ns3:failedLoginCount>0</ns3:failedLoginCount> 
    <ns3:scopeId>B47EAECF6AD14AA028B4EA038CB742D0</ns3:scopeId> 
    <ns3:scopeType>Tenant</ns3:scopeType> 
   </ns2:user> 
  </ns2:getUserByIdResponse> 
 </S:Body> 
</S:Envelope>

For each user the following information is returned:

id
The ID for the user.

name
The name for the user.

encPasswd
The SHA encoded password for the user.

displayName
The name displayed in the WMC for the user.

isActive
True or false depending on whether the user is logged in.

isMutable
True or false. True means that the object can be updated. False means that the object cannot be
updated.

isVisible
True or false. True means that the object is visible in the WMC.

email
tThe email address for the user.

createdTime
The date and time the user was created.
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failedLoginCount
The number of failed attempts to log in by using this name. After five failures, the username is blocked
for 15 seconds. For each successive failure, the blocked time is doubled (15 - 30 - 60 - 120).

scopeId
The scope ID for the scope where the user is located. Applies to Cloud only.

scopeType
The type of scope, either tenant or environment. Applies to Cloud only.
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getUsers
Gets a list of all the users based on the session ID.

Applies to Clouds and Integration Appliances.

Returns:
The users

Examples:

The following example is a SOAP request to get users. The input for the request is the session ID.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>8EB8F17160F7D1E561EC45EFEBF344CF</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:getUsers/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request to get users:

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getUsersResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:users> 
    <ns3:id>860DDF6E8DE511EF0EA8E249A1514EA1</ns3:id> 
    <ns3:name>foo@mycompany.com</ns3:name> 
    <ns3:encPasswd>{SHA}L84w50sj87W4IQUhr2NqKsuO8kI=</ns3:encPasswd> 
    <ns3:displayName>Foo</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>true</ns3:isMutable> 
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    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:email>foo@mycompany.com</ns3:email> 
    <ns3:createdTime>2010-02-24T23:12:10.252Z</ns3:createdTime> 
    <ns3:failedLoginCount>0</ns3:failedLoginCount> 
    <ns3:scopeId>B47EAECF6AD14AA028B4EA038CB742D0</ns3:scopeId> 
    <ns3:scopeType>Tenant</ns3:scopeType> 
   </ns2:users> 
   <ns2:users> 
    <ns3:id>90D63CC6F3A5F90C587B2B478858432D</ns3:id> 
    <ns3:name>admin@mycompany.com</ns3:name> 
    <ns3:encPasswd>{SHA}8eQYsQgWL3V0sLf7akuJO5wM11c=</ns3:encPasswd> 
    <ns3:displayName>admin@mycompany.com</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>false</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:email>admin@mycompany.com</ns3:email> 
    <ns3:createdTime>2010-02-12T21:50:35Z</ns3:createdTime> 
    <ns3:lastLoginTime>2010-03-10T17:20:39.774Z</ns3:lastLoginTime> 
    <ns3:lastFailedLoginTime>2010-03-03T18:25:24.936Z</ 
    ns3:lastFailedLoginTime> 
    <ns3:failedLoginCount>0</ns3:failedLoginCount> 
    <ns3:scopeId>B47EAECF6AD14AA028B4EA038CB742D0</ns3:scopeId> 
    <ns3:scopeType>Tenant</ns3:scopeType> 
   </ns2:users> 
   <ns2:users> 
    <ns3:id>965AAB3FED8D3CCBBE4DC8EE0E2944EA</ns3:id> 
    <ns3:name>webman</ns3:name> 
    <ns3:encPasswd>{SHA}clO20r2ZJMJcDrNwXQzhWB8YcdI=</ns3:encPasswd> 
    <ns3:displayName>WebServiceUser</ns3:displayName> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:isMutable>true</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:email>webman@mycompany.com</ns3:email> 
    <ns3:createdTime>2010-03-02T22:11:32.935Z</ns3:createdTime> 
    <ns3:failedLoginCount>0</ns3:failedLoginCount> 
    <ns3:scopeId>B47EAECF6AD14AA028B4EA038CB742D0</ns3:scopeId> 
    <ns3:scopeType>Tenant</ns3:scopeType> 
   </ns2:users> 
   <ns2:users> 
    <ns3:id>B77F69E6D9488E2607B02076B4F848DC</ns3:id> 
    <ns3:name>support@mycompany.com</ns3:name> 
    <ns3:encPasswd>{SHA}Ek2MpQlE1+fGMEYo1kSF6lpbNIk=</ns3:encPasswd> 
    <ns3:displayName>support@mycompany.com</ns3:displayName> 
    <ns3:isActive>false</ns3:isActive> 
    <ns3:isMutable>false</ns3:isMutable> 
    <ns3:isVisible>true</ns3:isVisible> 
    <ns3:email>support@mycompany.com</ns3:email> 
    <ns3:createdTime>2010-02-12T21:50:35Z</ns3:createdTime> 
    <ns3:failedLoginCount>0</ns3:failedLoginCount> 
    <ns3:scopeId>B47EAECF6AD14AA028B4EA038CB742D0</ns3:scopeId> 
    <ns3:scopeType>Tenant</ns3:scopeType> 
   </ns2:users> 
  </ns2:getUsersResponse> 
 </S:Body> 
</S:Envelope>

For each user the following information is returned:

id
The ID for the user.

name
The name for the user.
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encPasswd
The SHA encoded password for the user.

displayName
The name displayed in the WMC for the user.

isActive
True or false depending on whether the user is logged in.

isMutable
True or false. True means that the object can be updated, false if not.

isVisible
True or false. True means that the object is visible in the WMC, false if not.

email
The email address for the user.

createdTime
The date and time the user was created.

failedLoginCount
The number of failed attempts to log in to the tenant by using this name. After five failures, the
username is blocked for 15 seconds. For each successive failure, the blocked time is doubled.

scopeId
The scope ID for the scope where the user is located. Applies to Clouds only.

scopeType
The type of scope, either tenant or environment. Applies to Clouds only.
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grantPrivilege
Grants the specified privilege.

Applies to Clouds and Integration Appliances.

Parameter:

privilege
The specified privilege being granted.

Returns:
True if the privilege is granted.
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grantPrivileges
Grants the specified privileges.

Applies to Clouds and Integration Appliances.

Parameter:

privileges
The specified privileges being granted.

Returns:
True if the privileges are granted.
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grantRole
Grants a specified role to a specified user.

Applies to Clouds and Integration Appliances.

Parameters:

userName
The specified userName to whom the specified roleName is to be granted.

role
The specified roleName to be granted to the specified userName.

Returns:
True if the role is granted to the user.

The following example is a SOAP request to grant a role.

2428   



Request: 
<soapenv:Envelope 
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"xmlns:sec=" 
http://www.approuter.com/schemas/2008/1/security"> 
<soapenv:Header> 
<sec:sessionId>AEBD5F4E5F311F0B60F6C12642F0418F</sec:sessionId> 
</soapenv:Header> 
<soapenv:Body> 
<sec:grantRole> 
<sec:username>test</sec:username> 
<sec:role>user</sec:role> 
</sec:grantRole> 
</soapenv:Body> 
</soapenv:Envelope>  
 
 
Response: 
<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
<S:Body> 
<ns3:grantRoleResponse xmlns:ns3="http://www.approuter.com/schemas/2008/1/security"  
xmlns:ns2="http://www.approuter.com/schema/router/1000/security/03"> 
<ns3:success>true</ns3:success> 
</ns3:grantRoleResponse> 
</S:Body> 
</S:Envelope>
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hasPrivilege
Returns true if a privilege exists for the specified user, target, and action.

Applies to Clouds and Integration Appliances.

Parameters:

username
The specified user.

target
The specified target.

action
The specified action.

Returns:
True if the privilege exists.
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isRealmUser
Returns true if the specified user belongs to the realm that corresponds to the session ID.

Applies to Clouds and Integration Appliances.

Parameter:

username
The specified user.

Returns:
True if the user belongs to the realm.

Examples:

The following example is a SOAP request to check if the specified user belongs to the realm.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>A85C21BB99E816D48800C90B2C5547D4</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:isRealmUser> 
   <sec:username>admin@mycompany.com</sec:username> 
  </sec:isRealmUser> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:isRealmUserResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:isRealmUser>true</ns2:isRealmUser> 
  </ns2:isRealmUserResponse> 
 </S:Body> 
</S:Envelope>

Feedback | Notices
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isUserEnabled
Checks to see if the specified username is enabled. An enabled user is authenticated.

Applies to Clouds and Integration Appliances.

Parameter:

username
The username to be checked.

Returns:
True if the specified username is enabled.

Examples:

The following example is a SOAP request to check if the specified user is enabled.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>A85C21BB99E816D48800C90B2C5547D4</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:isUserEnabled> 
   <sec:username>webman</sec:username> 
  </sec:isUserEnabled> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:isUserEnabledResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:isUserEnabled>true</ns2:isUserEnabled> 
  </ns2:isUserEnabledResponse> 
 </S:Body> 
</S:Envelope>
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listAvailableActions
List the available actions for a specified target.

Applies to Clouds and Integration Appliances.

Parameter:

target
The specified target.

Returns:
The list of actions for the specified target.
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listGrantableRoles
Returns a list of roles that can be granted (excludes conditional roles).

Applies to Clouds and Integration Appliances.

Returns:
The list of roles.

Examples:

The following example is a SOAP request to list the grantable roles.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>AA91E56114D36B296D82660639B6482F</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:listGrantableRoles/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:listGrantableRolesResponse xmlns:ns2="http://www.approuter.com/ 
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  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:roles>admin@A51EDD44BE6C10B2D1335A9D634D407D</ns2:roles> 
   <ns2:roles>user@A51EDD44BE6C10B2D1335A9D634D407D</ns2:roles> 
   <ns2:roles>publisher@A51EDD44BE6C10B2D1335A9D634D407D</ns2:roles> 
  </ns2:listGrantableRolesResponse> 
 </S:Body> 
</S:Envelope>
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listPrivileges
Returns a list of privileges for the specified targets and action.

Applies to Clouds and Integration Appliances.

Parameters:

targets
The specified targets.

action
The specified action.

Returns:
The list of privileges.
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listRoles
Gets a list of all the role names.

Applies to Clouds and Integration Appliances.

Returns:
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The role names.

Examples:

The following example is a SOAP request to get the role names.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>84076B5B810064272043B5106EEE46C3</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:listRoles/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:listRolesResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:roles>user@B74A0FF293331AB2A7E4F21E15D143F3</ns2:roles> 
   <ns2:roles>publisher@B74A0FF293331AB2A7E4F21E15D143F3</ns2:roles> 
   <ns2:roles>admin@B74A0FF293331AB2A7E4F21E15D143F3</ns2:roles> 
  </ns2:listRolesResponse> 
 </S:Body> 
</S:Envelope>
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listUsers
Returns a list of all users.

Applies to Clouds and Integration Appliances.

Returns:
A list of all users.

Examples:

The following example is a SOAP request for the list of users.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>8F059BEEA3611033D277773A95404641</sec:sessionId> 
 </soapenv:Header> 
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 <soapenv:Body> 
  <sec:listUsers/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request for the list of users:

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:listUsersResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:users>foo@mycompany.com</ns2:users> 
   <ns2:users>httpclient@mycompany.com</ns2:users> 
   <ns2:users>admin@mycompany.com</ns2:users> 
   <ns2:users>webman@mycompany.com</ns2:users> 
   <ns2:users>support@mycompany.com</ns2:users> 
  </ns2:listUsersResponse> 
 </S:Body> 
</S:Envelope>
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login
Logs in to an Integration Appliance or a Cloud.

Parameters:

username
The user ID that you use to log in to an Integration Appliance or Cloud.

password
The password for username.

Returns:
The session ID.

Examples:

The following code is an example of a SOAP request that you can use to log in to the web service:
Note: To login to the Cast Iron Live web service, use the IBM ID Credentials for the username and password
fields in the SOAP request.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header/> 
 <soapenv:Body> 
  <sec:login> 
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   <sec:username>webman@mycompany.com</sec:username> 
   <sec:password>My6word3S</sec:password> 
  </sec:login> 
 </soapenv:Body> 
</soapenv:Envelope>

The password must be at least eight characters long and contain a combination of three of the following
characters:

Alphabet characters
Uppercase alphabet characters
Numbers
Special characters

The following code is an example of a SOAP response to a successful login request:

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:loginResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  security" xmlns:ns3="http://www.approuter.com/schema/router/1000/security/03"> 
   <ns2:sessionId>8F059BWEA3611033D277773A95404641</ns2:sessionId> 
  </ns2:loginResponse> 
 </S:Body> 
</S:Envelope>

The session ID is required to run the other operations in the Management API after logging in.
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logout
Logs out of an Integration Appliance or Cloud.

Returns:
Logs out of the Integration Appliance or Cloud

Examples:

The following example is a SOAP request to log out.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>BB93F99B80AC742BEE3BC81262C2486F</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:logout/> 
 </soapenv:Body> 
</soapenv:Envelope>
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The following example is a SOAP reply to a logout request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:logoutResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  security" xmlns:ns3="http://www.approuter.com/schema/router/1000/security/03"> 
   <return>true</return> 
  </ns2:logoutResponse> 
 </S:Body> 
</S:Envelope>
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removeKerberosConfiguration
Removes the Kerberos configuration.

Applies to Clouds and Integration Appliances.
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removeRoleFromRoleGroup
Removes the specified role as a member of the specified group.

Applies to Clouds and Integration Appliances.

Parameters:

role
The name of the role.

group
The name of the group from which the role is to be removed.

Returns:
True if the role is successfully removed from the group.
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revokePrivilege
Revokes the specified privilege.

Applies to Clouds and Integration Appliances.

Parameter:

privilege
The specified privilege being revoked.

Returns:
True if the privilege is revoked.
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revokeRole
Revokes a specified role from a specified user.

Applies to Clouds and Integration Appliances.

Parameters:

userName
The specified userName to whom the specified roleName is to be revoked.

role
The specified roleName to be revoked from the specified userName.

Returns:
True if the role is revoked from the user.
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roleExists
Checks if the specified role exists. Returns true if the role exists.

Applies to Clouds and Integration Appliances.

Parameter:

role
The specified role to be checked to see if it exists.

Returns:
True if the specified role exists.

Examples:

The following example is a SOAP request to check if a role exists.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>A85C21BB99E816D48800C90B2C5547D4</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:roleExists> 
   <sec:name>securitymonitor</sec:name> 
  </sec:roleExists> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is a SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:roleExistsResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:roleExists>true</ns2:roleExists> 
  </ns2:roleExistsResponse> 
 </S:Body> 
</S:Envelope>
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setCurrentScope
Sets the current scope for this thread.

Applies to Clouds only.

Returns:
True if the current scope was set.

Examples:

The following example is a SOAP request to set the current scope.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>84B7E4D6D856EB5812EB71896C3547CC</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:setCurrentScope> 
   <sec:scopeName>Development</sec:scopeName> 
  </sec:setCurrentScope> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:setCurrentScopeResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:setCurrentScopeResponse> 
 </S:Body> 
</S:Envelope>
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setCurrentScopeById
Sets the current scope for this thread.
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Applies to Clouds only.

Returns:
True if the current scope was set.

Examples:

The following example is a SOAP request to set the current scope by the ID of the tenant or environment.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>84B7E4D6D856EB5812EB71896C3547CC</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:setCurrentScopeById> 
   <sec:scopeId>8DA9ED360FCB9B3F6E867705490D4B9F</sec:scopeId> 
  </sec:setCurrentScopeById> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:setCurrentScopeByIdResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:setCurrentScopeByIdResponse> 
 </S:Body> 
</S:Envelope>
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setKerberosConfiguration
Sets the Kerberos configuration.

You can use the Kerberos protocol to provide security on an unsecured network for communication between
your server and Clouds or Integration Appliances.

Applies to Clouds and Integration Appliances.

Parameters:

serverName
The name of the Kerberos server.
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realm
The realm for the Kerberos server.
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setLdapConfiguration
Sets an LDAP configuration.

Applies to Clouds and Integration Appliances.

Parameter:

ldapConfig
The LDAP configuration.
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updateRole
Updates the specified role.

Applies to Clouds and Integration Appliances.

Parameters:

role
The specified roleName to be updated.

displayName
The name to be displayed in the WMC.

email
The email address for roleName.

Returns:
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True if the role is updated.
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updateUser
Updates a user.

Applies to Clouds and Integration Appliances.

Parameters:

username
The user name for the tenant associated with the session ID.

displayName
The name to display in the WMC.

email
The email address for the username.

Returns:
True if the user was successfully updated.

Examples:

The following example is a SOAP request to update a user. The input for the request is the session ID and the
username. The email address is being updated in this example.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>A85C21BB99E816D48800C90B2C5547D4</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:updateUser> 
   <sec:username>webman</sec:username> 
   <sec:displayName>?</sec:displayName> 
   <sec:email>webman@mycompany.com</sec:email> 
  </sec:updateUser> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:updateUserResponse xmlns:ns2="http://www.approuter.com/ 
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  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:success>true</ns2:success> 
  </ns2:updateUserResponse> 
 </S:Body> 
</S:Envelope>

The email address was successfully updated.
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userExists
Checks if the specified username exists.

Applies to Clouds and Integration Appliances.

Parameter:

username
The username for which the check is made.

Returns:
True if the username exists.

Examples:

The following example is a SOAP request to check if a user exists. The input for the request is the session ID
and the username.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sec="http://www.approuter.com/schemas/2008/1/security"> 
 <soapenv:Header> 
  <sec:sessionId>99E1848F7661D4FC066AD5F97AB44C0C</sec:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sec:userExists> 
   <sec:username>webman</sec:username> 
  </sec:userExists> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:userExistsResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/security" xmlns:ns3="http://www.approuter.com/schema/ 
  router/1000/security/03"> 
   <ns2:userExists>true</ns2:userExists> 
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  </ns2:userExistsResponse> 
 </S:Body> 
</S:Envelope>
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Deployment
Information about the deployment WSDL.

The deployment WSDL provides operations to create, get, and delete configurations, rules, and projects. You
can start, pause, stop, and cancel jobs. You can also import or export repositories.

This section contains the following topics:

cancelJob
cloneConfiguration
createAssets
createConfiguration
createRepeatingRule
createRule
createUserConfiguration
deleteConfiguration
deleteProject
deleteRule
deleteUserConfiguration
downloadProject
exportRepository
getAllProjects
getAssetGroupDisplayString
getAssetGroupScript
getAssetGroupWarnings
getAssetProperties
getAssetPropertiesBindings
getConfiguration
getConfigurationGroups
getProject
getRule
getRules
getUserConfiguration
getUserConfigurations
importRepository
publishProject
resume
saveOrchestrationValues
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saveProperties
setConfigurationGroups
start
stopAndCancel
stopAndWait
suspend
undeploy
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cancelJob
Cancels the specified job group.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the project.

Version
The version number for the project.

configName
The name used to identify a configuration, such as Default.

jobId
The ID for the job.

Together projectName, Version, and configName uniquely identify a configuration.

You can obtain the jobId by first running the searchJobs operation (orcmon.wsdl).
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cloneConfiguration
Clones the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

oldConfigName
The name of the configuration being cloned.

newConfigName
The name of the cloned configuration.

Returns:
The cloned configuration.

Examples:

The following code is an example of a SOAP request to clone a configuration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>855BE295392375C8551C8B98D6EA4774</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:cloneConfiguration> 
   <dep:projectName>GenericProject_1_Cloud</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:oldConfigName>GenericProject_2_Cloud</dep:oldConfigName> 
   <dep:newConfigName>GenericProject_3_Cloud</dep:newConfigName> 
  </dep:cloneConfiguration> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:cloneConfigurationResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:cloneConfigurationResponse> 
 </S:Body> 
</S:Envelope>
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createAssets
Creates assets by using the specified script.

The endpoint is specified as a project URL, such as project-url:// Endpoints/TargetDB. The module ID is
typically either http://www.approuter.com/module/webservice/ or http://
www.approuter.com/module/database/

Database assets must be enclosed as specified in the following table.

Database Enclosure

DB2® AS/400 " "

Informix® [ ]

Microsoft SQL [ ]

Oracle " "

Sybase " "

The following table lists the assets that can be created for the databases.

Database Asset

DB2 As/400, Informix, Microsoft,
Sybase

Applies to Clouds, Integration Appliances. Buffer tables, control tables,
and triggers.

Local Staging Database Buffer tables, control table, index tables, and triggers

Oracle Buffer tables, control tables, sequences, and triggers

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

ModuleID
The module ID for the assets.

endpointUrl
The endpoint URL for the assets.

2448   



propNames
The names of the property assets.

username
The user ID for the endpoint.

password
The password for the endpoint.

assetType
The type of asset.

script
The script to run against the endpoint.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
Success or failure.
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createConfiguration
Creates the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The specified configuration.

Examples:

The following example is a SOAP request to create a configuration.
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<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:createConfiguration> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363W</dep:configName> 
  </dep:createConfiguration> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:createConfigurationResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:createConfigurationResponse> 
 </S:Body> 
</S:Envelope>
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createRepeatingRule
Creates a repeating rule for downtime for the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

stopDate
The date the configuration is to be stopped.

restartDate
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The date the configuration is to be restarted.

downtimeType
The type or reason for the downtime.

repeat
Specifies that the downtime rule be repeated.

repeatInterval
Specifies the amount of time between repeats of the downtime rule.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The new repeating rule for the specified configuration.
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createRule
Creates a downtime rule for the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

stopDate
The date the configuration is to be stopped.

restartDate
The date the configuration is to be restarted.

downtimeType
The type or reason for the downtime.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
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The new downtime rule for the specified configuration.

Examples:

The following code is an example of a SOAP request to create a rule. Dates must conform to ISO 8601.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>8FDBC8ED7A014272714D23D14794473A</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:createRule> 
   <dep:projectName>GenericProject_1_Cloud</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>Default</dep:configName> 
   <dep:stopDate>2010-04-17T07:00:00.066Z</dep:stopDate> 
   <dep:restartDate>2010-04-17T08:00:00.066Z</dep:restartDate> 
   <dep:downtimeType>stop</dep:downtimeType> 
  </dep:createRule> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:createRuleResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:ruleId>2</ns2:ruleId> 
  </ns2:createRuleResponse> 
 </S:Body> 
</S:Envelope>
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createUserConfiguration
Creates the specified user configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.
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version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The specified user configuration.
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deleteConfiguration
Deletes the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Examples:

The following code is an example of a SOAP request to delete a configuration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>AACA96757B36C2B4582C811197EE43C0</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:deleteConfiguration> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:deleteConfiguration> 
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 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:deleteConfigurationResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:deleteConfigurationResponse> 
 </S:Body> 
</S:Envelope>
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deleteProject
Deletes the specified project.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

Examples:

The following code is an example of a SOAP request to delete a project.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>80C147E844799CA856AF3DB6910C4B63</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:deleteProject> 
   <dep:projectName>MIME_Test1</dep:projectName> 
   <dep:version>1.0</dep:version> 
  </dep:deleteProject> 
 </soapenv:Body> 
</soapenv:Envelope>
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The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:deleteProjectResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:deleteProjectResponse> 
 </S:Body> 
</S:Envelope>
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deleteRule
Deletes the rule for the specified ID.

Applies to Clouds and Integration Appliances.

Parameter:

ruleId
The specified ID for the rule to be deleted.

Examples:

The following code is an example of a SOAP request to delete a rule.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>8FDBC8ED7A014272714D23D14794473A</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:deleteRule> 
   <dep:ruleId>2</dep:ruleId> 
  </dep:deleteRule> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:deleteRuleResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
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   <ns2:success>true</ns2:success> 
  </ns2:deleteRuleResponse> 
 </S:Body> 
</S:Envelope>
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deleteUserConfiguration
Deletes the specified configuration for the specified user.

Applies to Clouds and Integration Appliances.

Parameters:

userName
The name of the specified user.

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Examples:

The following example is a SOAP request to delete the specified configuration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>AACA96757B36C2B4582C811197EE43C0</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:deleteConfiguration> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:deleteConfiguration> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request.
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<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:deleteConfigurationResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:deleteConfigurationResponse> 
 </S:Body> 
</S:Envelope>
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downloadProject
Downloads the specified project as a byte array.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The specified project in a compressed file.
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exportRepository
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Exports the project repository in XML format.

Applies to Integration Appliances only.

Returns:
The project repository in XML format.
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getAllProjects
Gets all the projects.

Applies to Clouds and Integration Appliances.

Returns:
All the projects.

Examples:

The following example is a SOAP request to get all projects.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:getAllProjects/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getAllProjectsResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:projects> 
    <assets/> 
    <configurations> 
     <configuration> 
      <envId> 
       <guidString>A51EDD44BE6C10B2D1335A9D634D407D</guidString> 
      </envId> 
      <lastmodified>2010-04-03T06:28:42.078Z</lastmodified> 
      <name>Default</name> 
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      <orchestrationValues> 
       <orchestrationValue> 
        <enabled>true</enabled> 
        <syncLoggingEnabled>false</syncLoggingEnabled> 
        <loggingLevel>errorValues</loggingLevel> 
        <maxJobs>1</maxJobs> 
        <orchestrationRelativeurl>project-url:// 
        Orchestrations/Receive</orchestrationRelativeurl> 
        <state>undeployed</state> 
       </orchestrationValue> 
       <orchestrationValue> 
        <enabled>true</enabled> 
        <syncLoggingEnabled>false</syncLoggingEnabled> 
        <loggingLevel>errorValues</loggingLevel> 
        <maxJobs>1</maxJobs> 
        <orchestrationRelativeurl>project-url:// 
        Orchestrations/Post</orchestrationRelativeurl> 
        <state>undeployed</state> 
       </orchestrationValue> 
      </orchestrationValues> 
      <projectName>HTTP_363i</projectName> 
      <projectVersion>1.0</projectVersion> 
      <propertyValues/> 
      <state>undeployed</state> 
     </configuration> 
    </configurations> 
    <envId> 
     <guidString>A51EDD44BE6C10B2D1335A9D634D407D</guidString> 
    </envId> 
    <lastpublished>2010-04-03T06:28:41.894Z</lastpublished> 
    <name>HTTP_363i</name> 
    <orchestrations> 
     <orchestration> 
      <relativeurl>project-url://Orchestrations/Post</relativeurl> 
     </orchestration> 
     <orchestration> 
      <relativeurl>project-url://Orchestrations/Receive</ 
      relativeurl> 
     </orchestration> 
    </orchestrations> 
    <properties/> 
    <version>1.0</version> 
   </ns2:projects> 
  </ns2:getAllProjectsResponse> 
 </S:Body> 
</S:Envelope>
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getAssetGroupDisplayString
Gets the asset display string for the specified configuration, endpoint, and property names.
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The endpoint is specified as a project URL, such as project-url://Endpoints/TargetDB. The module ID is typically
either http:// www.approuter.com/module/webservice/ or http://www.approuter.com/module/database/

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

ModuleID
The module ID for the assets.

endpointUrl
The endpoint URL for the assets.

propNames
The names of the property assets.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The asset display string.

Feedback | Notices
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getAssetGroupScript
Gets the asset script for the given configuration, endpoint, and property names.

The endpoint is specified as a project URL, such as project-url://Endpoints/TargetDB. The module ID is typically
either http://www.approuter.com/ module/webservice/ or http://www.approuter.com/module/database/

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
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The version number for the specified project.

configName
The configuration name for the specified project.

ModuleID
The module ID for the assets.

endpointUrl
The endpoint URL for the assets.

propNames
The names of the property assets.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The asset script.

Feedback | Notices
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getAssetGroupWarnings
Gets the asset warnings for the specified configuration, endpoint, and property names.

The endpoint is specified as a project URL, such as project-url://Endpoints/TargetDB. The module ID is typically
either http:// www.approuter.com/module/webservice/ or http://www.approuter.com/module/database/

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

ModuleID
The module ID for the assets.

endpointUrl
The endpoint URL for the assets.
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propNames
The names of the property assets.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The asset warnings.

Feedback | Notices
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getAssetProperties
Gets the asset property values for the specified configuration and endpoint.

The endpoint is specified as a project URL, for example project-url://Endpoints/TargetDB. The module ID is
typically either http://www.approuter.com/ module/webservice/ or
http://www.approuter.com/module/database/

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

ModuleID
The module ID for the assets.

endpointUrl
The endpoint URL for the assets.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The values for the asset properties.

Feedback | Notices
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getAssetPropertiesBindings
Gets the asset properties for the specified configuration, endpoint, and property names.

The endpoint is specified as a project URL, such as project-url://Endpoints/TargetDB. The module ID is typically
either http:// www.approuter.com/module/webservice/ or http://www.approuter.com/module/database/

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

ModuleID
The module ID for the assets.

endpointUrl
The endpoint URL for the assets.

propNames
The names of the property assets.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The asset properties.

Feedback | Notices
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getConfiguration
Gets the specified project.
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Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

Version
The version number for the specified project.

Returns:
The specified project.

Examples:

The following example is a SOAP request to get a specified project:

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:getConfiguration> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:getConfiguration> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getConfigurationResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:configuration> 
    <envId> 
     <guidString>A51EDD44BE6C10B2D1335A9D634D407D</guidString> 
    </envId> 
    <lastmodified>2010-04-08T20:58:49.694Z</lastmodified> 
    <name>HTTP_363j</name> 
    <orchestrationValues> 
     <orchestrationValue> 
      <enabled>true</enabled> 
      <syncLoggingEnabled>false</syncLoggingEnabled> 
      <loggingLevel>errorValues</loggingLevel> 
      <maxJobs>1</maxJobs> 
      <orchestrationRelativeurl>project-url://Orchestrations/ 
      Post</orchestrationRelativeurl> 
      <state>stopped</state> 
     </orchestrationValue> 
     <orchestrationValue> 
      <enabled>true</enabled> 
      <syncLoggingEnabled>false</syncLoggingEnabled> 
      <loggingLevel>errorValues</loggingLevel> 
      <maxJobs>1</maxJobs> 
      <orchestrationRelativeurl>project-url://Orchestrations/ 
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      Receive</orchestrationRelativeurl> 
      <state>stopped</state> 
     </orchestrationValue> 
    </orchestrationValues> 
    <projectName>HTTP_363i</projectName> 
    <projectVersion>1.0</projectVersion> 
    <propertyValues/> 
    <state>stopped</state> 
   </ns2:configuration> 
  </ns2:getConfigurationResponse> 
 </S:Body> 
</S:Envelope>
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getConfigurationGroups
Gets the display names for the groups with permission for the given configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The group display names.

Examples:

The following example is a SOAP request to get configuration groups with permission for the specified
configuration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>AACA96757B36C2B4582C811197EE43C0</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:getConfigurationGroups> 
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   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:getConfigurationGroups> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getConfigurationGroupsResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:groupDisplayNames> 
    <ns4:id>8D8D61C4EF435FDB63E543509B9F4978</ns4:id> 
    <ns4:name>admin@A51EDD44BE6C10B2D1335A9D634D407D</ns4:name> 
    <ns4:displayName>Administrator Group</ns4:displayName> 
    <ns4:isActive>true</ns4:isActive> 
    <ns4:isMutable>false</ns4:isMutable> 
    <ns4:isVisible>true</ns4:isVisible> 
    <ns4:createdTime>2010-04-02T22:44:46Z</ns4:createdTime> 
    <ns4:scopeId>A51EDD44BE6C10B2D1335A9D634D407D</ns4:scopeId> 
    <ns4:scopeType>Environment</ns4:scopeType> 
    <ns4:groupType>Admin</ns4:groupType> 
   </ns2:groupDisplayNames> 
  </ns2:getConfigurationGroupsResponse> 
 </S:Body> 
</S:Envelope>
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getProject
Gets the specified project.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

Version
The version number for the specified project.

Returns:
The specified project.
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Examples:

The following example is a SOAP request to get the specified project.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:getProject> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
  </dep:getProject> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Body> 
 <ns2:getProjectResponse xmlns:ns2="http://www.approuter.com/ 
 schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
 deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
 security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
  <ns2:project> 
   <assets/> 
   <configurations> 
    <configuration> 
     <envId> 
      <guidString>A51EDD44BE6C10B2D1335A9D634D407D</guidString> 
     </envId> 
     <lastmodified>2010-04-03T06:28:42.078Z</lastmodified> 
     <name>Default</name> 
      <orchestrationValues> 
       <orchestrationValue> 
        <enabled>true</enabled> 
        <syncLoggingEnabled>false</syncLoggingEnabled> 
        <loggingLevel>errorValues</loggingLevel> 
        <maxJobs>1</maxJobs> 
        <orchestrationRelativeurl>project-url:// 
        Orchestrations/Post</ 
        orchestrationRelativeurl> 
        <state>undeployed</state> 
       </orchestrationValue> 
       <orchestrationValue> 
        <enabled>true</enabled> 
        <syncLoggingEnabled>false</syncLoggingEnabled> 
        <loggingLevel>errorValues</loggingLevel> 
        <maxJobs>1</maxJobs> 
        <orchestrationRelativeurl>project-url:// 
        Orchestrations/Receive</ 
        orchestrationRelativeurl> 
        <state>undeployed</state> 
       </orchestrationValue> 
      </orchestrationValues> 
      <projectName>HTTP_363i</projectName> 
      <projectVersion>1.0</projectVersion> 
      <propertyValues/> 
      <state>undeployed</state> 
     </configuration> 
    </configurations> 
    <envId> 
     <guidString>A51EDD44BE6C10B2D1335A9D634D407D</guidString> 

 2467



    </envId> 
    <lastpublished>2010-04-03T06:28:41.894Z</lastpublished> 
    <name>HTTP_363i</name> 
    <orchestrations> 
     <orchestration> 
      <relativeurl>project-url://Orchestrations 
      /Post</relativeurl> 
     </orchestration> 
     <orchestration> 
      <relativeurl>project-url://Orchestrations/Recieve</ 
      relativeurl> 
     </orchestration> 
    </orchestrations> 
    <properties/> 
    <version>1.0</version> 
   </ns2:project> 
  </ns2:getProjectResponse> 
 </S:Body> 
</S:Envelope>
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getRule
Gets the downtime rule for the specified downtime rule ID.

Applies to Clouds and Integration Appliances.

Parameters:

ruleId
The specified downtime rule ID.

Returns:
The downtime rule.

Examples:

The following code is an example of a SOAP request to get a rule.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>8FDBC8ED7A014272714D23D14794473A</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:getRule> 
   <dep:ruleId>2</dep:ruleId> 
  </dep:getRule> 
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 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getRuleResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/deployment/ 
  types" xmlns:ns4="http://www.approuter.com/schema/router/1000/security/03" 
  xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:rule> 
    <ns3:configUrl>config-url://GenericProject_1_Cloud:1.0:Default</ 
    ns3:configUrl> 
    <ns3:downtimeType>stop</ns3:downtimeType> 
    <ns3:envId> 
     <guidString>A7FFE81243A1E319FCAED0DFABF9470B</guidString> 
    </ns3:envId> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:repeatInterval>0</ns3:repeatInterval> 
    <ns3:repeatType>none</ns3:repeatType> 
    <ns3:repeatingRule>false</ns3:repeatingRule> 
    <ns3:restartDate>2010-04-17T08:00:00.066Z</ns3:restartDate> 
    <ns3:ruleId>2</ns3:ruleId> 
    <ns3:stopDate>2010-04-17T07:00:00.066Z</ns3:stopDate> 
   </ns2:rule> 
  </ns2:getRuleResponse> 
 </S:Body> 
</S:Envelope>
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getRules
Gets the downtime rules for the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

Version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.
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Returns:
The downtime rules for the specified configuration.

Examples:

The following code is an example of a SOAP request to get rules.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>8FDBC8ED7A014272714D23D14794473A</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:getRules> 
   <dep:projectName>GenericProject_1_Cloud</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>Default</dep:configName> 
  </dep:getRules> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getRulesResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:rules> 
    <ns3:configUrl>config-url://GenericProject_1_Cloud:1.0:Default</ 
    ns3:configUrl> 
    <ns3:downtimeType>stop</ns3:downtimeType> 
    <ns3:envId> 
     <guidString>A7FFE81243A1E319FCAED0DFABF9470B</guidString> 
    </ns3:envId> 
    <ns3:isActive>true</ns3:isActive> 
    <ns3:repeatInterval>0</ns3:repeatInterval> 
    <ns3:repeatType>none</ns3:repeatType> 
    <ns3:repeatingRule>false</ns3:repeatingRule> 
    <ns3:restartDate>2010-04-17T08:00:00.066Z</ns3:restartDate> 
    <ns3:ruleId>2</ns3:ruleId> 
    <ns3:stopDate>2010-04-17T07:00:00.066Z</ns3:stopDate> 
   </ns2:rules> 
  </ns2:getRulesResponse> 
 </S:Body> 
</S:Envelope>
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getUserConfiguration
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Gets the specified configuration for the specified user.

Applies to Clouds and Integration Appliances.

Parameters:

userName
The name of the specified user.

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
The specified configuration for specified user.

Feedback | Notices
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getUserConfigurations
Gets the configurations for the specified user.

Applies to Clouds and Integration Appliances.

Parameter:

userName
The name of the specified user.

Returns:
The configurations for the specified user.

Feedback | Notices
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importRepository
Imports the project repository in XML format.

Applies to Integration Appliances only.

Parameters:

importType
The type of import.

data
The project repository in XML format.

Returns:
Success or failure

Feedback | Notices
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publishProject
Publishes the given project and creates a default configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

content
The project in a compressed file (a .par file).

Returns:
Success or failure.
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resume
Resumes the specified configuration

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
Success or failure.

Examples:

The following example is a SOAP request to resume running a configuration that was paused.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:resume> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:resume> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:resumeResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/deployment/ 
  types" xmlns:ns4="http://www.approuter.com/schema/router/1000/security/03" 
  xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:resumeResponse> 
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 </S:Body> 
</S:Envelope>
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saveOrchestrationValues
Saves the specified values for the specified orchestration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

values
The specified values to save for the specified orchestration.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
Success or failure.

Examples:

The following example is a SOAP request to save the values for the specified orchestration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>AACA96757B36C2B4582C811197EE43C0</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:saveOrchestrationValues> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
   <dep:values> 
    <enabled>true</enabled> 
    <syncLoggingEnabled>false</syncLoggingEnabled> 
    <loggingLevel>errorValues</loggingLevel> 
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    <maxJobs>1</maxJobs> 
    <orchestrationRelativeurl>orchestrationRelativeurl>project-url:// 
    Orchestrations/ 
    Receive</orchestrationRelativeurl> 
    <state>stopped</state> 
   </dep:values> 
  </dep:saveOrchestrationValues> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:saveOrchestrationValuesResponse xmlns:ns2="http:// 
  www.approuter.com/schemas/2008/1/deployment" xmlns:ns3="http:// 
  www.approuter.com/schemas/2008/1/deployment/types" xmlns:ns4="http:// 
  www.approuter.com/schema/router/1000/security/03" xmlns:ns5="http:// 
  www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:saveOrchestrationValuesResponse> 
 </S:Body> 
</S:Envelope>
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saveProperties
Saves the specified properties for the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

Version
The version number for the specified project.

configName
The configuration name for the specified project.

properties
The specified properties to save for the specified configuration.

Together projectName, version, and configName uniquely identify a configuration.
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setConfigurationGroups
Sets the groups with permission for the specified project.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

groupIds
The IDs for the groups.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
Success or failure.
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start
Starts the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:
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projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
Success or failure.

Examples:

The following example is a SOAP request to start a configuration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:start> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:start> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:startResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/deployment/ 
  types" xmlns:ns4="http://www.approuter.com/schema/router/1000/security/03" 
  xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:startResponse> 
 </S:Body> 
</S:Envelope>
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stopAndCancel
Stops and cancels all the jobs for the specified configuration.
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Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
Success or failure.

Examples:

The following example is a SOAP request to stop and cancel the configuration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:stopAndCancel> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:stopAndCancel> 
 </soapenv:Body> 
</soapenv:Envelope></soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:stopAndCancelResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:stopAndCancelResponse> 
 </S:Body> 
</S:Envelope>
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stopAndWait
Stops and waits for jobs for the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
Success or failure

Examples:

The following example is a SOAP request to stop the configuration and wait.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:stopAndWait> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:stopAndWait> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:stopAndWaitResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:stopAndWaitResponse> 
 </S:Body> 
</S:Envelope>

Feedback | Notices
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suspend
Suspends the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
Success or failure.

Examples:

The following example is a SOAP request to suspend the specified configuration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:suspend> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:suspend> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:suspendResponse xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/deployment/ 
  types" xmlns:ns4="http://www.approuter.com/schema/router/1000/security/03" 
  xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:suspendResponse> 
 </S:Body> 
</S:Envelope>
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undeploy
Withdraw the specified configuration.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the specified project.

version
The version number for the specified project.

configName
The configuration name for the specified project.

Together projectName, version, and configName uniquely identify a configuration.

Returns:
Success or failure.

Examples:

The following example is a SOAP request to withdraw the specified configuration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:dep="http://www.approuter.com/schemas/2008/1/deployment"> 
 <soapenv:Header> 
  <dep:sessionId>85EBDCE6FF0685C296D79CD55D86405F</dep:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <dep:undeploy> 
   <dep:projectName>HTTP_363i</dep:projectName> 
   <dep:version>1.0</dep:version> 
   <dep:configName>HTTP_363j</dep:configName> 
  </dep:undeploy> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:undeployResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/deployment" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  deployment/types" xmlns:ns4="http://www.approuter.com/schema/router/1000/ 
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  security/03" xmlns:ns5="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:undeployResponse> 
 </S:Body> 
</S:Envelope>
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Orcmon
Information about the orcmon WSDL.

Using the orcmon WSDL, you can search for jobs, get a job count, and get job details. You can also set and get
job monitoring properties.

This section contains the following topics:

getJobCount
getJobDetails
getMonitoringProperties
purgeJobs
searchJobs
setMonitoringProperties
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getJobCount
Returns the number of jobs that have the specified parameters.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the project that contains the configuration where the jobs run.
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version
The version number of the project.

configName
The name of the configuration that contains the orchestration where the jobs run. For the default
configuration, this value should be 'Default'.

orchName
The name of the orchestration where the jobs run.

jobId (optional)
The ID of the jobs for which a count is returned.

jobKey (optional)
The job key for the jobs for which a count is returned.

minStartDate
The earliest date that the jobs started.

maxStartDate
The latest date that the jobs started.

status
The status of the jobs.

–Setting status as negative gets all status.

–Setting specific status value (number or lowercase keyword) gets jobs with that status:

success = 0
errored = 1
running = 2
cancelling = 3
terminated = 4
cancelled = 5
suspended = 6
crashed = 7
suspending = 8
unknown = 101

Returns:
The number of jobs.
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getJobDetails
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Returns the details for the job with the specified parameters.

Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the project that contains the configuration where the job runs.

version
The version number of the project.

configName
The name of the configuration that contains the orchestration where the job runs.

orchName
The name of the orchestration where the job runs.

jobId
The ID of the job for which the details are returned.

Returns:
The job details for the job that has the specified parameters.

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.api.doc/ci00132.html

getMonitoringProperties
Gets the properties for managing orchestration monitoring data.

Applies to Integration Appliances only.

Returns:
The monitoring properties.
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purgeJobs
Purges jobs that have the specified parameters.

Applies to Integration Appliances only.

Parameters:

projectName
The name of the project that contains the configuration where the jobs run.

version
The version number of the project.

configName
The name of the configuration that contains the orchestration where the jobs run.

orchName
The name of the orchestration where the jobs run.

jobId
The ID of the job to be purged.

jobKey
The job key for the jobs to be purged.

minStartDate
The earliest date that the jobs started.

maxStartDate
The latest date that the jobs started.

status
The status of the jobs.

exportJobs
Whether to return the purged jobs - true or false.

Returns:
The purged jobs if exportJobs is set to true.
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searchJobs
Returns the jobs that have the specified parameters.
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Applies to Clouds and Integration Appliances.

Parameters:

projectName
The name of the project that contains the configuration where the jobs run.

version
The version number of the project.

configName
The name of the configuration that contains the orchestration where the jobs run.

orchName
The name of the orchestration where the jobs run.

jobId
The ID of the jobs to be returned.

jobKey
The job key for the jobs to be returned.

minStartDate
The earliest date that the jobs started.

maxStartDate
The latest date that the jobs started.

status
The status of the jobs.

page
0-based page numbering.

pageSize
The number of lines per page.

Returns:
The jobs that have the specified parameters.

Examples:

The following code is an example of a SOAP request to search jobs.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:orc="http://www.approuter.com/schemas/2008/1/orcmon"> 
 <soapenv:Header> 
  <orc:sessionId>834133D57E9259C94D44E53A5F6B43C2</orc:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <orc:searchJobs> 
   <orc:projectName>CloudProvideProject_2</orc:projectName> 
   <orc:version>1.0</orc:version> 
   <orc:configName>Default</orc:configName> 
   <orc:orchName>ProvideOnCloud</orc:orchName> 
   <orc:jobId></orc:jobId> 
   <orc:jobKey></orc:jobKey> 
   <orc:minStartDate></orc:minStartDate> 
   <orc:maxStartDate></orc:maxStartDate> 
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   <orc:status>errored</orc:status> 
   <orc:page>0</orc:page> 
   <orc:pageSize>1</orc:pageSize> 
  </orc:searchJobs> 
 </soapenv:Body> 
</soapenv:Envelope

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns3:searchJobsResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2005/1/monitoringProps/" xmlns:ns3="http://www.approuter.com/ 
  schemas/2008/1/orcmon" xmlns:ns4="http://www.approuter.com/schemas/2004/1/ 
  orcmon/" xmlns:ns5="http://www.approuter.com/schema/router/1000/logging.xsd" 
  xmlns:ns6="http://www.approuter.com/schemas/2004/1/orcmon"> 
   <ns3:jobs status="1" startTime="2010-04-15T10:40:02.665Z" 
   path="CloudProvideProject_2/1.0/Default/Orchestrations/ProvideOnCloud" 
   
id="_dcs_markdown_workspace_Transform_htmlout_0_com.ibm.wci.api.doc_ci00135_ADCF71CC
D81139F8CF16F815998B4B73" endTime="2010-04-15T10:40:38.066Z"> 
    <ns6:event seqNum="0"> 
     <ns6:eventType> 
      <ns4:taskStartLoggedEvent> 
       <ns4:taskId>ADCF71CCD81139F8CF16F815998B4B73</ns4:taskId> 
       <ns4:sequenceNumber>0</ns4:sequenceNumber> 
       <ns4:time>2010-04-15T10:40:02.665Z</ns4:time> 
      </ns4:taskStartLoggedEvent> 
     </ns6:eventType> 
    </ns6:event> 
    <ns6:event seqNum="1"> 
     <ns6:eventType> 
      <ns4:setStatusLoggedEvent> 
       <ns4:taskId>ADCF71CCD81139F8CF16F815998B4B73</ns4:taskId> 
       <ns4:sequenceNumber>1</ns4:sequenceNumber> 
       <ns4:status>2</ns4:status> 
      </ns4:setStatusLoggedEvent> 
     </ns6:eventType> 
    </ns6:event> 
  </S:Body> 
</S:Envelope>
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setMonitoringProperties
Sets the properties for managing orchestration monitoring data.

Applies to Integration Appliances only.

Parameter:
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properties
The properties for managing orchestration monitoring data.

Returns:
A list of warning and error messages.
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Lognotif
Information about the lognotif WSDL.

Using the lognotif WSDL, you can save, get, and delete notification policies. You can also get and set email and
SNMP endpoints, set and get log levels, and get a log count.

This section contains the following topics:

createNotificationPolicy
deleteNotificationPolicy
getEmailEndpoint
getLogCount
getLogLevel
getNotificationPolicies
getNotificationPolicy
getSnmpEndpoint
searchLogs
setEmailEndpoint
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createNotificationPolicy
Creates and saves a notification policy.

Applies to Clouds and Integration Appliances.
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Parameter:

policy
The name of the policy.

Returns:
The notification policy ID of the policy was successfully created. If not successful, returns a -1.

Examples:

The following example is a SOAP request to create a notification policy.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif"> 
 <soapenv:Header> 
  <log:sessionId>910D9A7B441C97AC2FCC54E3F1274AA7</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:createNotificationPolicy> 
   <log:name>TestNotif</log:name> 
   <log:logComponent>orchestration</log:logComponent> 
   <log:logLevel>error</log:logLevel> 
   <log:emailAddresses>user@mydomain.com</log:emailAddresses> 
   <log:isSnmp>false</log:isSnmp> 
  </log:createNotificationPolicy> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:createNotificationPolicyResponse xmlns:ns2="http:// 
  www.approuter.com/schemas/2008/1/lognotif" xmlns:ns3="http:// 
  www.approuter.com/schemas/2008/1/lognotif/types"> 
   <ns2:policyId>688128</ns2:policyId> 
  </ns2:createNotificationPolicyResponse> 
 </S:Body> 
</S:Envelope>
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deleteNotificationPolicy
Deletes a notification policy.

Applies to Clouds and Integration Appliances.

Parameter:
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policyId
The specified ID for the notification policy to be deleted.

Returns:
Success or failure.

Examples:

The following is a SOAP request to delete the notification policy with the specified ID.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif"> 
 <soapenv:Header> 
  <log:sessionId>910D9A7B441C97AC2FCC54E3F1274AA7</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:deleteNotificationPolicy> 
   <log:policyId>688128</log:policyId> 
  </log:deleteNotificationPolicy> 
 </soapenv:Body> 
</soapenv:Envelope>

The following is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:deleteNotificationPolicyResponse xmlns:ns2="http:// 
  www.approuter.com/schemas/2008/1/lognotif" xmlns:ns3="http:// 
  www.approuter.com/schemas/2008/1/lognotif/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:deleteNotificationPolicyResponse> 
 </S:Body> 
</S:Envelope>
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getEmailEndpoint
Gets the email endpoint for notifications based on the session ID.

Applies to Integration Appliances only.

Returns:
The email endpoint.

Examples:

The following example is a SOAP request to get an email endpoint.
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<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif"> 
 <soapenv:Header> 
  <log:sessionId>910D9A7B441C97AC2FCC54E3F1274AA7</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:getEmailEndpoint/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getEmailEndpointResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/lognotif" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  lognotif/types"> 
   <ns2:emailEndpoint> 
    <ns3:active>true</ns3:active> 
     <ns3:credentials> 
      <ns3:password>test</ns3:password> 
      <ns3:user>test</ns3:user> 
     </ns3:credentials> 
    <ns3:host>hq-exch-01</ns3:host> 
    <ns3:port>123</ns3:port> 
    <ns3:sender>user@mydomain.com</ns3:sender> 
    <ns3:subject>Notification</ns3:subject> 
   </ns2:emailEndpoint> 
  </ns2:getEmailEndpointResponse> 
 </S:Body> 
</S:Envelope>
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getLogCount
Gets the number of logs for the specified parameters.

Applies to Clouds and Integration Appliances.

Parameters:

logComponent
The specified component for which logs are generated.

logLevel
The level of logging to be done for the specified component.

maxDaysOld
The maximum number of days to go back to get logs. Use 1 for no maximum.
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status
The specified status of logs to be included in the count. The default values are:

All
Resolved
Unresolved

Returns:
The number of logs that match the specified parameters.

Examples:

The following example is a SOAP request to get a log count.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif"> 
 <soapenv:Header> 
  <log:sessionId>910D9A7B441C97AC2FCC54E3F1274AA7</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:getLogCount> 
   <log:logComponent>orchestration</log:logComponent> 
   <log:logLevel>error</log:logLevel> 
   <log:maxDaysOld>3</log:maxDaysOld> 
   <log:status>all</log:status> 
  </log:getLogCount> 
 </soapenv:Body> 
</soapenv:Envelope>

The following is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getLogCountResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/lognotif" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  lognotif/types"> 
   <ns2:logCount>8</ns2:logCount> 
  </ns2:getLogCountResponse> 
 </S:Body> 
</S:Envelope>
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getLogLevel
Gets the log level for the specified log component.

The default log levels are:
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All. (Note: The actual level of logs retrieved for the All level is determined by the logging level set in the
WMC. For more information, see "Specify System Log Settings" in the WMC).
Fatal
Severe
Warning
Info

Applies to Clouds and Integration Appliances.

Parameter

logComponent
The specified component for which logs are generated.

Returns:
The log level for the specified component.

Examples

The following example is a SOAP request to get the log level for orchestrations.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif"> 
 <soapenv:Header> 
  <log:sessionId>AD2E025868AC1392A44E6E27E4594EF9</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:getLogLevel> 
   <log:logComponent>orchestration</log:logComponent> 
  </log:getLogLevel> 
 </soapenv:Body> 
</soapenv:Envelope>

The following is the SOAP reply to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns3:getLogLevelResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/lognotif/types" xmlns:ns3="http://www.approuter.com/ 
  schemas/2008/1/lognotif"> 
   <ns3:logLevel>warning</ns3:logLevel> 
  </ns3:getLogLevelResponse> 
 </S:Body> 
</S:Envelope>
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getNotificationPolicies
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Gets the notification policies.

Applies to Clouds and Integration Appliances.

Returns:
The notification policies.

Examples:

The following example is a SOAP request to get notification policies.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif"> 
 <soapenv:Header> 
  <log:sessionId>910D9A7B441C97AC2FCC54E3F1274AA7</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:getNotificationPolicies/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getNotificationPoliciesResponse xmlns:ns2="http:// 
  www.approuter.com/schemas/2008/1/lognotif" xmlns:ns3="http:// 
  www.approuter.com/schemas/2008/1/lognotif/types"> 
   <ns2:notificationPolicies> 
    <emailAddresses>user@mydomain.com</emailAddresses> 
    <id>688129</id> 
    <logComponent>orchestration</logComponent> 
    <logLevel>error</logLevel> 
    <name>TestNotif</name> 
    <snmp>false</snmp> 
   </ns2:notificationPolicies> 
  </ns2:getNotificationPoliciesResponse> 
 </S:Body> 
</S:Envelope>

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.api.doc/ci00143.html

getNotificationPolicy
Gets the notification policy that is using the specified notification policy ID.

Applies to Clouds and Integration Appliances.

Parameter:
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policyId
The specified ID for the notification policy.

Returns:
The notification policy.

Examples:

The following example is a SOAP request to get a notification.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif"> 
 <soapenv:Header> 
  <log:sessionId>910D9A7B441C97AC2FCC54E3F1274AA7</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:getNotificationPolicy> 
   <log:policyId>688129</log:policyId> 
  </log:getNotificationPolicy> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getNotificationPolicyResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/lognotif" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  lognotif/types"> 
   <ns2:notificationPolicy> 
    <emailAddresses>user@mydomain.com</emailAddresses> 
    <id>688129</id> 
    <logComponent>orchestration</logComponent> 
    <logLevel>error</logLevel> 
    <name>TestNotif</name> 
    <snmp>false</snmp> 
   </ns2:notificationPolicy> 
  </ns2:getNotificationPolicyResponse> 
 </S:Body> 
</S:Envelope>

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.api.doc/ci00144.html

getSnmpEndpoint
Gets the SNMP endpoint for notifications.

Applies to Integration Appliances only.

Returns:
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The SNMP endpoint.

Examples:

The following example is a SOAP request to get an SNMP endpoint.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif"> 
 <soapenv:Header> 
  <log:sessionId>910D9A7B441C97AC2FCC54E3F1274AA7</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:getSnmpEndpoint/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getSnmpEndpointResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/lognotif" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  lognotif/types"> 
   <ns2:snmpEndpoint> 
    <ns3:active>true</ns3:active> 
    <ns3:community>Test</ns3:community> 
    <ns3:host>hq-exch-01</ns3:host> 
   </ns2:snmpEndpoint> 
  </ns2:getSnmpEndpointResponse> 
 </S:Body> 
</S:Envelope>
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searchLogs
Gets the logs for the specified parameters.

Applies to Clouds and Integration Appliances.

Parameters:

logComponent
The specified component for which logs are generated. logComponent is one of:

hardware
resources
network
security
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orchestration
deployment
all

logLevel
The level of logging to be done for the specified component. logLevel is one of:

critical
error
warning
info
all

maxDaysOld
The maximum number of days to go back to get logs. Use -1 for no maximum.

status
The specified status of logs to be included in the search. status is one of:

resolved
unresolved
all

page
Uses 0-based page numbering. Log pagination starts with zero. Maximum size of page should be
documented as 2,147,483,647.

pageSize
Specifies the size of the log pages that are returned. Maximum size of pageSize should be documented
as 2,147,483,647.

Returns:
The logs that match the specified parameters.

Examples:

The following example is a SOAP request to search the logs for logs that match the specified parameters.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif"> 
 <soapenv:Header> 
  <log:sessionId>AD2E025868AC1392A44E6E27E4594EF9</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:searchLogs> 
   <log:logComponent>orchestration</log:logComponent> 
   <log:logLevel>error</log:logLevel> 
   <log:maxDaysOld>6</log:maxDaysOld> 
   <log:status>all</log:status> 
   <log:page>1</log:page> 
   <log:pageSize>5</log:pageSize> 
  </log:searchLogs> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP reply to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
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  <ns3:searchLogsResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/lognotif/types" xmlns:ns3="http://www.approuter.com/ 
  schemas/2008/1/lognotif"> 
   <ns3:logs> 
    <ns2:system>orchestration</ns2:system> 
    <ns2:message>Internal error: java.lang.RuntimeException: Could 
    not create the module activity: invoke for module http://www.approuter.com/ 
    module/jde/: com.approuter.maestro.sdk.mpi.ActivityCreationException: Not able 
    to connect to gateway</ns2:message> 
    <ns2:id>10157</ns2:id> 
    <ns2:level>error</ns2:level> 
    <ns2:timestamp>2010-04-07T09:03:30.155Z</ns2:timestamp> 
   </ns3:logs> 
   <ns3:logs> 
    <ns2:system>orchestration</ns2:system> 
    <ns2:message>Unable to compile the orchestration config-url:// 
    JDE_TestCase_101/3.2/Default/Orchestrations/Orchestration</ns2:message> 
    <ns2:id>10156</ns2:id> 
    <ns2:level>error</ns2:level> 
    <ns2:timestamp>2010-04-07T09:03:29.124Z</ns2:timestamp> 
   </ns3:logs> 
   <ns3:logs> 
    <ns2:system>orchestration</ns2:system> 
    <ns2:message>Error while trying to call remote operation connect 
    on gateway for activity com.approuter.module.jde.activity.JdeInvoke and 
    Secure Connector 2133, error is The Secure Connector name: 2133 is not 
    correct. Please specify the right agent name</ns2:message> 
    <ns2:id>10155</ns2:id> 
    <ns2:level>error</ns2:level> 
    <ns2:timestamp>2010-04-07T09:03:29.110Z</ns2:timestamp> 
   </ns3:logs> 
   <ns3:logs> 
    <ns2:system>orchestration</ns2:system> 
    <ns2:message>Undeploy of Orchestration config-url:// 
    JDE_TestCase_101/3.2/Default/Orchestrations/Orchestration failed: 
    Orchestration not deployed: config-url://JDE_TestCase_101/3.2/Default/ 
    Orchestrations/Orchestration.</ns2:message> 
    <ns2:id>10153</ns2:id> 
    <ns2:level>error</ns2:level> 
    <ns2:timestamp>2010-04-07T08:48:30.078Z</ns2:timestamp> 
   </ns3:logs> 
   <ns3:logs> 
    <ns2:system>orchestration</ns2:system> 
    <ns2:message>Orchestration not deployed: config-url:// 
    JDE_TestCase_101/3.2/Default/Orchestrations/Orchestration</ns2:message> 
    <ns2:id>10152</ns2:id> 
    <ns2:level>error</ns2:level> 
    <ns2:timestamp>2010-04-07T08:48:29.059Z</ns2:timestamp> 
    </ns3:logs> 
  </ns3:searchLogsResponse> 
 </S:Body> 
</S:Envelope>
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setEmailEndpoint
Sets the email endpoint for notifications.

Applies to Integration Appliances only.

Parameter:

emailEndpoint
The email endpoint.

Returns:
Success or failure.

Examples:

The following example is a SOAP request to set an email endpoint.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/ 
envelope/" xmlns:log="http://www.approuter.com/schemas/2008/1/lognotif" 
xmlns:typ="http://www.approuter.com/schemas/2008/1/lognotif/types"> 
 <soapenv:Header> 
  <log:sessionId>910D9A7B441C97AC2FCC54E3F1274AA7</log:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <log:setEmailEndpoint> 
   <log:emailEndpoint> 
    <typ:active>true</typ:active> 
    <typ:credentials> 
     <typ:password>test</typ:password> 
     <typ:user>test</typ:user> 
    </typ:credentials> 
    <typ:host>hq-exch-01</typ:host> 
    <typ:port>123</typ:port> 
    <typ:sender>user@mydomain.com</typ:sender> 
    <typ:subject>Notification</typ:subject> 
   </log:emailEndpoint> 
  </log:setEmailEndpoint> 
 </soapenv:Body> 
</soapenv:Envelope>

The following is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:setEmailEndpointResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/2008/1/lognotif" xmlns:ns3="http://www.approuter.com/schemas/2008/1/ 
  lognotif/types"> 
   <ns2:success>true</ns2:success> 
  </ns2:setEmailEndpointResponse> 
 </S:Body> 
</S:Envelope>
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System
Information about the system WSDL.

The system WSDL applies to Integration Appliances only. Using system WSDL you can set or get an appliance
name or network configuration. You can also run system commands or get system information.

This section contains the following topics:

downloadPostmortem
executeCommand
getApplianceName
getNetworkConfiguration
getResourceUtilizationData
setApplianceName
setNetworkConfiguration
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downloadPostmortem
Downloads the postmortem file.

Use the information in this file to resolve Integration Appliance issues.

Applies to Integration Appliances only.

Returns:
The postmortem file.
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executeCommand
Runs the specified system command.

Applies to Integration Appliances only.

Parameter:

command
The specified system command to run.

Returns:
Success or failure.

Enums:

The system commands are defined as enumerated constants.

The following table lists the system commands.

Comm
and Description

remove
JobHist
ory

Removes job histories from the Integration Appliance.

remove
Project
s

Removes projects from the Integration Appliance.

remove
Runnin
gJobs

Stops and removes running jobs from the Integration Appliance.

generat
ePostm
ortem

Generates an archive of information gathered from Integration Appliance logs, orchestration logs,
and transaction stores. Use this information to debug Integration Appliance issues. Run this
command before rebooting the Integration Appliance.

restart Restarts the Integration Appliance routing subsystem.

reboot Shuts down all routing services and then reboots the Integration Appliance.

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.api.doc/ci00150.html

 2501



getApplianceName
Gets the appliance name.

Applies to Integration Appliances only.

Returns:
The appliance name.

Examples:

The following code is an example of a SOAP request to get the Integration Appliance name.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sys="http://www.approuter.com/schemas/2008/1/system"> 
 <soapenv:Header> 
  <sys:sessionId>91997FBCE89093792D40DEF8FDB345DD</sys:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sys:getApplianceName/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns3:getApplianceNameResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/router/1000/NetConfig02.xsd" xmlns:ns3="http://www.approuter.com/ 
  schemas/2008/1/system" xmlns:ns4="http://www.approuter.com/schemas/2008/1/ 
  util/types"> 
   <ns3:applianceName>TheIntegrator</ns3:applianceName> 
  </ns3:getApplianceNameResponse> 
 </S:Body> 
</S:Envelope>

Feedback | Notices

 Last updated: Thursday, 2 June 2016
file:///dcs/markdown/workspace/Transform/out.html

http://pic.dhe.ibm.com/infocenter/wci/v7r0m0/topic/com.ibm.wci.api.doc/ci00151.html

getNetworkConfiguration
Returns the status of the current network configuration.

Applies to Integration Appliances only.

Returns:
The network status.

Examples:
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The following code is an example of a SOAP request to get the network configuration.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sys="http://www.approuter.com/schemas/2008/1/system"> 
 <soapenv:Header> 
  <sys:sessionId>91997FBCE89093792D40DEF8FDB345DD</sys:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sys:getNetworkConfiguration/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns3:getNetworkConfigurationResponse xmlns:ns2="http:// 
  www.approuter.com/schemas/router/1000/NetConfig02.xsd" 
  xmlns:ns3="http://www.approuter.com/schemas/2008/1/system" 
  xmlns:ns4="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns3:networkStatus> 
    <ns2:active>true</ns2:active> 
    <ns2:carrierTimeout>30</ns2:carrierTimeout> 
    <ns2:emgmt active="true"> 
     <ns2:ipaddr>10.10.60.23</ns2:ipaddr> 
     <ns2:netmask>255.255.255.0</ns2:netmask> 
     <ns2:broadcast>10.10.60.255</ns2:broadcast> 
     <ns2:MACaddr>00:04:23:cd:e8:b5</ns2:MACaddr> 
     <ns2:fromDhcp>true</ns2:fromDhcp> 
     <ns2:leaseExp>Sat Apr 24 05:33:10 2010 GMT</ns2:leaseExp> 
     <ns2:isVirtual>false</ns2:isVirtual> 
     <ns2:linkInfoValid>true</ns2:linkInfoValid> 
     <ns2:autoNegotiate>true</ns2:autoNegotiate> 
     <ns2:speed>1000</ns2:speed> 
     <ns2:fullDuplex>true</ns2:fullDuplex> 
    </ns2:emgmt> 
    <ns2:edata active="true"> 
     <ns2:ipaddr>10.10.50.23</ns2:ipaddr> 
     <ns2:netmask>255.255.255.0</ns2:netmask> 
     <ns2:broadcast>10.10.50.255</ns2:broadcast> 
     <ns2:MACaddr>00:04:23:cd:e9:d9</ns2:MACaddr> 
     <ns2:fromDhcp>true</ns2:fromDhcp> 
     <ns2:leaseExp>Sat Apr 24 05:33:14 2010 GMT</ns2:leaseExp> 
     <ns2:isVirtual>false</ns2:isVirtual> 
     <ns2:linkInfoValid>true</ns2:linkInfoValid> 
     <ns2:autoNegotiate>true</ns2:autoNegotiate> 
     <ns2:speed>1000</ns2:speed> 
     <ns2:fullDuplex>true</ns2:fullDuplex> 
    </ns2:edata> 
    <ns2:gateway> 
     <ns2:value>10.10.70.3</ns2:value> 
     <ns2:fromDhcp>true</ns2:fromDhcp> 
     <ns2:dhcpSource>emgmt</ns2:dhcpSource> 
    </ns2:gateway> 
    <ns2:hostname> 
     <ns2:value>myhost</ns2:value> 
     <ns2:fromDhcp>true</ns2:fromDhcp> 
     <ns2:dhcpSource>emgmt</ns2:dhcpSource> 
    </ns2:hostname> 
    <ns2:domain> 
     <ns2:value>mycompany.com</ns2:value> 
     <ns2:fromDhcp>true</ns2:fromDhcp> 
     <ns2:dhcpSource>emgmt</ns2:dhcpSource> 
    </ns2:domain> 
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    <ns2:search> 
     <ns2:value>mycompany.com mycompany.corp</ns2:value> 
     <ns2:fromDhcp>true</ns2:fromDhcp> 
     <ns2:dhcpSource>emgmt</ns2:dhcpSource> 
    </ns2:search> 
    <ns2:dns> 
     <ns2:value>10.10.20.21 10.10.10.15</ns2:value> 
     <ns2:fromDhcp>true</ns2:fromDhcp> 
     <ns2:dhcpSource>emgmt</ns2:dhcpSource> 
    </ns2:dns> 
    <ns2:ntp> 
     <ns2:value>10.10.20.21</ns2:value> 
     <ns2:fromDhcp>true</ns2:fromDhcp> 
     <ns2:dhcpSource>emgmt</ns2:dhcpSource> 
    </ns2:ntp> 
    <ns2:routes/> 
    <ns2:httpProxy> 
     <ns2:host/> 
     <ns2:port/> 
     <ns2:user/> 
     <ns2:passwd/> 
     <ns2:enabled>false</ns2:enabled> 
    </ns2:httpProxy> 
    <ns2:ftpProxy> 
     <ns2:host/> 
     <ns2:port/> 
     <ns2:user/> 
     <ns2:passwd/> 
     <ns2:enabled>false</ns2:enabled> 
    </ns2:ftpProxy> 
    <ns2:sftpProxy> 
     <ns2:host/> 
     <ns2:port/> 
     <ns2:user/> 
     <ns2:passwd/> 
     <ns2:enabled>false</ns2:enabled> 
    </ns2:sftpProxy> 
    <ns2:history> 
     <ns2:startAttempt>Fri Apr 23 17:33:07 2010 GMT</ 
     ns2:startAttempt> 
     <ns2:started>Fri Apr 23 17:33:15 2010 GMT</ns2:started> 
     <ns2:stopped/> 
     <ns2:stopReason/> 
     <ns2:current>Monitoring network</ns2:current> 
    </ns2:history> 
   </ns3:networkStatus> 
  </ns3:getNetworkConfigurationResponse> 
 </S:Body> 
</S:Envelope>
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getResourceUtilizationData
Gets the resource utilization data for the given appliance.

Applies to Integration Appliances only.

Returns:
Appliance resource utilization data.

Examples:

The following code is an example of a SOAP request to get the Integration Appliance resource utilization data.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sys="http://www.approuter.com/schemas/2008/1/system"> 
 <soapenv:Header> 
  <sys:sessionId>9705D42CDA8D28BA04CEBAB3D9C44B5A</sys:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sys:getResourceUtilizationData/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns2:getResourceUtilizationDataResponse xmlns:ns4="http://www.approuter.com/ 
  schemas/router/1000/NetConfig02.xsd" xmlns:ns3="http://www.approuter.com/ 
  schemas/2008/1/util/types" xmlns:ns2="http://www.approuter.com/schemas/2008/1/ 
  system"> 
   <ns2:applianceUtilization> 
    <diskPercentUsed>6<//diskPercentUsed> 
    <usedMemory>35813024</usedMemory> 
    <maxMemory>1509949440</maxMemory> 
    <collectionCount>1</collectionCount> 
    <totalRunningJobs>0</totalRunningJobs> 
    <time> 
     <ns3:offset>0</ns3:offset> 
     <ns3:time>1379634870597</ns3:time> 
    </time> 
   </ns2:applianceUtilization> 
  </ns2:getResourceUtilizationDataResponse> 
 </S:Body> 
</S:Envelope>
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Sets the appliance name.

Applies to Integration Appliances only.

Parameter:

applianceName
The specified name for the appliance.

Returns:
Success or failure.

Examples:

The following code is an example of a SOAP request to the Integration Appliance name.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sys="http://www.approuter.com/schemas/2008/1/system"> 
 <soapenv:Header> 
  <sys:sessionId>91997FBCE89093792D40DEF8FDB345DD</sys:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sys:setApplianceName> 
   <sys:applianceName>TheIntegrator</sys:applianceName> 
  </sys:setApplianceName> 
 </soapenv:Body> 
</soapenv:Envelope>>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <ns3:setApplianceNameResponse xmlns:ns2="http://www.approuter.com/ 
  schemas/router/1000/NetConfig02.xsd" 
  xmlns:ns3="http://www.approuter.com/schemas/2008/1/system" 
  xmlns:ns4="http://www.approuter.com/schemas/2008/1/util/types"> 
   <ns3:success>true</ns3:success> 
  </ns3:setApplianceNameResponse> 
 </S:Body> 
</S:Envelope>
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setNetworkConfiguration
Sets the current network configuration.

Applies to Integration Appliances only.
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Returns:
Success or failure.

Example:

The following code is an example of a SOAP request to set the network configuration for an Integration
Appliance. Enter the values for your network and appliance.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:sys="http://www.approuter.com/schemas/2008/1/system" 
xmlns:net="http://www.approuter.com/schemas/router/1000/ 
NetConfig02.xsd"> 
 <soapenv:Header> 
  <sys:sessionId>?</sys:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <sys:setNetworkConfiguration> 
   <sys:networkType> 
    <net:emgmt> 
     <net:fallback> 
      <net:ipaddr>?</net:ipaddr> 
      <net:netmask>?</net:netmask> 
      <net:broadcast>?</net:broadcast> 
     </net:fallback> 
     <net:manual> 
      <net:ipaddr>?</net:ipaddr> 
      <net:netmask>?</net:netmask> 
      <net:broadcast>?</net:broadcast> 
     </net:manual> 
     <net:useDhcp>?</net:useDhcp> 
     <net:useDhcpRoutes>?</net:useDhcpRoutes> 
     <net:autoNegotiate>?</net:autoNegotiate> 
     <net:speed>?</net:speed> 
     <net:fullDuplex>?</net:fullDuplex> 
    </net:emgmt> 
    <net:edata> 
     <net:fallback> 
      <net:ipaddr>?</net:ipaddr> 
      <net:netmask>?</net:netmask> 
      <net:broadcast>?</net:broadcast> 
     </net:fallback> 
     <net:manual> 
      <net:ipaddr>?</net:ipaddr> 
      <net:netmask>?</net:netmask> 
      <net:broadcast>?</net:broadcast> 
     </net:manual> 
     <net:useDhcp>?</net:useDhcp> 
     <net:useDhcpRoutes>?</net:useDhcpRoutes> 
     <net:autoNegotiate>?</net:autoNegotiate> 
     <net:speed>?</net:speed> 
     <net:fullDuplex>?</net:fullDuplex> 
    </net:edata> 
    <net:gateway> 
     <net:useDhcp>?</net:useDhcp> 
     <net:dhcpSource>?</net:dhcpSource> 
     <net:manual>?</net:manual> 
     <net:fallback>?</net:fallback> 
    </net:gateway> 
    <net:hostname> 
     <net:useDhcp>?</net:useDhcp> 
     <net:dhcpSource>?</net:dhcpSource> 
     <net:manual>?</net:manual> 
     <net:fallback>?</net:fallback> 
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    </net:hostname> 
    <net:domain> 
     <net:useDhcp>?</net:useDhcp> 
     <net:dhcpSource>?</net:dhcpSource> 
     <net:manual>?</net:manual> 
     <net:fallback>?</net:fallback> 
    </net:domain> 
    <net:search> 
     <net:useDhcp>?</net:useDhcp> 
     <net:dhcpSource>?</net:dhcpSource> 
     <net:manual>?</net:manual> 
     <net:fallback>?</net:fallback> 
    </net:search> 
    <net:dns> 
     <net:useDhcp>?</net:useDhcp> 
     <net:dhcpSource>?</net:dhcpSource> 
     <net:manual>?</net:manual> 
     <net:fallback>?</net:fallback> 
    </net:dns> 
    <net:ntp> 
     <net:useDhcp>?</net:useDhcp> 
     <net:dhcpSource>?</net:dhcpSource> 
     <net:manual>?</net:manual> 
     <net:fallback>?</net:fallback> 
    </net:ntp> 
    <net:routes> 
     <!--Zero or more repetitions:--> 
     <net:route> 
      <net:destination>?</net:destination> 
      <net:netmask>?</net:netmask> 
      <net:router>?</net:router> 
      <net:interface>?</net:interface> 
     </net:route> 
    </net:routes> 
    <net:httpProxy> 
     <net:host>?</net:host> 
     <net:port>?</net:port> 
     <net:user>?</net:user> 
     <net:passwd>?</net:passwd> 
     <net:enabled>?</net:enabled> 
     <net:passwdEncoding>?</net:passwdEncoding> 
    </net:httpProxy> 
    <net:ftpProxy> 
     <net:host>?</net:host> 
     <net:port>?</net:port> 
     <net:user>?</net:user> 
     <net:passwd>?</net:passwd> 
     <net:enabled>?</net:enabled> 
     <net:passwdEncoding>?</net:passwdEncoding> 
    </net:ftpProxy> 
    <net:sftpProxy> 
     <net:host>?</net:host> 
     <net:port>?</net:port> 
     <net:user>?</net:user> 
     <net:passwd>?</net:passwd> 
     <net:enabled>?</net:enabled> 
     <net:passwdEncoding>?</net:passwdEncoding> 
    </net:sftpProxy> 
    <net:carrierTimeout>?</net:carrierTimeout> 
    <net:enabled>?</net:enabled> 
   </sys:networkType> 
  </sys:setNetworkConfiguration> 
 </soapenv:Body> 
</soapenv:Envelope>
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Staging
Information about the staging WSDL.

The staging WSDL applies to Integration Appliances only. Using the staging WSDL, you can check whether the
staging database is started. You can start or stop the staging database.

This section contains the following topics:

isStagingDatabaseStarted
startStagingDatabase
stopStagingDatabase
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isStagingDatabaseStarted
Returns whether the staging database is started (True or False).

Applies to Integration Appliances only.

Returns:
True if the staging database is started.

Examples:

The following code is an example of a SOAP request to check if the staging database is started.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:stag="http://www.approuter.com/schemas/2008/1/staging"> 
 <soapenv:Header> 
  <stag:sessionId>91997FBCE89093792D40DEF8FDB345DD</stag:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <stag:isStagingDatabaseStarted/> 
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 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <isStagingDatabaseStartedResponse xmlns="http://www.approuter.com/ 
  schemas/2008/1/staging"> 
   <isStarted>true</isStarted> 
  </isStagingDatabaseStartedResponse> 
 </S:Body> 
</S:Envelope>
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startStagingDatabase
Starts the staging database. Returns success if the database starts or failure if the database fails to start.

Applies to Integration Appliances only.

Returns:
Success or failure.

Examples:

The following code is an example of a SOAP request to start the staging database.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:stag="http://www.approuter.com/schemas/2008/1/staging"> 
 <soapenv:Header> 
  <stag:sessionId>91997FBCE89093792D40DEF8FDB345DD</stag:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <stag:startStagingDatabase/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <startStagingDatabaseResponse xmlns="http://www.approuter.com/ 
  schemas/2008/1/staging"> 
   <success>true</success> 
  </startStagingDatabaseResponse> 
 </S:Body> 
</S:Envelope>
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stopStagingDatabase
Stops the staging database. Returns success if the database stops or failure if the database fails to stop.

Applies to Integration Appliances only.

Returns:
Success or failure.

Examples:

The following code is an example of a SOAP request to stop the staging database.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:stag="http://www.approuter.com/schemas/2008/1/staging"> 
 <soapenv:Header> 
  <stag:sessionId>91997FBCE89093792D40DEF8FDB345DD</stag:sessionId> 
 </soapenv:Header> 
 <soapenv:Body> 
  <stag:stopStagingDatabase/> 
 </soapenv:Body> 
</soapenv:Envelope>

The following example is the SOAP response to the request.

<S:Envelope xmlns:S="http://schemas.xmlsoap.org/soap/envelope/"> 
 <S:Body> 
  <stopStagingDatabaseResponse xmlns="http://www.approuter.com/ 
  schemas/2008/1/staging"> 
   <success>true</success> 
  </stopStagingDatabaseResponse> 
 </S:Body> 
</S:Envelope>
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簡介

《IBM® Cast Iron® 連接器開發套件 (CDK) 開發⼈員⼿冊》適⽤於想要使⽤ Cast Iron Studio (Studio) 開發平台來
開發和部署外掛程式連接器的開發⼈員，⽽外掛程式連接器可從應⽤程式系統或其他資料來源擷取資料。

連接器可將外部應⽤程式的 API 外露給 Cast Iron 開發平台，來加強 Studio 的核⼼功能。 API 會以新的程式庫和
物件類型來擴充 Scripting 引擎，並將通知事件從外部系統發佈到 Cast Iron 實體或虛擬整合設備中。Cast Iron 設
備⽀援連接到多種類型的端點，包括 FTP、SFTP、HTTP、HTTPS、電⼦郵件（SMTP、POP）、SAP、MQ、Web
服務，以及許多商業資料庫系統。

每⼀個連接器都有關聯的 XML 描述⼦檔案，可讓連接器在設計時期於 Studio 中使⽤。XML 綱⽬定義 (XSD) 檔會
定義 XML 檔的元素和屬性。

Cast Iron 開發平台的特⾊是提供了可引導您進⾏開發程序的「CDK 連接器精靈」。Studio 提供直覺式的拖放介
⾯，可⼤幅縮短開發時間。

本⼿冊提供連接器的概觀、介紹 Cast Iron 開發平台元件，並提供開發和部署您專屬連接器時所需的逐步程序。

必備項⽬

開發連接器時會在 Studio 內進⾏許多⼯作，這表⽰您應該有使⽤ Studio 和 Cast Iron 產品的知識。 您也應該熟悉
下列語⾔和檔案格式：

延伸標記語⾔ (XML)
Web 服務說明語⾔ (WSDL)
可延伸樣式表語⾔轉換 (XSLT)

註： 對於許多活動，Studio 都⽀援「探索」處理程序，來決定傳送給端點或從端點接收的參數結構。如果您的輸
⼊活動將在設計時期供探索，您必須利⽤抽象 WSDL 或綱⽬元素類型。將元素宣告為抽象時，需要使⽤替代群
組。如果無法使⽤抽象版本，則您必須修改 WSDL 檔或綱⽬。接著在設計時期即會以實際的資料類型替代您的抽
象檔。如需抽象檔的相關資訊，請參閱使⽤新增活動視窗。

設計考量

由於近來透過 Web 以服務形式遞送之應⽤程式導向軟體的急速成⻑，使得對專案實作有效的準則更加重要。⼩⼼
規劃設計活動有助於確保專案的成功。

開始開發之前，請仔細考量下列準則：

作業與使⽤者分析 - 請考量開始專案之前要由⼀般使⽤者執⾏的作業。利⽤綱⽬檔所提供的元素以及 XML
檔的配置內容，您可以控制使⽤者對 Studio 和其功能所擁有的存取權層次。例如，藉由定義使⽤者的端
點，您可以限制或增加可新增⾄其編排的活動數。瞭解⼀般使⽤者如何執⾏其作業也⾮常重要。以使⽤者

可能需要的順序提供資訊，這有助於專案順利整合，並且可產⽣⼀致的使⽤者經驗。

命名慣例 - 有時候，在使⽤截⽌時間緊湊的專案時，很可能會草率將應⽤程式的元件加上標籤。例如，在
設計端點畫⾯時，您可能會傾向快速定義⼀個「類型」欄位，以便能夠進⾏更重要的功能作業。不過，直

覺式命名實務的好處通常不明顯，除⾮之後使⽤者⾯臨任意且混淆的命名⽅法。請記得，部署之後，連接

器即會被重複使⽤，因此請務必使⽤有邏輯、⼀致且直覺式的命名慣例。

開始之前

開始專案之前，請先收集下列資訊。將這些資訊供存取，可讓您的開發程序進⾏得更加順利：
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連線欄位 - 準備好指定連接端點所需的連線欄位詳細資料（例如名稱和類型）。
輸⼊活動 - 在設計時期決定哪些輸⼊活動將供動態探索，⽽哪些會是靜態。
輸⼊和輸出資料類型 - 準備好指出每⼀項活動要⽀援的輸⼊和輸出資料類型。

本⼿冊的內容架構

本⼿冊的內容架構

這份⽂件的設計是為了讓您在盡可能短的時間內開始開發專案。第⼀章介紹「CDK 連接器精靈」，並提供進⾏專
案所需的程序。 不過，如果您偏好先⾃⾏熟悉 CDK 開發平台再開始開發，則請先花幾分鐘檢閱第四章 CDK 元件
中的資訊再開始。

本⼿冊分為以下幾節。

開始使⽤ CDK 連接器精靈

介紹「CDK 連接器精靈」，並提供建置連接器的逐步指⽰。

測試與除錯

提供測試及除錯連接器的程序。

匯出和匯⼊連接器專案

提供如何匯出或匯⼊連接器專案的相關資訊。

Cast Iron CDK 元件

提供 Studio 開發平台的概觀並介紹 CDK 元件。

常⾒問題 (FAQ)

提供⼀些常⾒問題的解答。

取得協助

提供 IBM 資源的相關資訊，並告訴您如何取得協助。

上層主題： 設計考量

開始使⽤ CDK 連接器精靈

「CDK 連接器精靈」會呈現⼀系列可在其中輸⼊連接器基本詳細資料的三個視窗，引導您進⾏開發處理程序。該
「精靈」接著會產⽣您可測試、認證並部署到 Studio 的編排。

程序

1. 啟動 Studio。
2. 選取檔案 -> 新建連接器專案。

結果

「精靈」會在 Studio ⼯作區中開啟，並顯⽰「連接器資訊」視窗。
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下⼀步

在下⼀個階段中，您會使⽤「連接器資訊」視窗來新增連接器的基本資訊。

「連接器資訊」視窗

在這個階段期間，您會將連接器的⼀般資訊（例如名稱、版本和說明）新增⾄「連接器資訊」視窗，並新

增⽤於連接器活動的 WSDL 或綱⽬檔。
使⽤新增連線欄位視窗

您可以在「新增連線欄位」視窗中指定要外露給使⽤者的端點連線參數。您的使⽤者會使⽤這些值來連接

⾄其端點。

使⽤新增活動視窗

您可以在「新增活動」視窗中建⽴和定義連接器活動，以及將輸⼊和輸出資料的資訊輸⼊⾄該視窗中。

「最終摘要」視窗

在開發階段結束時，「最終摘要」視窗會警⽰您已準備好完成所產⽣的編排，並將專案匯出⾄連接器儲存

庫。

完成編排

您會完成編排，以便能夠將其匯出⾄ Studio。除了連接器編排之外，您也必須完成 Cast Iron 連接器介⾯的
編排。

Cast Iron 連接器介⾯
Cast Iron 連接器使⽤您實作為編排的三個標準介⾯：TestConnection、ListObjects 和 DescribeObjects。
完成連接器介⾯編排

在這個階段期間，您會將商業邏輯新增⾄ Cast Iron TestConnection、ListObjects 和 DescribeObjects 編
排。

發佈⾄本端儲存庫

在此階段期間，Studio 會驗證您的編排。 如果驗證成功，則您可以將連接器發佈⾄本端電腦上的儲存庫，
以進⾏測試和除錯。

「連接器資訊」視窗

在這個階段期間，您會將連接器的⼀般資訊（例如名稱、版本和說明）新增⾄「連接器資訊」視窗，並新增⽤於

連接器活動的 WSDL 或綱⽬檔。

關於這項作業

您可以在「連接器資訊」視窗中輸⼊連接器專案的基本詳細資料。「連接器資訊」視窗看起來如下：

圖 1. 「連接器資訊」視窗
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程序

1. 在「名稱」⽂字欄位中，輸⼊連接器的名稱。
註： 因為 NCName 的實際限制，所以「名稱」⽂字欄位中的字元不能包含符號字元，例如 :、@、$、%、
&、/、+、,、;、空格字元或不同括弧。此外，「名稱」⽂字欄位中字元的開頭不能是數字、點或減號字
元，雖然它們之後可以出現在 NCName 中。

2. 在「說明」⽂字欄位中，輸⼊連接器的說明。
3. 在「版本」⽂字欄位中，輸⼊連接器的版本號碼。
4. 如果要新增 WSDL 或綱⽬檔，請按⼀下瀏覽按鈕，並導覽⾄您要的檔案。 所選取的檔案會顯⽰在「新增

WSDL/綱⽬檔」欄位中。
註： 如果在設計時期會動態探索到輸⼊活動，您必須針對這個步驟提供包含抽象類型的 WSDL 或綱⽬。如
需抽象檔的相關資訊，請參閱使⽤新增活動視窗。

5. 按下⼀步。

結果

這時會顯⽰「新增連線欄位」視窗。

下⼀步

在下⼀個階段中，您會使⽤「新增連線欄位」視窗來指定端點連線內容。

上層主題： 開始使⽤ CDK 連接器精靈

使⽤新增連線欄位視窗

您可以在「新增連線欄位」視窗中指定要外露給使⽤者的端點連線參數。您的使⽤者會使⽤這些值來連接⾄其端

點。

關於這項作業

在此設計階段期間，您新增連線欄位以及連接⾄端點所需的對應詳細資料。「新增連線欄位」視窗看起來如下：
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圖 1. 「新增連線欄位」視窗

程序

1. 按⼀下加號圖⽰ (+)。 「新增端點連線欄位」畫⾯中會顯⽰空⽩的連線欄位。
2. 在「新增端點連線欄位」畫⾯中，輸⼊欄位類型（例如：密碼），來指定與使⽤者名稱相關聯的密碼。如
果要開始編輯，請按兩下「連線欄位名稱」資料格中的某⼀列來啟動它，然後輸⼊資訊。完成時，按

Enter 鍵。 欄位類型資訊會顯⽰在「名稱」欄位中。
3. 在「端點連線欄位詳細資料」畫⾯中，按⼀下類型和格式下拉功能表，然後選取與您在「新增端點連線欄
位」畫⾯中輸⼊之資訊對應的種類。在「新增端點連線欄位」畫⾯中，輸⼊欄位類型（例如：密碼），來

指定與使⽤者名稱相關聯的密碼。

4. 重複這些步驟來新增其他連線欄位。 在您新增其他欄位之後，請按下⼀步。

結果

這時會顯⽰「新增活動」視窗。

下⼀步

在下⼀個階段中，您會使⽤「新增活動」視窗來定義連接器活動。

上層主題： 開始使⽤ CDK 連接器精靈

使⽤新增活動視窗

您可以在「新增活動」視窗中建⽴和定義連接器活動，以及將輸⼊和輸出資料的資訊輸⼊⾄該視窗中。

關於這項作業

在此階段期間，您可以指定在設計時期靜態還是動態探索輸⼊資料。例如，如果要在設計時期探索資料，則可以

使⽤建⽴活動來建⽴不同的物件類型（如 Account、Contact 或 User）。對建⽴活動的輸⼊會視要建⽴的物件⽽
有所不同。在這種狀況下，建⽴會被視為可瀏覽的活動，其輸⼊會視要產⽣的物件⽽有所不同。
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註： 如果要讓您的輸⼊活動在設計時期可供探索，您必須提供抽象 WSDL 或綱⽬類型。抽象 WSDL 或綱⽬類型會
以實作中⽴的詞彙來說明 Web 服務，反之，具體 WSDL 或綱⽬類型則會定義實作服務的端點在網路上如何外露。
圖 1 顯⽰含有抽象類型定義的 WSDL 範例：
圖 1. 含有抽象定義的 WSDL

「新增活動」視窗看起來如下：

圖 2. 「新增活動」視窗
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程序

1. 按⼀下加號 (+) 圖⽰。 「新增連接器活動」畫⾯中會顯⽰空⽩的⽂字欄位。
2. 在「新增連接器活動」畫⾯中，新增活動名稱。如果要開始編輯，請按兩下「活動名稱」資料格中的某⼀
列來啟動它，然後輸⼊資訊。完成時，按 Enter 鍵。
註： 因為 NCName 的實際限制，所以「名稱」⽂字欄位中的字元不能包含符號字元，例如 :、@、$、%、
&、/、+、,、;、空格字元或不同括弧。此外，「名稱」⽂字欄位中字元的開頭不能是數字、點或減號字
元，雖然它們之後可以出現在 NCName 中。

3. 在「新增連接器活動」畫⾯中，選取起始者活動勾選框，指⽰所選取的活動是否為起始者活動。
4. 在「動態輸⼊/輸出需求」畫⾯中，指定輸⼊參數和（或）輸出參數是否需要動態探索。 如果您想要輸⼊活
動在設計時期可供探索，則必須提供抽象綱⽬類型。

5. 如果⼀或多個參數需要動態探索，請在「選取輸⼊/輸出資料」畫⾯中，使⽤選取輸⼊或選取輸出按鈕，來
選取每⼀個活動的輸⼊和（或）輸出資料。附註：請勿將特定的輸⼊資料類型指派給多個活動。

註： 「起始者活動」只有輸出類型。因此，您只能選取「活動詳細資料」區段中的輸出類型。
6. 對每⼀個新活動重複這些步驟。
7. 完成之後，按下⼀步。

結果

這時會顯⽰「最終摘要」視窗。

下⼀步

在「最終摘要」視窗中檢視結果。

上層主題： 開始使⽤ CDK 連接器精靈

「最終摘要」視窗
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在開發階段結束時，「最終摘要」視窗會警⽰您已準備好完成所產⽣的編排，並將專案匯出⾄連接器儲存庫。

「最終摘要」視窗會確認已順利產⽣您的連接器活動。「最終摘要」視窗看起來如下：

圖 1. 「最終摘要」視窗

上層主題： 開始使⽤ CDK 連接器精靈

完成編排

您會完成編排，以便能夠將其匯出⾄ Studio。除了連接器編排之外，您也必須完成 Cast Iron 連接器介⾯的編排。

關於這項作業

在您完成開發⼯作之後，請執⾏下列程序，以完成連接器編排。 在 Cast Iron 連接器介⾯中已為您介紹 Cast Iron
TestConnection、ListObjects 和 DescribeObjects 連接器介⾯，並提供了完成每⼀項編排的程序。

在後續步驟中，您會從「Web 服務提供服務」活動讀取輸⼊資料、新增邏輯，然後使⽤「傳送回覆」輸出活動來
回應，以完成連接器的編排。「提供服務」活動提供了可從外部⽤⼾端啟動的 Web 服務。在執⾏時期，「傳送回
覆」活動會將回應傳回給⽤⼾端。

程序

1. 在「專案」⼯具箱標籤，選取編排，例如：CreateObjects。 編排會顯⽰在 Studio ⼯作區中。
2. 在編排中，按⼀下提供服務活動。 這時會顯⽰「對映輸出」畫⾯。
3. 在「對映輸出」畫⾯中，按⼀下主體。 這時會出現顯⽰輸⼊資料的節點類型視窗。
4. 使⽤節點類型視窗中的資訊對映主體資料，並使⽤該資料在端點中建⽴物件。
5. 選取編排 -> 驗證。
註： 為起始者活動產⽣的編排具有「提供服務」及「呼叫服務」活動。 作為實作起始者活動的⼀部分，會
在結束時提取所需資料，並將值傳遞給預先⽣產的「呼叫服務活動」。「呼叫服務活動」必須是編排中的
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最後⼀項活動。同時，將選擇性參數 location 移⼊⾄已接收的 callbackURL，作為預先產⽣「提供服
務活動」的 ConnectionFields 標頭的⼀部分。

結果

這時會出現顯⽰驗證結果的「驗證結果」視窗。

下⼀步

完成 Cast Iron TestConnection、ListObjects 和 DescribeObjects 連接器介⾯的編排。
上層主題： 開始使⽤ CDK 連接器精靈

Cast Iron 連接器介⾯

Cast Iron 連接器使⽤您實作為編排的三個標準介⾯：TestConnection、ListObjects 和 DescribeObjects。

在「新增活動」階段期間，「精靈」會⾃動建⽴ TestConnection、ListObjects 和 DescribeObjects 介⾯的編排範
本。您必須根據個別連接器的需求來完成編排。本節介紹 TestConnection、ListObjects 和 DescribeObjects 介
⾯。在完成連接器介⾯編排中，您可以完成每⼀項的編排。

TestConnection

TestConnection 介⾯會反映您新增⾄「連線資訊」視窗的值，並且由連接器⽤來建⽴端點連線。建⽴連線之後，
即會以布林運算⼦傳回連線狀態。

ListObjects

ListObjects 介⾯會反映您新增⾄「新增活動」視窗的值，並傳回特定連接器活動所⽀援的所有物件的清單。例
如，Salesforce 建⽴作業可能會⽀援 Account、Customer、Contact、Opportunity 和 User，還有其他的物件。傳
回清單應該對應於「ListObjects 回覆活動」綱⽬。以下是 XML 格式的 ListObjects 回應範例：

<ListObjectsResponse 
xmlns="http://www.approuter.com/schemas/cdk/api/"> 
<objectType 
label="Customer" 
xmlns="http://www.approuter.com/schemas/cdk/api/">Account</objectType> 
<objectType 
label="Account Object" 
xmlns="http://www.approuter.com/schemas/cdk/api/">Customer</objectType> 
<objectType 
label="Customer details" 
xmlns="http://www.approuter.com/schemas/cdk/api/">Contact</objectType> 
<objectType 
label="Opportunity details" 
xmlns="http://www.approuter.com/schemas/cdk/api/">Opportunity</objectType> 
<objectType 
label="User details" 
xmlns="http://www.approuter.com/schemas/cdk/api/">User</objectType> 
</ListObjectsResponse>

DescribeObjects

DescribeObjects 介⾯提供了輸⼊及輸出，可讓使⽤者順利透過連接器活動使⽤外露的物件。例如，如果選取
Salesforce 建⽴作業，則會根據從 ListObjects 選取的物件動態探索輸⼊綱⽬。以下是 DescribeObjects 傳回的回
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應範例：

<DescribeObjectResponse baseType="sObject" 
  baseTypeNS="urn:sobject.partner.soap.sforce.com" 
 name="create" typeNS="http://example.com/stockquote" 
 xmlns="http://www.approuter.com/schemas/cdk/api/" 
 xmlns:con="http://www.approuter.com/schemas/cdk/config/" 
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"> 
 <object label="createInput" maxCount="1" minCount="1" name="createInput" 
  used="true"> 
  <con:field configurable="true" label="ObjectName" maxCount="1" 
   minCount="1" name="ObjectName" used="true"> 
   <con:type>string</con:type> 
  </con:field> 
  <con:field configurable="true" label="FirstName" maxCount="1" 
   minCount="1" name="FirstName" used="true"> 
   <con:type>string</con:type> 
  </con:field> 
  <con:field configurable="true" label="LastName" maxCount="1" 
   minCount="1" name="LastName" used="true"> 
   <con:type>string</con:type> 
  </con:field> 
  <con:field configurable="true" label="Phone" maxCount="1" 
   minCount="1" name="Phone" used="true"> 
   <con:type>string</con:type> 
  </con:field> 
 </object> 
 <responseObject label="createOutput" maxCount="1" 
  minCount="1" name="createOutput" used="true"> 
  <con:field configurable="true" label="Id" maxCount="1" 
   minCount="1" name="Id" used="true"> 
   <con:type>string</con:type> 
  </con:field> 
  <con:field configurable="true" label="ObjectName" maxCount="1" 
   minCount="1" name="ObjectName" used="true"> 
   <con:type>string</con:type> 
  </con:field> 
  <con:field configurable="true" label="Status" maxCount="1" 
   minCount="1" name="Status" used="true"> 
   <con:type>string</con:type> 
  </con:field> 
 </responseObject> 
</DescribeObjectResponse> 

動態綱⽬探索

DescribeObjects 綱⽬探索特性可讓您在執⾏時期動態探索綱⽬。任何連接器活動使⽤綱⽬元素作為輸⼊或輸出
時，會將此綱⽬匯⼊⾄編排。如果需要使⽤ complexType QName 探索先前匯⼊的綱⽬並動態替代為輸⼊或輸出
活動，請在 DescribeObject 回應中設定屬性，如下列綱⽬所⽰：

< xsd:schema   targetNamespace = " urn.sample.stock 
 " xmlns:xsd = "http://www.w3.org/2001/XMLSchema" > 
 < xsd:element   name = "TradePriceRequest" > 
 < xsd:complexType > 
 < xsd:all > 
 < xsd:element   name = "tickerSymbol"   type = "xsd:string"   /> 
 </ xsd:all > 
 </ xsd:complexType > 
 </ xsd:element > 
 < xsd:complexType   name = "ciObject" ></ xsd:complexType > 
 < xsd:complexType   name = " tradingPartner " > 
 < xsd:sequence > 
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 < xsd:element   name = "partnerName"   type = "xsd:string"   /> 
 </ xsd:sequence > 
 </ xsd:complexType >  

例如，若要替代之前綱⽬中的 complexType tradingPartner，請設定資訊來探索綱⽬，並動態替代它，如下
列範例所⽰：

DescribeObject Response value to  
@name   -> tradingPartner [complexType name to be discovered] 
@typeNS  ->  url.sample.stock [complexType namespace ] 
@baseType -> http://www.approuter.com/schemas/cdk/api/    [CDK default] 
@baseType -> cObject [CDK default]

上層主題： 開始使⽤ CDK 連接器精靈

完成連接器介⾯編排

在這個階段期間，您會將商業邏輯新增⾄ Cast Iron TestConnection、ListObjects 和 DescribeObjects 編排。

完成 TestConnection 編排
在下列步驟中，您會將值對映⾄物件類型，並且呼叫編排活動來測試端點連線。

完成 ListObjects 編排
在後⾯的步驟中，您會將商業邏輯新增⾄ ListObjects 編排，並將值對映⾄物件類型，以及呼叫編排活動來
測試端點連線。請只在您的編排活動於設計時期可供探索時，才完成本節的程序。

完成 DescribeObjects 編排
若要完成 DescribeObjects 編排，您可以將輸出對映⾄輸⼊資料，並將物件 meta 資料轉換成 XML 格式，
以符合 ci-connector-api.xsd 檔，然後測試編排。

上層主題： 開始使⽤ CDK 連接器精靈

完成 TestConnection 編排

在下列步驟中，您會將值對映⾄物件類型，並且呼叫編排活動來測試端點連線。

程序

1. 在 Studio「專案」⼯具箱標籤中，按⼀下 TestConnection 編排。 編排會顯⽰在 Studio ⼯作區中。
2. 在編排中，新增連接端點所需的邏輯，如圖 1 所⽰。
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3. 在編排中，按⼀下傳送回覆活動。 輸⼊會顯⽰在「來源編排」畫⾯中。
圖 1. TestConnection

4. 將「來源編排」畫⾯中顯⽰的值，對映到「⽬標活動」畫⾯中的物件類型。 您現在已準備好測試編排。
5. 在編排中，於提供服務活動上按⼀下滑⿏右鍵。 這時會顯⽰「驗證活動」功能表。
6. 在「驗證活動」功能表中，選取呼叫服務。 這時會顯⽰「呼叫服務」視窗。
7. 在「呼叫服務」視窗中，輸⼊標頭和主體資料，然後按⼀下執⾏來啟動測試。如果要檢視測試活動，請按
⼀下顯⽰回應按鈕。 測試完成時，結果會顯⽰在「驗證」⼯具箱標籤中。

8. 如果連線成功，測試回應會顯⽰ "true" 值。如果要完成編排，請將 "true" 對映⾄「⽬標活動」畫⾯中
TestConnectionResponse 參數的 success 欄位。

下⼀步

如果您的連接器活動在設計時期可供探索，請完成完成 ListObjects 編排中的程序。 如果您的連接器活動不會供探
索，則可進⾏完成 DescribeObjects 編排。
上層主題： 完成連接器介⾯編排

完成 ListObjects 編排

在後⾯的步驟中，您會將商業邏輯新增⾄ ListObjects 編排，並將值對映⾄物件類型，以及呼叫編排活動來測試端
點連線。請只在您的編排活動於設計時期可供探索時，才完成本節的程序。

程序

1. 在 Studio「專案」⼯具箱標籤中，按⼀下 ListObjects 編排。 編排會顯⽰在 Studio ⼯作區中。
2. 在 ListObjects 編排中新增邏輯，如圖 1 所⽰。 「⽬標活動」畫⾯中會顯⽰針對提供的端點，連接器所⽀
援的物件清單。

圖 1. ListObjects
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3. 在編排中，選取傳送回覆活動。 輸⼊會顯⽰在「來源編排」畫⾯中。
4. 在「來源編排」畫⾯中，按⼀下某個活動。 「⽬標活動」畫⾯中會顯⽰該作業所⽀援的物件清單。
5. 將「來源編排」畫⾯中顯⽰的值，對映到「⽬標活動」畫⾯中 ListObjectsResponse 下的物件類型，如圖 1
所⽰。 您現在已準備好測試編排。

6. 在編排中，於提供服務活動上按⼀下滑⿏右鍵。 這時會顯⽰「驗證活動」功能表。
7. 在「驗證活動」功能表中，選取呼叫服務。 這時會顯⽰「呼叫服務」視窗。
8. 在「呼叫服務」視窗中，輸⼊標頭和主體資料，然後按⼀下執⾏來啟動測試。如果要檢視測試活動，請按
⼀下顯⽰回應按鈕。

結果

測試完成時，結果會顯⽰在「驗證」⼯具箱標籤中。如果有錯誤，請進⾏必要的更正，然後重新執⾏單元測試。

下⼀步

完成 DescribeObjects 編排。
上層主題： 完成連接器介⾯編排

完成 DescribeObjects 編排

若要完成 DescribeObjects 編排，您可以將輸出對映⾄輸⼊資料，並將物件 meta 資料轉換成 XML 格式，以符合
ci-connector-api.xsd 檔，然後測試編排。

程序

1. 在 Studio「專案」⼯具箱標籤中，按⼀下 DescribeObjects 編排。 編排會顯⽰在 Studio ⼯作區中。
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2. 在編排中，按⼀下提供服務活動。 這時會顯⽰「對映輸出」畫⾯。
3. 在「對映輸出」畫⾯中，按⼀下主體。 這時會出現顯⽰輸⼊資料的節點類型視窗。
4. 根據 object 和 operation_name 將邏輯新增⾄編排（如圖 1 所⽰），來取得物件 meta 資料。
圖 1. DescribeObjects

5. 將物件 meta 資料轉換成 XML 格式，以符合Cast Iron CDK 綱⽬檔中說明的 ci-connector-api.xsd
檔。將 meta 資料轉換成 XML 之後，您的綱⽬看起來如下：

< DescribeObjectResponse 
baseType = "sObject" 
baseTypeNS = "urn:sobject.partner.soap.sforce.com" 
name = "create" 
typeNS = "http://example.com/stockquote" 
xmlns = "http://www.approuter.com/schemas/cdk/api/" 
xmlns:con = "http://www.approuter.com/schemas/cdk/config/" 
xmlns:xsi = "http://www.w3.org/2001/XMLSchema-instance" > 
< object 
label = "createInput" 
maxCount = "1" 
minCount = "1" 
name = "createInput" 
used = "true" > 
< con:field 
configurable = "true" 
label = "ObjectName" 
maxCount = "1" 
minCount = "1" 
name = "ObjectName" 
used = "true" > 
< con:type > string </ con:type > 
</ con:field > 
< con:field 
configurable = "true" 
label = "FirstName" 
maxCount = "1" 
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minCount = "1" 
name = "FirstName" 
used = "true" > 
< con:type > string </ con:type > 
</ con:field > 
< con:field 
configurable = "true" 
label = "LastName" 
maxCount = "1" 
minCount = "1" 
name = "LastName" 
used = "true" > 
< con:type > string </ con:type > 
</ con:field > 
< con:field 
configurable = "true" 
label = "Phone" 
maxCount = "1" 
minCount = "1" 
name = "Phone" 
used = "true" > 
< con:type > string </ con:type > 
</ con:field > 
</ object > 
< responseObject 
label = "createOutput" 
maxCount = "1" 
minCount = "1" 
name = "createOutput" 
used = "true" > 
< con:field 
configurable = "true" 
label = "Id" 
maxCount = "1" 
minCount = "1" 
name = "Id" 
used = "true" > 
< con:type > string </ con:type > 
</ con:field > 
< con:field 
configurable = "true" 
label = "ObjectName" 
maxCount = "1" 
minCount = "1" 
name = "ObjectName" 
used = "true" > 
< con:type > string </ con:type > 
</ con:field > 
< con:field 
configurable = "true" 
label = "Status" 
maxCount = "1" 
minCount = "1" 
name = "Status" 
used = "true" > 
< con:type > string </ con:type > 
</ con:field > 
</ responseObject > 
</ DescribeObjectResponse >

6. 在 DescribeObjects 編排中，選取傳送回覆活動。 這時會顯⽰「對映輸⼊」畫⾯。
7. 在「對映輸⼊」畫⾯中，將產⽣的 XML 對映到「⽬標活動」畫⾯中的 DescribeObjectResponse 參數。 您
現在已準備好測試編排。
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8. 在編排中，於提供服務活動上按⼀下滑⿏右鍵。 這時會顯⽰「驗證活動」功能表。
9. 在「驗證活動」功能表中，選取呼叫服務。 這時會顯⽰「呼叫服務」視窗。

10. 在「呼叫服務」視窗中，輸⼊標頭和主體資料，然後按⼀下執⾏來啟動測試。如果要檢視測試活動，請按
⼀下顯⽰回應按鈕。

結果

測試完成時，結果會顯⽰在「驗證」⼯具箱標籤中。如果有錯誤，請進⾏必要的更正，然後重新執⾏單元測試。

下⼀步

在下⼀個階段中，您會學習如何將連接器專案發佈⾄本端儲存庫。

上層主題： 完成連接器介⾯編排

發佈⾄本端儲存庫

在此階段期間，Studio 會驗證您的編排。 如果驗證成功，則您可以將連接器發佈⾄本端電腦上的儲存庫，以進⾏
測試和除錯。

程序

1. 選取檔案 -> 將連接器發佈⾄本端儲存庫，或按⼀下發佈⼯具列圖⽰，如圖 1 所⽰。 Studio 會驗證編排。
如果驗證成功，連接器即會發佈⾄位於 <user_home>/.castiron/connector-repository 的連接器儲存庫。如
果驗證失敗，則會顯⽰錯誤訊息。請更正問題，再重新發佈。

2. 重新啟動 Studio。 您的連接器活動會顯⽰在 Studio「活動」⼯具箱標籤中，且可供使⽤。
圖 1. 將連接器發佈⾄本端儲存庫

在開發⼯作結束之後，您的連接器和連接器活動會顯⽰在 Studio「活動」⼯具箱標籤中，如圖 2 所⽰。
圖 2. Studio「活動」⼯具箱標籤中顯⽰的連接器和連接器活動。
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註： 請不要嘗試將連接器專案直接部署⾄設備，因為這會導致錯誤。為獲得最佳結果，請只部署在 Studio
內顯⽰為端點的連接器專案。

下⼀步

在下⼀節中，您會進⾏執⾏時期驗證，以及測試端點。

上層主題： 開始使⽤ CDK 連接器精靈

測試與除錯

Studio 提供了數個機能來測試您的連接器元件。在測試與除錯階段期間，您可以進⾏執⾏時期驗證，來測試您的
連接器及診斷配置或資料錯誤。所有出埠端點都應該加以測試。

當您測試連接器時，Studio 建置程序會檢查 XML 檔的形式是否完整，並對照綱⽬檔加以驗證。接著其會產⽣出埠
對映、建⽴並傳送出埠訊息、接收回應，以及執⾏⼊埠對映。CDK 會執⾏兩種類型的測試：

單元測試

整合測試

單元測試連接器元件

單元測試是任何開發專案的成功關鍵，其基本上是通過或失敗的測試，可驗證連接器的元件是否能如預期

般執⾏。

整合測試連接器服務和活動

在整合測試期間，您會驗證連接器服務、訊息與介⾯是否適當地執⾏。

單元測試連接器元件

單元測試是任何開發專案的成功關鍵，其基本上是通過或失敗的測試，可驗證連接器的元件是否能如預期般執

⾏。

關於這項作業

在這個階段期間，您會執⾏單元測試來模擬⽤⼾端與 Web 服務（其外露為「Web 服務提供」活動）之間的通訊。

程序

1. 在「專案」⼯具箱標籤，選取編排。 編排會顯⽰在 Studio ⼯作區中。
2. 在編排中，於提供服務活動上按⼀下滑⿏右鍵。 這時會顯⽰「驗證活動」功能表。
3. 在「驗證活動」功能表中，選取呼叫服務。 這時會顯⽰「呼叫服務」視窗，如圖 1 所⽰。
4. 在「呼叫服務」視窗中，輸⼊標頭和主體資料，然後按⼀下執⾏來啟動測試。如果要檢視測試活動，請按
⼀下顯⽰回應按鈕。
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圖 1. 「呼叫服務」視窗

註： 使⽤「重設」按鈕時請⼩⼼。其會消除「呼叫服務」視窗中現有的內容，並重新移⼊ Web 服務範本資
訊。請只有在要重新開始進⾏單元測試時，才按⼀下「重設」。

結果

測試完成時，結果會顯⽰在「驗證」⼯具箱標籤中。如果有錯誤，請進⾏必要的更正，然後重新執⾏單元測試。

下⼀步

執⾏整合測試，以判斷您的連接器元件是否適當地執⾏。

上層主題： 測試與除錯

整合測試連接器服務和活動

在整合測試期間，您會驗證連接器服務、訊息與介⾯是否適當地執⾏。

程序

1. 在「專案」⼯具箱標籤，選取編排。 編排會顯⽰在 Studio ⼯作區中。
2. 在「活動」⼯具箱標籤中，選取⼀個活動，然後將它拖放到編排中。
3. 在 Studio ⼯作區中，按⼀下該活動。 該活動會強調顯⽰。
4. 在「核對清單」畫⾯中，按⼀下挑選端點。 這時會顯⽰「挑選端點」畫⾯。
5. 在「挑選端點」畫⾯中，按⼀下新建。 這時會顯⽰「建⽴端點」畫⾯。
6. 在「建⽴端點」畫⾯中，輸⼊連線資訊，然後按⼀下 TestConnection。
7. 如果連線成功，請按⼀下確定。
8. 在「核對清單」畫⾯中，按⼀下配置。 這時會顯⽰「配置」畫⾯。
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9. 選⽤項⽬：在「配置」畫⾯中，按⼀下瀏覽以搜尋可瀏覽的活動。（不可瀏覽的活動不需要這個步驟。）
這時會顯⽰ ListObjects 對話視窗。

10. 在 ListObjects 對話視窗中，選取要成為選定活動之輸⼊的綱⽬。
11. 完成輸⼊及輸出對映。
12. 測試編排。 如果您要檢視處理器活動，請在 Studio 的「喜好設定」視窗中勾選顯⽰ CDK 連接器活動⽇誌
選項，如圖 1 所⽰。
圖 1. 「喜好設定」視窗

結果

處理器活動和最終測試結果會顯⽰在 Studio「驗證」⼯具箱標籤中。

下⼀步

在下⼀節中，您會學習如何匯出和匯⼊連接器專案。

上層主題： 測試與除錯

匯出和匯⼊連接器專案
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建⽴並測試完連接器之後，您可以將它匯出⾄外部位置，以供其他⼈使⽤。您也可以將連接器保存檔匯⼊

Studio。

您可以使⽤ Studio 功能表或按⼀下「匯出」或「匯⼊」⼯具列圖⽰，來匯出和匯⼊連接器專案。
註： 請不要嘗試將連接器專案直接部署⾄設備，因為這會導致錯誤。為獲得最佳結果，請只部署在 Studio 內顯⽰
為端點的連接器專案。

匯出連接器專案

當您將完成的連接器從 Studio 匯出⾄外部位置時，即可供其他⼈載⼊及使⽤。匯出的連接器會包裝為標準
的 .zip 檔。
匯⼊連接器專案

您可以使⽤ Studio 來匯⼊已開發為標準壓縮保存檔的連接器專案。

匯出連接器專案

當您將完成的連接器從 Studio 匯出⾄外部位置時，即可供其他⼈載⼊及使⽤。匯出的連接器會包裝為標準的 .zip
檔。

關於這項作業

您可以使⽤ Studio 功能表選項或⼯具列，來匯出連接器。如果您不指定⽬錄，匯出的連接器專案會放在專案⽬錄
的⼦⽬錄中。如果您選擇匯出⾄保存檔，則專案會包裝在專案⽬錄下的 .zip 保存檔中。

程序

1. 選取檔案 -> 匯出連接器，或按⼀下匯出連接器⼯具列圖⽰。 這時會顯⽰「檔案」對話視窗，顯⽰可⽤連接
器的清單。

2. 在「檔案」對話視窗中，選取連接器，然後按⼀下確定。 這時會顯⽰「儲存」對話視窗。
3. 在「儲存」對話視窗中，瀏覽⾄要⽤來匯出專案的位置，然後按⼀下儲存。

結果

您的連接器即會匯出為標準 .zip 保存檔。

下⼀步

在下⼀節中，您會學習如何匯⼊連接器專案。

上層主題： 匯出和匯⼊連接器專案

匯⼊連接器專案

您可以使⽤ Studio 來匯⼊已開發為標準壓縮保存檔的連接器專案。

關於這項作業

您可以使⽤ Studio 功能表選項或⼯具列，將連接器匯⼊ Studio。

程序
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1. 選取檔案 -> 匯⼊連接器，或按⼀下匯⼊連接器⼯具列圖⽰。 這時會顯⽰「檔案」對話視窗。
2. 在「檔案」對話視窗中，選取連接器，然後按⼀下確定。

結果

連接器會以 .zip 保存檔形式匯⼊⾄ Studio。

下⼀步

在下⼀節中，會呈現 CDK 元件的概觀。
上層主題： 匯出和匯⼊連接器專案

Cast Iron CDK 元件

「連接器開發者套件」含有四個主要元件，這些元件共同運作即構成了 CDK 開發平台。

圖 1 顯⽰這些元件，並說明其與 Studio 的關係：

圖 1. CDK 元件
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Cast Iron CDK 綱⽬檔
XML 綱⽬檔提供語法，⽽且會定義如何在 XML 檔中表⽰元素和屬性。您可以將 Cast Iron CDK 綱⽬檔匯⼊
⾄ Studio 開發環境，然後將綱⽬元素從專案⼯具箱標籤拖曳到您的編排，來建⽴端點和連線。
Cast Iron CDK XML 檔
您的 XML 檔定義外掛程式所執⾏的活動。 XML 檔中的每⼀個活動都必須與 WSDL 檔中定義的⼀項作業對
映。

Cast Iron CDK WSDL 檔
WSDL 檔是⼀種 XML 格式的檔案，將網路服務定義為⼀組端點。WSDL 檔會說明如何存取 Web 服務，並指
定服務所執⾏的作業。WSDL 通常是由 Web 服務提供者所開發，且可透過 UDDI（通⽤說明、探索與整
合）登錄來使⽤。

Cast Iron CDK .par 檔
您的外掛程式會包裝成 .par 檔。您的 .par 是您重新命名並匯⼊⾄ Studio 的標準 .zip 檔。
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Cast Iron CDK 綱⽬檔

XML 綱⽬檔提供語法，⽽且會定義如何在 XML 檔中表⽰元素和屬性。您可以將 Cast Iron CDK 綱⽬檔匯⼊⾄
Studio 開發環境，然後將綱⽬元素從專案⼯具箱標籤拖曳到您的編排，來建⽴端點和連線。

這些 CDK 綱⽬檔為：

ci-connector-config.xsd - Studio 和部署引擎會使⽤這個檔案來定義連接器可使⽤的基本配置選項。外掛程式
meta 資料會儲存為 XML 檔中的元素，且配置之後，端點內容即會定義⼀般使⽤者會看到的內容，以及對其外露
的活動。這裡是 ci-connector-config.xsd 檔案：

<xs:schema 
 
id="_dcs_markdown_workspace_Transform_htmlout_0_nl_zh_TW_com.ibm.wci.cdk.doc_cdk_sch
emas_ci-cdk-config" 
 version="1.0" 
 targetNamespace="http://www.approuter.com/schemas/cdk/config/" 
 xmlns:tns="http://www.approuter.com/schemas/cdk/config/" 
 xmlns:xs="http://www.w3.org/2001/XMLSchema" 
 xmlns:jaxb="http://java.sun.com/xml/ns/jaxb" 
 xmlns:xjc="http://java.sun.com/xml/ns/jaxb/xjc" 
 jaxb:extensionBindingPrefixes="xjc" 
 jaxb:version="2.0" 
 elementFormDefault="qualified"> 
 <xs:annotation> 
  <xs:appinfo> 
   <jaxb:schemaBindings> 
    <jaxb:package 
     
name="com.approuter.studio.connectors.cdk.config" /> 
   </jaxb:schemaBindings> 
   <jaxb:globalBindings> 
    <xjc:simple /> 
   </jaxb:globalBindings> 
  </xs:appinfo> 
 </xs:annotation> 
 <xs:element 
  name="connectorConfiguration"> 
  <xs:complexType> 
   <xs:sequence> 
    <!-- Connector description --> 
    <xs:element 
     name="description" 
     type="xs:string" /> 
    <!-- Endpoint form definition --> 
    <xs:element 
     name="endpoint" 
     type="tns:EndpointForm" /> 
    <!-- Connector activities --> 
    <xs:element 
     name="activity-group" 
     type="tns:ActivityGroup" /> 
    <xs:element 
     name="operations" 
     minOccurs="0"> 
     <xs:complexType> 
      <xs:sequence> 
       <xs:element 
        name="operation" 
        
type="tns:operationType" 
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        minOccurs="0" 
        
maxOccurs="unbounded" /> 
      </xs:sequence> 
      <!-- 
       default endpoint location 
for those 
       operations that do not 
define one or are 
       not defined 
      --> 
      <xs:attribute 
       name="default-endpoint-
location" 
       type="xs:string" 
       use="optional" /> 
     </xs:complexType> 
    </xs:element> 
    <!-- Minimum client version --> 
    <xs:element 
     name="clients" 
     minOccurs="0"> 
     <xs:complexType> 
      <xs:sequence> 
       <xs:element 
        name="client" 
        
type="tns:CompatibleClient" 
        minOccurs="0" 
        
maxOccurs="unbounded" /> 
      </xs:sequence> 
     </xs:complexType> 
    </xs:element> 
    <!-- release documentation --> 
    <xs:element 
     name="release-documentation" 
     type="tns:ReleaseDocumentation" 
     minOccurs="0" 
     maxOccurs="unbounded" /> 
   </xs:sequence> 
   <!-- 
    Internal name of the connector. Do not change 
    names between releases of the connector 
   --> 
   <xs:attribute 
    name="name" 
    type="xs:string" 
    use="required" /> 
   <!-- Readable label for connector --> 
   <xs:attribute 
    name="label" 
    type="xs:string" 
    use="required" /> 
   <!-- 
    Connection namespace. Used to associate 
    activities with endpoints within Studio 
   --> 
   <xs:attribute 
    name="connection-ns" 
    type="xs:string" 
    use="required" /> 
   <!-- Version of this connector --> 
   <xs:attribute 
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    name="version" 
    type="xs:string" 
    use="required" /> 
   <!-- notes --> 
   <xs:attribute 
    name="notes" 
    type="xs:string" /> 
   <!-- release date --> 
   <xs:attribute 
    name="release-date" 
    type="xs:dateTime" 
    use="optional" /> 
   <!-- 
    General hint to consumer as to its 
    classification 
    classification 
   --> 
   <xs:attribute 
    name="category" 
    type="tns:ConnectorCategory" /> 
  </xs:complexType> 
 </xs:element> 
 <xs:complexType 
  name="ReleaseDocumentation"> 
  <xs:simpleContent> 
   <xs:extension 
    base="xs:string"> 
    <!-- corresponding plugin connector version --> 
    <xs:attribute 
     name="release-version" 
     type="xs:string" /> 
   </xs:extension> 
  </xs:simpleContent> 
 </xs:complexType> 
 <xs:complexType 
  name="CompatibleClient"> 
  <xs:attribute 
   name="clientName" 
   type="xs:string" 
   default="castiron-studio" /> 
  <xs:attribute 
   name="minimumClientVersion" 
   type="xs:string" 
   default="6.0" /> 
 </xs:complexType> 
 <!-- 
  Endpoint form. Test connection action required. 
 --> 
 <xs:complexType 
  name="EndpointForm"> 
  <xs:complexContent> 
   <xs:extension 
    base="tns:Form"> 
    <xs:sequence> 
     <xs:element 
      name="test-connection-action" 
      type="tns:TestConnectionAction" /> 
     <!-- Connector description --> 
     <xs:element 
      name="endpoint-description" 
      type="xs:string" /> 
    </xs:sequence> 
    <!-- 
     Used for Studio menu integration (e.g. 
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     Endpoints menu-item, default endpoint 
     instance name) 
    --> 
    <xs:attribute 
     name="endpoint-name" 
     type="xs:string" 
     use="required" /> 
   </xs:extension> 
  </xs:complexContent> 
 </xs:complexType> 
 <xs:complexType 
  name="Form"> 
  <xs:sequence> 
   <!-- Form fields --> 
   <xs:element 
    name="field" 
    type="tns:FormField" 
    minOccurs="0" 
    maxOccurs="unbounded" /> 
   <!-- Fields can be grouped --> 
   <xs:element 
    name="field-group" 
    type="tns:FieldGroup" 
    minOccurs="0" 
    maxOccurs="unbounded" /> 
   <!-- Form actions.   --> 
   <xs:element 
    name="actions" 
    type="tns:Actions" 
    minOccurs="0" 
    maxOccurs="1" /> 
  </xs:sequence> 
  <xs:attribute 
   name="name" 
   type="xs:string" 
   use="required" /> 
 </xs:complexType> 
 
 <!-- Fields can be a member of a group --> 
 <xs:complexType 
  name="FieldGroup"> 
  <xs:sequence> 
   <xs:element 
    name="field" 
    type="tns:FormField" 
    minOccurs="0" 
    maxOccurs="unbounded" /> 
   <xs:element 
    name="field-group" 
    type="tns:FieldGroup" 
    minOccurs="0" 
    maxOccurs="unbounded" /> 
  </xs:sequence> 
  <xs:attribute 
   name="name" 
   type="xs:string" 
   use="required" /> 
  <!-- Readable group label --> 
  <xs:attribute 
   name="label" 
   type="xs:string" 
   use="optional" /> 
  <!-- 
   Predefined groups. If specified, there is no 
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   need to specify label, groups, or fields. If 
   specified they will be ignored. 
  --> 
  <xs:attribute 
   name="type" 
   use="optional"> 
   <xs:simpleType> 
    <xs:restriction 
     base="xs:string"> 
     <xs:enumeration 
      value="connection-timeout" /> 
     <xs:enumeration 
      value="connection-proxy" /> 
     <!-- TBD others --> 
    </xs:restriction> 
   </xs:simpleType> 
  </xs:attribute> 
 </xs:complexType> 
 <xs:complexType 
  name="FormField"> 
  <xs:annotation> 
   <xs:appinfo> 
    <jaxb:bindings 
     node="//xs:complexType[@name='FormField']"> 
     <jaxb:class 
      
implClass="com.approuter.studio.connectors.cdk.config.ConnectorFormField" /> 
    </jaxb:bindings> 
   </xs:appinfo> 
  </xs:annotation> 
  <xs:complexContent> 
   <xs:extension 
    base="tns:FieldDescriptor"> 
    <xs:sequence> 
     <!-- summary description text --> 
     <xs:element 
      name="short-description" 
      type="xs:string" 
      minOccurs="0" /> 
     <!-- detailed description text --> 
     <xs:element 
      name="long-description" 
      type="xs:string" 
      minOccurs="0" /> 
     <!-- hint text --> 
     <xs:element 
      name="hint" 
      type="xs:string" 
      minOccurs="0" /> 
    </xs:sequence> 
   </xs:extension> 
  </xs:complexContent> 
 </xs:complexType> 
 <xs:complexType 
  name="Actions"> 
  <xs:sequence> 
   <xs:element 
    name="action" 
    type="tns:Action" 
    maxOccurs="unbounded" /> 
   <!-- summary description text --> 
   <xs:element 
    name="short-description" 
    type="xs:string" 

2538   



    minOccurs="0" /> 
  </xs:sequence> 
  <xs:attribute 
   name="label" 
   type="xs:string" 
   use="optional" /> 
 </xs:complexType> 
 <xs:complexType 
  name="Action"> 
  <xs:simpleContent> 
   <xs:extension 
    base="xs:string"> 
    <xs:attribute 
     name="label" 
     type="xs:string" /> 
    <!-- 
     the operation that should be invoked in 
     response to the action 
    --> 
    <xs:attribute 
     name="operation-name" /> 
    <!-- summary description text --> 
    <xs:attribute 
     name="short-description" 
     type="xs:string" 
     use="required" /> 
   </xs:extension> 
  </xs:simpleContent> 
 </xs:complexType> 
 <xs:complexType 
  name="TestConnectionAction"> 
  <xs:simpleContent> 
   <xs:restriction 
    base="tns:Action"> 
    <xs:attribute 
     name="operation-name" 
     fixed="TestConnection" /> 
    <xs:attribute 
     name="label" 
     type="xs:string" 
     fixed="Test Connection" /> 
   </xs:restriction> 
  </xs:simpleContent> 
 </xs:complexType> 
 
 
 <!-- predefined connector categories --> 
 <!-- 
  used to indicate the enterprise solution type 
 --> 
 <xs:simpleType 
  name="ConnectorCategory"> 
  <xs:restriction 
   base="xs:string"> 
   <xs:enumeration 
    value="CRM" /> 
   <xs:enumeration 
    value="SCM" /> 
   <xs:enumeration 
    value="ERP" /> 
   <xs:enumeration 
    value="ECM" /> 
   <xs:enumeration 
    value="SFA" /> 
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   <xs:enumeration 
    value="BPM" /> 
   <xs:enumeration 
    value="IBP" /> 
   <xs:enumeration 
    value="ORM" /> 
   <xs:enumeration 
    value="MIS" /> 
   <xs:enumeration 
    value="SIS" /> 
   <xs:enumeration 
    value="COM" /> 
   <xs:enumeration 
    value="MOM" /> 
   <xs:enumeration 
    value="PIM" /> 
   <xs:enumeration 
    value="Database" /> 
   <!-- etc --> 
  </xs:restriction> 
 </xs:simpleType> 
 
 <!-- activities --> 
 <xs:complexType 
  name="ActivityGroup"> 
  <xs:sequence> 
   <xs:element 
    name="activity" 
    type="tns:Activity" 
    minOccurs="1" 
    maxOccurs="unbounded" /> 
  </xs:sequence> 
  <!-- 
   this is the label of the group under which the 
   activities will appear 
  --> 
  <xs:attribute 
   name="label" 
   type="xs:string" 
   use="optional" /> 
 </xs:complexType> 
 
 <!-- activity --> 
 <xs:complexType 
  name="Activity"> 
  <xs:sequence> 
   <!-- wsdl operation --> 
   <xs:element 
    name="operation-name" 
    type="xs:string" /> 
   <xs:element 
    name="description" 
    type="xs:string" /> 
   <xs:element 
    name="task-list" 
    type="tns:Tasks" /> 
  </xs:sequence> 
  <xs:attribute 
   name="name" 
   type="xs:string" 
   use="required" /> 
  <!-- 
   this is the label of the activity that appears 
   under an activity group 
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  --> 
  <xs:attribute 
   name="label" 
   type="xs:string" 
   use="optional" /> 
 </xs:complexType> 
 
 <!-- activity tasks --> 
 <xs:complexType 
  name="Tasks"> 
  <xs:sequence> 
   <xs:element 
    name="configure-task" 
    type="tns:ConfigureTask" /> 
  </xs:sequence> 
 </xs:complexType> 
 <!-- 
  possible enhancement: determine "browsability" 
  based on if input is an extension of abstract 
  type. 
  type. 
 --> 
 <xs:complexType 
  name="ConfigureTask"> 
  <xs:sequence> 
   <xs:element 
    name="type" 
    type="tns:ConfigurationType" 
    default="browse" /> 
   <xs:element 
    name="applies-to" 
    type="tns:AppliesTo" 
    minOccurs="0" 
    default="inputs" /> 
  </xs:sequence> 
 </xs:complexType> 
 
 <!-- browsable or not --> 
 <!-- 
  possible enhancement: determine browsability 
  based on if input is an extension of abstract 
  type. 
  type. 
 --> 
 <xs:simpleType 
  name="ConfigurationType"> 
  <xs:restriction 
   base="xs:string"> 
   <xs:enumeration 
    value="none" /> 
   <xs:enumeration 
    value="browse" /> 
  </xs:restriction> 
 </xs:simpleType> 
 
 <!-- are the inputs or outputs configured? --> 
 <!-- 
  possible enhancement: determine browsability 
  based on if input is an extension of abstract 
  type. 
  type. 
 --> 
 <xs:simpleType 
  name="AppliesTo"> 
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  <xs:restriction 
   base="xs:string"> 
   <xs:enumeration 
    value="inputs" /> 
   <xs:enumeration 
    value="outputs" /> 
   <xs:enumeration 
    value="both" /> 
  </xs:restriction> 
 </xs:simpleType> 
 
 
 <!-- ******************* --> 
 <!-- Descriptors...      --> 
 <xs:simpleType 
  name="allNNI"> 
  <xs:annotation> 
   <xs:documentation> for maxOccurs 
   </xs:documentation> 
  </xs:annotation> 
  <xs:union 
   memberTypes="xs:nonNegativeInteger"> 
   <xs:simpleType> 
    <xs:restriction 
     base="xs:NMTOKEN"> 
     <xs:enumeration 
      value="unbounded" /> 
    </xs:restriction> 
   </xs:simpleType> 
  </xs:union> 
 </xs:simpleType> 
 <xs:attributeGroup 
  name="counts"> 
  <xs:attribute 
   name="minCount" 
   type="xs:nonNegativeInteger" 
   use="optional" 
   default="1" /> 
  <xs:attribute 
   name="maxCount" 
   type="tns:allNNI" 
   use="optional" 
   default="1" /> 
 </xs:attributeGroup> 
 <xs:complexType 
  name="Descriptor" 
  abstract="true"> 
  <xs:sequence /> 
  <xs:attribute 
   name="name" 
   type="xs:string" 
   use="required" /> 
  <!-- readable label text --> 
  <xs:attribute 
   name="label" 
   type="xs:string" 
   use="optional" /> 
  <xs:attributeGroup 
   ref="tns:counts" /> 
 </xs:complexType> 
 <!-- 
  child nodes annotated with 'volatile' indicate 
  that text node is set externally to the 
  connector implementation (e.g. by end-user 
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  building a project that uses the connector) 
 --> 
 <xs:complexType 
  name="FieldDescriptor"> 
  <xs:complexContent> 
   <xs:extension 
    base="tns:Descriptor"> 
    <xs:sequence> 
     <!-- field type (e.g. string, boolean, ...) 
--> 
     <xs:element 
      name="type" 
      type="tns:FieldType" /> 
     <!-- associated xsd type --> 
     <xs:element 
      name="soap-type" 
      type="tns:SoapType" 
      minOccurs="0" /> 
     <!-- 
      define a default value for the field 
if 
      applicable 
      applicable 
     --> 
     <xs:element 
      name="default-value" 
      type="xs:string" 
      minOccurs="0" /> 
     <!-- 
      define if values are of a particular 
format 
      e.g. password etc 
     --> 
     <xs:element 
      name="format" 
      type="tns:FieldFormat" 
      minOccurs="0" /> 
     <!-- 
      define if possible values form a 
collection 
      (e.g. a range or set of values) 
     --> 
     <xs:element 
      name="field-restriction" 
      type="tns:FieldRestriction" 
      minOccurs="0" /> 
     <!-- 
      define if values are restricted to 
regex 
      pattern 
      pattern 
     --> 
     <xs:element 
      name="value-restriction" 
      type="tns:ValueRestriction" 
      minOccurs="0" /> 
     <!-- 
      volatile: current or set value. 
(e.g. 
      "posted" value from endpoint panel 
when 
      end-user presses the 'Test 
Connection' 
      button.) 
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      button.) 
     --> 
     <xs:element 
      name="value" 
      type="xs:string" 
      minOccurs="0"> 
      <xs:annotation> 
       
<xs:appinfo>volatile</xs:appinfo> 
      </xs:annotation> 
     </xs:element> 
    </xs:sequence> 
    <!-- 
     <xs:attribute name="readable" 
     type="xs:boolean" use="optional" 
     default="true"/> <xs:attribute 
     name="writable" type="xs:boolean" 
     default="true" use="optional"/> 
    --> 
    <!-- namespace of this FieldDescriptor --> 
    <xs:attribute 
     name="ns" 
     type="xs:anyURI" /> 
    <!-- 
     can a configuration property be applied to 
     this field? 
    --> 
    <xs:attribute 
     name="configurable" 
     type="xs:boolean" 
     default="false" /> 
    <!-- internal --> 
    <xs:attribute 
     name="used" 
     type="xs:boolean" 
     default="true"> 
     <xs:annotation> 
      <xs:appinfo>volatile</xs:appinfo> 
     </xs:annotation> 
    </xs:attribute> 
   </xs:extension> 
  </xs:complexContent> 
 </xs:complexType> 
 <!-- 
  Descriptor allows consumers to obtain detailed 
  object description. For instance, this allows 
 --> 
 <!-- 
  Studio's UI generator to produce a user 
  interface with various ui-component types and 
  behaviors (in a consistent way.) 
 --> 
 <!-- 
  Note: ObjectDescriptor is part of 
  DescribeObjectResponse defined in 
  ci-connector-api.xsd 
  ci-connector-api.xsd 
 --> 
 <xs:complexType 
  name="ObjectDescriptor"> 
  <xs:complexContent> 
   <xs:extension 
    base="tns:Descriptor"> 
    <xs:sequence> 
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     <xs:element 
      name="field" 
      type="tns:FieldDescriptor" 
      minOccurs="0" 
      maxOccurs="unbounded" /> 
     <xs:element 
      name="object" 
      type="tns:ObjectDescriptor" 
      minOccurs="0" 
      maxOccurs="unbounded" /> 
    </xs:sequence> 
    <!-- namespace of this ObjectDescriptor --> 
    <xs:attribute 
     name="ns" 
     type="xs:anyURI" /> 
    <!-- internal --> 
    <xs:attribute 
     name="used" 
     type="xs:boolean" 
     default="true"> 
     <xs:annotation> 
      <xs:appinfo>volatile</xs:appinfo> 
     </xs:annotation> 
    </xs:attribute> 
   </xs:extension> 
  </xs:complexContent> 
 </xs:complexType> 
 
 <!-- supported types --> 
 <xs:simpleType 
  name="FieldType"> 
  <xs:restriction 
   base="xs:string"> 
   <xs:enumeration 
    value="string" /> 
   <xs:enumeration 
    value="base64" /> 
   <xs:enumeration 
    value="boolean" /> 
   <xs:enumeration 
    value="int" /> 
   <xs:enumeration 
    value="decimal" /> 
   <xs:enumeration 
    value="date" /> 
   <xs:enumeration 
    value="dateTime" /> 
   <xs:enumeration 
    value="anyType" /> 
   <!-- any of the above (e.g. string, int, etc) --> 
  </xs:restriction> 
 </xs:simpleType> 
 
 <!-- cooresponding xsd type --> 
 <xs:simpleType 
  name="SoapType"> 
  <xs:restriction 
   base="xs:string"> 
   <xs:enumeration 
    value="xs:base64Binary" /> 
   <xs:enumeration 
    value="xs:boolean" /> 
   <xs:enumeration 
    value="xs:decimal" /> 
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   <xs:enumeration 
    value="xs:int" /> 
   <xs:enumeration 
    value="xs:string" /> 
   <xs:enumeration 
    value="xs:date" /> 
   <xs:enumeration 
    value="xs:dateTime" /> 
   <xs:enumeration 
    value="xs:anyType" /> 
   <!-- 
    can be id, booolean, decimal, int, string, 
    date, dateTime 
   --> 
  </xs:restriction> 
 </xs:simpleType> 
 
 <!-- supported type formats --> 
 <xs:simpleType 
  name="FieldFormat"> 
  <xs:restriction 
   base="xs:string"> 
   <xs:enumeration 
    value="string" /> 
   <xs:enumeration 
    value="password" /> 
   <xs:enumeration 
    value="percent" /> 
   <xs:enumeration 
    value="phone" /> 
   <!-- 
    <xsd:enumeration value="date"/> date 
    formats??? 
    formats??? 
   --> 
   <xs:enumeration 
    value="url" /> 
   <xs:enumeration 
    value="email" /> 
   <xs:enumeration 
    value="currency" /> 
  </xs:restriction> 
 </xs:simpleType> 
 <!-- 
  possible values form a well defined collection 
 --> 
 <xs:complexType 
  name="FieldRestriction"> 
  <xs:choice> 
   <!-- value is restricted to a range of values --> 
   <xs:element 
    name="value-range" 
    type="tns:ValueRange" /> 
   <!-- value is restricted to a set of values --> 
   <xs:element 
    name="value-set" 
    type="tns:ValueSet" /> 
  </xs:choice> 
 </xs:complexType> 
 
 <!-- possible values form a set --> 
 <xs:complexType 
  name="ValueSet"> 
  <xs:sequence> 
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   <xs:element 
    name="entry" 
    type="tns:ValueSetEntry" 
    maxOccurs="unbounded" /> 
  </xs:sequence> 
  <!-- 
   is the set of values open or closed to 
   additions 
   additions 
  --> 
  <xs:attribute 
   name="restricted" 
   type="xs:boolean" 
   use="optional" 
   default="true" /> 
 </xs:complexType> 
 <xs:complexType 
  name="ValueSetEntry"> 
  <xs:sequence> 
   <xs:element 
    name="label" 
    type="xs:string" 
    minOccurs="0" /> 
   <!-- 
    value must be parsable for specified FieldType 
   --> 
   <xs:element 
    name="value" 
    type="xs:string" /> 
  </xs:sequence> 
 </xs:complexType> 
 <!-- 
  possible values are within a defined range 
 --> 
 <xs:complexType 
  name="ValueRange"> 
  <xs:sequence> 
   <!-- 
    min and max must be parsable for specified 
    FieldType 
    FieldType 
   --> 
   <xs:element 
    name="min" 
    type="xs:string" 
    minOccurs="0" /> 
   <xs:element 
    name="max" 
    type="xs:string" 
    minOccurs="0" /> 
   <!-- 
    e.g. for FieldType 'int' with min=0, max = 4, 
    and step=2, the only allowed field values are 
    0, 2, and 4 
   --> 
   <xs:element 
    name="step" 
    type="xs:string" 
    minOccurs="0" 
    default="1" /> 
  </xs:sequence> 
 </xs:complexType> 
 <!-- 
  value is restricted in length or regular 
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  expression 
  expression 
 --> 
 <xs:complexType 
  name="ValueRestriction"> 
  <xs:sequence> 
   <xs:element 
    ref="tns:length" 
    minOccurs="0" /> 
   <xs:element 
    ref="tns:min-length" 
    minOccurs="0" /> 
   <xs:element 
    ref="tns:max-length" 
    minOccurs="0" /> 
   <xs:element 
    ref="tns:pattern" 
    minOccurs="0" /> 
  </xs:sequence> 
 </xs:complexType> 
 <xs:complexType 
  name="ValueAttrib"> 
  <xs:complexContent> 
   <xs:extension 
    base="xs:anyType"> 
    <xs:attribute 
     name="value" 
     use="required" /> 
    <xs:attribute 
     name="fixed" 
     type="xs:boolean" 
     use="optional" 
     default="false" /> 
   </xs:extension> 
  </xs:complexContent> 
 </xs:complexType> 
 <xs:complexType 
  name="NumAttrib"> 
  <xs:complexContent> 
   <xs:restriction 
    base="tns:ValueAttrib"> 
    <xs:attribute 
     name="value" 
     type="xs:nonNegativeInteger" 
     use="required" /> 
   </xs:restriction> 
  </xs:complexContent> 
 </xs:complexType> 
 
 <!-- values conform to a regular expression --> 
 <xs:complexType 
  name="Pattern"> 
  <xs:complexContent> 
   <xs:restriction 
    base="tns:ValueAttrib"> 
    <xs:attribute 
     name="value" 
     type="xs:string" 
     use="required" /> 
   </xs:restriction> 
  </xs:complexContent> 
 </xs:complexType> 
 <xs:element 
  name="length" 
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id="_dcs_markdown_workspace_Transform_htmlout_0_nl_zh_TW_com.ibm.wci.cdk.doc_cdk_sch
emas_length" 
  type="tns:NumAttrib" /> 
 <xs:element 
  name="min-length" 
  
id="_dcs_markdown_workspace_Transform_htmlout_0_nl_zh_TW_com.ibm.wci.cdk.doc_cdk_sch
emas_minLength" 
  type="tns:NumAttrib" /> 
 <xs:element 
  name="max-length" 
  
id="_dcs_markdown_workspace_Transform_htmlout_0_nl_zh_TW_com.ibm.wci.cdk.doc_cdk_sch
emas_maxLength" 
  type="tns:NumAttrib" /> 
 <xs:element 
  name="pattern" 
  
id="_dcs_markdown_workspace_Transform_htmlout_0_nl_zh_TW_com.ibm.wci.cdk.doc_cdk_sch
emas_pattern" 
  type="tns:Pattern" /> 
 
 
 <!--       ...Descriptors --> 
 <!-- ******************** --> 
 <!-- 
  operationType allows defining endpoint location 
  on a per operations basis. 
 --> 
 <xs:complexType 
  name="operationType"> 
  <xs:sequence> 
   <xs:element 
    name="endpoint-location" 
    type="xs:string" /> 
  </xs:sequence> 
  <xs:attribute 
   name="name"> 
   <xs:simpleType> 
    <xs:restriction 
     base="xs:string"> 
     <xs:enumeration 
      value="testConnection" /> 
     <xs:enumeration 
      value="listObjects" /> 
     <xs:enumeration 
      value="describeObject" /> 
    </xs:restriction> 
   </xs:simpleType> 
  </xs:attribute> 
 </xs:complexType> 
</xs:schema>

ci-connector-api.xsd - 您的應⽤程式需要能夠利⽤來⾃連接器 API 的呼叫，與適當的連接器交談，您才能存取端
點。這個檔案說明 TestConnection、ListObjects 和 DescribeObject API 的要求/回應類型。這裡是 ci-
connector-api.xsd 檔案：

<xs:schema 
 
id="_dcs_markdown_workspace_Transform_htmlout_0_nl_zh_TW_com.ibm.wci.cdk.doc_cdk_sch
emas_ci-cdk-api" 
 version="1.0" 
 targetNamespace="http://www.approuter.com/schemas/cdk/api/" 
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 xmlns:tns="http://www.approuter.com/schemas/cdk/api/" 
 xmlns:ccc="http://www.approuter.com/schemas/cdk/config/" 
 xmlns:xs="http://www.w3.org/2001/XMLSchema" 
 xmlns:jaxb="http://java.sun.com/xml/ns/jaxb" 
 xmlns:xjc="http://java.sun.com/xml/ns/jaxb/xjc" 
 jaxb:extensionBindingPrefixes="xjc" 
 jaxb:version="2.0" 
 elementFormDefault="qualified"> 
 <xs:import 
  namespace="http://www.approuter.com/schemas/cdk/config/" 
  schemaLocation="ci-connector-config.xsd" /> 
 <xs:annotation> 
  <xs:appinfo> 
   <jaxb:schemaBindings> 
    <jaxb:package 
     
name="com.approuter.studio.connectors.cdk.api" /> 
   </jaxb:schemaBindings> 
  </xs:appinfo> 
 </xs:annotation> 
 <xs:complexType 
  name="TestConnection"> 
  <xs:sequence> 
   <xs:element 
    name="endpoint" 
    type="ccc:EndpointForm" /> 
  </xs:sequence> 
 </xs:complexType> 
 <xs:complexType 
  name="TestConnectionResponse"> 
  <xs:sequence> 
   <xs:element 
    name="success" 
    type="xs:boolean" /> 
   <xs:element 
    name="message" 
    type="xs:string" /> 
  </xs:sequence> 
 </xs:complexType> 
 <xs:complexType 
  name="ListObjects"> 
  <xs:sequence> 
   <xs:element 
    name="endpoint" 
    type="ccc:EndpointForm" /> 
   <xs:element 
    name="operation" 
    type="xs:string" 
    minOccurs="1" /> 
  </xs:sequence> 
 </xs:complexType> 
 <xs:complexType 
  name="ListObjectsResponse"> 
  <xs:sequence> 
   <xs:element 
    name="objectType" 
    type="tns:ObjectType" 
    minOccurs="1" 
    maxOccurs="unbounded" /> 
  </xs:sequence> 
 </xs:complexType> 
 <xs:complexType 
  name="ObjectType"> 
  <xs:simpleContent> 
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   <xs:extension 
    base="xs:string"> 
    <xs:attribute 
     name="label" 
     type="xs:string" 
     use="optional" /> 
   </xs:extension> 
  </xs:simpleContent> 
 </xs:complexType> 
 <xs:complexType 
  name="DescribeObject"> 
  <xs:sequence> 
   <xs:element 
    name="endpoint" 
    type="ccc:EndpointForm" 
    minOccurs="1" /> 
   <xs:element 
    name="objectType" 
    type="xs:string" 
    minOccurs="1" /> 
   <xs:element 
    name="operation-name" 
    type="xs:string" /> 
  </xs:sequence> 
 </xs:complexType> 
 <xs:complexType 
  name="DescribeObjectResponse"> 
  <xs:sequence> 
   <xs:element 
    name="object" 
    type="ccc:ObjectDescriptor" /> 
   <xs:element 
    name="responseObject" 
    type="ccc:ObjectDescriptor" /> 
  </xs:sequence> 
  <!-- local part name of the derived type --> 
  <xs:attribute 
   name="name" 
   type="xs:string" /> 
  <xs:attribute 
   name="description" 
   type="xs:string" /> 
  <!-- namespace of derived type --> 
  <xs:attribute 
   name="typeNS" 
   type="xs:string" /> 
  <!-- namespace of base/abstract type --> 
  <xs:attribute 
   name="baseTypeNS" 
   type="xs:string" /> 
  <!-- local part name of base/abstract type --> 
  <xs:attribute 
   name="baseType" 
   type="xs:string" /> 
 </xs:complexType> 
</xs:schema>

上層主題： Cast Iron CDK 元件

Cast Iron CDK XML 檔

您的 XML 檔定義外掛程式所執⾏的活動。 XML 檔中的每⼀個活動都必須與 WSDL 檔中定義的⼀項作業對映。
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XML 已新興為⼀種通⽤語⾔，可代表及傳輸與程式設計語⾔、軟體平台和硬體無關之結構化資料。針對您的開發
專案，您可以使⽤任何⽂字編輯器或符合 XML 的編寫⼯具，來建⽴ XML 檔。您的檔案必須符合綱⽬檔的規則，
否則外掛程式會失敗。

上層主題： Cast Iron CDK 元件

Cast Iron CDK WSDL 檔

WSDL 檔是⼀種 XML 格式的檔案，將網路服務定義為⼀組端點。WSDL 檔會說明如何存取 Web 服務，並指定服務
所執⾏的作業。WSDL 通常是由 Web 服務提供者所開發，且可透過 UDDI（通⽤說明、探索與整合）登錄來使
⽤。

在專案⼀開始，您必須將符合 WS-I（Web 服務交互作業能⼒）的 WSDL 檔匯⼊開發平台，使得您的開發環境可
以產⽣建置⽤⼾端 Web 服務應⽤程式所需的物件。Web 服務 API 會提供⼀組物件或 WSDL 類型的定義，以及⼀
組 Web 服務作業。

上層主題： Cast Iron CDK 元件

Cast Iron CDK .par 檔

您的外掛程式會包裝成 .par 檔。您的 .par 是您重新命名並匯⼊⾄ Studio 的標準 .zip 檔。

.par 檔包含您的外掛程式。它是從 Studio 專案匯出，並且是您實作介⾯作業的位置，該作業可讓您識別及盤存外
掛程式內含的物件。當您遞送 .par 時，其會⾃動展開⾄外掛程式的⽬錄中。

上層主題： Cast Iron CDK 元件

常⾒問題 (FAQ)

以下是⼀些常⾒問題，可協助您解決在開發程序期間可能發⽣的問題。

問：如何判斷我的輸⼊活動在設計時期是否可供探索？

答：如果活動的輸⼊會視物件類型⽽有所不同，您應選取可供探索，並對輸⼊使⽤抽象 WDSL 或綱⽬元素
類型。

問：我的綱⽬或 WSDL 不含抽象元素類型。如何將它新增⾄我的檔案中？

答：WSDL 和綱⽬提供了⼀個機制，可強制替代特定的元素或類型。如果要將抽象元素新增到檔案中，請
將下列 complexType 元素新增⾄ WSDL 或綱⽬中：complexType name="MyObject"。請務必在與輸
⼊類型相同的名稱空間中定義它。

問：我可以修改現有的連接器嗎？

答：只要連接器是使⽤「CDK 連接器精靈」所建置，您只需啟動「精靈」，然後在其中新增活動或修訂現
有的活動，即可加以更新。

問：我有現有的專案。我可以對其執⾏「精靈」，再使⽤編排來外露連接器活動嗎？

答：是的。您可以對現有的專案執⾏「精靈」，但請確定您的活動名稱未與現有的編排名稱衝突。

問：Studio 中未顯⽰我的連接器。為什麼？
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答：許多錯誤只要檢查錯誤即可更正。請檢查位於 Studio_Install_dir 下的⽇誌檔，以查看失敗的相
關資訊。

取得協助

本節告訴您如何取得 IBM 和其產品的相關資訊，以及如何聯絡銷售和技術⽀援⼈員。

您可以在以下網址存取 IBM 公司網站：http://www.ibm.com。

這個網站包含 IBM 公司、其背景以及產品等相關資訊。此網站也提供了銷售與技術⽀援的聯絡資訊。

在聯絡 IBM ⽀援中⼼之前，請驗證您已符合下列準則：

您的公司具有作⽤中的維護合約。

您已獲得提交問題的授權。

您擁有設備序號。

您擁有⽤於購買設備的客⼾號碼。

您可以採⽤下列兩種⽅式之⼀，向 IBM 提交軟體問題報告：

1. 使⽤服務要求 (SR) 問題提交網⾴。您需要使⽤您的 IBM 使⽤者 ID 和密碼來登⼊。
2. 透過電話聯絡 IBM。請參閱 IBM Software Support Handbook 中的全球聯絡⽬錄，取得適當的軟體⽀援中
⼼電話號碼。
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